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Motion is a behavior-driven motion graphics application that allows you to create stunning
imaging effects for a wide variety of broadcast, video, and film projects.

This preface covers the following:

• About Motion (p. 13)

• About the Motion Documentation (p. 14)

• Additional Resources (p. 14)

About Motion
Motion lets you create sophisticated moving images and other visual effects on the fly
and in real time. Simply drag one of Motion’s built-in behaviors (such as Spin or Throw)
or filters (such as Glow or Strobe) onto an object in the Canvas and watch your composition
spring to life—twirling, zipping across the screen, pulsing with luminescence, or any of
hundreds of other effects.

You can also animate the traditional way, using keyframes, but Motion behaviors give
you instant feedback, so you can sit with your clients, art directors, or friends and
interactively design a motion graphics project on your desktop. You want a title to fade
in, do a little shimmy, and then slide out of view? Simply click Play, then drag the Fade,
Random Motion, and Gravity behaviors onto the title in the Canvas—no preview rendering
time is necessary.

Whether you need simple text effects like lower-thirds and credit rolls, a complex motion
graphics project for a show intro or television commercial, or more advanced image
manipulation techniques to stabilize footage or composite green screen effects, Motion
has a flexible tool set to meet your motion graphics needs.
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About the Motion Documentation
The Motion 4 User Manual (this document) contains detailed information about the Motion
interface, commands, and menus and gives step-by-step instructions for creating Motion
projects and for accomplishing specific tasks. It is written for users of all levels of
experience.

Additional Resources
Along with the documentation that comes with Motion, there are a variety of resources
you can use to find out more about the application.

Motion Website
For general information and updates as well as the latest news about Motion, go to:

• http://www.apple.com/finalcutstudio/motion

Apple Service and Support Websites
For software updates and answers to the most frequently asked questions for all Apple
products, go to the general Apple Support webpage:

• http://www.apple.com/support

For software updates, documentation, discussion forums, and answers to the most
frequently asked questions for Motion, go to:

• http://www.apple.com/support/motion

To get more information on third-party tools, resources, and user groups, go to:

• http://www.apple.com/finalcutstudio/resources

To provide comments and feedback about Motion, go to:

• http://www.apple.com/feedback/motion.html

For discussion forums for all Apple products, where you can search for an answer, post
a question, or answer other users’ questions, go to:

• http://discussions.apple.com

For more information on the Apple Pro Training Program, go to:

• http://www.apple.com/software/pro/training
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Motion graphics is a type of visual effects work most commonly associated with title
sequences and show openers, bumpers and interstitials, and interface design like DVD
menus. It is also frequently used in technical settings for simulations of moving systems
such as traffic patterns or scientific models.

Motion graphics usually incorporates multiple objects onscreen simultaneously and is
typically governed by design considerations and a strong sense of visual impact.
Sophisticated motion graphics artists often combine traditional layout and design
techniques with tools borrowed from special effects work such as keying, masking,
compositing, and particle systems to create dynamic moving designs.

This chapter covers the following:

• General Motion Graphics Tools (p. 15)

• Tools and Techniques Specific to the Motion Application (p. 17)

• About Motion Projects (p. 18)

General Motion Graphics Tools
The tools commonly used for motion graphics fall into several categories.

Design Tools
Graphic designers have been using software to facilitate their work for many years. Motion
has incorporated many of the most valuable tools commonly found in layout and design
applications, including guides, alignment, and direct manipulation for positioning,
transforming, and distorting layers. Motion also contains some of the most flexible and
sophisticated tools for creating and handling text elements. This is especially important
because text is such a critical component of motion graphics design.
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Timing Tools
The principal difference between traditional design and motion graphics design is that
motion graphics design is time-based. Motion graphics artists are concerned with creating
a well-composed and readable layout that can be manipulated over time. Motion provides
a Timeline that contains tools usually found in a video editing application (such as tools
for trimming, setting markers, slipping, and snapping) to allow a motion graphics artist
to hone and compose the temporal aspects of a kinetic project.

Motion also supports audio files, including basic audio mixing, so you can create a
soundtrack for your project and make timing decisions based upon the audio as well as
visual components. You can animate layers, filters, behaviors, and other elements to
create elegant and precise compositions. Furthermore, you can smoothly retime your
footage using optical flow technology, or apply Retiming behaviors to clips for some
funky effects such as stutter and flash frames.

2D and 3D Compositing Tools
Any time you have more than one layer onscreen simultaneously, you must employ some
version of compositing to combine the elements. This might mean moving the layers
onscreen so they don’t overlap, adjusting the layers’ opacities so they are partly visible,
or incorporating blend modes that mix the overlapping images in a variety of ways.
Compositing is fundamental to motion graphics work. Fortunately, Motion makes it easier
than ever before, allowing you to control layer and group order, lock and group layers,
and apply more than 25 different blending options to create unique effects.

You can also mix 2D and 3D groups in a single project. This allows you to do basic
compositing with some elements of your project and complex 3D animations with other
elements.

Special Effects Tools
You can further enhance your motion graphics projects by employing many of the same
tools used in movies to combine dinosaurs with live actors, sink luxury liners in the ocean,
or create space battles. Motion provides many of these tools such as keying (to isolate an
object shot against a solid-colored background), masking (to hide wires or other objects
that should not be seen in the final image), and particle systems (to simulate natural
phenomena such as smoke, fire, and water). Motion can be used to create special effects
shots like these, but its real power is in integrating these tools with the design and editing
tools described above.
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Tools and Techniques Specific to the Motion Application
As the field of motion graphics design has evolved, the tool sets in the most common
applications have grown, but Motion takes a completely fresh approach to the task. It
incorporates the cutting edge of software design and takes advantage of the latest
powerful Apple hardware. And while it does include the tools and techniques artists have
grown accustomed to, it also incorporates a streamlined and new set of tools called
behaviors that make previously complex procedures as simple as dragging and dropping.
A tool called the replicator creates a customizable pattern from copies of a layer, quickly
creating complex design effects that would take hours to build in other applications.
Flexible paint and shape tools allow you to add or create shapes that are drawn on the
Canvas over time.

Behaviors
The Motion behaviors simplify the most common tasks such as scaling, fading, and moving
elements. Behaviors also allow you to create complex 2D or 3D interactions such as Edge
Collision (making elements bounce off of designated boundaries) or Attractor effects
(giving one element a gravitational pull on surrounding elements). And because text is
such a critical element of motion graphics work, Motion includes more than 140 behaviors
specifically designed for text elements that treat individual letters uniquely while
simultaneously affecting the entire text layer in which they reside.

Heads-Up Display (HUD)
Motion uses a special floating window called the heads-up display, referred to as the HUD,
to provide at-your-fingertips access to your most frequently used parameters. The HUD
changes dynamically, depending on what is selected. The HUD also provides access to
unique visual controls for some of the behaviors.

The HUD also allows you to quickly add behaviors to specific parameters of an object.
These Parameter behaviors allow you to affect a single aspect of an object (its position,
scale, or opacity, for example) rather than the object as a whole.

Real-Time Feedback
With the right hardware configuration, nearly every effect and adjustment you make can
be viewed in real time. This means that you can watch how the various elements of your
composition interact as you modify them. Not only does this mean less waiting time
while the computer converts your various clicks and drags into a viewable movie, it means
that you can interact with your creation in a more fluid and engaging way. Rather than
making a set of assumptions and then waiting to see how they turn out, you can
immediately see how your ideas work, then make adjustments on the fly.

Real-time feedback turns the act of designing a motion graphics sequence into an act of
exploration and discovery, which is the way most artists prefer to create. Motion provides
not just a new set of brushes for the motion graphics artist, but a whole new type of work
environment.
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Mouse and Keyboard Shortcut Considerations
If you have a two- or three-button mouse connected to your computer, you can right-click
to access the same controls specified by the Control-click commands in the user
documentation (for example, Control-click the Toolbar, then choose Customize Toolbar
from the shortcut menu). If you are working on a MacBook or MacBook Pro, keep in mind
that some keyboard shortcuts may require you to use the Function key (Fn—next to the
Control key) in conjunction with the keys specified in the user documentation. For more
information about keyboard shortcuts in Motion, see Keyboard Shortcuts.

About Motion Projects
In Motion, you create 2D or 3D motion graphics and compositing projects with imported
images (such as Adobe Photoshop or Illustrator files), image sequences, QuickTime movies,
audio files, as well as objects created within Motion. These objects include text, masks,
shapes, particles, paint strokes, and so on.

A Motion project is made up of groups that contain layers. All media imported into Motion,
or elements created within a project, are referred to as layers. A layer must live within a
group. The group acts as a “parent” to its layers. You can select multiple layers within a
group to create a nested group. A group can be 2D or 3D. For more information on layer
and group basics, see Transforming Objects and Layers.

Cameras and lights can be added to projects. When a camera is added to a project, you
have the option to switch the project to 3D mode or to remain in 2D mode (unless the
project is empty or completely 2D, in which case it is automatically switched to 3D mode).
2D groups can exist in a 3D project. A 2D group can be nested in a 3D group. A 3D group
can be nested in a 2D group. Once a 3D group is nested in a 2D group, the group is
flattened. This means that the nested 3D group acts like a flat card and ignores the camera.
In addition, the flattened group does not intersect with layers of the 2D group or other
groups in the project. For more information on working in 3D, see 3D Compositing.

Any transforms, filters, or behaviors that are applied to a group are applied to the layers
within the group. If you move or apply a filter or behavior to a group, all layers within
that group are affected. You can also apply filters and behaviors to the individual layers
within a group.

A filter is a process that changes the appearance of an image. For example, a blur filter
takes an input image and outputs a blurred version of that image. For more information
on using filters, see Using Filters.

A behavior is a process that applies a value range to an object’s parameters, creating an
animation based on the affected parameters. For example, the Spin behavior rotates an
object over time at a rate that you specify. For more information on using behaviors, see
Using Behaviors.
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Groups and layers can be moved and animated by using behaviors or by setting keyframes.
Filters can also be animated.

A project represents a single flow of image data built from the bottom up. In a composite
with a single group, the layers within that group are stacked above one another. Filters
and behaviors that are applied to a layer appear beneath the object in the Layers tab.
The group represents the image that results from its combined layers and their applied
behaviors, filters, and composite modes (blend modes). For more information on building
projects, see Creating and Managing Projects. For more information on basic compositing,
see Basic Compositing.

In a simple example, a group contains a single image with applied color correction and
blur filters (in that order). The image provides the input data to the color correction filter.
The output data of the color correction is the input data for the blur filter. The group
represents the result of that image data flow. Groups and layers are also stacked one
above the other in a project—the output of the lower layer is the input to the layer above
it in the list.

When working in 3D mode, a layer that is below another layer in the Layers tab can appear
above that layer in the Canvas if its Z position is closer to the camera. You can force the
layers to respect their order in the Layers tab by selecting the Layer Order checkbox in
the Group tab of the Inspector.

19Chapter 1 About Motion and Motion Graphics





This chapter introduces you to the Motion interface. It also describes how to work with
all of the basic tools you need to get started.

This chapter covers the following:

• Workspace Overview (p. 22)

• Utility Window (p. 23)

• Toolbar (p. 44)

• Canvas (p. 53)

• Project Pane (p. 84)

• Timing Pane (p. 101)

• Window Arrangements (p. 128)

• HUD (p. 134)
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Workspace Overview
When you open Motion, the workspace fills your entire monitor, but the interface is
actually made up of several independent windows. The sizes and arrangements of these
windows are flexible to allow for the varying needs of different projects. There are
additional panes and windows that can be displayed along with the default set. In the
following example, the Project pane and Timing pane have been opened.

Utility window CanvasTiming pane

Project pane Toolbar

The Motion workspace contains the following major components:

• Utility window: The utility window includes the Preview area, File Browser, Library, and
the Inspector (when layout is set to Standard). For more information, see Utility Window.

• Toolbar: The Toolbar contains controls to create and edit elements in your project,
such as text, shapes, and masks. There are also icons to apply filters and behaviors, to
create particle systems and replicators, and to show and hide the various windows and
panes of the Motion interface. For more information, see Toolbar.

• Canvas: The Canvas is the main work area of the interface, where you can view and
manipulate elements, as well as control playback of your project. The Canvas also
contains the Status bar and the project view options. For more information, see Canvas.

• Project pane: The Project pane can appear on either the left or right side of the Canvas
window and can be hidden to maximize the Canvas working area. The Project pane
contains three tabs that allow you to see and manipulate the contents of the current
project in a variety of ways. For more information, see Project Pane.
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• Timing pane: The Timing pane appears at the bottom of the Canvas window and can
be hidden to maximize the Canvas working area. The Timing pane contains three tabs
that allow you to see and manipulate different aspects of the current project with an
emphasis on how they are arranged in time. For more information, see Timing Pane.

Utility Window
When you open Motion, a utility window appears on the left side of the screen and
contains the File Browser from which you can add files to your project. The utility window
also has tabs to display the Library, which contains all of the effects, templates, and other
goodies that come with Motion, and the Inspector where you can manipulate individual
settings for those effects.

The utility window is where you locate, organize, and modify the media, effects, and
parameters that go along with your project. This includes sorting through the media on
your disk, browsing all of the effects, presets, and other content, and viewing and
manipulating all of the parameters that control how your objects and effects behave.
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In the default window layout, File Browser, Library, and Inspector tabs reside in a utility
window on the left side of the Canvas. If you choose the Cinema layout, two utility
windows are displayed, one on the left of the Canvas, containing the File Browser and
Library, and one on the right side of the Canvas, containing the Inspector. As each of the
three tabs can appear independently of one another, they are treated as separate entities
below.

File Browser Library Inspector

File Browser
In the utility window, the File Browser tab displays all of the files on your computer.
Navigating the File Browser is similar to navigating a window in the Finder. You can drag
items directly from the File Browser into your project.

File Browser Preview Area
The top area of the File Browser contains a preview of the selected layer. The Preview
area includes both a visual preview, complete with a Play button to show the multiple
frames of moving footage, and text information about the file: filename, media type, file
size, and frame rate. The Preview area also contains an audio mute button.
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Note: When displayed in the Preview area, audio files contain a text description but no
image preview.

To play a preview of a file on disk
µ Select the file in the File Browser.

The preview starts playing.

Note: If you do not want items to play automatically in the Preview area when you click
them (in the File Browser or Library), you can turn off the “Play items automatically on a
single click” checkbox in the General pane of Motion Preferences.

To import a file displayed in the Preview area
1 Select the file in the File Browser.

2 Click the Import button in the Preview area.

The file is added to the project (to the Canvas, Layers tab, Timeline layers list, and Media
tab).

Note: For a larger preview, you can double-click any file listed in the File Browser. This
opens a viewer window where you can preview the file at its native size. You can also
Control-click a file and choose Open in QuickTime Player from the shortcut menu.
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File Browser Sidebar
The middle section of the File Browser contains navigational controls as well as a sidebar
containing a list of servers, drives, and folders available on your computer.

View buttons

Forward/Back buttons

Path pop-up menu

Search field

Clicking a drive or folder in the sidebar displays its contents in the file stack below. Above
the list of drive and folder icons in the sidebar are several controls to navigate and sort
the contents of the window.

Forward and Back buttons: Step backward and forward through the folders most recently
viewed. This works similarly to the Forward and Back buttons in the Finder.

If you are working on a Mac with a Multi-Touch trackpad, you can use a three-finger swipe
left or right to navigate up and down the directory tree.

Path pop-up menu: Displays the file system hierarchy (folders inside of folders) for the
currently viewed folder.

Icon View and List View buttons: These buttons control the view of the file stack. Click
the left button to set the display to icon view. Click the right button to set the view to
list view.

Search field: Filters the contents of the file stack to include only files whose names contain
the text you type into the Search field. To clear the Search field, click the Clear button at
the right side.

Note: Folders are not filtered out.

File Browser Stack
At the bottom section of the File Browser is the file stack, which displays the contents of
the folder selected in the sidebar. You can scroll through long stacks using a scroll bar or
with a two-finger swipe on a Multi-Touch trackpad.
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You can Control-click a file in the File Browser stack to display a shortcut menu. For most
items, the following options are available in the menu:

• Open in Viewer: This option opens the file in a viewer window.

• Open in QuickTime Player: This option opens the file in a QuickTime window.

• Reveal in Finder: This option displays the location of the file in the Finder.

• Rename: This option turns the name of the file into an active text field so that you can
type a new name for the file.

• Move to Trash: This option moves the file into the Trash.

Moving around the stack is easy.

To view the contents of a folder displayed in the file stack
Do one of the following:

µ Double-click the folder.

µ Select the folder, then press Return.

The contents of the folder replace the current file stack view.

To return to a previously viewed folder
Do one of the following:

µ Click the Back button directly beneath the Preview area (to the left of the Path pop-up
menu).

µ Choose a new folder from the Path pop-up menu directly beneath the Preview area.

µ Press Command–Up Arrow.

µ Three-finger swipe left on a Multi-Touch trackpad.

Working in the File Browser
You can easily organize files in the File Browser. You can also customize how files are
displayed there.

To rename a folder or file
Do one of the following:

µ Control-click the file or folder, then choose Rename from the shortcut menu. When the
text field becomes active, type the new name, then press Return.

µ In the stack, click the name of the folder or file once to select it, then click it again to
activate the text field. Type the new name, then press Return.

Warning: Renaming folders or files from within the File Browser renames the item on
your hard disk or network. If projects are using files from the originally named folder,
Motion may list the footage as missing.
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To delete a folder or file
Do one of the following:

µ In the stack, Control-click the file, then choose Move to Trash from the shortcut menu.

µ Drag the file from the stack to the Trash icon in the Dock.

Warning: Deleting folders or files from within the Motion File Browser removes the files
from your hard drive or network and places the files in your Trash.

Organizing Your Files
You can organize the files and folders displayed in the File Browser just as you manipulate
files in the Finder. You can move files in and out of folders and create new folders. All of
the changes you make to your file structure from within Motion are reflected in the Finder.

To create a new folder
µ Click the New Folder button at the bottom of the utility window.

To move a file into a folder
µ Drag the file to the folder icon.

The file is moved inside that folder.

Icon View and List View
The file stack can be displayed in icon view or list view. Each view is useful for different
situations. There are certain options that only affect the icon view (such as icon size) and
certain options that only affect list view (such as sorting by columns).

Icon view List view

To view the File Browser in icon view
µ Click the Icon View button to the right of the Path pop-up menu above the sidebar.

28 Chapter 2 The Motion Interface



To view the File Browser in list view
µ Click the List View button to the right of the Path pop-up menu above the sidebar.

Icon View

List View

In icon view, you can control the size of the icons using the scale slider at the bottom of
the window.

Scale slider

To change the icon size
µ Drag the icon scale slider to the right to make the icons larger and drag to the left to

make them smaller.

µ On a Multi-Touch trackpad, use a pinch open to make the icons larger or pinch closed to
make the icons smaller.

In list view, the contents of the selected folder are displayed as a series of columns: Name,
Date, Size, Duration, and Kind.

You may need to expand the width of the utility window, or use the scroller at the bottom
of the window (or a two-finger swipe on a Multi-Touch trackpad), to see all of the columns.

Sorting Columns
You can sort the list by any of the columns. This can be helpful if you are looking for a
particular file and you know the approximate size or modification date.

To sort the File Browser list
µ Click the header for the column you want to sort.

The column header darkens and the contents of the window are sorted by that column.
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Collapsing Animations
Frequently, animated sequences may be delivered as a series of sequentially numbered
still images. Motion can save you time by allowing you to import these sequences as a
single object where each image becomes a sequential frame in a movie.

To import a series of numbered still images as a single object
1 Click the “Show image sequences as collapsed” button.

The File Browser displays multiple items collapsed into a single object.

2 Drag the object from the File Browser to the Canvas, Layers tab, Timeline, or Media tab.

Note: Images from digital cameras are often numbered sequentially but are not part of
an animation sequence. You may want to turn off this option to import a single still image
from a digital camera.

Library
The second tab in the utility window is called the Library. This is similar to the File Browser,
but rather than showing the files on your disk, it shows all of the effects, content, presets,
fonts, music, photos, and other elements available from within Motion.

Library content can be expanded by adding certain plug-ins, fonts, music, or photos, as
well as by saving content that you create within Motion. You can also save modified
versions of existing effects (such as customized behaviors or camera animations) as custom
additions to the Library.
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Like the File Browser, the Library is divided into three sections. The top section is the
Preview area; the middle section is the sidebar; and the bottom section is the file stack,
where the actual effects and other objects are displayed.

Library Preview Area
The Preview area contains a visual preview and a Play button to show the multiple frames
of moving footage, previews of filters, behaviors, generators, particle emitters, replicators,
and so on. The Preview area also contains text information for the selected object, such
as a description of the behavior, filter, or generator. The Library Preview area is almost
identical to the File Browser Preview area, but instead of an Import button, it has an Apply
button.

Note: When certain particle emitters are selected in the stack, an animated preview plays
in the Preview area. While it is playing, you can drag the pointer around in the Preview
area to see how the particle looks when moving.

To play a preview of an element such as a replicator
µ In the Library, click the Replicators category, click a replicator subcategory, then click the

replicator you want to preview from the stack.

The preview begins playing in the Preview area.

31Chapter 2 The Motion Interface



Library Sidebar
The middle section of the Library contains navigational controls as well as a list of folders
of effect types and content available in Motion.

View buttons

Path pop-up menu

Search field

Theme pop-up menu

Forward/Back buttons

Clicking a folder in the sidebar displays its contents in the file stack below. Above the
Library categories in the sidebar are several controls to navigate and sort the contents
of the window.

Forward and Back buttons: Step backward and forward through the folders most recently
viewed. These work similarly to the Forward and Back buttons in a web browser.

You can also use a three-finger swipe left or right to navigate up and down the directory
tree.

Path pop-up menu: Displays the file system hierarchy (folders inside of folders) for the
currently viewed folder.

Icon View/List View buttons: These buttons control the view of the file stack. Click the
left button to set the display to icon view. Click the right button to set the view to list
view.

Theme pop-up menu: Allows you to sort and organize Library content by theme. You
can choose an existing theme or create a custom theme and add content to the custom
theme.

Note: Behaviors, filters, fonts, LiveFonts, images, image sequences, and movies cannot
be added to a theme. However, layers and groups that contain these types of items may
be added to a theme.

Items that can be added to a theme include the following:

• Replicators
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• Emitters

• Shapes

• Gradients

• Text styles

• Shape styles

• Layers or groups

For more information about working with themes, see Working with Themes in the Library.

Search field: Filters the contents of the file stack to include only those objects whose
names contain the text you type into the Search field.

Note: Folders containing no matches are filtered out.

Library File Stack
At the bottom section of the Library is the file stack, which displays the contents of the
folder selected in the sidebar. You can scroll through long file stacks using a scroll bar or
with a two-finger swipe on a Multi-Touch trackpad.

To view the contents of a folder displayed in the file stack
Do one of the following:

µ Double-click the folder.

µ Select the folder, then press Return.

The contents of the folder replace the current file stack view.

To return to a previously viewed folder
Do one of the following:

µ Click the Back button directly beneath the Preview area.

µ Choose a new folder from the Path pop-up menu directly beneath the Preview area.

µ Press Command-Up Arrow.

µ Use a three-finger swipe left on a Multi-Touch trackpad.

Library Content
The Library contains all of the effects, presets, fonts, and other content available within
Motion. These are grouped into categories that are listed on the left of the sidebar. Choose
any of these items to display a list of subcategories on the right. The Library also contains
two additional categories—Music and Photos—which provide quick access to your iTunes
and iPhoto libraries.

For information on adding Library content to your project, see Adding Library Elements
to a Project.
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The Library contains the following categories:

• Behaviors: Contains the Audio, Basic Motion, Camera, Motion Tracking, Parameter,
Particles, Replicator, Retiming, Shape, Simulations, Text Animation, and Text Sequence
behaviors. Different kinds of behaviors can only be applied to specific types of objects.
For example, Text Animation and Text Sequence behaviors can only be applied to text.
For more information on how to apply behaviors, see Applying Behaviors.

• Filters: Contains all filter effects divided into individual subcategories. Third-party FxPlug
filters will appear in the category to which they belong. Most filters can be applied to
any layer (text, images, shapes, footage, particles, and so on) or mask in your project.
For more information on filters, see About Filters.

• Image Units (Filters): Contains all of the processing plug-ins based on core image
processing that are installed on your computer.

• Generators: Contains a selection of checkerboards, noise patterns, color rays, animated
text objects, and other computer-generated elements for use in your projects. For more
information on generators, see About Generators.

• Image Units (Generators): Contains all of the generators based on core image processing
that are installed on your computer.

• Particle Emitters: Contains a selection of preset particle systems organized into
subcategories. For more information on the particle systems presets, see Using the
Particle Library.

• Replicators: Contains a selection of preset replicators organized into subcategories. For
more information on the preset replicators, see Using the Replicator Library Presets.

• Shapes: Contains a collection of preset shapes. Shapes are added to a project like other
Library elements.

• Gradients: Contains a selection of preset gradients that can be applied to shapes or
text. You can drag the gradient directly to a shape or text, or select the shape or text
in the project first, select the gradient in the Library, then click Apply.

• Fonts: Contains all of the fonts available on your system. It includes both TrueType and
Type 1 fonts. You can drag the font directly to text in the project, or select the text in
the project first, select the font in the Library, then click Apply. For more information
on changing fonts in this browser, see Changing Fonts.

• LiveFonts: Contains all of the LiveFonts currently installed on your computer. LiveFonts
can only be applied to text. For more information, see Using LiveFonts

• Text Styles: Contains a collection of preset type styles that can be applied to text. You
can drag the text style directly to text in the project, or select the text in the project
first, select the text style in the Library, then click Apply. Text styles also appear in the
Text Inspector. For more information, see Using and Creating Preset Text Styles.
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• Shape Styles: Contains a collection of preset shape styles that can be applied to shapes.
You can drag the shape style directly to a shape in the project, or select the shape in
the project first, select the shape style in the Library, then click Apply. Shape styles also
appear in the Paint Stroke Tool HUD and the Shape Inspector. For more information,
see Using Shapes, Masks, and Paint Strokes.

• Music: This Library category allows you to browse for and import audio files directly
from your iTunes library. The Music subcategories include the library and any playlists
created in iTunes. The contents of each playlist appear in the file stack. When displayed
in list view, the Music category shows the Name, Artist, Album, Duration, and Size
information created in iTunes.

Note: Rights-protected AAC files cannot be imported into Motion and do not appear
in the file stack. This includes all music purchased from the iTunes Store. Video content
from iTunes cannot be imported to a Motion project.

• Photos: This Library category allows you to browse for and import image files directly
from your iPhoto library. The Photos subcategories include the library and any albums
created in iPhoto. The contents of each album appear in the file stack.

Note: When importing a large-scale image into Motion, you have the option to import
the file as is, to scale the image to the size of the Canvas, or to change the resolution
of the image to fit the Canvas. For more information, see Using High-Resolution Still
Images.

• Content: Contains individual elements used in the templates and other presets. These
can be used to create your own custom elements, such as particles and replicators,
which can be saved to the Library for later use.

• Favorites: As you make custom versions of any type of effect, including particle systems,
customized filters, animation curves, cameras, groups, or layers, you can store them in
the Favorites folder. You can also add shortcuts to frequently used items. By default,
this folder is empty.

Note: The Preview area does not display descriptions of built-in presets copied to the
Favorites category. Control-click the favorite, then choose Edit Description from the
shortcut menu to add a description that appears in the Preview area of the Library.

• Favorites Menu: This is another category of favorites. Items stored in this folder appear
in the Favorites menu in the menu bar.

Working in the Library
You can easily create, save, and organize files and themes in the Library.

Adding Library Elements to a Project
Effects and content elements can be added to a project from the Library in two ways.
You can drag an element from the Library stack directly into your project or select an
element in the Library stack and then click the Apply button in the Preview area.
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Note: To add behaviors and filters, a third option is available. You can select an object or
objects in the project and use the Add Behavior or Add Filter icon in the Toolbar. You
can also create custom particles and replicators (using an existing layer in your project)
via the Make Particles and Replicator icons in the Toolbar. For more information on making
custom particles, see Creating a Simple Custom Particle System. For more information
on making custom replicators, see Creating a Simple Custom Replicator Pattern.

To add a Library effect or element to a project
1 Select the layer or group (in the Canvas, Layers tab, or Timeline layers list) to which you

want to apply the effect or content element.

2 Select the element in the Library.

For example, click the Filters category, click a filter subcategory, then click the filter you
want to apply from the stack.

3 Click the Apply button in the Preview area.

The element is added to the selected layer or group in your project.

You can also drag an element from the Library directly to a layer or group in the Layers
tab, Canvas, or Timeline. For more information about placing and reordering objects in
a project, see Organizing Groups and Layers in Motion.

Working with Themes in the Library
The Library allows you to create new custom themes (categories that contain effects and
content), add content to existing themes, edit how themes are displayed, remove themes,
and search for themes.

To create a new custom theme
1 Choose New Theme from the Theme pop-up menu.

2 In the Create New Theme dialog, type a theme name, then click OK.

A new theme is added. New themes appear in the Theme pop-up menu.

Custom themes are saved in your /Users/username/Library/Application
Support/Final Cut Studio/Motion/Library/ folder in the Themes file.

To add content to a theme
µ Control-click an item in the Library, choose Theme from the shortcut menu, then choose

the theme in which you want to save the content. An item must be saved in the Library
in order to add it to a theme. For more information on saving items to the Library, see
Saving and Sharing Custom Library Elements.

To sort using the Theme pop-up menu
Do one of the following:

µ Select a category in the Library, then choose a theme from the Theme pop-up menu.
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µ To sort using the default themes, select the Content category, then choose the Folio,
Traditions, or Learning theme from the Theme pop-up menu.

Default themes are stored in your /Library/Application
Support/Final Cut Studio/Motion/Library/ folder in the Themes file.

To remove a theme
1 Choose the theme you want to remove from the Theme pop-up menu.

The Remove Theme item becomes available in the Theme pop-up menu.

2 Choose Remove Theme from the Theme pop-up menu.

The theme is removed from the list.

Note: You can only remove custom themes.

To clear the Search field
µ Click the Clear button at the right of the Search field.

Organizing Your Effects
You can organize the effects, elements, and folders displayed in the Library just as you
manipulate files in the Finder. You can move effects and elements in and out of folders,
create new folders, and even delete some files or folders.

Note: You cannot modify the effects, elements, and folders that are built into Motion.

To create a new folder
µ Click the New Folder button at the bottom of the utility window.

A new folder is added to the current Library subcategory.

For more information on organizing custom folders and content, see Adding Your Own
Content to the Library.
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Icon View and List View
The file stack can be displayed in icon view or list view.

Icon view List view

To view the Library in icon view
µ Click the Icon View button to the right of the Path pop-up menu above the sidebar.

To view the Library in list view
µ Click the List View button to the right of the Path pop-up menu above the sidebar.

Icon View

List View

In icon view, you can control the size of the icons using the scale slider at the bottom of
the window.

Scale slider

To change the icon size
µ Drag the icon scale slider to the right to make the icons larger and to the left to make

them smaller.

µ On a Multi-Touch trackpad, pinch open to make the icons larger and pinch closed to
make them smaller.

Saving and Sharing Custom Library Elements
You can save nearly any object in Motion to the Library. These include animated cameras
and lights, customized behaviors, filters, particle systems, or replicators, shapes and text,
as well as layers and groups. To save an object for future use, you can drag it to an existing
or new folder in the Library. Once an object is placed in the Library, it can be added to a
project like any other element in the Library.
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You can save multiple objects to the Library as one file or multiple files. For example, if
you create an effect using multiple filters and you want to save the cumulative effect of
those filters to apply to other objects, you can save all of the filters as one item in the
Library.

Although you can save custom objects into their namesake folders, it is generally
recommended that you save customized objects that you use frequently in the Favorites
category. This is because some Motion Library categories contain so many items that
utilizing the Favorites or Favorites Menu categories may save you search time. Within the
Favorites category, you can create additional folders to assist you in better arranging your
custom items.

Note: You can create new folders in the built-in categories, such as the Color Correction
filters subcategory; however, those folders only appear in the Library stack and not the
sidebar. Folders added to the Favorites category appear in the Library sidebar.

To save an object to the Library
1 Open the Library and select the Favorites, Favorites Menu, or other category.

2 Drag the customized object you want to save from the Layers tab, Timeline, or Inspector
into the stack at the bottom of the Library.

Objects that are saved to the Favorites Menu category can be quickly applied to objects
using the Favorites menu.

When you save a customized object, it’s saved in the /Users/username/Library/Application
Support/Final Cut Studio/Motion/Library/ folder.

Note: Items dragged to the wrong category are automatically placed into their namesake
categories. For example, if a custom behavior is dragged to the Filters category, it is
automatically placed in the Behaviors category and the Behaviors category becomes
active.

To save multiple objects to the Library
1 Open the Library and select the Favorites, Favorites Menu, or another category.

2 In the Layers tab, select all of the objects you want to save, drag them to the stack, and
keep holding down the mouse button until the drop menu appears.

3 Choose “All in one file” or “Multiple files.”

“All in one file” saves all the objects together and they are listed as one item in the Library.
“Multiple files” saves the objects as individual objects in the Library.

4 To name the file or files, do one of the following:

• Control-click the icon in the Library stack, choose Rename from the shortcut menu,
then type a descriptive name.

• Select the icon, click “Untitled,” then type a descriptive name.
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When you Control-click the icon, the Edit Description option becomes available. This is
a handy tool that allows you to enter custom notes about an item saved in the Library.
Once you choose Edit Description, enter your notes in the text field and click OK.

Inspector
Every effect and element in Motion, from behaviors to particle systems to gradients, is
controlled by a collection of parameters that modify the various attributes for that effect.
For example, a Blur filter has an amount slider that controls how much blur is applied.

Some parameters are controlled with sliders, some with dials or pop-up menus. In fact,
there are thousands of parameters using many types of controls. All of them are accessed
in the Inspector. For more information on Inspector controls, see Generic Inspector
Controls.

Important: The Inspector is contextual—what appears in the Inspector is based on the
selected object. An object must be selected for parameters to appear in the Inspector.

Even objects without applied effects have many parameters that you can modify to alter
the nature of the object and how it behaves in your project. These include an object’s
scale, opacity, and position onscreen, as well as more obscure attributes such as a clip’s
pixel aspect ratio or field order.

The Inspector consists of four tabs, each of which contains a set of parameters for the
selected object. The first three tabs, Properties, Behaviors, and Filters, are present for any
selected object. The fourth tab, generically called the Object tab, changes its name and
contents depending on the type of object selected.

Inspector Preview Area
The Preview area contains a visual preview of the selected object and a Play button to
show the multiple frames of moving footage. The Inspector Preview is almost identical
to the File Browser and Library Preview areas, but it has no Apply or Import button.

Properties
This tab contains controls for setting basic attributes of the selected object, such as
Transform controls (position, scale, rotation, and so on), Blending controls (opacity, blend
mode, and so on), Shadows controls, Four Corner controls, Crop controls, and controls
for designating the object’s In and Out points.
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Note: Different parameters are available in the Properties tab depending on the type of
object that is selected. For example, when a 3D group is selected, the Lighting parameter
appears in the tab and the Crop, Drop Shadow, and Four Corner parameters do not.

Behaviors
When behaviors are applied to an object, the parameters associated with the behaviors
appear in the Behaviors tab when that object is selected.

Filters
Whenever a filter is applied to a layer (or mask), the parameters associated with that filter
appear in the Filters tab.

Object
The appearance of the Object tab is context-sensitive—the name of the tab and the
controls therein are based on the type of the currently selected object. The different types
of Object tabs are described below:

• Object: Appears when there is no currently selected object. There are no parameters
in the Object tab of the Inspector.

• Image: Appears when an image, image sequence, or movie is selected. This tab contains
the Drop Zone checkbox, the state of which determines whether the image selected
is a drop zone target. The Fit parameter determines how a dropped layer is sized within
the drop zone, and the Clear button removes the reference layer from the drop zone.
For more information, see Drop Zones.

• Group: Appears when a group is the selected object. The tab contains the Type
parameter, which allows you to convert a group from 2D to 3D, and vice versa. A 2D
group has different available parameters than a 3D group.

When set to 3D, the Flatten and Layer Order parameters become available. When the
Flatten checkbox is selected, all of the elements in the 3D group are flattened like a
card or billboard. When the Layer Order checkbox is selected, the project elements are
sorted by their order in the Layers tab rather than their order in Z space. For more
information, see Layer Order and Depth Order.

When set to 2D, the Fixed Resolution parameters become available, which allow you
to manually define the size of a group. By default, Fixed Resolution is disabled and the
size of the group is determined by the layers within that group. For more information,
see Fixing the Size of a Group.

Note: When selected, Fixed Resolution crops the group to the size specified in the
Fixed Width and Fixed Height parameters around the anchor point of the group.

• Camera: Appears when a camera is selected and contains controls specific to a scene
camera, including the type of camera, its angle of view, and depth of field parameters.
For more information on working with cameras, see Cameras.
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Note: A scene camera is a camera that is added to a project, as opposed to a default
camera view that you choose in the upper-left corner of the Canvas, such as Top, Right,
or Perspective.

• Light: Appears when a light is selected and contains controls that allow you to change
the light type, color, intensity, and so on. For more information on working with lights,
see Lighting.

• Media: Appears when an item is selected in the Media tab of the Project pane (for more
information see Project Pane). These parameters deal mostly with attributes of the file
on disk or how the file is interpreted by Motion. Because multiple project objects can
reference a single media file, the tab contains a list of linked objects including the name
of the group where they exist. Making changes in this tab affects all objects that refer
to the selected media file. For more information on working with media parameters,
see Object Media Tab Parameters.

• Text: Appears when a text layer is selected and contains all of the controls that affect
the text. This tab is divided into three panes: Format, Style, and Layout.

• Format: Contains standard type controls such as font, size, tracking, kerning, and so
on. It also contains a large text entry box called the Text editor where you can edit
the contents of the text (in addition to onscreen editing).

• Style: Controls the color, texture, and similar attributes for the typeface, outline, glow,
and drop shadow. Each of these sections is grouped and can be s or off by selecting
the activation checkbox next to the category name.

• Layout: Contains paragraph style controls such as justification, alignment, and line
spacing (leading). This pane also contains controls to create a type-on effect or to
modify text path options. For more information on working with text parameters,
see Creating and Editing Text.

• Mask: Appears when a mask is selected and contains the Feather (softness) parameter.
This tab also contains controls to change the mask’s shape type and how multiple
masks interact, an Invert Mask checkbox, and position value sliders for the mask control
points. For more information on working with mask attributes, see Mask Parameters.

• Shape: Appears when a shape layer is selected and contains all of the controls that
affect the shape. This tab is divided into four panes: Style, Stroke, Advanced, and
Geometry.

• Style: Contains controls to modify the fill and outline of a shape, including changing
the brush type for an outline or paint stroke.

• Stroke: Once a paint stroke has been created using the Paint Stroke tool, or the Brush
Type for a shape outline is set to Airbrush or Image, the Stroke pane becomes
available. Use these controls to set the stroke color and brush scale, to adjust the
opacity, spacing, width, and other parameters.
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• Advanced: Contains controls that allow the dabs of a paint stroke to be animated
like particles.

• Geometry: Contains controls that allow you to change the shape type, to close or
open a shape, and to individually adjust the position of a shape’s control points using
value sliders. For more information on working with shapes, see Using Shapes, Masks,
and Paint Strokes.

• Emitter: Appears when a particle emitter is selected. The parameters in this tab control
all aspects of the emitter, such as the emitter shape, space (2D or 3D), angle, and range.
This tab also provides access to cell controls. For emitters with multiple cells, these
controls affect all cells. For more information on using particles, see Working with
Particles.

• Particle Cell: Appears when a particle cell is selected. Particle cells can only be selected
in the Layers tab or Timeline layers list. This tab contains controls for attributes such
as birth rate, speed, angle, and color.

• Replicator: Appears when a replicator is selected. Replicators can only be selected in
the Layers tab or Timeline layers list. This tab contains controls for attributes such as
replicator shape, space (2D or 3D), pattern, size, and cell controls. For more information
on using the replicator, see Using the Replicator.

• Replicator Cell: Appears when a replicator cell is selected. Replicator cells can only be
selected in the Layers tab or Timeline layers list.

• Generator: Displays the parameters and attributes of the selected generator, such as
the Center, Size, and Intensity parameters of a Lens Flare generator. The specific
parameters listed depend on the selected generator. For more information on
generators, see Working with Generators.

Locking the Inspector
The Inspector typically changes dynamically based on the object that is selected. However,
sometimes you want to select another object while you continue looking at the parameters
for the current object. When you lock the Inspector, it does not change based on your
selection.

To lock the Inspector
Do one of the following:

µ Click the lock icon in the upper-right corner of the Preview area of the Inspector.
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µ Choose Window > Create Locked Inspector.

To unlock the Inspector
Do one of the following:

µ Click the unlocked lock icon in the upper-right corner of the Preview area of the Inspector.

µ Choose Window > Create Unlocked Inspector.

Toolbar
Motion’s Toolbar is located at the top of the main window. The default set of controls
provides access to all of the tools you need for manipulating objects in the Canvas and
elsewhere in the application. There are tools that create new text layers, shape layers,
and masks. There are also icons to apply filters and behaviors, and to create particle
systems and replicators. Finally, there are icons to show and hide the various windows
and panes of the Motion interface such as the Timeline, HUD, and others.

Tool Groups
Tools are grouped in different ways. Several tools have multiple modes or options, such
as Shape tools that can be set to Rectangle, Circle, or Line. The Circle and Line tools are
hidden until you click the Shape tool and hold down the mouse button, invoking a pop-up
list of additional tool states. Tools with additional states (subtools) are indicated with a
tiny downward arrow in the lower-right corner of the tool.

Arrow indicates hidden 
tool states.

Tools are also grouped into categories of use. The first set is called the View tools because
they deal with changing the view and manipulation method in the Canvas. The second
set is called Create tools, because they add new content to the project, such as text and
shapes. The Mask set contains tools that add a mask to an existing layer or group.
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On the top-right side of the Toolbar is a series of icons that adjust the Motion interface.
These controls hide and show the various panes, tabs, and windows that comprise the
Motion interface.

The following tables itemize each of the tools in the default tool set, by group. The first
group is the View set. Once you have selected a tool and an object in the Canvas, you
can switch between tools by pressing the Tab key. Press Shift-Tab to cycle through the
tools in the reverse order.

View Tools
The View tools enable you to adjust and manipulate objects in the Canvas. The first button
in this group activates eight subtools. Click this button and hold down the mouse button
to see a pop-up list of all the subtools.

Description
Keyboard
shortcutTool nameButton

Select/Transform tool is the default. This tool
selects and moves objects in the Canvas. You can
scale objects by dragging their corner points or
rotate an object by dragging its center point.
If you have another tool selected, such as a mask
tool, pressing the S key selects the previous tool
option selected in the Select/Transform tools. If
you are using the Adjust 3D Transform tool, press
Shift-S to choose the Select/Transform tool.

S (Press Tab to
cycle through
tools. An
object must be
selected in
order to tab
through the
tools.)

Select/Transform
tool (arrow)

Changes the point around which an object scales
or rotates. To use it, drag the current anchor point
to a new position.

S (Press Tab to
cycle through
tools.)

Adjust Anchor
Point tool

Distorts an object by moving two adjacent corners
at the same time, leaving the other two corners
locked into place.

S (Press Tab to
cycle through
tools.)

Adjust Shear
tool

Changes the direction and offset of an object’s
drop shadow. This tool never moves the object
itself.

S (Press Tab to
cycle through
tools.)

Adjust Drop
Shadow tool

Allows you to distort an object by moving one of
the corner points, leaving the other three corners
locked into place. The image is stretched and
distorted to fit the shape you create.

S (Press Tab to
cycle through
tools.)

Adjust Four
Corner tool

Allows you to hide portions of an object by
dragging the edge or corner of the object.

S (Press Tab to
cycle through
tools.)

Adjust Crop
tool

Allows you to modify points and Bezier handles
for masks, shapes, and motion paths.

S (Press Tab to
cycle through
tools.)

Adjust Control
Points tool
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Description
Keyboard
shortcutTool nameButton

Available when a text object is selected, allows
you to modify the position and X, Y, or Z rotation
for individual characters (glyphs) in a text object.

S (Press Tab to
cycle through
tools.)

Adjust Glyph
tool

A contextual tool that allows you to modify special
controls such as the center point of a Circle Blur,
or the shape of a particle emitter or replicator, or
the start and end points of a gradient.

S (Press Tab to
cycle through
tools.)

Adjust Item
tool

Allows you to manipulate objects in 3D space
using 3D transform and rotation manipulators. To
return to 2D controls, click the Select/Transform
tool. To display rotational controls in the Canvas,
press the Command key.

QAdjust 3D
Transform tool

Allows you to drag your view of the Canvas in
different directions. The Pan tool never moves
individual objects. To reset the pan, double-click
the Pan tool. To pan the Canvas without selecting
the Pan tool, press the Space bar and drag in the
Canvas.

HPan tool

Allows you to zoom in and out on the Canvas.
Click the point in the Canvas that you want to
zoom toward or away from and drag to the right
to zoom in or drag left to zoom out. To reset the
zoom, double-click the Zoom tool. To zoom into
a specific area of the Canvas, press
Command-Space bar (in that order) and drag an
area of the Canvas. While still pressing the keys,
click to zoom in to the Canvas in 50 percent
increments of the current zoom level. Press Space
bar-Command-Option (in that order) and click in
the Canvas to zoom out in 50 percent increments.

ZZoom tool

Allows you to navigate through your scene as if
you are walking with the camera. Click the Walk
Camera icon, then use the Up Arrow, Down Arrow,
Right Arrow, and Left Arrow keys to navigate.

NoneWalk Camera
tool

Create Tools
The Create tools generate new layers. You can modify the attributes for the newly created
layers in the Inspector. The first button in each group activates any available subtools.
Click this button and hold down the mouse button to see a pop-up list of all the subtools
for that group.
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Description
Keyboard
shortcutTool nameButton

Creates a new rectangle shape in the Canvas and
adds a shape layer to the Layers tab. Click at the
position where you want one corner to appear
and drag to the position of the opposite corner.
Pressing Shift while you drag constrains the layer
to a square.

RRectangle tool

Creates a new circle shape in the Canvas and adds
a shape layer to the Layers tab. Click at the
position where one edge of the circle should begin
and drag toward the opposite edge. Pressing Shift
while you drag constrains the shape to a circle.

CCircle tool

Creates a new line shape in the Canvas and adds
a shape layer to the Layers tab. Click at the
position where one end of the line should begin
and drag toward the opposite end. Pressing the
Shift key while you drag constrains the line to
specific angles.

NoneLine tool

Creates a new freeform shape with Bezier point
vertices. To create a shape, click repeatedly in the
Canvas to add points to your shape. To close the
shape, click the first point of the shape or press
the C key. To create an open-ended shape,
double-click the last point.

B (Switches
Bezier/B-Spline
tool.)

Bezier tool

Creates a new freeform shape with B-Spline
vertices. To create a shape, click repeatedly in the
Canvas to add points to your shape. To close the
shape, click the first point of the shape or press C.
To create an open-ended shape, double-click the
last point.

B (Switches
Bezier/B-Spline
tool.)

B-Spline tool

Creates shape-based paint strokes. Click where
you want to start the stroke, then drag to create
the stroke. Command-drag to adjust the size of
the brush stroke before you create the stroke.

PPaint Stroke
tool

Creates new text and lets you edit the text of
existing text layers. To create a text layer, click the
tool in the Canvas at the position where you want
the text to appear, then begin typing. Choose the
Select/Transform tool (or press Esc) to grab or
move the new text layer. To change the text of an
existing text layer, select the Text tool, then click
the text. The text becomes editable.

TText tool
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Mask Tools
The Mask tools can only be accessed when a layer (a visible object in the Canvas, such
as an image or replicator) or 2D group is selected. Using a Mask tool creates a new mask
that hides portions of the selected layer. By default, the area inside the mask remains
visible. Masks have their own set of controls available in the Inspector. For more
information about masks, see Using Shapes, Masks, and Paint Strokes.

The first button in each group activates any available subtools. Click this button and hold
down the mouse button to see a pop-up list of all the subtools for that group.

Description
Keyboard
shortcutTool nameIcon

Creates a new rectangular mask in the Canvas.
Click at the position where you want one corner
to appear and drag to the position of the opposite
corner. Pressing the Shift key while you drag
constrains the mask to a square.

Option-RRectangle
Mask tool

Creates a new circular mask in the Canvas. Click
at the position where one edge of the mask should
begin and drag toward the opposite edge.
Pressing the Shift key while dragging constrains
the mask to a circle.

Option-CCircle Mask
tool

Creates a freeform mask in the shape that you
draw. Drag to create the freeform shape. The
shape automatically closes the mask between the
first and last points.

NoneFreehand Mask
tool

Creates a new freeform mask with Bezier point
vertices. To create a mask, click repeatedly in the
Canvas to add points to your mask. To close the
mask, click the first point of the mask or press C.
To create an open-ended mask, double-click the
last point.

Option-B
(Switches
Bezier/B-Spline
Mask tools.)

Bezier Mask
tool

Creates a new freeform mask with B-Spline
vertices. To create a mask, click repeatedly in the
Canvas to add points to your mask. To close the
mask, click the first point of the shape or press C.
To create an open-ended shape, double-click the
last point.

Option-B
(Switches
Bezier/B-Spline
Mask tools.)

B-Spline Mask
tool

Camera and Effects Icons
The first icon on the right side of the Toolbar adds a new camera to a project. The next
four icons make up the effects controls. These are special controls providing instant access
to the most common effects. Because these controls apply effects to existing objects,
they are not available unless an object is selected.
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DescriptionIcon nameIcon

Adds a new camera to the workspace. When you
add a camera to a 2D project, a dialog appears
asking if you want to convert your 2D groups to
3D groups. Although a camera can be added to a
2D project, the camera has no effect on a 2D
group.

New Camera

Activates a pop-up menu of behaviors. Choosing
an item from the menu applies that behavior to
the selected object(s). Objects to which behaviors
can be applied include layers (images, particle
emitters, and so on), groups, cameras, and lights.
Generally, a subset of the controls for the behavior
appear in the HUD; all of the controls appear in
the Inspector. When the Adjust Item tool is
selected, onscreen controls (if any) become
available for the behavior.

Add Behavior

Activates a pop-up menu of filters. Choosing an
item from the menu applies that filter to the
selected object. Filters can only be applied to
layers (images, text, shapes, particle emitters,
masks, replicators, generators, and so on). Filters
cannot be applied to cameras or lights. Most of
the controls for the filter appear in the HUD; all of
the controls appear in the Inspector. When the
Adjust Item tool is selected, onscreen controls (if
any) become available for the filter.

Add Filter

Uses the selected layer (shape, text, image, and
so on) as the source for a particle cell. The
originally selected layer is disabled. A subset of
the controls for the particle system appear in the
HUD; all of the controls appear in the Inspector.
When the Adjust Item tool is selected, onscreen
controls become available for the particle emitter
(except when Point is selected from the emitter
Shape pop-up menu).

Make Particles

Uses the selected layer (shape, text, image, and
so on) as a source cell for the replicator. The
originally selected layer is disabled. A subset of
the controls for the replicator appear in the HUD;
all of the controls appear in the Inspector. When
the Adjust Item tool is selected, the replicator
onscreen controls become available.

Replicate

Interface Icons
The interface icons on the far right of the Toolbar provide access to the main elements
of the Motion interface. Click any of these icons to show or hide the corresponding
window, tab, or pane.
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Description
Keyboard
shortcutIcon nameIcon

F7 turns display of the HUD on and off. If the HUD
is not displayed, press D. Once the HUD is
displayed, pressing D cycles through the HUDs for
the selected object.

F7, DHUD

Shows/hides the File Browser. Hides and shows
the utility window if the File Browser is the only
open tab.

Command-1File Browser

Shows/hides the Library. Hides and shows the
utility window if the Library is the only open tab.

Command-2Library

Shows/hides the Inspector. Hides and shows the
utility window if the Inspector is the only open
tab.

Command-3Inspector

Shows/hides the Project pane.F5Project Pane

Shows/hides the Timing pane.F6Timing Pane

Customizing the Toolbar
You have many options for personalizing the Toolbar. You can change which controls
appear on the Toolbar as well as the order in which they appear. You can put spaces and
separators between the tools to group them to your liking. You can view all of the controls
as icons, icons with a text description, or just as text.

To add controls to the Toolbar
1 Do one of the following to display the Customize Toolbar dialog:

• Choose View > Customize Toolbar.

• Control-click the Toolbar, then choose Customize Toolbar from the shortcut menu.

2 Drag the buttons or icons you want to add to the position of your choice in the Toolbar.

3 Click the Done button to close the dialog.

To remove an item from the Toolbar
µ Control-click the button or icon you want to remove, then choose Remove Item from the

shortcut menu.

Note: You can also remove items from the Toolbar when the Customize Toolbar dialog
is open by dragging the items away from the Toolbar and releasing the mouse button.
A “poof” animation appears to indicate that the button has been removed.
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Spaces and Separators
In addition to adding and arranging controls in the Toolbar, you can add spaces, flexible
spaces, and separators to arrange and group the contents of your Toolbar.

• Separator: A separator adds a dotted vertical line between two controls. The separator
has no function other than as an organizational tool. The default layout uses a separator
between the effects icons and the interface icons.

• Space: A space adds a single icon’s width of space between other controls.

• Flexible Space: A flexible space distributes controls evenly across the Toolbar, taking
up as much or as little space as needed to fill the empty parts of the bar. The default
layout has a flexible space between the Mask tools and the Effects icons.

Additional Buttons and Icons
The Customize Toolbar dialog provides access to additional icons that are not present in
the default set.

DescriptionIcon nameButton

Opens the Customize Toolbar dialog.Customize

Opens the Colors window.Colors

Opens the Mac OS X Font panel. You can also
browse fonts within the Motion Library. For more
information, see Using the Library Font Preview.

Fonts

Opens a menu from which you can select any
generator and add it to the project.

New Generator

Adds a new light to the project, visible in the 3D
workspace.

New Light

Shows or hides the Layers tab in the Project pane.Layers
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DescriptionIcon nameButton

Shows or hides the Media tab in the Project pane.Media

Shows or hides the Audio tab in the Project pane.Audio

Shows or hides the Timeline in the Timing pane.Timeline

Shows or hides the Keyframe Editor in the Timing
pane.

Keyframe Editor

Shows or hides the Audio Editor in the Timing
pane.

Audio Editor

Opens the Template Browser. For more
information on using the Template Browser, see
Creating New Projects from Templates.

Template Browser

When you have an additional monitor connected
to your system, clicking this icon automatically
sends output to the external monitor. Clicking it
again turns off output to the additional monitor.
Without using this icon, you must choose Motion
> Preferences (or press Command-Comma) and
change the Output settings.

External Video On

When you have an additional monitor connected
to your system, clicking this icon turns off output
to the additional monitor. Without using this icon,
you must choose Motion > Preferences (or press
Command-Comma) and change the Output
settings.

External Video Off

Changing the Icon View
The Toolbar controls can be viewed as icons, text, or both. By default, both names and
icons are displayed. Once you get familiar with the icons, you can choose to hide the
names to save desktop space. Alternately, go with just the names to save the most space.

To change the view in the Toolbar
Do one of the following:

µ Control-click the Toolbar, then choose an option from the shortcut menu.
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µ Choose an option from the Show pop-up menu in the lower-left corner of the Customize
Toolbar dialog.

Icon & Text

Icon Only

Text Only

Hiding the Toolbar
Once you get familiar with the common controls and the keyboard shortcuts, you may
want to hide the Toolbar altogether to simplify the interface and provide more room for
the Canvas.

To hide the Toolbar
Do one of the following:

µ Click the Toolbar button in the upper-right corner of the main window.

µ Choose View > Hide Toolbar.

µ Press Command-Option-T.

Toolbar button

If the Toolbar is currently hidden, these same controls all show the Toolbar instead of
hiding it.

Canvas
The majority of your screen is occupied by your main work area, the Canvas. This is similar
to the document window in many other applications. It is here that you arrange and lay
out the layers that comprise your composite. Adding layers and effects to your project is
as simple as dragging them from the utility window to the Canvas.
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When you want to watch your project play back, the transport controls at the bottom of
this window (below the Canvas) allow you to play your project at regular speed or frame
by frame. The mini-Timeline lies just above the transport controls and below the main
body of the window. This control provides a view of where selected layers in the Canvas
begin and end in time.

Mini-Timeline Transport controls

Whatever you see in the Canvas reflects exactly what you get when you export or output
your project. However, this window is not just a place to view the results of your work;
this is where you modify and arrange the elements of your project.

You can directly manipulate the items in the Canvas to modify physical attributes such
as position, scale, and rotation, or use familiar drag-and-drop techniques to apply behaviors
or filters directly to the items in the Canvas. See Using Behaviors and Using Filters to learn
more about how to use these features.

Canvas Shortcut Menu
The Canvas has its own shortcut menu that allows you to access some tools you may
need while working in the Canvas.
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To use the Canvas shortcut menu
µ Control-click an empty area of the Canvas (in the gray area outside of the actual project)

and choose an option from the shortcut menu:

• New Group: Adds a new group to the project above any existing groups in the Layers
tab.

• Import: Opens the Import dialog, which allows you to import files from the Finder.

• Paste: Pastes any item that has been copied to the Clipboard into a new group in the
project. The new group is added above any existing groups in the Layers tab.

• Project Properties: Opens the Project Properties dialog, which allows you to modify the
project’s background color, aspect ratio, field rendering, motion blur, and so on. For
more information on the Project Properties dialog, see Creating Blank Projects from
Project Presets.

Status Bar
A Status Bar appears at the top-left of the Canvas, below the Toolbar, and provides
information about your project. There are three types of information that can be displayed
here: color, coordinates, and frame rate.

Status Bar

Color
Some motion graphics projects may require you to match or align different colors in your
project. The Status Bar can provide visual and numerical information on the color of the
pixel currently under the pointer, as well as the value of the alpha channel. No clicking
is necessary—as you move the pointer, the Status Bar updates.

To display the current pixel color in the Status Bar
µ Control-click the Status Bar, choose Color from the shortcut menu, then position the

pointer over the Canvas.
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This procedure allows you to see the exact color and alpha values of the examined pixel.
You can view the color numerically in one of three formats:

• RGBA: The red, green, blue, and alpha components of the color are represented in
values from 0–255.

• RGBA (percent): The red, green, blue, and alpha components of the color are represented
in values from 1–100.

• HSV: The hue is represented from 1–360, and the saturation and value (luminance) are
represented in values from 1–100.

To choose between viewing color in RGB, RGB (percent), and HSV
µ Control-click the Status Bar, then choose the color space option you want from the

shortcut menu.

Note: Color must be enabled in the Status Bar to choose a color space.

Coordinates
For precision placement of objects in the Canvas, it may be helpful to know the exact
pixel position of the pointer at any given time. The Status Bar can display this information
in an X and Y coordinate system (Cartesian). The center point of the Canvas is 0,0.

To display the current pointer position in the Status Bar
µ Control-click the Status Bar, then choose Coordinates from the shortcut menu.

Frame Rate
Part of the way Motion plays back your project in real time is by lowering the frame rate
when the sequence is too complex to render at full speed. You can monitor the current
frame rate in the Status Bar. It is measured in frames per second (fps).

Note: This number only appears while the project is playing.

To monitor the project’s playback frame rate
µ Control-click the Status Bar, then choose Frame Rate from the shortcut menu.

56 Chapter 2 The Motion Interface



You can also turn the Status Bar items on and off in the Appearance Preferences pane.
To display Motion Preferences, choose Motion > Preferences.

Canvas View Options
This section discusses the various ways to view the Canvas using the view options menus
just above the top-right corner of the Canvas.

View options

Zoom Level pop-up menu: The Zoom Level pop-up menu offers several different default
zoom levels. Zooming the Canvas does not actually change the size of the images in your
project. It merely changes the current view of the entire window.

You can choose to set the view to percentages of 12, 25, 50, 100, 200, 400, 800, or 1600,
or to Fit In Window.

For more information on zooming in and out of the Canvas, see Canvas Zoom Level.

Render View and Overlay

Zoom Level

Channels

View Layouts

Channels pop-up menu: The Channels pop-up menu controls which color channels are
displayed in the Canvas. You can use this menu to view a single color channel in the
Canvas, to examine layers’ alpha channels, or to manipulate effects that affect only a
single color channel. This menu displays the following options:

• Color: Shows the image just as it would appear on a video monitor. Visible layers
appear in natural color and transparent areas reveal the background color as set in the
Project Properties dialog. This is black by default. To change the project background
color, choose Edit > Project Properties (or press Command-J), then click or Control-click
the Background Color well.
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Note: The Background pop-up menu in the General tab of the Project Properties dialog
must be set to Solid in order to export the background color with the project. This
option creates a solid alpha channel on export (when exporting using a codec that
supports alpha channels). When the Background pop-up menu is set to Transparent,
the color is visible in the Canvas, but does not render as part of the alpha channel.

• Transparent: Shows the background area of the Canvas as transparent. A checkerboard
pattern appears by default where no images block the background.

• Alpha Overlay: Displays the image in normal color, but adds a red highlight over
transparent areas of the image.

• RGB Only: Displays the normal mix of red, green, and blue channels but displays
transparent areas (including semi-transparent areas) as opaque.

• Red: Displays only the red channel as a range of black to white.

• Green: Displays only the green channel as a range of black to white.

• Blue: Displays only the blue channel as a range of black to white.

• Alpha: Displays the alpha (transparency) channel of the layers in the Canvas.

• Inverted Alpha: Displays an inverted view of the alpha (transparency) channel.

Render pop-up menu: The Render pop-up menu controls the quality and resolution of
the Canvas display, as well as facilitating the enabling/disabling of certain features that
can significantly impact playback performance.

If you have a complex project that is causing your computer to play at a very low frame
rate, you can make changes in this menu to reduce the strain on the processor. This frees
you from waiting for the image to be rendered at full resolution each time you make an
adjustment, allowing you to watch complex projects at high frame rates while you’re
constructing projects.

Note: These options are also available in the View pull-down menu (View > Resolution,
Quality, or Render Options).

The Render pop-up menu displays the following options:

• Full: Displays the Canvas at full resolution.

• Half: Displays the Canvas at half resolution.

• Third: Displays the Canvas at one-third resolution.

• Quarter: Displays the Canvas at one-quarter resolution.

• Draft: Renders objects in the Canvas at a lower quality to allow optimal project
interactivity. There is no antialiasing, and 32-bit (floating point) footage is truncated to
8-bit.

Tip: When working in your project, work in Draft or Normal for better interactivity.
When you are ready to export your project, use Best or Custom.
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• Normal: The default setting, renders objects in the Canvas at a medium quality. Shapes
are antialiased, but 3D intersections are not. Floating point (32-bit) footage is truncated
to 8-bit.

• Best: Renders objects in the Canvas at best quality, which includes higher quality image
resampling, antialiased intersections, and antialiased particle edges. If the project
contains any floating point QuickTime images, the floating point versions of those files
are loaded and rendered in float. This option slows down project interactivity.

For more information on float space, see About Bit Depth.

• Custom: Allows you to set a variety of additional controls to customize render quality.
Choosing Custom opens the Advanced Quality Options dialog. For information on the
settings in the Advanced Quality Options dialog, see Advanced Quality Settings.

Note: 10-bit YUV (Y′CBCR) files render at 8-bit in the Canvas unless render quality is set
to Best.

Tip: When exporting a project using the “Movie - current project and canvas settings”
option (from the Use pop-up menu in the Export dialog), set Render Quality to Best
prior to exporting.

• Lighting: Turns the effect of lights in a project on or off. This setting does not turn off
lights in the Layers tab (or light scene icons), but it disables light shading effects in the
Canvas.

When this setting is selected and you are using a default export preset (such as DV
NTSC Movie), your project is exported with lighting. This is because export presets are
exported with the “Use current project and canvas settings” option selected by default
(in the Output tab of the Export Options dialog). When this checkbox is selected,
whatever is enabled in the View pop-up menu is also exported.

For information on overriding current project settings for lighting on export, see
Overriding Project Settings Selected in the Render Pop-Up Menu.

• Shadows: Turns the effect of shadows in a project on or off.

For information on overriding current project settings for shadows on export, see
Overriding Project Settings Selected in the Render Pop-Up Menu.

• Reflections: Turns the effect of reflections in a project on or off.

For information on overriding current project settings for reflections on export, see
Overriding Project Settings Selected in the Render Pop-Up Menu.

• Depth of Field: Turns the effect of depth of field in a project on or off.

For information on overriding current project settings for depth of field on export, see
Overriding Project Settings Selected in the Render Pop-Up Menu.

• Motion Blur: Turning this setting off disables the preview of motion blur in the Canvas.
This may result in a performance improvement.
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When Motion Blur is enabled in the View pull-down menu (View > Render Options >
Motion Blur) and you are using the default export preset (“Movie - current project and
canvas settings”), your project is exported with motion blur. (The default codec used
is Apple ProRes 4444.) When this default setting is used, any options chosen in the
View pop-up menu (or the View pull-down menu), as well as settings in the Project
Properties dialog, are exported.

However, if you choose any another preset, motion blur is disabled and must be
manually enabled. For example, if you choose DV NTSC Movie, motion blur is disabled.
You can override a preset’s settings, as described below.

Note: When opening a Motion project in another application such as Final Cut Pro,
Motion Blur in the View pop-up menu controls whether or not motion blur is applied.

For information on overriding current project settings for motion blur on export, see
Overriding Project Settings Selected in the Render Pop-Up Menu.

• Field Rendering: Turning this setting off disables field rendering, which is required for
smooth motion playback on a TV monitor. Field rendering nearly doubles rendering
time, so disabling this item will typically result in a significant performance improvement.

When Field Rendering is enabled in the View menu and you are using the default export
preset (“Movie - current project and canvas settings”), your project is exported with
field rendering. (The default codec used is Apple ProRes 4444.) When this default setting
is used, any options chosen in the View pop-up menu (or the View pull-down menu),
as well as settings in the Project Properties dialog, are exported.

However, if you choose another preset, field rendering is enabled based on the selected
preset itself (whether that particular codec requires fields). For example, if you choose
DV NTSC Movie, field rendering is enabled because fields are expected. If you choose
DVCPRO HD 720p24 Movie, field rendering is disabled because it is a progressive-scan
(no fields) movie format.

Note: When opening a Motion project in another application such as Final Cut Pro or
DVD Studio Pro, the Field Rendering setting in the View pop-up menu does not control
whether field rendering is applied or not. This is controlled in the Project Properties
dialog (press Command-J). When Field Order is set to anything other than None, field
rendering is used in the other application, regardless of the Field Rendering status in
the View pop-up menu.

For information on overriding current project settings for field rendering on export,
see Overriding Project Settings Selected in the Render Pop-Up Menu.

• Frame Blending: Turning this setting off disables frame blending in the Canvas. Frame
blending can smooth the appearance of video frames by interpolating the pixels
between two adjacent frames to create a smoother transition.
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When this setting is turned on in the View menu and you are using the default export
preset (“Movie - current project and canvas settings”), your project is exported with
frame blending. (The default codec used is Apple ProRes 4444.) When this default
setting is used, any options chosen in the View pop-up menu (or the View pull-down
menu), as well as settings in the Project Properties dialog, are exported.

However, if you choose any other preset, frame blending is enabled based on the
selected preset. For example, if you choose DV NTSC Movie, frame blending is enabled.

For information on overriding current project settings for frame blending on export,
see Overriding Project Settings Selected in the Render Pop-Up Menu.

• Preview for Float Bit Depth: When working in float space, turning this setting off drops
the preview in the Canvas to 8-bit. Because working in float space drastically increases
processing time, turn this setting off to speed your workflow. This setting does not
modify the actual output of the project.

Note: For more information on float space, see About Bit Depth.

View and Overlay pop-up menu: The View and Overlay pop-up menu provides access
to the various types of guides and controls that can be viewed in the Canvas. When an
option is active, a checkmark appears beside the menu item.

Note: These options are also available in the View pull-down menu.

• Show Overlays: Turns the display of all overlays in the Canvas on or off. This setting
must be on in order to view any of the other overlay items (grids, guides, and so on).
To turn the camera overlays on or off, use Show 3D Overlays.

Note: You can also press Command-Slash (/).

• Rulers: Turns display of the rulers along the edge of the Canvas on or off. You can
specify where the rulers appear in the Canvas section of Motion Preferences. For more
information on using rulers, see Canvas Rulers.

Note: You can also press Command-Shift-R.

• Grid: Turns a grid display on and off over the Canvas. You can set the spacing and color
of the grid in the Canvas section of Motion Preferences.

Note: You can also press Command-Apostrophe (’).

• Guides: Turns display of manually created guides on and off. Guides can only be created
if rulers are also displayed. You can change the color of the guides in the Canvas pane
of Motion Preferences.

Note: You can also press Command-Semicolon (;).

• Dynamic Guides: Turns display of automatic dynamic guides on and off. These guides
appear when dragging a layer past edges of other layers. You can change the color of
the dynamic guides in the Canvas pane of Motion Preferences.

Note: You can also press Command-Shift-Colon (:).
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• Safe Zones: Turns display of the title safe and action safe guides on and off. By default,
these guides are set at 80% and 90%. You can change these settings and the color of
the guides in the Canvas pane of Motion Preferences.

Note: You can also press the Apostrophe key (’).

• Film Zone: Turns display of the film aspect ratio guides on and off. This can be helpful
if you are creating a project for videotape that is to be transferred to film. You can
change the size of the guides as well as their color in the Canvas pane of Motion
Preferences.

Note: You can also press Shift-Quotation Mark (”).

• Handles: Turns display of object handles in the Canvas on and off. Viewing object
handles is necessary to perform certain onscreen transformations, such as resizing.
Handles only appear on selected objects.

• Lines: Turns display of the lines that outline an object on and off.

• Animation Path: Turns animation paths on and off. These editable paths indicate the
route along which animated objects travel. If the selected object is not positionally
animated, this command does not appear to have any effect. If handles are not
displayed, the path curves cannot be adjusted in the Canvas. Animation paths created
by behaviors, with the exception of the Motion Path behavior, are for display only and
are not editable.

• Show 3D Overlays: Turns all 3D overlays in the Canvas on and off, including Camera
overlays, 3D View Tools, Compass, Inset view, 3D grid, and 3D scene icons. (3D overlays
appear only in projects that contain 3D groups.)

Note: You can also press Command-Option-Slash (/).

• 3D View Tools: Turns the Camera menu and 3D View tools in the Canvas on and off.

Camera menu 3D View tools

Pan Dolly

Orbit

Editing 
camera

• Compass: Turns the 3D Compass in the Canvas on and off. Using red, green, and blue
axes, the compass shows your current orientation in 3D space. The red axis is X
(horizontal), the green axis is Y (vertical), and the blue axis is Z (depth).
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Holding the pointer over the 3D Compass exposes color-coded shortcuts to the reference
camera views. Click any of the colored view icons, such as Front, Left, Right, Perspective,
and so on to switch to that corresponding camera view. The Canvas animates as it
changes to the new view. For more information on working with the 3D Compass and
the different views, see Views.

3D Compass 3D Compass showing 
camera shortcuts

• Inset View: Turns the Inset view in the Canvas on and off. When enabled, a temporary
window appears in the lower-right corner of the Canvas displaying a Active Camera or
Perspective view of your project helping you stay oriented as you move objects in 3D
space. You can change the size of the Inset view, as well as control whether the Inset
view appears on transform changes, on all changes, or manually.

The Perspective view dynamically changes to fit the objects in the Inset view (even if
objects are no longer visible in the main window). This view is triggered when you are
already looking through the camera. The Active view is triggered when you are using
a camera view other than the active camera (such as Front). For more information on
the Inset view, see Inset View.

Inset view

Note: Because project elements are 2D (flat) objects, the elements are not visible when
you use orthogonal camera views (Left, Right, Top, and Bottom) unless the elements
are rotated in 3D space (or unless text, particles, or the replicator is using the Face
Camera parameter in its Inspector). This is because orthogonal views are at right angles
(perpendicular) to the elements. When an object is selected, a thin gray line represents
the object in the Canvas. For more information on using cameras, see Cameras.
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• 3D Grid: Turns the grid in the Canvas on and off. The 3D grid helps you stay oriented
and can be used to guide the placement of objects in your project. The 3D grid only
appears when you are in a 3D workspace.

• 3D Scene Icons: Turns the display of the cameras and lights in the Canvas on or off. The
scene icons appear in the Canvas as yellow wireframe icons. Lights appear with red
(X), green (Y), and blue (Z) adjust 3D handles that let you transform and rotate the light
object. The handles are still displayed when the 3D Scene Icons command is turned
off. For more information on the 3D scene icons, see 3D Scene Icons.

Light

Camera

• Correct for Aspect Ratio: Applies an artificial distortion of the Canvas in projects with
nonsquare pixels. When the setting is on, the computer monitor simulates what a TV
monitor displays. When the setting is off, projects with nonsquare pixels appear
stretched. This is because computer monitors have square pixels. This setting does not
modify the actual output of the project.
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• Show Full View Area: When enabled, this setting lets you see the portion of a layer that
extends beyond the edge of the Canvas. This setting is disabled by default, as it slows
your project’s interactivity.

• Use Drop Zones: Turns drop zones on and off. When turned on, a checkmark will appear
next to the menu item, and drop zones will accept objects dragged to them. When
turned off, drop zones will ignore objects dropped onto them. For more information
on using drop zones, see Drop Zones.

• Save View Defaults: Saves the current state of all the settings in this menu as the default
state for new projects.

View Layouts pop-up menu: This pop-up menu lets you specify how you want to view
your project in the Canvas. You can view the Canvas as a single workspace, or choose
from the available window arrangements in the menu. The following examples show two
of the available window arrangements.

Note: Although the different workspace views are available for 2D projects, they are most
useful when working in 3D space.

Two top windows; one lower window arrangement Four windows arrangement

• Single: The default value, displays a single window in the Canvas.
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• Two-up, side by side: Displays two windows in the Canvas, one next to the other.

• Two-up, top and bottom: Displays two windows in the Canvas, one on top of the other.

• Three-up, large window below: Displays three windows, two next to each other on top
and a larger window below.

• Three-up, large window right: Displays three windows, two stacked on the left side and
a larger window spanning the right side.

• Four-up, large window right: Displays four windows, three stacked on the left side and
one larger window on the right side.

• Four-up: Displays four windows, all the same size.

Advanced Quality Settings
When the Canvas view quality is set to Custom in the Quality section of the Render pop-up
menu (or in the View > Quality pull-down menu), the Advanced Quality Options dialog
opens.

The Advanced Quality Options dialog provides additional controls to fine-tune your
rendering performance and quality.

Quality: A pop-up menu that sets the quality to Draft, Normal, Best, or Custom. These
options are identical to the Quality settings in the Render pop-up menu.

For more information on the Render popup menu, see Canvas View Options.

• Draft: When Draft is selected from the Quality pop-up menu, none of the quality options
are turned on, and Text Quality is set to Low. This option allows optimal project
interactivity.

• Normal: When Normal is selected from the Quality pop-up menu, “Shape antialiasing”
is turned on and Text Quality is set to Medium. This option allows project interactivity
that is slower than Draft, but much faster than Best.

• Best: When Best is selected from the Quality pop-up menu, “High quality image
resampling,” “Shape antialiasing,” and “Antialias 3D intersections” are turned on. Text
render quality is set to High. Additionally, if the project contains any floating point
QuickTime images, the floating point versions of those files are loaded and rendered
in float space. This option slows down project interactivity.
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• Custom: Whereas Draft, Normal, and Best automatically define the render quality
settings, Custom allows you to pick and choose the individual quality settings in the
Advanced Quality Options dialog.

High Quality Resampling: Turns on high-quality resampling.

Text Quality: Sets text render quality to Low, Medium, or High. When High is selected,
it may slow down project interactivity.

Shape antialiasing: Renders shapes at a higher resolution, then scales objects back to
regular resolution to ensure smooth edges.

Antialias 3D intersections: Renders objects intersecting in 3D space at a higher resolution,
then scales objects back to regular resolution to ensure smooth edges.

Use floating-point footage when necessary: Floating point versions (if any exist in the
project) of floating point QuickTime images are loaded and rendered in float space. This
option slows down project interactivity.

Overriding Project Settings Selected in the Render Pop-Up Menu
Lighting, shadows, reflections, depth of field, field rendering, motion blur, and frame
blending severely impact rendering time. The options selected in the Render pop-up
menu are exported with your project when using the default export presets (“Movie -
current project and canvas settings”). These effects can be turned off temporarily while
exporting. This section describes how to override these settings.

To override the current project settings during export
1 Choose File > Export.

2 Optional: Select a name and location for the saved file.

3 In the Export dialog, click the Options button next to the Export pop-up menu.

4 In the Output tab of the Export Options dialog, deselect “Use current project and canvas
settings.”

Note: If you have already chosen another export preset from the Use pop-up menu in
the Export dialog, “Use current project and canvas settings” is deselected.

The options in the Output tab become available, including Resolution, Color, Frame Rate,
Camera, Lighting, Shadows, Reflections, Depth of Field, Render Quality, Field Rendering,
Motion Blur, and Frame Blending settings.

5 Select the settings you want enabled during the export, such as Lighting, Shadows,
Reflections, Frame Blending and so on.

The exported file will include the settings chosen here, but the Canvas will continue to
display only the settings chosen in the Render pop-up menu.

To override the current project settings for field rendering on export
1 Choose File > Export.
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2 Optional: Select a name and location for the saved file.

3 In the Export dialog, click the Options button next to the Export pop-up menu.

4 In the Output tab of the Export Options dialog, turn off “Use current project and canvas
settings.”

5 Deselect the Field Rendering checkbox.

Note: If you have already chosen another export preset from the Use pop-up menu in
the Export dialog, “Use current project and canvas settings” is turned off.

The options in the Output tab become available, including Resolution, Color, Frame Rate,
Camera, Lighting, Render Quality, Field Rendering, Motion Blur, and Frame Blending
settings.

When the Field Rendering checkbox is selected in the Output tab, the project is exported
with field rendering regardless of the Field Rendering status in the View pop-up menu.

To override the current project settings for motion blur on export
1 Choose File > Export.

2 Optional: Select a name and location for the saved file.

3 In the Export dialog, click the Options button next to the Export pop-up menu.

4 In the Output tab of the Export Options dialog, turn off “Use current project and canvas
settings.”

5 Deselect the Motion Blur checkbox.

Note: If you have already chosen another export preset from the Use pop-up menu in
the Export dialog, “Use current project and canvas settings” is turned off.

The options in the Output tab become available, including Resolution, Color, Frame Rate,
Camera, Lighting, Render Quality, Field Rendering, Motion Blur, and Frame Blending
settings.

When the Motion Blur checkbox is selected in the Output tab, the project is exported
with motion blur regardless of the Motion Blur status in the View pop-up menu.

To override the current project settings for frame blending on export
1 Choose File > Export.

2 Optional: Select a name and location for the saved file.

3 In the Export dialog, click the Options button next to the Export pop-up menu.

4 In the Output tab of the Export Options dialog, deselect “Use current project and canvas
settings.”

5 Deselect the Frame Blending checkbox.

Note: If you have already chosen another export preset from the Use pop-up menu in
the Export dialog, “Use current project and canvas settings” is deselected.
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The options in the Output tab become available, including Resolution, Color, Frame Rate,
Camera, Lighting, Render Quality, Field Rendering, Motion Blur, and Frame Blending
settings.

When the Frame Blending checkbox is selected in the Output tab, the project is exported
with frame blending regardless of the Frame Blending status in the View pop-up menu.

Canvas Zoom Level
You can zoom in on the Canvas to allow precision alignment and placement of objects,
and you can zoom out to get a sense of the big picture or to see the path of a moving
object. You can also use the dynamic zoom modes to quickly zoom in or out of the Canvas,
or to zoom specific areas of the Canvas. If you are using a Mac computer with a Multi-Touch
trackpad, you can pinch open to zoom in and pinch closed to zoom out.

Zooming the Canvas does not actually change the size of the images in your project. It
merely changes the current view of the entire window.

To zoom in or out on the Canvas
µ Choose a zoom level from the Zoom Level pop-up menu.

In the following image, 50% is chosen from the Zoom Level pop-up menu.

To use the dynamic zoom mode
µ Hold the Space bar and Command key (in that order), then drag diagonally in the Canvas.

The zoom occurs around the spot clicked in the Canvas.

To zoom in and out using a Multi-Touch trackpad
µ Place two fingers on the trackpad and move them closer together (“pinch closed”) to

zoom in or farther apart (“pinch open”) to zoom out.

Once zoomed in, you can use a two-finger swipe in any direction to scroll around.
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To zoom in and out of a specific area of the Canvas
µ Hold down the Space bar and Command key (in that order), then drag the area of the

Canvas you want to zoom. While still holding down the keys, click the mouse button to
zoom in 50 percent increments of the current zoom level. Press Space
bar-Command-Option (in that order), then click to zoom out in 50 percent increments of
the current zoom level.

Note: To pan the Canvas without selecting the Pan tool, hold down the Space bar and
drag in the Canvas.

To reset the Canvas Zoom level
Do one of the following:

µ Choose 100% from the Zoom Level pop-up menu.

µ In the Toolbar, double-click the Zoom tool (located between the Pan and Walk Camera
tools).

To reset the Canvas Pan
µ In the Toolbar, double-click the Pan tool.

To zoom the Canvas so that the entire viewable area of the project fills the window
µ Choose Fit In Window from the Zoom Level pop-up menu.

Canvas Rulers
Using rulers in the Canvas can help you compose or align the elements of your project,
as well as snap objects to the rulers.

To turn on rulers
µ In the View pop-up menu, enable Rulers (or press Command-Shift-R). When enabled, a

checkmark appears next to the item in the pop-up menu.

By default, rulers appear along the left and top sides of the Canvas. You can change the
location of the rulers in the Canvas pane of Motion Preferences.

To change the location of the rulers
1 Choose Motion > Preferences.

2 In the Canvas pane, choose a ruler layout from the Ruler Location pop-up menu.

To add a horizontal or vertical guide to the Canvas
1 In the Toolbar, click the Select/Transform tool (or press S).

2 Click in the gray area of the horizontal or vertical ruler, and drag into the Canvas.

As you drag, the value of the guide is displayed in the Canvas.
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Note: Guides must be enabled in the View menu (press Command-Semicolon) to display
the guides.

The ruler units are in pixels, with the 0,0 point in the center of the Canvas.

3 When the guide is in the location you want, release the mouse button.

To simultaneously add a horizontal and vertical guide to the Canvas
1 In the Toolbar, click the Select/Transform tool (or press S).

2 Drag from the corner in which the rulers meet into the Canvas.

3 When the guides are in the location you want, release the mouse button.

To remove a guide from the Canvas
µ In the Toolbar, click the Select/Transform tool (or press S), then drag the guide off the

Canvas.

To change the color of the guides
1 Choose Motion > Preferences.

2 In the Canvas pane, click or Control-click the Guide Color well, then select a color.
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Canvas in 3D Mode
In addition to the traditional 2D project workspace, Motion provides a 3D workspace in
which to arrange and animate objects, including groups, layers, cameras, and lights. When
you switch to 3D mode, additional controls become available in the Canvas that reflect
the new environment. A small set of 3D View tools appears in the upper-right corner of
the Canvas window, and a 3D Compass appears in the lower-left corner. The upper-left
corner of the Canvas contains the Camera menu, where you can choose which camera
to use to view your project in 3D space.

Note: You must add at least one camera to your project to create a 3D workspace.

To add a camera to your project
1 Click the New Camera icon in the Toolbar.

A dialog appears that prompts you to switch your 2D groups to 3D groups.

2 Click Switch to 3D to add a camera and create a 3D project.

If you click Keep as 2D, a camera is added to your project and all groups remain 2D groups.

Manipulating the 3D View
The 3D workspace provides tools for manually changing your view or viewing your scene
from a particular reference camera view, such as Front, Back, Top, Bottom, and so on. You
can also choose to view the scene through any of the cameras added to your project.

Note: The Left, Right, Top, and Bottom camera views are orthogonal views. You cannot
animate or export these views.

To set the current view
µ Click the Camera menu in the upper-left corner of the Canvas and choose a camera from

the menu. Motion animates your view change as it moves to the new view.

Camera menu

If you have modified the view, an asterisk appears next to the name of the camera view.

Note: If you isolate a layer or group (choose Object > Isolate), the Camera menu shows
the name of the isolated object as the current view. For more information on the Isolate
feature, see Layers Tab.
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To use the 3D View tools
µ Drag the Pan, Orbit, or Dolly tool from the 3D View tools.

Like a camera move, the view moves, rotates, or zooms.

DollyPan

Editing camera

Orbit

Important: The gray editing camera icon appears beside the 3D View tools when a
user-created scene camera is active. This icon is a reminder that when you use the 3D
View tools, you are moving the scene camera which will affect your export.

To reset your camera
Do one of the following:

µ Double-click the Pan, Orbit, or Dolly tool.

µ Click the Camera menu (in the upper-left corner of the Canvas) and choose Reset View.

µ In the Properties tab of the Inspector, click the Transform parameters reset button.

Manipulating Objects in 3D Space
The 3D workspace provides tools for manipulating objects in 3D space. These tools include
the 3D onscreen controls that directly manipulate the object, the 3D transform controls
in the HUD, and the parameters in the Properties tab for the selected object.

To transform an object in 3D space
1 Select the object that you want to transform and select the Adjust 3D Transform tool in

the Toolbar.
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Scale handles appear around the edge of the object, and three colored 3D axis handles
appear at the anchor point of the object. Each arrow-shaped handle corresponds to an
axis along which you can move the object.

3D axis handles appear 
as colored arrows.

2 Drag the appropriate transform handle, and the object moves along the selected axis.

The red axis is X (horizontal), the green axis is Y (vertical), and the blue axis is Z (depth).

To rotate an object in 3D space
1 Select the object that you want to transform and select the Adjust 3D Transform tool in

the Toolbar.

Scale handles appear around the edge of the object, and three colored 3D axis handles
appear at the anchor point of the object. The three small circles near the axis handles are
3D rotation handles. Each rotation handle corresponds to an axis around which you can
rotate the object.

2 Position the pointer over one of the three rotation handles on either side or above the
colored arrows.

• The red ring indicates rotation around the X axis.

• The green ring indicates rotation around the Y axis.

• The blue ring indicates rotation around the Z axis.

3 Once the 3D rotation handle is active, drag left or right in the Canvas to rotate the object
around the selected axis.

3D rotation handles help you find the right axis. As you rotate, a small info window displays 
the changed values.
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To reset a transformed object
1 Select the object you want to reset.

2 In the Properties tab of the Inspector, click the Transform parameters reset button.

Reset button

For more information on working in 3D and using the 3D transform tools in the HUD, see
3D Compositing.

Playing Your Project
Use the transport controls at the bottom of the Canvas to play your project and see how
it looks over time. You can set playback to loop as well as set playback to begin and end
on certain frames in your project. You can also turn audio on and off.

Go to start of project Go to next frame

Go to end of project Go to previous frame

Play from start Loop playback

Play/Pause

Play/Mute audioRecord

Play/Pause: Starts and stops playback. The keyboard shortcut is the Space bar.

Loop playback: Controls whether playback loops indefinitely, or whether playback stops
when the end of the play range is reached. The keyboard shortcut is Shift-L. For more
information on setting a project play range, see Defining the Play Range.

Play from start: Plays from the play range In point to the play range Out point. This allows
you to watch just a portion of the entire project. To learn how to define the In and Out
points, see Defining the Play Range.

Go to start of project: Automatically returns your playhead to the beginning of the
project. The keyboard shortcut is Home.

Go to end of project: Automatically moves the playhead to the end of the project. The
keyboard shortcut is End.

Go to previous frame: Moves the playhead backward by one frame. Clicking the button
(or holding down the shortcut key) rewinds the project one frame at a time. The keyboard
shortcut is the Left Arrow (or Page Up) key.

Note: If you are working on a Mac with a Multi-Touch trackpad, you can rotate left to go
to the previous frame.
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Go to next frame: Advances the playhead by one frame. Clicking the button (or holding
down the shortcut key) advances the project one frame at a time. The keyboard shortcut
is the Right Arrow (or Page Down) key.

Note: If you are working on a Mac with a Multi-Touch trackpad, you can rotate right to
go to the next frame.

Play/Mute audio: Turns audio playback on or off.

Note: Turning audio off may improve your playback performance.

Record: Enables or disables animation recording. When recording is enabled, the value
sliders for all animateable parameters appear with a pink tint in the Inspector. This is to
inform you that any change you make to a parameter (such as moving an object in the
Canvas or adjusting a slider) creates a keyframe.

Note: When “Record keyframes on animated parameters only” is selected in the Recording
Options dialog, keyframes are added only to parameters that are already animated. For
more information, see Recording Keyframes on Animated Parameters Only.

RAM Preview
When you play your project, Motion performs complex calculations to represent the
objects and effects that appear in each frame. This is called rendering. The project plays
back as quickly as possible up to the frame rate specified in the Project Properties dialog.
With a very complex project, the frame rate may be significantly reduced, making it
difficult to see how the project looks when it is played at full frame rate.

You can render parts of your project and store the frames in RAM. This lets you play back
your project and see it play at full frame rate. This is called RAM Preview. You can choose
to render the play range, a selection, or the entire project (All). As the frames are rendered,
a progress dialog appears and shows which frame is being rendered, how many more
frames remain, and an approximation of the time remaining.

You can interrupt the RAM Preview by clicking the Stop button. The section that has
already been rendered is stored in RAM.

Note: Because different sections of the project can be of differing complexities, the Time
remaining value may be somewhat inaccurate.

To RAM Preview your entire project
µ Choose Mark > RAM Preview > All.
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The RAM Preview dialog appears, and displays a progress bar. When the RAM Preview is
completed, the dialog closes.

When a section of your project is currently stored in RAM, the Timeline and the
mini-Timeline turn green to indicate which frames are stored.

RAM Preview indicators

RAM Previewing Regions
Previewing large sections of your project using RAM Preview requires large quantities of
RAM to store the frames. You may not have enough RAM to store all of the frames you
want to preview. You can restrict which frames are rendered either by choosing to preview
the play range or a selection. Using RAM Preview on a selection renders all visible layers
in the project from the first frame of the selection until the last.

To RAM Preview the play range
µ Choose Mark > RAM Preview > Play Range.

The RAM Preview dialog appears, and displays a progress bar. When the RAM Preview is
completed, the dialog closes.

To RAM Preview a selection
1 In the Timeline, Command-Option-drag the region you want to preview.

A light blue band appears over the selected frames.

For more information on regions, see Working with Regions.

2 Choose Mark > RAM Preview > Selection.

The RAM Preview dialog appears. When the RAM Preview is completed, the dialog closes.
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Note: Working in 32-bit float color space has no effect on your RAM Preview. Although
the project is rendered in float, the preview is down-converted to 8-bit for display on
your monitor.

Clearing the RAM Preview
You can manually delete the RAM Preview to make room for a new RAM Preview or to
free up RAM for other operations.

To clear the RAM Preview
µ Choose Mark > RAM Preview > Clear RAM Preview.

Mini-Timeline
The mini-Timeline lies just above the transport controls and below the Canvas. This control
provides an at-a-glance look at where selected objects fit into your overall project. The
mini-Timeline also has a playhead to indicate which frame you are viewing as well as In
and Out markers to identify the play range. The length of the mini-Timeline represents
the entire duration of the project.

Playhead Out pointIn point

Selected clip

You can drag the playhead through the mini-Timeline to scrub your project, or to jump
quickly to a particular point in time. You can also change the play range or layer In and
Out points by dragging the In and Out markers. When you drag an In or Out point, the
playhead temporarily moves along with the pointer. This allows you to see the frame
where your In or Out point will be set. When you release the mouse button, the playhead
snaps back to its previous position.

Project markers set in the Timeline are indicated in the mini-Timeline by a thin, green
line. For more information on project markers and object markers, see Adding Markers.

Note: Object markers do not appear in the mini-Timeline.

Editing in the Mini-Timeline
You can perform many nonlinear editing functions in the mini-Timeline. You can drag
objects (such as clips or images, or items that have been saved to the Library, such as
shapes, text, cameras, lights, and so on) from the utility window directly to the
mini-Timeline. You can also move, trim, and slip objects to change which portion of the
object appears at which point in time. For more information on editing functions such
as Move, Trim, and Slip, see Editing Objects in the Timeline.
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To add an object to the mini-Timeline
1 Drag the object from the File Browser to the mini-Timeline.

As you drag, a tooltip appears to indicate the frame where your edit will take place.

2 When you reach the desired frame, release the mouse button.

The object is added to the project beginning at that frame.

You can also add multiple objects to the mini-Timeline at once. You can choose to add
the objects sequentially (one after another) or as a composite (all at the same point in
time).

Tip: If the Timeline contains project markers, you can snap the imported object to a
marker. Drag the layer over the mini-Timeline, and release the mouse button when a
black bar appears at the snap point. The layer’s In point is the project marker.

To add multiple objects to the mini-Timeline
1 Drag the objects from the File Browser to the mini-Timeline.

As you drag, a tooltip appears to indicate the frame where your edit will take place.

2 Continuing to hold down the mouse button, drag to the desired frame.

A drop menu appears.

3 Choose the desired edit type from the drop menu, then release the mouse button.

Depending on the item that is dragged to the Timeline, up to four different drop options
are available. For more information on the Timeline drop menu, see Adding Objects to
the Track Area.

To move an object in time
1 In the Layers tab, Timeline layers list, or Canvas, select the object you want to move.

The object appears in the mini-Timeline.

2 In the mini-Timeline, drag the object to the left or right to reposition it in time.
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A tooltip appears to indicate the new In and Out point of the object, as well as the amount
of change from the previous position.

3 When you reach the position you want, release the mouse button.

To shorten or lengthen an object
1 Select the object to display it in the mini-Timeline.

2 Position the pointer over the beginning or ending edge of the object.

The pointer changes to a trim pointer.

Trim pointerStart of media

3 Drag the edge of the object to change its duration.

A tooltip appears to indicate the new In or Out point and the amount of change that
your edit is causing.

You cannot trim an object to be longer than the amount of frames available in the
corresponding media file unless its End Condition is set to Hold, Loop, or Ping Pong in
the Timing controls of the Properties tab of the Inspector.

To slip a video clip (or other multi-frame object) in the mini-Timeline
1 Select the multi-frame object you want to modify.

2 Position the pointer over the body of the clip in the mini-Timeline and press the Option
key.

The pointer changes to a slip pointer.

3 Drag the clip to the left or right to use a later or earlier part of the clip.

A tooltip appears to indicate the new In and Out points.

Slip pointerStart of media End of media
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Note: You cannot slip a clip unless it has been trimmed first. For more information, see
Slipping Objects.

To snap the playhead to a project marker in the mini-Timeline
µ Press Shift and drag the playhead in the mini-Timeline.

Timecode and Current Frame Fields
There are two timecode fields at the bottom of the Canvas, to the left and right of the
transport controls. The field to the left is the current frame field that shows the frame or
timecode number where the playhead is positioned. You can change the playhead position
by changing the number in the current frame field.

The field to the right is the project duration field. This field indicates the length of your
current project. You can modify the duration of the project by changing the number in
this field. When a semicolon appears between the seconds and frames values, it indicates
that timecode is being counted in the drop-frame format.

A semicolon in this 
position indicates 

drop-frame timecode.

Both fields can be modified in multiple ways and can be displayed either as incremental
frame numbers or as eight-digit timecode numbers.

To change the current frame or duration
µ Click the field, type a new number into the field, and then press Tab or Return to confirm

your entry.

To increase or decrease the current frame or duration one frame at a time
µ Click the left or right arrow for the field you want to change.

Left arrow

Right arrow

Value slider

Drag pointer

You can also move the playhead one frame at a time by pressing the Left Arrow key (or
Page Up key) to move forward, and the Right Arrow key (or Page Down key) to move
backward.
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To change the duration in seconds, minutes, or hours, type the following in the project
duration field

µ To set the duration in seconds, type the number of seconds followed by a period. For
example, to create a 10-second project, type “10.” (10 followed by a period) in the field,
then press Return.

µ To set the duration in minutes, type the number of minutes followed by two periods. For
example, to create a 10-minute project, type “10..” (10 followed by two periods) in the
field, then press Return.

µ To set the duration in hours, type the number of hours followed by three periods. For
example, to create a 1-hour project, type “10...” (10 followed by three period) in the field,
then press Return.

This procedure works in timecode as well as frames.

To move ahead or back in seconds, minutes, or hours, type the following in the current
frame field

µ To move forward in seconds, type a plus sign (+), then type the number of seconds you
want to move forward, and then type a period. For example, to move 2 seconds ahead,
type “+2.” (a period after the number two) then press Return. To move ahead in minutes,
type two periods after the number then press Return. To move ahead in hours, type three
periods after the number, then press return.

µ To move backward in seconds, type a minus sign (–), then type the number of seconds
you want to move backward, and then type a period. For example, to move 2 seconds
backward, type “–2.” in the field, then press Return. To move backward in minutes, type
two periods after the number; to move backward in hours, type three periods after the
number.

To move the playhead to a specific frame
µ With the Canvas or Project pane active, type the desired timecode or frame number into

the current frame field. Press Return to confirm your entry.

To move forward a specific number of frames
µ Type a plus sign (+) followed by the number of frames you want to move forward.

To move backward a specific number of frames
µ Type a minus sign (–) followed by the number of frames you want to move backward.

To modify the current frame or duration dynamically
µ Click the center area of the field (where the numbers are), then drag to the left to increase

the value, or to the right to decrease the value.

Dragging the current frame field in this way is equivalent to dragging the playhead
through the mini-Timeline.
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To switch between timecode and frame numbers
Do one of the following:

µ Click the current frame icon directly to the left of the current frame field.

µ Click the duration icon directly to the left of the project duration field.

Duration icon

Clicking either icon switches between frame and timecode view for all controls in all open
projects.

Counting Time
Motion offers two different ways of looking at the frame numbers for your project. You
can view the time as incremental frames, starting at 1 or 0 and continuing indefinitely.
Or, you can view the time in the video-standard, eight-digit timecode system, which
runs like a clock from 00:00:00:00 to 23:59:59:29. The first two digits represent the hours;
the second two, the minutes; the third two, the seconds; and the final two, the frames,
as in HH:MM:SS:FF.

Some formats of timecode also skip numbers in order to accommodate the inexact
frame rates of certain video formats.

Both frames and timecode have advantages, depending mainly on the format with
which you are originating and finishing. For example, if you are designing a title sequence
for a 35 mm film that must be exactly 720 frames, it is easier to set your counters to
frames.

If you are building a television spot that is going to be laid onto a videotape or broadcast,
you would probably benefit from setting your counters to timecode, so that the frame
numbers correspond with the numbers on the videotape.
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Project Pane
The Project pane contains three tabs, each of which provides access to a different aspect
of your project. The Layers tab displays the hierarchy of objects (groups, layers, cameras,
lights, behaviors, filters, and so on) in your project. The Media tab shows all the files
imported into your project, with an option to show the media whether or not it appears
in the Canvas. The Audio tab provides access to, and control of, any audio files in your
project. All of these tabs are covered in more detail later in the chapter.

Once you begin building more complex projects, you can view the components of your
project in a list. You can view and modify the hierarchy of objects, including grouping
layers and changing group order. You can turn certain objects and effects on and off to
temporarily simplify your composition. You can view and modify the media files associated
with the layers in your project. You can also modify certain attributes of the layers and
groups, such as opacity, blend mode, and audio levels.

All of this can be accomplished in the Project pane, which is ordinarily to the left of the
Canvas.

To display the Project pane
Do one of the following:

µ Click the Project icon in the Toolbar.

µ Press F5.

µ Use a horizontal three-finger swipe on a Multi-Touch trackpad.

µ Drag the divider on the left edge of the Canvas.
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You can also switch the arrangement of the windows so the Project pane appears on the
right side of the Canvas.

Note: When the Project pane is on the right side of the Canvas, and you are using a
Multi-Touch trackpad, three-finger swipe in the opposite direction to show and hide the
pane.

To switch the sides of the Canvas and Project panes
µ Choose Window > Layouts > Swap Project Pane and Canvas.

The Project pane contains three tabs: Layers, Media, and Audio. Each of these tabs allows
you to view the elements of your project in a list view.

Layers Tab
The Layers tab of the Project pane provides an overview of all the layers, effects, and
masks currently used in your project. The hierarchy of items in the list illustrates which
objects are above or below other objects in the Canvas. All objects, with the exception
of cameras and lights, must reside within groups. Masks, behaviors, and effects can be
applied to groups or to individual layers. Applied masks, behaviors, and effects are listed
beneath the group or layer to which they are applied. The masks, behaviors, and effects
appear indented in the list.

The Name and Status columns in the Layers tab display several icons that indicate linked
audio, 2D/3D status, or lock status. By default, applied masks, behaviors, and filters also
appear in the list. You can turn the display of these objects on or off in the Layers tab.
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To display the Layers tab
Do one of the following:

µ Click the Project icon in the Toolbar.

µ Choose Window > Layers.

µ Press Command-4.

µ If the Project pane is already visible, click the Layers tab at the top of the pane.

The information is displayed in a column view and there are many controls to let you
customize the view while you are working. You can resize or rearrange the columns and
you can hide certain columns and display others that are not visible in the default set.

Layers Tab Controls
The Layers tab contains the following columns and controls:

Click to show additional 
columns.

Link icon

2D/3D icon (set to 2D)

3D icon (set to 3D)

Isolate button (active)

Isolate button (inactive)

On: Contains an activation checkbox to turn the visibility of the object on or off. When
the object visibility is turned off, you can still modify the object’s parameters and
manipulate its onscreen controls.

Preview: Contains a thumbnail of the object. The group thumbnail represents the
cumulative result of the composite up to that point in the project.

Name: Identifies the object by name. To edit the name, double-click the text area of a
selected object, type a new name, then press Return. In projects that contain a camera,
the Isolate button appears in the Name column.

Isolate button: The Isolate button only appears in projects that contain a camera. Once
a camera is added to the project, all groups are converted to 3D (if you choose Switch to
3D in the New Camera dialog). If you choose Keep as 2D in the New Camera dialog, the
camera is added to the project, but the groups remain 2D groups. Once a camera is added
to the project, the Isolate button appears for any selected group, layer, or camera.
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The button has an active and inactive state. Clicking the Isolate button for a layer or group
sets that object to its original face-forward orientation (so you can apply a mask, for
example). Clicking the button again returns to the previous view. Clicking the Isolate
button for a camera takes you to that camera’s view.

Note: When a group or layer is isolated, the name of the item replaces the current camera
listing in the Camera menu (in the upper-left corner of the Canvas).

Status: Contains a number of several possible icons to indicate the status of the object.
The lock icon lets you lock an object to prevent any changes from affecting that object.
Locking a group prevents changes to all layers and effects within that group. This column
may also include a link icon when a layer has a corresponding audio element, such as a
multichannel QuickTime file.

The Status column also contains a 2D/3D icon to switch a group between 2D or 3D mode.
The same icon appears immediately to the left of the group name and indicates the
2D/3D status of the group. Individual layers cannot be 2D or 3D—they are always 2D
elements within a 2D or 3D group.

To display additional columns, click the right angle bracket at the right of the column
headers. A pop-up menu appears containing three items: Preview, Opacity, and Blend.

Checkmarks in the pop-up menu identify which columns are currently displayed. By
default, only the Preview column is checked. Choose the other items to add them to the
Layers tab. Choosing a checked item hides it from view.

Opacity: Displays the current opacity (transparency) of the group or layer. You can adjust
the slider to change the item’s opacity.

Note: Opacity can also be adjusted in a HUD or in the Properties tab of the Inspector.

Blend Mode: Displays the current blend mode of the layer or group. Click the pop-up
menu to choose a new blend mode. For more on blend modes, see Using Blend Modes.
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Note: Blend mode can also be changed by Control-clicking the item in the Layers tab (or
Timeline layers list, then choosing a new Blend Mode option from the shortcut menu.
Likewise the blend mode of an object can be modified in the object’s HUD, or in the
Properties tab of the Inspector.

Working in the Layers Tab
You can customize the Layers tab in a variety of ways to accommodate different working
styles and the needs of different projects.

Editing Columns
Any window that contains columns of data can be reorganized to suit your needs. You
can change the order in which columns appear as well as the size of the cells. For example,
in the Layers tab, you may want the Preview column to appear to the right of the Name
column instead of to its left. You can also sort the items in the column by type of file.

To reorder columns
µ Drag the column header left or right to a new position.

Columns can be resized in several ways. You can adjust the width of a column, or you
can change the height of all cells in the columns at once, including any icons and text
inside the cells.

To adjust column width
µ In the header row, drag a column border to resize the width.

To adjust cell height
µ Position the pointer over any horizontal line and drag up or down to decrease or increase

the height of all cells.

Icons and thumbnails resize themselves as you make the adjustment.

You can also drag the scale slider at the bottom of the window. Drag left to decrease the
height of the rows and drag right to increase their height.

Adding and Removing Groups
The Layers tab has controls to add new groups and to remove existing objects from the
project.
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To create a new group in the Layers tab
Do one of the following:

µ Click the Add button (+) in the upper-left corner of the tab.

µ Choose Object > New Group (or press Command-Shift-N).

A new empty group is added at the top of the list.

Note: You can also create new groups when dragging files to the Layers tab from the
File Browser or Library. For more information, see Adding Files to Your Project.

To remove an object from the Layers tab
Do one of the following:

µ Select the object you want to remove, then click the Delete button (–) in the upper-left
corner of the tab.

µ Control-click the object you want to remove, then choose Delete from the shortcut menu.

µ Select the object you want to remove, then choose Edit > Delete (or press Delete).

The object is removed. This action removes the object from the Canvas as well.

Note: If you delete a media file (an imported image, image sequence, audio file, or
QuickTime movie) from the project, the file is also removed from the Media tab unless
“Automatically manage unused media” is deselected in the General pane of Motion
Preferences. When this setting is turned off, media files are deleted from the Layers tab
(and Canvas), but remain in the project in the Media tab. Drag an item from the Media
tab into the Canvas to add it to the Layers tab.

Filtering the Layers Tab View
As your project becomes more complex, you may want to temporarily hide certain objects
from view. This allows you to focus on one or more objects without the distraction of all
the other objects in your list. You can perform this sort of filtering by using the Search
field in the upper-right corner of the tab.

Once you begin typing in the Search field, the Layers tab hides any objects that do not
contain the text you type. Hidden objects continue to appear in the Canvas.

To filter the Layers tab
µ Type the name of the object or objects you want to view in the Search field. All other

objects are temporarily hidden.

Search field
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To stop filtering and return to the complete list
µ Click the Clear button inside the Search field.

The Search field is cleared and the Layers tab returns to the unfiltered view.

Hiding and Showing Effects
Masks, behaviors, and filters can be turned on and off in the Layers tab by using the
buttons at the bottom-right corner of the tab.

Note: Hiding the effect in the Layers tab does not disable it from view in the Canvas nor
prevent you from modifying the effect’s parameters or manipulating its onscreen controls.

Show Behaviors

Show Masks

Show Filters

To turn on and off the display of masks in the Layers tab
µ Click the Show Masks button.

To turn on and off the display of behaviors in the Layers tab
µ Click the Show Behaviors button.

To turn on and off the display of filters in the Layers tab
µ Click the Show Filters button.
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Turning Effects On and Off
When certain effects are applied to a layer or group, icons appear in the Name column
for that item. This lets you know that such an effect is applied, especially if you have the
effects hidden. There are icons for masks, filters, and behaviors. Additionally, these icons
let you turn the effects on and off in the Canvas.

Filter disabled

Masks

Behaviors

Filters

Isolate (inactive)

Note: You can also Control-click the icons in the Layers tab or Timeline layers list to display
a list of the applied effects.

To turn masks off for a layer or group
µ Click the Mask icon.

A red slash appears over the icon and the effect is temporarily turned off.

To turn behaviors off for a layer or group
µ Click the Behavior icon.

A red slash appears over the icon and the effect is temporarily turned off.

To turn filters off for a layer or group
µ Click the Filter icon.

A red slash appears over the icon and the effect is temporarily turned off.

For each of these controls, clicking the icon again turns the effect back on.

Additional Options in the Layers Tab
Quite a few additional features are available in the Layers tab and Timeline layers list,
which you can find in the shortcut menu that appears when you Control-click layers in
the list. These operations apply to the selected item.

• Cut: Removes the layer and places it on the Clipboard.

• Copy: Copies the layer to the Clipboard.
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• Paste: Places the contents of the Clipboard in the current location.

• Duplicate: Creates a new layer identical to the selection.

• Delete: Removes the selected layer.

• Group: Places the selected layers into a group. (For more information on working with
groups, see Grouping and Ungrouping Layers.)

• Ungroup: Restores the components to their ungrouped state if the selection contains
a group.

• Active: Turns the layer on or off. This is equivalent to clicking the activation checkbox
in the On column.

• Solo: Soloing a layer hides all other layers in the project. When the selected item is
soloed, checkboxes for other layers and groups are dimmed. You can solo multiple
layers and groups at a time.

• Isolate: Available when a project contains a camera, this option isolates the selected
layer, group, or camera. For a layer or group, choosing Isolate changes the item back
to its original face-forward orientation to allow the application of a mask, for example.
Clicking a camera’s Isolate button activates that camera’s view. This is the same as
clicking the Isolate icon in the Name column.

• 3D Group: Switches the group from 2D mode to 3D mode.

• Blend Mode: Sets the blend mode for the selected layer. This is equivalent to setting a
value in the Blend column.

• Add Image Mask: Adds an image mask to the selected layer. An image mask creates
transparency in another object by deriving an alpha channel from another layer, such
as a shape, text, movie, or still image. For more information, see Applying Image Masks
to a Layer.

• Make Clone Layer: Clones the selected layer. Like the Duplicate command, Make Clone
Layer lets you make copies of a selected layer. However, copies created by the Make
Clone Layer command are automatically modified to match certain changes you make
to the original layer. For more information on cloning layers, see Making Clone Layers.

• Reveal Source Media: Opens the Media tab and highlights the media file associated
with the selected clip.

Media Tab
The second tab in the Project pane contains a complete list of media in your project.
“Media” includes imported audio, image, image sequence, and QuickTime movie files.
Unlike the Layers tab, the Media tab may contain items that are not actively used in your
project. Also, if you’ve used a single layer repeatedly, the Media tab may only show one
version of that layer. Effects (such as filters or masks) and other objects created within
Motion (such as masks, shapes, or text) do not appear in the Media tab.
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To display the Media tab
Do one of the following:

µ Choose Window > Media.

µ Press Command-5.

µ If the Project pane is already visible, click the Media tab at the top of the pane.

µ To display the additional columns in the Media tab, drag the divider between the Project
pane and the Canvas (the vertical bar on the right side of the window).

Media Tab Column Headers
The Media tab provides a great deal of technical information about the media files in
your project.

Media Tab Columns: This data is displayed in columns for each file.

• Preview: Shows a thumbnail of the media file. The thumbnail for an audio file (with no
associated image) appears as a speaker icon.

• Name: Contains the name of the media. Media names are not editable because they
refer to the actual names of the files on disk.

• Kind: Identifies the type of media, including QuickTime movie, still image, QuickTime
audio, or PDF. For a list of supported codecs and file types, see Supported File Formats.

• In Use: When checked, this field indicates that the media is currently being used in your
project. When unchecked, it is not used. If “Automatically manage unused media” is
selected in the General pane of Motion Preferences, Motion removes unused media
from the Media tab automatically. Disable this setting if you prefer to manage the
contents of the Media tab manually.

• Duration: Displays the duration of the media in either frames or timecode.

• Frame Size: Displays the native size of the image in pixels. The numbers represent width
and height. This column remains blank for audio-only files.

• Compressor: Displays the type of compression used in the clip, if any. This is also
sometimes referred to as a codec.

• Depth: Displays the number of colors (bit depth) of the file. Any item listed as Millions
of Colors+ indicates that the media contains an alpha channel in addition to the RGB
data.

• Vid Rate: Clips are displayed the original frames per second of the media. Sequences
are listed at the current project frame rate and still images display no Vid Rate.
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• Data Rate: Displays the number of bytes per second at which the media file plays.

• Aud Rate: Displays the sample rate in the audio track, measured in kilohertz (kHz).

• Aud Format: Displays the bits per sample (usually 8, 16, or 24) and the number of
channels (usually mono, stereo, or multi-channel) of the audio track.

• File Size: Displays the overall file size of the media on disk.

• File Created: Displays the creation date of the media.

• File Modified: Displays the last date on which the media was modified.

Working in the Media Tab
The media tab can be customized to aid in the organization and management of the
media in your project.

Hiding Columns
You can choose which of the columns are displayed by clicking the right angle bracket
at the right of the column headers, then choosing an option from the pop-up menu.

Items in the list with a checkmark are currently displayed in the Media tab. Items with no
checkmark are currently hidden.

To hide a column
µ Click the right angle bracket at the right of the column headers, then choose the item

you want to hide from the pop-up menu.

To show a column
µ Click the right angle bracket at the right of the column headers, then choose the item

you want to show from the pop-up menu.

The item is added to the far right of the columns.

Any window that contains columns of data can be reorganized. You can change the order
in which columns appear, as well as the size of the cells. For example, in the Media tab,
you may want the Frame Size column to appear before the Name column. For specific
instructions on how to edit columns, see Editing Columns.
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Adding and Removing Media
The Media tab has controls to add new files and to remove existing files from the project.

To add a file to the Media tab
Do one of the following:

µ Click the Add button (+) in the upper-left corner of the tab. In the Import Files dialog,
navigate to the file you want to add to your project, select the file, then click Import.

Note: To import an image sequence, turn on the Image Sequence checkbox. If this
checkbox is deselected, only the individual files selected in the Import dialog are imported.
To select multiple files, Shift-click the files; to select noncontiguous files, Command-click
the files.

µ With the Media tab active, choose File > Import (or press Command-I). In the Import Files
dialog, navigate to the file you want to add to your project, select the file, then click
Import.

The file is added to the Media tab.

Important: Files added directly to the Media tab are not added to the Canvas. To add a
file to the Canvas, drag the file from the Media tab to the Canvas.

To remove a file from the Media tab
Do one of the following:

µ Select the file you want to remove and click the Delete button (–) in the upper-left corner
of the tab.

µ Control-click the file, then choose Delete from the shortcut menu.

µ Select the file you want to remove, then choose Edit > Delete (or press Delete).

The media is removed. If the media is used in the Canvas, an alert appears asking you to
confirm that you want to remove the files.

Filtering the Media Tab
As your project becomes more complex, you may want to temporarily hide certain files
from view. This allows you to focus on one or more files without the distraction of all the
other files in your list. You can perform this sort of filtering by using the Search field in
the upper-right corner of the tab. For instructions on how to filter the Media tab, see
Filtering the Layers Tab View.

Additional Options in the Media Tab
Quite a few additional features are available in the Media tab, which you can find in the
shortcut menu that appears when you Control-click files in the list. The actions in this
menu apply to the selected file or files.
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When an item is selected in the tab, the shortcut menu provides the following commands:

• Open in Viewer: Opens the selected item in the viewer window. This is equivalent to
double-clicking a file in the File Browser.

• Open in QuickTime Player: Opens the selected item in the QuickTime Player application.

• Reveal in Finder: Switches out of Motion, and opens a Finder window where the Media
file resides on disk.

• Reconnect Media: Opens the Reconnect Media dialog where you can assign a new
source file on disk to correspond to the media file in Motion.

• Cut: Removes the file and places it on the Clipboard.

• Copy: Copies the file to the Clipboard.

• Paste: Places the contents of the Clipboard in the current location.

• Duplicate: Creates a new file identical to the selected file.

• Delete: Removes the selected file.

When no items are selected in the tab, the shortcut menu provides a different set of
commands:

• Import Media: Imports media into the Media tab, but does not place the media into
the Canvas.

• Reconnect Missing Media: When a media file is moved from where it was stored when
it was added to your project, you need to reconnect the media to your project. This
command displays a dialog that lets you navigate to the new location of the file.

• Remove Unused Media: If any media is in your project but is not used, you can choose
this command to quickly removed the unused objects from the Media tab.

• Paste: Pastes any media files on the Clipboard into the Media tab, but does not place
the media into the Canvas.

• Project Properties: Opens the Project Properties dialog, where you can set basic project
information such as project width and height, bit depth, aspect ratio, background color,
render settings, and much more. For more information on the Project Properties dialog,
see Creating Blank Projects from Project Presets.

Sorting Columns in the Media Tab
The following procedures help determine how the items in the Media tab are sorted.
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To sort the items in a column by type of file in the Media tab
µ Click the column header.

Click the column header 
to sort by that column’s 
data type.

Note: Sorting does not work in the Layers tab or Timeline layers list.

The layers are sorted in the column and a small arrow appears indicating the direction
of the sort.

The arrow in the column 
header indicates the 
direction of the sort.

To reverse the direction of the sort
µ Click the header of the column that contains the small arrow.

The arrow points in the opposite direction, and the data is sorted in reverse order.
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Audio Tab
The Audio tab lists all of the audio files and files that contain audio (such as a multitrack
QuickTime movie) in your project. You can modify the levels of the individual files or
modify the overall audio level of the project. For more information on working with audio
in Motion, see Working with Audio.

To display the Audio tab
Do one of the following:

µ Choose Window > Audio.

µ Press Command-6.

µ If the Project pane is already visible, click the Audio tab at the top of the pane.

Columns in the Audio Tab
The Audio tab contains a number of columns with both display and editable information
about the audio components of your project:

On: Contains an activation checkbox to turn the audio on or off.

Name: Identifies the file by name. To edit the name, double-click the text area of a selected
file, type a new name, then press Return. This column also contains a slider and value
field to control the level (volume) of the file. Numbers in the value field are measured in
decibels (dB).

Pan: Displays the left-right balance of the sound. You can modify the Pan parameter by
dragging the slider to the right or left or by entering a numerical pan value. Negative
numbers move panning to the left, positive numbers move panning to the right.
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Status: Contains Mute and Solo buttons to control audio playback for the file. When the
Mute button is active, all sound from that file is removed from the mix. When the button
is inactive, audio from the file plays back based on the level slider in the Name column.

Mute

Solo

When the Solo button is active, other nonsoloed audio elements do not play. This allows
you to temporarily play a single item without hearing the other files in the mix. You can
solo more than one file. This allows you to hear just the soloed files rather than the entire
mix.

Output: Specifies audio output channels such as stereo, left, right, center, and so on.
Click the field, then choose the output channel you want for the audio track.

Lock: Allows you to lock an audio file to prevent any changes from affecting that file.
This column also may include a link icon when a file has a corresponding video element.

Working in the Audio Tab
The Audio tab can be customized to aid you in managing and organizing your audio
assets.

Editing Columns in the Audio Tab
You can control which columns are displayed by clicking the right angle bracket to the
right of the column headers. Doing so opens a pop-up menu. Items in the list with a
checkmark are displayed in the Audio tab. Items without a checkmark are hidden. You
can also edit the arrangement and size of the columns. For more on how to hide and
show columns, see Hiding Columns. For instructions on how to edit columns, Editing
Columns.

Adding and Removing Audio Files
The Audio tab has controls to add new files and to remove existing files from the project.

To add an audio file to the project
Do one of the following:

µ Click the Add button (+) in the upper-left corner of the tab. In the Import Files dialog,
navigate to the file you want to import, select the file, then click OK.

µ With the Audio tab active, choose File > Import (or press Command-I). In the Import Files
dialog, navigate to the file you want to add to your project, select the file, then click
Import.

The file is added to the project (the Audio and Media tabs).
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Note: When importing a QuickTime movie that contains multiple audio tracks, select Mix
to Stereo in the Import Files dialog to import the file with a single audio track. Select
Import All Tracks to import the file with individual tracks.

To remove a file from the Audio tab
Do one of the following:

µ Select the file you want to remove, then click the Delete button (–) in the upper-left corner
of the tab.

µ Control-click the file, then choose Delete from the shortcut menu.

µ Select the file you want to remove, then choose Edit > Delete (or press Delete).

The file is removed. This action removes the file from the project (from the Audio and
Media tabs).

Filtering the Audio Tab
As your project becomes more complex, you may want to temporarily hide certain audio
files from view. This allows you to focus on one or more files without the distraction of
all the other files in your list. You can perform this sort of filtering by using the Search
field in the upper-right corner of the tab. For instructions on how to filter your view, see
Filtering the Layers Tab View.

Additional Options in the Audio Tab
Quite a few additional features are available in the Audio tab, accessible through the
shortcut menu that appears when you Control-click files in the list:

• Cut: Removes the file and places it on the Clipboard.

• Copy: Copies the file to the Clipboard.

• Paste: Places the contents of the Clipboard in the current location.

• Duplicate: Creates a new file identical to the original file.

• Delete: Removes the selected file.

• Send to Soundtrack Pro: Launches Soundtrack Pro and opens the selected audio clip in
Soundtrack Pro for editing.

• Active: Turns the file on and off. This is equivalent to clicking the activation checkbox
in the On column.

• Mute: Sets the selected item to be muted. This is equivalent to clicking the Mute button
in the Status column.

• Solo: Sets the selected item to Solo. This is equivalent to clicking the Solo button in
the Status column.

• Reveal Source Media: Opens the Media tab and highlights the media file associated
with the selected clip.
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When no items are selected in the tab, the shortcut menu provides a different set of
commands:

• Import Audio: This option appears when no files are selected in the Audio tab. Opens
the Import Files dialog, which you can use to navigate to the audio file you want to
import.

• Paste: This option appears when no files are selected in the Audio tab. Pastes any audio
data that is currently in the Clipboard into the Audio tab and Media tab.

• Project Properties: This option appears when no files are selected in the Audio tab.
Opens the Project Properties dialog, where you can set basic project information such
as project width and height, bit depth, aspect ratio, background color, render settings,
and much more. For more information on the Project Properties dialog, see Creating
Blank Projects from Project Presets.

Timing Pane
Like the Project pane, the Timing pane has three tabs, each to control a different aspect
of your project. The Timeline tab is a broad overview of all the objects and how they are
laid out over time. The Keyframe Editor tab displays the animation curves for animated
parameters and effects, and the Audio Editor tab provides access to the level and pan
controls for the audio components of your project.

At some point in most projects, you want to view the contents of your composition
represented as a graph over time. This may be to compare when two objects appear or
disappear, or when an effect begins or changes. You may want to add or remove objects
in your project at a particular point in time to observe or modify how different parameters
of different effects occur. You may also want to view your audio waveforms to allow visual
events to synchronize with your soundtrack.
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All of this can be accomplished in the Timing pane, which appears at the bottom of the
Canvas.

To display the Timing pane
Do one of the following:

µ Drag the divider on the bottom edge of the Canvas.

µ Click the Timing icon in the upper-right corner of the Toolbar.

Timing icon

µ Choose Window > Timeline (or press Command-7).

µ Press F6.

µ Use a vertical three-finger swipe on a Multi-Touch trackpad.

µ Choose Window > Layouts > Cinema (or press Option-Control-U).
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Timeline
The Timeline is the most general of the tabs in the Timing pane. It can display not only
the visual elements in your project (the layers), but also audio tracks, cameras, lights,
keyframes, and effects such as masks, behaviors, and filters. For more information on
using the Timeline, see Using the Timeline.

To display the Timeline tab
Do one of the following:

µ Choose Window > Timeline (or press Command-7).

µ When using a Multi-Touch trackpad, three-finger swipe up or down to show and hide
the Timing pane.

µ If the Timing pane is already visible, click the Timeline tab at the top of the pane.

Timeline Layers List
The left side of the Timeline tab—the Timeline layers list—is nearly identical to the Layers
tab in the Project pane. Objects appear in the project hierarchy categorized into layers
and groups. The columns and controls are identical to those in the Layers tab:
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On (not labeled): This column (identical to the On column in the Layers tab) contains an
activation checkbox to the left of each object that turns the visibility of the object on and
off. When the object visibility is turned off, you can still modify the object’s parameters
and manipulate its onscreen controls.

Name (not labeled): Identifies the object by name. (This column is identical to the Name
column in the Layers tab.) To edit the name, double-click the text area of a selected object,
type a new name, then press Return. In projects that contain a camera, the Isolate button
also appears in this column.

Isolate: The Isolate button only appears in projects that contain a camera. Once a camera
is added to the project, all groups are converted to 3D (if you choose Switch to 3D in the
New Camera dialog). If you choose Keep as 2D in the New Camera dialog, the camera is
added to the project, but the groups remain 2D groups. Once a camera is added to the
project, the Isolate button appears for any selected group, layer, or camera.

The button has an active and inactive state. Clicking the Isolate button for a layer or group
sets that object to its original face-forward orientation (so you can apply a mask, for
example). Clicking the button again returns to the previous view. Clicking the Isolate
button for a camera takes you to that camera’s view.

Status (not labeled): Contains a number of several possible icons to indicate the status
of the object. (This column is identical to the Status column in the Layers tab.) The lock
icon lets you lock an object to prevent any changes from affecting that object. Locking
a group prevents changes to all layers and effects within that group. This column may
also include a link icon when a layer has a corresponding audio element, such as a
multi-channel QuickTime file.

The Status column also contains a 2D/3D icon to switch a group between 2D or 3D mode.
The same icon appears immediately to the left of the group name and indicates the
2D/3D status of the group. Individual layers cannot be 2D or 3D—they are always 2D
elements within a 2D or 3D group.

Note: Changes made in the Timeline layers list also change the Layers tab in the Project
pane and vice versa.
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Timeline Track Area
The main part of the Timeline tab, to the right of the Timeline layers list, is called the track
area. Objects in your project are each represented by a colored bar. Different colors
represent different types of objects. For example, behaviors and filters are purple and
audio layers are green. For a complete table of colors, see Timeline Tracks.

Group tracks differ from individual object tracks in two ways. First, when an object that
resides in a group is selected, a thinner group bar appears above the layers within the
group. Second, when the group itself is selected, the group track displays a special
indicator that identifies how many objects reside within that group. Layers, cameras, and
lights are counted in that total; effects such as masks, behaviors, and filters are not counted
in that total.

Timeline Ruler
At the top of the track area is the ruler that provides a gauge for the positions and
durations of the objects in your project.

In point Out point

PlayheadProject marker

The ruler can contain indicators to help mark important frames or sections of the project
such as the playhead, play range indicators (also called In and Out points), and markers.
The ruler can be viewed in frames or timecode.

To change the ruler view format
µ Control-click the ruler, then choose Display Frames or Display Timecode from the shortcut

menu.

Note: You can also click the current frame icon directly to the left of the current frame
field (to the left of the transport controls) or click the duration icon directly to the left of
the project duration field (to the right of the transport controls) to switch the project
between frames and timecode.
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The playhead tracks the frame currently visible in the Canvas. You can drag the playhead
or reposition it using the transport controls described inPlaying Your Project. The playhead
in the Timeline and the playhead in the mini-Timeline are linked. Moving one automatically
moves the other.

The play range indicators limit the area of the project to be played. For more on setting
and using the play range, see Defining the Play Range.

Markers can be added to your project to identify an important frame or range of frames.
For more on creating and using markers, see Adding Markers.

Working in the Timeline
The Timeline tab can be customized to facilitate a variety of working styles and specific
project needs.

Turning Effects On and Off
When certain effects are applied to an object, icons appear next to the name of that item.
There is an icon for masks, filters, and behaviors. These icons control the visibility of those
effects in the Canvas.

Filter disabled

Masks
Behaviors
Filters

To turn masks off for a layer or group
µ Click the Masks icon in the Timeline layers list.

A red slash appears over the icon and the effect is temporarily turned off.

To turn behaviors off for an object
µ Click the Behaviors icon in the Timeline layers list.

A red slash appears over the icon and the effect is temporarily turned off.

To turn filters off for a layer or group
µ Click the Filters icon in the Timeline layers list.

A red slash appears over the icon and the effect is temporarily turned off.

For all three of these controls, clicking the icon again turns the effect back on.
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Timeline Tab Display Options
As with the Layers tab, you can choose to show or hide effects such as masks, filters, and
behaviors. Additionally, the Timeline lets you display keyframes. You can also choose to
display audio tracks and, if audio tracks are displayed, you can hide groups and layers.
All of these display options are controlled by the row of buttons in the lower-left corner
of the Timeline tab.

Show/Hide Audio

Show/Hide Masks

Show/Hide Keyframes

Show/Hide Behaviors

Show/Hide Filters

Show/Hide Layers

Masks, behaviors, and filters can be displayed as layers in the Timeline, just as they are
displayed in the Layers tab. Showing or hiding effects in the list does not control whether
the effect appears in the Canvas.

To turn on or off the display of masks in the Timeline
µ Click the Show/Hide Masks button.

To turn on or off the display of behaviors in the Timeline
µ Click the Show/Hide Behaviors button.

To turn on or off the display of filters in the Timeline
µ Click the Show/Hide Filters button.

When keyframes are shown, each track becomes a little taller, and the bottom section is
used to show any keyframes that exist for the layer.

Selected keyframeKeyframe

To turn on or off the display of keyframes in the Timeline
µ Click the Show/Hide Keyframes button.

107Chapter 2 The Motion Interface



Audio files appear in a separate section from other objects. You can move the divider
between the audio and video sections of the Timeline to show more or less of each
section.

Divider

To turn on or off the display of audio files
µ Click the Show/Hide Audio button in the lower-left corner of the Timeline tab.

To turn on or off the display of layers and groups
µ Click the Show/Hide Layers button in the lower-left corner of the Timeline tab.

Note: You cannot hide layers and groups unless audio files are currently visible. This is
to prevent the Timeline from becoming completely empty.

To move the divider between audio and video tracks
µ Position the pointer over the divider, then drag up or down to expand or contract the

track section.

You can adjust the height of the tracks in the Timeline to provide more or less vertical
space. You can also expand the size of the Layers tab.

To adjust track height
Do one of the following:

µ Position the pointer over any horizontal line and drag up or down to decrease or increase
the height of all tracks.
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µ Click one of the “Set timeline row size” buttons at the bottom of the tab.

To change the width of the Timeline layers list
1 Position the pointer over the rightmost edge of the Timeline layers list.

2 When the pointer changes to the column adjust pointer, drag left or right.

Adding and Removing Groups
The Timeline has controls to add new groups and to remove existing layers from the
project.

To create a new group in the Timeline tab
Do one of the following:

µ Click the Add button (+) in the upper-left corner of the tab.

µ Choose Object > New Group (or press Shift-Command-N).

A new empty group is added at the top of the list.

You can also create new groups when dragging files to the Timeline tab from the File
Browser or Library. For more information, see Adding Files to Your Project.

To remove an object from the Timeline tab
Do one of the following:

µ Select the object you want to remove, then click the Delete button (–) in the upper-left
corner of the tab.

µ Control-click the file you want to remove, then choose Delete from the shortcut menu.

µ Select the file you want to remove, then choose Edit > Delete (or press Delete).

The object is removed. This action removes the object from the Canvas as well.

Using the Current Frame Field
Next to the Add button (+) and the Delete button (–), the Timeline tab also contains a
current frame field that can be used to navigate your project.

To move the playhead to a new time
Do one of the following:

µ Click the current frame field, then type a frame number.

µ Drag the current frame value slider to the left or right to advance or rewind.

109Chapter 2 The Motion Interface



Note: To advance or rewind more rapidly, press Shift while dragging in the current frame
value slider.

µ With the Timeline active, type the timecode or frame number where you want to move
the playhead. Press Return to jump to that frame.

To move forward a specific number of frames
µ Type a plus sign (+) and then the number of frames you want to move forward.

To move backward a specific number of frames
µ Type a minus sign (–) and then the number of frames you want to move backward.

Collapsing and Expanding Groups and Layers
You can collapse a group or layer so the tracks for the individual objects within the group
are temporarily hidden.

Layer collapsed Layer expanded

To collapse or expand a group or layer
µ Click the disclosure triangle to the left of the group or layer name in the Timeline layers

list.

Disclosure triangle

A variety of editing tasks can be done in the Timeline, including moving, trimming, and
slipping. For more information on how to perform editing in the Timeline, see Editing
Objects in the Timeline.
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Zooming in the Timeline
As you get familiar with using the Timeline, you will find yourself wanting to focus on an
individual edit point one second, and the next, you’ll want to see the overview of your
whole project. Fortunately, you can quickly zoom in and out on the Timeline using a
variety of different tools.

The bottom of the Timeline contains a zoom slider and a scroller.

Zoom slider

Scroller

Handle

To zoom the Timeline using the zoom slider
µ Drag the zoom slider left to zoom in and right to zoom out.

The Timeline updates as you drag.

To zoom the Timeline using the scroller
µ Click the handle of the scroller and drag it away from the center to zoom out and toward

the center to zoom in.

The Timeline updates as you drag.

You can also automatically zoom the Timeline to include the entire duration of your
project or just the play range as defined by the play range indicators (In and Out points).

To zoom the Timeline using a Multi-Touch trackpad
µ Pinch open to zoom in, pinch closed to zoom out.

Once zoomed in, you can use two-finger swipes to scroll left or right.

To zoom the Timeline to fit the entire project
Do one of the following:

µ Double-click the Zoom Time View button to the right of the ruler.

Zoom Time View button

µ Choose View > Zoom Time View > To Project.

Note: An object must be selected in the Timeline layers list in order to access the Zoom
Time View items in the View menu.

µ Control-click the ruler, then choose Zoom to Project from the shortcut menu.

To zoom the Timeline to fit the play range
Do one of the following:

µ Click the Zoom Time View button to the right of the ruler.
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µ Choose View > Zoom Time View > To Play Range.

Note: An object must be selected in the Timeline layers list in order to access the Zoom
Time View options in the View menu.

µ Control-click the ruler, then choose Zoom to Play Range from the shortcut menu.

The Zoom Time View button switches between the Zoom to Play Range and Zoom to
Project settings. If no play range is established, choosing Zoom to Play Range performs
a Zoom to Project.

Changing the Track Display
The tracks in Motion can be displayed in a variety of ways to satisfy different working
styles. You can set your tracks to be viewed as Name Only, Name Plus Thumbnail, and
Filmstrip.

Name

Name Plus Thumbnail (default)

Filmstrip

To change the Timeline track display
1 Choose Motion > Preferences (or press Command-Comma) to open Motion Preferences.

2 Click the Appearance icon to open the Appearance pane.

3 In the Timeline section, choose an item from the Timebar Display pop-up menu:

• Name: Displays only the name of the object on the track.

• Name Plus Thumbnail: Displays the name of the object and a single thumbnail on the
track.

• Filmstrip: Displays frames of the object over the track.

Regardless of the Timebar Display setting, tracks for cameras, lights, behaviors, and filters
are always labeled with names only. When the Timebar Display is set to Filmstrip, your
processing time is increased.
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Keyframe Editor
The Keyframe Editor is where you can view and modify the individual attributes of filters,
behaviors, and other effects over time. Each parameter can be displayed as a curve
showing how the parameter’s value changes over time. You can manipulate the points
within that curve (called keyframes) to create a variety of powerful effects. For more
information on using the Keyframe Editor, see Keyframes and Curves.

To display the Keyframe Editor
Do one of the following:

µ Drag the divider on the bottom edge of the Canvas, then click the Keyframe Editor tab
at the top of the pane.

µ Click the Timing icon in the upper-right corner of the Canvas, then click the Keyframe
Editor tab at the top of the pane.

µ Choose Window > Keyframe Editor (or press Command-8).

µ Press F6, then click the Keyframe Editor tab at the top of the pane.

µ Choose Window > Layouts > Cinema (or press Control-Option-U), then click the Keyframe
Editor tab at the top of the pane.

µ If the Timing pane is already visible, click the Keyframe Editor tab at the top of the pane.
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Keyframe Basics
You animate an object by creating at least two keyframes for a parameter, such as
Opacity, at different points in time in a project. A keyframe is a point in time that records
any change in the value of a parameter. For example, to create an animation in which
an object is completely transparent at frame 1 and becomes completely opaque at
frame 120, you create two keyframes: an Opacity keyframe set to a value of 0% at frame
1 and an Opacity keyframe set to a value of 100% at frame 120. The image fades in from
0% to 100% over the 120 frames. The smooth, fade-in transition between the two
keyframed values is called interpolation.

All keyframes for a specific parameter (such as Opacity or Rotation) are positioned on
a line over time. Different values for the keyframes change the shape of that line and
create what is called an animation curve. The type of curve from keyframe to keyframe
(interpolation) can be changed to create different animation effects. For example,
keyframes set to Bezier create smooth transitions in values. Keyframes set to Linear
create straight lines between the keyframes, for sharper changes in value. You can
modify keyframes and their animation curves in the Keyframe Editor, located in the
Timing pane. For more information, see Keyframes and Curves.

Keyframe Editor Controls
The left side of the Keyframe Editor contains a list of parameters. You can choose which
parameters are displayed in the list in the Show menu. You can also create custom sets
of parameters. This allows you to focus on certain parameters at a time. For more
information on creating and viewing parameter sets, see Custom Parameter Sets.

There are a number of controls above the parameter list:

Show pop-up menu: Use the Show pop-up menu to select what is displayed in the
Keyframe Editor. The Show options include:

• All: This option displays all parameters for the currently selected object, whether or
not the parameters are animated.

• Animated: This option displays only the animated parameters and curves for the
currently selected object. This includes animation curves created by keyframing as well
as behaviors. This is the default setting. With the Keyframe Editor active, you can also
press the U key to choose Animated from the Show pop-up menu.
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When the selected object is not animated, nothing appears in the Keyframe Editor.

• Modified: This option displays only the curves that have been modified for the currently
selected object. This includes modifications that are not animated. For example, if you
change the color of a shape (without animating the color change), the parameter
appears in the Modified list because the color was changed from the default color.
Animated parameters also appear in the list. With the Keyframe Editor active, you can
also press the Y key to choose Modified from the Show pop-up menu.

• Active: This option shows only the parameters currently being modified. When this
option is selected, nothing appears in the Keyframe Editor unless you are actively
modifying an object (in the Canvas, Inspector, or HUD). For example, when Active is
selected and you are moving an object around in the Canvas, the X and Y Position
parameters and curves are displayed.

• Position: Displays only the Position parameters for the selected object. With the Keyframe
Editor active, you can also press the P key to choose Position from the Show pop-up
menu.

• Rotation: Displays only the Rotation parameters for the selected object. With the
Keyframe Editor active, you can also press R to choose Rotation from the Show pop-up
menu.

• Scale: Displays only the Scale parameters for the selected object. With the Keyframe
Editor active, you can also press S to choose Scale from the Show pop-up menu.

• Shear: Displays only the Shear parameters for the selected object. With the Keyframe
Editor active, you can also press H to choose Shear from the Show pop-up menu.

• Anchor Point: Displays only the Anchor Point parameters for the selected object. With
the Keyframe Editor active, you can also press A to choose Anchor Point from the Show
pop-up menu.

• Opacity: Displays only the Opacity parameters for the selected object. With the Keyframe
Editor active, you can also press O to choose Opacity from the Show pop-up menu.
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• New Curve Set: Allows you to create a custom curve set.

• Manage Curve Sets: Allows you to manage (delete, duplicate, and so on) your custom
curve sets.

Note: For more information on using curve sets, see Custom Parameter Sets.

Current Frame Field: The current frame field appears between the Show pop-up menu
and the keyframe edit tools.

Current frame field

For more information, see Timecode and Current Frame Fields.

Keyframe edit tools: There are three different tools available to assist in editing keyframes
and curves in the Keyframe Editor. For more information about using these tools, see
Modifying Keyframes.

Box

Sketch

Edit

• Edit: Select and edit keyframes.

• Sketch: Draw curves with keyframes. You must have a parameter active (checkbox
enabled) and selected in the list to be able to sketch a curve.

• Box: Drag a selection box to enclose and manipulate keyframes.

Keyframe Editor parameters: The Keyframe Editor parameters list is divided into four
columns.

• On (not labeled): This column contains activation checkboxes to turn the display of
parameters on and off in the keyframe graph. Activating the checkbox next to the
object name turns all of the parameters for that object on or off for display purposes
only (the animation of the object is not affected).

• Name (not labeled): Lists the name of the selected object and its parameters.

• Value (not labeled): Displays the value for the current playhead position for that
parameter. You can drag in the value field to set new keyframe values, or double-click
in the field and type a new value. For more information, see Modifying Keyframes.
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• Animation menu (not labeled): The last column contains a pop-up menu to control
animation and keyframing attributes for that parameter. The menu contains the
following items:

• Enable/Disable Animation: Remains unavailable until keyframing is applied to the
parameter, either by using the Record button or by directly adding a keyframe. Once
the parameter is animated, the menu item is automatically renamed to Disable
Animation. Activating it at that point hides the keyframes you have set, restoring the
parameter to its default value. However, the keyframes are not thrown away. Choosing
Enable Animation restores the parameter to its last keyframed state.

• Reset Parameter: Removes all keyframes and settings for this parameter. The parameter
value is restored to its default value.

• Add Keyframe: Adds a keyframe at the current frame. If your playhead is positioned
on a frame where a keyframe has already been added, this menu item is unavailable.
To add a keyframe, you can also Option-click the Animation menu. A keyframe is
automatically added to the last modified parameter of the object (regardless of the
status of the Record button) at the current playhead position.

• Delete Keyframe: Deletes the current keyframe. The Delete Keyframe command is
only available if the playhead is positioned on a frame where a keyframe already
exists. You can also Control-click a keyframe and choose Delete from the shortcut
menu, or select the keyframe and press Delete.

• Previous Keyframe: Moves the playhead to the previous keyframe for this parameter.
The Previous Keyframe command is only available if a keyframe exists earlier in the
project. You can also press Option-K to advance to the next keyframe.

• Next Keyframe: Moves the playhead to the next keyframe for this parameter. The
Next Keyframe command is only available if a keyframe exists later in the project.
You can also press Shift-K to advance to the next keyframe.

• Interpolation: Sets the type of curve for the parameter. See the table in Modifying
Curves for examples of the different interpolation methods.

• Before First Keyframe: Defines the animation before the first keyframe of a parameter.
This is called extrapolation. For examples of the different extrapolation methods, see
Extrapolation.

• After Last Keyframe: Defines the animation after the last keyframe of a parameter.
This is called extrapolation. For examples of the different extrapolation methods, see
Extrapolation.

• Lock/Unlock Parameter: Locks the parameter to prevent changes. When a parameter
is locked, neither keyframes nor curves are adjustable.
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• Reduce Keyframes: Applies a “thinning” algorithm to the keyframes for the selected
parameter. This reduces the number of keyframes in a parameter while attempting
to maintain a similar curve shape. For more information on keyframe thinning, see
Keyframe Thinning.

• Set to Curve Snapshot: If “Take/Show curve snapshot” is turned on (see Keyframe
Editor Control Buttons.), this option reverts any keyframe changes made in the
currently selected curve back to the most recent snapshot. For more information,
see Curve Snapshots.

Animation Menu States
Depending on the current condition of the parameter for the selected object, the
Animation menu displays a different icon. The following table shows the Animation menu
icons.

DescriptionStateIcon

The parameter has no associated keyframes.No Keyframes

Keyframing is active on this parameter but the
playhead is not currently positioned on a
keyframe.

Keyframing Active

The playhead is currently positioned on a keyframe
for this parameter.

Current Keyframe

This parameter is being controlled by a behavior,
as opposed to a keyframe. When a behavior is
applied to a layer or group, the name of the
behavior also appears in the Animation menu.

Behavior Applied

Keyframe Editor Control Buttons
In the lower-left corner of the Keyframe Editor, five buttons provide additional control
over the Keyframe Editor window: Snapping, “Show audio waveform,” “Fit curves,” “Clear
curve list,” and “Take/Show curve snapshot.”

Clear curve list

Show audio waveform

Fit curves

Snapping

Take/Show curve 
snapshot

Snapping: When snapping is turned on, keyframes snap to other keyframes, markers,
grid points, and other snappable items.
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Show audio waveform: Turns on the display of audio waveforms for the selected object.

When “Show audio waveform” is turned on and the project contains at least one audio
file, a pop-up menu at the bottom of the Keyframe Editor allows you to view the waveform
of the master audio track or any individual audio track in the project. The waveform of
the track selected in this list is displayed in the Keyframe Editor.

Click to display a list of 
audio tracks in the 
project.

Fit curves: Automatically scales the graph both vertically and horizontally (in time) to
include all of the keyframes of your active parameters.

Clear curve list: Empties the parameters list. This control is only active for custom curve
sets.

Take/Show curve snapshot: When this setting is enabled, as you move keyframes in the
Keyframe Editor, the original curve—as it appeared when you took the snapshot—appears
as a lighter color. As long as you remain in the Keyframe Editor editing the current set of
curves, the snapshot curve remains available.

Auto Scaling the Keyframe Graph
As you change keyframe values, they may exceed the currently displayed value range in
the Keyframe Editor. You can turn on Auto Scaling to make the graph range expand as
keyframe values exceed the current range. At the right side of the Keyframe Editor is the
“Auto-scale vertically to fit curves” button.

Auto-scale vertically to fit curves: Turn on “Auto-scale vertically to fit curves” to
continuously stretch the graph vertically to fit all of the curves in view.

Auto-scale vertically to fit 
curves
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Keyframe Graph
The remainder of the Keyframe Editor tab contains the keyframe graph. This area displays
all of the curves and keyframes for the selected parameters. Parameters are represented
by different colors. Keyframes appear as diamonds and curves appear as solid lines. Areas
before the first keyframe and after the last keyframe are represented by dotted lines.
Selected parameters and keyframes appear white.

You can manipulate keyframes directly by dragging them in the graph. Moving keyframes
left and right changes their position in time, while dragging them up and down changes
their values. You can also double-click a keyframe, type a number into the pop-up value
field, and then press Return to change its value.

Control-click a keyframe to access shortcut menu options as well as an Interpolation
submenu, which allows you to change curve types. For more information on manipulating
keyframes and curves in the graph, see Modifying Keyframes and Modifying Curves.

Ruler
At the top of the keyframe graph is a ruler that provides a visual gauge for the positions
and durations of the keyframes and curves. The ruler is identical to the Timeline ruler. For
more information on working with the ruler, see Timeline Ruler.

Zooming in the Keyframe Editor
As you become familiar with the Keyframe Editor, you may want to switch between
focusing on an individual keyframe or curve and seeing an overview of your whole project.
Fortunately, you can quickly zoom in and out on the Keyframe Editor using a variety of
different tools.

The bottom of the Keyframe Editor contains a zoom slider and a scroller.

Zoom slider

Scroller

Handle
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To zoom the Keyframe Editor using the zoom slider
µ Drag the zoom slider left to zoom in or right to zoom out.

The Keyframe Editor updates as you drag.

To zoom the Keyframe Editor using the scroller
µ Drag the handle of the scroller away from the center to zoom out and toward the center

to zoom in.

The Keyframe Editor updates as you drag.

To zoom the Keyframe Editor using a Multi-Touch trackpad
µ Pinch open to zoom in and pinch closed to zoom out.

Once zoomed in, you can use two-finger swipes to scroll left or right.

Audio Editor
The Audio Editor provides a view of your audio elements over time. You can view and
modify the level and pan information for the audio files in your project. You can also view
the audio waveforms of your layers. In many ways, the Audio Editor is simply a specialized
Keyframe Editor just for audio. For more on using the Audio Editor, see Working with
Audio.

To display the Audio Editor
Do one of the following:

µ Choose Window > Audio Editor (or press Command-9).

µ Drag the divider on the bottom edge of the Canvas, then click the Audio Editor tab at
the top of the pane.

µ If the Timing pane is already visible, click the Audio Editor tab at the top of the pane.

µ Click the Timing icon in the upper-right corner of the Canvas, then click the Audio Editor
tab at the top of the pane.

µ Press F6, then click the Audio Editor tab at the top of the pane.

Choose Window > Layouts > Cinema (or press Option-Control-U), then click the Audio
Editor tab at the top of the pane.
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Audio Editor Controls
The left side of the Audio Editor contains four rows of controls for the audio track currently
in view. The top row controls playback; the second row controls the In and Out points of
the audio track; the third row controls the selected track’s level; and the fourth row
controls the selected track’s pan settings.

Playback controls

Play range controls

Level controls

Pan controls

Audio Playback Controls
The playback controls in the Audio Editor do not control playback in the Canvas. Rather,
they allow you to listen to the audio component of your project without being distracted
by (or slowed down by) the visual component.

There are four playback controls:

Current framePlay/Pause

Use marked region

Jump to start

Jump to start: Moves the playhead to the beginning of the audio clip or to the beginning
of the marked region (if the “Use marked region” button is turned on).

Play/Pause: Starts and stops playback in the Audio Editor.

Use marked region: Restricts playback to the play range (the In and Out points) for the
selected audio track. For more information, see Audio Play Range Controls.

Current frame: Indicates the current playhead position in the Audio Editor. You can also
use this field to change the current frame.
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Audio Play Range Controls
The second row provides two controls to set the In and Out points for the audio file.
Changing a file’s In or Out point in the Audio Editor is reflected in the Timeline as well.
The area of the track between the In and Out points is the region used when “Use marked
region” is turned on in the playback controls.

Note: The In and Out points of the master track cannot be modified.

Level Controls
The third row contains controls to adjust and keyframe the level of the selected audio
track.

Activation checkbox: This checkbox at the left of the row turns the display of the level
animation curve on and off. It does not disable existing level settings or prevent you from
making new settings.

Level: A slider and value slider that control the level (volume) of the track. If the playhead
is currently positioned on a keyframe, the slider controls the level of that keyframe. If the
playhead is not on a keyframe, the slider adjusts the entire curve.

Pan Controls
The fourth row contains controls to adjust and keyframe the pan (left-right balance) of
the selected audio track.

Activation checkbox: This checkbox at the left of the row turns the display of the pan
animation curve on and off. It does not disable existing pan settings or prevent you from
making new settings.

Pan: A slider and value slider that control the left-right balance of the track. If the playhead
is currently positioned on a keyframe, the slider controls the pan setting of that keyframe.
If the playhead is not on a keyframe, the slider adjusts the entire pan curve. Negative
numbers move panning to the left, while positive numbers move panning to the right.
When the value is zero, the balance is split evenly between left and right. You can use
the value slider for more precise control.

Animation Menu
Appears to the right of the Level and Pan value sliders and is similar to the Animation
menu found in the Keyframe Editor. The menu is represented by different icons depending
on the current state of the parameter. For a table describing the different icons, see
Animation Menu States.

Animation menu: The commands within the Animation menu are listed below.

• Enable/Disable Animation: Turns keyframing on and off for this parameter. Once
keyframes are added, choosing Disable Animation does not delete the keyframes, but
just globally hides their effect.

• Reset Parameter: Removes any keyframes and restores the parameter to its default
value.
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• Add Keyframe: Adds a new keyframe at the current playhead position. To add a keyframe,
you can also Option-click the Animation menu.

• Delete Keyframe: Deletes a keyframe at the current playhead position.

• Previous Keyframe: Moves the playhead to the first keyframe to the left of the current
playhead position.

• Next Keyframe: Moves the playhead to the first keyframe to the right of the current
playhead position.

• Show in Keyframe Editor: Displays the audio parameters in the Keyframe Editor and
brings that tab to the front.

Level Meters
Audio level meters appear at the right side of the Audio Editor controls. There are two
vertical bars that show the level at the current playhead position. The left bar shows the
levels for the left audio channel and the right bar shows the levels for the right audio
channel. As you play, the meters change to indicate the changing audio level.

Peak indicators

Peak indicators appear at the top of the meters. These small lights illuminate red when
the volume exceeds acceptable levels (called peaking). They remain red for a short time
after the peak occurs.
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Audio Editor Keyframe Graph
The remainder of the window contains the keyframe graph. This area contains the curves
and keyframes for the level and pan of the selected track. Keyframes appear as diamonds,
and curves appear as solid lines. Areas before the first keyframe and after the last keyframe
are represented with dotted lines. The waveform of the selected track is displayed behind
the curves.

Audio track bar

At the top of the graph a green bar shows the duration of the audio file. As you change
the file’s In and Out points, the bar shrinks or expands to show the new duration.

As in the Keyframe Editor, you can manipulate keyframes here also by dragging them in
the graph. Moving a keyframe left or right changes its position in time, while dragging
it up or down changes its value. Because audio keyframes work exactly the same as
keyframes for other parameters, you can learn more about working with audio keyframes
in Modifying Keyframes and Modifying Curves.

Ruler
At the top of the Audio Editor Keyframe graph is a ruler that provides a visual gauge for
the positions and durations of the level and pan keyframes and curves. The ruler in the
Audio Editor shows different time than the rulers in the Timeline and Keyframe Editor.
This ruler shows the time for the selected audio file rather than for the whole project.

The ruler can contain indicators to help mark important frames or sections of the project
such as the playhead, play range indicators (also called In and Out points), and markers.
The ruler can be viewed in either frames or timecode.

To change the ruler view format
µ Control-click the ruler, then choose Display Frames or Display Timecode from the shortcut

menu.

Markers can be added to your project to identify an important frame or range of frames.
For more information on creating and using markers, see Adding Markers.
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Note: The playhead in the Audio Editor is not the same as the playhead in the Timeline
and the Canvas. The Audio Editor playhead shows the current time within the selected
audio track rather than the current time within the entire project.

Audio Scrubbing
You can choose whether or not you want to hear the audio play when you drag the
playhead through the ruler in the Audio Editor. This is called audio scrubbing. To turn
audio scrubbing on or off, click the button in the lower-left corner of the Audio Editor.

Working in the Audio Editor
You can modify a number audio settings and view options using the controls in the Audio
Editor.

Modifying the Audio Play Range
There are three ways to change the audio track start and end times.

To change the audio track’s start time
Do one of the following:

µ Drag the center of the In value slider. Dragging to the right advances the audio, and
dragging to the left rewinds.

µ Click the right or left arrows at the sides of the In value slider to move forward or backward
by one frame.

µ Click in the field and type a new number.

To change the audio track’s end time
Do one of the following:

µ Drag the center of the Out value slider. Dragging to the right advances the audio, and
dragging to the left rewinds.

µ Click the right or left arrow at the side of the Out value slider to move forward or backward
by one frame.

µ Click the current frame field, then type a new number.

Alternatively, you can change the start and end time using the audio track bar to set new
start and end times.
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To change the start and end time using the audio track bar
µ Select the track in the Audio tab, then drag either end of the audio track green bar (located

above the waveform in the Audio Editor).

Note: You cannot create marked regions for the master audio track.

Changing the Playhead Position in the Audio Editor
There are three ways to move the playhead within the Audio Editor.

To change the playhead position
Do one of the following:

µ Drag in the center of the current frame field. Dragging to the right advances and dragging
to the left rewinds.

µ Click the arrows on either side of the current frame field to move forward or backward
by one frame.

µ Click the current frame field, then type a new number.

Zooming in the Audio Editor
You can zoom in or out in the Audio Editor just as you can in the Timeline or Keyframe
Editor.

The bottom of the Audio Editor contains a zoom slider and a scroller.

To zoom the Audio Editor using the zoom slider
µ Drag the zoom slider left to zoom in and right to zoom out.

The Audio Editor updates as you drag.

To zoom the Audio Editor using the scroller
µ Click the handle of the scroller and drag it away from the center to zoom out and toward

the center to zoom in.

The Audio Editor updates as you drag.
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To zoom the Audio Editor using a Multi-Touch trackpad
µ Pinch open to zoom in, and pinch closed to zoom out.

Once zoomed in, you can use two-finger swipes to scroll left or right.

Window Arrangements
Different workflows require different sets of windows to be visible, and in different sizes.
For example, when designing a layout for your composition, the bigger the Canvas, the
better. However, when tweaking or finessing an animated effect, you may want more
room dedicated to the Timing pane and the Inspector. Fortunately, Motion allows you
to switch between different layouts quickly and even to save your own custom layouts.

Preset Layouts
Motion provides three preset window arrangements, called layouts. These layouts distribute
the application’s windows in varying ways to accommodate different workflows.

To choose a preset window layout
µ Choose Window > Layouts, then choose a layout from the submenu.

• Standard: This layout displays the utility window on the left and the Canvas on the
right.
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• Alternate: This layout displays two utility windows on the left, the top one containing
the Inspector and the bottom one containing the File Browser and Library. The Canvas
fills the remainder of the screen to the right.

• Cinema: The Cinema layout also displays two utility windows. The window on the left
side of the workspace contains the File Browser and Library. The window on the right
side contains the Inspector. The Canvas is in the middle with the Project pane displayed.
The minimum monitor width resolution is 1325 to use Cinema layout.
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Basic Window Controls
In addition to choosing from the preset arrangements, you can manually arrange your
windows, resize them, or minimize them to the Dock.

To move a window
µ Drag a window by the title bar to the new location.

To resize a window
µ Drag the resize control in the lower-right corner of the window to resize it to the desired

size.

To simultaneously resize adjacent windows
µ Drag the boundary between the two windows (the black line along the edge of the

window). The pointer changes its shape over the boundary, indicating you can drag from
there.

Drag the thin black line 
between two windows to 
resize them at the same 
time.

To minimize a window to the Dock
µ Click the minimize button in the title bar. You can also double-click the title bar of the

Canvas to minimize it to the Dock.

Note: The utility windows cannot be minimized.

To close a window
Do one of the following:

µ Click the close button.

µ Press Command-W in an active window.
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Tabs
Motion uses tabbed windows to provide convenient access to multiple windows at once.
You can switch between windows simply by clicking the appropriate tab. In addition,
you can drag any tab out of its docked position to show the tabbed window in its own
separate window. You can also drag a tab into another window. This lets you view multiple
tabbed windows from the same group at one time. For example, you can drag the
Inspector tab to a new location so that you can view the Library and the Inspector windows
simultaneously.

To detach a tab
µ Drag the tab out of its docked position to any new location.

When you release the mouse button, the tab becomes its own window, and you can use
all standard window controls, such as closing, minimizing, and resizing.

To reattach a tab
µ Drag the tab at the top of the window back to its original location. For example, drag the

Inspector tab back to its original group of tabs, and release the mouse button.

The tab is reattached.

To show or hide a tab
µ In the Window menu, choose the name of the tab you want to show or hide. For example,

choose Window > Timeline to show or hide the Timeline tab. You can also choose
Keyframe Editor or Audio Editor to show or hide those tabs.

To reorder tabs
µ Drag a tab left or right in the tab area to reorder the tabs.

If the tab is detached from the Timeline area, click the close button. This closes the window,
and it does not reappear as a tab. To display the window again, use the Window menu,
and choose the appropriate command to show the window you want.

Swapping the Project Pane and Canvas
Similar to changing tab order, you can also change whether the Project pane appears to
the left of the Canvas (default), or to the right. This can be especially useful when working
with multiple monitors. For example, if the Canvas occupies the entire left monitor and
your utility windows are on the right monitor, moving the Project pane to the right side
of the Canvas would make it closer to the utility windows.

To move the Project pane to the opposite side of the Canvas
µ Choose Window > Layouts > Swap Project Pane and Canvas.
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Saving Custom Layouts
Once you have the windows arranged to your liking, you can save your screen layout
with a relevant title so you can switch back to it later. This makes it easy to set up layouts
that help you perform certain tasks. For example, you might set up one layout that is
good for editing curves, while another layout has an expanded Timeline for editing
keyframes. You can switch between layouts in the Window > Layouts submenu, and you
can delete and duplicate layouts in the Manage Layouts dialog. (Choose Window >
Manage Layouts.)

When you save a layout, you save the following items:

• Window positions (size and location)

• Column orders (in the Project pane)

• Project pane position (left or right)

Note: Tab order, Timeline display options, and Canvas display options are not saved in
the custom layout.

To save a layout
1 Organize the windows on your screen the way you want.

2 Choose Window > Save Current Layout.

The Create Window Layout dialog appears.

3 Type the name you want to use to save the layout, then click Save.

The layout is saved and now appears in the Layouts submenu.

The new layout appears 
in the bottom section of 
the submenu.
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You can also create a new custom layout (based on the current state) by clicking the Add
button (+) in the Manage Layouts dialog.

To switch to a saved custom layout
µ Choose Windows > Layouts, then choose the custom layout from the submenu.

To delete a saved layout
1 Choose Window > Manage Layouts.

The Manage Layouts dialog opens.

2 Select the layout you want to delete.

3 Click the Delete button (–) to remove the item from the list.

4 Click the Done button.

To duplicate a layout
1 Choose Window > Manage Layouts.

The Manage Layouts dialog opens.

2 Select the layout you want to duplicate.

3 Click the Duplicate button.

A duplicate of the layout is added to the list. The word “copy” is appended to the name.

4 Click Done.

To rename a layout in the list
1 Choose Window > Manage Layouts.

The Manage Layouts dialog opens.

2 Double-click the layout you want to rename in the list.

The name changes to a value field.

3 Type the new name in the value field.

4 Click Done.
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Full Screen Mode
Motion has an option to cover your entire monitor with the Canvas. This is helpful for
watching playback of your project without the distraction of the software interface. In
this mode, all of the tools and controls that affect the Canvas remain active, though you
have to rely on keyboard shortcuts and shortcut menus (Control-click) to change from
one tool or control to another. You can access the menu bar by positioning your pointer
at the top of the screen where the menu normally is.

To switch into Full Screen mode
Do one of the following:

µ Choose View > Full Screen Mode.

µ Press F8.

To return to normal view
Do one of the following:

µ Position your pointer over the menu, then choose View > Full Screen Mode again.

µ Press F8 again.

HUD
The HUD (heads-up display) is one of the most versatile and handy tools in the Motion
interface. It is a dynamically updating floating window that puts the most common
controls for any selected object within easy reach.
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The HUD also contains special controls for certain types of effects such as Basic Motion
behaviors and particle systems. These unique controls allow you to set multiple parameters
simultaneously and in an intuitive way.

For example, the 2D Particle Emitter HUD contains a single control that provides a visual
way to manipulate three different particle system parameters: Emission Range, Emission
Angle, and Speed. You can read more about specific HUD controls in their namesake
chapters.

Note: It is easier to enter a specific value for a slider parameter in the Inspector’s value
sliders. You can Option-click to the left or right of an Inspector’s slider to decrease or
increase by a value of 1. Option-click the arrow on either side of the value slider to increase
or decrease by a value of .01.

Displaying HUDs
When multiple effects are applied to an object, you can quickly cycle through the different
effects’ HUDs. A small downward-facing arrow next to the HUD name indicates additional
effects are applied to the selected object.

The arrow indicates 
multiple control sets for 
selected layer.
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Click the arrow to display a pop-up menu that lists all of the possible HUDs that can be
displayed for the selected object.

Note: Pressing D cycles through all HUDs for the selected object.

When multiple objects of the same type are selected, a combined HUD appears, and
“Multiple Selection” appears in its title bar.

To switch between HUDs of a selected object
Do one of the following:

µ Click the downward arrow in the HUD title bar, then choose the HUD you want to view
from the pop-up menu.

µ Press D to cycle through all HUDs for the selected object. To cycle the HUDs in reverse,
press Shift-D.

The HUDs are cycled in the order in which the effects are applied.

Most of the time, the HUD displays a subset of the parameters visible in the Inspector for
the selected object. If you are working in the HUD, you can quickly jump to the Inspector
to access the remainder of the controls for that object.

To jump to the Inspector from the HUD
µ Click the Inspector icon (the “i”) in the upper-right corner of the HUD.

The Inspector appears and the tab corresponding to the HUD controls is brought to the
front.
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Motion has thousands of different parameters that allow virtually unlimited creativity and
flexibility. However with so many different settings to adjust, it might seem daunting to
master the whole interface. Fortunately, there are only a small number of user interface
controls to modify those myriad parameters. This chapter describes each of those controls
in specific detail.

Many parameters are actually compound parameters, where making an adjustment
changes more than one setting. Such parameters can be identified by a disclosure triangle
next to the setting name. Clicking the disclosure triangle exposes a more thorough set
of controls, allowing you to set individual aspects of the parameter’s value with greater
specificity.

This chapter covers the following:

• Toolbar Controls (p. 138)

• Slider Controls (p. 138)

• Coordinate Controls (p. 139)

• Dial (p. 140)

• Value Field (p. 141)

• Activation Checkbox (p. 141)

• Menus (p. 141)

• Source Well (p. 142)

• Color Controls (p. 143)

• Gradient Controls (p. 146)

• Mini-Curve Editor (p. 156)

• Generic Inspector Controls (p. 158)

• Rasterization Indicator (p. 160)
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Toolbar Controls
Motion’s Toolbar is located at the top of the main window. There are tools that transform
objects and the project view, as well as tools that create new layers, such as text, shapes,
and masks. There are also icons to apply filters and behaviors, and to create particle
systems and replicators. Icons at the right of the Toolbar show and hide the various
windows and panes of the Motion interface.

Several tools have multiple modes or options, such as Shape tools that can be set to
rectangle, circle, or line mode. The Circle and Line tools are hidden until you click the
Shape tool and hold down the mouse button. Tools with additional states are indicated
with a tiny downward arrow in the lower-right corner of the tool.

To access a tool’s additional modes or options
µ Click a tool with a small downward arrow in the lower-right corner of the tool and, holding

down the mouse button, choose a mode or option.

For a description and use of each tool, see Toolbar.

Slider Controls
Sliders are used for settings where the value of the parameter is a number chosen from
a range of numbers. They are by far the most common control type in Motion, mainly
because of their versatility.

Basic Slider
Sliders are used to choose a value from within a fixed range, such as opacity, which must
fall between 0 and 100%, or a color fill which must fall between 0 and 1.

Sliders are also used for parameters that have a commonly used range, but can be set to
values outside of that range, such as the amount slider in the Gaussian Blur filter, which
has a default range of 0 to 64, but can manually be set as high as 600.

To change a slider value
µ Drag the slider to the left to lower values and to the right to increase values.

µ Option-click to the left or right of the slider to decrease or increase by a value of 1.
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Value Slider
To the right of each slider is a second control, called a value slider. This control displays
the parameter’s current numerical value and has arrow buttons on either side.

Some parameters have sliders with effectively infinite ranges, such as scale, which can
be set at any value positive or negative (although the indicator can only display 6 or 7
digits).

Left arrow

Right arrow

Value sliders lack the relative positioning feedback that traditional sliders provide, but
they can be dragged directly to modify the value.

To modify the value of a parameter using a value slider
Do one of the following:

µ Click the left or right arrows to decrease or increase the value one increment at a time.

µ Option-click the arrows to decrease or increase the value by .01.

µ Double-click the number and type a new value directly in the field.

µ Click directly on the numbers and drag either left and right or up and down to decrease
or increase the value.

Note: When you position the pointer above a value slider, the pointer changes to a
four-way arrow. If you begin by dragging up or down, subsequent horizontal movement
will be ignored. If you begin by dragging left or right, subsequent vertical movement will
be ignored.

Coordinate Controls
Parameters that define a specific location in the Canvas are controlled using three value
sliders to set the x, y, and z axes; parameters that define a specific location in a
two-dimensional object have two value sliders for x and y.
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Note: In most cases, only the x and y axis value sliders are visible. The z axis value slider
can be revealed by clicking the disclosure triangle next to the parameter name.

The most common example of this type of control is the Position parameter, which sets
the center point for an object. But this control also occurs for any parameter that defines
a position in the Canvas, such as the center of a lens flare or the origin of a particle system.

To modify a coordinate value in the inspector
µ Use the value sliders for the x, y, and (when applicable) z axes.

For more on using value sliders, see Value Slider.

Tip: Any coordinate parameter can be set by moving an object or an onscreen control
directly in the Canvas. This allows you to set the value visually rather than numerically.
Depending on the particular coordinate parameter you are modifying, you may need to
select a specific tool in the Toolbar.

Dial
Parameters measured in degrees (such as Rotation or Hue) employ the dial control.

Some parameters are limited to a value between 0 and 360 degrees. If you rotate such a
dial more than one revolution, the numbers simply repeat. Other parameters can be set
to negative values or multiple rotations.

Dials always have a value slider beside them to indicate the value set by the dial. Dial
value sliders can be manipulated directly as well.

To adjust a parameter using a dial
Do one of the following:

µ Drag the dial in a clockwise or counterclockwise direction to increase or decrease the
value.

µ Directly modify the value slider.

For more on working with value sliders, see Value Slider.
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Value Field
This control allows direct entry of text to set the value of the parameter.

An example of a parameter that uses a value field is the text entry field.

Activation Checkbox
Any parameter that must either be on or off uses a checkbox control. For example, the
All Caps and Align to Path settings for text objects are controlled with checkboxes.

Unlike those with sliders and dials, parameters controlled by a checkbox cannot be
keyframed.

To activate or deactivate a parameter controlled by a checkbox
µ Click the checkbox.

Menus
Motion uses a variety of different types of menus and menu-like controls. These include
pop-up menus, value lists, parameter selection menus, and tracking selection menus.

Menus cannot be keyframed.

Pop-Up Menu
Parameters that have a pre-defined set of options are controlled with pop-up menus. In
some cases the choices available in the pop-up menu might change depending on the
settings of other related parameters.

To change the value of a pop-up menu
µ Click the menu and choose an item from the list.

The menu displays the name of the selected option.
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Value List
Another type of pop-up menu. You can click the disclosure button to the right of the
field to display preset values, or you can type a value directly into the value field.

An example of a value list is Typeface.

Parameter Selection Menu
A special type of pop-up menu, specifically for Parameter behaviors. When a Parameter
behavior is applied to an object, you need to identify which parameter the behavior
should affect. You can either type the name of the parameter directly into the value field,
or you can choose from the Go pop-up menu, which lists all current parameters.

An example of a parameter selection menu is the “Average behavior” Apply To parameter.

Tracking Selection Menu
Similar to the parameter selection menu, this control allows you to select existing tracking
data stored in another Motion Tracking behavior in the project and apply that data to
the currently selected tracking behavior.

Tracking Selection menu

An example of the Tracking selection menu is the Source pop-up menu in the Match
Move behavior.

Source Well
Many parameters in Motion require the input of another object, such as the texture for
a Bump Map filter, or the object in an Orbit Around behavior.

This new object’s alpha channel or motion path is used as a source to affect the target
object. Such parameters display a source well (sometimes called an Image well), an empty
box to which you can drag a source object.
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To use a source well
µ Drag an object from the File Browser, Library, Layers tab, or Media tab into the empty

box.

Once accepted, the name and a thumbnail of the source object appears in the well and
is used as a source for the effect.

To replace the contents of a source well
µ Drag a new object directly onto the well.

The old source is replaced with the new one.

To clear a source well
µ Drag the icon in the well out.

A “poof” animation occurs and the well is emptied.

Important: Once an object has been added to the well, modifying the original source
object has no effect on the instance of the object used in the well.

Color Controls
Many objects and effects in Motion have attributes that can be set to a specific color (or
a range of colors in the form of a gradient). Text objects, shapes, generators, particle and
replicator systems, and other types of objects have color settings. Many filters such as
borders, glows, keying, and some stylize effects also have user-definable color settings.

Color well Eyedropper

Color controls consist of several related elements, including the color well, pop-up color
palette, colors window, eyedropper, and individual sliders for the different color channels.

Color Well
A color well is the small color box you click to open the Colors window to change the
color of a selected object, such as text, a shape, or particles. The color well has two parts,
a swatch and a disclosure button.

To change the color of an object
1 Select the object you want to modify.

2 Click the relevant tab in the Inspector, then do one of the following:

• Click the color well and pick a color from the Colors window.

• Click the disclosure button or control-click the color well and pick a color from the
pop-up color palette.
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• Click the eyedropper, then in the Canvas, click an object of the desired color.

• Click the color well’s disclosure triangle and manipulate the individual Red Green Blue,
(and when applicable, Opacity) sliders.

Pop-Up Color Palette
When you control-click a color well or click the adjacent pop-up arrow, a temporary color
palette appears.

New color
Original color

Click here to select a 
grayscale color.

The pointer becomes an eyedropper and an info area on the right displays the RGB and
HLS values for the current pointer position. A swatch displays the currently saved color
alongside the new one.

One advantage to picking colors this way is that as you move the pointer, the Canvas
updates dynamically. Click to lock the currently selected color.

The Colors Window
You can also use the Mac OS Colors window within Motion. This gives you access to the
familiar color pickers such as the web-safe palette or the crayons picker.

Color Picker Selector

Currently selected color

Active Color Picker

Saved Swatches

The Colors window has four sections: the icons at the top select different picker interfaces;
the large color swatch shows the currently selected color; the middle section shows the
currently active picker; and at the bottom, the row of boxes can be used to save swatches.
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To show the Colors window
Do one of the following:

µ Click a color well.

µ Choose View > Show Colors.

µ Press Command-Shift-C.

To pick a color in the Colors window do one of the following
µ Click the color of your choice from the picker area.

µ Click the magnifying glass, then click anywhere on the screen to choose that color.

Note: If the Colors window was opened by clicking a color well, a color chosen in the
Colors window automatically loads into the color well. However if you open the Colors
window manually (or leave it open after a color has already been chosen) you must drag
the selected color from the swatch in the Colors window to the color well in the Inspector
or HUD.

To save a color to the Colors window swatch area
1 Select a color in the picker or by using the magnifying glass.

2 Drag the color from the large swatch to one of the white squares at the bottom of the
Colors window.

Colors saved in this area will remain accessible across applications and restarts.

Tip: To add more white squares, drag the bottom of the Colors window down.

Eye Dropper
Beside every color well is an eye dropper control. This allows you to pick a color already
in use in the Motion Canvas. By choosing colors from the colors already in your scene
you can ensure any new elements remain in the same palette, creating a more cohesive
and integrated design.

To pick a color using the eye dropper
1 In the Inspector, click the eye dropper for the color parameter you want to set.

The pointer turns into an eyedropper.

2 Click a color in the Canvas.

That color is assigned to the color well.
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Expanding Color Controls
Sometimes you need precise numerical control over your colors. This can be helpful if
you are trying to match two colors exactly, or when you want to adjust one of the color
channels independently. It can also be helpful when choosing how a color should be
animated, For example, you could keyframe the channels differently.

Every group of color controls has a disclosure triangle, which, when clicked, reveals
individual sliders for the component color channels in your selected color. You can choose
a color by adjusting these various sliders. For more on using sliders, see Slider Controls.

Gradient Controls
Most attributes that can be filled with a color can alternatively be filled with a gradient.
Like color controls, gradient controls are a group of compound settings with a great deal
of additional options and controls that appear when the disclosure triangle is clicked.

Gradient preset pop-up 
menu

Gradient Preset Pop-up Menu
When the gradient controls are collapsed, you can select a preset gradient from the
Gradient preset pop-up menu.

To change the current gradient to a saved preset
µ Click the Gradient preset pop-up menu and select the gradient of your choice.

The colors of the new gradient will be applied to the existing gradient type.
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Gradient Editor
To customize or modify the gradient, you must expand the controls to reveal the gradient
editor.

Gradient editor controls

Controls in the Gradient Editor
Use the gradient editor to change the color, color position, number of colors, opacity,
direction, and interpolation of a gradient. Click the disclosure triangle to reveal individual
controls for each of the parameters. The color and opacity of a gradient can be animated.

Graphical controls: Three bars allow you to set the color, opacity, and spread of a gradient.
The spread of color and opacity across the gradient can be adjusted by dragging a set
of controls called tags. Selecting a tag activates additional controls in the gradient editor,
including Color, Opacity, and Location sliders.

Color: A color well that sets the color of the selected color tag.

Opacity: A slider that sets the transparency of the selected opacity tag (in the graphical
controls above). The opacity tags control the opacity/transparency of the gradient. You
can add multiple opacity tags to create a gradient of varying levels of transparency. By
default, the opacity of a gradient applied to text is 100%.

Note: There is also an Opacity parameter (below the Angle parameter) that controls the
opacity of the gradient as a whole.

Spread Control: A control (shaped like a small triangle) between each pair of color tags
that sets where one color ends and the next begins.
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Interpolation: A pop-up menu that sets the interpolation of the color tag to Constant,
Linear, or Continuous.

• Constant: Creates a constant color distribution from the color or opacity tag, moving
from left to right in the gradient. For example, if the left color tag in a three-color,
left-to-right gradient is set to Constant, the gradient from the left tag to the center tag
is solid.

• Linear: Creates a uniform distribution of opacity or color between the tags.

• Continuous: The opacity or color changes gradually between color tags or opacity tags.

Location: A slider that sets the location of the selected gradient color, opacity tag, or
spread control.

Type: This pop-up menu allows you to choose a linear or radial gradient.

• Linear: Creates a linear gradient.

• Radial: Creates a radial gradient.

Angle: Available in some gradients when Type is set to Linear, this dial/value slider
changes the angle of the gradient.

Start: Value sliders that set the start position of the gradient. This parameter affects the
gradient as a whole—colors and opacity. X position is the left value slider and Y position
is the right value slider. Click the disclosure triangle to display the individual X and Y
parameters.

• X: Controls the X start position of the gradient.

• Y: Controls the Y start position of the gradient.

End: Value sliders that set the end position of the gradient. This parameter affects the
gradient as a whole—colors and opacity. X position is the left value slider and Y position
is the right value slider. Click the disclosure triangle to display the individual X and Y
parameters.

• X: Controls the X end position of the gradient.

• Y: Controls the Y end position of the gradient.
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Feather: Use the slider or value field to soften the gradient fill. Positive values soften the
shape outward; negative values soften the shape inward.

Using the Gradient Editor
The gradient editor is a flexible and powerful tool, allowing you to create a wide variety
of custom styles.

To change the colors in a gradient
1 Click the gradient disclosure triangle to show the gradient editor.

2 To change the color of a color tag in the gradient editor, do one of the following:

• Double-click a color tag.

Color tag

The Colors window appears. Use the Colors window to set a new color for the tag.

• Click a color tag, then use the individual Red, Green, or Blue color channel slider.

Red gradient color tag is selected

• Click a color tag, then click the disclosure triangle to the immediate right of the color
well to display the pop-up color palette. Drag the eyedropper in the palette to select
a new color. Drag in the lower palette to set the tag to a grayscale color.

• Click a color tag, then Control-click the color well to display the pop-up color palette.

• Click a color tag, click the eyedropper tool, then click a color in the Canvas.

To move the position of a color tag or opacity tag
1 Click the color tag or opacity tag you want to move.
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2 Do one of the following:

• Drag the tag left or right.

Location slider

Drag the color tag to 
change position of the 
color. 

• In the Location parameter, use the slider or value field to enter a specific value. A value
of 100% is the rightmost position of the gradient, and a value of 0% is the leftmost
position of the gradient.

To change the spread of the gradient color or opacity
µ Drag the small triangle between the color tag or opacity tag to change the location of

the spread. The closer the spread control is to a tag, the sharper the color or opacity
spread.

The Location parameter is also updated as you move the spread control, indicating its
position on the gradient.

Spread control

Note: The Spread control does not appear for color or opacity tags that are set to Linear
or Constant.

To change the color or opacity tag interpolation
Do one of the following:

µ Control-click a tag, then choose Constant, Linear, or Continuous from the shortcut menu.

µ Click a tag, then choose Constant, Linear, or Continuous from the Interpolation pop-up
menu.
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To add a color tag to a gradient
µ To add a new color tag, position the pointer in the lower color bar where you want to

add the new color, then click.

A new color tag is added to the gradient.

Click in the lower color 
bar to add a color tag.New color tag

Note: Although the colors, opacity, and position of the tags of a gradient can be animated,
the number of color tags and opacity tags cannot.

To add an opacity tag
µ Position the pointer in the opacity bar where you want to add the new tag, then click.

A new opacity tag is added to the gradient.

Until the value is adjusted, the gradient opacity is 100%.

To duplicate a color or opacity tag
µ Option-drag the tag to its new position.

To remove a color or gradient tag from the gradient
µ Drag the tag away from the gradient bar.

The tag is removed with a “poof.”

To change the opacity of a gradient color
1 Click an opacity tag.

The Opacity controls are enabled.

Opacity controls

Selected opacity tag

2 Use the slider or value field to change the value of the opacity.

The gradient transparency reflects the new opacity values.
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Tip: The lower the percentage of the opacity, the greater the transparency.

Editing Color and Opacity Direction and Distribution
You can quickly reverse the direction or evenly distribute the gradient color and opacity
tags.

To reverse the gradient color or opacity direction
µ Click the Reverse Tags icon next to the opacity or color gradient.

Reverse Tags icon 
(opacity)

Reverse Tags icon (color)

The tags are reversed.

To evenly distribute the gradient color or opacity tags
µ Click the Distribute Tags icon next to the opacity or color gradient.

Distribute Tags icon 
(opacity)
Distribute Tags icon 
(color)

To change the direction of a shape’s gradient
1 With the shape selected, click the disclosure triangle to show the gradient editor.

2 Use the Start and End value sliders to change the direction of the gradient.

The left value slider is X and the right value slider is Y.

Saving Gradient Presets
As with shape styles, once you have created a gradient, you can save it in the Library.

To save a gradient in the Library
1 Select the object with the gradient you want to save.
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2 Choose Save Gradient from the Gradient preset pop-up menu.

Gradient preset pop-up 
menu

3 In the Save Preset To Library dialog, type the name of the gradient.

4 Click Save.

The custom gradient appears in the Gradients category in the Library. Custom presets
can be identified in the Library by the small user icon that appears in the lower-right
corner of the larger gradient icon. The new gradient also appears in the Gradient preset
pop-up menu.

Custom gradient saved in 
Library

Like the preset gradients, a preview of the gradient appears in the Preview area when
the gradient is selected in the stack.
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Using the Onscreen Gradient Controls
Onscreen controls provide a more interactive way to edit a gradient’s color, location of
the color tags and opacity tags, opacity, and start and end points. You can also use
onscreen controls to add color tags and opacity tags, as well as change their interpolation.

Start triangle

Opacity tag

End triangle

Color tag

To display the onscreen gradient controls
µ In the Canvas, Control-click the object with the applied gradient, then choose Edit Gradient

from the shortcut menu.

The onscreen controls appear.

To adjust the start and end gradient positions
µ To adjust the Start X and Y position of the gradient, drag the top triangle (at the end of

the gradient line).

µ To adjust the End X and Y position of the gradient, drag the bottom triangle (at the end
of the gradient line).

To change the location of the gradient tags
µ To change the location of the gradient color, drag the color tags along the gradient line.

µ To change the location of the gradient opacity, drag the opacity tags along the gradient
line.

To remove a color or opacity tag
µ Drag the color tag or opacity tag away from the onscreen controls and release the mouse

button.
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To add a color tag
Do one of the following:

µ Control-click the gradient control line at the location you want the new tag, then choose
Add Color Tag from the shortcut menu.

µ Double-click or Option-click the gradient control line at the location you want the new
tag.

To duplicate a color or opacity tag
µ Option-drag the tag to its new position.

To change the color of a gradient tag
µ Control-click the tag, then drag the eyedropper in the pop-up color palette to select a

new color. As you drag over the color spectrum, the gradient color is actively updated.

To add an opacity tag
Do one of the following:

µ Control-click the gradient control line at the location you want the new tag, then choose
Add Opacity Tag from the shortcut menu. By default the new tag is set to 100% opacity.

µ Shift-Option-click the gradient control line at the location you want the new tag.

To change an opacity tag’s transparency
µ Control-click the tag, then drag the eyedropper in the pop-up palette to set a new opacity

value for the tag. White represents more opaque values, progressively darker levels of
gray represent decreasing opacity, and black represents complete transparency. As you
drag over the spectrum, the gradient is actively updated.

To change a color tag’s interpolation
µ Control-click the line next to the tag, then choose Constant, Linear, or Continuous from

the Color Interpolation submenu.

To change an opacity tag’s interpolation
µ Control-click the line next to the tag, then choose Constant, Linear, or Continuous from

the Opacity Interpolation submenu.
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To reverse the direction of the color gradient
µ Control-click the gradient control line, then choose Reverse Color from the shortcut menu.

To reverse the direction of the opacity gradient
µ Control-click the gradient control line, then choose Reverse Opacity from the shortcut

menu.

To evenly distribute the gradient color tags
µ Control-click the gradient control line, then choose Distribute Color from the shortcut

menu.

To evenly distribute the gradient opacity tags
µ Control-click the gradient control line, then choose Distribute Opacity from the shortcut

menu.

To apply a preset gradient style
µ Control-click the gradient control line, choose Presets from the shortcut menu, and then

choose a preset style from the list.

To remove an opacity tag or a color tag
µ Drag the tag away from the gradient onscreen controls and release the mouse button.

Mini-Curve Editor
A mini-curve editor is a scaled-down version of the Keyframe Editor. Appearing in the
Inspector, mini-curve editors give you the functionality to create basic animations directly
in the Inspector, without having to open the Keyframe Editor.

Two Particle behaviors—Scale Over Life and Spin Over Life—have mini-curve editors in
the Inspector (when the Increment Type parameter is set to Custom). Mini-curve editors
are also present for paint objects, in the Stroke pane of the Shape Inspector.

By default, the mini-curve editor is collapsed and shows a scaled-down representation
of the actual animation curve.

Collapsed mini-curve 
editor

To expand a mini-curve editor
µ Click the disclosure triangle next to the collapsed mini-curve editor.
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The expanded mini-curve editor appears.

Sketch tool

Box tool

Edit tool

Mini-curve editor

When expanded, the mini-curve editor shows a representation of the relevant animation
curve. In the example above, the Range parameter is mapped to the X axis and the Spin
Amount parameter is mapped to the Y axis.

The procedure for adding keyframes in a mini-curve editor is slightly different than for
adding them in the full-sized Keyframe Editor.

To add keyframes in the mini-curve editor
Do one of the following:

µ Click the curve in the mini-curve editor.

µ Double-click the curve in the mini-curve editor to add a keyframe and activate its value
field.

µ Option-click the curve, then choose Add Keyframe from the shortcut menu.

The mini-curve editor provides the Edit, Sketch, and Box tools, and each functions in the
same manner as it does in the Keyframe Editor. For more information on using the Edit
tool, see Using the Edit Tool. For more information on using the Sketch tool, see Using
the Sketch Tool. For more information on using the Box tool, see Using the Box Tool.
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The Auto Fit checkbox sets whether Motion automatically scales the animation curve to
fit within the confines of the mini-curve editor.

Auto Fit turned on in the 
mini-curve editor

Generic Inspector Controls
In addition to the common parameter control types listed above, there are several other
controls that are widely used within the Inspector tab.

Reset button: Automatically restores the parameter value (or in some cases, an entire
set of parameters) back to its default value.

Reset button

Preset pop-up menu: The Library contains style presets that can be applied to text and
shapes. The Style Preset pop-up menu allows you to apply a preset style to the selected
text. The Shape Style pop-up menu lets you apply a style to the selected shape (including
paint strokes). Through this menu, you can also save custom text and shape presets to
the Library.

Style Preset pop-up 
menu

For example, the Style Preset pop-up menu in the Text Style pane allows you to save text
style, format, or all (the parameters set in the Format pane and the parameters set in the
Style pane).
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Animation menu: Most parameters can be animated. This means that you can assign
specific values to certain frames (keyframes) so the parameter value changes over time.
Any parameter that can be animated has an Animation menu to the right of the parameter
settings.

Animation menu

Depending on the current condition of the parameter, the Animation menu displays a
different icon. For a table indicating the possible states, see Animation Menu States.

Click the Animation menu to display a pop-up menu filled with animation options:

• Enable/Disable Animation: Remains unavailable until keyframing is applied to the
parameter, either by using the Record button or by adding a keyframe. Once the
parameter is animated, the menu item is automatically renamed Disable Animation.
Activating it at that point effectively hides the keyframes you have set, restoring the
parameter to its default value. However, the keyframes are not thrown away. Choosing
Enable Animation restores the channel to its last keyframed state.

• Reset Parameter: Removes all keyframes and settings for this parameter. The parameter
value is reset to its default value.

• Add Keyframe: Adds a keyframe at the current frame. If the playhead is positioned on
a frame where a keyframe has already been added, this menu item is unavailable. You
can also Option-click the animation menu to add a keyframe.

Note: You can use a keyboard shortcut to quickly add a keyframe by pressing Control-K.
A keyframe is automatically added to the last modified parameter of the layer.

• Delete Keyframe: Deletes the current keyframe. The Delete Keyframe command is only
available if the playhead is positioned on a frame where a keyframe already exists.

• Previous Keyframe: Moves the playhead to the previous keyframe for this parameter.
The Previous Keyframe command is only available if a keyframe exists earlier in the
project.

159Chapter 3 User Interface Controls



• Next Keyframe: Moves the playhead to the next keyframe for this parameter. The Next
Keyframe command is only available if a keyframe exists later in the project.

• Show in Keyframe Editor: Opens the Keyframe Editor if it is not displayed and displays
the graph for the parameter you are modifying.

Rasterization Indicator
In the Properties tab of the Inspector, a small “LED” icon appears when a group is
rasterized. This is called the rasterization indicator. This is not a control, but rather an
indicator to alert you that a group has been rasterized.

Some operations, as well the application of certain filters or a mask, cause a group to be
rasterized. When a group is rasterized, it is converted into a bitmap image. Rasterization
affects 2D and 3D groups in different ways. When a 2D group is rasterized, the blend
modes on objects within the group no longer interact with objects outside of the group.
In addition, when a 3D group is rasterized, the group as a whole can no longer intersect
with objects outside of the group. The rasterized 3D group is treated as a single object
and uses layer order, rather than depth order when being composited in the project.

Once an operation triggers a rasterization on a group, the rasterization indicator appears
next to the parameter in the Properties tab.

Rasterization indicator

Additionally, a small frame appears around the 2D or 3D group icon (to the left of the
group name) in the Layers tab and Timeline layers list.

3D group icon after 
group rasterization

3D group icon prior to 
group rasterization

For more information on rasterization, see About Rasterization.
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The Motion menu bar provides access to nearly every control in the application. Many
menu items are context sensitive, so they are dimmed when the command cannot be
performed based on the current state of the application or what is selected. This section
serves as a reference guide for all menus.

Many of these commands have shortcut keys that perform the same command from the
keyboard. These shortcuts are listed in parentheses after the description.

This chapter covers the following:

• Application Menu (p. 161)

• File Menu (p. 162)

• Edit Menu (p. 164)

• Mark Menu (p. 166)

• Object Menu (p. 168)

• Favorites Menu (p. 171)

• View Menu (p. 171)

• Window Menu (p. 177)

• Help Menu (p. 179)

Application Menu
The first Motion menu contains general functions to control the application, modify the
preferences, and access the Apple website. It also provides access to system-level services.

• About Motion: Opens the About Motion window where you can find the version of
Motion you are running as well as the registration and trademark information.

• Preferences: Opens Motion Preferences. See Preferences for a detailed description of
the settings in that window.

• Commands: Provides access to controls for customizing your keyboard command keys.

• Customize: Opens the Command Editor.
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• Import: Opens a dialog that allows you to import a customized key command set.

• Export: Opens a dialog that allows you to export a customized key command set.

• Command Sets: Allows you to load a customized key command set.

• Final Cut Pro Set: Sets the active keyboard to match the default key command layout
in Final Cut Pro wherever possible. Select from English, Japanese, French, German,
or Spanish.

• Standard Set: Sets the active keyboard to the default key command layout. Select
from English, Japanese, French, German, or Spanish.

Note: For information on customizing your shortcut keys, see Customizing
Keyboard Shortcuts.

• Provide Motion Feedback: Opens a web page where you can send comments to Apple
about Motion.

• Services: A system menu item that provides access to commands that work across
different applications. See Mac OS X Help for more information about this submenu.

• Hide Motion: Hides all Motion windows. The application is still running in the
background. You can bring it back to the front by clicking the Motion icon in the Dock.
(Command-H)

• Hide Others: Hides windows from all applications other than Motion.
(Command-Option-H)

• Show All: Shows all windows from all applications currently running.

• Quit Motion: Stops the application from running. You are prompted to save any open
documents. (Command-Q)

File Menu
This menu contains functions and commands that deal with files on your disk that are
associated with Motion.

• New: Creates a new Motion document. (Command-N)

• Open: Opens a dialog from which you can choose a Motion project to open.
(Command-O)

• Open Template: Displays the Template Browser, from which you can choose one of the
built-in templates. (Command-Shift-O)

For more information on working with templates, see Creating New Projects from
Templates.

• Open Recent: Opens a submenu that lists the ten most recently opened files, giving
you quick access to the projects you have been working on recently. You can clear the
list by choosing Clear Menu from the bottom of the submenu.
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• Close: Closes the currently selected window. If the Canvas is the currently selected
window, and the project has not been saved, Motion asks you to save the project before
closing the window. (Command-W; press Command-Option-W to close all windows.)

• Save: Stores the current state of the selected project to disk. (Command-S; press
Command-Option-S to save all open projects.)

• Save As: Saves the current state of the selected project with a new name.
(Command-Shift-S)

• Save As Template: Saves the current project as a template. For more information on
working with templates, see Creating New Projects from Templates.

• Revert: Restores the selected project to the last saved state. All of the work done since
the last save is lost. Use caution; you cannot undo this operation.

• Restore from Autosave: Displays a dialog from which you can choose a project saved
to the Autosave Vault.

• Import: Opens the Import Files dialog and lets you choose a file from disk to import
into your project. (Command-I)

• Import as Project: Displays the “Import File as Project” dialog. The file you choose is
automatically placed into the Canvas of a newly created project. If multiple items are
selected, they are all placed in the same project. (Command-Shift-I)

• Export: Displays the Export dialog so you can output your current project to a file on
disk. (Command-E)

For more information on the various Export settings, see Exporting from Motion.

• Export Selection: Displays the Export dialog so you can output only your currently
selected object to a file on disk. Objects that are not selected are not exported.
(Command-Option-E)

For more information see Exporting Portions of a Project.

• Share: Displays the Share window, where you can select from multiple preset output
formats, such as MobileMe, DVD, Blu-ray, YouTube, and others. (Command-Shift-E)

For more information on the Share window, see Sharing Your Project.

• Reconnect Media: When a layer in your project refers to a file on disk that has been
moved or modified, this command allows you to reestablish that link. This menu item
is not active unless a layer that has lost its reference file is selected.

• Remove Unused Media: When a media item is imported into the Media tab (and not
into the project), this command allows you to remove it from your project. This menu
item is not active unless an item that has lost its reference file is selected.

• Remove Optical Flow Retiming: When a media item has been processed for retiming,
choosing this menu will flush the retiming information file.

For more on optical flow retiming, see Retiming.
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• Page Setup: Displays the standard system Page Setup dialog where you can set paper
size and orientation for printing. (Command-Shift-P)

• Print: Displays the standard system Print dialog, from which you can print the contents
of the Canvas. (Command-P)

Edit Menu
This menu contains familiar commands such as Undo, Cut, Copy, and Paste and also
contains commands to select and delete objects, modify project properties, and control
the Motion spelling checker.

• Undo: This command is usually followed by the name of the last command performed
such as Undo Move, or Undo Rotation Change. Choosing this menu item restores the
project to the state before that action was taken. You can undo up to 99 actions. If the
menu item is dimmed, you cannot undo. (Command-Z)

• Redo: This command is usually followed by the name of the last command performed
such as Redo Move or Redo Rotation Change. It is only active if one or more actions
have been undone. Choosing this menu item performs the exact action that was just
undone. (Command-Shift-Z)

• Cut: Removes the selection and stores it on the Clipboard so it can be pasted later.
(Command-X)

• Copy: Copies the selection and stores it on the Clipboard so it can be pasted later.
(Command-C)

• Paste: Adds the current Clipboard selection to the project based on the current selection.
This command is not available if nothing is on the Clipboard or if the contents of the
Clipboard cannot be pasted to the current selection—for example, text cannot be
pasted onto a keyframe. (Command-V)

• Paste Special: Gives you the choice to paste the contents of the Clipboard into the
active Timeline by inserting (pushing existing objects out of the way) or exchanging
the contents with the selected object. Additional options are available.
(Command-Option-V)

For more information, see Paste Special.

• Duplicate: Makes a copy of the current selection and immediately adds it to the project.
(Command-D)

• Delete: Removes the current selected object. In the Timeline, Delete leaves a gap where
the object was. (Delete)

• Ripple Delete: Removes the selected object and closes the gap left behind in the
Timeline. (Shift-Delete)
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• Insert Time: Adds blank space into the Timeline. You can only use Insert Time after
selecting a time range in the Timeline ruler. For more information on time ranges, see
Defining the Play Range.

• Split: Breaks an object into two objects, each on its own Timeline track. The split occurs
at the current playhead position. If no object is selected, or the playhead is not
positioned over a selected object, this menu item is dimmed.

• Transform Control Points: When multiple control points of a shape or mask are selected,
choosing this command will create a transform box around the points.
(Command-Shift-T)

For more information, see Transforming Multiple Control Points.

• Select All: Selects all objects in the project. (Command-A)

• Deselect All: Releases any selection. (Command-Shift-A)

• Send Audio to Soundtrack Pro: Lets you specify where to save an audio file, then opens
it in Soundtrack Pro. (Command-U)

• Project Properties: Opens the Project Properties dialog where you can change the
settings for the current project. For details of the Project Properties dialog, see General
Tab of the Project Properties Window. (Command-J)

• Spelling: This submenu contains the spell checking controls that allow you to search
through the selected text layer for spelling errors. These commands are only active
when a body of text is selected. (Command-Colon)

For more information on using the spelling checker, see Adding Text with the Text
Editor.

• Show/Hide Spelling and Grammar: Opens the system Spelling and Grammar dialog.

• Check Spelling: Turns the spelling checker on for the currently selected text.
(Command-Semicolon)

• Check Spelling As You Type: This command turns automatic spelling checking on and
off. When active, a checkmark appears next to the menu item. This command only
functions on text in the Text editor, not the Canvas.

• Special Characters: This command is part of Mac OS X. It opens the Characters Palette
which provides access to nontypical text characters like bullets, arrows, and currency
icons. It can only be used in Motion when typing in a text layer.
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Mark Menu
This menu contains commands to set the beginning and end points of your objects, add
markers to the Timeline, navigate through your project, and control animation of effects.

• Mark In: This command does two different things. If no object is selected, it sets the
beginning frame of the play range to the current playhead position. If an object is
selected, it trims the In point for that object to the current playhead frame. (I)

• Mark Out: This command does two different things. If no object is selected, it sets the
ending frame of the play range to the current playhead position. If an object is selected,
it trims the Out point for that object to the current playhead position. (O)

• Move Selected In Point: This command moves the selected object or objects so the In
point aligns with the current playhead position. (Shift-Left Bracket)

• Move Selected Out Point: This command moves the selected object or objects so the
Out point aligns with the current playhead position. (Shift-Right Bracket)

• Markers: This submenu contains all of the controls for creating, modifying, and deleting
markers. For more information on using markers, see Adding Markers.

• Add Marker: Adds a marker at the current playhead frame. If an object is selected, an
object marker is added. If no object is selected, a project marker is added (M or the
Tilde key to add an object marker; Shift-M to add a global marker).

• Edit Marker: Opens the Edit Marker dialog where you can set a marker’s name, color,
duration, and comment. A marker must be selected for this menu item to be active.
(Command-Option-M)

• Delete Marker: Removes the selected marker from the project.

• Delete All Markers: Removes all markers from the selected object. If no object is
selected, it deletes all project markers.

• Mark Play Range In: Sets the play range In point to the location of the playhead.
(Command-Option-I)

• Mark Play Range Out: Sets the play range Out point to the location of the playhead.
(Command-Option-O)

• Reset Play Range: Moves the play range In and Out points to the first and last frame of
the project. (Option-X)

• Play: Starts playback of the project. (Space bar)

• Loop Playback: Turns looping on and off. When looping is enabled, playback
automatically repeats from the beginning of the play range after the end is reached.
(Shift-L)

• Record Animation: Turns keyframe recording on and off. For more information on
recording animation, see Animating in the Canvas.

166 Chapter 4 Motion Menus



• Recording Options: Opens the Recording Options dialog where you can set the
granularity of keyframe recording.

• Go to: This submenu contains all of the different commands to navigate to a particular
frame within your project. All of these commands move your playhead to a new location.

• Project Start: Moves the playhead to the first frame of the project. (Home)

• Project End: Moves the playhead to the last frame of the project. (End)

• Play Range Start: Moves the playhead to the project In point. (Shift-Home)

• Play Range End: Moves the playhead to the project Out point. (Shift-End)

• Previous Frame: Moves the playhead backward by one frame. (Left Arrow)

• Next Frame: Moves the playhead forward by one frame. (Right Arrow)

• 10 Frames Back: Moves the playhead backward ten frames. (Shift-Left Arrow)

• 10 Frames Forward: Moves the playhead forward ten frames. (Shift-Right Arrow)

• Previous Keyframe: Moves the playhead to the previous keyframe in the project.
(Option-K)

• Next Keyframe: Moves the playhead to the next keyframe in the project. (Shift-K)

• Previous Marker: Moves the playhead to the closest marker earlier in time.
(Command-Option-Left Arrow)

• Next Marker: Moves the playhead to the closest marker later in time.
(Command-Option-Right Arrow)

• Selection In Point: Moves the playhead to the first frame of the selected object. (Shift-I)

• Selection Out Point: Moves the playhead to the last frame of the selected object.
(Shift-O)

• RAM Preview: This submenu contains commands to play back your project in real time,
by temporarily storing the frames in a RAM buffer. For more information on how and
when to use the RAM Preview functions, see RAM Preview.

• Play Range: Renders the area between the project In and Out points and stores the
frames in RAM. Once the frames are stored, the region plays back at full speed.
(Command-R)

• Selection: Renders the range of time occupied by the selected objects and stores the
frames in RAM. Once the frames are stored, the region plays back at full speed.
(Command-Option-R)

• All: Renders the entire project and stores the frames in RAM. Once the frames are
stored, the region plays back at full speed. (Command-Shift-Option-R)

• Clear RAM Preview: Clears the RAM cache.
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Object Menu
This menu contains all of the commands for manipulating objects within Motion. This
includes their placement in the layer hierarchy and physical alignment in the Canvas.

• New Group: Adds a new empty group to the project. (Command-Shift-N)

• New Camera: Adds a new camera to the project, and lets you specify whether to use
2D or 3D mode. (Command-Option-C)

• New Light: Adds a new light to the project, and lets you specify whether to use 2D or
3D mode. (Command-Shift-L)

• New Drop Zone: Adds a new drop zone to your project. Drop zones allow you to quickly
replace footage in a project by dropping clips directly onto the Canvas. A drop zone
appears as a rectangle with a gradient circle in its center. The drop zone’s layer name
appears in the center of the drop zone. Any media item dragged and dropped into the
region defined by the drop zone object automatically replaces the drop zone placeholder
graphic. When media is dragged over the drop zone, a highlight appears around the
drop zone area. (Command-Shift-D)

• Bring to Front: Moves the selected object to the top of the layers within a group.
(Command-Right Brace)

• Send to Back: Moves the selected object to the bottom of the layers within a group.
(Command-Left Brace)

• Bring Forward: Moves the selected object upward in the Layers tab by one object.
(Command-Right Bracket)

• Send Backward: Moves the selected object downward in the Layers tab by one object.
(Command-Left Bracket)

• Alignment: This submenu contains all of the commands for aligning and distributing
multiple objects within the Canvas. For more information on arranging objects within
the Canvas, see Using Object Alignment Commands.

• Align Left Edges: Moves the selected objects so that their left edges line up with the
leftmost edge in the selection.

• Align Right Edges: Moves the selected objects so that their right edges line up with
the rightmost edge in the selection.

• Align Top Edges: Moves the selected objects so that their top edges line up with the
topmost edge in the selection.

• Align Bottom Edges: Moves the selected objects so that their bottom edges line up
with the bottommost edge in the selection.

• Align Far Edges: In 3D mode, aligns the farthest edges of each object along the Z
(depth) axis.

• Align Near Edges: In 3D mode, aligns the nearest edges of each object along the Z
(depth) axis.

168 Chapter 4 Motion Menus



• Align Horizontal Centers: Lines up the selected objects on their horizontal center
points.

• Align Vertical Centers: Lines up the selected objects on their vertical center points.

• Align Depth Centers: Lines up the selected objects on their Z (depth) center points.

• Distribute Lefts: Spreads the selected objects evenly between the leftmost and
rightmost objects based on their left edges.

• Distribute Rights: Spreads the selected objects evenly between the leftmost and
rightmost objects based on their right edges.

• Distribute Tops: Spreads the selected objects evenly between the topmost and
bottommost objects based on their top edges.

• Distribute Bottoms: Spreads the selected objects evenly between the topmost and
bottommost objects based on their bottom edges.

• Distribute Far: Spreads the selected objects evenly between each object’s farthest
point.

• Distribute Near: Spreads the selected layers evenly between each object’s nearest
point.

• Distribute Horizontal Centers: Spreads the selected objects evenly between the leftmost
and rightmost objects based on their horizontal center points.

• Distribute Vertical Centers: Spreads the selected objects evenly between the topmost
and bottommost objects based on their vertical center points.

• Distribute Depth Centers: Spreads the selected objects evenly between the nearest
and farthest objects, based on their Z (depth) center points.

• Group: Combines the selected objects into a group. (Command-Shift-G)

• Ungroup: Removes the grouping so you can manipulate the objects individually.
(Command-Option-G)

• Active: Sets whether or not an object is active. When an object is not active, it doesn’t
appear in the Canvas and doesn’t appear in the final output. When the selected item
is active, the menu item has a checkmark beside it. (Control-T)

• Solo: Soloing an object hides all other objects in the project. When the selected item
is soloed, the menu item has a checkmark beside it. You cannot solo a camera or light.
(Control-S)

Note: You can also Control-click an object in the Layers tab and choose Solo from the
shortcut menu.

• Isolate: Isolating an object sets the object back to its original orientation. For example,
if you want to apply a mask to or rotoscope a layer that has been transformed in 3D
space, you can isolate the layer so that it is displayed in its original orientation (2D,
facing the front of the project). (Control-I)
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Isolate is only available in projects that contain a camera. When an object can be
isolated, a small Isolate button appears in the Layers tab. Click the button to isolate the
object. When you isolate an object, the object name appears in the Camera menu in
the Canvas as the name of your current view. Isolating a camera activates that camera’s
view.

• Lock: Locking an object prevents any changes from affecting that object. When the
selected item is locked, the menu item has a checkmark beside it. (Control-L)

• Unsolo: This submenu lets you turn a soloed object back to its normal state. There are
three choices: Video Only (Shift-Control-S), Audio Only, or Video and Audio. This menu
item is only available when a currently soloed object is selected.

• 3D Group: Changes the selected group to a 3D group. Deselecting the menu option
changes the group back to a 2D group (Control-D).

• Blend Mode: This submenu sets the blend mode for the selected layer. An object must
be selected in order to see the blend mode options. A layer can only have one blend
mode set at a time. The current setting is indicated with a checkmark beside the menu
item. For descriptions and examples of the various blend modes, see Using Blend
Modes.

• Add Image Mask: Adds a mask to the selected layer. (Command-Shift-M)

• Add Keyframe: Adds a keyframe to the currently selected object. The menu changes to
reflect the type of keyframe you are adding, such as Add Position Keyframe, Add Scale
Keyframe, and so on. (Control-K)

• Convert to Keyframes: This command can only be chosen when the selected object or
objects have behaviors applied. All behaviors are reproduced as keyframes on the
parameters that they affect. (Command-K)

• Convert to Mask: This command can only be chosen when the selected object is a
shape. The shape will be converted to a mask and applied to the enclosing group.

For more on converting shapes to masks, see Converting Between Shapes and Masks.

• Make Particles: Uses the selected layer as a cell source for a new particle emitter. (E)

• Replicate: Replicates the selected layer. (L)

• Make Clone Layer: Creates a clone of the selected layer or group. In a motion graphics
project, sometimes it is necessary to reuse a complex object in other parts of the project
multiple times. Although you can duplicate or cut and paste any object, if you update
the original, none of the changes you make are applied to the copies. It can become
a tedious and difficult management task. Making clone layers instead of duplicates lets
you control all the copies by modifying the original and also improves project playback
and rendering performance.
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Each cloned item is copied and named “Clone Layer,” “Clone Layer 1,” and so on. When
you clone a layer, the cloned layer is placed in its original group. When you clone a
group, a new group is created that contains the clone. Cloned items are identified in
the Layers tab with an icon for a cloned layer and an icon for a cloned group.

Cloned image layer Cloned 3D group

For more information, see Making Clone Layers.

• Reveal Source Media: Opens the Media tab and highlights the item that corresponds
with the selected item in the Canvas or Timeline. The Inspector is also updated to reveal
the properties of the source media. (Shift-F)

Favorites Menu
The Favorites menu remains empty until you create your own favorite effects. Once you
have created favorites and stored them in the Favorites Menu folder in the Library tab,
they appear in the Favorites menu, grouped by type.

• Show Favorites Menu Items: Opens the Library and displays the Favorites Menu folder.

View Menu
The View menu contains commands for controlling the Motion interface. Most of these
items affect the Canvas, but some also apply to the Timeline and other panes.

• Zoom In: Zooms into the Canvas. (Command-Equal Sign)

• Zoom Out: Zooms out of the Canvas. (Command-Hyphen)

• Zoom Level: This submenu lets you set a particular zoom level, or automatically zooms
your Canvas in or out to fit the entire width of the Canvas window. (Shift-Z)

• Zoom Time View: This submenu allows you to automatically zoom the contents of the
Timeline.

• To Project: Zooms your Timeline so the entire duration of the project fills the window.

• To Play Range: Zooms your Timeline so the area between the project In and Out
points fills the window.

• Full Screen Mode: Fills your entire monitor with the Canvas (with the Timing and Project
panes hidden). In this mode, you can do all normal Canvas operations including
playback. To leave Full Screen mode, choose the menu item again. (F8)

• External Video: Sends output to an external video monitor. (Command-F1 or
Command-F12)
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• Correct for Aspect Ratio: Adjusts the display of the Canvas to simulate the nonsquare
pixels that appear on a TV monitor.

• Show Full View Area: Turns on or off the display of layers that are completely off or
partially off the edges of the Canvas. Areas that are off the edges of the Canvas appear
semi-transparent by default.

• Use Drop Zones: Turns drop zones on and off. For more information on using Drop
Zones, see Drop Zones.

• Save View Defaults: Saves the current state of all the overlay settings (rulers, safe zones,
animation paths, 3D overlays, and so on) as the default state for new projects.

• 3D View: This submenu sets the view to a scene camera or default camera view in a
3D project. A scene camera is a camera that you add to a project. A default camera
view is a built-in camera view, such as Perspective, Right, or Top. This menu is identical
to using the Camera menu in the upper-left corner of the Canvas.

For more information on cameras and views, see 3D Compositing.

Note: Because project elements are 2D (flat) objects, the elements are not visible when
you use the orthogonal camera views (Front, Back, Left, Right, Top, and Bottom) unless
the elements are rotated in 3D space (or text, particles, or the replicator are using the
Face Camera parameter in their respective Inspectors). This is because orthogonal views
are at right angles (perpendicular) to the elements. When an object is selected, a thin
gray line represents the object in the Canvas.

• Active Camera: Shows the view from the active camera.

• Perspective: Shows the perspective camera view. The perspective view defaults to a
view from the front center. Use the 3D View tools to pan, orbit, or dolly the camera.

• Front: Shows the front camera view. Use the 3D View tools to pan, orbit, or dolly the
camera.

• Back: Shows the back camera view (the view from the back of the scene). Use the
3D View tools to pan, orbit, or dolly the camera.

• Left: Shows the left camera view (the view from the left of the scene). Use the 3D
View tools to pan, orbit, or dolly the camera.

• Right: Shows the right camera view (the view from the right of the scene). Use the
3D View tools to pan, orbit, or dolly the camera.

• Top: Shows the top camera view (the view from the top of the scene). Use the 3D
View tools to pan, orbit, or dolly the camera.

• Bottom: Shows the bottom camera view (the view from the bottom of the scene).
Use the 3D View tools to pan, orbit, or dolly the camera.

• Next Camera: When the Canvas is active, changes your view to the next scene camera
based on camera order in the Layers tab. (Option-C)
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• Select Active Camera: Selects the camera currently active in the Timeline.
(Option-Control-C)

• Reset View: Resets the camera view to its default orientation. (Option-R)

• Fit Objects into View: Reframes the current camera to automatically fit the selected
objects into the Canvas. (F)

• Frame Object: Frames the selected objects in the active view. If no objects are selected,
Frame Objects resets the reference camera to view all the objects in the scene. For
more information on camera views, see 3D View Tools.

• Focus on Object: Used when a camera has depth of field turned on. Adjusts the
camera’s Focus Offset to the selected object. (Control-F) For more information, see
Depth of Field.

• Channels: This submenu sets the Canvas to display individual color or transparency
channels. Current settings are indicated with a checkmark beside the item in the menu.
This menu is identical to the Channels pop-up menu above the Canvas.

• Color: Shows the image just as it would appear on a video monitor. Visible layers
appear in natural color and transparent areas reveal the background color as set in
the Project Properties. This is black by default. (Command-J)

• Transparent: Shows the background area of the Canvas as transparent. A checkerboard
pattern appears by default where no images block the background.

• Alpha Overlay: Displays the image in normal color, but adds a red highlight over
transparent areas of the image.

• RGB Only: Displays the normal mix of red, green, and blue channels but transparent
areas (including semi-transparent areas) are treated as opaque.

• Red: Sets the Canvas to display only the red channel as a range of black to white.
(Shift-R)

• Green: Sets the Canvas to display only the green channel as a range of black to white.
(Shift-G)

• Blue: Sets the Canvas to display only the blue channel as a range of black to white.
(Shift-B)

• Alpha: Sets the Canvas to display the alpha (transparency) channel of the layers in
the Canvas. (Shift-A)

• Inverted Alpha: Sets the Canvas to display an inverted view of the alpha (transparency)
channel. (Shift-Option-A)

• Toggle Current & Alpha: Switches back and forth between viewing the current state
and just the alpha channel. (V)
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• Resolution: This submenu sets the quality level of the Canvas. Reducing the resolution
improves playback performance. Choose from Full (Shift-Q), Half, Third, and Quarter
resolution. Each lower setting further degrades the image. The current setting is
indicated with a checkmark beside the menu item.

• Quality: Sets the display mode for objects in the Canvas, such as text and images, to
Draft, Normal, Best, or Custom.

• Draft: Renders objects in the Canvas at a lower quality to allow optimal project
interactivity. There is no antialiasing, and 32-bit (floating point) footage is truncated
to 8-bit.

• Normal: The default setting, renders objects in the Canvas at a medium quality.
Shapes are antialiased, but 3D intersections are not. Floating point (32-bit) footage
is truncated to 8-bit.

• Best: Renders objects in the Canvas at best quality, which includes higher-quality
image resampling, antialiased intersections, and antialiased particle edges. If the
project contains any floating point QuickTime images, the floating point versions of
those files are loaded and rendered in 32-bit float color space. This option slows
down project interactivity. For more information on float color space, see About Bit
Depth.

• Custom: Allows you to set a variety of additional controls to customize render quality.
Choosing Custom opens the Advanced Quality Options dialog. For information on
the settings in the Advanced Quality Options dialog, see Advanced Quality Settings.

Tip: When working in your project, work in Draft or Normal for better interactivity.
When you are ready to export your project, use Best or Custom.

Note: 10-bit YUV (Y′CBCR) files render at 8-bit in the Canvas unless Render Quality is set
to Best.

Tip: When exporting a project using the “Movie - current project and Canvas settings”
option (from the Use pop-up menu in the Export dialog), set Render Quality to Best
prior to exporting.

• Render Options: This submenu contains rendering controls that typically impact playback
speed. Turn these items off to improve system performance.

• Lighting: Turns off lighting to improve performance. When lighting is enabled, a
checkmark appears beside the menu item. (Option-L)

• Shadows: Turns off rendering of shadows to improve performance. When shadow
rendering is enabled, a checkmark appears beside the menu item. (Control-Option-S)

• Reflections: Turns off rendering of reflections to improve performance. When reflection
rendering is enabled, a checkmark appears beside the menu item. (Control-Option-R)
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• Depth of Field: Turns off depth of field rendering to improve performance. When
depth of field rendering is enabled, a checkmark appears beside the menu item.
(Control-Option-D)

• Motion Blur: Turns off motion blur rendering to improve performance. When motion
blur rendering is enabled, a checkmark appears beside the menu item. (Option-M)

• Field Rendering: Turns off field rendering to improve performance. When field
rendering is enabled, a checkmark appears beside the menu item. (Option-F)

• Frame Blending: Turns off frame blending to improve performance. When frame
blending is enabled, a checkmark appears beside the menu item. (Control-Option-B)

• Preview Float Bit Depth: When working in 32-bit float color space, turning this setting
off drops the preview in the Canvas to 8-bit. Because working in float space drastically
increases processing time, turn this setting off to speed your workflow. This setting
does not modify the actual output of the project.

• Show Overlays: Turns the display of all overlays on and off in the Canvas. This setting
must be on in order to view any of the other overlay items (grids, guides, and so on).
When Show Overlays is active, a checkmark appears beside the menu item.
(Command-Slash)

• Show Rulers: Turns display of rulers in the Canvas on and off. When rulers are visible, a
checkmark appears beside the menu item. (Command-Shift-R)

• Show Tool Info: Displays a brief description of the tool the cursor is currently hovering
over. (Option-T)

• Overlays: This submenu turns the various indicators, guides, and grids in the Canvas
on and off.

• Grid: Turns the display of a grid on and off. You can customize the grid in the Canvas
pane of Motion Preferences. When the grid is displayed, a checkmark appears beside
the menu item. (Command-Apostrophe)

• Guides: Turns the display of guides on and off. When guides are visible, a checkmark
appears beside the menu item. (Command-Semicolon)

• Dynamic Guides: Turns dynamic guides on and off. Dynamic guides are the lines that
appear when you drag one item into alignment with another layer. When dynamic
guides are enabled, a checkmark appears beside the menu item.
(Command-Shift-Semicolon, or to quickly turn dynamic guides off and on, press N.)

• Safe Zones: Turns the display of title safe and action safe guides on and off. You can
customize the safe zones in the Canvas pane of Motion Preferences. When safe zones
are displayed, a checkmark appears beside the menu item. (Apostrophe)

• Film Zones: Turns display of film-based aspect ratio guides on and off. You can
customize the film zones in the Canvas pane of Motion Preferences. When film zones
are displayed, a checkmark appears beside the menu item. (Shift-Apostrophe)
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• Handles: Turns the display of object handles in the Canvas on and off. The handles
are the corner points that let you manipulate an object. When handles are displayed,
a checkmark appears beside the menu item.

• Lines: Turns the display of object border lines on and off. When lines are displayed,
a checkmark appears beside the menu item.

• Animation Path: Turns display of keyframe animation paths on and off. Animation
paths are the lines that show where an object moves in the Canvas. When animation
paths are displayed, a checkmark appears beside the menu item.

• Guides: This submenu lets you control the guides in the Canvas.

• Lock Guides: Causes all guides to be fixed in their current position. This prevents you
from accidentally moving a guide instead of moving an object
(Command-Option-Semicolon).

• Unlock Guides: Releases guides to be manually manipulated.

• Clear Guides: Removes all guides from the Canvas.

• Add Vertical Guide: Adds a vertical guide to the Canvas.

• Add Horizontal Guide: Adds a horizontal guide to the Canvas.

• Snap: Turns object snapping on and off in the Canvas. Snapping automatically aligns
objects as you drag them. When snap is enabled, a checkmark appears beside the menu
item (N).

• Show 3D Overlays: Turns all 3D overlays on and off, including the 3D View tools, 3D
Compass, Inset view, 3D grid, and 3D scene icons.

• 3D Overlays: This submenu controls the display of 3D overlays in the Canvas.

• 3D View Tools: Turns the Camera menu and 3D View tools on and off.

• Compass: Turns the 3D Compass on and off. The compass shows your current
orientation in 3D space. The red axis is X (horizontal), the green axis is Y (vertical),
and the blue axis is Z (depth). When you pause the pointer over the compass, its
state becomes active, allowing you to choose a new view by clicking one of the
colored view icons, such as front, left, right, perspective, and so on. The Canvas
animates the view change, rotating to the new view.

• Inset View: Turns the Inset view on and off. When enabled, a temporary window
appears in the lower-right corner of the Canvas and displays a perspective or active
camera view of your project that helps you stay oriented as you move objects in 3D
space. You can change the size of the Inset view, as well as control whether the Inset
view appears on transform changes, on all changes, or manually.

• 3D Grid: Turns the 3D grid on and off. The 3D grid helps you stay oriented while
working in 3D space and can be used to guide the placement of objects in your
project. The 3D grid appears only when you are in 3D mode.
(Command-Shift-Apostrophe)
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• 3D Scene Icons: Turns all 3D scene icons, such as lights and cameras on and off. The
scene icons appear in the Canvas as wireframe icons, and each includes red, green,
and blue handles that let you transform and rotate the camera or light.

• Show/Hide Fonts: Displays (or hides) the Font dialog for selecting fonts and font
attributes. (Command-T)

• Show/Hide Colors: Displays (or hides) the Colors window for selecting colors.
(Command-Shift-C)

• Show/Hide Toolbar: Turns the display of the Toolbar on or off. This is equivalent to
clicking the Toolbar button at the upper-right corner of the Canvas. (Command-Option-T)

• Customize Toolbar: Opens the Customize Toolbar dialog.

Window Menu
This menu contains controls to show and hide all of the windows, panes, and tabs in the
Motion interface. You can also choose and manage window layout sets.

• Minimize: Shrinks the active window to the Dock. This is equivalent to clicking the
Minimize button at the upper left of the window. (Command-M)

• Minimize All: Shrinks all windows (except the utility window) to the Dock. For example,
if the Keyframe Editor is floating and you select Minimize All, the Keyframe Editor
window and the active project window are minimized to the dock.

• Zoom: Resizes the active window to maximize desktop real estate. Switches between
full screen and the previously saved non-full screen state.

• Save Current Layout: Stores the current window arrangement. Choosing this option
requires you to name the layout you want to save. The new layout appears in the
Layouts submenu.

• Manage Layouts: Opens the Manage Layouts dialog where you can add, delete,
duplicate, and modify custom window layouts.

• Layouts: This submenu is where you can choose from existing window layouts. Choose
one of the layouts from the submenu to rearrange your windows to that pre-saved
state. For more on managing window layouts, see Window Arrangements.

• Create Locked Inspector: Creates a new Inspector window that doesn’t update based
on the selection. To unlock the Inspector, click the lock in the Preview area of the
Inspector.

• Show Inspector: This submenu provides direct access to any of the four tabs in the
Inspector window: Properties (F1), Behaviors (F2), Filters (F3), and Object (F4). The Object
tab changes depending on what type of object is selected.

• Show/Hide Project Pane: Turns the display of the Project pane on or off. (F5)

• Show/Hide Timing Pane: Turns the display of the Timing pane on or off. (F6)
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• Show/Hide HUD: Turns the display of the HUD on or off. (F7)

• Show/Hide Background Task List: The Background Task List window displays any
background processing when Motion performs optical flow retiming.

For more information on optical flow, see the Optical Flow pop-menu item in Timing
Controls in the Properties Tab.

• File Browser: Turns the display of the File Browser on or off. If the utility window is not
present, one is created. If the File Browser is the only tab in the utility window, this
command closes the window. (Command-1)

• Library: Turns the display of the Library on or off. If the utility window is not present,
one is created. If the Library is the only tab in the utility window, this command closes
the window. (Command-2)

• Inspector: Turns the display of the Inspector on or off. If no utility window is present,
one is created. If the Inspector is the only tab in the utility window, this command
closes the window. (Command-3)

• Layers: Turns the display of the Layers tab on or off. If the Project pane is not visible,
this command causes it to appear. If Layers is the only tab in the Project pane, this
command closes the pane. (Command-4).

• Media: Turns the display of the Media tab on or off. If the Project pane is not visible,
this command causes it to appear. If Media is the only tab in the Project pane, this
command closes the pane. (Command-5)

• Audio: Turns the display of the Audio tab on or off. If the Project pane is not visible,
this command causes it to appear. If Audio is the only tab in the Project pane, this
command closes the pane. (Command-6)

• Timeline: Turns the display of the Timeline on or off. If the Timing pane is not visible,
this command causes it to appear. If the Timeline is the only tab in the Timing pane,
this command closes the pane. (Command-7)

• Keyframe Editor: Turns the display of the Keyframe Editor on or off. If the Timing pane
is not visible, this command causes it to appear. If the Keyframe Editor is the only tab
in the Timing pane, this command closes the pane. (Command-8)
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• Audio Editor: Turns the display of the Audio Editor on or off. If the Timing pane is not
visible, this command causes it to appear. If the Audio Editor is the only tab in the
Timing pane, this command closes the pane. (Command-9)

• Bring All to Front: If any Motion windows are hidden behind windows from other
applications, this command moves the windows to the front.

• Open Project/Untitled List: All open projects appear at the bottom of the Window menu.
An unsaved project is listed as “Untitled.” Choosing an item from this list brings that
project’s Canvas to the front.

Help Menu
The Help menu provides access to resources for learning more about Motion.

• Motion Help: Opens the Motion User Manual.

• Release Notes: Opens a webpage with a file containing last-minute release information
about Motion, as well as changes to the documentation that may affect your use of
the software.

• New Features: Opens a webpage summarizing new features in Motion 4.

• Motion Support: Opens a webpage that contains up-to-date technical support
information about Motion.

• Motion on the Web: Opens a web link to the Apple Motion online community. This site
contains additional tutorials, training resources, information about product updates,
and other information.

• Apple Training Centers: Opens a link to the Apple Training Centers webpage, where
you can find information about Apple-authorized training in your area.

• Create Support Profile: Generates a special file describing the technical details about
your workstation such as processor speed, video card specifications, and so on. This
file is used only by authorized Apple technical support technicians.
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Motion Preferences allow you to customize your workspace, tailor the interface for different
types of projects, and define the presets for new projects and for exporting finished
movies. The Motion Preferences window contains nine panes that group global settings
according to function: General, Appearance, Project, Cache, Canvas, 3D, Output, Presets,
and Gestures. To open the Motion Preferences window, choose Motion > Preferences (or
press Command-Comma).

This chapter covers the following:

• General Pane (p. 182)

• Appearance Pane (p. 184)

• Project Pane (p. 186)

• Cache Pane (p. 189)

• Canvas Pane (p. 191)

• 3D Pane (p. 193)

• Output Pane (p. 195)

• Presets Pane (p. 197)

• Gestures Pane (p. 202)
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General Pane
The General Preferences pane contains settings that apply globally to all aspects of Motion,
grouped into the following categories: Startup, Interface, File Browser & Library, Content
Library & Templates, Media, and Keyframe Editor.

Startup
This section of the General Preferences pane allows you to define what Motion does when
first opened. Choose an item from the pop-up menu.

At Startup pop-up menu: This pop-up menu allows you to choose the default behavior
when Motion is launched. Select from one of four options.

• Open Last Project(s): Any projects that were open when the program was last quit are
reopened. This allows a continuity of work across sessions.

• Create New Project: This command opens a new empty project. If a default preset has
not been chosen, the Select Project Preset dialog appears at startup.

• Show Welcome Screen: This is the default setting. Upon startup, you are presented with
four options: To View the Quick Tours (links to web-based QuickTime tours of the
application), Begin with an Online Tutorial (links to web-based tutorials of the
application), Start with a Template (opens the Template Browser), or Start with a New
Project. To skip the initial screen, change the Motion Preferences (or turn off the “Show
the Welcome Screen at startup” checkbox in the welcome screen).

• Browse Templates: This option takes you directly to the Template Browser. For more
information on working with templates, see Creating New Projects from Templates.

Interface
This section of the General Preferences pane allows you to set some general options for
the interface.
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Drop Menu Delay: This setting determines how long you must wait before the drop
menu appears when dragging to the Timeline, mini-Timeline, Layers tab, or Canvas. The
drop menu provides additional choices for editing and importing objects into the project.

Show Tooltips: This checkbox turns tooltips on and off across the application. Tooltips
provide explanatory information such as names and basic usage techniques. They appear
when you pause the pointer over tools and controls.

File Browser & Library
These settings in the General Preferences pane affect how the utility window displays
the contents of the File Browser and Library.

Display Folders: This setting lets you choose between listing folders alphabetically within
the list or grouped together at the end of the list after all nonfolder items.

Show preview icons: This checkbox turns preview icons on and off in the utility window.
For example, when the checkbox is selected, the first frame of a QuickTime movie is
displayed. When it is deselected, the Finder QuickTime icon is displayed.

Preview iconsGeneric icons

Note: The screen shots in the Motion User Manual were taken with the “Show preview
icons” checkbox deselected in Motion Preferences.

Play items automatically on a single click: This checkbox controls whether the Preview
area automatically plays the contents of the item selected in the file stack.

Content Library & Templates
Use this control to change the location of your Motion content folder. This also allows
multiple users on a network to share a single, centralized folder.

To set the Motion content path
1 Click Choose (next to Library Path).

2 In the dialog that appears, navigate to the content’s location, then click Choose.

3 Restart Motion.

To reset the Motion content path to its default location
µ Click Reset (next to the Choose button).
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Media
This section in the General Preferences pane contains the “Automatically manage unused
media” checkbox. When the checkbox is selected, Motion removes unused media from
the Media tab whenever you delete that media from the Canvas, Layers tab, or Timeline
layers list. If you want to retain (in the Media tab) a copy of media that is no longer used
in your project, deselect this checkbox.

Keyframe Editor
This section in the General Preferences pane contains the “Lock Keyframes in Time”
checkbox. When the checkbox is selected, you can change the values of keyframes in the
Keyframe Editor, but you cannot move the keyframes forward or back in time. This helps
prevent changing your animation timing as you adjust values.

Appearance Pane
The Appearance pane of the Motion Preferences window contains settings that control
visual elements of the Motion interface, grouped into the following categories: HUD,
Thumbnail Preview, Timeline, and Status Bar.

HUD
The HUD (heads-up display) is a semi-transparent window that floats above the other
windows on your screen. Use the Window Opacity slider in the HUD section of the
Appearance pane to set the opacity (transparency) of the HUD.

Thumbnail Preview
The thumbnails that appear in the Layers tab of Motion can provide helpful information
about the items selected in that window. For items that are partially transparent (contain
an alpha channel), you can set the background that appears behind the image. There are
two background options: Checkerboard and Color. Choose either of these options from
the Background menu in Thumbnail Preview section of the Appearance pane.

Background: A pop-up menu with two options for thumbnail backgrounds.

• Checkerboard: This is the default setting. It displays a checkerboard pattern where
transparent pixels appear.

184 Chapter 5 Preferences



• Color: This setting displays a solid color where transparent pixels appear.

Background Color: When Color is chosen from the Background pop-up menu, this color
well is enabled and allows you to select a new background color from the Colors window
or pop-up color palette.

Timeline
This section of the Appearance pane lets you choose how to display the bars that appear
in the Timeline to represent your objects. Choose a timebar style from the Timebar Display
pop-up menu.

Timebar Display: A pop-up menu with three options.

• Name: The bars in the Timeline display the object name only.

• Name Plus Thumbnail: This setting is the default. Bars in the Timeline display an icon
representing the first frame of the object followed by the name of the object.

• Filmstrip: Bars in the Timeline are displayed as a continuous strip of frames. The name
text does not appear. For an example of the different states, see Specifying the Track
Display. Only layers (shapes, images, image sequences, text, and so on) display a
thumbnail or a continuous strip of frames. Objects such as cameras, lights, and behaviors
do not display a thumbnail.

Status Bar
The Status Bar is the area in the Motion workspace above the Canvas and below the
Toolbar. You can choose to display three different types of information in this area: Color,
Coordinates, and Frame Rate. You can also choose from three different methods of
representing the color data. All of these settings are available in the Status Bar section of
the Appearance pane.

Color: Turn on this checkbox to display the color value of the pixel currently under the
pointer. Colors are displayed in the format chosen in the Display Color As pop-up menu.

Coordinates: Turn on this checkbox to display the X and Y coordinates of the current
pointer position.

Frame rate: When this checkbox is selected, Motion displays the frame rate of the project
during playback. Nothing is displayed unless the project is playing.

Display Color As: When the Color checkbox is selected, use this pop-up menu to choose
from among three styles for displaying the color data.

• RGB: This setting displays the red, green, blue, and alpha values of each pixel in ranges
of 0–255. The Alpha value is also displayed.

• RGB (Percent): This setting displays the red, green, blue, and alpha values of each pixel
in ranges of 1–100.
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• HSV: This setting displays the color as hue, saturation, and value (brightness) where
hue is a value from 1–360, and saturation and value are ranged from 1–100. Alpha is
also displayed ranged from 1–100.

Project Pane
The Project Preferences pane contains settings for timing, display, and playback options.
There are four categories of controls: Default Settings, Time Display, Still Images & Layers,
and Playback Control.

Default Settings
These controls in the Project Preferences pane determine default values for newly created
projects. To change these settings for a specific project, use the Project Properties dialog
instead (choose Edit > Project Properties or press Command-J).

Note: These settings only take effect in projects created after the preferences are set. Any
currently opened projects are not affected.

Project Duration: Sets the default duration for new projects. You can type a number into
the value field and choose Frames or Seconds from the pop-up menu.

Background Color: A color well that sets the color of the background for any new projects
that are created after the color has been changed. This does not change the background
color of the current project. To change the background color for a current project, choose
Edit > Project Properties (or press Command-J) and use the Background Color controls.

Note: To render a new background color into your final output, you must choose Solid
from the Background pop-up menu in the General tab of the Project Properties dialog
(press Command-J).
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Time Display
The controls in this section of the Project Preferences pane set how the time counters
across the application are displayed.

Display Time As: A pop-up menu with two choices:

• Frames: Displays all counters as incrementing frame numbers.

• Timecode: Displays all counters as eight-digit timecode numbers.

Frame Numbering: A pop-up menu that lets you choose whether frame counts begin
at zero or one.

Still Images & Layers
These settings in the Project Preferences pane control the default duration, placement,
and size of still images and imported layers, as well as layers created in Motion, such as
text, shapes, and masks.

Default Layer Duration: You can specify the duration of still images, generators, and
other layers that lack an inherent duration in one of two ways:

• Use project duration: All layers are the same duration as the project.

• Use custom duration: Layers are the duration defined in this value field.

Duration: If Default Layer Duration is set to “Use custom duration,” enter a value in this
field, and use the pop-up menu to set the time to Frames or Seconds.

Create Layers At: When you drag layers to the Canvas, the Layers tab, or the Timeline
layers list, they can either be added to the project at the current playhead position or
they can be added at the first frame of the project. This setting also applies to layers
created within Motion, such as text or shapes.

• Current frame: Creates layers at the current playhead position.

• Start of project: Creates layers at the first frame of the project.

Large Stills: When importing large still images, set this pop-up menu to instruct Motion
to import the file at its original size, to change the resolution of the image to fit the Canvas
size, or to scale the image down to fit the Canvas size.

Note: For more information on the differences between the Large Stills options, see Using
High-Resolution Still Images.

The Large Stills pop-up menu has three options:

• Do Nothing: Imports the image at its original size.

• Scale to Canvas Size: Imports and scales the image to fit the project size while
maintaining its aspect ratio.

• Down-Res to Canvas Size: This setting changes the resolution of the imported image
so that the image fits the project size while maintaining its aspect ratio.
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Playback Control
These settings in the Project Preferences pane control how Motion plays back your project.

Time View Updating: When the Timing pane is visible, you can set the view to
automatically move along with your project’s playback. Make one of the following choices
from the pop-up menu:

• Don’t update: The Timing pane does not change as you play. This setting improves
performance.

• Jump by pages: As the playhead reaches the end of the current view, the window jumps
forward. The playhead crosses the screen again, and so on.

• Scroll continuously: The playhead remains static and the Timing pane scrolls by behind
it.

If Audio Sync Is Lost: Motion always attempts to keep audio and video playback locked
in sync, but if the project is too complex to play both audio and video smoothly, one or
the other must be compromised. Choose from one of two options:

• Skip video frames: Audio continues to play, but video frames are skipped to keep up.

• Pause audio playback: Audio playback is temporarily suspended during playback.

Limit playback speed to project frame rate: Motion plays back your project as fast as
possible based on the complexity of the effects and the strength of your computer. When
this checkbox is selected, playback rate never exceeds the frame rate of your project. This
means you can watch your project play back at the same frame rate as your exported
movie. When the checkbox is deselected, playback rate is only limited by your processor
power and may play much faster than the project frame rate.

Loop audio while scrubbing: When this checkbox is selected, the audio for the frames
where you drag the playhead repeats. When the checkbox is deselected, the audio for
those frames plays only once.
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Cache Pane
The Cache pane contains settings to control the cache for projects. There are four
categories of controls: Memory & Cache, Autosave, LiveFonts, and Optical Flow Retiming.

Memory & Cache
This setting in the Cache pane of the Preferences window lets you specify how much
memory is allocated to the project cache.

Project Cache: Enter a number in the value field to specify the percentage of your total
system memory that you want to use for the project cache. The larger the number, the
more memory available to Motion to cache frames, resulting in a higher likelihood of
consistently smooth playback.

Autosave
These settings in the Cache pane of the Preferences window control how frequently
projects are automatically saved, as well as the location of the saved files. Saved projects
are time-and-date stamped.

Use Autosave Vault: When this checkbox is selected, Motion stores auto-saved projects
to the location specified by the Autosave Vault Folder path. By default, the Autosave Vault
folder is located in a folder called Motion Documents in the Documents folder of your
home directory.

Save a copy every: Specifies how often, in minutes, a project is saved.

Keep at most: Specifies how many versions of the autosaved project to store in the vault.

Maximum of: Specifies the maximum number of different auto-saved projects to store
in the vault.

Autosave Vault Folder: The Choose button allows you to set where the Autosave files
are kept. The Reset button sets the Autosave location back to its default.
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Customizing Autosave
There are a number of ways to customize Autosave for your needs.

To store auto-saved projects in a specific location
1 Choose Motion > Preferences (or press Command-Comma).

2 Click Cache.

3 In the Autosave group, turn on Use Autosave Vault.

By default, the Autosave Vault folder is located in a folder called Motion Documents in
the Documents folder of your home directory.

To set a new location for the Autosave vault
µ Click Choose, set a new location in the dialog, then click Choose.

To revert to an auto-saved project
1 Choose File > Restore from Autosave.

The Restore Project dialog appears.

2 Choose a saved project from the pop-up menu.

Note: A project must be saved before the Revert commands are available in the File
menu.

LiveFonts
These settings in the Cache pane of the Preferences window determine how LiveFonts
are cached (stored) by Motion. For more information about LiveFonts, see Using LiveFonts.

Cache intermediate LiveFont sizes: This checkbox turns caching of LiveFont data on or
off. This option is on by default, as it improves performance if you frequently use LiveFonts.

Cache Path: Click Choose to define a custom location to cache your LiveFont data. Because
this cache can grow quite large, it is advised that you set this to a drive other than your
primary system drive.

Delete LiveFont Cache: Over time, your LiveFont cache can grow to take up many
gigabytes of disk space. To recover this space, you can delete the cache by clicking this
button.
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Optical Flow Retiming
When you retime footage, Motion needs to store the retiming files. This setting in the
Cache pane of the Preferences window specifies where the retiming files are stored. You
can choose to store the files in the same location as the source footage or specify your
own location.

In folder with source media: Click this button to save the retiming files in the same
location as the source footage.

In this folder: Click the Choose button to specify where the optical flow retiming files
are stored. By default, the Optical Flow folder is located in the
/Users/username/Documents/Motion Documents/Retiming Cache Files folder.

Canvas Pane
This pane of the Preferences window contains settings to customize your Canvas view.
Changes made in this pane take immediate effect in your current project. There are five
categories of controls: Background, Alignment, Safe Zone, Film Zone, and Snapping.

Background
This section in the Canvas pane of the Preferences window allows you to choose a color
for the background of your Canvas—the color outside of the project boundaries. This
color is not exported with your project, but only acts as a guide for helping identify
transparent and colored layers.

Canvas Color: This color well allows you to choose a color for the background of the
Canvas.
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Full View Opacity: If Show Full View Area is enabled in the View menu, this setting
controls the opacity of the part of a layer that extends beyond the edge of the Canvas
into the background. When set to 100%, the layer is transparent. When set to 0%, the
layer is fully opaque.

Alignment
These settings in the Canvas pane of the Preferences window control the color and display
of the optional grid, rulers, and guides that appear in the Canvas. Grids, guides, and rulers
can be turned on and off in the View menu or in the View pop-up menu at the upper-right
corner of the main window.

Grid Spacing: This slider sets the width for the grid in pixels.

Grid Color: This color well sets the color of the grid lines.

Guide Color: This color well sets the color of guides.

Dynamic Guide Color: This color well sets the color for dynamic guides.

Ruler Location: This pop-up menu sets the position of the ruler in the Canvas. There are
four options:

• Bottom Left

• Top Left

• Top Right

• Bottom Right

Safe Zone
Safe zones are special guides to help you avoid putting layers in areas of the screen that
might not appear correctly on consumer television sets. Layers that appear outside the
action safe region may be cut off. The area outside the title safe region may have
distortions that make text hard to read. The safe zone guides can be turned on and off
in the View menu, or in the View pop-up menu at the upper-right corner of the main
window (above the Canvas). To customize how safe zones appear in the Canvas, use the
Safe Zone controls in the Canvas pane of the Preferences window.

Action Safe Region: Sets the percentage of the Canvas where the action safe guides
appear. (Default is 90% of canvas.)

Title Safe Region: Sets the percentage of the Canvas where the title safe guides appear.
(Default is 80% of canvas.)

Safe Zone Color: Sets the color of the safe zone guides.
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Film Zone
When producing output to be used for both television and film, it may be helpful to see
the area of the TV frame that will be cut off when it is converted to film. The film zone
settings allow you to display a guide that identifies the aspect ratio of the film gauge you
are working in. Film zone guides can be turned on and off in the View menu or in the
View pop-up menu at the upper-right corner of the main window. To customize how
film zones appear in the Canvas, use the Film Zone controls in the Canvas pane of the
Preferences window.

Aspect Ratio: This pop-up menu sets the guide size to match one of the standard aspect
ratios. Entering a number into the value field to the right of the pop-up menu sets a
custom aspect ratio. There are five menu choices:

• Academy Flat 1.85:1

• High Definition 16:9

• Academy Standard 4:3

• Anamorphic Scope 2.25:1

• Custom

Film Zone Color: Sets the color of the film zone guides.

Snapping
Objects in the Canvas automatically snap to other objects when you drag them around.
This setting in the Canvas pane of the Preferences window determines whether the
objects snap to objects’ center points, edges, or both centers and edges. Snapping can
be turned on and off in the View menu or by pressing N when the Canvas is active.

3D Pane
The 3D Preferences pane lets you control various aspects of working in the Motion 3D
workspace. There are two categories of controls: General and 3D Grid.

General
This area of the 3D Preferences pane lets you control the Inset view and choose whether
new groups default to 2D or 3D mode.
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Display Inset View: A pop-up menu that lets you control whether the Inset view appears
on transform changes, on all changes, or manually. Inset View must be enabled in the
View menu or View pop-up menu for the Inset view to appear.

• On Transform Change: The Inset view appears when adjusting an object’s transform
parameters such as position, rotation, or scale.

• On All Changes: The Inset view appears when making adjustments specific to an object,
such as adjusting the parameters of a replicator, in the HUD or Inspector.

• Manually: When this option is selected, the Inset view is displayed all the time.

Inset view

Inset View Size: Use the slider to adjust the size of the Inset view.

Default New Group Type: Use this pop-up menu to specify whether new groups are
created as 2D or 3D groups. When set to Automatic, Motion determines the type of group
that is created based on the project. For example, when Automatic is selected and you
are working in a 3D project, new groups are 3D. If you are working in a 2D project (no
camera), new groups are 2D.

3D Grid
This area of the 3D Preferences pane lets you modify settings for the grid that appears
in the Motion 3D workspace.

3D Grid Spacing: Specifies the spacing between grid lines, in pixels.

Primary Grid Color: Lets you set the color of the main grid lines. The main grid lines
appear slightly heavier than the secondary grid lines.

Secondary Grid Color: Lets you set the color of the secondary grid lines (the lines that
appear within the main grid lines).
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Output Pane
The Output Preferences pane tells Motion to render the contents of the Canvas out to a
video deck or monitor connected to your computer via FireWire or another port. This
pane has one category of settings: External Video.

To view Motion video output on a computer display connected to your computer
1 Choose Motion > Preferences.

2 In the Output pane, choose one of the display options from the Video Output pop-up
menu.

Video Output in Motion
If you’re creating work that is intended to be viewed on a TV monitor (such as broadcast
design or DVD menus), it’s imperative that you see your design on such a monitor before
finalizing your Motion project. While you can do a great deal of layout and color
adjustments on your computer screen, you might be surprised how different things
may look when they appear on a TV screen.

First, whether you’re working in NTSC (the American and Japanese TV standard) or
PAL/SECAM (the European TV standard), colors are going to look quite different from
the way they look on your computer monitor. (NTSC has been affectionately referred
to as “Never Twice the Same Color.”)

Furthermore, TV signals are interlaced, meaning that the vertical resolution is cut in half
and displayed at twice the rate. This can mean that thin horizontal lines in your design
(such as font serifs) may buzz or flicker when played back on a TV screen.

Fortunately, Motion allows you to view the contents of your Canvas directly on a TV
monitor that is connected to your computer. You can connect a monitor to your
computer using a FireWire device such as a DV camcorder or deck, or by using a third
party video capture card. For accurate results, you should use a professional-grade
monitor with calibration controls.

External Video
These settings in the Output Preferences pane control how Motion plays your project
directly to a video deck or monitor connected to your computer.
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Video Output: Set this pop-up menu to match the type of device connected to the
monitor. When this is set to anything other than None, Motion outputs a new frame to
the externally connected video monitor every time you release the mouse button (if the
Canvas has changed). If no deck or video monitor is connected, the menu is set to None.

If you have two computer displays, one can be used to view the Motion interface and
the Finder while the other can be used as a dedicated video monitor using an Apple
Cinema Display as an external monitor. The following external video monitoring choices
are available depending on the number and type of monitors connected:

• Digital Cinema Desktop Preview: The video is not scaled unless it is too large to fit on
the display. If the video signal is larger than the display, it is scaled to fit on the display.

The video always maintains proper aspect ratio and does not exhibit scaling artifacts
due to magnification, however, some formats, especially SD formats, may look very
small when displayed on large computer displays.

• Digital Cinema Desktop Preview - Full Screen: The video is scaled to fit the display in at
least one dimension. If the aspect ratio of the video signal and the computer display
do not match, the video on the display is letterboxed (black on top and bottom) or
pillarboxed (black on sides) as necessary.

This format gives you the biggest picture possible and maintains the proper aspect
ratio, however, scaling artifacts may be noticeable when viewed up close.

• Digital Cinema Desktop Preview - Main: Uses your main monitor as the Digital Cinema
Desktop display. The video is scaled to fit the display in at least one dimension.

This format gives you the biggest picture possible and maintains the proper aspect
ratio, however, scaling artifacts may be noticeable when viewed up close.

• Digital Cinema Desktop Preview - Raw: This mode shows the video data with as little
processing as possible. This can be useful for engineering evaluations of the image. No
scaling is done whatsoever.

Using this option, more accurate assessments of video quality can be made. This option
is not useful for general viewing, as no scaling or pixel aspect ratio adjustments are
made, even when the video is larger than the display.

Note: For example, a 720p frame (1280 x 720) showing in raw mode on an 800 x 600
display only shows 800 x 600 of the image.

• None: This mode is automatically selected when no deck or video monitor is connected
to your system.

Options: When the Video Output pop-up menu is set to one of the Digital Cinema Desktop
Preview settings, the Options button becomes active. For monitors connected via FireWire,
there is no need to adjust the options. For monitors connected via third-party hardware,
the options may have applicable settings.
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Update during playback: Plays the project out to the external video monitor while the
project plays back in the Canvas. This option severely degrades performance.

Update dynamically on parameter change: Sends a new video frame out to the external
video as you adjust parameters (instead of only after releasing the mouse button). This
option may severely degrade performance.

Presets Pane
The Presets Preferences pane contains presets for both project settings and export settings.
In this pane, you can choose defaults, as well as create, modify, and delete settings. The
default project preset determines the settings assigned when you create a new project.
You can change any of these settings while you are working by opening the Project
Properties window (choose Edit > Project Properties or press Command-J).

Show: This pop-up menu lets you choose between modifying presets for new projects
or modifying presets for exporting.

Preset list: Below the Show menu, the current list of presets appears. The checkbox to
the left of each name identifies the default preset. Check a different box to select a new
preset. The column on the right shows which presets are locked. Locked presets cannot
be modified. You can duplicate a locked preset and edit the copy.

Summary box: To the right of the Preset list, the Summary box displays details of the
currently selected preset.

Create new documents using default: When this checkbox is selected, creating a new
project automatically uses the default project preset. When this checkbox is deselected,
creating a new project displays the Select Project Preset dialog so you can choose a preset
for the new project.

Add New Preset: Click the Add button (+) to display the Project Preset Editor dialog and
create a new preset.

Remove Preset: To remove a preset, select the preset you want to remove and click the
Delete button (–).
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Duplicate: To duplicate a preset, select the preset you want to duplicate, then click
Duplicate.

Edit: To edit a preset, click the Edit button. If the Show pop-up menu is set to Project
Presets, the Project Preset Editor opens. If the Show pop-up menu is set to Export Presets,
the Export Options window opens. See Project Preset Editor and Export Options Window
for more information.

Project Preset Editor
The Project Preset Editor dialog is where you make changes to a project preset.

Note: Locked presets cannot be edited. If you attempt to edit a locked preset, an alert
dialog appears, a duplicate copy of the preset is made, and your edits are applied to the
duplicate.

To open the Project Preset Editor
1 In the Presets Preferences pane, choose Project Presets from the Show pop-up menu

(located in the upper-left corner of the pane).

2 Click the Edit button, then do one of the following:

• Double-click an unlocked preset in the Preset list.

Note: When you double-click a default preset in the Preset list of the Presets pane, an
alert dialog appears stating that the selected preset cannot be modified. Click OK to
create an editable copy of the preset.

• Select a nonlocked item in the Preset list and click the Edit button.

• Select an item in the Preset list, click Duplicate, select the copied preset, then click the
Edit button.

The Project Preset editor contains the following settings:

Name: This editable field contains the name for the preset.
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Description: This field contains descriptive text to identify the preset. You can enter your
own descriptive text in this field. The new text will appear in the Summary box in the
Preset Preferences pane.

Width and Height: These fields set the frame size for the preset.

Pixel Aspect Ratio: Sets the pixel aspect ratio for the preset. This should match the type
of media with which you are working.

Field Order: Sets the field order for your project. DV projects typically use the Lower First
setting.

Frame Rate: Sets the frame rate for your preset. Click the list arrow to display common
rates or type your own custom value.

Export Options Window
The Export Options window is where you make changes to an export preset.

To open the Export Options window
1 In the Presets pane, choose Export Presets from the Show pop-up menu (located in the

upper left corner of the pane).

2 Click the Edit button, then do one of the following:

• Double-click an unlocked preset in the Preset list.

Note: When you double-click a default preset in the Preset list of the Presets pane, an
alert dialog appears stating that the selected preset cannot be modified. Click OK to
create an editable copy of the preset.

• Select a nonlocked item in the Preset list and click the Edit button.

• Select an item in the Preset list, click Duplicate, select the copied preset, then click the
Edit button.
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The Export Options dialog contains the following settings:

Information Fields
The Name and Description fields display information about the selected preset.

Name: This editable field contains the name for the preset.

Description: Contains descriptive text to identify the preset. This text appears in the
Summary box in the Preset Preferences pane. You can enter your own descriptive text in
this field.

The Video/Audio and Output tabs appear beneath the Name and Description fields. To
the right of the tabs, a summary box displays the details of settings from the two tabs.

Video/Audio Tab
The Video/Audio tab contains two groups of controls: Video and Audio.

Video Controls
This group of controls allows you to set your video output options.

Kind: Choose from QuickTime Movie, Still Image, or Image Sequence.

Note: Audio options are only available for QuickTime movies.

Compressor: Depending on the Kind setting, different compressor types are available.

Quality: For some compressors, you can set a quality setting. If the control is dimmed,
that compressor type does not offer variable quality.

Start number: For image sequences, you can set a starting frame number. Each file
generated in the image sequence has an incrementing number.

Add spaces: When generating image sequences, clicking the Add Spaces checkbox
causes extra spaces to be added to the filenames to ensure that the sequence of files is
read in proper order by some other applications.

Advanced: The Advanced button is only active for QuickTime movies. Clicking this button
opens the standard compression settings dialog. In most cases, you should not need to
make any changes in this dialog.

Audio controls
This group of controls allows you to set your audio output options.

Sample rate: Sets the audio sample rate for your exported movie. For best results, set
this to be the same sample rate as the source audio in your project.

Mix: Sets the audio output mix for your project. Use the default Stereo setting or choose
5.1 Surround.

Advanced: The Advanced button opens the standard Sound Settings dialog. In most
cases, you should not need to make any changes in this dialog.
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Output Tab
The Output tab contains the following controls:

Use current project and canvas settings: When this checkbox is selected, the current
project settings will override the current export settings. This allows one export preset
to be used with multiple project presets. When this checkbox is deselected, you can create
specific settings for the export preset.

Resolution: You can specify the output size to be relative to the project’s frame size (Full,
Half, Third, or Quarter), to be a preset, or you can choose Custom and type a specific
number into the width and height value fields. Lower resolutions should be used only
for draft versions.

Color: Choose whether the exported items include the color data only, color data plus
alpha channel (transparency), or just the alpha channel data.

Important: Some compressor types do not support alpha channels.

Premultiply alpha: When this checkbox is selected, semi-transparent pixels in your output
are mixed with black.

Frame Rate: Controls whether projects are output at the project frame rate, or at another
frame rate that you specify. There are two options:

• Use project frame rate: When this option is selected, the project is exported at the frame
rate defined in the Project Properties dialog.

• Use (fps): When this option is selected, you can define a frame rate other than the
current project frame rate. Choose a frame rate from the pop-up menu or manually
enter a frame rate.

Camera: Sets which camera view is used when you output a 3D project. Use the default
Active Camera setting or choose another scene camera.

Note: A scene camera is a camera that you add to a project, as opposed to a default
camera view that you choose in the upper-left corner of the Canvas (Top, Right,
Perspective, and so on). You can only export a project using a scene camera.

Lighting: When this checkbox is selected, the lighting effects are rendered with the
project. When this checkbox is deselected, no lighting effects appear in your final output.

Shadows: When this checkbox is selected, shadows are rendered with the project. When
this checkbox is deselected, no shadows appear in your final output.

Reflections: When this checkbox is selected, reflections are rendered with the project.
When this checkbox is deselected, no reflections appear in your final output.

Depth of Field: When this checkbox is selected, camera depth of field effects are rendered
with the project. When this checkbox is deselected, no depth of field effects appear in
your final output.
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Render Quality: Allows you to choose Draft, Normal, Best, or Custom quality for your
final output. The better the quality, the longer the render time. For descriptions of Draft,
Normal, Best, and Custom render qualities, see the Render pop-up menu section in Canvas
View Options. Selecting Custom opens the Advanced Quality Options dialog. For more
about the Advanced Quality Options dialog, see Advanced Quality Settings.

Field Rendering: When this checkbox is selected, the output always renders individual
fields regardless of the setting in the View menu pop-up menu (above the right side of
the Canvas). When it is deselected, frames are rendered whole, regardless of the setting
in the View pop-up menu.

Motion Blur: When this checkbox is selected, motion blur is applied to moving layers
regardless of the setting in the View pop-up menu (above the right side of the Canvas).
When deselected, no motion blur is applied.

Frame Blending: When this checkbox is selected, frame blending is applied to moving
footage in the rendered output. The result can be smoother looking playback, but this
option can increase rendering time.

Use Float Bit Depth: When working in float color space, turning this setting off drops
the rendered output to 8-bit. Because working in float space drastically increases
processing time, turn this setting off to speed your rendering time. This setting does not
affect the use of float bit depth in the Canvas.

Gestures Pane
The Gestures Preferences pane contains settings pertaining to using a graphics tablet to
control Motion.

You cannot turn on gestures in Motion unless you have a tablet attached to your computer
and Handwriting Recognition is turned on in the Ink preferences in System Preferences.
For convenience, you can open Ink Preferences directly from the Gestures Preferences
pane by clicking the Open Ink Preferences button.

For more information on using gestures, see Using Gestures.

Note: Swipes, pinches and other multi-touch gestures performed on a Multi-Touch
trackpad are unaffected by any settings in the Gestures tab of the preferences.
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Input
These settings in the Gestures Preferences pane control how Motion knows when your
pen movements should be interpreted as gestures.

Input Method: Lets you choose between observing the settings in your Mac OS
Preferences and your Wacom Preferences or using gestures only when a trigger is enabled.

When you set the input to require a trigger, your pen and tablet act as a mouse until you
press one of the buttons on the pen or press a modifier key. This indicates that you are
entering a gesture. Releasing the button or key returns the pen to normal mouse state.

Trigger: Sets which trigger method to be used: Pen Button 1, Pen Button 2, or the Control
key on your keyboard.

Allow gestures in the air: Lets you trigger gestures without pressing the tip of the pen
on the tablet. This option is only available when a trigger is used to activate gestures.
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A project file consists of a single composition that you are working on. Project files contain
objects, which are linked references to source media files on disk, but they contain no
media themselves. Project files simply house information about how a composition is
assembled, what media files on disk are used, and what effects from the Library have
been applied. They also contain any shapes, masks, and text objects that you create.

This chapter covers the following:

• Creating New Projects (p. 205)

• Managing Projects (p. 219)

• Browsing Media Files in Motion (p. 226)

• File Types Supported by Motion (p. 232)

• Adding Media to Your Project (p. 243)

• Managing Layers in Your Project (p. 248)

• Deleting Objects from a Project (p. 251)

• Exchanging Media in a Project (p. 252)

• Object Media Tab Parameters (p. 253)

• Using Media in the Library (p. 259)

• Organizing Groups and Layers in Motion (p. 264)

• Customizing and Creating New Templates (p. 280)

Creating New Projects
Before you can do anything in Motion, you first need to create a new project. Depending
on the type of project you are working on, there are three ways to do this. You can base
your composition on one of the supplied templates, you can create a new blank project
using one of the available project presets, or you can create a new project using your
own custom settings if you need an unusual frame size or frame rate.
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Motion is resolution-independent, meaning that it supports projects using a wide range
of frame sizes and frame rates. Using Motion, you can create small movies for streaming
on the web, standard definition and high definition movies for broadcast, or even
film-resolution files for film output. Regardless of the resolution at which you’re working,
Motion works exactly the same, although high-resolution projects using large media files
may have higher memory and graphics card requirements than projects with smaller
resolutions.

Important: Motion is hardware-dependent. This means that the type of graphics card
installed on your system dictates performance and the maximum file size that you can
import into Motion. For most recommended cards, the file size limit is 4 K or 8 K. However,
other factors also impact performance, such as the bit depth of your projects, the VRAM
on your computer system, and the number of monitors that are connected to your
graphics card. For the best results, resize very large images to the largest size required in
the project. For more information, visit the Motion website at
http://www.apple.com/finalcutstudio/motion.

Note: Because of hardware limitations and differences, the appearance of projects shared
between systems with different installed graphics cards may vary.

Each project has a single group of project properties that define the duration of the
project, the size of the Canvas, the frame rate of playback, and other details that affect
how your composition is formatted. Later, when you have finished your project and you’re
ready to export it, the project properties you select define the media file that is created.
Although you can change these settings at any time, it’s best to choose the settings that
match your final planned output format.

Regardless of your project settings, Motion still allows you to add nearly any kind of media
file supported by QuickTime to your project. Furthermore, you’re free to mix media files
with different properties in the same project. For example, you can combine video clips
of different frame sizes with graphics files. In the end, the file you output uses the frame
size and frame rate specified by the project properties.

206 Chapter 6 Creating and Managing Projects

http://www.apple.com/finalcutstudio/motion


Welcome Screen
The first time you open Motion, a Welcome Screen presents you with two ways to create
a new project. You can click Start with a Template to open the Template Browser, or you
can click Start with a New Project to create a new blank project file.

By default, this screen always appears when you open Motion. If you don’t want to see
this screen at startup, you can uncheck the “Show the Welcome Screen at startup”
checkbox at the bottom. After you’ve made the desired selection, click Continue.

Note: You can also choose a different startup option from the At Startup pop-up menu
in the General pane of Motion Preferences. The At Startup pop-up menu has four options:

• Open Last Project(s): Automatically opens the last project(s) you worked on, whenever
Motion is opened.

• Create New Project: Opens the Select Project Preset dialog, allowing you to pick a preset
to use to create a new, blank project file. If a default project preset is set, this dialog
does not appear.

• Show Welcome Screen: Shows the Welcome Screen every time Motion is opened.

• Browse Templates: Opens the Template Browser, allowing you to pick a template to
use.

For more information about options available in Motion Preferences, see Preferences.

Creating New Projects from Templates
The easiest way to create a new project in Motion is to open one of the existing templates
and customize it for your own purposes. Motion templates are simply pre-made projects,
available from the Template Browser, that are set up for easy customization. Motion
comes with a variety of royalty-free templates that you can use and customize. Each
template contains pre-made graphics, text objects, and backgrounds that you can use
as is, or exchange with your own custom objects to make the design your own.
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Eventually, you can extend this collection by creating your own templates of frequently
used layouts. For example, if you regularly create titles and graphics sequences for a
television series, you can create a group of templates for the show that contains layouts
for every motion graphics shot you need. For future shows, you can then open these
existing templates and customize them with updated text and graphics, without needing
to recreate each layout from scratch.

The templates that come with Motion are available in NTSC, PAL, and HD resolutions. All
templates are organized by themes.

To create a new project from a template
1 To open the Template Browser, do one of the following:

• When the Motion Welcome Screen opens, click Start with a Template.

• If Motion is already open, choose File > Open Template (or press Command-Shift-O).

2 When the Template Browser appears, use the Show pop-up menu to see templates that
have been optimized for a specific video format, including NTSC, PAL, or HD.

You can also choose to show All formats or Other formats.

Show pop-up menu

Preview area

Project properties
appear here.

Project description
appears here.

The Theme list shows all templates of the selected type.

3 Click a template theme to display its contents at the right.

4 Click an individual template to see a preview of it in the preview area, along with additional
information including its resolution, duration, and frame rate.

5 To create a new project from the selected template, click Open Template.
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A new project is created using the objects contained in that template. You can then
customize the project by editing the text objects or exchanging the graphic elements it
uses with your own. The changes you make to projects created using templates are not
saved back to the source template file.

For more information about using, modifying, and creating templates, see Customizing
and Creating New Templates.

Creating Blank Projects from Project Presets
If you’re creating a new project from scratch, but the final result is going to conform to
one of the common standards for web delivery, broadcast, or film output, you can use
one of the project presets that ships with Motion. Unlike a template, choosing a preset
only defines the essential properties of the project, such as the frame size and frame rate.
The resulting project is completely empty, ready for you to add your own objects.

Because you can have as many open project files in Motion as the amount of RAM in your
computer supports, you can create a new project at any time without having to close
projects that are already open.
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To create a new project
1 Choose File > New (or press Command-N).

2 Choose a preset from the pop-up menu, then click OK.

A new project window is created. It is not saved to disk until you choose a save command
from the File menu. For more information on saving project files, see Saving Projects.

Note: If you have already set a default preset, Motion will open a new project window
at that resolution, bypassing the Select Project Preset dialog.

Creating Blank Projects with Custom Settings
If none of the available presets meets your needs, you can create a new project with
custom project settings from the same window.
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To create a new project with custom project settings
1 Choose File > New (or press Command-N).

Note: If you have already set a default preset, hold down the Option key and choose File
> New From Preset (or press Command-Option-N).

2 Choose Custom from the bottom of the Preset pop-up menu.

The Project Properties window appears.

3 Choose the appropriate settings in the General and Render Settings tabs, then click OK.

A new project window is created using the settings you specified.

General Tab of the Project Properties Window
The General tab allows you to define the most essential properties of the project you’re
creating. By choosing different parameters, you can accommodate nearly any video or
film format you need to output to. These properties are the default settings used when
you export your project to create the final output file.

The General tab contains the following settings:

Preset: The Preset pop-up menu appears at the top of the General tab. You can choose
an existing preset to base your new preset on, changing any necessary parameters to
better suit your needs.

Width and Height: Define both the size of the Canvas and the default output resolution
of your project. Frame size is usually defined by the video format you plan on outputting
to. For example, NTSC DV format video is 720 x 480, whereas PAL DV format video has a
frame size of 720 x 576.

Bit Depth: Sets the bit depth of the project. This pop-up menu has three options:

• 8-bit (Integer)

• 16-bit Float

• 32-bit Float
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Note: When working in float space, you can quickly change the preview in the Canvas
to 8-bit to speed your workflow by turning off Preview Float Bit Depth in the View pop-up
menu. The View pop-up menu is located in the upper-right corner of the main window
(below the Timing icon). This setting does not modify the actual output of the project.
For more information on bit depth, see About Bit Depth.

Dither: Selecting this checkbox adds a form a noise to prevent the appearance of banding
or posterization when using lower bit depths.

Pixel Aspect Ratio: Defines whether the project is created using square or nonsquare
pixels. Computer displays, film, and high definition video use square pixels, while standard
definition video uses nonsquare pixels. Choose Square for projects intended for the web,
high definition projects, and film, or one of the nonsquare pixel ratios corresponding to
each international standard definition broadcast standard. A field to the right of this
pop-up menu displays the numerical aspect ratio, in case you need to change it manually.

Field Order: When working with interlaced video, choose the field order you plan on
using for eventual output from this pop-up menu. This should match the field order of
the device being used to output the resulting QuickTime file to video. When working
with progressive-scan video or film, choose None.

Frame Rate: Choose a frame rate (in frames per second) that matches the format you’ll
eventually be outputting to. For example, film is 24 fps, PAL video is 25 fps, and NTSC
video is 29.97 fps. Additional frame rates are available for different video formats.

Duration: Allows you to enter the total duration available in your project’s Timeline. A
pop-up menu allows you to define the duration with either a timecode value based on
the currently selected frame rate, a frame count, or in seconds. The default value is
900 frames, or 30 seconds.

Start Timecode: This value sets the start timecode for display while working in the project.

Background Color: A color well that defines the background color that appears in the
Canvas. If other graphics or QuickTime objects smaller than the Canvas are present in the
project, this color appears behind those objects.

Background: A pop-up menu that defines whether the Background Color is rendered as
part of the alpha channel. Regardless of the selection, the Background Color is visible in
the Canvas. There are three options:

• Transparent: The background color does not render as part of the alpha channel.

• Solid: The background color creates a solid alpha channel.
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• Environment: The background color creates a solid alpha channel and interacts with
3D projects, including blend modes and reflections. In the following images of the
Canvas, Reflection is turned on for the elliptical shape (in the Properties tab of the
Inspector). In the left image, the elliptical shape retains its original white color because
Background is set to Solid. In the right image, the pink background is reflected in the
elliptical shape because Background is set to Environment.

Project Description: A field into which you can enter a brief description of the project.
It may also be useful to call out significant characteristics of that particular preset such
as frame size or frame rate.

For more information about commonly used frame sizes, frame rates, interlacing, and
other project setting information, see Supported File Formats.

Render Settings Tab of the Project Properties Window
The Render Settings tab contains parameters that affect how Motion renders the objects
and animation in your project. These settings can affect how your project looks when
exported.
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The Render Settings tab is divided into two categories: Motion Blur and Reflections. The
Motion Blur controls simulate the effect a camera’s mechanical shutter has on a frame of
film or video when either the camera or its subject is moving. In Motion, motion blur
affects objects in your project that are animated using behaviors or keyframes. This allows
you to create more natural-looking motion in your project, even though the animation
is artificially created. As with a camera, faster objects have more blur, whereas slower
objects have less.

No motion blur Motion blur at 360°Motion blur at 180°

Important: Unlike Final Cut Pro or Final Cut Express, blur created by these parameters
does not affect motion that occurs within a QuickTime movie file or an image sequence.
It only affects animated objects.

The Motion Blur section of the Render Settings tab has two parameters:

Samples: The number of sub-frames rendered per frame, where 1 frame is 360 degrees.
Higher Samples values result in a higher-quality motion blur effect, but are more
processor-intensive. The default Samples value is 8. The maximum possible value is 256.

Shutter Angle: Defines the size of the motion blur that appears for animated objects.
Increasing the shutter angle increases the number of frames over which the shutter is
open.

The following image shows a shape that has been keyframed to move quickly across the
Canvas horizontally.
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In the next image, Motion Blur is enabled and Samples is set to the default value of 8.

Note: When using larger Shutter Angle values, it may be necessary to increase the Samples
value to eliminate unwanted artifacts.

In the above image, the Shutter Angle is set to the default of 360 degrees, which represents
1 frame. In the following image, Shutter Angle is set to 600 degrees.

The Reflections section of the Render Settings tab has one parameter:

Maximum Bounces: When a reflective object is itself reflected in another object, the first
object can be seen in the reflection, potentially causing an endless repetition of reflections.
This parameter limits the number of “bounces” that can occur in a scene. The number of
allowed reflections is set per project.

For more information about reflections, see Reflections.

About Bit Depth
When working with images, an increase in bits per pixel for those images means more
color information becomes available. A one-bit-per-pixel bitmap image is comprised of
purely black or white image pixels (no shades of gray).

A grayscale image comprises image pixels with 256 levels of gray. Each pixel requires
8 bits to represent the 256 shades of gray. Therefore, the bit depth of a grayscale image
is 8 (28 = 256).
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An RGB image can comprise image pixels with 256 shades of each of the primary
colors—red, green, and blue. In this case, there are 28 (256) shades of each color
component. This creates more than 16.7 million possible colors (256 x 256 x 256 > 16.7
million). The bit depth of an RGB image can be 24 (8 bits for each color), and the bit depth
of an RGBA image (red, green, blue, and an alpha channel) can be 32 (8 bits for each color
+ alpha channel). The bit depth of an alpha channel describes the transparency of each
pixel. Although these images are 24- and 32-bit, such color images are often referred to
as 8-bit (because of the 8 bits per channel).

Note: An RGB image does not necessarily imply 8 bits per pixel.

Motion’s bit depth setting is bits-per-channel. In an 8-bit Motion project, the 256 levels
of color are represented on an integer scale of 0–255 (where 0 represents black and 255
represents white). All of your operations are clamped within that 0–255 range. There is
a one-to-one ratio between each number and its represented color. In 8-bit mode, 16.7
million colors can be represented—equaling the number of possible combinations of
256 different color values from each red, green, and blue channel. Although that is a large
number of colors, it is often helpful to have finer gradations of colors available. Using
floating point calculations, color shades can be subdivided into an enormous amount of
intermediate colors, providing orders of magnitude more colors available to your project
palette. Incredibly small increments of color can be represented in 16-bit float, and even
finer increments in 32-bit float.

The bit depth of your source footage will often determine the bit depth of your project.
Even if your source footage is 8-bit, you may want to work in a project with a higher bit
depth to achieve better results. When you increase the bit depth of your project, you are
not introducing any new color information to the original images. However, operations
such as keying, color correction, applying blur or other filters with high parameter values,
or creating graphics that require very smooth color gradients can benefit from the new
number of possible color levels.

Important: There is a price for working in higher bit depths, however. And that price is
paid in processing time. Remember also that because Motion is hardware-dependent,
most systems have a limitation on the size of imported files. For more information on the
required hardware, visit the Motion website at
http://www.apple.com/finalcutstudio/motion.

When exporting a 16-bit or 32-bit float project, keep in mind that most file formats
available for export do not support float—including QuickTime (8-bit only). OpenEXR is
a float format. TIFF, PNG, and Adobe Photoshop files support the 16-bit integer format.
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Note: Depending on your project, dithering can be useful or problematic. For example,
enabling dithering in a project in which banding is present may reduce the appearance
of the banding. In a float project, dithering may cause excessive noise in the project’s
output. For this reason, a checkbox has been added to the General tab of the Project
Properties window that allows you to turn dithering on or off. This setting applies to the
display and export of a project.

Creating, Editing, and Deleting Presets
If you commonly create projects using custom settings that don’t match any of the
available presets, you can create a new preset with these settings for future use. Presets
are created, modified, and deleted in the Presets pane of Motion Preferences.

To create a new custom preset
1 Choose Motion > Preferences (or press Command-Comma).

2 In the Presets pane, choose Project Presets from the Show pop-up menu.

3 Click the Add button (+) beneath the presets list.

The Project Preset Editor appears.

4 In the Project Preset Editor, do the following:

a In the Name field, type a descriptive name for the preset.

217Chapter 6 Creating and Managing Projects



b In the Description field, enter a brief description of what that preset is for. It may also
be useful to call out significant characteristics of that particular preset, such as frame
size and frame rate.

c Enter a frame size into the Width and Height fields.

d Choose a Pixel Aspect Ratio, Field Order, and Frame Rate from the corresponding
pop-up menus.

5 Click OK.

6 If you’re done creating new project presets, close the Motion Preferences window.

Note: For more information on industry-standard frame sizes, pixel aspect ratios, field
order, and frame rates, see Supported File Formats.

To choose a custom preset to be the new default
Do one of the following:

µ In the Presets pane of Motion Preferences, click the checkbox to the left of the preset you
want to be the default for all newly created projects.

µ Choose File > New to display the Select Project Preset dialog. Choose a project preset
from the Preset pop-up menu, click Set as Default, then click OK.

You can also edit existing presets. This allows you to update a preset you’ve already
created, or to make a new preset by customizing an existing one with similar settings.

To duplicate an existing preset prior to editing it
1 In Motion Preferences, select a preset in the Presets pane.

2 Click Duplicate.

The duplicated preset appears underneath the original preset with “copy” appended to
its title.

To edit an existing preset
1 In Motion Preferences, select a preset in the Presets pane.

2 Click Edit.

3 When the Project Preset Editor appears, make any necessary changes, then click OK.

Note: You cannot edit or delete locked project presets.

To delete a custom preset
1 In Motion Preferences, select a preset in the Presets pane.

2 Click the Delete button (–) underneath the presets list.

Note: You cannot edit or delete locked project presets.

Note: You cannot unlock a preset that is built into Motion. When the preset is
double-clicked, an alert appears stating that the selected preset cannot be modified. To
create a copy of the preset that you can customize, click OK.
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Moving Presets Between Computers
Each preset you create is saved as a separate file. If you’ve created one or more custom
presets that you rely on, you may want to move them to other computers you use that
have Motion installed. All user-created presets are stored in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Presets/Project/
folder.

To copy a project preset to another computer
µ Copy your custom preset files to that computer’s /Users/username/Library/Application

Support/Final Cut Studio/Motion/Presets/Project/ folder.

Managing Projects
When you work on a project in Motion, it’s important to be organized. This includes
keeping careful track of your project files, saving often, and maintaining regular backups.
The idea is to make sure that nothing gets accidentally misplaced or deleted, and that
you don’t lose work by deleting valuable digital resources. Motion also autosaves projects
to files that can be retrieved at any time.

Saving Projects
As with any application, it’s a wise practice to save early and often as you work on your
project. This way, you don’t lose work due to unforeseen circumstances such as a blackout
occurring just as you were about to finish your latest animated masterpiece.

Besides preserving your work for future use, Motion’s save commands can be used in
other ways to manage the development of your project. For example, if you’re happy
with your current composition, but you want to create a variation of what you’ve done,
you can use the Save As command to save a copy of the current project. You can then
freely alter this duplicate, leaving your original project alone in case you don’t like your
changes.

You can also use the Save As command as an archival tool, saving individually named
copies of your project periodically over the course of its creation. This serves two purposes.
First, it ensures that you have duplicates of your project file, protecting you from
inadvertently misplacing your only copy and losing days of work. Second, it also gives
you a way to go back to previous versions of your composition, in the event that you or
your client want to make a change based on an earlier point in that project’s development.

To save a project
1 Choose File > Save (or press Command-S).
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If the project has not already been saved, the Save As dialog appears.

2 Type a name into the Save As field, choose a location on your hard drive to save the file,
then click Save.

Note: If the project has already been saved, the project file is simply updated.

To save a duplicate of a project
1 Choose File > Save As (or press Command-Shift-S).

The Save As dialog appears.

2 Type a new name into the Save As field, choose a location on your hard drive, then click
Save.

Important: When using the Save As command, it’s important to use a name that is different
from the name of any previously saved versions of the same project. Otherwise, you run
the risk of overwriting a previous version of this project file that you want to keep. You’ll
be warned if this happens.

To save all open projects
1 Press Option, then choose File > Save All (or press Command-Option-S).

2 If all open project files have already been saved, the Save All command simply updates
them. If any open project has not been saved, enter a name in its Save As field, then click
Save.

Note: The Save All command only appears when you press Option while opening the
File menu.

Collecting Media
When saving a project, Motion gives you the option to automatically gather together the
media used in your project. The media is collected in a folder of your designation. The
advantage to collecting your media is that it makes portability and backup easier, as well
as organizing all your project media in a single place. By default, Collect Media is turned
off.

To use the Collect Media save function
1 Choose File > Save As (or press Command-Shift-S).
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The Save As dialog appears.

2 Choose Copy to Folder from the Collect Media pop-up menu.

Choosing the Copy to Folder option creates a folder with the name specified in the Save
As field. A Motion project file of the same name is created within that folder, as well as a
folder named “Media,” which contains all the media used in the project.

If the Collect Media option is used, you have the option to specify whether unused media
are collected as well.

Using Autosave
Motion automatically saves backups of your project in a folder on your hard drive. In the
Cache pane of Motion Preferences, you can specify how frequently projects are
automatically saved, as well as the location of the saved files. Saved projects are time-
and date-stamped. For more information about autosave, see Autosave.

To store autosaved projects in a specific location
1 Choose Motion > Preferences (or press Command-Comma).

2 Click Cache.

3 In the Autosave group, turn on Use Autosave Vault.

By default, the Autosave Vault folder is located in a folder called Motion Projects in your
Documents folder in your home directory.

To set a new location for the Autosave vault
µ In the Cache pane of Motion Preferences, click Choose and select a new location in the

dialog.

To revert to an autosaved project
1 Choose File > Restore From Autosave.

The Restore Project dialog appears.

2 Choose a saved project from the pop-up menu.
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Reverting Projects
The Revert command discards all changes you’ve made to a project since the last time
you saved it. The Revert command is especially useful as a tool for trying out numerous
changes in your project. You can save your project in the state you like it, then make all
the changes you want. If you don’t like the result, use the Revert command to immediately
go back to the way it was before.

Note: You can also use the application’s unlimited undo feature to achieve the same
purpose in incremental steps. For more information on the Undo command, see Edit
Menu.

To revert a project to the last saved version
µ Choose File > Revert.

Important: This command cannot be undone.

Opening and Closing Projects
You can open one or more previously saved project files either in the Finder or from
within Motion. You can have as many projects open at the same time as the amount of
RAM in your computer can support. Your computer’s RAM is divided up among the
operating system, any other applications that are currently open, and all currently open
documents. If, at any point, you notice a decrease in performance because you’ve run
out of RAM, simply quit one or more other applications, or close one or more open projects
to free up RAM for the remaining open projects.

To open one or more project files in the Finder
Do one of the following:

µ Double-click a Motion project file. Motion automatically opens with that project.

µ Select one or more Motion project files, then drag them onto the Motion application icon
either in the Applications folder or in the Dock, if you’ve placed one there.

µ Select one or more Motion project files, then choose File > Open (or press Command-O)
in the Finder.

µ Select one or more Motion project files, Control-click one of them, then choose Open
from the shortcut menu.

Motion automatically starts and opens all selected projects.

To open a project file from within Motion using the Open command
1 Choose File > Open (or press Command-O).

The Open dialog appears.

2 In the Open dialog, navigate to the project file you want, then click Open.

To open a project file from within the Motion File Browser
1 In the File Browser, navigate to the project file you want and then select the file.
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2 Do one of the following:

• Double-click the project file.

• In the Preview area, click the Import button.

The project opens in a new Canvas.

Opening Recent Projects
Every project you open in Motion is automatically added to the Open Recent submenu
in the File menu. You can choose a project from a list of projects that you’ve worked on
recently from this submenu. Motion keeps the names of the previous projects you’ve
worked on in the Open Recent submenu.

To open a recent project
µ From the File menu, choose a project’s filename from the Open Recent submenu.

If the Open Recent submenu becomes too crowded, you can clear it out.

To clear the Open Recent submenu
µ Choose File > Open Recent > Clear Menu.

Managing Multiple Open Projects
Each open project is self-contained in its own window, and each has its own Layers,
Media, Audio, Timeline, Keyframe, and Audio Editor tabs.

There are expose commands within Motion that allow you to visually access all the
layers in a project directly in the Canvas, quickly selecting items without having to drill
down into the Layers tab or Timeline. For more information, see Expose Commands.

Note: You can use the Expose system commands to see all open project windows at
once. For more information on how to use the system’s Expose commands see Mac
Help, available in the Finder Help menu.

Closing Projects
You can close projects either one at a time, or all at once. You close a project by closing
its project window (the window containing the Canvas).

To close a single project
Do one of the following:

µ Press Control-W to close the currently selected window.

µ Click the Canvas window’s close button.

To close all open projects
Do one of the following:

µ Press Command-Option-W.
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µ Option-click the close button.

Moving and Archiving Motion Project Files
If you want to move a Motion project file to another computer, you must also move all
the media that the project uses along with it, including all QuickTime, still image, and
audio files. In addition, if your project uses any third-party Motion plug-ins or nonstandard
fonts or LiveFonts, you need to make sure that those are also installed on the computer
you’re moving the project to, or they’ll be unavailable to your project.

Similarly, when you’re finished with a project and you want to archive it, it’s a good idea
to archive not just the project file, but also all media used (especially media that wasn’t
captured from a device-controllable video or audio source), graphics, fonts, custom
behaviors, filters, or third-party add-ons used by that project. In the event you want to
restore the project for later revisions, you’ll have everything you need to get started
quickly. If you have a recordable CD or DVD drive, backing up your media is easy. For
more information on copying files to a recordable CD or DVD disc, see Mac Help in the
Finder Help menu.

The easiest way to collect all the media used in your project is to use the Collect Media
feature. For more information, see Collecting Media.

Note: If you move a project to another computer without collecting, its media may go
offline even though you’ve moved its media files along with it. For more information on
how to relink media files to your project, see Online Versus Offline Media.

Archiving QuickTime Video
If you use QuickTime video clips in a Motion project that you want to archive for
long-term storage, whether or not you also archive the video clips themselves depends
on how they were captured. For example, if you captured your video using a
device-controllable camcorder or deck with Final Cut Express or Final Cut Pro, archiving
the video clips you used may be unnecessary. This is because you can always recapture
them from the original source tapes using the Final Cut project file you logged them
with. In this case, it’s a good idea to back up the Final Cut Express or Final Cut Pro project
file along with your Motion project file.

If you captured your video without device control, or if the video was captured by
someone else and you no longer have the ability to recapture the clips exactly as they
appear in your project, it’s probably a good idea to back up these clips along with the
rest of the graphics files, audio files, and fonts you used in your project.
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Unused Media
By default, media used by objects added to your project are managed automatically by
Motion. If you delete an object from the Canvas or Layers tab, the source media is removed
automatically from the Media tab. You can turn off this feature in the General pane of
Motion Preferences. For more information, see Media.

Searching for Projects Using the Finder
Spotlight indexes certain properties of your Motion projects, allowing you to perform
advanced searches. Use Spotlight in the Finder to take advantage of this feature. The
following properties of Motion projects are indexed by Spotlight and can be searched
for:

DescriptionProject property

Project width, in pixelsWidth

Project height, in pixelsHeight

Project duration, in secondsDuration

The name of any layer in your projectLayer name

The name of any media object in your projectMedia name

The path to any media object in your projectPathname

The content of any text object in your projectText

The text in the Project Description field in Project PropertiesDescription

The name of any marker in the Timeline of your projectMarker name

The text of any marker comment in your projectMarker comment

Editing Project Properties
Even though every project starts out with a preset group of project properties, you can
change these properties at any time, even after you’ve added objects.

To edit the properties of an existing project
1 Choose Edit > Project Properties (or press Command-J).

2 In the Project Properties dialog, change any necessary parameters, then click OK.

For more information on the parameters available in the Project Properties dialog, see
General Tab of the Project Properties Window and Render Settings Tab of the Project
Properties Window.

Most changes made to a project’s properties are fairly transparent and have no visual
effect on the project itself. The main exception is a change made to the project’s frame
size.

225Chapter 6 Creating and Managing Projects



Changing the Frame Size of a Project
When you change the frame size of a project (in Project Properties) that already has
objects within it, you essentially change the size of the Canvas. This adds to, or reduces,
the amount of room available to lay out the objects in your project.

It’s important to understand that changing the size of the Canvas in no way changes the
size or position of any objects already placed within it. Furthermore, since the coordinate
system used by Motion uses 0, 0 as the center of the frame, all objects remain arranged
in their current positions relative to the center of the frame as the edge of the frame
shrinks toward the center. This may result in objects being cut off as the frame shrinks
past their edges. In the following example, a project with a frame size of 720 x 480 is
reduced to 320 x 240.

Original frame size (720 x 480) Reduced frame size (320 x 240)

Note: Because Motion is resolution-independent, it’s not usually necessary to change
your project’s frame size. You can output your projects at any size, regardless of the
current frame size, by changing the options in Motion’s export dialogs. For example, if
you’re building a project with a frame size for standard definition broadcast, you can still
export a half-resolution version of your project to post on the web simply by exporting
to the necessary size.

Browsing Media Files in Motion
This section describes how to browse the media files you want to use in your Motion
project. As with project files, it’s important to make sure that the source media you’re
using is organized in a way that makes sense and is easy to keep track of. Centralizing
source media that’s only used in one project can be helpful, as is carefully organizing
media that is shared by more than one project.
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Navigation Controls in the File Browser
You use the File Browser to navigate every volume connected to your computer for media
files to add to your Motion project. While similar to a Finder window, the File Browser
has many custom controls specific to Motion that allow you to quickly locate and preview
files you might want to use.

Note: You can also browse for and import files directly from your iTunes and iPhoto
libraries from within the Motion Library. For more information, see Adding iTunes and
iPhoto Files from the Library.

Preview area

Sidebar

File stack

View buttons
Search field

Path pop-up menu

Forward/Back buttons

New Folder button

“Show image sequences 
as collapsed” button

Scale slider
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Sidebar: This area of the File Browser displays all the hard disks and removable media
currently connected to your computer. You can also access networked volumes. Additional
icons allow you to access commonly used folders in your home folder such as the Desktop,
Documents, Movies, Music, and Pictures folders.

File stack: Located beneath the sidebar, the file stack displays all the files and folders
within the currently selected disk in the sidebar. Clicking a folder opens its contents into
the file stack, replacing the previously displayed contents. You can navigate up and down
the current folder hierarchy using the Back and Forward buttons and the Path pop-up
menu. The file stack can be switched between list view and icon view.

Preview area: Displays a preview of the currently selected file in the file stack. If a movie
is selected, the Play button allows you to play through the clip. Information about the
clip being previewed appears to the right of the thumbnail preview.

Back and Forward buttons: These buttons allow you to navigate your browsing history.
Clicking the left arrow moves you to the last item browsed. Repeatedly clicking the left
arrow eventually moves you up to the first item you selected, such as the Desktop, a
partition, or your home folder. Once you have reached the beginning of your browsing
history, the left arrow is dimmed. Clicking the right arrow takes you forward in your
browsing history. If you have never opened any folders within the currently open folder
in the file stack, the right arrow is dimmed.

Path pop-up menu: Displays the current folder hierarchy as a list, with the currently open
folder at the top, and each enclosing folder appearing underneath. “Computer” appears
at the bottom, which is the topmost directory of all disks connected to your computer.

Search field: The Search field filters the file stack for the search terms you’ve entered.

Controls for Customizing the File Browser
Use these controls to customize the appearance of the File Browser.

File Browser divider: Dragging this divider up and down allows you to reallocate space
between the File Browser sidebar and the file stack. Shrinking the sidebar also shrinks
each displayed icon, down to a certain point.

Icon View button: Sets the file stack to display each file and folder as an icon. Image and
movie files are represented by a thumbnail image, while folders are represented by a
folder icon. All icons in the stack are arranged into a grid, the size of which is defined by
a scale slider at the bottom of the File Browser.
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List View button: Sets the file stack to display each file and folder as a hierarchical list.
A thumbnail of each file and folder appears to the left of each file and folder name within
the Name column. To the right, several additional columns display information for the
date, size, duration, and kind of each file. The contents of the file stack can be sorted by
any single column by clicking that column’s header. Clicking the same header twice
reverses the sort order, from ascending to descending, or vice versa.

Icon View button

List View button

Folders in this list can be opened hierarchically, using the disclosure triangle to the left
of each folder’s icon, or they can be double-clicked to replace the current contents of the
file stack with the contents of that folder.

Icon view List view

Scale slider: When in icon view, this slider enlarges or reduces the size of all icons
displayed in the file stack. The current scale size affects how many icons can be
simultaneously viewed within the current area of the file stack. The file stack can be
enlarged with the File Browser divider.

“Show image sequences as collapsed” button: Image sequences are movie clips that
have been saved as individual image files, one for each frame of film or video. Clicking
this button allows you to view properly named image sequence files as a single image
sequence file. In the event that you’re viewing image files that have numbered filenames
that aren’t actually an image sequence (such as images captured with a digital camera
that you’ve imported from an iPhoto directory), you can turn this control off to see each
individual image file separately.
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New Folder button: Allows you to create a new folder within the currently displayed
location in the file stack. These new folders are created in the Finder and allow you to
reorganize media files on disk from within Motion.

Note: To delete a folder from the File Browser, select the folder, then press
Command-Delete.

Different Methods of Browsing, Searching, and Previewing Files
This section contains procedures you can use to look for and preview files using the
controls in the File Browser.

To browse the contents of a disk
Do one of the following:

µ Click the disk’s icon in the File Browser sidebar.

µ Press the Up Arrow and Down Arrow keys to move up and down the sidebar list.

To browse the file stack in icon view
Do one of the following:

µ Double-click a folder in the file stack to open its contents into the file stack.

µ Click an icon in the file stack, then press the arrow keys to change the selected folder. To
open the currently selected folder, press Return.

To browse the file stack in list view
Do one of the following:

µ Double-click a folder in the file stack to open its contents into the file stack.

µ Click the disclosure triangle to the left of a folder’s icon to open its contents into a
hierarchical list.

µ Click a list item, then press the Up Arrow and Down Arrow keys to navigate the list.

µ Press the Right Arrow key to open the selected folder into hierarchical view—this has
the same effect as clicking a folder’s disclosure triangle. Press the Left Arrow key to close
a folder that’s been opened hierarchically.

µ Press the Return key to open a folder’s contents into the file stack.

To navigate the current file path hierarchy
Do one of the following:

µ Click the Forward button to move to the previously opened folder.

µ Click the Back button to move to the last previously opened folder down the current
folder hierarchy.

µ Choose a folder in the current hierarchy from the Path pop-up menu.
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To sort the file stack in list view
µ Click the header of any information column to sort by that category. Click the same

column a second time to reverse the sort order, from ascending to descending, or vice
versa.

To search for a file
µ Type a search term in the Search field. The file stack immediately updates with files that

contain the search term anywhere within their filenames. Only disks or folders currently
displayed in the file stack are searched. Character case is ignored.

For example, typing “flag” in the Search field might result in the following filenames
appearing in the file stack: “Dutch Flag.tif, flagAnimation.mov, flagellum.tif, Iron Flag.m4a.”

To clear the search results
µ Click the Clear button at the far right of the Search field to restore the contents of the file

stack to the previously selected file path.

To preview a file
µ Select any supported media file in the file stack. The Preview area updates with a thumbnail

and additional text information about that file. If “Play items automatically on a single
click” is selected in the General pane of Motion Preferences, an animated preview of
movie clips and image sequences begins playing.

To preview a file at full size
µ Double-click a file in the file stack to open it into its own viewer window, complete with

playback controls.
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About Networked Disks and Removable Media
You should be careful when adding media files from a remote server to your project.
Although the File Browser sidebar allows you to easily access the contents of disks on
other computers on your network, doing so only places a link to that file in your project.
The actual media file remains on the remote disk where you found it. As a result,
whenever that remote disk becomes unavailable, the corresponding object in your
project goes offline. Furthermore, depending on the speed of your network, you may
experience performance issues when using media files on other computers. Ideally, you
should copy all media files you want to use in your project onto a disk that’s physically
connected to your computer, both to ensure the file’s future availability, and to guarantee
playback performance. If you do use media from a networked hard drive, make sure it’s
one that is always mounted on your system, and that you have a high-performance
network.

This is especially true for media from removable disks, such as CD-ROM, DVD-ROM, and
removable hard drives that are frequently disconnected from your computer. Always
copy media files from such media to your local hard drive so that the media doesn’t
become unavailable when the media is ejected or disconnected.

File Types Supported by Motion
Motion can use the most popular multimedia file formats supported by QuickTime. These
formats can be broken down into the following categories:

• QuickTime movies

• Still image files

• Image sequences

• Layered Photoshop files

• PDF files

• Audio files

QuickTime Movies
Motion supports QuickTime movies using any codec currently installed on your computer.
Examples of QuickTime movies you can import include clips captured with Final Cut Express
or Final Cut Pro, stock footage from a CD-ROM or DVD collection, or computer-generated
animation from a 3D animation package.
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While you can import movies that use nearly any codec, it’s inadvisable to use highly
compressed clips in your projects if you can avoid it. Clips that are excessively compressed
may display undesirable visual artifacts. Fortunately, QuickTime comes with many codecs
that are ideal for moving uncompressed or minimally compressed video files between
applications, including but not limited to: Apple ProRes 4444, Apple ProRes 422 (HQ),
Apple ProRes 422, Uncompressed 8- and 10-bit 4:2:2, Pixlet, None, Animation, Apple
M-JPEG A and B, Apple DVCPRO-50, Apple DV/DVCPRO.

Some of these codecs support alpha channels, which define areas of transparency within
the clip. If a particular QuickTime clip has an alpha channel, Motion automatically uses it
in your project.

Mixing Different Kinds of QuickTime Files
You can freely combine clips that are compressed with different codecs in the same
project. Furthermore, you can also combine clips that have different frame sizes, pixel
aspect ratios, and interlacing. To learn more about alpha channels, interlacing, pixel aspect
ratio, frame rates, and frame sizes, see Supported File Formats.

Importing Movies from Final Cut Express or Final Cut Pro
Unlike Final Cut Express or Final Cut Pro, Motion processes video in RGB color space.
Video clips that have been captured in Y′CBCR color space are treated as RGB clips when
imported into a Motion project.

Important: Mixing clips with different frame rates may result in undesirable motion
artifacts.

Still Image Files
You can import still image files using virtually every popular still image format in use,
including but not limited to: SGI, Photoshop, BMP, PICT, JPEG, TIFF, TGA, and JPEG-2. Like
video clips, you can mix still image files with differing frame sizes and pixel aspect ratios.
When you create or modify an image in a graphics editor such as Photoshop, it’s a good
idea to keep in mind the frame size and pixel aspect ratio of your project to ensure that
the graphics you create are appropriate for your project. For more information, see
Supported File Formats.
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Using High-Resolution Still Images
A common and effective use of still images in motion graphics work is the animation of
high-resolution files. The DPI of image files as defined in programs like Photoshop does
not apply to video, as the dimensions of each imported still image are defined simply by
the number of pixels. If the current dimensions of an image are larger than the frame size
of your project, the image appears to be much larger, and by default it appears to be
“zoomed in” to its maximum size. You can change the scale of the image to shrink it down
to fit within the project’s frame size, but you can also animate the scale to zoom into or
out of the image, or animate the image’s position to pan around within it, creating all
kinds of motion-control effects.

Because Motion is graphics-card dependent, you may have different file-size import
limitations. When you import an image that is too large, an alert dialog appears that states
“This media is too large to render at full resolution, and will be shown at a lower quality.”
Click OK to import the image at a lower quality. For more information, visit the Motion
website at http://www.apple.com/finalcutstudio/motion.

When importing large still images, you can set a preference that tells Motion to import
the file at its original size, to change the resolution of the image to fit the Canvas size, or
to scale the image down to fit the Canvas size.

To set the large still image import preference
1 Choose Motion > Preferences (or press Command-Comma).

2 In the Still Images & Layers group of the Project pane, choose a setting from the Large
Stills pop-up menu.

Click to choose large still 
import preference.

There are three options: Do Nothing, Scale to Canvas Size, and Down-Res to Canvas Size.

• Do Nothing: Imports the image at its original size.
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In the following example, an 1146 x 756 image is imported into an NTSC D1 project
(720 x 486) with Do Nothing selected in the Preferences. The image is much larger than
the Canvas.

• Scale to Canvas Size: Imports and scales the image to fit the project size while
maintaining its aspect ratio.

In the following example, a 1166 x 738 JPEG image is imported into an NTSC D1 project
with Scale to Canvas Size selected in Preferences.
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The image is scaled—the equivalent of using the Transform tool to scale down the
image in the Canvas while pressing Shift. To observe that the image is merely
transformed and has not changed resolution, select the image file in the Media tab of
the Project pane, and then open the Media tab in the Inspector. The Fixed Width and
Fixed Height parameters display the resolution of the original file.

The image is scaled to fit the largest X or Y value of the image to that of the Canvas.

• Down-Res to Canvas Size: This setting changes the resolution of the imported image
so that the image fits the project size while maintaining its aspect ratio.

Note: The Down-Res to Canvas Size option is the best choice for optimizing your process
time. When you use Scale to Canvas Size, Motion must calculate the scale at each frame.

In the following example, a 757 x 1140 JPEG image is imported into an NTSC Broadcast
SD project with Down-Res to Canvas Size selected in Preferences.
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The image looks identical to an image that is scaled on import. However, its resolution
has been changed so that the image fits the Canvas. To observe that the resolution of
the image has changed, select the image file in the Media tab of the Project pane, and
then open the Media tab in the Inspector. The Fixed Width and Fixed Height parameters
display the new resolution of the imported image.

Note: You can use the Fixed Width and Fixed Height parameters in the Media tab to
further down-res the image.

Still Image Duration
When you first import a still image into your project, the image assumes a duration equal
to the current duration of your project. Increasing the duration of your project does not
automatically increase the duration of an image that’s already been imported. Still images
have infinite duration in Motion, so you can stretch them out in the Timeline to be as
long as you need. For more information about working with objects in the Timeline, see
Using the Timeline.
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Image Sequences
Numbered image sequences store video clips as individual still image files. Each image
file has a number in the filename that indicates where it fits into the sequence. In a film
clip that’s been digitally scanned, each file represents a single frame. In a video clip that’s
been converted to an image sequence, each file contains both fields of a single video
frame, with the upper and lower lines of the image saved together. Image sequences use
the same variety of file formats as still image files. Some of the most popular formats for
saving image sequences include SGI, BMP, JPEG, TIFF, and TGA. Like still image formats,
many of these support alpha channels, which are automatically used by Motion.

Because image sequences have been around for so long (before QuickTime, they were
the only way to store video on a computer), they remain the lowest-common-denominator
file format for exchanging video across many different editing and compositing
applications. While QuickTime is increasingly used to exchange video clips between
platforms, image sequences are still in common use, especially in film compositing.

As with QuickTime video clips, you can mix image sequences of different formats, using
different frame sizes, pixel aspect ratios, frame rates, and interlacing. For more information,
see Supported File Formats.

Important: Any imported image sequence must contain three or more digits of “padding,”
for example, imagename.0001.tif.

Collapsing Image Sequences
The “Show image sequences as collapsed” button at the bottom of the File Browser allows
you to display image sequences as a single object, rather than as the collection of
individual files that exist on your disk. Image sequences that you import into your project
in this way are treated as single objects everywhere they appear in your project.

Click to collapse or 
expand image 

sequences.

Note: You can turn this feature off in case you have numbered image files that aren’t
supposed to be used as an image sequence. For example, pictures taken with digital
cameras often have numbered filenames that can be mistaken for an image sequence.

Layered Photoshop Files
You can also import layered Photoshop files. Many motion graphics professionals create
layouts in Photoshop, where they paint and manipulate all the graphical elements they’ll
use to create a static composition. Once that’s done, the resulting layered file can be
imported into Motion to be animated, along with other imported and Motion-generated
objects, to create the final project.
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When importing Photoshop files, you can choose to import:

• All the layers merged together as a single object

• All layers as individual objects, nested together within a group

• An individual layer as a single object

When you import all layers as individual objects, Motion creates a new group in the Layers
tab and Timeline, and nests each layer of the Photoshop file as an individual object within
that Motion group. Each resulting object retains the position, opacity, and blend mode
of the original Photoshop layer. Furthermore, Photoshop text layers are imported, but
appear in Motion as noneditable bitmap graphics.

Incompatible Effects
The following Photoshop effects are not currently imported into Motion:

• Layer effects

• Layer masks

• Adjustment layers

• Paths

• Shapes

Note: Motion does not support Photoshop layer sets.

For more information on how to import layered Photoshop files, see Adding Layered
Photoshop Files to a Project.

PDF Files
The PDF file format is a PostScript-based document format that accommodates
PostScript-based graphics and text, as well as bitmap graphics. Areas of transparency
within a PDF file are also transparent within Motion.

PDF files are capable of storing PostScript-based illustrations. Unlike graphics file formats
such as TIFF and JPEG, which save images as a collection of pixels at a given resolution
that are divided into red, green, and blue channels, PostScript-based illustrations are
saved as mathematical descriptions of how the artwork is drawn. As a result, PDF files
using PostScript-based artwork and text have infinite resolution.

The practical difference between bitmap files and PostScript-based files is that scaling a
bitmap beyond 100 percent results in the image progressively softening the more you
increase its size. PostScript-based illustrations remain sharp and clear no matter how large
or how small you scale them.
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When importing a PDF file, its size is relative to the original page size of the file. As a
result, even small graphics may have a large frame size, with a lot of empty space
surrounding the graphic. When exporting a graphic as a PDF file for use in Motion, you
may want to scale the graphic up to fit more closely within the page, or reduce the page
size in the source application’s page preferences to more closely fit around the graphic.

Fixing the Resolution of a PDF Object
Although PDF files have unlimited resolution, large PDF objects can consume a lot of
video memory, which could potentially limit Motion’s performance. To avoid this, you
have the option of limiting the resolution of each PDF image used in your project in order
to save video memory. By using the fixed resolution parameters, the files only need to
be rendered once. This allows for faster performance.

If you decide to fix the resolution of a PDF file, the width and height values you assign
should be equal to the largest scale at which you plan on using that object in your project.
For example, you might add a PDF of a map to your project with the intent to scale it up
to zoom into a particular country. To conserve video memory, you can set the Fixed Width
and Fixed Height parameters to the maximum size of the zoomed in image. If at first you
don’t assign enough resolution, the Fixed Width and Fixed Height parameters can be
changed at any time.

The fixed resolution parameters for PDF objects can be adjusted in the Media tab of the
Inspector. Select the PDF object in the Media tab of the Project pane to activate the Media
tab of the Inspector. Adjust the following controls to modify the PDF’s fixed resolution
parameters.

Fixed Resolution: A checkbox that fixes the resolution of a PDF object in the Media tab
to the size specified in the Fixed Width and Fixed Height parameters.

Fixed Width: A slider that sets the maximum horizontal resolution to which a PDF object
can be smoothly scaled.

Fixed Height: A slider that sets the maximum vertical resolution to which a PDF object
can be smoothly scaled.

Use Background Color: When this checkbox is selected, the background color defined
in the Background Color controls is used for the transparent portions of the PDF.

Background Color: Use these color controls to set the background color for the
transparent portions of the PDF.

Mixed Content Within PDF Files
Although PDF files can simultaneously contain PostScript-based art, PostScript text, and
bitmapped graphics, all of these types of image data do not scale the same.
PostScript-based art and text scale smoothly, but bitmapped graphics that are embedded
in a PDF file are subject to the same scaling issues as any other bitmapped graphics
format. As a result, they may soften if scaled larger than their original size.
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Note: Form objects, buttons, and JavaScript objects that are present in an imported PDF
file do not appear in Motion.

Multi-Page PDF Files
You can import multi-page PDF files. When you do, an additional parameter called Page
Number appears in the Properties tab when the PDF object is selected. A slider appears
and allows you to set which page is displayed in the Canvas. This parameter can be
animated to display different pages over time.

Important: Multi-layered PDF files are not currently supported. To import a multi-layered
illustration, export each layer as a separate PDF file and import these as a nested group
of objects in Motion.

More About Alpha Channels
Ordinary video clips and image files have three channels of information, one each for the
red, green, and blue channels. Many video and image file formats also support an alpha
channel, which contains additional information that defines areas of transparency. An
alpha channel is a grayscale channel where white represents areas of 100 percent opacity
(solid), gray regions represent partially opaque areas, and black represents 0 percent
opacity (transparent).

When you import a QuickTime movie or an image file into your project, its alpha channel
is immediately recognized by Motion. The alpha channel is then used to composite that
object against any other objects that are behind it.

There are two different ways of embedding alpha channel information into files, and
Motion attempts to automatically determine which type of alpha channel a particular
object uses:

• Straight: Straight alpha channels are kept completely separate from the red, green,
and blue channels of an image. Media files using straight alpha channels appear perfectly
fine when used in a composition, but they may look odd when viewed in another
application. Translucent effects such as volumetric lighting, or lens flares in a computer
generated image may appear distorted until the clip is used in a composition.

• Premultiplied: This type of alpha channel is multiplied with the clip’s red, green, and
blue channels. As a result, objects with premultiplied alpha channels always look correct,
even with translucent lighting effects, because the entire image is precomposited
against a solid color. Most commonly, premultiplied alpha channels are multiplied
against black or white, but Motion can also resolve alpha channels that have been
premultiplied against other colors.
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The only time it really matters which kind of alpha channel an object has is when Motion
doesn’t correctly determine it. If an object’s alpha channel has been set to Straight in the
Media tab when it’s really premultiplied, it may appear fringed with the premultiplied
color around its edges. If this happens, you can select the problematic clip in the Media
tab of the Project pane, then change its Alpha Type parameter in the Media tab of the
Inspector.

Audio Files
You can import different audio file formats into your project, including but not limited
to WAV, AIFF, .cdda, MP3, and AAC. Although Motion is not necessarily intended to be a
full-featured audio editing and mixing environment such as GarageBand, Soundtrack Pro,
or Logic Pro, you can import music clips, dialogue, and sound effects to use in your
projects. If you import a QuickTime file with mono or stereo tracks of audio, the video
appears in the Timeline, while the audio appears in the Audio Editor.

From within Motion, you can select an audio file and open Soundtrack Pro to modify the
audio file. Once saved in Soundtrack Pro, the file is automatically updated in Motion. For
more information, see Using Soundtrack Pro with Motion.

You can freely import audio clips with different sample rates and bit depths. When you
do, Motion resamples any audio tracks that need it to the sample rate and bit depth
currently in use by your computer. The default is 16-bit, 44.1 kHz float for the built-in
audio interface. If you use a third-party audio interface, audio is remixed to the sample
rate and bit depth used by that device.

You can import audio files with sample rates up to 192 kHz, and with bit depths up to
32 bits. Mono and stereo files are supported. Multi-channel audio files are also supported.

Motion supports as many layers of audio as you want to use in the Audio Editor, although
mixing many audio tracks together may affect playback performance. In the Audio Editor,
you use the same tools and commands to edit audio objects as you use in the Timeline
layers list. Each audio layer also has individual settings for level and pan, so that you can
mix a group of tracks together for stereo output.

For more information about file formats supported by Motion, see Audio Formats. For
more information on using audio in Motion, see Working with Audio.

A seamless way to browse for and import music from your iTunes library is to use the
Music category in the Motion Library. For more information, see Adding iTunes and iPhoto
Files from the Library.

Note: You cannot import rights-managed AAC files, such as non-iTunes Plus tracks
purchased from the iTunes Store.
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Adding Media to Your Project
Once you’ve created a new project, the next step is to add media files to your composition.
All media types—movie clips, still images, audio files, or other objects appearing in the
Motion Library—are added to your project using the same methods.

Note: Layered Photoshop files have additional import options available from the drop
menu. For more information, see Adding Layered Photoshop Files to a Project.

The Link Between Motion Layers and Media Files
Prior to learning how to add media to your Motion project, it’s important to understand
the correspondence between layers and source media. Every time you add a file to your
project, you create a link between the layer you see in the Canvas and its corresponding
media file on disk.

Motion is a nondestructive application. This means that any changes you make to media
objects in a Motion project aren’t actually applied to the media files to which they’re
linked.

Because of this link, whenever you add a file to your project, you need to make sure it
remains available on your hard disk for as long as you’re working on that project. If you
move, delete, or rename media files that correspond to layers in a Motion project, those
objects become “offline.” Offline layers appear as checkered rectangles that occupy the
entire bounding box of the object.

If this happens, it’s easy to reconnect the offline layers in your project with new copies
of the media you lost, assuming those files are still available. For more information, see
Online Versus Offline Media.

Selecting Files in the File Browser
You can add files to a project using either the File Browser or the Import command in
the File menu. In most cases, the File Browser is more convenient, and gives you more
control over how the resulting objects appear in your project.
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Prior to adding files, you must first select them in the File Browser. You can add files to
a project either individually or in groups.

To select files in the File Browser
1 Open the File Browser.

2 Select one or more files by doing one of the following:

• Click a single file.

• While holding down the Shift or Command key, click each file you want to select.

• While holding down the Shift or Command key, click any selected file to deselect it.

• In list view, click to the left of any file’s thumbnail, then drag up or down to select
multiple consecutive files.

• In list view, press Shift and use the Up Arrow and Down Arrow keys to add files to the
current selection.

Adding Files to Your Project
The following procedures apply to adding every file type compatible with Motion.

Note: Although iTunes and iPhoto files can be added using the File Browser as described
below, it is recommended that you use the Music and Photo categories within the Motion
Library. Using the Library allows you to browse for files using the playlist or photo album
features available within iTunes and iPhoto. For more information, see Adding iTunes
and iPhoto Files from the Library.

To add one or more files to a project in a new group
1 If the Create Layers At setting in the Project pane of Motion Preferences is set to “Current

frame,” move the playhead to the frame in the Timeline where you want the first frame
of the file to start.

Note: If the Create Layers At setting is set to “Start of project,” this step is unnecessary as
imported files are always placed at frame 1.

2 Select one or more objects in the File Browser.

3 Do one of the following:

• Drag the selected files into the Canvas, placing them at any position.

• Click the Import button to add the selected files to the center of the Canvas.

• Drag the selected files into the blank bottom area of the Layers tab.

• Drag the selected files into the blank bottom area of the Timeline.

• Choose File > Import (or press Command-I), select one or more files in the Import Files
dialog, then click Open.
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A new group is created at the top of the Layers tab, and all files appear as layers nested
within it. Each new layer’s start time in the Timeline is set to the position of the playhead
in step 1.

To add one or more files to an existing group
1 If the Create Layers At setting in the Project pane of Motion Preferences is set to “Current

frame,” move the playhead to the frame in the Timeline where you want the first frame
of the file to start.

Note: If the Create Layers At setting is set to “Start of project,” this step is unnecessary as
imported files are always placed at frame 1.

2 Open the File Browser and Layers tab.

3 Select one or more files in the File Browser.

4 To nest the selected files underneath an existing group, do one of the following:

• Drag the selected files on top of any group in the Layers tab.

The objects appear nested at the top of the group of objects.

• Drag the selected files between any objects in a group.

A position indicator shows the new position that the objects occupy when you release
the mouse button.

• Drag the selected files into the Timeline, placing them between any objects that are
already nested underneath an existing group.

Note: For more information on editing objects into the Timeline, see Using the Timeline.

Once a file has been added to a project, it appears as a layer in the Canvas, Timeline,
Layers tab, and Media tab. Each new layer’s start time in the Timeline is set to the position
of the playhead in step 1.

You can also add files to your project without having them appear in the composition
by dragging a file directly into the Media tab. This allows you to add media objects you
might want to use in the future without actually placing them in your composition.

To drag one or more files to a project without using them in the composition
1 Open the Media tab.

2 Drag one or more files from the File Browser into the Media tab.

The resulting media objects don’t appear in the Canvas, Layers tab, or Timeline.

To copy and paste one or more files to a project without using them in the composition
1 Open the Media tab.

2 Select the object (or Shift-click to select multiple objects) in the Media tab, choose Edit
> Copy.

3 Click in the Media tab to make it the active window, then choose Edit > Paste.
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Adding Layered Photoshop Files to a Project
You can add a layered Photoshop file to your project by dragging it to the Canvas, Layers
tab, or Timeline, by using the Import button, or by using the Import command. Using the
Import button (in the Preview area) results in all layers of the Photoshop file being
collapsed into a single layer, by default. To maintain the layers of the imported file
separately, you need to use the drop menu or the File > Import command.

To control how a layered Photoshop file is added to your project using the drop menu
1 Drag a layered Photoshop file from the File Browser into the Canvas, Layers tab, or Timeline.

2 Before releasing the mouse button, pause until the Canvas drop menu appears.

This menu presents different commands for importing the layered file.

3 Drag the file over the command you want in the drop menu, and when the menu item
is highlighted, release the mouse button.

The layers of the Photoshop file are added using the command you choose:

• Import Merged Layers: All layers of the Photoshop file are collapsed into a single layer.

• Import All Layers: A new group is created and nested within the currently selected
group. Each layer of the Photoshop file appears as an individual layer nested within
this group.

You can also import individual layers from the Photoshop file. Each layer in the selected
Photoshop file appears as a separate item in the drop menu. Selecting an individual layer
adds only that particular layer to your project, where it appears as a single layer.

Note: When a Photoshop file contains more layers than can be displayed in the drop
menu, the Choose Layer option appears in the drop menu. Once Choose Layer is chosen,
use the Pick Layer to Import dialog to select which layer to import.

To control how a layered Photoshop file is added to your project using the Import
command

1 Choose File > Import.

2 Select the file you want to import, then click Import.

The Pick Layer to Import dialog appears.

3 Choose a command from the Layer Name pop-up menu:

• Merged Layers: All layers of the Photoshop file are collapsed into a single layer.

• All Layers: A new group is created and nested within the currently selected group. Each
layer of the Photoshop file appears as an individual object nested within this group.

• Individual layers: Each layer in the selected Photoshop file appears as a separate item
in the drop menu. Selecting an individual layer adds only that particular layer to your
project, where it appears as a single object.
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To choose a different Photoshop layer than was originally selected on import, select
the Photoshop file in the Layers tab, then choose a layer from the Layer pop-up menu
in the Properties tab of the Inspector.

Adding iTunes and iPhoto Files from the Library
You can add files from your iTunes and iPhoto libraries to a project via the Motion Library.
This is very convenient, as the iTunes library and playlists and iPhoto albums appear in
the Library subcategories.

Note: Although a connected iPod appears in the File Browser as a hard disk, you can only
browse for and import iPod files that are stored as data. Music transferred to the iPod via
iTunes cannot be imported into Motion.

To add an audio file from iTunes
1 In the Library, select the Music category.

The iTunes library and playlists appear. By default, All is selected (the iTunes library).

2 With All selected or by selecting a playlist, select an audio file from the stack.

Note: When displayed in list view, the Music category shows information created in
iTunes, such as the Name, Artist, Album, Duration, and Size of the file.

3 Do one of the following:

• In the Preview area, click Apply.

• Drag the audio file to the Canvas, Project pane, or audio area of the Timeline (not the
Audio Editor).

Note: Rights-protected AAC files cannot be imported into Motion and do not appear in
the file stack. This includes non-iTunes Plus music purchased from the iTunes Store.

For more information on working with audio files, see Working with Audio.

To add a file from iPhoto
1 In the Library, select the Photos category.

The iPhoto albums appear. By default, All is selected (the iPhoto library).

2 With All selected or by selecting an album, select a file from the stack.

Note: When displayed in list view, the Photos category shows information created in
iPhoto, such as the Name and Size of the file.

3 Do one of the following:

• In the Preview area, click Apply.

• Drag the file to the Canvas, Layers tab, or Timeline.
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Note: When importing large-scale images into Motion, you have the option to import
the files as is, to scale the images to the size of the Canvas, or to change the resolution
of the image to fit the Canvas. For more information, see Using High-Resolution Still
Images.

Managing Layers in Your Project
When you add a file to your project, a corresponding layer appears in the Canvas, Layers
tab, and Timeline. Once added, you can duplicate any layer in the Canvas, Layers tab, and
Timeline to create as many copies as you need. Each copy you create has individual
parameters in the Inspector, which gives you the freedom to individually modify and
animate each duplicate layer as necessary.

The Relationship Between Objects in the Layers Tab and Media Tab
Every file you add to your project creates a new corresponding object in the Media tab,
even if it’s identical to other files you have already added. This means that if you drag the
same file into your project five times from the File Browser, five corresponding objects
are created in the Media tab.

On the other hand, if you duplicate a layer that’s already in your project, a relationship is
maintained between that instance of the object and the previously existing object in the
Media tab. No new layer is created in the Media tab.

By default, objects added to your project are managed automatically by Motion. If you
delete a layer from the Canvas or Layers tab, the media object is removed automatically
from the Media tab. You can turn off this feature in the General pane of Motion Preferences.
For more information, see Media.

Duplicating Files
If you need more copies of an object in your project, either duplicate them directly in the
Canvas using the Duplicate command, or drag an object from the Media tab to the Canvas
or Timeline to create a new corresponding instance of that object. Another way to
duplicate an object is to use the Make Clone Layer command. For more information on
the Make Clone Layer command, see Making Clone Layers.

It is easier to manage all duplicated layers using the media object’s Media tab parameters
in the Inspector. These parameters define the media object’s essential properties, including
the frame rate, pixel aspect ratio, interlacing, and alpha channel parameters. There are
also additional parameters that allow you to define each media object’s end condition,
reversal, cropping, and timing. Each media object’s parameters affect all layers in the
project that have a relationship to the corresponding media object in the Media tab, so
changing the media object’s parameters simultaneously updates every layer in your
project to which it is related.
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For more information on a media object’s Media tab parameters, see Object Media Tab
Parameters.

Seeing the Relationships Between Objects
There are two object parameters where you can see the relationship between objects in
the Layers tab and objects in the Media tab.

• The Media parameter appears in the Properties tab of the Inspector whenever you
select an object in the Layers tab. The Media parameter is an image well that displays
the source media in the Media tab to which the currently selected object corresponds.

• The Linked Objects list appears in the Media tab of the Inspector whenever you select
an object in the Media tab of the Project pane. This list displays all objects in the Layers
tab that correspond to the selected source media. Changing an object’s name in the
Layers tab automatically updates the name that appears in the Linked Objects list.

Using the Reveal Source Media Command
A fast way to find any layer’s source media in the Media tab is to use the Reveal Source
Media command.

To reveal a layer’s source media in the Media tab
Do one of the following:

µ Control-click a layer in the Canvas, Layers tab, or Timeline, then choose Reveal Source
Media from the shortcut menu.

µ Select the layer, then choose Object > Reveal Source Media (or press Shift-F).

The Inspector opens and displays the Media tab. At the same time, the Media tab in the
Project pane opens. The source media is selected, and its Media tab parameters are
exposed in the Inspector.

Online Versus Offline Media
As mentioned earlier, adding a layer to a Motion project creates a link between the layer
in your project and its corresponding media file on disk. When you delete, move, or
rename files on disk that are linked to layers in Motion, those files go offline, meaning
that they’re temporarily unavailable to your project. This can also happen if you give
someone a project file without also providing them with the source media it uses.
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When you first open a project file with media that is unavailable, a dialog appears listing
all the media files that can’t be found. Assuming the media has been moved to another
folder or disk instead of being deleted, you have the option to search every disk connected
to your computer to find them. If you know the location of the missing media, you can
display a manual reconnection dialog to navigate directly to the files without having to
search.

To reconnect the media files in this list using Search
1 Click Search.

Motion attempts to automatically find the first missing file in the list. If it is found, a dialog
appears with the missing media file selected. If it is not found, a manual reconnection
dialog appears, giving you the option to navigate to the file manually.

2 In the manual reconnection dialog, click Open to reconnect the media.

If a file has been renamed, you’ll have to find it manually.

3 To find a file manually, navigate to the renamed file’s location, select it, then click Open.

If more than one of the missing media files appears in the same folder, all files are
automatically reconnected.

To cancel an active search
1 Click Cancel.

The manual reconnection dialog appears.

2 In the dialog, navigate to the file’s location, then click Open.
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To reconnect the media files in this list using Reconnect
1 Click Reconnect.

2 In the manual reconnection dialog, navigate to the file’s location, then click Open.

If a layer in your project file is offline and you do not immediately reconnect it upon
opening the project, it appears as a checkered rectangle that occupies the entire bounding
box of the layer.

If you do not immediately reconnect an offline layer, you can still save changes to the
project and even close it again, and reconnect the offline layers later. You can reconnect
these offline layers at any time.

To reconnect a layer in a project with its source media on disk
1 Open the Media tab in the Project pane.

2 Select the offline layer you want to reconnect.

3 Open the Media tab in the Inspector.

4 Click the Replace Media File button that appears underneath the Linked Objects parameter.

Motion attempts to automatically find the first missing file in the list. If it is found, a file
dialog appears with the missing media file selected.

5 Click Open to reconnect it.

Note: You can also use the File > Reconnect Media command.

The offline layer comes online, and the original graphic appears. If more than one missing
media file appears in the same folder, all files are automatically reconnected.

Deleting Objects from a Project
There are two ways you can delete an object in Motion. You can delete a single instance
of an object from the composition by deleting it in the Layers tab, Timeline, or Canvas.
By default, this removes the object from use and removes its source media in the Media
tab, if it is no longer used by the project. If other instances of that object appear in your
project, those are left alone.
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You can also delete the object that appears in the Media tab. Doing this also removes all
corresponding instances of that object in your project.

To delete one or more objects from a project
1 Select one or more objects by doing one of the following:

• To delete a single object, select it in the Layers tab, the Timeline, or the Canvas.

• To delete multiple objects, Shift-click to select the objects.

Note: In the Layers tab or Timeline, you can Command-click to select noncontiguous
objects.

2 To delete the selected objects, do one of the following:

• Choose Edit > Delete.

• Press Delete.

The objects are deleted from your project, but their corresponding source media files
on disk remain untouched.

To delete all objects that correspond to a single object in the Media tab
1 Open the Media tab, then select the source media you want to delete.

2 Do one of the following:

• Choose Edit > Delete.

• Press the Delete key.

A dialog appears and prompts you to confirm the deletion.

3 Click Delete.

Exchanging Media in a Project
You can exchange any layer in your project with a different object in the File Browser or
Library. This breaks that layer’s original source file link and creates a new link to the file
you’re exchanging. When you exchange a layer’s source media, the object in your project
retains all of its Property tab parameter values (including the Position, Scale, and Opacity
parameters), selected blend mode, nested filters and behaviors, masks, and keyframes.

The exchange operation allows you to replace layers in your project even after you’ve
modified and animated them. If you’re unhappy with a particular element of your
composition, exchange it with a new one.

Important: You can only exchange layers that are linked to media files on disk. You cannot
exchange Motion-generated objects such as particle systems, generators, or text objects.
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This operation allows you to use temporary layers in your project until the finished layer
is available. For example, if you’re expecting artwork from another artist that’s not yet
available, you can use a temporary graphic with the same dimensions, and then exchange
it when the final artwork becomes available.

This operation is extremely useful for customizing projects created using templates. For
more information, see Customizing Projects Created with Templates.

To exchange a layer in your project in the Layers tab
1 Drag a file from the File Browser onto a layer in the Layers tab.

2 When a curved pointer appears, release the mouse button.

The original layer in the Layers tab is replaced by the new object.

The curved pointer appears when 
you drag a new object over an 
existing object’s thumbnail.

To replace a layer in the Media tab
1 Select the object you want to replace in the Media tab.

2 In the Inspector, open the Media tab.

3 Click Replace Media File.

A dialog appears.

4 Navigate to the file you want to use to replace the current source media.

5 Click Open.

The new media object replaces the current object in the Media tab along with all layers
or objects linked to the media object in your project.

Object Media Tab Parameters
When you select an object in the Media tab of the Project pane, the Inspector displays a
Media tab that contains the properties defining how the object appears in Motion. This
includes parameters such as the type of alpha channel used, pixel aspect ratio, field order,
and so on. All of these parameters can be edited, which changes the way that object is
displayed and composited in your project.
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While Motion makes an effort to correctly interpret how objects you add to your project
should appear, sometimes it isn’t possible to correctly identify how a source media file
should be treated. Make sure that each object you add to your project has the correct
settings in its Media tab so you can successfully mix and match objects with different
pixel aspect ratios, alpha channel types, and frame rates.

Because Motion is a nondestructive application, changes made to these parameters are
not applied to the source media files on disk. They simply affect how objects are drawn
within Motion.

254 Chapter 6 Creating and Managing Projects



Controls in the Media Tab of the Inspector
The following controls let you modify the objects in the Media tab, which also affects all
the instances of the object in the project.

Inspector Media tab

Separate layers in a Photoshop file do not use the following parameters. These parameters
are used only when a PSD file is imported as “Merged.”

Note: PDF files with transparent backgrounds do not have the Alpha Type or Invert Alpha
parameters.
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Alpha Type: An object’s alpha channel contains information that defines areas of
transparency in the image or movie. When you import a QuickTime movie or an image
file, its alpha channel is immediately recognized by Motion. There are six different ways
to embed alpha channel information into files, which correspond to the options in this
pop-up menu. Motion automatically assigns one of these options based on an analysis
of the object when it is imported, but you can override this if necessary.

The six commands in this pop-up menu are:

• None/Ignore: The default setting for objects with no alpha channel. This option also
allows you to ignore an object’s existing alpha channel, so that the entire object is
solid.

• Straight: Straight alpha channels are kept completely separate from the red, green,
and blue channels of an image. Media files using straight alpha channels appear perfectly
fine when used in a composition, but they may look odd when viewed in another
application. Translucent effects such as volumetric lighting or lens flares in a
computer-generated image may appear distorted until the clip is used in a composition.
If Straight is chosen, but you see a black, white, or colored fringe around the object,
this parameter is incorrectly set and should be changed to one of the Premultiplied
options, depending on the color of the fringe.

• Premultiplied-Black: This type of alpha channel is multiplied with the clip’s red, green,
and blue channels. As a result, objects with premultiplied alpha channels always look
correct, even with translucent lighting effects, because the entire image is
precomposited against a solid color. This option interprets alpha channels that have
been precomposited against black.

• Premultiplied-White: This option interprets alpha channels that have been precomposited
against white.

• Premultiplied-Color: This option interprets files that have been precomposited against
another color.

• Guess Alpha Type: This option forces Motion to analyze the file in an attempt to
automatically figure out what kind of alpha channel it uses. If you’re unsure, use this
setting.

Invert Alpha: Ordinarily, an alpha channel is a grayscale channel, where white represents
areas of 100 percent opacity (solid), gray regions represent partially opaque areas, and
black represents 0 percent opacity (transparent). If an alpha channel has been incorrectly
generated in reverse, this checkbox inverts it.

Pixel Aspect Ratio: Defines whether the object was created using square or nonsquare
pixels. In general, objects created for computer display, film, and high definition video
use square pixels, while objects created for standard definition video formats use
nonsquare pixels. A text field to the right of this pop-up menu displays the numeric aspect
ratio, in case you need to manually change the ratio. By correctly identifying each object
you add to your project, you can mix and match both kinds of media.
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Field Order: When importing interlaced video, choose the field order with which the
clips were captured. This should match the field order of the device used for capture. The
interlacing is either Upper (Odd) or Lower (Even). If you choose incorrectly, you’ll notice
immediately upon playback that the video appears to “stutter,” because the order of
fields is accidentally reversed. When this happens, simply choose the opposite field order
setting in this pop-up menu. Clips that were shot using a progressive scan video camera
or on film have no interlacing, and should be set to None. By correctly identifying each
object in your project, you can freely mix and match clips with a different field order.

Frame Rate: Choose a frame rate in frames per second that matches the clip’s native
rate. For example, film is 24 fps, PAL video is 25 fps, and NTSC video is 29.97 fps. Additional
frame rates are available for different video formats. If the frame rate you require is not
listed, you can type a number in the text field to the right of the pop-up menu.

Note: Project frame rates are determined by the project preset. To edit a preset or to
create a new preset, choose Motion > Preferences and use the options in the Presets
pane.

If you change a QuickTime file’s frame rate, you can choose “From file” at the bottom of
the Frame Rate pop-up menu to change this parameter to the QuickTime file’s original
frame rate.

Note: While you can freely mix clips using different frame rates, clips playing at a frame
rate different from that of the project may not play smoothly.

Gamma: Changes the assumed gamma of imported images to 1/1.8, 1/2.2, 1/2.22, Custom,
or automatically based on the image file.

Note: If imported images appear too dark or too washed out, the gamma setting may
be incorrect.

Fixed Width and Fixed Height: Displays the resolution of an image. When Large Stills
(in Motion Preferences) is set to Scale to Canvas Size, these values display the resolution
of the original file. When Down-Res to Canvas Size is set in the preferences, these values
display the new resolution of the imported image.

When a PDF is selected, these controls set the maximum resolution to which a PDF object
can be smoothly scaled. For more information, see Fixing the Resolution of a PDF Object.

Crop: A multidimensional parameter that defines a number of pixels to be cropped from
each of an object’s four sides, relative to the outer edge of the bounding box that
surrounds that object. Cropping an object in the Media tab also crops all instances of
that object that appear in your project. A similar Crop parameter appearing for objects
in the Layers tab allows you to individually crop each instance of that object. For more
information, see Parameters in the Properties Tab.
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Timing: These parameters control the start, end, and duration of each media object.

• Start: Sets the In point of the object, in both constant and variable speed modes.
Adjusting this parameter always moves the object In point to the specified frame
without affecting the duration of the object.

• End: Sets the Out point of the object, in both constant and variable speed modes.
Adjusting this parameter always moves the object Out point to the specified frame
without affecting the duration of the object.

• Duration: Sets the total duration of the object. If Time Remap is set to Constant Speed,
adjusting Duration will also affect the Speed and the Out point. If Time Remap is set
to Variable Speed (in the Timing controls of the Properties tab of the Inspector), adjusting
Duration will not affect variable speed playback.

Linked Objects: This list displays all objects that appear in the Layers tab that have a
relationship to that object. Two columns display the name of each group containing an
instance of the source media, along with the object’s name. Changing an object’s name
in the Layers tab automatically updates the name that appears in the corresponding
object’s Linked Objects list.

Replace Media File button: This button allows you to relink a media object in your project
to another source file on disk. This feature is primarily useful for relinking offline objects,
but it can also be used to substitute the media used by an object in your project with
other media. It also lets you replace one object with another, along with all instances of
that object in your project.

Summary: A separate pane that lists the properties of the media file on disk that’s linked
to the selected object.
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Using Media in the Library
Motion ships with a collection of media and effects that you can use in your projects. The
Library shares many controls and window panes with the File Browser. Both tabs are
designed for the navigation of media that you want to add to your project. In general,
all the controls work identically to those found in the File Browser, but the organization
of listed media is different.

Categories Subcategories

The Library sidebar consists of a two-column pane. The left column displays all the
categories of media and effects that are available in the Library. When you select a
category, subcategories appear in the right column. Selecting a subcategory displays all
the media or effects objects within the subcategory in the Library stack below.

Library Categories
The Library contains many different types of categories, as described in the next sections.

Behaviors and Filters
Behaviors and filters are applied directly to objects that have already been added to your
project. They do not exist on their own. Instead, they must be attached to an object to
have an effect. Both behaviors and filters can be customized after they’ve been added to
a project, and customized versions can be stored in the Library for future use.

For more information about behaviors, see Using Behaviors. For more information about
filters, see Using Filters.

Image Units (Filters)
The Image Units category appears in the Motion Library if you are running Mac OS X 10.5
or later. Motion supports the operating system’s Core Image Units (filters).

Generators
Generators are user-customizable computer-generated objects that can be used to create
a variety of graphic elements. When you add a generator to your project, it automatically
adapts to the frame size and frame rate of the project. Generators also have infinite
duration, so they can play as long as necessary.
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Generators have all the property parameters belonging to other objects. Properties specific
to each generator also appear in the Generator tab of the Inspector whenever a generator
is selected. You can also save customized versions of generators in the Library for future
use.

For more information about the generators available in Motion, see Working with
Generators.

Image Units (Generators)
The Image Units category appears in the Motion Library if you are running Mac OS X 10.5
or later. Motion supports the operating system’s Core Image Units (generators).

Particle Emitters
Several categories of pre-made particle emitters let you quickly add effects ranging from
simulations of smoke, fire, and explosives, to animated abstract textures that you can use
in different ways. All of Motion’s pre-made particle systems can be customized once you
add them to your project.

For more information about using particle systems, see Working with Particles.

Replicators
Several categories of pre-made replicators let you quickly add background, transitional,
or other types of animated patterns. All of Motion’s pre-made replicators can be
customized once you add them to your project.

For more information about replicators, see Using the Replicator.

Shapes
This category contains pre-made shapes that you can use either as visual elements or as
image masks. Each shape is a Bezier shape and can be further customized using Motion’s
shape editing tools. For more information about editing shapes and masks, see Using
Shapes, Masks, and Paint Strokes.

Gradients
The Gradients category contains gradient presets that you can use in the gradient editor
found in particle system emitters and cells, as well as in text objects and shapes. Motion
comes with a collection of gradient presets, but you can also save your own custom
gradients created with any gradient editor.

Fonts and LiveFonts
Fonts and LiveFonts that are installed on your computer appear in these categories. Fonts
are organized into subcategories based on the categories of fonts you define in the Font
Book application. For more information about Font Book, see Mac Help in the Finder Help
menu.
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You can use the font categories to preview the fonts that are available on your computer.
You can also drag fonts and LiveFonts onto text objects to change the typeface they use.
For more information about using fonts with text objects, see Using the Library Font
Preview.

Text Styles
Text styles are presets that can be applied to text objects in your project to instantly
change their style parameters. These style parameters include face, outline, glow, and
drop shadow parameters. Dragging a text style onto a text object instantly applies that
style to the text.

For more information on text styles, see Editing Text Style.

Shape Styles
Shape styles are presets that can be applied to shapes and paint strokes to instantly
change their style parameters. Dragging a shape style onto a shape instantly applies that
style to the shape.

For more information on shape styles, see Saving Shapes and Shape Styles.

Music and Photos
These categories allow you to browse for and import audio files directly from your iTunes
library and image files directly from your iPhoto library. The Music subcategories that
appear in the Motion Library are playlists created in iTunes. The Photos subcategories
are albums created in iPhoto. The contents of each library, album, or playlist appear in
the file stack.

For more information on importing iPhoto or iTunes files, see Adding iTunes and iPhoto
Files from the Library.

Content
Motion ships with a collection of pre-made graphics and Motion-generated objects that
appear in the Content category. Any of these objects can be dragged into the Canvas
and used as design elements for your own project. Some of the subcategories contain
objects used to make the templates included with Motion. The one exception is the
Particle Images subcategory, which comprises particle cell sources used to generate the
particle emitter presets included with Motion.

By default, the content files that ship with Motion are stored in the /Library/Application
Support/Final Cut Studio/Motion/ folder when you install Motion. During installation, you
can select an alternate location to install the Motion content. Custom Motion-generated
objects that you place into the Library are saved in the /Users/username/Library/Application
Support/Final Cut Studio/Motion/Library/Content/ folder.
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Note: Dragging a media object into the Content category leaves its corresponding file
on disk in its original location. For this reason, it’s recommended you centralize all media
you plan on importing into the Library for future use into a dedicated and predictable
location on disk, to prevent accidentally moving, renaming, or deleting those files.

Favorites and the Favorites Menu
It’s easy to customize the behaviors, filters, particle systems, gradients, and generators
used in Motion to create your own effects. These customized objects are saved into their
corresponding categories. The Favorites category provides a place to put objects—built-in
or custom-made—that you frequently use. You can also place frequently used media
files into the Favorites, such as PDF or TIFF files. Objects you put in the Favorites category
are available to every project you create in Motion.

Objects you place in the Favorites Menu folder appear in the Favorites menu, for even
faster access. When you choose an item from the Favorites menu, that item is placed into
the currently selected layer, positioned at the center of the Canvas. Objects you put in
the Favorites Menu are available to every project in Motion.

Objects that are dragged into the Favorites and Favorites Menu categories are saved into
the /Users/username/Library/Application
Support/Final Cut Studio/Motion/Library/Favorites/ and /Favorites Menu/ directories,
respectively.

Note: Objects placed into subcategories that correspond to a folder in the
/Library/Application Support/Final Cut Studio/Motion/Favorites/ folder are shared among
all user accounts on that computer.

Adding Your Own Content to the Library
You can add your own customized versions of generators, filters, behaviors, and gradients
to categories in the Library. Furthermore, if you work on one or more programs that
frequently recycle the same graphics elements, or if you have a library of graphics that
you use regularly, you can add these media files to the Favorites category. It is
recommended that you add custom content to the Favorites category. Content you put
into the Library is available to every project in Motion.

To add Motion-generated objects to a Content category
µ Drag an object to the Favorites folder in the Library Category list or subcategory list, or

directly into the Library stack.

Important: Each category except the Content, Favorites, and Favorites Menu is filtered
by the type of object it represents. For example, you can place a user-customized filter
in the Filters category, but you cannot put a filter into the Behaviors category.

You can also place media from disk into the Content, Favorites, or Favorites Menu
categories.
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Using Custom Objects from the Library
When you drag a custom object from the Library to the Canvas, the center of the object
is dropped at the location in which you release the mouse button. If you use the Apply
button in the Preview area to add the object, the object is added at the center of the
Canvas.

When you drag objects to the Canvas that were saved with the “All in one file” drop
menu option, the objects are dropped at the location in which you release the mouse
button and are positioned according to their arrangement when originally saved to the
Library. If you use the Apply button in the Preview area to add the object, the objects
are added at the center of the Canvas.

Note: When you drag a custom mask from the Library into a project, the mask retains
the position with which it was saved (relative to the image or footage on which it is
dropped).

To add a media object to the Favorites category
µ Drag a media object from the Layers tab or Media tab, or from the File Browser, into the

Favorites folder in the Library.

When adding your own content, you can create additional folders to add subcategories
that appear in the subcategory column.

To create a new subcategory within any category
1 Open the Library and select a category.

2 Click the New Folder button (+) at the bottom of the Library.

3 Rename the new folder to suit your needs.

This new folder appears in the subcategory column whenever that category is selected.

To remove objects or folders from a Content category
µ Select an object or folder in the Library stack, then do one of the following:

• Choose Edit > Delete.

• Press Command-Delete.

When Library Media Becomes Unavailable
As with any other object used in a Motion project, Library media used by a project must
be present and installed on the current computer for those objects to appear correctly
in Motion. If someone gives you a project file and you don’t have the same filters, fonts,
or LiveFonts that they do, a warning appears when you open the project that lists the
items that are unavailable.

263Chapter 6 Creating and Managing Projects



You can either close the project and install the necessary files on your computer, or go
ahead and open the file. The following list outlines what happens when you open a
project file without having the necessary media:

• Missing Content: Missing content is treated like any other missing media object. The
objects go offline, and you have the option to reconnect them at any time. For more
information about reconnecting media, see Online Versus Offline Media.

• Missing Filters: When one or more filters are missing, objects in your project that use
those filters appear with a placeholder that shows which filter is missing. This gives
you the opportunity to reinstall the filter at a later point.

• Missing Fonts: When fonts are missing, the text objects that use those fonts default to
Geneva as a temporary substitute. Missing international fonts substitute the default
system font for that language.

• Missing LiveFonts: When LiveFonts are missing, the previously used LiveFont is replaced
by another LiveFont installed on your computer.

Organizing Groups and Layers in Motion
Whenever you drag a media file from the Library or File Browser into the Canvas, Layers
tab, or Timeline, or generate an image from within Motion, the resulting element is
represented as a layer. Think of layers as a series of clear overlays stacked one on top of
the other. These layers combine to create the composite that you see in the Canvas.
Motion provides a graphical representation of this layer hierarchy in the Layers tab of the
Project pane and also in the Timeline layers list. You can rearrange the stacking order of
the layers in your composition by dragging them to a new location in either of these lists.

Layers, in turn, are nested within containers known as groups. Whenever you create a
new layer, that layer is placed within a group. You can drag a layer from one group and
place it inside another group, but layers cannot exist on their own, outside of a group.
Layers nested inside groups appear indented in the Layers tab and the Timeline layers
list.

Nested layers

Enclosing group
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A group can also contain other groups nested inside it. In this way, you can construct
complex hierarchies of nested groups, with each nested group subordinate to the group
that contains it, up to the topmost group.

Nested groups

Enclosing group

One of the goals of organizing the layers in a project is to group layers that you want to
work together as a unit. Doing so ensures that animation and effects that are applied to
the enclosing group also affect all layers nested within that group. By nesting related
layers that you want to animate inside a group, you can save time by animating just the
enclosing group, instead of animating each layer individually.

For example, when you select a group that has three layers nested within it, the entire
group is selected as a single unit.

Layers list with group selected Group selected
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Moving a selection in the Canvas moves all three layers simultaneously.

Before moving group After moving group

Regardless of how they’re nested, individual layers can always be animated independently.
Subordinate groups can also be animated independently, although such animation and
effects also affect all groups or layers that are nested underneath.

The following example shows how you might create a hierarchy of groups to prepare for
the animation of a human figure. Each component of the figure is a separate layer. For
example, the arm is made up of hand, forearm, and upper arm layers. Each related layer
is in a group that’s nested inside a parent group. For the arm, the hand is nested inside
the forearm’s group, which is nested inside the upper arm’s group.
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Note: In this example, each object’s anchor point has been moved to the appropriate
axis of rotation for that object. For more information about changing an object’s anchor
point, see Using the Adjust Anchor Point Tool.

Both arms and both legs are also made up of a hierarchy of nested body parts. It then
follows that these nested groups of layers, which connect to the torso, are themselves
nested inside the Mannequin group. When you collapse the arm and leg hierarchies, you
can see the following simplified hierarchy.

Nesting groups to 
simplify a project

With all of these objects organized this way, animating the figure becomes easy. For
example, if you want to move the entire arm at once, you need only select the Left Arm
group, regardless of how many layers are nested within it.

Selecting the Left Arm 
group selects all objects 
within it.
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When you rotate the selection in the Canvas, every object nested within that group rotates
as a single item.

Before rotating Left Arm group After rotating Left Arm group

Another example of how you might make use of the group hierarchy can be seen through
the application of filters and behaviors. If you apply a filter to a single layer within a group,
the filter affects only that layer. All other layers within the group remain unaffected.

Filter applied to a single layer
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However, If you apply the same filter directly to the group, all layers nested within that
group are affected by the filter, as if they were a single layer.

Filter applied to the enclosing group

Background of Your Project
Two parameters in the Project Properties dialog (choose Edit > Project Properties) affect
the background color of your project and how your composition will appear when it’s
exported out of Motion:

Background Color: A color well that defines the color that appears in the Canvas if no
other object obscures the background.

Note: If you intend to export your project with a premultiplied alpha channel, be aware
that Motion always renders against black.

Background: A pop-up menu that defines whether the background color is rendered as
part of the alpha channel. If set to Solid, the background color creates a solid alpha
channel. If set to Transparent, the background color does not render as part of the alpha
channel. In either case, the background color is visible in the Canvas.

Selecting Layers and Groups in the Layers Tab
In order to reorganize layers and groups in a project, you must first select which ones
you want to move. This section covers the many methods you can use to select layers in
the Layers tab.

To select a single layer or group
µ Click a layer or group in the Layers tab.

Doing so deselects all other selected objects.

Note: Selecting a group does not also select the layers nested underneath it. However,
operations performed on a selected group also affect layers nested within it.

To select multiple contiguous layers or groups
Do one of the following:

µ Shift-click any two layers in the Layers tab.

269Chapter 6 Creating and Managing Projects



Doing so selects both layers, and also all layers in between.

µ Click to the left of any layer’s thumbnail icon and drag up or down to select multiple
layers.

To select or deselect multiple noncontiguous layers or groups
Do one of the following:

µ Command-click any unselected layer or group to add it to the selection.

µ Command-click any selected layer or group to deselect it.

To select all layers or groups in the Layers tab
Do one of the following:

µ Choose Edit > Select All (or press Command-A).

µ Click the first group or layer in the list, then Shift-click the last group or layer in the list.

To deselect all objects or groups in the Layers tab
µ Choose Edit > Deselect All (or press Command-Shift-A).

Reorganizing in the Layers Tab
The order in which layers and groups appear in the Layers tab helps to determine the
layout of your entire project. The order of layers and groups determines which objects
appear to be in front of other objects in the Canvas. You can change the ordering of one
or more objects in the Canvas or in the Layers tab.

To move a layer or group up or down in the Layers tab
µ Drag a layer or group up or down in the Layers tab.

A position indicator appears to show the new position the selection occupies when you
release the mouse button.

Note: You can also use the Bring and Send commands in the Object menu to move layers
up and down in the nested hierarchy within any group. This is especially useful when
working with selected objects directly in the Canvas. For more information, see
Arrangement Commands in the Object Menu.

If you want to organize the objects in your project into multiple groups, you can create
new, empty groups at any time.

To create a new, empty group
Do one of the following:

µ Click the Add button (+) at the top of the Layers tab.

µ Choose Object > New Group (or press Command-Shift-N).

New groups always appear at the top of the Layers tab, and are numbered incrementally
based on the number of groups you’ve created so far.
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When you have more than one group, you can move layers back and forth between them,
changing their nested relationship in your project.

To move a layer from one group to another
1 Select one or more layers.

2 Do one of the following:

• Drag the selected layers to a new position underneath another group.

A position indicator appears to show the new position the selection occupies when
you release the mouse button. If you drag the selected layers within a nested group,
the length of the position indicator shows which position the selection occupies within
the group hierarchy.

• Select one or more layers, choose Edit > Cut (or press Command-X), then select the
group you want to paste into, and choose Edit > Paste (or press Command-V).

You can also copy a layer from one group to another.

To copy a layer from one group to another
Do one of the following:

µ Option-drag one or more selected layers from one group to another.

µ Select one or more layers, choose Edit > Copy (or press Command-C), then select the
group you want to paste into, and choose Edit > Paste (or press Command-V).

Nesting Groups Inside Other Groups
In addition to nesting layers inside groups, you can also nest groups inside other groups.
You might do this if you’re creating a layer hierarchy to control the relationship of one
group of layers to another, or if you’re grouping layers to which you want to apply a
single set of behaviors and filters.

Nesting a group works the same way as nesting a layer.

To move a group inside another group
1 Select one or more groups.

2 Do one of the following:

• Drag the selected group onto another group.

• Drag the selected group to a new position underneath another group.

• Choose Edit > Cut (or press Command-X) to cut the selected group or groups, then
select the group into which you want to paste, and choose Edit > Paste (or press
Command-V).
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Grouping and Ungrouping Layers
You can also nest layers together within a new group using the Group command. You
can group layers that appear within the same group, or you can group groups that are
all nested at the same level relative to the hierarchy of your project. You cannot group
groups that appear at different levels.

To group selected layers together, nesting them in a new group
1 Select all the layers or groups that you want to group together.

2 Choose Object > Group (or press Command-Shift-G).

A new group is created and is numbered incrementally based on the number of groups
you’ve created so far. The layers or groups you selected are nested within the new group.

Before grouping layers After grouping layers

Groups of nested layers or groups can also be ungrouped, which deletes the containing
group and moves all objects and layers within it up the group hierarchy.

To ungroup nested layers
1 Select the group containing the nested layers or groups you want to ungroup.

2 Choose Object > Ungroup (or press Command-Option-G).

Note: You cannot ungroup groups that are already at the top of the Layers tab hierarchy.

Showing and Hiding Groups and Layers
Layers and groups appearing in the Layers tab can be hidden in order to make them
invisible in the Canvas without removing them from your composition. For example, if
you’ve placed a large object into your project and it’s in the way of some other objects
you want to move or rotate in the Canvas, you can simply hide the offending object. You
can also hide objects you’re not sure you want to keep in your project, while preserving
their placement in case you want to use them later.

If you hide a group, you also hide all layers and groups that are nested within it. Hidden
layers and groups are not rendered when your project is exported.
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To show or hide one or more selected layers
Do one of the following:

µ Click the checkbox to the left of a single object or group in the Layers tab or Timeline.

Activation checkbox

µ Choose Object > Active (or press Control-T) to turn the layers on or off.

µ Control-click a layer or group, then choose Active from the shortcut menu.

Note: If you hide one or more layers within a group, the enclosing group’s Activation
checkbox shows a dash, instead of a checkmark, to show that some of its layers are not
visible.

You can “solo” a layer or group in order to hide all other layers in the project. This
technique can be useful when you want to isolate a single object in the Canvas to animate
or manipulate without interfering with other objects in your composition.

To solo a layer
µ Select one or more layers or groups to solo.

µ Choose Object > Solo (or press Control-S).

Note: You can also Control-click an object in the Layers tab, then choose Solo from the
shortcut menu.

All other layers or groups are deactivated, and only the soloed object is visible in the
Canvas. When the selected item is soloed, the solo menu item displays a checkmark.

Fixing the Size of a Group
By default, the size of a group is determined by the layers within that group. Because
animated objects often grow in size, the active height and width of a group (its resolution)
can become quite large. You can constrain the resolution of a group to a specific width
and height in the Group tab of the Inspector.
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The project shown in the following image contains a particle system. Notice that the
animated particles, although not visible once they move off the Canvas, make the group
containing them very large.

Default size of a group
containing particles

Particles bounding box

You can crop the size of a group that contains growing objects using the Fixed Resolution
checkbox in the Group tab of the Inspector.

Group with Fixed Resolution
turned on

If your project contains animated objects that move or expand beyond the edges of the
Canvas and you don’t activate the Fixed Resolution checkbox, your computer processing
time may increase.

Note: The Group tab of the Inspector (which contains the Fixed Resolution parameter)
is only accessible when a group is selected in the project.

When the Fixed Resolution checkbox is selected, objects that are in the group but outside
of the Canvas are cropped to the size of the group defined in the parameter.
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When enabled, the Fixed Resolution parameter crops the group to the size specified in
the Fixed Width and Fixed Height parameters. This means that if the group’s anchor point
is offset, the cropping may not occur around the edges of the Canvas, and objects may
become cut off.

Selected group with an offset anchor point before Fixed 
Resolution is turned on.

Selected group with Fixed Resolution turned on and set to 
project size. Notice that the text objects are cut off.

Anchor point

Anchor point

To fix the resolution of a group
1 In the Layers tab (or the Timeline layers list), select the group.

2 In the Inspector, click the Group tab.

3 Turn on the Fixed Resolution checkbox.

Fixed Resolution enabled 
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By default, the group’s resolution is set to the project size. An indicator appears to the
right of Fixed Resolution, informing you that the group has been rasterized. For more
information on rasterization, see About Rasterization.

4 To define a resolution other than that of the project, adjust the Fixed Width and Fixed
Height sliders.

Note: When a layer within a fixed resolution group is selected, the bounding box around
the layer appears at its original size, unaffected by the containing group’s resolution.

Locking Groups and Layers
Once you’ve finished making adjustments to a particular layer or group, you can lock it
to prevent accidental modification. Locked layers cannot be moved, and their parameters
cannot be altered or animated. Animation and behaviors that were applied to the layer
prior to being locked still play. Locking a group also locks all layers and groups nested
within it.

To lock layers or groups
Do one of the following:

µ Click the layer’s lock icon in the Layers tab.

Lock icon

µ Select one or more layers or groups, then choose Object > Lock (or press Control-L).
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The locked layer’s bounding box in the Canvas turns red to indicate that it is locked.

Collapsing and Uncollapsing Group Hierarchies
Groups and layers in the Layers tab appear in a hierarchy that shows which layers are
nested inside which groups. Nested layers and groups appear underneath and indented
to the right of the group they’re nested within.

To make the Layers tab easier to manage, you can collapse all layers that appear nested
within a single group using that group’s disclosure triangle. Collapsed groups appear as
a single line in the list, and can be moved or nested like any other layer. Each group’s
thumbnail displays a preview of the entire composite within, making it easy to see what’s
nested inside.

To open or collapse a single group
Do one of the following:

µ Click the disclosure triangle to the left of that group’s name and icon.

µ Press the Up Arrow and Down Arrow keys to navigate up and down the Layers tab, then
press the Right Arrow key to open a group, or the Left Arrow key to collapse it.

Renaming Groups
You can rename the groups and layers that appear in the Layers tab to further organize
your media and make each group’s and object’s purpose easier to identify. When you
rename a layer, the original name of the source media file on disk remains unchanged.
Also, changing a layer’s name in the Layers tab does not change the name of its
corresponding object in the Media tab. You cannot change the name of an object in the
Media tab.

To rename a group or layer
1 Double-click the name of the group or layer you want to rename.

2 When the name is highlighted, type a new name.
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3 When you’re finished, press Return to accept the new name.

The new name is also automatically accepted when you click another layer or group.

Note: Once you change a layer’s name in Motion, there is no automatic way to change
it back to what it was originally except for the Undo command.

Searching for Groups and Layers
If it’s difficult to find a single group or layer in a large project, you can use the Search field
at the top of the Layers, Media, and Audio tabs. It is similar to the Search field in the File
Browser, and allows you to search for all layers or groups with a name containing the
search term you enter.

To find a group or layer by name in the Layers tab
µ Type a search term in the Search field.

As soon as you begin typing, all groups and layers with names that don’t contain the
search term anywhere within them are hidden from view, leaving only a list of groups
and layers that match.

To clear the search results
µ Click the Clear button at the far right of the Search field to restore the full contents of the

Layers, Media, or Audio tab.

Clear button

Note: Groups and layers that are hidden as the result of a search operation are not disabled
in the Canvas, and they are not prevented from rendering during export.

In addition to searching for layers by name, you can find any object’s source media in
the Media tab using the Reveal Source Media command.

To reveal an object’s source media in the Media tab
Do one of the following:

µ Control-click an object in the Canvas or a layer in the Layers tab or Timeline, then choose
Reveal Source Media from the shortcut menu.

µ Select the object in the Canvas or layer in the Layers tab or Timeline, then choose Object
> Reveal Source Media (or press Shift-F).

The Media tab and Inspector both open. The “master” object is selected, and its Media
tab parameters are exposed in the Inspector.

Sorting Objects in the Media Tab
The Media tab contains 15 columns that provide information about each object in your
project.
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DescriptionColumn

Displays a thumbnail of the media object.Preview

Lists the filename of the source media on disk to which the object
is linked. If you change the name of corresponding linked objects
in the Layers tab, this name doesn’t change.

Name

Lists the type of file, whether it’s a still image, QuickTime movie,
image sequence, or audio file.

Kind

Indicates whether or not the media is in use in the project.In Use

Displays the total duration of the object, in frames or timecode,
depending on which is displayed in the Timeline.

Duration

Displays the frame size of the object, in pixels.Frame Size

For QuickTime movies, displays the codec used. For still images,
displays the method of compression that’s applied based on the
file type.

Compressor

Specifies the color depth of the image.Depth

Displays the frame rate of the object, in frames per second.Frame Rate

Displays the data rate at which a QuickTime movie is compressed.Data Rate

For audio files and QuickTime movies, displays the sample rate of
the audio.

Audio Rate

For audio files and QuickTime movies, specifies the bit depth of the
audio.

Audio Format

Shows the size of the source media file on disk.File Size

Shows the file creation date of the source media file on disk.File Created

Shows the file modification date of the source media file on disk.
This is a useful parameter to use for file management.

File Modified

You can customize the Media tab to show, hide, or rearrange any of these columns to
suit your needs. You can also resize the thumbnails displayed for each object.
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To show or hide a column
µ Click the right angle bracket (>) at the right of the column headers, then check or uncheck

the columns you want to show or hide in the pop-up menu.

To move a column to the right or left
µ Drag any column header to the right or left to move it.

To increase or decrease the size of each object’s thumbnail
Do one of the following:

µ Use the scale slider at the bottom of the Media tab.

µ Drag the separator between the rows of objects.

Customizing and Creating New Templates
Motion comes with a collection of templates that are ready for you to customize for your
own use. In addition, it’s also easy to create your own templates.

Customizing Projects Created with Templates
When you first create a new project file from a template, it’s an exact duplicate of the
original template. There’s nothing special about template-based projects, and they can
be edited and modified just like any other project. There are a few specific methods you’ll
probably use to customize template-based projects.

Keep in mind that most templates, especially ones you create yourself, are intended to
simplify the process of creating titles and graphics for recurring projects. Examples include
titles and lower thirds for news and interview programs, graphics for magazine shows,
and any repeating program that requires titles with a consistent look that must be updated
from show to show. Well-designed templates allow you to simply exchange key graphics
objects and edit the text to update them for the next show in the series.

Changes you make to new projects created from templates have no effect on the original
templates.
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Exchanging Objects
The easiest way to customize a template-based project is to exchange the objects used
in the template with your own objects, either from the File Browser or the Library. When
you exchange an object, the new object appears in your project with the same parameter
values used by the previous object. In addition, any filters, masks, behaviors, or keyframed
parameters that were applied to the original object remain applied to the exchanged
object.

Although there are several groups named “Drop Zone” in various templates, the objects
within the groups should be replaced—not the layers themselves.

Note: To quickly find all objects to be replaced in a template, type “Drop Zone” in the
Layers tab Search field and press Return. The “Drop Zone” objects are displayed in the
Layers tab.

For more information about exchanging objects, see Exchanging Media in a Project.

Drop Zones
Drop zones allow you to quickly replace footage in a project by dropping clips directly
onto the Canvas. A drop zone appears as a rectangle with a downward arrow in its center.
The drop zone’s layer name appears in the center of the drop zone. Any media item
(image or footage) dragged and dropped into the region defined by the drop zone object
automatically replaces the drop zone placeholder graphic. When media is dragged over
the drop zone, a highlight appears around the drop zone area.

Blank drop zone QuickTime movie being dragged onto drop zone

Note: If there are multiple overlapping drop zones in the Canvas, the topmost one has
priority when something is dragged onto the drop zone. You can force all drop zones to
appear by using Motion’s expose feature. For more see Exposing Drop Zones.
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Using Drop Zones
Drop zones are a unique element in your arsenal of tools to use when creating a new
Motion project and template. While you’re constructing your template, you may want to
disable them so you don’t accidentally drop a clip into a drop zone. Then, later when
using the template, you’ll want to be sure to turn them back on.

To enable drop zones to accept clips
µ Choose View > Use Drop Zones

A checkmark appears next to the menu item. Drop zones will accept objects that are
dragged to them.

To prevent drop zones from accepting clips
µ Choose View > Use Drop Zones.

Make sure a checkmark does not appear next to the menu item. Drop zones will ignore
objects dragged to them.

Exposing Drop Zones
Motion templates often contain drop zones where you can drag and drop your own
image objects. In addition, you can create your own drop zones in any project. You can
use Motion’s expose feature while dragging image items from the File Browser or Library
into the Canvas and be automatically presented with an exploded view of the valid drop
zones in the project.

To expose all drop zones in a project
1 Use the Library or File Browser to locate an object you wish to import into the project.

2 While holding down the Command key, drag the object onto the Canvas.

The object you are dragging to the Canvas is displayed as a thumbnail, and a curved
arrow replaces the pointer until you drop the object. Active objects explode and rescale
in the Canvas so that you can see them all at once. Moving the pointer over an object
reveals its Layers tab name.
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Note: You cannot Command-drag non-image objects (shapes, Motion projects, particles,
etc.) to the Canvas.

Exposing the drop zones

3 Drop the object onto its target.

The object replaces its target, everything moves and rescales back to their original
positions, and the playhead moves to the first frame of the dropped object.

Customizing Text Objects
Text objects can be easily updated using the Text tool. Editing a text object does nothing
to change the format, style, or layout of the text. Furthermore, simple edits made to text
objects have no effect on filters, masks, behaviors, or keyframed parameters that are
applied to that object.

For more information on editing text objects, see Adding Text.

Modifying Behaviors and Keyframes
Objects in template-based projects are animated using a combination of behaviors and
keyframed parameters. These can be edited at any time to customize the motion of the
objects. For more information on modifying behaviors, see Working with Behaviors. For
more information on modifying keyframes, see Modifying Keyframes.
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Using Objects, Behaviors, and Keyframes from Templates
Occasionally, you may find that you want to use a keyframed parameter or behavior
from a template in a project of your own. You can always create a new template-based
project, select the keyframes or behaviors you want to use, copy them, and paste them
into your own project.

All the graphics objects used by the templates also appear in the Content category of
the Library, within the Template Media subcategory. If there’s a particular graphic you
want to use, you can find it in the Library.

Creating New Templates
In addition to using and customizing the templates that ship with Motion, you can also
build your own templates from scratch. Template files contain everything that ordinary
projects do, including media objects, text objects, shapes, generators, behaviors, and
filters, in any combination.

You can create custom templates for commonly used shots that you regularly create. For
example, if you make titles for a news program, you can create templates for the opening
title, interstitial graphics, bumpers, and whatever other repetitious shots you regularly
create. Once saved as a template, you can quickly load the necessary template and, instead
of having to create a new title from scratch, simply customize it with new dates, title text,
and exchanged graphics and movies to reflect the requirements of each new program.

Templates are simply Motion files that are saved in a special way. To create a new template,
create the layout you need just like with any other Motion project. In preparation for
using the layout as a template, you should keep the following things in mind:

Naming Objects in the Layers Tab
The names you give to the groups and layers in your template should indicate each
object’s function. For example, you might name the text objects in a titling template
“Main Title,” “Starring,” “Guest Star,” and so on. If you use visual elements in the template’s
composition, describe their purpose, such as “Background Texture,” “Divider,” “Main Title
Background,” and so on. This way, when someone else wants to customize your template,
it’s easy to see what they’re supposed to do with it.

Using Drop Zones
Drop zones provide a way for template users to intuitively and quickly replace footage
in a template. There are two ways to create drop zones. The first creates a drop zone from
scratch, and the second converts an existing object into a drop zone.

To create a new drop zone
Do one of the following:

µ Choose Object > New Drop Zone (or press Command-Shift-D).
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µ Select an existing object in the Canvas, then turn on the Drop Zone checkbox in the
Image tab of the Inspector.

The Image tab of the Inspector contains controls to adjust the drop zone:

Drop Zone: A checkbox that sets whether an object is a drop zone.

Fit: A pop-up menu where you can choose between three different methods of object
placement within the drop zone. Values include Fit, Center, and Stretch. Fit automatically
modifies the Scale parameter so the new media is scaled proportionally to fit the
dimensions of the drop zone. Center does not modify the object in any way, merely
centering it in the drop zone. If media of a different resolution than the project is used,
the new resolution is used without any changes to the Scale parameter. If Stretch is
chosen, the dropped object is scaled and stretched to fit the dimensions of the drop
zone.

Clear: A button that clears the image from the drop zone, replacing it with the default
generic placeholder graphic.

Creating Multiple Projects for Each Resolution You Require
If you regularly create projects for a variety of formats, it saves time to create a version
of your project for each resolution you need. When you save the project as a template,
you can specify its format to help you browse for it later.

Consolidating Media
Unless you selected an alternate installation location when you installed Motion, the
built-in templates are stored in the /Library/Application
Support/Final Cut Studio/Motion/Templates/ folder. Customized templates are saved into
the /Users/username/Library/Application Support/Final Cut Studio/Motion/Templates/
folder, but any media used by that template remains in its original location on disk. If you
move, rename, or delete any media file used by a template, that object goes offline in all
projects created with that template.

To avoid this, it is recommended that you move all media files you plan on using to a
central folder on disk prior to importing them into the project file you’ll be saving as a
template. This helps to ensure that those media files are not lost. Alternatively, you can
use the File > Save As command, and use the Collect Media option. For more information,
see Collecting Media.

Tip: If you plan to share custom templates with other users, it is recommended that you
copy your custom templates folder to that computer’s /Users/username/Library/Application
Support/Final Cut Studio/Motion/Templates/ folder.

Note: In the General section of Motion Preferences (press Command-Comma), you can
direct Motion to the folder on your system or network that contains the content and
templates. This also allows multiple users on a network to share a single, centralized
folder.
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To save a project as a template
1 Choose File > Save as Template.

The Save dialog appears.

Note: It is recommended that you create a new custom theme in which to save your own
templates.

2 If you want to create a new theme to add your new template to, click New Theme, type
a name in the New Theme dialog, then click Create.

3 In the Save dialog, type a name for the template.

4 In the Theme pop-up menu, choose a theme in which to store your template.

5 Choose the format that your template conforms to from the Format pop-up menu.

6 If you want your template to play a preview when it appears in the Template Browser,
turn on Create QuickTime Preview.

7 Click Save.

Your new template is saved into the theme you selected. Customized templates are saved
into /Users/username/Library/Application Support/Final Cut Studio/Motion/Templates/,
in a folder that corresponds to the name of the theme you’ve selected.

Organizing Templates in the Template Browser
You can use the Template Browser to select and organize your templates, if necessary.
All templates are organized into categories. You can add, delete, and rename categories
directly in the Template Browser.

To add a category in the Template Browser
1 Choose File > Open Template.

The Template Browser opens.

2 Click New Theme.

3 Enter a name for the theme into the dialog at the top of the Template Browser.

4 Click Create.

The new category appears in the Theme column at the left.
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To delete a category in the Template Browser
1 Choose File > Open Template.

The Template Browser opens.

2 Select a category in the Theme column.

3 Press Delete.

An alert dialog prompts you to confirm the deletion.

4 Click the Delete button.

The directory on your disk corresponding to that category is placed in the Trash, but not
deleted. Any template files in that category’s directory are also placed in the Trash.

To delete individual templates from the Template Browser
1 Choose File > Open Template.

The Template Browser opens.

2 Select a template.

3 Press Delete.

An alert dialog prompts you to confirm the deletion.

4 Click the Delete button.

287Chapter 6 Creating and Managing Projects





Compositing is the process of combining at least two images to produce an integrated
final result. The process can be as simple as placing text over an image, or as complex as
combining live actors with drooling space aliens that shoot laser beams from their eyes.
Motion graphics artists move multiple objects simultaneously onscreen using a strong
sense of visual design. Motion graphics artists typically use techniques such as changing
group and object order, transforming the physical properties of objects (such as scale),
adjusting object opacity and blend mode settings, applying filters to objects, and creating
text and shapes. Motion graphics projects often combine layout and design techniques
with techniques borrowed from special effects work such as keying, masking, color
correction, and creation of particle systems.

This chapter covers the following:

• Compositing Workflow (p. 290)

• Group and Layer Order (p. 291)

• Transforming Objects and Layers (p. 293)

• 2D Transform Tools (p. 296)

• Adjusting Object Properties in the Inspector (p. 312)

• Making Clone Layers (p. 317)

• Editing Opacity and Blending Parameters (p. 319)

• Drop Shadows (p. 343)

• Retiming (p. 345)

• Expose Commands (p. 349)

289

Basic Compositing 7



Compositing Workflow
Once you import the objects you need for your project, the first step is to arrange the
objects within the Canvas to come up with the general design of your piece. Even before
you animate anything, you should decide what size each object should be, where
everything should be positioned, if any objects need to be rotated to fit where they need
to be, and so on. You can also make more extreme manipulations to create other effects.
For example, you could crop out unwanted parts of a particular object.

You can use different transform tools, each of which allow you to perform basic
compositing tasks such as selecting, moving, rotating, scaling, shearing, corner-pinning,
cropping, changing an object’s anchor point, and manipulating drop shadows. The
transform tools are available in the View section of the Toolbar. When you switch among
the transform tools, different onscreen controls appear in the Canvas. Drag these controls
to perform the selected transform action.

The onscreen transform controls for shapes include an additional roundness handle. For
more information, see Creating and Editing Shapes.

Drag a corner handle of 
an object in transform 
mode to resize it.

Additional controls in the HUD let you change each selected object’s opacity, blend mode,
and drop shadow settings.
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The onscreen controls and the HUD controls all correspond to parameters that appear
in the Properties tab of the Inspector. Each parameter corresponds to a different Canvas
control, and adjustments made in the Canvas are simultaneously updated in the Inspector.
For example, if you’re using the Select/Transform tool and you change an object’s scale
by dragging its corner handles in the Canvas, the object’s Scale parameter is updated in
the Properties tab of the Inspector.

When you begin to lay out a composition, it’s a good idea to start by creating a static
layout of your project that represents how it looks at the beginning, end, or at a particular
moment in time. In addition to manipulating the geometry of objects in your project,
you can also alter their opacity. This gives you additional control over how overlapping
elements of your layout merge together. Blend modes provide further control over the
appearance of overlapping objects, accentuating or stylizing the colors of the topmost
objects based on the objects underneath.

After you create an initial layout, you can animate any of the objects you’ve added to set
your project in motion. For more information about animating objects and their properties,
see Animation in Motion.

Group and Layer Order
In a purely 2D project, the order in which layers and groups appear in the Layers tab and
Timeline (the layer order) determines which layers appear in front of others in the Canvas.
Before you use any of the tools described in this chapter, you should first arrange the
layers and groups in your project so that they appear in the proper order. For information
about layer order, see Reorganizing in the Layers Tab.

Arrangement Commands in the Object Menu
In addition to rearranging object order in the Layers tab, you can also move objects in
front of or behind other objects using commands in the Object menu. This is useful when
you want to quickly move an object to the front while you’re working in the Canvas.
Rather than open the Layers tab, you can simply use one of the commands in the Object
menu.

The arrangement commands can be used with either objects, groups, or groups that are
nested within another group. Reordering a group reorders all objects that are nested
within that group.

Note: You cannot use the reorder commands to move objects out of the group they’re
nested within.
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There are four arrangement commands in the Object menu:

• Bring to Front: Places the selected object in front of all other objects within the same
group by moving it to the top of the nested group in the Layers tab and Canvas.

After Before

• Send to Back: Places the selected object behind all other objects within the same group
by moving it to the bottom of the nested group in the Layers tab and Canvas.

After Before

• Bring Forward: Moves the selected object up one level in the hierarchy of objects nested
within the same group in the Layers tab and Canvas, moving it closer to the front in
the Canvas.

• Send Backward: Moves the selected object down one level in the hierarchy of objects
nested within that group in the Layers tab and Canvas, moving it closer to the back in
the Canvas.
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Reordering Nonconsecutive Selections
When you apply Bring Forward or Send Backward arrangement command on
nonconsecutive selected layers, the layers move up or down the object hierarchy together,
and any space between the layers remains.

Bring Forward command appliedNonconsecutive layers selected

When you apply Bring to Front or Send to Back arrangement command on nonconsecutive
selected layers, the layers move up or down the object hierarchy together, and any space
between the layers is removed.

Transforming Objects and Layers
Transforms are operations that you perform on objects—such as moving, resizing, or
rotating. Object transforms can be performed either directly using onscreen controls
(transform handles), or by changing the object’s parameters in the Properties tab of the
Inspector. In general, the controls in the Canvas give you a more hands-on method of
working, while the individual parameter controls in the Properties tab are better suited
for subtle adjustments requiring greater numerical precision. For more information about
each transform’s corresponding parameter and its numerical values, see Adjusting Object
Properties in the Inspector.

Important: Applying a mask or certain filters to a group can cause what is called
rasterization. Rasterization converts a group into a bitmap image, which affects blend
modes and interactions with other objects in a project. For more information on
rasterization, see About Rasterization.

Selecting Objects to Transform
Before you can transform objects and groups, you must first select what you want to
transform in the Canvas, Layers tab, or Timeline. Selecting a group or object in one place
also selects it in the others.

When an object is selected in the Canvas, it is surrounded by a bounding box with
transform handles corresponding to the currently selected transform mode. These handles
allow you to transform each selected object.
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To select a single object in the Canvas
µ Click any object in the Canvas.

To select multiple objects in the Canvas, or to add objects to a selection
Do one of the following:

µ Drag a selection box over all the objects you want to select.

µ Holding down the Shift key, click all the objects you want to select.

µ To add objects to a selection, holding down the Shift key, drag a selection box over objects
you want to add to the selection.

To deselect one of multiple selected objects in the Canvas
Do one of the following:

µ Shift-click an object you want to deselect.

All other selected objects remain selected.

µ Holding down the Shift or Command key, drag a selection box over one or more objects
you want to deselect.

To select all objects in the Canvas
Do one of the following:

µ Choose Edit > Select All.

µ Press Command-A.

To deselect all objects in the Canvas
Do one of the following:

µ Choose Edit > Deselect All.

µ Press Command-Shift-A.

From time to time, an object may become hidden behind another object. The best way
to select a hidden object is to select it in the Layers tab or Timeline. When you do so, the
object’s bounding box and transform controls appear in the Canvas, even if the object
is completely obscured.
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Note: When an inactive object is selected, you also see only the bounding box for that
object.

For more information on how to select objects and groups in the Layers tab, see Selecting
Layers and Groups in the Layers Tab.

Rules for Transforming Selected Objects and Groups
The way you transform selected objects depends on how many objects are selected.

Transforming a Single Object
If you select a single object, the changes you make only affect that one object. All
unselected objects remain unaffected. For example, if you select a single object, transform
handles appear around that one object.

After scalingBefore scaling

Transforming Multiple Objects
If you select multiple objects in the Canvas, changes made to one object are simultaneously
made to all others. Each transform occurs around each object’s own anchor point, so the
effect is the same as if you made the same transform to each object’s handles, one object
after another.

Before scaling After scaling
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Transforming a Group
If you select an entire group, all objects and groups that are nested within it are treated
as a single object. One set of transform handles appears on a bounding box that
encompasses every object within that group. All object transforms occur around a single
anchor point belonging to the group.

Before scaling After scaling

2D Transform Tools
Before you transform an object in the Canvas, you should make sure that the pointer is
set to the correct transform tool. These tools can be selected from the View tool set in
the Toolbar. Selecting a 2D transform tool in the Toolbar activates a corresponding
onscreen control in the Canvas. You modify objects by manipulating the active onscreen
control.

There are nine 2D transform tools:

Select/Transform tool

Adjust Shear tool

Adjust Four Corner tool

Adjust Control Points tool

Adjust Anchor Point tool

Adjust Drop Shadow tool

Adjust Crop tool

Adjust Item tool

Adjust Glyph tool

• Select/Transform: Scales and rotates selected objects.

• Adjust Anchor Point: Offsets the anchor point used for all object transforms.
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• Adjust Shear: Tilts objects, either horizontally or vertically.

• Adjust Drop Shadow: Manipulates object drop shadows directly in the Canvas.

• Adjust Four Corner: Stretches an object into different polygonal shapes.

• Adjust Crop: Cuts off pixels from any of the object’s four edges.

• Adjust Control Points: Manipulates control points on shapes, paths, and curves.

• Adjust Glyph: Transforms individual letters in a text object. The Adjust Glyph tool is also
3D tool, using the same transform controls as the Adjust 3D Transform tool.

• Adjust Item: Moves onscreen controls such as gradients, center points of filters, emitter
attributes, and so on.

Note: Certain tools are automatically activated when certain objects are selected. The
Adjust Control Points tool becomes available when a shape or mask is selected and is
used to adjust Bezier or B-Spline control points. The Adjust Item tool becomes available
when the selected item has additional onscreen controls, such as a filter or a gradient
generator.

To switch among transform tools
Do one of the following:

µ Click the Select/Transform tool in the Toolbar, then, while holding down the mouse
button, choose a transform tool from the pop-up menu.

µ With an object in the Canvas selected, press Tab. Pressing Tab repeatedly cycles the
Canvas through each of the transform modes in order.

µ Control-click any object in the Canvas, then choose a transform mode from the shortcut
menu.

The options in the shortcut menu vary depending on the type of object that is selected.
For example, a shape contains shape-specific options such as Stroke, Edit Gradient, and
Edit Points. Those options do not apply to an image.
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Note: Press Shift-Tab to cycle through the transform modes in reverse.

For more information about 3D transform tools, see 3D Transform Tools.

Moving Objects in the Canvas
The simplest thing you can do to start arranging the objects in your project is to move
them around. With the exception of the Adjust Drop Shadow tool, all transform tools let
you reposition objects, so this is the one operation you can perform regardless of the
currently selected transform tool.

The easiest way to reposition an object is to drag it around within the Canvas. If you want
to make more precise adjustments to an object’s position, you can also change the
numerical values of an object’s X and Y Position parameters in the Properties tab of the
Inspector. For more information on object properties, see Parameters in the Properties
Tab.

You can move objects anywhere within the frame defined by the Canvas, but you can
also drag objects past the edge of the frame. By default, when you move an object past
the edge of the frame, it becomes invisible, although you can still manipulate it using its
bounding box.

Note: The bounding box that indicates the position of objects located offscreen only
appears when those objects are selected.

One example of when it’s necessary to move an object past the edge of the frame is when
you plan on animating an object so that it flies onscreen. Prior to animating it, you need
to move it to a position offscreen to achieve this effect.

Note: To make an object completely visible that is partially or totally outside of the Canvas,
turn on Show Full View Area in the View pop-up menu (directly above the right side of
the Canvas).

To move one or more objects in the Canvas
1 Select one or more objects.

2 Do one of the following:

• Drag an object to another location. If more than one object is selected, dragging one
of the currently selected objects moves all of them.
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• Holding down the Command key, press the Right Arrow, Left Arrow, Up Arrow, or Down
Arrow key to reposition the selected objects one pixel at a time.

• Holding down the Command and Shift keys, press the Right Arrow key or the Left Arrow
key to reposition the selection ten pixels at a time.

Tip: When repositioning very small objects, zoom into the Canvas to get a better view.
For information on zooming in the Canvas, see Canvas Zoom Level.

Note: If you press the Up Arrow key or the Down Arrow key while working in the Canvas
(without holding down the Command key or Command-Shift key combination), the
selection is applied to the next object up or down in the Layers tab.

Using Canvas Compositional Aids
When you’re arranging objects directly in the Canvas, take advantage of various
compositional aids to help you. For example, if you are working on a piece for broadcast
or film, turn on the safe zones in the Canvas to avoid putting objects past the title-safe
or action-safe boundaries. A grid and rulers can also be enabled to provide a useful
reference, and Dynamic Guides can be turned on to help you align objects with more
precision than by simply looking at them.

Furthermore, snapping can be turned on and off to help you position objects relative
to the center and edges of the Canvas, either with or without the other guides enabled.

Note: Press Command while you manipulate an object to temporarily disable snapping,
allowing the object to move freely.

For more information about enabling various Canvas options to help you lay out your
composition, see Canvas Rulers.

To duplicate an object
Do one of the following:

µ Select the object you want to duplicate, then Option-drag the object.

µ Option-click the object, then choose Duplicate from the shortcut menu.
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Using Object Alignment Commands
Several commands in the Object menu let you reposition any number of simultaneously
selected objects to align with one another in various ways. These commands make it easy
to quickly organize a jumble of objects into an even layout without having to manually
line up each individual object.

Before using alignment commands After using alignment commands

In each operation, the left, right, top, and bottom of the selected objects are defined by
the bounding box that surrounds each individual object. The position of the anchor point
is ignored.

Each of the following commands affects the Position parameter of each object:

• Align Left Edges: Objects are moved horizontally so that their left edges line up with
the leftmost object in the selection.

• Align Right Edges: Objects are moved horizontally so that their right edges line up with
the rightmost object in the selection.

• Align Top Edges: Objects are moved vertically so that their tops line up with the topmost
object in the selection.

• Align Bottom Edges: Objects are moved vertically so that their bottoms line up with the
bottommost object in the selection.

• Align Far Edges: Objects are moved in Z space so that their far edges line up with the
furthest object in the selection.

• Align Near Edges: Objects are moved in Z space so that their near edges line up with
the closest object in the selection.

• Align Horizontal Centers: Objects are moved horizontally so that their centers line up
along the center point between the leftmost and rightmost objects in the selection.

• Align Vertical Centers: Objects are moved vertically so that their centers line up along
the center point between the topmost and bottommost objects in the selection.

• Align Depth Centers: Objects are moved in Z space so that their centers line up along
the center point between the farthest and nearest objects in the selection.
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• Distribute Lefts: Objects are moved horizontally so that the left sides of all objects are
evenly distributed, from right to left, between the leftmost and rightmost objects in
the selection.

• Distribute Rights: Objects are moved horizontally so that the right sides of all objects
are evenly distributed, from right to left, between the leftmost and rightmost objects
in the selection.

• Distribute Tops: Objects are moved vertically so that the tops of all objects are evenly
distributed, from top to bottom, between the topmost and bottommost objects in the
selection.

• Distribute Bottoms: Objects are moved vertically so that the bottoms of all objects are
evenly distributed, from top to bottom, between the topmost and bottommost objects
in the selection.

• Distribute Far: Objects are moved in Z space so that the far edges of all objects are
evenly distributed along the Z axis, from closest to furthest, between the closest and
furthest objects in the selection.

• Distribute Near: Objects are moved in Z space so that the near edges of all objects are
evenly distributed along the Z axis, from closest to furthest, between the closest and
furthest objects in the selection.

• Distribute Horizontal Centers: Objects are moved horizontally so that the centers of all
objects are evenly distributed, from left to right, between the leftmost and rightmost
objects in the selection.

• Distribute Vertical Centers: Objects are moved vertically so that the centers of all objects
are evenly distributed, from top to bottom, between the topmost and bottommost
objects in the selection.

• Distribute Depth Centers: Objects are moved in Z space so that the centers of all objects
are evenly distributed, from closest to furthest, between the closest and furthest objects
in the selection.
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Using the Select/Transform Tool
The default transform tool is the Select/Transform tool, which activates onscreen controls
that enable you to adjust an object’s scale, position, and rotation.

Scale handle

Rotation handle

Anchor point

Bounding box

Scaling
When you select an object, eight scale handles appear around the edge of the object’s
bounding box. Drag the handles to resize the object. By default, the width and height of
an object are not locked together when you adjust scale handles. This means that the
aspect ratio of an object can be freely changed. (The aspect ratio of an object is the ratio
of its width to its height.) To preserve an object’s aspect ratio, press Shift while dragging
a scale handle. Changes made to the scale of an object are applied to the Scale parameter
in the Properties tab of the Inspector.

Note: The onscreen Select/Transform controls for Motion-created shapes include a
roundness handle in the upper-left corner of the bounding box that is not present in the
Select/Transform controls for other objects. For more information, see Creating and Editing
Shapes.

To resize the height and width of an object in the Canvas independently
1 Click to select the object in the Canvas.

Note: If you have another tool selected, such as the Mask tool, pressing the S key returns
you to the transform tools. If necessary, tab through the transform tool states to activate
the Select/Transform tool.

A bounding box appears around the selected object.

Note: You can also Control-click the object in the Canvas, then choose Transform from
the shortcut menu.
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2 Do one of the following:

• Drag one of the corner handles to resize the object’s width and height at the same
time. By default, you can resize the width and height independently, by any amount.

• Press Shift, then drag any of the corner handles to resize the object while locking its
width and height together, maintaining the object’s current aspect ratio.

• Drag the top or bottom scale handle to limit scale changes to the object’s height, or
drag the left or right scale handle to limit scale changes to the object’s width.

Drag the left scale handle 
to change the object’s 
width.
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• Press Option while dragging any scale handle to resize an object around its anchor
point, rather than unilaterally.

Resizing while pressing the Option key Resizing without pressing the Option key

As you drag the scale handles, an info window appears and shows you the new width
and height percentages and the amount by which the object is changing. This amount
is represented by a delta symbol.

Note: Scaling the width or height of an object by a negative value reverses the image,
flipping its direction.

Rotating
The Select/Transform tool also activates a handle that allows you to rotate the image
around its anchor point. For animation purposes, Motion keeps track of the number of
times you’ve rotated the object and stores this value in that object’s Rotation parameter
in the Properties tab of the Inspector.

To rotate an object in the Canvas
1 Click to select the object in the Canvas.

Note: The Select/Transform mode is the default mode when Motion opens. If it is currently
not selected in the Toolbar, click the 2D transform tool button in the Toolbar and choose
the Select/Transform tool from the pop-up menu.

2 Do one of the following:

• Drag the rotation handle to rotate the object.

• Press Shift while you drag the rotation handle to constrain the angle of the selected
object to 45-degree increments.
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As you drag the rotation handle, the original angle of the object is indicated by a small
circle that appears on a larger circle surrounding the object’s anchor point. Additionally,
an info window appears, showing you the new angle of rotation and the delta of change
between the object’s former angle and the angle to which you’ve dragged it.

Using the Adjust Anchor Point Tool
Using the Adjust Anchor Point tool, you can move any object’s anchor point, changing
the way in which different geometric transforms are performed.

Objects rotate around the anchor point, but the anchor point also affects shearing and
resizing operations. For example, the default anchor point for any object is the center of
the bounding box that defines its edges. If you rotate an object, it spins around this central
anchor point.
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If you move an anchor point, however, the object no longer rotates around its own center,
but instead rotates around the new anchor point.

This not only affects the rotation of an object, but any moving and scaling operations
performed upon that object as well. Changes made to an object’s anchor point are stored
in the Anchor Point parameter of the Properties tab in the Inspector.

To change the anchor point of an object in the Canvas
1 Click and hold the Select/Transform tool, then choose the Adjust Anchor Point tool from

the pop-up menu.

In the Canvas, the object’s anchor point appears as a round target surrounded with three
colored arrows representing the X, Y, and Z coordinate axes. For more information on
coordinate axes, see 3D Transform Onscreen Controls.

2 Do one of the following:

• Drag the white circle to move the anchor point vertically or horizontally.

• Drag one of the arrows to move the anchor point along the corresponding axis.

As you drag the anchor point, a line stretches from the default position of the anchor
point to its new position. Additionally, an info window appears and shows you the
anchor point’s new coordinates on top and the delta (amount of change) between the
anchor point’s new and old positions.

Note: If the anchor point is close to the center or edges of the object, and Dynamic Guides
are turned on, the anchor point snaps to that location.

Using the Adjust Shear Tool
The Adjust Shear tool activates onscreen shear handles that can be used to slant an object,
either horizontally or vertically.
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This is an isometric operation, so it doesn’t necessarily provide a realistic perspective
effect. When you shear an object, this change is stored in that object’s Shear parameter,
which can be seen in the Properties tab of the Inspector.

Before shearing After shearing

To shear an object in the Canvas
1 Click and hold the Select/Transform tool, then choose the Adjust Shear tool from the

pop-up menu.

2 In the Canvas, drag one of the four shear handles to slant the object. The top and bottom
controls angle the object horizontally, while the left and right controls angle the object
vertically.
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Using the Adjust Drop Shadow Tool
The Adjust Drop Shadow tool activates onscreen handles can be used to change the blur,
angle, and distance of an object’s drop shadow.

Default drop shadow (before adjusting 
with the Adjust Drop Shadow tool)

After adjusting blur, angle, and distance

To adjust the drop shadow of an object in the Canvas
1 Click and hold the Select/Transform tool, then choose the Adjust Drop Shadow tool from

the pop-up menu.

2 In the Canvas, drag one of the four corner handles to adjust the blur of the drop shadow.

Drag within the shadow’s bounding box to adjust the distance and angle of the drop
shadow.

For more information on working with drop shadows, see Drop Shadows.
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Using the Adjust Four Corner Tool
The Adjust Four Corner tool activates onscreen controls that allow you to stretch an object
into different polygonal shapes to create false perspective effects and simulate 3D effects
and placement within your composition.

Before corner-pinning After corner-pinning

To corner-pin an object in the Canvas
1 Click and hold the Select/Transform tool, then choose the Adjust Four Corner tool from

the pop-up menu.

2 In the Canvas, drag each of the four corner handles to stretch the object into the shape
you want.

Note: Just as you can with the scale handles, you can reverse the corner handles to flip
the image. However, changing the angle of any one corner more than 180 degrees can
produce unexpected results.

After you have corner-pinned an object, you can quickly revert back to the object’s original
shape by deselecting the object’s Four Corner checkbox in the Properties tab of the
Inspector. Doing so resets the shape of the object without resetting the corner-pinning
shape you defined in the Four Corner parameter of the Properties tab.

Note: The Four Corner parameter can be used in combination with a tracking behavior
to create a four-corner track on a foreground object. For more information, see Option
2: Corner-Pin the Object Before Tracking.
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Using the Adjust Crop Tool
The Adjust Crop tool activates onscreen cropping handles that you can drag to resize the
borders of an object.

Cropping allows you to chop off each of the four edges of an object to eliminate parts
you don’t want to see in your composition. Common examples of objects you’d want to
crop are video clips with a black line along the right or left edge because of the video
format or with vignetting around the edges because of a wide-angle lens. You can use
the crop operation to cut these undesirable artifacts out when using them in your
composition. You could also crop an object to isolate a single element of the image, so
long as that element can be adequately cut out with a simple rectangular shape.

Before cropping After cropping

Cropping in the Inspector Versus Cropping in the Media Tab
When you crop an imported image using the onscreen transform tool (which is the
same as using the Crop controls in the object’s Properties tab), only the instance of that
file is cropped. The source image in the Media tab is not cropped. To crop the source
image, you must select the object in the Media tab of the Project pane, then use the
Crop tools in the Media tab of the Inspector. For more information, see Controls in the
Media Tab of the Inspector.

Note: If you need to isolate a more irregularly shaped object, or you want to create a
border of a particular shape, see Using Shapes, Masks, and Paint Strokes for more
information.
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To crop an object in the Canvas
1 Click and hold the Select/Transform tool, then choose the Adjust Crop tool from the

pop-up menu.

2 In the Canvas, drag one of the eight handles around the edge of the object to crop it:

• Drag the top, left, right, or bottom handle to only crop that side.

• Drag one of the four corner handles to crop both corresponding sides simultaneously.

• Press Shift while you drag to constrain corner edge cropping to the aspect ratio of the
object.

Note: If an object is corner-pinned, you can no longer enable the Crop mode in the
Canvas (onscreen controls). You can still crop a corner-pinned object by adjusting its
Crop parameter settings in the Properties tab of the Inspector.

Additionally, the crop area and the image can be manipulated separately.

To move the crop area while keeping the underlying image in place
µ Press Command and Option while you drag inside the crop area.

To move the image while keeping the crop area in place
µ Press Command while you drag inside the crop area.

Using the Adjust Control Points Tool
You can modify a shape or mask directly in the Canvas with the Adjust Control Points
tool.

To modify a shape’s control points in the Canvas
1 Once the shape or mask is created, click and hold the Select/Transform tool, then choose

the Adjust Control Points tool from the pop-up menu.

Note: You can also double-click the shape, or Control-click the object, then choose Edit
Points from the shortcut menu to enter the Adjust Control Points mode.

The object’s control points become active.

2 In the Canvas, drag the points to modify the shape of the object.
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For more information on working with shapes and masks, see Using Shapes, Masks, and
Paint Strokes.

Using the Adjust Glyph and Adjust Item Tools
The Adjust Glyph tool, available when a text object is selected, activates onscreen controls
that allow you to modify the position and X, Y, or Z rotation for individual characters
(glyphs) in a text object.

For information on using the Adjust Glyph tool, see Adjusting Glyph Attributes.

The Adjust Item tool activates onscreen controls that allow you to manipulate filters,
behaviors, generators, and other objects. For example, you can use the Adjust Item tool
to adjust the center point of a blur filter, the shape of a particle emitter, or the settings
of a gradient.

Adjusting Object Properties in the Inspector
Groups and objects have many of the same parameters in the Properties tab of the
Inspector. Manipulating an onscreen transform handle also changes the corresponding
parameter in the Properties tab of the Inspector. If you want to transform an object more
precisely than the onscreen controls allow, you can change that parameter’s value directly.

When you select a single object and open the Properties tab of the Inspector, the object’s
parameters are displayed. Making changes to the values in the Properties tab affects the
selected object. If more than one object is selected in the Canvas, Timeline, or Layers tab,
the parameter values displayed in the Properties tab of the Inspector become inaccessible.
However, you can still adjust the onscreen controls. Manipulating any of the onscreen
transform handles affects every selected object equally.

To modify parameter values in the Properties tab of the Inspector
Do one of the following:

µ Select a parameter value field, type a new number, then press Return.

µ If the parameter has a graphical control, such as a slider or dial, adjust the control.

µ To reset a parameter to its default state, either click its reset button, or choose Reset
Parameter from the parameter’s Animation menu.

Important: The Lighting and Reflection parameter groups are available only in a 3D
project.
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In addition to only being available in a 3D project, the Lighting and Reflection parameter
groups in the Properties tab are only available for some objects under certain conditions.
Use the following guidelines when working with lights and reflections:

• The Reflection parameter group is not available for 3D particle emitters or 3D replicators.

• The Reflection parameter group is not available for normal text objects. However the
Reflection parameters are available for flattened text, which is activated by the Flatten
checkbox in the Layout pane of the Text Inspector.

For more information on how to use the parameter controls, see User Interface Controls.

Parameters in the Properties Tab
The Properties tab displays the following parameters for most objects and groups:

Transform Parameters
Position: Defines the X (horizontal), Y (vertical), and Z (depth) position of each object.

The coordinate system used by Motion specifies the center of the Canvas as 0, 0, 0
regardless of the frame size of the project. Moving an object to the left subtracts from
the X value, while moving to the right adds to the X value. Moving an object up adds to
the Y value, and moving an object down subtracts from the Y value. Moving an object
closer adds to the Z value, while moving further away subtracts from the Z value.

Canvas center point
(0,0)

-360 pixels +360 pixels

+240 pixels

-240 pixels

Note: This is identical to the coordinate system used by Final Cut Pro and Final Cut Express,
but different from that used by Shake, in which 0,0 defines the upper-left corner of the
compositional area.

Each object’s position is centered on its anchor point. Offsetting the anchor point also
offsets the position of the object relative to the X, Y, and Z position values you have set.

Rotation: Controls a one-dimensional value representing the number of degrees of
rotation. A positive value rotates the object counterclockwise. A negative value rotates
the object clockwise.

Rotating an object beyond 360 degrees results in multiple rotations when the Rotation
parameter is animated.
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Click the disclosure triangle next to the Rotation parameter to reveal additional
subparameters:

• Animate: This pop-up menu allows you to set the interpolation for animated 3D rotation
channels to one of two options:

• Use Rotation: The default interpolation method. Pattern elements rotate from their
start rotation to their final rotation. Depending on the animation, the elements may
twist this way and that before reaching their final orientation (the last keyframed
value). For example, if the X, Y, and Z Angle parameters are animated from 0 degrees
to 180 degrees in a project, the elements rotate on all axes before reaching their final
orientation.

• Use Orientation: This alternate interpolation method provides for smoother
interpolation but does not allow multiple revolutions. It interpolates between the
pattern elements’ start orientation (first keyframe) to their end orientation (second
keyframe).

Note: The Rotation parameter must be keyframed for the Animate parameter options
to have any effect.

Scale: Controls the percentage representing the object’s scale, relative to its original size.
By default, the horizontal and vertical scale of an object is locked together at the object’s
original aspect ratio—all of which is represented by a single percentage. Click the
disclosure triangle to display independent percentages for the X, Y, and Z scales of the
object.

Note: Setting an object’s scale to a negative value flips the object.

Shear: Defines the X and Y shear of the object. An object with no shear has X and Y shear
values of 0. Positive values shear in one direction, while negative values shear in the other.

Anchor Point: Defines the X, Y, and Z position of the anchor point relative to the center
of the object. Coordinates of 0, 0, 0 center the anchor point in the bounding box defining
the outer edge of the object.

Blending Parameters
Opacity: Defines the transparency of the object. For more information, see Editing Opacity
and Blending Parameters.

Blend Mode: Sets the Blend Mode of the object. For more information, see Editing Opacity
and Blending Parameters.
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Preserve Opacity: When this checkbox is selected, the object appears only where another
object is visible behind it in the composite. The front object uses the opacity value of the
object behind it. For more information, see Preserve Opacity Option.

Preserve Opacity turned off for the text
circle object

Preserve Opacity turned on for the text
circle object

Casts Reflections: Determines whether an object casts a reflection. Choose from three
options in this pop-up menu:

• Yes: The object is seen reflected in nearby reflective objects.

• No: The object is ignored by reflective surfaces.

• Reflection Only: The object becomes invisible, but will appear in reflective surfaces
around it.

Lighting Parameters
Shading: A pop-up menu that enables you to set how an object responds to lights in
the scene. There are three options:

• Inherited: The object uses the shading value of its parent.

• On: The object can be lit.

• Off: The object ignores scene lights.

Highlights: When this checkbox is selected, lit objects in the scene show highlights. This
parameter has no effect if Shading is set to Off.

• Shininess: Determines how strong an object’s highlights appear. Higher values create
a glossier appearance.

For more information on using lights, see Lighting.

Shadows Parameters
Cast Shadows: Sets whether or not an object will cast a shadow if it is between a light
source and another object.

Note: This parameter does not affect drop shadows.
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Receives Shadows: Controls whether or not neighboring objects’ shadows will affect
the current object. When this checkbox is deselected, light will affect the object as if the
shadow-casting object did not exist.

Shadows Only: Allows an object to block light and cast a shadow, while the object itself
does not appear in the scene.

Note: For more information on using shadows, see Shadows.

Reflection Parameters
Reflectivity: A slider that controls the shininess of the object’s surface. When set to 0%,
there is no reflectivity. When set to 100%, the object is totally reflective, like a mirror.

Blur Amount: A slider that controls how blurry the reflection appears, creating the
appearance of soft-focus due to the surface quality of the reflecting object.

Falloff: Determines whether the reflection fades with distance from the object, producing
a more realistic result. Click the disclosure triangle to show the additional options within
the Falloff section: Begin Distance, End Distance, and Exponent (how quickly the reflection
gets fainter as the object gets further from the surface).

Blend Mode: A pop-up menu that determines the blend mode used for the reflection.

Note: For more information on using reflections and their parameters, see Reflections.

Additional Parameters in the Properties Tab
Drop Shadow: Turns the drop shadow of an object on and off. For more information
about working with drop shadows, see Drop Shadows.

Four Corner: Turns corner-pinning on and off. If an object has been corner-pinned and
this checkbox is deselected, the object resumes its original shape, although the
corner-pinning coordinates are maintained. Reselecting the checkbox re-enables the
corner-pinning effect specified by the Four Corner coordinate parameters.

Click the disclosure triangle to display four two-dimensional parameters that define the
polygonal transform of a corner-pinned object. Individual parameters for the Bottom Left,
Bottom Right, Top Right, and Top Left corners of the bounding box that surrounds an
object have individual X and Y coordinates.

Crop: Turns cropping on and off. If an object has been cropped and this checkbox is
deselected, the object resumes its original size, although the cropping values are
maintained. Reselecting the checkbox re-enables the cropping effect specified by the
crop parameters.
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Click the disclosure triangle to display four crop parameters. Each slider defines the number
of pixels to be cropped from each of the object’s four sides, relative to the outer edge of
the bounding box that surrounds it. These parameters are similar to the crop parameters
that appear when an object is selected in the Media tab, except that cropping an object
in the Layers tab only crops the currently selected instance of that object in your project.
Duplicates of that object remain untouched. If you want to crop all instances of the object
simultaneously, use the Crop parameter on the object in the Media tab. For more
information, see Controls in the Media Tab of the Inspector.

Timing: These parameters control all aspects of clip retiming. For more information, see
Retiming.

Making Clone Layers
In a motion graphics project, sometimes it is necessary to reuse a complex object in other
parts of the project multiple times. Although you can duplicate or cut and paste any
object, if you update the original, none of the changes you make are applied to the copies.
It can become a tedious and difficult management task. If you find yourself applying the
same filters and masks to more than one copy of an object, you should take advantage
of the Make Clone Layer command. Making clone layers has the additional benefit of
improving project playback and rendering performance.

You can make clone layers out of layers, groups, particle systems, text, shapes, and
replicators.

To create a clone layer
Do one of the following:

µ Select the object from which you wish to make a clone layer, then choose Object > Make
Clone Layer (or press K).

µ Control-click an object in the Canvas, then choose Make Clone Layer from the shortcut
menu.

µ Control-click an object in the Layers tab or Timeline layers list, then choose Make Clone
Layer from the shortcut menu.
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A clone layer is created and appears in the Canvas slightly offset from the original object.
In the Layers tab, the clone layer appears with the default name “Clone Layer.” A Clone
Layer icon appears next to the name.

The clone layer inherits the following properties from its source object at the time of its
creation Rotation, Scale, Opacity, Blend Mode, and Drop Shadow. Adjustments made to
any of these properties of the source object after clone layer creation do not propagate
to any clone layers made from the same source object. The clone layers only inherit
changes made to filters and masks in the source object.

Important: Changes to behaviors don’t propagate to clone layers, unless the behavior
affects a filter or mask in the source object.

Clone layer objects can be manipulated in the Canvas and Timeline in exactly the same
way as the source object.

Important: A clone layer created from retimed objects cannot have its Frame Blending
parameter changed from that of the source object.

Clone Layers and Rasterization
Some operations, as well as the application of certain filters or a mask, cause a clone layer
to be rasterized. When a clone layer is rasterized, it is converted into a bitmap image. The
blend mode of a clone layer does not interact with objects outside of the group that
contains the clone layer. In addition, a 3D clone layer is treated as a single object and
uses layer order (in the Layers tab), rather than depth order when composited in the
project.

For more information on rasterization and 3D Clone Layers, see About Rasterization.

Note: Cameras and lights in the project interact with clone layers.
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Editing Opacity and Blending Parameters
The opacity and blending controls for each object appear both in the Properties tab of
the Inspector, and in the default HUD for any selected object.

Opacity
By layering together objects with varying opacities, you can merge them together in ways
not otherwise possible. For example, if you have two full-screen background images that
you want to use together, you can set the opacity of the object in front to 50%, allowing
the object in back to show through.

Image in front Image in back Front image at 50% opacity

You can overlap as many objects as you want, and by varying their opacities, selectively
reveal objects in the back.

To change an object’s opacity
Do one of the following:

µ Adjust the Opacity slider in the Properties tab.

µ Adjust the Opacity slider in the HUD.

Note: Some objects, such as text and shapes, have additional opacity parameters in their
respective tabs in the Inspector. For example, setting a shape’s Opacity value in the
Properties tab and setting its Opacity value in the Style pane are separate controls that
have multiplicative effects. In other words, if Opacity is set to 50% in the Properties tab,
then set to 50% in the Shape Style pane, the result opacity for the text is 25%.
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Blend Modes
While the Opacity parameter simply defines a uniform level of transparency for an object,
the blend modes allow you many more creative options to control how the overlapping
images interact, based on the colors in each object. By default, each object’s blend mode
is set to Normal, so that changes to an object’s opacity uniformly affect every part of the
image equally.

Blend modes can create transparency in an object regardless of the setting of its Opacity
parameter. This is because the pixels of an image with a selected blend mode are
combined with the pixels of any objects lying immediately below in the Canvas. For
example, if you overlap two objects, then set the blend mode of the top one to Screen,
the darker areas of the screened image become transparent, while the lighter areas remain
more solid, resulting in the following image:

Important: The transparency created by most of the available blend modes only affects
how an object combines with overlapping objects underneath. These blend modes do
nothing to affect an object’s alpha channel. For information about blend modes that do
affect an object’s alpha channel, see Blend Modes That Manipulate Alpha Channels.

Each blend mode combines objects in different ways. For example, setting the top object’s
blend mode to Multiply yields a result opposite to that of the Screen blend mode, as the
darker areas of the image remain solid, and the lighter areas become transparent.
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Blend modes only affect the combination of an object with the objects below it. Any
objects appearing above have no effect on this interaction, even if the object is transparent.
In the following example, the text objects on the top level have no effect on the blended
images below.

For overlapping layers with different blend modes, the bottommost pair of objects is
combined first, and that combination then interacts with the next object up, and so on
until all overlapping objects have been combined for the final image. In this case, each
object with a specified blend mode only interacts with the image below it, whether that
image is a single object or a pair of objects that have been blended together.

Each of Motion’s blend modes works in conjunction with the Opacity parameter to alter
the interaction between the foreground and background objects. Adjusting an object’s
opacity lessens the blending effect that is assigned to it, even as it reduces that object’s
visibility. This allows you to customize any blend mode to better suit your needs.

Blend modes only affect overlapping objects, and have no interaction with your project’s
background color. If you specify a blend mode for an object that doesn’t overlap anything,
that object remains as it was before.

To change a selected object’s blend mode
Do one of the following:

µ Choose an option from the Blend Mode pop-up menu in the HUD.

µ Choose an option from the Blend Mode pop-up menu in the Properties tab.

µ Choose Object > Blend Mode, then choose an option from the submenu.

µ Display the Blend Mode column in the Layers tab, then choose an option from an object’s
Blend Mode pop-up menu.

µ Control-click an object in the Canvas, then choose an option from the Blend Mode
submenu in the shortcut menu.

µ Control-click an object in the Layers tab or Timeline layers list, then choose an option
from the Blend Mode submenu in the shortcut menu.
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Preserve Opacity Option
The Preserve Opacity checkbox allows you to limit an object’s visibility to areas of the
Canvas where the object overlaps nontransparent regions of other objects. For example,
you might place two overlapping objects into your project, as shown below:

If you turn on Preserve Opacity for the Dolphin object in front, the result is this:

The only area of the Dolphin object that is visible is the area that overlaps the sea life
picture object behind it. At first, this may not appear to be very exciting, but the Preserve
Opacity checkbox can be used in combination with the opacity and blend mode to create
some very interesting effects.

Note: The object with the enabled Preserve Opacity parameter takes the opacity value
of the object beneath it in the composite stack.
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Preserve Opacity is an easy way to selectively reveal part of an object. In this example,
by setting the blend mode of the top color wash layer to Exclusion, you get the resulting
image:

By selecting the Preserve Opacity checkbox for the color wash layer on top, only the
overlapping parts are displayed, and the superimposed image only affects the Dolphin
layer.

To turn on Preserve Opacity
µ Turn on an object’s Preserve Opacity checkbox in the Properties tab.

Using Blend Modes
Each of the available blend modes presents a different method for combining two or
more images together. Blend modes work in addition to an object’s alpha channel and
opacity parameter.

To understand the descriptions of each blend mode in this chapter, it’s important to
understand that blend modes mix colors from overlapping images together based on
the brightness values within each color channel in an image. Every image consists of red,
green, blue, and alpha channels. Each individual channel contains a range of brightness
values that define the intensity of each pixel in the image that uses some of the channel’s
color.
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The effect that each blend mode has on overlapping objects depends on the range of
color values within each object. The red, green, and blue channels within each overlapping
pixel are mathematically combined to yield the final image.

These value ranges can be described as blacks, midrange values, or whites. These regions
are loosely illustrated by the chart below.

Blacks WhitesMidrange color values

For example, the Multiply blend mode renders color values that fall into the white areas
of an image transparent, while the black areas of the image are left alone. All midrange
color values become translucent, with colors falling into the lighter end of the scale
becoming more transparent than the colors that fall into the darker end of the scale.

Group Blend Modes
Blend modes work differently depending on whether they’re used with groups or layers.
In particular, the Pass Through blend mode is available only for groups.

Pass Through
When a group is set to Pass Through, each object is individually blended with all objects
and groups that appear underneath it in the Layers tab. In this example, the Swirls object
is set to Stencil Luma, and the Fishes object is set to Add.
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With the enclosing group set to Pass Through, the Swirls object stencils all other objects
underneath it, including the Gradient object in the bottom group. The result is that all
objects are stenciled against the background color. The Fishes object is likewise added
to the combined stack of objects.

Normal
When a group is set to Normal, the layers nested within that group can only be blended
with one another. Objects nested within that group do not blend with objects in other
groups beneath it in the Layers tab.

In this example, the Fishes and Swirls objects in the topmost group are only blended with
themselves when the topmost group is set to Normal.
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The Gradient object in the bottom group is left unaffected, although the transparency
in the top group caused by the combination of the Add and Stencil Luma blend modes
reveals it in the background.

Other Blend Modes
When you set a group to any of the other available blend modes, each layer nested within
that group is blended according to its blend mode. The resulting image is then blended
with the groups underneath, according to the selected blend mode for that group. In
this example, the topmost group is set to Multiply.

As a result, the combination of the Added Fishes and the Stenciled Swirls objects is
multiplied with the Gradient object in the bottommost group.
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Object Blend Modes
The following section describes how blend modes affect individual objects. All blend
modes are presented in the order in which they appear in the Blend Mode pop-up menu.

About the Examples in This Section
Most of the examples in this section are created using the following two reference
images. The resulting “Mondrian Monkey” illustrates how differently the color values
from each image interact when using each blend mode. When examining the results,
pay particular attention to the white and black areas of the colored squares, as well as
the highlights and shadows in the monkey. These show you how each blend mode
treats the whites and blacks in an image.

The other brighter and darker colors serve to illustrate each blend mode’s handling of
overlapping midrange color values. The yellow, gray, orange, and blue squares, in
particular, all have very different color and luminance values that contrast sharply from
example to example.

Boxes object Monkey object

Important: Depending on the blend mode, layer and group ordering may or may not
be important. Certain blend modes behave differently depending on which image is
on top.

Normal
The default for objects. The only transparency in an object set to Normal is caused by its
Opacity parameter or by an alpha channel that is assigned to it.

Subtract
Subtract darkens all overlapping colors. Whites in the foreground image go black, while
whites in the background image invert overlapping color values in the foreground image,
creating a negative effect.

Blacks in the foreground image become transparent, while blacks in the background
image are preserved.
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Overlapping midrange color values are darkened based on the color of the background
image. In areas where the background is lighter than the foreground, the background
image is darkened. In areas where the background is darker than the foreground, the
colors are inverted.

The order of two objects affected by the Subtract blend mode is important.

Boxes object on top Monkey object on top

Darken
Darken emphasizes the darkest parts of each overlapping image. Whites in either image
allow the overlapping image to show through completely. Lighter midrange color values
become increasingly translucent in favor of the overlapping image, while darker midrange
color values below that threshold remain solid, retaining more detail.

The order of two objects affected by the Darken blend mode does not matter.
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Suggested uses: The Darken blend mode is useful for using one image to texturize another
selectively, based on its darker areas. You can also use Screen, Color Burn, and Linear
Burn for variations on this effect.

Multiply
Like Darken, Multiply emphasizes the darkest parts of each overlapping image, except
that midrange color values from both images are mixed together more evenly.
Progressively lighter regions of overlapping images become increasingly translucent,
allowing whichever image is darker to show through. Whites in either image allow the
overlapping image to show through completely. Blacks from both images are preserved
in the resulting image.

The order of objects affected by the Multiply blend mode does not matter.

Suggested uses: The Multiply blend mode is particularly useful in situations where you
want to knock out the white areas of a foreground image and blend the rest of the image
with the colors in the background. For example, if you superimpose a scanned sheet of
handwritten text over a background image using the Multiply blend mode, the resulting
image becomes textured with the darker parts of the foreground.
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Color Burn
Color Burn intensifies the dark areas in each image. Whites in the background image
replace the foreground image, while whites in the foreground image become transparent.
Midrange color values in the background image allow midrange color values in the
foreground image to show through.

Lighter midrange color values in the background image allow more of the foreground
image to show through. Darker midrange values in all visible overlapping areas are then
mixed together, resulting in intensified color effects.

The order of two objects affected by the Color Burn blend mode is important.

Boxes object on top Monkey object on top

Linear Burn
Similar to Multiply, except that darker overlapping midrange color values are intensified,
like Color Burn. Progressively lighter color values in overlapping images become
increasingly translucent, allowing darker colors to show through. Whites in either image
allow the overlapping image to show through completely.

The order of two objects affected by the Linear Burn blend mode does not matter.
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Add
Add emphasizes the whites in each overlapping image and lightens all other overlapping
colors. The color values in every overlapping pixel are added together. The result is that
all overlapping midrange color values are lightened. Blacks from either image are
transparent, while whites in either image are preserved.

The order of two objects affected by the Add blend mode does not matter.

Suggested uses: The Add blend mode is useful for using one image to selectively texturize
another, based on its lighter areas such as highlights. You can also use Lighten, Screen,
Color Dodge, and Linear Dodge to create variations of this effect.

Lighten
Lighten emphasizes the lightest parts of each overlapping image. Every pixel in each
image is compared, and the lightest pixel from either image is preserved, so that the final
image consists of a dithered combination of the lightest pixels from each image. Whites
in both images show through in the resulting image.
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The order of two objects affected by the Lighten blend mode does not matter.

Screen
Like Lighten, Screen also emphasizes the lightest parts of each overlapping image, except
that the midrange color values of both images are mixed together more evenly.

Blacks in either image allow the overlapping image to show through completely. Darker
midrange values underneath a certain threshold allow more of the overlapping image
to show. Whites from both images show through in the resulting image.

The order of two objects affected by the Screen blend mode does not matter.
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Suggested uses: The Screen blend mode is especially useful for knocking out the blacks
behind a foreground subject, instead of using a Luma Key. It’s mainly useful when you
want the rest of the foreground subject to be mixed with the background image as well,
based on its brightness. It’s good for glow and lighting effects and for simulating
reflections. You can also use the Add, Lighten, and Color Dodge blend modes to create
variations of this effect.

Top object Bottom object Screen composite

Color Dodge
Whites in either the foreground or background image are preserved in the final image.
Blacks in the background image replace the foreground image, while blacks in the
foreground image become transparent.

Midrange color values in the background image allow midrange color values in the
foreground image to show through. Darker values in the background image allow more
of the foreground image to show through. All overlapping midrange color values are
mixed together, resulting in interesting color mixes.

Reversing the two overlapping images results in subtle differences in how the overlapping
midrange color values are mixed together.

Boxes object on top Monkey object on top

Linear Dodge
Similar to Screen, except that lighter midrange color values in overlapping regions become
intensified. Blacks in either image allow the overlapping image to show through
completely. Whites from both images show through in the resulting image.
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The order of two objects affected by the Linear Dodge blend mode does not matter.

Overlay
Whites and blacks in the foreground image become translucent and interact with the
color values of the background image causing intensified contrast. Whites and blacks in
the background image, on the other hand, replace the foreground image.

Overlapping midrange values are mixed together differently depending on the brightness
of the background color values. Lighter background midrange values are mixed by
screening. Darker background midrange values, on the other hand, are mixed together
by multiplying.

The visible result is that darker color values in the background image intensify the
foreground image, while lighter color values in the background image wash out
overlapping areas in the foreground image.

The order of two objects affected by the Overlay blend mode is important.

Boxes object on top Monkey object on top
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Suggested uses: The Overlay blend mode is particularly useful for combining areas of vivid
color in two images.

Soft Light
Soft Light is similar to the Overlay blend mode. Whites and blacks in the foreground
image become translucent, but interact with the color values of the background image.
Whites and blacks in the background image, on the other hand, replace the foreground
image. All overlapping midrange color values are mixed together, creating a more even
tinting effect than the Overlay blend mode.

The order of two objects affected by the Soft Light blend mode is important.

Boxes object on top Monkey object on top

Suggested uses: The Soft Light blend mode is useful for softly tinting a background image
by mixing it with the colors in a foreground image.

Hard Light
Whites and blacks in the foreground image block the background image. Whites and
blacks in the background image, on the other hand, interact with overlapping midrange
color values in the foreground image.
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Overlapping midrange color values are mixed together differently depending on the
brightness of the background color values. Lighter background midrange values are
mixed by screening. Darker background midrange values, on the other hand, are mixed
together by multiplying.

The visible result is that darker color values in the background image intensify the
foreground image, while lighter color values in the background image wash out
overlapping areas in the foreground image.

The order of two objects affected by the Hard Light blend mode is important.

Boxes object on top Monkey object on top

Vivid Light
Vivid Light is similar to the Hard Light blend mode, with two exceptions. The first is that
midrange color values are mixed together more intensely. The second is that whites and
blacks from either overlapping image are preserved in the end result.

Note: Some dithering may result in overlapping areas of solid white and solid black.

Overlapping midrange color values are mixed together differently depending on the
brightness of the background color values. Lighter midrange values become washed out,
while the contrast of darker midrange color values is increased. The overall effect is more
pronounced than with the Hard Light blend mode.
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Reversing the two overlapping images results in subtle differences in how the overlapping
midrange color values are mixed together.

Boxes object on top Monkey object on top

Linear Light
Linear Light is similar to the Hard Light blend mode, except that overlapping midrange
color values are mixed together with higher contrast. Whites and blacks in the foreground
image block the background image. Whites and blacks in the background image, on the
other hand, interact with overlapping midrange color values in the foreground image.

Overlapping midrange color values are mixed together. Lighter background colors brighten
the foreground image, while darker colors darken it.

The order of two objects affected by the Linear Light blend mode is important.

Boxes object on top Monkey object on top

Pin Light
Pin Light is similar to the Hard Light blend mode, except that overlapping midrange color
values are mixed together differently based on their color value. Whites and blacks in the
foreground image block the background image. Whites and blacks in the background
image, on the other hand, interact with overlapping midrange color values in the
foreground image.
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The methods used by the Pin Light blend mode to mix two images are somewhat complex.
Overlapping midrange color values are treated differently depending on which of the
four regions of the luminance chart they fall into.

• Lighter and darker areas of the foreground image falling close to the whites and blacks
are preserved.

• Areas of the foreground image falling near the center of the midrange are tinted by
the background color.

• Darker areas of the foreground image in between the blacks and center of the midrange
are lightened.

• Lighter areas of the foreground image in between the whites and the center of the
midrange are darkened.

The end result may appear alternately tinted or solarized, depending on the lightness or
darkness of the overlapping values. This blend mode lends itself to more abstract effects.

The order of two objects affected by the Pin Light blend mode is important.

Boxes object on top Monkey object on top

Hard Mix
Hard Mix is similar to the Hard Light blend mode, except that the saturation of overlapping
midrange color values is intensified, resulting in extremely high-contrast images. Whites
and blacks are preserved.
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While the order of two objects doesn’t affect the overall look of two images blended
using the Hard Mix blend mode, there may be subtle differences.

Difference
Similar to the Subtract blend mode, except that areas of the image that would be severely
darkened by the Subtract blend mode are colorized differently.

The order of two objects affected by the Difference blend mode does not matter.

Exclusion
Similar to the Difference blend mode, except that the resulting image is lighter overall.
Overlapping areas with lighter color values are lightened, while darker overlapping color
values become transparent.
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The order of two objects affected by the Exclusion blend mode does not matter.

Blend Modes That Manipulate Alpha Channels
The Stencil and Silhouette blend modes let you use a single object’s alpha channel or
luma values to isolate regions of background objects and groups.

Note: Similar effects can be accomplished using shape and image masks. In addition,
masks may provide you with a greater degree of control, depending on your needs. For
more information, see Using Shapes, Masks, and Paint Strokes.

Stencil modes crop out all non-overlapping parts of objects underneath the object used
as the stencil. Silhouette modes do the opposite, punching holes in overlapping objects
underneath in the shape of the object used as the silhouette.

When working in a 3D group, changes in depth order affect the Stencil and Silhouette
blend modes differently. For example, if you have two layers in a 3D group and the upper
layer is set to Stencil Alpha or Stencil Luma, the blend mode remains in effect when the
upper layer is moved behind the lower layer in Z space. If you have two layers in a 3D
group and the upper layer is set to Silhouette Alpha or Silhouette Luma, the blend mode
does not remain in effect when the upper layer is moved behind the lower layer in Z
space.
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Limiting the Effect of Stencil and Silhouette Blend Modes
Whenever you use the Stencil or Silhouette blend modes in a group that is set to the
Pass Through blend mode, the resulting effect carries down through every object in
every group that lies underneath it in the Layers tab, unless the group that contains it
is rasterized. This is a powerful, but not always desired effect, because it prevents you
from placing a background group to fill the transparent area.

You can limit the Stencil or Silhouette blend mode to affect only those objects that are
within the same enclosing group by setting the group’s blend mode to anything other
than Pass Through.

For example, if you set the enclosing group of the two objects in the Silhouette Alpha
example to Normal, then add a group underneath containing additional objects, those
objects show through the transparent areas created by the silhouetted group.

Stencil Alpha
The Stencil Alpha blend mode uses the alpha channel of the affected object to crop out
all non-overlapping parts of objects and groups underneath it in the Layers tab.

Object used for stencil End resultObject underneath

Stencil Luma
The Stencil Luma blend mode does the same thing as the Stencil Alpha blend mode, but
uses the affected object’s luma value to define transparency. Stencil Luma is useful if the
object you want to use for cropping has no alpha channel of its own.
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Silhouette Alpha
Silhouette Alpha is the reverse of the Stencil Alpha blend mode and is useful for cutting
holes in objects underneath.

Object used for silhouette End resultObject underneath

Silhouette Luma
Silhouette Luma is the reverse of Stencil Luma.

Behind
The Behind blend mode forces the object to appear behind all other objects and groups,
regardless of its position in the Layers tab and Timeline.

If multiple objects or groups are set to Behind, they appear behind all other groups that
are not set to Behind, in the order in which they appear in the Layers tab.

Alpha Add
The Alpha Add blend mode works similarly to the Add blend mode, but instead of adding
the color channels of overlapping objects, it adds their alpha channels together. Try using
this blend mode instead of Motion’s default method of alpha channel compositing for a
different treatment of overlapping areas of translucency.

Premultiplied Mix
The Premultiplied Mix blend mode is intended for compositing images that are
premultiplied, such as those generated by 3D modeling and rendering software. (A
premultiplied image’s red, green, and blue channels are multiplied by the image’s alpha
channel.) Premultiplied Mix is useful for images with translucent lighting effects such as
lens flares, volumetric lighting, fog and haze effects, and so on.

The Premultiplied Mix blend mode performs an unpremultiply composite—the foreground
image is assumed to be premultiplied. Artifacts may appear as a result of unpremultiplying
pixels whose RGB and alpha values are very small (resulting in pixels with values of 255).
In some cases, the hardware performs bilinear filtering and then the blend mode
unpremultiplies the alpha.
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Drop Shadows
A drop shadow, by default, is a dark, translucent, offset shape that falls behind an object,
as if a light was shining on the object. Drop shadows are the same size as the object to
which they’re applied, although blurring a drop shadow may enlarge it somewhat.

They create the illusion of depth, with the result that the foreground object seems to
pop out at the viewer. For this reason, drop shadows are frequently used to create the
impression of space between two overlapping objects.

Drop shadows also darken overlapping regions of background objects. A good example
of when to use this is when you place text over a background that might obscure it. By
adding a drop shadow, you can make a foreground text object easier to read.

Without a drop shadow With a drop shadow

It’s easy to add a drop shadow to any object, since each object has individual drop shadow
parameters in the Inspector and HUD. Once activated, drop shadows can also be
manipulated directly in the Canvas.

Tip: Motion also has the ability to generate true cast shadows when using lighting in 3D
layers. For more information about cast shadows, see Shadows.
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Important: Text objects have additional drop shadow parameters, located in the Style
pane of the Text tab. For more information about text object drop shadows, see Adding
a Drop Shadow.

Adjusting Drop Shadows in the Canvas
You can interactively modify an object’s drop shadow using the onscreen controls.

The Adjust Drop Shadow Transform Tool
Selecting the Adjust Drop Shadow transform tool in the Toolbar provides additional
onscreen controls for selected objects with active drop shadows.

Drop Shadow blur 
handles

Drop Shadow position 
bounding box

Four handles at each corner allow you to increase or decrease the blur of the drop shadow.
Dragging anywhere within the drop shadow’s bounding box allows you to simultaneously
change the shadow’s angle and distance.

To increase or decrease a drop shadow’s blur
1 Click and hold the Select/Transform tool, then choose the Adjust Drop Shadow tool from

the pop-up menu.

2 In the Canvas, drag one of the four corner handles in to decrease a shadow’s blur or out
to increase it.

To move an object’s drop shadow
1 Click and hold the Select/Transform tool, then choose the Adjust Drop Shadow tool from

the pop-up menu.

2 Drag anywhere within the shadow’s bounding box to move it around.

Drop Shadow Controls in the Properties Tab
In addition to the Canvas and HUD drop shadow controls, each object has individual drop
shadow parameters in the Properties tab of the Inspector.

Use the checkbox to turn any object’s drop shadow on or off. Click the disclosure triangle
to reveal additional controls.

Drop Shadow: Turns any object’s drop shadow on or off.
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Color: Sets the drop shadow’s color. This color is black, by default.

Opacity: Sets the drop shadow’s transparency.

Blur: Specifies how soft the drop shadow is.

Distance: Sets how close or far an object’s drop shadow is to the object. The farther away
a drop shadow is, the more distance there appears to be between the object and anything
behind it in the composition.

Angle: Lets you change the direction of the drop shadow. Changing the Angle of the
drop shadow changes the apparent direction of the light casting the shadow.

Fixed Source: When this checkbox is selected, the drop shadow behaves as if it were
cast by a fixed light source, regardless of camera or text movement.

Retiming
Your motion graphics projects may require you to perform special timing tricks on media:
speeding a clip up, slowing it down, or playing it back at a variety of speeds.

Using Retiming Behaviors
The Retiming category of behaviors offers various ways to quickly execute the most
commonly applied retiming tasks. A hold frame or strobe is easily accomplished with a
retiming behavior. Take some time to look over the behaviors in the Retiming category
before spending a lot of time in the Inspector creating your own custom retiming from
scratch.

Tip: You can also manipulate clip timing in the Timeline with the help of modifier keys.
Indicators in the Timeline help you visualize loops and other retiming conditions. For
more information on Retiming in the Timeline, see Retiming in the Timeline.

Timing Controls in the Properties Tab
Media objects (images and movie clips as opposed to Motion-created shapes) have
individual timing parameters in the Properties tab of the Inspector. Click the disclosure
triangle beside the Timing category to reveal these timing controls.

Time Remap: Sets how time is remapped in the clip. Use this pop-up menu to set Constant
Speed or Variable Speed.

• Constant Speed: Retimes the entire clip using the same value.

• Variable Speed: Allows you to animate the speed of the clip over time.

Speed: Sets the speed of the clip as a percentage. The default is 100%. Values lower
than 100 play back the clip more slowly than its original speed and also extend the
duration of the clip. Values higher than 100 play back the clip faster than its original speed
and shorten the duration of the clip. This parameter appears only when Time Remap is
set to Constant Speed.
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Retime Value: Displays the time value of the clip at a given frame. This parameter appears
only when Time Remap is set to Variable Speed. When you set Time Remap to Variable
Speed, two keyframes are automatically generated at the first and last frame of the clip.
The two default keyframes represent 100% constant speed. Adding keyframes to this
parameter and assigning them different Retime Values makes the speed of the clip ramp
from one speed to another.

In: Sets the In point of the object, in both constant and variable speed modes. Adjusting
this parameter always moves the object In point to the specified frame without affecting
the duration of the object.

Out: Sets the Out point of the object, in both constant and variable speed modes.
Adjusting this parameter always moves the object Out point to the specified frame without
affecting the duration of the object.

Duration: Sets the total duration of the object. If Time Remap is set to Constant Speed,
adjusting Duration will also affect the Speed and the Out point. If Time Remap is set to
Variable Speed, adjusting Duration will not affect variable speed playback.

Reverse: This checkbox controls whether the clip is played back in reverse.

Frame Blending: Sets the method used to determine how the image is blended during
each frame of playback. The Frame Blending pop-up menu contains the following items:

• None: Displays the frame from the original clip nearest the source frame.

• Blending: The default setting. Displays a blend of the individual pixels of adjacent
frames.

• Motion-Blur Blending: Applies a motion blur algorithm to the blended frames.

• Optical Flow: Uses an optical flow algorithm to blend the two frames surrounding the
desired frame. Using this method affects playback performance most significantly. In
order to display frames properly, Motion analyzes the clip to determine the directional
movement of pixels. Only the portion of the clip used in the project (the clip between
the In and Out points) is analyzed.

When you choose Optical flow, an analysis indicator appears to the left of the transport
controls underneath the Canvas to show that the clip is being analyzed.

Analysis indicator

If you play back the project before the analysis is complete, the clip will appear as if
Frame Blending is set to None. Once the analysis is complete, the indicator disappears,
and the clip will play back properly. If you wish, you may view more detailed information
about the clip analysis and stop the process before it is finished.
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You can perform optical flow analysis on multiple clips simultaneously. The clips are
processed in the order that Frame Blending is set to Optical Flow.

Note: The more motion contained in a clip, the longer the analysis takes.

For information on pausing, reordering, or stopping a clip analysis, see Displaying and
Editing Retiming Tasks.

Important: When importing interlaced footage and using the Optical Flow method for
frame blending, if Field Dominance is not set to the correct value, artifacts may appear
in the retimed object.

End Condition: A pop-up menu that lets you set how playback continues when the end
of the clip is reached. There are four options:

• None: The default setting. The object’s duration in your project is equal to the duration
of its source media file.

• Loop: When the last frame of the clip is reached, the clip loops back to the first frame
and plays again. This can cause a jump in the clip’s apparent playback unless the clip
was designed to be looped seamlessly.

• Ping-Pong: When the last frame of the clip is reached, the next iteration of clip playback
is reversed. If you set a clip of a ball rolling on the floor to loop with the Ping-Pong
option, it would appear to roll forward, then backward, then forward again for the
duration of the object. This allows you to extend the duration of certain video clips
more smoothly than with the Loop setting.

• Hold: This freezes the last frame of the clip for the amount set in the End Duration
slider.

Note: When using the Hold option with interlaced footage, ensure that field order is
properly set in the Media Inspector. To modify a clip’s field order, select the clip in the
Media tab of the Project pane, then choose an option from the Field Order pop-up
menu in the Media Inspector.

End Duration: A slider that lets you set the number of frames by which the clip is extended
at the end of its duration. This value may be adjusted only if End Condition is set to a
value other than None.

Displaying and Editing Retiming Tasks
You can display processing information when retiming a clip.

To display more information about ongoing clip analysis
Do one of the following:

µ Choose Window > Show Task List.
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µ Click the analysis indicator (to the left of the transport controls underneath the Canvas).

Click the analysis 
indicator to show the 
Background Task List.

The Background Task List dialog appears.

Pause button

The Background Task List shows all processes Motion is working on in the background.
Each task is labeled, has a progress bar, and displays text describing how far along the
task is. You may interrupt current and pending operations by pressing the pause button
next to the progress bar.

To pause clip analysis
µ In the Background Task List dialog, click the pause button.

Click to pause clip 
analysis.

Once paused, a message appears detailing how many frames of the total number of
frames have been processed.

Note: When analysis is paused, projects play back at a much improved speed.

To restart clip analysis
µ In the Background Task List dialog, click the analyze/pause button.

Click to restart clip 
analysis.
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To reorder clip analysis
µ In the Background Task List dialog, drag the clip you want to analyze to the top of the

list.

Analysis begins on the repositioned clip and is paused on the clip that was previously
being processed.

To automatically close the Background Task List dialog when analysis is complete
µ In the Background Task List dialog, turn on the “Close when tasks are complete” checkbox.

Expose Commands
Motion’s expose key commands provide a way of viewing multiple windows at once,
exploding and rescaling them without having to move them around manually.

The expose commands allow you to visually access all the layers in a project directly in
the Canvas, quickly selecting items without having to drill down into the Layers tab or
Timeline. Expose commands also let you select inactive layers at the playhead’s current
position or jump automatically to a selected layer’s In point.

There are two expose commands: The first displays all layers in a project, and the second
displays only those layers active at the current position of the playhead in the Timeline.

Exposing All Layers
Using the Expose All Layers key command, you can get a visual sense of all the elements
in your project and quickly select a particular element you wish to manipulate.

To expose all layers in your project
1 Click anywhere in the Canvas.

2 Press Shift-X.
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All the layers in the project temporarily scale down and spread out over the Canvas. Each
layer in the project is represented by a white frame in the Canvas. Moving the pointer
over a frame shows the layer’s name.

Canvas after invoking 
Expose All Layers command

Canvas before invoking
Expose All Layers command

3 Select the layer you want to work on.

The layers move and rescale back to their original positions, the element is selected in
the Canvas, and the playhead moves to the first frame of the selected layer.

Exposing Active Layers
The Expose Active Layers command lets you view the layers that are active at the position
of the playhead in the Timeline.

To expose objects that are active at the playhead position
1 Click anywhere in the Canvas.

2 Press X.

All the layers active at the current position of the playhead temporarily scale down and
spread out over the Canvas. Each active layer is represented by a white frame in the
Canvas. Moving the pointer over a frame reveals the layer’s name.

3 Select the object you want to work on.

The elements move and rescale back to their original positions, the element is selected
in the Canvas, and the playhead moves to the first frame of the selected object.
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The Timeline is one of the most flexible and valuable elements of the Motion interface.
This is where you can control all of the timing aspects of your project. Whether you want
to line up multiple layers to begin or end together, change which portion of a clip is used,
or lengthen or shorten a particular object, the Timeline provides the tools you need.

You can organize your objects to begin and end on the frames you choose. You can also
align multiple effects so that they occur simultaneously. You can control objects’ durations
and even perform common trim operations to edit the objects as you would in a video
editing program.

Additional controls let you manipulate masks, filters, behaviors, keyframes, and audio
elements along with your visual footage. The Timeline ruler provides an exact reference
for managing timing and synchronizing effects. You can lock tracks to prevent changes,
temporarily hide an object from view, and manage links between audio and video.

This chapter covers the following:

• About the Timeline (p. 352)

• Timeline Layers List (p. 354)

• Adding Objects to the Timeline Layers List (p. 361)

• Adding Objects to the Track Area (p. 365)

• Editing Objects in the Timeline (p. 370)

• Working in the Ruler (p. 386)

• Adding Markers (p. 393)
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About the Timeline
The Timeline consists of the Timeline layers list on the left and a track area on the right.
You can add images and clips to your project using the Timeline, just as you add files to
the Layers tab or the Canvas. You can drag objects into the Timeline layers list, or drag
them directly into the Timeline track area. The Timeline ruler, located above the track
area, provides an exact reference for managing timing and synchronizing effects. You
can lock tracks to prevent changes, temporarily hide an object from view, and manage
links between audio and video.

Timeline ruler

Track area

Timeline layers list

Although you can perform many types of effects without ever using the Timeline, it is an
essential tool when you want to manipulate the timing of the contents of your project.
Motion integrates many of the features ordinarily reserved for nonlinear editing software
into the compositing workflow.

The Timeline is not displayed by default in the Standard layout. It can be viewed by
displaying the Timing pane.

To display the Timing pane
Do one of the following:

µ Click the Timing icon (in the upper-right corner of the Toolbar).

Timing icon

µ Drag the divider beneath the Play button in the transport controls upward.
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µ Choose Window > Layouts > Cinema.

µ Press F6.

Cinema Layout moves the Inspector to the right side of the interface and displays the
Timing pane.

µ If you are working on a Mac with a Multi-Touch trackpad, you can use a three-finger swipe
up to display the Timing pane. Use a three-finger swipe down to hide the Timing pane.

Note: To change interface layouts, choose Window > Layouts, then choose Standard,
Alternate, or Cinema. You can also create and save your own layout arrangements. See
Window Arrangements for more information on layouts.

If the Timing pane is already displayed, you may need to click the Timeline tab to bring
it to the front.

Timeline Tracks
Each object in your project appears as a colored bar in the track area of the Timeline.
Tracks are arranged in a hierarchy identical to that of the Layers tab in the Project pane.
This allows you to quickly see each object’s place in time, as well as its relative position
and duration.

You can determine the type of each object in the track area based on its appearance.

DescriptionHow it appearsItem

A double blue bar. For groups
with multiple layers, the lower
bar displays three lines and a
value indicating the number of
layers in the group.

Group

A blue barLayers (video, stills, shapes, text,
particles, replicators, cameras,
lights)

A gray barMasks

A thin purple barBehaviors and Filters

Blue diamonds beneath the track
that is keyframed. Selected
keyframes appear white.

Keyframes

A green bar displaying the audio
waveform. If the audio file has
an applied Audio behavior, the
purple bar appears underneath
the audio track.

Audio
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When you select an object, the color changes to a darker shade, and the name of the
object turns white. When the Timeline is in Filmstrip mode, the filmstrip frames are
highlighted with a white border. See Specifying the Track Display for more information
on how to set different Timeline view modes.

Timeline Layers List
The Timeline layers list mirrors the Layers tab in the Project pane and displays your project
objects (groups, layers, filters, behaviors, and so on) and their stacking order. Behaviors,
filters, masks, and keyframes applied to an object can also be displayed. In the Timeline
layers list, you can reorder objects. This change is immediately reflected in the Layers tab
in the Project pane. You can also lock tracks to prevent further editing on those tracks
and disable entire tracks to omit them from view in the Canvas.

Naming Objects in the Timeline Layers List
You can rename any object in Motion. This can be helpful if you are using more than one
version of an asset, using multiple cameras, or if you want to categorize things into named
groups. Masks, shapes, particles, and other content you generate within Motion are
created with generic names. Renaming them allows you to better manage and keep track
of them while you work.

To rename an object
1 In the Timeline layers list, double-click the name of the object.

2 Type a new name in the editable text field.

3 Press Return or Tab.

Although Motion allows you to rename objects you import from your disk, changing the
object’s name in the Timeline layers list does not modify the name of the file on disk. This
allows you to use one source clip multiple times and name each instance uniquely inside
Motion.
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Enabling Timeline Tracks
To the left of each track in the Timeline layers list is an activation checkbox that turns
that track on and off. When a track is turned off (disabled), it is ignored in the Canvas.
Not only can you turn video or audio on and off, but you can also disable or enable effects
such as masks, filters, and behaviors.

Activation checkbox is 
turned off.

Disabled track

To turn visibility for an object on or off
µ Click the checkbox at the left edge of the track you want to control.

When the box is checked, visibility is on, and when the box is unchecked, visibility is off.
Additionally, when a track is disabled, the entire track is dimmed in the Timeline.

Collapsing and Expanding Groups and Layers
Motion allows you to collapse and expand different parts of the Timeline layers list to
show more or less data to accommodate different working styles. Layers with applied
masks, filters, and other objects can be collapsed to hide those effects bars. Furthermore,
whole groups can be collapsed to hide all of the objects contained within them.
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When a layer or group is collapsed in this manner, it still appears in the Canvas window.
Unlike enabling or disabling tracks, collapsing and expanding the Timeline layers list is
only an organizational tool to help manage the view of the Timeline.

Disclosure triangle

To collapse or expand a layer or group in the Timeline
µ Click the disclosure triangle to the left of the layer or group name. If no disclosure triangle

is present, that object cannot be collapsed or expanded any further.

Adding and Deleting Groups in the Timeline
Motion allows you to add and delete groups directly in the Timeline layers list. If nothing
is selected in the list when a new group is added, the new group appears at the top of
the list. If an object is selected, the new group is added directly above the selected object.

To add a group
µ Click the Add button (+).

Add button

You can also add a group by dragging a new item into your project.

To delete a group
1 Select the group you want to delete.

2 Click the Delete button (–).

You can also click the Delete button to remove any selected object (camera, layer, group,
filter, and so on) in the Timeline layers list. You can also Control-click a track, then choose
Delete from the shortcut menu.
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Locking Timeline Tracks
Occasionally, you may want to prevent changes to a particular item. The lock icon at the
right edge of the Timeline layers list allows you to lock an object and prevent any changes
from affecting that object. An object that is locked in the Timeline also appears locked
in the Layers tab in the Project pane.

Lock icon

Tracks appear locked in 
the Timeline.

When an item is locked, the bounding box in the Canvas turns from white to red and the
colored bar appears with a cross-hatched pattern.

Locked tracks still appear in the Canvas and are included in your final output. Although
you cannot make changes to a locked object, you can still copy or duplicate that object
or change the object’s layer order.

To lock a track
µ Click the lock icon at the right edge of the Timeline layers list.

Audio-Video Links
Ordinarily, objects that contain both audio and video are linked together so that they
always remain in sync. This link is represented by an icon in the Timeline layers list.

Note: To display audio in the Timeline, click the Show Audio button, located in the
lower-left corner of the Timeline tab.

Objects that are linked are always edited together in the Timeline. Operations such as
cut, copy, paste, and split also affect both audio and video. However, if you ever want to
break that relationship so that you can move or edit the audio or video without the other
tagging along, you can disable that link and move either object freely. Beware that this
may result in your audio and video playing out of sync.

To manipulate audio and video elements separately
1 Click the link icon to the right of the object name for either the video or audio element.
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The link icon changes to a broken link.

2 Move, trim, or slip the audio or video bar.

The link icon also appears in the Layers tab in the Project pane.

Before After

Timeline View Options
The lower-left corner of the Timeline contains several controls to customize what elements
appear in the Timeline.

Audio tracks are displayed in a separate partition in the Timeline. You can resize the
partitions by dragging the divider for each partition.

FunctionButton nameButton

Displays all groups, layers, and objects. Audio
tracks must be displayed for this switch to have
any effect.

Show/Hide Layers

Displays audio tracks. The waveforms appear on
the audio tracks.
Note: When an audio file with an applied Audio
behavior is displayed in the Timeline, the Audio
behavior appears below the audio track that it
modifies.

Show/Hide Audio

Displays keyframes for all tracks. Keyframes appear
as blue diamonds (white when selected).

Show/Hide Keyframes

Displays mask tracks for objects that have masks
applied.

Show/Hide Masks

Displays behavior tracks for objects that have
behaviors applied.

Show/Hide Behaviors

Displays filter tracks for objects that have filters
applied.

Show/Hide Filters

Click one of the “Set timeline row size” buttons to
select a track size. To manually resize tracks,
position the pointer over a row separator line and
drag up or down.

Set Timeline Row Size
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Zooming in the Timeline
You can zoom in and out in the Timeline using the Zoom/Scroll control, the zoom slider,
or using a pinch open or pinch closed on a Multi-Touch trackpad. Each of these methods
lets you zoom in and out of the Timeline horizontally, showing more or less time in the
Timeline window. As you zoom in, you can see greater detail, which lets you place objects
with greater precision. As you move the zoom slider, the Timeline remains centered on
your current frame.

Zoom slider Zoom/Scroll control

Scroller Handle

The Zoom/Scroll control appears at the bottom of the Timeline window and lets you
scroll through your project when you drag the scroller left or right.

The Zoom/Scroll control also lets you zoom in and out in your Timeline. It can help you
navigate your project more quickly because it provides an overview of your Timeline at
a glance. The width of the control represents the entire duration of your project, and the
width of the scroller identifies the currently viewed segment.

Note: If you are working on a Mac with a Multi-Touch trackpad, you can use a two-finger
swipe to scroll, or the pinch open and pinch closed gestures to zoom in the Timeline.

If you drag either handle of the scroller inward, the scroller gets shorter and zooms in on
the Timeline. Dragging either handle outward lengthens the scroller and zooms out of
the Timeline. The Timeline playhead is always visible to provide a reference point for
which segment of your Timeline is currently being viewed.

To zoom in or out of the Timeline
µ Drag the handle at either end of the scroller. Drag toward the center of the Timeline to

zoom in. Drag away from the center to zoom out.

If you press Shift while dragging a handle, the opposite end remains locked in position
and allows you to zoom in or out on the edge of the current view.

Adjusting the Height of the Timeline Tracks
In addition to zooming in and out in the Timeline, you can adjust the height of the tracks.
Audio and object tracks may be resized separately. Some tracks, such as filters or behaviors,
do not resize at all.
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To adjust the height of the tracks
Do one of the following:

µ Drag the row separator between two layers in the Timeline layers list. When the pointer
changes to an adjust pointer, drag up or down to modify the vertical size of the tracks.

µ Click one of the “Set timeline row size” buttons.

Specifying the Track Display
You can choose several different ways to display the objects within the tracks in the
Timeline. You can display just the name of the object in the track, which makes the track
thin, and is the easiest way to see many tracks at a time. You can choose to show the
name and a thumbnail image of the object, which provides quick visual feedback and
lets you identify exactly what each object is. You can also display a track as a filmstrip,
which shows a series of thumbnails and lets you see where changes occur in a movie
object. When you modify the track display setting, the display for image and mask tracks
in the Timeline changes.

To specify the track display
1 Choose Motion > Preferences to display the Preferences window.

2 Click the Appearance icon.

3 In the Timeline section, choose an item from the Timebar Display pop-up menu.

4 Click the close box to close the Preferences window.

The bars are displayed according to your choice.

Note: When the Timebar Display is set to Filmstrip, your processing time is increased.
When a filter is applied to a layer or group, the result of the filter is displayed in the
filmstrip.
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Adding Objects to the Timeline Layers List
You can add images and clips to your project by dragging them to the Timeline layers
list. When you drag an image from the File Browser or Media tab into the Timeline layers
list, you can choose whether add the new object to an existing group, replace an existing
object, or create a new object. Once an object is added to the Timeline layers list, it
appears in the layers lists and becomes a Timeline track in the track area. The new object
can appear above or below an existing object; where you release the mouse button
determines placement of the new object.

Note: You can also add objects to the Timeline track area. For more information, see
Adding Objects to the Track Area.

To add an object to an existing group
1 Drag an object from the File Browser, Library, or Media tab, and position the pointer over

the Timeline layers list.

• If you position the pointer over a group, the track is highlighted with a black border.

• If you position the pointer between object tracks within a group, the position indicator
appears.

2 Release the mouse button to add the layer to the group.

The new layer is placed on top of other existing objects in the group, or in between the
objects where you dragged it.

To replace an object in an existing group
1 Drag an object from the File Browser, Library, or Media tab, and position the pointer over

the object that you want to replace.

A black highlight box appears around the object.

Note: The replace command can be used only for image, image sequence, and QuickTime
movie files.

2 Release the mouse button.

The new object replaces the old one.

To create a new group on top of existing groups
1 Drag an object from the File Browser, Library, or Media tab into the Timeline layers list,

at the upper edge of the top object.
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2 When the position indicator appears, release the mouse button.

A new group is created on top of other existing groups in the hierarchy or “stack” of
groups and layers.

To create a new group below existing groups
1 Drag an object from the File Browser, Library, or Media tab into the Timeline layers list,

below the lower edge of the bottom object.

Note: There are two different position indicators: The shorter indicator places the object
in the existing group. While holding down the mouse button, move slightly to the left
until a longer indicator appears. This indicator creates a new group.

2 Release the mouse button.

A new group is created below other existing groups in the hierarchy or “stack” of groups
and objects.

Managing Track Order
The Timeline layers list provides you with the tools to control object order. In 2D Motion
projects, the topmost track in the list appears on top of other layers in the Canvas. This
means you may need to rearrange the order of objects in your project to get the effects
you want.

To rearrange objects within a group
1 In the Timeline layers list, drag the object icon you want to move to a new position

between the other tracks.

Before After

2 When the position indicator appears in the location you want, release the mouse button.

The tracks are reordered.

To move an object from one group to another existing group
1 Drag the object icon in the Timeline layers list over another group.

362 Chapter 8 Using the Timeline



A black border highlights the group.

2 Release the mouse button.

The object moves into the selected group and is placed above any existing objects within
that group.

You can also drag an object to a specific place in the new group by dragging it in between
existing tracks in the new group. Motion’s groups and layers are “spring-loaded,” which
means that when they are collapsed, dragging an object onto them causes them to
temporarily expand, just like folders in the Finder.

To drop an object inside a collapsed group
1 Drag the object onto the collapsed group in the Timeline layers list.

2 Position the pointer over the name of the group until the group springs open.

3 Drag the object to the desired location within the group, then release the mouse button.
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Nesting Groups and Layers
To help organize large groups of objects or to create certain kinds of special effects, you
can place one group inside of another. This gives you the flexibility to create a group
containing multiple objects, and then treat that entire group as a single object within
another group. You could go further and take that “parent” group, combine it with some
other groups, and treat that group as a single element, and so on. This is called nesting
or grouping.

There are many reasons why you might choose to nest your layers or groups. Doing so
allows you to simplify your composite, grouping objects and layers into fewer containers.
It also allows you to manipulate a group of objects as one. For example, you could take
the individual letters of your title (each animated on its own) and use nesting to animate
the group of them across the screen. You can also use grouping to create complex particle
systems. You can nest several objects into a layer, and use the entire layer as the emitter
cell. For more on particle systems, see Working with Particles.

Note: You cannot use the Group command with objects that are in different groups.

To place one group inside another
1 Drag the group icon in the Timeline layers list onto the group inside of which you want

to nest it.

A black border highlights the destination group.

2 Release the mouse button.

The first group is now nested inside the second group.

You can also select the objects you want and choose Object > Group (or press
Command-Shift-G).

Note: There is no limit to the number of groups you can nest.

To return a nested group to its original state
µ Select the nested group, then choose Object > Ungroup (or press Command-Option-G).

The nested group is restored into individual objects. Any group within another group
can be ungrouped.

To remove a group from within a nest
1 Click the group icon in the Timeline layers list.

2 Drag the group out of the existing parent group to the area above the highest track.

The position indicator appears.

3 Release the mouse button.

The group is restored to primary group status.

To delete a group or object track
1 Select the group or object in the Timeline layers list.
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2 Press Delete.

You can also Control-click an object, then choose Delete from the shortcut menu.

All of the operations just described can also be performed with multiple tracks. For
example, rather than just moving one object from Group 1 to Group 3, you can select
two or three objects within Group 1 and move them all at once.

To select more than one object or group track
µ Command-click each of the tracks in the Layers list that you want to include in your

selection.

Adding Objects to the Track Area
When you drag a new object to the track area, a drop menu appears and lets you choose
how the object should be incorporated into the project. Depending on where in track
area you drop the object, you see different options. If you drag to a group or object track
in the track area, you can choose Composite, Insert, or Overwrite. An additional Exchange
option becomes available when you exchange the same type of media (such as a
QuickTime movie, an image sequence, or an image file). For example, Exchange appears
when you drag a QuickTime movie to a QuickTime movie’s track.

Note: You can also add objects to the Timeline layers list. For more information, see
Adding Objects to the Timeline Layers List.

Once an object is added to a project using the Timeline, it appears in the layers list and
becomes a Timeline track. The new object can appear above or below an existing object;
where you release the mouse button determines placement of the new object.
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Note: Cameras and lights that have been saved to the Library can be dragged to the
Timeline.

Dragging to a group track Dragging within an object track

If you are dropping multiple objects, you can choose Composite or Sequential from the
drop menu. Sequential imports objects one after the other.

Note: If you release the mouse button before the drop menu appears, the default choice
of Composite is applied. This means that the new layer appears on top of other objects
in the Canvas.

Composite
When you choose Composite from the drop menu, the new object is added to a new
track within the active group and all layers remain onscreen simultaneously.

Before After

To composite an object
1 Drag an object from the Library or Media tab into the Timeline tracks area.

As you drag, a tooltip appears at the pointer to tell you the frame number at which you
are located.

2 When you reach the frame where you want the new layer to start, position the pointer
over the layer you want as the background, and hold down the mouse button until the
drop menu appears.

3 Choose Composite from the drop menu.

The new layer is composited into the project.
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Insert
When you choose Insert from the drop menu, Motion leaves the existing object in the
track, but pushes it forward in time to make room for the new item. For example, if you
insert a five-frame movie into a group containing an existing object, the new movie is
added to the Timeline at whichever frame you drop it, pushing the remaining frames of
the original movie out five frames.

Before After

If you insert an object midway through an existing object, the existing object is split into
two objects, each on its own track.

To insert an object
1 Drag an object from the Library or Media tab into the Timeline track area.

As you drag, a tooltip appears at the pointer to tell you the frame number at which you
are located.

2 When you reach the frame where you want the new object to start, keep the mouse
button pressed until the drop menu appears.

3 Choose Insert from the drop menu.

The new object is inserted into the track, breaking the original bar into two, and pushing
the frames after the insertion further out in time.

Overwrite
The Overwrite drop menu option deletes the existing object, overwriting it with your
new object.

Before After
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If the new object is shorter than the one currently in the group, the Overwrite option
splits the duration of the existing object and deletes only the frames where the new
object appears.

Before After

To overwrite an object
1 Drag an object from the Library or Media tab into the Timeline track area.

As you drag, a tooltip appears to tell you the frame number at which you are located.

2 When you reach the frame where you want the new object to start, hold down the mouse
button until the drop menu appears.

3 Choose Overwrite from the drop menu.

The frames of the new object replace the frames of the original object. If the original
object contained more frames than the new one, the old object is split into two objects
and the additional frames remain.

Exchange
The Exchange drop menu option is a variant of the Overwrite option, but instead of
dropping the entire duration of the new object into the project, the duration of the
existing object is used.

For example, if you drag a 30-second clip over a 5-second clip, choosing Exchange swaps
the existing 5 seconds with the first 5 seconds of the longer clip.

Before After

Similarly, if you try to exchange a 10-second clip with one that lasts only 5 seconds, the
first 5 seconds are replaced, and the remaining 5 seconds would remain. The Exchange
option transfers any filters, behaviors, and keyframes from the original object onto the
new object.
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Note: You cannot use Exchange with audio files.

To exchange an object
1 Drag an object from the Library or Media tab into the Timeline track area.

As you drag, a tooltip appears to tell you the frame number at which you are located.

2 When you reach the object you want to exchange, hold down the mouse button until
the drop menu appears.

3 Choose Exchange from the drop menu.

The old object is replaced by the new object.

Sequential
This drop menu option is only available when you are dropping multiple objects into the
Timeline. Sequential drops objects one after another in the Timeline. For more information,
see Adding Multiple Clips to the Timeline.

Adding Multiple Clips to the Timeline
When you drag more than one item to the Timeline, the new objects appear in their own
tracks above any existing objects. This is equivalent to performing a composite edit with
a single object. A drop menu lets you choose whether the additional objects should be
stacked up as a composite, or whether they should appear one after another (sequentially).

Composite Sequential

To add multiple objects as a composite
1 Shift-select the files you want in the Library or Media tab, then drag them to the Timeline

track area.

2 When you reach the frame where you want the new objects to start, hold down the
mouse button until the drop menu appears.

3 Choose Composite from the drop menu.

The multiple objects are all edited into the project at the same point in time, each on its
own track.
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Alternatively, you can drop the multiple objects into the Timeline layers list. Doing so
always results in a composite edit. Also, if you release the mouse button before the drop
menu appears, a composite edit is applied.

To add multiple objects sequentially
1 Command-select the files you want in the File Browser, Library, or Media tab, then drag

them to the Timeline track area.

2 When you reach the frame where you want the new objects to start, hold down the
mouse button until the drop menu appears.

3 Choose Sequential from the drop menu.

The multiple objects are edited into the project, one after another, each on its own track.

Setting Drag and Drop Preferences
You can set preferences that specify where an item is dropped when you add it to the
Timeline. You can choose between dropping items at the start of the project or at the
current playhead position. You can also set the delay time before the drop menu appears.

To specify where new objects appear in the Timeline
1 Choose Motion > Preferences.

The Preferences window appears.

2 Click the Project icon.

The Project Preferences pane opens.

3 In the Still Images & Layers section, click the appropriate button to create layers at “Current
frame” or “Start of project.”

Note: The Create Layers At preference only applies when you drag items to the Timeline
layers list, the Layers tab of the Project pane, or directly into the Canvas. Clips dropped
on a specific frame within the Timeline always appear at that exact location.

To set the drop menu delay preference
1 Choose Motion > Preferences.

The Preferences window appears.

2 Click the General icon to view the General preferences pane.

3 In the Interface section, adjust the Drop Menu Delay slider to set the delay pause for the
drop menu.

Editing Objects in the Timeline
During the process of designing and implementing a motion graphics project, you place
objects in the Timeline and Canvas, move them forward or backward in time, and trim
them to match the timing of other objects in your project.
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Motion has several features that help you modify the objects in the Timeline. You can
arrange your objects to begin and end at designated frames. You can also use powerful
alignment and timing tools, such as snapping and markers. You can also modify keyframes
in the Timeline. This section describes the various ways you can perform these actions.

Motion uses the terms move, trim, and slip to describe the different ways of editing
Timeline objects.

• Move: Changes the location of an object without affecting its content or duration.

• Trim: Changes the duration of an object without affecting its location or content.

• Slip: Changes the content of an object without affecting its location or duration.

Moving Objects
Move an object when you want it to begin and end at a different point in the project.

To move an object
µ In the track area, click an object bar and drag left or right to move it in time.

A tooltip appears that identifies the new In and Out points of the clip, so you can drag
the clip to the frame you want. The delta symbol (the small triangle) indicates the number
of frames you are moving.

To move an object and snap it to neighboring items
µ Press Shift as you drag the item in the Timeline.

Snap-to lines appear and the edges of the clip automatically line up precisely with these
lines.

Moving Objects to the Playhead
You can move an object to a new location in the Timeline by using the Move Selected
In (or Out) Point command. This command automatically shifts the position of the selected
object to the current playhead position and can be used to move and align multiple
objects in one operation.

To move an object to the playhead
1 Select the object you want to move.

2 Place the playhead at the point in the Timeline where you want to move the object.
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3 Choose Mark > Move Selected In Point (or press Shift-Left Bracket) to align the object’s
beginning to the playhead or choose Mark > Move Selected Out Point (or press Shift-Right
Bracket) to align the end of the object to the playhead position.

Before After

Moving Objects Shortcut
In the Timeline, you can quickly move an object forward or backward a specific number
of frames, or to a specific frame.

To move an object to a specific frame
1 In the Timeline, select the object you want to move, then type the number of the frame

(or timecode) where you want to move the object.

A value field appears that displays the number you typed.

2 Press Return.

The object’s In point moves to the specified frame number.

To move an object a specific number of frames
Do one of the following:

µ To move the object forward a specific number of frames, select the object, type a plus
sign (+) followed by the number of the frames you want to move, and then press Return.

µ To move the object backward a specific number of frames, select the object, type a minus
sign (–) followed by the number of the frames you want to move, and then press Return.

Trimming Objects
Trim an object when you want to shorten or lengthen its duration in the Timeline. You
can shorten or lengthen either the beginning or end of the object by dragging from the
left or right edge of the object bar in the Timeline (the In and Out points).
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You can also trim an object by using the menu items and corresponding keyboard
shortcuts to change an object’s In and Out points. This allows you to trim multiple objects
simultaneously as well as make trimming changes on the fly while your project is playing
back.

You can only lengthen a footage layer if there are existing unused frames in the source
media. If you need to extend an object and the source material doesn’t have enough
frames, you can change its End Condition to Loop, Ping Pong, or Hold. The End Condition
parameter is located in the Properties tab of the Inspector. You can extend the length of
other objects, such as cameras, text, and shapes without restriction.

Note: For more information on the Timing controls, see Retiming.

When you resize an object, unused frames temporarily appear beyond the boundaries
of the object in a lighter color. If there is no room outside of the currently used portion,
no unused frames appear and you cannot lengthen the object.

Unused frames

To trim an object
1 Move the pointer to one end of the object you want to trim.

The pointer changes to a trim pointer.

2 Drag the end of the bar until it reaches the frame where you want the object to start or
end.

As you drag, a tooltip shows the new In or Out point, and the new duration of the object.
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To trim an object and snap to neighboring items
µ Press Shift as you drag the edge of the item in the Timeline.

Snap-to lines appear, and the edge of the object you are dragging automatically lines up
precisely with these lines.

To change an object’s In or Out point
1 Select the object you want to trim.

2 Place the playhead on the frame where you want the new In or Out point.

Before After

3 Choose Mark > Mark In (or press I) to set a new In point or choose Mark > Mark Out (or
press O) to change the Out point.

To trim multiple objects at the same time
1 Select the objects you want to trim.

2 Place the playhead at the In or Out position you want.

3 Choose Mark > Mark In (or press I) or Mark > Mark Out (or press O) to set a new In or Out
point.

All selected objects are trimmed to the new point.

Note: If one of the objects doesn’t have enough media to complete the trim, it moves
as far as it can toward the desired point.

Slipping Objects
Slip an object when you want to use a different section of your clip, but you don’t want
to change the layer’s duration or where it appears in the Timeline. Slipping is only possible
after you have trimmed an object.
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For example, if you have a shot of a door opening that is 3 seconds long and you want
to trim it down to only 1 second, you can use the Slip function to select which one-second
section to use: the first second as the door leaves the jamb, the next second where it is
flying open, or the last second where it bangs against the wall.

Before After

Note: You can only slip an object as far as the existing unused frames in the source media.

To slip an object
1 With the pointer over the object, press and hold down the Option key.

The pointer turns into the slip pointer.

2 Drag the middle part of the colored bar left or right.

Dragging to the right replaces the frames with a section from later in the source material,
while dragging to the left uses frames from earlier in the clip.

Splitting Tracks
Occasionally you may want to divide a single object into multiple objects, each in its own
Timeline track. You might do this if you want an effect to apply to one portion of an
object but not to another part. Or you might want an object to change layer order midway
through, to create the effect that objects are moving in 3D space. When working in 3D,
you can split camera tracks as well. Splitting tracks allows you to turn one object into
multiple pieces and then manipulate each segment of the object on its own track.

Before After
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To split an object track
1 Select the object in the track area of the Timeline layers list for the object you want to

split.

2 Place the playhead on the frame where you want the split to occur.

3 Choose Edit > Split.

The object is broken into two pieces, each positioned on its own track.

Deleting Objects
Removing objects from your project can be just as important as adding them. Motion
provides three ways to remove an object from the Timeline.

• Delete: Removes the object, leaving a gap in the Timeline.

Before After

• Ripple Delete: Removes the object and closes up the gap left behind. If the objects are
within a group, the group is split into two objects.

Before After

• Cut: Deletes the object, leaving a gap in the Timeline, and copies the object to the
Clipboard for later pasting.

To delete an object
1 Select the object you want to delete.

2 Choose Edit > Delete (or press Delete).

You can also Control-click the object, then choose Delete from the shortcut menu.
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To ripple delete an object
1 Select the object you want to delete.

2 Choose Edit > Ripple Delete (or press Shift-Delete).

To cut an object
1 Select an object you want to delete.

2 Choose Edit > Cut from the menu bar (or press Command-X).

You can also Control-click the object, then choose Cut from the shortcut menu.

Copying and Pasting Objects
As in other applications, you can copy and paste objects. Copying leaves an object in
place and copies it to the Clipboard for later pasting.

When you paste an object, it is placed at the position of the playhead.

Before After

If a track is selected, the object is pasted into that track above all other objects. If no track
is selected, a new track is created for the pasted object (as illustrated above).

Change the active track by clicking the Timeline layers list. Pasting multiple objects retains
the relative object and layer order of the Clipboard contents. New tracks can be added
to accommodate the paste operation.

Objects with filters behaviors, keyframes, and other effects retain those effects when cut,
copied, and pasted.

To copy an object to the Clipboard
1 In the Timeline layers list or File Browser, select the object or objects you want to copy.

2 Choose Edit > Copy (or press Command-C).

To paste an object
1 In the Timeline layers list, select the layer where you want the object pasted.

2 Position the playhead at the desired time position.

3 Choose Edit > Paste (or press Command-V).
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Paste Special
In addition to ordinary pasting, Motion lets you paste as an insert, overwrite, or exchange
edit. These three commands appear in the Paste Special dialog. Paste special can also be
used with regions to perform a special type of paste. For more information, see Pasting
into a Region Using the Paste Special Command.

• Insert into time region: Pastes the Clipboard contents into the project, pushing existing
objects farther down in time.

• Overwrite into time region: Pastes the Clipboard contents into the project, deleting any
existing objects at the same point in time.

• Exchange media with existing object: Replaces the selected object in the project with
the Clipboard contents.

To paste an object as an insert
1 Select the track where you want the object pasted.

2 Position the playhead at the desired time position.

3 Choose Edit > Paste Special (or press Command-Option-V).

The Paste Special dialog appears.

4 Select “Insert into time region.”

5 Click OK to confirm your edit.

To paste an object as an Overwrite
1 Select the track where you want the object pasted.

2 Position the playhead at the desired time position.

3 Choose Edit > Paste Special (or press Command-Option-V).

The Paste Special dialog appears.

4 Select “Overwrite into time region.”

5 Click OK to confirm your edit.

To paste an object as an Exchange
1 Select the track where you want the object pasted.

2 Position the playhead at the desired time position.

3 Choose Edit > Paste Special (or press Command-Option-V).

The Paste Special dialog appears.

4 Select “Exchange media with existing object.”

5 Click OK to confirm your edit.

Note: The “Exchange media with existing object” option is only available for an item
copied from the File Browser. To copy an image element from the File Browser, select
the image and choose Edit > Copy (or press Command-C).
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Displaying and Modifying Keyframes in the Timeline
You can move or delete keyframes that are displayed in the Timeline. You can also display
in the Timeline the animation curve for a selected keyframe in the Keyframe Editor.

To display keyframes in the Timeline
µ At the bottom of the Timeline layers list, click the Show/Hide Keyframes button.

Show/Hide Keyframes 
button

When the button appears dark gray, it is enabled. The keyframes appear below the object
tracks. In the following image, the “5-sided star” object has three keyframes. The keyframes
appear in the track below the object.

To move a keyframe’s position in time
µ Drag the keyframe to the left or right. When selected, the keyframe appears white.

Moving the keyframe in the Timeline only modifies its position in time. To directly modify
the value of a keyframe, do one of the following:

• Control-click the keyframe, choose the property you want to adjust from the shortcut
menu, enter a new value, and press Return.

• Use the Keyframe Editor. This allows you to change the value and interpolation of the
keyframe. For more information on the Keyframe Editor, see Keyframes and Curves.

To delete a keyframe or group of selected keyframes
µ Select the keyframe or keyframes that you want to delete, and do one of the following:

• Press Delete.

• Control-click one of the selected keyframes, then choose Delete Keyframes from the
shortcut menu.

To delete all keyframes
µ Control-click a keyframe, then choose Delete All Keyframes from the shortcut menu.

To display an animation curve in the Keyframe Editor
µ Control-click a keyframe on the track, then choose Show in Keyframe Editor from the

shortcut menu.
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The Keyframe Editor is displayed, the animation curve appears, and a new, untitled curve
set is created. For more information on curve sets, see Filtering the Parameter List.

Retiming in the Timeline
By default, a 60-frame clip played back at 30 frames per second takes two seconds to
display its 60 frames. If its In point is frame 1, its Out point is frame 60. Speed and duration
are interactive; that is, if you increase the speed at which the clip plays back, its duration
automatically decreases. Playing back the same clip at 15 frames per second would take
twice as long. The clip’s In point remains the same, but its Out point is now 120.

For more detailed information about retiming, see Retiming. For more information on
using the Retiming behaviors, see Retiming Behaviors.

Adjusting a Clip’s Speed
Motion allows you to easily change the timing of clips in the Timeline.

To shorten the clip’s duration and speed up its playback speed
1 With the pointer over the end of the clip, press and hold down the Option key.

The pointer turns into the retime pointer.

2 Drag the Out point of the clip’s bar to the left.

As you drag, the tooltip displays the clip’s duration and speed.

Note: To use the retime pointer, Constant Speed must be chosen from the Time Remap
pop-up menu in the Properties tab of the Inspector. When Variable Speed is chosen, the
retime pointer has no effect.
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To lengthen the clip’s duration and slow down its playback speed
1 With the pointer over the start or end of the clip, press and hold down the Option key.

The pointer turns into the retime pointer.

2 Drag the Out point of the clip’s bar to the right.

As you drag, the tooltip displays the clip’s Duration and Speed.

Looping a Clip
When a looped clip reaches its last frame, it starts playing again from its first frame.
Another way of extending a clip’s duration is by looping it. You can easily loop a clip by
adjusting it in the Timeline.

To loop a clip
1 With the pointer over the end of the clip, press and hold Option-Shift.

The pointer turns into the loop pointer.

2 Drag the Out point of the layer’s bar to the left.

As you drag, the tooltip displays the clip’s In and Out points, Duration, and Loop Duration.
A looped clip has barriers to indicate where loops begin and end in the Timeline.

First loop barrier

The first loop barrier in a clip’s bar is interactive. Moving the barrier changes the point at
which the clip loops.

To change the loop point of a clip
µ Drag the first loop barrier left or right.

The end point of the clip’s loop moves as you drag.
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Editing in the Group Track
In addition to the ability to edit individual objects within groups, Motion allows you to
do a variety of editing tasks directly in the group track, even if that track is collapsed. This
allows you to collapse your tracks and do many of the functions typically limited to a
dedicated nonlinear editor such as Final Cut Pro.

Ordinarily the group bar indicates the name of the object if there is only one object and
the number of composited items for areas where more than one object overlaps.

Moving Objects in the Group Track
Motion lets you move objects within a group depending on where you click. You can
move all of the objects within the group as a single object by clicking the thin blue group
bar at the top of the group track. If you click an area where only one clip exists, you move
just that item. If you click an area where multiple objects overlap, dragging moves all of
the overlapping items.

To move an entire group as a single object
1 Click the thin blue group bar at the top of the group track.

The layer can be collapsed or expanded.

2 Drag to the right or left to move the entire layer in time.

Before After

To move a single object within a group
1 Click the area of the group track where the one clip is visible.

That clip is highlighted in the group track.
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2 Drag the section left or right to move the object within the group forward or backward
in time.

Before After

Moving and Editing Overlapping Objects
You can move all overlapping objects of a group at once or edit a single object within a
group.

To move overlapping objects within a group
1 Click the area of the group track where the overlap is indicated.

The selected area may exceed the overlapping region if an object extends beyond the
overlap.

2 Drag the section to move all of the objects at once.

Before After

You can also use the shortcut menu to select any one of the overlapping objects in order
to edit that object directly. This is one way that you can manipulate individual objects
within a group without having to expand the group.

To edit one item in an overlapping area of a group
1 Control-click the overlapping area of the group, then choose the object you want to

manipulate from the shortcut menu.
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The boundaries of that one object are highlighted in the group track.

2 Move, trim, or slip the object independently from the other objects in the group.

Trimming Objects in the Group Track
Trimming the edges of the group bar automatically trims the edges of the objects within
the group. If there is only one object, trimming the group bar simply trims that object. If
there is more than one object lined up with the edge of the group, trimming the group
automatically trims all of those objects.
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You cannot trim the individual object tracks within the body of the group track.

Before After

Disconnecting the Group Track from Its Contents
You can modify the group bar to be longer or shorter than the contents of the group.
For example, you might shorten a group bar to hide a section of the objects within it.
Objects that extend beyond the boundaries of the group bar (the thin blue bar at the
top of the group track) are not displayed in the Canvas.

Before After

To change the length of the group independently from the objects within it
µ Press Command, then drag the edge of the group track.

Only the thin blue layer bar is trimmed.

Note: Once you manually change the length of the group bar, it is no longer automatically
updated as you add or modify the objects within it. To restore automatic updating, realign
the group bar with the right edge of the last clip in the group.

You can use this same technique to trim an object without automatically changing the
duration of masks, filters, or other applied effects.
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To trim an object without changing applied effects
µ Press Command while you drag the edge of the object.

Slipping Objects in the Group Track
In addition to moving and trimming, you can slip certain objects directly in the group
bar. Any portion of the group that contains only one object can be slipped. Areas where
more than one object overlap cannot be slipped without expanding the group and directly
manipulating the individual objects.

To slip an object in the group track
1 Option-click an area of the group where the object is located.

2 Drag to the right or left to use an earlier or later portion of the media without moving
the position or duration of the object.

You can only slip an object if there are unused frames in the source media associated
with that clip. For more information on slipping, see Slipping Objects.

Working in the Ruler
You can perform several types of functions using the ruler area of the Timeline. You can
move the playhead to a specific frame to view the project at a specific time. You can also
set In and Out points so that playback occurs only within the specified frames. In addition,
you can select a range of frames, so that you can delete, cut, or paste into the selected
frames.

In point Out point

PlayheadCurrent frame field
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Navigating in the Timeline
Motion provides many different controls for navigating the Timeline. You can directly
drag the playhead to “scrub” through your project as quickly or slowly as you want, or
you can jump to a specific frame. Additionally, you can automatically jump to object
boundaries, markers, and other important indicators in the Timeline.

To move the playhead to a new point in time
Do one of the following:

µ Double-click the current frame field, type a frame number, then press Return.

µ Drag the current frame value slider to the left or right to advance or rewind.

µ Drag the playhead to the frame you want.

µ Click the ruler at the frame number where you want to move the playhead.

µ With the Canvas or Project pane active, type the timecode or frame number where you
want to move the playhead. The new frame number appears in the current frame field
in the Canvas. Press Return to jump to that frame.

µ With the Timeline active, type the timecode or frame number where you want to move
the playhead. The new frame number appears in the Timeline’s current frame field. Press
Return to jump to that frame.

Important: If a track is currently selected, typing a number and pressing return moves
the selected object in the track rather than the playhead.

To move forward a specific number of frames
µ Press Shift–Plus Sign and then the number of frames you want to move forward.

Important: If a track is currently selected, typing a number and pressing return moves
the selected object in the track rather than the playhead.

To move backward a specific number of frames
µ Press Shift–Minus Sign and then the number of frames you want to move backward.

Important: If a track is currently selected, typing a number and pressing return moves
the selected object in the track rather than the playhead.

To move ahead or back in seconds, minutes, or hours, type the following in the current
frame field

µ To move forward in seconds, type Shift–Plus Sign, then type the number of seconds you
want to move forward, and then type a period. For example, to move 2 seconds ahead,
type “+2.” (with a period after the number) in the field, then press Return. To move ahead
in minutes, type two periods after the number, and to move ahead in hours, type three
periods after the number.
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µ To move backward in seconds, type a Shift–Minus Sign, then type the number of seconds
you want to move backward, and then type a period. For example, to move 2 seconds
backward, type “–2.” (with a period after the number) in the field, then press Return. To
move backward in minutes, type two periods after the number, and to move backward
in hours, type three periods after the number.

Important: If a track is currently selected, typing a number and pressing return moves
the selected object in the track rather than the playhead.

To play back your project
µ Press the Space bar.

To move forward or backward one frame at a time
Do one of the following:

µ Click the “Go to next frame” or “Go to previous frame” button in the transport controls
(left of the Play/Mute Audio button).

µ Choose Mark > Go to > Previous Frame or Next Frame.

µ Press the Left Arrow key to move backward or the Right Arrow key to move forward.

Note: If you are working on a Mac with a Multi-Touch trackpad, you can rotate left to go
to the previous frame or rotate right to go to the next frame.

To move forward or backward ten frames at a time
Do one of the following:

µ Choose Mark > Go to > 10 Frames Back or 10 Frames Forward.

µ Press the Shift key, then press the Left Arrow or Right Arrow key.

To jump directly to the beginning of the project
Do one of the following:

µ Click the “Go to start of project” button in the transport controls (to the right of the Record
button).

µ Choose Mark > Go to > Project Start.

µ Press Home.

To jump directly to the end of your project
Do one of the following:

µ Click the “Go to end of project” button in the transport controls.

µ Choose Mark > Go to > Project End.

µ Press End.
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To jump to the next keyframe
Do one of the following:

µ With the animated object selected, press Shift-K.

µ With the animated object selected, choose Mark > Go to > Next Keyframe.

To jump to the previous keyframe
Do one of the following:

µ With the animated object selected, press Option-K.

µ With the animated object selected, choose Mark > Go to > Previous Keyframe.

For information on displaying keyframes in the Timeline, see Timeline View Options.

In addition to simply moving to new positions in the ruler, you can navigate directly to
objects within the Timeline, such as objects, markers, and keyframes. For more information
on markers, see Adding Markers. For more information on keyframes, see Keyframes and
Curves.

To jump directly to the beginning or end of an object in the Timeline
1 Select the object you want to navigate to.

2 Do one of the following:

• Choose Mark > Go to > Selection In Point or Selection Out Point.

• Press Shift-I (for the In point) or Shift-O (for the Out point).

Defining the Play Range
Ordinarily, clicking the Play button plays your project from the first frame until the last.
However, you can change the area of your project Motion plays by modifying the In and
Out points in the Timeline ruler. You might do this to focus on a particular section as you
fine-tune your project or make other changes to it. Once you’re done focusing on that
section, you can reset the In and Out points to the beginning and end of your project.

New In point New Out point

To customize the playback In point
Do one of the following:

µ In the ruler, drag the In point marker from the left edge of the ruler to the frame where
you want to set the In point. As you drag, the playhead also moves with your pointer.
When you release the mouse button, the playhead snaps back to its previous position.

µ Choose Mark > Mark Play Range In.

µ Press Command-Option-I.
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To customize the playback Out point
Do one of the following:

µ In the ruler, drag the Out point marker from the right edge of the ruler to the frame where
you want to set the Out point.

µ Choose Mark > Mark Play Range Out.

µ Press Command-Option-O.

To reset playback In and Out points
Do one of the following:

µ Choose Mark > Reset Play Range.

µ Press Option-X.

The In and Out points reset themselves to the beginning and end of the project.

To navigate to playback In and Out points
Do one of the following:

µ Choose Mark > Go to > Play Range Start or Play Range End.

µ Press Shift-Home (In point) or Shift-End (Out point).

Working with Regions
Sometimes you may want to make changes to a range of frames, known as a region. You
might do this to cut or copy a section of time to remove it or move it to a new position
in your project. Regions do not have to align with object edges in the Timeline. You can
create a region that begins midway through an object or one that includes empty frames
beyond the edges of objects.

To select a range of frames
µ Command-Option-drag in the Timeline.

A light blue band appears over the selected frames.
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To expand or contract a region
µ Position the pointer at either edge of a region to modify its end point. Click to the right

to make it longer or to the left to make it shorter.

Selected regions ordinarily apply to all tracks in your Timeline. However, sometimes you
only want to select one or more tracks. This allows you to make complex selections across
multiple layers and tracks.

To move a region
µ Position the pointer over the region, then drag to move the region.

To deselect tracks from a selection range
µ Command-click the track you want to deselect.

Once you have defined your selection range, you can delete the section or ripple delete
the section (to delete it and close the resulting gap). You can cut or copy the section to
move it to the Clipboard so you can paste it somewhere else.

Note: Pasting a region does not paste at the current playhead location. To quickly move
the pasted region to the playhead location, press the Shift key while you drag the pasted
object. As you approach the current playhead location, the object snaps into place.

You can also paste into a region, which fills the existing region with the contents of the
Clipboard.
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Pasting into a Region Using the Paste Special Command
Regions are also useful for performing a special type of paste command called paste
special. You can define a region and paste objects into that region. You have three choices
for how the paste into is performed. You can insert, pushing the existing region down in
time, overwrite the existing contents of the region, or exchange the existing objects with
the Clipboard contents. In all of these cases, the pasted objects never exceed the duration
of the region they are pasted into.

To paste into a region
1 Select the object that you want to copy to the Clipboard to be pasted.

2 Press Command-C to copy or Command-X to cut your selection.

3 Command-Option-drag in the Timeline to select a region.

4 Choose Edit > Paste Special.

The Paste Special dialog appears.

5 Select either Insert, Overwrite, or Exchange.

6 Click OK to close the dialog.

The Clipboard contents are pasted into the region using the method you specified. For
more information on the different editing types, see Adding Objects to the Track Area.

Inserting Time
You can select a region in order to add blank playback time into your project. For example,
you might want to add some black frames between two objects, or put some frames in
as a placeholder for a clip you don’t yet have. This is called inserting time.

To insert time into a project
1 Command-Option-drag in the ruler. Drag as wide an area as you want to insert.

2 Choose Edit > Insert Time.

The number of frames in the region is added to the project, beginning at the end of the
selected region and pushing any existing objects further out in time.

Before After
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Project Duration
Motion projects default to ten seconds in length. You can change this duration to match
the needs of your project. To learn how to change the default project duration, see General
Tab of the Project Properties Window.

To change the project duration
Do one of the following:

µ Drag in the project duration field in the lower-right corner of the Canvas. Dragging to
the right extends the length and dragging to the left shortens it.

µ Click the project duration field and type a number into the value field.

µ Choose Edit > Project Properties (or press Command-J) and change the value of the
project duration field in the dialog.

Note: You can click the stopwatch button to switch between viewing the project duration
field in frames or timecode.

Adding Markers
A marker is a visual reference point in the Timeline that identifies a specific frame. You
can add as many markers as you want in the Timeline ruler while playing the project, or
when the playhead is stopped.

Use markers to:

• Add a visual reference to a track

• Add a visual reference to a project marker in the mini-Timeline

• Align other tracks, objects, or keyframes to an important point in time

• Add notes about a particular area in your project

You can assign different colors to different types or markers and create marker groups.
For example, use green to label all audio markers or pink to identify all temporary object
markers.
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You can add two types of markers: project markers and object markers. Project markers
are fixed to a specific timecode value in the ruler. Object markers are attached to an object
and move around as you move the object. Object markers appear only in the Timeline.
Project markers appear in the Timeline, Keyframe Editor, and Audio Editor.

Object marker

Project marker

Object marker

Note: Project markers are indicated in the mini-Timeline by a fine green line. For more
information on the mini-Timeline, see Mini-Timeline.

Project marker Project marker

To add a project marker
1 Place the playhead on the exact frame where you want the marker to appear.

2 Check that no objects are selected, then do one of the following:

• Choose Mark > Markers > Add Marker.

• Press M.

• Control-click the gray marker bar above the ruler in the Timeline, then choose Add
Marker from the shortcut menu.

A green marker is added in the gray bar above the Timeline ruler.
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Note: You can also press Shift-M to add a project marker at the playhead position, whether
or not an object is selected.

To add an object marker
1 Place the playhead on the exact frame where you want the marker to appear.

2 Select the object where you want to add the marker, then do one of the following:

• Choose Edit > Markers > Add Marker.

• Press M.

A red marker is added to the group bar.

In this way, you can add markers while playing your project. The markers appear at the
frame where the playhead is at the time you press the M key.

Moving and Deleting Markers
Timeline markers can be easily moved or deleted.

To move a marker
µ Drag the marker left or right to a new location.

To delete a marker
Do one of the following:

µ Drag the marker vertically out of the area where it resides, then release the mouse button.

The marker disappears with a “poof” animation.

µ Double-click the marker, then click the Delete marker in the Edit Marker dialog.

µ Position the playhead over the marker, select the group or object (for group or object
markers), then choose Mark > Markers > Delete.

µ Control-click the marker, then choose Delete Marker from the shortcut menu.

Deleting All Markers
In addition to deleting one individual marker, you can delete all markers from your project
in one step. This deletes either project markers or all markers in a selected layer or object.

To delete all project markers only
1 Choose Edit > Deselect All (or press Command-Shift-A).

2 Choose Mark > Markers > Delete All Markers.
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To delete all object markers
Do one of the following:

µ Select the group or layer containing the markers you want to delete, then choose Mark
> Markers > Delete All Markers.

µ Control-click the gray marker bar above the ruler in the Timeline, then choose Delete All
Markers from the shortcut menu.

Editing Marker Information
You can edit the information for a marker, including its name, starting frame, duration,
and color. You can also add comments to the marker. Comments show up as a tooltip
when the pointer is paused over the marker.

To edit marker information
1 Open the Edit Marker dialog by doing one of the following:

• Double-click a marker to display the Edit Marker dialog.

• Choose Edit > Markers > Edit.

• Control-click the Marker, then choose Edit Markers from the shortcut menu.

Notes added in the Comments field appear as tooltips when the pointer is over the
marker.

2 Type a name in Name field.

3 Type a number in the Start field.

The marker moves to the frame number you enter.

4 Type a value in the Duration field to specify the range of frames for the marker.

5 Type text in the Comment field.

This comment appears as a tooltip when you pause the pointer over project markers.

6 Click the Color pop-up menu to display a list of eight possible colors, then choose the
color you want for the marker.
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7 Click the Type pop-up menu to choose a marker type:

• Standard: The default marker for use in Motion

• DVD Menu Loop: When you are using a Motion project as a menu background in
DVD Studio Pro, the DVD menu normally plays through the entire Motion project, then
starts over at the beginning of the project. When a loop point marker is defined, the
DVD menu plays the Motion project to the end the first time through, then starts over
at the loop point marker for subsequent loops.

• DVD Alpha Transition: When you are using a Motion project as an alpha transition in
DVD Studio Pro, this marker sets the point where the alpha value of the transition (the
Motion project) becomes 0. When a Motion project is used as a transition, only its alpha
channel is used when blending two pieces of video in DVD Studio Pro.

8 Click OK to accept your changes.

Navigating with Markers
You can jump from your current playhead position to a nearby project marker either
forward or backward.

To jump to the next marker
µ Control-click the gray marker bar above the ruler in the Timeline, then choose Next Marker

from the shortcut menu.

The playhead automatically jumps to the position of the next project marker.

You can also choose Mark > Go To > Next Marker or press Command-Option-Right Arrow.

To jump to the previous marker
µ Control-click the gray marker bar above the ruler in the Timeline, then choose Previous

Marker from the shortcut menu.

The playhead automatically jumps to the position of the previous project marker.

You can also choose Mark > Go To > Previous Marker or press Command-Option-Left
Arrow.

You can also navigate to adjacent markers from within the Edit Marker dialog. In that
case, the dialog remains open and the contents are replaced with the information for the
next marker.

Next marker

Previous marker
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You can use behaviors to animate objects using simple graphical controls. With behaviors,
you can easily create basic motion effects or complex simulated interactions between
multiple objects. You can add behaviors to objects (cameras, lights, layers, or groups) or
properties in a project to create animated effects without needing to create or adjust
keyframes. Drag a behavior onto an object, and the object is automatically animated
based on the type of behavior you applied. You can customize behavior parameters in
the HUD or in the Behaviors tab of the Inspector to change a behavior’s effect.

This chapter covers the following:

• Behavior Concepts (p. 399)

• Browsing for Behaviors (p. 403)

• Applying and Removing Behaviors (p. 404)

• Modifying Behaviors (p. 415)

• Working with Behaviors (p. 417)

• Changing the Timing of Behaviors (p. 423)

• Animating Behavior Parameters (p. 431)

• Saving and Sharing Custom Behaviors (p. 434)

• Basic Motion Behaviors (p. 437)

• Parameter Behaviors (p. 460)

• Retiming Behaviors (p. 489)

• Simulation Behaviors (p. 494)

• Additional Behaviors (p. 522)

• Behavior Examples (p. 522)

Behavior Concepts
Behaviors are designed to be flexible and can be combined with one another to create
all kinds of effects. Using behaviors, motion graphics design becomes interactive, allowing
you to create complex motion effects and simulated object interactions very quickly.
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Behaviors can also be used to animate the parameters of nearly any particle system
emitter, shape, mask, replicator, filter, generator, camera, or light. This allows you to
quickly create animated backgrounds, dynamic filter effects, interesting camera and
lighting effects, and incredibly complex particle systems, all using a few simple controls.

Motion Tracking behaviors serve a different purpose than other behaviors. Rather than
immediately creating animation on the object to which it is applied, a tracking behavior
analyzes an object’s motion, or the motion in a clip. This analyzed motion can be used
to stabilize a shaky clip, match the movement of an object to the movement in the
analyzed clip, track a layer onto a clip (such as a logo or text onto a moving car), and so
on. For more information, see Motion Tracking.

There are 11 different kinds of behaviors in Motion.

• Audio behaviors are applied to audio files to create simple audio effects, such as fade-ins
and fade-outs, pans, and fly-bys. There is also a separate Audio Parameter behavior
that can be applied to the parameters of nearly any object. For more information, see
Audio Behaviors.

• Basic Motion behaviors are among the simplest behaviors. They animate specific
parameters of the object to which they are applied. Some Basic Motion behaviors affect
position while others affect scale or rotation. Examples include Fade In/Fade Out, Spin,
and Throw. All of the Basic Motion behaviors can be applied to images and clips, particle
emitters, shapes, text, and so on. Most of the Basic Motion behaviors can be applied
to cameras and lights. For more information, see Basic Motion Behaviors

• Camera behaviors are specifically designed to be applied to a camera in a 3D project
and create basic camera moves such as dolly moves, panning, and zooming. For more
information, see Camera Behaviors.

• Motion Tracking behaviors perform multiple tasks. While all tracking behaviors analyze
the motion present in a clip, the application of that data varies depending on the
specific behavior. For example, the Stabilize behavior stabilizes movement in a clip that
may have been created by camera shake. The Match Move behavior analyzes the motion
in an object (such as a clip) and applies that motion to another object to integrate it
with the tracking source. For more information, see Motion Tracking Behaviors.

• A Parameter behavior can be applied to a specific parameter of any object (including
filters and behaviors) and the effect is limited to just that parameter. The same Parameter
behavior can be applied to different parameters, resulting in completely different effects.
For example, you can apply the Oscillate behavior to the opacity of text to make the
letters fade in and out, or you can apply the Oscillate behavior to the rotation of a
shape to make the shape rock back and forth. You can also apply Parameter behaviors
to filter parameters, generator parameters, the parameters of particle systems and
replicators, or even the parameters of other behaviors. Examples include Oscillate,
Randomize, and Reverse. Most Parameter behaviors can be applied to cameras and
lights. For more information, see Parameter Behaviors.
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• Particles behaviors are specifically designed to be applied to a particle emitter or cells
within particle systems. These behaviors affect how individual particles are animated
over the duration of their life. For more information, see Using Particles Behaviors.

• Replicator behaviors are specifically designed to be applied to a replicator or cells within
the replicator. These behaviors affect how the replicator cell parameters are animated
over their pattern. For example, you can create an animation that travels over the
replicator pattern in which each cell goes from 0 percent opacity to 100 percent. For
more information, see Using the Sequence Replicator Behavior.

• Retiming behaviors are applied directly to footage and cloned layers (or groups) in order
to create hold frames, reverse the footage, change the speed of the footage, create
strobe frames or stutter, or scrub the footage. These behaviors are applied to the footage
objects in the Layers tab, not in the Media tab. For more information, see Retiming
Behaviors.

• Shape behaviors are specifically designed to be applied to a shape or mask. Shape
behaviors affect the individual vertices of a shape or mask. For example, applying the
Randomize behavior randomly animates the control points (or tangents, or both) on
the shape. For more information, see Shape Behaviors.

• Simulation behaviors perform one of two tasks. Some Simulation behaviors, such as
Gravity, animate the parameters of an object in a way that simulates a real-world
phenomenon. Other Simulation behaviors, such as Attractor and Repel, affect the
parameters of one or more objects surrounding the object to which they’re applied.
These behaviors allow you to create some very sophisticated interactions among
multiple objects in your project with a minimum of adjustments. As with the Basic
Motion behaviors, Simulation behaviors also affect specific object parameters. Examples
include Attractor, Gravity, and Repel. Simulation behaviors can be applied to cameras
and lights. For more information, see Simulation Behaviors.

• Text behaviors animate text parameters to create various animated effects. Examples
include Scroll Up, which causes text to move vertically for scrolling titles or credits, and
Type On, which reveals text letter by letter. For more information, see Text Animation
and Text Sequence Behaviors and Sequence Text Behavior.

For an introduction to using and applying behaviors, see Applying and Removing
Behaviors. For more detailed information on how to manipulate behaviors in a project,
see Working with Behaviors.

Note: Audio, Camera, Motion Tracking, Particles, Replicator, Shape, and Text behaviors
are discussed in their respective chapters.

For step-through examples of using behaviors, see Behavior Examples.
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Behaviors Versus Keyframes
It’s important to understand that behaviors do not add keyframes to the objects or
parameters to which they’re applied. Instead, behaviors automatically generate a range
of values that are then applied to an object’s parameters, animating over the duration
of the behavior. Changing the parameters of a behavior alters the range of values that
behavior generates.

Keyframes, on the other hand, apply specific values directly to a parameter. When you
apply two or more keyframes with different values to a parameter, you animate that
parameter from the first keyframed value to the last.

By design, behaviors are most useful for creating generalized, ongoing motion effects.
They’re also extremely useful for creating animated effects that might be too complex
or time-consuming to keyframe manually. Keyframing, in turn, may be more useful for
creating specific animated effects where the parameter you’re adjusting is required to
hit a specific value at a specific time. For more information on using keyframes, see
Keyframes and Curves.

The animation created by behaviors can be converted into keyframes. For more
information, see Converting Behaviors to Keyframes.
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Browsing for Behaviors
All available behaviors appear in the Library tab. Selecting the Behaviors category in the
category pane of the sidebar reveals the behavior subcategories (text behaviors have
two categories).

Behaviors in the selected 
subcategory

Behavior subcategories

Library categories

Selecting a subcategory reveals all behaviors of that type in the Library stack.
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When you select a behavior in the Library stack, a short description and preview of the
behavior appear in the Preview area.

Note: To help you understand how each behavior works, the animated behavior previews
provide hints in the form of animation paths and color coding. While most previews are
self-explanatory, the Parameter previews show before/after examples of the behavior’s
effect on an animated object, with the gear graphic turning red to show the object after
the behavior takes effect. For Simulation behaviors, the red gear graphic identifies the
object in a group with the applied selected behavior.

Applying and Removing Behaviors
Behaviors are applied directly to objects in one of the following ways:

• Dragging a behavior directly to an object in the Canvas, Layers tab, or Timeline

To apply a behavior to an object in the Timeline, drag the behavior to the object in the
Timeline layers list or the Timeline track area.

Note: It is usually easier to drag a behavior to a camera or light in the Layers tab or
Timeline than directly to the object in the Canvas.

• Selecting an object, selecting a behavior in the Library, and then clicking the Apply
button in the Preview area

• Selecting an object, and then choosing a behavior from the Add Behavior pop-up menu
in the Toolbar

• Control-clicking a parameter of an object (including the parameters of other behaviors),
and choosing a Parameter behavior from the shortcut menu

Behaviors are removed by selecting the behavior in the Canvas, Layers tab, Timeline, or
Inspector and pressing Delete. For detailed information about applying and removing
behaviors, see Applying Behaviors and Removing Behaviors.
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Where Behaviors Appear
When you apply a behavior to an object, it appears nested underneath that object in the
Layers tab and in the Timeline.

Nested behaviors as they 
appear in the Layers tab

New behaviors you apply to an object appear above other behaviors that were applied
previously.

Parameter controls that let you adjust the attributes of a behavior appear in the Behaviors
tab of the Inspector.

Newly applied behaviors 
appear above those that 
have been previously 
applied. Behaviors appear 
with all of their editable 
parameters in the 
Behaviors tab of the 
Inspector.

A Behaviors icon also appears to the right of the object name in the Layers tab and
Timeline. Clicking this icon enables and disables all behaviors that have been applied to
that object.

Behaviors icon
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Note: Behaviors can be hidden from view in the Layers tab using the Show/Hide Behaviors
button in the lower-right corner of the Layers tab. For more information, see Hiding and
Showing Effects.

When any behavior is applied to an object in your project, a Behaviors icon (a gear)
appears in the Animation menu to the right of the affected parameter in the Properties,
Behaviors, or Filters tab where it’s applied. This icon shows you that a behavior is
influencing that parameter.

The Behaviors icon 
appears in the Animation 
menu of the affected 
parameter.

Animation Paths
When certain behaviors are applied to an object, an animation path appears and displays
the projected path of the object over time. Consider this path a “preview” of the animation
created by the behavior. Unlike animation paths created using keyframes or the path
created by the Motion Path behavior, animation paths for behaviors cannot be edited.
To show or hide all types of paths, use the View pop-up menu above the Canvas.

Behavior Effects in the Keyframe Editor
If you open the Keyframe Editor and look at a parameter that is affected by one or more
behaviors, you see a noneditable curve that represents the behavior’s effect on that
parameter. The noneditable curve appears in addition to that parameter’s editable curve,
which can be used to keyframe that parameter.

Editable curve Noneditable curve

Note: Use the Show pop-up menu in the Keyframe Editor to select which parameters are
displayed and to create curve sets. For more information on curve sets, see Custom
Parameter Sets.
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For more information on combining behaviors and keyframes, see Combining Behaviors
with Keyframes.

Applying Behaviors
You can apply behaviors directly to objects in the Canvas, Layers tab, or Timeline. Some
behaviors automatically animate specific parameters of the layer to which they’re applied.
For example, the Throw behavior affects only an object’s Position parameter, and the
Grow/Shrink behavior affects only an object’s Scale parameter. Other behaviors animate
the parameters of layers that surround the layer to which the behavior is applied. For
example, the Attractor behavior causes other layers to move toward the affected layer
by animating their Position parameter.

Important: Text, Particles, Replicator, Audio, Shape, and Camera behaviors should only
be applied to their namesake objects. The Grow/Shrink and Fade In/Fade Out behaviors
cannot be applied to cameras and lights.

With the exception of the Custom behavior, Parameter behaviors can also be applied to
a parameter of an object (such as position) in addition to the object itself. For more
information, see Applying Parameter Behaviors.

Note: The Create Layers At preference (in the Project pane of Motion Preferences), which
allows you to specify whether layers are created at frame 1, or at the current playhead
position, applies only to layers that are created or imported, such as text, shapes, or a
QuickTime movie file.

You can also apply behaviors directly to groups in the Layers tab or Timeline. Depending
on the applied behavior, all objects nested within that group are either affected as if they
were a single object or as individual elements. You can often change this result by
adjusting the Affect or Affect Subobjects parameter in the Behaviors tab of the Inspector.

Tip: If you do not see the expected result when applying behaviors to objects, try turning
the Affect Subobjects parameter on or off or choosing a different option from the Affect
pop-up menu. These parameters determine whether the entire group or its components
(such as the child objects nested within that group) are affected by the behavior and
how an object interacts with surrounding objects, respectively. The Affect Subobjects
checkbox only appears in the Inspector when the Throw and Spin behaviors, or the
Simulation behaviors, are applied to a group or object that contains multiple objects,
such as a particle emitter or text.

To apply a behavior to an object
Do one of the following:

µ Drag a behavior from the Library to an appropriate object in the Canvas, Layers tab, or
Timeline.

407Chapter 9 Using Behaviors



To apply a behavior to an object in the Timeline, drag the behavior to the object in the
Timeline layers list or the Timeline track area.

Note: It is usually easier to drag a behavior to a camera or light in the Layers tab or
Timeline than directly to the object in the Canvas.

An advantage to applying behaviors from the Library is the ability to preview the animation
created by the behavior in the Library Preview area.

µ Select an object in the Canvas, Layers tab, or Timeline, then select a behavior from the
Library stack and click Apply in the Preview area.

Apply button

µ Select an object in the Canvas, Layers tab, or Timeline, then click the Add Behavior icon
in the Toolbar and choose the behavior you want from the pop-up menu.

To apply a behavior to multiple objects
1 Select all of the objects to which you want to apply the behavior.

In the Layers tab, Canvas, or Timeline, Shift-click to select a contiguous set of objects, or
Command-click to select individual, noncontiguous objects.

2 Do one of the following:

• In the Toolbar, click the Add Behavior icon, then choose a behavior from one of the
submenus.

• Select a behavior in the Library, then click Apply in the Preview area.

3 Play the project to see the animated effect in action.

Important: Not all behaviors automatically create motion on an object. Some behaviors,
such as Throw, require you to set the throw velocity (in the HUD or in the Inspector)
before the object is “thrown.” Other behaviors, such as Orbit Around, require a source
object to act as the central object for other objects to move around.
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When a behavior is applied to an object, the object parameters affected by that behavior
are automatically animated based on the behavior’s default settings. For example, if you
apply the Gravity behavior to an object in the Canvas, that object’s position is animated
and it moves down, according to the Gravity behavior’s default setting.

Default Behavior Duration
In most cases, a behavior’s duration is the Timeline duration of the object to which it is
applied. For example, if you apply a Spin behavior to an object that begins at frame 20
and ends at frame 300, the Spin behavior’s duration is also frame 20 to frame 300. For
information on trimming the duration of a behavior, see Trimming Behaviors.

Removing Behaviors
Because behaviors don’t add keyframes, removing a behavior instantly eliminates its
animated effect. All types of behaviors are removed in the same way.

To remove a behavior from an object
1 Select a behavior in the Layers tab, Timeline, Behaviors tab, or pop-up menu in the title

bar of the HUD.

In this example, the 
Gravity behavior is 
selected in the Behaviors 
tab of the Inspector. 

2 Do one of the following:

• Choose Edit > Delete.

• Control-click the behavior in the Layers tab or Timeline, then choose Delete from the
shortcut menu.

• Press Delete.
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Applying Parameter Behaviors
Parameter behaviors function differently than other behaviors. All behaviors affect specific
parameters of an object—when a Spin behavior is applied to an image, the Rotation
parameter for that image is automatically affected; when a Fade In/Fade Out behavior is
applied to a clip, the Opacity parameter for that clip is automatically affected, and so on.
Parameter behaviors are applied to individual parameters of an object, camera, filter,
behavior, and so on, rather than to the object itself.

This includes the parameters of filters, emitters and cells in particle systems, shapes, text,
and so on. You can also apply Parameter behaviors to the parameters of other behaviors
that have been applied to an object.

In a simple comparison, a Throw behavior is applied to a text layer and the text travels
across the Canvas. The Throw behavior affects the Position parameter of the text layer.
If an Oscillate Parameter behavior is applied directly to the Position parameter of a shape,
that shape moves back and forth across the Canvas.

A Parameter behavior’s effect on an object depends on the parameter to which it is
applied. For example, if you apply the Randomize parameter behavior to a particle emitter’s
Position parameter, the emitter drifts around the screen when the project plays. Applying
the Randomize parameter behavior to a shape’s Scale parameter makes the shape
randomly grow and shrink.

Important: Although you can apply a Parameter behavior to an object using Library
behavior or the Add Behavior icon in the Toolbar, the applied behavior will not affect the
object until you select a parameter to which you want to apply the Parameter behavior.
A more direct way to apply a Parameter behavior is by using the shortcut menu in the
Inspector.

To apply a Parameter behavior to a specific parameter of an object
1 Select the object to which you want to apply the Parameter behavior.
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2 Do one of the following:

• Control-click a parameter in the Inspector, then choose a Parameter behavior from the
shortcut menu.

In this example, the 
Oscillate parameter 
behavior is applied to the 
Rotation parameter of a 
shape. 

• Control-click a parameter in the HUD, then choose a Parameter behavior from the
shortcut menu.

In this example, the 
Randomize parameter 
behavior is applied to the 
Feather parameter of a 
shape. 
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• Control-click a parameter in the Keyframe Editor, then choose a Parameter behavior
from the shortcut menu.

Once a Parameter behavior is applied to a parameter, the Inspector automatically opens
to the Behaviors tab.

Note: Use the Show pop-up menu to choose the parameters you want displayed in
the Keyframe Editor. For more information, see Filtering the Parameter List.

To apply a Parameter behavior to an object
1 Do one of the following:

• Drag a Parameter behavior from the Library to an appropriate object in the Canvas,
Layers tab, or Timeline.

Note: It is usually easier to drag a behavior to a camera or light in the Layers tab or
Timeline than directly to the object in the Canvas.

• Select an object in the Canvas, Layers tab, or Timeline, then click the Add Behavior icon
in the Toolbar and choose an item from the Parameter submenu.

The behavior is applied to the object, but no parameter is assigned to the behavior.

2 To assign a specific parameter to the Parameter behavior, do one of the following:

• Select the Parameter behavior, then choose a parameter from the Apply To (Go) pop-up
menu in the HUD.

In this example,
the Randomize 
parameter behavior is 
applied to the
Opacity parameter
of a shape.

• Select the Parameter behavior, then choose a Parameter behavior from the Apply To
(Go) pop-up menu in the Behaviors tab of the Inspector.

Once assigned, the parameter to which the behavior is applied appears in the Apply To
text field.

Note: If you save a Parameter behavior as a favorite, its parameter assignment is saved
along with the rest of that behavior’s settings. As a result, it can be applied like any other
behavior and that new object’s parameter is automatically affected.
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Where Parameter Behaviors Appear
Like other behaviors, Parameter behaviors appear nested underneath the objects to which
they’re applied in the Layers tab and the Timeline, along with any other behaviors that
have been applied to that object.

Note: Although a Parameter behaviors appear nested under objects in the Layers tab,
keep in mind that each Parameter behavior is applied to a single parameter of an object,
and not the object itself.

Notice that the Parameter behavior icon includes an image similar to a funnel. The funnel
represents the “channeling” of individual parameters.

Parameter behavior

Parameter behavior
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Opening a parameter’s Animation menu in the Inspector displays the names of all the
behaviors currently applied to that parameter. Choosing one automatically opens that
item’s Behaviors tab.

In this example, the 
Oscillate and Randomize 
Parameter behaviors are 
affecting the Size 
parameter of the 
Crystallize filter.

Like all other behaviors, when a Parameter behavior is applied to an object in your project,
a Behaviors icon appears in the Animation menu of the affected parameter in the
Properties, Behaviors, or Filters tab where it is applied, as well as in the Animation menu
of each affected parameter in the Keyframe Editor.

Reassigning a Parameter Behavior to Another Parameter
Once you apply a Parameter behavior, it remains assigned to that parameter unless you
reassign it. This is possible using the Apply To (Go) pop-up menu, located at the bottom
of the Parameter behavior controls in the HUD or Behaviors tab.

The Apply To (Go) pop-up menu displays all of the properties available for the object to
which the behavior is applied. If an object has other behaviors or filters applied to it,
those parameters also appear within submenus of the Apply To (Go) pop-up menu.

To reassign a Parameter behavior to another parameter in the HUD
1 In the Layers tab, Timeline, or Behaviors tab of the Inspector, select the Parameter behavior

you want to reassign.

2 In the HUD, choose a new parameter from the Apply To (Go) pop-up menu.

The Parameter behavior is applied to the newly chosen parameter and the Apply To field
is updated to reflect the new assignment. In the Inspector, the Behaviors icon now appears
next to the new parameter.

To reassign a Parameter behavior to another parameter in the Inspector
1 Select the object containing the Parameter behavior you want to reassign.
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2 In the Behaviors tab of the Inspector, choose a new parameter from the Apply To (Go)
pop-up menu.

Modifying Behaviors
Each behavior has a subset (or sometimes a complete set) of parameters that appear in
the HUD. In addition, all behavior parameters appear in the Behaviors tab of the Inspector.
Both the HUD and the Behaviors tab reference the same parameters, so changing a
parameter in one automatically changes the same parameter in the other.

Modifying Parameters in the HUD
In general, the parameters that appear in the HUD are the most essential for modifying
that behavior’s effect. Frequently, the controls available in a behavior’s HUD are also more
descriptive and easier to use than those in the Behaviors tab, although the Behaviors tab
may contain more controls. For example, compare the controls for the Fade In/Fade Out
behavior in the Behaviors tab to those available in the HUD:
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As you can see, the controls in the HUD consolidate two of the parameters available in
the Behaviors tab into a single, graphical control. There are times, however, when it may
be more desirable to use a behavior’s individual parameters to finesse the effect you’re
trying to achieve with greater detail, including the ability to enter specific parameter
values.

To display the HUD for a behavior
1 Do one of the following:

• Select the behavior you want to modify in the Layers tab, Timeline, or Behaviors tab of
the Inspector.

• Control-click an object in the Canvas, then choose a behavior from the Behaviors
submenu in the shortcut menu.

Note: If the HUD doesn’t appear, you may need to choose Window > Show HUD (or
press F7 or D).

2 Make adjustments to the behavior using the controls in the HUD.

To cycle through the HUDs of an object
Do one of the following:

µ Click the disclosure triangle in the title bar of the HUD (to the right of the title) to open
a pop-up menu that displays all of the behaviors and filters that are applied to that object.
Choose an item from this list to display its HUD.

Click the disclosure 
triangle and select a 
behavior or filter to 
display the respective 
HUD. 

µ Select an object in the Canvas, then press D to cycle forward through all available HUDs
for that object. To cycle in reverse, press Shift-D.

Modifying Parameters in the Behaviors Tab of the Inspector
The Behaviors tab of the Inspector displays every behavior that’s applied to the selected
object. A disclosure triangle to the left of each behavior’s name reveals all of that behavior’s
parameters. Unlike the HUD, the Behaviors tab displays every parameter for a behavior.

To display the Behaviors tab
1 Select an object with an applied behavior.
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2 Open the Inspector, then click the Behaviors tab.

All of the applied behaviors appear in the tab.

Modifying Multiple Behaviors Simultaneously
In most cases, you can modify the parameters of most behaviors of the same type at the
same time.

Note: The behaviors must be the same (such as two Throw behaviors) and they must
be applied to separate objects.

To edit multiple behaviors at the same time
1 In the Layers tab or the Behaviors tab of the Inspector, Command-select the behaviors

(of the same type) that you want to modify.

2 Do one of the following:

• In the HUD titled “Multiple Selection,” adjust the parameters.

• In the Behaviors tab of the Inspector, adjust the parameters.

Only behaviors that apply are available. Once you adjust the parameters, all of the
selected behaviors are modified.

Working with Behaviors
This section describes how to enable, rename, lock, duplicate, move, and reorganize
behaviors in your project. These procedures apply to every type of behavior.

Behaviors Controls in the Layers Tab and Timeline
When you apply a behavior to an object, the behavior appears in three different
places—the Layers tab, the Timeline, and the Behaviors tab of the Inspector.

While the Behaviors tab in the Inspector contains all of the editable parameters for a
behavior that’s been applied to an object, the Layers tab and Timeline have several
controls for each behavior:

Activation checkbox: Turns each individual behavior on or off. Behaviors that are turned
off have no effect on the object to which they’re applied.

Name: Double-click this field to rename the behavior.
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Lock: Click the lock icon to lock or unlock a behavior. You cannot modify the parameters
of a locked behavior.

Activation checkbox Name

Enable/disable behaviors

Lock

Enable/disable behaviors: A Behaviors icon (a gear) appears to the right of the name of
each object with one or more behaviors applied to it. Clicking this icon turns all behaviors
applied to that object on and off.

Behaviors currently 
disabled

Note: Control-clicking the Behaviors icon opens a shortcut menu that displays all the
behaviors that are applied to that object. Choose a behavior from this menu to display
it in the Inspector.

Control-click the 
Behaviors icon and 
choose a behavior to 
display it in the Inspector.

Show/Hide Behaviors button: Located at the bottom of the Layers tab and Timeline,
this button lets you show or hide all behaviors. This button neither enables nor disables
behaviors that have been applied to objects in your project; it only controls their visibility.

Show Behaviors button is 
enabled.
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Copying, Pasting, and Moving Behaviors
After you have added behaviors to an object, there are a number of ways you can copy
and move them among the other items in the Timeline or Layers tab.

Behaviors can be cut, copied, and pasted like any other item in Motion. When you cut or
copy a behavior in the Timeline or Layers tab, you also copy the current state of all that
behavior’s parameters.

To cut or copy a behavior
1 Select a behavior.

2 Do one of the following:

• Choose Edit > Cut (or press Command-X) to remove the behavior and place it on the
Clipboard.

• Choose Edit > Copy (or press Command-C) to leave the behavior there and copy it to
the Clipboard.

To paste a behavior
1 Select an object onto which you want to Paste the behavior.

2 Choose Edit > Paste (or press Command-V).

The cut or copied behavior is applied to the selected object, with all its parameter settings
intact.

You can also move a behavior from one object to another in the Layers tab or Timeline
layers list by simply dragging it to a new position.

To transfer a behavior from one object to another
µ In the Layers tab or Timeline layers list, drag a behavior from one object and drop it on

top of another.
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Note: If you move a Parameter behavior to another object, it is applied to the same
parameter it affected in the previous object—as long as the corresponding parameter
exists. If the parameter does not exist, the parameter assignment (Apply To field) is set
to none.

Dragging a behavior 
from one object to 

another

You can also duplicate a behavior in place.

To duplicate a behavior
1 Select the behavior you want to duplicate.

2 Do one of the following:

• Choose Edit > Duplicate (or press Command-D).

• Control-click the behavior you want to duplicate, then choose Duplicate from the
shortcut menu.

You can also duplicate a behavior and apply the duplicate to another object in the Layers
tab or Timeline layers list.

To drag a duplicate of a behavior to another object
µ Option-drag the behavior to the object to which you want to apply the duplicated

behavior.

The duplicated behavior is applied to the second object, and the original behavior is left
in its original location.

When you duplicate an object, you also duplicate all behaviors that have been applied
to it. This way, if you’re creating a project with a number of objects that all need to use
the same behavior, you can simply apply that behavior to the first instance of that object,
and then duplicate that object as many times as necessary.
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Applying Multiple Behaviors to an Object
There is no limit to the number of behaviors you can add to an object. When multiple
behaviors are applied to a single object, they all work together to create a final animated
effect.

In general, each behavior applies a value to a specific parameter. The values generated
by all behaviors that affect the same parameters are combined to create the end result.
For example, if you apply the Throw, Spin, and Gravity behaviors to a single object, the
Throw and Gravity behaviors combine to affect the position of the object. The Spin
behavior affects the rotation of the object.

Behavior Order of Operations
When combining different behavior types (such as Parameter and Simulation behaviors),
or combining behaviors and keyframes, it is important to understand the behaviors’ order
of operations. Motion evaluates behaviors and keyframe in the following order:

Keyframes > Simulation behaviors > All other behaviors

Important: The order of operation is always in effect—regardless of the order in which
the behaviors are applied or the keyframes are added to a layer or group.

Use the following guidelines for animating layers with multiple behaviors and/or keyframes:

• When you animate a layer with keyframes and then apply a behavior, the effect of the
keyframes is evaluated first.

For example, if you animate the Rotation parameter of a layer using keyframes and
then apply a Rotational Drag (Simulation) behavior to the layer, the Rotational Drag
behavior slows the rotation of the layer. Motion is evaluating the keyframed rotation,
and then applying the drag (from the Simulation behavior) to the keyframed animation.

• When you animate a layer with any behavior, and then add keyframes, the effect of
the keyframes is evaluated first.

For example, if you animate a layer so that it rotates in a clockwise direction using the
Spin behavior and then keyframe the Rotation parameter so that the layer rotates in a
counterclockwise direction, the layer rotates in the counterclockwise direction. Although
the keyframes are added to the project after the Spin behavior, Motion evaluates the
keyframes first.

• When you animate a layer with a Simulation behavior and then apply another behavior,
the effect of the Simulation behavior is evaluated first.
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For example, if you animate a layer using the Gravity (Simulation) behavior and then
apply a Throw (Basic Motion) behavior, the layer moves downward as specified by the
Gravity behavior and in the direction specified in the Throw behavior. Motion is applying
the value of the Throw behavior to the value of the Gravity behavior, creating the end
result.

• When you animate a layer with a behavior and then apply a Simulation behavior, the
Simulation behavior is evaluated before the first behavior (and may have no effect).

For example, if you animate the Rotation parameter of a layer using the Oscillate
(Parameter) behavior and then apply a Rotational Drag (Simulation) behavior to the
layer, the layer oscillates, but is not slowed by the Rotational Drag behavior. Motion is
evaluating the Simulation behavior (Rotational Drag) before the Parameter behavior
(Oscillate), applying the drag to a 0 value. There is no data for the Simulation behavior
to affect.

Note: Although the Spin behavior appears in the Basic Motion category, Spin is treated
as a Simulation behavior in Motion’s order of operations.

For information on combining keyframes with behaviors, see Combining Behaviors with
Keyframes.

Reordering Behaviors
When you apply a number of behaviors to a single object, they all appear nested beneath
that object in the Timeline and Layers tab. You can change the order in which they are
applied; however, because behaviors combine according to the order of operations rather
than by their order in the Layers tab, reordering is generally useful only as an organizational
tool. One notable exception to this is the Stop behavior. It suspends the activity of all
behaviors appearing beneath it that affect the same parameter, while not affecting any
behaviors above it in the Layers tab.

To reorder a behavior
1 Drag the behavior you want to reorder up or down in the list of nested behaviors applied

to the same object.

A position indicator shows where the behavior appears when you release the mouse
button.

A position indicator 
appears whenever you 
drag a behavior within 
the list.

2 When the position indicator is in the correct position, release the mouse button.
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Note: Motion has a specific order of operations for keyframes and behaviors. For more
information, see Behavior Order of Operations.

Changing the Timing of Behaviors
You can change a behavior’s timing to control when it starts, how long it lasts, and when
it stops. There are several ways to do this. You can use the Stop Parameter behavior to
suspend one or more behavior’s effects on a single parameter. You can also trim each
behavior in the Timeline. Finally, for some behaviors, you can change the Start Offset
parameter to delay their beginning, and you can change the End Offset to stop the
behaviors prior to the end of their object duration in the Timeline. These behaviors include
Fade In/Fade Out, Grow/Shrink, and Snap Alignment to Motion.

Using the Stop Behavior
The easiest way to control behavior timing is to use the Stop behavior (in the Parameter
category). The Stop behavior halts the animation occurring in any one parameter, whether
the animation is based on keyframes in the Keyframe Editor or behaviors that have been
applied to that object.

As explained in Applying Parameter Behaviors, all Parameter behaviors can be applied
directly to a parameter of an object (such as opacity or position) or directly to an object
(such as text or an image). If the behavior is applied directly to an object, a parameter
must be explicitly assigned to the behavior (in the Behaviors tab of the Inspector).

To stop a parameter from animating
1 Move the playhead to the frame where you want animation to stop.

2 Select the affected object, then open the Properties tab in the Inspector.

3 Control-click the parameter you want to stop, then choose Stop from the shortcut menu.

The parameter is animated until the frame at which the Stop behavior begins.

Note: When applied in this manner, the Stop behavior takes effect at the current frame
(regardless of the Create Layers At Preference setting).

4 To assign the Stop behavior to a different parameter, choose a new parameter from the
Apply To (Go) pop-up menu.

The Stop behavior halts the animation of all behaviors that affect the selected parameter
of that object. For example, if the Gravity, Edge Collision, and Rotate behaviors are applied
to a shape and you apply the Stop parameter to the shape layer’s Position parameter,
the shape stops moving but continues rotating.

To control when animation affecting that parameter is stopped, trim the Stop behavior
in the Timeline. For more information on trimming behaviors, see the next section on
Trimming Behaviors.
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For more information about applying Parameter behaviors, see Applying Parameter
Behaviors.

Trimming Behaviors
When you apply a behavior to an object, the duration of the behavior in the Timeline
defaults to the duration of the object to which it’s applied.

The default duration of a 
behavior matches the 
duration of the object to 
which it is applied.

A behavior can be modified to limit the duration of its effect. For example, if you apply
the Spin behavior to a replicator layer, by default that replicator spins around for its entire
duration. If you trim the Out point of the Spin behavior, the spinning stops at the new
position of the Out point.

A tooltip indicates the 
new position of the Out 
point.

To change the duration of a behavior in the Timeline
1 Move the pointer to the In or Out point of any behavior in the Timeline.

2 When the pointer changes to the trim pointer, do one of the following:

• Drag the In point to delay the beginning of the behavior’s effect.

• Drag the Out point to end the behavior’s effect prior to the end of the object.

Note: When you drag the In or Out point of a behavior, a tooltip appears and displays
the new location and duration of the In or Out point.
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Trimming the Out point of a behavior often sets the object to its original state beyond
the Out point behavior. For many behaviors, using the Stop behavior to pause the object’s
animation is a more efficient method than trimming its Out point. Another way to stop
a behavior’s effect and leave the affected object in the transformed state is to adjust a
behavior’s Start and End Offset parameters. See Changing the Offset of Parameter
Behaviors for more information.

Note: The Simulation behaviors do not leave the object at the transformed state after
the last frame of the trimmed behavior. For more information, see Controlling Simulation
Behaviors.

Controlling Simulation Behaviors
Keep in mind that the ideal use for behaviors (with the exception of the Motion Tracking
behaviors) is creating fluid motion graphics that do not require specific timing. This is
especially true with the Simulation behavior group, which allows you to create some very
sophisticated interactions among multiple objects in your project with minimal editing.

Unlike Basic Motion behaviors, you cannot stop or change the motion of a Simulation
behavior in the Timeline. However, you can affect the rate of a Simulation behavior by
modifying its duration in the Timeline. You can also change the starting frame of the
behavior.

But because the Simulation behaviors simulate natural effects, such as Gravity, the laws
of inertia apply—an external force set the object in motion, and that object stays in
motion even once the active force is no longer present. Changing the duration of a
Timeline bar for a Simulation behavior does stop the “active” force on the object, but
does not stop the motion of the object. You can, of course, control Simulation behaviors
by modifying their parameters.

In the following image, the Orbit Around (Simulation) behavior is applied to the large
circle. The center text is assigned as the object that the circle moves around. The red
animation path represents the motion the circle travels over its duration. The Orbit Around
behavior is the same duration (300 frames) as the large circle to which it is applied.

Animation path

Behavior and object are 
the same duration
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In the next image, the Orbit Around behavior is trimmed in the Timeline to a shorter
duration (190 frames) than the object to which it is applied. Notice the change in the
shape of the animation path: At frame 190, where the Orbit Around behavior ends, the
object (the circle shape) stops moving around its target and continues moving off the
Canvas. The Orbit Around behavior—the active force—is no longer present, but the
motion of the circle does not stop.

Moving Behaviors in Time
In addition to changing a behavior’s duration, you can also move its position in the
Timeline relative to the object under which it’s nested. This lets you set the frame at which
that behavior begins to take effect.

To move a behavior in the Timeline
1 Click anywhere within the middle of a behavior’s bar in the Timeline.

2 Drag the behavior to the left or right to move it to another position in the Timeline.

As you move the bar, a tooltip appears and displays the new In and Out points for the
behavior. The tooltip also displays the delta value, which shows the number of frames
you have moved the bar.

Changing the Offset of Parameter Behaviors
Certain Parameter behaviors have two additional parameters, Start Offset and End Offset,
which are used to change the frame where a parameter behavior’s effect begins and
ends.

The Start Offset parameter has a slider that lets you delay the beginning of the behavior’s
effect, relative to the first frame of its position in the Timeline. You can adjust this
parameter to make the Parameter behavior start later.
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The End Offset parameter lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline. Using this slider to stop the effect, instead of
trimming the end of the behavior in the Timeline, lets you freeze the behavior’s effect
on the object for its remaining duration.

The following example illustrates how to use the Start Offset and End Offset parameters
with the Ramp behavior.

To use the Start Offset and End Offset parameters
1 Select an object, such as a shape.

2 In the Properties tab of the Inspector, Control-click the Scale parameter, then choose
Ramp from the shortcut menu.

The Ramp behavior is applied to the Scale parameter of the object, and the Behaviors
tab is displayed. The Ramp behavior lets you create a gradual transition in any animateable
parameter.

3 Set the Start Value to 0 and the End Value to 200, then play the project.

The object scales from its original scale to twice its original size over the duration of the
object.

4 Set the Start Offset to 90 and the End Offset to 90.

The object does not begin scaling until frame 90, and stops scaling 90 frames from its
last frame in the Timeline.

Combining Behaviors with Keyframes
Any object can have both behaviors and keyframes applied to it simultaneously. When
this happens, the values generated by the behavior and the keyframed values that are
applied to the parameter itself are combined to yield the final value for that parameter.
This lets you combine the automatic convenience of behaviors with the direct control of
keyframing to achieve your final result.

Note: Motion has a specific order of operations for keyframes and behaviors. For more
information, see Behavior Order of Operations.
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For example, if you apply the Random Motion behavior to a shape, that shape might
weave around onscreen with a completely random animation path similar to the following:

Random animation path

If you turn the Random Motion behavior off temporarily and create an animation path
using keyframes, you can create a completely predictable and smooth movement.

Keyframed animation 
path

You can combine the two by turning the Random Motion behavior back on, with the end
result being an animation path that follows the general direction you want, but that has
enough random variation in it to make it interesting.

Random animation path 
combined with the 
keyframed animation 
path

While this example shows how you can combine behaviors and keyframes to create
animation paths, you can combine behaviors and keyframes for any parameter.
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Combining Behaviors and Keyframes in the Keyframe Editor
When you display a parameter that’s affected by a behavior in the Keyframe Editor, two
curves appear for that parameter. An uneditable curve in the background displays the
parameter as it is affected by the behavior. There are no keyframes over this first curve.
Superimposed over the curve displaying the behavior’s effect is the parameter’s editable
curve.

Behavior effect curveEditable curve

You can keyframe a parameter either before or after applying a behavior to the object
that affects it. When you keyframe a parameter that is already affected by a behavior, the
value of the keyframed curve is combined with the value generated by the behavior at
each frame, which either raises or lowers the resulting value displayed by the background
curve. The background curve doesn’t just display the behavior’s animated values, it
displays the sum of all values affecting that parameter.

Behavior curve is affected 
by the keyframes.
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Raising or lowering a keyframe in the Keyframe Editor also raises or lowers the background
curve, because the keyframe is modifying the values generated by the behavior.

Important: The value displayed in the Inspector for the affected parameter reflects the
final combined result of both keyframes and behaviors that are applied to that parameter.
Editing a parameter’s values directly in the Inspector only results in changes made to the
underlying parameter value, whether keyframed or not. This parameter value is then
combined with the behavior’s effect, yielding a final value that may differ from the value
you entered.

Moved keyframe

For more information on how to use keyframes in the Keyframe Editor, see Keyframes
and Curves.

Important: When you combine keyframes with multiple behaviors, the results can appear
to be unpredictable, depending on the combination of behaviors that are applied.
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You can convert the behaviors that are applied to all parameters of an object into
keyframes. Converting behaviors that have already been combined with keyframes turns
the sum of all behaviors and keyframes affecting that parameter into a thinned series of
keyframes (a curve with fewer keyframes). This results in a final animation curve that
closely replicates the shape of the background curve that appeared in the Keyframe
Editor. These keyframes can then be edited directly in the Keyframe Editor.

Before After converting to keyframes

For more information on converting behaviors into keyframes, see Converting Behaviors
to Keyframes.

Animating Behavior Parameters
You can animate most behavior parameters in order to change the parameter’s effect
over time. You can animate behavior parameters using Parameter behaviors, or by
keyframing them in the Keyframe Editor.
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Applying Parameter Behaviors to a Behavior
You can animate a behavior’s parameter by applying a Parameter behavior. For example,
you can apply the Oscillate Parameter behavior to the Drag parameter of the Orbit Around
behavior, then adjust the Start and End values to increase from 0 to 8 over time. This
results in the orbit of the object slowly decaying, causing the object to fall toward the
center of the orbit.

Object with Orbit Around parameter Oscillate Parameter behavior added to the Drag 
parameter of the Orbit Around behavior

For more information about adding Parameter behaviors, see Applying Parameter
Behaviors.

Keyframing Behaviors
If you need more control when animating a behavior’s parameters, you can use keyframes.
For example, you can keyframe the Drag parameter of the Orbit Around behavior to grow
and shrink the object’s orbit many times, creating a much more complex animation path.
Keyframing this animation path manually would be very difficult, but by keyframing a
single parameter within a single behavior, you can create this effect with ease.

Default Orbit Around behavior Default Orbit Around behavior with keyframed 
Drag parameter

For more information about keyframing parameters, see Animating Behaviors.
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Converting Behaviors to Keyframes
Behaviors are best suited for fluid effects in which precise timing is not a requirement.
However, there may be projects in which you want finite control over the animated effects
created with behaviors. If necessary, several of the behaviors can be baked into keyframes.
This means that the animation curves created by the behaviors (which have no keyframes)
can be converted into keyframed animation curves. You can then modify the keyframes
in the Keyframe Editor to meet more precise timing requirements.

Because many (though not all) behaviors affect shared object parameters, when you
convert a behavior to keyframes, all behaviors applied to the same object are also
converted into keyframes. The keyframes are applied to the individual parameters that
the behaviors originally affected. For example, the Gravity and Throw behaviors affect
Position, so you could not convert the Gravity behavior to keyframes without affecting
the Throw behavior. When behaviors that are applied to other objects affect the object
being converted (for example, the Attractor or Repel behavior), their effect is baked into
the object’s resulting keyframes value. The original behaviors remain applied to the other
objects, but the resulting effect is not doubled up as a result of the keyframes combining
with the behavior.

Note: You cannot convert many of the Simulation, Replicator, Particle, or Text behaviors
into keyframes. Simulation behaviors such as Vortex can affect the parameters of all
objects within a project, and baking such a behavior would create an overwhelming
amount of keyframes. Remember, the beauty of such behaviors is that they automatically
create very complex motion that would be too time-consuming to keyframe manually.

If a behavior (or an object with applied behaviors) can be baked, the Convert to Keyframes
command appears in the Object menu when the behavior or object is selected. If the
Convert to Keyframes command is dimmed, keyframes cannot be generated from the
behavior.

To convert behaviors to keyframes
1 Do one of the following:

• Select an object that has behaviors you want to convert.

• In the Inspector, select a behavior you want to convert.

2 Choose Object > Convert to Keyframes (or press Command-K).

A dialog prompts you to confirm the conversion to keyframes.

3 Click Convert.

All behaviors are converted into keyframes, which appear in the Keyframe Editor. The
entire animation of the object is converted into keyframes, even if some of the behaviors
fall outside of the object’s time range.

Note: You cannot selectively convert individual behaviors. The Convert to Keyframes
command converts all behaviors that are applied to an object at once.
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Saving and Sharing Custom Behaviors
You can save any object in Motion to the Library, including cameras, lights, customized
filters and behaviors, groups, and layers (customized particle systems, replicators, shapes,
and text). Objects animated with behaviors or keyframes can also be saved to the Library
and retain their animation when applied to another project.

Customized behaviors can be saved in an existing folder in the Library, such as the
Favorites category, or you can create a new folder within an existing category. Once a
behavior is placed into the Library, it can be added to a project like any other object in
the Library. Behaviors saved in the Library appear with a custom icon.

Note: Items that are saved to the Library appear in the Finder with a .molo extension
(“Motion Library object“). These items cannot be opened from the Finder.

You can save multiple objects to the Library as one file or multiple files. For example, if
you create an animation that uses multiple behaviors and you want to save the cumulative
effect of those behaviors, you can save all of the behaviors as one item in the Library.

Although you can save custom behaviors into the Behaviors category, it is generally
recommended that you save items that you use frequently in the Favorites category;
some Motion Library categories contain so many items that utilizing the Favorites or
Favorites Menu category may save you search time. Within the Favorites category, you
can create additional folders to assist you in better arranging your custom items.

Behaviors that are saved to the Favorites Menu category can be quickly applied to objects
using the Favorites menu.

You can also create new folders in existing categories. You can create a new folder in the
Favorites or Behaviors category. Folders created in the Behaviors category appear in the
Library sidebar. Folders created in the subcategories, such as the Basic Motion subcategory,
appear in the Library stack and not the sidebar.

To save a behavior to the Library
1 Open the Library and select the Favorites, Favorites Menu, or Behaviors category.

2 Drag the customized behavior you want to save from the Layers tab, Timeline, or Inspector
into the stack at the bottom of the Library.

When you save a customized behavior, it is saved in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/ folder.

Note: If a custom behavior is dragged to another subcategory, such as the Glow (Filters)
subcategory, it is automatically placed in the Behaviors category and the Behaviors
category becomes active.

To save multiple behaviors to the Library
1 Open the Library and select the Favorites, Favorites Menu, or Behaviors category.
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2 In the Layers tab, select all of the behaviors you want to save and drag them to the stack,
holding down the mouse button until a drop menu appears.

3 Choose “All in one file” or “Multiple files” from the drop menu, then release the mouse
button.

“All in one file” saves all the behaviors together. They are listed as one item in the Library.
“Multiple files” saves the behaviors as individual objects in the Library.

4 To name the file or files, do one of the following:

• Control-click the icon, choose Rename from the shortcut menu, then type a descriptive
name.

• Select the icon, click “Untitled,” then type a descriptive name.

Note: When you Control-click the icon, the Edit Description option becomes available.
This is a handy tool that allows you to enter custom notes about an item saved in the
Library. Once you choose Edit Description, enter your notes in the text field and click OK.

To create a new folder in the Behaviors, Favorites, or Favorites Menu category
1 Open the Library and select the Behaviors, Favorites, or Favorites Menu category.

2 Do one of the following:

• Click the New Folder button at the bottom of the window.

• Control-click an empty area of the Library stack (the lower section of the Library), then
choose New Folder from the shortcut menu.

Note: You may have to expand your stack window or use icon view to access an empty
area.

An untitled folder appears in the subcategories list in the Library sidebar.

3 With the new folder selected, click the name, type a new name, then press Return.

To create a new folder in a Behaviors subcategory
1 Open the Library and select a Behaviors subcategory, such as Basic Motion.

2 Do one of the following:

• Click the New Folder button at the bottom of the window.

• Control-click an empty area of the Library stack (the lower section of the Library), then
choose New Folder from the shortcut menu.

The new untitled folder appears in the Library stack. The new folder does not appear
in the Library sidebar.

3 With the new folder selected, click the name, type a new name, then press Return.
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To move a behavior to a custom folder in the Behaviors category
µ Drag the behavior to the new folder in the Library sidebar.

The custom preset is added to the new folder and to the All subcategory.

To move a behavior to a custom folder in a Behaviors subcategory
µ Drag the behavior to the new folder in the Behaviors subcategory in the Library stack.

The custom preset is added to the new folder and to the All subcategory.

Deleting Custom Behaviors
Custom behaviors can easily deleted from your system, if necessary.

To delete a custom behavior
µ In the Library stack, Control-click the custom behavior, then choose Move to Trash from

the shortcut menu.

To delete a custom folder from a subcategory in the Library stack
µ Control-click the folder in the Library stack, then choose Move to Trash from the shortcut

menu.

Note: You can also delete the folder from the Finder. The folder is stored in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/ folder.

Important: Deleting a custom object or folder cannot be undone.

To delete a custom folder from a category in the Library sidebar
µ In the Finder, navigate to the /Users/username/Library/Application

Support/Final Cut Studio/Motion/Library/ folder, Control-click the folder, then choose
Move to Trash from the shortcut menu.

Moving Behaviors Among Different Computers
Each customized behavior you drag into the Motion Library is saved as a separate file in
the /Users/username/Library/Application Support/Final Cut Studio/Motion/ folder on your
computer. For example, a saved custom behavior named My Motion Path in the Favorites
folder of the Library appears in the /Users/username/Library/Application
Support/Final Cut Studio/Motion/Library/Favorites/ folder.

Items that are saved to the Library appear in the Finder with a .molo extension (“Motion
Library object“). These items cannot be opened from the Finder.

436 Chapter 9 Using Behaviors



If you’ve created one or more custom behaviors that you rely upon, you may want to
move them to other computers that have Motion installed.

To copy a custom behavior to another computer
µ Copy one or more Motion custom preset files to that computer’s

/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/ folder.

Basic Motion Behaviors
Basic Motion behaviors animate specific parameters of the object to which they are
applied. Some affect position, while others affect scale, rotation, or opacity.

Note: To view examples of Basic Motion behavior workflows, see Behavior Examples.

Warning: Building consecutive Basic Motion behaviors or placing such a behavior before
or after the Camera Framing behavior can create unexpected results. These behaviors
can continue to affect the object even after the behavior ends, thus influencing the
subsequent behavior’s animation path. For example, If a Framing behavior was applied
after a Motion Path behavior, the residual effect of the Motion Path behavior would be
combined with the animation path generated by the Framing behavior, resulting in the
target object being framed improperly.

The following sections cover the Basic Motion behaviors:

• Fade In/Fade Out

• Grow/Shrink

• Motion Path

• Move

• Point At

• Snap Alignment to Motion

• Spin

• Throw

Fade In/Fade Out
Lets you dissolve into and out of any object. The Fade In/Fade Out behavior affects the
opacity of the object to which it is applied, fading from 0 percent opacity to 100 percent
opacity at the beginning of the object, and then back to 0 percent opacity at the end.
You can eliminate the fade-in or fade-out effect by setting the duration of either to
0 frames.

Note: This behavior is multiplicative. This means that the Fade In and Fade Out parameters
are multiplied by the object’s current opacity to produce the resulting level of transparency.
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The Fade In/Fade Out behavior is useful for introducing and removing elements you’re
animating in a project. For example, you could apply the Fade In/Fade Out behavior to
text that moves across the screen to make it fade into existence, and then fade away at
the end of its duration.

Note: Fade In/Fade Out behavior cannot be applied to a camera or light.

Parameters in the Inspector
Fade In Time: A slider defining the duration, in frames, over which the object fades in
from 0 to 100 percent opacity from the first frame of the object. A duration of 0 frames
results in a straight cut into the object, making it appear instantly.

Fade Out Time: A slider defining the duration, in frames, over which the object fades
out from 100 to 0 percent opacity from the last frame of the object. A duration of 0 frames
results in a straight cutaway from the object, making it disappear instantly.

Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative
to the first frame of its position in the Timeline. Adjust this parameter to make the behavior
start later. This parameter value is measured in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline, in frames. Adjust this parameter to make the
behavior stop before the actual end of the behavior in the Timeline. Use this slider to
offset the end of the Fade Out effect from the end of the object.

HUD Controls
The HUD lets you control the Fade In and Fade Out durations, equivalent to the Fade In
Time and Fade Out Time parameters in the Behaviors tab of the Inspector. Drag anywhere
within the shaded area of the Fade In or the Fade Out ramp to adjust their durations.

Note: Continue dragging beyond the limits of the graphical HUD control to extend the
durations of the Fade In or Fade Out.

Fade In

Fade Out

Grow/Shrink
Use the Grow/Shrink behavior to animate the scale of an object, enlarging or reducing
its size over time at a speed defined by either the Scale Rate or Scale To parameter. The
Grow/Shrink effect always begins at the object’s original size at the first frame of the
behavior.
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Note: The Grow/Shrink behavior cannot be applied to cameras or lights.

Tip: To scale particles over their lifetime, use the Scale Over Life particle behavior. For
more information, see Using Particles Behaviors.

Note: The vertical and horizontal growth rates can be set to independent values, for
asymmetrical effects.

The Grow/Shrink behavior is a good one to use with high-resolution graphics to zoom
into an image, such as a map or photograph. You can also combine this behavior with
the Throw or Wind behavior to pan across the image while zooming into it.

The Grow/Shrink behavior can also be used to emphasize or de-emphasize images in
your project. You can enlarge objects to make them the center of attention, or shrink an
object while introducing another to move the viewer’s eye to the new element.

Parameters in the Inspector
Increment: This pop-up menu lets you choose how the behavior’s effect progresses over
its duration in the Timeline. There are three options:

• Continuous Rate: This option uses the Scale Rate parameter to grow or shrink the object
by a steady number of pixels per second.

• Ramp to Final Value: This option grows or shrinks the object from its original size to
the specified percentage plus the original scale in the Scale To parameter. If the behavior
is shortened in the Timeline, the Grow/Shrink effect goes faster.

• Natural Scale: Enabled by default, this option uses an exponential curve to allow the
animation to progress slowly when the scale values are small and speed up when the
values are large. This creates the illusion that the scaling is occurring at a constant
speed.

Scale Rate/Scale To: Depending on the command chosen in the Increment pop-up menu,
the Scale Rate or Scale To parameter defines the speed and magnitude of the effect. This
parameter can be expanded to reveal X and Y subparameters by clicking the disclosure
triangle to the left. This lets you adjust the horizontal or vertical scale independently.

Curvature: This parameter lets you adjust the acceleration with which this behavior
transitions from the original to the final size. Higher Curvature values result in an easing
into and out of the effect, where the object slowly starts to change size, and this change
gradually speeds up as the behavior continues. Curvature does not affect the overall
duration of the effect since that is defined by the length of the behavior in the Timeline,
minus the End Offset.

Note: The Curvature parameter is not available when the Increment parameter is set to
Natural Scale.
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End Offset: A slider that lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline, in frames. Adjust this parameter to make the
behavior stop before the actual end of the behavior in the Timeline. Use this slider to
offset the end of the Grow/Shrink effect from the end of the object.

HUD Controls
The Grow/Shrink HUD consists of two rectangular regions. The first, a rectangle with a
dotted line, represents the original size of the object. The second is a solid rectangle that
represents the relative growth rate, and can be resized by dragging any of the borders.
Enlarge the box to grow the target object, or reduce the box to shrink it. A slider to the
right lets you adjust the scale of the HUD controls, increasing or decreasing the effect
the controls have over the object.

Scale Rate/Scale To 
parameter

Zoom level of the HUD 
control

Original size

Motion Path
The Motion Path behavior lets you create a 2D or 3D motion path for an object to follow.
When you first apply the Motion Path behavior, it defaults to an open spline—a straight
line defined by two points at the beginning and end of the motion path. You can also
choose from preset path shapes, such as a closed spline, loop, rectangle, or wave, or use
a shape to define a path. A shape used as the source for a motion path can be animated.

You can modify the motion path in 3D space so that an object travels on the path along
the path’s X, Y, and Z axes. For more information, see Adjusting a Motion Path in 3D
Space.
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The first point on the path is the position of the object in the Canvas at the first frame of
the behavior. Option-click anywhere on the path to add Bezier points, which allow you
to reshape the motion path by creating curves.

Motion path

Note: To show or hide the motion path, choose Show Overlays from the View pop-up
menu in the Status Bar. (The Animation Path option shows and hides the animation paths
of other behaviors.)

When you play the project, the object moves along the assigned path. The speed at which
the target object travels is defined by the duration of the behavior. Speed is also affected
by the Speed parameter, which lets you modify the object’s velocity—adding acceleration
and deceleration at the beginning and end of the behavior, for example. You can also
create a custom preset defining how the object travels along the path.

Note: When you switch between the different Path Shape options, the Inspector and the
HUD display parameters specific to the selected option.

The Motion Path behavior is an easy way to create predictable motion without having
to use the Keyframe Editor. It’s also a great way to create reusable motion paths that you
can save in the Library for future use.

When the Motion Path behavior is added to an object, the Adjust Item tool is automatically
selected, allowing you to modify the default path in the Canvas by adding points and
using the Bezier (or B-Spline) controls attached to each point to adjust each curve. You
can also move and resize preset motion path shapes, such as a rectangle or wave, in the
Canvas.
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Parameters in the Inspector
Path Shape: A pop-up menu that lets you define the shape of the path on which the
object travels.

• Open Spline: The default shape, a straight path defined by two points at the beginning
and end of the path. You can choose to work with Bezier or B-Spline control points.
Option-click (or double-click) anywhere on the path to add points.

Use the outer control 
points to resize the circle 
or rectangle motion path 
shape.

• Closed Spline: A closed path in which the last point is in the same location as the first
point. You can choose to work with Bezier or B-Spline control points. Option-click (or
double-click) anywhere on the path to add points.

• Circle: A simplified version of Closed Spline, in which the X radius or Y radius can be
adjusted to create a circle or an ellipse.

• Rectangle: A closed path in which the width and the height can be adjusted to create
a square or a rectangle.

• Wave: A wavy path (a sine wave) defined by two points, one at the beginning and one
at the end of the path, and controlled by the End Point, Amplitude, Frequency, Phase,
and Damping parameters.

• Geometry: The object travels along the edge of a shape or mask that is used as the
source for the path.

The motion path defined in the Shape Source 
image well

Shape layer used as the Shape Source
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Note: The Path Shape parameters work similarly to text on a path. For more information
about working with text on a path, see Working with Text on a Path.

Shape Type: When Path Shape is set to Open Spline or Closed Spline, this pop-up menu
allows you to choose one of two ways to manipulate the shape of the path: Bezier or
B-Spline.

• Bezier: Lets you manipulate the keyframe curve manually by dragging the handles.

Note: For more information about creating and adjusting Bezier curves, see Editing
Bezier Control Points.

• B-Spline: B-Splines are manipulated using only points—there are no tangent handles.
The points themselves do not lie on the surface of the shape. Instead, each B-Spline
control point is offset from the shape’s surface, pulling that section of the shape towards
itself as if it was a magnet, in order to create a curve. B-Splines are extremely
smooth—by default, there are no sharp angles in B-Spline shapes, although you can
create sharper curves, if necessary.

Note: For more information about working with B-Spline curves, see Editing B-Spline
Control Points.

Radius: When Circle is the defined path shape, this slider allows you to change the size
of the circular path. Click the disclosure triangle to individually adjust the X radius and Y
radius.

Note: When the Motion Path behavior is selected, you can also use the onscreen control
points to resize the circle. Press Shift to resize the X and Y radii uniformly.

Size: When Rectangle is the defined path shape, this slider allows you to change the size
of the rectangular path. Click the disclosure triangle to individually adjust the X scale and
Y scale.

Note: When the Motion Path behavior is selected, you can also use the onscreen control
points to resize the rectangle. Press Shift to resize the X and Y scales uniformly.

Offset: When Circle, Rectangle, or Geometry is the defined path shape, this slider lets
you specify where the object starts moving on the path.

End Points: When Wave is the defined path shape, this control sets the location of two
default points on the wave’s path. The end points can also be adjusted using the wave’s
onscreen controls (active by default when the Motion Path behavior is selected). Moving
the left end point moves the entire path; moving the right end point lengthens, shortens,
or angles the path.

Amplitude: When Wave is the defined path shape, this slider defines half the distance
from the highest point to the lowest point in the wave. Higher values result in more
extreme waves.

Frequency: When Wave is the defined path shape, this slider sets the number of waves.
Higher values result in more waves.
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Phase: When Wave is the defined path shape, this dial defines the degrees of the offset
of the waves from the start and end points of the path. When set to 0 degrees (default),
the wave begins and ends at half the distance from the highest point to the lowest point
in the wave. When set to 90 degrees, the wave begins and ends at the highest point in
the wave. When set to –90 degrees, the wave begins at the lowest point in the wave.
When set to 180 degrees, the waves are the same as 0 degrees, but inverted.

Damping: When Wave is the defined path shape, this slider progressively diminishes the
oscillation of the wave. Positive damping values diminish the wave forward (from left to
right); negative values diminish the wave backward (from right to left).

Wave shape Damping value set to 0 Damping value set to 3

Damping value set to –3

Attach to Shape: When Geometry is the defined path shape, this checkbox, when
activated, forces the motion path to follow the source shape at its original location. When
disabled, the motion path can exist in a location other than its source shape.

Note: When Attach to Shape is on, you cannot move the object to another location.
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To align the rotation of an object to match all changes made to its position along an
animation path, apply the Snap Alignment to Motion behavior. For more information,
see Snap Alignment to Motion.

Shape layer on path before Snap Alignment to 
Motion is applied

Shape layer on path after Snap Alignment to 
Motion is applied

Shape Source: When Geometry is the defined path shape, this image well defines the
object (shape or mask) to use as the motion path source.

• To: This pop-up menu, located to the right of the Shape Source image well, displays a
list of all objects in the current project that can be used as a shape source for the motion
path.

Direction: A pop-up menu that defines the object’s direction over the path. There are
two options:

• Forward: The object moves in a forward direction along the path (from the start point
to the end point, depending upon the Offset parameter).

• Reverse: The object moves in a backward direction along the path (from the end point
to the start point, depending upon the Offset parameter)

Note: The Offset parameter is available when Path Shape is set to Circle or Rectangle.

Speed: A pop-up menu that defines the object’s velocity from the first to the last point
in the motion path. There are eight choices:

• Constant: The object moves at a steady speed from the first to the last point on the
motion path.

• Ease In: The object starts at a slow speed, then reaches and maintains a steady speed
through the last point on the motion path.

• Ease Out: The object starts at a steady speed, then slows down as it gradually decelerates
to a stop at the last point of the motion path.

• Ease Both: The object slowly accelerates from the first point on the motion path, and
then slows down as it gradually decelerates to a stop at the last point of the motion
path.
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• Accelerate: The object moves along the path with increasing speed.

• Decelerate: The object moves along the path with decreasing speed.

• Natural: The speed in which the object moves over the path is determined by the
shape of the path. For example, if the path is a U-shape curve, the object moves faster
as it moves toward the low point of the U and slower as it moves up the edges.

• Custom: Custom allows you to define the movement of the object along its path by
setting keyframes for the object’s speed from 0 to 100 percent. In other words, you
determine the position of the object along the path in time.

Custom Speed: This parameter becomes available when Speed is set to Custom. You
can modify the Custom Speed velocity curve in the Keyframe Editor. You can keyframe
custom values to make an object, for example, travel forward to a specific percentage of
the path, then backward, then forward, and so on before it reaches the end of the
animation.

Apply Speed: When the Loops parameter is set to a value greater than 1, this pop-up
menu determines how the Speed parameter (velocity) is applied over the duration of the
behavior.

Note: Loops must be set to a value greater than 1 for the Apply Speed parameter to have
any effect.

• Once Per Loop: The velocity, as defined by the Speed parameter, is applied to each
cycle. For example, if Loops is set to 3 and Speed is set to Accelerate, the object
accelerates each time it travels over the path. The speed is applied to the entire duration,
ignoring the Loops setting.

• Over Entire Duration: The velocity, as defined by the Speed parameter, is applied one
time over the duration of the behavior. For example, if Loops is set to 3 and Speed is
set to Accelerate, the object accelerates the first time it travels over the path, but not
the second and third time.

Loops: Determines the number of times the object travels the motion path over the
duration of the behavior. For an object to travel its path more than once, or to “ping
pong,” Loops must be set to a value greater than 1.

End Condition: A pop-up menu that defines the behavior of the object once it reaches
the end of its motion path. There are two options:

• Repeat: The object travels the motion path the number of times defined by the Loop
parameter.

• Ping-Pong: The object moves along the path until it reaches the last point on the path,
then it moves backward to the first point on the path. The number of “ping pongs” is
defined by the Loops parameter.
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Control Points: This parameter becomes available when the path shape is Open Spline
or Closed Spline. Click the disclosure triangle to display the Position parameters for the
motion path control points. The first value field is X, the second value field is Y, and the
third value field is Z.

Note: You cannot apply Parameter behaviors to the control points.

HUD Controls
In the HUD, the following controls are always available: Path Shape, Shape Type, Direction,
Speed, Apply Speed (sets the number of times the object travels the path over the object’s
duration), and End Condition. Other parameters become available depending on what
is selected from the Path Shape parameter.

Related Behaviors
• Gravity

• Random Motion

• Throw

• Wind

Motion Path Tasks
The following tasks show you how to customize the Motion Path behavior.

Distancing the Object from the Motion Path
By default, the object is locked to the motion path by its anchor point.

To distance the object from the path
µ Select the Adjust Anchor Point tool from the Toolbar and move the anchor point in the

Canvas.

For more information on using the Adjust Anchor Point tool, see Using the Adjust Anchor
Point Tool.

Note: A separate Offset parameter allows you to offset the starting location of the object
on the motion path (it does not offset the object from the path itself ).
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Moving the Object and Its Motion Path
Moving an object automatically moves the object’s related motion path.

To move the object and its motion path
µ Select the object (not the Motion Path behavior), and move the object in the Canvas.

Using Geometry for a Motion Path Shape
The following section describes how to use geometry as the source for a motion path
shape. You can use a shape that is animated with behaviors or keyframes as the source
for a motion path. This includes animated transforms (a shape changing its location in
the Canvas) and animated control points (a shape changing its shape due to keyframed
control points).

To use geometry for a motion path shape
1 Import (or draw) the shape you want to use as the path source.

2 Choose Geometry from the Path Shape pop-up menu.

The Shape Source well appears in the Inspector and HUD.

3 From the Layers tab, drag the shape to the Shape Source well.

4 When the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the shape appears in the well and the shape is used as the source shape
for the motion path.

Note: You may want to disable the source shape in the Layers tab so that the source
shape is not visible in your project.

To select another geometry source for a motion path shape
µ Choose the object you want to use as the motion path’s shape source from the To pop-up

menu (located next to the Shape Source image well).

Use the To pop-up menu 
to choose another object 
in your project as the 
shape source for the 
motion path.

Note: To align the rotation of the object to the shape of its motion path, you can apply
the Snap Alignment to Motion behavior (in the Basic Motion behaviors subcategory).
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To use the Custom Speed parameter
1 In the Inspector or HUD, choose Custom from the Speed pop-up menu.

The Custom Speed parameter becomes available. By default, a keyframe is set at the first
and last points of the behavior to create an animation of 0 percent to 100 percent, where
at 0 the object is at the beginning of the path, and at 100 the object is at the end of the
path. This is the same velocity used with the Constant preset.

2 Enable Record (press A).

Note: When Record is enabled, all keyframeable parameter value fields are tinted. This is
to remind you that any value change entered in this state creates a keyframe.

3 Move the playhead to the position where you want to create a keyframe, then enter a
value in the Custom Speed field.

For example, a value of 90 moves the object 90 percent of the way through the motion
path.

4 Continue moving the playhead and adding keyframes to obtain the result you want.

Note: If you change the Speed parameter to a preset (such as Constant) after creating a
custom speed, the custom velocity channel is ignored but remains intact.

Adjusting a Motion Path in 3D Space
You can adjust a motion path in 3D space. The easiest way to modify a motion path in
3D space is to add a camera to your project and manipulate the path in a modified camera
view.

To adjust a motion path in 3D space
1 If there is no camera in your project, add a camera by doing one of the following:

• Click New Camera in the Toolbar.

• Choose Object > New Camera (or press Command-Option-C).

Note: If none of your project groups are set to 3D, a dialog appears asking you if you
want to switch your 2D groups to 3D groups. Click Switch to 3D to allow the camera
to affect the groups.

2 Do one of the following:

• Choose a camera view from the Camera pop-up menu in the upper-left corner of the
Canvas (the default option is Active Camera). This example uses the Top view.

• With the Active Camera (or other) view selected, use the Orbit tool (the center tool in
3D View tools in the upper-right corner of the Canvas) to rotate the camera.

Note: If you use the 3D View tools with any camera selected, you are moving the
camera, not just changing the camera view.
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Depending on the camera view, the object on the path may no longer be visible. For
example, if the object has not been rotated in X or Y space and you are working in Top
view, the camera is looking down perpendicularly (on the Y axis) on the object. The
motion path and its points are still visible (as long as the Motion Path behavior is
selected).

In the following image, the motion path appears flat when viewed from above—the
affected object only moves in X and Y space.

3 Drag a control point up or down to adjust the object in Z space.

In the following image, the path is no longer flat—the affected object moves in X, Y, and
Z space.

Note: The motion path onscreen controls are available for all camera views.

To enter specific values for the control point locations, click the Control Points disclosure
triangle in the Motion Path behavior parameters. The first value field is X, the second
value field is Y, and the third value field is Z.

4 To reset the camera view, do one of the following:

• Double-click the 3D View tool that you previously adjusted. For example, if you dragged
the Orbit tool to rotate the current camera, double-click the Orbit tool to reset the
camera.
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• If you chose (and/or modified) a default camera view (such as Top, Right, Left, and so
on), choose Active Camera from the Camera menu, or choose View > 3D View > Active
Camera.

• With the camera selected, click the reset button in the Properties tab of the Inspector.

Move
The Move behavior places a point in the Canvas that creates a specific location for an
object or group to move toward or away from.

In the following illustration, the center fish image has an applied Vortex behavior, causing
the outer turtle image to circle around the fish image.

In the next illustrations, the turtle image has an applied Move behavior. The Move target
(null object) is positioned in the center of the fish image. While the turtle image circles
about the fish image, it is also drawn to the center of the fish image.

Tip: The Move behavior is an ideal tool when working in 3D mode, as it allows you to
simulate camera movements without using a camera. For example, when applied to a
group that contains objects that are offset in Z space, you can create a dolly-like move.

Parameters in the Inspector
Position: Value fields that allow you to define the X, Y, and Z position of the target point.
The target (null object) is added to the center of the Canvas by default.

451Chapter 9 Using Behaviors



Note: The Move behavior and the Adjust Item tool in the Toolbar must be selected to
move the target. Use the Select/Transform tool to move the object.

Strength: A slider defining the speed at which the object moves toward the target. With
a value of 0, the object doesn’t move at all. The higher the value, the faster the object
moves.

Direction: A pop-up menu that sets whether the object moves toward the target point
or away from the point.

Speed: A pop-up menu that defines the object’s velocity from its position in the Canvas
to the position of the target. There are six choices:

• Constant: The object moves at a steady speed from its position toward the target.

• Ease In: The object starts at a slow speed, then reaches and maintains a steady speed
toward the target.

• Ease Out: The object starts at a steady speed, then slows down as it gradually decelerates
to a stop when it reaches the target.

• Ease Both: The object slowly accelerates and then slows down as it gradually decelerates
to a stop when it reaches the target.

• Accelerate: The object moves toward the target with increasing speed.

• Decelerate: The object moves toward the target with decreasing speed.

Note: To move the object more slowly toward its target, extend the duration of the
Move To behavior in the Timeline or mini-Timeline. To move the object faster, shorten
the duration of the behavior.

HUD Controls
The HUD has a slider that sets the influence amount (Strength), a Direction pop-up menu
that defines whether the object moves toward the null point or away from the point, and
a Speed pop-up menu that allows you to define the object’s velocity.

Point At
When the Point At behavior is applied to an object or group, you can specify a target
point for the affected object to turn toward.

Tip: Use the Point To behavior with the Move To behavior to created animated objects
that not only move toward a point (or each other), but that turn in the direction of the
target.

Parameters in the Inspector
Object: An image well that defines the target object. To set the target object, drag the
object from the Layers tab to the Object well in the Point At HUD or Inspector. You can
also drag the target object from the Layers tab onto the Point At behavior.
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Transition: This slider determines how long it takes for the object to go from its starting
orientation to pointing at the center of the target object. This parameter is useful when
the object is pointing at a moving target object.

If Transition is set to 50% in a 300-frame project, and the target object is not moving, the
point-at object takes 150 frames to point at (or orient to) the center of the target object
and then stops moving for the duration of the behavior. If Transition is set to 100%, the
point-at object takes the full 300 frames to point at the target object. If the Point At
behavior’s duration is 100 frames, and Transition is set to 50%, the point-at object takes
50 frames to orient to the target object.

If Transition is set to 50% in a 300-frame project, and the target object is animated, the
point-at object takes 150 frames to point at (or orient to) the center of the target object
and then continues following the animated target object for the duration of the behavior.
If Transition is set to 100%, the point-at object takes the full 300 frames to point at the
target object.

Speed: A pop-up menu that defines the object’s velocity from its position in the Canvas
to the position of the target. There are six choices:

• Constant: The object moves at a steady speed from its position toward the target.

• Ease In: The object starts at a slow speed, then reaches and maintains a steady speed
toward the target.

• Ease Out: The object starts at a steady speed, then slows down as it gradually decelerates
to a stop when it reaches the target.

• Ease Both: The object slowly accelerates and then slows down as it gradually decelerates
to a stop when it reaches the target.

• Accelerate: The object moves toward the target with increasing speed.

• Decelerate: The object moves toward the target with decreasing speed.

Axis: A pop-up menu that lets you align the rotation of the object to the X, Y, or Z axis.
The default axis is Z. This parameter specifies which axis points at the target once the
movement is complete.

Invert Axis: If the object is aligning on the correct axis, but appears backwards, this
checkbox flips the object so that it faces the proper direction.

HUD Controls
The HUD has an Object well, a Transition slider, a Speed pop-up menu that allows you
to define the object’s velocity, an Axis pop-up menu to choose which axis should point
at the target once the movement is complete, and an Invert Axis checkbox.
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Snap Alignment to Motion
This behavior aligns the rotation of an object to match all changes made to its position
along an animation path. This behavior is meant to be combined with behaviors that
animate the position of an object, or with a keyframed animation path you create yourself.

Before After, with Snap Alignment to Motion applied to 
arrow

For example, if you have a graphic of a fish to which you’ve applied the Motion Path
behavior, you can add the Snap Alignment to Motion behavior to make the fish point in
the direction it is moving.

Parameters in the Inspector
Rotation Axis: A pop-up menu that lets you rotate the object around the X, Y, or Z axis.
You can also choose All to rotate the object around all three axes. The default rotation
axis is Z. All uses the acceleration direction as “up,” like a roller coaster.

Axis: A pop-up menu that lets you specify whether the object aligns itself on its horizontal
or vertical axis.

Invert Axis: If the object is aligning on the correct axis, but appears backwards, this
checkbox flips the object so that it faces the proper direction.

End Offset: A slider that allows you to offset the end of the behavior’s effect relative to
the last frame of its position in the Timeline, in frames. For example, if End Offset is set
to 60, the object actively snaps to the direction of the path until 60 frames before the
end of behavior in the Timeline.

HUD Controls
The HUD has a pop-up menu to control the axis around which the object is rotated, a
pop-up menu to control the axis used to adjust the object’s alignment, and a checkbox
to let you invert the axis.

Related Behaviors
• Align To Motion
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Spin
Apply the Spin behavior to animate the rotation of an object, spinning it around a single
axis. Using the Custom axis controls, the rotation does not have to occur on a principle
axis (X, Y, or Z). If you trim the end of the Spin behavior to be shorter than the duration
of the object to which it is applied, it remains at the angle of the last frame of the behavior,
as long as there are no other behaviors or keyframes affecting that object’s Rotation
parameter.

Uses for Spin are fairly obvious, but another way to use the Spin behavior is with objects
that have an off-center anchor point. Because objects rotate around the anchor point, if
you change an object’s anchor point before you apply a Spin behavior to it, you can
quickly change the look of the motion you create. For more information on changing an
object’s anchor point, see Using the Adjust Anchor Point Tool.

Note: Although the Spin behavior appears in the Basic Motion category, Spin is treated
as a Simulation behavior in Motion’s order of operations. For more information, see
Behavior Order of Operations.

Parameters in the Inspector
Affect Subobjects: This parameter appears when Spin is applied to an object that contains
multiple objects, such as a group, particle emitter, or text. When this checkbox is selected,
each object within the layer or group rotates as an individual object. When this checkbox
is deselected, the entire layer or group spins.

Increment: This pop-up menu lets you choose how the behavior’s effect progresses over
its duration in the Timeline. There are two choices:

• Continuous Rate: Uses the Spin Rate parameter to spin the object by a steady number
of degrees per second.

• Ramp to Final Value: Spins the object for the number of degrees specified in the Spin
To parameter over the behavior’s duration in the Timeline.

Spin Rate/Spin To: A dial controlling the speed at which the object spins. When Increment
is set to Continuous Rate, the Spin Rate defines a continuous rate of spin in degrees per
second. When Increment is set to Ramp to Final Value, Spin To defines a number of
degrees to spin over that object’s duration. Negative values result in clockwise motion,
while positive values result in counterclockwise motion.
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Axis: A pop-up menu that allows you to choose whether the object spins about the X,
Y, or Z axis. You can also choose Custom, which yields additional Longitude and Latitude
parameters.

HUD showing axis set to the 
default Z

Axis set to X Axis set to Y

When Axis is set to Custom, additional Longitude and Latitude parameters become
available. These parameters allow the object to spin at an angle (not locked to the X, Y,
or Z axes).

Drag the axis control in 
the center of the circle to 
modify the longitude and 
latitude of the spin.
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The following image illustrates longitude and latitude.

Y

X

Z

Latitude

Longitude

• Latitude/Longitude: Available when Axis is set to Custom (or by dragging the center
control of the Spin HUD), these parameters allow you to specify the axis of rotation.

HUD Controls
The Spin behavior’s HUD controls include an outer ring and an inner control. Drag along
the edge of the outer ring to manipulate an arrow that indicates the direction and speed
the object spins. Adjust the length of the arrow to change the speed at which the spinning
occurs—drag around multiple times to increase the rate of the spin.

The inner arrow controls the axis about which the object or group spins. When you drag
the inner controls, a globe control becomes available that allows you to adjust the object’s
spin in degrees longitude and latitude.

Note: You can spin the arrow around the ring multiple times to rotate the object more
quickly.

Controls direction and 
speed of spin.
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Throw
The Throw behavior is the simplest way of setting an object in motion. Controls let you
adjust the speed and direction of a single force that’s exerted on the object at the first
frame of the behavior. After this initial force is applied, the object continues drifting in a
straight line at the same speed, for the duration of the Throw behavior.

A simple example of using the Throw behavior is to send a series of offscreen objects
moving across the screen. When used in conjunction with other behaviors such as
Grow/Shrink and Fade In/Fade Out, you can create sophisticated moving elements without
keyframing a single parameter.

The Throw behavior is also useful when you’re moving an object through a simulation.
For example, you might move the object past other objects that have Attractor or Repel
behaviors applied to them. Because the Throw behavior only applies a single force to
move the target object at the initial frame of the behavior, any other behaviors that
interact with the target object have potentially greater influence over its motion.

Important: The Throw behavior does not apply a continuous force, nor can you create
changes in direction or speed, since this behavior cannot be keyframed. If you need to
create keyframed changes in direction or speed, use the Wind behavior. If you need to
create a more complex animation path, use the Motion Path behavior.

Parameters in the Inspector
Affect Subobjects: This parameter appears when Throw is applied to an object that
contains multiple objects, such as a group, particle emitter, or text. When this checkbox
is selected, each object within the parent object moves as an individual object. When
this checkbox is deselected, the entire layer or group moves as a whole.

Increment: This pop-up menu lets you choose how the behavior’s effect progresses over
its duration in the Timeline. There are two choices:

• Continuous Rate: Sets the speed of the object at a steady number of pixels per second,
specified in the Throw Velocity parameter.

Note: If the Canvas is displaying a nonsquare pixel image, the vertical rate is in pixels
per second, and the horizontal rate is the perceptual equivalent.

• Ramp to Final Value: Moves the object from its original position to the specified distance
(in pixels) in the Throw Distance parameter.

Throw Velocity/Throw Distance: When the Increment pop-up menu is set to Continuous
Rate, the Throw Velocity parameter appears, which lets you set a continuous speed for
the object to move in X, Y, or Z space. When the Increment pop-up menu is set to Ramp
to Final Value, the Throw Distance parameter appears, which sets a total distance (in
pixels) for the object to travel in X, Y, and Z space over its duration. The slider is limited
to 100 pixels. Use the value field to enter values greater than 100.
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HUD Controls
The 2D HUD lets you specify the direction and speed of the Throw behavior by dragging
an arrow within a circular region. The direction of the arrow defines the direction of
movement in X and Y space, and the length of the arrow defines speed (velocity). A slider
to the right lets you adjust the scale of the HUD control, increasing or decreasing the
effect the direction/speed control has over the object.

Controls direction and 
speed of Throw.

Adjusts scale of the 
direction and speed 
control.

When you click the 3D button, additional 3D controls become available. The center arrow
now defines the direction the object is thrown in 3D space (X, Y, and Z axes). The Speed
slider (on the left side of the HUD) lets you increase or decrease the velocity of the thrown
object.

Adjusts velocity of the 
throw. 

Adjusts the direction of 
the throw in X, Y, and Z 
space.

In the 2D and 3D Throw HUDs, press the Shift key while dragging the arrow to constrain
it to 45 degree angles. In the 2D HUD, press the Command key to change the arrow’s
direction without affecting its length.

Note: The maximum speed you can define with the HUD is not the maximum possible
speed. Higher values can be entered into the Throw Velocity/Throw Distance parameter
in the Behaviors tab of the Inspector.

Related Behaviors
• Motion Path

• Gravity
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• Random Motion

• Wind

Parameter Behaviors
These behaviors can be applied to any object parameter that can be animated, and their
effects are limited to just that parameter. The same parameter behavior can be added to
different parameters, resulting in completely different effects. For example, you can apply
the Oscillate behavior to the opacity of an object to make it fade in and out, or you can
apply it to the rotation of an object to make it rock back and forth. You can also apply
parameter behaviors to filter parameters, generator parameters, the parameters of particle
systems, or even the parameters of other behaviors. Examples include Oscillate, Randomize,
and Reverse.

For more information on applying Parameter behaviors, see Applying Parameter Behaviors.

The following sections cover the Parameter behaviors:

• Audio

• Average

• Clamp

• Custom

• Exponential

• Link

• Logarithmic

• MIDI

• Negate

• Oscillate

• Quantize

• Ramp

• Randomize

• Rate

• Reverse

• Stop

• Track

• Wriggle
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Audio
This behavior allows you to animate nearly any parameter based on properties of an
audio file, such as bass frequency. For example, the Audio parameter behavior can be
applied to the Scale parameter of an object so that it scales up and down based on the
amplitude of the bass, or to the Opacity parameter so that it fades in and out to the beat.
For more information on using the Audio parameter behavior, see Audio Parameter
Behavior.

Average
This behavior smoothes the transition from one value to another caused by keyframes
and behaviors that are applied to a parameter. Use the Average behavior to smooth out
animated effects. Averaged motion moves more fluidly, while averaged changes to
parameters such as Opacity and to filter parameters appear to happen more gradually.
Use the Window Size parameter to adjust the amount by which to smooth the affected
parameter.

Tip: The Average behavior can be used to smooth out the sequence of values generated
by a Randomize behavior.

Parameters in the Inspector
Window Size: A slider lets you adjust the amount of smoothing to apply to the affected
parameter by specifying the number of adjacent frames to average together. Higher
values apply more smoothing by averaging a wider range of values, resulting in more
fluid animation. Lower values average a narrower range of values and apply less smoothing
with values that are closer to the original.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD lets you adjust the Window Size parameter and change the parameter
assignment.

Related Behaviors
• Negate

• Reverse

461Chapter 9 Using Behaviors



Clamp
This behavior allows you to define a minimum and maximum value for an animated
parameter. In the following illustration, the center image has an applied Vortex behavior.
The outer images circle around the center image, as indicated by the red animation path.

The red lines indicate the 
animation paths of the 
outer image.

In the following illustration, a Clamp behavior is applied to the X Position parameter of
the image at the top of the Canvas. The Max value is set to 230 and the Min value is set
to 0. The image travels 230 pixels to the right but does not move left past the 0 point,
creating a half-circle animation.

Notice that the circle motion path is essentially cut in half. If a negative value is entered
in the Min value field, the image moves past the 0 point.

Parameters in the Inspector
Clamp At: A pop-up menu in which you choose the option to clamp parameter values
at only the minimum, only the maximum, or both the minimum and maximum.

Min: A value slider that lets you define the minimum amount of change for an animated
parameter.

Max: A value slider that lets you define the maximum amount of change for an animated
parameter.

462 Chapter 9 Using Behaviors



The value is represented as a percentage, in pixels, or in degrees, depending on the
parameter assignment. For example, if Clamp is applied to the Rotation parameter, the
Min and Max values are degrees. If Clamp is applied to the X Position parameter, the
values are in pixels.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD lets you set the clamp to Min, Max, or Min and Max values, and also to change
the parameter assignment.

Related Behaviors
• Quantize

Custom
The Custom behavior allows you to make your own behaviors by creating a set of
parameters, then keyframing them to create the type of animation you want to apply to
an object. By saving custom behaviors you create in the Library, you can create your own
collection of behaviors to suit your needs.

Prior to creating a Custom behavior, you must first add the Custom behavior to an object
in the Canvas. The Custom behavior is added to an object like all other non-Parameter
behaviors in Motion.

Note: Although the Custom behavior is a Parameter behavior, it does not appear in the
shortcut menu when you Control-click a parameter.

Parameters in the Inspector
Unlike other behaviors, the Custom behavior doesn’t start out with any parameters in
the Behaviors tab. Instead, a pair of pop-up menus allows you to add and remove any
parameters you want to use.

Add Parameter: The Add Parameter pop-up menu allows you to add parameters that
you want to keyframe to create custom animation. Choose a parameter from this menu
to add it to the Custom parameter list for keyframing.

Remove Parameter: The Remove Parameter pop-up menu lists all the parameters you’ve
added to the current Custom behavior. Choose a parameter from this menu to remove
it from the Custom parameter list, along with any keyframes that are applied to that
parameter.
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HUD Controls
There are no HUD controls for this behavior.

Adding a Custom Behavior
Prior to creating a Custom behavior, you must first add the Custom behavior to an object
in the Canvas.

For more information on saving behaviors, see Saving and Sharing Custom Behaviors.

To add a Custom behavior to an object
Do one of the following:

µ Select the object to which you want to add a Custom behavior, click the Add Behavior
icon in the Toolbar, then choose Parameter > Custom from the pop-up menu.

µ In the Library, select the Behaviors category, select the Parameter subcategory, then drag
the Custom icon to the object in the Canvas, Layers tab, or Timeline.

The Custom behavior is applied to the object. The behavior has no effect until you add
a parameter to the behavior.

To add a parameter you want to animate in a Custom behavior
µ Choose a parameter you want to add to the Custom parameter list from the Add Parameter

pop-up menu. This menu contains every animateable parameter.

The parameter appears in the Behaviors tab below the Custom behavior.

The new parameter 
appears here.

Once you’ve added all the parameters you want to animate in your Custom behavior,
you can keyframe them in the Keyframe Editor to create whatever animated effect you
require. For more information on keyframing parameters to create animation, see
Animating Behaviors.
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To remove a parameter from the Custom parameter list
µ Choose the parameter you want to remove from the Remove Parameter list.

That parameter no longer appears in the Custom parameter list. Any keyframes that were
applied to that parameter are deleted.

Once you have animated all the parameters you added, you can save the Custom behavior
into the Library for future use. For more information about saving Custom behaviors to
the Library, see Saving and Sharing Custom Behaviors.

When you apply a Custom behavior that you’ve saved in the Library to an object in a
project, its keyframed animation is scaled to the duration of the object to which it is
applied. This means that no matter how long the original Custom behavior was, you can
apply it to any object, and the animated effect speeds up or slows down to accommodate
the new object’s duration.

Exponential
The Exponential parameter behavior creates more natural animations when scaling
objects, especially when using high values. For example, when an object scales from very
small to very large, the animation appears to slow down as the object reaches its upper
scale values. The Exponential parameter behavior works like the Ramp behavior, but
applies a mathematical function to create an exponential curve (rather than linear)
between the two values. This allows the animation to progress slowly when the scale
values are small and speed up when the scale values are large.

Tip: When applied to parameters other than Scale, the Exponential parameter behavior
creates more organic animations than other interpolation modes.

You can also change the interpolation modes of keyframes to Exponential. For more
information, see Modifying Curves.

Parameters in the Inspector
Start Value: The value that’s added to the parameter at the first frame of the Exponential
behavior.

End Value: The value the Exponential behavior reaches at the last frame of the behavior.
Over the life of the behavior, the parameter the Exponential behavior is applied to makes
a transition from the Start Value to the End Value plus the original value.
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Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative
to the first frame of its position in the Timeline. Adjust this parameter to make the behavior
start later. The units of this parameter are in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline, in frames. Adjust this parameter to make the
behavior stop before the actual end of the behavior in the Timeline. Using this slider to
stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the
end of the effect for the remaining duration of the object. Trimming the end of the
behavior resets the object to its original parameter.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD lets you set the start and end values and change the parameter assignment.

Related Behaviors
• Logarithmic

• Ramp

Link
The Link parameter behavior forces the value of one parameter to match that of another
“linked” parameter. The source behavior can be within the same object or from another
object. The linked parameters must contain numerical data. Parameters controlled by
checkboxes, menus, and other non-numeric values cannot be linked. The linked parameters
also must contain the same number of attributes. You cannot link a compound parameter
such as Scale X-Y-Z to a parameter such as Opacity which has only one slider. You can
however, link a compound parameter such as Scale X-Y-Z to Position X-Y-Z.
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The values of the source parameter can be scaled to more accurately apply to the
destination parameter, so for example a source parameter with a range of 1–100 can be
scaled when applied to a parameter with a range of 0 – 1. The values can also be offset
from the source, and the effect can be mixed with the destination value in a variety of
ways to create different resulting effects.

The Link behavior can be applied to parameters that have been animated with behaviors
or keyframes; however, it does not affect the parameter when the Start Values or End
Values are zero.

When using the Link behavior to control an object’s position parameter, the linked
coordinates are based on the center point of the current group. So when an object is
linked to another object within the same group, it will share an identical position. However,
if the source object is in a different group, the coordinates may appear offset in space.

If your goal is to match an identical position across groups with different center points,
you can create an invisible dummy object in the group containing the source, link it to
the source object, then use the Match Move behavior to copy the dummy object’s position
to that of the intended target. Match Move automatically compensates for inter-group
position offsets and provides the option to either attach one object to another or to
mimic the source object’s transformations. For more about Match Move, see Motion
Tracking Behaviors.

You can also link to the group’s coordinates instead of the object’s, and use the Offset
parameters in the Link behavior to obtain the position you want. However, if that group
is subsequently added to another group, the linked object may again not move as
expected.

Parameters in the Inspector
Source Object: The object in which the source parameter resides. Click the To pop-up
menu to select from the objects in the current project.

Source Parameter: The Source Parameter (Compatible Parameters) pop-up menu shows
the parameter that serves as the source for the Link behavior and can be used to select
a new source parameter. Only parameters with the same value type and number of
attributes as the parameter selected in the Apply To (Target Parameters) pop-up menu
appear here.

Note: When possible, this parameter will default to the identical parameter in the source
object as has been selected in the Apply To parameter.

Important: Changing the Apply To (Target Parameters) setting will change which
parameters appear in the Source Parameter (Compatible Parameters) pop-up menu. If
you cannot find the parameter you are looking for, you may need to first choose a Target
Parameter to which you can link.

467Chapter 9 Using Behaviors



Apply To: The Apply To (Target Parameters) pop-up menu shows the parameter being
affected and can be used to reassign the behavior to another parameter. Because only
certain parameters can be linked, you must set the Apply To parameter before eligible
parameters will appear in this pop-up menu.

Apply Mode: Pop-up menu to specify how the values from the source parameter affect
the target parameter. The choices include:

• Add to source: Choosing this option will add the source parameter value to the existing
value of the target parameter.

• Multiply by source: Choosing this option will multiply the source parameter value with
the existing value of the target parameter.

• Replace with source: Choosing this option will replace the existing value of the target
parameter with that of the source parameter.

Mix Over Time: Pop-up menu to set how rapidly the source parameter values begin to
affect the target parameter. Options include: Ease In, Ease Out, Ease In/Out, Accelerate,
Decelerate, Accel/Decelerate, and Custom Mix.

Mix Time Range: When the Mix Over Time is set to one of the Ease or Acceleration options,
this slider controls over how many frames the ease or acceleration occurs.

Tip: Ease In and Accelerate begin at the In point of the Link behavior, and Ease Out and
Decelerate end at the Out point of the Link behavior. Therefore, you can trim the Link
behavior in the timeline to specify where the ease or acceleration begins and/or ends.

Custom Mix: When the Mix Over Time parameter is set to Custom Mix, this slider can be
animated to create a user-determined mix between the source and target parameter
values.

Scale: Slider to specify a value to be multiplied with the Source parameter before it is
applied to the target.
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Apply Link When: Pop-up menu that enables you to limit when values from the source
are applied to the target. There are five choices:

• Any source value: When this item is selected, no limits are placed on the source
parameter values. An Offset slider for each setting associated with the source parameter
will appear at the bottom of the Behaviors tab. If the source parameter has a single
slider, such as Opacity, there will be a single offset slider. If the source parameter has
multiple sliders, such as Position X-Y-Z, there will be offset sliders for each of those
settings.

• Source value above minimum: When this item is selected, the link will apply only when
the source value exceeds a defined minimum value. If the source value falls below the
defined minimum, the link behavior will stop. When selected, the Clamp Source Values
Within Range checkbox as well as Offset and Minimum sliders for each setting associated
with the source parameter will appear at the bottom of the Behaviors tab. If the source
parameter has a single slider, such as drop shadow Blur, there will be an offset and a
minimum slider for that setting. If the source parameter has multiple sliders, such as
Scale X-Y-Z, there will be offset and minimum sliders for each of those settings.
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• Source value below maximum: When this item is selected, the link will apply only when
the source value stays below a defined maximum value. If the source value exceeds
the defined maximum, the link behavior will stop. When selected, the Clamp Source
Values Within Range checkbox as well as offset and maximum sliders for each setting
associated with the source parameter will appear at the bottom of the Behaviors tab.
If the source parameter has a single slider, such as shape Roundness, there will be an
offset and a maximum slider for that setting. If the source parameter has multiple sliders,
such as Rotation X-Y-Z, there will be offset and maximum sliders for each of those
settings.
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• Source value between min and max: When this item is selected, the link will apply only
when the source value stays within a defined range. If the source value falls below the
defined minimum, or exceeds the defined maximum, the link behavior will stop. When
selected, the Clamp Source Values Within Range checkbox as well as offset, minimum,
and maximum sliders for each setting associated with the source parameter will appear
at the bottom of the Behaviors tab. If the source parameter has a single slider, such as
shape Feather, there will be one set of three sliders (offset, minimum, and maximum)
for that setting. If the source parameter has multiple sliders, such as Fill Color (red,
green, blue), there will be sets of three sliders for each of those settings.
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• Source value outside min and max: When this item is selected, the link will apply only
when the source value stays outside of a defined range. If the source value falls above
the defined minimum, or below the defined maximum, the link behavior will stop.
When selected, the Clamp Source Values Within Range checkbox as well as offset,
minimum, and maximum sliders for each setting associated with the source parameter
will appear at the bottom of the Behaviors tab. If the source parameter has a single
slider, such as Outline Width, there will be one set of three sliders (offset, minimum
and maximum) for that setting. If the source parameter has multiple sliders, such as
Shear X-Y, there will be sets of three sliders for each of those settings.

Clamp Source Value Within Range: This checkbox becomes available when the Apply
Link pop-up menu is set to a choice requiring a minimum or maximum value. When
selected, values that exceed the defined range will be pinned to the highest or lowest
allowable setting.

(Parameter) offset: This slider allows you to create a constant offset between the source
parameter value and the value applied to the target parameter.

(Parameter) min: When the Apply Link When pop-up menu is set to “Source value above
minimum,” “Source value between min and max,” or “Source value outside min and max,”
a “min” slider appears for each component of the source parameter. Adjusting this slider
defines a minimum value to limit when the link behavior is active.

(Parameter) max: When the Apply Link When pop-up menu is set to “Source value below
maximum,” “Source value between min and max,” or “Source value outside min and max,”
a “max” slider appears for each component of the source parameter. Adjusting this slider
defines a maximum value to limit when the link behavior is active.

HUD Controls
The HUD lets you set all parameters and change the parameter source and target.
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Logarithmic
The Logarithmic parameter behavior is the inverse of the Exponential behavior. Like the
Exponential behavior, it creates more natural animations when scaling objects, especially
when using high values. The Logarithmic parameter behavior applies a mathematical
function to create a logarithmic curve (rather than linear) between the two values—the
effect ramps up quickly, and then the effect slows down. This allows the animation to
progress slowly when the scale values are small and speed up when the scale values are
large.

The Logarithmic behavior can be applied to parameters that have been animated with
behaviors or keyframes; however, it does not affect the parameter unless the Start Values
or End Values are nonzero.

Tip: When applied to parameters other than Scale, the Logarithmic parameter behavior
creates more organic animations than other interpolation modes.

Note: You can also change the interpolation modes of keyframes to Logarithmic. For
more information, see Modifying Curves.

Parameters in the Inspector
Start Value: The value that’s added to the parameter at the first frame of the Logarithmic
behavior.

End Value: The value the Logarithmic behavior reaches at the last frame of the behavior.
Over the life of the behavior, the parameter that the Logarithmic behavior is applied to
makes a transition from the Start Value to the End Value, plus the original value.

Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative
to the first frame of its position in the Timeline. Adjust this parameter to make the behavior
start later. The units of this parameter are in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline, in frames. Adjust this parameter to make the
behavior stop before the actual end of the behavior in the Timeline. Using this slider to
stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the
end of the effect for the remaining duration of the object. Trimming the end of the
behavior resets the object to its original parameter.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD lets you set the start and end values and change the parameter assignment.

Related Behaviors
• Exponential

• Ramp
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MIDI
The MIDI behavior allows you to edit and animate object parameters using standard MIDI
devices, such as a synthesizer. For the true motion graphics mixmaster.

Parameters in the Inspector
Control Type: Specifies the mode of the MIDI controller. The three available control types
are:

• Note: This mode is displayed when the control is a keyboard key on the MIDI device.

• Controller: This mode is displayed when the control is a knob, dial, key, slider, or foot
pedal on the MIDI device.

• Learning: This mode is used to “teach” Motion which control (such as a knob, dial, or
key) you want to use on the MIDI device to manipulate the parameter to which the
MIDI behavior is applied. When in Learning mode, the first knob, dial, or key that you
adjust on the MIDI device is set as the control.

Note: When the MIDI behavior is first applied, Learning is the default control type.

ID: Displays the identification number of the MIDI control (such as a knob, dial, or key)
that you are manipulating.

Value: When you are manipulating the MIDI control, displays the standard MIDI value
between 0 and 1.

Scale: Increasing the Scale value multiplies the Value parameter in the MIDI behavior.
This means that when Scale is increased, the MIDI control has a larger range of value and
a greater effect on the parameter it’s controlling. For example, when you are using a knob
to adjust an object’s rotation, the default rotation value range (when Scale is set to 1) for
a full turn of the knob may only be 30 percent. When the Scale value is increased to 13,
the rotation value of a full turn of the knob is increased to 370 degrees.

Apply To: The Apply To (Go) pop-up menu (parameter assignment control) shows the
parameter being affected and can be used to reassign the behavior to another parameter.

HUD Controls
The HUD controls allow you to adjust the Control Type, ID, Value, and Scale parameters,
as well as change the parameter assignment.

Applying the MIDI behavior
The MIDI behavior is applied in the same way as all other Parameter behaviors. In the
following examples, the MIDI parameter behavior is used to adjust an object’s opacity
and rotation.

Note: This behavior can only be used if you have a MIDI device correctly connected to
your computer.

To use the MIDI behavior to adjust an object’s opacity
1 Select an object, then select the Opacity parameter in the Properties tab of the Inspector.
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2 Control-click the parameter, then choose MIDI from the shortcut menu.

The MIDI parameters are displayed in the Behaviors tab. By default, Control Type is set
to Learning.

Like all other Parameter behaviors, the Apply To field displays the parameter to which
the behavior is applied.

3 On your MIDI device, tweak the control (such as the knob, dial, or key) that you want to
use as the controller for the Opacity parameter.

Note: When in Learning mode, the first control adjusted on the MIDI device is set as the
control. To reset the selected controller, choose Learning from the Control Type pop-up
menu, and adjust another control on the MIDI device.

The identification number of the MIDI control is displayed in the ID field. The value range
of the control is 0 to 127, the default MIDI control value.

Because an object’s opacity can only fall between 0 (completely transparent) to 100
(completely opaque), the default MIDI values are sufficient to adjust the parameter.

To use the MIDI parameter behavior to adjust an object’s rotation
1 Select an object, then select the Rotation parameter in the Properties tab of the Inspector.

2 Control-click the parameter, then choose MIDI from the shortcut menu.

3 On your MIDI device, tweak the control (knob, dial, key, and so on) that you want to use
as the controller for the Rotation parameter.

As mentioned above, the default Value range is 0 to 1. Because the Rotation value of an
object can be much larger, you can use the Scale parameter to multiply the Value range.

4 To give the control more sensitivity, increase the Scale value.

Negate
Inverts the value of each keyframe and behavior effect in the parameter to which it’s
applied by multiplying the parameter by –1. The Negate behavior basically flips each
parameter value to its opposite. Animation paths are flipped, rotation is reversed, and
any effect’s parameter is changed to its opposite.
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For example, applying the Negate behavior to the Position parameter of an object with
an animation path results in the animation path moving to the opposite quadrant of the
Canvas.

Note: If you want to reverse the motion taking place on an animation path, rather than
flipping the shape of the animation path itself, use the Reverse parameter behavior.

Parameters in the Inspector
Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD control allows you to change the parameter assignment.

Related Behaviors
• Average

• Reverse

Oscillate
The Oscillate behavior animates a parameter by cycling it between two different values.
You can customize how wide apart the high and low values are as well as the number of
oscillations per minute. The Oscillate behavior can create all kinds of cyclical effects. For
example, if you apply the Oscillate behavior to the rotation property of an object, it will
begin to rock back and forth. This happens because the rotation property cycles back
and forth between the original rotation value plus and minus the Amplitude value that’s
set in the Oscillate behavior.

Applying the Oscillate behavior to the X value of the Scale parameter instead causes the
width of the object to cycle, and it repeatedly stretches and compresses for the duration
of the behavior.

The Oscillate behavior is additive, meaning that the value generated by this behavior is
added to the original value of the parameter to which it’s applied.
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Parameters in the Inspector
Wave Shape: A pop-up menu that lets you choose the shape of the oscillation’s wave.
The choices are Sine (default), Square, Sawtooth, and Triangle.

• Sine: The default wave shape, the sine wave creates a smooth animation between
values. For example, if Oscillate is applied to an object’s Opacity parameter, and the
Wave Shape is set to Sine, the object gracefully fades in and out.

• Square: The square wave creates abrupt changes in values. For example, when Oscillate
is applied to an object’s Opacity parameter, and the Wave Shape is set to Square, the
object flashes on and off (like turning a light switch on and off ).
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• Sawtooth: The Sawtooth wave ramps upward over time and then drops sharply. For
example, when Oscillate is applied to an object’s Opacity parameter, and the Wave
Shape is set to Sawtooth, the object fades in slowly and fades out abruptly (like using
a light dimmer to fade up a light, and then flicking the power switch off ).

• Triangle: Similar to the sine wave, a triangle wave creates a smooth animation between
values but with sharper changes at the transitions. For example, when Oscillate is
applied to an object’s Opacity parameter, and the Wave Shape is set to Triangle, the
object fades in and out more acutely than the sine wave.

Phase: A slider that lets you adjust the point of the specified oscillation at which the
behavior starts. This parameter allows you to put multiple objects with identical Oscillate
behaviors out of phase with one another so that they don’t all look the same.

Amplitude: A slider that lets you adjust the maximum values that the parameter oscillates
between. The parameter swings between the amplitude value and the negative of the
amplitude value. Higher values result in more extreme swings from the beginning to the
ending of each oscillation.

Speed: A slider that lets you adjust the speed at which the oscillation occurs, in oscillations
per minute. Higher values result in faster oscillations.
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Half Range: When this checkbox is selected, the sine (or other wave shape) wave is
essentially cut in half and does not cross over the value of 0. For example, when Amplitude
is set to 100, the parameter oscillates between 100 and –100. When Half Range is selected,
however, the parameter oscillates between 100 and 0. When Amplitude is set to –100,
the parameter oscillates between –100 and 0.

Tip: When you are oscillating position parameters, set Wave Shape to Sine and enable
Half Range to create a bouncing effect.

The dotted line 
represents 0. When Half 
Range is disabled, the 
parameter oscillates 
between the Amplitude 
value and its inverse, 
such as 100 and –100.

The dotted line 
represents 0. When Half 
Range is enabled, the 
parameter oscillates 
between the Amplitude 
value and 0.

Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative
to the first frame of its position in the Timeline. Adjust this parameter to make the behavior
start later. The units of this parameter are in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline, in frames. Adjust this parameter to make the
behavior stop before the actual end of the behavior in the Timeline. Using this slider to
stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the
end of the effect for the remaining duration of the object. Trimming the end of the
behavior resets the object to its original parameters.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.
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HUD Controls
The HUD lets you adjust the Phase, Amplitude, Speed, and Half Range parameters as well
as change the parameter assignment of the Oscillate behavior.

Related Behaviors
• Ramp

• Rate

Creating a Decaying Oscillation
When you are oscillating an object’s rotation or position, a common effect is to “decay”
or “dampen” the animation over time. This means that the animation gradually slows or
comes to a stop. You can achieve this effect using keyframes to slow the amplitude of
the oscillation.

To decay an oscillating rotation using keyframes
1 Go to the frame where you want the animation to begin, then enable Record (press A).

2 Set the Amplitude value to the maximum value you want to use in your project.

Note: When Record is enabled, any value change to a parameter using the Inspector,
HUD, or Canvas creates a keyframe.

3 Go to the frame where you want the animation to come to a stop and set the Amplitude
value to 0.

When the object is selected, you can see the dampening of the animation—caused by
the keyframed Amplitude parameter—in the Keyframe Editor (when Animated is chosen
from the Show pop-up menu).
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When the Oscillate behavior is selected, you can see the keyframed Amplitude value in
the Keyframe Editor (when Animated is chosen from the Show pop-up menu).

Quantize
The Quantize behavior lets you create an incremental animation in any keyframed or
behavior-influenced parameter. For example, if opacity is animated so that an object
gradually fades in over time, you can add the Quantize behavior to make the object
become opaque in steps.

Note: The Quantize behavior only works with animated parameters.

Parameters in the Inspector
Step Size: A value slider that defines the size of the steps, based on the units of the
parameter to which it is applied. For example, when Quantize is applied to rotation, the
steps are in degrees (even though it is not a dial control). When applied to position, the
steps are in pixels.

The following left screenshot shows the projected path (the red line) of a layer with an
applied Throw behavior. The right image displays the same animation path after the
Quantize behavior is added. In this example, the Step value is set to 90.
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Offset: A slider that offsets the steps. For example, when Quantize is applied to a Position
parameter and Step Size is set to 100, an object “steps” in increments restricted to 100
pixels; thus, the step offset is 100, 200, 300, and so on. If Offset is set to 50, the step offset
is restricted to 50, 150, 250, and so on.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected, and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD lets you define the step size, offset, and parameter assignment.

Ramp
The Ramp behavior lets you create a gradual transition in any parameter that can be
animated, from the Start Value to the End Value. The speed of the transition is defined
by the length of the Ramp behavior in the Timeline, and by the behavior’s end value.
Additional parameters allow you to define how the transition occurs, whether it’s at a
single continuous speed, or whether it accelerates over time.

Ramp is a versatile behavior. If you apply it to the Scale property, it works like the
Grow/Shrink behavior. If you apply it to the Opacity property, you can fade an object in
or out in different ways. Although you can use the Ramp behavior to mimic other Motion
behaviors, it can be applied to any parameter you want.

Note: This behavior is additive, meaning that the value it generates is added to the original
value of the parameter to which it’s applied.

For example, suppose you’re animating different segments of a bar graph, and each
segment needs to grow until it reaches a specific length. (Hint: this can be done by
assigning a subtracting mask to each bar object, and animating the position of each bar’s
mask to slowly reveal each bar over time.)
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Once you’ve arranged the different bars with their masks in the Canvas, you can apply
Ramp behaviors to the X values of each mask to easily move each mask off to the side,
giving the illusion that each bar is growing. Set the End Value parameter of each Ramp
behavior to the length you want each bar to reach, and you’re done!

Before After using Ramp behaviors to move the masks

Parameters in the Inspector
Start Value: The value that’s added to the parameter at the first frame of the Ramp
behavior.

End Value: The value the Ramp behavior reaches at the last frame of the behavior. Over
the life of the behavior, the parameter the Ramp behavior is applied to makes a transition
from the Start Value to the End Value, plus the original value.

Curvature: This parameter lets you ease the acceleration with which the Ramp behavior
transitions from the Start Value to the End Value. Higher Curvature values result in an
ease in/ease out effect, where the value slowly begins the transition, gradually speeds
up as the behavior continues, then gradually slows down to a stop as it reaches the end.
Curvature does not affect the overall duration of the effect, since that is defined by the
length of the behavior in the Timeline.

Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative
to the first frame of its position in the Timeline. Adjust this parameter to make the behavior
start later. The units of this parameter are in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline, in frames. Adjust this parameter to make the
behavior stop before the actual end of the behavior in the Timeline. Using this slider to
stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the
end of the effect for the remaining duration of the object. Trimming the end of the
behavior resets the object to its original parameter.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.
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HUD Controls
The HUD lets you adjust the Ramp’s Start Value, End Value, and Curvature parameters,
as well as change the parameter assignment.

Related Behaviors
• Oscillate

• Rate

Randomize
Creates a continuous sequence of randomly increasing and decreasing values, based on
the parameters defining the range and type of values that are generated.

Although the values created with this behavior appear to be random, they’re actually
predetermined by the parameter settings you’ve chosen. As long as you don’t change
the parameters, the frame-by-frame values created by this behavior remain the same. If
you don’t like the values that were randomly generated, click the Generate button in the
Behaviors tab in the Inspector to pick a new random seed number. This number is used
to generate a new sequence of values.

The Apply Mode parameter determines how values generated by this behavior are
combined with other behaviors and keyframes that affect the same parameter. This
provides you with different ways of using a Randomize behavior to modify a parameter’s
preexisting values.

The Randomize behavior is useful for creating jittery effects, such as twitchy rotation,
flickering opacity, and other effects requiring rapid and varied changes over time that
would be time-consuming to keyframe. The Randomize behavior can be modified with
other behaviors, such as Average and Negate, to exercise further control over the values
being generated.

Parameters in the Inspector
Amount/Multiplier: This parameter is set to Amount when the Apply Mode is set to Add,
Subtract, or Add and Subtract, and is set to Multiplier when the Apply Mode is set to
Multiply. This parameter defines the maximum value the Randomize behavior will generate.

Apply Mode: A pop-up menu that determines how values generated by this behavior
are combined with other behaviors and keyframes that affect the same parameter. This
provides you with different ways of using a Randomize behavior to modify a parameter’s
preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

Frequency: A slider that lets you adjust the amount of random variation per second.
Higher values will generate faster variations, whereas lower values will generate slower
variations.

Noisiness: Adds an additional overlay of random variance to the Frequency you’ve set.
Higher Noisiness values result in more erratic variations in the affected parameter.
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Link: This parameter appears when you apply this behavior to a two-dimensional
parameter (such as Scale) or three-dimensional parameter (such as Position) that consists
of X, Y, and/or Z values. Turn this checkbox on to keep the behavior’s effect on each value
proportional.

Affect Subobjects: This parameter only appears when the Randomize behavior is applied
to a parameter of the Sequence Replicator behavior. When Affect Subobjects is selected,
each object has a different random behavior. When Affect Subobjects is deselected, each
object undergoes the same animation.

Random Seed: A button that lets you pick a new random seed number. This number is
used to randomly generate new sequences of values, based on the other parameters of
this behavior.

Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative
to the first frame of its position in the Timeline. Adjust this parameter to make the behavior
start later. The units of this parameter are in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline, in frames. Adjust this parameter to make the
behavior stop before the actual end of the behavior in the Timeline. Using this slider to
stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the
last random value generated by this behavior for the remaining duration of the object.
Trimming the end of the behavior resets the parameter to its original value.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD lets you adjust the Amount, Multiplier, Frequency, Noisiness, Link (for
multidimensional parameters), Start Offset, and End Offset parameters, as well as parameter
assignment.

Related Behaviors
• Random Motion

• Wriggle

Rate
This behavior increases a parameter’s value over time, with the rate of increase determined
by the Rate slider. Unlike the Ramp behavior, this behavior has no end value; it simply
continues to increase or decrease the parameter it’s applied to until the end of the
parameter.

Note: To decrease a parameter over time, enter a negative value into the Rate parameter.
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Parameters in the Inspector
Rate: A value slider that lets you set a rate of increase over time for the affected parameter.
Measured in percentage increase per second.

Curvature: This parameter lets you ease the acceleration with which the Rate behavior
transitions from the Start Value to the End Value. Higher Curvature values result in an
ease in/ease out effect, where the value slowly begins the transition, gradually speeds
up as the behavior continues, then gradually slows down to a stop as it reaches the end.
Curvature does not affect the overall duration of the effect, since that is defined by the
length of the behavior in the Timeline.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline, in frames. Adjust this parameter to make the
behavior stop before the actual end of the behavior in the Timeline. Using this slider to
stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the
last random value generated by this behavior for the remaining duration of the object.
Trimming the end of the behavior resets the parameter to its original value.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD has controls for Rate, Curvature, and parameter assignment.

Related Behaviors
• Oscillate

• Ramp

Reverse
Unlike the Negate behavior, which inverts the value of the parameter to which it’s applied,
the Reverse behavior reverses the direction of any animation that affects a parameter,
whether it’s caused by behaviors or keyframes. For example, when you apply the Reverse
behavior to path animation that begins at the left and moves to the right, the animation
path won’t move, but the object instead begins at the right and moves to the left. The
Reverse behavior basically switches the beginning and ending points of animated objects.

Parameters in the Inspector
Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD control allows you to change the parameter assignment.

Related Behaviors
• Average

• Negate
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Stop
The Stop behavior suspends parameter animation (created by keyframes or applied
behaviors) of an object. For example, if you assign the Stop Parameter behavior to the
Position parameter of an object that is moving across the screen and rotating, the object
ceases to move across the screen but continues to rotate.

Each behavior’s effect on the object is frozen at the first frame of the Stop behavior in
the Timeline. Keyframes that are applied to that parameter cease to have any effect for
the duration of the Stop behavior in the Timeline.

If the Stop behavior is shorter than the object to which it’s applied, all keyframes and
behaviors affecting that channel immediately take effect after the last frame of the Stop
behavior. For more information on using the Stop behavior, see Using the Stop Behavior.

Parameters in the Inspector
Apply To: The Apply To (Go) pop-up menu shows the parameter being stopped and can
be used to reassign the Stop behavior to another parameter.

HUD Controls
The HUD control allows you to change the parameter assignment.

Track
This behavior allows you to apply tracking data to a parameter of an effect, such as the
center point of the Light Rays filter. For more information on using the Track behavior,
see Track Parameter Behavior.

Wriggle
This behavior works similarly to the Randomize behavior, but with a slower effect.

Note: A Wriggle behavior applied to an Opacity parameter set to 100% does not have
much effect. This is because there isn’t much room to “wriggle.” For a better result, set
the Opacity to 0, or change the Apply Mode to Subtract.

Parameters in the Inspector
Amount/Multiplier: This parameter is set to Amount when the Apply Mode is set to Add,
Subtract, or Add and Subtract. This parameter is set to Multiplier when the Apply Mode
is set to Multiply. This parameter defines the maximum value that the Wriggle behavior
generates.

Apply Mode: A pop-up menu that determines how values generated by this behavior
are combined with other behaviors and keyframes that affect the same parameter. This
provides you with different ways of using a Wriggle behavior to modify a parameter’s
preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

Frequency: A slider that lets you adjust the amount of random variation per second.
Higher values generate faster variations, whereas lower values generate slower variations.
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Wriggle Offset: A slider that allows you to offset the sequence of random values when
you want to apply the same Wriggle behavior to multiple objects. By offsetting each
object’s version of the Wriggle behavior, you can prevent objects from moving in sync.

Noisiness: This slider adds an additional overlay of random variance to the Frequency
you’ve set. Higher Noisiness values result in more erratic variations in the affected
parameter.

Link: This parameter appears when you apply the Wriggle behavior to a two-dimensional
parameter (such as Scale) or three-dimensional parameter (such as Position) that consists
of X, Y, and/or Z values. Turn this checkbox on to keep the behavior’s effect on each value
proportional.

Affect Subobjects: This parameter only appears when the Wriggle behavior is applied
to a parameter of the Sequence Replicator behavior. When Affect Subobjects is selected,
each object has a different wriggle behavior. When Affect Subobjects is deselected, each
object undergoes the same animation.

Random Seed: A button that lets you pick a new random seed number. This number is
used to randomly generate new sequences of values, based on the other parameters of
this behavior.

Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative
to the first frame of its position in the Timeline. Adjust this parameter to make the behavior
start later. This parameter is measured in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the
last frame of its position in the Timeline, in frames. Adjust this parameter to make the
behavior stop before the actual end of the behavior in the Timeline. Using this slider to
stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the
last random value generated by this behavior for the remaining duration of the object.
Trimming the end of the behavior resets the parameter to its original value.

Apply To: The Apply To (Go) pop-up menu shows the parameter being affected and can
be used to reassign the behavior to another parameter.

HUD Controls
The HUD lets you adjust the Amount, Multiplier, Frequency, Wriggle Offset, Noisiness,
Link (for multidimensional parameters), Start Offset, and End Offset parameters, as well
as change the parameter assignment.

Related Behaviors
• Random Motion

• Randomize
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Retiming Behaviors
Retiming behaviors are applied to image sequences, QuickTime movies, and clone layers
in order to change their timing. Retiming effects include creating hold frames, changing
playback rate, reversing a clip, creating stutter or strobe effects, and so on.

Important: Retiming behaviors can only be applied to QuickTime movies, image
sequences, or clone layers. In other words, a Retiming behavior cannot be applied to a
particle emitter, but it can be applied to an instance of the particle emitter. For more
information on cloning layers, see Making Clone Layers.

Retiming Behaviors Versus Timing Controls in the Inspector
When a clip is selected, a group of Timing parameters appears in the Properties tab of
the Inspector. These controls allow you to do some of the same effects as the Retiming
behaviors, such as slowing down or speeding up, looping, or reversing a clip; however,
the Timing controls affect the entire clip. The beauty of the Retiming behaviors is that
you can define which portion of the clip is affected by the behavior. Any timing changes
made to a clip using the Inspector’s Timing controls are respected by the Retiming
behaviors. For example, if you changed the speed of the clip to 50% in the Timing
parameters, a Retiming behavior uses that half-speed clip as its source. For more
information on Timing controls in the Inspector, see Retiming.

The following sections cover the Retiming behaviors:

• Flash Frame

• Hold Frame

• Loop

• Ping Pong

• Replay

• Reverse

• Reverse Loop

• Scrub

• Set Speed

• Strobe

• Stutter

Flash Frame
This behavior randomly inserts a user-defined range of random frames (adjacent to the
current frame) into the playback of a clip.
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Parameters in the Inspector
Random Frames: A slider that sets the probability that a frame within the duration of
the behavior is replaced with a random frame. When this value is set to 0, no random
frames are inserted. When set to 100, every frame is random. The default value is 10%.

Frame Range: A slider that defines the range from which the random frames are chosen,
based around the current frame. The default value is 10 frames.

Duration: A slider that sets the duration of the sequence of random frames. The default
value is 1, which means 1 random frame is inserted at a time. When Duration is set to 30,
for example, 30-frame sequences (chosen from the Frame Range) are randomly inserted.
The Duration value overrides the Random Frame count (so that a new random frame
does not interrupt the sequence).

Random Seed: A button that lets you pick a new random seed number. This number is
used to randomly generate new values, based on the other parameters of this behavior.

HUD Controls
The HUD contains the Random Frames, Frame Range, Duration, and Random Seed
parameters.

Hold Frame
The Hold Frame behavior holds the frame at the behavior’s In point for the duration of
the behavior. The clip continues playing normally after the behavior’s Out point. For
example, if the Hold Frame behavior begins at frame 60 and ends at frame 300, the clip
plays normally until frame 59, frame 60 is held for 240 frames, and then normal playback
resumes—frame 61 of the clip—at frame 301.

The Hold behavior is always applied at the current frame, rather than at the start of the
object.

Parameters in the Inspector
Offset: A slider that sets the offset for the hold frame. When set to 0 (the default), the
frame at the start of the behavior is the hold frame. When set to 60, however, the frame
at the start of the behavior (the hold frame) is the start frame plus 60 frames. This
parameter is measured in frames.

Tip: Flickering may occur if the Hold Frame behavior is applied to interlaced footage. To
avoid this, ensure that Field Order is properly set in the Inspector. To change field order,
select the footage in the Media tab of the Project pane, show the Media tab in the
Inspector, then choose a field order option from the Field Order pop-up menu.

HUD Controls
The HUD contains the Offset parameter.
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Loop
This behavior loops a segment of the clip within the duration of the behavior. The loop’s
starting frame is derived from the start frame of the behavior. For example, if the behavior
is applied at the start of a clip, and Loop Duration is set to 30, the first 30 frames of the
clip loop repeatedly until the end of the behavior. At the end of the behavior, normal
playback resumes from the frame at the end of the loop duration.

Parameters in the Inspector
Loop Duration: A slider that sets the duration of the looped frames. The default value is
30 frames.

HUD Controls
The HUD contains the Loop Duration parameter.

Ping Pong
This behavior “ping-pongs” a segment of the clip within the duration of the behavior.
The ping-pong’s starting frame is derived from the start frame of the behavior. For example,
if the behavior is applied at the start of a clip, and Duration is set to 30, the first 30 frames
of the clip play forward, then play in reverse, then forward, and so on until the end of the
behavior. At the end of the behavior, normal playback resumes.

Parameters in the Inspector
Duration: A slider that sets the duration of the ping-pong frames. The default value is
30 frames.

HUD Controls
The HUD contains the Loop Duration parameter.

Replay
The Replay behavior resets the playhead at the beginning of the behavior to a specific
frame, and then plays the clip normally from that frame. The clip plays back normally
after the end of the behavior. This allows you to trigger playback of the clip at different
times, without requiring multiple copies of the movie object.

Parameters in the Inspector
Start From: A pop-up menu that determines whether the replay starts from an absolute
frame number or an offset from the frame at the start of the behavior.

• Absolute Frame: Sets the replay to start at the frame specified in the Start Time
parameter. For example, if the behavior starts at frame 60 of the clip and Start Frame
is set to 30, when playback reaches frame 60, the clip starts playback over from frame
30.
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• Offset Frame: Allows you to offset the start frame of the replay. For example, if the
behavior starts at frame 60 of the clip, and Start Frame is set to 30, when playback
reaches frame 60, the clip starts playback at frame 90. If Start Frame is set to –30, the
clip starts playback over from frame 30.

Start Time: A slider that sets the start frame from which to replay the clip. The default is
frame 1.

HUD Controls
The HUD contains the Start From and Start Time parameters.

Reverse
This behavior plays the clip or image sequence in reverse.

Parameters in the Inspector
There are no parameters for this behavior.

HUD Controls
There are no parameters for this behavior.

Reverse Loop
This behavior loops a segment of the clip in reverse within the duration of the behavior.
If Loop Duration is set to 30 and the behavior begins at frame 1, frames 1–30 are played
in reverse, then frames 31–60 are played in reverse, frames 61–90 are played in reverse,
and so on.

Tip: To achieve a nice stutter effect, set Loop Duration to 2.

Parameters in the Inspector
Loop Duration: A slider that sets the duration of the looped frames to be played in
reverse. The default value is 30 frames.

HUD Controls
The HUD contains the Loop Duration parameter.

Scrub
Like the Scrub filter, the Scrub behavior moves a virtual playhead around a clip, allowing
you to change the timing of the clip without moving it in the Timeline. Additionally, the
Scrub behavior allows you to animate the offset parameter using keyframes or parameter
behaviors, often with interesting results. Try applying the Oscillate behavior to the Frame
offset, with the Offset From parameter set to Current Frame.

Note: You can also apply parameter behaviors to the Retime Value parameter in the
Timing controls for the image itself. The Timing controls are located in the Properties tab.
Time Remap must be set to Variable Speed in order to access the Retime Value parameter.

Important: Scrub does not affect clip audio.
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Parameters in the Inspector
Frame Offset: Sets the offset of the virtual playhead.

Offset From: Sets the position from which the virtual playhead is offset. Values can be
selected from First Frame or Current Frame.

HUD Controls
The HUD contains the Frame Offset and Offset From parameters.

Set Speed
This behavior allows you to change the speed (playback rate) of a clip. The speed specified
in the behavior begins at the behavior’s In point and exists for the duration of the behavior.
The clip continues playing at its default speed after the behavior’s Out point. For example,
if the Set Speed behavior begins at frame 60 and ends at frame 300, the clip plays normally
until frame 59, plays back at the rate specified in the behavior from frame 60 to frame
300, and then resumes its default playback speed at frame 301. You can apply an “ease-in”
or “ease-out” effect to the speed change.

Parameters in the Inspector
Speed: A slider that sets the speed of the clip as a percentage. The default is 100% (the
clip’s normal speed). A Speed setting of 50% plays the clip at half speed.

Note: The Speed parameter can be keyframed to create variable playback rate changes.

Ease In Time: A slider that sets the number of frames over which the ease in to the speed
change occurs (from the start of the behavior). The default value is 20 frames.

Ease In Curve: A slider that defines the curvature of the ramp when easing into the speed
change. A value of 0 creates a sharp transition to the new speed; a value of 100 creates
the smoothest ease in to the new speed. The default is 50%.

Ease Out Time: A slider that sets the number of frames over which the ease out of the
speed change occurs (from the end of the behavior). The default value is 20 frames.

Ease Out Curve: A slider that defines the curvature of the ramp when easing out of the
speed change. A value of 0 creates a sharp transition from the new speed to the original
speed; a value of 100 creates the smoothest ease out. The default is 50%.

HUD Controls
The HUD contains the Speed, Ease In Time, Ease In Curve, Ease Out Time, and Ease Out
Curve parameters.

Strobe
The Strobe behavior simulates the look of a strobe light or lower frame rate video by
holding a number of frames as defined by the Strobe Duration parameter over the playback
of the clip. For example, when Strobe Duration is set to 10, frame 1 is held for 10 frames,
frame 11 for 10 frames, frame 21 for 10 frames, and so on. The frames in between (2–10,
12–20, 22–30, and so on) do not appear.
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Parameters in the Inspector
Strobe Duration: A slider that sets the number of frames to hold. A value of 1 plays the
clip at normal speed. The default value is 5 frames.

HUD Controls
The HUD contains the Strobe Duration parameter.

Stutter
This behavior randomly inserts hold frames, of random durations, into the playback of a
clip. The effect is similar to a tape that sticks during play in a videocassette recorder.

Parameters in the Inspector
Stutter Amount: A slider that sets the probability that a hold frame is generated at the
given frame. When set to 0%, no hold frames are created; when set to 100%, every frame
is a hold frame. Values in between 0 and 100 indicate the probability of frames (within
the duration of the behavior) that are replaced by hold frames. The default value is 10%.

Duration Range: A slider that sets the maximum duration of hold frames. A value of 1
inserts single-frame hold frames at a frequency determined by the Stutter Amount
parameter. Increasing the Duration Range increases the range of hold frames. For example,
a value of 30 creates random hold frames with a minimum of 1 frame and a maximum
of 30 frames. The default value is 3 frames.

Random Seed: A button that lets you pick a new random seed number. This number is
used to randomly generate new values, based on the other parameters of this behavior.

HUD Controls
The HUD contains the Stutter Amount, Duration Range, and Random Seed parameters.

Simulation Behaviors
These behaviors perform one of two tasks. Some Simulation behaviors, such as Gravity,
animate the parameters of an object in a way that simulates a real-world phenomenon.
Other Simulation behaviors, such as Attractor and Repel, affect the parameters of one or
more objects surrounding the object to which they’re applied. These behaviors allow you
to create some very sophisticated interactions among multiple objects in your project
with a minimum of adjustments. Like the Basic Motion behaviors, Simulation behaviors
also affect specific object parameters. Examples include Attractor, Gravity, and Repel.

Note: To view examples of working with the different Simulation behaviors, see Behavior
Examples.
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Important: Several Simulation behavior parameters contain object wells into which target
objects used as attractors, repellers, orbiters, and so on, are dragged. Dragging an object
to a well may be tricky—be sure to click the object name in the Layers tab and immediately
drag the object to the object well (without releasing the mouse button). The behavior
must remain active even though you are dragging another object in the Layers tab. If
you click the object in the Layers tab and release the mouse button, that object becomes
selected, and the behavior’s parameters are no longer displayed. This behavior is true of
all wells, including mask source and image wells.

The following sections cover the Simulation behaviors:

• Align To Motion

• Attracted To

• Attractor

• Drag

• Drift Attracted To

• Drift Attractor

• Edge Collision

• Gravity

• Orbit Around

• Random Motion

• Repel

• Repel From

• Rotational Drag

• Spring

• Vortex

• Wind

Align To Motion
The Align To Motion behavior changes the rotation of an object to match changes made
to its direction along an animation path. This behavior is meant to be combined with
Simulation behaviors that animate the position of an object or with a keyframed animation
path you create yourself.
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Note: The Align to Motion behavior does not work on objects animated using the Motion
Path behavior. Instead, use the Snap Alignment to Motion behavior (in the Basic Motion
subcategory).

Before using Align To Motion After using Align To Motion

Unlike the Snap Alignment to Motion behavior, which produces absolute changes in
rotation that precisely match changes in direction, Align To Motion has a springy reaction
and creates a more lively effect.

In the above example, the fish travels along the keyframed animation path, but it isn’t
aligned to the animation path (notice the rotation handle). Using the Align To Motion
behavior, its angle of rotation moves so that it points in the direction of the animation
path. By adjusting the Drag parameter, you can make it careen wildly about its anchor
point as it goes around curves in the animation path.

Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Rotation Axis: A pop-up menu that lets you rotate the object around the X, Y, or Z axis.
You can also select All to rotate the object around all three axes. The default rotation axis
is Z.

Axis: A pop-up menu that lets you specify whether the object aligns itself on its horizontal
or vertical axis.

Invert Axis: A checkbox that flips the orientation with which the object aligns itself to
the motion.

Spring Tension: A slider that adjusts how quickly the object’s rotation changes to match
a change in the object’s direction. Lower values create a delay between a change to an
object’s position and its subsequent change in rotation. Higher values create more
responsive changes in rotation.

496 Chapter 9 Using Behaviors



Drag: A slider that adjusts whether or not the change in rotation made by this behavior
overshoots the new direction of the object. Low drag values result in springy changes in
rotation, where the object rotates back and forth as it overshoots changes in direction.
High drag values dampen this effect, making the object’s rotation stick more closely to
the changes made in rotation. Higher values also cause the object’s rotation to lag behind
the object’s change in position.

HUD Controls
The HUD has controls for the Rotation Axis, Axis, Invert Axis, Spring Tension, and Drag
parameters. When applied to a group or layer that contains multiple objects (such as
particles, text, or a replicator), the Affect Subobjects checkbox also appears in the HUD.

Related Behaviors
• Snap Alignment to Motion

Attracted To
This behavior is part of a group of Simulation behaviors that let you create complex
animated relationships between two or more objects. These behaviors are extremely
powerful and allow complicated effects to be created with a minimum of steps.

An object with the Attracted To behavior moves toward a single specified target, the
object of attraction. Additional parameters allow you to adjust the area of influence that
defines how close an object needs to be to move toward the object of attraction, and
how strongly it is attracted.

Shape object of 
attraction

Shape object with 
Attracted To behavior
Animation path

The Drag parameter lets you define whether attracted objects overshoot and bounce
about the attracting object, or whether they eventually slow down and stop at the position
of the target object.

You can apply two or more Attracted To behaviors to a single object, each with a different
object of attraction, to create tug-of-war situations where the object bounces among all
the objects it’s attracted to.
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Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Object: An image well that defines the object of attraction. To set the defined target
object, drag the object from the Layers tab to the Object well in the Attracted To HUD
or Inspector. In the Layers tab, you can also drag the target object onto the Attracted To
behavior.

Strength: A slider defining the speed at which the object moves toward the object of
attraction. With a value of 0, the object doesn’t move at all. The higher the value, the
faster the object moves.

Falloff Type: A pop-up menu that determines whether the distance defined by the
Influence parameter falls off linearly or exponentially.

• Linear: Object attraction falls off in proportion to the object’s distance.

• Exponential: The closer an object is within the area of influence, the more strongly it
is attracted, and the faster it moves toward the object of attraction.

Falloff Rate: This value determines how quickly the force of attraction between objects
affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting
up to speed as they move toward the object of attraction. A high Falloff Rate causes
objects to accelerate much more slowly. When set to Exponential, the attraction falls off
more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that
fall within the area of influence move toward the object of attraction. Objects that are
outside of the area of influence remain in place.

Drag: A slider that can be used to reduce the distance attracted objects overshoot the
object of attraction. Lower Drag values result in the object overshooting the object of
attraction, moving past and then careening back around toward the target object again
and again. Higher Drag values result in the object coming to rest sooner.

Include X, Y, and Z: Buttons that allow you to specify the axes on which the affected
object (or objects) moves around the object to which it is attracted. When Z is enabled,
the object moves about its attractor object in Z space.

HUD Controls
The HUD has an Object well you can use to assign an object of attraction, as well as
Strength, Falloff Type, Falloff Rate, Influence, Drag, and axis assignment parameters. When
applied to an object that contains multiple objects (such as a group, particles, text, or the
replicator), the Affect Subobjects checkbox also appears in the HUD.
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Related Behaviors
• Attractor

• Drift Attracted To

• Drift Attractor

• Orbit Around

• Spring

• Vortex

Attractor
If you apply an Attractor behavior to an object, other objects that lie within the area of
influence move toward it. You can manipulate the strength with which other objects are
attracted, as well as the distance required for attraction to begin.

Start of Attractor effect End of Attractor effect

By default, objects overshoot the object of attraction and bounce around, never coming
to rest. The Drag parameter lets you adjust this behavior, changing whether attracted
objects overshoot and bounce around, or whether they eventually slow down and stop
at the position of the target object.

The Attractor behavior can affect all objects in the Canvas that fall within the area of
attraction, or you can limit its effect to a specific list of objects by using the Affect
parameter.

The Attractor behavior can also be applied to objects in motion. If you animate the position
of the target object to which you’ve applied the Attractor behavior, all other objects in
the Canvas continue to be attracted to its new position.

Parameters in the Inspector
Affect: A pop-up menu that limits which objects in your project are affected by the
Attractor behavior. There are three options:

• All Objects: All objects in the Canvas are affected by the Attractor behavior.
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• Related Objects: The default setting. Only other objects that are within the same group
as the object of attraction are affected.

• Specific Objects: Only objects appearing in the Affected Objects list are affected by the
Attractor behavior.

Affected Objects: A list that appears when Specific Objects is chosen in the Affect pop-up
menu. Drag objects from the Layers tab into this list to be affected by the Attractor
behavior when the Specific Objects option is selected in the Affect pop-up menu. To
remove an item from the list, select the item and click Remove.

• Layer: This column lists the name of the layer containing the object.

• Name: This column lists the name of the object itself.

Strength: A slider defining the speed with which attracted objects move toward the
target object. With a value of 0, attracted objects don’t move at all. The higher the value,
the faster attracted objects move.

Falloff Type: A pop-up menu that determines whether the distance defined by the
Influence parameter falls off linearly or exponentially.

• Linear: Object attraction falls off in proportion to the object’s distance.

• Exponential: The closer an object is within the area of influence, the more strongly it
is attracted, and the faster it moves toward the object of attraction.

Falloff Rate: This value determines how quickly the force of attraction between objects
affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting
up to speed as they move toward the object of attraction. A high Falloff Rate causes
objects to accelerate much more slowly. When set to Exponential, the attraction falls off
more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence in pixels. Objects that
fall within the area of influence move toward the object of attraction. Objects that are
outside of the area of influence remain in place.

Drag: A slider that can be used to reduce the distance attracted objects overshoot the
object of attraction. Lower Drag values result in the object overshooting the object of
attraction, moving past and then careening back around toward the target object again
and again. Higher Drag values result in the object coming to rest sooner.

Include X, Y, and Z: Buttons that allow you to specify the space in which the object (or
objects) moves toward the target object. For example, when X and Y are enabled, the
object moves in the XY plane; when Y and Z are enabled, the object moves in the YZ
plane.

HUD Controls
The HUD lets you adjust the Affect, Strength, Falloff Type, Falloff Rate, Influence, Drag,
and axis assignment parameters.
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Related Behaviors
• Attracted To

• Drift Attracted To

• Drift Attractor

• Orbit Around

• Spring

• Vortex

Drag
This behavior lets you simulate the force of friction on a moving object, slowing it down
over time. Applying the Drag behavior is an easy way to decelerate objects with multiple
behaviors that create complex motion.

Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Amount: Sliders that can be used to slow down an object over time, causing it to
eventually come to a stop. Higher Drag values result in the object coming to rest sooner.
Click the Amount disclosure triangle to adjust the drag applied to the X, Y, and Z values
separately. An example of this is to create a situation where an object’s vertical speed
slows down faster than its horizontal speed.

Include X, Y, and Z: Buttons that allow you to specify the space in which drag is in effect.
For example, when X and Y are enabled, the object drags in the XY plane; when Y and Z
are enabled, the object drags in the YZ plane.

HUD Controls
The HUD lets you adjust the amount of drag and axis assignment. When applied to an
object that contains multiple objects, such as a group, particles, text, or the replicator,
the Affect Subobjects checkbox also appears in the HUD.

Related Behaviors
• Rotational Drag

Drift Attracted To
Similar to the Attracted To behavior, but by default an object moves toward the object
of attraction and comes to rest, rather than overshooting the object of attraction and
bouncing around.
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Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Object: An image well that defines the object of attraction. To set the defined target
object, drag the object from the Layers tab to the Object well in the Drift Attracted To
HUD or Inspector. In the Layers tab, you can also drag the target object onto the Drift
Attracted To behavior.

Strength: A slider defining the speed at which the object moves toward the object of
attraction. With a value of 0, the object doesn’t move at all. The higher the value, the
faster the object moves.

Falloff Type: A pop-up menu that determines whether the distance defined by the
Influence parameter falls off linearly or exponentially.

• Linear: Object attraction falls off in proportion to the object’s distance.

• Exponential: The closer an object is within the area of influence, the more strongly it
is attracted, and the faster it moves toward the object of attraction.

Falloff Rate: This value determines how quickly the force of attraction between objects
affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting
up to speed as they move toward the object of attraction. A high Falloff Rate causes
objects to accelerate much more slowly. When set to Exponential, the attraction falls off
more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that
fall within the area of influence move toward the object of attraction. Objects that are
outside of the area of influence remain in place.

Drag: A slider that can be used to reduce the distance attracted objects overshoot the
object of attraction. Lower Drag values result in the object overshooting the object of
attraction, moving past and then careening back around toward the target object again
and again. Higher Drag values result in the object coming to rest sooner.

Include X, Y, and Z: Buttons that allow you to specify the space in which the affected
object (or objects) drifts toward the object to which it is attracted. For example, when X
and Y are enabled, the object drifts in the XY plane; when Y and Z are enabled, the object
drifts in the YZ plane.

HUD Controls
The HUD has an Object well you can use to assign an object of attraction, sliders for
strength and drag, and axis assignment. When applied to an object that contains multiple
objects (such as a group, particles, text, or the replicator), the Affect Subobjects checkbox
also appears in the HUD.
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Related Behaviors
• Attracted To

• Attractor

• Drift Attractor

• Orbit Around

• Spring

• Vortex

Drift Attractor
Similar to the Attractor behavior, but by default objects within the area of influence move
toward the object of attraction and come to rest, rather than overshooting the object of
attraction and bouncing around.

Parameters in the Inspector
Affect: A pop-up menu that limits which objects in your project are affected by the Drift
Attractor behavior. There are three options:

• All Objects: All objects in the Canvas are affected by the Drift Attractor behavior.

• Related Objects: The default setting. Only other objects that are within the same group
as the object of attraction are affected.

• Specific Objects: Only objects appearing in the Affected Objects list are affected by the
Drift Attractor behavior.

Affected Objects: A list that appears when Specific Objects is chosen in the Affect pop-up
menu. Drag objects from the Layers tab into this list to be affected by the Attractor
behavior when the Specific Objects option is selected in the Affect pop-up menu. To
remove an item from the list, select the item and click Remove.

• Layer: This column lists the name of the layer containing the object.

• Name: This column lists the name of the object itself.

Strength: A slider defining the speed with which attracted objects move toward the
target object. With a value of 0, attracted objects don’t move at all. The higher the value,
the faster attracted objects move.

Falloff Type: A pop-up menu that determines whether the distance defined by the
Influence parameter falls off linearly or exponentially.

• Linear: Object attraction falls off in proportion to the object’s distance.

• Exponential: The closer an object is within the area of influence, the more strongly it
is attracted, and the faster it moves toward the object of attraction.

503Chapter 9 Using Behaviors



Falloff Rate: This value determines how quickly the force of attraction between objects
affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting
up to speed as they move toward the object of attraction. A high Falloff Rate causes
objects to accelerate much more slowly. When Falloff Type is set to Exponential, the
attraction falls off more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that
fall within the area of influence move toward the object of attraction. Objects that are
outside of the area of influence remain in place.

Drag: A slider that can be used to reduce the distance attracted objects overshoot the
object of attraction. Lower Drag values result in the object overshooting the object of
attraction, moving past and then careening back around toward the target object again
and again. Higher Drag values result in the object coming to rest sooner.

Include X, Y, and Z: Buttons that allow you to specify the space in which the object (or
objects) drift toward the target object. For example, when X and Y are enabled, the object
drifts in the XY plane; when Y and Z are enabled, the object drifts in the YZ plane.

HUD Controls
The HUD has controls for Affect, Strength, Drag, and axis assignment.

Related Behaviors
• Attracted To

• Attractor

• Drift Attracted To

• Orbit Around

• Spring

• Vortex
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Edge Collision
This is a good behavior to use if you’re setting up complex motion simulations and you
don’t want your objects exiting the Canvas. Objects with the Edge Collision behavior
applied either come to a stop or bounce off after colliding with the edge of the Canvas
frame. For example, if you apply the Throw behavior to an object and set the velocity to
send the object toward the edge of the frame, then apply Edge Collision, the object will
bounce off the edge of the frame according to the Bounce Strength parameter.

Animation path of a 
thrown object affected 
by the Edge Collision 
behavior

The angle at which the object bounces depends on the angle at which it hits the edge
of the frame; the speed it travels after bouncing is set by the Bounce Strength parameter.

Note: Edge Collision has no effect on objects that are larger than the Canvas.

Important: By default, the Edge Collision behavior uses the size of the project and the
bounding box to determine how the object collides with the edge of the Canvas. For
example, in an NTSC Broadcast SD project (720 x 486 pixels), an object bounces off the
right and left edges of the project at its bounding box. With groups (particles, text, and
objects), only the object’s center is used. You can make the object travel further off the
Canvas before it bounces by adjusting the Width and Height parameters. If you’re using
this behavior with an object that has an alpha channel that’s smaller than its bounding
box, adjust the Crop parameter in the object’s Properties tab to fit the bounding box as
closely as possible to the edge of the image.

Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.
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Bounce Strength: The speed at which objects travel after colliding with an edge. A value
of 0 causes objects to come to a complete stop when colliding with an edge that’s
perpendicular to the direction of motion. Higher values cause an object to move faster
after bouncing. This parameter only slows the object in the direction perpendicular to
the bounced edge.

Active Edges: Six checkboxes define which collision box edges are detected by the Edge
Collision behavior. You can turn edges on and off in any combination.

• Left Face: Defines the left edge for the collision.

• Right Face: Defines the right edge for the collision.

• Top Face: Defines the top edge for the collision.

• Bottom Face: Defines the bottom edge for the collision.

• Back Face: Defines the back edge (in Z space) for the collision.

• Front Face: Defines the front edge (in Z space) for the collision.

Width: A slider that allows you to define a width (the right and left edges of the Canvas)
other than the size of project. By default, Width is set to the project size.

Height: A slider that allows you to define a height (the top and bottom edges) other
than the size of project. By default, Height is set to the project size.

Depth: A slider that allows you to define a depth (the back and front faces, in Z space)
for the edge collision. By default, Depth is set to 100 pixels.

HUD Controls
The HUD has controls for Bounce Strength and Width, Height, and Depth. When applied
to an object that contains multiple objects (such as a group, particles, text, or the
replicator), the Affect Subobjects checkbox also appears in the HUD.
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Gravity
This behavior causes an object, or the objects within a group (when Affect Subobjects is
selected), to fall over time. The gravitational acceleration can be increased or decreased,
resulting in a change to the rate of fall. Objects affected by the Gravity behavior continue
to fall past the bottom edge of the Canvas (unless the Edge Collision behavior has been
applied).

Animation path of an 
object pulled down by 
the Gravity behavior

The Gravity behavior can be used in conjunction with other behaviors that animate the
position of objects to create natural-looking arcs and animation paths that simulate
thrown objects falling to the ground. For example, apply the Throw behavior to an object
to send it flying through the air, and then apply the Gravity behavior to it to make the
object arc up and then fall down past the bottom of the Canvas.

You can also set the Acceleration parameter to a negative value, effectively applying
“anti-gravity” to the object and making it fly up.

Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Acceleration: A slider defining the strength of gravity affecting the target object. The
higher this value, the faster the target object falls.

HUD Controls
The HUD lets you adjust the Acceleration parameter. When applied to an object containing
multiple objects (such as a group, particles text, or a replicator), the Affect Subobjects
checkbox also appears in the HUD.

Related Behaviors
• Motion Path

• Random Motion
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• Throw

• Wind

Orbit Around
Similar to the Attracted To behavior, the Orbit Around behavior’s default parameter
settings give the object sufficient initial velocity to orbit around another object in a perfect
circle.

Note: Behaviors such as Attractor and Repel applied to nearby objects may disrupt an
object with the Orbit Around behavior applied to it.

Animation path of an 
object affected by the 
Orbit Around behavior

Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Object: A well that defines the object to orbit around. To set the defined target object,
drag the object from the Layers tab to the Object well in the Orbit Around HUD or
Inspector. In the Layers tab, you can also drag the target object onto the Orbit Around
behavior.

Strength: A slider defining the speed at which the object moves.

Falloff Type: A pop-up menu that determines whether the distance defined by the
Influence parameter falls off linearly or exponentially. The default is Linear.

• Linear: Object attraction falls off in proportion to the object’s distance.

• Exponential: The closer an object is within the area of influence, the more strongly it
is attracted, and the faster it moves toward the object of attraction.

508 Chapter 9 Using Behaviors



Falloff Rate: This value determines how quickly the force of attraction between objects
affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting
up to speed as they move toward the object of attraction. A high Falloff Rate causes
objects to accelerate much more slowly. When set to Exponential, the attraction falls off
more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence in pixels. Objects that
fall within the area of influence move toward the object of attraction. Objects that are
outside of the area of influence remain in place.

Drag: The default value for Orbit Around is 0, which results in a stable orbit. Any other
value causes the orbit to decay and the object to spiral into the object of attraction.

Include X, Y, and Z: Buttons that allow you to specify the space in which the orbit occurs.
For example, when X and Y are enabled, the object orbits in the XY plane. In the illustration
below, X and Y are selected in the Include parameter. The yellow motion paths represent
the motion of the white stars around the target object (the orange outlined star). The
light gray box represents the boundary of the group.

In the illustration below, Y and Z are turned on in the Include parameter. The white stars
move around the target object in the YZ plane.
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Pole Axis: This parameter becomes available when the X, Y, and Z axes are enabled in
the Include parameter. Because all points are at a fixed distance from the target or attractor
object (the Pole Axis), the object can be visualized on a sphere of all possible orbits, with
the target object at the center of the sphere. The Pole Axis defines the two points on the
sphere that the orbit must pass through.

• X: The following image illustrates Pole Axis set to X. The light gray box represents the
boundary of the group.

• Y: The following image illustrates Pole Axis set to Y.

• Z: The following image illustrates Pole Axis set to Z.
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• Random: When Random is selected, the axes shift to a different random position.

Direction: A pop-up menu that lets you set whether objects move around in a clockwise
or counterclockwise direction.

HUD Controls
The HUD has an image well you can use to assign an object of attraction, as well as
controls for Strength, Falloff Type, Falloff Rate, Influence, Drag, axis and Pole Axis
assignment, and Direction. When applied to an object that contains multiple objects
(such as a group, particles, text, or the replicator), the Affect Subobjects checkbox also
appears in the HUD.

This image well defines 
the object of attraction.

Related Behaviors
• Attracted To

• Attractor

• Drift Attracted To

• Drift Attractor

• Spring

• Vortex
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Random Motion
The Random Motion behavior animates the position of an object and makes that object
move around the Canvas along a random path.

Animation path of a 
shape affected by the 
Random Motion 
behavior. The shape of 
the path is determined 
by the Seed parameter.

Although the motion created with this behavior appears to be random, it’s actually
predetermined by the particular group of parameters you’ve chosen. As long as you don’t
change the parameters, the animation path created by this behavior remains the same.
If you don’t like the path that was randomly generated, click the Generate button in either
the HUD or the Behaviors tab in the Inspector to pick a new random seed number. This
number is used to generate a new path.

The Random Motion behavior is useful for quickly creating varied animation paths for
large numbers of objects you want to move at the same time. For example, you can create
an arrangement of ten objects in the Canvas and apply the Random Motion behavior to
all of them.

You can also use the Random Motion behavior to add variation to the animation paths
created by other behaviors that affect an object’s position. For example, adding Random
Motion to an object with the Orbit Around behavior results in a more erratic animation
path, although it still orbits as before.

Shape with Orbit Around behavior Orbit Around behavior modified by
Random Motion
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Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Amount: A slider that determines the speed the object moves by changing the length
of the animation path. Higher values result in faster motion and longer animation paths.

Frequency: A slider that determines the number of twists and turns in the animation
path, which can be seen by the crookedness of the resulting animation path. Higher
values create more turns in the animation path. Lower values result in straighter animation
paths.

Noisiness: A slider that determines an additional level of jaggedness along the animation
path shape defined by the Amount parameter. Higher values result in a more
jagged-looking animation path.

Drag: A slider that controls the speed the object moves along the animation path. While
the Amount parameter controls the length of the animation path, the Drag parameter
shrinks or enlarges the animation path as a whole.

Include X, Y, and Z: Buttons that allow you to specify the space in which random motion
is in effect. For example, when X and Y are enabled, the motion occurs in the XY plane;
when Y and Z are enabled, the motion occurs in the YZ plane.

Random Seed: A button that lets you pick a new random seed number. This number is
used to randomly generate new animation paths, based on the values you’ve picked in
the other parameters of this behavior.

HUD Controls
The HUD has controls for the Amount, Frequency, Noisiness, Drag, axis assignment, and
Random Seed parameters. When applied to an object that contains multiple objects (such
as a group, particles, text, or a replicator), the Affect Subobjects checkbox also appears
in the HUD.

Related Behaviors
• Motion Path

• Gravity

• Throw

• Wind
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Repel
If you apply the Repel behavior to an object, that object pushes away all other objects
within the area of influence in the Canvas. The strength with which objects are pushed
away can be increased or decreased, as can the distance repelled objects travel.

Before After

Object with Repel 
behavior

You can also specify which objects are affected by this behavior, creating an effect where
only specific objects are moved, while others remain still.

The Repel behavior is the opposite of the Attractor behavior, and is part of a group of
simulation behaviors that create complex animated relationships between two or more
objects.

Parameters in the Inspector
Affect: A pop-up menu that limits which objects in your project are affected by the Repel
behavior. There are three options:

• All Objects: All objects in the Canvas are affected by the Repel behavior.

• Related Objects: The default setting. Only other objects that are within the same group
as the repelling object are affected.

• Specific Objects: Only objects appearing in the Affected Objects list are affected by the
Repel behavior.

Affected Objects: A list that appears when Specific Objects is chosen in the Affect pop-up
menu. Drag objects from the Layers tab into this list to be affected by the Attractor
behavior when the Specific Objects option is selected in the Affect pop-up menu. To
remove an item from the list, select the item and click Remove.

• Layer: This column lists the name of the layer containing the object.

• Name: This column lists the name of the object itself.
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Strength: A slider defining the speed with which repelled objects move away from the
object. With a value of 0, repelled objects don’t move at all. The higher the value, the
faster repelled objects move.

Falloff Type: A pop-up menu that determines whether the distance defined by the
Influence parameter falls off linearly or exponentially.

• Linear: Repulsion between objects falls off in proportion to the object’s distance.

• Exponential: The closer an object is within the area of influence, the more strongly it
is repelled, and the faster it moves away from the object doing the repelling.

Falloff Rate: This value determines how quickly the force of repulsion between objects
affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting
up to speed as they move away from the object of repulsion. A high Falloff Rate causes
objects to accelerate much more slowly. When set to Exponential, the attraction falls off
more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence in pixels. Objects that
fall within the area of influence move away from the object of repulsion. Objects that are
outside of the area of influence remain in place.

Drag: A slider that can be used to reduce the distance repelled objects travel away from
the repelling object.

Include X, Y, and Z: Buttons that allow you to specify the space in which the objects
move away from the object with the applied Repel behavior. For example, when X and
Y are enabled, the object moves away in the XY plane; when Y and Z are enabled, the
object moves away in the YZ plane.

HUD Controls
The HUD has controls for which objects are affected, as well as for Strength, Falloff Type,
Falloff Rate, Influence, axis assignment, and Drag.

Related Behaviors
• Repel From

Repel From
While the Repel behavior pushes other objects away, the Repel From behavior has the
converse effect, making the object it’s applied to move away from a selected object in
the Canvas.

Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.
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Object: An image well that defines the object to be repelled from.

Strength: A slider defining the speed at which the object is repelled. With a value of 0,
the object is not repelled at all. The higher the value, the faster the object is repelled.

Falloff Type: A pop-up menu that determines whether the distance defined by the
Influence parameter falls off linearly or exponentially.

• Linear: Repulsion between objects falls off in proportion to the object’s distance.

• Exponential: The closer an object is within the area of influence, the more strongly it
is repelled, and the faster it moves away from the object doing the repelling.

Falloff Rate: This value determines how quickly the force of repulsion between objects
affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting
up to speed as they move away from the object of repulsion. A high Falloff Rate causes
objects to accelerate much more slowly. When set to Exponential, the attraction falls off
more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence in pixels. Objects that
fall within the area of influence move away from the object of repulsion. Objects that are
outside of the area of influence remain in place.

Drag: A slider that can be used to reduce the distance the object or objects travel away
from the repelling object.

Include X, Y, and Z: Buttons that allow you to specify the space in which the object
moves away from the selected object. For example, when X and Y are enabled, the object
moves in the XY plane; when Y and Z are enabled, the object moves in the YZ plane.

HUD Controls
The HUD has an image well you can use to assign an object to move away from, as well
as controls for Strength, Falloff Type, Falloff Rate, Influence, axis assignment, and Drag.
When applied to an object that contains multiple objects (such as a group, particles, text,
or the replicator), the Affect Subobjects checkbox also appears in the HUD.

Related Behaviors
• Repel

Rotational Drag
This behavior is similar to the Drag behavior, except that it affects Rotation instead of
position. Rotational Drag simulates friction affecting objects that are spinning due to
keyframed or behavior-driven changes to the Rotation parameter. By setting higher Drag
values, you can slow rotational changes to an eventual stop.
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Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Amount: A slider that can be used to slow down an object’s rotation over time, causing
it to eventually come to a stop. Higher Amount values result in the rotation ending sooner.

HUD Controls
The HUD lets you control the amount of drag. When applied to an object that contains
multiple objects (such as a group, particles, text, or the replicator), the Affect Subobjects
checkbox also appears in the HUD.

Related Behaviors
• Drag

Spring
The Spring behavior creates a relationship between two objects, so that an object with
the Spring behavior applied to it moves back and forth around a second object. The
Attract To parameter defines the object that serves as the target and center of the Spring
behavior. Additional parameters let you adjust the speed of the behavior (Spring Tension)
and the acceleration of the object at each change in direction (Relaxed Length).

If the Attract To object is at rest, the resulting motion is fairly simple and the springing
object moves back and forth in a straight line. If the Attract To object is in motion, the
springing object’s motion will be much more complex, changing direction according to
the velocity of the Attract To object.

Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Attract To: An image well that defines the object of attraction. To set the defined target
object, drag the object from the Layers tab to the Attract To well in the Spring HUD or
Inspector. In the Layers tab, you can also drag the target object onto the Spring behavior.

Spring Tension: A slider that determines how fast the object is pulled toward the object
of attraction.

Relaxed Length: The distance from the target object at which object attraction diminishes
to zero. As the springing object’s distance increases past this point, the force of attraction
increases proportionally, to bring it back toward the target object.
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Repel: With this checkbox selected, when the object gets closer to the object of attraction
than the Relaxed Length value, the objects are pushed apart. When this checkbox is
deselected, no repelling force is applied.

Include X, Y, and Z: Buttons that allow you to specify the space in which the affected
object moves back and forth around the assigned object. For example, when X and Y are
enabled, the object moves back and forth in the XY plane; when Y and Z are enabled,
the object moves back and forth in the YZ plane.

HUD Controls
An image well in the HUD lets you set the Attract To object. You can also control the
Spring Tension and Relaxed Length parameters and axis assignment. A checkbox lets you
turn on the Repel parameter. When this behavior is applied to an object that contains
multiple objects (such as a group, particles, text, or the replicator), the Affect Subobjects
checkbox also appears in the HUD.

Related Behaviors
• Attracted To

• Attractor

• Drift Attracted To

• Drift Attractor

• Orbit Around

• Vortex

Vortex
The opposite of the Orbit Around behavior. While the Orbit Around behavior causes one
object to orbit around another target object, the Vortex behavior exerts a force on all
objects surrounding the object to which the Vortex behavior is applied.

Parameters in the Inspector
Affect: A pop-up menu that limits which objects in your project are affected by the Vortex
behavior. There are three options:

• All Objects: All objects in the Canvas are affected by the Vortex behavior.

• Related Objects: The default setting. Only other objects that are within the same object
as the object of attraction are affected.

• Specific Objects: Only objects appearing in the Affected Objects list are affected by the
Vortex behavior.

Affected Objects: A list that appears when Specific Objects is chosen in the Affect pop-up
menu. Drag objects from the Layers tab into this list to be affected by the Attractor
behavior when the Specific Objects option is selected in the Affect pop-up menu. To
remove an item from the list, select the item and click Remove.

• Layer: This column lists the name of the layer containing the object.
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• Name: This column lists the name of the object itself.

Strength: A slider defining the speed at which the affected objects move about the object
of attraction.

Falloff Type: A pop-up menu that determines whether the distance defined by the
Influence parameter falls off linearly or exponentially. The default is Linear.

• Linear: Object attraction falls off in proportion to the object’s distance.

• Exponential: The closer an object is within the area of influence, the more strongly it
is attracted, and the faster it moves toward the object of attraction.

Falloff Rate: This value determines how quickly the force of attraction between objects
affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting
up to speed as they move toward the object of attraction. A high Falloff Rate causes
objects to accelerate much more slowly. When set to Exponential, the attraction falls off
more quickly than when set to Linear.

Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that
fall within the area of influence move toward the object of attraction. Objects that are
outside of the area of influence remain in place.

Drag: The default value for Vortex is 0, which results in a stable vortex. Any other value
causes the vortex to decay and the object to spiral into the object of attraction.

Include X, Y, and Z: Buttons that allow you to specify the space in which the objects
vortex around the target object. For example, when X and Y are enabled, the object circles
around in the XY plane; when Y and Z are enabled, the object circles around in the YZ
plane.

Pole Axis: This parameter becomes available when the X, Y, and Z axes are enabled in
the Include parameter. Because all points are at a fixed distance from the target or attractor
object (the Pole Axis), the object can be visualized on a sphere of all possible orbits, with
the target object at the center of the sphere. The Pole Axis defines the two points on the
sphere that the orbit must pass through. For more information, see this parameter’s
discussion in Orbit Around.

Direction: A pop-up menu that lets you set whether objects move around in a clockwise
or counterclockwise direction.

HUD Controls
The HUD has a pop-up menu that lets you limit the objects affected by this behavior, as
well as controls for Strength, Falloff Type, Falloff Rate, Influence, Drag, axis assignment,
and Direction.

Related Behaviors
• Attracted To

• Attractor

• Drift Attracted To
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• Drift Attractor

• Orbit Around

• Spring

Wind
Apply the Wind behavior to an object to animate its position and move it in a specified
direction. Unlike the Throw behavior, the velocity specified by the Wind behavior is a
continuous force, and its parameters can be keyframed to achieve gradual changes in
speed and direction.

The Wind behavior is better than the Throw behavior when you want to vary the speed
of the object being animated. You can either apply another behavior (such as Randomize
or Ramp) or keyframe the Velocity parameter of the Wind behavior to vary the speed and
direction of the object. You cannot make gradual changes in either speed or direction
with the Throw behavior.

Parameters in the Inspector
Affect Subobjects: This parameter appears when this behavior is applied to an object
that contains multiple objects, such as a group, a particle emitter, a replicator, or a text
layer. When this checkbox is selected, all objects within the parent object are affected
individually. When this checkbox is deselected, all objects within the parent object are
affected by the behavior together, as if they were a single object.

Air Thickness: A slider and value slider that adjusts how fast the object accelerates on
the X, Y, or Z axis when the speed is changed. Lower values (simulating thinner air) have
less effect when pushing the object, so it takes longer to get up to speed. Higher values
(thicker air) have more effect and push the object up to speed more quickly.

Velocity: A slider and value slider that adjust the speed on the X, Y, or Z axis at which
the simulated air is blowing the object. Higher values result in faster motion.
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HUD Controls
The HUD lets you specify the direction and speed of the Wind behavior by dragging an
arrow within a circular region. The direction of the arrow defines the direction of
movement in X and Y space, and the length of the arrow defines speed (velocity). A slider
to the right lets you adjust the scale of the HUD control, increasing or decreasing the
effect the control has over the object.

Controls direction and 
speed of Wind

Adjusts scale of the HUD 
control

Press the Shift key while dragging the arrow to constrain it to 45 degree angles. Press the
Command key to change the arrow’s direction without affecting its length.

When you click the 3D button, the HUD allows you to use the center arrow control to
define the direction the object is “blown” by the wind in 3D. The Speed slider (on the left
side of the HUD) lets you increase or decrease the velocity of the blown object.

Adjusts velocity of the 
wind

Adjusts the direction of 
the wind in X, Y, and Z 
space

Note: The maximum speed you can define with the HUD is not the maximum speed
possible. Higher values can be entered into the Velocity parameter in the Behaviors tab
of the Inspector.

Related Behaviors
• Motion Path

• Gravity

• Random Motion

• Throw
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Additional Behaviors
Audio, Camera, Motion Tracking, Particles, Replicator, Shape, and Text behaviors are
designed specifically to be applied to their respective objects: Audio files, cameras, particle
emitters or cells, replicators or replicator cells, shapes, and text.

• For more information about Audio behaviors, see Audio Behaviors.

• For more information about Camera behaviors, see Camera Behaviors.

• For more information about Particles behaviors, see Using Particles Behaviors.

• For more information about Replicator behaviors, see Using the Sequence Replicator
Behavior.

• For more information about Shape behaviors, see Shape Behaviors.

• For more information about Text behaviors, see Text Animation and Text Sequence
Behaviors.

• For more information about the Motion Tracking behaviors, including the Track
Parameter behavior, see Motion Tracking Behaviors.

Behavior Examples
The following examples illustrate different ways that groups of behaviors can be combined
to create different effects. The first three examples use content available in Motion, so, if
you want, you can follow along.

Example 1: Using the Gravity and Edge Collision Simulation Behaviors
Gravity makes an object fall over time at a rate specified in the Acceleration parameter.
Unless other behaviors such as Edge Collision are also applied, the object falls off of the
bottom of the Canvas (or moves beyond the top edge of the Canvas if a negative
Acceleration value is used). In this example, a group comprised of three layers (star shapes)
is used to illustrate the Gravity and Edge Collision behaviors.

Note: Although you can apply the Simulation behaviors to single objects, their strength
is in using groups of objects. Some Simulation behaviors, such as Vortex, require the
existence of another object in a project to have any effect. For example, an object with
an applied Vortex behavior needs another object to circle around it; an object with an
applied Orbit Around behavior needs an object to orbit around.

In this case, Gravity is applied to a group that contains three layers (semi-transparent,
colored stars).

To use the Gravity behavior
1 Drag the “5-sided star” shape from the Library (in the Shapes category) to the Layers tab

or Canvas.

2 Press Command-D two times to create two copies of the star.
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3 If you’d like, modify the color and opacity of the stars.

For more information on modifying shapes, see Shape Parameters.

4 In the Layers tab, double-click the group that contains the stars, type “Stars” in the text
field, then press Return.

The group is renamed Stars.

5 Apply the Gravity behavior to the Stars group.

Gravity behavior applied 
to group (not to 
individual layers of the 
group)

The animation path created by the Gravity behavior appears in the Canvas, and the group
of stars falls when you play the project. Because the behavior is applied to the group, all
layers in the group fall at the same rate.

6 To increase the rate of the falling layer, drag the Acceleration slider in the Gravity HUD
or Inspector toward the right (this example uses an Acceleration value of 100).

Note: You can enter a negative number in the Acceleration value field in the Inspector
to make the layer float upward rather than fall.

To use the Edge Collision behavior
1 Apply the Edge Collision behavior to the Stars group.
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2 In the Edge Collision HUD (or Inspector), make sure the Affect Subobjects checkbox is
deselected.

When the Edge Collision behavior is applied to a group, and the Affect Subobjects
parameter is turned off, the entire group is “bounced” off the bottom of the screen at
the anchor point of the group.

When the Edge Collision 
behavior is applied to a 
group and Affect 
Subobjects is turned off, 
the object (group) 
bounces at its anchor 
point off the bottom of 
the screen.

3 In the Edge Collision HUD (or Inspector), select Affect Subobjects.

Note: The Edge Collision behavior Inspector parameters also include Active Edges controls
for turning on and off the edge of the screen (or Z space) against which an object collides.
By default, an object is deflected from all edges of the screen.

When the bottom edge of each star hits the lower edge of the screen, the star is deflected
and bounces upward.

As the project plays, each star bounces up and down.

Other Simulation behaviors that also use the Affect Subobjects parameter include Align
To Motion, Drag, Gravity, Random Motion, and Rotational Drag.

Example 2: Using the Orbit Around Behavior
The Orbit Around behavior makes an object orbit around another object in a perfect
circle. The parameters of the Orbit Around behavior can be modified to create a more
interesting animation.
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You create animation using the Orbit Around behavior by specifying a target object that
other objects circle around. You set the target object by dragging the object to the Object
well in the Orbit Around Behaviors tab.

To use the Orbit Around behavior
1 Using the result of the previous example, delete the Edge Collision and Gravity behaviors

from the project.

2 In the Layers tab, click the Add button (+) to create a new group, then rename the group
“Center.”

3 Option-drag the one of the stars to the new group.

A copy of the layer is added to the group.

4 Rename the copied star “center star,” then position the star in the center of the Canvas.

5 Apply the Orbit Around behavior to the Stars group.

The Orbit Around behavior is applied to the group of stars (“Stars”) in the project. The
center star in the center of the Canvas is in a separate group from the rest of the layers.
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When the Orbit Around behavior is first applied, no animation occurs. This is because
you must specify the layer that the group will orbit around.

6 Drag an object, in this case the “center star” layer, from the Layers tab and drop it in the
Object well of the Orbit Around HUD or Inspector.

This object becomes the target object around which the other objects orbit.

You can alternately drag an object in the Layers tab onto the Object well of the Behaviors
tab.

Important: Dragging an object to a well may be tricky—be sure to click the object name
in the Layers tab and immediately drag the layer to the Object well (without releasing
the mouse button). The behavior must remain active even though you are clicking another
object in the Layers tab. If you click the object you want to drag to the Object well and
then release the mouse button, that object becomes selected, and the behavior’s
parameters are no longer displayed. This is true of all wells, including Mask Source and
Image wells. To show the Orbit Around behavior parameters again, select the Orbit Around
behavior.

Drag the layer to the 
Object well. Release the 
mouse button when the 
curved arrow appears 
above the well.

7 In the Orbit Around HUD (or the Inspector), make sure Affect Subobjects is selected.

When Affect Subobjects is selected, objects within the group move individually around
the target object.

Other Simulation behaviors that also use a target object include Attracted To, Drift Attractor
To, Repel From, and Spring.
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Example 3: Using the Vortex Simulation Behavior
The Vortex behavior is the opposite of the Orbit Around behavior—Orbit Around causes
one object to orbit around another target object, whereas Vortex exerts a force on all
objects surrounding the object to which the Vortex behavior is applied. You can specify
whether All Objects, Related Objects, or Specific Objects are affected by the Vortex.

The following examples use the same group of layers (stars) used in Example 2: Using
the Orbit Around Behavior. For this example, the layers are repositioned in the Canvas.

To use the Vortex behavior
1 Using the result of the previous example, delete the Orbit Around behavior from the

project.

2 Apply the Vortex behavior to the “center star” layer in the Center group.

By default, Related Objects is selected in the Affect parameter of the Vortex behavior.
When Related Objects is selected, all objects that exist in the same group as the object
to which the behavior is applied move around that object. Because the star is the only
object in the Center group, nothing happens.
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3 In the Vortex HUD or Inspector, choose All Objects from the Affect pop-up menu.

When All Objects is chosen, all objects in the project—regardless of the group in which
they exist—are affected and move around the object to which the Vortex behavior is
applied.

Note: If you have a layer that is center-aligned with the layer that has the applied Vortex
behavior (the gradient background in this example), the aligned layer is not affected by
the Vortex behavior. Once you offset its position, the layer is influenced by the Vortex
behavior.

Using the Vortex behavior, there are two ways to create an animation in which only certain
objects (not every object in the project) swirl around the object with the applied Vortex
behavior:

• Set the Affect parameter to Specific Objects and select each layer that you want to swirl
around the target layer.

• Move the object with the applied Vortex behavior into the same group as the star
layers, and set the Affect parameter to Related Objects.
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To affect only Specific Objects
1 In the HUD or Inspector, set the Vortex Affect parameter to Specific Objects (without

moving any layers).

2 If it is not displayed, show the Behaviors tab in the Inspector.

In the Vortex parameters, an Affected Objects list appears.

3 To apply the vortex to specific objects, drag the objects from the Layers tab to the Affected
Objects list. Like the Object wells, you can drop the object when the curved arrow appears
above the list.
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As layers are added, the names of the objects as well as the group in which they exist
appear in the list. When a group is dragged to the Affected Objects list, all layers within
that group are added to the list.

Click Remove to delete a 
layer from the Affected 
Objects list.

Note: Objects from any group in a project can be dragged to the Affected Objects list.
To remove an object, select the object in the list and click Remove.

Any layers that are added to the Affected Objects list swirl around the layer to which the
Vortex behavior is applied.

To affect only Related Objects
1 In the Layers tab, move the object with the applied Vortex behavior into the group that

contains the objects you want to affect. In this case, drag the “center star” object from
the Center group into the Stars group. When the drop menu appears, choose Move Shape
to Group.
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Note: For more information about the drop menu, see Converting Between Shapes and
Masks.

2 In the HUD or Inspector, set the Vortex Affect parameter to Related Objects.

The objects in the group circle around the target object.

Note: Other Simulation behaviors that also use the Affect parameter include Attractor,
Repel, and Drift Attractor.

Example 4: Creating a Clock Animation
In this example, two Parameter behaviors are used to create an animated clock. By
arranging the layers and their anchor points properly, each part’s motion can be created
quickly and easily using the Rate and Oscillate behaviors.

Note: The source files for this example are not included in the Sample Media folder.

To create a clock animation
1 Place the graphics layers constituting the hands, face, and pendulum into the Canvas,

arranging them to create the clock.

The hands are on top, the face in the middle, and the pendulum should be in the back.
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By default, the anchor point is located at the center of each object. Prior to adding
behaviors to animate these layers, you need to move the anchor points so that the layers
move the way they’re supposed to. In this example, the hands should spin about the
center of the clock face, not the center of the hand itself, and the pendulum should swing
from its top.

2 Choose the Adjust Anchor Point tool and move the anchor points of both hand layers
and the pendulum layer to the center of the clock face.

Now that the composition is set up to be animated, the only remaining thing to do is to
assign behaviors to each of the layers.

3 Select the minute hand layer, open the Properties tab in the Inspector, Control-click the
Rotation parameter, then choose Rate from the shortcut menu.

The Rate Parameter behavior is applied to the Rotation parameter.

4 In the Behaviors tab, set the Rate parameter to –49.
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This rotates the minute hand clockwise at a continuous rate.

5 Select the hour hand layer, Control-click its Rotation parameter in the Properties tab, then
choose Rate from the shortcut menu.

6 In the Behaviors tab, set the Rate parameter to –4.

When you play the project at this point, you can see that the hour hand and minute hand
rotate clockwise at rates replicating the relative movement of real clock hands.

Tip: To make the hands of the clock appear to “tick,” you can apply the Quantize Parameter
behavior to the Rotation parameter of the hands and adjust the Step Size to accommodate
your animation.

Now it’s time to make the pendulum swing. You should have already adjusted its anchor
point to be at the top. This way, the bottom pendulum layer will swing properly.

7 Select the pendulum layer, Control-click the Rotation parameter in the Behaviors tab,
then choose Oscillate from the shortcut menu.

8 In the Behaviors tab, set the Oscillate behavior’s amplitude to 20.
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The pendulum layer doesn’t swing so widely.

9 Increase the speed to 50.

This keeps with the overall fast-forward motion of the clock. You’re done!
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Although behaviors are ideal for instantly adding complex motion or effects to an object,
keyframes provide additional precision and flexibility. Keyframes ensure that a particular
event happens on the exact frame you choose. Most common effects utilize some
keyframing. Whenever a movement or effect is timed to match a musical beat or a
particular word in the soundtrack, a keyframe is the best tool for the job. Furthermore,
any effect where multiple objects are affected in a coordinated way is usually the result
of keyframing.

This chapter covers the following:

• What Is Keyframing? (p. 536)

• Using the Record Button (p. 539)

• Applying Movement to a Clip (p. 541)

• Animating Filters (p. 545)

• Animating Behaviors (p. 546)

• Animation Menu (p. 549)

• The Reset Button (p. 551)

• Animating in the Timeline (p. 552)

• Modifying Keyframes in the Timeline (p. 553)

• Animating in the Keyframe Editor (p. 558)

• Filtering the Parameter List (p. 566)

• Modifying Keyframes (p. 573)

• Modifying Curves (p. 581)

• Mini-Curve Editor (p. 591)

• Animating on the Fly (p. 593)

• Keyframe Thinning (p. 595)
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What Is Keyframing?
Keyframing is the process of assigning a specific parameter value to an object at a specific
point in time. For example, you might want a clip to be scaled to fill the screen exactly
five seconds into your project. When you set more than one keyframe, Motion generates
the in-between frames, resulting in a smooth change of that parameter over time. This
is called interpolation. For example, if you want a title to change from green to blue over
time, you would set two keyframes at two different points in time. The first one would
define the text’s color as green, and the second keyframe would set the color to blue.
Motion automatically makes the frames between those points change smoothly from
green to blue.

Motion lets you keyframe parameters such as color values, position, rotation, opacity, and
almost every other parameter in the application.

Animation in Motion
There are several different places in Motion where you can create and edit keyframes and
the values between them, which are represented by animation curves. For example, you
can animate basic properties such as scale, rotation, and screen position by simply
manipulating the object directly in the Canvas when the Record button is enabled.

Record button
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When Record is enabled, a keyframe is created for any parameter that is adjusted. This
includes parameters adjusted in the Canvas, Inspector, or HUD. In the Recording Options
dialog (choose Edit > Recording Options or press Option-A), you can select the “Record
keyframes on animated parameters only” option, which adds keyframes only to parameters
that are already animated (keyframed)—even when Record is enabled. For more
information, see Recording Keyframes on Animated Parameters Only.

You can also use the HUD and the Inspector to set and modify values for nearly every
option in the application. Any time you adjust a slider or other control, you have the
option of locking that change to the current frame, thereby setting a keyframe. From that
point on, no matter what else you do, that parameter always finds its way to that specific
value when playback reaches that frame.

Keyframed Opacity 
parameter

HUD displays current 
value of animated 
Opacity parameter
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You can also view and modify keyframes in the Timeline by clicking the Show/Hide
Keyframes button. Keyframes appear as small blue (or white, when selected) diamonds
beneath their parent object.

Selected keyframeShow/Hide Keyframes 
button

In the Keyframe Editor, you can see and manipulate a graph for every parameter in the
application. Again, keyframes appear as diamonds, and the lines (or curves) connecting
the keyframes indicate the values for the interpolated frames.

Selected keyframe

You can filter the parameter list to show only the parameters and keyframes that you are
interested in.

Animating in the Canvas
The easiest way to perform basic keyframing is to modify objects directly in the Canvas.
The most common effects that you can create with keyframes are changes to Scale,
Rotation, and Position. Additional parameters that can be keyframed in the Canvas include
Shear, Pivot, Drop Shadow, Crop, and Four Corner. While many of these techniques can
also be performed using behaviors, keyframing gives you the added flexibility to set
specific values on precise frames.
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Ordinarily, when you make transformations to an object in the Canvas, the object remains
in the new position or shape for its entire duration. In order to create change in an object
over time, you must create keyframes. There are several ways to create keyframes while
working in the Canvas.

Using the Record Button
One of the simplest ways to create keyframes is to use the Record button. When Record
is enabled, a keyframe is created for any parameter that is adjusted.

Note: When Record is enabled, keyframes are created whether you adjust the object
onscreen, in the HUD, or in the Inspector.

Record button onRecord button off

When keyframing (Record) is enabled, the changes that you apply to the object are applied
at the current playhead position (viewable in the mini-Timeline at the bottom of the
Canvas). A keyframe is automatically added (though no indicator appears). If you move
the playhead to a new position and change the shape or position of the object, you create
a new keyframe. Motion automatically figures out the shape and position of the object
during the frames between the two keyframes you set.

Important: When Record is enabled, a red keyframe appears in the center of the selected
object. When moving the object in the Canvas, do not click the keyframe in the center
of the object as you are actually selecting and repositioning that keyframe instead of the
object’s current position.

To scale an object over time using the Record button
1 Click the Record button (or press A) to turn on keyframe recording.

You can also choose Mark > Record Animation.

2 Select an object in the Canvas.

3 Move the playhead to a new time position.

4 Resize the object by dragging a scale handle.

5 Click the Record button (or press A again) to turn off keyframe recording.

The object is scaled over the interval you set. In this same way, you can keyframe any of
the transformation parameters for your object.

539Chapter 10 Keyframes and Curves



You can also Control-click the object to display a shortcut menu with options for modifying
the Pivot, Shear, Drop Shadow, Four Corner, and Crop parameters. For example, choose
Transform from the shortcut menu to activate scale and rotation handles in the Canvas.
For more information on object transformations in the Canvas, see Transforming Objects
and Layers.

When the Record button is on, each time you move the playhead to a new frame any
change you make to an object automatically generates new keyframes. When animating
an object’s position, an animation path is created.

540 Chapter 10 Keyframes and Curves



Note: To view the animation paths of keyframed objects, ensure that Animation Path is
selected in the View pop-up menu (in the upper-right corner of the main window, above
the Canvas).

When the Record button is off, changes you make modify the entire animation globally.
For example, if an object is keyframed to fly from the lower left to the center of the screen,
dragging the object to the right when the Record button is off moves the entire path to
the right.

Note: If you are positioned on a previously set keyframe, any changes you make modify
that individual keyframe rather than the entire curve, regardless of whether the Record
button is on or off.

Applying Movement to a Clip
Because moving objects onscreen is so fundamental to motion graphics, Motion makes
it especially easy.
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To move an object across the screen
1 Click the Record button (or press A) to turn on keyframe recording.

2 Place the playhead at the starting frame.

3 Place the object in a starting position.

4 Move the playhead forward.

5 Drag the object to the ending position you want.

6 Click the Record button (or press A) to turn off keyframe recording.

If you play back your project, the object flies from position one to position two over the
interval you set. You can see the path the object travels by turning on the Animation
Path setting in the View pop-up menu above the Canvas.

Important: When Record is enabled, you can choose to only add keyframes to an object’s
parameters that are already animated. This option is available in the Recording Options
dialog. For more information, see Recording Keyframes on Animated Parameters Only.
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Manipulating Animation Paths in the Canvas
When the animation path is displayed, you can directly manipulate the keyframes to
reposition them and change the path that the object follows.

When dragging a keyframe in the Canvas, the control point number, as well as the X, Y,
and Z position values, are displayed in an info window at the pointer position.

To add keyframes to an animation path
1 Option-click the path.

A new keyframe point is added.

2 Drag the keyframe point to the new position.

You can convert a linear keyframe point into a Bezier keyframe point to create a curved
path. This can be done either as you create the keyframe, or after the keyframe has been
created.

To add a Bezier keyframe to an animation path
µ Option-click the path, then immediately drag away from the point.

A point is added and a Bezier handle appears.

To change an existing keyframe into a Bezier point
µ Command-click the keyframe and drag away from the point.

Handles are added to the keyframe.

Animation path control points are modified in the same manner as shape or mask Bezier
points. For more information on manipulating Bezier splines, see Drawing Masks and
Shapes Using Bezier Splines.

Animating with the HUD
To keyframe the parameters that appear in the HUD, you follow the same procedure as
keyframing directly in the Canvas. For example, when an object is selected in the Canvas,
the HUD gives quick access to the object’s opacity. If you want to make a custom effect
such as a temporary dip to black, you would keyframe the opacity parameter.
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To animate a clip’s opacity
1 Click the Record button (or press A) to turn on keyframe recording.

2 Place the playhead at the frame where you want to begin the fade.

3 Click the Opacity slider handle in the HUD.

Even if you don’t change the slider’s value, clicking it sets a keyframe at that point in time.
This way the object remains at its previous opacity from the beginning of the clip until
that new keyframe, then begins the interpolation toward the next keyframe.

4 Move the playhead forward to a new time.

5 Change the Opacity value.

6 Move the playhead forward again.

7 Change the Opacity slider again.

8 Click the Record button (or press A) to turn off keyframe recording.

Keyframes at the Beginning and End of the Curve
When you begin adding keyframes, you instruct Motion to automatically modify the
in-between frames to interpolate the effect. But what values are used for the frames
before the first keyframe and after the last one?

By default, when you add your first keyframe, that same value is extended forward and
backward to the beginning and end of the clip (just the same as if you hadn’t added a
keyframe at all).

Once you add a second keyframe, the effect begins to change over time. But the frames
before that first keyframe remain at the value of that first keyframe. Similarly, the frames
after the last keyframe hold at that last defined value.

You can override this default behavior to create loops and other patterns by using the
Before First Keyframe and After Last Keyframe submenus as described in the Extrapolation
section later in this chapter.
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Animating Filters
In addition to making changes to a clip’s basic attributes, keyframing can be used to
modify nearly every parameter in the application. When the Record button is activated,
any parameter displayed on the HUD becomes keyframeable. For example, as you apply
filters to objects, the most important parameters are displayed on the HUD. Using
keyframes, you can animate those parameters. In this way, you can create a shot that
grows more blurry over time, or animate the width of a bevel effect.

To animate a filter
1 Select an object that you want to modify.

2 Apply a filter to the object.

The HUD changes to display the parameters for the filter. For more information on how
to apply filters, see Applying and Removing Filters.

3 Click the Record button (or press A) to turn on keyframe recording.

4 Place the playhead where you want the effect to begin changing.

5 In the HUD, set the parameter slider you want to animate to a beginning value.

6 Move the playhead to the frame where you want the effect to stop changing.

7 Set the slider to a new value.

New playhead position
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8 Click the Record button (or press A) to turn off keyframe recording.

The filter now changes over time to reflect your settings. This same technique can be
applied to any parameter in any filter that appears in the HUD.

Animating Behaviors
In addition to animating filter parameters, you can also animate behaviors. Animating
behaviors might appear complicated at first because most of the behaviors are already
changing, but combining these features is a powerful way to greatly enhance behaviors’
usefulness. For example, you might want to animate a Random Motion behavior to begin
as a subtle random motion and then become increasingly severe as the effect progresses.
Or you might want to apply a Gravity behavior, but you don’t want the object to start
falling toward the ground until five seconds into the clip. Keyframes allow you to
manipulate the specific parameters of each behavior.

Note: In Motion, you can bake all the behaviors that have been applied to an object into
keyframes using the Convert to Keyframes command in the Object menu. For more
information, see Converting Behaviors to Keyframes.

To animate a behavior
1 Select an object in the Canvas.

2 Apply a behavior.

3 Click the Record button (or press A) to turn on keyframe recording.

4 Place the playhead at the frame where you want the effect to begin changing.

5 Using the HUD, adjust the behavior’s settings.

6 Move the playhead to a new time position.

7 Adjust the behavior settings again.

8 Click the Record button (or press A) to turn off keyframe recording.

Animating Using the Inspector
Although you can animate many attributes using the HUD, many other parameters are
only accessible in the Inspector. All of the Inspector’s tabs contain keyframeable
parameters. In this way, you can animate the position and shape of a mask, the color and
styles of a text object, or the various options within the generators. The parameters that
are keyframeable depend on which object is selected and which effects have been applied
to that object.

You can animate parameters in the Inspector using the Record button and the
mini-Timeline playhead just as you would animate parameters in the Canvas or HUD.

To animate parameters in the Inspector
1 Select the object you want to keyframe in the Canvas.
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2 Click the Record button (or press A) to turn on keyframe recording.

3 Place the playhead on the frame where you want the effect to begin.

4 Display the Inspector by clicking the tab or rearranging the screen layout to one that
includes the Inspector.

For more information on layouts, see Preset Layouts.

5 Click the Inspector tab where the parameter you want to modify is located (filters in this
example).

6 Set the parameter to the beginning value.

7 Move the playhead to a new position.

8 In the Inspector, change the parameter to a new value.

9 Click the Record button (or press A) again to disable record.

The parameter now changes over time.
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Combining Behaviors and Keyframes
Because it is possible to add keyframes to an object that may already have a behavior (or
many behaviors) applied, it is possible that these two methods could conflict. For example,
you might apply a Throw behavior toward the upper left, and at the same time add
keyframes that instruct the object to move to the right. Now what?

Behavior motion path Keyframe animation path

The way Motion handles this sort of conflict is that the instructions are added together,
giving you a combination of the two sets of instructions. In the above example, the object
would move toward the upper left, but it won’t get as far, because the keyframes are
pushing it in an opposing direction.

Combined animation path

The larger the Throw velocity rate, the more it overpowers the keyframes, and vice versa.
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Once you get the hang of how it works, you can use this method to enhance and control
the effects of behaviors. For example, you could apply a Gravity behavior which causes
an object to fall toward the bottom of the frame, but keyframe the object’s position to
move across the screen from left to right. In this way, you can create the effect of the
object falling as it moves. Or you might apply a Fade In/Fade Out behavior, but use
keyframes on the object’s Opacity parameter to limit the maximum opacity to 80%. The
clip would still fade in and out and you could continue to modify the behavior’s attributes,
but the object would never exceed the opacity value set by the keyframes.

One method for handling behaviors and keyframes is to convert behaviors to keyframes.
For more information on converting behaviors to keyframes, see Converting Behaviors
to Keyframes.

Animation Menu
Animating in the Inspector provides additional options, such as the ability to delete or
reset keyframe information. You can also navigate between keyframes in the Inspector.
Every keyframeable parameter contains an Animation menu. If a parameter lacks a menu,
it cannot be animated.

• Enable/Disable Animation: This menu item remains unavailable until animation is applied
to the parameter either by using the Record button or by directly adding a keyframe.
Once the parameter has at least one keyframe set, the menu item is automatically
renamed Disable Animation. Choosing Disable Animation at that point effectively hides
the keyframes you have set, restoring the parameter to its default value. However, the
keyframes are not thrown away. Choosing Enable Animation again restores the
parameter to its last keyframed state.

• Reset Parameter: Removes all keyframes and settings for this parameter. The parameter
value is reset to its default value.

549Chapter 10 Keyframes and Curves



• Add Keyframe: Adds a keyframe at the current frame in the project. If the playhead is
positioned on a frame where a keyframe has already been added, this menu command
is unavailable. To quickly add a keyframe without accessing the Animation menu in
the Inspector, press Control-K. A keyframe is automatically added to the last modified
parameter of the object (regardless of the status of the Record button) at the current
time.

Note: To add a keyframe, you can also position the pointer over the Animation menu
and press Option. When the keyframe icon appears next to the pointer, click to add a
keyframe.

• Delete Keyframe: Deletes the current keyframe. The Delete Keyframe option is available
only if the playhead is positioned on a frame where a keyframe already exists.

• Previous Keyframe: Moves the playhead to the previous keyframe for this parameter.
The Previous Keyframe command is available only if a keyframe exists earlier in the
project.

• Next Keyframe: Moves the playhead to the next keyframe for this parameter. The Next
Keyframe command is available only if a keyframe exists later in the project.

• Show in Keyframe Editor: This opens the Keyframe Editor and displays the selected
parameter’s keyframes and curves. For more information on working with the Keyframe
Editor, see Animating in the Keyframe Editor.

To set keyframes using the Animation menu
1 Enable Record (press A), then move the playhead to the frame where you want to set the

first keyframe.

2 Change the value of the parameter you want to keyframe.

3 Click the Animation menu, then choose Add Keyframe.

A keyframe is added at the current frame.

4 To set another keyframe for the same parameter, move the playhead to the next location
and adjust the parameter.

A keyframe is automatically added when you change the parameter.

To navigate to a keyframe
1 Click the Animation menu for the parameter containing the keyframe you seek.

2 Choose Previous Keyframe if the desired keyframe is earlier in time than the current time
position, or choose Next Keyframe if the desired keyframe is later in time than your current
time position.

Note: You can also choose Mark > Go To > Previous Keyframe (or press Option-K) or Mark
> Go To > Next Keyframe (or press Shift-K) to move from keyframe to keyframe.

To delete a keyframe
1 Navigate the playhead to the frame where the keyframe is currently set.
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2 Click the Animation menu for the parameter you want to change, then choose Delete
Keyframe.

Note: To delete all of the keyframes for a parameter, choose Reset Parameter from the
Animation menu.

To reset all keyframes for a parameter
µ Click the Animation menu for the parameter you want to reset, then choose Reset

Parameter.

All keyframes are removed for that parameter.

Animation Menu States
Depending on whether or not a parameter is currently animated, and whether or not the
playhead is positioned on a keyframe, the Animation menu displays a different icon. This
provides the ability to determine the status of that parameter at a glance.

Keyframed parameter

Parameter is not 
animated
Behavior applied to 
parameter

Keyframed parameter 
with keyframe at current 
frame

The Reset Button
Each parameter set in the Inspector is equipped with a reset button. A parameter set
might be a filter, or it might be a category of effects or transformations, such as Transform,
Blending, or other items in the Properties tab.

Reset button
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The reset button removes all keyframes applied to all of the parameters within the set
and restores those parameters to their default state.

Animating in the Timeline
When keyframing, it is often very helpful to view your keyframes over time. This lets you
line up keyframes with other important timing elements in your project such as edit
points, sound cues, markers, and even other keyframes. These functions are available in
the Timeline.

Keyframe

In order to view your keyframes in the Timeline, you must first turn on the Show Keyframes
option.

To show keyframes in the Timeline
µ Click the Show/Hide Keyframes button.

Show/Hide Keyframes 
button
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You can identify a keyframe’s value in the shortcut menu. Multiple keyframes on the same
frame are all listed in the menu.

To display a keyframe’s value
µ Control-click the keyframe in the Timeline.

A shortcut menu appears. The first items in the list are the keyframe values for any
keyframes on that frame.

Note: There is no way to add keyframes in the Timeline.

Modifying Keyframes in the Timeline
When keyframes are visible in the Timeline, you can change their positions in time by
dragging them horizontally in the track. This does not modify the keyframe’s parameter
value, it just changes the position in time when the keyframe occurs.

To move a keyframe in the Timeline
1 Click the Show/Hide Keyframes button in the Timeline.

Any keyframes in the project become visible.

2 Identify the object where the keyframe is located.

3 Drag the keyframe to the left or right to move it forward or backward in time.

Although moving a keyframe in time does not change the parameter’s value, it can have
a significant effect on the nature of the animation. For example, if you have two keyframes
that animate an object from the top of the screen to the bottom over five seconds, moving
one of the keyframes forces the animation to occur more slowly (if you drag them farther
apart) or more quickly (if you drag them closer together).

When there are multiple keyframe values set in the same frame, you can choose any value
to edit individually, though the values are represented by a single keyframe marker in
the Timeline.

To edit a keyframe value already present in the Timeline
1 Control-click the keyframe.
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A shortcut menu appears. The first items in the list are the keyframe values for any
keyframes on that frame.

2 Choose the keyframe value you wish to edit.

3 Type a new value into the value field, then press Return.

Note: To exit an active value field without making any changes, press Esc.

Aligning Keyframes with Other Objects
One of the main advantages of manipulating keyframes in the Timeline is the ability to
line up a keyframe with another important time marker. For example, you may want to
align a filter keyframe applied to one object with an object in another track.

To align a keyframe to another object
1 Click the Show/Hide Keyframes button in the Timeline.

Any keyframes in the project become visible.

2 Identify the keyframe you want to move.

Note: Control-clicking a keyframe in the Timeline displays a shortcut menu containing
the parameter name and value for each keyframe. If more than one keyframe is at the
same point in time, the shortcut menu lists all of them.

3 Drag the keyframe until it lines up with the edge of the object.
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If you press the Shift key while you drag, the keyframe snaps to the edges of other objects.

You can use this same technique to align keyframes from one object to keyframes in
another object. In this way, you can arrange two objects to both fade in or blur into focus
at exactly the same frame. It doesn’t matter whether the objects are in the same group
or not.

To align keyframes of multiple objects
1 Click the Show/Hide Keyframes button in the Timeline.

Any keyframes in the project become visible.

2 Identify the keyframe you want to move.

3 Find the object containing the parallel action.

4 Drag the keyframe in the first object until it lines up with the corresponding keyframe in
the second object.

Aligning Keyframes to Markers
Other objects in your Timeline can also serve as guides for where to move your keyframes.
For example, you may have a music cue or line of narration where you want a particular
effect to end or change.

One great way to do this is to use time markers. Simply identify the important frame with
a marker and drag the keyframe until it lines up with the marker. Markers create snap
points, so pressing Shift while you drag a keyframe makes it snap to markers. To learn
more about setting markers, see Adding Markers.
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To align a keyframe with a marker
1 Click the Show/Hide Keyframes button in the Timeline.

Any keyframes in the project become visible.

2 Identify the keyframe you want to move and drag it to the marker.

3 Press the Shift key while you drag to enable snapping.

The keyframe snaps to the marker.

Deleting Keyframes in the Timeline
If you ever need to remove a keyframe, or clear all keyframes from a particular object,
you can delete keyframes using the shortcut menu in the Timeline.

To delete a keyframe in the Timeline
1 Click the Show/Hide Keyframes button in the Timeline.

Any keyframes in the project become visible.

2 Control-click the keyframe you want to delete, then choose Delete Keyframes from the
shortcut menu.

To delete all keyframes from an object
1 Click the Show/Hide Keyframes button in the Timeline.

Any keyframes in the project become visible.

2 Control-click any keyframe for the object you want to clear, then choose Delete All
Keyframes from the shortcut menu.

For more precise control of effects using keyframes, you can use the Keyframe Editor.
Any keyframe in the Timeline can be viewed in the Keyframe Editor using the shortcut
menu.

To view a keyframe in the Keyframe Editor
µ Control-click the keyframe in the Timeline, then choose Show in Keyframe Editor from

the shortcut menu.

The Keyframe Editor is brought to the front and the keyframe (and the rest of that
parameter) is highlighted in the graph.
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Trimming Keyframed Effects
When the duration of an effect such as a filter or behavior in the Timeline is changed,
keyframes applied to that object are scaled accordingly. This means that an effect
keyframed to change over time speeds up or slows down if the object it is applied to is
shortened or lengthened.

After

Before

Changing the duration of an object does not modify keyframes applied to attributes in
the Properties or Object tab in the Inspector. Keyframes appear in the area underneath
the object bar if you choose to show keyframes in the Timeline.

You can also speed up or slow down a keyframed effect by resizing the effect bar in the
Timeline.

557Chapter 10 Keyframes and Curves



You can prevent this automatic resizing by pressing Command while resizing an effect
object. This changes the overall duration of the effect, but does not alter the speed at
which the effect changes as determined by the keyframes.

Pressing Command while you resize an object with effects applied trims the object without
trimming the effects. This works the same way as trimming a group without modifying
the durations of the component elements.

Animating in the Keyframe Editor
Whenever you create two or more keyframes, Motion generates interpolated values for
the frames that come between. These are called curves. The Keyframe Editor is the control
that allows you to view and make modifications to those curves. This feature provides
one of the most sophisticated and powerful ways to modify the objects and effects in
your project.

Viewing the curves for your animated parameters gives you another way to understand
how your effect is changing over time. The curves are laid out over a graph where you
can compare the curves of different parameters. As you get more familiar with “reading”
the graphs, you will learn how and why certain effects feel organic or synthetic.
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In the Keyframe Editor you can add and delete keyframes, as well as move them in
two-dimensional space to modify their values (up-down) and their positions in time
(left-right). You can also directly manipulate the curves themselves with the tools Motion
provides. Furthermore, you can define a variety of interpolation methods, creating
dramatically different types of effects. You can also apply Parameter behaviors directly
to curves in the Keyframe Editor by Control-clicking the curve name and choosing a
Parameter behavior from the shortcut menu. For more information about Parameter
behaviors, see Parameter Behaviors.

For example, in the real world, when objects move, they observe rules of physics, such
as inertia and momentum. Motion’s Keyframe Editor allows you to simulate these sorts
of effects in your motion graphics.

Check Your Selection
The parameters that are available in the Keyframe Editor depend on which objects are
selected in the other windows. If you select one item in the Layers tab, Canvas, or
Timeline, only parameters for that object are accessible in the Keyframe Editor.

If you want to compare curves from parameters across multiple objects (for example to
make two separate objects begin fading in at the same time), you must select both
items in the Layers tab, Canvas, or Timeline. Then parameters for both objects are listed
in the Keyframe Editor.

Additionally, you can modify curves on an group if it is selected instead of the objects
within it. In this way, you can view or modify keyframe activity that affects all of the
objects within the group.

To display the Keyframe Editor
Do one of the following:

µ If the Timing pane is already visible, click the Keyframe Editor tab in the Timing pane.

µ Choose Window > Keyframe Editor.

µ Press Command-8.
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Parts of the Keyframe Editor
The Keyframe Editor is made up of a list of parameters on the left and a multi-functional
graph on the right.

Zoom controls

Animation menu

Curve graph

Show pop-up menu

Control buttons

Keyframe editing tools

Current frame field

Show Pop-Up Menu
The Show pop-up menu lets you filter the parameters displayed in the Keyframe Editor,
allowing you to focus on only those parameters that you want to modify. For more
information, see Working with the Show Pop-Up Menu.

Current Frame Field
This field lets you instantly jump to any frame in your project. Because it is also a value
slider, you can drag in the field to move the playhead to a new frame.

To move to a frame
Do one of the following:

µ Double-click in the value field, type a frame number, then press Return.

The playhead moves to the specified frame.

µ Drag the current frame value slider left or right. Dragging to the left moves the playhead
earlier in time. Dragging to the right moves it forward in time.

Keyframe Edit Tools
There are three different tools available to assist in editing keyframes and curves in the
Keyframe Editor. For more information about using these tools, see Modifying Keyframes.

Edit: Select and edit keyframes.

Sketch: Draw curves with keyframes.
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Box: Drag a selection box to enclose and manipulate keyframes.

Edit tool (default)

Sketch tool

Box tool

Parameter List
Any keyframeable parameters of your selected items can be displayed in the list on the
left side of the Keyframe Editor tab. This includes object properties, filters, and behaviors.
By selecting multiple items in the Layers tab or Timeline, you can compare parameters
across multiple objects.

Activation checkbox: The checkbox on the left determines which parameters are displayed
in the graph. Checked parameters are considered “active.”

Parameter name column: The second column lists the object name and the parameter
names for each object.

Value column: The third column displays the parameter value for the frame where the
playhead is currently positioned. If the playhead is parked on a keyframe, the field shows
the value for that keyframe. If the playhead is not parked on a keyframe, the field shows
the value of that parameter at that frame. For more information on changing the values
of keyframes, see Modifying Keyframes.

You can click the value to activate the field. When Record is enabled, a keyframe is
automatically added if you click the value field at a frame that has no keyframe. To type
a value in the field, double-click it.

Note: Selecting a keyframe does not display the value of that keyframe, it shows the value
for a parameter at the frame where the playhead is currently positioned.

Animation menu: The fourth column contains a pop-up menu that mimics the Animation
menu found in the Inspector. However, the Animation menu in the Keyframe Editor
contains several commands not found in the Inspector.

• Enable/Disable Animation: This command remains unavailable until keyframing is applied
to the parameter, either by using the Record button or by directly adding a keyframe.
Once the parameter has some animation applied, the command is automatically
renamed Disable Animation. Activating it at that point effectively hides the keyframes
you have set, restoring the parameter to its default value. However, the keyframes are
not thrown away. Choosing Enable Animation restores the parameter to its last
keyframed state.

• Reset Parameter: Removes all keyframes and settings for this parameter. The parameter
value is reset to its default value.
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• Add Keyframe: Adds a keyframe at the current frame in the mini-Timeline. If the playhead
is positioned on a frame where a keyframe has already been added, this command is
unavailable.

Note: As mentioned in the Animation menu section, you can use a keyboard shortcut
to quickly add a keyframe by pressing Control-K. A keyframe is automatically added to
the last modified parameter of the object.

• Delete Keyframe: Deletes the current keyframe. The Delete keyframe command is
available only if the playhead is positioned on a frame where a keyframe already exists.

• Previous Keyframe: Moves the playhead to the previous keyframe for this parameter.
The Previous Keyframe command is available only if a keyframe exists earlier in the
project.

• Next Keyframe: Moves the playhead to the next keyframe for this parameter. The Next
Keyframe command is available only if a keyframe exists later in the project.

• Interpolation: Sets the type of curve for the parameter. See the table in the Modifying
Curves section later in this chapter for examples of the different interpolation methods.
Choose from Constant, Linear, Bezier, Continuous, Ease In, Ease Out, Exponential, or
Logarithmic.

• Before First Keyframe: Defines what happens between the first keyframe and the
beginning of the clip. See the table in the Extrapolation section later in this chapter for
examples of the different extrapolation methods. Choose from Constant, Linear, Ping
Pong, Repeat, or Progressive. You can also turn the extrapolation into actual keyframes
by choosing Generate Keyframes.

• After Last Keyframe: Defines what happens between the last keyframe and the end of
the clip. See the table in the Extrapolation section later in this chapter for examples of
the different extrapolation methods. Choose from Constant, Linear, Ping Pong, Repeat,
or Progressive. You can also turn the extrapolation into actual keyframes by choosing
Generate Keyframes.

• Lock/Unlock Parameter: Locks this parameter from further changes. When a parameter
is locked, neither keyframes nor curves are adjustable.
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• Reduce Keyframes: Opens the Reduce Keyframes dialog, which allows you to apply a
thinning algorithm to the keyframes for the chosen parameter. This reduces the number
of keyframes in a parameter while attempting to maintain a similar shape to the curve.
The thinning algorithm can be adjusted in two ways. Increasing the Maximum Error
Tolerance results in fewer keyframes. Increasing the Smoothing Factor makes smoother
curves between keyframe values.

• Set to Curve Snapshot: If “Take/Show curve snapshot” is turned on (in the lower-left
corner of the Keyframe Editor), this option will revert any keyframe changes made in
the currently selected curve back to the most recent snapshot. For more information,
see Curve Snapshots.

Curve Graph
A graph appears to the right of the parameter list and displays the curves for your selected
parameters. The graph has a time ruler at the top and a zoom/scroll control at the bottom
that are identical to the corresponding controls in the Timeline. These allow you to identify
at what time keyframes appear, as well as see project markers, playback In and Out points,
and the playhead. Using the zoom controls at the bottom of the graph, you can zoom in
to obtain much more precise control over keyframe positioning and curve shape. For
more information on using the zoom/scroll controls, see Zooming in the Timeline.

The body of the graph displays the keyframes and curves of active parameters. Each
parameter is a different color, though some colors are duplicated.

Control Buttons
In the Keyframe Editor, several buttons provide additional control over the Keyframe
Editor window: Snapping, “Show audio waveform,” and “Fit visible curves in window.”
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Snapping: When Snapping is enabled, keyframes snap to markers, other keyframes, and
other snappable items.

Snapping enabled

Show audio waveform: Turns on display of the audio waveforms for the selected item
in the background of the graph. This lets you line up an effect to take place at the same
time as an event that occurs in the audio.

“Show audio waveform” 
enabled

Note: If there are multiple audio tracks in the project, a pop-up menu at the bottom of
the Keyframe Editor allows you to view the waveform of any individual audio track in the
project, or the master track.

Fit visible curves in window: Automatically scales the curve graph to include all of the
keyframes of your active parameters.
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There are times when the values of your keyframes may exceed the vertical resolution of
the graph. For example, as you stretch a keyframe, you can drag it so far that you force
the window to scroll.

When you click this button, Motion automatically rescales the graph both vertically and
horizontally so that your curve is entirely visible.

“Fit visible curves in 
window” button

The values of your keyframes are not changed.

Auto-scale vertically: Click the “Auto-scale vertically” button (the magnifying glass in the
upper-right corner of the Keyframe Editor) to stretch the graph to fit all of the curves
currently in view.

“Auto-scale vertically” 
button
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When “Auto-scale vertically” is on, the range of the graph increases to accommodate
your entire curve even as you change it. For example, if you drag a keyframe up to increase
its value, as you drag past the top of the window, the whole graph is rescaled, rather than
scrolled.

This can be disconcerting at first because it might appear that your curve refuses to get
bigger even as you drag your keyframe. However, if you watch the values at the left side
of the window, you can see that the graph is being zoomed vertically to make room for
your wider range of values.

Filtering the Parameter List
Effective use of the Keyframe Editor requires controlling the list of parameters currently
on display in the curve graph. While you may want quick access to all of the different
parameters you are animating, displaying too many parameters at once makes the graph
difficult to read. Motion provides the ability to store sets of parameters to facilitate this
management.

Working with the Show Pop-Up Menu
The Show pop-up menu allows you to display ten built-in parameter curve sets as well
as custom sets you build yourself.

The first option in the Show pop-up menu lets you view all parameters associated with
a selected object (or multiple selected objects).

To view all of the parameters for all selected objects
µ Choose All from the Show pop-up menu.
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By default, only the animated parameters are active in the graph. Turn individual
parameters on and off by clicking the activation checkbox to show or hide them in the
graph. You can choose to display all parameters associated with a particular group or
object by checking or unchecking the checkbox for that group or object.

Animated Curve Sets
Alternatively, you can elect to view only the parameters that are currently animated—in
other words, parameters that already contain one or more keyframes. The next options
in the Show pop-up menu display these dynamic parameters.

To view only animated (keyframed or behavior-influenced) parameters
Do one of the following:

µ Choose Animated from the Show pop-up menu.

µ With the Keyframe Editor active, press U.

Any parameters with one or more keyframes are displayed.

To view parameters that have been changed from their default values
Do one of the following:

µ Choose Modified from the Show pop-up menu.

µ With the Keyframe Editor active, press Y.

This option shows only the parameters that have been modified from their default values,
or are currently being modified (in the Canvas, Inspector, or HUD).

To view only parameters that are currently active
µ Choose Active from the Show pop-up menu.

When Active is selected and you are moving an object around in the Canvas, the X and
Y Position parameters and curves are displayed.

Related Curve Sets
The next six options in the Show pop-up menu display specific parameters, animated or
not. If you need to check the position of several related objects in a project, using the
Position curve set makes this a lot easier. Multiple related curve sets can be displayed at
the same time so you won’t have to switch back and forth between them. Each of these
built-in curve sets has an associated keyboard shortcut.
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To view only the Position parameters for a selected object
Do one of the following:

µ Choose Position from the Show pop-up menu.

µ With the Keyframe Editor active, press P.

The Position parameters for the selected object are displayed.

To view only the Rotation parameters for a selected object
Do one of the following:

µ Choose Rotation from the Show pop-up menu.

µ With the Keyframe Editor active, press R.

The Rotation parameters for the selected object are displayed.

To view only the Scale parameters for a selected object
Do one of the following:

µ Choose Scale from the Show pop-up menu.

µ With the Keyframe Editor active, press S.

The Scale parameters for the selected object are displayed.

To view only the Shear parameters for a selected object
Do one of the following:

µ Choose Shear from the Show pop-up menu.

µ With the Keyframe Editor active, press H.

The Shear parameters for the selected object are displayed.

To view only the Anchor Point parameters for a selected object
Do one of the following:

µ Choose Anchor Point from the Show pop-up menu.

µ With the Keyframe Editor active, press A.

The Anchor Point parameters for the selected object are displayed.

To view only the Opacity parameter for a selected object
Do one of the following:

µ Choose Opacity from the Show pop-up menu.

µ With the Keyframe Editor active, press O.

The Opacity parameter for the selected object is displayed.
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Custom Parameter Sets
In addition to using the built-in curve sets, you can make and manage your own using
the last two options in the Show pop-up menu. As you create and store custom parameter
sets, they appear in the Show pop-up menu so you can switch quickly between them.
Deleting, duplicating, and modifying custom sets is done in the Manage Curve Sets dialog
(accessible from the Show pop-up menu).

To create a new parameter set
1 Choose New Curve Set from the Show pop-up menu.

A dialog appears.

2 Type a name for the set, then click OK.

Once your set has been created, you can choose it from the Show pop-up menu.

There are several ways to add a custom parameter set to the Keyframe Editor.

To add parameters to a custom parameter set
Do one of the following:

µ Drag a parameter name from any of the tabs in the Inspector directly into the Keyframe
Editor parameter list.
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µ Click the Animation menu for the desired parameter, then choose Show in Keyframe
Editor.

The parameter is added to the custom curve set.

Note: If Animated is chosen from the Show pop-up menu when you use the Show in
Keyframe Editor command from the Animation menu, a new untitled curve set is
automatically created.

µ With the Keyframe Editor active, hold down the Shift key and press one of the keyboard
shortcuts for the built-in related curve sets. For more information, see Related Curve Sets.

Note: If you press the same relative curve set keyboard shortcut more than once
sequentially, you create a new custom curve set with a new name each time.

To delete parameters from a custom set
µ Drag the parameter out of the list. It disappears with a “poof” animation.

To delete all parameters from a custom set
µ Click the “Clear curve list” button in the lower left corner of the Keyframe Editor.

“Clear curve list” button

To delete a custom parameter set
1 Choose Manage Curve Sets from the Show pop-up menu.
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The Manage Curve Sets dialog appears.

2 Select the name of the set you want to delete.

3 Click the Delete button (–) at the top of the dialog.

The set is deleted.

4 Click Done to close the dialog.

To duplicate a custom parameter set
1 Choose Manage Curve Sets from the Show pop-up menu.

The Manage Curve Sets dialog appears.

2 Select the name of the set you want to duplicate.

3 Click the Duplicate button at the top of the dialog.

The set is duplicated.

4 Double-click the set name in the list, then type a new name for the set.

5 Click Done to close the dialog.

The new set now appears in the Show pop-up menu. These sets are saved with the project,
so each time you reopen the project, they are available to you. Store as many parameter
sets as you like. Once you have a set stored, you can change or delete that set as needed.

Saving Animation Curves
Animation curves can be saved in an existing folder in the Library, such as the Favorites
category, or you can create a new folder within an existing category. Once an animation
curve is placed into the Library, it can be added to an object in any project. Animation
curves saved in the Library appear with a custom icon.

Note: Items that are saved to the Library appear in the Finder with a .molo extension
(“Motion Library object”). These items cannot be opened from the Finder.

You can save multiple curves to the Library as one file or multiple files. For example, if
you create an animation that uses multiple curves and you want to save the cumulative
effect of the animation, you can save all of the curves as one item in the Library.
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Although you can save animation curves into the Content category, it is generally
recommended that you save items that you use frequently in the Favorites
category—some Motion Library categories contain so many items that utilizing the
Favorites or Favorites Menu categories may save you search time. Within the Favorites
category, you can create additional folders to assist you in better arranging your custom
items.

You can also create new folders in existing categories. You can create a new folder in the
Favorites, Favorites Menu, or Content category. Folders created in the Content category
appear in the Library sidebar. Folders created in the subcategories, such as the Basic
Motion subcategory, appear in the Library stack and not the sidebar. For more information
on creating folders in the Library, see Saving and Sharing Custom Behaviors.

Animation curves that are saved to the Favorites Menu category can be quickly applied
to objects using the Favorites menu.

To save an animation curve to the Library
1 Open the Library and select the Content, Favorites, or Favorites Menu category.

2 Drag the name of the parameter animation curve you want to save from the parameter
list in the Keyframe Editor into the stack at the bottom of the Library.

When you save an animation curve, it’s saved in the /Users/username/Library/Application
Support/Final Cut Studio/Motion/Library/ folder.

Note: If an animation curve is dragged to another subcategory, such as the Glow (Filters)
subcategory, it is automatically placed in the Content category and the Content category
becomes active.

To save multiple animation curves to the Library
1 Open the Library and select the Content, Favorites, or Favorites Menu category.

2 In the parameter list of the Keyframe Editor, select all of the animation curves you want
to save and drag them to the stack, holding down the mouse button down.

3 When the drop menu appears, choose “All in one file” or “Multiple files.”

“All in one file” saves all the animation curves together, listed as one item in the Library.
“Multiple files” saves the curves as individual items in the Library.

4 To name the file or files, do one of the following:

• Control-click its icon in the Library stack, choose Rename from the shortcut menu, then
type a new descriptive name.

• Select the icon, click its name, then type a new descriptive name.
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Note: When you Control-click an animation curve icon in the Library stack, the Edit
Description shortcut menu item becomes available. This is a handy tool that allows you
to enter custom notes about an item saved in the Library. Once you choose Edit
Description, enter your notes in the text field, then click OK.

Modifying Keyframes
The Keyframe Editor provides an ideal environment for manipulating your keyframes
because you can see their values, placement in time, and how the changes you make
affect the interpolative curves surrounding your keyframes.

Curve Snapshots
When modifying keyframes, it is often helpful to have a frame of reference for your curves.
This is useful both as a guide as you’re editing, and as a safety net in case you make some
changes, then decide to go back to your curve’s original state.

To take and show curve snapshots
µ Click the “Take/Show curve snapshot” button at the bottom of the Keyframe Editor.

Now, as you move keyframes in the Keyframe Editor, the original curve—as it appeared
when you took the snapshot—is represented by a lighter color. As long as you remain
in the Keyframe Editor editing the current set of curves, the snapshot curve will remain
available.

Original curve (pink)

New curve (white)

If, after editing a curve, you wish to revert back to the snapshot, you can do so from the
Animation menu in the Keyframe Editor.

To revert a curve back to its most recent snapshot
µ From the Animation menu in the Keyframe Editor, select Set to Curve Snapshot.

The curve reverts to the state of its last snapshot.

Important: If you leave the Keyframe Editor, or load a different set of curves into the
Keyframe Editor, curve snapshots are taken again, replacing the previous curve snapshots.
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Using the Edit Tool
To use the following set of instructions, first select the Edit tool from the keyframe edit
tools in the Keyframe Editor.

Edit tool

To change the value of a keyframe
Do one of the following:

µ Click the keyframe you want to modify, then drag the keyframe along the Y axis (up and
down) to change its value. To change its position in time, drag along the X axis (left to
right).

Press the Shift key while dragging to constrain movement to one axis.

When dragging a keyframe in the graph, numbers appear indicating the new position
and value of the keyframe. The first number is the frame number and the second number
is the parameter value.

ValueFrame number

When you drag two keyframes closer together along the X axis, the transformation
between those values happens more quickly. When you drag keyframes farther apart
from each other, the change happens more slowly.
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µ Double-click the keyframe you want to modify, type the new value into the value field,
then press Return.

Keyframe value

Current frame

This changes the value of the keyframe along the Y axis (up and down).

Note: To get out of an active value field without making any changes, press Esc.

µ Drag in the value slider in the parameter list.

• Drag to the right to increase the value of the keyframe along the Y axis.

• Drag to the left to decrease the value of the keyframe along the Y axis.

• Press Shift while dragging to change the value in increments of 10.

• Press Option while dragging to change the value in increments of .01.

In addition to modifying existing keyframes, you can add and delete keyframes right in
the graph.

To add a keyframe
1 Press the Option key and move the pointer over the parameter curve you want to modify.

The pointer turns into a plus sign (+).

2 Click the curve at the frame where you want the keyframe to appear.

3 Drag the keyframe to your preferred value.

Note: You can also add a keyframe at the current playhead position by choosing Add
Keyframe from the Animation menu for any parameter, or by double-clicking the curve.

Curves created when new keyframes are added are set to the Bezier interpolation method.
For more information on interpolation methods, see Modifying Curves.
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To delete a keyframe
Do one of the following:

µ Select the keyframe, then press Delete.

Note: You can drag to select multiple keyframes.

µ Control-click the keyframe, then choose Delete from the shortcut menu.

µ Navigate to the keyframe, then choose Delete Keyframe from the Animation menu for
that parameter.

To delete all of the keyframes for a parameter
µ Click the Animation menu in the parameter list, then choose Reset Parameter.

Note: You can also use the Animation menu in the Inspector.

Controlling Keyframes
In addition to deleting keyframes, you can lock or disable them. Also, there are special
settings in the shortcut menu for keyframes that you can apply to control the shape of
your curve. For more information, see Modifying Curves.

To lock or disable a keyframe
µ Control-click the keyframe you want to modify, then choose Lock or Disable from the

shortcut menu.

Lock prevents any further modification to that keyframe. Disable makes a keyframe
temporarily ignored without deleting it.

Copying and Pasting Keyframes and Animation Curves
Keyframes and the animation curves they form can be moved from one parameter to
another using copy and paste commands. This technique can be useful for copying a
particular keyframe effect from one object to another, moving a keyframe path earlier or
later in the same parameter, or for creating keyframes on one parameter and applying
them to another parameter.

To copy keyframes, you must select the keyframes you want to copy, either individually,
or as an entire channel or channels.

To select keyframes
Do one of the following:

µ Using the Edit tool, drag a selection box around the keyframes you want to select.
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µ Shift-click the keyframes you want to select.

If only the curve (and not 
the keyframes) appears 
white, the keyframes are 
not selected.

Selected keyframes 
appear white.

Once you have the keyframes selected, you can cut or copy them to move them to the
Clipboard.

To copy selected keyframes
µ Choose Edit > Copy (or press Command-C).

To cut selected keyframes
µ Choose Edit > Cut (or press Command-X).

To paste your selected keyframes, you must select both the parameter you want to paste
to, and the place in time where you want the pasted keyframes to begin.

To paste keyframes
1 Select the destination parameter in the parameter list (on the left side of the Keyframe

Editor).

2 Place the playhead at the point in time where you want the keyframes to begin.

3 Choose Edit > Paste (or press Command-V).

Note: Pasted keyframes may not make an identical-looking curve to the original if the
parameter scales are different.

577Chapter 10 Keyframes and Curves



To select an entire animation curve
Do one of the following:

µ Select a parameter row in the parameter list of the Keyframe Editor.

µ Shift-click or Control-click in the parameters list to select multiple parameters.

Once you have the keyframed parameters selected, you can cut or copy them to move
them to the Clipboard.

To copy selected animation curves
µ Choose Edit > Copy (or press Command-C).

To cut selected animation curves
µ Choose Edit > Cut (or press Command-X).

When pasting animation curves, any keyframes in destination parameters are replaced,
and the timing of the original keyframes is retained over the entire channel in the new
destination.

To paste animation curves
1 In the parameter list of the Keyframe Editor, select the destination parameter.

2 Choose Edit > Paste (or press Command-V).

Note: Pasted animation curves may not make an identical-looking curve to the original
if the parameter scales are different.

Using the Sketch Tool
The Sketch tool (next to the Edit tool) allows you to sketch animation curves in the
Keyframe Editor, creating keyframes as you go. In order to sketch a curve, the parameter
you wish to animate must first appear in the parameter list. See Custom Parameter Sets
for methods of displaying the curves you wish to appear.

Sketch tool

To sketch an animation curve
1 In the parameter list, select the parameter you wish to sketch.

2 Select the Sketch tool from the keyframe edit tools.

3 Drag in the curve graph to sketch an animation curve.
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Dragging or clicking anywhere in the Keyframe Editor replaces existing keyframes.

Parameter and sketch 
tool selected

Drag in the graph to 
create new keyframes for 

selected parameter.

Curve of new keyframes 
added to existing 
animation curve

To add individual keyframes using the Sketch tool
1 Select the Sketch tool from the keyframe edit tools.

2 In the parameter list, select the parameter you wish to sketch.

3 Click in the curve graph to add a keyframe.

Additional clicks create additional individual keyframes.

Using the Box Tool
Also in the keyframe edit tools, the Box tool allows you to drag a selection box around a
number of keyframes, then manipulate their positions by adjusting the handles of the
selection box.

Box tool

To draw a selection box using the Box tool
1 Select the Box tool from the keyframe edit tools.

2 In the curve graph, drag to create a box enclosing the keyframes you wish to manipulate.
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A selection box with eight handles appears in the curve graph.

Keyframed parameters 
before selection

Selection box handle

Selected keyframes

Once you have drawn a selection box, there are a number of ways to manipulate the box
and keyframes therein. In general, you can drag any of the handles of the selection box
to move them.

Transforming Keyframes
Repositioning the handles of the selection box is the same as dragging the handles of
a bounding box of any object. The difference in this case is that the transforms done
by moving these handles affect not only the box itself, but the keyframes enclosed
therein. Moving the box moves all of the selected keyframes in whatever direction you
move; as a result, you can affect where the keyframes are positioned in time or their
parameter values, or both at the same time. Scaling the selection box “scales” the
keyframes within the selection box, changing their timing and parameter values.

Experiment with the selection box to see how different kinds of manipulation affects
the enclosed keyframes.

To move the selection box
µ Drag anywhere inside the selection box to move the box and the enclosed keyframes.

Moving left and right repositions the keyframes in time, and moving up and down
increases and decreases the parameter values of the selected keyframes.

Note: No matter where you drag the box, only the keyframes selected by the original
box are manipulated, even if the repositioned box overlaps keyframes outside of the
original selection. To manipulate additional keyframes, you must redraw the selection
box in the keyframe graph.

To scale the selection box
µ Hold down the Option key and drag any of the handles of the selection box.

The box scales up or down as you drag along the axes.
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To deform the selection box asymmetrically
µ Hold down the Command key and drag any of the corner handles of the selection box.

Each corner handle moves independently of the other three corner handles of the selection
box.

Modifying Curves
Perhaps the most powerful and valuable feature that the Keyframe Editor offers is the
ability to make changes to the curves between the keyframes. Of course, manipulating
keyframes causes changes in the curves, but Motion gives you tools to control the
interpolation and extrapolation of your parameter values themselves.

By using different preset mathematical algorithms or by using manual controls, you can
dramatically alter the impact of your effects.

When you set the interpolation for a curve, you select the keyframe you want to modify.
The method you choose determines the distribution of values through, into, or out of
the selected keyframe.

To set an interpolation method for a keyframe
1 Select the keyframe you want to affect.

The keyframe turns white.

2 Control-click the keyframe to display the shortcut menu.

3 Choose an interpolation method from the Interpolation submenu.

To set an interpolation method on a curve segment
µ Control-click the segment, then choose an interpolation method from the Interpolation

submenu.
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You can set different interpolation methods for different segments of the same curve.

When different interpolation methods are applied to the different segments of an
animation curve, the methods that are used in the curve appear with a dash next to their
name in the Interpolation submenu (in the Keyframe Editor parameter list). In the following
image, all interpolation methods are applied to the selected curve.

The different interpolation methods are described in the table below.

DescriptionExampleInterpolation method

Holds the keyframe at its current value when
applied to a segment or keyframe and then
changes suddenly to the new value when the next
keyframe occurs.

Constant

When applied to a keyframe, creates a uniform
distribution of values through the keyframe from
its two adjacent keyframes. When applied to a
segment, creates uniform distribution of values
between the two points.

Linear
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DescriptionExampleInterpolation method

Lets you manipulate the keyframe curve manually
by dragging the handles. If multiple Bezier
keyframes are selected, or Bezier is applied to the
curve segment, the handles of all the selected
keyframes are modified.

Bezier

This method behaves like Bezier interpolation, but
without access to the handles (they are calculated
automatically). The parameter begins to change
gradually, reaching its maximum rate of
acceleration at the midpoint, then it tapers off
slightly as it approaches the second keyframe.
When applied to a keyframe, the segments before
and after the keyframe are affected. When applied
to a curve segment, the segment between to the
two keyframe is affected.

Continuous

A type of reverse-inertia effect, so that a value
change slows coming into a keyframe. When
applied to a curve segment, the value change
eases into the segment.

Ease In

Creates a typical inertia-like lag, so that a value
change begins more slowly coming out of a
keyframe. When applied to a curve segment, the
value change eases out of the segment.

Ease Out

Creates an exponential curve between the current
value and the next, changing the value slowly at
first, then reaching its maximum rate of
acceleration as it approaches the next value.

Exponential

Creates a logarithmic curve between the current
value and the next, changing the value rapidly at
first, then slowing drastically as it approaches the
next value.

Logarithmic

Alternatively, you can apply an interpolation method to the entire parameter. In the
following example, the Y Position curve (green) is currently set to Linear.
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To change the interpolation method for an entire parameter
µ In the Keyframe Editor, click the Animation menu and choose a method from the

Interpolation submenu.

The selected interpolation method (Constant in this example) is applied to the green
curve.

To change the interpolation method for multiple parameters
1 In the parameter list of the Keyframe Editor, Shift-click to select the parameters you wish

to change.

2 Click the Animation menu (in the Keyframe Editor) and choose a method from the
Interpolation submenu.
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The selected interpolation method is applied to all of the selected curves.

Convert to Bezier
Bezier interpolation method is the most flexible, allowing manual modification of the
curve. Motion lets you convert any keyframe into a Bezier keyframe quickly and easily.

To convert a keyframe into a Bezier keyframe
µ While holding down the Command key, drag the keyframe in the keyframe graph.

Bezier handles appear and your mouse movement automatically controls one of the
handles.

Note: Command-clicking a Bezier point resets it to Linear interpolation.

To simultaneously modify the handles for more than one control point, Shift-click to select
multiple points, then adjust the tangents. If there are no tangents on the point, drag it
while holding down the Command key.

To break a handle
µ While holding down the Option key, drag the handle.
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To “lock” the handle’s angle while modifying
µ While holding down the Shift key, drag the handle.

Extrapolation
In addition to setting interpolation for the areas between keyframes, you can define how
Motion generates the values before the first keyframe and after the last one (extrapolation).
When you set a such a method for a parameter, new keyframes are added beyond your
original keyframes. This can be helpful when trying to extend the duration of an effect
such as a moving background.

To apply the Before First Keyframe setting for a parameter
µ In the Keyframe Editor, open the Animation menu for the parameter you want to change,

then choose an item from the Before First Keyframe submenu.
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To apply the After Last Keyframe setting for a parameter
µ In the Keyframe Editor, open the Animation menu for the parameter you want to change,

then choose an item from After Last Keyframe submenu.

The following table describes the extrapolation options available in the Before First
Keyframe and After Last Keyframe submenus.

DescriptionExampleExtrapolation method

(Default) The parameter remains at the exact value
of the first and last keyframes in the extrapolated
area.

Constant

Extends the curve beyond the first and last
keyframes uniformly, along the existing trajectory.

Linear

Copies the curve and repeats it, alternating
forward and backward.

Ping Pong

Duplicates the curve, applying it again and again.Repeat

Extends the curve by repeating the existing shape
of the curve, but rather than returning to the exact
same values, it begins again from the existing end
value.

Progressive

Reversing Keyframes
Using the Reverse Keyframe option in the Keyframe Editor, you can quickly “flop” time
by reversing the keyframes on a curve.
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To reverse keyframes
1 Select the keyframes you want to reverse.

You can drag–select 
groups of keyframes.

2 Control-click a selected keyframe and choose Reverse Keyframes from the shortcut menu.

The selected keyframes are reversed.
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Note: Reverse Keyframes flips the timing of all keyframes within a selected range of
keyframes, regardless of their selection state.

Non-selected keyframes 
bounded by the selected 
keyframes are also 
reversed.

A minimum of two keyframes must be selected for the action to have any effect.
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Generate Keyframes Command
Ordinarily, keyframe extrapolation occurs without actually creating any new keyframes.
This lets you experiment with different methods. However, you can convert an
extrapolation method into actual keyframes so you can further manipulate them. This is
done using the Generate Keyframes command. You can choose how many of the
extrapolation cycles you want converted into keyframes. Cycles after the number you
chose are left in the extrapolated state.

Generate Keyframes applied, set to one cycle

Original keyframe graph

Repeat Extrapolation applied

To convert extrapolation data into keyframes
1 In the Animation menu, choose Generate Keyframes from the Before First Keyframe or

After Last Keyframe submenu.

The Generate Keyframes dialog appears.

2 Choose the number of cycles you want to be keyframed.
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3 Click OK to confirm your selection.

Mini-Curve Editor
A mini-curve editor is a scaled-down version of the Keyframe Editor. Appearing in the
Inspector, mini-curve editors give you the functionality to create basic animations directly
in the Inspector, without having to open the Keyframe Editor.

Two Particle behaviors—Scale Over Life and Spin Over Life—have mini-curve editors in
the Inspector (when the Increment Type parameter is set to Custom). Mini-curve editors
are also present for paint objects, in the Stroke pane of the Shape Inspector.

By default, the mini-curve editor is collapsed and shows a scaled-down representation
of the actual animation curve.

Collapsed mini-curve 
editor

To expand a mini-curve editor
µ Click the disclosure triangle next to the collapsed mini-curve editor.
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The expanded mini-curve editor appears.

Sketch tool

Box tool

Edit tool

Mini-curve editor

When expanded, the mini-curve editor shows a representation of the relevant animation
curve. In the example above, the Range parameter is mapped to the X axis and the Custom
Spin parameter is mapped to the Y axis.

The procedure for adding keyframes in a mini-curve editor is slightly different than adding
them in the full-sized Keyframe Editor.

To add keyframes in the mini-curve editor
Do one of the following:

µ Click the curve in the mini-curve editor.

µ Double-click the curve in the mini-curve editor to add a keyframe and activate its value
field.

µ Option-click the curve, then choose Add Keyframe from the shortcut menu.

The mini-curve editor provides the Edit, Sketch, and Box tools, and each functions in the
same manner as in the Keyframe Editor. For more information on using the Edit tool, see
Using the Edit Tool. For more information on using the Sketch tool, see Using the Sketch
Tool. For more information on using the Box tool, see Using the Box Tool.
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The Auto Fit checkbox sets whether Motion automatically scales the animation curve to
fit within the confines of the mini-curve editor.

Auto Fit turned on in the 
mini-curve editor

Animating on the Fly
Another powerful feature that Motion offers is the ability to create animations while your
project is playing back. This is similar to how audio engineers adjust sliders for each of
their different audio channels while listening to the mix. The next time it is played back,
all of those changes are incorporated.

Because so many of Motion’s effects are displayed in real time, you can perform a sort of
“visual mix” and modify the various parameters of your effects while the project is playing
back.

For example, it is not until you see the various elements in your project in concert that
you can know whether each part is behaving as it should. One object may be fading too
slowly and making another element hard to see, or a text element might come and go
so quickly that it cannot be read. With keyframing on the fly, you can make adjustments
to any slider or parameter in the program while your project is playing. You can also
interactively manipulate objects in the Canvas. Then, if you don’t like what you did, rewind
and do it again. Each time you alter a parameter, you replace any keyframes previously
assigned.

To animate a parameter on the fly using the Inspector or the HUD
1 Click the Record button (or press A) or choose Mark > Record Animation to turn on

keyframe recording.
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2 Click the Play button or press the Space bar to begin playback.

3 As your project plays, adjust a parameter slider.

4 Disable Record.

The changes you made during playback are recorded as keyframes for that parameter.
You can view them in the Keyframe Editor.

If you don’t like the animation you made, you can delete the keyframes and try again.
You can choose Edit > Undo (or press Command-Z) to revert to the state before you
began recording your animation, or you can manually delete the keyframes you want to
replace.

To delete keyframes
Do one of the following:

µ Select the keyframe, then press Delete.

µ Control-click the keyframe, then choose Delete from the shortcut menu.

µ Select the keyframe, then choose Delete from the Animation menu for that parameter.

Note: To delete all of the keyframes for a parameter, choose Reset Parameter from the
Animation menu in the Keyframe Editor list or Inspector.

Handmade Motion in the Canvas
One of the most common uses for animating on the fly is to create handmade animation
paths. Although you can choose from a variety of curve types, it is very difficult to get
the semi-random movement except by sketching with your mouse or pen.

To create a handmade animation path in the Canvas
1 Enable Record (press A).

2 Click the Play button to begin playback.

3 Select the object you want to manipulate and drag it in the pattern of your choice.
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Both the position and speed of your movement are recorded and applied to the position
keyframes for that object.

Keyframes close together 
indicate slower 
movement. 

Keyframes spaced far 
apart indicate fast 
movement.

You can further manipulate the path either by dragging individual keyframes, or
re-recording a new animation path for that object.

Keyframe Thinning
Due to the way keyframing works, if the playhead is at a new frame, and you set a new
value for a parameter, a keyframe is added. For animating while the project is playing,
this might mean setting a new keyframe on every single frame. This doesn’t create a
problem until you want to make a change to the curve.

In many cases, the curve created by your animation can be represented using fewer
keyframes. Often, this will provide a smoother rate of change and will enable you to take
advantage of the various interpolation methods such as Ease In and Ease Out.
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You can simplify your keyframes in two ways: either while you are recording them, or
afterwards, by simplifying an existing animation curve using the Reduce Keyframes
command in the Animation menu for that parameter.

Reduce Keyframes option 
(in Keyframe Editor’s 
Animation menu) applied 
to Position Y

Recording Options
The Recording Options dialog allows you to set the Keyframe Thinning setting, to record
only on parameters that are already animated or to disable recording during playback.

The Keyframe Thinning setting only applies to recording animation while playing back.
This setting has no effect on ordinary keyframing.

To access Recording Options
Do one of the following:

µ Choose Mark > Recording Options (or press Option-A).

µ Double-click the Animate button.

The Recording Options dialog appears.
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Keyframe Thinning: There are three options of how thinning can be applied.

• Off: No thinning is applied. Keyframes are applied at every frame where the parameter
is changed.

• Reduced: Motion eliminates keyframes that can easily be replaced with a simple curve.

• Peaks Only: Only keyframes with dramatic value changes are recorded.

Don’t record keyframes during playback: When this checkbox is selected, keyframes
are not recorded while the project is playing back.

Record keyframes on animated parameters only: When this checkbox is selected,
keyframes are recorded only on parameters that are already animated.
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Disabling Animation While Playing
If you leave the Record button on, keyframes are added whenever you make adjustments.
If you want to restrict keyframing to when the project is not playing, you can disable that
feature individually.

To disable animation recording while playing
1 Choose Mark > Recording Options.

The Recording Options dialog appears.

2 Select “Don’t Record keyframes during playback.”

3 Click OK.

Recording Keyframes on Animated Parameters Only
When “Record keyframes on animated parameters only” is selected, keyframes are added
only to parameters that are already animated. For example, if the position of a shape is
animated (keyframed) and “Record keyframes on animated parameters only” is enabled,
only changes made to the position of that object are keyframed. If you change the color
of the object over time, the color changes are not keyframed—even when the Record
button is enabled.

Important: The Record button must be on when using the “Record keyframes on animated
parameters only” option. You can still manually add keyframes, regardless of whether or
not Record is enabled, by using the Animation menu in the Inspector or Keyframe Editor
list, or by pressing Option-K.

Tip: If you are a Final Cut Pro user, it is recommended that you use this option to emulate
the workflow with which you are familiar.

To record keyframes on animated parameters only
1 Enable Record (or press A).

2 Choose Mark > Recording Options (or press Option-A).

3 Select “Record keyframes on animated parameters only.”

4 Click OK.

Keyframes are now added only when you make changes to parameters that are already
animated. To observe how the “Record keyframes on animated parameters only” works,
walk through the following brief exercise.

To see the “Record keyframes on animated parameters only” in action
1 Enable Record (press A).

2 Choose Mark > Recording Options, and make sure “Record keyframes on animated
parameters only” in the Recording Options dialog is turned off, then click OK.

3 At frame 1 (press Home), draw a shape in the Canvas and move the object into a start
position.
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A position keyframe is created.

4 Advance to a different frame and move the object into another position.

A second position keyframe is created.

5 Choose Mark > Recording Options, and select “Record keyframes on animated parameters
only” in the Recording Options dialog, then click OK.

6 Go to a frame in between the two position keyframes, and move the shape in the Canvas.

A third position keyframe is added.

7 At frame 1 (press the Home key), click the Fill color well in the shape’s HUD, then change
the color of the object.

Fill color well

8 Advance to a different frame, then change the color object again.

9 Go to frame 1 and click the Play button (or press the Space bar).

Notice that the position of the object is animated, but the color is not. This is because
the shape had position keyframes when “Record keyframes on animated parameters
only” was selected.
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Particle systems allow you to quickly and easily create sophisticated effects involving
large numbers of automatically animated objects. You can use the included Particle
Emitters library to add a pre-made particle system to your composition, or you can create
your own custom particle effects using nearly any layer or group in your project. Particle
systems in Motion are flexible enough to create many different kinds of effects.

This chapter covers the following:

• About Particle Systems (p. 602)

• Anatomy of a Particle System (p. 603)

• Using Particle Systems (p. 605)

• Creating Graphics and Animations for Particle Systems (p. 623)

• The Difference Between Emitter and Particle Cell Parameters (p. 625)

• Emitter and Cell Parameters (p. 628)

• Animating Objects in Particle Systems (p. 649)

• Viewing Animated Emitter Curves in the Keyframe Editor (p. 653)

• Using Masks with Particle Systems (p. 654)

• Applying Filters to Particle Systems (p. 655)

• Particle System Examples (p. 655)

• Saving Custom Particle Effects to the Library (p. 664)
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About Particle Systems
Particle systems consist of two basic elements: a cell and an emitter. Think of the cells as
the “mold” for the particles that are generated by the emitter. You can use nearly any
layer or group in Motion as a source for a particle cell, including images, shapes, text,
movies, and image sequences. Each particle that is created is essentially a duplicate of
the original cell, and is animated according to the parameters for that particle system (a
particle cell and emitter) over its lifetime.

Object prior to becoming a particle system Particle system

The layer you use as a particle system’s cell determines how that particle system looks.
Particle systems can contain multiple cells, resulting in the release of several types of
particles from a single emitter. You’ll find that many of the most sophisticated particle
presets in the Particle Emitters library are constructed in this way.

Particle system based on a single cell Particle system based on two cells
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Anatomy of a Particle System
Every particle system is made up of an emitter and one or more particle cells. Each cell
appears inside of the emitter in the Layers tab and the Timeline.

Emitter

Cell

Original objects
(now disabled)

Behaviors applied to one 
particle cell

The emitter and cells have separate sets of parameters that control the particle system’s
behavior. If you imagine that a garden hose is a particle system, the nozzle acts as the
emitter, while the water represents the flow of particles. Changing the parameters of the
emitter changes the shape from which the particles are emitted and their direction, while
changing the cell’s parameters affects each individual particle.

By changing a few parameters, it’s possible to create very different effects using the same
cell.

Note: In a particle system, cells and particles are not the same thing. A cell is a layer (in
the Layers tab) that acts as the “mold” for the particles (the multiple objects generated
in the Canvas). The cell itself is a copy of a source object (cell source) that appears dimmed
(disabled) in the Layers tab, and therefore is by default not visible in the Canvas.

As with any effect in Motion, particle system parameters can be keyframed in order to
change a particle effect’s dynamics over time. For example, you can create a path of
bubbles that follows an object onscreen by keyframing the emitter’s Position parameter.
For more information on keyframing, see Keyframes and Curves.

603Chapter 11 Working with Particles



You can also track an emitter to a moving object in a clip, or apply existing tracking data
in your project to an emitter. For more information on using the Motion Tracking behaviors,
see Motion Tracking.

In addition, you can add behaviors to each cell or to the emitter itself to create even more
varied effects (simulation behaviors can be especially effective). Any behavior that you
apply to a cell is in turn applied to each particle it generates. This lets you achieve almost
limitless variation. Adding behaviors to cells in addition to the particle system’s own
parameters is an easy way to create complex, organic motion that would be impossible
to accomplish any other way. You can also apply a behavior to another object in your
project (an object that is not part of the particle system), such as Repel, and have the
particles weave around that object. For more information about behaviors, see Using
Behaviors.

Cell Source
Each cell in a particle emitter is a copy of a source object known as the cell source. The
cell source appears dimmed (disabled) in the Layers tab, and therefore does not appear
in the Canvas. Almost any layer in Motion can be used as a cell source, including shapes,
text, images, image sequences, and clips. Transformations that you apply to the source
are respected in the cell layer, which in turn propagates those transformations to the
particles that are generated in the Canvas. For example, if you use a rectangle shape that
is sheared and rotated as the cell source, particles created using that rectangle as the cell
source are sheared and rotated.

If the layer used as the cell source for the particle system has applied filters, the effects
of the filters are retained in the particles.

Note: Keep in mind that using a movie with applied filters as a particle cell source adversely
impacts your computer’s processing performance. For better performance, export your
sequence with the filter applied, then import it back into Motion and use the movie as
the cell source.
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Using Particle Systems
Despite their sophistication, particle systems are easy to set up and simple to use. This
section describes how to use pre-made particle systems from the Particle Emitters category
of the Library. Afterward, this section explains how to create a simple particle system of
your own.

Particle Systems and Layer Sizes
Particle systems often create particles that grow or move off the Canvas before they
die. This can make the size of a layer or group much larger than that of the Canvas.
Although the particles are not visible once they move off the Canvas (unless Show Full
View Area is turned on in the View menu), they are still present in the project and are
processed. If you apply a filter to a layer containing growing particles, or use that layer
as a source object, it is recommended that you select the Fixed Resolution checkbox in
the Group tab of the Inspector (available only when a group is the selected object). The
Fixed Resolution parameter allows you to set the specific width and height of a group,
cropping anything beyond those values. For more information, see Fixing the Size of a
Group.
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Using the Particle Library
The easiest way to add a particle system to your project is to use one of the presets in
the Particle Emitters category of the Library. There are many types of particle effects to
choose from. If you find one that is close to what you need, you can easily customize its
parameters after you add it to your project. Particle systems are added to a project exactly
like any other object.

To add a particle system from the Library
1 In the Library, click the Particle Emitters category.

2 Click one of the particle subcategories, such as Nature, Pyro, SciFi, and so on.

3 Select a particle preset in the Library stack.
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An animated preview of the selected particle emitter plays in the Preview area. While it
is playing, you can drag the pointer around in the Preview area to see how the particle
looks while in motion.

Note: If the preview does not automatically start playing, click the Play button in the
Preview area. To automatically play items selected in the File Browser or Library, choose
Motion > Preferences (or press Command-Comma), then select “Play items automatically
on a single click” in the File Browser & Library section of the General pane.

4 When you find a particle preset you want to use, do one of the following:

• Click Apply to add the selected particle system to your project at the center of the
Canvas.

Note: If Create Layers At is set to “Start of project” in the Project pane of Motion
Preferences, the particle system is added at the first frame.

• Drag the particle system into the Canvas to the position where you want it to appear.

• Drag the particle system into a group in the Layers tab or Timeline layers list. The particle
system appears at the center of the Canvas.

• Drag the particle system to the track area of the Timeline. When you reach the frame
where you want the new particles to start, release the mouse button.

The new particle system layer appears in your project, composited against any other
layers that you’ve already added.
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Motion Blur and Particles
To achieve the optimal look for the following particle emitters, it is recommended that
you enable motion blur in your project:

• Jelly Bands

• Light Transit 1

• Light Transit 2

• Light Transit 3

• Light Transit 4

• Rain Streaks

• Silly String 1

• Silly String 2

Note: To enable motion blur, choose Motion Blur from the Render pop-up menu (in
the Status Bar), or choose View > Render Options > Motion Blur (or press Option-M).

Once you have added a particle system from the Library, the system acts exactly as it did
in the Preview area. If necessary, you can edit a particle system’s Emitter parameters in
the HUD to tailor them to your own use.

Note: You can only modify a particle system after it has been added to a project.

The HUD displays a selected particle system’s most essential parameters, including the
size and number of particles that are created, how long they remain onscreen, how fast
they move, and the direction and area in which they travel. Select an individual cell in
the Layers tab or Timeline to edit its parameters in the HUD.

For more detailed information on using the particle HUD, see Customizing a Particle
System Emitter. For more comprehensive information on customizing all of a particle
system’s parameters, see Emitter and Cell Parameters.

Creating a Simple Custom Particle System
While Motion comes with a wide variety of particle system presets, many times you’ll
want to create something completely new. Creating a particle system begins with selecting
a layer in your project to use as the source for a cell within a new particle emitter.

You can use any layer in your project as a source for a cell in an emitter, including still
graphics, animation or video clips, or shapes created in Motion. The layer you select when
you create an emitter becomes the first cell in that particle system. In the Layers tab, cells
appear as a sublayer under the emitter layer. The cell specifies the look of the actual
particles generated in the Canvas.
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Note: You can also use a group as the source for an emitter cell, but keep in mind that
your project’s interactivity may slow drastically.

Emitter

Particle

Particle

To create an emitter
1 Place a layer that you want to use to generate particles into your project.

This example uses an image of a simple white circular gradient, such as the “basic blur”
image located in the Library (in the Particle Images subcategory of the Content category).

2 Move the object in the Canvas to the location where you want the center of your particle
system to be.

3 Select the object, then do one of the following:

• In the Toolbar, click the Make Particles icon.

• Press E.

609Chapter 11 Working with Particles



Once an emitter is added to the project, the following occurs:

• An emitter appears in the Layers tab and is selected.

• A cell containing the image to be “particle-ized” appears underneath the emitter.

• The original source layer (the cell source) is disabled.

Note: Changes made to the original source layer, such as opacity or shearing, are
respected in the particles even after the emitter is created.

• In the Canvas, the emitter bounding box appears, which can be transformed using the
onscreen controls.

• The first particle appears in the Canvas in the same location as the original layer.
Although it appears as if the particle is selected, the bounding box represents the
emitter.

• The Emitter HUD is displayed. If you have hidden the HUD, press F7.

Note: For projects with a frame rate greater than 30 frames per second (fps), at times
only the bounding box (not the first particle) may appear at the first frame of your
project. Because Motion generates particles at a default rate of 30 per second, there is
no guarantee that a particle will appear on every frame.

Particle system at frame 1

By default, the first frame of a new particle system (with a single cell) has one particle.
If you play your project, additional particles are generated and emerge from the center
of the emitter.
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By default, new cells emit one particle per frame in all directions (for 30 fps projects),
and each particle moves 100 pixels per second away from the emitter over a lifetime
of 5 seconds (150 frames in a 30-frames-per-second project).

Particle system at frame 30

Emitter center point

Note: The Initial Number parameter in the Emitter or Particle Cell tab of the Inspector
allows you to change the default behavior so that a particle system begins with a burst
of particles at the first frame. For more information, see Emitter and Cell Parameters.

The Predictability of Particle Systems
When you create a particle system or modify one of the parameters of an existing particle
system, the path of each particle in that system is immediately calculated and
predetermined. While the number and motion of particles may seem random, they are
actually completely predictable based on that system’s parameters. Playing the same
particle system twice with the same parameters results in exactly the same particle
motion. This means that once you create a particle system that looks right, it is always
the same.

Using Multiple Cells Within a Single Emitter
When you create a particle system from scratch, you don’t have to restrict yourself to
using just one cell. You can create a particle system that emits many different kinds of
overlapping particles by placing multiple cells inside of a single emitter in the Layers tab.

You can add as many cells as you want within a single emitter. Each cell has its own
particle cell parameters that govern how particles from that cell are created. When selected
in the Layers tab, each cell displays its own Particle Cell tab in the Inspector. Particle
systems with multiple cells generate particles from each cell simultaneously, according
to each cell’s parameters.

For an example of using multiple cells within a single emitter, see Example 2: Creating
Animated Pixie Dust.
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Additional cells can be created by either selecting multiple sources when initially creating
the emitter, or by dragging additional source layers onto the emitter in the Layers tab.

Note: When multiple sources are used to create a particle system, the resulting emitter
is positioned at the average of the sources’ position.

Customizing a Particle System Emitter
When you create an emitter, the particle system starts working according to the default
parameters in its Emitter and Particle Cell tabs, located in the Inspector. You can use the
Emitter HUD to easily change the most important of these parameters to suit your needs.

To display the HUD for a particle emitter
µ Select the emitter for which you want to display the HUD.

The HUD appears when you select the emitter. If the HUD does not appear, press F7.

Using the HUD to Create a Simple Smoke Effect
In this example, use the Emitter HUD to create a smoke effect. Use the emitter created
in Creating a Simple Custom Particle System A Blur image from the Content category in
the Library will serve as the cell source.

Before making adjustments to the selected particle system, it may be helpful to move
the playhead forward in the Timeline to a frame where you can see the particle system
in full effect. That way, any adjustments you make are readily apparent.

Particle system at frame 30

The first thing you may notice in this example is that the size of each particle is so big
that it’s hard to make out any texture in the particle system.
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To modify the particles’ appearance using the Emitter HUD
1 In the Emitter HUD, drag the Scale slider to the left to reduce every particle’s size so that

the individual particles are more identifiable.

2 In the HUD, click anywhere along the outer edge of the emission control and drag to
define a narrow segment that limits the range of the angle at which particles are created
(the emission range).

Both points defining the emission range rotate around the center of the emission control
symmetrically, so your initial wedge points to the right. As you adjust the emission range,
the particles rearrange themselves in the Canvas, enabling you to see the resulting effect.
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3 To make the particles drift upward, drag in the middle of the Emission Range segment,
rotating the arrow counterclockwise until it points up and slightly to the right of the
center control.

The emission angle of the particles updates in the Canvas to reflect the new setting in
the HUD.

4 Drag to lengthen the arrow so that it is approximately halfway between the center and
the edge of the emission control to create a slowly drifting column of particles.

Remember: While the angle of the arrow controls the emission angle of the particles, the
length of the arrow controls the speed of the particles. The longer the arrow, the faster
the particles, and vice versa.

At this point, the particles are all moving in the correct direction, but there aren’t very
many of them (there isn’t much of a fire yet).

5 Move the Birth Rate slider to the right to increase the number of particles created by the
emitter.
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As you increase the birth rate, more particles are created, forming a nearly unified column
of “smoke.” The particles move farther apart as they drift away from the emitter.

As you can see, a single object can be used to create a credible column of smoke rising
gently into the sky.

While the HUD controls are quite powerful, the Emitter and Particle Cell tabs in the
Inspector have many more parameters you can customize. For more information, see
Emitter and Cell Parameters.

Emitter HUD Parameters
The HUD contains the most frequently used emitter controls that are necessary to modify
a particle system’s size and shape. These parameters are a subset of those found in the
Emitter tab of the Inspector. In 2D projects, the Emitter HUD contains a group of sliders
and the emission control, which provides a visual way to manipulate three different
particle system parameters: Emission Range, Emission Angle, and Speed.

Emission Angle
(angle of arrow)

Emission Range

Emission Speed
(length of arrow)

2D Emitter HUD
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When 3D is enabled in the Emitter tab of the Inspector, the Emitter HUD offers additional
3D controls. In 3D, the emission control modifies the Emission Latitude and Emission
Longitude parameters.

3D Emitter HUD

Emission control

When an emitter and the Adjust 3D Transform tool (in the Toolbar) are selected, the 3D
Emitter HUD expands to display additional controls that allow you to transform the emitter
in X, Y, and Z space, regardless of whether the group containing the emitter is 2D or 3D.

For more information on using the 3D transform controls in the HUD, see 3D Transform
Tools.
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For particle systems containing multiple cells, the Emitter HUD parameters simultaneously
modify the effect of each cell’s parameters relative to one another. This means that for a
particle system consisting of two cells with different scale values, changing the scale in
the HUD resizes both cells simultaneously. For example, increasing the scale in the HUD
by 200% does not change the scale of both cells to 200%, but resizes the cells relative to
their original scale values.

Original particle system Particle system scaled to 200 percent

For this reason, in emitters with multiple cells, the HUD parameters are displayed as
percentages. When you modify the parameters of a single cell, the cell parameters are
adjusted directly.

Birth Rate: A slider that defines how many particles are created every second.

Life: A slider that defines how long each particle remains onscreen (in seconds) before
disappearing from existence.

Scale: A slider that defines the size of each particle, relative to the original size of the cell.

Emission Control: A graphical control that lets you modify several parameters.

• Emission Range (2D only): Drag the two points on the outer ring of the graphical emission
control to define the range of degrees at which particles are generated. In other words,
the Emission Range parameter defines the size of the “slice” of the pie graph that the
particles fill when generated.

• Emission Angle: Drag inside the emission control to change the direction in which
particles are emitted, inside the area defined by the Emission Range.
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• Speed (2D only): Drag inside the emission control to shorten or lengthen the arrows to
define how quickly particles move away from the emitter.

Use the following modifier keys to more precisely manipulate the graphical emission
control in the HUD:

• Shift (while adjusting Angle): Restricts angles to 45 degree increments.

• Shift (while adjusting Range): When working with a 2D emitter, restricts to 22.5-degree
increments.

• Command: When working with a 2D emitter, adjusts Angle only.

• Option: When working with a 2D emitter, adjusts Speed only.

Emission Latitude/Emission Longitude Control (3D only): When using a 3D particle
emitter (when the 3D checkbox is selected in the Emitter tab of the Inspector), the emission
control of the HUD lets you modify the Emission Latitude and Emission Longitude
parameters.

Emission Latitude and 
Longitude control

Drag the sphere in the center of the circle to modify the emission direction (in degrees
latitude and longitude) of the particles. You can also enter specific values in the Emitter
tab of the Inspector.
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Drag the Emission Range slider (above the sphere) to define the range of degrees at
which particles are generated. In other words, this control defines the size of the cone
that the particles fill when generated in 3D space.

Particle Emitters and the Properties Tab
Emitter parameters can be modified in the Properties tab of the Inspector like any other
object in Motion. The following sections briefly discuss using some of the parameters in
the Properties tab with a particle system (not all parameters in the Properties tab are
discussed). For more information on the Properties tab parameters, see Parameters in
the Properties Tab.

Note: When a particle cell is selected, only the Timing parameter appears in the Properties
tab of the Inspector. This allows you to control the In and Out points of the particle cell.

Important: Some operations that can be performed in the Properties tab, as well the
application of certain filters or a mask, cause a group to be rasterized. For more information,
see About Rasterization.
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Transform Parameters
As a particle system plays, the cells in the system are duplicated, according to the
parameters for that system, to create each individual particle in the Canvas. Because all
particles emerge relative to the position of the emitter (because the emitter can be a
point, a circle, geometry, a sphere, and so on), changing the emitter’s position in the
Canvas also changes the position of every particle in that system.

Origin of particle system 
after emitter has been 

repositioned

Origin of particle system

The exception to this is if the emitter’s position is animated using a behavior or keyframes.
In this case, particles emerging from the emitter’s position at each frame continue to
move relative to that position, regardless of changes to the emitter’s position in
subsequent frames. This results in a trail of particles following the path of the emitter.

The Attach to Emitter parameter in the Particle Cell tab of the Inspector modifies this
behavior. When set to 0%, the particles are completely independent of the emitter. When
set to 100%, the particles try to keep up with the position of the animated emitter.
Depending on any applied behaviors, such as Drag, the particles may not be able to keep
up with the emitter.
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Modifying an emitter’s other transformation parameters (Rotation, Scale, Shear, and
Anchor Point) changes the distribution of particles from that emitter and transforms each
particle. For example, if you create an emitter, then modify its Shear parameter, the
distribution of the emitted particles changes to reflect the new plane of the emitter, and
the particles are sheared along the same plane.

Analog Modulator particle system preset After Shear effect is applied

Blending
Any changes you make to the opacity or blend mode parameters for an emitter are
applied to the particle system as a whole—the result of the emitter is blended into the
scene. For more information about blend modes, see Using Blend Modes. For more
information about the Preserve Opacity setting, see Preserve Opacity Option.

Note: Within the emitter, the particles can be blended additively or normally (using the
Additive Blend checkbox).

Lighting
A 2D or 3D emitter can interact with lights in a 3D project. As with all layers, the Shading
pop-up menu (in the Lighting controls in the Properties tab of the Inspector) must be
set to On or Inherited for the lights to affect the particles. For more information on using
lights, see Lighting.

Shadows
A 2D or 3D emitter can cast and receive shadows in a 3D project. If the 3D checkbox is
selected in the Emitter tab of the Inspector, Render Particles must be set to In Global 3D
(Better) for particles to cast shadows. For more information on using shadows, see
Shadows.

Reflections
A 2D or 3D emitter can cast reflections in a 3D project, but only a 2D emitter can receive
reflections. For more information on using reflections, see Reflections.

Note: When the 3D checkbox in the Emitter tab of the Inspector is selected, the Reflections
parameter does not appear in the Properties tab.
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Drop Shadow
Drop shadows can be applied to a 2D particle system. When the Drop Shadow parameter
is enabled for the source object (in the Properties tab in the Inspector), each generated
particle appears with a drop shadow. For more information on working with drop shadows,
see Drop Shadows.

Note: This parameter is not available with the Box or Sphere emitter shapes, or when the
3D checkbox is selected in the Emitter tab of the Inspector.

Timing
Once you create a particle system, its duration can be as long or short as necessary,
regardless of the duration of the original layers used to create the particle system. The
duration of a particle system is defined by the duration of the emitter object. Changing
the In or Out point of an emitter in the Properties tab, Timeline, or mini-Timeline changes
the duration of the entire particle system.

By default, particles are generated by every cell in a system over the entire duration of
the emitter. The duration of each individually generated particle is defined by the Life
parameter of the cell that generated it, and not by the duration of the cell itself.

The duration of the cell actually controls the duration over which new particles are
generated. You can change a cell’s duration by dragging either its position or its In and
Out points in the Timeline. In this way, you can adjust the timing that defines when each
cell’s particles emerge.
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For example, you can create a particle system that simulates an explosion by offsetting
the appearance of three different types of particles. First, dense white particles emerge
from the center. Half a second later, more diffuse orange particles appear around a larger
area. One second after that, small sparks emerge from underneath both of these layers
as they fade away.

You can offset a cell in the Timeline or mini-Timeline to start before the emitter. This
creates a “preroll” in which the particle simulation starts before the particles are drawn.

For more information on adjusting the timing of layers in the Timeline, see Using the
Timeline.

Creating Graphics and Animations for Particle Systems
Creating a new particle system from scratch begins with designing the particles you want
it to emit. You can use any image, shape, text, or movie supported by Motion as a source
for a cell. This section presents things to keep in mind when you create particle imagery.

Creating Still Image Graphics for Particle Systems
Particle systems that use still images as their cell sources render in real time much faster
than systems that use video or animation clips. A still image is often all you need to create
a compelling particle system. Here are some guidelines for creating graphics for use as
particles.
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Graphics Size
If you are unsure what size you want your particles to be, it’s a good idea to make your
graphics larger rather than smaller. Increasing the size of particles beyond the size of the
original graphic may introduce unwanted artifacts. One caveat, however, is that the larger
the cell source size, the slower your interactivity.

Particle Edges
Keep in mind that the quality of the edges of your graphics can be extremely important
for creating convincing particles. Soft, translucent edges might look better than hard,
over-defined ones.

Object Color
By default, particles are created using the original colors of the image being used as the
cell. If necessary, you can tint the emitted particles using the Color Mode parameters in
the Emitter and Particle Cell tabs. Choose between tinting all particles by a single color
or creating a gradient tint that changes color over time. You can also choose to apply a
Library gradient to the particles. Tinting particles applies the tint color uniformly over the
entire particle system.

Create Graphics with an Alpha Channel
Always create graphics that you want to use as cells with predefined alpha channels. For
more information on importing files with alpha channels, see More About Alpha Channels.

Creating Animations to Use as Cells
You can also use QuickTime movies as cells. For example, you can create an animation
in Motion, render it as a QuickTime movie, and import it into another Motion project to
use as a cell. In general, the same recommendations for creating still graphics apply to
the creation of animation or video clips you intend to use as cells, but there are additional
considerations.

If a clip has been retimed, in the Properties tab or with a Retiming behavior, the effect of
the retiming is carried through to the particles system.

Note: Keep in mind that using a movie as the source cell for an emitter may impact your
project’s interactivity.

Create Clips That Loop
Particles created from QuickTime clips loop over and over for the duration of each
individual particle’s life. If the clip you use doesn’t loop well, there will be a jump cut at
every loop point. Another option is to use very short movies to introduce randomness
into the appearance of the particle system.

624 Chapter 11 Working with Particles



Use Video Clips with Minimal Compression
Ideally, QuickTime clips to be used as particles should be saved using a high-quality codec,
such as Animation or Uncompressed 8- and 10-bit 4:2:2. Other codecs can be used, but
they may introduce unwanted artifacts depending on the level of compression used.

There is an option to use random start frames, which cause the clips to play out of sync
relative to one another in the Canvas. There is also an option to play or not play the clip.

The Difference Between Emitter and Particle Cell Parameters
Emitter and Particle Cell parameters, though closely related, serve different purposes.
Emitter parameters control the overall shape and direction of the animated mass of
particles generated by the system. Other emitter parameters simultaneously modify the
parameters of all cells inside that emitter.

Particle Cell parameters, on the other hand, control the behavior of particles generated
from each cell that’s inside the particle emitter. For more information, see Particle Cell
Parameters in the Inspector.

When only one layer is used as a particle cell source, the cell controls appear in the Emitter
tab as well as in the Particle Cell tab. Once more than one layer is added to a Particle
Emitter, all cell controls appear in the Particle Cell tab. To access this tab, the cell must
be selected in the Layers tab or Timeline.

To open a particle system’s Emitter tab
1 Select an emitter object in the Layers tab, Timeline, or Canvas.

2 In the Inspector, click the Emitter tab.

The Emitter parameters appear.

The contents of the Emitter tab are dynamic, and different parameters appear depending
on the number of cells in the particle system, the emitter shape that’s used, and whether
the 3D checkbox is selected or deselected.

Parameters in the Particle Cell tab control the behavior of particles generated by the
selected cell, independently of the parameters governing the emitter. In particle systems
with multiple cells, each has its own particle cell parameters. This lets you create particle
systems made up of many kinds of particles, each with distinctly different behaviors.

For more information on using the Particle Cell parameters, see Particle Cell Parameters
in the Inspector.

To open a cell’s Particle Cell tab
1 Select any cell within an emitter in the Layers tab or Timeline layers list.

2 In the Inspector, click the Particle Cell tab.
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The Particle Cell parameters appear.
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Single Cell Versus Multi-Cell Emitter Parameters
If a particle system has only one cell, the Emitter tab displays all of the parameters for the
cell, as well as the emitter’s own parameters. In this case, you can control every aspect
of the particle system directly from this single tab, which saves you from having to go
back and forth between the Emitter and Particle Cell tabs.

Emitter tab for particle 
system with single cell

Emitter tab for particle 
system with multiple cells

If a particle system has two or more cells, the Emitter tab looks much different. The list
of parameters is much shorter, and the majority of the cell parameters are replaced with
a smaller group of master controls.
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Changes made using the master controls modify the effect of each cell’s parameters
relative to the other cells in the system. This means that for a particle system with three
cells that have different Scale values, increasing the Scale parameter in the Emitter tab
multiplies the Scale value of all three cells by the same percentage. This has the result of
increasing or reducing the size of every particle in the system, while keeping the size of
each particle relative to one another the same.

Original particle system Particle system scaled to 200 percent

For this reason, the master control parameters of multi-cell particle systems appear as
percentages.

Emitter and Cell Parameters
Several parameters in the Emitter tab are identical to those found in the Emitter HUD,
with one difference. While the emission control in the Emitter HUD allows you to
manipulate the Range, Angle, Latitude (3D), Longitude (3D), and Speed parameters using
a single, graphical control, the Emitter tab uses individual controls for each parameter.

Note: There is no way to directly control the animation of individual particles.

Important: The emitter parameters in the Properties and Emitter tabs can be keyframed
to change values over time.
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Emitter Parameters in the Inspector
These parameters determine how particles are distributed and rendered in your project.
The Emitter tab of the Inspector has a large number of parameters, some of which depend
on how certain parameters are set within the tab itself. All the various combinations of
parameters are described below.

Shape: The first parameter in the Emitter tab is the Shape pop-up menu. When 3D is
turned off, nine options are available. When the 3D checkbox is selected, two additional
shapes become available. Different shapes significantly alter the distribution of generated
particles. When you choose an emitter shape, different Emitter tab parameters appear
that are unique to that shape. For example, when Rectangle is the selected Emitter Shape,
Outline, Tile Fill, and Random Fill become available in the Arrangement options. When
Spiral is the selected Emitter Shape, the Arrangement parameter goes away and new
parameters such as Radius, Number of Arms, and Twists become available. These different
parameters provide additional control over the distribution of particles.

In addition, when the 3D checkbox is selected, the Render Particles, Emission Latitude,
Emission Longitude, and Depth Ordered parameters become available for all emitter
shapes.

• Point: This is the simplest emitter shape and is the default shape for newly created
emitters. It specifies a single point of emission for a particle system. There are no
additional parameters for the Point shape.
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• Line: Particles emerge from a line. Using the onscreen controls (with the Adjust Item
tool) or the Properties tab of the Inspector, you can specify the length and location of
the line. In the Inspector, you can set a specific number of points from which particles
emerge. This emitter shape is good for creating sheets of particles that cascade over a
wide area. The Line shape displays additional parameters.

• Rectangle: Particles emerge from a rectangle along its edge, or in a tile or random fill
pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the
size and location of the rectangle. Drag the corners to adjust width and height; drag
edges to adjust width or height independently. Depending on the selected Arrangement,
the Rectangle emitter shape displays additional parameters. In the following image,
the Emitter shape Arrangement parameter is set to Outline.

Use the following modifier keys to more precisely manipulate the corners of the
Rectangle onscreen controls (with the Adjust Item tool):

• Option: Adjustments to size are scaled uniformly, with the anchor point remaining
fixed.

• Shift: Adjustments to size are made proportionally.
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• Circle: Particles emerge from a circle-shaped emitter. Particles can be emitted in an
Outline, Tile Fill, or Random Fill pattern. This emitter shape is good for surrounding an
element in a composition with particles that emerge from its edge. Using the onscreen
controls (with the Adjust Item tool), you can specify the size and location of the circle.
Depending on the selected Arrangement, the Circle emitter shape displays additional
parameters. In the following image, the shape’s Arrangement parameter is set to Outline.

• Burst: Particles emerge from a burst pattern. Using the onscreen controls (with the
Adjust Item tool), you can specify the size and location of the burst. The Burst shape
displays additional parameters.
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• Spiral: Particles emerge from a spiral pattern. Using the onscreen controls (with the
Adjust Item tool), you can specify the size and location of the spiral. The Spiral shape
displays additional parameters.

• Wave: Particles emerge from a waveform. Using the onscreen controls (with the Adjust
Item tool) or the Start Point and End Point parameters in the Emitter Inspector, you
can specify the length and location of the wave. The Wave shape displays additional
parameters.

• Geometry: Particles emerge from the edge of a shape, defined by a spline object used
as the shape source. The Geometry shape displays additional parameters. The following
image on the right shows the shape that used as the emitter source. The image on the
left shows particles emerging from the edge of the shape source.
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To apply a shape as the geometry shape source for a particle emitter, drag the shape
to the Source Shape well in the Emitter Inspector (once Geometry is chosen from the
Shape pop-up menu).

• Image: Particles emerge from within an area defined by an image or from only the
edges of the image. The image may or may not have an alpha channel. If it does, the
shape of the alpha channel can also be used to define the emitter shape. The Image
shape displays additional parameters. The following image on the right shows the
image used as the emitter image source. The image on the left shows the particles
emerging from within the image.

To apply an image as the image source for a particle emitter, drag the image to the
Image Source well in the Emitter Inspector (once Image is chosen from the Shape
pop-up menu).
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• Box: This option is available when the 3D checkbox is selected in the Emitter tab.
Particles are emitted from a three-dimensional cube along its surface (Outline), or in a
tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you
can specify the size and location of the rectangle. Drag the front horizontal edge to
adjust height; drag the front vertical edge to adjust width; drag a back edge to adjust
depth; drag a front corner to simultaneously adjust the width and height. To reposition
the emitter, drag in the shape (but not on an edge or corner point). Depending on the
selected Arrangement, the Box shape displays additional parameters. In the following
image, the box’s Arrangement is set to Tile Fill.

• Sphere: This option is available when the 3D checkbox is selected in the Emitter tab.
Particles are emitted from a three-dimensional sphere along its surface (Outline) or in
a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool),
you can specify the radius and location of the sphere. Drag the outline of the sphere
to adjust its radius; drag within the sphere to reposition it in the Canvas. When Sphere
is selected, the Arrangement parameter becomes available. Depending on the selected
Arrangement, the Sphere shape displays additional parameters.

Arrangement: This parameter appears when Rectangle, Circle, Image, Box, or Sphere is
chosen in the Shape pop-up menu. Specifies the pattern from which the particles are
generated. The arrangement options are:

• Outline: Emits particles along the edge of the shape in 2D emitters and along the surface
of the shape in 3D emitters.

• Tile Fill: Emits particles from a tiled pattern of rows, columns, and ranks (3D emitters)
within the circle, rectangle, image, box, or sphere. You can specify the number of
columns, rows, and ranks, as well as the Tile Offset.

• Random Fill: Emits particles randomly from within the circle, rectangle, image, box, or
sphere.
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Size: This parameter is available when Rectangle or Box is chosen in the Shape pop-up
menu. Defines the size of the rectangle or cube from which particles are emitted. This
parameter is available whether the Arrangement is set to Outline, Tile Fill, or Random Fill.
When Rectangle is the selected shape, the Width and Height parameters are available.
When Box is selected, an additional Depth parameter is available.

Note: The Height is measured in project pixels; however, the Width is measured in square
pixels. This is done so that a shape that is numerically square will look square when Correct
for Aspect Ratio is turned on (checkmarked) in the View pop-up menu in the top-right
corner of the Canvas.

Columns: This parameter is available when one of the following is chosen in the Shape
pop-up menu: Rectangle, Circle, Image, Box, or Sphere; in addition, Arrangement must
be set to Tile Fill. This parameter specifies the number of horizontal emitter points on a
grid over the selected emitter shape. In the case of an irregular shape (nonrectangular),
grid points that fall outside of the shape are ignored.

Rows: This parameter is available when one of the following is chosen in the Shape
pop-up menu: Rectangle, Circle, Image, Box, or Sphere; in addition, Arrangement must
be set to Tile Fill. This parameter specifies the number of vertical emitter points on a grid
over the selected emitter shape. In the case of an irregular shape (nonrectangular), grid
points that fall outside of the shape are ignored.

Ranks: This parameter is available when Box or Sphere is chosen in the Shape pop-up
menu and Tile Fill is the selected Arrangement. This parameter specifies the number of
points in Z space on a grid over the selected shape from which particles are emitted.

Tile Offset: This parameter is available when one of the following is chosen in the Shape
pop-up menu: Rectangle, Circle, Image, Box, or Sphere; in addition, Arrangement must
be set to Tile Fill. Values from 0 to 100% offset the rows toward the right, and values from
0 to –100% offset the rows toward the left. A value of 50 or –50% creates a “brickwork”
pattern.

Image Source: This parameter is available when Image is chosen in the Shape pop-up
menu, and lets you specify the object used to define the shape of the emitter. Any image
or movie clip can be dropped onto this well to assign the desired shape.

Shape Source: This parameter is available when Shape is set to Geometry. This image
well allows you to specify an object that defines the shape of the emitter. Spline objects
may be dropped onto this well to assign the desired shape.

Emission Alpha Cutoff: This parameter is available when Image is chosen in the Shape
pop-up menu. When the Image Source object contains an alpha channel, this slider
defines the minimum opacity value that is necessary to create particles at that point on
the source image. For example, when set to 25%, particles appear only where the alpha
value of the image is equal to or greater than 25% opacity. The lower the Emission Alpha
Cutoff value, the more particles appear. In order for this parameter to be effective, the
alpha channel needs to have areas of varying transparency.
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Start Point: This parameter becomes available when Shape is set to Line or Wave. Two
sliders that define, in X and Y coordinates, the first point of the line used as the emitter
shape. Click the disclosure triangle to modify the Z position of the start point. You can
adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool).

End Point: This parameter becomes available when Shape is set to Line or Wave. Two
sliders that define, in X and Y coordinates, the second point of the line used as the emitter
shape. Click the disclosure triangle to modify the Z position of the start point. You can
adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool).

Emit At Points: This checkbox is available when any of the following is chosen in the
Shape pop-up menu: Line, Rectangle (with Arrangement set to Outline or Random), or
Circle (with Arrangement set to Outline or Random), Burst, Spiral, Wave, Geometry, Box
(with Arrangement set to Outline), Sphere (with Arrangement set to Outline). When the
Emit At Points checkbox is selected, particles emerge from a limited number of points
(as defined in the Points parameter). When the checkbox is deselected, particles may
emerge from anywhere on the line or edge. When the Adjust Item tool is selected, the
points are visible in the Canvas. When Emit At Points is selected, two additional parameters
become available: Point and Offset.

Points/Points Per Arm: This parameter is available when any of the following is chosen
in the Shape pop-up menu: Line, Rectangle, Image, or Circle (with Arrangement set to
Outline or Random Fill), Burst, Spiral, Wave, or Geometry; in addition, the Emit At Points
checkbox must also be selected. Defines the number of points from which particles are
emitted. For Rectangle or Circle shapes, the particles are emitted from evenly distributed
points along the edge of the shape when Outline is chosen from the Pattern pop-up
menu. When the Adjust Item tool is selected, the points are visible in the Canvas.

Keep in mind that using a large number of points slows your computer’s processing time.

Radius: This parameter is available when one of the following is chosen in the Shape
pop-up menu: Circle, Burst, Spiral, or Sphere. Defines the size of the shape from which
particles are emitted.

Twists: This parameter, available when Spiral is chosen in the Shape pop-up menu, defines
the number of turns in the spiral. The default value is 0.25.
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Number of Arms: This parameter, available when Burst or Spiral is chosen in the Shape
pop-up menu, defines the number of branches from which particles are emitted. The
default value is 3.

Spiral emitter shape set to default Number of 
Arms and Twists

Spiral emitter shape with default Arms and 
Twists set to .70

Amplitude: This parameter, available when Wave is chosen in the Shape pop-up menu,
defines half the distance from the highest point to the lowest point in the wave. Higher
values result in more extreme waves.

Frequency: This parameter, available when Wave is chosen in the Shape pop-up menu,
defines the number of waves. Higher values result in more waves.

Phase: This parameter, available when Wave is chosen in the Shape pop-up menu, defines
the degrees of the offset of the waves from the start and end points of the path. When
set to 0 degrees (default), the wave begins and ends at half the distance from the highest
point to the lowest point in the wave. When set to 90 degrees, the wave begins and ends
at the highest point in the wave. When set to 90 degrees, the wave begins at the lowest
point in the wave. When set to 180 degrees, the waves are the same as 0 degrees, but
inverted.

Damping: This parameter, available when Wave is chosen in the Shape pop-up menu,
determines the direction of progressive diminishment of the oscillation of the wave.
Positive damping values diminish the wave forward (from left to right); negative values
diminish the wave backward (from right to left).

Offset: This parameter is available when any of the following is chosen in the Shape
pop-up menu: Line, Rectangle (with Arrangement set to Outline), Circle (with Arrangement
set to Outline), Burst, Spiral, Wave, Geometry, or Image. Offsets either the emitter itself
or the particles generated on the shape. For example, when the emitter Shape is a Line,
changing the Offset value moves the emitter’s position in the Canvas. When the emitter
Shape is a Rectangle and Pattern is set to Outline, changing the Offset value moves the
particles along the edge of the shape.
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3D: When this checkbox is selected, the 3D emitter shapes (Box and Sphere) become
available. Because all emitter shapes can be used in 3D space, additional 3D parameters
are available for all emitter shapes when the 3D checkbox is selected: Render Particles,
Emission Latitude, and Emission Longitude. These additional parameters appear in the
Emitter Inspector and HUD.

These parameters are available for all shapes, regardless of the Arrangement setting.

Note: When the 3D checkbox is selected, particles cannot receive reflections and the
Reflections parameter (in the Properties tab) is no longer available for the emitter.
Additionally, when the 3D checkbox is selected, In Global 3D (Better) must be selected
from the Render Particles pop-up menu in order for particles to cast shadows and to be
affected by lights.

For more information on the additional 3D controls in the HUD, see. Emitter HUD
Parameters.

Emission Angle: This parameter is only available when Shape is set to a 2D shape. This
dial sets the direction in which particles travel. This parameter works in conjunction with
the Emission Range parameter. It is equivalent to one of the functions of the graphical
emission control in the Emitter HUD.

Note: When using an emitter shape other than a Point, such as a Line, Circle, Rectangle,
Spiral, Burst, or Wave, and Outline is chosen from the Arrangement pop-up menu, setting
the Emission Angle parameter to 180 degrees and the Emission Range parameter to
0 degrees restricts the emission of particles to the inside of the shape. Setting the Emission
Angle parameter to 0 degrees and the Emission Range parameter to 0 degrees restricts
the emission of the particles to outside of the shape.

Emission Range: A dial that restricts the area around the center of each emission point
from which particles are generated, in the direction of the Emission Angle. It is equivalent
to one of the functions of the graphical emission control in the Emitter HUD.

Note: When using a Line, Circle, Rectangle, Spiral, Burst, or Wave (but not Geometry)
shape, setting the Emission Range parameter to 0 degrees keeps particles perpendicular
to the emitter when they emerge.

Render Particles: A pop-up menu that appears when the 3D checkbox is selected, enabling
you to choose between two different rendering methods for the particles.

• In Local 3D (Faster): The default setting, renders particles faster but does not allow for
intersections with layers within the particles group or with layers in other groups, or
allow particles to cast shadows.

• In Global 3D (Better): This setting allows the particles to intersect with layers within the
emitter group and with layers in other groups. When turned on, your project’s
interactivity is slowed.
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Important: When the 3D checkbox is selected, In Global 3D (Better) must be selected
from the Render Particles pop-up menu in order for the 3D particles to cast shadows
and to be affected by lights.

Emission Latitude: Available when 3D is turned on, this control specifies the emission
direction (in degrees latitude) of the particles.

Emission Longitude: Available when 3D is turned on, this control specifies the axis of
rotation (in degrees longitude) from which the particles are emitted.

Depth Ordered: Available when 3D is turned on. When activated, this checkbox draws
the particles in the particle system according to each particle’s actual 3D position in the
project. In other words, particles that are closer to the camera appear closer; particles
that are farther away from the camera appear more distant.

Depth Ordered on Depth Ordered off

Face Camera: A checkbox that becomes available when 3D is turned on. When activated,
the particle system always faces the active scene camera. For more information on cameras,
see Active Camera.

Render Order: A pop-up menu that determines whether new particles are drawn on top
of or underneath particles that have already been generated. There are two options:

• Oldest First: New particles appear on top of older particles.

• Oldest Last: New particles appear underneath older particles.

Interleave Particles: Turning this checkbox on mixes particles generated from multiple
cells together. Turning this checkbox off layers particles in the same order as the cells
that generate them.

Note: This option has no effect with particle systems containing only one cell. Leaving
this option off speeds rendering with multiple cells.
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Particle Cell Parameters in the Inspector
The following parameters apply to the creation and motion of the individual particles
generated by each cell within an emitter. Cell Controls appear at the bottom of the Emitter
tab of the Inspector when a particle system is selected, and in the Particle Cell tab of the
Inspector when a particle cell is selected.
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Birth Rate: A slider that defines the birth rate of the cell. In other words, this parameter
defines how many particles of this cell emerge from the emitter every second. Higher
values create denser particle effects.

Low birth rate particle system High birth rate particle system

Birth Rate Randomness: A slider that defines an amount of variance in the Birth Rate of
generated particles. A value of 0 results in no variance—particles emerge from the emitter
at the same rate. A value greater than 0 introduces a variance defined by the Birth Rate
parameter, plus or minus a random value falling within the Birth Rate Randomness.

Initial Number: A slider that defines the initial number of particles. This parameter
determines how many particles of this cell appear at the first frame of a particle effect.
The result is an initial burst of particles that eventually evens out according to the Birth
Rate parameter.

Initial Number set to 5 (frame 3) Initial Number set to 20 (frame 3)
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Life: A slider that defines the duration of every particle, in seconds. This parameter specifies
how long each particle lasts before vanishing from existence. This effect is similar to how
sparks disappear after flying away from a sparkler. Unless the Color Over Life parameter
or Opacity Over Life parameter is used to fade each particle out over its life, particles
immediately vanish at the end of their lifetimes.

Life set to 5 (frame 60) Life set to 2 (frame 60)

Life Randomness: A slider that defines an amount of variance in the life of generated
particles. A value of 0 results in no variance—all particles from the selected cell emerge
with the same lifetime. A value greater than 0 introduces a variance defined by the Life
parameter, plus or minus a random value falling within the Life Randomness.

Speed: A slider that defines initial speed. This parameter determines how quickly each
particle flies away from the emitter. This, in conjunction with the Life and Birth Rate
parameters, determines how many particles appear in the Canvas at any given frame. It
is equivalent to one of the functions of the graphical emission control in the HUD.

Speed Randomness: A slider that defines an amount of variance in the speed of generated
particles. A value of 0 results in no variance—all particles from the selected cell emerge
with the same speed. A value greater than 0 introduces a variance defined by the Speed
parameter, plus or minus a predetermined random value falling within the Speed
Randomness.

Align Angle: When selected, the particles automatically rotate to match the shape on
which they are positioned. This parameter is available in all cases but the following:
Rectangle, Circle, Image, Box, and Sphere shapes with Tile Fill or Random Fill and Point.

Angle: A dial that defines the angle of rotation, in degrees, at which new particles are
created.

Angle Randomness: A dial that defines an amount of variance in the angle of generated
particles.

Spin: A dial that animates particles in a system by initially spinning each individual particle
around its center. Adjustments to this control are in degrees per second.
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Spin Randomness: A dial that defines an amount of variance in the spin of generated
particles. A value of 0 results in no variance—all particles from the selected cell spin at
the same rate. A value greater than 0 introduces a variance defined by the Spin parameter,
plus or minus a random value falling within the Spin Randomness.

Additive Blend: By default, particles are composited together using the Normal blend
mode. Select this checkbox to composite all overlapping generated particles together
using the Additive blending mode. This blending occurs in addition to whichever
compositing method is already being used. The result is that the brightness of overlapping
objects is intensified. This effect applies only to the particle system itself—the blend mode
of the emitter determines how the result of the emitter is blended into the scene.

Additive Blend off Additive Blend on

Color Mode: A pop-up menu that determines if and how particles are tinted. There are
five options:

• Original: Particles are generated using their original colors. When Original is chosen,
the Opacity Over Life parameter appears. Adjust the opacity controls to animate changes
to the opacity of particles over their lifetime.

For more information on using the gradient controls, see Using the Gradient Editor.
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• Colorize: Particles are tinted using the color specified in the Color parameter. Additional
Color and Opacity Over Life parameters appear.

• Color: Available when the Color Mode is set to Colorize, specifies a color to use to
tint the particles. You can also modify the alpha channel of each particle, altering its
opacity. This parameter is unique to the cell object. You can click the color well to
choose a color, use the eye dropper, or open the disclosure triangle and adjust the
Red, Green, Blue, and Opacity channel sliders.

For more information on using the Color controls, see Color Well.

For more information on using the gradient controls, see Using the Gradient Editor.

• Over Life: Particles are tinted based on their age, with the range of possible colors
defined by the Color Over Life gradient editor.

• Color Over Life: The Color Over Life gradient editor defines the range of color that
each particle assumes as it ages, beginning with the leftmost color in the gradient,
and progressing through the range of colors until finally reaching the rightmost color
at the end of its life. For more information on using the gradient controls, see Using
the Gradient Editor.

• Color Repetitions: Available when Color Mode is set to Over Life, this slider determines
the number of times the gradient color pattern is repeated over the life of the particle.

644 Chapter 11 Working with Particles



• Pick From Color Range: Particles are tinted at random, with the range of possible colors
defined by the Color Range gradient editor. A point on the gradient is randomly chosen,
so the relative sizes of each color region determine the frequency of the color being
used.

• Color Range: This gradient editor appears when Color Mode is set to Pick From Color
Range. Use it to define a range of colors used to randomly tint new particles. The
direction of the gradient colors is not relevant, only the number of colors that appear
within the gradient. The Color Range parameter has the same controls as the Color
Over Life gradient editor.

For more information on using the gradient controls, see Using the Gradient Editor.

• Take Image Color: When you choose this mode, each new particle’s color is based on
the color of the image at the position where the particle was generated. This mode is
available only when the Shape pop-up menu in the Emitter tab is set to Image.

Scale: A slider that defines the scale of every particle of a cell. Click the disclosure triangle
next to the Scale parameter to reveal separate X and Y scaling subparameters, which can
be used to resize the width and height of generated particles. This control affects the
initial scale of the particle (compared to the Scale Over Life behavior in the Particles
behavior category).

Scale set to 200% Scale set to 50%
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Note: When you use an image as a particle cell source and set a low Scale value, it is
recommended that you set the render quality in the Render pop-up menu (in the Status
Bar) or the View menu to Best (choose View > Quality > Best).

Scale Randomness: A slider that defines an amount of variance in the scale of generated
particles. A value of 0 results in no variance—all particles from the selected cell emerge
with the same size. A value greater than 0 introduces a variance defined by the Scale
parameter, plus or minus a random value falling within the Scale Range. The disclosure
triangle of the Scale parameter reveals separate X and Y subparameters, which can be
used to set the width and height of the Scale Range separately.

Attach To Emitter: A slider that determines how closely particles follow the position of
a moving emitter. If set to zero, particles follow their own path after being emitted,
resulting in particles that trail along the motion path the emitter is following. If this
parameter is set to 100, in the absence of other behaviors, all generated particles follow
along with the emitter, surrounding it in a moving cloud of particles.

Attach to Emitter set to 0 (zero) Attach to Emitter set to 100

Play Frames: This parameter appears if the particle system was created from a QuickTime
movie. This checkbox controls playback. If selected, playback of the animation or movie
clip used to generate each particle loops. If deselected, particles are generated using the
still frame specified by either the Random Start Frame parameter or the Source Start
Frame parameter.

Random Start Frame: This checkbox appears if the particle system was created from a
QuickTime movie. Introduces variation into animated particles generated from QuickTime
objects. If selected, each newly generated particle begins at a different frame of the
animation. Stills are chosen randomly if Play Frames is deselected.

Source Start Frame: This parameter appears if the particle system was created from a
QuickTime movie. Chooses the frame to begin animation, if the Play Frames checkbox is
selected, or the still frame to display if Play Frames is deselected. This parameter only
appears if Random Start Frame is deselected.
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Hold Frames: This parameter appears if the particle system was created from a QuickTime
movie. Adjust the slider to change the number of times each frame of the source movie
is repeated during playback. The larger the Hold Frames value, the slower your playback.

Hold Frames Randomness: This parameter appears if the particle system was created
from a QuickTime movie. Varies the number of frames to “hold.”

Show Particles As: Use this pop-up menu to view particles in a variety of preview modes,
or as they actually appear. These nonimage modes play more efficiently when viewing
a complex particle system and also provide other ways of analyzing particle motion. By
default, this parameter is set to Image, which displays each particle as it is supposed to
appear. There are four options from which to choose:

• Points: Each particle is represented by a single point. This is the fastest preview mode
and is useful for displaying the type and speed of particle motion in a system. When
selected, the Point Size parameter is revealed.

• Lines: Each particle is represented by a line. This is a good preview mode to use to
analyze the vector of each particle’s motion. The length of each line is determined by
that particle’s speed, and the angle of each line equals each particle’s direction.
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• Wireframe: Each particle is represented by a bounding box. Because the bounding
boxes are good indicators of each particle’s orientation in the system, this preview
mode is useful for evaluating the movements of individual particles. For example, it’s
easy to see the angle of rotation for particles that are spinning or following a complex
motion path.

• Image: Displays the full particle system effect.

Note: Whatever is selected in the Show Particles As pop-up menu appears in your final
render.

Random Seed: Although particle systems seem random, they’re actually deterministic.
This means that the random variation in each particle system is created based on the
number shown here. Unless this seed number is changed, a particle system with the same
parameter settings always plays back with the same motion. If you don’t like the current
random motion or distribution of the particle system, you can change the seed number
by typing a new number or clicking Generate. This changes the random calculations
performed for that system for all randomness parameters.

For more information about the random nature of particle systems, see The Predictability
of Particle Systems.

Particle Source: In particle systems with more than one cell, a parameter representing
each cell appears at the bottom of the Emitter tab. Each cell parameter has a checkbox
you can use to enable or disable that cell, a name field, and an image well for that object.
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Animating Objects in Particle Systems
You can add behaviors to a particle system’s emitter, or to the cells themselves, to quickly
achieve sophisticated, organic effects with very little effort. You can animate any emitter
using Basic Motion, Parameter, or Simulation behaviors. Emitter parameters and cell
parameters can also be animated via keyframes. If you animate emitter-specific parameters
such as Emission Angle or Emission Range, the position and distribution of new particles
generated by that emitter are animated. All animation occurs relative to the duration of
the emitter.

Animating an emitter’s Properties tab parameters is useful for altering the position and
geometric distribution of a particle system over time. Keyframing an emitter’s Position
parameter moves the source of newly emitted particles without affecting any particles
that were generated at previous frames, which creates a trail of particles.

Keyframing an emitter’s Emitter tab parameters is a good way to modify the particle
system’s overall characteristics over time, such as increasing or decreasing the size, speed,
or lifetime of newly generated particles.

Particles also have their own category of behaviors. The Particles behaviors include Scale
Over Life and Spin Over Life, which allow you to modify and animate the rotation and
size of the particles over their lifetime.

Using the Motion Tracking behaviors, you can apply existing tracking data to an emitter
or track an emitter to a clip. For more information on using the Motion Tracking behaviors,
see Motion Tracking.

For an example of a keyframed emitter object in a particle system, see Example 2: Creating
Animated Pixie Dust. For more information on keyframing parameters in the Curve Editor,
see Keyframes and Curves.

Applying Behaviors to Emitters
Applying behaviors to emitters is a quick and easy way to move emitters in your project.
Attaching the Motion Path and Snap Alignment to Motion behaviors to an emitter affects
the position of the source of all new generated particles. Throw and Spin affect the position
and rotation, respectively, of the emitted particles, unless Affect Subobjects is deselected.

With all Basic Motion behaviors, once individual particles emerge, they’re unaffected by
changes to the position of the emitter. This means that moving the emitter around the
screen using behaviors results in the creation of a trail of particles that behave according
to their particle cell parameters.

Note: This effect can be overridden by increasing a cell’s Attach to Emitter parameter
value.
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To apply a behavior to an emitter
µ Drag a behavior from the Library onto an emitter in the Canvas, Layers tab, or Timeline.

The behavior is applied to the emitter, which begins to move according to the parameters
of the behavior.

Note: Not all behaviors instantly activate an object when applied. For example, when a
Throw behavior is applied to an object, the Throw Velocity parameter must be adjusted
before the object moves.

Applying Behaviors to Cells
Simulation behaviors that are applied directly to cells are in turn applied to each individual
particle generated from that cell. This can result in some extremely complex animations
as dozens of particles move according to the behaviors you’ve defined. Behaviors applied
to cells have no effect on the position of the emitter. Parameter behaviors on a cell only
affect particles when they are created.

To apply a behavior to a cell
µ Drag a behavior from the Library to a cell in the Layers tab or Timeline.

The behavior is applied to the cell, and all particles generated from that cell begin to
move according to the parameters of the behavior.

Tip: If you do not see your expected result when applying behaviors to particle cells, try
turning the Affect Subobjects parameter on or off or selecting a different option from
the Affect pop-up menu in the HUD or Behaviors tab of the Inspector. These parameters
determine whether the entire object (such as the particle emitter) or its components
(such as the particle cells) are affected by the behavior and how an object interacts with
surrounding objects, respectively.

Note: The Affect Subobjects checkbox only appears in the Behaviors tab when the Throw
and Spin behaviors are applied to a group that contains multiple objects, such as a group,
particle emitter, or text.

Applying Parameter Behaviors to Emitter or Cell Parameters
As with all objects in Motion, you can apply Parameter behaviors to the parameters in
the Emitter or Particle Cell tab.

To apply a parameter behavior to an emitter or cell parameter
Do one of the following:

µ Drag a behavior from the Library onto an emitter or cell in the Layers tab or Timeline. In
the Apply To section of the Behaviors tab or HUD, choose an option from the Go pop-up
menu.

µ Select an emitter or cell in the Layers tab or Timeline, click Add Behavior, and choose a
Parameter behavior. In the Apply To section of the Behaviors tab or HUD, choose an
option from the Go pop-up menu.
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µ In the Emitter or Particle Cell tab, Control-click a parameter, then choose a Parameter
behavior from the shortcut menu.

Using Particles Behaviors
The Particles category in the Library contains two behaviors specifically for use with the
cells or emitter in a particle system:

Scale Over Life
This behavior lets you grow or shrink the particles in a system over the duration of each
particle’s life. It has one main parameter, and three optional parameters that appear
depending on the selected Increment Type.

Parameters in the Inspector
Increment Type: Choose an option from this pop-up menu to determine which method
is used to resize particles over their lifetime. There are four options:

• Natural Scale: Specifies starting and ending scale percentages that are used to animate
each particle’s size over its lifetime. Natural Scale uses an exponential curve to allow
the animation to progress slowly when the scale values are small, and speed up when
the values are large. This creates the illusion that the scaling is occurring at a constant
speed. When Natural Scale is selected, the Scale At Birth and Scale At Death parameters
become available.

• Rate: Specifies a steady rate at which particles change size over their entire lifetimes.
When Rate is selected, the Scale Rate parameter becomes available.

• Birth and Death Values: Specifies starting and ending scale percentages that are used
to animate each particle’s size over its lifetime. The scale amount generated by this
option for a specific particle at a specific time is multiplied by the pre-existing particle
Scale (defined in the Cell Controls section of the Emitter tab). When this option is
selected, the Scale At Birth and Scale At Death parameters become available.

• Custom: This mini-curve editor allows you to customize the scale of the particles over
their lifetime. Click the disclosure triangle to display the mini-curve editor in the
Inspector. For more information on using mini-curve editors, see Mini-Curve Editor.

Scale At Birth: Determines the initial size of particles when they are created. This parameter
appears when Natural Scale or Birth and Death Values is selected in the Increment Type
pop-up menu.

Scale At Death: Determines the size of each particle at the end of its lifetime. This
parameter appears when Natural Scale or Birth and Death Values is selected in the
Increment Type pop-up menu.

Scale Rate: Allows you to define how quickly each particle changes size. Positive values
grow particles over time, while negative values shrink particles over time. This parameter
appears when Rate is selected in the Increment Type pop-up menu.
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Custom Scale: This group of parameters appears when Increment Type is set to Custom.
Use this mini-curve editor for more precise control over the Scale of particles in your
particle system.

• Custom Scale: Use this slider to adjust the value of the selected keyframe in the
mini-curve editor. This parameter appears when Custom is selected in the Increment
Type pop-up menu.

• Over Life: Use this slider to adjust the position of the selected keyframe in the life of
the particle. This parameter appears when Custom is selected in the Increment Type
pop-up menu.

HUD Controls
The HUD contains the Increment Type pop-up menu, and the Scale Rate, Scale At Birth,
and Scale At Death parameters.

Spin Over Life
This behavior lets you spin the particles in a system over the duration of each particle’s
life. It has one main parameter and three optional parameters that appear depending on
the selected Increment Type.

Parameters in the Inspector
Increment Type: A pop-up menu that determines which method is used to spin particles
over their lifetime. There are three options:

• Rate: Specifies a steady rate and direction in which particles spin over their lifetime.
When Rate is selected, the Spin Rate parameter becomes available.

• Birth and Death Values: Specifies starting and ending spin degrees that are used to
animate each particle’s rotation over its lifetime. The spin amount generated by this
option for a specific particle at a specific time is added to the pre-existing particle spin
(defined in the Cell Controls section of the Emitter tab). When this option is selected,
the Spin At Birth and Spin At Death parameters become available.

• Custom: When Increment Type is set to Custom, a mini-curve editor appears that allows
you to customize the spin of the particles over their lifetime. Click the disclosure triangle
to display the mini-curve editor in the Inspector. For more information on using
mini-curve editors, see Mini-Curve Editor.

Spin Rate: Allows you to define how quickly each particle spins and the direction of the
spin. Positive values spin particles faster over time and in a counterclockwise direction;
negative values spin particles slower over time and in a clockwise direction.

Spin At Birth: Determines the initial spin of the particles when they are created.

Spin At Death: Determines the spin of the particles at the end of their lifetime.
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Custom Spin: This group of parameters appears when Increment Type is set to Custom.
Use this mini-curve editor for more precise control over the Spin of particles in your
particle system.

• Custom Spin: Use this control to adjust the value of the selected keyframe in the
mini-curve editor. This parameter appears when Custom is selected in the Increment
Type pop-up menu.

• Over Life: Use this slider to adjust the position of the selected keyframe in the life of
the particle. This parameter appears when Custom is selected in the Increment Type
pop-up menu.

HUD Controls
The HUD contains the Increment Type pop-up menu, and the Spin Rate, Spin At Birth,
and Spin At Death parameters.

Viewing Animated Emitter Curves in the Keyframe Editor
When you animate an emitter or cell parameter using keyframes, a curve describing that
animation appears in the Keyframe Editor. The selected object determines which curves
appear in the Keyframe Editor (when Animated is selected from the Show pop-up menu
in the Keyframe Editor list):

• Select the emitter to display animated emitter parameters such as Position and Rotation
(in the Properties tab) or Emission Angle and Range (in the Emitter tab).

• Select the cell to display animated parameters such as Birth Rate or Angle (in the Particle
Cell tab).

Note: To manually send an animated parameter to the Keyframe Editor, click the
parameter’s Animation menu, then choose Show In Keyframe Editor.

The parameter is displayed in the Keyframe Editor in a new, untitled curve set.
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Using Masks with Particle Systems
As shown in the following images, you can apply masks to the cell source layer of a particle
emitter. The effect of the mask on the cell source is carried through to the emitted particles.

Original source layer Bezier mask applied 
to source layer

Resulting particle system

You can also apply masks to the emitter object itself.

Rectangle mask (inverted) 
applied to the emitter object

For more information on working with masks, see Masking a Layer or Group.
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Applying Filters to Particle Systems
Filters can only be applied to a particle system’s emitter. You cannot apply separate filters
to individual cells. (Filters can be applied to the source of a particle cell, but not to a cell
directly.) As a result, filters always affect the entire particle system, including every single
cell, as if it were a single object.

Light Valve particle system default Light Valve with Bulge filter applied

For more information on applying filters to layers in your project, see Using Filters. For
more information on keyframing particle system parameters, see Animating Objects in
Particle Systems.

Particle System Examples
This section presents two examples of how to use particle systems to create very different
effects. The particle system created in the second example is turned into a 3D particle
system after the “pixie dust” is animated.

Tip: You can use the Make Clone Layer command to clone an emitter and then use the
Retiming controls or Retiming behaviors to create unique animations. For example, you
can create a starburst that explodes outward, then retracts, then explodes, and so on.
For more information on cloning, see Making Clone Layers.

Example 1: Creating an Animated Background
This first example describes how to create an animated background using a single still
image. By using the parameters available in the Emitter tab, a single image can be turned
into a complex animated texture. Once the example is created, quickly turn the system
into 3D particles using the 3D checkbox in the Emitter tab of the Inspector.

To create an animated background from a single image
1 Drag a file into the Canvas.
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This example uses a simple star graphic.

2 With the new layer selected, click the Make Particles icon in the Toolbar (or press E).

Once an emitter is added to the project, the following occurs:

• The emitter appears in the Layers tab and is selected.

• A cell containing the image to be “particle-ized” appears underneath the emitter.

• The original source layer (cell source) is disabled.

• In the Canvas, the emitter bounding box appears, which can be transformed using the
onscreen controls.

• The first particle appears in the Canvas in the same location as the original object.
Although it appears as if the particle is selected, it is actually the bounding box for the
emitter.

• The Emitter HUD is displayed. If you have hidden the HUD, press D or F7.

Note: For projects with a frame rate greater than 30 fps, at times only the bounding box
(not the particle cell) may appear at the first frame of your project. Because particles are
generated at a rate of 30 per second, there is no guarantee a particle will appear on every
frame.

3 In the Emitter tab of the Inspector, choose Circle from the Shape pop-up menu.

4 Choose Tile Fill from the Arrangement pop-up menu.

5 In the Cell Controls section of the Emitter tab, set the Initial Number parameter to 12.
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This creates a distributed group of particles that partially fills the Canvas.

6 To turn the particles into a uniform abstract mass, adjust the following parameters:

• Set Life to 4.

• Set Speed to 140.

• Set Spin to 60.

• Set Spin Randomness to 15.

• Select Additive Blend.

• Set Color Mode to Pick From Color Range. (Or, select another gradient from the Preset
pop-up menu if you prefer.)

• Set Scale to 65%.

• Set Scale Randomness to 150.

• Set Random Seed to 10000.

• Advance to frame 100. The resulting image now looks similar to this:

7 Apply a filter to the emitter.
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In this example, adding the Crystallize filter creates an even more abstract effect. You
might also consider adjusting the color gradient, or applying color correction to make
the background fit more appropriately with your foreground elements.

8 Adjust the Color Range opacity gradient so the particles fade in and out rather than
popping into and out of existence.

Example 2: Creating Animated Pixie Dust
This example shows you how to create a particle system that uses two different cells to
generate a streak of particles that trails behind another animated layer. Using two cells
adds more variation to a particle system than can be achieved with a single set of cell
parameters.

To create a two-cell particle system that leaves a trail
1 Drag the first image file into the Canvas.
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This example uses the Flare01 image from the Particle Images subcategory in the Content
category of the Library. This is a small image of a lens flare against black, with a built-in
alpha channel.

2 With the flare object selected, click the Make Particles icon in the Toolbar (or press E).

An emitter is added to the project, but nothing happens yet because the playhead is at
the first frame of the project, and only one particle has been created. Move the playhead
forward a few seconds to view the particle system at a frame where more particles have
been generated. You can also play the project while you make your modifications to the
particle system.

3 To create a variety of particles, place additional layers into the emitter you just created.

The easiest way to do this is to drag each additional layer you want to use into the group
containing the emitter.

Note: If you do not have any additional images in your project, you can create them in
the project or search the Content category in the Library for images.

Next, drag the new layer either onto the emitter, or below it (but not onto an existing
cell). This example uses the Spark12 file, also located in the Content folder in the Library.
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This results in the following image:

4 To make the particles generated by each different cell mingle together, select the
Interleave Particles checkbox in the Emitter tab of the Inspector.

5 Select the Flare01 cell in the Layers tab, then set the Scale slider in the Particle Cell tab
of the Inspector to 15%.

Doing this reduces the size of the particles generated by this cell.

6 Select the Spark12 cell in the Layers tab, then set the Scale slider in the Inspector to 45%.

The resulting image should look approximately like this:

Note: If necessary, disable the original Spark12 source layer.

7 Next, change the color of the particles generated by the Spark12 cell by doing the
following:

a Choose Colorize from the Color Mode pop-up menu.

b Click the color well in the Color section of the Inspector and choose a light red color
in the Colors window.

c Close the Colors window.
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All particles generated by that cell are now red.

8 Use the Opacity Over Life control to make this cell’s particles fade out over their life.

9 To make the spark particles spin as they move away, set the Spin parameter value to 60.

10 In the Layers tab, select the Flare01 cell of the particle system. Its parameters automatically
appear in the Inspector.

11 Follow the procedure in Step 7 to make these particles light yellow.

12 To make the particles generated from this cell spin in the opposite direction, set the Spin
parameter value to –60.
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13 To create a trail of particles, the emitter needs to be animated to follow the required
motion path. Do the following to create a motion path for the particle system:

a Place the playhead at frame 1.

b Click the Record button (or press A) to turn on animation recording.

c Select the emitter and drag the particle system to the lower-left corner of the screen.

d Press End to go to the last frame of the project.

e Drag the emitter toward the upper-right corner.

f Disable Record (press A).

g Click the Play button to begin playback.

14 Use the following illustration as a guide to adjust the Emission Range and Angle so the
particles appear to follow behind the emitter.

The result should look something like this:

You may want to adjust the Emitter parameters for Birth Rate, Life, and Speed to customize
the effect to your liking.
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To turn the system into 3D particles
1 In the Emitter Inspector, select the 3D checkbox.

3D checkbox

2 If your project does not contain a camera, click the New Camera button in the Toolbar.

If your project is a 2D project, a dialog appears asking if you want to switch your 2D
groups to 3D.

3 Click Switch to 3D.

A camera is added to the project, and your layers are turned into 3D layers.

4 In the 3D View tools (in the upper-right corner of the Canvas), drag the Orbit tool (the
center tool).

Pan tool

Orbit tool

Dolly tool

As the camera rotates, you can see that the particles are emitted in Z space.
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If you want your particles to intersect with other rotated layers, choose In Global 3D
(Better) from the Render Particles pop-up menu in the Emitter Inspector. In the following
image on the left, Global 3D is selected so the particles intersect with other objects in
the project that are transformed in 3D space. In the image on the right, Local 3D is selected
so the particles do not intersect with other objects.

Saving Custom Particle Effects to the Library
Once you have created a particle system that you are particularly proud of, you can save
it as a particle preset in the Particle Emitters, Favorites, or Favorites Menu folder of the
Library, for future use. Once you place particle systems in the Library, they become particle
presets that can be used just like any other particle preset.

Note: For organizational purposes, you may find it useful to create a new folder of your
own in the Favorites or Favorites Menu category to store custom particle systems.

To save a particle system to the Library
1 Open the Library and select either the Particle Emitters, Favorites, or Favorites Menu

category.

2 Drag the emitter you want to save into the stack at the bottom of the Library.

When you save a particle preset, it’s saved as a file in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Particle
Emitters/ folder. Any custom objects that you used to create that particle system also
appear here.

You can copy particle presets you create from this location to give to other Motion users,
or you can place particle presets that are given to you in this same folder. Whenever you
copy a particle preset file, you should make sure that you also copy any graphics or movie
files that it uses as well.

For more information on saving custom objects to the Library, see Adding Your Own
Content to the Library.
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Patterns of repeating elements are prevalent in various types of motion graphics projects,
from television title sequences, to news intros, to bumpers, to commercials. Creating
these complex collages is usually very time-consuming, requiring careful duplication of
elements, followed by tedious keyframing. The Motion replicator automates many of the
chores usually associated with setting up cascading arrays of kaleidoscopic imagery,
allowing you to create and animate your replicated images in dramatic ways quickly and
easily.

This chapter covers the following:

• Replicator Concepts (p. 666)

• Anatomy of a Replicator (p. 668)

• Getting Started with the Replicator (p. 672)

• Basic Replicator Parameters in the HUD (p. 680)

• Replicators and the Properties Tab (p. 684)

• Using the Replicator Onscreen Controls (p. 689)

• Advanced Replicator Controls (p. 692)

• Using Image and Geometry Objects (p. 722)

• Using Replicators in 3D Space (p. 724)

• Applying Masks to Replicators (p. 725)

• Animating Replicator Parameters (p. 727)

• Using the Sequence Replicator Behavior (p. 733)

• Using Behaviors with Replicators (p. 748)

• Applying Filters to Replicators (p. 750)

• Saving Custom Replicators to the Library (p. 751)
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Replicator Concepts
The replicator in Motion is specifically designed to build patterns of repeating elements
with a minimum of effort. The elements of the patterns can consist of video, still images,
shapes, text, or any other type of layer in a Motion project. For example, with very few
clicks of your mouse you can create a “video wall” based on a single QuickTime movie,
or a spinning pinwheel composed of basic shapes, or any other number of mesmerizing
graphics arrays.

Once you have replicated a layer, you can quickly change the shape of the pattern or set
its elements into motion by using behaviors or keyframes. In addition, the replicator has
a special behavior that allows you to animate the pattern’s elements in sequence over
the span of the onscreen composition.
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The Difference Between a Replicator and a Particle System
Although the replicator and particle systems share many of the same parameters, they
are very different tools. While both use layers (shapes, text, images, and so on) as cell
sources and both generate onscreen elements from those cells, each produces a unique
effect from those raw materials. A particle system generates dynamic elements that
change over time: Particles are born, emerging from an onscreen “emitter”; they move
across the Canvas; and they die, according to the “laws of nature” you specify in the
parameters of the system.

A replicator, however, is not a dynamic simulation. Its elements are not emitted like
particles (replicator elements do not have “birth rate,” “life,” or “speed” parameters). The
replicator simply builds a pattern of static copies of a source layer in a shape and
arrangement that you specify. Although the replicated elements you see onscreen are
static by default, the replicator parameters can be animated. For example, you can
designate a simple star shape as the source of your onscreen pattern and then replicate
the star multiple times along the outline of a circle. By keyframing the Offset and Color
parameters of your newly created replicator layer, you can launch the stars into animated
orbit around the center of the circle, making them change color as they whirl.

A behavior called Sequence Replicator allows you to “choreograph” the parameters of
your onscreen elements (their position, scale, and opacity, for example) in a cascade of
sequential animation. How the animation moves through the replicator pattern is
determined by the build style or origin of the replicator, as well as the parameters of
the Sequence Replicator behavior. This behavior works very similarly to the Sequence
Text behavior. For more information, see Using the Sequence Replicator Behavior.

You can replicate nearly any layer in Motion, including images, shapes, text, movies, and
image sequences. You cannot replicate a particle emitter or replicator layers. Each element
that is created is essentially a duplicate of the source layer. Unlike the particles of a particle
system, however, the elements are not animated over time by default.

Layer (paw print) prior to becoming replicated Layer (paw print) replicated in wave pattern
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The layer you use as the source for a replicator’s cells helps determine the look of the
replicator pattern. A single replicator can contain multiple source layers, resulting in
different cells in the same pattern and arrangement.

Single source layer (paw print) Two source layers (paw print and text)

Replicators take advantage of Motion’s 3D capabilities. Certain replicator shapes are
inherently 3D, and others can have points that exist in 3D space. Additionally, behaviors
applied to a replicator can pull pattern elements out of a plane. For more information,
see Using Replicators in 3D Space.

Anatomy of a Replicator
When you replicate a layer, two new layers appear in the Layers tab:

• A replicator layer that controls the onscreen pattern as a whole

• A cell layer that controls the individual elements in the pattern

The following sections explain the differences between replicators, cells, and the source
objects on which cells are based.
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Replicators and Cells
All replicators begin with a source layer: the object in your project that will be duplicated
and arrayed onscreen in a custom pattern. When you create a simple replicator—by
selecting the source layer you want to “replicate” and clicking the Replicate icon in the
Toolbar—two new layers are added to your project: A replicator layer and a cell layer.
The cell layer appears underneath its parent replicator layer in the Layers tab and Timeline
layers list. This cell layer is named for the source object. At the same time, the source
object itself is disabled but remains in its original position in the Layers tab.

Replicator

Cell

Replicated source layer 
(now disabled)

Once you have created the replicator, you can add additional cells by dragging another
source object from the Layers tab into the Replicator layer, as shown in the image below.
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When you drag the source object over the Replicator layer (while continuing to hold
down the mouse button), a drop menu appears. This menu gives you the option to add
the object as a replicator cell or to add the object as a mask to the replicator. For more
information, see Using Masks to Create Transparency.

The replicator and its cell (or cells) have separate sets of parameters that control the look
of the mosaic pattern you see in the Canvas. Changing the parameters of the replicator
changes the overall onscreen pattern, allowing you to create rectangular, circular, spiral,
and other geometric layouts. Changing the parameters of a cell affects each individual
element in the onscreen pattern, allowing you to modify attributes such as the angle,
color, and scale of the pattern pieces.

Replicator parameters are dynamic—different parameters appear in the Inspector
depending on the layout type you choose in the Shape pop-up menu. For example, when
Rectangle is the selected pattern shape, additional parameters appear in the Inspector
that allow you to modify the size of the rectangle, the number of rows and columns, and
other attributes. When Spiral is the selected shape, parameters appear that allow you to
adjust the radius of the spiral, the number of twists and arms, the number of points per
arm (the locations on the shape where the elements sit), and other attributes.
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Further, different parameters are also available depending on the selected arrangement
for the shape. In the following image, notice that the Columns, Rows, and Tile Offset
parameters are replaced with the Points and Offset parameters when the rectangle
arrangement is changed from Tile Fill to Outline.

Very different looks can be achieved by changing only a few parameters.

As with any effect in Motion, replicator parameters can be keyframed in order to change
a pattern’s dynamics over time. For example, you can create a wave of dots that follow
one another across the screen by keyframing the replicator’s Offset parameter.
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You can add behaviors to the replicator or its cells to create even more varied effects
(simulation behaviors can be especially effective). Behaviors applied to a replicator or a
cell can be applied to each element of the pattern. This lets you achieve almost limitless
variation and complexity that would take hours to animate using keyframes. You can also
apply a behavior, such as Vortex, to another object in your project (an object that is not
part of the replicator pattern), and have the pattern elements circumnavigate that object.

Replicator Source Objects
Almost any layer in Motion can be replicated (used as a cell source), including shapes,
text, images, image sequences, and clips.

Note: Although you can replicate a layer used as the source for a particle emitter, you
cannot replicate a particle emitter itself. You also cannot replicate a replicator.

Transformations that you apply to the source are respected in the replicator cells. For
example, if you use a sheared and rotated rectangle shape as the replicator source layer,
the replicated elements in the Canvas appear sheared and rotated. If the source layer has
applied filters, the effects of the filters are retained in the elements of the replicator
pattern.

Note: Keep in mind that replicating a movie, especially with applied filters, adversely
impacts your computer’s processing performance. For better performance, output your
sequence with the filter applied, then import it and use the movie as a source.

Creating Graphics and Animated Clips for a Replicator
Creating a replicator from scratch begins with designing the graphic you want to
replicate. You can use any image, shape, text, or movie supported by Motion as a source
for a replicator cell. The guidelines for creating source layers for a particle system also
apply to creating sources for the replicator. For more information, see Creating Graphics
and Animations for Particle Systems.

Getting Started with the Replicator
Although you can use the numerous replicator controls to create incredibly complex,
intricate animated patterns, replicating a layer in your project can be fast and easy. The
next two sections describe how to use pre-made replicators from the Library and how
to create a simple replicated pattern of your own.
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Using the Replicator Library Presets
The easiest way to add a replicator to your project is to use a replicator preset from the
Library. Because the Library replicators are pre-made using Motion content, they are for
more generalized usage. If you find one that is close to what you need, you can easily
customize its parameters after you add it to your project. Library replicators are added
to a project exactly like any other object.

For information on replicating your own objects, see Creating a Simple Custom Replicator
Pattern.

To use a replicator from the Library
1 Select the layer to which you want to add the replicator.

2 In the Library, select the Replicators category.

The Replicators category is divided into subcategories, such as Mattes, Transitional,
Backgrounds, and so on.

3 Select a subcategory, then select a replicator object, such as Curved Drops (in the
Miscellaneous subcategory).

A preview appears in the Preview area.

Note: If the preview does not automatically start playing, click the Play button in the
Preview area.

4 Once you have selected the replicator preset you want to use, do one of the following:

• Click Apply in the Preview area to add the replicator to the center of the Canvas.

• Drag the replicator to the Canvas.

• Drag the replicator to the desired group in the Layers tab or Timeline.

• Drag the replicator to the track area of the Timeline. As you drag, a tooltip displays the
current frame number.

The replicator preset appears in the project, composited above any objects below it in
the Layers tab.

Note: When adding items to the Timeline, additional options are available for compositing,
inserting, or overwriting layers. For more information, see Adding Objects to the Track
Area.
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Once you have added a replicator preset from the Library, it acts exactly as it appeared
in the Preview area. If necessary, you can edit the replicator parameters in the HUD or in
the Replicator tab of the Inspector to suit your project. You can also replace the preset
source with one of your own images, clips, shapes, or text layers as the source for the
pattern cells.

Note: You can only modify a replicator after it’s been added to a project. Once modified,
you can save the replicator in the Library. For information on saving custom replicators
to the Library, see Saving Custom Replicators to the Library.

To replace a replicator preset’s source image
1 In the File Browser or Library, select the file you want to use as the replacement graphic

for the replicator preset, then add it to the project.

2 In the Layers tab, drag the object over the replicator cell you want to replace.

3 When the pointer becomes a curved arrow, release the mouse button.

The original source object is replaced with the new object.

Creating a Simple Custom Replicator Pattern
Creating a custom replicator pattern begins by selecting a layer in your project to use as
a source for the cells of a new replicator pattern. To replicate an object, select the layer
that you want to use as a source, then click the Replicate icon in the Toolbar. By default,
a filled rectangular pattern is created from the source. You can then modify the replicator
parameters to suit your project needs.

Note: Like all other customized objects in Motion, you can save a replicator to the Library.
For more information, see Saving Custom Replicators to the Library.

To create a pattern from a source layer
1 Place an object that you want to replicate into your project.

This example uses the “5-sided star” from the Shapes category in the Library. Once added
to the project, the star object is scaled to 20%.
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2 Select the object, then do one of the following:

• In the Toolbar, click the Replicate icon.

• Choose Object > Replicate.

• Press L.

Once a layer is replicated, the following occurs:

• The replicator layer (labeled “Replicator”) appears in the Layers tab and is selected.

• A duplicate of the original layer (the star shape) becomes the replicator cell.

• The original source layer (the star shape) is disabled.

Note: Changes made to the original source layer, such as opacity or shearing, are
respected in the pattern after the replicator is created.

• In the Canvas, the replicator bounding box appears, which can be transformed using
the onscreen controls.

• In the Canvas, the default rectangle pattern appears, centered in the same location as
the source object. The pattern’s elements (the multiple stars) are created from the
replicator cell.
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• In the Toolbar, the Adjust Item tool is selected so that you can immediately begin using
the replicator’s onscreen controls.

Adjust Item tool

When the Adjust Item tool is selected, dragging the pattern’s bounding box resizes the
replicator. Dragging in the Canvas (not over the bounding box outline) repositions the
replicator object as a whole.

• The Replicator HUD is displayed.

Note: If you have hidden the HUD, press D.

By default, the patterns created by the replicator are not animated.

Removing a Replicator
You can remove a replicator from the Layers tab or Timeline layers list.

To remove a replicator
µ Select the replicator, then press Delete.

The original source layer or layers remain in the project.

Using Multiple Source Layers for the Replicator
When you create a replicator pattern from scratch, you don’t have to restrict yourself to
using just one cell source. You can create a pattern that includes different elements by
placing multiple cells inside of a single replicator.

You can add as many sources as you want to a single replicator. Each source becomes a
cell in the replicator, and each cell has its own set of parameters. The cell parameters
govern the elements in the pattern. When you select a replicator cell in the Layers tab or
Timeline layers list, its parameters are displayed in the Replicator Cell tab in the Inspector.

Additional cells can be created either by selecting multiple sources when initially creating
the replicator, or by dragging sources to the replicator layer in the Layers tab or Timeline
layers list.
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The following example uses two shapes as source layers for a single replicator.

To use multiple source layers for a replicator pattern
1 Shift-click to select the layers you want to replicate.

This example uses a white circle shape and a red elliptical shape (both created with the
Circle tool).

Note: Command-click noncontiguous layers that you want to add to the replicator.

2 Do one of the following:

• In the Toolbar, click the Replicate icon.

• Choose Object > Replicate (or press L).
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The cells of the default rectangle pattern are created from the source layers.

When multiple cells create a replicator pattern, the elements appear at the same points
on the pattern. The replicator is positioned at the average of the source’s positions.
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The elements in the pattern are stacked according to the order they appear in the Layers
tab and Timeline layers list. To change the stacking order of the layers, move the lower
cell above the upper cell.

Elliptical shape moved 
below white circle in 
Layers tab

Once the cells are reordered in the Layers tab, the red ellipse element appears in front
of the white circle element in the pattern.

To individually control the opacity of the elements in a replicator with more than one
source
Do one of the following:

µ Select the cell in the Layers tab, then adjust the Opacity Gradient control in the Replicator
Cell tab (or change Color Mode to Colorize and adjust the Opacity parameter in the Color
controls).

µ Select the original source layer—not the replicator cell itself—and change its opacity in
its HUD or Properties tab of the Inspector.

Removing a Source Layer from a Replicator
In the Layers tab or Timeline layers list, you can remove a cell from a replicator that
contains multiple cells.
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To remove a cell from a replicator
µ In the Layers tab or Timeline layers list, select the cell you want to remove, and then press

Delete.

The original source layers remain in the project.

Basic Replicator Parameters in the HUD
When a replicator is created from a source layer, the pattern is built using the default
parameters in the Replicator tab of the Inspector. You can also use the Replicator HUD
to easily change the most important of these parameters to suit your needs.

To display the Replicator HUD
µ In the Layers tab or Timeline layers list, select the replicator you want to display the HUD.

Note: If the HUD does not appear, choose Window > Show HUD (or press F7). You can
also press D to show the HUD.

The next section describes the controls in the Replicator HUD.

Replicator HUD Controls
The Replicator HUD contains frequently used controls that are necessary to modify the
shape and arrangement of the replicator. These parameters are a subset of the parameters
found in the Replicator tab of the Inspector. The HUD contains a group of sliders and
pop-up menus that provide an easy way change the shape of the pattern, as well as the
arrangement of the objects within the pattern. The controls in the Replicator HUD are
dynamic—they appear depending on what is selected from the Shape and Arrangement
pop-up menus. The HUD also provides quick access to the Opacity and Blend Mode
parameters, which are located in the Properties tab of the Inspector.

The HUD also provides quick access to the Opacity and Blend Mode parameters, which
are located in the Properties tab of the Inspector.
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When a replicator and the Adjust 3D Transform tool (in the Toolbar) are selected, additional
transform parameters become available in the HUD. For more information on using the
HUD’s 3D transform controls, see 3D Transform Tools.

Default replicator containing two cell sources 
(red star and white arc)

Replicator set to Burst in the Replicator HUD

Important: The Opacity, Blend Mode, and Shape parameters always appear in the
Replicator HUD. The parameters below Shape in the HUD are dynamic—they change
depending on what is selected from the Shape pop-up menu and Arrangement pop-up
menu (which is itself dynamic, invoking additional parameters). For a discussion of all
replicator parameters, see Advanced Replicator Controls.

Opacity: Defines the opacity of the replicator pattern as a whole. If a replicator contains
multiple cells, this setting affects the opacity of all pattern elements.

For information on controlling the opacity of the elements in a replicator with more than
one source, see Using Multiple Source Layers for the Replicator.
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Blend Mode: A pop-up menu that defines the blend mode of the replicator. Changing
this setting affects the pattern as a whole according to the layers composited beneath it
in the Layers tab—it does not affect the interaction of elements that may be stacked on
one another in a pattern. To affect the blending of elements within a pattern, you can
enable Additive Blend in the Replicator tab of the Inspector.

Note: For more information on blend modes, see Blend Modes.

Shape: A pop-up menu that defines the shape of the replicator. The default shape is
Rectangle. The shape options include Line, Rectangle, Circle, Burst, Spiral, Wave, Geometry,
Image, Box and Sphere.

Note: The Box and Sphere options are only available when the 3D checkbox is selected
in the Replicator tab of the Inspector.

Replicator Shape set to Rectangle 
(default)

Replicator Shape set to Circle 
(Arrangement set to Outline)

Replicator Shape set to Spiral

Note: Different parameters are available depending on what is selected from the Shape
pop-up menu.

Arrangement: A pop-up menu that defines the layout of the elements within the replicator
pattern. When the Shape parameter is set to the default Rectangle setting, the default
arrangement is Tile Fill. The Arrangement parameter is available only when Shape is set
to Rectangle, Circle, Image, Box, or Sphere.
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Think of the Arrangement parameter as necessary only when you need to specify how
elements are arranged in a closed shape (a circle, rectangle, or image). If Shape is set to
Line, for example, the elements appear along that line—there is no “space” within which
to arrange the pattern’s elements.

Arrangement set to Tile Fill 
(default)

Arrangement set to Outline Arrangement set to Random Fill

Different parameters are available depending on what is selected from the Arrangement
pop-up menu.

Columns: Defines the number of vertical columns in the pattern. Pattern elements are
distributed at points along the columns. This parameter is available when the selected
shape is closed, such as Rectangle, Circle, or Image, and when Arrangement is set to Tile
Fill. It is also available for Box and Sphere when Arrangement is set to Outline.

Note: The default Columns value limit is 20. You can set a higher number in the value
field in the Replicator tab of the Inspector.

Default number of 5 Columns and 5 
Rows

Columns set to 3 and Rows set to 7

Rows: Defines the number of horizontal rows in the pattern. This parameter is available
when the selected shape is closed, such as Rectangle, Circle, or Image, and when
Arrangement is set to Tile Fill. It is also available for Box and Sphere when Arrangement
is set to Outline.

Note: The default Rows value limit is 20. You can set a higher number in the value field
in the Replicator tab of the Inspector.
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Origin: Specifies how the elements traverse across the pattern from a point of origin. For
example, when using a Rectangle shape and Origin is set to Left, the elements sweep
across the rectangle from left to right. When set to Upper Right, the elements build from
the upper-right corner point of the shape to the lower-right corner. This parameter is
available when the Arrangement is set to Tile Fill or Random Fill.

Replicator Cell HUD Controls
The Replicator Cell HUD contains frequently used controls that are necessary to modify
the attributes of the individual elements in the replicator pattern. These parameters are
a subset of the parameters found in the Cell Controls section of the Replicator tab in the
Inspector (for replicators with one cell) or in the Replicator Cell tab (for replicators with
more than one cell). The Replicator Cell HUD contains sliders to adjust the Angle, Angle
End, Angle Randomness, Scale, Scale End, and Scale of Randomness cell parameters. For
more information about replicator cell parameters, see Replicator Cell Controls in the
Inspector.

To view the Replicator Cell HUD, select a replicator cell in the Layers tab or Timeline. (If
the HUD does not appear, press F7 or D.)

Replicators and the Properties Tab
Like any other layer in Motion, a replicator’s properties (such as its position, scale, blend
mode, shear, or drop shadow) can be modified in the Properties tab of the Inspector or
by using the onscreen transform controls. These properties are separate from the replicator
parameters in the Replicator and Replicator Cell tabs, which control the shape and size
of the replicator, as well as all aspects of its pattern and cells. The following sections briefly
discuss using the parameters in the Properties tab with a replicator. For more information
on the Properties tab, see Parameters in the Properties Tab.

Note: When a replicator cell is selected (as opposed to the replicator itself ), only the
Timing parameter appears in the Properties tab of the Inspector. This allows you to control
the In and Out points of the replicator cell.
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Important: Some operations that can be performed in the Properties tab, such as turning
on Crop or Drop Shadow, as well the application of certain filters or a mask, cause a group
to be rasterized. When a group is rasterized, it is converted into a bitmap image. Because
all replicators live in groups, this affects how replicators interact with other objects within
your project. For more information, see About Rasterization.

The following sections cover replicator properties that can be adjusted in the Properties
tab of the Inspector:

• Position, Rotation, Shear, and Anchor Point

• Scale

• Blending

• Lighting

• Shadows

• Reflection

• Drop Shadow

• Four Corner

• Crop

• Timing

Position, Rotation, Shear, and Anchor Point
Because all elements are attached to the points of the replicator pattern, changing the
replicator’s position, rotation, shear, or anchor point attributes using the controls in the
Properties tab changes every element in the replicator. This results in the entire pattern
being transformed at once. Modifying the anchor point moves the point for the entire
pattern—it does not change the anchor point for the individual elements.

Replicator selected in Layers tab Replicator with Shear X value of 30 degrees
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Scale
Using the Scale parameter resizes the replicator, affecting the size of the pattern elements
in X, Y, or Z space. To modify the size of the pattern without changing the size of its
elements, use the parameters in the Replicator tab. For example, to enlarge a rectangle
replicator without increasing the size of its elements, use the Scale parameter in the
Replicator tab; to lengthen a line replicator, use the Start Point and End Point parameters;
to increase the size of a circle replicator, use the Radius parameter.

The following illustrations demonstrate the difference between scaling only the replicator
pattern and scaling the replicator pattern and its elements. In the center illustration, the
replicator is scaled using the Scale parameter in the Properties tab. The pattern and its
elements are scaled. In the illustration on the right, the replicator is scaled using the Scale
parameter in the Replicator tab. Only the pattern is scaled, not the pattern elements.

Blending
Any changes you make to the opacity or blend-mode parameters for a replicator are
applied to the replicator as a whole—the replicator pattern is blended into the scene.
For more information about blend modes, see Using Blend Modes. For more information
about the Preserve Opacity setting, see Preserve Opacity Option.

Note: Within the replicator, the pattern elements can be blended additively or normally
(by selecting or deselecting the Additive Blend checkbox on or off in the Replicator tab).
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Lighting
This parameter group is available only for 3D projects. A 2D or 3D replicator can interact
with lights in a 3D project. As with all layers, the Shading pop-up menu (in the Lighting
section of the Properties tab) must be set to On or Inherited for the lights to affect the
replicator. For more information on using lights, see Lighting.

Shadows
This parameter group determines whether or not an object casts a shadow if positioned
between a light source and another object; whether or not neighboring objects’ shadows
affect the current object; and whether an object blocks light and casts a shadow while
the object itself does not appear in the scene. For more information on shadows, see
Shadows.

Note: This parameter does not affect drop shadows.

Reflection
Available in 3D projects, allows objects to create simulated reflectivity based on the
object’s “shininess,” the brightness and proximity of the reflected object, and the angle
of view. For more information, see Reflections.

Note: The Reflection parameter group is not available for 3D particle emitters, 3D
replicators, or nonflattened text.
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Drop Shadow
A Drop shadow can be applied to a 2D replicator. The drop shadow of the replicator
affects layers composited behind the replicator—if the pattern contains overlapping
elements, the shadow does not appear on the individual elements. When the Drop Shadow
parameter is enabled for the source layer (in the Properties tab in the Inspector),
overlapping pattern elements appear with a drop shadow.

Note: This parameter is only available when a 2D replicator shape is selected.

For more information on working with drop shadows, see Drop Shadows.

Four Corner
The Four Corner controls in the Properties tab allow you to stretch a replicator into
different polygonal shapes by moving one of the corner points, leaving the other three
corners locked into place. Adjusting the corners of the replicator affects the entire pattern
as a whole.

Note: This parameter is only available when a 2D replicator shape is selected.

Crop
The Crop controls in the Properties tab allow you to hide portions of a replicator pattern.
You can also use the onscreen cropping controls by choosing the Adjust Crop tool from
the Toolbar, then dragging any of the replicator object’s four edges or corners.

Note: This parameter is only available when a 2D replicator shape is selected.

For more information on cropping objects in Motion, see Parameters in the Properties
Tab.

Timing
Once you create a replicator, its duration can be as long or short as necessary, regardless
of the duration of the original sources used for the pattern cells. The duration of a replicator
is defined by the duration of the replicator layer. Changing the In or Out points of a
replicator in the Properties tab, Timeline, or mini-Timeline changes the duration of the
replicator.
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While the duration of the source layers has no affect on the replicator, the duration of
each cell affects how long the elements created from that cell are visible in the project.
You can change a cell’s duration by dragging either its position or its In and Out points
in the Timeline. In this way, you can adjust the timing that defines when each cell type
appears. For example, to create a pattern in which three different types of elements
appear at different times in the animation, you could offset the cells in the Timeline. In
the following image, the arc cells appear first. One second later, the star cells appear. One
second after that, the circle cells appear.

Note: You can animate the opacity of each cell so that it fades in; you do this by keyframing
the Opacity parameter in the Replicator tab or the Replicator Cell tab.

For more information on adjusting the timing of layers in the Timeline, see Using the
Timeline.

Using the Replicator Onscreen Controls
In addition to using the Position parameters in the Properties tab or the Select/Transform
tool to move the replicator in the Canvas, you can also use the Adjust Item tool, one of
the 2D transform tools available in the Toolbar. This section provides two examples of
using the Adjust Item tool to modify a replicator.

To use the Adjust Item tool
1 Select the replicator you want to adjust.
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2 In the Toolbar, click and hold the Select/Transform tool, then choose the Adjust Item tool
from the pop-up menu.

Adjust Item tool

Once the Adjust Item tool is selected, the replicator onscreen controls appear in the
Canvas. Dragging the pattern’s shape adjusts the size of the replicator shape. For example,
if the shape is a spiral or circle, dragging the shape changes the Radius parameter value.
Dragging in the Canvas (but not directly on the shape) repositions the replicator in the
Canvas.

When the pointer is over the 
replicator shape line, the line is 

highlighted. Dragging the shape 
resizes the replicator.

Dragging outside the 
replicator shape 

repositions the replicator.
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If the replicator shape is a rectangle, dragging a corner or edge of its bounding box
changes the Size parameter value. Depending on which handle you drag, you can constrain
the transform to width, height, or depth (in a box-shaped replicator). Or you can drag a
corner handle to scale the replicator in multiple dimensions simultaneously.

Drag the top or bottom 
edge to adjust its height.

Drag the left or right 
edge of the bounding 
box to adjust its width.
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Drag the corner handles 
to adjust width and 
height simultaneously. 
Press Shift to adjust 
width and height 
uniformly.

Advanced Replicator Controls
When a replicator is created from a source layer, the default replicator parameters are
used, resulting in a rectangular pattern consisting of five rows and five columns of
elements. Although the HUD provides a fast way to modify the basic replicator parameters,
the Replicator tab in the Inspector gives you total control over every aspect of that pattern.
This includes individual parameters for the replicator cell (for replicators with a single
cell).

To open the Replicator tab
1 Select a replicator.

2 In the Inspector, click the Replicator tab.

The replicator parameters appear.

The contents of the Replicator tab are dynamic, and different parameters appear
depending on the option you choose in the Shape pop-up menu. Also, different
parameters appear depending on the option you choose in the Arrangement pop-up
menu.

The Difference Between Replicator and Replicator Cell Parameters
The replicator and replicator cell parameters, though closely related, serve different
purposes. Replicator parameters control the overall shape, arrangement, offset, stacking
order, build order, and number of elements in the replicator pattern.

Replicator cell parameters control the behavior and appearance of the elements within
the replicator pattern. For more information, see Displaying Replicator Cell Parameters.

692 Chapter 12 Using the Replicator



For a replicator with only one cell (one source layer), the replicator and replicator cell
controls appear in the same Replicator tab. In this case, you can control every aspect of
the replicator directly from this single tab, which saves you from having to go back and
forth between the Replicator and Replicator Cell tabs. For a replicator with multiple cells,
the replicator parameters remain in the Replicator tab. The source wells for the layers
used as cells are listed in the lower portion of the tab.

Replicator tab for replicator 
with a single cell

Replicator tab for replicator 
with multiple cells
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Each cell has its own Replicator Cell tab that contains all parameters for that cell. To access
the cell-specific parameters, you must select a cell in the Layers tab or Timeline layers list.

Replicator Cell tab in InspectorCell selected in Layers tab

Replicator Controls in the Inspector
The controls in the Replicator tab give you complete control over every aspect of the
pattern created by the selected replicator. This includes the shape upon which the pattern
is built and the shape’s related parameters, such as the size of the pattern, how the
elements are arranged in the pattern, and so on.

Shape: The first parameter in the Replicator tab is the Shape pop-up menu, which sets
the overall shape of the onscreen replicator pattern. The default setting is Rectangle.
Choose any of up to 10 shape styles from the menu to alter the distribution of the pattern
elements.

Note: Depending on the item you choose in the Shape pop-up menu, additional controls
may appear in the Replicator tab. For example, when Rectangle is selected in the Shape
pop-up menu, the Outline, Tile Fill, and Random Fill options become available in the
Arrangement pop-up menu. These additional controls let you further customize the
chosen shape.
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The Shape pop-up menu contains the following items:

• Line: Elements are positioned on a line. Using the onscreen controls (with the Adjust
Item tool) or controls in the Inspector, you can specify the length and location of the
line. In the Inspector, you can set a specific number of points on the line—one element
is positioned at every point (including the end points of the line). The Line shape displays
additional Start Point, End Point, Points, and Offset parameters.

• Rectangle: Elements are positioned in a rectangle along the replicator outline, or in a
tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you
can specify the size and location of the rectangle. Drag the corners to adjust width and
height; drag edges to adjust width or height independently. When Rectangle is selected,
the Arrangement parameter becomes available. Depending on the selected
Arrangement, the Rectangle shape displays additional parameters.

Rectangle shape with 
Arrangement set to Outline

Rectangle shape with 
Arrangement set to Tile Fill

Rectangle shape with 
Arrangement set to Random Fill.
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• Circle: Elements are positioned in a circle along the replicator outline, or in a tile or
random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can
specify the radius and location of the circle. When Circle is selected, the Arrangement
parameter becomes available. Depending on the selected Arrangement, the Circle
shape displays additional parameters. In the following image, the circle’s Arrangement
is set to Outline.

• Burst: Elements are positioned in a flare pattern. Using the onscreen controls (with the
Adjust Item tool), you can specify the radius and location of the burst. The Burst shape
displays additional Radius, Number of Arms, Points Per Arm, Offset, and Origin
parameters in the Replicator tab.
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• Spiral: Elements are positioned in a spiral pattern. Using the onscreen controls (with
the Adjust Item tool), you can specify the radius and location of the spiral. The Spiral
shape displays additional Radius, Twists, Number of Arms, Points Per Arm, and Offset
parameters in the Replicator tab.

• Wave: Elements are positioned on a waveform. Using the onscreen control (with the
Adjust Item tool) or the Inspector, you can specify the length and location of the wave.
The Wave shape displays additional Start and End Point, Amplitude, Frequency, Phase,
Damping, Points, and Offset parameters in the Replicator tab.
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• Geometry: Elements are positioned along the edge of a shape, defined by a spline
object used as the shape source. The Geometry shape displays additional Shape Source,
Points, and Offset parameters in the Replicator tab.

Cells along the edge of the object defined in 
the Shape Source image well

Object used as the Shape Source

For information on using geometry (a shape) as a replicator shape, see Replicator Cell
Controls in the Inspector.

• Image: Elements appear within an area defined by an image or along its border,
depending on what is chosen from the Arrangement pop-up menu. The image may
or may not have an alpha channel. If it does, the shape of the alpha channel can also
be used to define the pattern. When Image is selected, the Arrangement parameter
becomes available. Depending on the selected Arrangement, the Image shape displays
additional parameters.

For information on using an image as a replicator shape, see Using Image and Geometry
Objects.
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• Box: This option is available when the 3D checkbox is selected in the Replicator tab.
Elements are positioned in a three-dimensional cube along the replicator outline, or
on its surface in a tile or random fill pattern. Using the onscreen controls (with the
Adjust Item tool), you can specify the size and location of the rectangle. Drag the front
horizontal edge to adjust height; drag the front vertical edge to adjust width; drag a
back edge to adjust depth; drag a front corner to simultaneously adjust the width and
height. To reposition the replicator, drag in the replicator (but not on an edge or corner
point). Depending on the selected Arrangement, the Box shape displays additional
parameters. In the following image, the box’s Arrangement is set to Tile.

• Sphere: This option is available when the 3D checkbox is selected in the Replicator tab.
Elements are positioned in a three-dimensional sphere along the replicator outline, or
on its surface in a tile or random fill pattern. Using the onscreen controls (with the
Adjust Item tool), you can specify the radius and location of the circle. Drag the outline
of the sphere to adjust its radius; drag within the sphere to reposition it in the Canvas.
When Sphere is selected, the Arrangement parameter becomes available. Depending
on the selected Arrangement, the Sphere shape displays additional parameters.

Arrangement: The Arrangement pop-up menu is available when Shape is set to Rectangle,
Circle, Image, Box, or Sphere. Specifies the layout of the elements in the selected shape.
The arrangement options are:

• Outline: Elements are positioned along the edge of the shape.

• Tile Fill: Elements are positioned in a tiled pattern of rows and columns within the circle,
rectangle, image, box, or sphere pattern. You can specify the number of columns and
rows, as well as the Tile Offset.

• Random Fill: Positions elements randomly from within circle, sphere, rectangle, or box.

Shape Source: This parameter is available only when Shape is set to Geometry. Allows
you to load a shape object as the source for the replicator pattern. To set the shape source
for the replicator, drag a shape from the Layers tab or Timeline layers list to the Shape
Source well.
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Image Source: This parameter, which becomes available when the Shape parameter is
set to Image, allows you load an image object as the source for the replicator shape. To
set the image source, drag an image from the Layers tab or Timeline layers list to the
Image Source well.

Emission Alpha Cutoff: When the Image Source object contains an alpha channel, this
slider defines the minimum opacity value that is necessary to create an element at that
point on the source image. For example, when set to 25%, elements only appear at points
where the alpha value of the image is equal to or greater than 25% opacity. The lower
the Emission Alpha Cutoff value, the more cells appear. In order for this parameter to be
effective, the alpha channel needs to have areas of varying transparency.

Shape with a feathered edge used 
as Image Source

Emission Alpha Cutoff set to 75% Emission Alpha Cutoff set to 30%

Start Point: This parameter is available when Shape is set to Line or Wave. Two sliders
define, in X, Y, and Z coordinates, the first point of the line or wave on which the elements
are positioned. Click the disclosure triangle to access the Z Start Point value slider. You
can adjust these values in the Canvas using the onscreen controls (with the Adjust Item
tool).

End Point: This parameter is available when Shape is set to Line or Wave. Two sliders
define, in X, Y, and Z coordinates, the second point of the line or wave on which the
elements are positioned. Click the disclosure triangle to access the Z Start Point value
slider. You can adjust these values in the Canvas using the onscreen controls (with the
Adjust Item tool).

Size: This parameter is available when Shape is set to Rectangle or Box and Arrangement
is set to Outline, Tile Fill, or Random Fill. Click the disclosure triangle to display separate
Width, Height, and Depth (for the Box shape) parameters. When Circle is the selected
shape, this parameter becomes Radius.

Note: For projects using the default camera settings and a default Z position for the
replicator (the replicator has not been transformed in 3D space), the Height is measured
in pixels, however, the Width is measured in square pixels. This is done so that a shape
that is numerically square appears square when “Correct for Aspect Ratio” is selected in
the View pop-up menu in the top-right corner of the Canvas.
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Amplitude: This parameter is available only when Shape is set to Wave. Defines half the
distance from the highest point to the lowest point in the wave. Higher values result in
more extreme waves.

Frequency: This parameter is available only when Shape is set to Wave. Defines the
number of waves. The default is value is 1.

Default Frequency value (1) Frequency value set to 2

Phase: This parameter is available only when Shape is set to Wave. A dial that defines
the degree of offset of the waves from the start and end points of the path. When set to
0 degrees (default), the wave begins and ends at half the distance from the highest point
to the lowest point in the wave. When set to 90 degrees, the wave begins and ends at
the highest point in the wave. When set to –90 degrees, the wave begins at the lowest
point in the wave. When set to 180 degrees, the waves are the same as 0 degrees, but
inverted.

Damping: This parameter is available only when Shape is set to Wave. A slider that
progressively diminishes the oscillation of the wave. Positive damping values diminish
the wave forward (from left to right); negative values diminish the wave backward (from
right to left).

Points: When Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement
is set to Outline or Random Fill, this parameter specifies the number of evenly distributed
element points along the edge of the shape.
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When Shape is set to Line or Wave, this parameter defines the number of evenly distributed
element points on the line or wave. When the Adjust Item tool is selected, the points are
visible in the Canvas.

When Shape is set to Geometry, this parameter defines the number of evenly distributed
element points around the shape.

Offset: When Shape is set to Line or Wave, adjusting this value moves the elements along
the line or wave.

When Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to
Outline, adjusting this value moves the elements along the edge of the shape.

When Shape is set to Geometry, adjusting this value moves the position of the elements
along the edge of the shape.

Build Style: When the Arrangement is set to Outline, this pop-up menu specifies the
direction in which the elements are placed along the edge of the shape. For the Rectangle,
Circle, and Image shapes, when Arrangement is set to Tile Fill and Origin is set to Upper
Left, Upper Right, Lower Left, or Lower Right, this parameter specifies how the elements
are built over the pattern. For the Box and Sphere shapes, when Arrangement is set to
Tile Fill and Origin is set to a corner (Front Upper Right, Front Upper Left, Front Lower
Left, Front Lower Right, Back Upper Left, Back Upper Right, Back Lower Left, or Back Lower
Right), this parameter specifies how the elements are built over the pattern.

When Arrangement is set to Outline, the Build Style options are:

• Clockwise: Places the elements along the shape in a clockwise direction.

• Counter Clockwise: Places the elements along the shape in a counterclockwise direction.

The following images show the difference between the Clockwise and Counter Clockwise
parameters, using a replicator that applies a gradient over its pattern elements.
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Note: When the cell Color Mode is set to Over Pattern, a gradient is applied to the
elements over the replicator pattern. In this example, the gradient begins yellow,
becomes orange in the middle, and becomes red at its end.

Gradient applied to replicator cells

When Build Style is set to Clockwise, the gradient is applied to the pattern in a clockwise
pattern. When set to Counter Clockwise, the gradient is applied in the reverse direction.

Build Style set to Clockwise Build Style set to Counter Clockwise

For Rectangle and Image shapes with Arrangement set to Tile Fill and Origin set to
Upper Left, Upper Right, Lower Left, or Lower Right, the Build Style options are:

• Across: Builds the elements across the pattern in the direction implied by the Origin
parameter.

• By Row: Builds the elements over the pattern by row.

• By Column: Builds the elements over the pattern by column.

For Box shapes with the Arrangement set to Tile Fill and Origin set to Front Upper Left,
Front Upper Right, Front Lower Left, Front Lower Right, Back Upper Left, Back Upper
Right, Back Lower Left, or Back Lower Right, the Build Style options are:

• Across: Builds the elements across the pattern in the direction implied by the Origin
parameter.

• By Row, Column, Rank: Builds the elements over the pattern by row, column, then rank
starting from the Origin.
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• By Column, Row, Rank: Builds the elements over the pattern by column, row, then rank
starting from the Origin.

• By Row, Rank, Column: Builds the elements over the pattern by row, rank, then column
starting from the Origin.

• By Column, Rank, Row: Builds the elements over the pattern by column, rank, then row
starting from the Origin.

• By Rank, Row, Column: Builds the elements over the pattern by rank, row, then column
starting from the Origin.

• By Rank, Column, Row: Builds the elements over the pattern by rank, column, then row
starting from the Origin.

Radius: This parameter is available when Shape is set to Burst, Spiral, Circle, or Sphere.
Defines the size of the selected shape.

Twists: This parameter is available only when Shape is set to Spiral. Defines the number
of turns in a spiral. The default value is 0.25. When Number of Arms is set to one, a single
spiral is created.

Spiral with default parameter settings Spiral with Number of Arms set to 1

Number of Arms: This parameter is available only when Shape is set to Burst or Spiral.
Defines the number of branches on which the elements are positioned. The default value
is 3.

Points Per Arm: This parameter is available only when Shape is set to Burst or Spiral.
Defines the number of element points on each branch of the burst or spiral. When the
Adjust Item tool is selected, the points are visible in the Canvas.

Columns: This parameter is available when the Shape is set to Rectangle (with
Arrangement set to Tile Fill), Circle (with Arrangement set to Tile Fill), Image (with
Arrangement set to Tile Fill), Box (with Arrangement set to Outline), or Sphere (with
Arrangement set to Outline). Specifies the number of vertical columns (or horizontal
element points) on a grid over the selected replicator. In the case of an irregular shape
(nonrectangular), points that fall outside of the shape are ignored.
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Note: The default Columns value limit is 20. You can set a higher number in the value
field.

Rows: Specifies the number of horizontal rows (or vertical element points) on a grid over
the selected replicator. In the case of an irregular shape (nonrectangular), points that fall
outside of the shape are ignored. This parameter is available when the Arrangement
parameter is set to Tile Fill. It is also available for Box and Sphere when Arrangement is
set to Outline.

Note: The default Rows value limit is 20. You can set a higher number in the value field.

Ranks: This parameter is available when Shape is set to Box (with Arrangement set to
Tile Fill or Outline), or Sphere (with Arrangement set to Tile Fill). When the Box or Sphere
shape is selected, specifies the number of points in Z space on a grid over the selected
replicator. In the case of an irregular shape (nonrectangular), points that fall outside of
the shape are ignored.

Tile Offset: This parameter is available when Shape is set to Rectangle, Circle, Image, Box,
or Sphere, and Arrangement is set to Tile Fill. Specifies the amount (in percentage points)
that the elements are offset from the pattern. Values from 0 to 100% offset the rows
toward the right, and values from 0 to –100% offset the rows toward the left. A value of
50 or –50% creates a “brickwork” pattern.

Rectangle shape set to Tile Fill Tile Offset set to a value of 20%
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Origin: This pop-up menu is available when Shape is set to Rectangle, Circle, Image, Box,
or Sphere, and Arrangement is set to Tile Fill or Random Fill. Specifies how the elements
traverse across the pattern from a point of origin. For example, when set to Left, the
elements sweep across the pattern from left to right. When set to Upper Right, the
elements traverse from the upper-right corner point of the shape to the lower-right
corner. This pop-up menu contains the following items:

Origin set to Left Origin set to Upper Right

• Upper Left: The elements originate in the upper-left corner of the pattern and end in
the lower-right corner.

• Upper Right: The elements originate in the upper-right corner of the pattern and end
in the lower-left corner.

• Lower Left: The elements originate in the lower-left corner of the pattern and end in
the upper-right corner.

• Lower Right: The elements originate in the lower-right corner of the pattern and end
in the upper-left corner.

• Center: The elements originate in the center of the pattern and move outward. This is
the default Origin option.

• Left: The elements originate at the left side of the pattern and end at the right side.

• Right: The elements originate at the right side of the pattern and end at the left side.

• Top: The elements originate at the top of the pattern and end at the bottom.

• Bottom: The elements originate at the bottom of the pattern and end at the top.

When Circle or Sphere is chosen from the Shape pop-up menu and Arrangement is set
to Tile Fill or Random Fill, the Origin options are:

• Center: The elements originate in the center of the pattern and build outward. This is
the default Origin option.
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• Edge: The elements originate along the edge of the pattern and build inward.

Origin set to Center Origin set to Edge

When Box is chosen from the Shape pop-up menu and Arrangement is set to Tile Fill
or Random Fill, the Origin options are:

• Front Upper Left: The elements originate in the front upper-left corner of the pattern
and end in the back lower right.

• Front Upper Right: The elements originate in the front upper-right corner of the pattern
and end in the back lower left.

• Front Lower Left: The elements originate in the front lower-left corner of the pattern
and end in the back upper right.

• Front Lower Right: The elements originate in the front lower-right corner of the pattern
and end in the back upper left.

• Back Upper Left: The elements originate in the back upper-left corner of the pattern
and end in the front lower right.

• Back Upper Right: The elements originate in the back upper-right corner of the pattern
and end in the front lower left.

• Back Lower Left: The elements originate in the back lower-left corner of the pattern
and end in the front upper-right.
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• Back Lower Right: The elements originate in the back lower-right corner of the pattern
and end in the front upper-left.

• Left: The elements originate at the left side of the pattern and end at the right side.
The pattern is identical on each row.

• Right: The elements originate at the right side of the pattern and end at the left side.
The pattern is identical on each row.

• Top: The elements originate at the top of the pattern and end at the bottom. The
pattern is identical on each rank.

• Bottom: The elements originate at the bottom of the pattern and end at the top. The
pattern is identical on each rank.

• Front: The elements originate at the front of the pattern and end at the back. The
pattern is identical on each column.

• Back: The elements originate at the back of the pattern and end at the front. The pattern
is identical on each column.

• Center: The elements originate in the center of the pattern and move outward. This is
the default Origin option.

• X Axis: The elements originate along the X axis of the pattern and move outward.

• Y Axis: The elements originate along the Y axis of the pattern and move outward.
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• Z Axis: The elements originate along the Z axis of the pattern and move outward.

Note: The origin parameter also determines where the Sequence Replicator behavior
starts its animation. For more information on the Sequence Replicator behavior, see
Using the Sequence Replicator Behavior.

Build Style: This pop-up menu is only available when Shape is set to Geometry. Specifies
the direction in which the elements are placed along edge of the shape. The options are:

• Clockwise: Places the elements along the shape in a clockwise direction.

• Counter Clockwise: Places the elements along the shape in a counterclockwise direction.

Shuffle Order: When enabled, rearranges the order in which the elements appear. When
Shuffle Order is selected, the Replicate Seed parameter becomes available.

Pattern with Shuffle Order disabled Pattern with Shuffle Order enabled

Replicate Seed: This parameter is available when Shape is set to Rectangle, Circle, Image,
Box, or Sphere, and Arrangement is set to Random Fill. Modifies the Random Fill pattern.
Although the result of the Random Fill option from the Arrangement pop-up menu seems
random, it’s actually deterministic. This means that the random variation in the pattern
is created based on the number shown here. Unless this seed number is changed, a
replicator with the same parameter settings and source object always appears the same.
If you don’t like the current random fill, you can change the seed number by typing a
new number or clicking Generate. This changes the random calculations performed for
that pattern. This parameter is also used to randomize the Shuffle Order parameter.

3D: When selected, the Box and Sphere shapes become available from the Shape pop-up
menu. In addition, if the Face Camera checkbox is selected, the pattern elements actively
face the camera when the camera or the replicator is rotated in 3D space.
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Reverse Stacking: Inverts the order in which the elements are stacked. To see the effect
of this parameter, elements must be overlapping.

Pattern with Reorder disabled:  The element to 
the right overlaps the next cell to the left.

Pattern with Reorder enabled:  The element to 
the left overlaps the next cell to the right.

Face Camera: When this checkbox is selected, the pattern elements actively face the
camera when the camera or the replicator is rotated. When Face Camera is deselected,
the elements face forward in the replicator pattern and appear flat (unless the source
layer or pattern elements are rotated in 3D space). Because Motion only supports 2D
objects, this option is key to giving 2D objects the appearance of 3D as the camera is
animated.

Note: Because replicator pattern elements are 2D (flat) objects, the pattern elements are
not visible when you use the orthogonal camera views, such as Left, Right, and Top (unless
the source layer or pattern elements are rotated in 3D space). This is because orthogonal
views are at right angles (perpendicular) to the elements. For more information on using
cameras, see Cameras.

Box Replicator with Face Camera turned off. Box Replicator with Face Camera turned on.
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Displaying Replicator Cell Parameters
The replicator cell parameters modify the individual elements in the onscreen pattern.
In a replicator with only a single cell, the cell parameters appear in the Replicator tab, in
the Cell Controls group. In a replicator with multiple cells, each cell has its own Replicator
Cell tab that contains all parameters for that cell.

To display the Cell Controls for a single-cell replicator
1 In the Layers tab, Timeline layers list, or Canvas, select a replicator layer.

2 In the Inspector, click the Replicator tab.

The cell parameters appear in the Cell Controls group.

Replicator cell 
parameters

To display the Cell Controls for a multi-cell replicator
1 In the Layers tab or Timeline layers, list select a cell (located beneath the replicator layer).
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2 In the Inspector, click the Replicator Cell tab.

Replicator Cell Controls in the Inspector
These controls appear at the bottom of the Replicator tab of the Inspector (for replicators
with a single cell) or in the Replicator Cell tab of the Inspector (for replicators with multiple
cells).

Align Angle: When this checkbox is selected, the replicator elements automatically rotate
to match the shape on which they are positioned. This parameter is available for all
replicator types except for the following: Rectangle, Circle, Image, Box, and Sphere shapes
with Tile Fill or Random Fill and Point.

Spiral replicator with Align Angle disabled Spiral replicator with Align Angle enabled
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Angle: Specifies (in degrees) the rotation of the replicator elements. When the 3D
checkbox is selected, using the default dial or value slider (when the disclosure triangle
is closed) modifies the Z angle. To modify the rotation of the pattern elements on all
three axes (X, Y, and Z), click the disclosure triangle and adjust the individual X, Y, and Z
dials. When the 3D checkbox is selected, this parameter displays the Animate pop-up
menu.

• Animate: A pop-up menu that sets the angle interpolation for keyframed animation of
the Angle parameter. There are two menu choices:

• Use Rotation: The default interpolation method. When the Angle parameter is
keyframed, pattern elements rotate from their start rotation to their final rotation.
Depending on the animation, the elements may twist this way and that before
reaching their final orientation (the last keyframed value). For example, if the X, Y,
and Z Angle parameters are animated from 0 degrees to 180 degrees in a project,
the elements rotate on all axes before reaching their final orientation.

• Use Orientation: This alternate interpolation method provides for smoother animation
but does not allow multiple revolutions. It interpolates between the pattern elements’
start orientation (first keyframe) to their end orientation (second keyframe).

Angle End: Specifies (in degrees) the rotation of the replicator elements at the end of
the pattern. The angle value of the elements at the end of the pattern equals the Angle
value (start) plus the Angle End value. For example, if Angle is set to 0 degrees and Angle
End set to 90 degrees, the elements are not rotated at all at their origin, and are rotated
by 90 degrees at the end of the pattern.

Line replicator (Origin set to Start Point) with 
Angle value of 0 and Angle End set to 0

Line replicator (Origin set to Start Point) with 
Angle value of 0 and Angle End set to 90

713Chapter 12 Using the Replicator



In a 3D project, using the default dial or value slider (when the disclosure triangle is
closed), modifies the Z angle. To modify the rotation of the pattern elements on all three
axes (X, Y, and Z), click the disclosure triangle and adjust the individual X, Y, and Z dials.
When the 3D checkbox is selected, this parameter displays the Animate pop-up menu.

• Animate: A pop-up menu that sets the angle interpolation for keyframed animation of
the Angle parameter. There are two menu choices:

• Use Rotation: The default interpolation method. When the Angle End parameter is
keyframed, pattern elements rotate from their start rotation to their final rotation.
Depending on the animation, the elements may twist this way and that before
reaching their final orientation (the last keyframed value). For example, if the X, Y,
and Z Angle parameters are animated from 0 degrees to 180 degrees in a project,
the elements rotate on all axes before reaching their final orientation.

• Use Orientation: This alternate interpolation method provides for smoother animation
but does not allow multiple revolutions. It interpolates between the pattern elements’
start orientation (first keyframe) to their end orientation (second keyframe).

Angle Randomness: Defines an amount of variance in the rotation of the replicator
elements. A value of 0 results in no variance—all elements have the same rotational value.
A value greater than 0 introduces a variance. The angle for an individual element is defined
by the Angle and Angle End parameter, plus or minus a random value falling within the
Angle Randomness.

In a 3D project, using the default dial or value slider (when the disclosure triangle is
closed), modifies the Z angle. To modify the rotation of the pattern elements on all three
axes (X, Y, and Z), click the disclosure triangle and adjust the individual X, Y, and Z dials.
When the 3D checkbox is selected, this parameter displays the Animate pop-up menu.

• Animate: A pop-up menu that sets the angle interpolation for keyframed animation of
the Angle Randomness parameter. There are two menu choices:

• Use Rotation: The default interpolation method. When the Angle Randomness
parameter is keyframed, pattern elements rotate from their start rotation to their
final rotation. Depending on the animation, the elements may twist this way and
that before reaching their final orientation (the last keyframed value). For example,
if the X, Y, and Z Angle parameters are animated from 0 degrees to 180 degrees in
a project, the elements rotate on all axes before reaching their final orientation.

• Use Orientation: This alternate interpolation method provides for smoother animation
but does not allow multiple revolutions. It interpolates between the pattern elements’
start orientation (first keyframe) to their end orientation (second keyframe).
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Additive Blend: By default, replicator elements are composited together using the Normal
blend mode. Select this checkbox to composite all overlapping elements using the Additive
blend mode. This blending occurs in addition to the compositing method set in the
Properties tab. The result is that the brightness of overlapping objects is intensified. This
applies only to the replicator itself—the blend mode of the replicator layer determines
how the result of the pattern is blended into the scene.

Color Mode: This pop-up menu specifies the origin of the color for the replicated elements
There are five menu options:

• Original: Elements are created using the original colors from the source layer. When
Original is chosen, the Opacity Gradient editor appears, allowing you to change the
opacity of the replicator elements over the pattern.

The following illustration shows a line-shape replicator with Opacity set to 10% at the
start of the gradient and 100% at the end of the gradient.

• Colorize: Elements are tinted using the color specified in the Color parameter. Additional
Color and Opacity Gradient parameters appear.
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• Over Pattern: Elements are tinted based on how they are ordered in the pattern. When
Over Pattern is chosen, the Color Gradient editor appears, allowing you to define the
range of color of the pattern, beginning with the leftmost color in the gradient, and
progressing through the range of colors until reaching the rightmost color at the end
of the pattern. Gradual color changes do not appear in each element, but only across
the pattern as a whole. An Opacity control is available at the top of the gradient editor.

• Pick From Color Range: Elements are tinted at random, with the range of possible colors
defined by the Color Range gradient editor, which appears when you choose Pick From
Color Range. A point on the gradient is randomly chosen, so the relative sizes of each
color region determine the frequency of the color being used. For more information
on using the gradient controls, see Using the Gradient Editor.

• Take Image Color: Each element’s color is based on the color of the image at the position
of the element point. This mode is only available when an image in used as the replicator
shape.

Tip: When using images larger than the Canvas as a replicator shape image source, it
is recommended that you select Down-Res to Canvas Size in Motion Preferences (in
the Still Images & Layers section of the Project pane) before importing the images.
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Color: A color well that becomes available when the Color Mode is set to Colorize. Use
it to specify a color to use to tint the replicator elements. You can also alter each element’s
opacity. This parameter is unique to the cell object. You can either click the color well to
choose a color, or open the disclosure triangle and use the Red, Green, Blue, and Opacity
channel sliders or value sliders.

Opacity Gradient: This gradient editor appears when Color Mode is set either to Original
or Colorize. Use it to change the opacity of the replicator elements over the pattern. This
gradient control is limited to grayscale values, which are used to represent varying levels
of transparency. White represents solid elements; progressively darker levels of gray
represent decreasing opacity; and black represents complete transparency. A simple
white to black gradient represents a pattern that is solid at its origin, but which fades out
gradually. For more information on using the gradient and opacity gradient controls, see
Using the Gradient Editor.

Color Repetitions: When Color Mode is set to Over Pattern, this parameter becomes
available. Drag the slider to increase the number of times the gradient is repeated over
the pattern. For more information on using the gradient controls, see Using the Gradient
Editor.

Scale: Defines the scale of the replicator elements. Click the disclosure triangle next to
the Scale parameter to reveal separate X Scaling and Y Scaling subparameters that can
be used to adjust the width and height of the elements separately. By default, Scale is
set to 100%—the size of the replicator elements is equal to the size of the source layer.

Scale End: Specifies the scale of the replicator elements at the end of the pattern, relative
to the Scale value. For example, if Scale is set to 100% and Scale End set to 50%, the
elements are 100% at their origin, and half of their size at the end of the pattern.
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Scale Randomness: Defines an amount of variance in the scale of the replicator elements.
A value of 0 results in no variance—all elements in the pattern are the same size. A value
greater than 0 introduces a variance. The scale for an individual element is defined by
the Scale parameter, plus or minus a random value falling within the Scale and the Scale
End. The disclosure triangle of the Scale Randomness parameter reveals separate X and
Y subparameters that can be used to set the width and height values separately.

Line replicator with Scale set to 100%;  
Scale End set to 50%

Scale Randomness set to 75

Play Frames: This checkbox appears if you create a replicator pattern using a QuickTime
object as the source for a cell. When this checkbox is selected, playback of the animation
or movie clip used for each element will loop. If this checkbox is deselected, animation
or clip will be frozen at the still frame specified by either the Random Start Frame
parameter or the Source Start Frame parameter.

Random Start Frame: This checkbox appears if you create a replicator pattern using a
QuickTime object as the source for a cell. Use this control to introduce variation into
elements using QuickTime animation or movies as their source objects. When this checkbox
is selected, each element in the pattern begins at a different frame of the clip. Stills are
chosen randomly if Play Frames is deselected.

Source Start Frame: This slider appears if you create a replicator pattern using a QuickTime
object as the source for a cell. The value selected in the slider designates the start frame
of the clip (when the Play Frames checkbox is selected) or the still frame to display (when
Play Frames is deselected). This parameter appears only if Random Start Frame is
deselected.
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Source Start Frame Offset: This slider appears if you create a replicator pattern using a
QuickTime object as the source for a cell, and if Random Start Frame is deselected. Offsets
the start frame chosen in the Source Start Frame parameter over the pattern. At their
origin, the elements play the animation from the frame specified in the Source Start Frame
parameter. Each step away from the origin advances the start frame by the offset amount.

Rectangle replicator shape with Origin set to 
Top and Source Frame Offset set to 0

When Source Frame Offset is set to 120, the 
effect of the offset occurs from the origin of the 
cells.

Hold Frames: This slider appears if you create a replicator pattern using a QuickTime
object as the source for a cell. Sets the number of times each frame of the source movie
is repeated during playback. The larger the Hold Frames value, the slower your playback.

Hold Frames Randomness: This slider appears if you create a replicator pattern using a
QuickTime object as the source for a cell. Varies the number of frames to “hold.”

Show Objects As: Use this pop-up menu to set the display of replicator elements to any
of several preview modes, or as they actually appear. The nonimage modes play back
more efficiently when viewing a complex replicator pattern. By default, this pop-up menu
is set to Image, which displays each element as it is supposed to appear. There are four
options from which to choose:
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Important: If the Show Objects As parameter is set to a nonimage mode upon exporting
the project, the project renders in that selected mode.

• Points: Each element is represented by a single point. This is the fastest preview mode.
When you choose Points, the Point Size slider appears, allowing you to increase the
size of the points for easier viewing. In the following image, the Point Size is set to 8.

• Lines: This option is effective only when the elements of the replicator are animated
using Simulation behaviors or the Throw (Basic Motion) behavior. The movement of
each pattern element is represented by a line and is useful in analyzing the vector of
each element’s motion. The length of each line is determined by that element’s speed,
and the angle of each line equals each element’s direction. In the following image, the
replicator elements are animated using the Vortex behavior.

Note: Element movement created by using the Sequence Replicator behavior or by
keyframing the replicator parameters is not displayed.
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• Wireframe: Each pattern element is represented by a bounding box. Because the
bounding boxes are good indicators of each element’s orientation in the pattern, this
preview mode is useful for evaluating the movements of individual elements. For
example, it’s easy to see the angle of rotation for elements that are spinning or following
a complex motion path.

• Image: Displays the elements as they are supposed to appear in your final render.

Random Seed: Although the result of adjusting the Angle Randomness, Scale Randomness,
Pick From Color Range, Random Start Frame, or Hold Frame Randomness parameters
seems random, it’s actually deterministic. This means that the random variation in the
pattern is created based on the number shown in the Random Seed field. Unless this
seed number is changed, a replicator with the same parameter settings always appears
the same. If you don’t like the current random scale or angle, you can change the seed
number by typing a new number the field or by clicking Generate.

Object Source: The cells of a replicator are listed at the bottom of both the Replicator
tab and the Replicator Cell tab. Each cell appears in an image well, and a checkbox allows
you to enable or disable that cell (if the replicator has multiple cells).
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Using Image and Geometry Objects
There are two ways that image and geometry objects can be used in a replicator: As an
element source or as a shape source. When used as an element source, the image or
geometry object is replicated to create the repeating elements in the pattern—the “tiles”
in the onscreen “mosaic.” When used as a shape source, the image or geometry object
specifies the shape of the replicator pattern on screen. In other words, elements are
positioned along the edge of the image or shape. The following section describes how
to use image and geometry objects as shape sources and element sources.

To use an image as the source of the onscreen elements
1 Import the image you want to use as the source for your repeating elements.

2 Select the image, then do one of the following:

• Click the Replicate button in the Toolbar.

• Press L.

• Choose Object > Replicate.

The image is replicated.

To use an image as the shape source of the replicator pattern
1 Import the image you want to use as the pattern shape in an existing replicator.

2 In the Replicator tab, choose Image from the Shape pop-up menu.

The Image Source well appears in the Inspector and HUD.

Image Source well

3 From the Layers tab, drag the image to the Image Source well.

4 When the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the image appears in the well.

Note: You may want to disable the source image in the Layers tab so it is not visible in
your project.
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To use a geometry shape as the source of the onscreen elements
1 Create or import the geometry object (shape or paint stroke) you want to use as the

source for your repeating elements.

2 Select the geometry object, then do one of the following:

• Click the Replicate button in the Toolbar.

• Press L.

• Choose Object > Replicate.

The geometry is replicated.

To use a geometry object as the shape source of the replicator pattern
1 Import (or draw) the shape you want to use as the pattern shape in an existing replicator.

2 In the Replicator tab, select Geometry from the Shape pop-up menu.

The Shape Source well appears in the Inspector and HUD.

Shape Source well

3 From the Layers tab, drag the shape to the Shape Source well.

4 When the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the shape appears in the well and is used as the source for the shape of
the replicator.

Note: You may want to disable the source shape in the Layers tab so it is not visible in
your project.

When you set the Shape parameter to Geometry, the Shape Source, Points, and Offset
parameters appear in the Replicator tab. Use these controls to modify the effect of the
geometry pattern in the Canvas.

723Chapter 12 Using the Replicator



Using Replicators in 3D Space
Two of the replicator pattern styles available in the Shapes pop-up menu have 3D
properties: Box and Sphere. The Box and Sphere shape options are available only when
the 3D checkbox is selected in the Replicator tab. Box and Sphere replicators build a
pattern of elements in 3D space. Whereas the 2D Rectangle and Circle replicator shapes
have columns (in the Y plane) and rows (in the X plane), Box and Sphere have an additional
Ranks parameter, which adds depth to the replicator.

Box replicator with 13 columns, 12 rows,
and 3 ranks

Sphere replicator with 14 columns, 14 rows,
and 5 ranks

The Line and Wave replicator shapes, on the other hand, have quasi-3D properties: Their
start and end points can be moved into Z space. In the following image, the Z Start Point
(yellow end of the pattern) is set to 20 and the Z End Point is –18 (red end of the pattern).

Although the Rectangle, Circle, Line, Wave, Image, and Geometry replicators have no
inherent 3D parameters, they can be moved and rotated in 3D space. Pattern elements
can also be pulled out of their plane when behaviors are applied. The replicator must be
a member of a 3D group in order to be pulled out of the X and Y planes by a behavior.
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The following illustrations demonstrate replicator pattern elements pulled into Z space.
In the illustration on the left, the Burst replicator’s Z position is set to 0 and the white
circle’s Z position is set to 225. An “Attracted To” Simulation behavior is applied to the
replicator, with the white circle set as the target object. As the project plays, as shown in
the center illustration, the replicator elements move forward in Z space toward the
attractor. In the right illustration, the camera is rotated to look behind the replicator.
Under the behavior’s influence, the replicator elements move past their attractor element,
and return to their original position.

Certain operations, as well as the application of certain filters or a mask, will rasterize a
3D group. For more information on rasterization, see About Rasterization.

Tip: When working with elements in 3D, you can quickly snap an object back to its original
orientation by using the Isolate command.

To isolate a group or layer
Do one of the following:

µ In the Layers tab (or Timeline layers list), click the Isolate button.

Inactive Isolate button

µ Control-click the layer or group, then choose Isolate from the shortcut menu.

µ Choose Object > Isolate.

Click the Isolate button again to return to your previous view.

Note: Clicking a camera’s Isolate button activates that camera’s view.

Applying Masks to Replicators
Masks can be applied to a replicator’s source layer (the original layer that is replicated to
create the repeating onscreen elements), or to the replicator itself.
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The following images show masks applied to the source layer of a replicator.

Mask applied to the 
replicator cell source 
layer

When a masked layer is used as the source for a replicator cell, the mask is respected in
the elements that appear onscreen.

Original source Circle mask applied to source Masked layer used as 
replicator source

Masks can also be applied to the replicator layer.

Mask applied to 
replicator

When the mask is applied to a replicator, the entire pattern onscreen becomes masked.

Circle mask applied to the 
replicator
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Note: Although masks cannot be applied to a 3D replicator, they can be applied to an
object that is used as a pattern source for 3D replicator.

For more information on working with masks, see Masking a Layer or Group.

Animating Replicator Parameters
Most of the replicator and replicator cell parameters can be animated with keyframing
or by using Parameter behaviors. If you animate the replicator’s shape-specific parameters
such as Radius, Twists, and Offset (in a Spiral replicator), the pattern on which the elements
are built is animated, not the elements themselves. To animate the elements of the
pattern, you keyframe the parameters in the Cell Controls group of the Replicator tab (or
in the Replicator Cell tab).

Keyframing the replicator parameters (or using Parameter behaviors) animates all elements
in the replicator symmetrically. To animate the individual elements in sequence over
time—without having to create keyframes—use the Sequence Behavior, described inUsing
the Sequence Replicator Behavior. To animate the replicator using Basic Motion or
Simulation behaviors, see Using Behaviors with Replicators.

Important: If you apply a Simulation behavior, or a Throw or Spin behavior, to a replicator
with keyframed parameters, some of those keyframed parameters are ignored. For more
information on using behaviors with the replicator, see Using Behaviors with Replicators.

You can also use keyframes to animate the parameters in a replicator’s Properties tab.
Parameters in this tab affect the replicator as a whole, not the individual replicator
elements. This can be useful for changing the replicator’s position or rotation over time.

Example: Creating an Animated Replicator
The following example demonstrates how quickly you can create attractive, complex
animated patterns with minimal effort. An animated replicator is created using a
hand-drawn shape as the source for the replicator’s cell. Once the replicator is created,
the Angle and Scale parameters are keyframed, and a Parameter behavior is applied to
the Radius parameter.

To create an animated replicator using keyframes
1 Add the object that you want to replicate to your project.
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This example uses a bow-shaped Bezier shape object that is filled with a custom gradient.

2 In the Layers tab, select the source layer and click the Replicate icon in the Toolbar (or
press L).

The default replicator object (rectangle shape with the tile fill arrangement) appears in
the Layers tab and in the Canvas. The original source layer is disabled.

3 In the Replicator tab of the Inspector, do the following:

a Select Circle from the Shape pop-up menu.

b Select Outline from the Arrangement pop-up menu.

The cells appear in a circle. By default, the circle shape contains five points, and its
Radius is set to 200. An element appears at every point on the circle.
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c If necessary, adjust the Radius parameter so that elements are not cut off in the Canvas.

In this example, Radius is set to 145.

d Increase the Points value until the elements overlap.

An element is created at every point on the shape. In this example, Points is set to 30.

e In the Cell Controls section of the Replicator tab, select Align Angle.

Based on the location of the anchor point of the source layer, the replicator elements
automatically rotate to match the curve of the circle.
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f Select Additive Blend.

Align Angle parameter

Additive Blend parameter

The color values in every overlapping pixel are added together, and all overlapping
midrange color values are lightened.
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4 Go frame 1 (press Home), and enable Record (press A).

When Record is enabled, the Record button in the transport controls pulses red and all
animateable values in the Inspector appear pink. Keyframes are created for any changes
made to a layer.

5 In the Replicator tab, click in the Angle value field, type 0, and press Enter to create a
keyframe.

Note: You can create keyframes without using the Record button by Option-clicking the
Animation menu icon of a parameter in the Inspector.

6 Set the Scale value to 50%.

7 Advance to the end of the project (press End), or to the frame where you want the
animation to stop.

In this example project, the last frame is 150.

8 Set the Angle value to 240 degrees and the Scale value to 80%.

9 Press A to disable Record, deselect the object (click in a gray area of the Canvas), then
play the project (press the Space bar).

The replicator elements rotate and increase in size over time to create a pinwheel.

Tip: A simple way to create a new look for a replicator is to move the position of the
source object’s anchor point. You can continue to play the project while you adjust the
anchor point until you create a look that you like.
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To change the anchor point of a replicator source layer
1 In the Layers tab, select the source.

Although not required to adjust its anchor point, you can enable the source layer so you
can see it in the Canvas.

2 In the Toolbar, select the Adjust Anchor Point tool.

Adjust Anchor Point tool

Note: You can also press Tab to cycle through the onscreen transform modes.

3 In the Canvas, drag the source object’s anchor point.

The alignment of the elements to the replicator shape (the circle) changes based on the
position of the anchor point.

To animate a replicator parameter using a Parameter behavior
1 Continuing with the above example, select the replicator in the Layers tab.

Note: Remember, you can continue to play back a project while making parameter
adjustments.

2 Control-click the parameter to which you want to add a Parameter behavior (this example
uses the Radius parameter), and choose Oscillate from the shortcut menu.

The size of the replicator oscillates in the Canvas, bringing the elements closer together
and further apart over the duration of the animation to create yet another look for the
replicator pattern. The Oscillate parameters appear in the Behaviors tab, and a Parameter
behavior icon appears in the Animation menu of the Radius parameter in the Replicator
tab.

3 Adjust the Oscillate parameters, if necessary.
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For more information on the Oscillate and other Parameter behaviors, see Parameter
Behaviors.

Displaying Replicator Animation Curves in the Keyframe Editor
The replicator parameters in the Properties and Replicator tabs can be keyframed to
create a change in values over time. You can view the resulting keyframe curves in the
Keyframe Editor by choosing Animated from the Show pop-up menu in the Keyframe
Editor. Different parameters (and their keyframe curves) are displayed in the Keyframe
editor depending on which layer you select in the Layers tab:

• Select the replicator layer to display animated replicator parameters such as Position
and Rotation in the Properties tab, or Size or Tile Offset (available when the shape is a
rectangle) in the Replicator tab.

• Select the cell layer to display animated parameters of the Replicator Cell tab, such as
Angle or Scale.

For more information on keyframing parameters in the Curve Editor, see Keyframes and
Curves.

Using the Sequence Replicator Behavior
The Sequence Replicator behavior allows you to animate the individual elements of a
replicator in sequence over time. This is the only way to animate the elements
individually—keyframing the cell parameters or applying other behaviors affects all
elements in the pattern uniformly.

The Sequence Replicator behavior is very similar to the Sequence Text behavior, which
allows you to animate text parameters in sequence through the characters of a text layer.
With the Sequence Replicator behavior, you can select and apply replicator cell parameters
such as Position, Color, Scale, Rotation, or Opacity, then animate those parameters in a
cascading sequence that passes through each element in a replicator pattern.
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The starting point for the sequence animation is based on the replicator’s origin or build
style. For example, if a spiral replicator’s Origin parameter is set to Center, the sequence
animation begins at the center of the spiral and moves outward; if the Origin of a rectangle
replicator with a tile fill is set to Upper Left, and the Build Style is set to Across, the
sequence begins with the elements in the upper-left corner of the pattern, then moves
toward the lower-right corner.

The Sequence Replicator behavior can be applied to the replicator object itself, or to the
cells of the replicator. When applied to the different cells of a replicator with multiple
cells, different animations can be created for each cell.

Like most other layers in Motion, once you have created a Sequence Replicator behavior,
you can save the behavior to the Library.

To apply the Sequence Replicator behavior to a replicator
Do one of the following:

µ In the Layers tab or Timeline layers list, select the replicator to which you want to apply
the Sequence behavior. In the Toolbar, click the Add Behavior icon and choose Replicator
> Sequence Replicator.

µ In the Library, select the Behaviors category, and then the Replicator subcategory. Drag
the Sequence Replicator behavior from the stack to the replicator in the Layers tab, Canvas,
or Timeline layers list.

The Sequence Replicator controls appear in the Behaviors tab of the Inspector, and the
Sequence Replicator HUD becomes active.

At the top of the Sequence Replicator controls in the Inspector are the Parameter pop-up
menus, which are used to add parameters to the behavior, or to remove them once
they’ve been added. The added parameters determine which properties are animated.
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Underneath the Parameter pop-up menus are the Sequence Control parameters, which
determine how the added parameters affect the onscreen elements. These controls
include options for setting the direction of the animation, whether the animation is
applied per element or to the whole pattern, the number of times the animation cycles
through the pattern, and so on.

Sequence Control 
parameters

Add or Remove 
parameters

Important: Before any sequencing animation can occur, you must explicitly add at least
one parameter to the behavior from within the Inspector or HUD and then set a value
for that parameter. Until a parameter is added, adjustments in the HUD have no effect.

Adding Parameters to the Sequence Replicator Behavior
In the following example, the Rotation, Opacity, and Scale parameters are added to the
Sequence Replicator behavior. The behavior is applied to a replicator with its Shape set
to Burst, and its Origin set to Center. This example uses the source object from Example:
Creating an Animated Replicator.

Burst replicator pattern prior to applying 
Sequence Replicator behavior

Replicator 
source object
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To add and animate parameters in the Sequence Replicator behavior
1 With the Sequence Replicator behavior selected in the Layers tab, display the Behaviors

tab in the Inspector.

2 In the Parameter row, do the following:

a Choose Rotation from the Add Parameter pop-up menu.

b Choose Opacity from the Add Parameter pop-up menu.

c Choose Scale from the Add Parameter pop-up menu.

The added parameters appear above the Add and Remove pop-up menus. No animation
occurs until you set a value for the parameters.

Play the project (press the Space bar) to see the effects of the sequencing adjustments
as they begin to take effect in the next steps.

3 Set Rotation to the largest (or smallest) value you want the cells to spin in the animation.

In this example, Rotation is set to 160 degrees.

Each element rotates from 0 degrees to 160 degrees over the pattern for the duration of
the Sequence Replicator behavior.

Note: If the elements are already rotated (in the Cell Controls), the elements are rotated
160 degrees from their original rotation value.

Each element rotates and pops into place before the next element begins its animation.
To soften this effect, increase the Spread value.

4 Increase the Spread value.

In this example, Spread is set to 12.
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In addition to creating a more graceful animation, changing the Spread value can also
dramatically change the appearance of the pattern.

5 Set Opacity to the lowest value you want the elements to become in the animation.

In this example, Opacity is set to 0.

Each element fades from 100% opacity to 0% opacity over the pattern for the duration
of the Sequence Replicator behavior.

Note: If the elements already contain some transparency, they fade from their original
opacity value to 0%.

6 Increase the Scale value. In this example, Scale is set to 190%.
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The animation begins at the original value for any added parameter, then transforms to
the value you specify in the Sequence Replicator parameters. The animation begins at
the origin of the pattern (set in the Origin or Build Style parameter of the Replicator tab
or HUD) and moves through to the end of the pattern.

Adjusting the Sequence Control Parameters
Once you have created a sequence animation, you can use the Sequence Control
parameters to change the manner in which the sequence moves through the replicator
pattern. The following section continues with the project used in the previous examples.

To change the way the sequence moves through the pattern
1 With the Sequence Replicator behavior selected, display the Behaviors tab in the Inspector.

2 Play the project (press the Space bar) to see the effects of the sequencing.

By default, Sequencing is set to “To,” which specifies that the animation begins at the
original value of the cells and moves to the value set in the Sequence Replicator behavior
for that parameter. The starting point for the sequence animation is based on the build
or “origin” of the pattern (as defined in the Origin or Build Style parameters in the
Replicator tab). In the example project, the elements begin completely opaque, at 100%
scale, and with 0 degrees of rotation at the origin of the pattern. As the sequence moves
toward the end of the pattern, the elements become completely transparent, are scaled
to 190%, and are rotated 160 degrees.

3 In the Sequencing pop-up menu, choose From.

The animation moves from the value set in the Sequence Replicator behavior to the
original value of the cells. This is the opposite of the To Sequencing option.

4 In the Sequencing pop-up menu, choose Through.
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The sequence goes through a full animation cycle starting at the original value of the
cells, moving to the value set in the Sequence Replicator, then returning to the original
value of the cells. This is similar to combining the To and From Sequencing options.

5 Choose All from the Unit Size pop-up menu.

The sequence animation affects all replicator elements simultaneously. The default is
Object, which applies the sequence animation to the elements of the replicator based
on the origin of the pattern.

Unit Size set to All Unit Size set to Object

6 Increase the Loops value to a minimum value of 3.

By default, a sequence animation plays through one time. The value of the Loops
parameter defines the number of times the animation repeats over the duration of the
replicator object.

7 Choose Ping Pong from the End Condition pop-up menu.

By default, the End Condition parameter is set to Hold, which completes a sequence
animation cycle, then starts the cycle again from the beginning. When set to Ping Pong,
the animation cycles forward one time, then cycles backward, then forward, and so on.

Note: The End Condition parameter has no effect for Loop values less than or equal to
1.

For more information the Sequence Replicator parameters, see Sequence Replicator
Controls.
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Sequence Replicator Controls
Use the following parameters to modify the sequence animation. With the exception of
the Add and Remove Parameter pop-up menus, all of the following parameters also
appear in the Sequence Replicator HUD.

Parameter: Use the Add and Remove pop-up menus in the Parameter row to add and
remove replicator cell parameters. When you choose an item from the pop-up menu,
additional controls appear in the Behaviors tab above the Parameter row. You can adjust
these controls (or keyframe them) to modify the sequence animation, which is based on
the change in value between these parameters and the original values of the cells. The
Add pop-up menu items include:

• Rotation: Adds a rotation dial and value slider that enables you to Specify (in degrees)
the rotation of the replicator elements.

• Color: Adds a row of color controls that let you specify a tint for replicator elements.
You can either click the color well to choose a color or open the disclosure triangle and
use the Red, Green, and Blue sliders.

• Scale: Adds a scale slider that lets you define the size of the replicator elements. Click
the disclosure triangle next to the Scale slider to reveal separate X scaling and Y scaling
subparameters that can be used to adjust the width and height of the cells separately.
By default, Scale is set to 100%—the size of the replicator cells is equal to the original
size defined in the cell parameters.

• Opacity: Adds an opacity slider, allowing you to define the transparency of the pattern
elements.

• Position: Adds two value sliders that define the offset of the elements from their original
position in X and Y space. Click the disclosure triangle next to the value sliders to reveal
separate X, Y, and Z position subparameters. For example, to create an animation in
which the elements move upward in Y over the replicator pattern, enter a positive
value in the Y Position field. In the following images, Y Position is set to 300.

For more information about the Rotation, Color, Scale, Opacity, and Position parameter,
see Parameters in the Properties Tab.
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Sequencing: This pop-up menu specifies how the sequence animation moves through
the elements of the pattern, based on the change from the original parameter value to
the value set in the Sequence Replicator parameters. The starting point for the sequence
animation is based on the selected Origin or Build Style parameters (in the Replicator
tab). For example, if a line replicator’s Origin parameter is set to End Point, the sequence
animation begins at the end of the line and moves toward the start of the line by default.
To change the starting point for the sequence animation, change the Origin or Build Style
of the pattern in the replicator controls (in the Replicator tab or HUD). The Sequencing
options are:

• To: Specifies that the animation begins at the original value of the cells and moves to
the value set in the Sequence Replicator behavior for that parameter. For example, if
the original opacity value of a cell is 100%, and opacity is set to 0% in the Sequence
Replicator parameters, the onscreen elements begin completely opaque and become
completely transparent.

• From: Specifies that the animation moves from the value set in the Sequence Replicator
behavior to the original value of the cells. For example, if the original opacity value of
a cell is 100% and opacity is set to 0% in the Sequence Replicator parameters, the
onscreen elements begin completely transparent and become completely opaque.
This is the opposite of the To option in the Sequencing pop-up menu.

• Through: Specifies that the sequence goes through a full animation cycle starting at
the original value of the cells, moves to the value set in the Sequence Replicator, and
then returns to the original value of the cells. For example, if the original opacity value
of a cell is 100% and opacity is set to 0% in the Sequence Replicator parameters, the
onscreen elements begin completely opaque, become transparent, and then become
completely opaque again.

• Through Inverted: Specifies that the sequence goes through an inverted animation cycle
starting from the value set in the Sequence Replicator, moves to the original value of
the cells, and then returns to the value set in the Sequence Replicator. For example, if
the original opacity value of a cell is 100% and opacity is set to 0% in the Sequence
Replicator parameters, the onscreen elements begin completely transparent, become
opaque, and then become completely transparent. This is the opposite of the Through
Sequencing option.
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• Custom: Allows you to use animation originally created in the source layer’s parameters
(except alpha parameters) or to keyframe how the animation moves through the values
set in the Sequence Replicator parameters over an individual element. Each element
undergoes the same value sequence. When Custom is chosen from the Sequencing
pop-up menu, the Source parameter becomes available.

Source parameter 
becomes available when 
Sequencing is set to 
Custom.

Source: This pop-up menu becomes available when Custom is chosen from the
Sequencing pop-up menu. The Source options are:

• Use Source Animation: If the source layer parameters are keyframed (in the Replicator
tab or HUD), choose this option to enable the animation created by those keyframes.

• Ignore Source Animation: If the source layer parameters are keyframed (in the Replicator
tab or HUD), choose this option to ignore the animation created by those keyframes.

Unit Size: This pop-up menu specifies whether the sequence animation is applied to the
replicator pattern as a whole, to its individual elements, or to a keyframed range. The
Unit Size options are:

• Object: Applies the sequence animation over each element as its own entity. Object is
the default setting.

When Unit Size is set to Object, each replicator 
pattern cell is affected individually.
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• All: Applies the sequence animation to all replicator elements simultaneously.

When Unit Size is set to All, every replicator 
pattern cell is affected simultaneously.

• Custom: Allows you to specify the percentage of elements in the pattern that are
affected by the sequence animation at once. Although you can create keyframes for
the Custom option, it is not required in order to affect the sequence. As shown in the
following images, the Object and All options allow you to sequence the animation only
through the origin or build style of the pattern, or through all pattern elements
simultaneously.

Unit Size set to All sequences the animation 
over all cells simultaneously.

Unit Size set to Object sequences the animation 
over the build of the pattern.
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Custom allows you to define an area of elements—based on percentage—that are
affected by the sequence.

Unit Size set to Custom allows you to define the 
percentage of cells affected as the sequence 
moves through the pattern.

When Custom is chosen from the Unit Size pop-up menu, the Start and End parameters
become available.

Start: This parameter is available when Custom is chosen from the Unit Size pop-up
menu. Specifies the offset of the start of the range of elements affected by the sequence
animation as it moves over the replicator pattern. In the above image, Start is set to 10%.

End: This parameter is available when Custom is chosen from the Unit Size pop-up menu.
Specifies the end of the range of elements affected by the sequence animation as it moves
over the replicator pattern. By default, End is set to 10%. In the above image, End is set
to 30%.

Note: If the Sequencing pop-up menu is set to Custom, the Custom option in the Unit
Size parameter has no affect.

Spread: Controls the amount of falloff of the animation. To create a softer transition
between each element, increase the Spread value.

Traversal: Sets the action of the sequence behavior to Constant Speed, Ease In, Ease Out,
Ease In/Out, Accelerate, Decelerate, or Custom.

• Ramp: Moves the animation from the origin of the replicator pattern through the end
of the pattern at a constant speed. The sequence moves in the direction specified in
the replicator parameters, such as the origin or build style.

• Ease In: The sequence animation begins slowly and increases to normal speed as it
moves through the replicator pattern.

• Ease Out: The sequence animation begins at normal speed and slows toward the end
of the replicator pattern.
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• Ease In/Out: The sequence animation begins slowly, increases to normal speed as it
moves toward the middle of the duration of the replicator pattern, and slows as it
reaches the end of the replicator pattern.

• Accelerate: The sequence animation increases in speed.

• Decelerate: The sequence animation decreases in speed.

• Custom: Allows you to keyframe how the animation moves through the replicator
pattern. When Custom is selected from the Traversal pop-up menu, the Location
parameter replaces the Loops parameter.

• Location: Defines the location of the pattern where the animation is in effect.

For more information on using the Custom Traversal option, see Using the Sequence
Replicator Custom Traversal Option.

Loops: Sets the number of times the animation sequences through the replicator pattern
over its duration.

Note: Loops is not available when the Traversal parameter is set to Custom.

End Condition: Determines how the sequence animation is repeated over the duration
of the replicator object. This parameter has no effect for Loop values less than or equal
to 1. The End Condition options are:

• Hold: Completes the sequence animation cycle one time, then starts it over again from
the beginning (once the last element in the sequence has completed its animation).

• Wrap: Treats the sequence animation as a continuous loop so the spread wraps from
the last element in the sequence to the first element.

• Ping Pong: Completes the sequence animation cycle forward, then completes the
animation backward, then forward, and so on.

Using the Sequence Replicator Custom Traversal Option
When the Traversal parameter in the Sequence Replicator behavior is set to Custom, you
can create location keyframes to specify where the effect of the sequence is at any given
time. This allows you to create a sequence animation that travels through a replicator
pattern in a unique way. This example shows how to use the Custom Traversal option to
scale the elements around a circle replicator shape by creating keyframes.

To use the Custom Traversal parameter
1 Once the Sequence Replicator behavior is applied to the replicator, add the parameters

(in the Behaviors tab) that you want to include in the sequence.
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2 Set the values for the added parameters. In this example, the Scale parameter is added
and the Scale value set to 200%.

Sequence behavior applied to replicator with 
Scale parameter set to 200%, Sequencing set to 
Through, and Spread set to 4

For more information on adding parameters to the Sequence Replicator behavior, see
Adding Parameters to the Sequence Replicator Behavior.

3 Choose Custom from the Traversal pop-up menu.

The Location parameter becomes available.

When Traversal is set to 
Custom, the Location 
parameter becomes 
available. Use the 
Location slider to 
keyframe how the 
sequence moves through 
the replicator pattern.

4 Enable Record (press A).

5 At the frame where you want to begin the animation, drag the Location slider (or use the
adjacent value slider) to set where the sequence begins.

As you drag the slider, the sequence moves through the pattern elements. Values displayed
in the Location parameter specify where in the pattern the sequence is (in percentage
points)—0 representing the origin of the pattern, and 100% representing the end of the
pattern.

In the Inspector, a keyframe is added to the Location parameter.

6 Go to the next frame where you want to set a keyframe, and move the Location slider.

7 Repeat step 6 until you have created all of your keyframes.

8 Play the project (press the Space bar).

746 Chapter 12 Using the Replicator



The animation moves through the replicator pattern based on its keyframed locations.
In this case, the scale moves erratically back and forth around the circle, rather than in a
constant direction.

Using Parameter Behaviors with the Sequence Replicator Behavior
Like all other layers in Motion, you can add Parameter behaviors to the Sequence Replicator
parameters to create even more varied, complex effects without keyframing.

To apply a Parameter behavior to a Sequence Replicator behavior
1 In the Layers tab or Timeline layers list, select the Sequence Replicator behavior.

2 Control-click the parameter to which you want to add a Parameter behavior, then choose
a Parameter behavior from the shortcut menu.

Note: You can only add a parameter behavior to controls that include the Animation
menu (the dash icon at the right side of the parameter row).
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The Parameter behavior is added and appears above the Sequence Replicator behavior
in the Behaviors tab. A Parameter behavior icon appears in the Animation menu of the
Sequence Replicator parameter.

Behavior icon

Note: When the Wriggle or Randomize Parameter behavior is added to a Sequence
Replicator parameter, the Affect Subobjects checkbox becomes available. Select the
checkbox if you want each element in the pattern to display a different random behavior.

For more information on using Parameter behaviors, see Parameter Behaviors.

Using Behaviors with Replicators
As with all layers in Motion, you can apply Basic Motion, Parameter, and Simulation
behaviors to a replicator or to its cells.

Only the Throw and Spin behaviors (from the Basic Motion subcategory) can be applied
to the replicator cell layer. All behaviors from the Basic Motion subcategory can be applied
to the replicator layer.

As previously noted, the replicator also has a special behavior called Sequence Replicator,
which allows you to animate the individual cells in sequence over time. For more
information on the Sequence Replicator behavior, see Using the Sequence Replicator
Behavior.

For more information on applying Parameter behaviors to the Sequence Replicator
behavior, see Using Parameter Behaviors with the Sequence Replicator Behavior.
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To apply a behavior to a replicator
Do one of the following:

µ Drag a behavior from the Library onto a replicator in the Canvas, Layers tab, or Timeline.

µ Select the replicator in the Layers tab, Timeline layers list, or Canvas, click the Add Behavior
icon in the Toolbar, then choose a behavior from the shortcut menu.

The behavior is applied to the replicator, which begins to move according to the
parameters of the behavior.

Not all behaviors instantly activate a layer when applied. For example, when a Throw
behavior is applied to a layer, the Throw Velocity parameter must be adjusted before the
object moves.

For more information on behaviors, see Using Behaviors.

Special Behavior Considerations
When Simulation behaviors, as well as the Spin and Throw behaviors, are applied to a
replicator that has animated parameters, some of the animation created by the keyframes
is ignored. For example, if the Angle parameter in the Cell Controls of the Replicator tab
is keyframed so that the pattern elements rotate over time and you apply a Spin
behavior—with the Affect Subobjects checkbox selected—the elements rotate according
to the rate set in the Spin behavior parameters and ignore the replicator’s Angle keyframes.
To rotate the entire replicator layer and enable the Angle keyframe animation, deselect
Affect Subobjects in the Spin parameters.
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Simulation Behaviors and Keyframes
A good rule to keep in mind is that any Simulation behavior, as well as the Throw and
Spin behaviors (in the Basic Motion behaviors category), applied to a replicator disables
all animation that affects the position or rotation or the individual elements.

To return to any keyframed animation that was created before you applied the behavior,
simply disable the behaviors. To disable a behavior, deselect its checkbox in the Inspector,
Layers tab, or Timeline layers list.

Spin behavior applied to replicator with
Affect Subobjects turned on (the individual 
elements spin)

Spin behavior applied to replicator with
Affect Subobjects turned off (the entire 
replicator pattern spins)

Applying Filters to Replicators
Filters can be applied to a replicator or its sources. When applied to the replicator, filters
affect every element of the replicator pattern as if it were a single layer. When filters are
applied to the source layers of a replicator, the effect of the filter is retained once the
layer is replicated. However, filters cannot be applied to the individual cells of a replicator.

Replicator before any filters
are applied

Circle Screen filter applied to
the source layer for the
replicator cells

Circle Screen filter applied to the 
replicator layer

For more information on applying filters to layers in your project, see Using Filters.

750 Chapter 12 Using the Replicator



Saving Custom Replicators to the Library
Once you have created a replicator that makes you particularly happy, you can save it as
a replicator preset in the Replicator or Favorites category of the Library for future use.
Once you place a custom replicator in the Library, it can be used just like any other
replicator preset.

To save a custom replicator to the Library
1 Open the Library and select either the Replicators, Favorites, or Favorites Menu category.

2 From the Layers tab or Timeline layers list, drag the replicator you want to save into the
stack at the bottom of the Library.

Note: For organizational purposes, you may find it useful to create a new folder of your
own in the Favorites or Favorites Menu category to store your replicators.

When you save a replicator preset, it’s saved as a file in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Replicators/
(or Favorites or Favorites Menu) folder.

You can copy replicator presets you create from this location to give to other Motion
users, or you can add replicator presets that are given to you to this same folder.

Note: Whenever you copy a replicator preset file, you should make sure that you also
copy any graphics or movie files that it uses as well.
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In motion graphics, typography communicates much more than just basic
information—titles, dates, and tag lines. Visual and kinetic type on the screen can also
provoke an immediate and often powerful emotional response. A title sequence can set
the mood for the film it introduces. A specific combination of text and animation can
instantly identify a broadcast network. And a clever television interstitial can forestall a
bored viewer from flipping channels during a commercial break. Type design is an art
form. Just look at the opening title sequence by Friz Freleng for Blake Edwards’ The Pink
Panther. Freleng’s animated titles—featuring a design and graphics style that holds up
even today, more than 40 years later—not only set the comic tone for a film franchise,
but launched the (virtual) career of an animated icon (with a little help from Henry
Mancini’s suave theme music).

Although trends in type design change, the balanced use of type and graphics remains
the key to achieving the right effect in commercials, documentaries, television and film
titles, broadcast logos, corporate presentations, or your own personal video projects. No
matter what style your project requires, Motion provides unique text animation tools that
offer immediate results.

This chapter covers the following:

• About Text in Motion (p. 754)

• Setting Motion Preferences for Text (p. 755)

• Adding Text (p. 756)

• Using the Text Tools (p. 768)

• About Fonts (p. 769)
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• Editing Text in the Inspector (p. 772)

• Editing Text Format (p. 775)

• Text Controls in the Format Pane (p. 776)

• Text Format-Related Tasks (p. 779)

• Editing Text Style (p. 781)

• Text Controls in the Style Pane (p. 782)

• Text Style-Related Tasks (p. 789)

• Using and Creating Preset Text Styles (p. 808)

• Editing Text Layout (p. 812)

• Text Controls in the Layout Pane (p. 813)

• Text Layout-Related Tasks (p. 825)

• Text Margin and Tab-Related Tasks (p. 835)

• Working with Text Glyphs (p. 837)

• Adding Behaviors and Filters to Text (p. 844)

• Using the Text HUD (p. 845)

About Text in Motion
Motion lets you add text to your project directly in the Canvas—select the Text tool, click
in the Canvas, then start typing. Once text is created, you can edit it in the Canvas or in
the Text editor in the Inspector. Text can be modified as a whole object, or as separate
glyphs (characters). This allows for endless combinations of text effects.

Text can be animated using behaviors or keyframes. For more information on animating
text, see Animating Text.

After you create the desired text treatment—a text style with the perfect gradient colors
and glow or a customized text behavior—you can save the behavior or style in the Library
for use on other text or in a future project.

You can apply filters to text, as well as change and animate text properties such as position,
blend modes, and drop shadows.

The stacking order of text can be easily changed in the Layers tab or Timeline. Text can
also be moved to or duplicated/copied into another layer.

The Motion Library includes LiveFonts (if you installed them) that can be applied to text.
LiveFonts are animated fonts that can add a little zing to your project.
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Using Text as Particle and Replicator Source Objects
Text layers can be used as source cells for particle emitters and replicators to quickly
create stunning graphics. If you later modify the source text, Motion automatically
updates the replicator and particle system. If the text used as a cell source has applied
behaviors or filters, the effect is carried over into the replicator or particle system.

Setting Motion Preferences for Text
Before you start any project, you should set up Motion Preferences according to your
project requirements. You can set the layer duration preferences so that an object (text
layer) is created at the current frame (the frame where the playhead is positioned at the
time you add the text). Alternatively, you can specify that the object is created at the start
of the project. By default, layers are created at the current frame. You can also specify a
default duration for any created layer.

Note: Layer duration preferences apply to all layers created within Motion, including text,
shapes, masks, particle emitters, and replicators.

To set the layer duration preferences
1 Choose Motion > Preferences (or press Command-Comma).

2 Click the Project icon.

The Project Preferences pane is displayed.

3 In the Still Images & Layers section, set the Default Layer Duration preference:

• To create text that is the length of the project, select “Use project duration” (the default
setting). This means that if you are working in a 300-frame project and you create text,
the duration of the text is 300 frames.

Note: If you have Create Layers At set to “Current frame,” and you create text at frame
50, the text exists from frame 50 to frame 300.

• To create text that is a specific duration, select “Use custom duration.” Next, enter a
value in the text field, then choose Frames or Seconds from the pop-up menu.

All layers you created are set to the entered duration by default.

4 Set the Create Layers At preference:

• To create text at the current location of the playhead, select “Current frame.”
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• To create text at the start of the project, select “Start of project.” This means that all
text is created at the beginning of the project by default, regardless of the playhead
location.

Create Layers At options

Adding Text
In Motion, you create text directly in the Canvas using the Text tool, enter text in the
Inspector, or bring in a text file. Once text is added to your project, you can easily apply
filters to the text or animate the text using behaviors or keyframes.

Adding Basic Text in the Canvas
This section describes adding text to your project in the Canvas.

For information on adding text using the Text tool, see Adding Paragraph Text in the
Canvas.

For information on adding text using the Text Editor, see Adding Text with the Text Editor.

For information on adding text to your project from a text file, see Adding a Text File to
a Project.

When Create Layers At is set to “Start of project” in the Project Preferences pane, text is
created at the first frame of the project. For example, if you are working in a 900-frame
project and you add text, the duration of the text is 900 frames. To shorten the duration
of the text, shorten the text layer duration in the Timeline or mini-Timeline. For more
information, see Using the Timeline.

To add text in the Canvas
1 In the Layers tab, select the group to which you want to add the text layer.

Note: If no group is explicitly selected, the text is added to the last selected group (the
group with the underline beneath its name).
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2 In the Toolbar, click the Text tool (or press T).

Text tool

3 Click in the Canvas.

The cursor flashes in the Canvas at the insertion point. Before you enter any text, an empty
text layer is added to the project and the Text HUD appears.

Empty text layer

4 Type the text you want.

Once text is added, the following occurs:

• The text appears in the Canvas.

• The text layer in the Layers tab is named with the entered text.

• The entered text appears in the mini-Timeline.
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• The entered text appears in the track bars of the group and layer in the Timeline.

Note: By default, the text Layout Method (adjustable in the Layout pane of the Text tab)
is set to Type. The Type layout option creates no right-hand margin, so if you enter a long
string of text, it extends on a single line beyond the Canvas until you create a manual
line break (press Return). This mode is useful for working with short text and panning
text across the Canvas. For information on changing text layout and setting margins, see
Non-Path Text Controls in the Layout Pane. To see items that extend beyond the edge
of the Canvas, choose View > Show Full View Area.

5 When you are done typing, press Esc or click the Select/Transform tool in the Toolbar.

The text is selected and appears with a bounding box in the Canvas.

Important: Once you have finished typing your text, be sure to press Esc or select another
tool on the Toolbar—do not use a keyboard shortcut. When the Text tool is selected, you
are in text-entry mode, so if you press S to select the Select/Transform tool, an “S” is added
to your text rather than the tool being changed.

To select text characters
Do one of the following:

µ Select the Text tool, then drag to select text in the Canvas.

µ Click in between two characters in the Canvas, press Shift, then press the Right Arrow
key to select characters to the right of the insertion point. Press the Left Arrow key to
select characters to the left of the insertion point.

µ Click the Select/Transform tool, then double-click the text.

To move the cursor between words
µ Press Option–Right Arrow to move the cursor forward between words; press Option–Left

Arrow to move the cursor backward between words.

To delete an entire word
µ Position the cursor at the end of the word you want to delete, then press Option-Delete.
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Adding Paragraph Text in the Canvas
Whereas clicking in the Canvas with the Text tool prompts basic text entry, dragging the
cursor in the Canvas prompts paragraph-style text entry. Paragraph text is contained
within margins that cause the text you type to wrap automatically to the next line. You
can adjust the margins of the paragraph to create a column of text as narrow or as wide
as you like.

To add paragraph text to your project
µ With the Text tool selected, drag in the Canvas to draw a custom text entry field.

Note: You can create a text entry field with margins that extend beyond the edge of the
Canvas.

When you release the mouse button, the paragraph text entry field appears in the Canvas.
You can begin typing at the flashing insertion point. A ruler appears above the text field,
and an empty rectangular column appears on the right side. In the Layout pane of the
Text Inspector, the Layout Method pop-up menu is automatically set to Paragraph.

Paragraph text entry field

When text extends beyond the upper and lower edges of the text entry box, the empty
rectangular column becomes a scroll control.
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Note: You can also type new paragraph text in the Text editor field of the Format pane
(in the Text Inspector). For more information, see Adding Text with the Text Editor.

Working in the Canvas, you can adjust the margins of the text entry field without affecting
the scale of the text.

To adjust the width or height of the text margins without scaling the text itself
Do one of the following:

µ With the Text tool selected, drag one of the text entry field’s onscreen scale handles.

Note: Do not use the Select/Transform tool to resize text margins. When you exit text-entry
mode (by pressing Esc or selecting a new tool from the Toolbar), a standard object
bounding box appears around the text. If you resize a text bounding box (by dragging
one of its scale handles), the text itself is resized, not just the width of the bounding box.
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µ In the Text Inspector, click the Layout pane and adjust the Left Margin, Right Margin, Top
Margin, or Bottom Margin values.

Margin controls

Note: When text is deleted from a paragraph, the paragraph margins remain in their
original locations.
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Paragraphs and 3D Space
Text can be modified when working in 3D space. As a camera rotates, the onscreen text
entry controls rotate with the text. Although the controls (the ruler, text entry field, and
scroll control) may appear to change in scale, this is only a perspective shift caused by
the movement of the camera.

Adding Text with the Text Editor
Once you have added a blank text layer to your project (clicked the Text tool in the
Canvas), you can enter and edit text in the Text editor rather than the Canvas. The Text
editor is useful when working with large amounts of text.

To enter text in the Text editor
1 Click the Text tool (or press T), then click or drag in the Canvas to create a blank text layer.

• If you click in the Canvas, you activate the default layout method (Type), which requires
that you insert manual line breaks (by pressing Return) to make text wrap to a new
line.

• If you drag in the Canvas, you activate the Paragraph layout method, which automatically
wraps text into a column.

2 In the Text Inspector, open the Format pane.
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3 Click in the Text editor and begin typing.

Text editor

You can also edit existing text in the Text editor and use the Mac OS X spelling checker.

To edit existing text using the Text editor
1 In the Layers tab, select the text to be edited.

Note: You can also select the Text tool (in the Toolbar) and click the text you want to edit
in the Canvas

The selected text appears in the Text editor.

2 Make your changes in the Text editor.

Changes are immediately reflected in the Canvas.

To use the spelling checker in the Text editor
Do one of the following:

µ Click in the Text editor, then choose an option from the Edit > Spelling submenu.

µ Control-click in the Text editor, then choose an item from the shortcut menu.

When a spelling error is found, the text is highlighted in the Text editor. If the Text tool
is active when the spelling is checked, the text is selected in the Canvas.
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Note: The spelling checker is not available when working with text in the Canvas.

Adding a Text File to a Project
Plain text (TXT) or Rich Text Format (RTF) files can be added to your project. Once the
text is added to your project, it can be edited in the same manner as text created within
the project. The appearance (font, size, layout, and so on) of the text imported from an
RTF file is preserved; the text appearance in a TXT file is based on the settings in the Text
Inspector.

Important: Text behaviors such as Tracking, Type On, and the sequence behaviors can
be added to text from an imported a text file. Keep in mind, however, that the more text
characters a behavior must animate, the more performance slows.

Note: Some formatting options available in RTF files, such as text wrapping, are not
supported in Motion.

To add a text file to a project from the File Browser
1 In the File Browser, select the TXT or RTF file you want to use.

2 Do one of the following:

• Drag the file to the Canvas, Layers tab, or Timeline layers list.

• Click the Import button in the Preview area of the File Browser.

The text is added to the project and can now be modified.

To add a text file to a project using the Import command
1 Choose File > Import.

2 In the Import Files dialog, select the TXT or RTF file you want to import, then click Import.

The text is added to the project and can now be modified.

About Plain Text Files
When a plain text file is added to a project, the following occurs:

• The text is formatted based on the settings in the Text Inspector.

• The Layout Method (in the Layout tab of the Text Inspector) is set to Paragraph.

Note: To change the layout of the text, choose another option from the Layout Method
pop-up menu. The ruler and scroll controls are available with the Paragraph and Scroll
layouts. The scroll control is available with the Crawl layout.

• The paragraph margins are set to the Safe Zones (press the apostrophe key) of the
project.
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About Rich Text Format Files
When a Rich Text Format (RTF) file is added to a project, the following occurs:

• The formatting (font, style, line spacing, outline [set in the Styles pop-up menu in the
TextEdit document], and so on) of the text is preserved in the project.

• Double-clicking in the text in the Canvas activates the text entry field, which includes
a horizontal ruler at the top of the text and a scroll control at the right of the text.

• The Layout Method (in the Layout tab of the Text Inspector) is set to Paragraph.

• Margins in the original text file are preserved in the project. The size of the onscreen
text entry field is determined by the margins set in the application in which the text
was created. In Motion, the margins can be edited onscreen or in the Layout pane of
the Text Inspector.

For more information on modifying margins, see Editing Margins and Tabs from Rich
Text Format Files.

For more information on the Layout pane, see Editing Text Layout.

• Tabs in the original text file are preserved in the project. The tabs appear as white
triangles in the ruler above the text entry field. Tabs can be moved or deleted.

For more information on modifying tabs, see Editing Margins and Tabs from Rich Text
Format Files.

Editing Margins and Tabs from Rich Text Format Files
Margins and tabs defined in the application in which the RTF text was created can be
modified in Motion.

For more information about the general use of tabs, see Working with Tabs.

To adjust a margin
1 Double-click the text to display the onscreen text entry field, ruler, and scroll control.

Note: The Text tool must be selected. If you adjust the text box using the Select/Transform
tool, the text is scaled.

2 Do one of the following:

• With the Text tool selected, drag one of the scale handles on the text entry field.

• In the Layout pane of the Text Inspector, adjust the Left Margin, Right Margin, Top
Margin, or Bottom Margin values.

To move the tabs
1 Double-click the text to display the onscreen text entry field, ruler, and scroll control.

Note: The Text tool must be selected in order for the ruler and tabs to appear in the
Canvas.
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2 Do one of the following:

• In the Canvas, drag a tab (the small white triangle) in the ruler.

• In the Layout pane of the Text Inspector, use the Tabs controls to adjust the position
and layout of the tabs.

To remove a tab
1 Double-click in the text to display the onscreen text entry field, ruler, and scroll control.

Note: The Text tool must be selected in order for the ruler and tabs to appear in the
Canvas.

2 Drag the tab (the small white triangle) off the ruler and release the mouse button.

The tab is removed from the ruler with a “poof,” and removed from the Tabs controls in
the Layout pane of the Text Inspector with less fanfare.

Copying and Pasting Text from Another Application
Text can be copied from another document or browser and pasted into a project.

Use the following guidelines when pasting text from another application into Motion:

• Pasted RTF text retains the original font attributes, including family and typeface, size,
color, outline, and drop shadow.

• When pasted, pure black text is converted to white text.

• White text copied from Motion is pasted to the clipboard as black text.

• Text pasted into an empty text entry field retains the paragraph format, including
alignment, justification, and tabs.

• Text pasted into an existing text entry field does not retain its original paragraph format.

• Paragraphs pasted into a text entry field retain the paragraph format, including
alignment, justification, and tabs.

Note: Keep in mind that a paragraph is defined as a block of text preceded by a carriage
return. Text pasted into an existing text entry field does not retain its original paragraph
format, but a paragraph pasted into a text entry field does retain its original paragraph
format.

• If an image is copied with the text, the image is not included when the text is pasted
in Motion.

• Dynamically numbered lists are not supported. Lists become standard text when pasted.

To copy and paste text into a project
1 In the document (RTF, TXT, Pages, and so on), copy the text.

2 Do one of the following:

• In the Motion Toolbar, select the Text tool, click in the Canvas, and choose Edit > Paste
(or press Command-V).
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• In the Format pane of the Text Inspector, click in the text editor and choose Edit > Paste
(or press Command-V).

Text as a Layer
Once created, text becomes a layer in your project. Because text layers share most of the
characteristics of other layers in Motion, you can use the transform
tools—Select/Transform, Adjust Anchor Point, Adjust Shear, Adjust Drop Shadow, Adjust
Four Corner, and Adjust Crop—to transform a selected text layer when the Flatten
checkbox is selected in the Layout pane of the Text Inspector. These onscreen tools are
shortcuts to the Transform controls in the Properties tab of the Inspector. To set specific
values, or fine-tune any of the transforms, use the Properties tab in the Inspector.

Important: Many of the transform tools are unavailable for text transforms until you select
the Flatten checkbox in the Text tab. Similarly, before you can apply a mask to text, you
must select the Flatten checkbox in the Text tab.

For more information on the Properties tab and onscreen transform tools, see Parameters
in the Properties Tab. For more information on the Flatten checkbox, see Non-Path Text
Controls in the Layout Pane.

Important: Some operations, as well the application of certain filters or a mask, cause a
group to become rasterized. When a group is rasterized, it is converted into a bitmap
image. Because all text layers live in groups, rasterization affects how text interacts with
other objects within your project. For more information, see About Rasterization.

When you make changes to text using the transform tools or the parameters in the
Properties tab of the Inspector, modifications are applied to the text as a layer, not as
editable text. The controls for editing the text itself are located in the Text tab of the
Inspector. Although some layer properties are similar to some text Style and Format
controls, such as Shear (in the Properties tab) and Slant (in the Format pane of the Text
tab), the layer properties are independent of the text format controls, and vice versa. For
example, if you apply a Slant value of 20 in the Format pane of the Text Inspector, a Slant
value of 20 is applied to each character in the word, simulating italics. If you apply a Shear
value of 20 in the Properties tab of the Inspector (or using the onscreen controls), a Shear
value of 20 is applied to the layer as a whole, not the individual text characters.

For information on transforming text using the onscreen transform tools, see Using the
Text Tools. For general information on using the onscreen controls, see 2D Transform
Tools.

In addition to moving text with the transform tools, you can move text up and down in
the composite in the Layers tab and Timeline. Just like all other layers in Motion, text can
also be copied, pasted, duplicated, and deleted. For more information, see Managing
Layers in Your Project.
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Using the Text Tools
As previously mentioned, text becomes a text layer when created. There are two ways
to edit a text layer:

• As with any other layer in Motion, you can edit text using the parameters in the
Properties tab in the Inspector, or by using the onscreen controls.

• You can edit the text characters using the Text parameters in the Text tab of the
Inspector or in the HUD.

The following interface tools are used to edit text in Motion:

• Toolbar

• Text HUDs

• Text Inspector

This section discusses using the Text tool (in the Toolbar) and the Text editor (in the
Format pane of the Text Inspector) to create and modify text.

Note: When text is selected with the default selection tool, you can use the standard
onscreen controls to move and animate the text in the Canvas.

Text Tool and the Toolbar
The Text tool is located in the Toolbar above the Canvas in the Create tool set.

Note: To customize the Toolbar layout, Control-click in the Toolbar area, then choose
Customize Toolbar from the shortcut menu. For more information on the tools and the
Toolbar, see Toolbar.

• Text tool: Use this tool to create text. Click the Text tool, then click or drag in the Canvas
to create a blank text layer.

Text tool

• If you click in the Canvas, you activate the default layout method (Type), which
requires that you insert manual line breaks (by pressing Return) to make text wrap
to a new line.

• If you drag in the Canvas, you activate the Paragraph layout method, which
automatically wraps text into a column.

• Select/Transform tool: Use this tool to select and transform text. Once text is created,
click the Select/Transform tool (or press Esc) to select the text. To select existing text,
click the Select/Transform tool, then click the text.
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Note: When the Select/Transform tool is selected, you can double-click the text to
automatically enter text-editing mode. When Motion is in text-editing mode, the Text
tool is highlighted in the Toolbar.

• Adjust Glyph tool: Use this tool to select and transform glyphs (individual characters of
text objects). Once text is created, click the Select/Transform tool, hold the mouse
button down, and select the Adjust Glyph tool from the pop-up menu.

For more information on editing text glyphs, see Working with Text Glyphs.

About Fonts
Motion uses all supported fonts installed on your Mac OS X system. Mac OS X-supported
fonts include OpenType, Type1 (or PostScript), and TrueType. All supported fonts installed
on your system appear in the Library, as well as in the Format pane of the Text Inspector.
This includes fonts located in the following folders on your computer:

• /Library/Fonts/

• /Users/username/Library/Fonts/

For information on installing fonts, see your system documentation. If you installed
LiveFonts from the install DVDs when you installed Motion, the LiveFonts are available
in Motion. For more information on LiveFonts, see Using LiveFonts.

You can preview and apply the available fonts in the Library or in the Format pane of the
Text Inspector.

Using the Library Font Preview
The Motion Library includes a Fonts category and Preview area to browse fonts or change
existing text.

For information on previewing and changing fonts in the Text Inspector, see Editing Text
Format.
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Previewing Fonts
When you select a font in the Fonts category of the Library, a preview of the font is
displayed in the Preview area of the Library.

To preview a font in the Library
1 In the Library, click the Fonts category.

2 Click the font subcategory you want to preview.

Note: The first subcategory, All Fonts, contains all fonts from the other subcategories.

If you are in list view, the font list appears in the stack. If you are in icon view, the font
thumbnails appear in the stack. In the images on the following pages, icon view is selected.

Icon view

List view

3 In the stack, click a font thumbnail or name.

The font is displayed in the Preview area, along with the font name and type.

Preview area

Font subcategory

Stack
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Changing Fonts
There are two ways to use the Library to change the font of text in the Canvas. The first
method is to drag a font to the text object in the Canvas. The second method is to select
a text object in the Canvas, Layers tab, or Timeline, select a typeface in the Library, then
click the Apply button in the Preview area.

To change the font by dragging a new font to the Canvas
1 In the Library, click the Fonts category and then the font subcategory.

2 Drag a font from the stack onto the text in the Canvas.

As you drag the font over the text, a transparent thumbnail of the font appears and the
pointer becomes a green add pointer (+). When you release the mouse button, the text
is changed to the selected font.

To change the font using the Apply button
1 In the Canvas, Layers tab, or Timeline, select the text to which you want to apply a new

font.

2 In the Library, click the Fonts category and then the font subcategory.

3 In the stack, click a font.
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4 In the Preview area, click Apply.

Apply button

The text is changed to the selected font.

Navigating the Font List
To quickly locate a font by its name in the font stack, you can type the first few letters of
the font name.

To select a font by typing the first few letters of its name
1 Click any font name or thumbnail in the font stack.

2 Quickly type the first two letters of the font name.

Note: If you do not type the second letter of the font name quickly, the selection is reset
and jumps to the font whose name begins with the second letter entered.

To move through the browser fonts in alphabetical order
µ Drag the scroll bar on the right side of the stack up or down to move through the fonts.

Editing Text in the Inspector
All text controls are located in the Text tab of the Inspector.

To display the Inspector
1 Select the text.

2 Do one of the following:

• Choose Window > Inspector.

• Click the “i” button on the HUD.

• Press Command-3.
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The Text tab is divided into three panes: Format, Style, and Layout. The Format pane
contains text basics, such as font, size, and tracking. Text characteristics such as face,
outline, and blur are controlled in the Style pane. The Layout pane contains text layout
controls, such as margins, justification and text on a path.

Click to show the
Format pane.

Click to show the
Style pane.

Click to show the
Layout pane.

As with all parameters in Motion, if the parameter can be animated, the Animation menu
icon appears next to the parameter in the Inspector.

Animation menu icon

To reset a parameter to its default settings (including removing keyframes), click the
Animation menu icon, then choose Reset Parameter from the pop-up menu.
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To reset a group of parameters, such as the text Face controls or the Sequence controls
of a text behavior, click the reset button in the Inspector. To reset a single parameter
within a group, click the Animation menu, then choose Reset Parameter.

Reset button

Editing Text With Applied Sequence Behaviors
Text Sequence behaviors automatically create animations that sequence text style and
text format attributes through the text characters. The style attributes include face (fill
color), glow, drop shadow and outline. The format attributes include position, opacity,
scale, rotation, tracking, and so on. Although the Text Sequence behaviors are all
presets—the parameters are already selected and animated—you can still add, remove,
or modify any parameter that is available to the Sequence Text behavior.

All of the text behaviors in the Text Sequence behaviors category were created using the
default text glow, outline, and drop shadow attributes. For example, for a sequence
behavior that incorporates a text glow, the glow color is the default yellow. For a sequence
behavior that incorporates a text outline, the outline color is the default red. The controls
to change these defaults are located in the Format tab of the Text Inspector.

Additionally, the text sequence behaviors are based on left-aligned text. Unless you have
defined the text as center aligned, the characters may animate from the left when certain
sequence behaviors are applied. To animate the text from its center, change the alignment
in the text HUD or in the Layout pane of the Text Inspector.

Use the following guidelines to modify text attributes when text sequence behaviors are
applied.

To change the default glow color (yellow)
1 Select the text and open the Style pane of the Text Inspector.

2 In the Glow controls, use the Color well to modify the glow color.

For more information on the glow controls, see Editing Text Glow. For more information
on using color wells, see Color Well.

To change the default outline color (red)
1 Select the text and open the Style pane of the Text Inspector.

2 In the Outline controls, use the Color well to modify the outline color.
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For more information on the outline controls, see Editing Text Outlines. For more
information on using color wells, see Color Well.

To change the default text alignment (left)
µ Select the text, then do one of the following:

• In the Layout pane of the Text Inspector, choose an option from the Alignment pop-up
menu.

• In the text HUD choose an option from the Alignment pop-up menu.

For more information on text layout, see Editing Text Layout.

Editing Text Format
The Text Format pane contains the controls for text basics such as font, typeface, size,
kerning, and character rotation. Many of the Format parameters can be animated
(keyframed).

For information on the controls in the Text Format pane, see Text Controls in the Format
Pane.

For information on performing tasks using the Text Format controls, see Text
Format-Related Tasks.
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To show the Text Format pane
µ In the Inspector, click the Text tab, then click the Format button.

Text Controls in the Format Pane
This section describes the parameters in the Format pane of the Text Inspector. Of the
following Format parameters, Family, Typeface, Size, and Tracking also appear in the Text
HUD.

Font Type: Sets the set of fonts displayed in the Collections and Family lists below. System
Fonts is the default; you can also choose LiveFonts.

Browse: Click the Browse button to display the Mac OS X Font window.

Collection: Displays the available font collections based on what is selected in the Font
Type parameter.
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Family: Sets the font (the set of characters, letters, and symbols of a single font) for the
text.

Typeface: Sets the type style, such as Bold, Condensed, and so on. The available typefaces
are specific to the selected font family.

Size: Determines the size of the text. You can enter a value in the value field or use the
slider. To change the font size, drag the Size slider left or right. The value of the Size in
the HUD and the Inspector is limited to 288 points. To create larger text, type a value in
the Size value field.

Size value field

Note: You can also scale the text in the Canvas using the onscreen controls, but doing
so scales the text as a layer and is independent of setting type point size via the Format
controls.

Tracking: Determines the spacing between the text characters. Tracking applies a uniform
value between each character.

Kerning: Adjusts the spacing between individual characters of text.

Baseline: Adjusts the baseline of text characters. The baseline is a horizontal “line” to
which the bottom of the characters is aligned.

Slant: Simulates italics by adding a slant value to the text characters.

Scale: Scales the text characters either proportionately in X space or Y space. To scale in
only X or only Y, click the disclosure triangle to enter separate X and Y scale values. In the
following image, the text X Scale is set to 50%, and the Y Scale is set to 100%.

Scale parameter 
disclosure triangle
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Affects Layout: This checkbox determines how the layout of the text on its path is affected
by changes in scale. For example, when Affects Layout is deselected and text is on an
open spline path (and Wrap Around is deselected in the Layout pane), increases in scale
bunch up the text characters along the length of the path and decreases in scale spread
the characters out over the length of the path. When Affects Layout is selected, increases
in scale extend the text characters beyond the path; decreases in scale bunch up the
characters toward their set alignment (left, right, or center).

Text on a path prior to scaling Affects Layout checkbox off Affect Layout checkbox on

Offset: Offsets the text from its original position (anchor point). Enter a value in the left
value slider to offset the text in X space; enter a value in the right value slider to offset
the text in Y space. Click the disclosure triangle to access the X, Y, and Z position values.

Rotation: Drag the dial or enter a value in the value slider to rotate the text characters
in Z space. Click the disclosure triangle to access separate X, Y, and Z rotation controls
and also the Animate pop-up menu.

• Animate: Available when the Rotation parameter is disclosed, this pop-up menu allows
you to change the interpolation for animated 3D rotation channels. By default, this
parameter is set to Use Rotation.

For more information about the Animate parameter, see Parameters in the Properties
Tab.

Note: The Rotation parameter must be keyframed for the Animate parameter options
to have any effect.

• Use Rotation: The default interpolation method, whereby text characters rotate from
their start rotation to their final rotation. Depending on the animation, the characters
may twist this way and that before reaching their final orientation (the last keyframed
value). For example, if the X, Y, and Z Rotation parameters are animated from
0 degrees to 180 degrees in a project, the text characters rotate on all axes before
reaching their final orientation.

• Use Orientation: This interpolation method provides for smoother interpolation but
does not allows multiple revolutions. This method interpolates between the text
characters’ start orientation (first keyframe) to their end orientation (second keyframe).
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Monospace: When enabled, this checkbox applies a fixed amount of space between
each text character.

All Caps: This checkbox sets all text characters to uppercase.

All Caps Size: When the All Caps checkbox is selected, this slider sets the size of the
uppercase characters based on a percentage of the font point size.

Text: Type directly in Text editor (the darker shaded area) to add and edit text in the
Inspector. For more information, see Adding Text with the Text Editor.

Publish To FCP: When using a Motion project as a template in Final Cut Pro, select this
checkbox to allow editing of certain text parameters from within Final Cut Pro. The editable
parameters include the following:

• Text string (text characters can be modified)

• Text size

• Text tracking

Text Format-Related Tasks
These tasks are useful when editing text Format parameters, including changing fonts,
moving the text insertion point, and adjusting kerning.

For information on the controls in the Text Format pane, see Text Controls in the Format
Pane.

To preview different fonts for text in the Canvas
1 Select the text.

2 In the Format pane of the Text Inspector, click the Family list arrow.
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The font family list appears.

Font Family list arrow

3 Drag the pointer in the font list up or down to preview fonts.

As you drag through the font family list, the text changes in the Canvas to the currently
selected font.

4 Once you have chosen a font, release the mouse button.

Note: You can also use the scroll bar , the wheel of a three-button mouse, or a two-finger
swipe on a Multi-Touch trackpad to move up and down the font list.

To move the text insertion point
µ Use the Right Arrow and Left Arrow keys to move the insertion point between adjacent

characters.

µ To jump to the beginning of a text line, press Command-Left Arrow.

µ To jump to the end of a text line, press Command-Right Arrow.

µ To jump to the beginning of the word, press Option-Left Arrow.

µ To jump to the end of the word, press Option-Right Arrow.

µ To move the insertion point through multiple lines of text (of a single text layer), use the
Up Arrow and Down Arrow keys.

To kern individual text characters
1 Click the Text tool (or press T).
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2 In the Canvas, position the insertion point (click the mouse button) in between the
characters you want to kern, and do one of the following:

• Use the Kerning slider or value field to set a specific kerning value.

• Press Control-Right Arrow to increase the space between the characters by one-pixel
increments.

• Press Control-Left Arrow to reduce the space between the characters by one-pixel
increments.

Editing Text Style
Use the Text Style pane to specify the text fill and to adjust its opacity and softness. Text
can be a solid color, an image, or a color gradient. You can also apply outlines and glows,
and apply drop shadows to text in the Style pane. Most of the style parameters can be
animated.

A set of pre-made text styles is available in the Motion Library. Text styles are modified
Style parameters that create a specific “look” for text, such as a red glow and gradient,
and are applied to text just like behaviors and filters. You can create custom text styles
and save the styles in the Library. For more information, see Using and Creating Preset
Text Styles.

There are four main groups of controls in the Style pane: Face, Outline, Glow, and Drop
Shadow. You can enable or disable all of the styles on a single text layer. By default,
Outline, Glow, and Drop Shadow are disabled.

For information on the Face controls, see Text Face Controls in the Style Pane. For
information on performing tasks using the Face controls, see Text Face-Related Tasks.

For information on the Outline controls, see Text Outline Controls in the Style Pane. For
information on performing tasks using the Outline controls, see Text Outline-Related
Tasks.
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For information on the Glow controls, see Text Glow Controls in the Style Pane. For
information on performing tasks using the Glow controls, see Text Glow-Related Tasks.

For information on the Drop Shadow controls, see Text Drop Shadow Controls in the
Style Pane. For information on performing tasks using the Drop Shadow controls, see
Text Drop Shadow-Related Tasks.

To show the Text Style pane
µ In the Inspector, click the Text tab, then click the Style button.

Text Controls in the Style Pane
This section describes the parameters in the Style pane of the Text Inspector, which
include the Face, Outline, Glow, Drop Shadow groups. Of the following Style parameters,
the Opacity and Color (in the Face controls) also appear in the Text HUD.

Text Face Controls in the Style Pane
Use the text Face controls to specify whether the text is a solid color, a color gradient, or
a texture. The following section describes the Face parameters. Nearly all of the Face
parameters can be animated.

Note: You can warp the fill of text independently of its other style parameters. For more
information, see Adjusting Glyph Attributes.

Style Preset: Allows you to save the format, style, or format and style of the selected text
to the Library, or to apply a preset text style from the Library to the selected text.

For more information on applying and saving text styles, see Using and Creating Preset
Text Styles.

Face: Enables and disables the text face parameters (Fill, Color, Opacity, Blur, and Four
Corner). Face is enabled by default.

Fill with: Click the “Fill with” pop-up menu to set the text fill to Color, Gradient, or Texture.

Color/Gradient/Texture: Sets the text fill color, gradient, or texture, depending on which
item is selected in the “Fill With” pop-up menu. Click the disclosure triangle to adjust
additional parameters.
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Note: When a LiveFont is applied to text, an additional Color Mix parameter is available
in the Color controls. For more information, see Using LiveFonts.

For information on editing text color, see Changing the Text Color. For more information
on applying a gradient to text, see Applying a Gradient to Text. For more information on
using textures, see Text Texture-Related Tasks.

Opacity: Sets the text opacity, regardless of the selected fill option (Color, Gradient, or
Texture).

For more information on changing text opacity, see Changing Text Opacity.

Blur: Sets the softness of the text, regardless of the selected fill option.

Four Corner: Controls the position of the face attribute. This allows for fun warping of
the text characters. In the following illustration, the Four Corner parameter in the Face
controls has been modified (the Four Corner parameter for the red outline has not been
modified). Click the disclosure triangle to reveal the following controls:

• Bottom Left: Offsets the text fill from the lower left of its original position. Enter a value
in the left value slider to offset the text fill in X space; enter a value in the right value
slider to offset the text fill in Y space. Click the disclosure triangle to access the X and
Y position values.

• Bottom Right: Offsets the text fill from the lower right of its original position. Enter a
value in the left value slider to offset the text fill in X space; enter a value in the right
value slider to offset the text fill in Y space. Click the disclosure triangle to access the
X and Y position values.

• Top Right: Offsets the text fill from the upper right of its original position. Enter a value
in the left value slider to offset the text fill in X space; enter a value in the right value
slider to offset the text fill in Y space. Click the disclosure triangle to access the X and
Y position values.

• Top Left: Offsets the text fill from the upper left of its original position. Enter a value in
the left value slider to offset the text fill in X space; enter a value in the right value slider
to offset the text fill in Y space. Click the disclosure triangle to access the X and Y position
values.

783Chapter 13 Creating and Editing Text



Texture Subparameters in the Style Pane
You can use an image, movie, shape, layer, or group as the fill for text. You do this with
the Texture option in the Face controls of the Style pane.

For information on using the Texture controls, see Text Texture-Related Tasks.

The texture parameters respect any filters applied to the source image, but not any
transforms applied to the image. For example, if the image used as the source texture
has a glow filter applied, the glow appears in the text’s texture. If the image used as the
source texture has been scaled, moved, or contains applied behaviors, the result of the
transforms does not appear in the applied texture.

The Texture controls allow you to adjust additional subparameters. If you are using an
image sequence or movie as the text’s texture source, you can specify the start frame for
the texture, or choose to hold a single frame for the texture. You can also adjust the
position of a texture that is applied to text so that it is offset in the text, but not
repositioned in your project. If an image used as a texture is cut off, you can specify the
edge behavior of the texture.

Use the slider or value 
slider to set a start frame.

Drag or enter numbers in 
the value sliders to 
reposition the source 
texture.

Click to lock texture 
source to the frame set in 
the Frame parameter.

Choose a wrap mode 
from this pop-up menu.
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Image: Drag the image you want to use as the source texture into the image well.

Frame: When using a movie or an image sequence as the texture source, use the slider
or value sliders to specify the start frame for the texture.

Hold Frame: When using a movie or an image sequence as the texture source, select the
Hold Frame checkbox to freeze the frame specified in the Frame parameter. The selected
frame is used as the texture for the text layer’s total duration.

Offset: Drag or enter a number in the Offset value sliders to specify the X and Y values
of the position of the source texture (relative to the text layer).

Wrap Mode: Use the Wrap Mode pop-up menu to specify how the edge of a texture is
treated when the texture is offset and appears cut off in the text or is too small to fill the
text to which it is applied. There are three options:

• None: As the default wrap mode, the texture remains transparent beyond the edge of
the source image.

• Repeat: Similar to tiling behavior, the texture source is repeated beyond the edge of
the source image.

• Mirror: Beyond the edge of the source image, the texture source is reflected like in a
mirror-duplicated, tiled, and alternately reversed to encompass the full width and height
of the text.

Text Outline Controls in the Style Pane
Use the Outline controls in the Style pane to create text outlines. You can change the fill
of the outline, as well as its opacity, softness, width, and layer order. With the exception
of Layer Order, all of the Outline parameters can be animated.

Note: You can warp the outline of text independently of its other style parameters. For
more information, see Adjusting Glyph Attributes.

Outline: A checkbox that enables and disables the outline of the text. Outline is disabled
by default.

Fill with: Choose an item from the “Fill with” pop-up menu to set the fill for the outline.
As with the Face controls, you can set the outline fill to Color, Gradient, or Texture.
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Color/Gradient/Texture: Sets the text outline color, gradient, or texture, depending on
which item is selected in the “Fill with” pop-up menu. Click the disclosure triangle to
adjust additional parameters.

Opacity: Sets the opacity of the text outline.

Blur: Sets the softness of the text outline.

Width: Sets the thickness of the outline.

Layer Order: Specifies whether the outline is drawn over or under the text face.

Four Corner: Controls the position of the outline attribute. This allows for outline warping
effects. Click the disclosure triangle to reveal the following controls:

• Bottom Left: Offsets the text outline from the lower left of its original position. Enter a
value in the left value slider to offset the text fill in X space; enter a value in the right
value slider to offset the text fill in Y space. Click the disclosure triangle to access the
X and Y position values.

• Bottom Right: Offsets the text outline from the lower right of its original position. Enter
a value in the left value slider to offset the text fill in X space; enter a value in the right
value slider to offset the text fill in Y space. Click the disclosure triangle to access the
X and Y position values.

• Top Right: Offsets the text outline from the upper right of its original position. Enter a
value in the left value slider to offset the text fill in X space; enter a value in the right
value slider to offset the text fill in Y space. Click the disclosure triangle to access the
X and Y position values.

• Top Left: Offsets the text outline from the upper left of its original position. Enter a
value in the left value slider to offset the text fill in X space; enter a value in the right
value slider to offset the text fill in Y space. Click the disclosure triangle to access the
X and Y position values.

Text Glow Controls in the Style Pane
Use the Glow controls to create a glow in front of or behind text. With the exception of
Layer Order, all of the Glow parameters can be animated.

When the Glow checkbox is selected, the text is rasterized. For more information, see
About Rasterization.
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Note: You can warp the glow of text independently of its other style parameters. For
more information, see Adjusting Glyph Attributes.

Glow: A checkbox that enables and disables the text glow effect. Glow is disabled by
default.

Fill with: Choose an item from the “Fill with” pop-up menu to set the fill for the glow. As
with the Face and Outline controls, you can set the glow fill to Color, Gradient, or Texture.

Color/Gradient/Texture: Sets the color, gradient, or texture of the glow effect. Click the
disclosure triangle to adjust additional parameters.

Opacity: Sets the opacity of the text glow.

Blur: Sets the softness of the text glow.

Radius: Sets the circumference of the glow.

Scale: Sets the size of the glow.

Offset: Offsets the glow in the X or Y position.

Layer Order: Specifies whether the glow is drawn over or under the text face.

Four Corner: Controls the position of the glow attribute. This allows for glow warping
effects. Click the disclosure triangle to reveal the following controls:

• Bottom Left: Offsets the text glow from the lower left of its original position. Enter a
value in the left value slider to offset the text fill in X space; enter a value in the right
value slider to offset the text fill in Y space. Click the disclosure triangle to access the
X and Y position values.

• Bottom Right: Offsets the text glow from the lower right of its original position. Enter
a value in the left value slider to offset the text fill in X space; enter a value in the right
value slider to offset the text fill in Y space. Click the disclosure triangle to access the
X and Y position values.

• Top Right: Offsets the text glow from the upper right of its original position. Enter a
value in the left value slider to offset the text fill in X space; enter a value in the right
value slider to offset the text fill in Y space. Click the disclosure triangle to access the
X and Y position values.
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• Top Left: Offsets the text glow from the upper left of its original position. Enter a value
in the left value slider to offset the text fill in X space; enter a value in the right value
slider to offset the text fill in Y space. Click the disclosure triangle to access the X and
Y position values.

Text Drop Shadow Controls in the Style Pane
Use the Drop Shadow controls to create a drop shadow on text, and to adjust the shadow
color, opacity, offset from the text layer, softness, and angle. All of the Drop Shadow
parameters can be animated.

Drop Shadow: A checkbox that enables and disables the drop shadow effect. Drop
Shadow is disabled by default.

Note: When the Flatten checkbox is selected in the Layout pane of the Text Inspector,
the Properties tab also contains controls to enable and disable a text layer’s drop shadow.
The Drop Shadow controls in the Properties tab of the Inspector are independent of the
controls in the Text Inspector. Enabling Drop Shadow in both locations adds to the existing
shadow.

Fill with: Choose an item from the “Fill with” pop-up menu to set the fill for the shadow.
As with the Face, Outline, and Glow controls, you can set the shadow fill to Color, Gradient,
or Texture.

Color/Gradient/Texture: Sets the color, gradient, or texture of the shadow. Click the
disclosure triangle to adjust additional parameters.

Opacity: Sets the opacity of the text shadow.

Blur: Sets the softness of the text shadow.

Scale: Sets the size of the shadow.

Distance: Specifies the offset of the text shadow.

Angle: Sets the angle (or direction) of the drop shadow.

Fixed Source: When this checkbox is selected, the drop shadow behaves as if it were
cast by a fixed light source, regardless of camera or text movement.

788 Chapter 13 Creating and Editing Text



Four Corner: Controls the position of the drop shadow attribute. This allows for outline
warping effects. Click the disclosure triangle to reveal the following controls:

• Bottom Left: Offsets the text drop shadow from the lower left of its original position.
Enter a value in the left value slider to offset the text fill in X space; enter a value in the
right value slider to offset the text fill in Y space. Click the disclosure triangle to access
the X and Y position values.

• Bottom Right: Offsets the text drop shadow from the lower right of its original position.
Enter a value in the left value slider to offset the text fill in X space; enter a value in the
right value slider to offset the text fill in Y space. Click the disclosure triangle to access
the X and Y position values.

• Top Right: Offsets the text drop shadow from the upper right of its original position.
Enter a value in the left value slider to offset the text fill in X space; enter a value in the
right value slider to offset the text fill in Y space. Click the disclosure triangle to access
the X and Y position values.

• Top Left: Offsets the text drop shadow from the upper left of its original position. Enter
a value in the left value slider to offset the text fill in X space; enter a value in the right
value slider to offset the text fill in Y space. Click the disclosure triangle to access the
X and Y position values.

Text Style-Related Tasks
These tasks are useful when editing text Style parameters, which include the Face, Outline,
Glow, and Drop Shadow groups.

Text Face-Related Tasks
These tasks are useful when editing text Face parameters, including glyph style attributes,
text color, working with text gradient and texture fills, and changing text opacity and
softness.

For information on using the Texture option in the Face controls, see Text Texture-Related
Tasks.

Changing a Style Attribute for a Single Text Character
The style attributes (face color, outline, glow, and drop shadow) for text characters (glyphs)
can be individually defined.

To change a style attribute of a glyph
1 Select the Text tool in the Toolbar, then drag in the Canvas to select the glyph(s) you

want to modify.

2 In the Style pane of the Text Inspector, modify the style attribute.

Only the selected text character is affected.
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Note: You can also modify the style attributes of a glyph with the Adjust Glyph tool. For
more information, see Working with Text Glyphs.

Changing the Text Color
You can change text color using the Colors window, the color well in the text HUD, or
the color well in the Style pane of the Text Inspector.

Note: To adjust the individual color channels, you must use the Style pane of the Text
Inspector.

To set the text color in the HUD
1 Select the text.

2 If the HUD is not displayed, press F7 (or D).

3 Click the color well, then use the Colors window to set the text color.

Note: There are many ways to choose a color using the Color parameter. For a complete
list, see step 4 in the next section, which describes choosing a color in the Inspector.

The text is dynamically updated as you select your color.

Note: To select a color from the Canvas (or anything on the desktop), click the color picker
in the Colors window, position the picker over the color you want to select, then click.

Color picker

To set the text color in the Inspector
1 Select the text.

2 In the Inspector, open the Style pane of the Text tab.

3 In the “Fill with” pop-up menu, ensure that Color is selected.
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4 Do one of the following:

• Click the color well, then use the Colors window to set the text color.

Color well

• Click the arrow button to the right of the color well (or Control-click the color well)
then click in the pop-up color palette to select a color. Drag in the lower palette to set
the color to a grayscale color.

Click here to select a 
grayscale color.

Displays original color.
Displays new color.

• Click the eyedropper tool to the right of the Color well, then click a color in the Canvas.

• In the Inspector, click the Color disclosure triangle to show the channel parameters,
and then use the sliders or value sliders to adjust each color channel.

Expanded disclosure 
triangle displaying color 
channels
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Applying a Gradient to Text
In the Inspector, you can apply a gradient fill to a text. The gradient can be customized
and animated using the Gradient editor.

Note: The text gradient controls are nearly equivalent to the gradient controls for shapes,
particles, and replicators, with a few parameter exceptions. For example, the text gradient
controls include a dial to specify the direction of a linear gradient. The shape gradient
controls include a start and end setting to specify the direction of a linear gradient. For
more information on working with gradients and shapes, see Using Shapes, Masks, and
Paint Strokes.

In addition to applying a preset text style from the Library, preset gradients from the
Library can also be applied to text. The gradient presets are located in the Gradients
category of the Library. A gradient that you apply to text can also be saved in the Library
for use in your current or future projects.

For more information on working with gradients, see Using the Gradient Editor.

To apply a text gradient
1 Select the text.

2 In the Inspector, open the Style pane of the Text tab.

3 Choose Gradient from the “Fill with” pop-up menu.

In the Inspector, the Color controls are replaced with the Gradient editor. The default
gradient is red and blue.

Set “Fill with” to Gradient.
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In the Canvas, the default gradient is applied to the selected text.

Applying a Preset Gradient to Text
There are two ways to apply a preset (or saved) gradient from the Library to text. The first
method is to use the Gradient preset pop-up menu in the Text Inspector. The second
method is to drag a gradient from the Library to text.

To apply a preset gradient in the Text Inspector
1 Make sure a gradient is applied to the text to which you want to apply a preset gradient.

2 In the Style pane, choose a preset from the Gradient preset pop-up menu.

Gradient preset pop-up 
menu

The selected gradient is applied to the text.
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To apply a preset gradient from the Library
1 In the Library, click the Gradients category.

2 In the stack, select a gradient.

A preview of the selected gradient appears in the Preview area.
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3 Do one of the following:

• Drag the gradient to the text in the Canvas, Layers tab, or Timeline.

• Make sure the text is selected, then click Apply in the Preview area.

After the preset gradient is applied to a text object, the preset can be edited with the
Gradient editor.

Changing Text Opacity
There are a few different ways to change the opacity of text:

• Because a text layer is like other layers in Motion, you can adjust its opacity in the
Properties tab. To change its opacity as a text layer, use the Opacity slider or value field
in the HUD or in the Properties tab of the Text Inspector to adjust the opacity of text.

• To change the opacity of individual Style pane parameters, such as Face, Glow, Drop
Shadow, or Outline, use the Opacity controls in the Style pane of the Text Inspector.

Note: The Opacity value in the Properties tab and the Opacity value in the Style pane
are separate controls. When both are adjusted for a text layer, the effect is multiplicative.
In other words, if Opacity is set to 50% in the Properties tab, then set to 50% in the
Text Style pane, the result opacity for the text is 25%.

Opacity parameter in 
Properties tab

To set the text opacity in the HUD
1 Select the text.

2 Press F7 (or D) to display the HUD.

3 Drag the Opacity slider.
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The text opacity is dynamically updated as you drag the slider, and the opacity of the
text as a layer is adjusted.

The Opacity parameter in the Properties tab of the Text Inspector is updated.

To set the opacity in the Properties tab of the Text Inspector
1 Select the text.

2 In the Inspector, click the Properties tab.

3 In the Blending controls, drag the Opacity slider or enter an opacity value in the field.

The Opacity parameter in the HUD is updated.

To set the opacity in the Style pane of the Text Inspector
1 Select the text.

2 In the Inspector, click the open the Style pane of the Text tab.

3 In the Face controls, drag the Opacity slider or enter an opacity value in the field.

Changing Text Softness
Use the Blur parameter in the Style pane of the Text Inspector to adjust the softness of
the text.

To adjust the softness in the Inspector
1 Select the text.

2 In the Inspector, open the Style pane of the Text tab.
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3 In the Face controls, drag the Blur slider, or enter a blur amount in the value slider.

Blur parameter

The text softness is dynamically updated as you drag the slider.

Resetting the Text Face Controls
You can reset the text to its original fill, opacity, and blur using the Inspector.

To reset the text face parameters
µ Click the reset button in the Face parameter row.

Reset button

Text Texture-Related Tasks
Use the Texture controls in the Style pane to apply and edit texture effects.

Using the Texture Image Well
Use the Texture image well to apply, replace, and remove textures.

To apply a texture to text
1 Select the text.

2 In the Inspector, open the Style pane of the Text Inspector.

3 Choose Texture from the “Fill with” pop-up menu.

The Color (or Gradient) controls are replaced with the Texture controls.
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4 Click the Texture disclosure triangle.

Image well

By default, no texture is applied to the text.

5 In the Layers tab or Media tab (of the Project pane), drag the image you want to use for
the texture to the Image well.

The image appears in the well and is applied to the text. When text is filled with an image,
the texture is applied to each text character. To learn how to make the texture continuous
through all text characters, see Applying a Continuous Texture to a Text Layer.

Important: When selecting an image to put into the Image well, be sure to click and drag
in one movement. If you click the image and release the mouse button, the image is
selected and its Inspector appears.

To replace a texture
1 Select the text and display the expanded Texture controls in the Style pane.
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2 In the Layers tab or Media tab, drag the image you want to use to replace the existing
texture to the Image well.

The new image appears in the well and is applied to the text.

Note: When an image (or a movie clip) is replaced in the Layers tab or Media tab, and
that image is used as a texture source, the texture for the text is replaced with the new
image.

To remove a texture
Do one of the following:

µ Click the Texture parameter reset button.

Reset button

µ Drag the image out of the well, then release the mouse button. The image disappears
with a “poof.”

Changing the Position of a Texture
You can adjust the position of a texture to fit the needs of your project.
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To change the position of a texture
µ In the Texture controls, do one of the following:

• Press Command, then drag in the Image well.

The image moves in the well and is offset in the text in the Canvas.

• Adjust the Offset values. The left value slider represents the X position values; the right
value slider represents the Y position values. Click the disclosure triangle to display the
labeled X and Y value sliders.

Note: You can adjust the position of a texture for a single glyph by selecting the glyph
with the Text tool or by using the Adjust Glyph tool. For more information on working
with glyphs, see Working with Text Glyphs.

Animating a Texture
You can set keyframes for the offset values of the texture source to create a moving
element within text. In the following example, an image of a leopard lying in the grass
is used as the texture source for the text “leopard.”

Original text layer prior to texture Image used as texture source

To animate the texture offset
1 Apply a texture to the text.

For instructions on how to apply a texture to text, see Using the Texture Image Well.

2 Move the playhead to the frame where you want the texture animation to begin.

3 Enable Record (press A).

Record button
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Note: Keep in mind that when Record is enabled, a keyframe is created for any change
you make to an object in your project.

4 To position the texture, do one of the following:

• Press Command, then drag in the Image well.

• Use the Offset value sliders to enter an offset value.

The image within the text moves, and a keyframe is created in the Offset parameters.

Text layer with texture applied

5 Move the playhead to the next frame where you want to set a keyframe.

6 Move the texture to the new position.

Repositioned text layer texture
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7 Go to frame 1 (or the start frame of your animation) and play the clip.

The texture offset is animated.

8 Disable Record.

Note: You can also use the Animation menu in the Inspector to manually set keyframes
without enabling Record. For more information, see Keyframes and Curves.

Using a Layer with Behaviors and Filters As a Texture Source
You can use a layer (image, movie, image sequence, shape, replicator, particle system,
group, or other text layer) that has applied behaviors and filters as a texture source for
text. The effect of the filters appears in the texture, but any animation effects do not
appear in the texture.

When using a layer with an applied filter as a texture source:

• To use the layer with the effect of the filter, use the steps in Using the Texture Image
Well.

• If the layer is an image or image sequence, you can use the layer without the effect
of the filters by dragging the image from the Media tab to the Texture Image well,
rather than from the Layers tab.

• To use a layer without the effect of the applied filter, make a copy of the layer in the
Layers tab, remove the filters from the layer, then turn the layer off. You can then
drag the layer from the Layers tab to the Image well.

When using a layer with an applied behavior or active transforms (for example, rotate)
as a texture source:

• Use the steps in Using the Texture Image Well. The effects of the behavior or transforms
are ignored.

Applying a Continuous Texture to a Text Layer
When you apply an image (or any layer) as the texture for text, the texture is applied to
each text character. To use the image as a continuous texture throughout the text, use
the text as a mask.

802 Chapter 13 Creating and Editing Text



To use text to mask an image
1 In the Layers tab or Canvas, select the layer you want to use as the texture.

2 Choose Object > Add Image Mask (or press Command-Shift-M).

A blank image mask layer is added to the image.

3 Drag the text that you want to use as a mask to one of the following:

• The Mask Source well in the Image Mask HUD

• The Image Mask layer in the Layers tab

• The Image well in the Image Mask tab of the Inspector
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The text masks the image.

For more information, see Using Shapes, Masks, and Paint Strokes.

Text Outline-Related Tasks
These tasks are useful when editing text Outline parameters, including outline color,
softness, opacity, and layer order.

Adding a Text Outline
To create a text outline, select the Outline checkbox in the Style pane of the Text Inspector.

To create an outline for text
1 Select the text.

2 In the Inspector, open the Style pane of the Text tab.

3 In the Outline controls, select the Outline checkbox.

The default outline color is red, with a width of one point.

Note: Turn off the Face checkbox to display a text outline with no fill.

Editing Text Outlines
Use the Outline controls to soften the opacity or blur of a text outline, change the width
of an outline, or to set and edit the fill of an outline.

For more information about adjusting text outlines using onscreen controls, see Working
with Text Glyphs.
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Note: The Outline fill controls—Color, Gradient, and Texture—are equivalent to the
controls for the Face parameters. For information on using these controls, see Text Face
Controls in the Style Pane.

To change the color of a text outline
µ Click the color well, then select a color from the Colors window.

To adjust the opacity of a text outline
µ Use the Opacity slider or value field to change the opacity of the outline.

To adjust the blur of a text outline
µ Use the Blur slider or value slider to change the blur of the outline.

To change the width of a text outline
µ Use the Width slider or value slider to change the width of the outline.

To set the layer order of a text outline
µ Make a choice from the Layer Order pop-up menu:

• Choose Under Face to place the outline behind the text face.

• Choose Over Face to place the outline in front of the text face.

To reset the text outline parameters
µ Click the reset button in the Outline parameter row.

Text Glow-Related Tasks
These tasks are useful when editing text Glow parameters, including glow color, softness,
opacity, radius, scale, and position.

Adding a Text Glow
To create a text glow, select the Glow checkbox in the Style pane of the Text Inspector.

To create a glow for text
1 Select the text.

2 In the Inspector, open the Style pane of the Text tab.

3 Select the Glow checkbox.

The default glow is yellow, with Scale and Opacity set to 100%, and Radius set to 1.
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Note: You can display just the text glow by deselecting the Face parameter checkbox
(and any other active parameters).

Editing Text Glow
Use the Glow controls to soften the opacity or blur of the text glow, to change the size
of the glow, or to set and edit the fill of a glow.

For more information about adjusting text glows using onscreen controls, see Working
with Text Glyphs.

Note: The Glow “Fill with” options—Color, Gradient, and Texture—are equivalent to the
controls for the Face parameters. For information on using these controls, see Text Face
Controls in the Style Pane.

To change the color of the glow
µ Click the color well and select a color from the Colors window.

To adjust the opacity of the glow
µ Use the Opacity slider or value slider to change the opacity of the glow.

To adjust the blur of the glow
µ Use the Blur slider or value slider to change the softness of the glow.

To adjust the radius of the glow
µ Use the Radius slider or value slider to adjust the radius of the glow.

To adjust the scale of the glow
µ Use the Scale slider or value slider to proportionally scale the glow. To scale in X or Y

dimensions individually, click the Scale disclosure triangle and adjust the X or Y slider.

To adjust the position of the glow
µ Use the Offset value sliders to change the position of the glow. The left value slider adjusts

the X axis, and the right value slider adjusts the Y axis. To display the individual X or Y
offset fields, click the Offset disclosure triangle.

To set the layer order of the glow
µ Choose an item from the Layer Order pop-up menu:

• Choose Under Face to place the glow behind the text face.

• Choose Over Face to place the glow in front of the text face.

To reset the text glow parameters
µ Click the reset button in the Glow parameter row.

Text Drop Shadow-Related Tasks
These tasks are useful when editing text Drop Shadow parameters, including shadow
color, softness, opacity, distance, and angle.
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Adding a Drop Shadow
To create a text drop shadow, select the Drop Shadow checkbox in the Style pane of the
Text Inspector.

To add a drop shadow
1 Select the text.

2 In the Inspector, open the Style pane in the Text tab.

3 In the Drop Shadow parameters, select the Drop Shadow checkbox.

The default black drop shadow is applied to the text.

Adjusting the Drop Shadow Parameters
Use the Drop Shadow controls to change the color or opacity of the shadow and to adjust
the softness of the shadow. You can also change the distance the shadow is offset from
the text, and adjust its angle.

For more information about adjusting text drop shadows using onscreen controls, see
Working with Text Glyphs.

Note: The Shadow “Fill with” options—Color, Gradient, and Texture—are equivalent to
the controls for the Face parameters. For information on using these controls, see Text
Face Controls in the Style Pane.

To adjust the color of the drop shadow
µ Click the color well and use the Colors window to set a new color.

To adjust the opacity of the drop shadow
µ In the Opacity parameter, drag the slider or use the value slider.

To adjust the softness of the drop shadow
µ Use the Blur slider or value slider to change the softness of the shadow.

To change the scale of the drop shadow
µ Use the Scale slider or value slider to proportionally scale the drop shadow. To scale in X

or Y dimensions individually, click the Scale disclosure triangle and adjust the X or Y slider.
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To change the distance of the shadow from the text
µ In the Distance parameter, drag the slider or use the value slider. The distance the shadow

is offset is represented in pixels.

To change the angle of the shadow from the text
µ Drag the Angle dial in a circular motion or use the value slider.

To reset the text drop shadow parameters
µ Click the reset button in the Drop Shadow parameter row.

Using and Creating Preset Text Styles
The Motion Library contains a set of preset text styles that you can easily apply to text in
your project. A text style is a group of Style parameters that have been modified and
saved in the Library. For example, the Tropical Waters text style includes a gradient fill
simulating the colors of a tropical lagoon and a sheer blue-colored glow that is set over
the text face, then scaled down and offset.

Tropical Waters text style applied to text layer

You can also customize and save your own text style or format (or both) in the Library.

Applying a Text Style
There are two ways to apply a text style to text. The first method is to select a style in the
Library. The advantage of using the Library to apply a text style is that you can preview
the style before it is applied to text. The second method is to apply the style in the Text
Inspector using the Style Preset pop-up menu. This section discusses both methods.

To apply a text style from the Library
1 In the Library, select the Text Styles category.
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2 Select a style from the stack.
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A preview of the style is displayed in the Preview area.

3 Do one of the following:

• Select the text to which you want to apply the style, then click the Apply button in the
Preview area.

• Drag the style from the stack to the text in the Canvas, Layers tab, or Timeline.

The text style is applied to the text.

To apply a text style from the Text Inspector
1 Select the text to which you want to apply a style.

2 In the Style pane of the Text Inspector, choose an item from the Style Preset pop-up
menu.

Style Preset pop-up 
menu

The text style is applied to the text.
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Resetting Text Style
Use the reset button in the Inspector to reset the text style controls to the default
parameter settings.

To reset all text style parameters
µ Click the reset button in the Style Preset parameter row.

Saving a Custom Text Style
Once you have modified parameters in the Style pane (such as Gradient or Glow) or
Format pane (such as Tracking or Slant), you can save the style that you have created to
the Text Styles category in the Library. These custom styles can then be used and applied
just like the preset styles.

Note: Any custom presets that you save to the Library are stored in
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Text Styles/.
The Motion Library is stored in two places on your computer: The read-only content that
is installed with Motion is in the /Library/Applications
Support/Final Cut Studio/Motion/Library/ folder (unless you selected a custom location
when you installed Motion), and all custom content that you create is saved in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/ folder.

To save a modified text style to the Library
1 Select the text with the modified parameters you want to save as a style.

2 In the Style pane, open the Style Preset pop-up menu and choose one of the following
options:

• To save a style with only the Style pane parameters, choose Save Style.

• To save a style with only the Format pane parameters, choose Save Format.

• To save a style with parameters from both the Style and Format panes, choose Save
All.

3 In the Save Preset To Library dialog, type the name of your preset.

4 Click Save.
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The custom preset is saved to the Text Styles category in the Library. Custom presets can
be identified in the Library by the small user icon that appears in the lower-right corner
of the larger text style icon.

Customized text style 
saved in Library

Editing Text Layout
The Text Layout pane contains controls for type layout, such as alignment, justification,
line spacing, and text on a path. You can also create a “typewriter” effect using the Type
On parameter in the Layout pane, or set text on a path.

For information on the controls in the Text Layout pane, see Text Controls in the Layout
Pane.

For information on performing tasks using the Text Layout controls, see Text
Layout-Related Tasks.
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To show the Text Layout pane
µ In the Inspector, click the Text tab, then click the Layout button.

Text Controls in the Layout Pane
This section describes the parameters in the Layout pane of the Text Inspector. Of the
following Layout controls, the Line Spacing and Alignment also appear in the Text HUD.
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Non-Path Text Controls in the Layout Pane
Use the Text Layout controls in the Layout pane of the Text Inspector to specify general
arrangement of your text. These controls allow you to make text flow in a single line, in
a paragraph with set margins, or on a path.

Layout Method: Specifies whether the text layout is set to Type, Paragraph, Path, Scroll,
or Crawl.

Note: When Layout Method is set to Scroll or Crawl, the Adjust Glyph tool is not available.
The Offset, Rotation, and Affects Layout parameters in the Format pane are also not
available.

• Type: The default layout method, creates a single line of text. As text is added, the string
of text continues off the Canvas.

Note: If you are creating multiple lines of text by using hard returns, be sure to set
Layout Method to Paragraph. This will allow you to use the Margin controls, as well as
align text correctly when using tabs.

• Paragraph: Makes the Margin controls available in the lower area of the Layout pane.
Use the sliders or value sliders to change the margin size.
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Double-clicking the text in the Canvas when Layout Method is set to Paragraph displays
a ruler and scroll control around the text entry field.

Note: When text is deleted from a paragraph text entry field, the paragraph margins
do not automatically scale. For information on modifying or creating a paragraph, see
Adding Paragraph Text in the Canvas.

• Path: Creates text on a path and makes the Path Options parameter group available.
The path can be an open or closed spline, a circle, a rectangle, a wave, or based on a
shape.

• Scroll: Positions the margins of the text entry field to match the project’s safe zones in
preparation for a scrolling animation. When Layout Method is set to Scroll,
double-clicking the text in the Canvas displays a ruler and an enhanced scroll control
that displays a preview of the text contents around the text box. Drag in the scroll bar
to navigate through large amounts of text.

Drag to scroll through 
the text.

For more information on safe zones, see Safe Zone.

Scroll does not automatically animate the text—text is only positioned and formatted
in preparation for you to create scrolling animation using keyframes or behaviors. For
more information on animating text, see Animating Text.

When Layout Method is set to Scroll, the following occurs:

• The Adjust Glyph tool is not available.
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• The Offset, Rotation, and Affects Layout parameters in the Format pane are not
available.

• When Scroll is selected from the Layout Method pop-up menu the text is flattened,
so the Flatten, Render Text, and Face Camera parameters are not available. For more
information, see the Flatten parameter description below.

For more information on safe zones, see Safe Zone.

• Crawl: Positions the text in a single string (within project safe zones) along the bottom
of the project in preparation for a crawl or ticker-type animation.

Double-clicking the text in the Canvas when Layout Method is set to Crawl displays a
scroll control below the text entry field.

Drag to scroll through 
the text.

Crawl does not automatically animate the text—text is only positioned and formatted
in preparation for you to create an animation using keyframes or behaviors. For more
information on animating text, see Animating Text.

When Layout Method is set to Scroll, the following occurs:

• The Adjust Glyph tool is not available.

• The Offset, Rotation, and Affects Layout parameters in the Format pane are not
available.

• When Crawl is selected from the Layout Method pop-up menu the text is flattened.
As a result, the Flatten, Render Text, and Face Camera parameters are not available.
For more information, see the Flatten parameter description below.

• Tabs are not available.

Alignment: Sets the alignment of the lines of text. The alignment choices are Left, Center,
and Right. The paragraphs of a text layer can be individually aligned by selecting the text
and choosing an alignment option from the pop-up menu.

Justification: Sets the justification of the lines of text. The justification choices are None,
Partial, and Full. The paragraphs of a text layer can be individually justified by selecting
the text and choosing a justification option from the pop-up menu.

Line Spacing: Specifies the distance between each line of text (leading) in point-size
increments. Dragging to the right (above 0) increases the line spacing and dragging to
the left (below 0) creates negative line spacing.
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Flatten: In 3D groups, text characters on a path may be influenced by behaviors in ways
that interfere with linear alignment. For instance, a simulation behavior might pull nearby
text characters out of their plane. Selecting the Flatten checkbox forces text characters
to remain in a 2D plane. When Flatten is selected, the text can still interact with other
objects in 3D space, but only as a flattened image, like a card.

Unflattened text on a 3D path can weave 
through other elements in a project.

Once Flatten is selected, the text characters no longer move in 3D space.

Flattened text image only exists in X and Y
and can only interact with other objects
as a flat card.

Use the following guidelines for the Flatten checkbox:

• The Flatten checkbox must be selected in order for text to receive reflections. If the
Flatten checkbox in the Layout pane of the Text tab (in the Inspector) is not selected,
the Reflections parameter does not appear in the Properties tab. For more information
on using reflections, see Reflections.

• The Flatten checkbox must be selected in order to use the 2D transform tools in the
Toolbar (Select/Transform, Adjust Anchor Point, Adjust Shear, Adjust Drop Shadow,
Adjust Four Corner, and Adjust Crop—in the Properties tab of the Inspector or in the
Toolbar.
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• The Flatten checkbox must be selected to apply a mask to text. The mask tools in the
Toolbar are not available when the checkbox is deselected.

Note: When a text layer that is rotated in Z space is flattened, the text that is further away
from the camera (further away in Z) appears smaller. For more information, see Working
with Objects Inside 2D Groups and Flattened 3D Groups.

Render Text: This pop-up menu allows you to choose between two different rendering
methods for text. This control is not available when the Flatten checkbox is selected, or
when Scroll or Crawl is selected from the Layout Method pop-up menu.

• In Global 3D (Better): This setting allows the text to intersect with layers within the text
group and with layers in other groups. When turned on, your project’s interactivity is
slowed.

Important: In Global 3D must be selected from the Render Text pop-up menu in order
for text to cast shadows. For more information on using shadows, see Shadows.

• In Local 3D (Faster): This setting renders text more quickly, but does not allow for
intersections with layers within the text group or with layers in other groups, or for text
to cast shadows.

Face Camera: When this checkbox is enabled, the text characters always face the camera,
even when the camera is rotated or the text is rotated. This checkbox is not available
when the Flatten checkbox is selected (text cannot face the camera and flatten to the
text plane at the same time). Additionally, text is flattened when Scroll or Crawl is selected
from the Layout Method pop-up menu, so Face Camera is not available.

Note: Because text characters are 2D (flat) objects, the text may not be visible when you
use the orthogonal camera views, such as Left, Right, and Top (unless the text layer or
characters are rotated in 3D space). This is because orthogonal views are at right angles
(perpendicular) to objects in the Canvas. For more information on using cameras, see
Cameras.

Anchor Point: Sets the anchor point of the text itself, rather than the anchor point of the
text layer. This allows you to rotate text around by character, word, line, or as a single
object. You can rotate the text using the Format pane of the Text Inspector, or by applying
a text sequence behavior.

To see a visual representation of the anchor point, select the text with the Adjust Glyph
tool. For more information on the glyph tool, see Working with Text Glyphs.

Note: The anchor point specified in the Layout pane is not the same as the anchor point
for the layer itself. The layer anchor point controls are available in the Properties tab and
the Adjust Anchor Point tool in the Toolbar. For more information on adjusting the anchor
point of a layer, see Using the Adjust Anchor Point Tool.

818 Chapter 13 Creating and Editing Text



The Anchor Point pop-up menu has four options:

• Character: Rotates each character as if each glyph has its own anchor point.

• Word: Rotates each word as if each word has its own anchor point.

• Line: Rotates each line as if the individual lines had their own anchor points.

• All: Rotates all of the text as a single object.

Position: Defines the position of the anchor point specified in the Anchor Point pop-up
menu. Click the disclosure triangle to display the individual X, Y, and Z parameters. To
see a visual representation of the anchor point, select the text with the Adjust Glyph tool.
For more information on the glyph tool, see Working with Text Glyphs.

Type On: This group of controls allows you to create a “type-on” effect, similar to a
typewriter. You can keyframe the type-on effect to occur forward or backward, or to move
in both directions.
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Note: There is also a Text Animation behavior called Type On which creates a forward
type-on effect without setting any keyframes.

The Type On parameter group has the following controls:

• Start: Sets the start point of the type-on effect (from the left side of the text). When set
to the default 0%, the text is fully “typed on.” When set to 100%, the text is fully “typed
off.” If the value animates from 0 to 100 over time, the text types off from left to right.
If the value animates from 100 to 0, the text types on from right to left.

• End: Sets the end point of the type-on effect (from the right side) of the text. When set
to the default 100%, the text is fully “typed on.” When set to 0%, the text is fully “typed
off.” If the value animates from 100 to 0 over time, the text types off from right to left.
If the value animates from 0 to 100, the text types on from left to right.

• Fade In: When this checkbox is selected, text characters are faded on or off. When the
checkbox is deselected, the text characters pop on as they appear.

For information on creating a type-on effect, see Creating a Type-On Effect. For
information on the Motion Path parameters, see Text Path Controls in the Layout Pane.

Text Path Controls in the Layout Pane
This group of controls, located in the Layout pane of the Text Inspector, allows you to
specify the initial shape of the text path and to modify the path and the text on that path.

For more information about creating a text path, see Text Layout-Related Tasks.

The Adjust Glyph tool can be used with text on a path. For more information, see Working
with Text Glyphs.

Path Shape: Sets the shape of the path to Open Spline, Closed Spline, Circle, Rectangle,
Wave, or Geometry.

• Open Spline: The default shape, a straight path defined by one point at the beginning
and one point at the end of the path. You can choose to work with Bezier or B-Spline
control points. Option-click (or double-click) anywhere on the path to add points.

820 Chapter 13 Creating and Editing Text



• Closed Spline: A closed path in which the last point is in the same location as the first
point. You can choose to work with Bezier or B-Spline control points. Option-click (or
double-click) anywhere on the path to add points.

• Circle: A simplified version of Closed Spline, in which the X radius or Y radius can be
adjusted to create a circle or an ellipse.

• Rectangle: A closed path in which the width and the height can be adjusted to create
a square or a rectangle.

• Wave: A wavy path (a sine wave) defined by one point at the beginning and one point
at the end of the path and controlled by the End Point, Amplitude, Frequency, Phase,
and Damping parameters.

• Geometry: The layer travels along the edge of a shape or mask that is used as the source
for the path. An animated shape can be used as the text path source. For example, use
a circle shape with an applied Oscillate Shape behavior as the source shape.

Path Type: When Path Shape is set to Open Spline or Closed Spline, the Path Type pop-up
menu becomes available, allowing you to choose one of two ways to manipulate the
shape of the path: Bezier or B-Spline.

• Bezier: Lets you manipulate the keyframe curve manually by dragging the handles. For
more information about creating and adjusting Bezier curves, see Editing Bezier Control
Points.

• B-Spline: B-Splines are manipulated using only points—there are no tangent handles.
The points themselves do not lie on the surface of the shape. Instead, each B-Spline
control point is offset from the shape’s surface, pulling that section of the shape toward
itself as if it were a magnet, in order to create a curve. B-Splines are extremely
smooth—by default, there are no sharp angles in B-Spline shapes, although you can
create sharper curves, if necessary. For more information about working with B-Spline
curves, see Editing B-Spline Control Points.

Radius: When Circle is the defined path shape, the Radius slider becomes available. This
slider allows you to change the size of the circular path. Click the disclosure triangle to
individually adjust the X radius and Y radius.

Note: When the Text tool is selected, you can also use the onscreen control points to
resize the circle. Press Shift to resize the X and Y radii uniformly.

Size: When Rectangle is the defined path shape, the Size slider becomes available. This
slider allows you to change the size of the rectangular path. Click the disclosure triangle
to adjust the X scale and Y scale individually.

Note: When the Text tool is selected, you can also use the onscreen control points to
resize the rectangle. Press Shift to resize the X and Y scale uniformly.
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Start Point: When Wave is selected in the Path Shape pop-up menu, this control become
available. Sets the location default start point on the wave’s path. The left value slider
sets the X coordinate of the start point. The right value slider sets the Y coordinate of the
start point. The start point can also be adjusted using the wave’s onscreen controls (active
by default when the Text tool is selected).

End Point: When Wave is selected in the Path Shape pop-up menu, this control becomes
available. Sets the location of the default end point on the wave’s path. The left value
slider sets the X coordinate of the end point. The right value slider sets the Y coordinate
of the end point. The end point can also be adjusted using the wave’s onscreen controls
(active by default when the Text tool is selected).

Amplitude: When Wave is selected in the Path Shape pop-up menu, this control become
available. A slider that defines half the distance from the highest point to the lowest point
in the wave. Higher values result in more extreme waves.

Frequency: When Wave is selected in the Path Shape pop-up menu, this control become
available. A slider that sets number of waves. Higher values result in more waves.

Phase: When Wave is selected in the Path Shape pop-up menu, this control become
available. A dial that defines the percentage of the offset of the waves from the start and
end points of the path. When set to 0% (default), the wave begins and ends at half the
distance from the highest point to the lowest point in the wave. When set to 90%, the
wave begins and ends at the highest point in the wave. When set to –90%, the wave
begins at the lowest point in the wave. When set to 180%, the waves are the same as
0%, but inverted.

Damping: When Wave is selected in the Path Shape pop-up menu, this control become
available. A slider that progressively diminishes the oscillation of the wave. Positive
damping values diminish the wave forward (from left to right); negative values diminish
the wave backward (from right to left).

Shape Source: When Geometry is selected in the Path Shape pop-up menu, this control
become available. An image well that defines the layer (shape or mask) to use as the
motion path source.

To: When Geometry is selected in the Path Shape pop-up menu, this control become
available. This pop-up menu displays a list of all layers in the current project that can be
used as a shape source for the motion path.

Attach to Shape: When Geometry is selected in the Path Shape pop-up menu, this control
become available. When this checkbox is enabled, the motion path follows the source
shape at its original location. When disabled, the motion path can exist in a location other
than its source shape.

Note: When Attach to Shape is enabled, you cannot move the layer to another location.

To learn how to use spline objects as a text path source shape, see Using Geometry for
a Path Source.
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Path Offset: Determines where the text begins on the path. Animate this value to move
text along a path. At 0%, the first text character is at the left end of the path; at 100%,
the first character is at the right end of the path.

Wrap Around: Available when Path Shape is set to Open Spline or Wave (an open path
shape), wraps the text from the end of the path around to the first point of the path.

Inside Path: When the Inside Path checkbox is selected, the baseline of text on a loop
path is shifted so the text appears inside of the loop.

Align to Path: Aligns the text to the shape of the path. When the checkbox is deselected,
all text characters align vertically, regardless of the shape of the path.

Control Points: Available when Open Spline or Closed Spline is selected from the Path
Shape pop-up menu, displays the X, Y, and Z positions for all control points on a path.
Enter different values in the fields to adjust the position of the control points using the
Inspector.

Margin Controls in the Layout Pane
This group of controls, which becomes available when the Layout Method is set to
Paragraph, Scroll, or Crawl, sets the size and location of the text margins.

When a text file is imported into Motion, its margin and tabs information is retained in
the Motion project. The Layout Method (in the Layout pane of the Text Inspector) for the
imported text is automatically set to to Paragraph.

By default, text created within Motion is set to Type, creating one long string of text until
you manually enter a line break. To create columns with tabs or use margins with text
created in Motion, Layout Method (in the Layout pane of the Text Inspector) must be set
to Paragraph or Scroll.

There are several ways to create and adjust text margins, including using the onscreen
controls and the Layout pane in the Text Inspector. You can set a margin for text before
or after it is created.

Margin controls

Layout Method must be 
set to Paragraph to show 
the Margin controls.
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Left, Right, Top, and Bottom Margins: Available when Layout Method is set to Paragraph,
Scroll, or Crawl, defines the text margins in the Canvas.

For more information on working with margins, see Text Margin and Tab-Related Tasks.

Tab Controls in the Layout Pane
When a Rich Text Format file is imported, any tabs in the RTF file are retained in the
Motion project. This information is displayed in the Layout pane of the text Inspector.
When text is created in Motion, it has no tab information, but tabs can be created. Adding,
moving, and removing tabs is done in the Canvas. Moving tabs, by modifying their values,
is done in the Inspector.

Tabs can also be added, moved, and removed in the Canvas. The tab, margin, and
alignment options are especially useful when formatting credit rolls.

Tab 0, 1, 2, and so on: Lists the tabs in the paragraph, including their type and positions.

• Tab type pop-up menu: Sets the tab to Left, Center, Right, or Decimal.
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• Tab value slider: Drag in the slider or use the left and right arrows to adjust the position
of the tab.

For more information on working with tabs, see Text Margin and Tab-Related Tasks.

Text Layout-Related Tasks
These tasks are useful when editing text Layout parameters, which include working with
text on a path and creating a type-on effect.

Creating Text on a Path
To place text on a path, you create the text and then apply the Path layout method (via
the Layout Method pop-up menu). Use the Path Options parameters to modify the text
on a path.

To create text on a path
1 Select the text you want to place on a path.

2 In the Layout pane of the Text Inspector, choose Path from the Layout Method pop-up
menu.

The Path Options parameters become available.

3 Select the Text tool (or press T) and click the text in the Canvas.

Important: Step 3 is important—the Text tool must be selected in order to view or edit
the text path.

The path appears below the text. The default path shape is set to Open Spline and contains
three control points.
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Working with Text on a Path
You can create text on a line, circle, rectangle, wave, or along the edge of a shape or
mask. An Open Spline text path can be manipulated to move through 3D space. You can
change the shape of a text path, add or remove control points, as well as animate the
text along the path. Text on a path can still be edited—you can change text characters
or fonts, tracking, kerning, and so on. Text Style parameters can also be modified for text
on a path.

Using Behaviors with Text on a Path
Text, Simulation, Parameter, and Basic Motion behaviors can be applied to text on a
path. This allows for the creation of some very clever and complex animation.

For more information on using Simulation and Parameter behaviors, see Using Other
Behaviors with Text.

Modifying the Path Shape
Keep in mind that the Text tool must be selected to view and edit the text path. Use the
following guidelines to modify the shape of the path.
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To adjust the text path
µ With the Text tool selected, drag a control point to change the shape of the path.

When additional text characters are added to text that is already on a path, the default
path may appear too short. In the following images, the first image shows the original
text placed on a path. The second image shows additional text. Notice that in the second
image with the added text characters, the path is shorter than the text.

Initial text placed on path Additional characters added to original text

To extend a text path
µ With the Text tool selected, drag the last control point toward the end of the text.
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When dragging, press Shift to constrain the path to a straight line. Once a path has been
extended, you can add control points for extra control over the shape of the path.

To add or modify text path control points
µ Option-click or double-click the path to add a control point.

Note: Control points can only be added to Open Spline or Closed Spline paths.

µ To remove a control point, select the point, then press Delete. You can also Control-click
the point and choose Delete Point from the shortcut menu.

µ To create a linear point, Control-click the point and select Linear from the shortcut menu.

µ To create a smooth (Bezier) point, Control-click the point and select Smooth from the
shortcut menu.

Note: When Path Type is set to B-Spline, the Very Smooth option becomes available in
the shortcut menu.

µ To lock a point, Control-click the point and select Lock Point from the shortcut menu. A
locked point cannot be edited.

µ To unlock a point, Control-click the point and select Unlock Point.

Important: Text paths are modified in the same way as shape control points. For a
complete information, see Using Shapes, Masks, and Paint Strokes.

Note: Clicking any path control point and holding down the mouse button displays an
info window containing the point number (based on the order the points are drawn on
the path) and X, Y, and Z coordinates. All path control points are also listed by number
in the Layout pane of the Text Inspector.

To adjust the text path in 3D space
1 If there is no camera in your project, add a camera by doing one of the following:

• Click the Add Camera icon in the Toolbar.

• Choose Object > New Camera (or press Command-Option-C).

Note: If none of your project groups are set to 3D, a dialog appears asking you if you
want to switch your 2D groups to 3D groups. Click Switch to 3D to allow the camera
to affect the groups.

2 To change the default camera view (Active Camera) to Top, do one of the following:

• Click “Active Camera” in the upper-left corner of the Canvas to open the Camera menu,
then choose Top.

• Choose View > 3D View > Top.

The text is no longer visible because the camera is now looking down perpendicularly
(on the Y axis) at the text on a path. The text path and its points are still visible. (The
yellow wireframe camera icon in the Canvas represents the Active Camera you added
in step 1.)
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Note: The text path onscreen controls are available for all camera views. This example
uses the Top view.

3 With the Text tool selected, drag a control point to adjust the text path in X, Y, or Z space.

Note: Manipulating text on a path in 3D only works when Path Shape is set to Open
Spline or Closed Spline.

Text on a path in 3D Top view. The right and left control 
points are set to positive Z values.

If you lose the path selection, select the text layer in the Layers tab.

Note: To enter specific values for the control point locations for the Open Spline or Closed
Spline, click the Control Points disclosure triangle in the Path Options group of the Layout
pane. The first value field is X, the second value field is Y, and the third value field is Z.

4 To change to a different camera view, choose another camera view from the Camera
menu in the upper-left corner of the Canvas.

Text on a path in Right camera view.
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5 To reset the camera view, do one of the following:

• Choose Active Camera from the Camera menu.

• Choose View > 3D View > Active.

Tip: When working with text in a 3D project, especially text that moves close to the
camera, set the Render Quality in the Render pop-up menu (in the Status Bar below
the Inspector icon) or the View menu to Best before exporting (choose View > Quality
> Best). Use Normal when working in your project, as Best mode dramatically slows
your project’s interactivity. You can also set the Render Quality on export in the Export
Options dialog: Choose Export, click Options, then choose Best from the Render Quality
pop-up menu. To customize an export, turn off the “Use current project and canvas
settings” checkbox.

Isolating a Group or Layer to Work with Text on a 3D Path
When working with text on a 3D path, the text may become difficult to read depending
on its orientation and distance from the camera. If you need to edit the text, you can
quickly snap the text layer to its original face-forward orientation using the Isolate button
in the Layers tab (or Timeline layers list) or the Isolate command in the Object menu.

To isolate a group or layer
Do one of the following:

µ In the Layers tab (or Timeline layers list), click the Isolate button.

Inactive Isolate button

µ Control-click the layer or group, then choose Isolate from the shortcut menu.

µ Choose Object > Isolate.

µ Click the Isolate button again to return to your previous view.

Note: Clicking a camera’s Isolate button activates that camera’s view.

Using Geometry for a Path Source
The following section describes how to use geometry as the source for a text path.
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To use geometry for a text path source
1 Import (or draw) the shape you want to use as the path source.

2 Select the text on a path, then choose Geometry from the Path Shape pop-up menu.

The Shape Source well appears in the Inspector.

3 From the Layers tab, drag the shape to the Shape Source well.

4 When the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the shape appears in the well and the shape is used as the source shape
for the text path.

Note: You may want to disable the source shape in the Layers tab so it is not visible in
your project.
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To select another geometry source for a text path shape
µ Click the To pop-up menu (located next to the Shape Source image well) and select the

layer you want to use as the text path’s shape source.

Animating Text on a Path
Text can be animated to move across the text path.

To animate text on a path
1 Create the path for the text to travel along.

2 Go to the frame where you want to begin the animation, and enable Record.

Note: Remember that using shortcut keys while in text editing mode may result in adding
characters to your text.

3 In the Layout pane, adjust the Path Offset slider or value slider to the amount you want
to move the text on the path.

A keyframe is added to the Path Offset parameter.

This icon indicates that a 
keyframe is present at 
the current playhead 
position.
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A positive value moves the text toward the right and a negative value moves the text
toward the left. You can enter values greater than 100% or less than 0% in the value
slider. A value greater than 100% moves the text completely off the path to the right; a
value less than 0% moves the text off the path to the left. In the following image, the
Path Offset is set to 105%, so the text is completely off the right end of the text path.

4 Go to the frame where you want to end the animation (or set the next keyframe).

5 Adjust the Path Offset slider or value slider to reposition the text on the path.

6 Play the project to see the text travel along the text path.

7 Disable Record.

Creating a Type-On Effect
There are two ways to create a type-on text effect: Use the Type On parameters in the
Text Layout controls, or apply the Type On behavior (in the Text Animation behavior
category). This section discusses using the Type On parameters in the Layout pane of the
Text Inspector. For information on the Type On text behavior, see Type On Behavior.

In this example, text is set to type on from left to right.
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To create a type-on effect
1 Select the text.

2 Go to the frame where you want the animation to begin.

3 Enable Record.

Record button

4 In the Layout pane, set the End value of the Type On parameters to 0.

The text disappears (is “typed off”).

Note: You can also use the Animation menu rather then enabling Record in the transport
controls. Click the Animation menu icon beside the End parameter, then choose Add
Keyframe.

5 Go to the frame where you want the animation to end (where you’d like the type-on
effect to be complete).

6 Set the End value to 100.

7 Play the project.

The text is appears character by character, from left to right (is “typed on”).
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To create a type-on effect in which the text characters “pop” on, turn off the Fade In
checkbox.

Note: You can use the Type On parameter when the text Layout Method is set to Type,
Paragraph (multiline text), or Path.

Tip: Remember that you can apply Parameter behaviors to nearly any parameter in
Motion. For example, to make the text from the above example stutter and flash as it
appears, apply the Randomize parameter behavior to the End parameter:

• Control-click the End value in the Type On controls, then choose Randomize from the
shortcut menu.

The Behaviors tab appears and displays the Randomize parameters. The text characters
pop into view more roughly, with irregular timing.

• To make the stutter effect more dramatic, adjust the Randomize parameters (such as
changing the Apply Mode or increasing the Noisiness parameter).

For more information on working with Parameter behaviors, see Applying Behaviors.

Text Margin and Tab-Related Tasks
These tasks are useful when editing text margins and tabs.

Creating a Text Margin
You can create a custom margin using the Margin controls in the Layout pane of the Text
Inspector or by drawing a text bounding box in the Canvas.

For information on creating a text box using the Text tool, see Adding Paragraph Text in
the Canvas.

To create text margins in the Inspector
1 Select the Text tool, click in the Canvas, and type some text.

By default, the text is set to Type in the Layout pane.

Note: Clicking the Text tool in the Canvas without dragging creates a blank text layer.

2 In the Layout pane, set Layout Method to Paragraph.

3 Set margin values using the Left, Right, Top, and Bottom Margin sliders.

4 Press Esc or click the Select/Transform tool to select the text bounding box and exit
text-editing mode.

Working with Tabs
When a Rich Text Format file is imported into a Motion project, any tabs defined in the
RTF file are retained. You can also add and modify tabs to text created in a Motion project.
Different lines of text that are separated by hard returns can have different tabs.
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Tabs are displayed in the Canvas and in the Layout panel of the Text Inspector.

Note: Text alignment is controlled with the Layout Method pop-up menu in the Layout
pane.

To add a tab
1 Ensure the text is set to Paragraph (or Scroll) in the Layout Method pop-up menu.

2 In the ruler above the text entry field in the Canvas, do one of the following:

• Click to add a left tab.

• Double-click to add a center tab.

• Control-click and choose an option from the create tab shortcut menu. The choices
are:

• Create left tab

• Create center tab

• Create right tab

• Create decimal tab

Once a tab is added, its white icon appears in the ruler.

Decimal tab

Left tab

Right tab

Center tab
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To change a tab type in the Canvas
µ Double-click a tab icon in the ruler.

The tabs cycle through the right, center, left, and decimal types.

To change a tab type in the Inspector
µ In the Tabs section of the Layout pane of the text Inspector, choose an option from the

Tab type pop-up menu.

The tabs icon is updated in the ruler in the Canvas.

To move the tabs
1 Double-click in the text to display the text box, ruler, and scroll control.

Note: The Text tool must be selected in order for the ruler and tabs to appear in the
Canvas.

2 Do one of the following:

• In the Canvas, drag a tab (the small white triangle) in the ruler.

• In the Layout pane of the Text Inspector, use the Tabs controls to adjust the position
and layout of the tabs.

The affected text is repositioned to the tab.

To remove a tab
1 Double-click in the text to display the text entry field, ruler, and scroll control.

Note: The Text tool must be selected in order for the ruler and tabs to appear in the
Canvas.

2 Drag the tab (the small white triangle) away from the ruler and release the mouse button.

The tab is removed from the ruler with a “poof” and removed from the Tabs controls in
the Layout pane of the Text Inspector with less fanfare.

Working with Text Glyphs
Using the Adjust Glyph tool, individual text characters can be modified independently
of the word, line, or paragraph in which they are a member. You can choose which text
attributes you want to change or animate, including position, rotation, scale, face (color
or fill), outline, glow, or drop shadow.

In addition to modifying individual text characters independently of their group, you can
transform style attributes independently of the text character. For example, you can warp
the drop shadow or glow of a letter without affecting its face or outline. These transforms
can be applied using onscreen controls or the Four Corner parameter in the Style pane
of the Text Inspector.
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When the Adjust Glyph tool is selected and Attribute is set to Transform Glyph (in the
text HUD), onscreen transform controls appear. These controls are identical to the 3D
onscreen transform controls. For more information on using these controls, see 3D
Transform Onscreen Controls.

The Attribute parameter is also available in the Sequence Text behavior, which allows
you to sequence any of the glyph effects through text. For more information on using
the Sequence Text behavior, see Sequence Text Behavior.

Displaying and Choosing the Onscreen Glyph Controls
There are two modes of onscreen controls available with the Adjust Glyph tool. When
Transform Glyph is chosen from the Attribute pop-up menu, the available controls are
identical to the 3D onscreen controls, allowing you to adjust a glyph’s scale, position, or
rotation without affecting the rest of the characters in the text layer. When Face, Outline,
Glow, or Drop Shadow is chosen from the Attribute pop-up menu, you can apply a
four-corner warp the selected attribute of a glyph—without affecting the other attributes
of that glyph or the rest of the characters in the text layer.

In transform glyph mode, the Adjust Glyph tool’s onscreen controls are identical to the
3D onscreen controls. For more information on moving, rotating, or scaling objects using
this tool, see 3D Transform Onscreen Controls.

To display the transform glyph onscreen controls
1 Select the text object that contains the glyph(s) that you want to modify.

2 Select the Adjust Glyph tool from the 2D transform tools menu in the Toolbar.

If no glyph was previously selected, the first glyph in the text is selected.

3 Do one of the following:

• To scale, rotate, or move the glyph, select Transform Glyph from the Attribute pop-up
menu in the text HUD.

• To warp a text style attribute, select Face, Outline, Glow, or Drop Shadow from the
Attribute pop-up menu in the text HUD.

Note: If the HUD does not appear, choose Window > Show HUD (or press F7).
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Selecting Characters with the Adjust Glyph Tool
You can select a single text glyph or multiple text glyphs with the Adjust Glyph tool.
When more than one glyph is selected, the last Shift-clicked glyph appears with the
transform tools. This is known as the “focused glyph.” A box appears around the other
selected characters. Any selected glyph (focused or not) is affected by transforms applied
to the focused glyph.

Note: If you are using the Adjust Glyph tool to warp a style attribute (face, outline, glow,
drop shadow) of a glyph, only one glyph can be selected at a time.

To select all glyphs
1 Select the text object that contains the glyphs that you want to modify.

2 Select the Adjust Glyph tool from the 2D transform tools in the Toolbar.

Ensure that the Attribute pop-up menu in the HUD is set to Transform Glyph. A glyph is
selected.

3 Choose Edit > Select All (or press Command-A).

All glyphs are selected, and the Adjust Glyph tool remains selected.

To select multiple glyphs
1 Select the text object that contains the glyphs that you want to modify.

2 Select the Adjust Glyph tool from the 2D transform tools in the Toolbar.

The first glyph in the text is selected.

3 Do one of the following:

• While pressing the Shift key, select the other glyphs you want to include in your edit.

• Drag to select the other glyphs you want to include in your edit.

• While pressing the Command key, select noncontiguous glyphs you want to include
in your edit.

Although the onscreen controls appear only around the focused (last selected) glyph,
any glyph surrounded by a box is affected by adjust the onscreen controls.
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To deselect a group of selected glyphs
µ Choose Edit > Deselect All (or press Command-Shift-A).

The glyphs are deselected and the Adjust Glyph tool remains selected in the Toolbar.

To select a glyph(s) in another text layer
µ With an active Adjust Glyph tool selection, click the text layer in the Layers tab or Timeline

layers list that you want to modify. If no glyph was previously selected in the new text
layer, the first glyph is active. If a glyph was previously selected, the last selected glyph
is active.

If no glyph was previously selected in the new text layer, the first glyph is active. If a glyph
was previously selected, the last selected glyph is active.

Resetting Position, Rotation, or Scale of a Transformed Glyph
When a text layer is moved, rotated, or scaled as a whole, the changes are reflected in
the Properties tab of the Inspector. However, when a glyph is transformed, the changes
are reflected in the Format pane of the Text Inspector.

To reset a rotated glyph
1 If the glyph is not selected, select the Adjust Glyph tool from the 2D transform tools in

the Toolbar, then select the glyph or Shift-select a group of glyphs.
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2 In the Format pane of the Text Inspector, click the Animation menu icon for the Rotation
parameter and choose Reset Parameter.

Animation menu icon

The glyphs return to their original rotation.

To reset a repositioned glyph
1 If the glyph is not selected, select the Adjust Glyph tool from the 2D transform tools in

the Toolbar, then select the glyph or Shift-select a group of glyphs.

2 In the Format pane of the Text Inspector, click the Animation menu icon for the Offset
parameter and choose Reset Parameter.

To reset a scaled glyph
1 If the glyph is not selected, select the Adjust Glyph tool from the 2D transform tools in

the Toolbar, then select the glyph or Shift-select a group of glyphs.

2 In the Format pane of the Text Inspector, click the Animation menu icon for the Scale
parameter and choose Reset Parameter.
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Adjusting Glyph Attributes
The onscreen controls for adjusting a glyph’s style attribute are similar to the shearing
and four corner onscreen controls. You can also warp a glyph’s attributes in the Text
Inspector.

To warp a glyph’s style attribute in the Canvas
1 Select the text object that contains the glyph(s) that you want to modify, then select the

Adjust Glyph tool from the 2D transform tools in the Toolbar.

2 Select the attribute you want to modify (Face, Outline, Glow, or Drop Shadow) from the
Attribute pop-up menu in the Text HUD.

The glyph is enclosed by a bounding box with eight handles: four corner handles for
four-corner warping and four shearing handles located in the middle of the bounding
box edges.

Corner handles

Shearing handles

3 Do one of the following:

• To shear the style attribute, drag a shearing handle.

• To warp the style attribute, drag a corner handle.

Once the attribute is adjusted (Glow in this example), that parameter is selected in the
Style pane of the Text Inspector (the Glow checkbox). That parameter is only turned
on for the modified glyphs in the text object.
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To warp a glyph style attribute in the Inspector
1 Select the text object that contains the glyph(s) that you want to modify, then select the

Adjust Glyph tool from the 2D transform tools in the Toolbar.

2 Select the attribute you want to modify (Face, Outline, Glow, or Drop Shadow) from the
Attribute pop-up menu in the Text HUD.

3 In the Style pane of the Text Inspector, click the Four Corner disclosure triangle for the
attribute you want to modify, then use the Bottom Left, Bottom Right, Top Right, or Top
Left value sliders to warp the attribute.

Resetting Adjusted Glyph Attributes
When a glyph’s attributes are modified using the Adjust Glyph tool, the changes are
reflected in the Style pane of the Text Inspector. Although you can only modify a style
attribute of one glyph at a time, you can reset multiple glyphs at one time.

To reset a single modified glyph attribute
µ With the glyph selected (using the Adjust Glyph tool), click the reset button for the relative

Four Corner parameter in the Style pane of the Text Inspector.

To reset multiple modified glyph attributes
1 Select the text object that contains the glyph(s) that you want to modify, then select the

Adjust Glyph tool from the 2D transform tools in the Toolbar.

2 Select the glyph or Shift-select a group of glyphs.

3 If it’s not already selected, select Transform Glyph from the Attribute pop-up menu in the
text HUD.

4 Shift-select the glyphs you want to reset.

5 Click the reset button for the Four Corner parameter in the Style pane of the Text Inspector.

Animating Glyphs
The Adjust Glyph tool allows you to animate individual text characters and their style
attributes.

For more information, see Animating with the Adjust Glyph Tool.

Adjust Glyph HUD Controls
When the Adjust Glyph tool is selected, additional controls become available in the Text
HUD. In addition to the text parameters, the HUD contains the 3D transform tools, the
Adjust Around pop-up menu, and the Attribute pop-up menus.

For more information on the text HUD controls, see Using the Text HUD.

For more information on the HUD 3D transform tools and the Adjust Around pop-up
menu, see 3D Transform HUD Controls.
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Attribute: Specifies the glyph attribute to be modified.

• Transform Glyph: Displays onscreen controls that allow you to scale, move, or rotate
the glyph.

• Face: Displays onscreen controls that allow you to shear or four-corner warp the face
(color fill) of the glyph.

• Outline: Displays onscreen controls that allow you to shear or four-corner warp the
outline of the glyph.

• Glow: Displays onscreen controls that allow you to shear or four-corner warp the glow
of the glyph.

• Drop Shadow: Displays onscreen controls that allow you to shear or four-corner warp
the drop shadow of the glyph.

Adding Behaviors and Filters to Text
Nontext behaviors and filters are applied to text in the same manner as they are to other
layers in Motion. This section provides a quick guide to applying behaviors and filters to
text.

When a filter is applied to text, the text is flattened. In the Layout pane of the Text
Inspector, the Flatten checkbox is selected and the parameter is disabled. When text is
flattened, filters are applied to the text in local space; that is, “flat” to the text.

Flattened text with applied Twirl filter

Note: To turn off the Flatten checkbox once a filter is applied, turn off (or remove) the
filter in the Layers tab, select the text, then turn off the Flatten checkbox (in the Layout
pane of the Text Inspector). If you turn the filter back on, the text is flattened (the Flatten
checkbox is selected and the parameter is disabled.
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To apply a behavior to text
Do one of the following:

µ In the Library, select a behavior, then drag it to the text in the Canvas, Layers tab, or
Timeline.

µ Select the text to which you want to apply a behavior, click the Add Behavior icon in the
Toolbar, then choose a behavior from the pop-up menu.

Add Behavior icon

Add Filter icon

The Text HUD is replaced with a behavior HUD.

Note: For more information on applying text behaviors, see Text Animation and Text
Sequence Behaviors and Preset Text Sequence Behaviors. For more information on other
behaviors, see Using Behaviors.

To apply a filter to text
Do one of the following:

µ In the Library, select a filter, then drag it to the text in the Canvas, Layers tab, or Timeline.

µ Select the text to which you want to apply a filter, click the Add Filter icon in the Toolbar,
then choose a filter from the pop-up menu.

Note: For more information on using filters, see Using Filters.

Using the Text HUD
The Text HUD contains some of the most commonly adjusted text parameters, such as
Opacity, type Family, and Color.

845Chapter 13 Creating and Editing Text



Note: If no HUD is present when the text is selected, press F7 or D to display the Text
HUD.

Family pop-up menu

Typeface pop-up menu

When a text layer and the Adjust 3D Transform tool (in the Toolbar) are selected, the 3D
transform tools become available in the HUD. These additional controls allow you to
transform the text object in X, Y, and Z dimensions, regardless of whether the group is
2D or 3D.

For more information on using the 3D transform tools in the HUD, see 3D Transform HUD
Controls.

When the Adjust Glyph tool is selected from the 2D transform tools in the Toolbar, the
Attribute pop-up menu and 3D transform tools become available in the Text HUD. The
Attribute menu specifies the glyph attribute to be modified. For more information on
glyphs, see Working with Text Glyphs.

Text Parameters in the HUD
The Text HUD includes the following controls:

Opacity: By default, the opacity of text is set to 100%. Use the slider to change the opacity
value of the text layer—the text face, outline, glow, and drop shadow. This is is the Opacity
parameter located in the Properties tab of the Inspector. To individually change the text
style elements (Face, Outline, Glow, and Drop Shadow), use the Style pane of the Text
Inspector.
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Blend Mode: The text blend mode is set to Normal by default. Use the Blend Mode
pop-up menu to choose another mode for the selected text.

Note: The Properties tab also contains controls to change the blend mode of the text.
When you change the blend mode of text in the Text HUD, the blend mode is also changed
in the Properties tab and vice versa.

Family: By default, the text font family is set to Geneva (if installed on your system). To
change the font of the selected text, choose a font from the pop-up menu. Once a font
is selected, new text is created using the last selected font.

Typeface: Choose the type style, such as Bold, Italic, and so on from the Typeface pop-up
menu. The available typefaces are specific to the selected font family.

Color: Text color is white by default. Click the color well to display the Colors window
and choose another color for the selected text. You can also Control-click a color well to
display the pop-up color palette, then drag in the color spectrum to select a color.

Size: Text is created at 48 points by default. To change the point size of text, drag the
Size slider.
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Note: The text Size sliders (in the HUD and in the Inspector) are limited to 288 points. To
set the text to a larger point size, type a number in the Size field in the Format pane of
the Text Inspector.

Text Size field

Tracking: Tracking applies a uniform value between each text character. Tracking is set
to 0 by default. To change the tracking value of text, drag the Tracking slider left (for a
negative tracking value) or right (for a positive tracking value).

Note: The text Tracking sliders (in the HUD and in the Inspector) are limited to 100 points.
To set a larger tracking value, type a number in the Tracking field in the Format pane of
the Text Inspector.

Line Spacing: When working with multiple lines of text, drag the slider to change the
space between lines of text. Dragging to the right (above 0) increases the line spacing
and dragging to the left (below 0) creates negative line spacing.

Alignment: Text alignment is set to Left by default. To change alignment, choose Right
or Center from the Alignment pop-up menu.

Note: When the Adjust Glyph tool is selected, the text HUD contains additional controls,
including the 3D transform tools, the Adjust Around pop-up menu, and the Attribute
pop-up menu.
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Text can be animated using behaviors, keyframes, or a combination of both. While you
can apply different behavior types (Basic Motion, Parameter, or Simulation) to text, Motion
has special class of text behaviors. Text behaviors create animation by applying a range
of values to text parameters specific to titling effects—without creating keyframes.

For more information on Basic Motion, Parameter, and Simulation behaviors, see Using
Behaviors.

Text behaviors are an ideal way to test different text treatments without setting keyframes.
You can quickly adjust the rate of an applied behavior using the behavior’s HUD and
watch as the animation updates in the Canvas. For more control, you can access all of
the parameters for a behavior in the Inspector. If your project requires specific timing and
positioning of text, you can use behaviors to test effects and then create keyframes after
you know what you want to do. Or you can create keyframes from the applied text
behaviors by using the Convert to Keyframes feature. This approach allows you to fine-tune
the animation created by the text behaviors.

Of course, behaviors are not required to animate text. You can create text animation via
traditional keyframing, or by combining both techniques.

Note: Although you can apply keyframes and behaviors to text, you’ll need to think about
the effect you are trying to create because this workflow can defeat the purpose of
behaviors. Mixing keyframes and behaviors can also yield unexpected results. For more
information on combining behaviors and keyframes, see Combining Behaviors with
Keyframes.

You can animate text as a whole or as individual characters (glyphs). Format parameters
such as text position, scale, rotation, tracking, and style attributes such as outline, glow,
and drop shadow can be animated. Text can be placed and animated on a path, used as
an image mask source, or used as a particle or replicator cell source.

This chapter covers the following:

• Text Animation and Text Sequence Behaviors (p. 850)

• Sequence Text Behavior (p. 853)
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• Scroll Text Behavior (p. 876)

• Text Tracking Behavior (p. 879)

• Type On Behavior (p. 880)

• Preset Text Sequence Behaviors (p. 882)

• Saving a Modified Text Behavior to the Library (p. 888)

• Using Other Behaviors with Text (p. 889)

• Using Behaviors to Animate Text in 3D (p. 890)

• Animating Text with Keyframes (p. 891)

• Animating with the Adjust Glyph Tool (p. 893)

• Using LiveFonts (p. 895)

Text Animation and Text Sequence Behaviors
In Motion, text behaviors are divided into two basic categories: Text Animation behaviors
and Text Sequence behaviors. The Text Animation behaviors allow you to quickly create
crawls, scrolls, animated text tracking, or “type-on” effects. This group also includes the
powerful Sequence Text behavior, which allows you to create a custom animation that
sequences text style and text format attributes through the text characters over time.
The style attributes include face (fill color), glow, drop shadow and outline. The format
attributes include position, opacity, scale, rotation, tracking, and so on. The sequence can
run through the text from left to right, right to left, or you can create a custom animation
for the direction of the sequence. The sequence can also be applied per character, per
word, per text layer, and so on.

In the following illustration sequence, the text in the upper area of the image is animated
by modifying the Scale, Blur, and Opacity parameters in the Text Sequence behavior. The
lower text is animated using the Fade In/Fade Out and Tracking behaviors.
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The Text Sequence behaviors includes six classes of preset sequence behaviors: Basic,
Continuous, Energetic, Glow, Highlighter, and Subtle. These behaviors employ the
parameters of the Sequence Text behavior (in the Text Animation category). Although
the Text Sequence behaviors are all presets—the parameters are already selected and
animated—you can still add, remove, or modify any parameter that is available to the
Sequence Text behavior.

Note: While most of the Text Sequence behaviors have a definite start or end (fade in or
out, blur in or out, and so on), the Continuous group of behaviors are designed to have
no start and end points.

You can save a modified behavior to the Library. For more information, see Saving a
Modified Text Behavior to the Library.

Applying a Text Behavior
Text behaviors are applied in the same manner as all other behaviors and filters in
Motion—by using the Library or the Add Behavior icon in the Toolbar. As with other
behaviors, the Library allows you to see a preview of the behavior before it is applied to
text. The Add Behavior icon allows you to quickly apply a behavior to single or multiple
text layers.

To apply a Text behavior from the Library
1 Create a text layer in your project.
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2 In the Library, select the Behaviors category and then select Text Animation or Text
Sequence from the Behaviors subcategories.

Text Animation behavior 
subcategory

Stack

Text Sequence behavior 
subcategory

3 Select a text behavior in the stack.

Like other behaviors in Motion, a preview of the animation plays in the Preview area.
Keep in mind that the preview merely represents the default animation of the behavior,
which can be modified.
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4 Do one of the following:

• Drag the behavior to the text in the Canvas, Layers tab, or Timeline.

• Click the Apply button in the Preview area.

The Text HUD is replaced with the text behavior HUD.

To apply a Text behavior from the Add Behavior icon
1 Select the text layer (or layers) to which you want to apply the behavior.

2 In the Toolbar, click the Add Behavior icon, then choose a Text Animation or Text Sequence
behavior from the pop-up menu.

Sequence Text Behavior
The Sequence Text behavior allows you to animate text attributes, such as scale, position,
color, opacity, and glow in sequence through the text characters. For example, you can
create a sequence in which the text characters fall vertically into place as they scale down,
fade in, and rotate.

After applying the Sequence Text behavior to a text layer, you must designate the
parameters of the text that you want to animate. You do this in the Behaviors tab of the
Text Inspector. Once you’ve linked the desired text parameter(s) to the behavior, you can
use the Sequence Text controls to adjust the animation’s direction, speed, number of
loops, and other qualities.

All of the Text Sequence behaviors (in the Text Sequence subcategory) are presets based
on the Sequence Text behavior. The Text Sequence presets contain the same controls
and are modified in the same manner as the Sequence Text behavior.

Tip: Using the Adjust Glyph tool, you can modify individual text characters independently
of the influence of the applied sequence text behavior. For information on using the
Adjust Glyph tool, see Working with Text Glyphs.

Note: The Text Sequence behavior shares many parameters with the Sequence Replicator
behavior. For more information on sequencing replicator patterns, see Using the Sequence
Replicator Behavior.

Once you have created a Sequence Text behavior, you can save the behavior to the
Library. For information on saving a modified behavior to the Library, see Saving a Modified
Text Behavior to the Library.

853Chapter 14 Animating Text



Using the Sequence Text Behavior
Applying and activating a Sequence Text behavior is a two-step process: First, you add
the Sequence Text behavior to a text layer. Second, you assign the parameters of the text
that you want to animate, either in the Behaviors tab of the Text Inspector or by
manipulating the text object with the onscreen controls. Once you’ve linked the desired
text parameter(s) to the behavior, you can use the Sequence Text controls in the Behaviors
tab to adjust the animation’s direction, speed, number of loops, and other qualities.

To apply the Sequence Text behavior
µ Select the text layer to be animated, click the Add Behavior icon in the Toolbar, then

choose Text Animation > Sequence Text.

The behavior is applied, and the first character of text is selected with the Adjust Item
tool.

Important: Unless you are using the onscreen controls (via Adjust Item tool) to create a
sequence, you must explicitly add at least one parameter to the behavior from within
the Inspector before any animation can occur. Until a parameter is added, adjustments
made in the HUD have no effect.

To create a sequence animation using the Inspector
1 With the Sequence Text behavior selected, display the Behaviors tab in the Inspector.
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The upper area of the Sequence Text controls contains the Add and Remove pop-up
menus, which are used to select the text parameters to be sequenced, or to remove
parameters once they have been added. The second group of parameters are the sequence
Controls, which include options for setting the direction and speed of the animation,
whether the animation is applied per character, per word, per text layer, and so on.

In this simple example, Opacity, Scale, and Glow scale are sequenced.
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2 In the Parameter row, click the Add pop-up menu, then choose Format > Opacity.

The Opacity parameter is added in the Behaviors tab above the Add and Remove pop-up
menus.

3 In the Inspector, set Opacity to 0 and play the project (press Space bar).

Because the Sequencing parameter is set to From by default, the opacity sequences from
the value set in the behavior (0%) to original value of the text (100%).

4 Click the Sequencing pop-up menu and select To.

Now when you play the project from the beginning, the opacity fades to the value set in
the behavior (0%) from the original value of the text (100%).

5 Click the Add pop-up menu, choose Format > Scale, then click again and choose Glow
> Scale.

The Scale and Glow Scale parameters are added to the Behaviors tab.
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6 In the Behaviors tab, set Scale to 250%, set Glow Scale to 250%, then set Spread (in the
Controls group) to 4.

The opacity sequences to the values defined in the behavior from the original values. The
increased spread value softens the sequence between the characters.

Note: While the style effects created in the Sequence Text behavior (Face, Outline, Glow,
and Drop Shadow) are independent of changes to the parameters in the Style pane of
the Text Inspector (Face, Outline, Glow, and Drop Shadow), changes made in the Style
pane do affect the sequenced text. For example, if you select the Glow checkbox in the
Style pane after adding Glow to the Sequence Text behavior, the appearance of the glow
may alter. This is because the Glow settings in the Style pane are additive to the sequence
behavior (the glow may appear brighter or more blurred). In the following illustration,
the glow is scaled and offset in the Style pane.

The above example touches only a portion of the options in the Sequence Text behavior.
Using the behavior’s parameters, you can create a nearly endless variety of sequences.
You can define the speed in which the sequence moves through the text, as well as
whether the sequence moves through the text per character, word, or line. You can also
change the direction of the sequence and define the number of times the sequence loops
over its duration. Variance and randomization can also be added to values defined in the
behavior. For more information on these controls, see Sequence Text Controls.
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To create a sequence animation using onscreen controls
1 With the Sequence Text behavior applied and the first letter (glyph) selected, do one of

the following:

• To sequence the position of the text, drag the character in the Canvas to a new position.
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In the Behaviors tab, the Position parameter is automatically added to the Format
category (above the Add and Remove parameter pop-up menus). The values in the
Position parameter can be modified in the Inspector (using the Position value sliders)
as well as in the Canvas (by dragging the glyphs of the text object.

Position is added to the 
sequence parameters.

• To sequence the rotation of the text, rotate the selected glyph in the Canvas. To display
the rotation controls, hold the Command key down. For more information on using
the onscreen transform controls, see 3D Transform Onscreen Controls.
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In this example, the text is rotated on its Y axis. In the Behaviors tab, the Rotation
parameter is automatically added to the Format category Format category (above the
Add and Remove parameter pop-up menus).

• To sequence the scale of the text, scale the selected glyph in the Canvas by dragging
a scale handle. (To scale the text uniformly, press Shift while dragging the scale handle
in the Canvas.)

In the Behaviors tab, the Scale parameter is automatically added to the Format category
(above the Add and Remove parameter pop-up menus).

Note that in the Controls section of the Behaviors tab, the Sequencing pop-up menu
is set to “From,” the default setting. As a result, upon playback, the text in your project
moves from the value in the Position parameter to the original value (the position of
the text before you dragged it in the Canvas).

2 Play the project (press Space bar).

The text animates from the modified position, rotation, or scale value to its original value
(its value before you manipulated the glyph in the Canvas.

For more information on the Sequence Text parameters, see Sequence Text Controls.

Note: When using the Sequence Text behavior, glyphs are selected with the Adjust Item
tool rather than the Adjust Glyph tool. This allows you to modify text characters
independently of the sequence behavior. For more information on the Adjust Glyph tool,
see Working with Text Glyphs.
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When a glyph is selected with the Adjust Item tool, a section of the mini-Timeline and
Timeline are highlighted. This area shows when the currently selected glyph is affected
by the sequence behavior.

Highlighted area 
indicates the animation 
location (in time) of the 
selected glyph.

To remove a parameter from the sequence behavior
µ In the Parameter row of the Behaviors tab, choose a parameter from the Remove pop-up

menu.

The parameter is removed from the behavior.

To create a softer transition between each text unit
µ In the Behaviors tab, drag the Spread slider to the right (or type a number in the value

slider).

Spread value set to 0 Spread value set to 11
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Using the Text Style Pane With the Sequence Text Behavior
Parameters that you want to include in a sequence animation are assigned in the Sequence
Text behavior. Attributes that are modified in the Style pane of the Text Inspector (Face,
Glow, Outline, or Drop Shadow) do not sequence. Therefore, if you want to modify a
specific parameter but want it to remain unchanged over the course of a sequence
animation, modify that parameter in the Style pane of the Text Inspector. For example,
you can create a sequence in which the text glow scales and fades (by setting Glow >
Scale and Glow > Opacity in the Sequence Text behavior), but where the text outline
remains constant (by setting the Outline parameters in the Style pane of the Text
Inspector).

Note: Because the parameters set in the Sequence Text behavior are independent of the
parameters set in the Style pane, you may see changes in the appearance of certain
attributes when you select parameter checkboxes in the Style pane. For example, if you
create a sequence that animates text glow and then select the Glow checkbox in the
Style pane of the Text Inspector, the effect is additive. The glow in the Style pane is added
to the glow created in the Sequence Text behavior.

To use the Style pane with the Sequence Text behavior
1 With the text object selected, click the Text tab in the Inspector, then click the Style pane.

2 In the Face controls, change the color of the text to something other than white. For
more information on using the color controls, see Color Controls.

3 Select the Outline checkbox and modify some Outline parameters.

4 Click the Add Behavior icon in the Toolbar, then choose Text Animation > Sequence Text
from the pop-up menu.

5 In the Behaviors tab, choose Face > Color from the Add pop-up menu.

The text turns default white. When the Sequencing pop-up menu is set to the default
“From,” the sequence behavior animates from the values defined in the Sequence Text
behavior to the original values of the text. Prior to applying the Sequence Text behavior,
the text color was defined in the Style pane, so this is considered the original color.

6 Play the project.

The text color sequences from the color defined in the Sequence Text behavior to the
original color of the text. The outline does not sequence.

Using the Custom Sequencing Option
When Custom is selected from the Sequencing pop-up menu, you can create your own
sequence by keyframing parameters. The following simple example creates a position
sequence.

To create an animation using the Custom Sequencing option
1 Select the text layer to be animated, click the Add Behavior icon in the Toolbar, then

choose Text Animation > Sequence Text.
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2 In the Behaviors tab, choose Custom from the Sequencing pop-up menu.

3 Drag the playhead to the frame where you want to begin the animation, then click the
Record button (or press A) to turn on keyframing.

When keyframing is on, parameters that can be animated appear pink in the Inspector.

4 Do one of the following:

• In the Behaviors tab, choose Format > Position from the Add pop-up menu, then use
the Position value sliders to define the beginning (or ending) position of the text.

• In the Canvas, drag the selected text character to its beginning (or ending) position.

A keyframe is added to the Position parameter.

5 Go to the next frame where you want to set a position keyframe, and do one of the
following:

• In the Behaviors tab, enter a new Position value.

• In the Canvas, drag selected text to a new position.

A second position keyframe is created.

6 Repeat Step 5 until you have added all of your keyframes.

Notice that an editable animation path appears in the Canvas. This appears only when
Custom is selected from the Sequencing pop-up menu.
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For more information on working with animation paths, see Manipulating Animation
Paths in the Canvas.

Note: If you change the Sequencing parameter to another option, such as Through
Inverted or To, and then change Sequencing back to Custom, the custom animation path
is retained.

Sequencing the Distortion of Style Attributes
In addition to using the value fields and sliders in the Inspector, you can use onscreen
controls to sequence the Four Corner parameter, creating warp effects that manipulate
the text Face, Outline, Glow, or Drop Shadow parameters. In the following simple examples,
text Glow, Outline, and Drop Shadow parameters are sequenced.

To sequence the warping of a text glow effect
1 Select the text layer to be animated, click the Add Behavior icon in the Toolbar, then

choose Text Animation > Sequence Text.

2 In the Parameter row of the Behaviors tab, choose Glow > Four Corner from the Add
pop-up menu.

In the Inspector, the Glow Four Corner parameter is added to the sequence above the
Add and Remove pop-up menus. The Four Corner parameter is used to distort the text’s
glow attribute, allowing you to use onscreen controls to “pull” the glow around the text.
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3 In the lower portion of the Behaviors tab of the Inspector, choose Glow from the Attribute
pop-up menu.

The onscreen controls appear that allow you to shear or four-corner adjust the attribute.

Shearing handles

Corner handles
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4 Do one of the following:

• To shear the glow, drag a shearing handle.

• To warp the glow, drag a corner handle.

Note: You can also use the value sliders in the Four Corner parameter in the Behaviors
tab. Click the Four Corner disclosure triangle to show the Bottom Left, Bottom Right,
Top Right, and Top Left controls.

Some characters may not appear affected when you drag in the Canvas. However,
when you play the project, all characters are affected.

5 Play the project.

The glow distortion is sequenced through the text, based on the settings in the Sequence
Text behavior parameters.

The following task describes an optional workflow in which you can distort text face,
glow, outline, or drop shadow using the above steps, but without using the Add pop-up
menu.

To sequence the warping of a text glow effect without using the Add pop-up menu
1 In the lower portion of the Behaviors tab of the Inspector, choose Glow from the Attribute

pop-up menu.
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Onscreen controls appear that allow you to distort the text attribute. No parameters are
added to the Inspector (above the Add pop-up menu) until the onscreen controls are
adjusted.

2 Do one of the following:

• To shear the glow, drag a shearing handle.

• To warp the glow, drag a corner handle.

Once you adjust a handle, the Four Corner parameter is added to the sequence above
the Add and Remove pop-up menus.

Note: You can also use the value sliders in the Four Corner parameter in the Behaviors
tab. Click the Four Corner disclosure triangle to show the Bottom Left, Bottom Right,
Top Right, and Top Left controls.

3 Play the project.

The glow distortion is sequenced through the text, based on the settings in the Sequence
Text behavior parameters.

Sequence Text Controls
The Sequence Text behavior has the following parameter controls in Behaviors tab.

Parameter (Add and Remove): Use the Add and Remove pop-up menus to add and
remove text format and style parameters to the sequence. Once a parameter is chosen,
its controls appear above the Add and Remove pop-up menus. There are five menu
items—Format, Face, Outline, Glow, and Drop Shadow—each of which invokes additional
submenu items.

• Format: Choose any of eight Format parameters from the submenu: Position, Opacity,
Scale, Rotation, Tracking, Baseline, Slant, or Character Offset. With the exception of
Character Offset, these parameters are also found in the Format pane of the Text
Inspector. (For more information on the text format parameters, see Editing Text Format.)
Choose the Character Offset option to offset characters alphabetically or numerically.
The amount of the offset is determined by the value set in the parameter. In the
following illustrations, Character Offset and Position are sequenced. The Character
Offset Value is 3. The words move in sequence from the character offset value to form
the original words: “offset 123.”
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When you choose Format > Character Offset from the Add pop-up menu, the Character
Set pop-up menu appears in the Behaviors tab. There are two menu options: Preserve
Case & Digits and Full Unicode. Choose Preserve Case & Digits to ensure that offset
characters respect the case and number of the original text. For example, with this
option selected, an uppercase letter will remain uppercase as other letters cycle through
its position.

Note: Using the onscreen controls to manipulate the scale, position, or rotation of the
text unit automatically adds Format parameters to the Sequence Text behavior. For
more information on using the onscreen controls to sequence text, see Using the
Custom Sequencing Option.

• Face: The second item in the Add pop-up menu. Choose any of four Face (color fill)
parameters for sequencing: Color, Opacity, Blur, or Four Corner. For more information
on the text face parameters, see Text Face Controls in the Style Pane.

• Outline: Choose any of six Outline parameters for sequencing: Color, Opacity, Blur,
Width, Layer Order, or Four Corner. For more information on text outline parameters,
see Text Outline Controls in the Style Pane.

• Glow: Choose any of eight Glow parameters for sequencing: Color, Opacity, Blur, Radius,
Scale, Offset, Layer Order, or Four Corner. For more information on text glow parameters,
see Text Glow Controls in the Style Pane.

• Drop Shadow: Choose any of seven Drop Shadow parameters for sequencing: Color,
Opacity, Blur, Scale, Distance, Angle, and Four Corner. For more information on text
drop shadow parameters, see Text Drop Shadow Controls in the Style Pane.

Sequencing: This pop-up menu sets how the sequence animation moves through the
text unit. (A text “unit” can be a character, word, line, or an entire text object, as set in
the Unit Size pop-up menu, described below.) There are five items in the Sequencing
pop-up menu:

• To: Specifies that the animation begins at the original parameter value and moves to
the value set in the sequence behavior. For example, if the original opacity value is
100%, and opacity is set to 0% in the Sequence Text parameters, the text unit begins
completely opaque and becomes completely transparent.

• From: Specifies that the animation moves from the value set in the sequence behavior
to the original parameter value. For example, if the original opacity value is 100% and
opacity is set to 0% in the Sequence Text parameters, the text unit begins completely
transparent and becomes completely opaque. This is the opposite of the To option in
the Sequencing pop-up menu.
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• Through: Specifies that the sequence goes through a full animation cycle starting at
the original value of the parameter, moves to the value set in the sequence behavior,
and then returns to the original value of the parameter. For example, if the original
opacity value is 100%, and opacity is set to 0% in the Sequence Text parameters, the
text unit begins completely opaque, becomes transparent, and then becomes
completely opaque again.

• Through Inverted: Specifies that the sequence goes through an inverted animation cycle
starting from the value set in the sequence behavior, moves to the original value, and
then returns to the value set in the sequence behavior. For example, if the original
opacity value is 100%, and opacity is set to 0% in the Sequence Text parameters, the
text unit begins completely transparent, becomes opaque, and then becomes
completely transparent. This is the opposite of the Through Sequencing option.

• Custom: Allows you to keyframe how the animation moves through the values set in
the Sequence Text parameters. When Custom is selected from the Sequencing pop-up
menu, the Minimum and Maximum parameters in the Variance controls (see description
below) are replaced with the Amount parameter, and the Fix pop-up menu appears.

Unit Size: Specifies whether the animation is sequenced by Character (the default setting),
Character (without spaces), Word, Line, All, or Custom (a keyframed range).

• Character: Sequences the animation by single characters of text (including spaces).

• Character (without spaces): Like the Character setting, sequences single characters of
text, but does not treat spaces as characters (spaces are ignored).

• Word: Sequences the animation by word.

• Line: Sequences the animation by lines of text.

• All: Sequences the animation through the entire text object.

• Custom: Allows you to customize the size of the sequenced text unit. When Custom is
selected from the Unit Size pop-up menu, the Start and End parameters become
available. These parameters define the size of the selection.

Start: Available when Unit Size is set to Custom, defines the starting point of the selection
to be sequenced.

End: Available when Unit Size is set to Custom, defines the ending point of the selection
to be sequenced.

Spread: Controls the amount of falloff at the beginning and end of the sequencing. To
create a softer transition between each text unit, increase the Spread value.

Direction: Sets the direction of the sequencing to Left to Right (default), Right to Left,
Center to Edges, Edges to Center, or Random.

• Left to Right: Sequences left to right.

• Right to Left: Sequences right to left.

• Center to Edges: Sequences from the center of the text outwards.
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• Edges to Center: Sequences from the outer edges of the text inwards.

• Random: Randomizes the direction of the sequencing. When Random is selected from
the Direction pop-up menu, the Random Seed parameter becomes available.

Random Seed: Available when Direction is set to Random, allows you to change the
current “randomness” (seed number) of the direction of the sequence by typing a new
number or clicking the Generate button.

Speed: Sets the action of the sequence behavior to Constant, Ease In, Ease Out, Ease
Both, Accelerate, Decelerate, or Custom.

Note: By default, the sequence animation lasts as long as the text layer to which it is
applied. You can speed or slow the behavior by adjusting its bar in the mini-Timeline or
Timeline. For more information, see Changing the Speed of Text Behaviors.

• Constant: The sequence animation moves from one end of the text to the other at a
constant rate. The sequence moves in the direction specified in the Direction pop-up
menu.

• Ease In: The sequence animation begins slowly and increases to normal speed as it
moves through the text.

• Ease Out: The sequence animation begins at normal speed and slows toward the end
of the text.

• Ease Both: The sequence animation begins slowly, increases to normal speed as it
moves toward the middle of the duration of the text, and slows as it reaches the end
of the text.

• Accelerate: The rate of the sequence animation increases as it moves through the text.

• Decelerate: The rate of the sequence animation decreases as it moves though the text.

• Custom: Allows you to keyframe how the selection (the animation) moves through the
text. When Custom is selected from the Speed pop-up menu, the Custom Speed
parameter becomes available.

Custom Speed: Available when Speed is set to Custom, allows you to keyframe the
completion of the sequencing by defining the location of the text where the animation
is in effect.

Loops: Sets the number of times the animation sequences through the text over its
duration.

Apply Speed: Controls the speed of the sequencing over multiple loops.

• Once Per Loop: The setting chosen in the Speed pop-up menu is applied one time for
each loop. For example, if Speed is set to Accelerate, the rate of the sequence animation
increases as it moves through the text for every loop.
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• Over Entire Duration: The setting chosen in the Speed pop-up menu is applied one time
for the length of the behavior. For example, if Speed is set to Accelerate, the rate of
the sequence animation increases as it moves through the text over the entire duration
of the behavior, regardless of the number of loops.

• Per Object: The setting chosen in the Speed pop-up menu is applied one time for each
object for every loop. For example, if Speed is set to Accelerate, the rate of the sequence
animation increases as it moves through each text object for every loop.

End Condition: Specifies how the animation is applied to the end of the sequence
animation.

• Hold: Completes the sequence animation cycle one time, then starts it over again from
the beginning (once the last text unit in the sequence has completed its animation).

• Wrap: Treats the sequence animation as a continuous loop so the spread wraps from
the last text unit in the sequence to the first text unit.

• Ping-Pong: Completes the sequence animation cycle forward, then completes the
animation backward, then forward, and so on.

End Offset: Offsets the end of the effect of the sequence behavior. By default, the
sequence animation is in effect until the end of the behavior. For example, to stop the
sequencing 60 frames from the end of the text layer (or project), drag the End Offset
slider to 60 or enter 60 in the value slider. Using this slider to stop the effect, instead of
trimming the end of the behavior in the Timeline, freezes the end of the effect for the
remaining duration of the object. Trimming the end of the behavior resets the text to its
original settings.
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Variance: This group of controls allows you to randomize the attributes assigned to
sequence through the text. For example, if you add variance to a scale sequence, the text
scale is randomized rather than moving strictly from the original Scale value to the Scale
value defined in the sequence behavior. These sliders control the frequency of the
randomness. When sequencing is set to To, From, Through, or Through Inverted, it is
useful to see how the Variance numbers affect the randomness. The following image
shows a sequence animation in which the Y Position is offset. When a low variance value
(or “frequency”) is applied, the randomness is very smooth along the line of text—like
the text is riding a very slow and smooth wave.

As the variance is increased, the randomness increases across the line of text—the text
is riding on very short and frequent waves so they are offset in Y with more randomness.

When Custom is chosen from the Sequencing pop-up menu, the same principle applies
in that a low variance value causes the text to offset from its animation with a smooth
path, while a high variance causes more randomness.

Note: The Variance parameters are sensitive, so keep in mind that low values are necessary
for smooth animation results.

• Variance: Allows you to fluctuate the values of the attributes assigned to sequence
through the text. For example, if you add variance to an opacity sequence, the text
opacity is randomized rather than moving strictly from the original Scale value to the
Scale value defined in the sequence behavior.

872 Chapter 14 Animating Text



• Minimum: Defines the lower boundary of the variance for the sequenced parameter
value. For example, if you set Minimum to 25% for a sequence that is animating text
scale, the minimum size that the text unit will scale to is 25% of the Scale value set in
the behavior.

Note: When Custom is selected from the Sequencing pop-up menu, Minimum (and
Maximum) is replaced with the Amount parameter.

• Maximum: Defines the upper boundary of the variance for the sequenced parameter
value. For example, if you set Maximum to 75% for a sequence that is animating text
scale, the maximum size that the text unit will scale to is 75% of the Scale value set in
the behavior.

Note: When Custom is chosen from the Sequencing pop-up menu, the Maximum and
Minimum sliders are replaced with the Amount slider.

• Amount: Available when Custom is chosen from the Sequencing pop-up menu, defines
the maximum amount that the animated parameter can deviate from its animation
value. For example, the following image shows a custom animation of a glyph in the
positive Y direction. When Amount is set to 50, the glyph deviates no more than 50
pixels to the left or right of the animation path (the bold red line shows the animation
path, the thinner red line displays the randomized path).

• Noisiness: Adds an additional overlay of random variance. Higher Noisiness values result
in more erratic variations in the affected parameter.

• Seed: Click the Generate button to create an initial random “seed” for creating
randomness in the Variance parameters. If you are not happy with the randomness
results when you first click Generate, click the button again or enter a value in the field.

Fix: Available when Sequencing is set to Custom, fixes the values defined in the behavior
to the start, end, or start and end of the behavior. There is also an option to not fix the
values. Variance must be greater than 0 for this parameter to have any effect.

• Start Point: When variance is applied, the values defined in the Sequence Text behavior
(above the Add and Remove pop-up menus in the Behaviors tab) at the start and at
the end of the behavior are fixed to the first frame of the behavior.
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In the following images, the text position is sequenced. Fix is set to Start Point.

• End Point: When variance is applied, the values defined in the Sequence Text behavior
(above the Add and Remove pop-up menus) at the start and at the end of the behavior
are fixed to the last frame of the behavior.

In the following images, the text position is sequenced. Fix is set to End Point.

• Both: When variance is applied, the values defined in the Sequence Text behavior
(above the Add and Remove pop-up menus) at the start and at the end of the behavior
are fixed to the first and last frames of the behavior.

• Neither: When variance is applied, the values defined in the Sequence Text behavior
(above the Add and Remove pop-up menus) at the start and at the end of the behavior
are not fixed to the first or last frames of the behavior.

In the following images, the text position is sequenced. Fix is set to Neither.

Attribute: In addition to sequencing text attributes such as outlines, glows, and drop
shadows, you can sequence the warping of those attributes. Use the Attribute pop-up
menu to select the attribute you want to modify.
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Note: The Attribute pop-up menu also appears in the HUD when the Adjust Glyph tool
is selected in the Toolbar. For more information on using the glyph tool, see Working
with Text Glyphs.

• Transform Glyph: Displays the glyph onscreen controls, allowing for the selection of
individual characters of a text object for direct manipulation.

For more information about sequencing using the glyph onscreen tools, see Using the
Custom Sequencing Option.

• Face: Displays onscreen controls that allow you to modify the shape, size, and position
of the face (color fill) of text characters.

• Outline: Displays onscreen controls that allow you to modify the shape, size, and position
of the outline of text characters.

• Glow: Displays onscreen controls that allow you to modify the shape, size, and position
of the glow of text characters.

• Drop Shadow: Displays onscreen controls that allow you to modify the shape, size, and
position of the drop shadow of text characters.

For more information about sequencing the warping of text attributes, see Sequencing
the Distortion of Style Attributes.

Position Type: When offsetting text attributes such as glows and outlines from text
objects that contain characters of different sizes, this pop-up menu specifies whether an
attribute is offset from the text uniformly (choose Absolute), or offset based on the size
of text characters (choose Relative).

• Absolute: When offsetting attributes, such as glows, shadows, and so on from text
objects, choose Absolute to create an even offset regardless of the size of the text
characters.

In the following image, the yellow glow is uniformly offset from the white text because
Absolute is chosen from the Position Type pop-up menu.

• Relative: When offsetting attributes, such as glows, shadows, and so on from text
objects, choose Relative to create an offset based on the size of the text characters.
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In the following image, the yellow glow is offset from the white text based on the size
of the text characters because Relative is chosen from the Position Type pop-up menu.

Scroll Text Behavior
The Scroll Text behavior allows you to quickly create scrolling or crawling text. Scroll Text
can also be applied to other objects, such as shapes and images, to create integrated
credits, prologues, and so on.

When the Scroll Text behavior is applied to text, whether the text is imported (RTF or TXT
files) or created in Motion, the Scroll Direction is set to Vertical by default (in the Behaviors
tab) and the layout is automatically set to Scroll in the Layout pane of the Text Inspector.
When Scroll Direction is set to Horizontal, layout is automatically set to Crawl in the Layout
pane of the Text Inspector. When the Scroll Text behavior is actively applied to text, you
cannot change the Layout Method parameter unless the Allow Layout Override checkbox
is selected.

Note: The Adjust Glyph tool is not available with the Scroll or Crawl layout methods.

To create a vertical scroll
1 Apply the Scroll Text behavior (from the Text Animation behavior category) to the layer

you want to animate.

For information on applying text behaviors, see Applying a Text Behavior.

Because the Scroll Direction is set to Vertical and the Start Off-Screen checkbox selected
by default, the layer shifts to below the Canvas for the beginning of the scroll. The
direction, position, and speed of the scroll can be changed in the Inspector or HUD.

2 Click the Play button.

The layer automatically scrolls upward in the Canvas.

3 To edit the text, double-click the text in the Canvas.
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The text stops scrolling, the ruler appears at the top edge of the text, and the scroll control
becomes available at the right edge of the text. To continue playback, deselect the text
by pressing Esc or clicking in an empty area of the Layers tab or the Timeline layers list.

For more information on the scroll controls, see Non-Path Text Controls in the Layout
Pane.

4 To customize the scroll, use the parameters in the Behaviors tab of the Inspector.

For more information on the Scroll Text behavior parameters, see Scroll Text Controls.

To create a horizontal scroll
1 Apply the Scroll Text behavior (from the Text Animation behavior category) to the layer

you want to animate.

For information on applying text behaviors, see Applying a Text Behavior.

2 Select Horizontal from the Scroll Direction pop-up menu in the Scroll Text HUD or
Behaviors tab of the Inspector.

Because the Start Off-Screen checkbox is selected by default, the layer shifts off the Canvas
to the right for the beginning of the crawl. The text is positioned in a single line and
Layout Method set to Crawl in the Layout pane of the Text Inspector.

The direction, position, and speed of the scroll can be changed in the Inspector or HUD.

3 Click the Play button.

The layer automatically crawls left in the Canvas.

4 To edit the text, double-click the text in the Canvas.

The text stops scrolling and the scroll control becomes available at the lower edge of the
text. To continue playback, deselect the text by pressing Esc or clicking in an empty area
of the Layers tab or Timeline layers list.

For more information on the scroll controls, see Non-Path Text Controls in the Layout
Pane.

5 To customize the scroll, use the parameters in the Behaviors tab of the Inspector.

For more information on the Scroll Text behavior parameters, see Scroll Text Controls.

To change the speed of the scroll in the Timeline
µ In the Timeline, do one of the following:

• Drag the behavior’s bar to the left to speed up the scroll.

• Drag the behavior’s bar to the right to slow down the scroll.

For more general information about adjusting behaviors in the Timeline, see Changing
the Timing of Behaviors.

Scroll Text Controls
Use the parameters in the Inspector to adjust the direction, rate, and position of the scroll.
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Scroll Direction: Sets the direction of the text scroll to vertical or horizontal.

• Vertical: Scrolls the text vertically in the Canvas.

• Horizontal: Scrolls the text horizontally in the Canvas.

Speed Control: Sets the speed of the scroll or crawl to Automatic, Fixed, or Custom.

• Automatic: The speed of the scroll is determined by the length of the behavior in the
Timeline. In other words, the length of the behavior determines how long it takes the
entire layer to scroll or crawl across the Canvas. By default, the duration of an applied
Scroll Text behavior is the same as the layer or group to which it is applied.

• Fixed: Determines the speed of the scroll based on the value in the Scroll Rate parameter
(pixels per second).

• Custom: Specifies the start and end positions (defined as offsets from the current
position) of the scrolling layer.

Scroll Rate Mult: Available when Speed Control is set to Automatic, multiplies the rate
of the scroll by the amount in the slider. Amounts higher than those available in the slider
can be entered in the value slider.

Scroll Rate: Available when Speed Control is set to Fixed, sets the speed of the scroll in
pixels per second.

Reduce Flicker: Modifies the speed of the scroll to reduce flickering on interlaced or
progressive displays. When Scroll Direction is set to Vertical and Speed Control is set to
Automatic or Custom, the options are None, Progressive, or Interlaced. When Scroll
Direction is set to Horizontal and Speed Control is set to Automatic or Custom, the options
are No or Yes.

• None: Available when Scroll Direction is set to Vertical. Has no effect on the speed of
the scroll.

• Progressive: Available when Scroll Direction is set to Vertical, prevents flicker on a
progressive display (such as an LCD television). This is not guaranteed to prevent flicker
on an interlaced display (such as a CRT television).

• Interlaced: Available when Scroll Direction is set to Vertical, prevents flicker on a
progressive display (such as an LCD television) or on an interlaced display (such as a
CRT television).

Note: Because the minimum speed to prevent flicker on an interlaced display is 2 pixels
per frame, and the minimum speed to prevent flicker on a progressive display is 1 pixel
per frame, the Interlaced option may result in faster scroll rates.

• No: Available when Scroll Direction is set to Horizontal, does not modify the scroll
speed in order to reduce flickering on interlaced or progressive displays.

• Yes: Available when Scroll Direction is set to Horizontal, modifies the speed of the scroll
to reduce flickering on interlaced or progressive displays.
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Allow Layout Override: Allows the text layout be manually changed. For example, when
horizontally scrolling imported RTF text, the text is automatically placed in a single line.
If the Allow Layout Override checkbox is selected, the text retains its paragraph form.

Note: This parameter is available only when the Scroll Text behavior is applied to a text
layer.

Start Off-Screen: When this checkbox is selected, the text is automatically moved to an
off-Canvas position for the start of the scroll.

Text Tracking Behavior
The Text Tracking behavior applies rate of change to the Tracking parameter of the Format
pane (in the Text Inspector). Tracking applies a uniform space between each character
of text.

To use the Text Tracking behavior
µ Apply the Text Tracking behavior (from the Text Animation subcategory) to the text.

By default, a Tracking rate of 10% is applied to the text.

As the project plays, the characters spread out based on the rate set in the Rate parameter
of the Text Tracking behavior.

Note: Just like the Tracking parameter in the Format pane of the Text Inspector, the Text
Tracking behavior respects the Alignment setting of the text. For example, to track from
the center of the text outward, the Alignment of the text must be set to Center. This
parameter is located in the text HUD or the Layout pane of the Text Inspector.
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Use the Text Tracking parameters to modify the rate and end offset of the character
tracking. The identical Text Tracking behavior parameters appear in the Text Tracking
HUD and in the Behaviors tab of the Inspector.

Text Tracking Controls
Use the Text Tracking parameters to control the rate and end offset of the tracking
animation.

Rate: Controls the rate of the change in tracking values. The higher the rate, the greater
the tracking values.

End Offset: Offsets the end of the effect of the Tracking parameter. By default, the text
characters track to the end of the duration of the text. For example, to stop the tracking
animation 60 frames from the end of the text layer (or project), drag the End Offset slider
to 60 or enter 60 in the value slider.

Note: Be sure to use the End Offset parameter to stop the effect of the tracking behavior
before the end of the text layer (or project) rather than changing the duration of the
Tracking behavior in the mini-Timeline or Timeline. If you trim the end of the behavior,
the text snaps back to its default tracking value at the end of the behavior.

Type On Behavior
The Type On behavior quickly creates a “type-on” effect.

To use the Type On behavior
µ Apply the Type On behavior (from the Text Animation subcategory) to the text layer.
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By default, the text “pops” on. To create a softer fade-in effect, enable Fade In in the Type
On HUD or Inspector.

Because the Type On behavior is applied to the duration of the text layer to which it is
applied, it takes the duration of the layer to complete the type-on effect. You can modify
the timing of the effect by resizing the mini-Timeline or Timeline bar.

Use the following guidelines to modify the default Type On behavior. The Type On controls
include only a single parameter: Fade In. The identical Type On behavior parameters
appear in the HUD and the Inspector.

As mentioned above, the type-on effect occurs over the duration of the text layer to
which it is applied. In other words, if your text layer is 300 frames long and you apply the
Type On behavior, the last text character is fully typed on at frame 300. You can shorten
the duration of the behavior so the type-on effect is completed sooner.

To increase the speed of the type on effect
1 Select the Type On behavior.

The Type On behavior is selected in the mini-Timeline and Timeline.

2 Do one of the following:

• In the mini-Timeline, click the right end of the Type On bar and drag toward the left
to the frame where you want the animation to end. As you drag, the new Out point,
the duration of the behavior, and the delta (amount of change) are displayed.

• Go to the frame where you want to set the new Out point, then choose Mark > Mark
Out (or press O).

By the time the playhead reaches the end of the new behavior duration bar, the type
on effect is complete.
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Note: You can also slow the type-on effect by extending the behavior beyond the duration
of the text layer.

Type On Controls
The Type On behavior contains only the Fade In parameter.

Fade In: When selected, each text character fades in rather than appearing with the
default “pop” effect.

Note: You can also create this type of animation using Type On parameter group in the
Layout pane of the Text Inspector. For more information, see Creating a Type-On Effect.

Preset Text Sequence Behaviors
Although the behaviors in the Text Sequence behavior subcategory are predefined
animations, values can be modified and other parameters added, or existing parameters
removed. For example, the Awaken In behavior (from the Basic group) automatically
animates text Opacity, Scale, and Rotation values (Format parameters) by default. However,
you can add a parameter, such as Position, to the behavior.

The Text Sequence behaviors are applied to text layers in the same manner as all other
behaviors. However, there is one big difference between the Text Sequence behaviors
and all other behaviors in Motion: Once added to text, the Text Sequence behaviors do
not last the duration of the text. This is because usually—to achieve the desired preset
effect—you want the animation to complete in a shorter period of time than over the
duration of the text. The default duration of the behavior can be modified to slow down
or speed up the effect of the animation.

All of the sequence behaviors are preset versions of the Sequence Text behavior in the
Text Animation subcategory. For more information on the Sequence Text behavior, see
Sequence Text Behavior.

As with all behaviors, you can save a modified behavior to the Library as your own custom
behavior. For more information, see Saving a Modified Text Behavior to the Library.

As with Text Animation and other behavior subcategories, clicking a behavior in the
Library stack plays the animation in the Preview area.

The following section discusses applying and customizing a preset behavior from Text
Sequence category.

Customizing a Text Sequence Behavior
In this section, the Flare In behavior (from the Glow group) is used to show how to modify
a Text Sequence behavior.

The following steps begin at the first frame of the text.
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To modify the Flare In behavior
1 Select the text layer to be animated, click the Add Behavior icon in the Toolbar, then

choose Text-Glow > Flare In.

At the first frame, the text is not visible because Face opacity and Glow opacity are
animating from 0% to 100%.

2 Click Play (or press the Space bar).

The text characters fade in from 0% to 100% percent opacity, and sharpen in from a blur
value of 10. A glow rides the effect in as the text appears.

3 With the Flare In behavior selected, click the Behaviors tab (if it is not already open).

The Inspector lists the specific text parameters used to create the animation (above the
Add and Remove pop-up menus). The sequence Controls are not disclosed by default.

Although most of the sequence Controls appear in the Flare In HUD, the Add and Remove
pop-up menus (and the parameters they affect) do not.
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Note: In the Canvas, an editable animation path appears with the selected text. This is
because Sequencing is set to Custom. For more information, see Using the Custom
Sequencing Option.

4 In the Parameter row of the Behaviors tab, choose Format > Rotation from the Add pop-up
menu.

A Rotation parameter is added to the sequence.
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Tip: Because most of the preset text sequence behaviors are keyframed, it is often helpful
to see where the keyframes occur when customizing. Click the Timing icon in the Toolbar,
or choose Window > Timeline to show the Timeline. In the Timeline, click the Show/Hide
Keyframes button. The keyframes are displayed on the behavior’s bar.

Show/Hide Keyframes 
button

5 Move the playhead to frame 1, then click the Record to turn on keyframing.

6 In the Behaviors tab, set the Rotation dial to 90.

7 Play the project (press the Space bar).

Because the Rotation parameter has only a single keyframe, the text remains static at
90 degrees.

8 Move the playhead to frame 30, and set Rotation to 0.

Now that you’ve set a second keyframe value, the sequence is now animated.

Note: You can edit the keyframes in the Keyframe Editor. For more information, see
Keyframes and Curves.

9 Return the playhead to frame 1 and play the project (press the Space bar).
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As the project plays, the text rotates from 90 degrees to 0 degrees.

You can quickly change the color or other attributes of the text glow by using the Glow
controls in the Style pane of the Text Inspector.

Changing the Default Settings in the Text Sequence Behaviors
Text Sequence behaviors use default text settings, such as glow color (yellow) and
alignment (left). You can quickly change these settings in the Inspector.

To change the default glow color of a preset sequence behaviors in the Text Style pane
1 Select the text sequence behavior.

2 In the Inspector, click Text tab, then click the Style pane.

Glow is not selected by default when using the preset Text Sequence behavior. However,
the Color well is still accessible.

3 Without selecting the Glow checkbox, choose a new color in the Color well of the Glow
controls.

Important: Selecting the Glow checkbox results in an additive effect: The values defined
in the Style pane are added to those in the sequence behavior. This may cause the preset
to change in appearance.

To change the default glow color of a preset sequence behavior in the Behaviors tab
1 Select the text sequence behavior.

2 In the Inspector, click the Behaviors tab.

3 In the Parameter row, click the Add pop-up menu, choose Glow > Color.

The Color parameter is added to the Glow parameters in the behavior.

4 Use the Color controls to change the color of the glow.

To change the default text alignment for a preset sequence behavior in the Text Layout
pane

1 Select the text.

2 In the Inspector, click Text tab, then click the Style pane.
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3 Choose Center from the Alignment pop-up menu.

Setting the In and Out Points of the Text Behaviors
The In and Out Points of text behaviors are defined in the same manner as all other
objects. For more information, see Trimming Objects.

Changing the Speed of Text Behaviors
When a behavior from the Text Animation group is added to a text layer, the behavior is
the duration of that text layer. Most of the behaviors from the Text Sequence group,
however, are much shorter than the duration of the text layer.

For example, with the Awaken In behavior selected, notice that the duration of the
behavior is much shorter than the duration of the text layer to which it is applied. You
can see this in the mini-Timeline or the Timeline.

You slow down or speed up the animation by changing the duration of the behavior.

To slow the sequence animation
1 Select the sequence behavior.

2 Do one of the following:

• In the mini-Timeline or Timeline, click the right end of the behavior bar and drag toward
the right (to extend the behavior) to the frame where you want the animation to end.

• Go to the frame where you want to set the new Out point, then choose Mark > Mark
Out (or press O).

For more information, see Trimming Objects.

Note: Conversely, you can speed up the animation by shortening the duration of the
behavior.

To speed up the sequence animation
1 Select the sequence behavior.

2 Do one of the following:

• In the mini-Timeline or Timeline, click the right end of the behavior bar and drag toward
the left (shorten the behavior) to the frame where you want the animation to end.
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• Go to the frame where you want to set the new Out point, then choose Mark > Mark
Out (or press O).

For more information, see Trimming Objects.

Saving a Modified Text Behavior to the Library
As with all modified behaviors, filters, generators, and so on, you can save a modified text
behavior to the Library.

To save a modified behavior to the Library
1 Select the behavior you want to save.

Note: Although not required, it is recommended that you rename the behavior to a more
descriptive name for organizational purposes.

2 In the Library, select the location in which you want to store the behavior, such as the
Text Sequence subcategory or Favorites category.

3 From the Layers tab or Timeline, drag the behavior to the Library stack. In this example,
the behavior is dragged to the Favorites stack. When the green add pointer (+) appears
over the stack window, release the mouse button.

Customized behavior dragged to Library

The behavior is saved to the Library. A custom behavior is represented by a user icon in
the lower-right corner of the Behaviors icon.

Customized behavior saved in Library

For more information saving items to the Library and organizing your custom content,
see Adding Your Own Content to the Library.
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Using Other Behaviors with Text
Because text is like all other layers in Motion, you can apply any Basic Motion, Parameter,
or Simulation behavior to text layers. Because the characters of text make the object a
group, you can create some unique animations using the Simulation behaviors. This
section provides a quick overview to working with nontext behaviors applied to text. For
more information on using behaviors, see Using Behaviors.

Behaviors are applied to text in the same manner as all other layers—by using the Library
or the Add Behavior icon in the Toolbar. As mentioned earlier, the Library allows you to
see a preview of the behavior before it is applied to text. The Add Behavior icon allows
you to quickly apply a behavior to a single or multiple text layers.

To apply a nontext behavior to text
Do one of the following:

µ In the Library, select the Behaviors category, select a Basic Motion, Parameter, or Simulation
subcategory, and then drag the desired behavior from the stack to the text (in the Canvas,
Layers tab, or Timeline).

µ Select the text, click the Add Behavior icon, then choose the behavior you want.

In the following example, an animation is created in which the text moves and collides
with the edge of the screen. You can set the text to hit the edge as a single object, or
have each text character hit the edge one at a time.

To create a text animation using nontext behaviors
1 From the Basic Motion subcategory, apply the Throw behavior to the text.

2 Adjust the Throw so that the text moves across the Canvas.

3 From the Simulations subcategory, apply the Edge Collision and Vortex behaviors to the
text.

4 In the Inspector, select the Affect Subobjects checkbox for the Edge Collision behavior.

5 Play the project (press the Space bar).
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The text characters are swept around the screen in a vortex pattern. If the text characters
start to move off the screen, they collide with the edge of the screen.

Related Objects is the default setting in the Affect parameter of the Vortex behavior,
which means that all objects within the same group are affected. You can change this to
Specific Objects to select which layers are affected, or change it to All Objects.

Note: Remember that behaviors often contain parameters that specify how layers to
which the behavior is applied are affected. These controls greatly influence the result of
a behavior when it is applied to text. For example, if you have text on a circular path and
you apply a Spin behavior to the text, the text layer rotates as a whole around its anchor
point. To rotate the individual text characters, select the Affect Subobjects checkbox in
the Spin parameters.

Spin behavior applied to text on a path with 
Affect Subobjects turned on (the individual text 
characters spin)

Spin behavior applied to text on a path with 
Affect Subobjects turned off (the text layer as a 
whole spins)

For more information on using behaviors, see Using Behaviors.

Using Behaviors to Animate Text in 3D
Although text has no inherent 3D parameters, a text layer can moved and rotated in 3D
space. Simulation behaviors can also influence text characters to move out of their X and
Y planes into Z space. The text must be a member of a 3D group to be pulled out of the
X and Y planes by a behavior. Additionally, text on an Open Spline path can be
manipulated in 3D space.
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For example, you can apply an Orbit Around behavior to a text layer and assign a target
object that is offset in Z space. With Affect Subobjects selected and all three axes (X, Y,
and Z) enabled in the Orbit Around behavior, the text characters circle about the target
object in X, Y, and Z space.

When the Face Camera checkbox is selected (in the Text Layout pane), the text characters
actively face the camera if the camera or text is rotated.

Tip: When working with text in a 3D project, especially text that moves close to the
camera, set the Render Quality in the View pop-up menu or the View pull-down menu
to Best before exporting (choose View > Render Quality > Best). Use Normal when working
in your project, as Best mode dramatically slows your project’s interactivity. You can also
set the Render Quality on export in the Export Options dialog: Choose Export, click Options,
then choose Best from the Render Quality pop-up menu. To customize an export, turn
off the “Use current project and canvas settings” checkbox.

For more information about 3D effects in Motion, see 3D Compositing.

Animating Text with Keyframes
You can create keyframes for most of the text parameters. As with all layers in Motion,
there are two ways to create keyframes: the Record button in the transport controls or
the Animation menu in the Inspector.

Note: Most text behaviors automatically animate the text parameters without creating
keyframes. For example, when the Tracking behavior is applied to text, the tracking occurs
at the rate specified in the behavior. For more information, see Text Animation and Text
Sequence Behaviors.
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Using Keyframes Versus Using Behaviors
The text animation method you use (keyframing or behaviors) depends on your project,
or more specifically, your timing needs. In general, if you need a very specific action to
happen at a specific point in time in your project, use keyframing. For example, if you
want text to be completely transparent at frame 1, become completely opaque at frame
60, become transparent again at frame 90, and opaque again at frame 120, use
keyframing. Keyframes apply specific values to a layer’s parameters at certain frames.

If the effect is more general, for example, you want the text to be completely transparent
at frame 1, become opaque over frames 60–90, and become transparent by frame 120,
use the Fade In/Fade Out behavior. Behaviors generate a range of values that are applied
to a layer’s parameters.

You can combine keyframing and behaviors on all layers in Motion. For example, if you
keyframe text opacity, you can then apply the Tracking behavior to automatically animate
the text tracking, or you can keyframe the Tracking parameter. Keep in mind, however,
that if you keyframe the text Opacity parameter and then apply a Fade In/Fade Out
behavior to the text, unexpected results may occur. For more information on combining
behaviors and keyframes, see Combining Behaviors with Keyframes.

Keyframing Text Animation
The following examples uses keyframes to animate the Tracking and Opacity parameters
of a text object, resulting in a unique fade-in effect. You can also create this same effect
using the Fade In/Fade Out behavior (in the Basic Motion behavior category) and the
Text Tracking behavior (in the Text Animation behavior category).

To create text tracking keyframes
1 With a text object added to your project, move the playhead to the frame where you

want to start the tracking animation.

2 Select the text.

3 Enable Record (press A).

When enabled, the Record button pulses red, the animateable parameters appear pink
in the Inspector, and a keyframe is automatically created whenever you change the value
of a parameter.

4 In the Format pane of the Text Inspector, drag the Tracking slider to set the first value.

Because keyframing is enabled, a Tracking keyframe is created. The lower the Tracking
value, the closer the text characters are to each other.

5 Move the playhead to the frame where you want to end the tracking animation.

6 Drag the Tracking slider to set an end value.
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To create text opacity keyframes
1 Move the playhead to the frame where you want to start the opacity animation.

2 Open the Style pane of the Text Inspector and drag the Opacity slider to set the first
Opacity value.

3 Move the playhead to the frame where you want to end the opacity animation.

4 Using the Opacity slider, enter an end Opacity value.

5 Disable Record.

6 To view the completed animation, return the playhead to the first frame and press the
Space bar.

To view the keyframes for a text parameter in the Keyframe Editor, click that parameter’s
Animation menu icon, then choose Show in Keyframe Editor. For more information on
the Keyframe Editor, see Animating in the Keyframe Editor.

Animating with the Adjust Glyph Tool
The Adjust Glyph tool allows you to animate text characters independently of their text
layers.

To animate text characters with the Adjust Glyph tool
1 Select the text object that contains the glyph(s) that you want to modify.

2 Select the Adjust Glyph tool from the 2D transform tools in the Toolbar.

Selecting the Adjust Glyph tool activates glyph transform handles in the Canvas and adds
additional controls to the Text Hud.

3 In the Text HUD, ensure that the Attribute pop-up menu is set to Transform Glyph.

When Transform Glyph is selected, you can modify and animate the position, rotation,
and scale of the text characters. You can choose other options from the Attribute pop-up
menu to activate transform handles that modify Face, Outline, Glow and Drop Shadow
parameters of the text characters.
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4 Move the playhead to the frame where you want the animation to begin, and click the
Record button (A) to turn on keyframing.

5 In the Canvas, select and drag one or more glyphs to a new position—the start position
of the animation sequence.

6 Go to the frame you want the animation to end, and drag the glyphs to their ending
positions.

An editable animation path is created for the keyframed glyphs. You can add and remove
control points and change the shape of the path in the Canvas. For more information on
working with animation paths, see Manipulating Animation Paths in the Canvas.

7 Move the playhead back to the start frame and play the project (press the Space bar).

The glyphs animate from their starting positions to their ending positions.

Note: The other options in the Attribute pop-up menu, Face, Outline, Glow, and Drop
Shadow, can be animated in the same manner as the Transform Glyph option.

The animation path can be edited in the Canvas. For more information, see Manipulating
Animation Paths in the Canvas.
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Using LiveFonts
The Motion Library includes LiveFonts that can be applied to text. LiveFonts are complete
animated character sets.

To preview the LiveFonts
1 In the Library, click the LiveFonts category.

The available LiveFonts are listed in the stack.

2 Click a LiveFont in the stack.

The preview of the animated font plays in the Preview area.

The following image shows the original text prior to the application of the LiveFont.
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To apply a LiveFont to text
Do one of the following:

µ Drag the LiveFont from the Library to the text in the Canvas, Layers tab, or Timeline.
Depending on the frame where you apply the font, the font may not appear, may appear
partially drawn, or may appear complete.

µ Select the text, select the LiveFont in the Library, then click the Apply button in the Preview
area.

µ Select the text, select LiveFonts from the Font Type pop-up menu in the Format pane of
the Text Inspector, then choose the specific LiveFont from the Family pop-up menu.

Font Family pop-up 
menu

Font Type pop-up menu
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Modifying Applied LiveFonts
Use the following guidelines to modify the default LiveFont animation. The LiveFont
parameters only appear in the Format pane of the Text Inspector once a LiveFont is
applied to text.

Because LiveFonts are movies, they are applied with default timing settings. You can
modify the timing settings, such as randomness, play direction, start time and so on,
using the LiveFont Timing parameters.

Random: Drag the slider or use the value slider to apply the LiveFont movie to each
character in the text in a different order. For example, the Freehand font movie draws
the characters from the first character to the last. When you apply a Random value, the
characters are drawn (the movie plays) in random order.

Random Seed: Click Generate or enter a value in the field to create a new random “seed”
that changes the way the LiveFont movie is applied to each character. The random
variation in the text selection is based on the random seed number displayed in the
Generate field.

Note: Generate has no effect unless a Random value is set.

Sequence: Controls the timing of the sequence. Using the Freehand font as an example,
the default Sequence value for the Freehand font is 50%, which “draws” (the movie plays)
the text characters on one at a time in sequence. When Sequence is set to 0, all characters
are drawn at the same time.

Direction: Sets the direction of the animation to run From Left, From Right, or Ping Pong.

Speed: Allows you to play the LiveFont movie more quickly or slowly based on a
percentage of the default speed.
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Play: Sets the LiveFont movie to play Forward, Backward, or Ping Pong. This is not the
same as the Direction parameter. Using the Freehand font as an example, when Play is
set to Backward, the text begins completely drawn and erases (in the direction specified
in the Direction parameter).

Loop: Sets the number of times the LiveFont movie plays through. The default setting
is 1, meaning that the LiveFont plays one time. A value of 3 means that it plays through
three times. For example, when the Loop parameter of the Freehand font is set to 3, each
character is drawn one time, then disappears, is drawn a second time, then disappears,
and is drawn a third time and remains.

To End: Loops the movie until the end of the text duration.

Note: When To End is enabled, the Loop parameter is ignored.

Hold First: Drag the slider or use the value slider to set the delay, in seconds, of the start
of the font’s “animation.” For example, when using the Freehand font and Hold First is
set to 3, the text does not begin to “draw on” for 3 seconds.

Note: The font “animation” varies depending on the LiveFont and can include the drawing
on of the font, the moving of highlights around the font, and so on.

Hold Last: Drag the slider or use the value slider to set the amount of time, in seconds,
that the font stays visible once the movie is completed. For example, when using the
Freehand font and Hold Last is set to 0, the text disappears as soon as it is finished drawing.

Modifying the Color and Style Attributes of LiveFonts
Although the LiveFonts are preset, their colors can be modified. Additionally, Outline,
Glow, and Drop Shadow parameters can be added to the LiveFonts.

To change the color of a LiveFont
1 Select the text with the applied LiveFont, click the Text tab in the Inspector, then click

the Style tab.

2 Use the Color well or color picker to define a new color.
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To define a mix value between the default LiveFont color and the new color, click the
disclosure triangle in the Face Color controls and adjust the Color Mix slider or value
slider. A Color Mix value of 0% leaves the LiveFont at its original color; 100% completely
changes the LiveFont to the new color.

Drag to adjust LiveFont 
color

To apply the Outline, Glow, or Drop Shadow parameters to the LiveFont, select their
respective checkboxes in the Style tab of the Text Inspector. For more information on
modifying these attributes, see Editing Text Style.
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Generators are objects in the Library that you add to your project to instantly create solids
or patterns such as colors, bars, stripes, noise, or gradients. Some generators create
animated patterns, while most create static, patterned images.

This chapter covers the following:

• About Generators (p. 901)

• Adding a Generator (p. 902)

• Modifying Generators (p. 903)

• Generator Parameters (p. 916)

• Text Generators (p. 939)

About Generators
Generators are added to your project in the same manner as other files—you drag the
generator to your project from the Library. The generator becomes a layer in the Layers
tab (and Timeline layers list) and appears in the Canvas. The generator is set to the duration
and size of your project by default. For example, if you are working on an NTSC D1 project
and you add a generator, the generator will have a 720 x 486 (.90) pixel aspect ratio.

Once a generator is added to a project, you can modify its preset values as well as animate
nearly all of its parameters—whether the generator is animated or static. Once you have
modified a generator, you can save it to the Library for later use.

Note: The duration of the generator depends on the Project settings in Motion Preferences.
If Create Layers At is set to “Start of project,” the generator starts at the first project frame
regardless of where the playhead is when the generator is added. If set to “Current frame,”
the generator starts at the playhead’s frame.

Once a generator is added to a project, you can edit its parameters in the HUD or Inspector.
As with all objects, the generator HUDs contain a subset of the larger group of controls
located in the Inspector. Nearly all generator parameters can be keyframed, whether the
default generator is an animated texture or a static image.
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Like all other objects in Motion, generators can be moved, rotated, duplicated, copied
and pasted, and animated. Generators can be reordered in the Layers tab and set to
different blend modes. Also, as with other objects, you can apply behaviors to generators
and apply Parameter behaviors to the parameters of a generator. You can also apply
filters to generators, or use a generator as the source for a particle cell.

The following sections discuss the different types of generators, adding a generator to a
project, modifying and animating a generator, and saving a modified generator to the
Library. Applying a Parameter behavior to a generator is also discussed. All generators
are modified, animated, and saved in the same manner. The best way to see what
generators can do is to simply experiment with their various parameters.

For an example of editing and animating a generator, see Editing Generators.

For an example of applying a behavior to a generator, see Applying Behaviors to
Generators.

Note: Performance may slow drastically when using generators in projects with large
resolutions and with better render-quality settings.

Generator Types
There are two groups of generators in the Library: Generators and Text Generators. The
Generator group creates images that are animated by default, such as the Clouds
generator, as well as images that are static, such as the Checkerboard. All generators
create images on the fly, but an animated generator creates a moving pattern by default.
Although a static generator is not animated by default, you can keyframe its parameters
to create an animated pattern. All of the Text Generators are animated. You can use any
generator as is or modify its settings to create different effects.

Note: All generators contain Opacity and Blend Mode controls in the HUD. As with all
objects in Motion, the Opacity and Blend Mode parameters for any generator can also
be modified in the Properties tab of the Inspector.

Although the sliders in the Inspector are usually limited to a specific range, you can often
manually enter values outside of that range in the value sliders (to the right of the sliders).

Adding a Generator
This section provides a quick introduction to adding a generator to a project. For a
description of each generator, see Generator Parameters.

To add a generator to a project
1 In the Library, click the Generators category.

2 In the stack, click a generator.
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The generator preview appears in the Preview area. If the generator is animated, such as
Swirly, the generator plays in the Preview area. You can click the Play/Pause button to
stop playback of the generator preview.

Play/Pause button

3 Drag the generator to your project.

As with all other objects, you can add the generator to your project by dragging it to the
Canvas, the Layers tab, or the Timeline.

The generator and its HUD appear in your project. (If the HUD in not visible, press F7.)
The HUD contains a subset of the complete controls that appear in the Generator tab of
the Inspector.

Note: Generators that are added to a project are not added to the Media tab. The Media
tab only includes media files that are imported into Motion, such as image sequences,
Photoshop files, and audio files.

4 Click Play (or press the Space bar).

Modifying Generators
In this section, the Checkerboard generator is used to illustrate how to edit and animate
a generator using the HUD. Once a generator has been customized, you can save the
generator to the Library for use in future projects. This section also briefly discusses
applying Parameter behaviors to the parameters of a generator.

Editing Generators
In this section, the Checkerboard generator parameters are edited to modify the
appearance of the default generator.

To edit the Checkerboard generator
1 Add the Checkerboard generator to your project.

Note: For information on adding a generator to your project, see Adding a Generator.
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The default Checkerboard generator appears in the Canvas, Layers tab, and in the Timeline,
and the HUD appears.

Checkerboard generator in Layers tab

Checkerboard generator HUD

The Checkerboard generator HUD contains controls for editing and animating the
checkerboard, such as Opacity, Blend Mode, Width, Height, Color, Size (of the checkers),
and Contrast. The only Checkerboard parameter that does not appear in the HUD is Pixel
Aspect Ratio (which appears in the Inspector).

2 Click the Color 1 color well and select a new color. If you are using the color wheel, click
the center point and drag the pointer to select a new color.
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Color 1 is replaced with the new color.

Note: You can save a color in the swatches area along the bottom of the Colors window.
Click in the color bar (to the right of the color picker tool), then drag the color chip to a
white swatch and release the mouse button.

Drag a color chip from 
here.

Position the color chip 
over a white swatch and 
release the mouse 
button.

3 Click the Color 2 color well and select a new color.
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Color 2 is replaced with the new color.

4 Drag the Size slider to change the size of the squares.

The checker size is 80 by default. Drag the slider to the left to make smaller checkers, and
to the right to make larger checkers.

To scale the generator (rather than the size of the checkers), use the Width and Height
parameters.

Note: You can also use the standard object scaling methods—the onscreen transform
controls or the Scale parameter in the Properties tab of the Inspector. However, scaling
generators in this manner has a greater impact on your system’s performance.

5 Drag the Contrast slider to adjust the contrast between Color 1 and Color 2.

Size slider
Contrast slider

Although the checkerboard pattern is not changing, adjusting the Contrast parameter
can create dramatically different textures.
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Editing Generators Using Onscreen Controls
The onscreen object transform tools, such as Transform, Shear, Anchor Point, Drop Shadow,
and so on, can be used to modify a non-text generator. Changes made to the generator
using these tools are reflected in the Properties tab. The Adjust Item tool is the only tool
that directly modifies a generator parameter, usually the Center or Offset parameter.
These changes are reflected in the Generator Inspector.

For more information on the transform tools, see 2D Transform Tools.

To use the Adjust Item tool with a generator
1 Select the generator you want to modify.

2 Click the Select/Transform button, hold the mouse button down, and select the Adjust
Item tool (the last tool in the pop-up list).

In the center of the Canvas, a small crosshair (+) appears.

3 Drag the crosshair to the position you want.

The Offset or Center parameter is adjusted accordingly.

Animating Generators
Although most generators create static images, you can animate the parameters of a
generator to create a moving texture over time. This section discusses using the HUD to
animate the Checkerboard generator from the above example.
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Note: You can also animate the parameters of an animated generator.

For information on using Parameter behaviors to animate a generator, see Applying
Behaviors to Generators.

To animate the Checkerboard generator parameters
1 Go to the frame where you want to begin the animation.

2 Enable Record (press A).

3 Set the initial generator parameter values:

a Drag the Size slider to set the initial checker size.

Once a keyframe is set for any parameter in a generator, a keyframe is set for all of the
generator parameters. In other words, once the Size parameter is keyframed, the Color 1,
Color 2, Contrast, and Center parameters are keyframed.

b Click the color wells and pick the initial colors.

c Drag the Contrast slider to set the initial contrast value.

d Drag one of the Center parameter value sliders to set the initial Center value.

The value slider on the left of the Center parameter is the X position of the checkers,
and the value slider on the right is the Y position. To animate the checkers horizontally,
use the left value slider. To animate the checkers vertically, use the right slider. To view
the X and Y parameters, click the Center disclosure triangle.

4 Go to the frame where you want to create the next keyframe.

5 Change the generator Size, Colors, and Contrast parameter values.

6 Play the project (press the Space bar).

The animated generator parameters create a moving, changing texture.

Saving Modified Generators
Once you have modified the parameters of a generator, you can save the generator to
the Library. For organizational purposes, it is recommended that you name objects that
you save back to the Library with a descriptive title. For example, if you save a
Checkerboard generator, it is named “Checkerboard 1” by default.
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To save a customized generator to the Library
1 To rename the modified generator, double-click the generator name in the Layers tab.

2 Type the new generator name, then press Return.

3 In the Library, navigate to the Generators category.

Note: You can also save the modified generator in another category, such as Favorites.

4 From the Layers tab, drag the modified generator to the Library stack.
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The modified generator is saved in the Generators category and appears organized
alphabetically in the stack. Custom items saved in the Library are identified with the user
icon in the lower right of the icon.

Customized generator 
saved in Library

Sharing Saved Generators
By default, any generator that you save in the Library is stored in your user folder:
/Users/username/Library/Application Support/Motion/Library/Generators/. To share custom
presets, templates, layouts, behaviors, filters, or Library content with another user, the
other user must copy the files into his or her home directory.

Applying Behaviors to Generators
Like all other objects in Motion, you can apply Basic Motion, Parameter, or Simulation
behaviors to a generator. This section describes applying the Randomize parameter
behavior to the Opacity parameter of the Star generator to create a flickering star.

To apply a Parameter behavior to the Star generator
1 Add the Star generator to your project and display the Generator tab in the Inspector.

2 In the Generator tab, click Spike Opacity to select that parameter.

The selected parameter appears in a darker gray than the other parameters.
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3 Control-click the Spike Opacity parameter, then choose Randomize from the shortcut
menu.

The Randomize parameter behavior is applied to the Spike Opacity parameter, and the
Behaviors tab is automatically displayed so you can adjust the Randomize parameters.
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When a Parameter behavior is applied to a parameter, a Behaviors icon appears in the
Animation menu for that parameter. In this example, the Behaviors icon appears in the
Animation menu for the Spike Opacity parameter.

Behaviors icon

4 Click Play (or press the Space bar).

Because the Randomize parameter behavior is applied to the opacity of the star spikes,
the star appears to flicker.

Flickering star over 
a background image
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To increase or decrease the effect of the flicker, you can modify the Randomize parameters.
To quickly jump to the Randomize parameters from the Generator tab, click the Behaviors
icon, then choose Randomize from the pop-up menu.

For more information on using Parameter behaviors, see Parameter Behaviors.

Using Generators as Particle Cell Sources
Like other objects, generators can be used as a source for particle cells. The following
example uses the Soft Gradient generator. It is recommended that you scale the generator
down in the Generator tab of the Inspector to give your particle system more flexibility
and to keep the project from taking too much processing power.

913Chapter 15 Working with Generators



To use a generator as a particle cell source
1 Add the Soft Gradient generator to your project.

2 In the HUD or Generator tab of the Inspector, lower the Radius value. This example uses
a Radius value of 40.

3 Lower the Width and Height values. In this example, Width is set to 82 and Height is set
to 75.

The size of the gradient and its bounding box are scaled down.

4 With the generator still selected, do one of the following:

• Press E.

• In the Toolbar, click the Make Particles icon.
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Once an emitter is added to the project, the Emitter object is selected In the Layers tab,
the generator object (the Soft Gradient) becomes an emitter source for the new particle
cells, and the original reference object (the Soft Gradient) is disabled.

In the Canvas, the emitter bounding box appears, which can be transformed using the
onscreen controls or the Inspector. The particle appears in the Canvas in the same location
as the original object. Although it appears as if the particle is selected, it is actually the
bounding box for the emitter.

5 Play the project (press Space bar).

Soft gradient particles are emitted.

You can change the particle color, emitter shape, scale, emission angle, birth rate, and
so on in the Emitter controls. For more information on working with particles, see Working
with Particles.

Modified particles using the 
Soft Gradient generator as a 
particle cell source
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Generator Parameters
The following sections describe the common parameters and details of each generator.

Parameters in Common
All generators have a reset button and Width, Height, and Pixel Aspect Ratio controls,
which are located in the Generator tab of the Inspector. The controls specific to each type
of generator are discussed later in this chapter.

• Reset: Click to reset the generator to the default settings.

Reset button

• Width: Sets the width of the generator, in pixels. Values range from 1 to the width of
your project.

• Height: Sets the height of the generator, in pixels. Values range from 1 to the height
of your project.

• Pixel Aspect Ratio: Sets the aspect ratio of the pixels drawn by the generator. Values
can be selected from the following options: Square, NTSC D1/DV, NTSC D1/DV
Anamorphic, PAL D1/DV, PAL D1/DV Anamorphic, Anamorphic 2:1, D4/D16, D4/D16
Anamorphic, HD (960x720, 1440x1080) HD (1280x1080), or Custom. When a value other
than Custom is selected, the Pixel Aspect Ratio of that selection is displayed in a value
field next to the pop-up menu. Enter values from 0 to 10000 in the value field. If the
value does not correspond to a preset value (for example, 2 for Anamorphic 2:1), Custom
appears in the pop-up menu.

HUD Controls
In most cases, the HUD controls for each generator are identical to the generator’s controls
in the Inspector. Additionally, the HUDs contain the Opacity and Blend Mode parameters.

Important: The Opacity parameter in the HUD is identical to the Opacity control located
in the Properties tab. This sets the transparency of the generator as a whole. Several
generators contain a separate opacity control in the Generator tab of the Inspector, which
is independent of the Properties tab.
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Caustics
The Caustics generator creates an animated, simulated water surface. The size, speed,
refraction, brightness, and color of the Caustics pattern can be modified and animated.
You can use the Caustics generator to add light patterns to a project, or as the source
object for an image map.

Default Caustics generator Modified Caustics generator over an image

Parameters in the Inspector
Size: Sets the size of the shapes and spaces in the pattern.

Speed: Sets the speed of movement of the light patterns.

Refraction: Sets the refraction of the light shapes.

Brightness: Sets the brightness of the light shapes.

Color: Picks the color of the light shapes. Use the disclosure triangle to display Red, Green,
and Blue sliders for more precise color selection.

HUD Controls
The HUD contains the following controls: Size, Speed, Refraction, Brightness, and Color.
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Cellular
The Cellular generator creates an animated pattern that looks like cells moving under a
microscope. You can change the color, size, and speed of the cells.

Default Cellular generator Modified Cellular generator

Parameters in the Inspector
Size: Sets the size of the cells in the pattern. Values range from 3 to 64.

Speed: Sets the speed of movement of the light patterns. Values range from 0 to 2.

Gradient: Sets the color gradient used for the cells. For information on using gradients,
see Gradient Controls.

HUD Controls
The HUD contains the following controls: Size, Speed, and Gradient.

Checkerboard
The Checkerboard generator creates a static checkerboard pattern. The contrast, color,
size, and position of the checkerboard squares can be edited and keyframed.

Default Checkerboard generator Modified Checkerboard generator

Parameters in the Inspector
Center: Sets the center of the generator.
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You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

Color 1: Picks the first color in the checkerboard. Use the disclosure triangle to display
Red, Green, Blue, and Opacity sliders for more precise color selection.

Color 2: Picks the second color in the checkerboard. Use the disclosure triangle to display
Red, Green, Blue, and Opacity sliders for more precise color selection.

Size: Sets the size of the squares in the checkerboard. Values range from 0 to 800.

Contrast: Sets the sharpness of the division between squares. Values range from 0 to 1.

HUD Controls
The HUD contains the following controls: Color 1, Color 2, Size, and Contrast.

Clouds
The Clouds generator creates an animated cloud pattern. You can modify or animate the
color, scale, speed, and strength of the cloud layers.

Turbulent CloudsNormal Clouds

Parameters in the Inspector
Horizontal Scale: Gives the appearance of zooming in or out of the simulation by
horizontally scaling the generator. Larger numbers indicate a higher level of zoom.

Vertical Scale: Gives the appearance of zooming in or out of the simulation by vertically
scaling the generator. Larger numbers indicate a higher level of zoom.

Speed: Sets the speed of movement of the clouds. Values range from 0 to 2.

Gradient: Sets the color gradient used for the clouds. For information on using gradients,
see Gradient Controls.

Method: A pop-up menu that sets the algorithm used to generate the clouds. Values
can be set to Normal (default) or Turbulent.

Offset: Sets the coordinates of the center of the clouds. Coordinates are calculated from
the center of your object, which is the coordinate origin.
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You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

1st Layer Strength: Sets the strength of the first layer of clouds. Values range from 0 to
1.

2nd Layer Strength: Sets the strength of the second layer of clouds. Values range from
0 to 1.

3rd Layer Strength: Sets the strength of the third layer of clouds. Values range from 0
to 1.

4th Layer Strength: Sets the strength of the fourth layer of clouds. Values range from 0
to 1.

HUD Controls
The HUD contains the following controls: Horizontal Scale, Vertical Scale, Speed, Gradient,
Method, 1st Layer Strength, 2nd Layer Strength, 3rd Layer Strength, and 4th Layer Strength.

Color Solid
The Color Solid generator creates a single-colored object. You can adjust the color of the
solid, as well as keyframe the color to create an animated texture of changing colors.

Default Color Solid generator Modified Color Solid generator

Note: When you want to create and animate a small, color-filled box or shape, use the
Shape tools to draw a vector-based shape rather than creating and masking a color solid.
This is more efficient in terms of processor time and workflow.

Parameters in the Inspector
Color: Sets the color. Use the disclosure triangle to display Red, Green, and Blue sliders
for more precise color selection.

HUD Controls
The HUD contains the following control: Color.
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Concentric Shapes
The Concentric Shapes generator creates a repeating pattern of shapes.

Concentric Shape Circles Concentric Shape Polygons

Parameters in the Inspector
Shape: A pop-up menu that specifies whether the concentric shapes are circles or
multi-sided polygons. There are two choices:

• Circles: Creates concentric circles.

• Polygons: Creates concentric polygons with a minimum of three sides.

Number of Sides: Available when Polygons is selected from the Shape pop-up menu,
determines the number of sides on the polygonal shape. A polygon must have a minimum
of three sides.

Rotation: Available when Polygons is selected from the Shape pop-up menu, determines
the orientation of the polygonal shapes.

Center: Sets the center point of the generator in the Canvas. The left value slider represents
X; the right value slider represents Y. To access the individual X and Y controls, click the
disclosure triangle.

Inner Cutoff: Defines a center stopping area for the generator. A value of greater than
0 creates a hole in the middle of the generator; the greater the value, the larger the hole.
Objects composited below the generator in the project appear in the cutoff areas.

Outer Cutoff: Defines an outer stopping area for the generator. The lower the value,
more the outer edges of the generator are cutoff. Objects composited below the generator
in the project appear in the cutoff areas.

Color Type: A pop-up menu that specifies whether the concentric shapes are two color
or gradient. There are two choices:

• 2 Color: Creates two-color concentric shapes. When 2 Color is selected from the Color
Type pop-up menu, the Color 1, Color 2, and Contrast parameters are available.

• Gradient: When Gradient is selected from the Color Type pop-up menu, the Gradient
editor and Gradient Handling parameters are available.
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For more information on the Gradient editor, see Using the Gradient Editor.

Color 1: Available when 2 Color is selected from the Color Type pop-up menu, sets the
first color in the generator. Using the default settings, this color appears in the center of
the concentric shapes.

Color 2: Available when 2 Color is selected from the Color Type pop-up menu, sets the
second color in the generator.

Gradient Handling: A pop-up menu available when Gradient is selected from the Color
Type pop-up menu; specifies whether to clamp, repeat, or mirror the gradient in the areas
beyond the end of the shape (determined by the Center and Point 2 parameters). There
are three menu choices:

• Clamp to End Point: Limits the gradient to its edge (as defined by the Center and Point
2 parameter).

• Mirror: Mirrors the gradient from its edge (as defined by the Center and Point 2
parameter).

• Repeat: Repeats the gradient from its edge (as defined by the Center and Point 2
parameter).

Width: Sets the width of the concentric shapes.

Contrast: Available when 2 Color is selected from the Color Type pop-up menu, controls
the transition between the two defined colors. A value of 1 creates the highest contrast
between the colors, lower values create less contrast, softening the shapes.

Phase: Adjust this slider to cycle through the colors or gradient.

Tip: Animate the Phase parameter to create a “hypnotic” effect.

HUD Controls
The HUD contains the following controls: Shape, Number of Sides, Rotation, Inner Cutoff,
Outer Cutoff, Color Type, Color 1, Color 2, Width, Contrast, and Phase.
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Gradient
The Gradient generator initially creates a nonanimated blue-and-red linear gradient. You
can change the gradient from linear to radial, add and remove colors in the gradient, and
change the gradient start and end points. You can save a modified gradient to the Gradient
category in the Library and later apply it to shapes, text objects, or particle cells. The
gradient controls can be keyframed to create a moving, color-changing gradient.

Default Gradient generator Modified Gradient generator

Parameters in the Inspector
Gradient: Sets the color gradient. For information on using gradients, see Gradient
Controls.

Type: A pop-up menu that sets the gradient to Linear or Radial.

For more information on the Type pop-up menu, see Using the Gradient Editor.

End Condition: When Radial is chosen from the Type pop-up menu in the Gradient editor,
the End Condition pop-up menu becomes available. (For more information on the Type
pop-up menu, see Using the Gradient Editor.) The End Condition pop-up menu has two
choices:

• Hold Last Tag: Extends the last color defined in the gradient editor beyond the gradient
(defined by the Start and End parameters) to the edge of the Canvas.

• Transparent Tag: Ends the gradient at the location defined by the Start and End
parameters. Because transparency is created, objects below the gradient in the project
appear beyond the end of the gradient.

HUD Controls
The HUD contains the following controls: Gradient, Type, and End Condition.

923Chapter 15 Working with Generators



Grid
The Grid generator creates a grid pattern made of two different colored lines. By default
they are white lines on a black background. Using the controls in the Inspector, you can
customize the colors and line widths of the grid, and add additional graph paper lines.

Default Grid generator Modified Grid generator (brown lines over a blue 
background that is set to .23 opacity, over a 
butterfly image)

Parameters in the Inspector
Offset: Sets the coordinates of the center of the grid. Coordinates are calculated from
the center of your object, which is the coordinate origin.

You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

Line Color: Sets the color of the grid lines.

BG Color: Sets the color of the grid background.

BG Opacity: Sets the opacity of the background. Values range from 0 to 1.

Feather: Sets the feathering or sharpness of the grid lines. Values range from 0 to 1.

Line Width: Sets the width of the grid lines.

Autofit: Rounds grid background width and height values to ensure that there aren’t
any partial columns or rows at the edge of the grid.

BG Width: Sets the width of the background or space between the lines.

BG Height: Sets the height of the background or space between the lines.

Graph Paper Lines: Adds an additional grid pattern on top of the existing grid. With this
option selected, the Graph Line Color and Graph Line Frequency controls become available.

Graph Line Color: Available when the Graph Paper Lines checkbox is selected, defines
the color of the “graph paper” lines.

Graph Line Frequency: Available when the Graph Paper Lines checkbox is selected, sets
how frequently a grid line is also a graph line.
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HUD Controls
The HUD contains the following controls: Line Color, BG Color, BG Opacity, Feather, Line
Width, Autofit, BG Width, BG Height, Graph Paper Lines, Graph Line Color, and Graph Line
Frequency.

Lens Flare
Lens flares result from a bright light source pointed right at a lens, refracting off multiple
elements in the lens assembly of a camera. This filter allows you to add a simulated lens
flare to an object.

This filter can be used to simulate a bright light source in the picture.

Original image Lens Flare applied

Parameters in the Inspector
Center: Sets the position of the center of the lens flare.

You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

Size: Sets the radius of the ring of the lens flare.

Intensity: Sets the intensity of the lens flare. Values range from 0 to 4.

Falloff: Sets how fast the lens flare falls off. Values range from 0 to 10.

Color: Picks the color of the lens flare. Use the disclosure triangle to display Red, Green,
and Blue sliders for more precise color selection.

Outer Color: Picks the outer color of the lens flare.

Ring Color: Picks the color of the ring of the lens flare.

Streak Color: Picks the color of the streaks in the lens flare.

Streak Intensity: Sets the intensity of the streaks. Values range from 0 to 1.

Streak Count: Sets the number of streaks in the lens flare. Values range from 1 to 100.

Streak Noise Frequency: Sets the frequency of the noise in the streaks. Values range
from 1 to 100.
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Streak Noise Level: Sets the level of noise in the streaks of the lens flare. Values range
from 0 to 20.

Ring Radius: Sets the radius of the ring of the lens flare. Values range from 0 to 1.

Ring Width: Sets the ring’s width, with values ranging from 0 to 1.

Glow Falloff: Sets how fast the glow falls off of the lens flare. Values range from 0 to 20.

Streak Map: An image well that displays a thumbnail of the map chosen for the streaks
of the lens flare.

For information on using image wells, see Source Well.

HUD Controls
The HUD contains the following controls: Size, Intensity, Falloff, Color, Outer Color, Ring
Color, Streak Color, Streak Intensity, Streak Count, Streak Noise Frequency, Streak Noise
Level, Ring Radius, Ring Width, Glow Falloff, and Streak Map.

Membrane
The Membrane generator creates a sheer, animated sheet that appears to move gracefully
about in 3D space. The speed, start and end points, offset, brightness, and color can be
modified and animated. To expand the animation beyond the Canvas borders, increase
the Width and Height parameters in the Inspector.

Default Membrane generator Modified Membrane generator (composited 
over a gradient)

Parameters in the Inspector
Speed: Sets the speed of movement of the sheet.

Start 1–4: Sets the starting point for the sheet wave. Experiment with these controls to
find different wave shapes.

End 1–4: Sets the ending point for the sheet wave. Experiment with these controls to
find different wave shapes.

Offset: Sets the coordinates of the center of the sheet. Coordinates are calculated from
the center of your object, which is the coordinate origin.

926 Chapter 15 Working with Generators



Brightness: Sets the brightness of the sheet.

Color: Picks the color of the membrane. Use the disclosure triangle to display Red, Green,
and Blue sliders for more precise color selection.

HUD Controls
The HUD contains the following controls: Speed, Start 1–4, End 1–4, Offset, Brightness,
and Color.

Noise
Where would motion graphics artists be without a noise filter or generator? To make
animated noise, you can keyframe the Random Seed parameter in the Noise HUD or
Inspector. When filters are applied to an animated Noise generator, you can create some
unique textures. In the second image below, the Scrape distortion filter is applied to an
animated Noise generator to create a vibrant, electric light-type texture.

Default Noise generator Noise generator with applied Scrape filter

Parameters in the Inspector
Random Seed: Each seed value gives you a different noise image, so changing this over
time allows you to get constantly changing noise. The easiest way to see and use the
random seed parameter is to add a ramp behavior to it, then ramp from a very small
random seed value to a very large random seed value over time.

HUD Controls
The HUD contains the following control: Random Seed.
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One Color Ray
The One Color Ray generator creates a ray pattern based on variations of a color. You can
select the color, the degree of variance, the number of divisions represented, and rotation
of the pattern.

One Color Ray generator One Color Ray generator modified

Parameters in the Inspector
Color Space: A pop-up menu that sets the color space. Generally, if you are working in
NTSC, use YIQ. If you are working in PAL, use YUV.

Offset: Sets the coordinates of the ray pattern’s center. Coordinates are calculated from
the center of your object, which is the coordinate origin.

You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

Color: Picks the base color for the one color ray.

Color Variance: Sets how much the colors differ from each other.

Divisions: Sets the number of divisions in the ray pattern.

Rotation: Sets the rotation of the whole pattern from the center point.

Sharpness: Defines the hardness of the edges of the rays. Values ranges from .25 to 1.

Waviness: Positive or negative values create waves in the rays. Values range from –10 to
10.

Frequency: When Waviness is set to any value other than 0, determines the number of
waves in the rays.

Phase: When Waviness is set to any value other than 0, defines the offset of the waves
from the start and end of the rays. (Animate this value to create interesting effects.)

Inner Cutoff: Defines a center stopping area for the generator. A value of greater than
0 creates a hole in the middle of the generator; the greater the value, the larger the hole.
Objects composited below the generator in the project appear in the cutoff areas.
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Outer Cutoff: Defines an outer stopping area for the generator. The lower the value, the
more the outer edges of the generator are cut off. Objects composited below the generator
in the project appear in the cutoff areas.

HUD Controls
The HUD contains the following controls: Color, Color Variance, Divisions, Sharpness,
Waviness, Frequency, Phase, Inner Cutoff, and Outer Cutoff.

Op Art 1
There are three Op Art generators to help confuse your background-foreground senses.
The Op Art generators create mathematically oriented patterns using a repetition of
simple shapes. Although some static patterns create a visual illusion of movement, you
can keyframe the Op Art parameters to create actual moving moiré patterns.

Default Op Art 1 generator Modified Op Art 1 generator at 50% opacity over 
blue rectangle

Parameters in the Inspector
Line Thickness: Sets the thickness of the lines in the pattern.

Color 1: Sets the first color of the pattern. Use the disclosure triangle to display Red,
Green, Blue, and Opacity sliders for more precise color selection.

Color 2: Sets the second color of the pattern. Use the disclosure triangle to display Red,
Green, Blue, and Opacity sliders for more precise color selection.

Contrast: Sets how sharp or blurred the division is between the lines and the background.

Wavelength 1: Sets the frequency of the wave up and down.

Wavelength 2: Sets the frequency of the wave from left to right.

Amplitude: Sets the amplitude of the waves.

Roundness: Sets the shape of the waves.

HUD Controls
The HUD contains the following controls: Line Thickness, Color 1, Color 2, Contrast,
Wavelength 1, Wavelength 2, Amplitude, and Roundness.
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Op Art 2
Another Op Art generator that creates mathematically oriented patterns using a repetition
of simple shapes. Although some static patterns create a visual illusion of movement,
you can keyframe the Op Art parameters to create actual moving moiré patterns.

Default Op Art 2 generator Modified Op Art 2 generator (composited over a 
second image with Blend Mode set to Soft Light 
in the Properties tab)

Parameters in the Inspector
Scale: Sets how close or far away the dots appear.

Angle: Sets the angle of the dot rows.

Dot Color: Sets the color of the dots.

Background Color: Sets the color of the background.

For more information on using the color controls, see Color Controls.

Contrast: Sets how sharp or blurred the division is between the dots and the background.

Dot Size: Sets the dot size.

Compression: Sets how shallow or deep the fold in the imaginary paper appears.

HUD Controls
The HUD contains the following controls: Scale, Angle, Dot Color, Background Color,
Contrast, Dot Size, and Compression.

930 Chapter 15 Working with Generators



Op Art 3
Yet another Op Art generator that creates mathematically oriented patterns using a
repetition of simple shapes. Although some static patterns create a visual illusion of
movement, you can keyframe the Op Art parameters to create actual moving moiré
patterns.

Default Op Art 3 generator Modified Op Art 3 generator (with Random
Tile filter)

Parameters in the Inspector
Line Thickness: Sets the thickness of the lines in the pattern.

Color 1: Sets the first color of the generator. Use the disclosure triangle to display Red,
Green, Blue, and Opacity sliders for more precise color selection.

Color 2: Sets the second color of the generator. Use the disclosure triangle to display
Red, Green, Blue, and Opacity sliders for more precise color selection.

For more information on using the color controls, see Color Controls.

Contrast: Sets how sharp or blurred the division is between the lines and the background.

Wavelength: Sets the frequency of the wave.

Amplitude: Sets the number of amplitude of the wave.

Skew: Sets rotation of the wave pattern.

Roundness: Sets the shape of the wave.

HUD Controls
The HUD contains the following controls: Line Thickness, Color 1, Color 2, Contrast,
Wavelength, Amplitude, Skew, and Roundness.
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Soft Gradient
The Soft Gradient generator creates a soft-edged, radial gradient. The gradient contains
an alpha channel so that you can place the generator over another image in the project.
You can change and keyframe the color, size, and position of the Soft Gradient.

Default Soft Gradient generator Modified Soft Gradient generator over image 
(yellow radial gradient in upper-left corner)

Parameters in the Inspector
Center: Sets the position of the center of the gradient.

You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

Color: Picks the color of the gradient. Use the disclosure triangle to display Red, Green,
and Blue sliders for more precise color selection.

Radius: Sets the radius of the gradient circle. Values range from 0 to 1000.

HUD Controls
The HUD contains the following controls: Color and Radius.

Spirals
This generator creates a repeating circular spiral pattern.

Spiral default Modified Spiral
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Parameters in the Inspector
Type: A pop-up menu that specifies whether a “modern” or “classic” spiral is created.

• Modern (Linear): Creates a “modern” spiral pattern: The color swirls remain evenly
spaced as they move toward the center of the spiral. When Modern is selected, the
Scale parameter becomes available.

• Classic (Exponential): Creates a “classic” spiral pattern: The color swirls become thinner
as they move toward the center of the spiral. When Classic is selected, the Tightness
parameter becomes available.

Center: Sets the center point of the generator in the Canvas. The left value slider represents
X; the right value slider represents Y. To access the individual X and Y controls, click the
disclosure triangle.

You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

Color Type: A pop-up menu that specifies whether the spirals are two-color or a gradient
fill.

• 2 Color: Creates two-color spirals. When 2 Color is selected from the Color Type pop-up
menu, the Color 1, Color 2, and Contrast parameters are available.

933Chapter 15 Working with Generators



• Gradient: Allows you to add many colors to the spiral, creating soft transitions between
the colors. Spiral colors are determined by the Gradient Editor. You can create a custom
gradient, or apply a preset gradient to the spirals.

For more information on using the Gradient Editor, see Using the Gradient Editor.

Color 1: Available when 2 Color is selected from the Color Type pop-up menu, sets the
first color of the spiral.

Color 2: Available when 2 Color is selected from the Color Type pop-up menu, sets the
second color of the spiral.

Gradient: Available when Gradient is selected from the Color Type pop-up menu, allows
you to pick a gradient from the Library.

Scale: Available when Modern is selected from the Type pop-up menu, determines the
size of the spiral arms.

Tightness: Available when Classic is selected from the Type pop-up menu, determines
the curl of the spiral. The lower the Tightness value, the looser the spiral.

Contrast: Controls the transition between the two defined colors. A value of 1 creates
the highest contrast between the colors, lower values create less contrast, softening the
spiral. The Contrast parameter is not available when Gradient is chosen from the Color
Type pop-up menu.

Rotation: Rotates the spiral around its center. (Animate the Rotation parameter to create
a hypnotic effect.)

HUD Controls
The HUD contains the following controls: Type, Color Type, Color 1, Color 2, Gradient,
Scale, Tightness, Contrast, and Rotation.
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Star
The Star generator creates a glowing star shape that contains an alpha channel. The scale,
width, angle, epsilon (which fine-tunes the size of the star spikes), and opacity of the
spikes can be modified and keyframed, as well as the position, color, and radius of the
star.

Default Star generator Multiple modified Star generators over gradient

Parameters in the Inspector
Center: Sets the position of the center of the star.

You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

Color: Picks the halo around the star. Use the disclosure triangle to display Red, Green,
Blue, and Opacity sliders for more precise color selection.

Radius: Sets the radius of the circle at the center of the star. Values range from 0 to 300.

Spike Scale: Sets the size of the star spikes. Values range from 0 to 100.

Spike Angle: Sets the angles of the star spikes.

Spike Opacity: Sets the opacity of the star spikes. Values range from –8 to 0.

Spike Width: Sets the width of the star spikes. Values range from 0 to 50.

Epsilon: Fine-tunes the strength of the star spikes. Values ranges from –2 to 0.

HUD Controls
The HUD contains the following controls: Color, Radius, Spike Scale, Spike Angle, Spike
Opacity, Spike Width, and Epsilon.
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Stripes
The Stripes generator creates a default image with vertical bands of two alternating colors.
You can change and keyframe the position, colors, size, and contrast of the stripes. By
animating the Center parameter, you can create an animation in which the stripes
continuously move across the screen without the need to resize and pan the object across
the Canvas.

Default Stripes generator Modified Stripes generator used as animated 
background

Parameters in the Inspector
Center: Sets the position of the center of the stripe pattern.

You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

Color 1: Picks the color of the first stripe. Use the disclosure triangle to display Red, Green,
Blue, and Opacity sliders for more precise color selection.

Color 2: Picks the color of the second stripe. Use the disclosure triangle to display Red,
Green, Blue, and Opacity sliders for more precise color selection.

Size: Sets the width of the individual stripes.

Contrast: Sets the sharpness or blurriness of the edge between the stripes. Values range
from 0 to 1.

HUD Controls
The HUD contains the following controls: Color 1, Color 2, Size, and Contrast.
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Swirly
The Swirly generator creates an animated pattern in one of three different styles called
Pulse, Spiderweb Spin, and Spiky. Once you select a style, you can modify and animate
the scale, rotation, persistence, radius, amplitude, and number of passes of the pattern.

Default Swirly generator Modified Swirly generator 

Parameters in the Inspector
Scale: Sets the size of the swirly shape.

Rotation: Sets the rotation of the initial shape.

Persistence: Sets the number of times the shape is repeated.

Minimum Radius: Sets the minimum radius of the initial shape.

Radius Amplitude: Sets the amplitude of the whole shape.

Amplitude: Sets the amplitude of the waves that make up the shape.

Passes: Sets the number of shapes morphing at one time.

Style: A pop-up menu that sets the style of Swirly-Pulse, Spiderweb Spin, or Spiky.

HUD Controls
The HUD contains the following controls: Scale, Rotation, Persistence, Minimum Radius,
Radius Amplitude, Amplitude, Passes, and Style.
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Two Color Ray
The Two Color Ray generator creates a ray pattern alternating between two colors. You
can select the colors, the number of divisions represented, and rotation of the pattern.

Default Two Color Ray generator Two Color Ray generator modified

Parameters in the Inspector
Offset: Sets the coordinates of the center of the ray pattern. Coordinates are calculated
from the center of the object, which is the coordinate origin.

You can also use the Adjust Item tool to adjust this parameter using the onscreen controls.
For more information, see Editing Generators Using Onscreen Controls.

Color 1: Picks the base color for the two color ray.

Color 2: Picks the alternating color for the two color ray.

Divisions: Sets the number of divisions in the ray pattern.

Rotation: Sets the rotation of the whole pattern from the center point.

Contrast: Sets the sharpness or softness of the division between the rays.

Waviness: Positive or negative values create waves in the rays. Values range from –10 to
10.

Frequency: When Waviness is set to any value other than 0, determines the number of
waves in the rays.

Phase: When Waviness is set to any value other than 0, defines the offset of the waves
from the start and end of the rays.

Inner Cutoff: Defines a center stopping area for the generator. A value of greater than
0 creates a hole in the middle of the generator; the greater the value, the larger the hole.
Objects composited below the generator in the project appear in the cutoff areas.

Outer Cutoff: Defines an outer stopping area for the generator. The lower the value,
more the outer edges of the generator are cut off. Objects composited below the generator
in the project appear in the cutoff areas.
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HUD Controls
The HUD contains the following controls: Color 1, Color 2, Divisions, Rotation, Contrast,
Waviness, Frequency, Phase, Inner Cutoff, and Outer Cutoff.

Text Generators
Whereas other generators create background images and patterns, text generators use
text characters to create text-based animations, such as timecode, time and date, or text
animation created from a plain text (.txt). file. Text generators also use the standard text
parameters, such as tracking, text on a path layout, and glow to modify the appearance
of the generator. Text Generators have their own set of common parameters available in
the HUD and in the Inspector. The Inspector for each text generator contains four panes:
Format, Style, Layout, and Generator.

The first three panes (Format, Style, and Layout) which control the color, outline, glow,
drop shadow, and path of the text can be used to modify the text in a Text Generator.
These panes are identical to those in the Text Inspector (for a text layer) with one
exception. In the Format pane, the Text editor and Publish to FCP controls found in the
Text Inspector are not available. Additionally, the Text and Transform Glyph tools cannot
be used to modify the text. Changing any of the text, such as adding words or correcting
a spelling error, must be done in the source file.

Note: When Type is selected from the Layout Method pop-up menu in the Layout pane,
and the Text tool is selected in the Toolbar, a line appears under the currently-selected
type in a Text Generator.

The appearance of a text generator—including color, outline, glow, drop shadow, path,
and so on—can be modified in the Format, Style, and Layout panes of the Generator
Inspector. This includes placing the generator text on a path.

For information on the Format, Style, and Layout panes, see Creating and Editing Text.

The parameters in the Generator pane are described below.

File
The File text generator displays the contents of a text file. The appearance (font, weight,
size, and so on) of the text in the source file is ignored in favor of the settings in the
Inspector. The text file must be in plain text (.txt) format.

The text displays onscreen word by word, line by line, appearing and disappearing based
on the settings in the Inspector. The duration of the generator determines the speed of
the text. All text in the source file is displayed; the longer the duration of the generator,
the slower the text appears.

Parameters in the Inspector
Browse: Click the Browse button to locate the file you want to use as the text source.
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Speed: A pop-up menu that sets the behavior of the text as it appears and disappears
onscreen. Choose any of several options:

• Constant: The text appears and disappears at a steady speed from the first word or line
to the last word or line in the text file.

• Ease In: The text appears at a slow speed.

• Ease Out: The text disappears at a slow speed.

• Ease Both: The text appears and disappears at a slow speed.

• Accelerate: The text appears and disappears with increasing speed.

• Decelerate: The text appears and disappears with decreasing speed.

• Custom: Custom allows you to define the appearance and disappearance of the text
by setting keyframes for the text from 0 to 100 percent using the Custom Speed slider,
described below. In other words, you determine the rate of the appearance and
disappearance of the text over time.

Custom Speed: A slider that becomes available when Custom is chosen from the Speed
pop-up menu, allows you to keyframe the timing of the appearance or disappearance of
the text. At 0 percent, none of the text has appeared; at 100 percent, the last of the text
in the file is displayed (the last line or word).

Random: When selected, randomizes the order in which the lines of text appear.

Random Seed: If you do not like the current order in which the text is appearing, you
can change the seed number by typing a new number or clicking Generate. This changes
the random calculations to display the text in a different order.

Text Controls: The File generator HUD contains the standard text HUD controls. For more
information, see Using the Text HUD.

HUD Controls
The HUD contains the following controls: Speed, Random, and Text Controls.

Using the File Generator
The source file for the File generator must be in plain text (.txt) format. Generally, you
can use the “Save As” command in your text application to save the file as plain text.

Note: If you are using the Mac OS X TextEdit application, choose Format > Make Plain
Text (Command-Shift-T) to save a copy as plain text.

To use the File generator
1 Select the File generator in the project.

2 Click the Generator tab of the Inspector, click the Generator pane of the Inspector, then
click the Browse button.

The “Choose text file” dialog appears.
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3 Select the text file you want to use, then click Open.

The text file is loaded into the generator. If you are at the first frame of your project and
depending on what is chosen from the Speed pop-up menu, the text may not appear in
the Canvas until you play the project.

4 Press the Play button.

The text appears and disappears line by line. Use the parameters in the Generator pane
to modify the animation. For more information, see File.

The appearance of the text is based on the settings in the Format, Style, and Layout panes
in the Generator tab of the Inspector. For more information on using and editing text,
see Creating and Editing Text.

Numbers
The Numbers text generator displays random numbers based on the settings in the
Inspector.

Parameters in the Inspector
Animate: When this checkbox is selected, the numbers are animated as the project plays.
When deselected, a static number is displayed.

Start: Sets the beginning number for the generator. Slider values range from 0 to 100.
For negative numbers or numbers greater than 100, use the value slider (to the right of
the slider). Default values are based on the project. For example, when the Numbers
generator is added to a default project of 300 frames, the Start value is 1 and the End
value is 300.

Tip: You can use the Link parameter behavior to set the visible numbers to show the
values of one of the other parameters used in your project. The number display may
appear at a scaled rate in some cases. In other cases, the number display may be translated
into another form (such as a percentage)—for example, if you were linking to the value
of a point light’s Falloff parameter, the number displayed on screen would be scaled by
a factor of .1 and the Intensity parameter would be displayed as a percentage. You can
scale and offset the value of the linked parameter using the Scale slider in the Link behavior
tab. To convert the number to a different format, use the Format pop-up menu in the
Numbers generator. For more about the Link behavior, see Link.

End: Sets the ending number for the generator. Slider values range from 0 to 100. For
negative numbers or numbers greater than 100, use the value slider (to the right of the
slider). Default values are based on the project. For example, when the Numbers generator
is added to a default project of 300 frames, the Start value is 0 and the End value is 300.
If the End value is set to 200, a range of 0 to 200 is counted over the 300 frames.

Format: A pop-up menu that specifies the format of the displayed numbers. There are
seven choices:

• Number: Numbers are used in the generator.
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• Currency: Currency is used for the generator. The default is U.S. dollars. To change to
another currency, chose an option in the Region pop-up menu.

• Percent: Percent is used for the generator.

• Scientific: Uses scientific numbers for the generator.

• Spell Out: Spells out the numbers in the generator.

• Binary: Uses the binary numeral system for the generator. The binary system uses two
symbols (0 and 1) to represent numeric values.

• Hexadecimal: Uses hexadecimal numeral system for the generator. This system uses
16 symbols. The symbols 0 to 9 represent the numbers 0 to 9, and the letters A through
F represent 10 to 15.

Tip: When using the Hexadecimal or Binary formats, inputs of very large numbers are
required to create change in every character in the generator. For example, if the default
Start and End values of 1 and 300 are used (in a default project of 300 frames), only the
last two or three digits appear animated in the Hexadecimal format.

If a number such as 4,294,967,296 is used, nearly all characters are animated.

Decimals: Available when Number, Currency, Percent, or Scientific is chosen from the
Format pop-up menu, sets the number of decimal places.

Capitalize: When this checkbox is selected, initial uppercase letters are used when spelling
out the numbers. This checkbox is available only when Spell Out is chosen from the
Format pop-up menu.

Minimum Digits: Available when Number is chosen from the Format pop-up menu,
defines the minimum digits used in the generator. The default value is 1.

Thousands Separator: Available when Number, Currency, or Percent is chosen from the
Format pop-up menu, displays a comma or other character to separate thousands (based
on what is chosen in the Region pop-up menu).

Random: Numbers are displayed randomly.
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Random Seed: If you don’t like the current random number count, you can change the
seed number by typing a new number or clicking Generate. This changes the random
calculations to display different numbers.

Random Hold Frame: When the Random checkbox is selected, specifies how long (in
frames) each number is held onscreen. For example, If Random is selected and Random
Hold Frame is set to 20, a number is displayed for 20 frames, then the next number is
displayed and held for 20 frames, and so on.

Region: By default, the generator uses the current system’s region. Click the Current
button to set the current system’s region as the region for the generator. Click the Region
pop-up menu to select another region.

Note: The selected region is saved with the generator. If opened on another computer
with a different regional setting, the generator retains the saved region.

Text Controls: The Numbers generator HUD contains the standard text HUD controls.
For more information, see Using the Text HUD.

HUD Controls
The HUD contains the following controls: Format, Decimals, Minimum Digits, and Text
Controls.

Time Date
The Time Date text generator displays the date and time based on the settings in the
Inspector. You can create a countdown or count-up animation by defining start and end
values. You can also specify time units, as well as time and date format.

The default date and time are based on the computer’s system clock at the time the
generator is added to the project. This can be changed in the Inspector by manually
entering a value or clicking the Set Current Time button.

Parameters in the Inspector
Animate: When this checkbox is selected, the time and date are animated as the project
plays. The animation, such as a countdown or count up, is based on the values set in the
Start and End fields. When Animate is deselected, static information is displayed.

Start: Available when the Animate checkbox is selected, specifies the start date and time
for the generator. This parameter can be animated using keyframes.

End: Available when the Animate checkbox is selected, specifies the end date and time
for the generator. This parameter can be animated using keyframes.

Value: Specifies the date and time displayed in the generator. Value is not available when
the Animate checkbox is selected. This parameter can be animated using keyframes.

Set Current Time: Click to set the current time in the generator.

Time Units: A pop-up menu that sets the units of time used in the generator to Seconds,
Minutes, Hours, Days, Months, or Years.

943Chapter 15 Working with Generators



Time Format: A pop-up menu that sets the time format used in the generator. Choose
one of four options:

• None: No time is displayed in the generator. (The date appears in the generator if any
option other than None is chosen from the Date Format pop-up menu.)

• Short: Displays the time in hours and minutes.

• Medium: Displays the time in hours, minutes, and seconds.
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• Long: Displays the time in hours, minutes, seconds, and time zone.

Date Format: A pop-up menu that sets the date format used in the generator. Choose
one of five options:

• None: No date is displayed in the generator. (The time appears in the generator if any
option other than None is chosen from the Time Format pop-up menu.)

• Short: Displays the month, day, and year in all-numeral style.

• Medium: Displays the month abbreviated to three letters without a period, the day,
and the year.

• Long: Displays the month spelled out completely, the day, and the year.

• Full: Displays the day of the week and the month spelled out completely, the day, and
the year.

Region: By default, the generator uses the current system’s region. Click the Current
button to set the current system’s region as the region for the generator. Click the Region
pop-up menu to select another region.

Padding: Adds a 0 in front of single-digit times or dates.

Text Controls: The Time Date generator HUD contains the standard text HUD controls.
For more information, see Using the Text HUD.

HUD Controls
The HUD contains the following controls: Set Current Time, Time Units, Time Format, Date
Format, and Text Controls.

Timecode
The Timecode text generator displays timecode based on the current project or the
settings in the Inspector. You can specify a specific timecode value, an offset to the current
timecode, the timecode format, and the timecode base.

Parameters in the Inspector
Current Timecode: When this checkbox is selected, the generator uses the project’s
current timecode.
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Offset: Available when the Current Timecode checkbox is selected. Specifies an offset
value to the current timecode. This parameter can be animated using keyframes.

Value: Available when the Current Timecode checkbox is deselected. Specifies the
timecode value that is displayed. This parameter can be animated using keyframes.

Format: Sets the timecode format to HMSF, HMS, or frames.

• HMSF: Timecode is displayed in hours, minutes, seconds, frames format.

• HMS: Timecode is displayed in hours, minutes, seconds format.

• Frames: Frame numbers are displayed.

Timecode Base: Sets the timecode for the generator to the frame rate of the current
project: 23.976, 24, 25, 29.97, 29.97 Drop, 30, 50, 59.94, 59.94 Drop, or 60.

Label: Text entered in the Label field is added as a prefix to the timecode displayed in
the Canvas.

Text Controls: The Timecode generator HUD contains the standard text HUD controls.
For more information, see Using the Text HUD.

HUD Controls
The HUD contains the following controls: Current Timecode, Format, Timecode Base, and
Text Controls.

946 Chapter 15 Working with Generators



Motion includes more than 100 special effects to modify the appearance of your clips.
Such effects are called filters. In the same way different font choices add flavor to text,
filters add flavor to images. Fonts can help to determine mood or style. The filters you
select can shape the character of your project. A sepia tone color correction on an object
can make the viewer think of days gone by. You can use a kaleidoscope filter to transform
an object into something completely new. A slit-scan filter can provide a window into
another world.

This chapter covers the following:

• About Filters (p. 948)

• Browsing For and Previewing Filters (p. 948)

• Applying and Removing Filters (p. 949)

• Adjusting Filters (p. 952)

• Enabling, Renaming, and Locking Filters (p. 957)

• Copying, Pasting, Moving and Duplicating Filters (p. 957)

• Reordering Filters (p. 959)

• Changing Filter Timing (p. 959)

• Blur Filters (p. 961)

• Border Filters (p. 972)

• Color Correction Filters (p. 974)

• Distortion Filters (p. 992)

• Glow Filters (p. 1014)

• Keying Filters (p. 1021)

• Matte Filters (p. 1027)

• Sharpen Filters (p. 1028)

• Stylize Filters (p. 1029)

• Tiling Filters (p. 1052)
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• Time Filters (p. 1058)

• Video Filters (p. 1061)

About Filters
When desktop publishing was first introduced, people tended to fill their publications
with numerous fonts on a page, simply because they could. The result was often as
amateurish as it was enthusiastic. And with Motion’s easy-to-use filters, you might be
tempted to adorn your kinetic graphics projects with a surfeit of visual effects. This is
what’s known a bad idea. The best way to think about filters is as a condiment for your
project—not the entree. A handful of thoughtfully selected and well-executed filters goes
much further than a grab bag of every filter in the Library. Not only does a bunch of filters
start to affect performance, but they clutter and confuse the look of your project.

To get the best performance from Motion, use a recommended graphics card. For more
information, visit the Motion website at http://www.apple.com/finalcutstudio/motion.

You add filters to objects in much the same way as behaviors, and you have the same
ability to adjust the parameters of the filters over time without having to adjust keyframes.

There are 13 categories of filters in Motion, organized alphabetically in the Library.

Filter types

Note: Many third-party companies offer FXPlug filters and effects to extend the
functionality of the Final Cut Studio suite. If you install such a third-party product, additional
effects will appear in the Filters list, usually in a separate custom-named category.

Browsing For and Previewing Filters
All installed filters appear in the Library. Select the Filters category to display the 13 filter
subcategories. Select a subcategory to show all filters of that type in the stack.
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Once a filter is selected in the stack, a preview and brief description of the filter appears
in the Library Preview area.

To browse for a filter
1 In the Library, click the Filters category.

A list of subcategories appears on the right side of the library.

2 Click a filter subcategory.

A list of filters in that subcategory appears in the stack.

3 Click a filter in the stack to select it.

A preview and short description of the selected filter appear in the Preview area at the
top of the Library.

Applying and Removing Filters
Each filter affects how a specific object is displayed, and is applied directly to objects in
the Canvas, Layers tab, or the Timeline.

Important: The application of some filters can cause a group to be rasterized. When a
group is rasterized, it is converted into a bitmap image. In 2D groups, the application of
any filter causes rasterization. In 3D groups, the application of certain filters causes
rasterization. For more information on rasterization, see Filters and Rasterization.
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To apply a filter
Do one of the following:

µ Drag a filter to an object in the Canvas, Layers tab, or the Timeline.

µ Select an object in the Canvas, Layers tab, or Timeline, then select a filter from the Library
stack and click Apply in the Preview area.

µ Select an object in the Canvas, Layers tab, or Timeline, and in the Toolbar, select the Add
Filter icon, then select a category and a filter to apply.

To remove a filter from an object
1 Select a filter that’s been applied to an object in the Layers tab, Timeline, or Filters tab of

the Inspector.

2 Do one of the following:

• Choose Edit > Delete.

• Press Delete.

To modify a filter on an object
1 Select a filter that’s been applied to an object in the Layers tab, Timeline, or Filters tab of

the Inspector.

2 Adjust parameters in the Inspector or the HUD.

Applying Multiple Filters to an Object
You can apply any number of filters to an object in Motion. When multiple filters are
applied to a single object, they all work together to create a final look for the object.
Multiple filters appear under the object to which they are applied.

Layers tab Timeline tab

Note: Remember that the more filters you use in a project, the more you impact the
performance of Motion.
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Improving Performance with Filters
When applying filters to several different layers in Motion, it is recommended that you
apply the filters to the layers’ parent group. Also, when applying filters to very large
groups (such as a group containing a growing particle system), you should select the
Fixed Resolution checkbox in the Group tab of the Inspector. When Fixed Resolution is
selected, layers that are in the group but are outside of the Canvas are cropped to the
size of the group defined in the parameter. The Group tab is only available when a group
is selected. For more information, see Fixing the Size of a Group.

Note: When enabled, the Fixed Resolution parameter crops the group to the size
specified in the Fixed Width and Fixed Height parameters around the anchor point of
the group.

Where Filters Appear
After you apply a filter, it appears underneath the object to which it is applied in the
Layers tab and the Timeline.

Timeline tabLayers tab
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The most recently applied filters appear at the top of the Filters tab of the Inspector.

Filters tab

When you apply a filter to an object, the filter retains its default settings. For example,
the Bevel filter applies a border with a Light Angle of 0 degrees, Bevel Width of 0.2, Opacity
of 0.8, and Light Color set to white. You can modify those default settings in the Filters
tab or the Inspector or in the HUD.

Special Considerations When Applying Filters to Text and Groups
Filters affect text, 2D, and 3D groups in different ways. For more information on applying
filters to 2D groups, see 2D Group Properties. For information on applying filters to 3D
groups, see 3D Group Properties. For information on applying filters to text, see Adding
Behaviors and Filters to Text.

Adjusting Filters
Filters can be tailored to your specific needs by adjusting their parameters. The parameters
can be adjusted in a number of different ways, such as using sliders in the HUDs and in
the Inspector, by dragging onscreen controls, by adding keyframes, or by applying
parameter behaviors.
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Adjusting Parameters in the Inspector and HUD
Each filter has its own distinct set of parameters. These parameters can be adjusted in
one of two places: the Filters tab of the Inspector or the filter’s HUD. As with all parameters
in Motion, the HUD contains the most essential parameter controls for modifying a filter,
whereas the Filters tab in the Inspector contains the filter’s entire list of editable
parameters.

Both the HUD and the Filters tab reference the same parameters—changing a parameter
in one automatically changes that parameter in the other. Frequently, the controls available
in a filter’s HUD represent all parameters except for the position parameters. For example,
compare the controls for the Fisheye filter in the Filters tab to those available in the HUD:

Filters tab HUD

Most filter parameters have only a single set of numbers that represent their value.
Parameters with a disclosure triangle, however, may have additional numbers that
represent a different way of describing the same value. In the case of the Center parameter,
the numbers indicated in the value sliders are absolute values, but the X and Y values
under the disclosure triangle represent percentages. If the defaults for X and Y are both
0.5, that represents the center of the image. Changing the percentages updates the
absolute values in the value sliders.

For more information on accessing the Inspector and HUD controls, see Inspector and
HUD.
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In most cases, you interact manually with the parameters of a filter. The following image
shows the Filters tab in the Inspector for the Hatched Screen filter. The Hatched Screen
filter has six controls: Center, Angle, Scale, Skew, Stretch, and Contrast.

Hatched Screen filter in the Inspector

Use the dial, slider, the value slider, or value field to set and enter values for each parameter
as you see fit.

Important: Although the sliders are limited to a predetermined range of values, using
either the value slider or the value field may often allow you to specify a parameter value
outside of the slider’s range.

Using Onscreen Controls
Some of the filters have onscreen controls that manipulate certain filter parameters,
especially position. As you use these controls, the associated parameters will update in
the Inspector.

Keyframing Filter Parameters
Animating filter parameters is easy. The following section shows two ways to change a
filter parameter over time using keyframes.

To animate filter parameters using Record
1 Select the filter you want to animate.

2 Click the Record button (or press A) to enable recording.

3 Go to the frame where you want to add a keyframe.

4 Change the value of the parameter to the desired value.

A keyframe is automatically added with the value you select.

5 Go to the next frame where you want a keyframe.

6 Repeat steps 3 and 4 until you are finished.

To animate filter parameters using the Animation menu
1 Select the filter you want to animate.
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2 Go to the frame where you want to add a keyframe.

3 In the Inspector, click the Animation menu for the parameter you want to animate, then
choose Add Keyframe from the menu.

Adding a keyframe in the Animation menu

4 Change the value of the parameter to the desired value.

5 Go to the next frame where you want a keyframe.

6 Repeat steps 3 and 4 until you are finished.

Note: Remember to add a keyframe before adjusting a parameter value.

For more detail on using keyframes and the animation menu, see Animation Menu.

Applying Behaviors to Filter Parameters
Animating filter parameters is easy using Parameter behaviors. For example, if you have
an object with an applied Circle Blur filter, you can randomize the amount of blur applied
to the object over time.

To randomize the blur applied to an object
1 Select the object with the applied blur filter.

2 In the Inspector, open the Filters tab.

3 Select the Amount parameter.
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4 Control-click Amount, then choose Randomize from the shortcut menu.

The Behaviors icon appears in the Animation menu, and the Behaviors tab opens in the
Inspector.

Behaviors icon

Adjusting the Amount parameter in Randomize changes the amount of variance between
the random values. A small number causes small variations in the random values, and a
larger number means larger variations in the values. For more detailed information about
the Randomize behavior, see Randomize.

For more detailed information about all of the Parameter behaviors, see Parameter
Behaviors.
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Enabling, Renaming, and Locking Filters
When you apply a filter to an object in your project, it appears in three different
places—the Layers tab, the Timeline, and the Filters tab of the Inspector. While the Filters
tab in the Inspector contains all of the editable parameters for any filter that has been
applied to an object, the Layers tab and Timeline have three primary controls for each
filter that appears.

Lock icon

Name

Activation checkbox

The following filter controls appear in the Layers tab and Timeline:

• Activation checkbox: Turns each individual filter on or off. Filters that are turned off are
not rendered.

• Name: The name of each filter can be customized by double-clicking the name and
typing a new one.

• Lock: Click the lock icon to switch the locked state on and off for the filter.

Copying, Pasting, Moving and Duplicating Filters
Filters can be easily copied, pasted, and moved like any other object in Motion. There are
a number of ways you can move and copy filters among the other objects in the Timeline
or Project pane. They can be pasted over other filters and moved across projects. When
you cut or copy a filter in the Timeline or Project pane, you also copy the current state
of all that filter’s parameters.

To cut or copy a filter
1 Select the filter in the Layers tab or Timeline.

2 Do one of the following:

• To remove a filter, choose Edit > Cut (or press Command-X).

• To copy the filter, choose Edit > Copy (or press Command-C).

To paste a filter
1 Select the object to which you want to apply the filter.

2 Choose Edit > Paste (or press Command-V).
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The filter is applied with all its parameter settings intact.

Note: Pasting a filter does not paste it at the current playhead location. To quickly move
the filter to the playhead location, press the Shift key while you drag the pasted object.
As you approach the current playhead location, it snaps into place.

To move a filter
µ Drag the filter from its current location to another layer to which you want to apply the

filter.

Original location

The destination is 
highlighted.

To duplicate a filter
µ Option-drag the filter from its current location to the new object to which you want to

apply the filter.

The pointer changes to 
indicate duplication.

Note: You can also choose Edit > Duplicate (or press Command-D) to duplicate the filter.
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Reordering Filters
When multiple filters are applied to a single object, they appear beneath that object in
the Timeline or Project pane. You can change the order in which they are applied to the
object, to change how they interact.

Some filters yield better results depending on the order in which they are applied. For
instance, you wouldn’t want to apply a color correction after a blur. To get the most
accurate color correction, you want to apply the color correction filter to the source object,
not a modified version of the source. The same is true for extracting keys, and just about
process that depends on color information.

To reorder a filter
1 Select the filter you want to reorder.

2 Click the name of the filter or the icon to the left of the name, then drag it up or down
in the Layers tab.

A position indicator shows the new position for the filter when you release the mouse
button.

3 Release the mouse button when the position indicator is in the new location.

The Circle Blur moves 
above the Highpass filter.

Changing Filter Timing
Filters appear as a bar in the Timeline and like other duration bars, can be trimmed or
moved (slipped) in time.

When you apply a filter to an object, the duration of the filter defaults to the length of
the object to which it is applied. This can be seen in the Timeline.

Filter duration defaults to 
object duration.
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Once applied, a filter’s duration can be modified to affect the object over a different
amount of time than the object’s duration. For example, applying the Soft Focus filter to
an object results in that object being blurred for the entire object’s duration in the
Timeline. Changing In and Out points of the Soft Focus filter, however, changes when the
blur is applied to the object.

To trim a filter in the Timeline
1 Position the pointer on the In or Out point (the left or right edge) of the filter you want

to trim.

2 When the pointer changes to the trim pointer, drag the In or Out point to change the
duration of the filter.

Changing a filter’s Out point

As you drag, the new In or Out points are displayed. Also displayed is the delta value,
which represents the amount of change for the duration.

In addition to changing a filter’s duration, you can also slip its position in the Timeline
relative to the layer under which its nested. This allows you to set the frame at which a
filter begins to take effect.

To slip a filter in the Timeline
µ Click anywhere in the middle of a filter bar in the Timeline, then drag it to the left or right

to move its In point to another frame.

The filter is moved and its duration is not affected. While you drag, the new In and Out
points are indicated, along with the amount of change (the delta).

Slipping a filter
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Blur Filters
Blur filters take many forms in Motion. They can be used practically to simulate the
real-world blurring that occurs due to the depth of field in photographed material, or
they can be used creatively to make all sorts of designed effects. Motion provides a wide
variety of blur filters you can use for any task.

Channel Blur
Gives you control over blurring each color channel of an object. The Channel blur can be
applied selectively to each of the different color channels of the object: red, green, blue,
and alpha.

Blurring individual channels allows you to create customized glow effects by retaining
sharpness in selected channels while softening others.

Original image Amount = 15, Blur Red On

Parameters in the Inspector
Amount: Sets the radius of the object blur.

Blur Red: A checkbox that sets the blur to affect the red channel.

Blur Green: A checkbox that sets the blur to affect the green channel.

Blur Blue: A checkbox that sets the blur to affect the blue channel.

Blur Alpha: A checkbox that sets the blur to affect the alpha channel.

Horizontal: Sets the percentage of maximum horizontal blur. This is a percentage of the
Amount parameter.

Vertical: Sets the percentage of maximum vertical blur.

Crop: A checkbox that sets whether or not the image is cropped beyond its original
borders.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount, Blur Red, Blur Green, Blur Blue, and
Blur Alpha.
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Circle Blur
Creates a circular blur within an image, specified by a center point that sets the center
of the blur effect, and a radius that sets the size of the affected region. The amount of
blur within the affected area can also be customized.

This filter is useful for quickly blurring a limited area within an image. For more
sophisticated control of the image region to be blurred, try the Compound Blur filter.

This filter causes rasterization in 3D groups.

Original image Center of Circle Blur on the right side of crab

Parameters in the Inspector
Center: Sets the position of the center of the blur effect.

Amount: Sets the amount of the blur.

Radius: Sets the radius of the circle defining the blurred area.

Crop: Sets whether or not the image is cropped beyond its original borders.

Mix: Sets the percentage at which the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount, Radius, and Crop.

Compound Blur
Blurs an object using the specified channel of a designated map image. You can use any
shape, still image, or movie file as the map image. You can select any or all of the red,
green, blue, alpha, or luminance channels to create the overall shape of the blur.

One of the fastest ways to use this filter is to create a shape object, and trace the subject
of the image you want to blur. Then, assign this shape as the Blur Map image, using either
its Luminance or Alpha channel to define the blurred area, and turn off the original shape
object in the Layers tab or Timeline to reveal the new blur effect.

When this filter is applied, Compound Blur uses the original image as the map to create
the initial blur. Drag any image into the Blur Map well to assign a different image.
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This filter causes rasterization in 3D groups. For more information on rasterization, see
About Rasterization.

Original image Map image

Compound Blur applied

Parameters in the Inspector
Amount: Sets the radius of the blur.

Blur Map: An image well that displays a thumbnail of the map chosen.

Map Channel: A pop-up menu to select the channel to be blurred. The blur is applied
to the red, green, blue, alpha, or luminance channel.

Invert Map: Sets whether or not the blur map is inverted.

Stretch Map: Sets whether or not the map is stretched.

Horizontal: Sets the percentage of maximum horizontal blur.

Vertical: Sets the percentage of maximum vertical blur.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount, Blur Map, and Map Channel.
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Defocus
A more accurate model of the out-of-focus effect that occurs through a real-world camera
lens. The Defocus filter blurs an image while creating a controlled glow effect in brighter
areas of the image. The resulting object has a lens aperture-shaped structure around the
highlights. The shape of the blurred glow around the affected highlights can be
customized.

Use this filter when you are trying to blur one image to match video or stills that were
shot with a camera. For example, if you have keyed a woman standing in front of a blue
screen, and you intend to place a background image behind her to make it look like she’s
standing in a valley with mountains in the background, use the Defocus filter instead of
a Gaussian Blur to create a realistic depth-of-field effect for the mountains in the distance.

Original image Defocus applied

Parameters in the Inspector
Amount: Sets the radius of the defocus.

Gain: Sets the amount of gain applied to the high luminance areas.

Shape: A pop-up menu that sets the shape of the lens aperture. Circle or Polygon.

Sides: Sets the number of sides of the lens aperture, if Shape pop-up menu is set to
Polygon.

Rotation: Sets the angle of rotation of the polygonal lens aperture, if Shape is set to
Polygon.

Aspect Ratio: Sets the aspect ratio of the lens aperture.

Crop: Sets whether or not the blur will be cropped at the object’s original border.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount, Gain, Shape, Sides, Rotation, and
Aspect Ratio.
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Directional Blur
Blurs an object along a specific angle. This filter creates a blurred streaking effect.

Note: Remember that the more filters you use in a project, the more you impact the
performance of Motion.

Original image Directional Blur applied

Parameters in the Inspector
Amount: Sets the radius of the blur.

Angle: Sets the angle of the direction of movement.

Crop: Sets whether or not the blur is cropped at the object’s original boundaries.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount and Angle.

Gaussian Blur
The Gaussian blur is the softest blur effect you can apply, and is one of the most frequently
used blur effects. By default, it affects the entire image uniformly, although you can control
the amount of horizontal and vertical blur independently.
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Gaussian blur is entirely appropriate for most motion graphics tasks, and can be animated
for a variety of focus-control effects. However, to more accurately simulate camera focus,
the Defocus filter may be more appropriate. For more information on the Defocus filter,
see Defocus.

Original image Gaussian Blur applied

Parameters in the Inspector
Amount: Sets the radius of the blur.

Horizontal: Sets the percentage of the Amount applied in the horizontal direction.

Vertical: Sets the percentage of the Amount applied in the vertical direction.

Crop: Sets whether or not the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount, Horizontal, and Vertical.

Gradient Blur
The Gradient Blur filter allows you to control the blurred region of an image by creating
a graduated blur between two points. Point one is the beginning of the blur, and the
point at which the image is at its sharpest. Point two is the end of the blur, and the point
at which the image is at its blurriest, depending on the value set in the Amount parameter.
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This filter causes rasterization in 3D groups.

Original image Point 1 upper left, Point 2 lower right

Parameters in the Inspector
Point 1: Sets the position of the start point of the gradient.

Point 2: Sets the position of the end point of the gradient.

Amount: Sets the radius of the blur.

Crop: Sets whether or not the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount and Crop.

Movement Blur
Analyzes movement in a clip using optical flow methods, blurs the movement, and mixes
the result with the original image.

This filter causes rasterization in 3D groups.

Original image Movement Blur applied

Parameters in the Inspector
Amount: Sets the radius of the blur.
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Sensitivity: Sets the sensitivity of blur detection. The higher the value, the lower the
threshold of movement required to result in motion blur.

Quality: Sets the quality of the blur calculations. A higher value increases the quality of
the resulting blur.

Smoothness: A pop-up menu that sets the smoothness of the blur.

Display: A pop-up menu that sets how the Movement Blur is displayed. Menu choices
are Motion Blur and Optical Flow. Motion Blur shows the blurred image. Optical Flow
shows reference points for how the movement of the image was analyzed to determine
the application of blur.

Grid Size: Sets the size of each panel in the grid overlay used for optical flow analysis.

Grid Scale: Sets the scale of the entire grid used for optical flow analysis.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount, Sensitivity, Quality, Smoothness, and
Display.

Prism
Blurs and refracts the image as if seen through a prism, creating a rainbow effect.

Original image Prism applied

Parameters in the Inspector
Amount: Sets the radius of the blur.

Angle: Sets the angle of refraction.

Crop: Sets whether or not the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the blurred and refracted
image.

HUD Controls
The HUD contains the following controls: Amount and Angle.
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Radial Blur
This filter creates a rotational blur centered on a point. The effect is similar to the motion
blur you would see if an image were spinning quickly.

Original image Radial Blur applied

Parameters in the Inspector
Center: Sets the position of the center of the radial blur.

Angle: Sets the angle of rotation of the blur.

Subsampling: Sets the number of samples.

Crop: Sets whether or not the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Angle, Subsampling, and Crop.
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Soft Focus
This filter creates an effect that’s similar to duplicating an object, using the Screen blend
mode to composite it against itself, and then blurring one of the overlapping objects.
The advantage of this filter is that you can do this all within a single filter. The Strength
parameter controls how much of the blurred image is added back to the original image,
while other sliders let you control the overall, horizontal, and vertical amount of blur.

Original image Soft Focus applied

Parameters in the Inspector
Amount: Sets the radius of the blur.

Strength: Sets the amount of opacity of the blurred composite.

Horizontal: Sets the percentage of the maximum horizontal blur.

Vertical: Sets the percentage of the maximum vertical blur.

Crop: Sets whether or not the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount and Strength.

Variable Blur
A blur that can either include or exclude a circular region, to create a sort of tunnel focus
effect. If the inner radius of the circle is larger than the outer radius of the circle, the blur
is applied outside of the circle. Otherwise, the blur is applied to the area within the circle.
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This filter causes rasterization in 3D groups.

Original image Variable Blur (outside of circle)

Parameters in the Inspector
Center: Sets the position of the center of the circle.

Amount: Sets the percentage of the blur.

Inner Radius: Sets the inner radius of the circle.

Outer Radius: Sets the outer radius of the circle.

Crop: Sets whether or not the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following controls: Amount, Inner Radius, Outer Radius, and Crop.

Zoom Blur
This filter creates a blur that simulates a fast camera zoom in to a point. This filter causes
rasterization in 3D groups.

Original image Zoom Blur applied

Parameters in the Inspector
Amount: Sets the radius of the blur.
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Center: Sets the position of the center of the blur.

Crop: Sets whether the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the blurred image.

HUD Controls
The HUD contains the following control: Amount.

Border Filters
Border filters allow you to frame objects in a composition in various ways.

Bevel
Creates a bevelled border around the edges of an object by superimposing an angled
frame over the original image. The simulated direction of reflected light and opacity of
the bevel can be adjusted to vary the effect.

This filter causes rasterization in 3D groups.

Original image Bevel applied

Parameters in the Inspector
Light Angle: Sets the angle at which the light is hitting the bevel.

Bevel Width: Sets the width of the bevel as a percentage of the area of the object.

Opacity: Sets the opacity of the bevel, ranging from 0 (invisible) to 1.0 (opaque).

Light Color: Picks the color of the light hitting the bevel border. The color controls can
be expanded with the disclosure triangle to include Red, Green, and Blue sliders to more
precisely select colors.

Mix: Sets what percentage of the original image is blended with the beveled image.

HUD Controls
The HUD contains the following controls: Light Angle, Bevel Width, Opacity, and Light
Color.
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Simple Border
Creates a solid color border of variable width around the edges of an object. This filter
causes rasterization in 3D groups.

Original image Border applied

Parameters in the Inspector
Width: Sets the thickness of the border.

Color: Picks the color of the border. The color controls can be expanded with the disclosure
triangle to include Red, Green, Blue, and Opacity sliders to more precisely select the color
of the border.

Mix: Sets what percentage of the original image is blended with the bordered image.

HUD Controls
The HUD contains the following controls: Width and Color.

Widescreen
This filter “letterboxes” an object by masking the object at its top and bottom to simulate
a variety of video and film aspect ratios. Because this filter is masking the image, what
appears behind the object is either the background color of the project or the object that
is beneath the masked object in the composite. You can also add an additional border
to the masked image and customize the color and size of the border.

This filter causes rasterization in 3D groups.
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Note: Because the Widescreen filter is masking the object to which it is applied, the object
is not cropped and retains its original shape.

Original image Widescreen applied

Parameters in the Inspector
Aspect Ratio: A pop-up menu that sets the aspect ratio of the mask. Values include:
1.66:1, 1.70:1, 1.78:1, 1.85:1, 2.35:1, 2.55:1, and 3.00:1.

Offset: Sets the position of the mask relative to the Y center of the object. Values range
from –1.0 (the bottom of the object) to 0 (the center of the object) to 1.0 (the top of the
object).

Border Size: Sets the thickness of the border.

Note: The border has no effect on the aspect ratio mask, but merely adds an additional
frame within the edge of the image created by the mask.

Border Color: Picks the color of the border. The color controls can be expanded with the
disclosure triangle to include Red, Green, Blue, and Opacity sliders to more precisely select
the color of the border.

Mix: Sets what percentage of the original image is blended with the letterboxed image.

HUD Controls
The HUD contains the following controls: Aspect Ratio, Offset, Border Size, and Border
Color.

Color Correction Filters
Color correction filters can be used in a number of ways. You can change a mood by
making an object sepia colored, or make your object stand out by oversaturating it. In
addition, these filters can be used to fix a problem with contrast, color, gamma, or
brightness.

Brightness
Boosts or lowers the uniform brightness of an image by the specified amount.
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Although this may seem to be the first filter to use if you want to correct for improper
exposure in an image, the drawback of this filter is that it boosts or lowers everything in
an image at once. This means that raising the brightness in an image raises it everywhere,
including in the shadows. The result is that a brightened image may look washed out.

On the other hand, this filter can come in very handy as a way to modify the edges and
effects of shapes, masks, particle systems, and generators.

A better filter for exposure correction is the Gamma filter. For more information, see
Gamma.

Original image Brightness filter applied

Parameters in the Inspector
Brightness: Sets the multiplying brightness value applied to the object.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following control: Brightness.

Channel Mixer
Allows cross-mixing of red, green, blue, and alpha channels into one another. The Channel
Mixer filter’s main parameters are divided into four sections, each of which manipulates
an individual channel. In each section, you can adjust the value of the relevant color
channel added to or subtracted from the red, green, blue, and alpha channels. This is a
more flexible version of the Channel Swap filter below.

Parameters in the Inspector
Red - Red: Sets the amount of input red added to the output red. The default value is
1.0, which leaves the red channel unmodified. As this value increases, the output value
of red increases by the amount of input red multiplied by the value of Red - Red.
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Red - Green: Sets the amount of input green added to the output red. The default value
is 0, which leaves the red channel unmodified. As this value increases, the output value
of red increases by the amount of input green multiplied by the value of Red - Green.

Red - Blue: Sets the amount of input blue added to the output red. The default value is
0, which leaves the red channel unmodified. As this value increases, the output value of
red increases by the amount of input blue multiplied by the value of Red - Blue.

Red - Alpha: Sets the amount of input alpha added to the red channel. The default value
is 0, which leaves the red channel unmodified. As this value increases, the value of red
increases by the amount of input alpha multiplied by the value of Red - Alpha.

Green - Red: Sets the amount of input red added to the output green. The default value
is 0, which leaves the green channel unmodified. As this value increases, the output value
of green increases by the amount of input red multiplied by the value of Green - Red.

Green - Green: Sets the amount of input green added to the output green. The default
value is 1.0, which leaves the green channel unmodified. As this value increases, the
output value of green increases by the amount of input green multiplied by the value of
Green - Green.

Green - Blue: Sets the amount of input blue added to the output green. The default value
is 0, which leaves the green channel unmodified. As this value increases, the output value
of green increases by the amount of input blue multiplied by the value of Green - Blue.

Green - Alpha: Sets the amount of input alpha added to the green channel. The default
value is 0, which leaves the green channel unmodified. As this value increases, the value
of green increases by the amount of input alpha multiplied by the value of Green - Alpha.

Blue - Red: Sets the amount of input red added to the output blue. The default value is
0, which leaves the blue channel unmodified. As this value increases, the output value
of blue increases by the amount of input red multiplied by the value of Blue - Red.

Blue - Green: Sets the amount of input green added to the output blue. The default value
is 0, which leaves the blue channel unmodified. As this value increases, the output value
of blue increases by the amount of input green multiplied by the value of Blue - Green.

Blue - Blue: Sets the amount of input blue added to the output blue. The default value
is 1.0, which leaves the blue channel unmodified. As this value increases, the output value
of blue increases by the amount of input blue multiplied by the value of Blue - Blue.

Blue - Alpha: Sets the amount of input alpha added to the blue channel. The default
value is 0, which leaves the blue channel unmodified. As this value increases, the value
of blue increases by the amount of input alpha multiplied by the value of Blue - Alpha.

Alpha - Red: Sets the amount of input red added to the output alpha. The default value
is 0, which leaves the alpha channel unmodified. As this value increases, the output value
of pixels with non-transparent alpha increases by the amount of input red multiplied by
the value of Alpha - Red.
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Alpha - Green: Sets the amount of input green added to the output alpha. The default
value is 0, which leaves the alpha channel unmodified. As this value increases, the output
value of pixels with nontransparent alpha increases by the amount of input green
multiplied by the value of Alpha - Green.

Alpha - Blue: Sets the amount of input blue added to the output alpha. The default value
is 0, which leaves the alpha channel unmodified. As this value increases, the output value
of pixels with nontransparent alpha increases by the amount of input blue multiplied by
the value of Alpha - Blue.

Alpha - Alpha: Sets the amount of input alpha added to the output alpha channel. The
default value is 1.0, which leaves the alpha channel unmodified. As this value increases,
more alpha is added to the pixels in the alpha channel. Values above 1 have no effect,
unless the alpha has been eroded by negative values in the other alpha parameters.

Monochrome: Sets the filter to monochrome mode. In monochrome mode, all three
color channels are affected by the Red controls.

Allow Mono > 1: Allows monochromatic color channels to be set to values greater than
1. By default, this checkbox is selected. Color values are normally between 0 and 1, but
can go over 1 or below 0 if your project’s bit depth is set to 16 bits or 32 bits per channel.
If this checkbox is deselected, each of the Red color output controls are linked. Moving
any one of them causes the others to automatically adjust to keep the total value at 1.0.
The filter must be in monochrome mode for this parameter to be active.

Include Alpha: Sets whether or not to include the alpha channel in the mono calculation.
The filter must be in monochrome mode for this parameter to be active.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Red - Red, Red - Green, Red - Blue, Red - Alpha,
Green - Red, Green - Green, Green - Blue, Green - Alpha, Blue - Red, Blue - Green, Blue -
Blue, Blue - Alpha, Alpha - Red, Alpha - Green, Alpha - Blue, Alpha - Alpha, Monochrome,
Allow Mono > 1, and Include Alpha.
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Channel Swap
Substitutes the color value of a color channel with that of either a selected channel, or
its inverse. If you select Blue from Red, the value of blue in the object will match the value
of red across the entire object. The Channel Swap filter can be used in a variety of ways,
including simply inverting the alpha channel of an object.

Original image Blue from parameter set to Red

Parameters in the Inspector
Red from: The numerical value of red is replaced by the numerical value of color of the
selected channel. Values can be selected from Red (unchanged), Green, Blue, Alpha,
Inverse Red, Inverse Green, Inverse Blue, and Inverse Alpha.

Green from: Sets the value of green to the value of the selected channel. Values can be
selected from Red, Green (unchanged), Blue, Alpha, Inverse Red, Inverse Green, Inverse
Blue, and Inverse Alpha.

Blue from: Sets the value of blue to the value of the selected channel. Values can be
selected from Red, Green, Blue (unchanged), Alpha, Inverse Red, Inverse Green, Inverse
Blue, and Inverse Alpha.

Alpha from: Sets the value of the alpha to the value of the selected channel. Values can
be selected from Red, Green, Blue, Alpha (unchanged), Inverse Red, Inverse Green, Inverse
Blue, and Inverse Alpha.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Red from, Green from, Blue from, and Alpha
from.
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Color Balance
Color balance generally refers to the overall tint of an image reflecting the color
temperature of the primary source of light. For example, sunlight is generally bluer than
interior tungsten light, which tends to be more orange. Although most film and video is
shot to make sure that the whites in an image are a true neutral white, different film
stocks and video color balance settings result in slight tints in the image.

Use this filter to adjust the color balance of an object by boosting or lowering the individual
amount of reds, greens, and blues in the shadows, midtones, and highlights of an image.
You can use this filter to correct for improper color balance, or to change the color balance
in an image for a stylized effect.

Original image Midtone Blue = 0.20, Highlight Blue = -0.5

Parameters in the Inspector
Shadow Red: Picks the color gain applied to the shadow range of the red color channel.
Values range from –1.0 (no color) to 0 (unaltered color) to 1.0 (maximum color).

Shadow Green: Picks the color gain applied to the shadow range of the green color
channel.

Shadow Blue: Picks the color gain applied to the shadow range of the blue color channel.

Midtone Red: Picks the color gain applied to the midtone range of the red color channel.

Midtone Green: Picks the color gain applied to the midtone range of the green color
channel.

Midtone Blue: Picks the color gain applied to the midtone range of the blue color channel.

Highlight Red: Picks the color gain applied to the highlights of the red color channel.

Highlight Green: Picks the color gain applied to the highlights of the green color channel.

Highlight Blue: Picks the color gain applied to the highlights of the blue color channel.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.
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HUD Controls
The HUD contains the following controls: Shadow Red, Shadow Green, Shadow Blue,
Midtone Red, Midtone Green, Midtone Blue, Highlight Red, Highlight Green, and Highlight
Blue.

Color Reduce
Reduces the full range of color in an image down to two, three, or four colors that you
select. Depending on the number of substitute colors you choose in the Reduce To
parameter, this filter breaks down the full range of colors in the image into a color range
for each Match Color parameter that’s available. It then substitutes the selected Replace
With color for each interpreted range of color.

If two colors are selected, all color information in the object is reduced to the selected
two colors; if three, they are reduced to three; and so on.

Original image Color Reduce defaults applied

Parameters in the Inspector
Smoothness: Sets the smoothness of the transitions between the reduced areas. Values
range from 0 (hard edges) to 1 (smooth blending).

Reduce To: Selects the number of colors in the reduced object. Choices are 4 Colors, 3
Colors, or 2 Colors.

Match Color 1: Picks the color of the first selection color for reduction. The color controls
can be expanded with the disclosure triangle to reveal Red, Green, and Blue sliders for
more precise color selection.

Replace With: Picks the color that is substituted for the selection determined by Color 1.

Match Color 2: Picks the color of the second selection color for reduction.

Replace With: Picks the color that is substituted for the selection determined by Color 2.

Match Color 3: Picks the color of the third selection color for reduction. This parameter
is used only if Reduce To is set to 3 Colors or 4 Colors.

Replace With: Picks the color that is substituted for the selection determined by Color 3.
This parameter is used only if Reduce To is set to 3 Colors or 4 Colors.
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Match Color 4: Picks the color of the fourth selection color for reduction. This parameter
is used only if Reduce To is set to 4 Colors.

Replace With: Picks the color that is substituted for the selection determined by Color 4.
This parameter is used only if Reduce To is set to 4 Colors.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Smoothness, Reduce To, Match Color 1, Replace
With, Match Color 2, Replace With, Match Color 3, Replace With, Match Color 4, and Replace
With.

Colorize
Substitutes the blacks and whites in an image with different colors you select. All other
colors in the image are remapped to a duochrome range that falls between these two
colors.

Interesting colorized “negative” effects can be achieved by remapping the blacks in an
image to a lighter color than the whites.

Original image Colorize with defaults

Parameters in the Inspector
Remap Black To: Sets the color that is mapped to black. The color controls can be
expanded with the disclosure triangle to include Red, Green, Blue, and Opacity sliders to
more precisely select the color.

Remap White To: Sets the color that is mapped to white. The color controls can be
expanded with the disclosure triangle to include Red, Green, Blue, and Opacity sliders to
more precisely select the color.

Intensity: Sets the strength of the colorization. Values range from 0 (no colorization) to
1.00.

Mix: Sets the percentage at which the original image is blended with the color-corrected
image.
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HUD Controls
The HUD contains the following controls: Remap Black To, Remap White To, and Intensity.

Contrast
Adjusts the contrast of an object.

Original image Contrast filter applied

Parameters in the Inspector
Contrast: Sets the amount of contrast to be applied to the object.

Pivot: Sets the point around which the contrast is adjusted. The point of contrast
adjustment is the level which is displayed if Contrast is set to 0.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Contrast and Pivot.

Desaturate
Reduces the amount of color in an image by a specified amount. This filter can be used
to mute the color in an image, making brighter colors less saturated. It can also be used
to completely eliminate the color from an image, turning a color image to a grayscale
one.

Original image Desaturated image
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Parameters in the Inspector
Desaturation: Sets the amount of desaturation. Values range from 0 (no change) to 1.00
(full desaturation).

Luminance: Sets how the luminance type is calculated. Values can be selected from the
following: NTSC, PAL, Film, Red, Green, and Blue. If NTSC, PAL, or Film is selected, luminance
is calculated based on weighting for those standards; if a channel is selected, luminance
is calculated using that channel.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Desaturation and Luminance.

Equalize
Remaps the black and white points in an image, resulting in individual adjustments to
the contrast in the dark and light parts of an image. The Equalize filter can be used to
adjust the overall contrast range of an image, crushing the whites and blacks, or it can
be used to create selective washed out or darkened effects.

This filter causes rasterization in 3D groups.

Original image Equalize applied

Parameters in the Inspector
Black Point: Sets the relative color value used for black.

White Point: Sets the relative color value used for white.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Black Point and White Point.
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Gamma
The Gamma filter adjusts the relative distribution of brightness within the midtones of
an image, while leaving the white and black points alone. The perceived result is to
brighten and darken the areas of medium brightness within an image, while leaving the
highlights and shadows untouched. This avoids a washed-out result.

This is one of the most useful filters for correcting poor exposure in images, and should
almost always be used first before trying the Brightness filter.

Original image Gamma filter applied

Parameters in the Inspector
Gamma: Sets the gamma correction.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following control: Gamma.

Gradient Colorize
Uses each pixel’s color value to determine the application of a color value from a gradient.

Original image Gradient Colorize with Rainbow gradient
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Parameters in the Inspector
Gradient: Selects a gradient preset to be applied to the object, or is used to edit a custom
gradient.

For more information on using the Gradient editor, see Using the Gradient Editor.

Offset: Sets an amount, in degrees, that the color wheel is offset to determine color
application. Values start at 0 degrees.

Repeats: Sets the number of times the gradient repeats over the course of its range.

Repeat Method: Sets the method by which the gradient is mapped when repeating.
Values can be set to either Mirror (default) or Wrap. This parameter only affects the filter
when Repeats is set to a number greater than 1.

Map Channel: Sets the channel used to determine how the image is colorized. Values
can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Gradient, Offset, Repeats, Repeat Method, and
Map Channel.

HSV Adjust
An alternate method of performing color correction based on the HSV color model. HSV
is often used in computer interfaces.

This filter provides controls to adjust the Hue, Saturation, and Value levels in an image.
The Hue control is an angular representation of the color values in an image. By rotating
the Hue angle, you uniformly remap the colors throughout an image, similar to the effect
of turning the hue or phase knob of a broadcast monitor.
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The saturation controls the intensity of the color in an image, with a high saturation
resulting in vivid color, and a low saturation resulting in a grayscale image with no color
at all. The Value slider, on the other hand, adjusts the overall brightness or darkness of
all colors in an image, including the blacks and whites in a desaturated image.

Original image HSV Adjust filter applied (low saturation goes to 
grayscale)

Parameters in the Inspector
Hue: Sets the angle of adjustment used to set the zero point of the color wheel.

Saturation: Sets the color saturation of the object, ranging from –1.0 (no color information)
to 0.0 (unadjusted color) to 3.0.

Value: Sets the intensity adjustment applied to the object.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Hue, Saturation, and Value.
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Invert
Inverts all color and brightness in an image. This filter can be used to turn a scanned
negative image into a properly displayed positive.

Original image Image inverted

Parameters in the Inspector
Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
None.

Levels
This filter provides controls to remap the white and black points of an image, along with
a Gamma control to adjust the midtones, all at once. A histogram provides an analysis
of the image that you can use to help you judge the adjustments you want to make.

A powerful option within this filter is the ability to make independent adjustments to the
red, green, blue, and alpha channels of an object.

Parameters in the Inspector
Histogram: Displays an analysis of the object. By default, the RGB channels are selected.
A pop-up menu can be used to select Red, Green, Blue, or Alpha channels individually
for viewing.

Click the disclosure triangles to expose parameters for each channel (RGB, Red, Green,
Blue, Alpha, and Gamma) to display sliders:

• Black In: Sets the In point for black, below which values are considered black.

• Black Out: Sets the minimum brightness value that appears in the output. Other values
are scaled between Black Out and White Out values.

• White In: Sets the In point for white, above which values will not be output.

• White Out: Sets the maximum brightness value that appears in the output. Other values
are scaled between Black Out and White Out values.

987Chapter 16 Using Filters



• Gamma: Sets the amount of gamma correction.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
None.

Negative
Simulates the effect of turning an image into a film negative. This filter causes rasterization
in 3D groups.

Original image Negative applied

Parameters in the Inspector
Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
None.

Reduce Banding
Reduces the amount of banding in the image.

Original image Reduce Banding filter applied
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Parameters in the Inspector
Noisiness: Sets the amount of noise to introduce into the object.

Movement: Sets whether or not to animate the noise in the image.

Mix: Sets the amount of the original image to mix with the color-corrected image.

HUD Controls
The HUD contains the following control: Noisiness.

Saturate
Increases or decreases the amount of color in an image by a specified amount. This filter
can be used to mute the color in an image, making brighter colors less saturated. It can
also be used to completely eliminate the color from an image, turning a color image to
a grayscale one.

This filter causes rasterization in 3D groups.

Original image Saturate filter applied

Parameters in the Inspector
Saturation: Sets the color saturation of the object, ranging from –1.0 (no color information)
to 0.0 (unadjusted color) to 3.0.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following control: Saturation.

Sepia
Tints an object with a sepia tone. The black and white points are remapped to dark and
light sepia colors. The amount of tinting can be adjusted, to achieve either a subtle mix
of the original and tinted colors, or a completely tinted image.
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This filter is good for that “old-time western” look.

Original image Sepia filter applied

Parameters in the Inspector
Amount: Sets the amount of sepia tone applied to the object.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following control: Amount.

Threshold
Reduces all colors in an image to a duotone, with the additional ability to limit the range
of midtones that are preserved in the image. The result is an extremely high-contrast
image that defaults to black and white—but you can reduce the image to any two colors.

Original image Dark color: black. Light color: white.

Parameters in the Inspector
Threshold: Sets the threshold of selection for color substitution. The threshold determines
what will be considered light and what will be considered dark areas of the object.

Smoothness: Sets the smoothness of transition between the two colors substituted.
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Dark Color: Sets the color used to represent the dark interpreted areas of the object. The
color controls can be expanded with the disclosure triangle to include Red, Green, and
Blue sliders, for more precise color selection.

Light Color: Sets the color used to represent the light interpreted areas of the object.

Correct For Alpha: This setting renders semi-transparent pixels correctly. Enable this
setting if the edges of the filtered image show artifacts.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Threshold, Smoothness, Dark Color, and Light
Color.

Tint
Tints an entire image with a single color. Shadows and highlights are less affected, but
all of the midrange colors in the image are gradually replaced with the tint color as the
Intensity parameter is increased.

Original image Tint (brown) applied

Parameters in the Inspector
Color: Picks the color that is used to tint the object. The color controls can be expanded
with the disclosure triangle to display Red, Green, Blue, and Opacity sliders for more
precise color selection.

Intensity: Sets the amount of tint applied to the object.

Mix: Sets what percentage of the original image is blended with the color-corrected
image.

HUD Controls
The HUD contains the following controls: Color and Intensity.
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YIQ Adjust
Allows color adjustment in YIQ color space. The YIQ color space definition was formerly
used to describe an NTSC broadcast signal.

Parameters in the Inspector
Y: Sets the intensity of the Y color channel.

I: Sets the phase of the I color channel.

Q: Sets the phase of the Q color channel.

Mix: Sets the amount of the original image to mix with the color-corrected image.

HUD Controls
The HUD contains the following controls: Y, I, and Q.

YUV Adjust
Allows color adjustment in YUV (Y′CBCR) color space. The YUV color space definition is
used to describe NTSC and PAL broadcast signals.

Parameters in the Inspector
Y: Sets the intensity of the Y color channel.

U: Sets the phase of the U color channel.

V: Sets the phase of the V color channel.

Mix: Sets the amount of the original image to mix with the color-corrected image.

HUD Controls
The HUD contains the following controls: Y, U, and V.

Distortion Filters
Distortion filters are used to change the shape of your objects, warping, twisting, and
pulling them in all directions.

Basic 3D (Obsolete after Motion 3)
Allows you to rotate an object on the X, Y, and Z axes, and set its position and perspective.
In Motion 4, this filter is available only in projects created with an earlier version of Motion,
in which the Basic 3D filter was applied.
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This filter causes rasterization in 3D groups.

Original image Basic 3D applied

Parameters in the Inspector
X Rotation: Sets the amount, in degrees, that the object is rotated along the X axis.

Y Rotation: Sets the amount, in degrees, that the object is rotated along the Y axis.

Z Rotation: Sets the amount, in degrees, that the object is rotated along the Z axis.

Distance: Sets the distance the object is pushed away from the Canvas.

Perspective: Sets the amount of perspective shift placed on the object.

Back Face: An image well to which you can drag an object to use as the “back” side of
a rotated object.

Back Face Style: A pop-up menu that contains fit and display options for the object in
the Back Face image well:

• Center: Positions the object in the Back Face image well in the center of the rotated
object.

• Stretch: Stretches the object in the Back Face image well to the size of the rotated
object.

• Transparent: Hides the object in the Back Face image well.

• Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
None.

Black Hole
This filter distorts an image by causing part of it to disappear into the specified center
point, and by bowing the top, bottom, and sides inward. As the value of the Amount
parameter increases, the more the sides bow in, and the more of the image at the center
point disappears into it. The Poke filter has a similar effect without removing part of the
image.
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This filter causes rasterization in 3D groups.

Original image Black Hole applied

Parameters in the Inspector
Center: Sets the position of the center of the black hole.

Amount: Sets the amount of force pulling on your object. Values range from 0 (no gravity)
to 1000 (the entire object is pulled into the black hole).

Mix: Sets the amount of the original image to mix with the distorted image.

HUD Controls
The HUD contains the following control: Amount.

Bulge
This filter distorts an image as if pushed outward, as if something were “shoving” it from
behind.

This filter causes rasterization in 3D groups.

Original image Bulge applied

Parameters in the Inspector
Center: Sets the position of the center of the bulge.

Amount: Sets the amount of the bulge.
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Scale: Sets the direction and scale of the bulge. Lower values make the image appear to
bulge inwards; higher values make the image appear to bulge outwards.

Mix: Sets the amount the original image to mix with the distorted image.

HUD Controls
The HUD contains the following controls: Amount and Scale.

Bump Map
This filter uses a source object to define a bump pattern which can be used to deform
an object, with parameters to control the amount of distortion. You can use any image,
movie, or shape as the source object.

When this filter is initially applied, Bump Map behaves as if there were a black image
applied to the Map Image well, which does not distort the target image at all.

To learn how to add an object to the Map Image well, see Source Well.

This filter causes rasterization in 3D groups.

Original image Bump Map filter applied with a tiger image

Parameters in the Inspector
Map Image: An image well that displays a thumbnail of the map chosen.

Direction: Sets the angle at which the bump map protrudes.

Amount: Sets how far the bump map protrudes. Positive values push upward, negative
values push downward.

Repeat Edges: Sets whether or not the edges of the object are repeated.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Map Image, Direction, and Amount.
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Disc Warp
Stretches the image outward around a circular region. As the radius of the warping region
increases, the image is warped outward with a greater amount of distortion. The color
of the resulting disk is determined by the color value of the pixel where the center is
placed.

This filter causes rasterization in 3D groups.

Original image Disc Warp applied

Parameters in the Inspector
Center: Sets the position of the center of the disk.

Radius: Sets the size of the disk.

Crop: Sets whether the object is cropped at its original boundaries.

Mix: Sets the amount the original image to mix with the distorted image.

HUD Controls
The HUD contains the following control: Radius.

Displace
This filter uses an image to define a displacement region within the image, with parameters
to control the horizontal and vertical scale of displacement. You can use any image, movie,
or shape as the source image.

When this filter is initially applied, Displace behaves as if there were a black image applied
to the Map Image well, which does not displace the target.

To learn how to add an object to the Map Image well, see Source Well.
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This filter causes rasterization in 3D groups.

Original image Displace applied with a jellyfish as map image

Parameters in the Inspector
Map Image: An image well that displays a thumbnail of the map chosen.

Horizontal Scale: Sets the horizontal scaling of the object.

Vertical Scale: Sets the vertical scaling of the object.

Repeat Edges: Sets whether or not the edges of the object are repeated.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Map Image, Horizontal Scale, Vertical Scale, and
Repeat Edges.

Droplet
This filter simulates the effect of a drop of liquid falling onto the surface of a pool, with
your image displaced as the surface of the pool. This filter is not automatically animated,
but animating the Thickness parameter of this filter creates the effect of the ripples
spreading out from the center.

This filter causes rasterization in 3D groups.

Original image Droplet applied
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Parameters in the Inspector
Center: Sets the position of the center of the droplet effect.

Radius: Sets the radius of the droplet effect.

Height: Sets the height of the droplet ripples.

Thickness: Sets the width of the rippling waves from the droplet.

Crop: Sets whether the object is cropped at its original boundaries.

Mix: Sets the amount of the original image to mix with the distorted image.

HUD Controls
The HUD contains the following controls: Radius, Height, and Thickness.

Earthquake
Creates an animated displacement effect on an object, adjusting its position as if shaken
by an earthquake. This filter causes rasterization in 3D groups.

Original image Earthquake applied with three layers

Parameters in the Inspector
Twist: Sets the amount the object is rotated as it is displaced.

Horizontal Shake: Sets the maximum amount the image is displaced horizontally.

Vertical Shake: Sets the maximum amount the image is displaced vertically.

Layers: Sets the number of copies of the original object that are overlaid. Larger values
create a motion-blurred effect.

Epicenter: Sets the position of the center of the earthquake, around which the Twist
occurs.

Random Seed: Sets the value of the random seed used to determine which frames are
changed by the filter.

Mix: Sets which percentage of the original image is blended with the distorted image.
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HUD Controls
The HUD contains the following controls: Twist, Horizontal Shake, Vertical Shake, Layers,
and Random Seed.

Fisheye
Distorts an object as if it were seen through the view of a fisheye lens. The result is an
extremely wide-angle warping effect which is also known as barrel distortion.

You can try using the Fisheye filter with a negative Amount value as an imprecise way
to correct for certain types of barrel distortion in images that were shot using a wide-angle
lens.

This filter causes rasterization in 3D groups.

Original image Fisheye applied

Parameters in the Inspector
Radius: Sets the radius of the fisheye lens effect.

Amount: Sets the amount and nature of the distortion. Lower values create concave
distortion; higher values create convex distortion.

Center: Sets the position of the center of the fisheye effect.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Radius and Amount.
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Flop
Reverses an image horizontally, vertically, or in both directions. This filter causes
rasterization in 3D groups.

Original image Flop filter applied

Parameters in the Inspector
Flop: Sets the direction in which the object is flopped. Values can be selected from the
following: Horizontal, Vertical, or Both.

Mix: Sets what percentage of the original image is blended with the flopped image.

HUD Controls
The HUD contains the following control: Flop.

Fun House
Simulates the distortion caused by an imperfectly shaped mirror, similar to those in a
carnival fun house. This filter causes rasterization in 3D groups.

Original image Fun House applied

Parameters in the Inspector
Center: Sets the position of the center of the fun house mirror.

Width: Sets the width of the fun house mirror.

Amount: Sets the amount of distortion of the fun house mirror.
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Angle: Sets the angle at which the fun house mirror is set.

Mix: Sets which percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Width, Amount, and Angle.

Glass Block
This filter cuts an object into a series of tiles and offsets the portion of the image within
each tile to create a duplicated pattern effect. The number of tiles into which the image
is broken, and the amount that each portion of the image is offset, can be customized.

This filter causes rasterization in 3D groups.

Original image Glass Block applied

Parameters in the Inspector
Center: Sets the position of the origin of the glass block effect.

Scale: Sets the scale of the portions of the duplicated parts.

Angle: Sets the angle of offset used to sample the duplicated parts.

Tile Size: Sets the size of the glass blocks.

Mix: Sets which percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Scale, Angle, and Tile Size.

Glass Distortion
Simulates the effect of your object being deformed as it shows through a piece of glass.
An image well lets you assign an object to use as the pattern in the glass, using any image,
movie, or shape. Other parameters let you control the scale and amount of distortion.

When this filter is initially applied, Glass Distortion behaves as if there were a black image
applied to the Distort Input well, which will leave the target object unchanged.

To learn how to add an object to the Map Image well, see Source Well.
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This filter causes rasterization in 3D groups.

Original image Glass Distortion (diamond image) applied

Parameters in the Inspector
Distort Input: An image well that displays a thumbnail of the image map chosen.

Center: Sets the position of the center of the tiling of the glass distortion.

Fit: Sets the relative scale of the map image.

X Scale: Sets the horizontal scale of the map image.

Y Scale: Sets the vertical scale of the map image.

Amount: Sets the amount of offset.

Softness: Sets how much blur is applied to the map image.

Mix: Sets which percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Fit, X Scale, Y Scale, Amount, and Softness.

Insect Eye
Maps a repeating hexagonal distortion pattern to an image, mimicking the POV of an
insect. This filter causes rasterization in 3D groups.

Original image Insect Eye applied
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Parameters in the Inspector
Size: Sets the size of the hexagons, in pixels.

Refraction: Sets the amount of distortion present in each hex.

Border Size: Sets the width, in pixels, of the border of each hex.

Border Color: Picks the color of the border of the hexagons. Use the disclosure triangle
to display Red, Green, and Blue sliders, for more precise color selection.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Size, Refraction, Border Size, and Border Color.

Mirror
By default, this filter splits an image in half vertically, and reverses the remaining half to
create a reflection. The center point and angle of this split point can be customized. This
filter is excellent for recreating the magic of 1980s music videos.

This filter causes rasterization in 3D groups.

Original image Mirror filter applied

Parameters in the Inspector
Center: Sets the position of the center of the mirror.

Angle: Sets the angle of the mirror’s orientation.

Repeat Border: When the Center and/or Angle parameters are offset from the center,
selecting this checkbox sets the edge pixels to repeat to fill in the rest of the shape.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Center and Mix.
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Poke
This filter distorts an image by bowing the top, bottom, and sides inward, and appears
to push the object into the Canvas at the specified Center point. As the value of the
Amount parameter increases, the more the sides bow in. The Black Hole filter has a similar
effect but also removes part of the image at the center point.

This filter causes rasterization in 3D groups.

Original image Poke applied

Parameters in the Inspector
Center: Sets the position of the center of the poke.

Radius: Sets the radius of the poke effect.

Scale: Sets the scale of the distortion.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Radius, Scale, and Mix.

Polar
Converts images from rectangular coordinates to polar coordinates, and vice versa.

Original image Polar applied
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Tip: This filter works very well with objects containing horizontal or vertical lines, such
as the Stripes or Checkerboard generators. A similar effect can be created with any image
by adding the Line Screen or other related filters.

Parameters in the Inspector
Center: Sets the center point of the distortion from Polar to Rectangular or Rectangular
to Polar.

Polar to Rect: When this checkbox is selected, specifies that a Polar to Rectangular
distortion be applied to the image. When deselected, a Rectangular to Polar distortion is
applied.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following control: Polar to Rect.
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Refraction
Creates a glass-distortion effect on an image, with an optional height map. This filter
causes rasterization in 3D groups.

Original image Refraction applied with a height map

Parameters in the Inspector
Softness: Sets the amount of softness applied to the refracted edges.

Refraction: Sets the amount that the image is distorted.

Height Map: An image well that displays a thumbnail of the height map chosen. The
height map is used to determine the edges along which the image is refracted.

Map Channel: Sets the channel used to determine how the image is refracted. If a height
map is present, the channel is selected from the height map; otherwise the channel is
selected from the source object. Values can be selected from the following: Luminance
(default), Red, Green, Blue, or Alpha.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Softness, Refraction, Height Map, and Map
Channel.
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Ring Lens
This filter creates a ring of distortion over the image. The result can be a donut-like bulge
in the image. This filter causes rasterization in 3D groups.

Original image Ring Lens applied

Parameters in the Inspector
Center: Sets the position of the center of the lens.

Radius: Sets the radius of the ring.

Thickness: Sets the thickness of the ring as a percentage of the radius. Values range from
0 (no thickness) to 1.00 (no hole in the center of the ring lens).

Refraction: Sets the amount of refraction of the lens.

Crop: Sets whether the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Radius, Thickness, and Refraction.

Ring Warp (Obsolete After Motion 3.0.2)
The Ring Warp filter is not included in the latest Motion release. The filter will appear
when you load older projects (Motion 3.0.2 and earlier).

The effect is similar to that of the Ring Lens, but the image is distorted with multiple
concentric rings. The number of rings can be increased or decreased using the Radius
and Refraction parameters.
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This filter causes rasterization in 3D groups.

Original image Ring Warp applied

Parameters in the Inspector
Center: Sets the position of the center of the rings.

Radius: Sets the radius of the rings.

Refraction: Sets the amount of refraction.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Radius and Refraction.

Ripple
Creates animated ripples over the surface of an object. This filter is automatically animated
to create an undulating effect on the surface of the affected image. The amplitude can
be adjusted to increase or decrease the rippling effect.

This filter causes rasterization in 3D groups.

Original image Ripple applied

Parameters in the Inspector
Center: Sets the position of the origin of the effect.
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Amplitude: Sets the width of the waves.

Crop: Sets whether the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following control: Amplitude.

Scrape
Smears an image along an angle defined by the Rotation parameter. The Scrape effect
starts at the center point, and continues to the edge of the object.

This filter causes rasterization in 3D groups.

Original image Scrape applied

Parameters in the Inspector
Center: Sets the position of the center of the scrape.

Rotation: Sets the angle of rotation of the scrape.

Amount: Sets the ramping of the number of pixels spread across the range of the scrape.
Values range from 0 (very gradual) to 200 (hard edge).

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Rotation and Amount.

Sphere
Simulates the effect of an image being wrapped around a sphere. This filter can be used
to turn an image of a map into an imprecise globe.
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This filter causes rasterization in 3D groups.

Original image Sphere filter applied

Parameters in the Inspector
Center: Sets the position of the center of the sphere.

Radius: Sets the radius of the sphere.

Crop: Sets whether the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following control: Radius.

Starburst
Radiates solid-colored rays out from the center of your object. The colors are derived
from pixel values around the selected center point, with the number of colors used
determined by the Radius parameter.

This filter causes rasterization in 3D groups.

Original image Starburst applied

Parameters in the Inspector
Center: Sets the position of the center of the starburst.
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Radius: Sets the radius of pixel sampling for ray color determination.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following control: Radius.

Stripes
By default, this filter turns your object into a series of vertical stripes. The angle of
generated stripes can be changed using the Angle parameter. The stripe colors are derived
from pixel values along a line through the center point at the angle specified by the Angle
parameter. The distribution of colors is determined by the Offset parameter.

This filter causes rasterization in 3D groups.

Original image Stripes applied

Parameters in the Inspector
Center: Sets the position of the center of the stripe effect.

Angle: Sets the angle of the stripes.

Offset: Sets the angle of pixel sampling used for sampling pixel color values.

Mix: Sets what percentage of the original image is blended with the striped image.

HUD Controls
The HUD contains the following controls: Angle and Offset.

Target
The Target filter draws bands of concentric circles outward from the center point value.
The target colors are derived from pixel values around the selected center point, with
the distribution of colors determined by the Angle parameter.
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This filter causes rasterization in 3D groups.

Original image Target applied

Parameters in the Inspector
Center: Sets the position of the center of the target.

Angle: Sets the angle of the line used to select pixels for the bands of circles in the target.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following control: Angle.

Twirl
Twirls an image like a fork twisting a plate of spaghetti. The image appears to stretch
from the sides to the center around in a spiral. The amount of spiraling is determined by
the Twirl parameter.

This filter causes rasterization in 3D groups.

Original image Twirl filter applied

Parameters in the Inspector
Amount: Sets the radius of the twirl. Larger values affect more of the image. Values range
from 0 (none of the image is affected) to 1.00 (largest amount of the image is affected).
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Twirl: Sets the amount of twirl.

Center: Sets the position of the center of the twirl.

Crop: Sets whether the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the twirled image.

HUD Controls
The HUD contains the following controls: Amount and Twirl.

Underwater
Applies an animated distortion to your object, as if it is being viewed through water. This
filter causes rasterization in 3D groups.

Original image Underwater filter applied

Parameters in the Inspector
Size: Sets the size of the ripples in the water. The smaller the number, the more ripples
there are in the water simulation.

Speed: Sets the speed at which the distortion is animated.

Refraction: Sets the amount that the image is distorted.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Size, Speed, and Refraction.

Wave
Distorts the object to simulate waves oscillating across it. The wave filter is not
automatically animated, but you can animate the Offset parameter to animate the effect
of waves causing the image to undulate.
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This filter causes rasterization in 3D groups.

Original image Wave filter applied

Parameters in the Inspector
Amplitude: Sets the amplitude of the waves.

Wavelength: Sets the length of the waves.

Offset: Sets the offset of the wave.

Vertical: Sets whether the waves run vertically or horizontally.

Repeat Edges: Sets whether or not the edges of the object are repeated.

Mix: Sets what percentage of the original image is blended with the distorted image.

HUD Controls
The HUD contains the following controls: Amplitude, Wavelength, Offset, and Vertical.

Glow Filters
Glow filters combine blur with brightness and color effects. The results are automatically
recomposited over the original image in many different ways. Glows can be used to
simulate film effects, as a method to make your footage more abstract, or used more
subtly, as accents to make individual elements in a composition stand out.
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Aura
This is a highly stylized filter that adds light or dark halos around well-defined areas of
an image. The resulting glow appears solarized, and the underlying image creates outlines
that show through the glow effect.

Original image Aura applied

Parameters in the Inspector
Inner Radius: Sets the amount the aura extends inward from its point of origin.

Outer Radius: Sets the amount the aura extends outward from its point of origin.

Brightness: Sets the brightness of the aura.

Crop: Sets whether or not the aura is cropped at the original boundaries of the object.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Inner Radius, Outer Radius, and Brightness.
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Bloom
This filter simulates the effect of extremely overexposed highlights on film. Highlights
above a certain threshold are blurred, brightened, and recomposited with the original.
All unaffected regions of the image interact with the glow effect, but otherwise retain
their detail.

Original image Bloom applied

Parameters in the Inspector
Amount: Sets the amount of the bloom.

Brightness: Sets the brightness of the bloom.

Threshold: Sets the luminance threshold at which the bloom starts.

Horizontal: Sets the amount of horizontal bloom.

Vertical: Sets the distance of vertical bloom.

Crop: Sets whether or not the bloom is cropped at the original boundaries of the object.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Amount, Brightness, and Threshold.
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Dazzle
This filter adds glowing star-shaped accents to the highlights in an image. This filter can
be customized to create anything from subtle highlights to outrageous, colorful flashes
of color.

Original image Dazzle applied

Parameters in the Inspector
Amount: Sets the radius of the spikes from the glow of Dazzle.

Angle: Sets the angle of rotation of the spikes from Dazzle.

Brightness: Sets the amount of brightness of the glow of Dazzle.

Threshold: Sets the luminance threshold of the glow.

Spike Count: Sets the number of spikes coming off of the glows.

Crop: Sets whether or not the glowed object is cropped at its original borders.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Amount, Angle, Brightness, Threshold, and
Spike Count.
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Gloom
This filter creates a muted, dark glow. The image is darkened, and areas of fine detail are
evened out into larger regions of color. It’s spooky.

Original image Gloom applied

Parameters in the Inspector
Radius: Sets the radius of the gloom.

Amount: Sets the amount of gloom. Values range from 0 (no gloom) to 2 (maximum
gloominess).

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Radius and Amount.

Glow
The most basic glow filter in this category, which can be customized for a wide variety
of effects.

Parameters in the Inspector
Radius: Sets the radius of the glow.

Opacity: Sets the opacity of the glow.

Threshold: Sets the luminance threshold at which the glow begins.

Softness: Sets the amount of softness applied to the glow.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Radius, Opacity, Threshold, and Softness.

Light Rays
A glow filter that uses the zoom blur to distribute the resulting glow, instead of a gaussian
blur. The effect is that of light rays shining through an object from a specified point.
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This filter causes rasterization in 3D groups.

Original image Light Rays applied

Parameters in the Inspector
Amount: Sets the amount of the light ray effect. Larger values extend the length of the
rays.

Center: Sets the position of the center point of the light source.

Glow: Sets the brightness multiplier of the light rays.

Expansion: Sets the distance the light rays extend outside the boundary of the source
object.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Amount and Glow.

Outer Glow
Adds a glow to the alpha channel of an object. The result is a glow around the outside
of an object, while the object’s actual image is unaffected.

Original image Outer Glow filter applied
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Parameters in the Inspector
Radius: Sets the size of the glow.

Brightness: Sets the brightness of the glow.

Inner Color: Picks the inner color of the glow. Use the disclosure triangle to display Red,
Green, and Blue sliders for more precise color selection.

Outer Color: Picks the outer color of the glow.

Range: Sets the gradient position between the two glow colors.

Horizontal: Sets the amount of horizontal glow.

Vertical: Sets the amount of vertical glow.

Crop: Sets whether or not the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Radius, Brightness, Inner Color, Outer Color,
and Range.

Overdrive
Creates an animated glow effect by compositing numerous glowing tinted duplicates of
the original image. Fine detail is lost, and the highlights of the image are emphasized.
You can customize the inner glow and outer glow colors.

Original image Overdrive applied

Parameters in the Inspector
Intensity: Sets the number of samples.

Size: Sets the radius of the effect.

Rotation: Sets the angle of rotation of the collected offsets.

Inner Glow: Picks the color of the inner part of the glow. Use the disclosure triangle to
display Red, Green, and Blue sliders for more precise color selection.
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Outer Glow: Picks the color of the outer part of the glow. Use the disclosure triangle to
display Red, Green, and Blue sliders for more precise color selection.

Crop: Sets whether or not the object is cropped at its original boundaries.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Intensity, Size, Rotation, Inner Glow, and Outer
Glow.

Keying Filters
Keying filters are used to isolate a subject that is surrounded by an area of fairly uniform
color or brightness by generating an alpha channel based on the shape of that area.
Keying is most commonly performed on subjects that were shot against a blue- or
green-colored background, but keys can also be based on brightness values.

A common example of color keying is the meteorologist on TV. This person is always seen
standing in front of an animated map of the weather, but in reality he or she is standing
in front of a big green screen. As part of the broadcast, the green screen is keyed out,
and replaced by the map. You can do the same thing in Motion.

Important: Keying a foreground subject is not always easy, and it takes time and patience
to learn how to use the parameters in each filter to achieve the best effect. Even so, most
keys are pulled using more than one tool to do the job. Good compositing artists usually
combine one or more masked keying filters, Matte Choker filters, a Spill Suppressor filter,
and one or more garbage and holdout masks to isolate a single subject. For more
information on techniques you can use to improve a key, see Performing Multiple Keys
on a Single Subject.

Blue Green Screen
The Blue Green Screen filter is intended for subjects that were shot in front of a blue
screen or green screen. This filter renders the blue or green areas of the image transparent,
allowing one or more background images to show through.

Parameters in the Inspector
Key: Selects one of three keying modes: Blue, Green, or Blue Green Difference.

Color Level: Sets the percentage of color purity being keyed.

Tolerance: Sets the color tolerance for your key. Larger values allow a greater difference
between the set key color and other color values that are incorporated into the key.

Edge Thin: Sets the amount of thinning done at the edges of the matte. A positive value
erodes the matte edge.

Invert Matte: Sets whether or not the matte is inverted.
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Mix: Sets what percentage of the original image is blended with the keyed image.

HUD Controls
The HUD contains the following controls: Key, Color Level, Tolerance, Edge Thin, and
Invert Matte.

Color Key
This filter can pull a key based on any color you select. Bear in mind that if the color is
too close to that of the subject you’re trying to isolate, parts of your foreground subject
may disappear as well. The resulting effect renders the selected color transparent, allowing
a background image to show through.

Original image Color Key filter rendering gray transparent

Parameters in the Inspector
Color: Picks the color for your key. Use the disclosure triangle to display Red, Green, and
Blue sliders for more precise color selection.

Tolerance: Sets the color tolerance for your key.

Invert Matte: Sets whether or not the alpha channel of your color key is inverted.

Mix: Sets what percentage of the original image is blended with the keyed image.

HUD Controls
The HUD contains the following controls: Color, Tolerance, and Invert Matte.
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Luma Key
Luma Key pulls a key from your object based on a selected brightness level. This can be
effective if you’re keying a subject that was shot against a solid white or black background,
and exposed so that there are no absolute highlights or shadows within the foreground
subject. Despite this, shadows and highlights in the image usually make this a difficult
filter with which to pull a perfect key.

Original image Luma Key filter (set to Darker) applied

Parameters in the Inspector
Key Mode: Sets the mode used to calculate the luminance value of your object. The
modes can be selected from the following: Key Out Brighter, Key Out Darker, Key Out
Similar, or Key Out Dissimilar.

Luminance: Sets the type of luminance that is keyed. The types can be selected from
the following: NTSC, PAL, Film, Red, Green, or Blue.

Threshold: Sets the threshold of the key.

Tolerance: Sets the tolerance of the threshold. Larger values allow a greater difference
between the set key color and other color values that are incorporated into the key.

Mix: Sets what percentage of the original image is blended with the keyed image.

HUD Controls
The HUD contains the following controls: Key Mode, Luminance, Threshold, and Tolerance.
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Primatte RT
The Primatte RT filter is a high-quality keying filter, which renders the blue or green areas
of the image transparent, allowing one or more background images to show through.

Original image Primatte RT filter (Backing Color set
to Green), so background cheetah
shows through

Parameters in the Inspector
Output Type: Sets the output type of the keyer. Select values from the following:
Foreground, Background, Processed Foreground, and Matte.

Backing Color: Pick the backing color for the matte. Use the disclosure triangle to display
Red, Green, Blue, and Opacity sliders for more precise color selection. In addition, clicking
the color well opens the Colors window, which allows you to use the color controls to
select a color from the object.

Auto Sample: Automatically samples the dominant color type in the image to be used
for the key. Select Red, Green, or Blue.

Replacement Color: Picks the color to be used to fill in pixels in spill and transition areas.
The intelligent edge smoothing of the Primatte RT filter can take pixel color values from
the background to substitute in spill and transition areas. Use the disclosure triangle to
display Red, Green, Blue, and Opacity sliders for more precise color selection.

Noise Removal: Sets the threshold for noise removal.

Matte Density: Sets the density of the matte. This value cannot be set to a value lower
than Noise Removal.

Spill Suppression: Sets the amount of spill suppression applied to the matte. This value
cannot be set to a value lower than Noise Removal.

Mix: Sets what percentage of the original image is blended with the keyed image.

HUD Controls
The HUD contains the following controls: Output Type, Backing Color, Auto Sample,
Replacement Color, Noise Removal, Matte Density, and Spill Suppression.
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An Example Using Primatte RT
Getting the Primatte RT basics down is easy. Here’s an example.

To create a simple composite using Primatte RT
1 Import a background image into your project.

2 Import the foreground image for which a matte needs to be generated.

3 Select the foreground object, and turn off the background to directly observe the filter’s
effects.

4 Apply the Primatte RT filter to the object.
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The Primatte RT filter makes a guess as to the non-subject color you are trying to remove.
It makes a guess based on the dominant color present in the image, which may or may
not be the color of the background. For example, if the image is a large red object that
obscures most of a green screen, Primatte RT selects Red as its base sample. In this case,
however, Primatte RT correctly guesses that you’re trying to key out the blue color. If
Primatte RT’s guess is incorrect, use the Auto Sample buttons to choose a different color.

Tweaking the Noise Removal parameter can help for blue or green screens that have
some variance in their color value. Additionally, the darker areas of your object can fool
the keyer’s defaults, so in order to get a clean matte you may have to adjust Matte Density
so the background doesn’t show through these dark areas. Lastly, Spill Suppression can
be used to reduce blue screen reflections or interactions with the foreground object.

5 Turn on the background layer.

Spill Suppressor
Whenever you key an image that was shot against a blue or green screen, there’s a good
chance that some color reflected off of the screen and illuminated the edge of the
foreground subject. This fringing around the edge of the subject is called spill, and is
usually difficult to eliminate because it’s actually part of the subject you’re trying to
preserve. The Spill Suppressor filter deals with this by tinting the keyed color in order to
turn it into a neutral tone.

Note: The Spill Suppressor may inadvertently tint other areas of the foreground subject
in addition to the colored fringe, so adjust its settings with care.

Parameters in the Inspector
Spill Type: Sets the type of spill to be suppressed. Select Blue or Green.

Amount: Sets the amount of spill to be suppressed.

Mix: Sets what percentage of the original image is blended with the spill-suppressed
image.

HUD Controls
The HUD contains the following controls: Spill Type and Amount.
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Matte Filters
Matte filters are used to modify mattes.

Matte Choker
This filter increases or decreases the semi-transparent area of an object’s alpha channel
by performing a gamma correction (similar to the Gamma color correction filter) to all
regions of the alpha channel falling between solid black and solid white. This allows you
to widen or narrow the semi-transparent areas within an object, while leaving all
100-percent solid and transparent areas unaffected.

Parameters in the Inspector
Edge Thin: Higher positive edge thin values eat into the alpha channel, eliminating
fringing around the edges of translucent areas. Negative values fill in translucent areas,
filling in holes and widening the matte into regions of fringing.

Feather: Lower values reduce the amount of translucency in a matte, but this results in
harder edges around holes and edges in the alpha channel.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Edge Thin and Feather.

Matte Magic
This filter shrinks and softens the edges of a matte.

Original image with rectangular matte Matte Magic filter applied

Parameters in the Inspector
Shrink: Shrinks the edges of the matte with a soft edge to eat into the alpha channel, to
reduce fringing.

Feather: Feathers the edges of the matte.

Mix: Sets what percentage of the original image is blended with the filtered image.

Note: The Matte Magic filter has no effect on images with a solid alpha channel.

1027Chapter 16 Using Filters



HUD Controls
The HUD contains the following controls: Shrink and Feather.

Sharpen Filters
These filters sharpen images by creating a high contrast overlay that emphasizes edges
within the image.

Sharpen
Sharpens an image by enhancing the color contrast around edges within the image.

Original image Sharpen filter applied

Parameters in the Inspector
Intensity: Sets the intensity of the sharpening.

Amount: Sets the amount of the sharpening.

Mix: Sets what percentage of the original image is blended with the sharpened image.

HUD Controls
The HUD contains the following controls: Intensity and Amount.
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Unsharp Mask
Similar to Sharpen, this filter provides many more options to refine and control the amount
of sharpening applied to the image. This filter causes rasterization in 3D groups.

Original image Unsharp Mask filter applied

Parameters in the Inspector
Radius: Sets the amount of the mask’s effect.

Amount: Sets the amount of the multiplier used to sharpen the object’s edges.

Threshold: Sets the threshold of luminance difference to be considered as a high contrast
range, between 0 and 1.

Horizontal: Sets the horizontal width of the unsharp mask.

Vertical: Sets the vertical scale of the unsharp mask.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Radius, Amount, and Threshold.

Stylize Filters
Unlike distortion filters, which warp and deform an image, filters in the stylize subcategory
make an image appear as if it was created with a different medium.
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Add Noise
This filter adds an overlay noise of the selected type to an image. This filter causes
rasterization in 3D groups.

Original image Add Noise filter applied

Parameters in the Inspector
Amount: Sets the amount of noise added to the image.

Type: Sets the type of noise added to the image. Values can be selected from White
Noise (Uniform), Pink Noise (TV Static), and Gaussian Noise (Film Grain).

Monochrome: Sets whether the added noise is monochrome or color.

Blend Mode: Sets the blend mode used to add noise to the image.

Autoanimate: Sets whether the noise is animated automatically.

Random Seed: Sets the seed used to generate the position of the noise. This parameter
is only available if Autoanimate is deselected.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Amount, Type, Monochrome, Blend Mode,
Autoanimate, and Random Seed.

Bad Film
This filter simulates old or damaged film and/or playback equipment.
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This filter causes rasterization in 3D groups.

Parameters in the Inspector
Focus Amount: Sets the amount of blur applied to the image, simulating a projector lens
going in and out of focus.

Focus Variance: Varies the amount defined in the Focus Amount parameter. For example,
if Focus Amount is set to 3 and Focus Variance set to 1, the Focus Amount varies between
2 and 4.

Brightness Amount: Simulates underexposed footage or an inconsistent projector bulb
by lightening and darkening the image.

Brightness Variance: Varies the amount defined in the Brightness Amount parameter.
For example, if Brightness Amount is set to 2.5 and Brightness Variance set to 2, the
Brightness Amount varies between .5 and 4.5.

Saturate Amount: Adjusting this parameter simulates a variety of aged film stocks. Values
below 0 lower the saturation, creating a faded film appearance. A value of –100 removes
all saturation to simulate black-and-white film. Values above 0 simulates oversaturation.

Saturate Variance: Varies the amount defined in the Saturate Amount parameter. For
example, if Saturate Amount is set to –20 and Saturate Variance set to 10, the Saturate
Amount varies between –30 and –10.

Scratches: Simulates scratches on film. The higher the value, the more scratches.

Hairs: Simulates hairs on film. The higher the value, the more hairs.

Dust: Simulates dust or dirt on film. The higher the value, the more dirt.

Tip: Hair, dust, and scratches occur with some random variance and may not appear on
every frame. If you don’t see any effect from adjusting these sliders, play the clip and
observe the effect over the duration of the shot.

Jitter Amount: Simulates the look of a film projector which has a problem with its gate.
Increasing the amount of jitter increases the appearance of horizontal shake in the film.

Jitter Variance: Varies the amount defined in the Jitter Amount parameter. For example,
if Jitter Amount is set to .25 and Jitter Variance set to .05, the Jitter Amount varies between
.2 and .3.
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Grain: Sets the amount of grain, allowing you to simulate different types of film stock.

Frequency of Change: Defines how often (in frames), the values set in the parameters
with variance are recalculated. For example, if Frequency of Change is set to 30, and Jitter
Amount and Jitter Frequency are set to values greater than 0, the jitter parameters are
recalculated every 30 frames, creating additional randomness.

Random Seed: A slider that lets you pick a new random seed number. This number is
used to randomly generate new sequences of values, based on the other parameters of
this behavior.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Focus Amount, Focus Variance, Brightness
Amount, Brightness Variance, Saturate Amount, Saturate Variance, Scratches, Hairs, Dust,
Jitter Amount, Jitter Variance, Grain, Frequency of Change, and Random Seed.

Bad TV
This filter simulates poor analog television reception, adding attributes like exaggerated
video field scan lines, static and roll. This filter causes rasterization in 3D groups.

Original image Bad TV applied

Parameters in the Inspector
Waviness: Sets the amount of horizontal offset applied to the video fields.

Roll: Sets the amount of vertical offset applied to the image. The entire image is displayed,
but the image is split along the roll line, with the otherwise missing part of the footage
shown joined along the roll line.

Static: Sets the amount of static added to the image.

Color Synch: Sets the amount of horizontal RGB channel offset applied to the image.

Saturate: Sets the amount of color saturation applied to the image. Negative values
reduce saturation, positive values add saturation.

Scan Line Brightness: Sets the brightness of the video field scan lines added to the image.
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Scan Line Thickness: Sets the thickness of the video field scan lines added to the image.

Scan Line Distance: Sets the distance between each of the video field scan lines added
to the image.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Waviness, Roll, Static, Color Synch, Saturate,
Scan Line Brightness, Scan Line Thickness, and Scan Line Distance.

Circle Screen
This filter reduces an image to a high-contrast grayscale version of itself. It then screens
it using a pattern of concentric circles, simulating a sort of etched screening technique.
The image is represented by varying thicknesses in the circular pattern.

This filter causes rasterization in 3D groups.

Original image Circle Screen applied

Parameters in the Inspector
Center: Sets the position of the center of the circle screen.

Scale: Sets the scale of the circle screen.

Contrast: Sets the contrast level.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Scale and Contrast.

Circles
This filter adds elliptical facets to an image, giving it a mosaic-like appearance. Each facet
takes a color sample from the center of itself. Unlike some of the other mosaic filters, the
edges of the facets do not join, so part of the untouched image is displayed between the
facets.
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This filter causes rasterization in 3D groups.

Original image Circles applied

Parameters in the Inspector
Size: Sets the size of the facets.

Falloff: Sets the amount of alpha blending done at the edges of the each facet.

Invert: Sets whether the facets are elliptical or tiles with elliptical cut-outs.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Size, Falloff, and Invert.

Color Emboss
This filter traces high-contrast edges in the image with darker versions of the color already
in the image. This gives the object the appearance of being stamped into the Canvas,
while retaining the colors of the original image. The Direction and amount of Relief can
be customized.

Original image Color Emboss applied

Parameters in the Inspector
Direction: Sets the angle of direction of the offset emboss.
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Relief: Sets the amount of the offset.

Crop: Sets whether or not the image is cropped beyond its original borders.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Direction, Relief, and Crop.

Crystallize
This mosaic filter simulates the effect of viewing an image through a pane of glass with
irregular facets patterned into it. These facets give an image a crystallized appearance.
This filter is automatically animated, and the facets appear to shift and turn according to
the value in the Speed parameter. To prevent the facets from moving, set the Speed to
zero.

This filter causes rasterization in 3D groups.

Original image Crystallize applied

Parameters in the Inspector
Size: Sets the size of the facets.

Speed: Sets the speed of the animation of the facets.

Smooth: Sets whether facet colors are based on average values in the area they are
replacing, or single samples taken from the center of the facet.

Feathering: Sets the amount of feathering that is applied to the edges of the facets.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Size, Speed, Smooth, and Feathering.
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Edge Work
This filter reduces an image to a high-contrast, grayscale version of itself. The detail in
this grayscale image can then be reduced and smoothed using various parameters to
create an image that resembles something hand-drawn. Depending on the amount of
smoothing you apply, many different effects are possible with this filter.

This filter causes rasterization in 3D groups.

Original image Edge Work applied

Parameters in the Inspector
Radius: Sets the radius of transition between light and dark areas.

Blur: Sets the amount the image should be blurred before edge detection.

Amount: Sets the amount of contrast between light and dark areas.

Smoothness: Sets the smoothness of the edge lining.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Radius, Blur, Amount, and Smoothness.

Edges
An edge detection filter that examines the luminance of an image to derive the high
contrast borders between different regions of brightness. These edges are then traced,
and all other detail is replaced by black. The amount of eliminated detail depends on the
value of the Intensity parameter. The colors of the resulting highlights are intensified
variants of the colors from the original image.
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This filter causes rasterization in 3D groups.

Original image Edges applied

Parameters in the Inspector
Intensity: Sets the intensity of the edges.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Intensity and Mix.

Extrude
Gives an object simulated depth, by creating a “front” and “back” side, then offsets them
and extrudes the edges so they connect.

Note: Because this filter only simulates depth, an object with the Extrude filter applied
does not interact with 3D aspects of Motion.

This filter causes rasterization in 3D groups.

Original image Extrude applied

Parameters in the Inspector
Angle: Sets the angle at which the object is extruded.

Distance: Sets the distance the object is extruded.

1037Chapter 16 Using Filters



Clipping: Sets the distance at which the extrusion is clipped.

Back Size: Sets the size of the back object, as a proportion of its original size.

Face Brightness: Sets a brightness level applied to the face of the object.

Front Brightness: Sets a brightness level applied to the front of the object.

Back Brightness: Sets a brightness level applied to the back of the object.

Extrude Style: Selects the method used to extrude the sides of the object. Shading or
Gradient can be selected. With Shading selected, the color values of the pixels at the
edges of the object are used along the extrusion. With Gradient selected, a gradient preset
or custom gradient can be used.

Gradient: Selects a gradient preset to be applied to the object. Can also be used to edit
a custom gradient. The gradient is applied only if the Extrude Style is set to Gradient.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Angle, Distance, Clipping, Back Size, Face
Brightness, Front Brightness, Back Brightness, Extrude Style, and Gradient.

Halftone
This filter reduces an image to a black and white version of itself, simulating the halftone
screening method for print, in which the shadows and highlights of an image are recreated
using patterns of small and large dots.

This filter causes rasterization in 3D groups.

Original image Halftone applied

Parameters in the Inspector
Center: Sets the position of the center of the halftone dots.

Angle: Sets the angle of the alignment of the dots.

Scale: Sets the scale of the halftone dots.

Contrast: Sets the amount of contrast between the lightest and darkest dots.
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Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Angle, Scale, and Contrast.

Hatched Screen
This filter reduces an image to a black and white version of itself, simulating a halftone
pen-and-ink method of shading an image, in which the shadows and highlights of an
image are recreated using hatched patterns of lines.

This filter causes rasterization in 3D groups.

Original image Hatched Screen applied

Parameters in the Inspector
Center: Sets the position of the center of the hatched screen.

Angle: Sets the angle of the hatched screen.

Scale: Sets the scale of the hatched screen.

Skew: Sets the amount of skew of the hatched screen.

Stretch: Sets the amount of stretch of the hatched screen.

Contrast: Sets the relative amount of contrast between light and dark areas.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Angle, Scale, Skew, Stretch, and Contrast.
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Highpass
This filter emphasizes areas of detail in an image, and stylizes the colors in the resulting
image to create a psychedelic display. This filter causes rasterization in 3D groups.

Original image Highpass applied

Parameters in the Inspector
Radius: Sets the amount of variance of detail to consider. Values range from 0 (entire
range of color) to 100 (only the most detailed portions).

Amount: Sets the amount of emphasis.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Radius and Amount.

Indent
Creates a shiny, bump-mapped appearance on an image, giving the appearance of
“depressed” and “flat” areas. This filter causes rasterization in 3D groups.

Original image Indent applied

Parameters in the Inspector
Softness: Sets the softness of the transition between the flat and raised areas.
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Brightness: Sets the level of brightness of the object.

Ambient: Sets the amount of ambient light hitting the object.

Highlight Brightness: Sets the amount of brightness applied to the highlights of the
object.

Highlight Sharpness: Sets the degree of sharpness applied to the highlights of the object.

Light Rotation: Sets the angle, in degrees, at which the ambient light hits the object.

Depth: Sets the amount of depth between the flat and raised areas.

Height Map: An image well that displays a thumbnail of the height map chosen. If present,
the height map is used to determine the flat and raised areas of the object.

Map Channel: Sets the channel from the object that is used to determine the flat and
raised areas of the image. If a height map is present, the channel is selected from the
height map. Otherwise, values can be selected from the following: Luminance (default),
Red, Green, Blue, or Alpha.

Stretch To Fit: Sets whether the Height Map is stretched to fit the dimensions of the
filtered object. By default, this checkbox is selected. If it is deselected, the following four
parameters are available to edit:

• Height Map X Scale: Sets the scaling used to determine the width of the Height Map.

• Height Map Y Scale: Sets the scaling used to determine the height of the Height Map.

• Height Map X Offset: Sets the amount of offset used to position the Height Map
horizontally.

• Height Map Y Offset: Sets the amount of offset used to position the Height Map vertically.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Softness, Brightness, Ambient, Highlight
Brightness, Highlight Sharpness, Light Rotation, Depth, Height Map, Map Channel, and
Stretch To Fit.

Line Art
Performs an edge detection of the high-contrast borders between regions of differing
brightness in an object, tracing the edges and reducing all other detail in the image to
the color specified by the Paper Color parameter. The color of the resulting outline can
also be customized. The result is to simulate the look of a line drawing on paper.
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This filter causes rasterization in 3D groups.

Original image Line Art applied

Parameters in the Inspector
Threshold: Sets the threshold of edge detection.

Smoothness: Sets the level of smoothness of transition between the lines and the
background.

Paper Color: Sets the color of the paper. The color controls can be expanded with the
disclosure triangle to reveal Red, Green, and Blue sliders to more precisely select the color.

Paper Opacity: Sets the opacity of the paper.

Ink Color: Sets the color of the ink used in the line drawing.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Threshold, Smoothness, Paper Color, Paper
Opacity, and Ink Color.

Line Screen
This filter reduces an image to a high-contrast grayscale version of itself. It then screens
the image using a pattern of straight lines, simulating a sort of etched screening technique.
The image is represented by varying thicknesses in the pattern of the parallel lines.
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This filter causes rasterization in 3D groups.

Original image Line Screen applied

Parameters in the Inspector
Center: Sets the position of the center of the line screen.

Angle: Sets the angle of the line screen.

Scale: Sets the scale of the line screen.

Skew: Sets the amount of skew of the line screen.

Stretch: Sets the amount that the line screen is stretched.

Contrast: Sets the relative amount of contrast between light and dark areas.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Angle, Scale, Skew, Stretch, and Contrast.

MinMax
This filter softly patterns an image by choosing a maximum or minimum color value for
pixels within the specified radius. The result erodes or dilates the light or dark areas of
your object into soft, blocky regions.
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This filter causes rasterization in 3D groups.

Original image MinMax dilating dark areas

Parameters in the Inspector
Mode: Sets the mode of the effect. The following modes are available: Minimum and
Maximum.

Radius: Sets the radius of the effect.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Mode and Radius.

Noise Dissolve
Dissolves an object by adding a pattern of noise to it. Raising the value of the Dissolve
Amount parameter gradually eats away at more and more of the image. The alpha channel
is set to zero within the noisy areas, so background images are revealed as the Dissolve
Amount increases.

Original image Noise Dissolve at 50%

Parameters in the Inspector
Dissolve Amount: Sets the percentage of pixels dissolved by noise.

Random Seed: Sets a number to be used as a seed for noise placement.
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Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Dissolve Amount and Random Seed.

Pixellate
This filter turns an image into a mosaic of blocks using colors taken from an object. The
scale of the blocks can be increased or decreased.

This filter causes rasterization in 3D groups.

Original image Pixellate applied

Parameters in the Inspector
Center: Sets the position of the center of the pixellation effect.

Scale: Sets the scale of the pixellation.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following control: Scale.
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Posterize
This filter reduces the number of colors in your object to a set number per color channel,
adjustable using the Levels parameter.

Original image Posterize applied

Parameters in the Inspector
Levels: Sets the number of levels of posterization.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following control: Levels.

Relief
Uses the color values of an object or height map to calculate height vertices, creating
the appearance of a 3D height map.

Note: As this filter simulates depth, an object with the Relief filter applied does not interact
with 3D aspects of Motion.

This filter causes rasterization in 3D groups.

Original image Relief applied
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Parameters in the Inspector
Front: Sets the position of the center point of the front of the height map, determining
the direction to which the height vertices are projected. Values are coordinates.

Front Size: Sets the size of the front object, as a proportion of its original size.

Back: Sets the position of the center point of the back of the height map, determining
the direction from which the height vertices are projected. Values are coordinates.

Back Size: Sets the size of the back object, as a proportion of its original size.

Fuzziness: Sets the amount of fuzziness applied to the height vertices. The higher the
Fuzziness value, the softer the edges of the height vertices.

Height Map: An image well that displays a thumbnail of the height map chosen. If present,
the height map is used to calculate the height vertices.

Map Channel: Sets the channel used to calculate the height vertices. If a height map is
present, the channel is selected from the height map, otherwise the channel is selected
from the source object. Values can be selected from the following: Luminance (default),
Red, Green, Blue, or Alpha.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Front Size, Back Size, Fuzziness, Height Map,
and Map Channel.

Slit Scan
Create an animated fly-through effect by simulating the slit scan process used to create
“stargate” images in science fiction films.

This filter causes rasterization in 3D groups.

Original image Slit Scan applied

Parameters in the Inspector
Center: Sets the position of the center of the slit.

Rotation: Sets the angle of rotation of the slit.
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Speed: Sets the speed of the simulation.

Perspective: Sets the angle of perspective on the object.

Glow: Sets the amount of the glow on the slit.

Glow Color: Picks the color of the glow of the slit. Use the disclosure triangle to display
Red, Green, and Blue sliders for more precise color selection.

Offset: Sets the amount of offset between what is above and what is below the slit.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Rotation, Speed, Perspective, Glow, Glow Color,
and Offset.

Slit Tunnel
Simulates a circular version of the slit scan process used to create “warp tunnel” images
in science fiction films. This filter is automatically animated to create a fly-through effect.

This filter causes rasterization in 3D groups.

Original image Slit Tunnel filter applied

Parameters in the Inspector
Center: Sets the position of the center of the tunnel.

Rotation: Sets the angle of rotation of the object during movement.

Speed: Sets the speed of the simulation.

Perspective: Sets the angle of perspective on the object.

Glow: Sets the amount of the glow at the end of the tunnel.

Glow Color: Picks the color of the glow at the end of the tunnel. Use the disclosure
triangle to display Red, Green, and Blue sliders for more precise color selection.

Mix: Sets what percentage of the original image is blended with the filtered image.
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HUD Controls
The HUD contains the following controls: Rotation, Speed, Perspective, Glow, and Glow
Color.

Texture Screen
This filter uses a source object specified by the Map Image parameter to screen the target.
The source object used can be any image, movie, or shape you want.

By default, Texture Screen behaves as if there were a black image applied to the Map
Image well, which makes the target appear desaturated and washed out.

To learn how to add an object to the Map Image well, see Source Well.

This filter causes rasterization in 3D groups.

Original image Texture Screen filter applied, circle image

Parameters in the Inspector
Map Image: An image well that displays a thumbnail of the map chosen to generate the
screen.

Center: Sets the position of the center of the texture screen.

Angle: Sets the angle at which the texture screen is placed.

Skew: Sets the amount of skew applied to the map image.

Stretch: Sets the amount of stretch applied to the map image.

Scale: Sets the scale applied to the map image.

Contrast: Sets the amount of contrast applied to the image by the screen.

Threshold: Sets the threshold of brightness of the background image used to determine
the brightness of the luminance map.

Noise Contrast: Sets the amount of contrast added to the noise.

Noisiness: Sets the amount of noise.

Mix: Sets what percentage of the original image is blended with the filtered image.
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HUD Controls
The HUD contains the following controls: Map Image, Angle, Skew, Stretch, Scale, Contrast,
Threshold, Noise Contrast, and Noisiness.

Vectorize Color
Makes the object appear as multicolored polygons. Four colors are substituted over the
entire color range of the object.

Original image Default colors set in Vectorize Color

Parameters in the Inspector
Resolution: Sets the resolution of the polygons. The smaller the value, the smaller the
size of polygons in the resulting image.

Smoothness: Sets the smoothness of transition between the colors that you select. Values
range from 0 to 1.

Curvaceousness: Sets the spikiness of the polygons generated by the filter. The larger
the number, the more rounded each polygon.

First Color: Picks the first color that is substituted. The color controls can be expanded
with the disclosure triangle to display Red, Green, and Blue sliders for more precise color
selection.

Second Color: Picks the second color that is substituted.

Third Color: Picks the third color that is substituted.

Fourth Color: Picks the fourth color that is substituted.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Resolution, Smoothness, Curvaceousness, First
Color, Second Color, Third Color, and Fourth Color.

Vignette
Simulates the light fall-off and blurring that can be seen in the corners of images as seen
through some camera lenses.
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This filter causes rasterization in 3D groups.

Original image Vignette applied

Parameters in the Inspector
Size: Sets the size of the vignette. The larger the size, the more of the object is affected
by the vignette.

Falloff: Sets the amount of feathering applied to the border of the vignette. The higher
the falloff, the softer the edge of the vignette.

Blur Amount: Sets the amount of blur applied to the part of the image affected by the
vignette.

Darken: Sets the amount the affected part of image is darkened by the vignette.

Saturation: Sets the amount of color saturation applied to the parts of the image affected
by the vignette.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Size, Falloff, Blur Amount, Darken, and Saturation.

Wavy Screen
This filter reduces an image to a high-contrast grayscale version of itself. It then screens
the resulting image using a pattern of angled lines, simulating a sort of etched screening
technique. The image is represented by varying thicknesses in the pattern of the
zigzagging lines.
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This filter causes rasterization in 3D groups.

Original image Wavy Screen applied

Parameters in the Inspector
Amplitude: Sets the amplitude of the waves.

Wavelength: Sets the wavelength.

Scale: Sets the scale of the waves.

Contrast: Sets the contrast of the screen.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Amplitude, Wavelength, Scale, and Contrast.

Tiling Filters
Tiling filters can be used to create a wide variety of geometric patterns from the simple
to the complex. Tiles can be created using many different shapes and can be arranged
into many new and exciting mosaics.

Kaleidoscope
This filter simulates the effect of looking at an image through a kaleidoscope. It is not
automatically animated, but by animating the Offset Angle parameter you can simulate
the effect of twisting the kaleidoscope’s knob to rotate the image pattern.
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This filter causes rasterization in 3D groups.

Original image Kaleidoscope applied

Parameters in the Inspector
Center: Sets the position of the center of the kaleidoscope.

Segment Angle: Sets the angle at the tip of each triangular tile.

Offset Angle: Sets the rotation of the whole kaleidoscope. Values range from 0 to 360.

Partial Segments: This checkbox sets whether partial segments are used to complete
the radius of the kaleidoscope. When Partial Segments is deselected, segments may be
distorted in order to map them across the radius of the kaleidoscope with facets of equal
size.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Segment Angle and Offset Angle.

Kaleidotile
Simulates looking through a kaleidoscope with rectangular facets. It is not automatically
animated, but by animating the Angle parameter you can simulate the effect of twisting
the kaleidoscope to rotate the image pattern.

1053Chapter 16 Using Filters



This filter causes rasterization in 3D groups.

Original image Kaleidotile applied

Parameters in the Inspector
Center: Sets the origin of the kaleidotile effect.

Width: Sets the width of the panels of the kaleidotile effect.

Height: Sets the height of each of the panels.

Angle: Sets the angle of rotation of the panels.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Width, Height, and Angle.

Offset
Treats an object as a tile, offsetting its horizontal and vertical origins but displaying the
entire object nevertheless. This filter causes rasterization in 3D groups.

Original image Offset applied, mix at 50%

Parameters in the Inspector
Horizontal Offset: Sets the horizontal offset of the object.

Vertical Offset: Sets the vertical offset of the object.
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Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Horizontal Offset and Vertical Offset.

Parallelogram Tile
Simulates looking through a kaleidoscope with facets made of parallelograms. It is not
automatically animated, but by animating the Angle parameter you can simulate the
effect of twisting the kaleidoscope to rotate the image pattern.

This filter causes rasterization in 3D groups.

Original image Parallelogram Tile applied

Parameters in the Inspector
Center: Sets the position of the origin of the parallelogram tiles.

Angle: Sets the angle of rotation of the panels.

Acute Angle: Sets the acute angle at which the parallelogram sides meet.

Tile Size: Sets the size of the panels.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Angle, Acute Angle, and Tile Size.

Perspective Tile
Endlessly tiles an image, mapping it onto a grid that can be positioned in simulated 3D
space. Can create an endlessly repeating video wall stretching off into the distance.
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This filter causes rasterization in 3D groups.

Original image Perspective Tile applied

Parameters in the Inspector
Top Left: Sets the position of the top-left corner of the grid.

Top Right: Sets the position of the top-right corner of the grid.

Bottom Right: Sets the position of the bottom-right corner of the grid.

Bottom Left: Sets the position of the bottom-left corner of the grid.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
None.

Random Tile
Tiles your object in an irregular pattern with circular panels. This filter causes rasterization
in 3D groups.

Original image Random Tile applied

Parameters in the Inspector
Center: Sets the center point on the object from which the tiles are generated. Values
are coordinates.
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Radius: Sets the radius of each tile.

Feathering: Sets the amount of feathering applied to the edges of each tile.

Seed: Sets a number to be used as a seed for tile placement and stacking.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Radius, Feathering, and Seed.

Tile
This filter tiles an image. The number of duplicates of the image that appear depends on
the value of the Scale parameter.

This filter causes rasterization in 3D groups.

Original image Tile applied

Parameters in the Inspector
Center: Sets the position of the origin of the tiles.

Skew: Sets the amount of skew applied to the tiles.

Scale: Sets how much the tiles are scaled.

Stretch: Sets the amount tiles are stretched vertically.

Angle: Sets the angle of rotation of the tiles.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Skew, Scale, Stretch, and Angle.

Triangle Tile
Tiles your object with triangular shaped panels. The effect is similar to one of the
kaleidoscope filters. It is not automatically animated, but by animating the Angle parameter
you can simulate the effect of twisting the kaleidoscope to rotate the image pattern.
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This filter causes rasterization in 3D groups.

Original image Triangle Tile applied

Parameters in the Inspector
Center: Sets the origin of the tile.

Angle: Sets the angle of rotation of the triangles.

Tile Size: Sets the size of the triangles.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Angle and Tile Size.

Time Filters
Where other filters manipulate objects in two or three dimensions, Time filters manipulate
objects in the fourth dimension—time. These filters are most often used with moving
footage.

Echo
Echoes an object’s motion by repeating frames. The result is that moving areas of an
image leave a streaking trail behind as they move.

This filter causes rasterization in 3D groups.

Parameters in the Inspector
Delay: Sets the amount of delay between echoes. Values range from 0 to 1. A value of 0
is a zero frame echo, and a value of 1 represents a 60-frame echo.

Number: Sets the number of echoes.

Decay: Sets the amount of time it takes for an echo to decay.

Amount: Sets the relative opacity of each echo.

Mix: Sets what percentage of the original image is blended with the filtered image.
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HUD Controls
The HUD contains the following controls: Delay, Number, Decay, and Amount.

Scrub
Moves a virtual playhead around a clip, allowing you to change the timing of the clip
without moving it in the Timeline. Additionally, this filter allows you to animate the offset
parameter, often with interesting results. Try adding the Scrub filter to a clip, then applying
the Randomize behavior to the Frame offset, with the “Offset from” parameter set to
Current Frame. Also, you can create a hold frame by setting Offset to First Frame, then
using “Frame offset” to find the frame you wish.

Important: Scrub does not affect clip audio.

This filter causes rasterization in 3D groups.

Parameters in the Inspector
Frame offset: Sets the offset of the virtual playhead.

Offset from: Sets the position from which the virtual playhead is offset. Values available
include First Frame or Current Frame.

Frame Blending: Turns the blending between frames on and off.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Frame offset, Offset from, and Frame Blending.

Strobe
Strobes the image by holding frames for a set duration. The effect is that moving images
appear to skip frames as they play.

Parameters in the Inspector
Strobe Rate: Sets the number of frames of each strobe.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following control: Strobe Rate.

Trails
Draws light or dark trails following an object’s movement. This filter is only effective with
moving images.
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This filter causes rasterization in 3D groups.

Original image Decay is turned on, and Trail On is set to Light.

Parameters in the Inspector
Duration: Sets the duration of the trails.

Echoes: Sets the number of echoes trailing behind.

Decay: Sets whether the trails decay over time or disappear at the end of the duration.

Trail On: Sets the kind of values that trigger the trails. This pop-up menu can be set to
Light or Dark.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Duration, Echoes, Decay, and Trail On.

WideTime
Similar to the Echo filter, but WideTime holds frames both before and after the current
frame to stretch the image’s motion out in time.

This filter causes rasterization in 3D groups.

Parameters in the Inspector
Duration: Sets the number of frames before and after the current frame that are blended.

Decay: Sets the amount of time the added frames are held.

Amount: Sets the amount of opacity of the delayed object being overlaid. Values range
from 0 (no reduction) to 1.0 (transparent).

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Duration, Decay, and Amount.
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Video Filters
Video filters are more utilitarian in nature, and can be used to help prepare a project for
broadcast output.

Broadcast Safe
This filter limits the range of luminance or chrominance in an image to the broadcast
legal limit.

Parameters in the Inspector
Video Type: Sets the rule set to be used for filtering image data. Value can be NTSC or
PAL.

Fix Method: Sets the type of fix to be made to the image. Value can be Reduce Luminance
or Reduce Saturation.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Video Type and Fix Method.

Deinterlace
This filter deinterlaces an interlaced object using one of several possible methods.

This filter causes rasterization in 3D groups.

Parameters in the Inspector
Dominant Field: Selects the dominant field. Value can be Upper or Lower.

Method: Sets how the object is interlaced. The method can be Duplicate, Interpolate, or
Blend.

• Duplicate: The nondominant field is eliminated, and the data from the dominant field
is duplicated to fill in the missing lines.

• Interpolate: The nondominant field is eliminated, and a new field is created by averaging
each pair of adjacent video lines to create new ones.

• Blend: The nondominant field is eliminated, and new lines are created by averaging
the eliminated line along with each pair of adjacent video lines.

Mix: Sets what percentage of the original image is blended with the filtered image.

HUD Controls
The HUD contains the following controls: Dominant Field and Method.
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Motion has a flexible tool set that you can use to create simple shapes, complex
illustrations, and paint effects right in your project. The same techniques you use for
drawing can also be used to mask objects to produce a wide variety of transparency
effects, to crop out parts of still images, and to rotoscope moving subjects.

This chapter covers the following:

• About Shapes, Masks, and Paint Strokes (p. 1064)

• The Difference Between Shapes, Paint Strokes, and Masks (p. 1065)

• Shape and Mask Drawing Tools (p. 1066)

• Creating and Editing Shapes (p. 1076)

• Adding Shapes from the Library (p. 1105)

• Shape Parameters (p. 1105)

• Shape Controls in the HUD (p. 1128)

• Creating Illustrations Using Multiple Shapes (p. 1129)

• Creating Holes and Transparency in Shapes (p. 1131)

• Applying Filters to Shapes (p. 1132)

• Animating Shapes (p. 1133)

• Shape Behaviors (p. 1133)

• Keyframing Shape Animation (p. 1151)

• Saving Shapes and Shape Styles (p. 1153)

• Using Masks to Create Transparency (p. 1157)

• Mask Parameters (p. 1170)

• Applying Image Masks to a Layer (p. 1174)

• Image Mask Parameters (p. 1177)

• Using Masks to Aid Keying Effects (p. 1178)

• Converting Between Shapes and Masks (p. 1182)

• Manipulating Alpha Channels Using Filters (p. 1184)
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About Shapes, Masks, and Paint Strokes
Shapes and masks are vector-based objects that are drawn and edited using control
points that define mathematical curves. Each control point in a shape defines some sort
of corner or curve, and the actual spline that makes up the shape connects these control
points together like a connect-the-dots drawing. You can edit or animate any shape by
moving and editing its control points or by applying a Shape behavior.

Shape behaviors are designed specifically to be applied to shapes and masks, and perform
tasks such as oscillating the position of the control points, tracking the control points,
writing on a shape over time, as well as randomizing or wriggling the position of the
control points. As with all objects in Motion, you can also apply Basic Motion, Parameter,
and Simulation behaviors to shapes.

A paint stroke is a shape that is created in one of two ways: You can “paint” the stroke in
the Canvas using the Paint Stroke tool in the Toolbar, or you can modify the outline of
an existing shape. The Paint Stroke tool allows you to use a stylus and graphics tablet (or
a mouse) to create a paint stroke, rather than drawing the shape in a point-by-point
fashion (like a Bezier or B-Spline shape). In addition to sharing other shape outline
parameters, paint strokes have a unique tool set that allows you to change the look of
the paintbrush and to create particle-type effects with the stroke. Paint strokes have a
special behavior called Sequence Paint, which allows you to sequence the stroke
parameters over time, such an opacity, rotation, and scale.

The Paint Stroke feature is a design and graphics tool, not a retouching or rotoscoping
tool.

Note: Using a stylus and graphics tablet is recommended when using the paint feature.
While you can create paint strokes using the mouse, a pen allows for a more fluid creation
of strokes.

Because shapes are mathematically defined, you can take advantage of the vector nature
of shapes to resize them by any amount, without introducing unwanted artifacts. Shapes
are similar to imported PDF objects in that they’re completely resolution independent.

As with all objects in Motion, you can save a shape or a shape style to the Library. This
means that once you create or animate that shape, or both, you can save it to the Library
for use in a future project. You can also save just the style of a shape—such as a custom
gradient fill or modified brush stroke.
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The Difference Between Shapes, Paint Strokes, and Masks
Shapes are primarily used to create all kinds of visual elements. They work like any other
object, except that they are created in Motion and are stored within your project file. A
single shape can be used as a background or colored graphic in a composition, or you
can create complex illustrations using many shapes. Each illustration below is composed
of shapes created within Motion.

Character drawn in Motion using Bezier tool Replicator using Bezier shape

You can create a paint stroke from scratch, or convert an existing shape to a paint stroke.
Unlike shapes that are created one point at a time, a paint stroke is created in one
continuous movement. You can use the stroke as a whole, or create unique graphic
elements that can be drawn on over time. While paint strokes share the same parameters
as all other shapes, they have additional specialized parameters.

Paint stroke with applied Sequence Paint behavior
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Masks, on the other hand, are used to create regions of transparency in layers. While
shapes work as objects by themselves, masks must be assigned to an object to have an
effect. For example, if you have a picture in which you want to isolate the foreground
subject, you can create a mask to cut out the background.

Object Mask Masked object

Like any other layers, shapes, masks, and paint strokes can be animated using behaviors
and keyframes. Shapes also have their own special category of behaviors. What’s more,
you can also animate the control points used to create each shape or mask in your project.
This allows you to animate the actual form of each shape, in addition to the shape’s basic
position, rotation, and scale parameters.

Shape and Mask Drawing Tools
Shapes and masks (and paint strokes) are made with splines, and they’re created and
edited using similar tools. This section covers the two spline-drawing methods that are
available in Motion: Bezier splines and B-Splines. You can use Bezier shapes and B-Spline
shapes interchangeably for any task. The default shape type is Bezier.

Bezier splines are good for drawing shapes for illustration. The controls used to manipulate
Bezier splines are similar to those found in many other drawing and compositing
applications, so they may already be familiar to you. Bezier controls lend themselves to
the creation of precise, detailed shapes. Tangent handles adjust the curvature of the
shape on either side of the control point, and this defines the surface of the shape.

Bezier control point

Tangent handles
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B-Splines can also be used to draw shapes, but unlike Bezier controls, B-Splines are
manipulated using only points—there are no tangent handles. Furthermore, the points
themselves do not lie on the surface of the shape. Instead, each B-Spline control point is
offset from the shape’s surface, pulling that section of the shape toward itself as if it was
a magnet, in order to create a curve. By combining the influence of multiple B-Spline
points, you can create different curves. B-Splines are extremely smooth—by default, there
are no sharp angles in B-Spline shapes, although you can create sharper curves, if
necessary.

B-Spline control point

Because B-Spline controls are so simple, they’re easy to animate and manipulate. The
tools you use for a particular task are largely a matter of personal preference.

Note: Shapes drawn with Bezier and B-Spline tools can be converted into paint strokes
by selecting the shape’s Outline checkbox and choosing a different brush type in the
Inspector. For more information, see Creating Paint Strokes.

Drawing Masks and Shapes Using Bezier Splines
This section describes how to draw a Bezier shape from scratch. These methods are
identical whether you use the shape or masking tools. This section focuses on drawing
shapes. For more information on drawing masks, see Using Masks to Create Transparency.

To draw a Bezier shape
1 Click the Bezier tool in the Toolbar (or press B).

Bezier tool 
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Note: The Bezier Mask tool is located in the Mask tools section of the Toolbar.

Bezier Mask tool

The Bezier Tool HUD appears. (If it does not appear, press F7.) To change the color of the
shape before it is drawn, use the color controls in this HUD. Select the Outline checkbox
to create an outline with the shape. The Width slider adjusts the width of the outline.
Once the shape is created, the Shape HUD appears.

Note: Outlines can be added and edited after a shape is drawn.

2 Click in the Canvas to draw the first point.

3 To add additional points to further define the shape, do one of the following:

• Click to make a linear corner point.

• Click, then drag to make a curved Bezier point, adjusting it to the shape you want.

Note: Press Shift while making a curved point to constrain its tangents to 45-degree
angles.

While you’re drawing a shape, you can also use any of the point-editing procedures
described below to move and adjust existing control points prior to finishing the shape.
You can adjust any control point except the first one you created, because clicking the
first point closes the shape.
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Tip: If you need a closer look at what you’re doing, magnify the Canvas while drawing a
shape. Use Command-Equal Sign (=) to zoom in and Command-Hyphen (-) to zoom out.
You can scroll around by pressing the Space bar as you drag in the Canvas. If you have
a Multi-Touch trackpad, it’s even easier: pinch open or closed to zoom in or out, and use
a two-finger swipe to scroll around.

4 To finish the shape, do one of the following:

• Click the first point you drew to create a closed shape.

• Press C to close the shape, joining the first point you created to the last.

• Double-click anywhere in the Canvas to create the last point of an open shape.

• Press Return to create the last point of an open shape.

Note: Before a shape is closed, you can press Esc at any time to cancel the entire operation,
deleting the shape.

Immediately after finishing a shape, the Shape HUD appears and the Adjust Control Points
tool is selected, which allows you to edit the shape you’ve just created.

Note: Once you have finished drawing a shape, press Esc to change to Select/Transform
mode.

Drawing Masks and Shapes Using B-Splines
This section describes how to draw a B-Spline shape. These methods are identical whether
you’re using the shape or masking tools, but this section focuses on drawing shapes. For
more information on drawing masks, see Using Masks to Create Transparency.
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To draw a B-Spline shape
1 Click the B-Spline tool in the Toolbar (or press B).

B-Spline tool

Note: If the Bezier tool is selected, pressing B once selects the B-Spline tool. If another
tool is selected, such as the Text tool, press B twice to select the B-Spline tool. The B-Spline
Mask tool is located in the Mask tools section of the Toolbar.

B-Spline Mask tool

The B-Spline Tool HUD appears. (If it does not appear, press F7.) To change the color of
the shape before it is drawn, use the color controls in this HUD. Select the Outline checkbox
to create an outline with the shape. The Width slider adjusts the width of the outline.
Once the shape is created, the Shape HUD appears.

2 Click in the Canvas to draw the first point.

3 Continue clicking to draw additional points to define the shape you need.

Note: Press Shift while making a curved point to constrain its tangents to 45-degree
angles.
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As you create new B-Spline control points, keep the following rules in mind:

• The control points you draw influence the shape of the curve from a distance. They do
not lie directly on the surface of the curve.

• To create more detailed curves, create more points. However, it’s a good habit to use
the fewest number of points necessary to create the amount of detail you need. Shapes
with an excessive number of points can be difficult to edit later on.

Simple B-Spline curve Multi-point B-Spline curve
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• In many instances, it is easier to create a loose group of control points first and then
adjust them afterwards to create the precise curve you need in a later step.

Starting with a loose collection of points Fine-tuning the illustration later

4 While drawing a shape, you can move and adjust the control points you’ve already created
prior to finishing the shape. You can adjust any control point except the first one you
created, because clicking the first point closes the shape.

Tip: If you need a closer look at what you’re doing, you can magnify the Canvas while in
the middle of drawing a shape. You can also scroll around by pressing the Space bar
while you drag in the Canvas.

5 When you’re ready to finish your shape, do one of the following:

• Click the first point you drew to create a closed shape.

• Press C to close the shape, joining the first point you created to the last.
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• Press Return to finish an open shape at the last point you made.

• Double-click anywhere in the Canvas to define the last point of an open shape.

Note: You can press Esc at any time while drawing a shape to cancel the entire operation
and delete the shape.

Immediately after finishing a shape, the Shape HUD appears and the Adjust Control Points
tool is selected, which allows you to edit the shape you’ve just created. Press Shift-S to
change to the Select/Transform tool.

Controlling B-Spline Curvature
Each control point on a B-Spline path affects the curvature of the shape nearby. By default,
these curves are very rounded, but you can adjust the degree of roundness, even creating
corner points by adjusting the control point weight handle.

To modify the smoothness of B-Spline control points
1 Create a shape using B-Splines.

2 Command-drag one of the control points.

1073Chapter 17 Using Shapes, Masks, and Paint Strokes



A weight handle appears.

3 Drag the weight handle away from the control point to sharpen the path. Drag it towards
the control point to smooth the path.

Drawing Masks Using the Freehand Mask Tool
This section describes how draw a freehand mask. Like the Paint Stroke tool, the Freehand
Mask tool allows you to create a shape in one movement, rather than drawing the shape
in a point-by-point fashion (like a Bezier or B-Spline shape). It is recommended to use a
stylus and tablet when using the Mask Freehand tool. For more information on drawing
masks, see Using Masks to Create Transparency.

To draw a freehand mask
1 Select the layer you want to mask, click the Mask tool in the Toolbar, then choose the

Freehand Mask tool.

Freehand Mask tool

The Freehand Mask Tool HUD appears.

2 Adjust the controls in the Freehand Mask Tool HUD.

• To change the blend mode of the mask before it is drawn, use the Mask Blend Mode
pop-up menu in this HUD.
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• Adjust the Feather slider to soften the mask. Positive values spread the feathering
outward, while negative values feather the shape inward.

Original image 
before masking

3 Touch the stylus on the tablet to begin drawing the mask in the Canvas (if using a mouse,
click in the Canvas, but don’t release the mouse button).

Continue drawing around the object you are masking. To close the mask, finish the line
at the mask’s starting point. A small circle will appear when the pointer is over the starting
point.

Note: If you don’t close the mask at its starting point, the mask is automatically closed
when you release the mouse button.

A small circle indicates 
target to close mask.

The mask is completed.

4 Edit your control points to fine-tune the mask.

For more information on editing control points, see How to Edit Shapes.
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Creating and Editing Shapes
Use the Bezier and B-Spline shape tools to create any kind of line or shape you need.
Once you draw a shape, you can adjust the fill, outline, and feathering to suit your needs.

Note: You can only feather shapes that have the outline turned off.

To make a freehand shape using the Bezier or B-Spline tool
1 Select the Bezier or B-Spline tool (press B).

2 Click in the Canvas to create the necessary control points for the line you need.

For more information, see Shape and Mask Drawing Tools.

3 To finish drawing the line, do one of the following:

• Double-click to create the last point.

• Press Return to finish the line at the last point you drew.

The mask is left open.

By default, the Outline checkbox is selected for open shapes.

To edit a shape’s outline
1 Select a shape, then open the Shape tab in the Inspector.

2 To manipulate the shape’s outline, do any of the following in the Style pane of the Shape
tab:

• To turn a shape’s outline on or off, click the Outline checkbox.

• To change the color of the outline, use the Brush Color parameter in the Outline controls.

• To change the width of the outline, drag the Width slider.

Note: You can also use the Shape HUD to turn the outline on and off, and to change
its color, roundness, and width.

• To change how the outline’s sharp corners are drawn, choose an option from the Joint
pop-up menu.

• To change the shape of an outline’s start and end caps, choose an option from the
Start Cap or End Cap pop-up menu.

• To change whether the outline appears over or under a shape’s fill, choose a command
from the Order pop-up menu.

• To change the roundness of the outline, adjust the Roundness slider.

• To change the outline from the default solid to an editable paint stroke, set Brush Type
to Airbrush or Image. For more information, see Style Pane Controls in the Inspector.

To create filled or empty shapes
1 Click the Bezier or B-Spline shape tool (press B).

2 Create the necessary control points for the shape you need.
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For more information, see Shape and Mask Drawing Tools.

3 When you’re ready to close the shape, click the first point you created.

4 By default, new closed shapes are filled. To make the shape empty, select it, then deselect
the Fill checkbox in the Shape HUD.

Filled shape Empty shape

To edit a shape’s fill
1 Select a shape, then open the Shape tab in the Inspector.

2 In the Style pane of the Shape tab, do any of the following:

• To turn a shape’s fill on or off, click the Fill checkbox.

• To change a shape’s fill mode from a solid color to a gradient, choose an option from
the Fill Mode pop-up menu.

• If the shape’s fill mode is set to a solid color, you can choose the color using the Fill
Color controls.

• If the shape’s fill mode is set to a gradient, you can either choose a gradient from the
gradient preset pop-up menu, or click the Gradient parameter’s disclosure triangle to
display the Gradient editor and create your own custom gradient. For more information
on using the Gradient editor, see Gradient Controls.

To feather a shape
1 Select the shape you want to feather.

2 If the shape’s Outline checkbox is selected, deselect the checkbox in the Style pane of
the Shape tab.

3 Adjust the Feather slider in the HUD or in the Style pane of the Shape tab.
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Positive values spread the feathering outward, while negative values feather the shape
inward.

Feathered inFeathered out

Tip: You can also blur a shape in other ways using filters. For more information, see
Applying Filters to Shapes.

Creating Rectangles, Circles, and Lines
The Rectangle and Line tools create simple linear shapes. The Circle tool creates a simple
Bezier shape. Once drawn, a shape can be converted to a Linear, Bezier, or B-Spline shape
in the Inspector. The resulting shapes can be edited just like any other Bezier shape, using
the methods described in How to Edit Shapes.

To make a rectangle
1 Click the Rectangle tool (or press R).

The Rectangle Tool HUD appears. To change the color or roundness of the shape before
it is drawn, use the controls in the HUD. Select the Outline checkbox to create an outline
with the shape. The Width slider adjusts the width of the outline. Once the shape is
created, the Shape HUD appears.

The Rectangle shape layer does not appear in the Layers tab until an object is drawn.

Note: Outlines can be added and edited after a shape is drawn.
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2 Click in the Canvas to define the first corner of the rectangle, then drag until the resulting
rectangle is the size you want, and release the mouse button to finish drawing.

Note: To create a perfect square, press Shift while you drag. To draw the rectangle from
its center, press Option while you drag.

3 Once the shape is created, press S or Esc to exit shape-drawing mode and activate the
Select/Transform tool.

To make a rounded rectangle
1 Create a rectangle shape as described above.

2 Do one of the following:

• Drag the roundness handle in the upper left corner of the shape.

Rectangle with handles Rectangle corners modified with 
roundness handle

• In the HUD, adjust the Roundness slider.

Note: You can also set the Roundness value in the Shape HUD prior to drawing the
rectangle.

• In the Inspector, click the Geometry pane and adjust the Roundness slider.
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To make a circle
1 Click the Rectangle tool and, holding the mouse button, select the Circle tool (or press

C).

The Circle Tool HUD appears. To change the color of the shape before it is drawn, use
the color controls in the HUD. Select the Outline checkbox to create an outline with the
shape. The Width slider adjusts the width of the outline. Once the shape is created, the
Shape HUD appears.

2 Click in the Canvas to define the start point of the bounding box that defines the circle,
then drag until the resulting circle is the size you want, and release the mouse button to
finish drawing.

Note: To create a perfectly symmetrical circle, press Shift while you drag. To draw the
circle from its center, press Option while you drag.

Tip: If you change a circle’s Shape Type to B-Spline in the Geometry pane of the Shape
Inspector, you can use different methods to manipulate the circle.

3 Once the shape is created, press S or Esc to activate the Select/Transform tool.

To make a line
1 Click the Rectangle (or Circle) tool and, holding the mouse button, select the Line tool.
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The Line Tool HUD appears. To adjust the color and width of the line before it is drawn,
use the controls in the HUD.

2 Click in the Canvas to define the start point of the line, and keep holding down the mouse
button.

3 Drag until the resulting line is the length you want, then release the mouse button.

Tip: Pressing Shift while dragging constrains the line movement to 45-degree angles.

Important: Because a line is really an outline, all of the Outline parameters in the Inspector
apply to a line.

4 Once the shape is created, press S or Esc to select the Select/Transform tool.

The Shape HUD appears.

Note: Rectangles and circles can be converted into paint strokes by selecting the shape’s
Outline checkbox and choosing a different brush type in the Inspector. By default, a line
is an outline, so it would only require a change in brush type. For more information, see
Using a Shape Outline as a Paint Stroke.

Creating Paint Strokes
Unlike a freehand Bezier or B-Spline shape that is drawn one point at a time, a paint stroke
is typically created with one continuous movement.

Technically, paint strokes are outline-only shapes created using any shape tool. An
outline-only shape is indicated by a paintbrush icon in the layers tab and Timeline layers
list. This icon changes to a shape icon once a shape fill is enabled.

Note: The Paint Stroke feature is a design and graphics tool, not a retouching or
rotoscoping tool.

There are two ways to create a paint stroke:

• Use the Paint Stroke tool in the Toolbar and draw a stroke in the Canvas using a stylus
and tablet (or a mouse).

• Create a shape (paint stroke, line, rectangle, or circle) in the Canvas, select the Outline
checkbox, and modify the outline in the Style pane of the Shape Inspector.

To access additional paint stroke controls in the Stroke and Advanced panes of the Shape
Inspector, the Brush Type parameter in the Style pane must be set to Airbrush or Image.

Note: This section discusses creating an airbrush or image brush paint stroke using the
Paint Stroke tool in the Toolbar. For information about converting a shape to an editable
paint stroke, see Using a Shape Outline as a Paint Stroke.
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When using an airbrush or image brush preset, the Paint Stroke tool creates a shape
outline that is comprised of dabs. Dabs—analogous to the cells of a replicator or particle
emitter—define the appearance of the stroke. While particle cells emit a variety of different
particle types, airbrush paint strokes have only a single dab type. The dabs can be very
close together or spaced widely apart along the stroke. The dabs’ color, opacity, spacing,
scale, angle, and so on can be modified in the Inspector once a stroke is created.

For more information on modifying a paint stroke after the stroke is created, see Stroke
Pane Controls in the Inspector.

Paint strokes can be animated using behaviors or by keyframing. In addition to Basic
Motion, Simulation, and Parameter behaviors, shapes have their own category of behaviors
that includes a behavior that allows you to sequence effects over the length of the stroke.
For more information on using the Shape behaviors, see Shape Behaviors.

Note: The stroke’s shape (defined by its control points) and open/closed state can be
modified in the Canvas or Inspector. Because a stroke is a shape, it can be edited just like
any other shape, using the methods described in How to Edit Shapes.

Once you click the Paint Stroke tool in the Toolbar and prior to drawing the stroke in the
Canvas, you can define the color and other attributes of the stroke in the Paint Stroke
Tool HUD. In the HUD, you select a preset shape style to use as your brush source.

There are several ways to set the style of a paint stroke:

• Select a preset shape style in the Paint Stroke Tool HUD prior to drawing a stroke. If no
preset shape is selected prior to drawing a stroke, a basic solid stroke (outline) is created.

• Modify a paint stroke created with the Paint Stroke tool using the Shape Style pop-up
menu in the Style pane of the Shape Inspector.

• Select the Outline checkbox and modify the outline of a shape (circle, rectangle, and
so on). The Outline checkbox can be selected or deselected in the Shape HUD or the
Style pane of the Shape Inspector.

• Drag a shape style (in the Shape Styles category) from the Library to the paint stroke
object in the Layers tab. The style of the shape from the Library is applied to the paint
stroke.

Depending on the effect you want, you may achieve better results using a stylus and
tablet with the Paint Stroke tool. Many styles and brushes take advantage of the pen
pressure and speed applied when creating the stroke using a graphics tablet. You can
apply the pressure or speed to different stroke parameters, such as width, opacity, and
spacing. For example, choosing Width from the Pen Pressure pop-up menu in the Paint
Stroke Tool HUD results in wider strokes when you apply more pen pressure.

Note: Speed can also be read when using a mouse rather than a stylus.
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Using the Write On parameter, you can record a stroke so that it “draws” over time. In
this case, a Write On Shape behavior is applied to the stroke using as its settings the time
it took to draw the stroke and the speed at which each section of the stroke was created.
These settings can be modified after the stroke is created. A Write On behavior can also
be applied after a paint stroke has been created. For more information on using the Write
On behavior, see Write On.

To make a paint stroke
1 Select the Paint Stroke tool (or press P).

Paint Stroke tool

The Paint Stroke tool HUD appears. (If it doesn’t appear, press F7.)

Important: Like the other drawing tool HUDs, the Paint Stroke Tool HUD is available only
after the Paint Stroke tool is selected and before you create your stroke in the Canvas.
The Paint Stroke Tool HUD allows you to determine the properties derived from the
pressure and speed of the stylus before the stroke is drawn.

2 Define a paint stroke style in the HUD:

a Choose an option from the Shape Style preset pop-up menu.

b Modify the Brush Color and Width settings.

If a preset is not used, a basic solid stroke is created. Once the stroke is created, you
can still apply a preset to the stroke using the Inspector. Presets do not override the
width or color of the stroke set in the HUD.

Note: The Pen Pressure and Pen Speed parameters become available depending upon
the chosen style. These parameters are not available with a solid brush type.

3 If you want to create a stroke that is drawn over time, select the Write On checkbox.
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When a paint stroke is created with the Write On checkbox selected, a Write On behavior
is applied to the stroke. Like any other behavior, you can modify its parameters in the
HUD or Inspector. For more information on using the Write On behavior, see Write On.

4 Draw your stroke in the Canvas. Once the stroke is complete, press S or Esc to select the
Select/Transform tool.

The Paint Stroke Tool HUD is replaced with the Shape HUD. The Paint Stroke HUD
parameters are identical to all other shape HUDs. Once a stroke is drawn, you must use
the Inspector to modify parameters unique to the paint stroke and its dabs.

The lower portion of the Paint Stroke Tool HUD contains a sketch area and a play button.
This allows you view a preview of what a paint stroke effect will look like.

To preview the paint stroke in the Paint Stroke Tool HUD’s sketch area
1 Click the Paint Stroke tool in the Toolbar.

2 Do one of the following:

• Select any brush style in the Paint Stroke Tool HUD, then draw a stroke in the sketch
area to see a preview of the paint stroke.

• Select the Write On checkbox, draw a stroke in the sketch area, then click the Play
button to see a preview of the write-on stroke.

• Apply a preset from the Shape Style pop-up menu to an existing stroke in the sketch
area.

If the preset is an animated stroke, the stroke is automatically drawn in the sketch area.
Press the Play button to see the stroke animation again.

Note: To create a paint stroke that is “painted” on the Canvas over time (if your chosen
preset is not animated), select the Write On checkbox in the HUD prior to drawing the
paint stroke in the Canvas.

Important: Some operations, as well as the application of certain filters or a mask, cause
a group to be rasterized. Because all paint strokes live in groups, this affects how strokes
interact with other objects within your project. For more information, see Groups and
Rasterization.

Paint Stroke Tool HUD Parameters
The Paint Stroke Tool HUD is displayed after the Paint Stroke tool is selected in the Toolbar
and before a stroke is drawn. This HUD contains controls that define the color and width
of the stroke and how pen pressure and speed affect the stroke (opacity, width, and so
on), a checkbox that allows the stroke to be “drawn in” over time, smoothing controls,
and a Shape Style pop-up menu for quick access to preset brush styles and a sketch area
for sampling these brush styles.

Brush Color: A color well and eyedropper that set the color of the brush. For more
information on using these controls, see Color Controls.
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Width: A slider that defines the width of the paint stroke.

Pen Pressure: When creating paint strokes, this pop-up menu allows you to determine
stroke properties derived from the pressure of your pen prior to creating the stroke. This
parameter is not available for solid brush types. Choose from one of the following:

Note: Only strokes drawn using a stylus and tablet will have recorded pressure variations.

• Nothing: Pen pressure is ignored.

• Width: The harder the pen pressure, the wider the stroke. To adjust the width of the
dabs after the stroke is created, use the width controls in the Stroke or Style pane.

• Opacity: The harder the pen pressure, the more opaque the stroke. To adjust the opacity
of the dabs after the stroke is created, use the opacity controls in the Stroke pane.

• Spacing: The harder the pen pressure, the greater the spacing in between the stroke
dabs. To adjust the spacing of the dabs after the stroke is created, use the spacing
controls in the Stroke or Style pane.

• Angle: The harder the pen pressure, the greater the angle of the stroke dabs. To adjust
the angle of the dabs after the stroke is created, use the angle controls in the Stroke
pane.

• Jitter: The harder the pen pressure, the larger the amount of jitter on the stroke. Jitter
randomizes the position of the paint dabs, giving the dabs a particle-like appearance.
To adjust the jitter of the dabs after the stroke is created, use the jitter controls in the
Stroke pane.

Note: You can affect multiple parameters on a single stroke, such as pressure affecting
opacity and spacing. Choose an option before the stroke is created, such as Opacity. Once
the stroke is created, apply a pen shape behavior to the stroke and apply the action to
another parameter, such as Spacing. For more information on the pen shape behaviors,
see Shape Behaviors.

Pen Speed: This pop-up menu allows you to affect the stroke’s width, opacity, spacing,
angle, and jitter based on the speed recorded when drawing the stroke with the paint
stroke tool. These settings can be applied to paint strokes created using a stylus and
graphics tablet or mouse. This parameter is not available for solid brush types. Choose
from one of the following:

• Nothing: Pen speed is ignored.

• Width: The faster you move the pen, the more narrow the stroke; the slower you move
the pen, the wider the stroke. To adjust the width of the dabs after the stroke is created,
use the width controls in the Stroke or Style pane.

• Opacity: The faster you move the pen, the less opaque the stroke. To adjust the opacity
of the dabs after the stroke is created, use the opacity controls in the Stroke pane.
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• Spacing: The faster you move the pen, the greater the spacing between the dabs of
the stroke. To adjust the spacing of the dabs after the stroke is created, use the spacing
controls in the Stroke or Style pane.

• Angle: The faster you move the pen, the greater the angle of the stroke dabs. To adjust
the angle of the dabs after the stroke is created, use the angle controls in the Stroke
pane.

• Jitter: The faster you move the pen, the larger the amount of jitter on the stroke. Jitter
randomizes the position of the paint dabs so they appear more like particles. To adjust
the jitter of the dabs after the stroke is created, use the jitter controls in the Stroke
pane.

Write On: This parameter allows a stroke to be “painted” on the Canvas over time. For
more information, see Write On.

Smoothing: Select this checkbox to create a smoother stroke with fewer control points.
Paint strokes drawn with smoothing on will be created as bezier shapes. Paint strokes
drawn with smoothing off will be created as linear shapes.

Shape Style: A pop-up menu that allows you to apply a preset shape style (from the
Library) to the selected shape. You can also save any custom shape style to the Library
using this pop-up menu. Any stroke (shape) presets you have saved to the Library also
appear in this list.

Sketch Area: An empty field where brush styles can be sampled in combination with the
current Paint Stroke Tool HUD settings.

Shapes as a Layer
Once created, a shape (including paint strokes) becomes a layer. Because shape layers
share most of the characteristics of other layers in Motion, you can use the transform
tools—Select/Transform, Anchor Point, Shear, Drop Shadow, Four Corner, and Crop—to
transform a selected shape layer. These onscreen tools are shortcuts to the layer controls
in the Properties tab of the Inspector. To set specific values, or fine-tune any of the
transforms, use the Properties tab in the Inspector.

For more information on the Properties tab and onscreen transform tools, see Parameters
in the Properties Tab.

Important: Some operations, as well the application of certain filters or a mask, cause a
group to be rasterized. When a group is rasterized, it is converted into a bitmap image.
Because all shape (masks, shapes, and paint strokes) layers live in groups, this affects how
shapes interact with other objects within your project. For more information, see Shapes
and Rasterization.

Note: Paint strokes render in a plane, so they can always be thought of as rasterized. This
is independent of other objects within the group in which the paint stroke lives. This
affects how the dabs interact with objects within a paint stroke’s own group.
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How to Edit Shapes
There are two ways to edit shapes. You can edit them in their entirety, like any other
object, using the Transform tools, or you can adjust them point by point using the Adjust
Control Points tool. The shape-editing techniques in this section apply to both shapes
and masks.

You perform most of your detailed editing using a shape’s individual control points. The
Transform and Shear tools are better for overall transformations of an entire shape. The
following guidelines apply to all shape types: shapes, masks, and paint strokes.

Using Dynamic Guides and Snapping While Editing
The Canvas Dynamic Guides and control point snapping help you snap the selected
points to one another. You can snap the points of one shape to other points on that
shape, or you can snap the points of one shape to the points of a different shape.

To use control point snapping on a single shape
1 In the View menu above the right side of the Canvas, ensure that Dynamic Guides are

turned on.

2 Choose View > Snap to ensure snapping is turned on.

When active, a check mark appears next to the menu item.

3 Select the shape you want to edit, click the Select/Transform tool, and while holding
down the mouse button, choose the Adjust Control Points tool from the pop-up menu.

Note: In the Canvas, you can also Control-click a shape and choose Edit Points from the
shortcut menu.

4 In the Canvas, drag a control point.

Guides appear when the selected control point aligns with other control points on the
shape.

1087Chapter 17 Using Shapes, Masks, and Paint Strokes



To use control point snapping on multiple shapes
1 In the View menu of the Toolbar, ensure that Dynamic Guides are turned on.

2 Choose View > Snap to ensure snapping is turned on.

When active, a check mark appears next to the menu item.

3 Select the shape you want to edit, click the Select/Transform tool, and while holding
down the mouse button, choose the Adjust Control Points tool from the pop-up menu.

Note: In the Canvas, you can also double-click a shape or control-click a shape and choose
Edit Points from the shortcut menu to show its control points.

4 Shift-select another shape.

5 In the Canvas, drag a control point on the originally selected shape.

Guides appear when the selected control point aligns with other control points on the
shape being edited, as well as other shapes in the Canvas.

Use the following guidelines to turn Dynamic Guides off, so that snapping doesn’t interfere
with subtle shape adjustments:

• Press N to turn off the dynamic guides. Press N again to turn the Dynamic Guides back
on.

• Once you begin to move the selected control point, press and hold the Command key
to turn off snapping as you drag the point.

Note: If you press Command and then drag a control point, adjustable tangent handles
are created. If you press Command and click a curved point, that point becomes a
corner point. For more information on editing Bezier curve control points, see Editing
Bezier Control Points.
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To transform a Bezier or B-Spline shape
1 Click the Select/Transform tool.

2 Click a shape.

3 Move, resize, or rotate the shape.

Note: To quickly enter control point adjustment mode in the Canvas, double-click the
shape.

When you move, resize, rotate, or shear a shape, you also transform its control points to
match the new orientation of the shape.

Original shape Shape after moving, rotating, and scaling. Note 
that the control points have also moved.

For more information about how to perform object transformations, see 2D Transform
Tools.

Displaying a Shape’s Control Points
There are several ways to display the control points of a shape to allow point-by-point
editing in the Canvas.

To show a shape’s control points
Do one of the following:

µ Select the shape you want to edit, click the Select/Transform tool, and while holding
down the mouse button, choose the Adjust Control Points tool from the pop-up menu.

The control points appear.

µ Click and hold the Select/Transform tool, choose the Adjust Control Points tool from the
pop-up menu, then select a shape in the Layers tab or Timeline layers list.

µ Double-click a shape.

µ Control-click a shape in the Canvas, then choose Edit Points from the shortcut menu.
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Note: Overlays must be enabled in the View menu (or the Canvas View menu) in order
to see the control points and spline of a shape. In addition, if Handles are turned off in
the View > Overlays submenu (or the Canvas View menu), you cannot see a shape’s Bezier
or B-Spline control points when editing. When editing shapes, make sure that Handles
are turned on.

Once you display a shape’s control points, you need to select one or more control points
to edit them.

While editing the control points of a shape, you can select another shape and remain in
control point-adjustment mode. This allows for quick modification of multiple shapes’
control points.

To select another shape in control point-adjustment mode
µ While editing a shape using the Adjust Control Points tool, click an unselected shape in

the Canvas or Layers tab.

The new shape is selected in control point-adjustment mode.

Selecting and Deselecting Control Points on a Shape
The methods you can use to select and deselect points are similar to those available for
selecting and deselecting shapes in the Canvas.

To select one or more control points
Do one of the following:

µ Click any control point.

µ Drag a selection box over one or more points.

µ Shift-click unselected control points to add them to the selection.

µ Shift-drag a selection box around unselected control points to add them to the selection.
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Note: When your pointer is positioned over a control point, a Tool Info window appears
identifying the control point name. When dragging a control point, the Tool Info window
displays the point’s name and coordinates. You can choose whether or not to display this
info by choosing View > Show Tool Info or pressing Option-T.

To select every control point on a shape
µ Choose Edit > Select All (or press Command-A).

To deselect one or more selected control points
Do one of the following:

µ Shift-click one or more selected points.

µ Shift-drag a selection box over one or more selected points.

To deselect every control point on a shape
Do one of the following:

µ Click the Canvas anywhere outside the selected shape.

µ Choose Edit > Deselect All (or press Command-Shift-A).

To select a specific control point (based on the order the shape is drawn)
µ Enable Show Tool Info and position the pointer over any control point to display its control

point number.

Note: All shape control points are also listed by number in the Geometry tab of the Shape
Inspector.

Moving Control Points to Adjust a Shape
Because the control points define the shape, simply move control points to change the
shape.

To move one or more control points
µ Select one or more points, then drag them to a new position.
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As you drag one or more selected control points, the rest of the shape automatically
stretches or curves to accommodate the change.

Selecting three points Moving all three points simultaneously

µ Press Command-Left Arrow, Command-Right-Arrow, Command-Up Arrow or
Command-Down Arrow to nudge a point by one pixel (or Command-Shift to nudge by
10 pixels).

To constrain the movement of selected points
1 Select one or more control points.

2 Press Shift while you drag one of the selected points either horizontally, vertically, or
diagonally.

Important: Selected control points can only be moved—you cannot shear or corner-pin
them. To rotate or scale them, you must use the Transform Control Points command. See
Transforming Multiple Control Points.

Modifying Shape Edges
You can also select the line between two points and move the edge of the shape without
affecting the rest of the shape.

To move a shape edge
1 With the Adjust Control Points tool selected, click any edge of a shape object.

The control points on either side of the line are selected.
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2 Drag the line segment.

The distance between the two points remains constant, but the line can be moved freely.
Press Shift to constrain the movement horizontally, vertically, or diagonally.

3 Click anywhere outside the selection, or switch to a different tool to release the selection.

Transforming Multiple Control Points
You can scale and rotate a group of points as if they were a single object by using the
Transform Control Points command. The lines connecting the selected points to unselected
points will move and adjust as necessary.

To transform a group of control points
1 With the Adjust Control Points tool selected, drag a selection box around the points you

want to modify.

2 Choose Edit > Transform Control Points or press Command-Shift-T.

A transform box appears around the selected points.
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Note: Transform Control Points is only available when at least two points on the same
spline are selected.

3 Scale, rotate, offset the anchor point, and reposition the group of points as if they were
a separate object.

4 Click anywhere outside the selection, or switch to a different tool to release the selection.

Manipulating Control Points Across Multiple Shapes
In addition to manipulating multiple control points on a single shape, you can modify
multiple control points across different shapes simultaneously. This allows you to make
identical control point level changes to multiple objects in one step.

To modify control points across multiple shapes
1 With the Adjust Control Points tool selected, select the points you want to modify.

2 Shift-click additional objects to make their control points appear.

3 Shift-click additional control points across multiple objects.
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4 Reposition any one point and all points will be modified accordingly.

Note: The Transform Control Points command cannot be applied to groups of control
points selected across multiple objects.

Tip: You can modify points on a mask and points on a shape simultaneously. However,
you must manually select the mask in the Layers tab before its points can be added to
the selection.

Adding and Deleting Control Points
If you did not create enough control points to make the shape you need, you can add
more to the existing shape. You can also extend or close an open shape.

To add control points to a selected shape
1 Select the Adjust Control Points tool.

2 Do one of the following:

• Double-click or Option-click the edge of a shape to add a new control point.

Note: To add control points to a B-Spline shape, double-click or Option-click the B-Spline
frame’s edge, rather than the edge of the shape itself.

• Control-click the edge, then choose Add Point from the shortcut menu.
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Adding more control points does not immediately change a Bezier shape, unless you
drag Bezier curve points as you create them.

Before adding Bezier point After adding Bezier point

Adding more control points to a B-Spline shape, on the other hand, nearly always changes
its shape.

Before adding B-Spline point After adding B-Spline point

To add control points to the end of an open shape
1 Select an open shape with the Adjust Control Points tool.

2 Option-click anywhere outside of the shape to add new control points to the end of the
shape.

3 Option-click the first point in the shape to close it (or place the pointer over the first point
and press C).

The closed shape is not filled.

To close an open shape
Do one of the following:

µ With the Adjust Control Points tool active, Option-click the first point in the shape to
close it (or press C).

The closed shape is not filled.

µ Control-click a control point, then choose Close Curve from the shortcut menu.

µ Display the Geometry pane in the Shape tab of the Inspector, then select Closed.
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You can reopen the shape by deselecting the Closed checkbox.

To create an open shape from a closed shape
Do one of the following:

µ Control-click a point on the shape, then choose Open Curve from the shortcut menu.

The segment before the point (in a clockwise order) is removed from the shape. This
action causes the selected point to become Control Point 1 and the remaining points to
be renamed accordingly. If the originally closed shape was filled, the Fill checkbox remains
selected. To disable the fill, deselect the Fill checkbox in the HUD or Style pane of the
Shape Inspector.

µ Select the shape and deselect the Closed checkbox in the Geometry pane of the Shape
Inspector.

Note: The spline before the first point drawn is removed. To change the start point (the
first point drawn) of the shape, Control-click a point and choose Set Start Point from the
shortcut menu.

If a shape has more control points than are necessary, you can delete points from it to
make it easier to edit. This can be helpful if you animate the shape later on.

To delete control points from a shape
1 Select a shape with the Adjust Control Points tool.

2 Select one or more points to delete, then do one of the following:

• Choose Edit > Delete.

• Control-click the selected points, then choose Delete Point from the shortcut menu.

• Press Delete.

The shape changes to adjust to the missing point. If you remove points from a closed
shape, the shape remains closed.

Before deleting point After deleting point

Warning: If you delete a point from a shape that already has a keyframed shape
animation parameter in the Keyframe Editor, that control point is removed from the
entire animation.
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Locking Control Points
You can lock individual control points in a shape to fix them in place and prevent them
from being accidentally adjusted. A shape with locked points can still be moved. Locking
a control point simply prevents it from being adjusted while you edit a shape using the
Adjust Control Points tool.

To lock and unlock points
1 Choose the Adjust Control Points tool, then select a shape.

2 Control-click a control point, then choose Lock Point from the shortcut menu.

If the point was unlocked, it becomes locked. If the point was locked, Unlock Point appears
in the shortcut menu, and the point becomes unlocked.

Locked points appear with small 
dashes on either side of the point.

Editing Bezier Control Points
The methods used to adjust Bezier shapes are similar to those used by many other
applications. Bezier control points are widely used to modify curves, and allow you to
easily draw any shape you may need.

Each point in a Bezier shape can be converted from a hard corner to a curve.

Curve Corner
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To convert control points from corners to curves and vice versa
Do one of the following:

µ Command-click a curved point to turn it into a corner (Linear) point.

µ Command-drag a corner point to turn it into a curved (Bezier) point, creating adjustable
tangent handles.

µ Control-click one or more selected points, then choose Linear or Smooth from the shortcut
menu to change the control point type.

Curved Bezier control points have two tangent handles that you use to adjust the curvature
of the shape on either side of the control point. These handles can be adjusted in a variety
of ways to create symmetrical and asymmetrical curves. By default, these tangent handles
are locked to one another at an angle of 180 degrees, although this can be overridden
to allow each tangent to be independently adjusted.

Important: If Record (automatic keyframing) is turned on, turning a corner into a curve
causes an animated effect in which the corner gradually turns into the curve.

To adjust a Bezier curve using the control point’s tangent handles
Do one of the following:

µ Drag a tangent handle to adjust its length. By default, the opposing tangent is locked to
180 degrees, and adjusting the angle of one tangent automatically adjusts the other.
However, the length of each tangent can be independently adjusted.

µ Option-drag either tangent to break the relationship between opposing tangents. Once
this relationship is broken, adjustments to one tangent have no effect on the other, and
both tangents can be rotated freely.
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µ Control-click a handle control point and choose Break Handle from the shortcut menu
to break the relationship between opposing handles.

µ Option-drag a broken tangent or Control-click a handle control point and choose Link
Handle from the shortcut menu to lock the angle of the tangents together again. The
tangents now maintain their relationship when moved and rotated.

Note: You can also press Command-Option and drag a control point so the tangents
maintain their broken relationship when moved and rotated.

µ Control-click a handle control point and choose Align Handles from the shortcut menu
to align the tangents to a 180-degree angle.

Tip: Press Shift while you adjust a tangent to constrain its movement to 45-degree angles.

To simultaneously modify the handles for more than one control point, Shift-select the
points (on the same spline) and then adjust the tangents.

Important: If Record (automatic keyframing) is enabled, curve adjustments are keyframed,
creating animated shape changes.

Editing B-Spline Control Points
Editing the position of control points in B-Spline shapes is similar to editing Bezier shapes.
In fact, the steps for selecting, moving, adding, deleting, and locking control points are
almost exactly the same. The main difference in editing both types of shapes lies in how
you manipulate and adjust curves.
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The simplest, and usually fastest, way to manipulate B-Spline curves is to move one or
more B-Spline points closer to or farther away from one another. When B-Spline points
are moved closer to one another, a sharper curve is created. B-Spline points that are
farther away from one another create shallower curves.

Shallow curve Sharper curve (B-Spline points are closer.)

Each B-Spline control point tugs on a section of the shape, pulling it toward itself. As a
result, you manipulate a shape’s curve by moving its control points in the direction you
want to pull the shape. For example, notice how every control point creating the S curve
below is offset in the direction of the curve it influences.

Note: You can show and hide the B-Spline frame lines that enclose B-Spline control points
by choosing View > Overlays > Lines.

By default, B-Spline shapes have no corners. While this is the default behavior, you can
adjust the amount of curvature at each individual B-Spline control point. This allows you
to create sharper curves using fewer control points, even creating corners at a single
point, if necessary.

The easiest way to adjust B-Spline point curvature is by Command-dragging the control
point. You can also switch among three preset degrees of curvature.
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To switch a B-Spline control point among three degrees of curvature
Do one of the following:

µ Command-click one or more selected B-Spline control points to switch between three
progressively sharper amounts of curvature.

Very Smooth B-Spline point Smooth B-Spline point Linear B-Spline point

µ Control-click a B-Spline point, then choose Very Smooth, Smooth, or Linear from the
shortcut menu.

You can also adjust B-Spline control points along a sliding scale by holding down the
Command key and dragging.

To adjust the amount of curvature in a B-Spline control point by dragging
µ Command-drag one or more selected B-Spline control points to make their curves

progressively sharper.

• Dragging away from the point makes the curve progressively sharper.

• Dragging toward the point makes the curve progressively looser.

Note: Once the handle appears, you can modify the curve without the Command key.
Drag the handle away from the point to make the curve sharper. Drag the handle toward
the point to make the curve looser.

If you later decide you don’t like the B-Spline curve adjustment you made, you can always
reset the degree of curvature by Command-clicking the point (or Control-clicking and
choosing an option from the shortcut menu) to revert it to the default curvature amount.

Using a Shape Outline as a Paint Stroke
You can convert a shape outline into a paint stroke by modifying the Brush Type in the
Inspector. Once a shape outline is assigned a different brush type, all of the paint stroke
parameters become available. You can modify and animate its brush parameters, as well
as apply the Sequence Paint behavior.

To convert an existing shape into an editable paint stroke
1 Select an existing shape.

2 In the Shape HUD or Style pane of the Shape tab, select the Outline checkbox.
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Modify any Outline parameter you want. In this example, the outline is widened and
colored orange.

Default circle shape with Outline checkbox 
deselected

Circle shape with Outline checkbox selected

Note: A line shape has no fill and is a paint stroke upon creation.

3 If you don’t want the shape filled, deselect the Fill checkbox in the Shape HUD or Inspector.

Note: Solid must be chosen from the Brush Type pop-up menu in the Style pane of the
Shape Inspector for the shape fill options to remain available.

Once Fill is deselected, the shape icon in the Layers tab becomes a paint stroke icon.

Paint stroke icon
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4 In the Style pane of the Shape tab, choose Airbrush from the Brush Type pop-up menu.

Once the Brush Type is changed to Airbrush (or Image), the following occurs:

• The stroke softens because it is using a soft brush type. A paint stroke is comprised of
dabs and the brush type is the source for the dabs. The brush profile can be modified
to vary opacity within the brush. You can apply a custom opacity gradient to the brush
profile.

• The Stroke pane becomes available. Use the Stroke pane to set the Stroke Color mode
and Brush Scale parameters, and to adjust various options.

• The Advanced pane becomes available. The Advanced pane contains a single group
of controls that allow the dabs of a paint stroke to be animated like particles. For more
information on Dynamics, see Advanced Pane Controls In the Inspector.

Note: When a paint stroke is created using the Paint Stroke tool in the Toolbar, additional
stylus parameters appear in the Advanced pane.

5 Use the controls in the Style, Stroke, and Advanced panes of the Shape Inspector to
modify or animate your paint stroke.
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For a complete description of these parameters, see Style Pane Controls in the Inspector,
Stroke Pane Controls in the Inspector, and Advanced Pane Controls In the Inspector. In
the example below, the Additive Blend parameter is enabled in the Style pane. Additionally,
the Color Over Stroke, Spacing Over Stroke, Width Over Stroke, Brush Scale, and Brush
Scale Randomness parameters are modified in the Stroke pane.

Adding Shapes from the Library
The Shapes category in the Library contains pre-drawn shapes that can be added to a
project. Once a shape is added to a project from the Library, the shape can be edited.

To add a shape to a project from the Library
1 In the Library, select the Shapes category.

2 Do one of the following:

• Select a shape, then click Apply in the Preview area.

• Drag a shape from the Library into the Canvas, Layers tab, or Timeline tab.

The shape is added to the project and can be modified. For information on editing shapes,
see How to Edit Shapes.

Shape Parameters
The Shape tab in the Inspector appears when you select a shape in the Canvas, Layers
tab, or Timeline. This tab contains the Style, Stroke, Advanced, and Geometry panes. These
panes contain parameters that let you further customize the shape.

Style Pane Controls in the Inspector
The Shape tab’s Style pane contains controls to modify the fill and outline of a shape,
including changing the brush type for an outline or paint stroke. The parameters are
grouped into two main categories of controls: Fill and Outline.

Style Pane Parameters
The Style pane is available for all shapes and paint strokes.
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Shape Style: This pop-up menu allows you to apply a preset shape style (from the Shape
Styles category in the Library) to the selected shape. In addition to the preset styles, any
custom styles you have saved to the Library also appear in this list.

Fill: By default, this checkbox is selected for new closed shapes, which are filled with the
color specified in the Fill Color controls. The Fill parameters allow you to modify the fill
of a shape. For complete instructions on using the Gradient editor, see Gradient Controls.

• Fill Mode: This pop-up menu sets how a shape is filled. There are two options:

• Color: When this option is selected, the Fill Color controls appear and allow you to
pick a color to fill the shape. Fill opacity allows you to set the opacity of the fill.

• Gradient: When this command is selected, the Gradient editor appears, as well as
the Gradient preset pop-up menu. The Gradient preset pop-up menu allows you to
apply a preset gradient (from the Gradients category in the Library) to the selected
shape. In addition to the preset gradients, any custom gradients you have saved to
the Library also appear in this list. Click the disclosure triangle to the left to display
the Gradient editor, which you can use to create your own custom color and opacity
gradients. For more information on using the Gradient editor, see Gradient Controls.
The controls for the Gradient editor are identical to the gradient controls for text,
with one exception. The text gradient parameters include a dial to control the angle
of the gradient. The shape gradient parameters use Start and End point controls,
which are available in the Inspector or in the onscreen controls.

Gradient preset pop-up 
menu

• Fill Color: These controls, available when Fill Mode is set to color, let you pick a color
fill for the shape. For more information on using the color controls, see Color Controls.

• Fill Opacity: This slider, available when Fill Mode is set to Color, adjusts the opacity of
the fill (independently of the outline, if enabled).

• Feather: A slider that feathers (softens) the edges of a shape. Positive feathering values
soften the edge of the shape from its edge outward. Negative feathering values soften
the edge of a shape inward from the edge.
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Note: You cannot feather an object when the Outline checkbox is selected.

Feathered out Feathered in
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Outline: When this checkbox is selected, the shape outline appears in the Canvas and
the outline controls become available. By default, this checkbox is deselected for closed
shapes and on for open shapes and paint strokes. When you select the Outline checkbox,
the Brush Type, Brush Color, Brush Opacity, Width, First and Last Point Offsets, Order, and
other controls become available.

No outline With outline

• Brush Type: This pop-up menu lets you choose a Solid, Airbrush, or Image brush to
create the outline.

• Solid: The default setting. Creates a solid outline along the shape spline or paint
stroke.

• Airbrush: Creates an outline made up of editable brush strokes referred to as dabs.
You can set the dabs to be close together so that the line appears solid, or you can
space the dabs further apart. When Brush Type is set to Airbrush, the Stroke and
Advanced panes become available in the Shape Inspector.
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• Image: Allows you to use a layer as a dab source. When Brush Type is set to Image,
the Stroke and Advanced panes become available in the Shape Inspector.

• Brush Color: Lets you pick a color to use for the outline or paint dabs. These color
controls are identical to the shape Fill Color controls (and all color controls throughout
Motion).

Note: When Stroke Color Mode (in the Stroke pane) is set to Color Over Stroke or Pick
From Color Range, Brush Color is not available.

• Brush Opacity: Defines the opacity of the entire stroke, regardless of the Brush Type
setting.

Note: When Stroke Color Mode (in the Stroke pane) is set to Color Over Stroke or Pick
From Color Range, the Brush Color and Brush Opacity parameters are unavailable. When
Stroke Color Mode (in the Stroke pane) is set to Use Brush Color, you can adjust the
opacity, in the Stroke pane, to change over the course of the stroke. For more
information on using the Opacity Over Stroke parameter, see Stroke Pane Controls in
the Inspector.

The Brush Opacity control allows you to define a different opacity value for a shape
and its outline.

Outline opacity set to 50%Outline opacity set to 100%

• Brush Source: When Image is the selected Brush Type, drag a layer into the Brush Source
image well for use as the outline’s brush source. You can use images, image sequences,
QuickTime movies, text, and shapes as the brush source.
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When a movie or image sequence is the brush source, additional parameters appear.
For more about Movie or image sequence parameters, see Additional Parameters When
Brush Source Is a QuickTime Movie or Image Sequence.

• Brush Profile: Available when Airbrush is the selected Brush Type, this gradient editor
allows you to create varying levels of opacity within the brush. The brush profile uses
the same opacity controls as a standard gradient editor. For more information, see
Gradient Controls.

The default gradient 
creates a soft airbrush.

Modify the Brush Profile opacity gradient to create new brush looks.

• Width: A slider that changes the width of a shape’s outline or width of a paint stroke’s
dabs. On paint strokes, width adjustments will alter the size of the dab while also
maintaining the spacing between each dab.

Note: If you used the pressure parameters in the Paint Stroke Tool HUD to create
variations in the stroke when the stroke was created, adjusting the Width parameter
affects the width of the stroke uniformly.

• Preserve Width: When this checkbox is selected, the defined width of the outline/stroke
does not change when the shape is scaled. This option is only available when Solid is
the selected Brush Type.
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• Joint: When Solid is the selected Brush Type, this pop-up menu lets you choose how
hard corners on a shape’s outline are drawn. There are three options:

• Square: All corners are squared off.

Square Joints

• Round: All corners are rounded.

Round joints

• Bevel: All corners are cut at an angle.

Beveled joints
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• Start Cap: Pop-up menu that lets you choose the shape of an open outline’s start cap
(the shape of the edge of an outline). This option is only available when Solid is the
selected Brush Type.

There are five options:

• None: The stroke ends at the control point.

• Square: The cap is squared off.

• Round: The cap is rounded.

• Bevel: The cap is cut at an angle.

• Arrow: The cap is a customizable arrow. When Arrow is selected from the Start Cap
or End Cap pop-up menus, the Arrow Length and Arrow Width sliders appear.

• End Cap: Pop-up menus that let you choose the shape of an outline’s end cap. This
option is only available when Solid is the selected Brush Type.

There are five options:

• None: The stroke ends at the control point.

• Square: The cap is squared off.

• Round: The cap is rounded.

• Bevel: The cap is cut at an angle.

• Arrow: The cap is a customizable arrow. When Arrow is selected from the Start Cap
or End Cap pop-up menus, the Arrow Length and Arrow Width sliders appear.

• Spacing: Available for the Airbrush and Image brush types, this parameter defines the
space in between dabs. A lower number creates a more solid line, and a higher number
creates a greater distance in between dabs.

• Additive Blend: By default, dabs are composited together using the Normal blend mode.
Select this checkbox to composite all overlapping dabs together using the Additive
blend mode. This blend mode occurs in addition to whichever compositing method
is already being used on the paint stroke. This checkbox is only available when Brush
Type is set to Airbrush or Image.

• Reverse Stacking: Available when Brush Type is set to Airbrush or Image, this parameter
inverts the order in which the dabs are stacked. To see the effect of this parameter,
dabs must be overlapping.

• First Point Offset: This parameter allows you to offset and animate the start point of the
outline. This is very useful for effects such as drawing a line across a map over time.

You can also use the Shape Write On behaviors to draw a stroke or outline over time.
For more information, see Write On.

• Last Point Offset: This parameter allows you to offset and animate the end point of the
outline.
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• Order: A pop-up menu lets you choose whether an outline is drawn over or under the
shape fill color or gradient. The effect is more apparent with thicker outline widths.

• Over Fill: Outlines appear on top of the selected fill of the shape.

Over Fill

• Under FIll: Outlines are obscured beneath the selected fill of the shape.

Under Fill

Additional Parameters When Brush Source Is a QuickTime Movie or
Image Sequence
A collection of additional settings appear when the Brush Source is set to a multi-frame
object such as a QuickTime movie or Image sequence.

Play Frames: A checkbox that controls playback. If the checkbox is selected, it loops the
playback of the animation or movie clip. If it’s deselected, the paint dabs use the still
frame specified by either the Random Start Frame parameter or the Source Start Frame
parameter.
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Random Start Frame: A checkbox that introduces variation to image brush strokes using
multi-frame source objects. If the checkbox is selected, each dab will pull from a random
frame in the source. The dab will either start animating from this random frame or remain
still depending on whether the Play Frames checkbox is selected or deselected. This
pattern of randomness can be adjusted by using the Random Seed button under the
Stroke Pane.

Source Start Frame: Click the Source Start Frame disclosure triangle to display a mini-curve
editor that allows you to define the frame at which playback of the source clip begins in
the paint dabs. The Source Start Frame default keyframe value is 0, at which playback
starts from frame 1. You can simply change the start frame for all dabs, or you can create
a curve so that start frames vary over the length of the stroke (different dabs use different
start frames). For example, if the first Source Start Frame value is 50, each dab begins
playback at frame 50. If you create an animation curve that begins at 50 and ends at 250,
each dab begins clip playback at a progressively later frame.

The Play Frames checkbox must be selected in order for playback to occur. If Play Frames
is deselected, you can display different still frames over the length of the stroke. This
parameter only appears if Random Start Frame is deselected.

Note: For information on using the mini-curve editor, see Mini-Curve Editor.

When you click the Source Start Frame disclosure triangle, the Stroke Length and Source
Start Frame parameters become available.

• Source Start: Use the sliders or enter a number into the value field to change the value
of the selected keyframe in the mini-curve editor.

• Stroke Length: Stroke Length is mapped horizontally on the mini-curve editor graph
and provides a visual representation of the position of the changes in start frame value
(keyframes) over the length of the stroke. Use the sliders or enter a number into the
value field to change the value of the selected keyframe.

Hold Frames: Sets the number of times each frame of the source movie is repeated
during playback. The larger the Hold Frames value, the slower your playback.

Hold Frames Randomness: Varies the number of frames to “hold.”
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Stroke Pane Controls in the Inspector
Once an airbrush or image paint stroke has been created using the Paint Stroke tool, a
set of paint stroke controls becomes available, combining controls similar to those of a
particle system or replicator. Use these controls to set the Stroke Color Mode and Brush
Scale parameters, and to adjust the Opacity, Spacing, Width, and Angle Over Stroke
parameters.

Stroke Pane Parameters
The Stroke pane becomes available when Airbrush or Image is selected from the Brush
Type pop-up menu in the Style pane.

Stroke Color Mode: Use this pop-up menu to specify how the color is applied to the
stroke over its length. There are three options:

• Use Brush Color: Uses the color of the brush as defined by the Brush Color parameter
in the Style pane. The stroke is a solid color over its length. When you choose Use Brush
Color from the Stroke Color Mode pop-up menu, the Opacity Over Stroke control
becomes available.

• Color Over Stroke: Dabs are tinted based on their position over the length of the paint
stroke. When you choose this option, the Color Over Stroke control becomes available.

• Pick From Color Range: Dabs are tinted at random, with the range of possible colors
defined by a gradient editor. A point on the gradient is randomly chosen, so the relative
sizes of each color region determine the frequency of the color being used.
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Opacity Over Stroke: An opacity control that appears when Stroke Color Mode is set to
Use Brush Color. Use it to change the opacity of dabs based on their location on the
stroke. This gradient control is limited to grayscale values, which are used to represent
varying levels of transparency. White represents solid dabs, progressively darker levels of
gray represent decreasing opacity, and black represents complete transparency. A simple
white-to-black gradient represents a stroke that is solid at its start, but that fades out
gradually over its length until finally vanishing at the end. For information on using the
gradient editor, see Gradient Controls.

Gradient preset
pop-up menu

Use the gradient preset pop-up menu to load a custom opacity gradient into the gradient
editor.

Note: None of the default gradients have opacity gradients. If a color gradient preset is
selected, it has no effect on the opacity gradient.

Color Over Stroke: A gradient editor defining the range of color of the stroke, beginning
with the leftmost color in the gradient, and progressing through the range of colors until
reaching the rightmost color at the end of the stroke. Gradual color changes do not
appear in each dab, only across the stroke as a whole. An opacity bar appears at the top
of the gradient editor. For information on using gradient editors, see Gradient Controls.
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Color Range: A gradient editor that appears when the Stroke Color Mode is set to Pick
From Color Range. Use it to define a range of colors used to randomly tint the stroke’s
paint dabs. The direction of the gradient colors is not relevant, only the number of colors
that appear within the gradient. The Color Range parameter has the same controls as the
Color Over Stroke parameter. For information on using gradient editors, see Gradient
Controls.

Color Repetitions: When you choose Color Over Stroke from the Stroke Color Mode
pop-up menu, the Color Repetitions parameter becomes available. Drag this slider to
increase the number of times the gradient is repeated over the stroke.

Spacing Over Stroke: This mini-curve editor allows you to customize the spacing of the
dabs over the length of the stroke. You can create a curve that gradually increases the
dabs’ spacing over the length of the stroke, create a curve that varies the dabs’ spacing
over the length of the stroke, and so on. Select or add a keyframe in the graph to make
changes to the Spacing Over Stroke and Stroke Length parameters.

In the following illustrations, the default Spacing Over Stroke value of 100% in the
mini-curve editor creates an even distribution of the dabs—based on the value set in the
Spacing parameter in the Style pane. For more on using the mini-curve editor, see
Mini-Curve Editor.
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In the following illustrations, the Spacing Over Stroke curve in the mini-curve editor is
adjusted so that a greater value is used at the start of the stroke, and 100% is used at the
end of the stroke. The dabs at the beginning of the stroke are spaced more widely apart
and get closer at the end of the stroke.

Two controls let you fine-tune the curve in the graph:

• Spacing Over Stroke: Use the sliders or enter a number in the value field to change the
value of the selected keyframe.

• Stroke Length: Stroke Length is mapped horizontally on the mini-curve editor graph
and provides a visual representation of the position of the changes in spacing value
(keyframes) over the length of the stroke. Use the sliders or enter a number in the value
field to change the value of the selected keyframe.

Note: For information on using the mini-curve editor, see Mini-Curve Editor.

Fixed Brush Dabs: When animating brush strokes using behaviors or keyframes, selecting
the Fixed Brush Dabs checkbox keeps the number and spacing of the dabs constant
regardless of the changes in the stroke’s shape over time. The effect of this parameter is
not visible when editing a paint stroke on a single frame.

Anchor Dabs To: This pop-up menu, available when the Fixed Brush Dabs checkbox is
deselected, defines how dabs are added to or removed from a paint stroke when the
length of the paint stroke is modified. When the Fixed Brush Dabs checkbox is selected,
dabs are anchored to the start and end of the paint stroke. There are two options:

• Start: Adds dabs to or removes dabs from the start point of a paint stroke when the
length of the paint stroke is modified. The first dab on the stroke remains fixed.

• Start and End: Adds dabs to or removes dabs from the start and end points of a paint
stroke when the length of the paint stroke is modified. The first and last dabs on the
stroke remain fixed.

Note: Changing a shape’s control points or adjusting the Width or Spacing parameters
(in the Style pane) or Spacing Over Stroke and Width Over Stroke parameters (in the
Stroke pane) affect the dab spacing because larger dabs can be spaced further apart.

1118 Chapter 17 Using Shapes, Masks, and Paint Strokes



Width Over Stroke: This mini-curve editor allows you to customize the width of the dabs
over the length of the stroke. You can create a curve that gradually increases the dabs’
width over the length of the stroke, create a curve that varies the dabs’ width over the
length of the stroke, and so on. Select or add a keyframe in the graph to make changes
to the Width Over Stroke and Stroke Length parameters. The start value for the dab width
is based on the value set in the Width parameter in the Style pane. For more on using
the mini-curve editor, see Mini-Curve Editor.

Two controls let you fine-tune the curve in the graph:

• Width Over Stroke: Use the sliders or enter a number in the value field to change the
value of the selected keyframe.
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• Stroke Length: Stroke Length is mapped horizontally on the mini-curve editor graph
and provides a visual representation of the position of the changes in width value
(keyframes) over the length of the stroke. Use the sliders or enter a number in the value
field to change the value of the selected keyframe.

The Width Over Stroke parameter can be adjusted directly on the selected paint stroke
in the Canvas. For more information, see Using the Width Over Stroke Onscreen Controls.

Brush Scale: A slider and value field that allow you to change the size of the brush (the
source of the dabs). Click the disclosure triangle to adjust the X and Y scale values
independently. By default, Scale is set to 100%—the size of the dabs is equal to the size
of the source brush. Unlike the width parameter in the style tab, brush scale adjustments
only affect the size of the dabs and don’t preserve the spacing between dabs.

Brush Scale Randomness: Defines an amount of variance in the scale of the stroke’s
brush. A value of 0 results in no variance—all dabs in the stroke are the same size. A value
greater than 0 introduces a variance. The scale for an individual dab is defined by the
Scale parameter, plus or minus a random value falling within the Brush Scale, Width Over
Stroke, and Width (in the Style pane) parameters. Click the disclosure triangle to adjust
the X and Y values independently.

Align Brush Angle: When this checkbox is selected, the stroke dabs automatically rotate
to match the shape on which they are positioned.
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Brush Angle: Specifies (in degrees) the rotation of the stroke dabs. Using the default dial
or value slider modifies the Z angle. When the Local 3D checkbox is selected, additional
Brush Angle Randomness controls become available. Click the disclosure triangle to
expose X, Y, and Z rotation dials and the Animate pop-up menu.

• Animate: Available when the Local 3D checkbox is selected, this pop-up menu allows
you to change the interpolation for animated 3D rotation channels. Click the Brush
Angle disclosure triangle to display the Animate parameter. By default, Animate is set
to Use Rotation.

• Use Rotation: The default interpolation method. Pattern elements rotate from their
start rotation to their final rotation. Depending on the animation, the elements may
twist this way and that before reaching their final orientation (the last keyframed
value). For example, if the X, Y, and Z angle parameters are animated from 0 degrees
to 180 degrees in a project, the elements rotate on all axes before reaching their final
orientation.

• Use Orientation: This alternate interpolation method provides for smoother
interpolation but does not allow multiple revolutions. It interpolates between the
pattern elements’ start orientation (first keyframe) to their end orientation (second
keyframe).

Angle Over Stroke: This mini-curve editor allows you to customize the Z rotation (in
degrees) of the dabs over the length of the stroke. You can create a curve that gradually
increases the dabs’ angle over the length of the stroke, a curve that varies the dabs’ angle
over the length of the stroke, and so on. Select or add a keyframe in the graph to make
changes using the Angle Over Stroke and Stroke Length controls.

• Angle Over Stroke: Use the dial or value slider to change the value of the selected
keyframe.

• Stroke Length: Stroke Length is mapped horizontally on the mini-curve editor graph
and provides a visual representation of the position of the changes in angle value
(keyframes) over the length of the stroke. Use the sliders or enter a number in the value
field to change the value of the selected keyframe.

Brush Angle Randomness: Defines an amount of variance in the rotation of the stroke
dabs. A value of 0 results in no variance—all dabs have the same rotational value. A value
greater than 0 introduces a variance. The angle for an individual dab is defined by the
Brush Angle and Angle Over Stroke parameters, plus or minus a random value falling
within the Brush Angle Randomness.
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Using the default dial or value slider modifies the Z angle. To individually modify the
rotation of the dabs in X, Y, and Z space, or to access the Animate parameter, click the
disclosure triangle when the Local 3D checkbox is selected.

• Animate: Available only when the Local 3D checkbox is selected, this pop-up menu
allows you to change the interpolation for animated 3D rotation channels. Click the
Brush Angle Randomness disclosure triangle to display the Animate parameter. By
default, Animate is set to Use Rotation.

• Use Rotation: The default interpolation method. Pattern elements rotate from their
start rotation to their final rotation. Depending on the animation, the elements may
twist this way and that before reaching their final orientation (the last keyframed
value). For example, if the X, Y, and Z Angle parameters are animated from 0 degrees
to 180 degrees in a project, the elements rotate on all axes before reaching their final
orientation.

• Use Orientation: This alternate interpolation method provides for smoother
interpolation but does not allow multiple revolutions. It interpolates between the
pattern elements’ start orientation (first keyframe) to their end orientation (second
keyframe).

Local 3D: This checkbox allows you to take advantage of the Motion 3D workspace. When
the Local 3D checkbox is selected, the following become possible:

• When the Face Camera checkbox is selected, paint dabs actively face the camera when
the camera or stroke is rotated and/or animated.

• When the Dab Depth Ordered checkbox is deselected, dab ordering remains consistent
when the paint stroke (or the camera) is rotated in X or Y space. When this checkbox
is selected, the dabs jump in front of each other each time the stroke rotates
180 degrees. In other words, this checkbox draws the dabs in the stroke according to
each dab’s actual 3D position in the project. Dabs that are closer to the camera appear
closer; dabs that are farther away from the camera appear more distant.

• When the Dynamics checkbox is selected in the Advanced pane, a paint stroke acts
similarly to an emitter—the dabs become particles. When the Local 3D checkbox is
selected, the dabs are animated in 3D space. When the Local 3D checkbox is deselected,
the particles are animated in X and Y space only. For more information on Dynamics,
see Advanced Pane Controls In the Inspector.

• When the Dynamics checkbox is selected in the Advanced pane, dabs can be pulled
out of their plane when certain Simulation behaviors are applied. For example, if a paint
stroke has an applied Attracted To behavior (with the Affect Subobjects checkbox
selected), and the target layer is in a different location in Z space, the dabs are pulled
into Z space and move toward the target layer. The paint stroke must be a member of
a 3D group to be pulled out of the X and Y planes by a behavior.
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Use the following guidelines when working in 3D with paint strokes:

• Even in a 2D project, a paint stroke’s general properties can be adjusted in 3D space.
For example, you can modify the Z parameter using the Position, Scale, Rotation,
and Anchor Point controls in the Properties tab of the Inspector.

• Paint strokes do not receive reflections (controlled in the Properties tab of the
Inspector) unless the Local 3D checkbox is deselected.

• Paint strokes do not cast shadows (controlled in the Properties tab of the Inspector)
unless the Local 3D checkbox is deselected.

• Lighting does not effect paint strokes unless the Local 3D checkbox is deselected.

Important: Although the Local 3D checkbox is selected, paint strokes do not intersect
with the “global” 3D world. This means that paint strokes can exist in 3D space, but do
not intersect with objects that exist inside their own group, or objects in other groups.
A 3D paint stroke is composited with the rest of the objects in the project based on layer
order.

Face Camera: Available only when the Local 3D checkbox is selected, the stroke dabs
actively face the camera if the camera is rotated or if the paint stroke is rotated and/or
animated when this checkbox is selected. When the Face Camera checkbox is deselected,
the elements face forward in the replicator pattern and appear flat (unless the source
layer or paint dabs are rotated in 3D space).

Because paint source dabs are 2D (flat) objects, the pattern elements are not visible when
you use the orthogonal camera views, such as Left, Right, and Top (unless the source
layer or dabs are rotated in 3D space). This is because orthogonal views are at right angles
(perpendicular) to the elements. For more information on using cameras, see Cameras.

Dab Depth Ordered: Available only when the Local 3D checkbox is selected, paint dab
ordering remains consistent when the paint stroke is rotated in X or Y space when this
checkbox is selected. When not selected, the dabs jump in front of each other each time
the stroke rotates 180 degrees.

Jitter: This slider and value field allow you to create a little chaos in your paint dabs. The
higher the value, the more dispersed the dabs. Click the disclosure triangle to display the
individual X and Y controls. Jitter can be animated so that the dabs behave like particles.

• Jitter: Moves the dabs both parallel and perpendicular to the stroke’s curves at its
control points.

• X: Moves the dabs parallel to the stroke’s curves at its control points.

• Y: Moves the dabs perpendicular to the stroke’s curves at its control points.
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Jitter Over Stroke: This mini-curve editor allows you to customize the scatter of the dabs
over the length of the stroke. You can create a curve that gradually increases the dabs’
jitter over the length of the stroke, a curve that varies the dabs’ jitter over the length of
the stroke, and so on. Select or add a keyframe in the graph to make changes using the
Jitter Over Stroke and Stroke Length controls.

• Jitter Over Stroke: This parameter is divided into two channels. Click the disclosure
triangle to display the individual X and Y controls. Use the X parameter to adjust
keyframes that define the amount of dab movement parallel to the stroke’s curve at
certain points along the stroke (red curve). Use the Y parameter to adjust keyframes
that define the amount of dab movement perpendicular to the stroke’s curve at certain
points along the stroke (green curve). Use the Jitter Over Stroke parameter to adjust
the amount of dab movement in both directions at certain points along the curve
(adjusts red and green curve simultaneously).

• Stroke Length: Stroke Length is mapped horizontally on the mini-curve editor graph
and provides a visual representation of the position of the changes in jitter value
(keyframes) over the length of the stroke. Use the sliders or enter a number in the value
field to change the value of the selected keyframe. For more on using the mini-curve
editor, see Mini-Curve Editor.

Random Seed: The variation of the Jitter, Brush Angle Randomness, and Brush Scale
Randomness parameters (in the Stroke pane) and the Life, Speed, and Spin Randomness
parameters (in the Advanced pane) are based on the number shown here. If you don’t
like the current random distribution of the dabs, you can change the seed number by
typing a new number or clicking Generate. The Jitter value must be 1 or more for this
parameter to have any effect.

Using the Width Over Stroke Onscreen Controls
The Width Over Stroke control can be manipulated using the mini-curve editor, or you
can adjust its keyframe values directly in the Canvas. An editable control appears at each
keyframe in the stroke.
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To use the onscreen Width Over Stroke controls
1 In the Canvas, Control-click the paint stroke, then choose Stroke from the shortcut menu.

Small control points (+) appear at each keyframe along the red spline.

2 Click the control point that represents the keyframe you want to adjust.

Control handles appear on either side of the control point.

3 To increase the width of the dabs, drag away from the point; to decrease the width of
the dabs, drag toward the point.

4 To change the position of a width keyframe, drag the control point left or right to move
it along the length of the stroke. (Keyframes can be dragged over one another.)

The mini-curve editor is updated as you make your onscreen adjustments.

5 To add width keyframes, double click or option-click on the red spline.

6 To delete width keyframes, select the keyframe and press Delete.

Advanced Pane Controls In the Inspector
The Advanced pane of the Shape tab contains controls that allow the dabs of a paint
stroke to be animated like particles. Unlike particles, dabs are only “born” one time; but
they can age and die like particles. Dynamic dabs share several controls with particles,
such as Emission Angle, Life, Speed, and Spin. When the Dynamics checkbox is deselected,
dabs are immortal.

When you select a shape created with the Paint Stroke tool, Pen Pressure and Pen Speed
controls appear in the Advanced pane.

Note: All of the Dynamics controls can be animated using keyframes or by applying
Parameter behaviors to the individual parameters.

Advanced Pane Parameters
The Advanced pane becomes available when Airbrush or Image is selected from the Brush
Type pop-up menu in the Style pane.

Dynamics: When this checkbox is selected, the dabs of a paint stroke become particles.
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Note: When a Simulation behavior is applied to a paint stroke, the Affect Subobjects
parameter only appears in the behavior if Dynamics is selected for the paint stroke. Click
the disclosure triangle to reveal the following additional Dynamics controls:

Emission Angle: A dial and value slider that set the direction in which the paint dabs
travel. This parameter works in conjunction with the Emission Range parameter.

Emission Range: A dial and value slider that restrict the area in which the dabs travel, in
the direction of the Emission Angle. Setting the Emission Range parameter to 0 degrees
keeps dabs perpendicular to the paint stroke.

Life: A slider that defines the duration of each dab, in seconds. This specifies how long
each dab lasts before disappearing—similar to how sparks disappear after flying away
from a sparkler.

Life Randomness: A slider and value field that define an amount of variance in the life
of the paint dabs. A value of 0 results in no variance—all dabs from the selected stroke
share the same life span. A value greater than 0 introduces a variance defined by the Life
parameter, plus or minus a random value falling within the Life Randomness value.

Speed: A slider and value field that defines initial speed, determining how quickly each
dab flies away from the stroke.

Speed Randomness: A slider and value field that define an amount of variance in the
speed of the paint dabs. A value of 0 results in no variance—all dabs from the selected
stroke move with the same speed. A value greater than 0 introduces a variance defined
by the Speed parameter, plus or minus a predetermined random value falling within the
Speed Randomness value.

Spin: A dial and value slider that animate the dabs of a paint stroke by initially spinning
each individual dab around its center. Adjustments to this control are in degrees per
second.

Spin Randomness: A dial and value slider that define an amount of variance in the spin
of the paint dabs. A value of 0 results in no variance—all dabs from the selected stroke
spin at the same rate. A value greater than 0 introduces a variance defined by the Spin
parameter, plus or minus a random value falling within the Spin Randomness value.

Pen Pressure: Allows you to affect the width, opacity, spacing, angle, or jitter of the paint
stroke based on the pressure of your stylus on the tablet when the stroke was created.
This parameter appears when you do any of the following:

• create a paint stroke using the Paint Stroke tool in the Toolbar

• apply a shape style from the Shape Style pop-up menu to an existing paint stroke

Note: Only strokes drawn using a stylus and tablet will have recorded pressure variations.
You can select how the pressure of the stylus affects the stroke either in the Paint Tool
HUD before the stroke is created or afterwards by activating this parameter in the
Advanced Pane.
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These controls are identical to the Apply Pen Pressure (Shape behavior) parameters. For
a description of the Pen Pressure parameters, see Shape Behaviors. The inspector
parameters can be used in combination with these shape behaviors to affect more than
one parameter (such as Opacity, Width, or Jitter) of the stroke using the same pressure
data.

Pen Speed: Allows you to affect the width, opacity, spacing, angle, or jitter of the paint
stroke based on the speed of your stylus on the tablet or the speed of your mouse when
the stroke was created. This parameter only appears when you do any of the following:

• create a paint stroke using the Paint Stroke tool in the Toolbar

• apply a shape style from the Shape Style pop-up menu to an existing paint stroke

These controls are identical to the Apply Pen Speed (Shape behavior) parameters. For a
description of the Pen Speed parameters, see Shape Behaviors. The inspector parameters
can be used in combination with these shape behaviors to affect more than one parameter
(such as Opacity, Width, or Jitter) of the stroke using the same pressure data.

Geometry Pane Controls in the Inspector
The Shape Inspector’s Geometry pane controls allow you to change the shape type, to
close or open a shape, and to individually adjust the position of a shape’s control points
using value sliders.

Geometry Pane Parameters
The Geometry pane controls are available for all shapes regardless of what is selected in
the Brush Type pop-up menu in the Style pane.

You can change a shape’s type at any time. Changing a shape’s type changes its form.
For example, a single set of control points produces the following three shapes, depending
on the selected Shape Type.

Linear shape Bezier shape B-Spline shape

Shape Type: Use this pop-up menu to change the type of control points that are used
to define the shape. For example, if you originally created a Bezier shape, you can choose
B-Spline from this menu to change each Bezier control point into a B-Spline control point.
Changing the shape type does not move the control points, although the shape is
changed, sometimes dramatically. There are three options:

• Linear: All control points are joined by hard angles, and the resulting shape is a polygon.
The control points of a Linear shape lie directly on its edge.
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• Bezier: Control points can be a mix of Bezier curves and hard angles, creating any sort
of shape. The control points of a Bezier shape lie directly on its edge.

• B-Spline: Control points are all B-Spline points, with different degrees of curvature.
B-Spline control points lie inside, outside, or on the edge of the shape, and are
connected by the B-Spline frame.

Note: To show or hide the display of the B-Spline frame, choose View > Overlays >
Lines.

Closed: If you select an open shape, this checkbox is deselected. Turning this checkbox
on connects the first and last points of an open shape. If you select a closed shape, this
checkbox is selected. Turning this checkbox off disconnects the first and last points,
converting the object into an open shape.

Roundness: Controls the roundness of the corners of a shape. This facilitates the creation
of round rectangles, as well as generally smoothing the edges of any shape.

Preserve Scale: This checkbox controls whether the Roundness setting is absolute, or
relative to the overall shape size. When this parameter is enabled, the roundness will
remain at the same approximate percentage of curvature as the object is scaled. When
it is disabled, the curvature will vary as the overall shape changes size.

Control Points: Click the disclosure triangle to display the position parameters for the
shape control points. Use the value sliders to adjust the position of a control point.

The Control Points parameter also contains an Animation menu, which allows you to add
keyframes, reset the shape’s animation, display the animation curve in the Keyframe
Editor, and so on. For more information on using the Animation menu, see Animation
Menu.

Shape Controls in the HUD
Once a shape or paint stroke is created and selected, the Shape HUD appears.

Note: Like all other layers, you can adjust the overall opacity of a shape (with its outline)
in the Properties tab of the Inspector.
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Shape HUD Parameters
A shape or completed paint stroke must be selected to display the Shape HUD. If the
HUD does not appear, press F7 or D.

Additional parameters appear in the HUD along with the standard Opacity, Blend Mode,
and Drop Shadow controls. For more information on these standard parameters, see
Parameters in the Properties Tab.

Fill: Select this checkbox to enable the shape fill. When selected, you can choose the fill
color using the adjacent color controls.

Outline: Select this checkbox to turn on an outline for the shape. When Outline is on,
you can select the outline color in the adjacent color well.

Width: Sets the width of the shape’s outline in pixels.

Feather: Drag this slider to feather (soften) the edges of a shape. Positive feathering
values soften the edge of the shape from its edge outward. Negative feathering values
soften the edge of a shape inward.

Note: You cannot feather a shape when the Outline checkbox is selected.

Roundness: Controls the roundness of the corners of a shape. This facilitates the creation
of round rectangles, as well as generally smoothing the edges of any shape.

Shape Style: Choose an option from this pop-up menu to apply a preset shape style
(from the Library) to the selected shape.

Creating Illustrations Using Multiple Shapes
You can use groups of shapes to create more detailed shapes and even complete
illustrations. For example, the following illustration was created using nested groups of
Bezier shapes.

It is important to understand that it’s not necessary to create every part of an illustration
with a single shape. Most of the time it is easier, and sometimes essential, to use multiple
overlapping shapes to create different parts of an illustration.
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For example, the face in the illustration above uses a gradient, but the eyes are a different
solid color. This is only possible using two shapes.

Organizing Objects Used in Multi-Shape Illustrations
You can arrange related layers in a project into groups. When you create illustrations
using multiple shapes, it is helpful to take advantage of the organizational tools in Motion
by grouping shape layers together. In the example above, the objects that make up the
illustration are grouped by category: The shapes that comprise the face are contained in
the “face” group, the shapes that form the right eye are contained in the “right eye” group,
and so on.

Each of these groups can in turn be nested inside a larger enveloping group that can be
used to transform or animate the entire illustration.

Within each group, you can use the Bring and Send commands in the Object menu to
reorder objects, controlling which layers are in front of others. By nesting layers that
belong together within the same group, you gain the ability to control the ordering of
each shape group relative to one another. For example, spiky locks of hair should cascade
over anime eyes, and not the other way around.

For more information on controlling group and layer hierarchies, see Reorganizing in the
Layers Tab. For more information on using the Bring and Send commands, see
Arrangement Commands in the Object Menu.
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Locking Layers and Shapes While Editing Illustrations
You can lock layers and shapes that are behind the shapes you’re drawing and editing
in the foreground to avoid accidentally selecting and modifying the wrong one. Layers
and shapes can be locked and unlocked at any time. To lock a layer or shape, use the lock
icons in the Layers tab or Timeline layers list.

Using Object Alignment
While arranging groups of shapes to create more complex illustrations, you can use the
Alignment commands in the Object menu. For more information on using object
alignment, see Using Object Alignment Commands.

Creating Holes and Transparency in Shapes
There are several ways you can create holes and transparency within shapes. You can use
the Opacity, Blend Mode, and Preserve Opacity parameters in the Properties tab to modify
a shape’s overall transparency.

Shapes with multiple blend modes

For more information on using object blending parameters, see Blend Modes.
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You can use one or more masks to punch holes inside shapes using the mask drawing
tools. You can also apply image masks to a shape, which allow you to use any object to
define transparency. For more information on using masks and image masks, see Using
Masks to Create Transparency.

Shape with a mask set to SubtractOriginal shape

Applying Filters to Shapes
You can apply filters to shapes, just like any other layer. When you apply a filter to a shape,
it remains editable, even though the filter changes it from a vector-based object into a
bitmapped object in order to perform the operation.

Original shape Shape with filter applied

You can apply filters to individual shapes or to a group that contains a number of shapes.
You can use filters to stylize shapes far beyond the options that are available in the Shape
tab of the Inspector. More importantly, you can use filters in conjunction with the Shape
tab parameters to interactively customize a shape’s look, while preserving the ability to
re-edit the shape at any time.

1132 Chapter 17 Using Shapes, Masks, and Paint Strokes



Important: Once you apply a filter to a shape, you can no longer smoothly increase the
size of that shape using the object’s transform controls. This is because filters change
shapes from vector objects to bitmapped objects. As a result, they scale like other
bitmapped objects, which display artifacts if they’re enlarged too much.

For more information on using filters, see Using Filters.

Animating Shapes
You can animate shapes using both behaviors and keyframes. In addition to using Basic
Motion, Simulation, and Parameter behaviors, shapes have their own special category of
Shape behaviors. Shape behaviors allow you to oscillate, randomize, or wriggle the
individual control points of shapes, to write on a shape outline over time, or to apply
tracking data to the control points of a shape.

You can also modify a paint stroke created with the Paint Stroke tool (in the Toolbar)
based on how it was drawn with the stylus. For example, you can apply the Apply Pen
Pressure behavior to a paint stroke in your project and map the pressure used in drawing
the stroke to opacity. The resulting stroke appears more opaque in the segments where
you pressed hardest when drawing that stroke.

Basic Motion and Simulation behaviors animate multiple parameters of a shape, such as
Position, Rotation, and Scale. Applying behaviors to shapes works the same as with any
layer in Motion, and keyframed animation of any of these parameters is stored in the
Keyframe Editor.

For more information on using Basic Motion, Parameter, and Simulation behaviors, see
Using Behaviors.

Shape Behaviors
Shape behaviors are specifically designed to be applied to shapes created within Motion.
After drawing a stroke or other shape, apply a Shape behavior to wriggle, oscillate, or
randomize a shape’s control points or to map pen pressure to various paint stroke
characteristics.

Apply Pen Pressure
This behavior is designed to be applied to a paint stroke created using a stylus and
graphics tablet. Once a stroke is created, this behavior allows you to affect the width,
opacity, spacing, angle, or jitter of the paint stroke based on the pressure of your stylus
on the tablet when the stroke was created.
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Note: These parameters are identical to the Pen Pressure parameters in the Advanced
Pane of the inspector. You can choose to use either the Advanced Pane parameters or
this shape behavior to apply the pressure data to the paint stroke. A combination of Pen
Pressure parameters in the Advanced Pane and Apply Pen Pressure shape behaviors can
be used to affect more than one parameter (such as Opacity, Width, or Jitter) of the stroke
using the same pressure data.

Parameters in the Inspector
Apply To: Use this pop-up menu to select how your paint stroke is affected by pen
pressure. There are five options:

• Width: Pen pressure affects the width of the stroke. The harder the pressure, the wider
the stroke.

• Opacity: Pen pressure affects the opacity of the stroke. The harder the pressure, the
more opaque the stroke.

• Spacing: The harder the pressure, the greater the spacing in between the dabs of the
stroke.

• Angle: The harder the pressure, the greater the angle of the stroke dabs.

• Jitter: The harder the pressure, the larger the amount of jitter on the stroke. Jitter
randomizes the position of the paint dabs so that they appear more like particles.

Min Pressure: Adjusts the minimum threshold of pressure sensitivity. Pressure values
below the minimum value are remapped to 0. For Opacity and Width, those remapped
values do not appear. For Spacing, Angle, and Jitter, the values will not be modified. If
the Min and Max pressure are plotted on a graph, Min Pressure represents the minimum
value, or 0. The area of the graph between Min and Max is remapped to the output values.

Max Pressure: Adjusts the maximum threshold of pressure sensitivity. Pressure values
above the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, and
Jitter, those values will have the greatest effect. If the Min and Max pressures are plotted
on a graph, Max Pressure represents the maximum value, or 1. The area of the graph
between Min and Max is remapped to the output values.

Scale: Determines the magnitude of the effect. Defines the output range for the dabs
based on the mapped values between minimum (0) and maximum (1) pressure, multiplied
by the value defined in the slider (or value field). This amount is then applied to the
parameter (width, opacity, and so on) by multiplying (for width, opacity, spacing, and
jitter) or adding (for angle). This control is independent of the Scale parameter in the
Stroke pane.

Invert: This checkbox inverts the attributes of the stroke created by the behavior. For
example, if pen pressure is set to affect the opacity of the stroke, transparent areas of the
stroke become more opaque and opaque areas become more transparent when the
checkbox is selected.
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HUD Controls
The parameters in the HUD are identical to the parameters in the Inspector.

Apply Pen Speed
When using a stylus or mouse to create paint strokes, this behavior allows you to affect
the width, opacity, spacing, angle, or jitter of the paint stroke based on the speed of your
pen strokes.

Note: A paint stroke created by using a mouse can be affected by the Apply Pen Speed
behavior.

The parameters in the HUD are identical to the parameters in the Inspector.

Note: In the Paint Stroke Tool HUD, you can select how the speed of the stylus affects
the stroke before the stroke is created. Applying the Pen Speed behavior allows you to
affect more than one parameter (such as Opacity, Width, or Jitter) of the stroke using the
same pressure data. The Pen Speed parameter also appears in the Advanced pane of the
Shape Inspector.

Parameters in the Inspector
Apply To: Use this pop-up menu to select how your paint stroke is affected by pen speed.
There are five options:

• Width: The quicker you move the pen, the more narrow the stroke; the slower you
move the pen, the wider the stroke.

• Opacity: Pen speed affects the opacity of the stroke. The faster you move the pen, the
less opaque the stroke.

• Spacing: The faster you move the pen, the greater the spacing in between the dabs of
the stroke.

• Angle: The faster the movement of the pen, the greater the angle of the stroke dabs.

• Jitter: The faster the movement of the pen, the larger the amount of jitter on the stroke.
Jitter randomizes the position of the paint dabs so they appear more like particles.

Min Speed: Adjusts the minimum threshold of speed sensitivity. Speed values below the
minimum value are remapped to 0. For Opacity and Width, those values do not appear.
For Spacing, Angle, and Jitter, the values will not be modified. If the Min and Max speeds
are plotted on a graph, Min Speed represents the minimum value, or 0. The area of the
graph between Min and Max is remapped to the output values.

Max Speed: Adjusts the maximum threshold of speed sensitivity. Speed values above
the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, and Jitter,
those values will have the greatest effect. If the Min and Max speeds are plotted on a
graph, Max Speed represents the maximum value, or 1. The area of the graph between
Min and Max is remapped to the output values.
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Scale: Determines the magnitude of the effect. Defines the output range for the dabs
based on the mapped values between minimum (0) and maximum (1) speed, multiplied
by the value defined in the slider (or value field). This amount is then applied to the
channel (width, opacity, and so on) by multiplying (for width, opacity, spacing, and jitter)
or adding (for angle). This control is independent of the Scale parameter in the Stroke
pane.

Invert: This checkbox inverts the attributes of the stroke created by the behavior. For
example, if pen speed is set to affect the width of the stroke, thin areas of the stroke
become wide and wide areas become thin when the checkbox is selected.

HUD Controls
The parameters in the HUD are identical to the parameters in the Inspector.

Apply Pen Tilt
When you are using a stylus to create paint strokes using the paint stroke tool, this
behavior allows you to affect the width, opacity, spacing, angle, or jitter of the paint stroke
based on the tilt of the pen while creating strokes.

Note: A combination of Apply Pen Tilt shape behaviors can be used to affect more than
one parameter (such as Opacity, Width, or Jitter) of the stroke using the same tilt data.

Parameters in the Inspector
Apply To: Use this pop-up menu to select how your paint stroke is affected by the tilt of
your pen as you draw. There are five options:

• Width: The tilt of the stylus affects the width of the stroke. The greater the tilt, the wider
the stroke.

• Opacity: The tilt of the stylus affects the opacity of the stroke. The greater the tilt, the
more opaque the stroke.

• Spacing: The greater the tilt of the stylus, the greater the spacing in between the dabs
of the stroke.

• Angle: The greater the tilt of the stylus, the larger the value of the angle of the stroke.

• Jitter: The greater the tilt of the stylus, the larger the amount of jitter on the stroke.
Jitter randomizes the position of the paint dabs so they appear more like particles.

Calculate Tilt: The pen tilt is measured on two axes: X and Y. X represents the stylus
tilting to the right and left (toward the right or left side of the tablet); Y represents the
stylus tilting up and down (toward the top or bottom of the tablet). Use this pop-up menu
to select how the tilt of the stylus affects the stroke. There are five options:

• Absolute: Takes the maximum tilt from any axis.

• X Only: Measures the tilt only on the X axis.

• Y Only: Measures the tilt only on the Y axis.
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• Axis: When Axis is chosen from the Calculate Tilt pop-up menu, the Tilt Axis parameter
becomes available.

• Polar: Uses the tilt of the stylus as if it were an angle. When viewed from above, the
stylus points in a certain direction. That angle represents a polar value.

Tilt Axis: A dial and value slider that becomes available when Calculate Tilt is set to Axis.
This parameter allows you to define the axis along which the tilt is measured.

Min Tilt: Adjusts the minimum threshold of tilt sensitivity. Tilt values below the minimum
value are remapped to 0. For Opacity and Width, those remapped values do not appear.
For Spacing, Angle, and Jitter, the values will not be modified. If the Min and Max tilt are
plotted on a graph, Min Tilt represents the minimum value, or 0. The area of the graph
between Min and Max is remapped to the output values.

Max Tilt: Adjusts the maximum threshold of tilt sensitivity. Tilt values above the maximum
value are remapped to 1. For Opacity, Width, Spacing, Angle, and Jitter, those values will
have the greatest effect. If the Min and Max tilt are plotted on a graph, Max Tilt represents
the maximum value, or 1. The area of the graph between Min and Max is remapped to
the output values.

Scale: Determines the magnitude of the effect. Defines the output range for the dabs
based on the mapped values between minimum (0) and maximum (1) tilt, multiplied by
the value defined in the slider (or value field). This amount is then applied to the parameter
(width, opacity, and so on) by multiplying (for width, opacity, spacing, and jitter) or adding
(for angle). This control is independent of the Scale parameter in the Stroke pane.

Invert: This checkbox inverts the attributes of the stroke created by the behavior. For
example, if pen tilt is set to affect the width of the stroke, thin areas of the stroke become
wide and wide areas become thin when the checkbox is selected.

HUD Controls
The parameters in the HUD are identical to the parameters in the Inspector.

Oscillate Shape
The Oscillate Shape behavior animates a shape by cycling its control points between two
different values. You can customize how wide apart the high and low values are, as well
as the number of oscillations per minute. This behavior is useful for creating fluid shape
movements (think shape yoga) that would be time-consuming to keyframe.

When the Oscillate Shape behavior is applied to a shape, all control points of the shape
are affected by default. When the behavior is selected in the Layers tab, affected control
points are highlighted in white on the blue shape behavior spline. To disable one or more
control points, click the control points. A disabled point appears blue. Drag to select
multiple control points.
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Parameters in the Inspector
Wave Shape: A pop-up menu that lets you select the shape of the oscillation’s wave. The
options are Sine (default), Square, Sawtooth, and Triangle. For more information on wave
shapes, see Oscillate.

Phase: A slider that lets you adjust the point of the specified oscillation at which the
behavior starts. This parameter allows you to put multiple shapes with identical Oscillate
behaviors out of phase with one another so that they don’t all look the same.

Amplitude: A slider that lets you adjust the maximum values that the control points
oscillate between. The control point swings between the amplitude value, and the negative
of the amplitude value. Higher values result in more extreme swings from the beginning
to the ending of each oscillation.

Speed: A slider that lets you adjust the speed at which the oscillation occurs, in oscillations
per minute. Higher values result in faster oscillations.

Alternate Phase: When this checkbox is selected, the motion of each control point is
offset by a phase of 180 degrees from its neighboring control point.

Oscillate Around: This pop-up menu allows you to define whether the oscillation for
each vertex is generated from a point or a perpendicular line.

• Point Origin: Each vertex’s oscillation is generated from a point. You can change the
location of the point using the onscreen controls (dragging the small blue circle at the
center of the shape) or using the X and Y Origin parameters in the Inspector.

The shape oscillates 
around the location of 
the point.

The point’s origin can
be animated to create
a more varied oscillation 
effect.

1138 Chapter 17 Using Shapes, Masks, and Paint Strokes



• Line: Each vertex’s oscillation is generated from a line. You can change the location of
the line using the onscreen controls (dragging the ends of the blue dotted line) or
using the using the Start and End coordinates in the Inspector.

Use the onscreen start 
and end points to 
change the position of 
the line.

HUD Controls
The Oscillate Shape HUD contains the Wave Shape, Phase, Amplitude, Speed, and Alternate
Phase parameters.

Randomize Shape
The Randomize Shape behavior allows you to animate the control points of a shape by
applying a random offset to each point of the shape. This behavior is useful for creating
rapid and varied effects on a shape.
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When the Randomize Shape behavior is applied to a shape, all control points of the shape
are affected by default. When the behavior is selected in the Layers tab, affected control
points are highlighted in white on the blue shape behavior spline. To disable one or more
control points, click the control points. A disabled point appears blue. Drag to select
multiple control points.

The white control point is 
enabled and affected by 
the behavior.

The blue control points 
are disabled and not 
affected by the behavior.

Parameters in the Inspector
Amount/Multiplier: This parameter is set to Amount when the Apply Mode is set to Add,
Subtract, or Add and Subtract; it is set to Multiplier when the Apply Mode is set to Multiply.
This parameter defines the maximum value the Randomize behavior will generate.

Apply To: A pop-up menu that defines whether the behavior is applied to the shape’s
control points, tangent handles, or both points and handles.

• Points: The control points of the shape are randomized, changing their position over
the duration of the behavior.

• Tangents: The control points’ tangent handles (rather than the control points) of the
shape are randomized. The control points stay in a fixed position while the curves in
between the points are animated.

• Points and Tangents: Both the control points and handles are animated.

Apply Mode: A pop-up menu that determines how values generated by this behavior
are combined with other behaviors and keyframes that affect the same parameter. This
provides you with different ways of using a Randomize behavior to modify a vertex’s
preexisting values. There are four options:

• Add: Values generated by this behavior are added to other behaviors and keyframes
that affect the same parameter.

• Subtract: Values generated by this behavior are subtracted from other behaviors and
keyframes that affect the same parameter.

• Multiply: Values generated by this behavior are multiplied by other behaviors and
keyframes that affect the same parameter.
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• Add and Subtract: Values generated by this behavior are added to and subtracted from
other behaviors and keyframes that affect the same parameter.

Frequency: A slider that lets you adjust the amount of random variation per second.
Higher values generate faster variations, whereas lower values generate slower variations.

Noisiness: A slider that adds an additional overlay of random variance to the Frequency
you’ve set. Higher Noisiness values result in more erratic variations in the affected
parameter.

Link: This parameter appears when you apply this behavior to a two-dimensional
parameter (such as Shear) or three-dimensional parameter (such as Position or Rotation)
that consists of X, Y, and/or Z values. Turn this checkbox on to keep the behavior’s effect
on each value proportional.

Preserve Angle: When this checkbox is selected, the tangent handles become (or remain)
flat, maintaining the continuity of the curves.

Random Seed: A button that lets you pick a new random seed number. This number is
used to randomly generate new sequences of values, based on the other parameters of
this behavior.

HUD Controls
The Randomize Shape HUD contains the Amount, Multiplier, Apply To, Frequency,
Noisiness, Link, and Preserve Angle parameters.

Sequence Paint
The Sequence Paint behavior allows you to animate the individual dabs of a paint stroke
in sequence over time. This is the only way to animate the dabs individually—keyframing
the stroke parameters or applying other behaviors affects all dabs in the stroke uniformly.
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The Sequence Paint behavior is very similar to the Sequence Text and Sequence Replicator
behaviors, which allow you to animate the Rotation, Color, Opacity, Scale, and Position
parameters in sequence through the characters of a text layer or the elements of a
replicator pattern. The Sequence Paint behavior adds Width to that list of parameters,
allowing you to create sequenced animation through the dabs of a paint stroke.

For an example of using a sequence behavior, see Using the Sequence Replicator Behavior.

Parameters in the Inspector
Sequence Paint: A checkbox that turns sequencing on or off. Before any sequencing
animation can occur, you must explicitly add at least one parameter to the behavior from
within the Inspector, and then set a value for that parameter. Until a parameter is added,
adjustments in the Inspector or HUD have no effect.

Parameter: Use the Add and Remove Parameter pop-up menus to add and remove
parameters to the sequence. Once the parameter is added, additional controls appear in
the Behaviors tab of the Inspector. Adjust those controls to create a sequence animation
based on the difference between the original value of the dabs and the modified value.
There are six menu options and related controls:

• Rotation: Specifies (in degrees) the rotation of the stroke dabs. You can either rotate
the dial or use the value slider. Click the disclosure triangle next to the Rotation
parameter to reveal separate X, Y and Z Rotation controls.

• Color: Specifies a color to use to tint the stroke dabs. You can either click the color well
to choose a color, or open the disclosure triangle and use the Red, Green, and Blue
sliders or value fields.

• Opacity: Defines the opacity of the stroke dabs. Set a new value using the slider.

• Scale: Defines the scale of the stroke dabs. Click the disclosure triangle next to the Scale
parameter to reveal separate X Scaling and Y Scaling subparameters, which can be
used to scale the width and height of the dabs separately. By default, Scale is set to
100%—the size of the stroke dabs is equal to the original size defined in the stroke
parameters.

• Width: Defines the width of the dabs. Unlike Scale, Width adjustments will alter the
size of the dab while also maintaining the spacing between each dab. Set a new value
using the slider.
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• Position: Defines the offset of the dabs from their original position. Click the disclosure
triangle next to the Position parameter to reveal separate X, Y, and Z Position
subparameters. For example, to create an animation in which the dabs move upward
in the Y axis over the paint stroke, enter a positive value in the Y Position field.

Sequence Control: These parameters contain controls that allow you to modify the way
the animation moves through the paint stroke, such as changing the direction of the
animation.

Sequencing: A pop-up menu that Specifies how the sequence animation—the value
change from the original parameter value to the value set in the Sequence Paint
parameters—moves through the dabs of the stroke. The starting point for the sequence
animation is based on the first control point of the paint stroke. There are five options:

Note: To change the start point of the shape, select the shape, click the Select/Transform
tool and, holding down the mouse button, choose the Adjust Control Points tool from
the shortcut menu. Then Control-click a control point and choose Set Start Point from
the shortcut menu.

• To: Specifies that the animation begins at the original value of the dabs and moves to
the value set in the Sequence Paint behavior for that parameter. For example, if the
original opacity value of a stroke is 100%, and opacity is set to 0% in the Sequence
Paint parameters, the dabs begin completely opaque and become completely
transparent.

• From: Specifies that the animation moves from the value set in the Sequence Paint
behavior to the original value of the stroke. For example, if the original opacity value
of a stroke is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs
begin completely transparent and become completely opaque. This is the opposite of
the To Sequencing option.

• Through: Specifies that the sequence goes through a full animation cycle starting at
the original value of the stroke, moves to the value set in the Sequence Paint behavior,
and then returns to the original value of the stroke. For example, if the original opacity
value of a stroke dab is 100%, and opacity is set to 0% in the Sequence Paint parameters,
the dabs begin completely opaque, become transparent, and then become completely
opaque again.

• Through Inverted: Specifies that the sequence goes through an inverted animation cycle
starting from the value set in the Sequence Paint behavior, moving to the original value
of the stroke, and then returning to the value set in the Sequence Paint behavior. For
example, if the original opacity value of a stroke is 100%, and opacity is set to 0% in
the Sequence Paint parameters, the dabs begin completely transparent, become opaque,
and then become completely transparent. This is the opposite of the Through option.
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• Custom: Allows you to keyframe how the animation moves through the values set in
the Sequence Paint parameters over a stroke. Each dab undergoes the same value
sequence. When Custom is selected, added parameters must be animated to yield any
effect.

Unit Size: A pop-up menu that specifies whether the sequence animation is applied to
the stroke as a whole, to its individual dabs, or to a custom range.

• Dab: Applies the sequence animation over each dab as its own entity. Dab is the default
setting.

• All: Applies the sequence animation to all stroke dabs simultaneously.

• Custom: Allows you to specify the percentage of dabs on the stroke that are affected
by the sequence animation at once. Although you can create keyframes for the Custom
option, it is not required in order to affect the sequence. Custom allows you to define
an area of dabs (based on percentage) that are affected by the sequence.

Start: Available when Unit Size is set to Custom, this parameter allows you to specify the
starting point for the dabs on the stroke (based on percentage) that is affected by the
animation.

End: Available when Unit Size is set to Custom, this parameter allows you to specify the
ending point for the dabs on the stroke (based on percentage) that is affected by the
animation

Spread: To create a softer transition between dabs, increase the Spread value using the
slider or value slider. (This parameter is not available when Unit Size is set to All.)

Traversal: A pop-up menu that sets the action of the sequence behavior to Constant
Speed, Ease In, Ease Out, Ease In/Out, Accelerate, Decelerate, or Custom.

• Constant Speed: Moves the animation from the origin of the paint stroke through the
end of the stroke at a constant speed.

• Ease In: The sequence animation begins slowly and increases to normal speed as it
moves through the paint stroke.

• Ease Out: The sequence animation begins at normal speed and slows toward the end
of the paint stroke.

• Ease In/Out: The sequence animation begins slowly, increases to normal speed as it
moves toward the middle of the stroke, and slows as it reaches the end of the paint
stroke.

• Accelerate: The sequence animation increases in speed.

• Decelerate: The sequence animation decreases in speed.

• Custom: Allows you to keyframe how the animation moves through the paint stroke.
When you choose Custom from the Traversal pop-up menu, the Location parameter
replaces the Loops parameter.
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Loops: Sets the number of times the animation sequences through the paint stroke over
its duration.

Note: Loops is not available when the Traversal parameter is set to Custom.

Location: Available only when Custom is selected from the Traversal pop-up menu, this
slider defines the location of the stroke where the animation is in effect.

For more information on using the Custom Traversal option, see Using the Sequence
Replicator Custom Traversal Option.

End Condition: A pop-up menu that determines how the sequence animation is repeated
over the duration of the sequence behavior. This parameter has no effect for Loop values
less than or equal to 1. The End Condition options are:

• Hold: Completes the sequence animation cycle one time, then starts it over again from
the beginning (once the last dab in the sequence has completed its animation).

• Wrap: Treats the sequence animation as a continuous loop so the spread wraps from
the last dab in the sequence to the first dab.

• Ping Pong: Completes the sequence animation cycle forward, then completes the
animation backward, then forward, and so on.

HUD Controls
The Sequence Paint HUD contains the Sequencing, Unit Size, Spread, Traversal, Loops,
and End Condition parameters.

Track Points
This behavior allows you to either track the control points of a shape or mask to a moving
clip or animated object, or to apply existing tracking data to a shape or mask. For
information on using the Track Points behavior, see Shape Track Points Behavior.
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Wriggle Shape
This behavior works similarly to the Randomize behavior, but with a slower effect (think
of a shape that’s had one too many espressos before dance class).

When the Wriggle Shape behavior is applied to a shape, all control points of the shape
are affected by default. When the behavior is selected in the Layers tab, affected control
points are highlighted in white on the blue shape behavior spline. To disable one or more
control points, click the control points. A disabled point appears blue. Drag to select
multiple control points.

Parameters in the Inspector
Amount/Multiplier: This parameter is set to Amount when the Apply Mode is set to Add,
Subtract, Add and Subtract; it is set to Multiplier when the Apply Mode is set to Multiply.
This slider defines the maximum value the Wriggle behavior generates.

Apply To: A pop-up menu that defines whether the behavior is applied to the shape’s
control points, tangent handles, or both points and handles.

• Points: The control points of the shape are wriggled, changing their position over the
duration of the behavior.

• Tangents: The control points’ tangent handles (rather than the control points) are
wriggled. The control points stay in a fixed position while the curves in between the
points are animated.

• Points and Tangents: Both the control points and tangent handles are animated.

Apply Mode: A pop-up menu that determines how values generated by this behavior
are combined with other behaviors and keyframes that affect the same parameter. This
provides you with different ways of using a Wriggle behavior to modify a vertex’s
preexisting values. There are four options:

• Add: Values generated by this behavior are added to other behaviors and keyframes
that affect the same parameter.

• Subtract: Values generated by this behavior are subtracted from other behaviors and
keyframes that affect the same parameter.

• Multiply: Values generated by this behavior are multiplied by other behaviors and
keyframes that affect the same parameter.
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• Add and Subtract: Values generated by this behavior are added to and subtracted from
other behaviors and keyframes that affect the same parameter.

Frequency: A slider that lets you adjust the amount of random variation per second.
Higher values generate faster variations, whereas lower values generate slower variations.

Wriggle Offset: A slider that allows you to offset the sequence of random values when
you want to apply the same Wriggle behavior to multiple shapes. By offsetting each
shape’s version of the Wriggle behavior, you can prevent them from moving in sync.

Noisiness: This slider adds an additional overlay of random variance to the Frequency
you’ve set. Higher Noisiness values result in more erratic variations in the affected vertices.

Link: This parameter appears when you apply this behavior to a two-dimensional
parameter (such as Shear) or three-dimensional parameter (such as Position or Rotation)
that consists of X, Y, and/or Z values. Turn this checkbox on to keep the behavior’s effect
on each value proportional.

Preserve Angle: When this checkbox is selected, the tangent handles become (or remain)
flat, maintaining the continuity of the curves.

Random Seed: A button that lets you pick a new random seed number. This number is
used to randomly generate new sequences of values, based on the other parameters of
this behavior.

HUD Controls
The Wriggle Shape HUD contains the Amount, Multiplier, Apply To, Frequency, Wriggle
Offset, Noisiness, Link, and Preserve Angle parameters.

Write On
The Write On behavior provides a quick way to draw a paint stroke or outline on the
Canvas over time. This allows you to create a handwritten text effect, create the
ever-popular old serial travel map effect, create a hand-sketched alpha mask for a transition
or reveal, create an animated graph for a business presentation, produce graphics to
prevent monitor burn-ins, and so on. The behavior can be automatically applied to a
paint stroke created with the Paint Stroke tool or added to an existing shape. You can
have the shape draw, erase, draw and erase, draw in reverse, and so on, over time.

When Write On is applied to a filled shape with an outline, only the outline of the shape
is drawn.

Note: You can manually animate the First Point Offset and Last Point Offset parameters
in the Style pane of the Shape Inspector to achieve the same effect as the Write On
behavior.
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Parameters in the Inspector
Shape Outline: This pop-up menu determines whether the stroke is drawn, erased, or
drawn and erased.

• Draw: Draws the stroke over the duration of the behavior.

• Erase: The stroke is completely drawn at the beginning of the behavior and is erased
over the duration of the behavior.

• Draw and Erase: The stroke is drawn, then erased over the duration of the behavior.

• Erase and Draw: The stroke is completely drawn at the beginning of the behavior, is
erased, then is drawn again.

Stroke Length: This slider defines the length, as a percentage, of the drawn or erased
stroke. A value of 100% uses the entire length of the stroke, bounded by the First Point
Offset and Last Point Offset parameters. If Stroke Length is set to 50%, once 50% of the
stroke is drawn on, it begins to erase (from the beginning of the stroke) so that only half
of the length of the stroke is ever displayed over the duration of the behavior.

Stroke Offset: This slider offsets where the stroke begins on the shape. The value is
expressed as a percentage of the total length of the shape from the start point defined
on the shape.

Direction: This pop-up menu sets the direction in which the stroke is drawn. There are
two options:

• Forward: The stroke is drawn in a forward direction.

• Reverse: The stroke is drawn in reverse.

Speed: A pop-up menu that defines the stroke’s “draw-on” velocity from the first to the
last point in the stroke. There are nine options:

• Constant: The stroke is drawn at a steady speed from the first to the last point in the
stroke.

• Ease In: The drawing of the stroke starts at a slow speed, then reaches and maintains
a steady speed through the last point on the stroke.

• Ease Out: The drawing of the stroke starts at a steady speed, then slows down as it
gradually decelerates to a stop at the last point of the stroke.

• Ease Both: The drawing of the stroke slowly accelerates from the first point on the
stroke, and then slows down as it gradually decelerates to a stop at the last point of
the stroke.

• Accelerate: The stroke is drawn with increasing speed.

• Decelerate: The stroke is drawn with decreasing speed.
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• Natural: The speed in which the stroke is drawn along the path is determined by the
shape of the path. For example, if the stroke is a U-shape curve, the stroke is drawn
along more quickly as it moves toward the low point of the U, and more slowly as it
moves up the edges.

• Recorded: This option only appears if there is a recorded time over which the stroke
was drawn. In other words, if a shape is converted to a paint stroke, this parameter
does not appear. If the paint stroke is created with the Paint Stroke tool in the Toolbar
(using a stylus or mouse), this option does appear.

• Custom: Custom allows you to draw the stroke along its path by setting keyframes for
the stroke’s speed from 0 to 100%. In other words, you determine what portion of the
stroke is drawn along its path in time.

Custom Speed: This parameter becomes available when Speed is set to Custom. You
can modify the Custom Speed velocity curve in the Keyframe Editor. For example, you
can keyframe custom values to draw a stroke forward to a specific percentage of its path,
then backward, then forward, and so on before it reaches the end of the animation.

End Offset: This slider offsets the end of the behavior inward from the defined Out point
and holds the last value. In other words, it offsets the visible paint stroke from the end
of the path of the stroke.

HUD Controls
The Write On HUD contains the Shape Outline, Stroke Length, Stroke Offset, Direction,
Speed, and Custom Speed parameters.

Creating Write On Paint Strokes
You can create a paint stroke that appears over the course of several frames by recording
the stroke as it is drawn, or you can apply the Write On behavior to an existing shape to
draw its outline on over time.

Creating a Write On Paint Stroke Using the Paint Stroke Tool
This section describes creating a “write-on” paint stroke using the Paint Stroke tool in the
Toolbar. To create a paint stroke that appears over the course of several frames, select
the Write On checkbox in the Paint Stroke Tool HUD. Once the stroke is created, additional
parameters become available in the Behaviors tab of the Inspector.

To paint a stroke over time
1 In the Toolbar, click the Paint Stroke tool (or press P).

The Paint Stroke Tool HUD appears. If the HUD does not appear, press F7 or D.

2 In the Tool HUD, select the Write On checkbox and select any other desired stroke settings.

3 In the Canvas, create your stroke.

4 Once the stroke is complete, press Esc to exit the paint mode.
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The Paint Stroke Tool HUD is replaced with the Shape HUD. In the Layers tab, a Write On
Shape behavior is automatically applied to the stroke. To modify the Write On parameters,
select the behavior and use the HUD or the Behaviors tab in the Inspector.

The speed at which the stroke is “painted” (including the duration it took to draw the
stroke) is mapped over the time extent (in frames) of the stroke. The faster a stroke is
drawn, the shorter the duration of the Write On behavior.

Note: If your Motion Project Preferences Create Layers At option is set to Current Frame,
the paint stroke is created at the current playhead position. If set to Start of Project, the
stroke is created at frame 1.

5 Play back your project. The stroke is “painted on” as the project plays.

6 To modify the speed at which the stroke is painted, adjust the duration of the behavior
in the Timeline or mini-Timeline.

You can also modify additional parameters, such as customizing the speed at which the
stroke is drawn, drawing on only a percentage of the stroke, offsetting the stroke, or
drawing the stroke in reverse. These parameters are available in the Write On behavior,
described above.

Creating a Write On Paint Stroke Using an Existing Shape
You can apply the Write On behavior to an existing shape to draw its outline over time.
Because the Write On behavior only affects outlines, Outline must be enabled in the
Shape parameters.

Note: When a Write On behavior is added to an existing shape, the behavior spans the
duration of the shape to which it is applied.

To create a write on stroke using an existing shape
1 Select the shape you want to use and select its Outline checkbox in the HUD or Shape

tab of the Inspector.

Note: You can leave the Fill checkbox selected, but only the outline is affected by the
Write On behavior.

2 In the Toolbar, click Add Behavior and choose Shape > Write On.

The Write On behavior appears in the Layers tab. If the playhead is located at the start of
the shape, the visual shape disappears and only the path is visible.
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3 Play the project (press the Space bar).

The outline is drawn over the length of the behavior.

4 To adjust the speed at which the stroke is painted, adjust the duration of the behavior
in the Timeline or mini-Timeline.

5 To adjust the properties of the stroke, use the Shape tab in the Inspector. For more
information, see Shape Parameters.

Keyframing Shape Animation
You can also keyframe a shape’s animation parameter to animate adjustments to its
individual control points. This opens up powerful animation possibilities, since you can
reform an entire shape using keyframe animation.

Shape Animation 
parameter

Shape Animation 
parameter keyframes

A series of corresponding keyframed shape changes

To keyframe a shape’s control points
1 Use the Adjust Control Points tool (in the Select/Transform Tool options) to select the

shape you want to animate.
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The shape’s control points appear in the Canvas. In this example, the selected shape is
the lower lip of the mouth illustration.

2 Enable Record (press A).

Record button

3 Move to the frame where you want to change the shape, then make any necessary
changes to the shape’s control points.

In the Keyframe Editor (and also in the Timeline, if the Show/Hide Keyframes button is
turned on), a keyframe appears for each adjustment you make at a new frame.

Note: Adjusting a shape while the playhead is on an already existing keyframe adjusts
the shape at that keyframe.

4 Continue advancing frames and making changes as needed.
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Every time you make a change to the shape at a new frame, you automatically create a
keyframe in that shape’s Shape Animation parameter.

5 When you are done animating the shape, disable Record.

The animated shape object interpolates between each keyframed shape. If you don’t like
how the interpolation is working, you can add more keyframes to force the control points
to follow the path you want.

Interpolated shapeFirst keyframe Second keyframe

You can also create, delete, and edit the timing of Shape Animation keyframes directly
in the Keyframe Editor. For simplicity, each change you make to a shape is recorded as a
single keyframe, no matter how many control points are edited. The Shape Animation
parameter only allows keyframes set to linear interpolation. You cannot use any other
form of keyframe interpolation.

The process used to animate both shapes and masks is identical. To see an example of
mask animation, see Keyframing a Mask’s Shape for Animation and Rotoscoping. For
more information on keyframing in general, see Keyframes and Curves.

Saving Shapes and Shape Styles
Like all objects in Motion, shapes and shape styles (a custom gradient fill and outline, for
example) can be saved to the Library. This allows you to add to the content that Motion
provides to create a library of your own custom objects and styles, including customized
behaviors and filters or whole project groups. Content you put into the Library is available
to every project in Motion.

Custom shapes (including masks) can be saved in the Shapes, Favorites, or Favorites Menu
categories of the Library. Custom shape styles, which are saved via the Shape Style pop-up
menu, are automatically saved in the Shape Styles category. You can create your own
folders within the Library categories or subcategories to better organize your effects.
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Each customized shape or shape style saved to the Library is saved as a separate file in
the Motion folder of the Application Support directory. For example, a saved custom
shape named “red heart” in the Shapes category of the Library appears in the
Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Shapes/
folder.

Items that are saved to the Library appear in the Finder with a .molo extension (“Motion
Library object”). These items cannot be opened from the Finder.

Saved Shape Positions
When you drag a custom shape from the Library to the Canvas, the center of the shape
is dropped at the location in which you release the mouse button. If you use the Apply
button in the Preview area to add the shape, the shape is added at the center of the
Canvas.

When you drag shapes that were saved with the “All in one file” option to the Canvas,
the shapes are dropped at the location in which you release the mouse button and are
positioned according to their arrangement when originally saved to the Library. If you
use the Apply button in the Preview area to add the shapes, the shapes are added at
the center of the Canvas.

When you drag a custom mask from the Library into a project, the mask retains the
position with which it was saved (relative to the image or footage on which it is dropped).

To save a shape to the Library
1 Open the Library and select the Favorites, Favorites Menu, or Shapes category.

2 Drag the shape you want to save from the Layers tab or Timeline layers list into the stack
at the bottom of the Library.

Shapes that are saved to the Favorites Menu category can be quickly added to a project
via the Favorites menu.

The saved custom shape appears in the Shapes category of the Library in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Shapes/
folder.

To save multiple shapes to the Library
1 Open the Library and select the Favorites, Favorites Menu, or Shapes category.

2 In the Layers tab, select all of the shapes you want to save, drag them to the stack, and
hold down the mouse button.
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3 When the drop menu appears, choose “All in one file” or “Multiple files.”

“All in one file” saves all the shapes together, and they are listed as one item in the Library.
“Multiple files” saves the shapes as individual objects in the Library.

4 To rename the file, do one of the following:

• Control-click the icon, choose Rename from the shortcut menu, then type a descriptive
name.

• Select the icon, click “current name,” then type a new descriptive name.

Note: When you Control-click the icon, the Edit Description option becomes available.
This is a handy tool that allows you to enter custom notes about an item saved in the
Library. Once you choose Edit Description, enter your notes in the text field and click OK.

To save a shape style to the Library
1 With the shape selected, choose Save Shape Style from the Shape Style pop-up menu in

the Style pane of the Shape Inspector (or in the Shape HUD).

2 Type a name for the style in the Save Preset to Library dialog and click Save (or press
Return).

The custom style is saved to the Library in the All subcategory of the Shape Styles category
by default. You can move the preset into an existing subcategory, or create your own
folders to organize your custom styles (see below).

When the style is selected in the Library stack, a preview is displayed in the Preview pane.
The new preset now appears in the Shape Style pop-up menu in the Style pane of the
Shape Inspector.

The saved custom shape style appears in the Shape Styles category of the Library in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/Shape
Styles/ folder.

To apply a shape style to a shape
Do one of the following:

µ With the shape selected, click the Style pane in the Shape Inspector (or in the Shape
HUD), then choose a style from the Shape Style pop-up menu.

µ Drag a shape style from the Library to a shape in the Canvas, Layers tab, or Timeline.

To create a new folder in a Library category
1 Open the Library and select the Shapes, Shape Styles, Favorites, or Favorites Menu

category.

2 Do one of the following:

• Click the New Folder button at the bottom of the window.
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• Control-click an empty area of the Library stack (the lower section of the Library) then
choose New Folder from the shortcut menu.

Note: You may have to expand your stack window or use icon view to access an empty
area.

The new untitled folder appears in the Library stack. The new folder does not appear
in the Library sidebar.

3 Double-click the name of the folder, type a new name, then press Return.

To create a new folder in a Library subcategory
1 Open the Library and select a subcategory, such as the Fauna subcategory of the Content

category.

2 Do one of the following:

• Click the New Folder button at the bottom of the window.

• Control-click an empty area of the Library stack (the lower section of the Library), then
choose New Folder from the shortcut menu.

Note: You may have to expand your stack window or use icon view to access an empty
area.

The new untitled folder appears in the Library stack. The new folder does not appear
in the Library sidebar.

3 Double-click the name of the folder, type a new name, then press Return.

To move a shape to a custom folder in a Library category
µ Drag the shape to the new folder in the Library sidebar.

The custom preset is added to the new folder and to the All subcategory.

To move a shape to a custom folder in a Library subcategory
µ Drag the shape to the new folder in the Library stack.

The custom preset is added to the new folder and to the All subcategory.

To move a shape style to a custom folder in a Library category
µ Once the new preset is saved via the Shape Style pop-up menu in the Style pane of the

Shape Inspector, drag the custom preset from the All subcategory in the Library stack to
the new folder in the Library sidebar.

The custom preset is added to the new folder.

Note: Because shape styles are saved via the Shape Style pop-up menu in the Style pane
of the Shape Inspector, they cannot be dragged directly to the Library.

To delete a custom shape or shape style
µ Control-click the custom item, then choose Move to Trash from the shortcut menu.
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To delete a custom folder from a subcategory in the Library stack
µ Control-click the folder in the Library stack, then choose Move to Trash from the shortcut

menu.

Note: You can also delete the folder from the Finder. The folder is stored in the
Users/username/Library/Application Support/Final Cut Studio/Motion/Library/ folder.

Important: Deleting a custom object or folder cannot be undone.

To delete a custom folder from a category in the Library sidebar
µ In the Finder, navigate to the Users/[username]/Library/Application

Support/Final Cut Studio/Motion/Library/ folder, Control-click the folder, then choose
Move to Trash from the shortcut menu.

Using Masks to Create Transparency
When you create a mask to define transparency within a layer, you’re drawing a shape
to use as that layer’s alpha channel. Because a layer’s alpha channel is a grayscale channel,
masks are grayscale objects, where white defines solid areas, progressively darker levels
of gray define decreasingly opaque areas, and black defines areas of complete
transparency. If you choose View > Channels > Alpha to set the Canvas to display the
alpha channel only, you can see the grayscale alpha channel directly.

Object alpha channelMasked object

Masks can be used with layers that already have an alpha channel, and can add to, subtract
from, intersect, or replace the layer’s original alpha channel.

Masking a Layer or Group
Use the mask tools to create different shapes with which to mask a layer or group. There
are five mask tools available that are analogous to the five shape drawing tools covered
earlier in this chapter:

• Rectangle Mask

• Circle Mask
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• Freehand Mask (used like the Paint Stroke tool)

• Bezier Mask

• B-Spline Mask

Note: You can also use an Image Mask to mask a layer. For more information, see Applying
Image Masks to a Layer.

Important: A mask cannot be applied to a nonflattened 3D group. (To flatten a 3D group,
select the Flatten checkbox in the Group tab of the Inspector.) A mask can be applied to
a layer within a 3D group. To add a mask to a layer that has been manipulated in 3D
space, use the Isolate button. Masks cannot be manipulated in 3D space. For example,
the Position parameter for a mask only includes the X and Y position parameters, but not
the Z position parameter; the Rotation parameter only includes Z, but not X or Y. For
more information, see Masking Objects in a 3D Project.

Drawing and editing masks using these tools works identically to drawing and editing
shapes. The main difference is that while drawing a shape creates a new layer in your
project, masks must be drawn on top of another layer in your project. Once drawn, masks
are nested within the specific layers or groups for which they were created, in the Layers
tab and Timeline. Once a mask is attached to a layer, a Masks icon appears to the right
of the name of the layer. Turn the mask display on or off by clicking this icon.

Click the Masks icon
to turn mask display
on or off.

Note: Masks created for one layer can be copied or moved to other layers.

Important: When a mask is applied to a 2D or flattened 3D group, the group is rasterized.
For more information, see Groups and Rasterization.
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To mask a layer
1 Select a layer in the Canvas or Layers tab.

2 Choose a mask drawing tool (the Rectangle Mask tool, the Circle Mask tool, the Freehand
Mask tool, the Bezier Mask tool, or the B-Spline Mask tool).

Note: If you haven’t selected a layer, the mask tools are not available.

3 Begin drawing the shape you need in order to mask the layer.

For more information about how to draw and edit shapes, see Shape and Mask Drawing
Tools.

4 When you’re done, you can finish the mask by doing one of the following:

• Click the first point to close the mask.

• Press C to close the mask, joining the first point you created to the last.

• Double-click to close the mask, joining the first point you created to the last.

• Press Return to close the mask, joining the first point you created to the last.
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• When using the Freehand Mask tool, join the end of the mask to the target circle at
the beginning of the mask. If you don’t reach the beginning of the mask, the mask
shape is automatically closed when you lift the stylus or release the mouse button.

Note: Unlike standard shapes, masks are always closed.

After you’ve finished drawing the mask, its effect is immediate, and the mask you created
appears nested underneath the layer to which it’s applied in the Layers tab and Timeline.

You can create multiple masks for a single layer. To add additional masks, select the object
again, then follow the above procedure. By default, all new masks are set to the Add
blend mode. You can change the Mask Blend Mode parameter in the Inspector to combine
masks for different effects. For more information about using multiple masks together,
see Combining Multiple Masks.

Masking Objects in a 3D Project
When working in a 3D project, you may want to mask a layer once it has been transformed
or the camera has been rotated. You can immediately switch a transformed object into
a “work view” using the Isolate button in the Layers tab or Timeline layers list, or the
Isolate command in the Object menu. Once a camera is added to a project, the Isolate
option is available for any layer, group, or camera in the project.

Note: Masks can be applied to the layers within a 3D group, but not the 3D group itself
(unless you’ve activated the Flatten checkbox in the Group tab of the Inspector). For more
information about the Flatten checkbox, see Mask Parameters.

1160 Chapter 17 Using Shapes, Masks, and Paint Strokes



To isolate a layer
1 In the 3D project, select the layer that you want to mask. In this example, the center

leopard image is the layer to be masked.

The Isolate button appears to the right of the layer name.

Note: A project must contain a camera in order to access the Isolate option.

2 Click the Isolate button or choose Object > Isolate.

Inactive Isolate button

Note: You can also Control-click the layer or group and choose Isolate from the shortcut
menu.

The layer is switched into “work view,” allowing you to mask the layer at its original
orientation.
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3 To return to your previous view (the view before you isolated the layer), click the Isolate
button again.

Active Isolate button

Note: Clicking a camera’s Isolate button activates that camera’s view.

Combining Multiple Masks
Often, you may find that it is impossible to create the mask shape you need using only
a single mask. For example, when masking something that has a hole in it, you need to
use at least two masks—one set to Add to mask the overall object, and a second one set
to Subtract to cut the necessary hole in the middle of it. In the following example, the
only way to mask the space between the diver’s arms and legs is to create three
overlapping masks set to Subtract.

Original object Three overlapping masks Final result

Other times, you may find that it’s simply more convenient to mask a complex object
using multiple masks. This is frequently the case when rotoscoping an object and
animating the masks. In this example, the dog’s head is masked with four different masks
set to Add—one for the head, one for each ear, and a separate mask for the mouth. This
makes it easier to make adjustments later on, especially when animating a mask to do
rotoscoping.

Original object Four overlapping masks End result
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Whatever the reason, you can easily combine multiple masks for any object by adjusting
each mask’s Mask Blend Mode parameter in the Inspector to create any combination.

Mask Blend Mode 
pop-up menu

Each mask’s blend mode determines whether the mask adds to, subtracts from, or replaces
a layer’s previously existing alpha channel. Additionally, blend modes affect how masks
interact with one another. Ultimately, every mask applied to a layer combines according
to the specified blend modes to create that layer’s final alpha channel. Mask Blend Modes
can be changed at any time.

Blend mode operations are also determined by the order in which each mask appears in
the Layers tab, particularly with the Replace and Intersect modes. For example, a mask
set to the Intersect mode masks out all other regions of a layer that do not overlap it. A
mask set to Intersect affects all masks nested underneath it. Masks added above it are
unaffected by this behavior.

Masks That Add and Subtract
New masks always default to the Add blend mode, allowing you to add to an existing
alpha channel without cropping what’s already there. Once you’ve drawn the first mask,
you may need to use additional masks set to Add or Subtract to refine it.

Masks set to Add create white areas in the alpha channel, making those parts of the object
opaque. This can be useful when masking several unconnected subjects in a single image.

Result of first mask Additional masks added to the first

Note: To display the rest of a masked layer so you can trace it to create a second mask,
turn off the first mask in either the Layers tab or Timeline. The outline of the first mask
remains visible, even though it’s no longer affecting the layer’s transparency.
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Predictably, masks set to Subtract have the opposite effect, creating black areas in the
layer’s alpha channel and making those parts of the object transparent. This is particularly
useful for cutting holes in an object.

Additional masks subtracted from the firstResult of first mask

Intersecting Masks
In many instances, you may find that you want to cut out parts of an object, while leaving
the rest of the object alone. Using a mask set to Intersect is a good way to do this.

For example, if you import a TIFF file with an alpha channel and you want to cut out part
of it without losing the alpha information that’s already there, the Intersect blend mode
is the only way to do this. This is also true for layers with keying filters applied.

Intersecting mask crops unwanted
opaque areas.

Original alpha channel from key

Replace Masks
A mask set to Replace completely replaces the previously existing alpha channel. It also
completely replaces all other masks appearing underneath it in the Layers tab. For this
reason, it is unlikely that any but the bottommost mask would be set to this blend mode.

Feathering Masks
One of the easiest ways to adjust a mask is to feather its edges. Feathering a mask by a
few pixels can make the masked object blend more seamlessly with a background.
Feathering a mask by larger amounts allows you to create progressively softer edges for
a variety of design purposes.
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You can feather mask edges either outward or inward. The direction in which you feather
a mask is dictated by the subject you’re masking. When rotoscoping a subject, a
combination of masks using both inward and outward feathered masks may be necessary
for the best results.

Feathered in (color channel) Feathered in (alpha channel)

Feathered out (color channel) Feathered out (alpha channel)

To feather the edge of a mask
1 Select a mask.

2 Open the Mask tab in the Inspector.

3 Do one of the following:

• Drag the Feather value slider to the right for a positive value to feather the mask
outward.

• Drag the Feather value slider to the left for a negative value to feather the mask inward.

Applying Filters to Masks
As with shapes, you can apply filters to masks, which remain editable even after the
application. Although uses for this technique might not be immediately obvious, it’s
actually an extremely powerful way to further manipulate the alpha channel created by
one or more masks.
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For example, you could apply the Crystallize filter to a mask to stylize its edges. This results
in jagged edges that resemble facets of crystal around the edges.

Original mask (color channel) Original mask (alpha channel)

Crystallize filter applied to alpha channel 
(color channel view)

Crystallize filter applied to alpha channel 
(alpha channel view)

When applying filters to masks, it’s useful to bear in mind that masks are just grayscale
images. In the example above, the Crystallize filter creates patterns in the grayscale mask
image, which results in a rippled translucent pattern.

To apply a filter to a mask
Do one of the following:

µ Drag a filter from the Library directly onto a mask in the Layers tab or Timeline.

µ Select a mask in the Layers tab or Timeline layers list, then choose a filter from the Add
Filter pop-up menu in the Toolbar.

The filter appears nested underneath the mask layer to which it’s applied.
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Applying Behaviors to Masks
You can apply behaviors directly to masks. When you apply a behavior to a mask, the
mask is animated like any other layer. However, since the mask only affects the
transparency within a layer, and not the position, rotation, or scale of the layer itself, the
result is similar to that of a “traveling matte,” where the mask moves within the layer to
which it’s applied, hiding and showing different areas of the image as it moves.

To apply a behavior to a mask
Do one of the following:

µ Drag a behavior from the Library directly onto a mask in the Layers tab or Timeline.

µ Select a mask in the Layers tab or Timeline, then choose a behavior from the Add Behavior
pop-up menu in the Toolbar.

The behavior appears nested underneath the mask to which it’s applied.

Keyframing a Mask’s Shape for Animation and Rotoscoping
You can keyframe a mask’s animation parameter to change its shape over time. This can
serve many purposes. For example, you can animate a subtractive mask to change the
shape of a hole in a foreground object, allowing other layers in the background to show
through.

A more conventional use of animated masks is to rotoscope a foreground subject.
Rotoscoping is the process of manually tracing a foreground subject in order to isolate
it from the background. The end result is similar to a blue screen or green screen effect.
Why would you bother? In a wide variety of situations, keying is either impractical or
impossible if the shot wasn’t well planned. Even for shots where keying is possible, manual
rotoscoping is often necessary to create garbage or holdout mattes to improve the effect.
(For more information on creating garbage and holdout mattes or masks using masks, see
Using Masks to Aid Keying Effects.)

All mask animation is stored in the Shape Animation parameter. It’s worth noting that
animated masks trigger the same motion blur as any other keyframed parameter in
Motion. For example, if you animate a layer’s position so that it moves really fast, the layer
is blurred when you enable motion blur. If you animate a layer’s mask so that it also moves
fast, the edges of the mask are blurred as well. This is important as an animated mask’s
blur should ideally match any blur that’s present in the foreground subject itself.

To rotoscope a subject by animating a mask
1 Choose View > Resolution > Full to ensure that you are viewing the Canvas at full

resolution.

Important: If the Canvas resolution is not set to full, the outlines of objects and images
may shift slightly. As a result, masks created to trace a subject at less than full resolution
may not be accurate.
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2 Move to the first frame where the mask animation should begin, then draw a mask that
accurately isolates the subject.

3 When you’re finished drawing the first mask, enable Record (press A).

Record button

4 Move to the first frame of the Timeline where you want to change the shape of the mask,
then make any necessary changes to its control points.

In this example, the best place to start when rotoscoping the dolphin is the frame in
which all the fins are showing.

Note: For some tips on rotoscoping, see Rotoscoping Tips.

When rotoscoping a moving subject, it’s a good idea to play through the clip and examine
its direction and speed to get a sense of how the mask needs to be animated. In particular,
you may find it helpful to place markers indicating frames where the subject or camera
stops, changes direction, or changes speed, since these are likely candidates for your first
pass of keyframed mask changes.
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By noting these changes, you can attempt to reduce the amount of keyframing by making
your first keyframed mask shape adjustments at these major changes in speed and
direction. Because animated masks are automatically interpolated to change from one
keyframed shape to another, you can let Motion do some of your work for you.

Note: If at any time the mask is deselected, you need to select the mask you’re working
on in the Layers tab so that its control points become visible in the Canvas. Make sure
that the Show Masks button is selected in the Layers tab so that masks are visible.

5 Continue moving the playhead and making changes as needed, since the interpolated
shape of the mask isn’t going to be perfect.

One imprecise rule of thumb is to move to the frame that’s halfway between any two
keyframed mask shapes and make new adjustments. Continue keyframing shape changes
at the halfway point between every two keyframes until the mask accurately follows the
motion of the subject. For irregularly shaped objects or objects with complex motion,
don’t be surprised if you need to add a large number of keyframes. Nobody ever said
that rotoscoping was fast!

Every time you move the playhead to a new frame and make a change to the mask’s
shape, a keyframe is automatically created in that shape’s Shape Animation parameter.
If you move the playhead directly on top of a previously existing keyframe, you change
the mask’s shape at that point without creating a new keyframe.

Shape Animation 
parameter

Shape Animation 
parameter keyframes

Note: You can also transform and shear masks as you would any other layer. If you move,
rotate, scale, shear, or change the anchor point for a mask while animation recording is
enabled, you add keyframes to additional channels in the Keyframe Editor.

6 When you’ve finished animating the mask, disable Record (press A).
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You can also create, delete, and edit the timing of a mask’s Shape Animation keyframes
directly in the Keyframe Editor. For simplicity, each change you make to a mask is recorded
as a single keyframe, no matter how many control points you edited. The Shape Animation
parameter only allows keyframes set to Constant—you cannot use any other form of
keyframe interpolation.

The process used to animate both masks and shapes is identical. To see an example of
shape animation, see Animating Shapes. For more information on keyframing in general,
see Keyframes and Curves.

Rotoscoping Tips
A good way to start rotoscoping an image is to find the frame with the most detail
showing in the subject you’re masking, and use that as your starting frame. For example,
if you’re masking someone walking, choose a frame where both that person’s arms and
legs are out in mid-stride. This allows you to decide how many control points you need
to start with. Using the minimum number of control points you can to achieve the
necessary level of detail in your mask makes it much easier to animate.

You should also bear in mind that it’s not always necessary to rotoscope an entire subject
with a single mask. Motion allows you to apply multiple masks to a single object, so
you can rotoscope different parts of a subject with separate masks. This can make your
job much easier. For example, if you’re rotoscoping someone carrying something while
walking across a room, you could use one mask for the upper part of the person’s body
which doesn’t change shape very much, and another two masks for the legs, which
change shape considerably as the person walks.

You can also use the Track Points behavior to apply tracking data to a shape or mask.
For more information on the Track Points behavior, see Shape Track Points Behavior.

Mask Parameters
A selected mask’s parameters appear in the Mask tab of the Inspector.

With the exception of the control points parameters, the parameters in the Mask HUD
are identical to the parameters in the Inspector.

Mask Controls in the Inspector
These controls allow you to adjust how the mask is drawn, how each mask operates upon
an object, and how masks are combined with one another. The Mask tab also allows you
to fine tune mask control point positions using value sliders.
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Shape Type: This pop-up menu lets you change the type of control points that are used
to define the mask. For example, if you originally created a Bezier mask, you can choose
B-Spline from this menu to change how the mask is drawn. Changing the shape type
might dramatically change the mask’s form even though its control points remain fixed
at their original coordinates. There are three options:

• Linear: All of a mask’s control points are joined by hard angles, and the resulting mask
is a polygon. The control points of a Linear mask lie directly on its edge.

• Bezier: Control points can be a mix of Bezier curves and hard angles, creating any sort
of mask. The control points of a Bezier mask lie directly on its edge.

• B-Spline: Control points are all B-Spline points, with different degrees of curvature.
B-Spline control points lie outside the surface of the mask, but are connected by the
B-Spline frame.

Note: You can hide the B-Spline frame by turning off Lines in the View pop-up menu
above the Canvas.

Mask Blend Mode: Determines how a mask interacts with the alpha channel of the layer
to which it’s applied. When a layer has multiple masks, each mask can have a different
Mask Blend Mode. When this happens, each mask adds to, or subtracts from, the layer’s
alpha channel according to the selected mode. The final alpha channel is the combined
result of all the masks that are applied. There are four choices in this pop-up menu:

• Add: This is the default selection for new masks. Each new mask adds to the existing
alpha channel. This is useful for adding back regions of an image that other masks are
cutting out. In the following example, both the rectangle and circle masks are creating
opaque regions.
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If the layer already contains an alpha channel, a mask set to Add mode isolates only
the masked section of the original alpha channel.

Original alpha channel of butterfly clip Circle mask set to default. Add mode applied 
to butterfly clip.

• Subtract: Subtracts a mask from the alpha channel. This is useful for creating holes in
the middle of objects, or for masking out additional regions of an image that are
untouched by other masks. In the following example, both the rectangle and circle
masks are creating transparent regions.
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• Replace: This setting uses the current mask to completely replace the object’s original
alpha channel, as well as any other masks that are applied to the same object that
appear underneath the current mask in the Layers tab. You can add additional masks
above, set to whatever blending mode you like. In the following example, the circle
mask is overriding the rectangle, since it is at the top of the masks that are nested
within the gradient object.

• Intersect: Masks that are set to intersect do not replace an object’s original alpha channel.
Instead, they mask out all regions of the object that do not overlap the mask itself. This
includes other masks applied to the same object that appear nested underneath the
intersecting mask in the Layers tab. In the following example, only the overlapping
areas of the rectangle and circle masks are opaque. Everything else is transparent.

Invert Mask: When this checkbox is selected, the mask is inverted—its solid and
transparent areas are swapped. This is useful if you need to switch the solid and
transparent areas of a mask you have already created.

Tip: You can apply different filters and effects to the foreground and background of an
image by first masking the foreground subject, duplicating the layer and its mask, then
inverting the duplicate layer’s mask. Effects that are applied to the background can then
be completely isolated from the foreground, or vice versa.

Note: You can adjust the opacity of a mask in the Properties tab of the Inspector.
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Roundness: Controls the roundness of the corners of a mask. This facilitates the creation
of rounded rectangle masks, as well as generally smoothing the edges of any mask.

Preserve Scale: This checkbox controls whether the Roundness setting is absolute or
relative to the overall mask size. When enabled, the roundness will remain at the same
approximate percentage of curvature as the object is scaled. When disabled, the curvature
will vary as the overall mask changes size.

Feather: A slider that feathers (softens) the edges of a mask. Positive feathering values
soften the edge of the mask from its edge outward. Negative feathering values soften
the edge of a mask inward from the edge. Feathering the edge of a mask can soften a
harsh rotoscoping job, making the masked object blend more easily with the background.

Mask Color: A pop-up menu that controls the color of the mask as displayed in the Canvas
when it is selected. This setting has no effect on the final output. Setting masks to different
colors may aid you in identifying which mask is which.

Control Points: Click the disclosure triangle to display the position parameters for the
mask control points. Use the value sliders to adjust the position of a control point. The
left value slider represents X and the right value slider represents Y.

Applying Image Masks to a Layer
Another way you can create transparency in a layer is by using image masks. An image
mask creates transparency in a layer by deriving an alpha channel from another layer,
such as a shape, text, movie, or still image.

Text layer Image layers Layers masked by text layer

Note: You can use masks and image masks together.

The power of image masks is that they do not have to be drawn or animated. Instead,
you can use virtually any image or movie clip to create transparency in another layer. By
default, movie clips create animated image masks, but you can also set an image mask
to use only a single frame.
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Image masks can also be used to assign masks that were created in other applications.
For example, you can import an animated mask that was created in another application
and exported as a QuickTime movie into your Motion project, then use it as an image
mask.

When you use a layer as an image mask, you can choose which of the layer’s channels
to apply to create transparency via the Source Channel pop-up menu in the Image Mask
tab of the Inspector. The choices include:

• Red

• Green

• Blue

• Alpha

• Luminance

Because alpha channels are basically 8-bit grayscale images, you can use any single color
channel as an image mask. You can also use another layer’s alpha channel. Luminance
allows you to use the aggregate luminance from the red, green, and blue channels of an
image to create transparency. For all these options, color is ignored.

Assigning an image mask is a two-part process. First, you create a blank image mask
underneath a layer. Then you assign the image you want to use to create transparency.

To add an image mask to a layer
1 Select the layer you want to mask.

2 Choose Object > Add Image Mask (or press Command-Shift-M).

The image mask appears underneath the layer in the Layers tab and Timeline.
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3 With the image mask selected, do one of the following:

• Open the Image Mask tab in the Inspector, then drag the layer you want to use as the
mask into the Mask Source well.

Mask Source well

• Drag the layer you want to use as the mask into the Mask Source well in the HUD.

Important: Be sure to click and drag in one movement to successfully drop a layer in
an image well. If you select the layer to use as the source, then release the mouse
button, you lose the selection.

In this example, text is used as the mask layer.

4 Choose the channel you want to use to create transparency from the Source Channel
pop-up menu, as well as any other options that are necessary to create the required
transparency.

Applying Filters to Image Masks
Like shape masks, you can add filters to image masks to further manipulate the
transparency effect. In particular, you may be able to improve the mask that’s created by
using color correction filters such as Brightness, Contrast, and Gamma to manipulate the
contrast of the mask, pulling out or reducing detail to create the transparency effect you
need.
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Filtering image masks works identically to filtering shape masks. For more information,
see Applying Filters to Masks.

Applying Behaviors to Image Masks
You can also apply behaviors to image masks to create animated transparency effects.
For more information, see Applying Behaviors to Masks.

Image Mask Parameters
Once you’ve added an image mask to a layer, the following parameters become available
in the Image Mask tab of the Inspector.

Image Mask Parameters in the Inspector
The Image Mask HUD contains the Mask Source, Source Channel, Mask Blend Mode, Invert
Mask, Stencil, and Stretch parameters. These controls, and the additional parameters in
the Inspector, are described below.

Mask Source: An image well that assigns a layer (a shape, text, an image, a movie, particle
emitter, numbered image sequence, and so on) to use to mask a layer.

Frame: When you use a movie or image sequence as the assigned image, this slider
allows you to select the start frame for playback.

Hold Frame: When you use a movie or an image sequence as the assigned image,
selecting this checkbox freezes the frame specified in the Frame parameter. That frame
is then used as the mask for the masked layer’s total duration.

Offset: Offsets the X and Y values of the mask’s position, relative to the layer it is masking.
This allows you to change which part of the layer is masked.

Wrap Mode: If an image mask is smaller than the layer to which it has been assigned,
you can increase the area it affects by selecting a wrap mode from this pop-up menu.
There are three options:

• None: The object is used as is.

• Repeat: The object is duplicated and tiled to fill up the full width and height of the
image.

• Mirror: The layer is duplicated, tiled, and reversed to fill up the full width and height
of the image. This may create a more seamless repetition for some images.

Source Channel: A pop-up menu that lets you choose which channel of the assigned
image is used to create the mask. There are five choices:

• Red: Uses the red channel as a grayscale mask.

• Green: Uses the green channel as a grayscale mask.

• Blue: Uses the blue channel as a grayscale mask.

• Alpha: Uses the alpha channel from the mask layer.
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• Luminance: Uses the aggregate luminance from the red, green, and blue channels as
a grayscale mask.

Mask Blend Mode: A pop-up menu that determines how an image mask interacts with
the alpha channel of the layer to which it is applied. When a layer has multiple image
masks, each mask can have a different Mask Blend mode. When this happens, each mask
adds to, or subtracts from, the layer’s alpha channel according to the selected mode. The
final alpha channel is the combined result of all the image masks that are applied. These
modes are identical to the Mask Blend Mode options available for shape masks. The four
options are:

• Add: This is the default selection for new masks. The mask is added to the alpha channel.
This is useful for adding back regions of an image that other masks are cutting out.

• Subtract: Subtracts a mask from the alpha channel. This is useful for creating holes in
the middle of layers, or for masking out additional regions of an image that are
untouched by other masks.

• Replace: This setting uses the current mask to completely replace the layer’s original
alpha channel, as well as any other masks that are applied to the same layer that appear
underneath the current mask in the Layers tab. You can add additional masks above,
set to whatever blending mode you like.

• Intersect: Masks that are set to Intersect do not replace a layer’s original alpha channel.
Instead, they mask out all regions of the layer that do not overlap the mask itself. This
includes other masks applied to the same layer that appear nested underneath the
intersecting mask in the Layers tab.

Invert Mask: When this checkbox is selected, the mask is inverted—its solid and
transparent areas are swapped. This is useful if you need to switch the solid and
transparent areas of a mask you’ve already created.

Stencil: When this checkbox is selected, the layer’s geometric transforms are respected
by the mask. If you’re creating a mask with transformed Scale, Position, Rotation, or other
parameters, select this checkbox to use the modified layer.

Stretch: A checkbox that becomes available when Stencil is deselected. Selecting this
checkbox stretches the mask to fit the boundaries of the image and centers the mask on
the layer’s center point.

Using Masks to Aid Keying Effects
Keying is rarely a one-step process. Although adding a keying filter is the first step, there
is usually additional work that needs to be done to create a good key that retains detail
around the edge of your subject. The mask tools and alpha channel filters presented in
this section can be used to turn a decent key into a great one. For more information
about using Motion’s keying filters see Keying Filters.
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Garbage Masks
The second step in many keying shots is to create a garbage mask to crop out unwanted
objects in the shot that can’t be keyed, such as the edge of a blue screen stage, lighting
rigs, or tape that appears in the background.

You can also use a garbage mask to conceal parts of the background that are too difficult
to key without the loss of foreground detail.

To create a garbage mask
µ Select a keyed layer and use one of the mask tools to draw a mask around the foreground

subject.

Note: The garbage mask must be animated if the subject is moving.

By default, the mask is set to Add, and crops out everything outside the mask, while
leaving the transparent areas within the mask alone.

For more information about using Motion’s keying filters, see Keying Filters.

Holdout Masks
Sometimes, while pulling a key, you lose part of the image you’re trying to keep. This can
happen when the color of the subject’s clothing is too close to the color of the background
being keyed out, or when you need to use keying values that are too aggressive. In this
example, very small parts of the lioness’s head and face are getting removed with the
key, rather than just the blue sky.
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The following images show an example of a key that needs to be manually masked. The
top image is the original shot to be keyed, and the bottom image is the keyed shot. The
lion image key leaves black spots or “dirt” on the key. If left uncorrected, the background
image would show through the lion in these areas.

In these cases, you can duplicate the original layer, mask the part of the subject that’s
being incorrectly keyed, and composite it over the keyed version to fill it back in.

Note: The Spill Suppressor filter can modify the color of the foreground subject as well.
If you’re using the Spill Suppressor filter on the keyed layer, you may have to apply the
same filter to the holdout mask layer to make sure the color matches. For more information
on the Spill Suppressor filter, see Keying Filters.

To create a holdout mask
1 Key and mask the foreground subject.

For more information about using Motion’s keying filters, see Keying Filters.

2 Duplicate the keyed layer, then move it so that it appears above the original layer in the
Layers tab or Timeline layers list.

3 Mask the area of the foreground that is incorrectly keyed.
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Make sure that the mask is entirely within the subject being keyed.

Note: The holdout mask must be animated if the subject is moving.

4 On the newly duplicated layer, delete the original keying filters since they’re unnecessary.

If you’ve used a Spill Suppressor filter, don’t delete it, since it’s probably changing the
color of the subject.

5 Feather the edge of the holdout mask you’ve just created, to make sure that it blends in
with the object you initially keyed.

In the following image, the mask on the lioness’s head creates a clean key by removing
the “dirt” left by the original key.

6 As an optional step, you can nest the originally keyed layer along with the holdout matte
you just created inside a dedicated group so that you can manipulate the entire subject
as a single object.

Performing Multiple Keys on a Single Subject
In some instances, it may be difficult to key an entire subject with a single keying filter
while retaining fine details. For example, uneven lighting or background color might
mean that the best settings to key a subject’s hair may not work elsewhere.
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If you attempt to key the entire subject with a single keying filter, chances are that you
need to use such extreme settings that a lot of edge detail is lost. In such cases, masks
can be used to isolate different parts of a subject, so that you can apply different keying
settings to each area.

To segment a subject into separate keying zones
1 Create a new group, and place the layer you’re keying within the new group.

2 Duplicate the layer you’re keying until you have a separate duplicate for each part of the
image you want to key separately.

3 Use one of the mask tools to mask each part of the subject in each of the duplicate layers.

Make sure that all of the duplicate layers overlap, so that there are no gaps in the
foreground.

Note: You may need to animate the overlapping masks if the foreground subject is
moving.

4 Apply the appropriate keying filter to each of the isolated parts of the subject, and adjust
each filter’s settings as necessary.

Eventually, you may find you can achieve an optimal key for each part of the subject.
Furthermore, with all duplicates nested within a single group, you can continue to
manipulate the subject as a single object.

Converting Between Shapes and Masks
Because masks and shapes are created in similar ways but perform different tasks, there
are occasions where you may create a shape and later want to convert it into a mask, or
vice versa. Changing shapes to masks and masks to shapes is done by changing the
object’s position in the Layers tab or by using the Object menu.

Note: Masks are not applicable to 3D paint strokes, 3D particle systems or replicators, 3D
text objects or unflattened 3D groups. In order to convert a shape to a mask on such an
object, the item must be flattened.

Different options are available when converting shapes to masks, depending on the type
of object that is being masked. The following steps apply when converting a shape to a
mask on an image-based object (movie or image sequence, images, generator, and so
on).

To convert a shape to a mask on an image
1 Use any of the shape tools to create a shape (or draw a paint stroke).

Note: You can also add a preset shape from Shapes category in the Library.

2 In the Layers tab, drag the shape object onto the layer to be masked.
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The shape is converted into a mask. If the layer to which the mask is applied is not centered
in the Canvas, the position of the mask will be slightly offset. This is because the position
of the converted mask is dependent upon the original position of the shape relative to
the center of its parent group.

Note: If the object receiving the mask has previously been scaled, when converted to a
mask, the shape will automatically be scaled too, which may produce unexpected results.
To convert a shape to a mask on a scaled object, you may want to first set the object to
100% scale or put the clip into a new group and convert the shape to a mask on the
group instead.

Note: Converting a shape that has been manipulated in 3D into a mask may produce
unexpected results as the shape must be collapsed into a 2D approximation of the 3D
shape before it is applied. For more on applying masks to 3D objects, see Masking Objects
in a 3D Project.

To convert a shape to a mask on a group
1 Use any of the shape tools to create a shape (or draw a paint stroke).

2 In the Layers tab, drag the shape onto the group layer and pause, holding down the
mouse button. When the drop menu appears, choose Move Mask To Group.

To convert a shape to a mask on the enclosing group
1 Use any of the shape tools to create a shape (or draw a paint stroke).

2 In the Layers tab, select the shape object and do one of the following:

• Drag the shape onto the group layer and pause, holding down the mouse button.
When the drop menu appears, choose Move Mask To Group.

• Choose Object > Convert Shape to Mask.

To convert a shape to a mask on another shape
1 Use any of the shape tools to create a shape (or draw a paint stroke).

2 In the Layers tab, drag the shape object onto another shape object and pause, holding
down the mouse button.

A drop menu appears.

3 Choose Add Mask To Shape.

The shape is converted into a mask on the other shape.

Note: Spline masks are not applicable to 3D paint strokes. The Local 3D checkbox must
be deselected in the Stroke pane of the Shape Inspector for the drop menu to appear.

To convert a shape to a mask on a particle emitter or replicator
1 Use any of the shape tools to create a shape (or draw a paint stroke).
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2 In the Layers tab, drag the shape object onto an emitter or replicator and pause, holding
down the mouse button.

A drop menu appears.

3 Choose Add Mask To Emitter or Add Mask to Replicator.

The shape is converted into a mask on the particle emitter or replicator.

Note: The 3D checkbox must be deselected in the Emitter or Replicator tab of the Inspector
for the drop menu to appear.

To convert a shape to a mask on text
1 In the Layers tab, select the text layer you want to mask.

2 In the Layout pane of the Text Inspector, ensure the Flatten checkbox is selected.

3 Use any of the shape tools to create a shape (or draw a paint stroke).

4 In the Layers tab, drag the shape object onto a text layer.

To convert a mask to a shape
µ In the Layers tab, select a mask and do one of the following:

• Choose Object > Convert To Shape.

• Drag the mask between two objects in the Layers tab.

• Drag the mask onto the group layer and pause, holding down the mouse button. When
the drop menu appears, choose Move Shape To Group.

Manipulating Alpha Channels Using Filters
In addition to using shape and image masks to create transparency within layers, there
are also filters you can use to manipulate or even replace a layer’s alpha channel.

For example, all of the keying filters create transparency by generating an alpha channel
based on colors or luminance values in that layer. Keying filters are usually used on layers
that have no alpha channel information, and they add a new alpha channel to the layers
to which they’re applied. For more information on the use of the keying filters, see Keying
Filters.

The process of improving a keying effect or of customizing an alpha channel created
using one or more shape or image masks may require the use of special filters. Although
you can apply any filter directly to a shape or image mask to modify that particular mask’s
effect, the filters described in this section modify a layer’s entire alpha channel directly,
including the sum total of all masks and other filters that have been applied to that layer.
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For example, if you’ve applied a keying filter, you can use the following filters to modify
the resulting alpha channel even though no mask appears for that layer in the Layers tab
or Timeline.

• Channel Blur: This filter, found in the Blur category of the Filters library, lets you
selectively blur the alpha channel. You can set the amount of horizontal and vertical
blur independently.

Original (color channel) Original (alpha channel)

Channel Blur (color channel) Channel Blur (alpha channel)

• Matte Choker: This filter, found in the Matte subcategory of the Filters library, increases
or decreases the semi-transparent area of a layer’s alpha channel by performing a
gamma correction (similar to the Gamma color correction filter) to all regions of the
alpha channel falling between solid black and solid white. This allows you to widen or
narrow the semi-transparent areas within a layer, while leaving all 100 percent solid
and transparent areas unaffected. Once you’ve added a Matte Choker to a layer, the
following parameters become available in the Filters tab of the Inspector:

• Edge Thin: A slider that allows you to modify the edges of the matte. Higher positive
Edge Thin values eat into the alpha channel, eliminating fringing around the edges
of translucent areas. Negative values fill in translucent values, filling in holes and
widening the matte into areas of fringing.
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• Feather: A slider that allows you to adjust edge translucence. Lower values reduce
the amount of translucence in a matte, but this results in harder edges around holes
and edges in the alpha channel.

• Mix: A slider that sets what percentage of the original image is blended with the
filtered image. Values range from 0 to 100%.

Keyed original object (color channel) Keyed object with holes (alpha channel)

Keyed object with Matte Choker (color channel) The Matte Choker eliminates the holes
(alpha channel).
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3D compositing introduces a number of new concepts to the art of motion graphics. At
first glance, these concepts might seem daunting. But you already have an advantage:
Because you move around in a real three-dimensional world, you’ll likely find the virtual
3D world of the Motion Canvas intuitively familiar.

This chapter covers the following:

• Real-World Coordinates (p. 1187)

• 3D Transform Tools (p. 1189)

• 3D Workspace and Views (p. 1199)

• Cameras (p. 1208)

• 2D and 3D Group Intersection (p. 1221)

• Lighting (p. 1224)

• Shadows (p. 1231)

• Reflections (p. 1241)

Real-World Coordinates
The position of any object in the real world can be described using a simple coordinate
system. For example, you could describe your computer’s position as being four feet
across from the door, three feet up from the floor, and five feet in front of the window. In
a coordinate system, each of the three numbers used to describe an object’s position
corresponds to a coordinate axis. The place where the zero values along each axis meet
is called the origin. In this example, the X equals 4, Y equals 3, and Z equals 5.
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Coordinates and Object Position in Space
The location of an object in Motion can be described in these terms as well. The coordinate
system used by Motion specifies the center of the Canvas as 0, 0, 0. Moving an object to
the left subtracts from the X value, while moving to the right adds to the X value. Moving
an object up adds to the Y value, and moving an object down subtracts from the Y value.
Moving an object closer adds to the Z value, while moving further away subtracts from
the Z value. The main difference between a 2D scene and a 3D scene is that in a 3D scene,
you can change your point of view, so that moving an object up doesn’t always mean
increasing its Y Position value.

Note: In a new project, the Canvas is oriented with the Z axis pointing straight at you.
This orientation preserves the traditional two-dimensional orientation of the X and Y axes,
which span the default Canvas from left to right (X) and top to bottom (Y).

3D Conventions
There are a few conventions commonly used to discuss and display three-dimensional
environments.

• Object movement is along an axis.

• Object rotation is around an axis.

• Each axis is color-coded: X is red, Y is green, and Z is blue.

• Positive rotation is counterclockwise around an axis.
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3D Transform Tools
There is no inherent difference between 2D and 3D project files in Motion. At any point,
you may decide to start working with groups or layers in 3D. Doing so requires no
preplanning on your part; in fact, it’s possible to go back and forth between manipulating
objects in 2D and 3D space. This section covers the tools you can use to move objects
around in the Canvas.

The image in the screen shot above has just been imported into the scene and is
positioned at the scene’s origin. Use the 3D Transform tool—located to the right of the
Select/Transform tool in the Toolbar—to move the image.

3D Transform tool

To use the 3D Transform tool
µ Select the 3D Transform tool in the Toolbar (or press Q).

Choose an axis type.

Drag to move Z.

Drag to move X and Y.

Drag to move X and Z.
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Two things happen immediately when you select the 3D Transform tool. The onscreen
controls change, and the object’s HUD changes.

3D Transform Onscreen Controls
When you select the 3D Transform tool, three colored arrows appear in the Canvas near
the center of the image. Each arrow corresponds to one of the three coordinate axes. In
the default view, the Z axis points directly out toward you, so that only the tip of the blue
Z arrow is visible. Dragging one of the onscreen arrows moves the image along a particular
axis.

To move an object using the onscreen controls
1 Select the object you wish to move.

2 Drag one of the colored arrows representing the desired axis of movement.

When dragging, the active arrow turns yellow, and an info window displays the current
coordinates of the object as well as the distance the object has moved. As always,
coordinates are given in the form of X, Y, and Z.

3D Transform tool active Moving the object along the X axis

Near the three colored arrows are three small circles. These are rotation handles. Placing
the pointer over any of these circles invokes a rotation ring for a particular axis.

To rotate an object around a single axis using the onscreen controls
1 Select the object you wish to rotate.

2 Move the pointer to the rotation handle (small circle) corresponding to the desired axis
of rotation.

The rotation ring appears.

3 Drag the ring to rotate the object.
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An info window displays the current Rotation values as well as the distance the object
has been rotated.

X axis rotation handle active Rotating the object around the X axis

To freely rotate an object around all axes using the onscreen controls
1 Select the object you wish to rotate.

2 Place the pointer over any of the rotation handles, then press and hold down the
Command key.

All three rotation rings appear.

3 Continue to hold down the Command key, and drag anywhere inside the rings to freely
rotate the object.

An info window displays the current rotation values as well as the distance the object
has been rotated.

Important: Rotation performed with the 2D Select/Transform tool is only around the Z
axis.

Rotating with 3D tool around the Z axis Rotating with 2D Select/Transform tool

Note: When the 3D Transform tool is active, a third set of onscreen controls becomes
available: scale handles, which appear on the edges of the bounding box surrounding
the selected image.
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3D Transform Onscreen Controls Display
It is possible to display a subset of the 3D transform onscreen controls.

• Press the Comma key (,) to display the axis arrows (but not the rotation handles or
scale handles).

• Press the Period key (.) to display the rotation handles (but not the axis arrows or scale
handles).

• Press the Slash key (/) to display the scale handles (but not the axis arrows or rotation
handles).

When you press any of the above keys a second time, the display switches back to
the default, with all three of the onscreen controls visible.

3D Transform HUD Controls
In addition to the onscreen controls, the HUD provides another method of transforming
objects in 3D space.

Choose an axis type.

Drag to move Z.

Drag to move X and Y.

Drag to move X and Z.

Move: Three controls in the Move section of the HUD let you drag the selected object
in one or more axes at once. Drag inside one of the Move controls to change the relevant
parameter values of the object in the Canvas.

• Move Z: Drag here to move the selected object in the Canvas along the Z axis. Dragging
to the right increases the Z value, and dragging to the left decreases the Z value. Hold
down the Command key when dragging to simultaneously scale the object as it is
translated (moved), preserving its size relative to the camera.

• Move XY: Drag here to move the selected object in the Canvas along the X and Y axes.
Dragging right or left increases or decreases the X value. Dragging up or down increases
or decreases the Y value. Using this control is identical to moving a 2D object directly
in the Canvas. Hold down the Command key when dragging to constrain movement
to the axis corresponding to the initial direction of the drag.
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• Move XZ: Drag here to move the selected object in the Canvas along the X and Z axes.
Dragging right or left increases or decreases the value of X. Dragging up or down
increases or decreases the value of Z. Hold down the Command key when dragging
to constrain movement to the axis corresponding to the initial direction of the drag.

Tip: As in the Inspector, holding down the Shift key while you drag in the HUD makes
larger changes. Holding down the Option key while you drag makes smaller changes.

Rotate and Scale: Two additional drag controls in the HUD let you rotate and scale the
selected object in the Canvas:

• Rotate XYZ: Drag here to rotate the selected object in the Canvas around all axes.
Starting at the origin, dragging up and down rotates the object around the X axis.
Dragging to the left and right rotates the object around the Y axis. Hold down the
Command key while dragging to constrain rotation to the Z axis.

• Scale: Drag here to uniformly scale the selected object in the Canvas. Dragging to the
right or up (or both) increases the Scale value. Dragging to the left or down (or both)
decreases the Scale value. Hold down the Command key while dragging to constrain
scaling to the axis corresponding to the initial direction of the drag.

Adjust Around: The Adjust Around pop-up menu, located under the Move, Rotate, and
Scale controls in the HUD, allows you to select which relative coordinate space is used
for transforms. The Adjust Around pop-up menu has three options:

• Local Axis: The default, this option orients the onscreen transform controls to the
object’s local axes.

• World Axis: This option orients the onscreen transform controls to the axes of the 3D
grid in the Canvas.

• View Axis: This option orients the onscreen transform controls to the view space of the
current view. The Z axis is aligned along the view’s line of sight. For more information
on views, see Views.

Relative Coordinates
To better understand the concept of relative coordinates, think of a system of satellites,
like the earth, the moon, and the sun. The moon’s parent is the earth, and the earth’s
parent is the sun. Usually, when considering these three bodies, the moon’s position is
described in terms of its position relative to the earth (the moon’s parent), and the earth’s
position is described relative to the sun (the earth’s parent). In Motion, an object’s position
and orientation are always relative to its parent.

1193Chapter 18 3D Compositing



When you add a new group to a Motion project, that group is created at the origin
coordinates of its parent. In the case of a root-level group (a group that is not nested within
any other groups in the Layers tab), the parent is the project itself. An object placed inside
of a group has its position described relative to its parent: the group.

Group at X=50, Y=50, Z=50 Group Inspector

In the previous example, a group has been positioned at X, Y, and Z coordinates of 50,
50, and 50, respectively. The group is located 50 units away from its parent’s origin on all
axes (the parent in this case being the project itself ). The image inside the group is
positioned at 0, 0, 0. Because the image’s position is relative to its parent, the group, it
shares its parent’s origin and has an apparent position in the world of 50, 50, 50.

Moving the image to a position of 25, 25, 25 displaces it by 25 units from the group’s
origin in all axes. While the image’s apparent position relative to the world is 75, 75, 75,
its Position values in the Inspector are 25, 25, 25 because its position is always relative to
its parent.

Image in group at 25, 25, 25 Image Inspector
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Rotation values are also relative to an object’s parent.

Group with Z Rotation set to 45 degrees Image with Z Rotation set to 90 degrees inside 
group with Z Rotation set to 45 degrees

Important: World and view transforms are limited to the HUD and onscreen controls; all
transforms made in the Inspector are relative to an object’s parent’s space.

Layer Order and Depth Order
When compositing in 2D, the Layers tab shows the layer order, which determines which
objects appear on top of other objects. Objects that are higher up in the Layers tab appear
on top of objects lower than them in the Layers tab.

Important: The children of 2D groups are always composited in layer order.

Group A on top in Layers tab Result of 2D composite in Canvas
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If you were to move Group A below Group B in the Layers tab, Group B would be rendered
on top of Group A.

Group B on top in Layers tab Result in Canvas

The Layers tab also shows object relationships in terms of parenting. The parent-child
relationship is displayed in the Layers tab through the use of indenting and disclosure
triangles.

Child of Elephant Group

Children of Group

Parent of all objects 
beneath it

Parent of Elephant

The Layers tab is not the only indicator of order when considering objects in 3D. When
depth-sorted, an object can be at the bottom of the Layers tab and yet appear to be on
top of everything else in the Canvas, because of the object’s position relative to the current
camera. The most common way to adjust depth order is to change the Z position of a
layer or group.
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Important: The children of 3D groups are composited in depth order by default.

Layers tab Objects sorted in depth order in Canvas

With the 3D groups above, objects are composited in depth order; their position in the
Layers tab does not correlate to their position in 3D space relative to the camera.

In the above example, the Blue A group is above the Red A group in the Layers tab but
it appears behind the Red A group in the Canvas because it is depth-sorted. The same
principle applies to the Blue B group and the Red B group.
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3D Transformations in 2D Groups
All objects have 3D transformations available, even when in 2D groups. All can be rotated
around any axis and moved along any axis. Keep in mind that objects in 2D groups are
not depth-sorted, and cannot intersect, regardless of their position in 3D space.

2D parent group in the Layers tab Groups sorted in layer order in Canvas

Both of these groups are positioned at the same point in 3D space, but because they
are layer-ordered, group A does not intersect with group B. If you change the parent
group to 3D, the two groups will intersect.

3D parent group in the Layers tab Groups sorted in depth order in Canvas

Note: If two groups are coplanar (occupy the same plane), they are composited in layer
order, regardless of whether the objects’ parent is a 2D group or 3D group. In a 2D
composite, all objects are coplanar.
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3D Workspace and Views
In a 3D workspace, everything is seen from the viewpoint of a camera. The default views
presented in the 3D workspace are reference cameras that can be used and manipulated
to help place and animate objects but are not used for rendering output. If you wish to
render specifically from one of the camera views, you must create a scene camera. For
more information on cameras, see Cameras.

Views
There are several different view layouts, with each layout consisting of an arrangement
of viewports. But each layout works exactly the same as another, and the views are
manipulated in precisely the same way no matter how many views there are. Each viewport
displays the scene from the point of view of a camera. Reference camera views have a
specific default position and orientation.

There are two types of default reference cameras:

• Orthogonal

• Perspective

An orthogonal camera views the scene by looking straight down one of the world axes:
X, Y, or Z. The default orthogonal “cameras” do not actually appear in the Layers tab,
Timeline, or Canvas. The Front and Back cameras look straight down the Z axis. The Top
and Bottom cameras look straight down the Y axis. The Left and Right cameras look
straight down the X axis.

Orthogonal camera view with no rotation
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Orthogonal cameras do not show perspective. Perspective cameras—and scene cameras
that you add to a project—distort the view the way a real-world camera would.

Object rotated in orthogonal camera view Object rotated in perspective camera view

In order to have access to reference camera views and camera controls, you must first
add a camera to your scene.

To add a scene camera to a Motion project
1 Choose Object > New Camera (or press Command-Option-C).

A camera object is added to the Layers tab, the Timeline, and the Canvas (represented
there by a wireframe icon). The 3D Transform tool in the Toolbar becomes active, the
Camera HUD appears (if it isn’t visible, press F7), and the Camera tab in the Inspector
becomes available.

If you add a camera to a project that contains no existing 3D groups, the following dialog
appears:

2 Click either “Keep as 2D” or “Switch to 3D.”
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Once you add a camera to a project, the Camera menu becomes available in the upper-left
corner of the Canvas.

Camera menu

3D Canvas Overlays
There are six 3D overlays that can appear in the Canvas: the Camera menu, the 3D View
tools, the Inset view, the 3D grid, the 3D Compass, and the 3D scene icons. You can turn
the display of each of the overlays on or off in the Canvas.

3D View toolsCamera menu

3D grid

Inset view

3D Compass

3D scene icons 
(camera, light)

To modify the appearance of 3D overlays
Do one of the following:

µ Choose View > 3D Overlays, then choose the type of 3D overlay you wish to show or
hide.

µ Choose the type of 3D overlay you wish to show or hide from the View pop-up menu in
the Status Bar.
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Camera Menu
The Camera pop-up menu, located in the upper-left corner of the Canvas, lists the currently
active camera view. Choose from a list of reference cameras and scene cameras, as well
as several view-related commands.

Camera menu

The Camera menu is divided into three sections:

• The top section allows you to select the currently active camera as well as any other
scene cameras you have added to the project. If a scene contains more than one camera,
the camera that is topmost in the Layers tab and in the Timeline at the current frame
is the active camera. For more information on scene cameras, see Cameras.

• The middle section allows you to select one of the default reference cameras:
Perspective, Front, Back, Left, Right, Top, Bottom.

• The bottom section allows access to five commands: Reset View, Select Active Camera,
Fit Objects Into View, Frame Objects, and Focus on Object. For details on each of these
commands, see the 3D View section in View Menu.

3D View Tools
The 3D View tools can be used to control both reference and scene cameras.

The scene camera indicator appears to the left of the 3D View tools only when a scene
camera is the active camera.

Dolly tool

Scene camera indicator

Pan tool

Orbit tool
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There are three 3D View tools:

• Pan: Drag in this box to move the camera along the X and Y axes relative to the current
view.

• Orbit: Drag in this box to orbit the camera around the currently selected scene object.
If nothing is selected, the camera orbits around its focal plane. For more information
on the camera focal plane, see Camera Controls. Orbit can affect X, Y, and Z Position
values, as well as X and Y Rotation values.

Note: If you use the orbit control to change one of the orthogonal reference cameras,
an asterisk appears next to the view’s name in the Camera menu, indicating that the
view is no longer a true orthogonal view.

• Dolly: Drag in this box to dolly the camera, moving it along the Z axis relative to the
current view.

Important: Double-clicking a 3D View tool resets all parameters that can be affected
by the tool.

3D View Tool Shortcuts
It is possible to use the Pan, Orbit, and Dolly tools with keyboard commands and a
three-button mouse:

• Pan: Drag in the Canvas while holding down the Option key and the right mouse
button.

• Orbit: Drag in the Canvas while holding down the Command key and the right mouse
button.

• Dolly: Drag in the Canvas while holding down the Command key, the Option key,
and the right mouse button.
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3D Compass
Located in the lower-left corner of the Canvas, the 3D Compass acts as an orientation
and shortcut device. It has active and passive states, depending on whether the pointer
is positioned over it. In its passive state, it displays the orientation of the three world axes
(X, Y, and Z). In its active state, the compass presents color-coded shortcuts to the reference
(orthogonal and perspective) cameras.

3D Compass in passive state 3D Compass in active state

To select a reference camera view using the 3D Compass
1 Position the pointer over the compass.

The compass changes to its active state, displaying a labeled icon for each of the reference
camera views.

2 Click the icon representing the camera you wish to activate.

The view in the Canvas updates to the selected reference camera view.

To select a scene camera view using the 3D Compass
1 Position the pointer over the 3D Compass.

The compass changes to its active state.

2 Control-click the 3D Compass, then choose a scene camera from the shortcut menu.

The view in the Canvas changes to the selected scene camera view.

Note: You can also choose a reference camera view from the 3D Compass shortcut menu.
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Inset View
When you move an object, an Inset view appears in the lower-right corner of the Canvas,
showing the scene from a different camera’s point of view. If you are currently viewing
the scene through the active camera, the Inset view shows the Perspective camera’s point
of view. If you are currently viewing the scene through any other camera, the Inset view
shows the active camera. Use the Inset view to see the results of changes that you make
in orthogonal views.

Inset view

Use Motion Preferences to set the Inset view’s size and when it appears in the Canvas.
For more information on Inset view properties, see 3D Pane.

3D Grid
The 3D grid shows the ground plane of the 3D world. The ground plane is, as the name
states, a plane attached to the “ground” of the scene, where Y equals 0. The ground plane
represents the dividing line between “up” and “down,” that is, between positive Y values
and negative Y values. It is centered on 0, 0, 0.

3D grid enabled
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3D Scene Icons
3D scene icons are the onscreen representations of cameras, lights, and edge-on lines.
An edge-on line is drawn when an object’s edge is facing the camera—which normally
results in an invisible object. This allows you to select objects that would otherwise be
invisible. None of the 3D scene icons appear in exported images and movie clips.

Camera

Edge-on line indicator

Camera’s angle of view

Light

Tip: Double-click a camera scene icon to select it and change the current view to that
camera.

View Layouts
Motion allows you to have multiple views active at the same time in the Canvas to help
with animating and positioning objects in 3D space. The View Layouts pop-up menu,
located in the Status Bar, just above the 3D View tools, lets you choose from seven different
view layouts. Each layout is represented by an icon in the pop-up menu:

• Single: The default value, displays a single window in the Canvas.

• Two-up, side by side: Displays two windows in the Canvas, one next to the other.

• Two-up, top and bottom: Displays two windows in the Canvas, one on top of the other.

• Three-up, large window below: Displays three windows, two next to each other on top
and a larger window below.

• Three-up, large window right: Displays three windows, two stacked on the left side and
a larger window spanning the right side.

• Four-up, large window right: Displays four windows, three stacked on the left side and
one larger window on the right side.
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• Four-up: Displays four windows, all the same size.

View Layouts pop-up 
menu

To open multiple windows in the Canvas
µ Choose a layout from the View Layouts pop-up menu.

The Canvas displays the layout you choose.

When working with multiple views, the last view you clicked in is the active view. The
active view is indicated by a yellow border. Only the active view can contain onscreen
controls.

The view in the 
upper-left quadrant 
is active.
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Note: The active view in the Canvas is not the same as the “Active Camera.” For more
information, see Active Camera.

Cameras
In 3D mode, anything you see in the Canvas represents the viewpoint of a camera, either
a default reference camera or a scene camera that you create. You can explicitly create
cameras that can be used to look at your scene from different points of view. You can
place, animate, and apply behaviors to cameras in your scene. Creating multiple cameras
gives you the ability to make different cameras active at different times, allowing you to
“cut to” different views over the course of the project.

Creating a Scene Camera
The scene cameras that you create are used for rendering output. Scene cameras appear
in the Canvas as wireframe camera icons and as objects in the Layers tab and Timeline.

To add a scene camera to a Motion project
µ Choose Object > New Camera (or press Command-Option-C).

A camera object is added to the Layers tab, the Timeline, and the Canvas (represented
there by a wireframe icon). The 3D Transform tool in the Toolbar becomes active, the
Camera HUD appears (if it isn’t visible, press F7), and the Camera tab in the Inspector
becomes available.

Active Camera
If a scene contains more than one camera, the camera that is topmost in the Layers tab
and in the Timeline at the current frame is the active camera. Although the active camera
is the default camera used for export, you can select any scene camera to export.

Camera 2 is the active 
camera at the position of 
the playhead.

Note: The “active camera” is not the same as the “active view.” The active view is the last
view you clicked in when working with multiple views. Only the active view, indicated
by a yellow border, can contain onscreen controls.
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Camera Controls
You can modify a scene camera’s properties via the Camera HUD or the Camera and
Properties tabs in the Inspector.

Parameters in the Inspector
Camera Type: A pop-up menu that sets the type of camera used. There are two options:
Framing (the default value) and Viewpoint. A Framing camera has its origin at the focal
plane. The focal plane of a camera is a plane located at a distance equal to the camera’s
focal distance along its local Z axis (or line of sight) and oriented perpendicular to the
camera’s local Z axis. A Viewpoint camera has its origin at its center of projection.

Framing 
camera

Camera’s focal plane

Camera’s angle 
of view

Viewpoint camera origin 
and center of projection

Framing camera origin

Camera’s angle of view

Tip: The position of a Framing camera’s origin makes it useful for orbiting moves. Rotating
the camera causes it to orbit, whereas rotating a Viewpoint camera causes it to pivot.

Angle of View: A slider and value slider that set the angle of view of the camera, which
is the number of degrees in which the camera sees. Value can be selected from 0 to
180 degrees.
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Note: When you animate the Angle of View parameter on a Framing camera, the result
is an opposing dolly effect. An opposing dolly zooms in the opposite direction that the
camera moves. When you animate the Angle of View parameter on a Viewpoint camera,
the result is a regular camera zoom.

Angle of View = 45 deg

Angle of View = 80 deg

Framing camera

Near Plane: A slider and value slider that set the distance at which the camera begins to
see objects. Objects closer to the camera than this distance are not rendered from this
camera’s point of view.

Far Plane: A slider and value slider that set the distance at which the camera ceases to
see objects. Objects further from the camera than this distance are not rendered from
this camera’s point of view.

Near Fade: A slider and value slider that set the softness factor for the near plane. The
softness factor sets a boundary range over which near objects fade in.

Far Fade: A slider and value slider that set the softness factor for the far plane. The softness
factor sets a boundary range over which far objects fade out.

Note: Camera depth of field parameters are also contained in this window. For a complete
description of these controls see Depth of Field.

HUD Controls
The Camera HUD contains the Camera Type, Angle of View, Focal Length, and DOF Blur
Amount parameters, which are also available in the Inspector. The Camera HUD also
contains 3D transform controls. For more information, see 3D Transform HUD Controls.

Scaling, Positioning, and Animating Cameras
Various controls allow you to scale, position, “walk,” and animate cameras. Once you have
positioned cameras in a project, you can quickly select a single camera view using the
Isolate command. For more information on using the Isolate command, see Isolate.
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Scaling a Camera
You can use the Scale parameter in the Properties tab of the Inspector to scale what a
camera sees. Changing the Scale value does not affect a camera’s Angle of View parameter.
Changing the Scale value only affects Framing cameras.

About Camera Scaling
To better understand camera scaling, imagine if you shrank down to only a few inches
tall. While the world around you hasn’t actually changed size, it would appear, to you,
to be much larger. Similarly, if you grew to 50 feet tall, the world would seem smaller,
even though it hasn’t changed. Scaling a camera up or down has the same effect

Positioning Cameras
Cameras share the same transform properties as any other object in Motion and can be
positioned in all the same ways: by using the onscreen controls and by editing parameters
in the HUD or Inspector. For more information on the onscreen controls, see 3D View
Tools. Additionally, cameras can be positioned using the Walk Camera tool. For more
information on the Walk Camera tool, see Walk Camera Tool.

Note: As a convenience, it is possible to move an orthogonal camera view to display the
scene from a position and orientation other than its default.

Important: A camera cannot be nested in a 2D group. If you try to create or add a camera
to a 2D group, the following dialog appears:

If you choose “Keep as 2D” the camera is automatically disabled.

Walk Camera Tool
The Walk Camera tool, located in the Toolbar, allows you to position the camera in 3D
space as you would in a video game, using a keyboard-and-mouse navigation method.

You can also record the movement you create using the Walk Camera tool by creating
keyframes. For more information on using the Record button and keyframing, see Using
the Record Button.
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Note: The Walk Camera tool is only available when Active Camera, Camera, or Perspective
is selected from the Camera menu. For more information on the Camera menu, see
Camera Menu.

Walk Camera tool

To use the Walk Camera tool
1 Select the Walk Camera tool in the Toolbar.

The pointer changes to indicate that the Walk Camera tool is active.

2 Use the Up Arrow, Down Arrow, Right Arrow, and Left Arrow keys to move the camera
in 3D space; hold down the Option key in conjunction with the arrow keys to move the
camera more slowly.

You can also drag in the Canvas to orient the camera.

Animating Cameras
Cameras can be animated directly in the Canvas by the same means used to animate any
other object in a project. Cameras can also be animated through the use of behaviors,
including special Camera behaviors. For more information on Camera behaviors, see
Camera Behaviors.

For more information on animating with keyframes, see Keyframes and Curves.

Isolate
The Isolate command (and Isolate button) temporarily aligns the current view with the
selected object and hides all other objects in the scene, facilitating access to distant or
obscured objects.

Isolate button

To isolate an object
1 Select the object you wish to isolate in the Canvas, Layers tab, or Timeline.
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2 Do one of the following:

• Choose Object > Isolate (or press Control-I).

• In the Layers tab or Timeline, click the Isolate button.

The current view changes to align itself with the selected object, and all other objects
in the scene are hidden.

Object in the Canvas Object after isolation

When an object is isolated, a temporary camera is created and listed in the Camera
menu. The camera shares its name with that of the isolated object.

To exit the isolated view
Do one of the following:

µ Choose Object > Isolate (or press Control-I).

µ In the Layers tab or Timeline, click the Isolate button.

µ Choose a different camera from the Camera menu.

Using Multiple Views with the Isolate Command
You can isolate as many objects as you have views. It is possible to edit an object in an
isolated view while looking at the results through a scene camera in another view. Once
an object is isolated in a view, you can activate another viewport and isolate a different
object.

Drag and Drop onto the Canvas
Dragging and dropping an object onto the Canvas adds the object to the scene at the
focal plane of the current camera. Dragging an object into the Layers tab or clicking the
Apply button in the Preview Area of the File Browser positions the object at 0,0,0.
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Using Cameras to Set Up Useful Working Views
When building a 3D project, it can be useful to position cameras to examine your project’s
layout from different viewpoints. Rather than repeatedly moving the Perspective camera,
you can add scene cameras to use as “spatial bookmarks.” You won’t want to use these
cameras during export, so be sure to disable them before rendering.

Depth of Field
In the real world, cameras have a limited range of focus. Objects within that range appear
sharp, and the further outside that range an object is, the blurrier it appears. This effect
is used by camera operators to help limit which part of a scene the viewer pays attention
to. Motion allows you to simulate that phenomenon, thereby increasing the sense of
depth in a 3D scene.

Every camera in Motion has a focus offset that determines the precise location of perfect
focus. Stretching away from that point in either direction are near and far focus points,
which determine the range of the depth of field.

Depth Of Field Focus Offset
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Note: Certain complex objects will not be affected by depth of field settings. These objects
include local 3D text, paint, particles and replicators. The objects in these groups will
likely be spread out along the z axis, but the camera cannot measure their relative depth
and thus cannot accurately render depth of field. The entire object will be rendered with
a constant level of blur.

Depth of Field Controls
Depth of Field settings are found in the Camera tab of the Inspector. By default, cameras
view all objects in focus, regardless of their distance. The Depth of Field controls allow
you to set a range of focus by changing the Near Focus and Far Focus parameters. Objects
outside that range will be blurred. You can also modify the type and amount of blur used
to render the out-of-focus effect.

DOF Blur Amount: A slider to control the maximum amount of blur applied to out-of-focus
objects.

Focus Offset: A slider to set the distance from the camera that will be in perfect focus.

Near Focus: A slider to set the nearest point of focus, measured in pixels as an offset
from the focal distance.

Far Focus: A slider to set the farthest point of focus, measured in pixels as an offset from
the focal distance.

Infinite Focus: Selecting this checkbox sets the far focus to infinity, overriding whatever
setting is chosen in the Far Focus slider.

Filter: A pop-up menu to set the type of blur algorithm used to render the out-of-focus
areas. Choices include: Gaussian or Defocus. The Defocus setting renders a more realistic
effect, but may impact performance. For best results, use Gaussian when setting up a
scene, and Defocus for final output.

Filter Shape: When the Filter pop-up menu is set to Defocus, use this pop-up menu to
choose between a disk-shaped, or polygon-shaped render kernel. Different shapes will
produce subtly different blur patterns simulating different types of camera lenses.

Sides: When the Filter Shape pop-up menu is set to Polygon, this slider sets the number
of sides in the polygon.

Depth: Pop-up menu to set the depth to Radial or Planar. While radial will typically exhibit
more realistic results there are certain cases where it may look artificial. These include
cases where the camera is set to a high DOF Blur Amount and/or the object is close to
the edge of the frame, the object is very large, the object is rotated and other similar
instances. In these cases, switching to Planar may produce improved results.

Rendering Depth of Field Effects
When depth of field is employed, playback performance may be significantly impacted.
To alleviate this, you can disable the effects of depth of field settings while working on
other aspects of your project.
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To enable/disable depth of field effects
µ From the Render pop-up menu in the Toolbar, select Depth of Field (or press

Option-Control-D).

When a check mark is visible next to the menu item, the effects will be rendered. When
no check mark is visible, all objects will remain in focus.

For information on overriding this setting during export, see Overriding Project Settings
Selected in the Render Pop-Up Menu.

Camera Behaviors
While most types of behaviors in Motion can be applied to cameras, there is an additional
set of special Camera behaviors specifically designed to be applied to a camera in a 3D
project. These behaviors create basic camera moves such as dolly moves, panning, and
zooming without keyframing.

To add a Camera behavior
1 Select a scene camera in the Layers tab, Timeline, or Canvas.

2 Click and hold the Add Behavior icon in the Toolbar, choose Camera from the pop-up
menu, then choose an item from the submenu.

There are six camera-specific behaviors: Dolly, Focus, Framing, Sweep, Zoom In/Out, and
Zoom Layer. These behaviors are applied directly to a camera object.

Dolly
Moves the camera a specified distance along the camera’s Z axis.

Parameters in the Inspector
Distance: A slider and value slider that set the distance of the dolly movement.

Speed: A pop-up menu that sets the type of interpolation used for the movement. The
value can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

HUD Controls
The HUD contains the same controls as the Inspector.

Focus
Animates the camera’s Focus Offset parameter to focus on a target object. For more on
camera focus settings, see Depth of Field.

Tip: This behavior can be used to perform a rack-focus effect during a scene.

Parameters in the Inspector
Target: An image well to specify the object upon which the camera will focus.

Transition: A slider to set how long it will take for the camera to reach the framing
position, measured as a percentage of the behavior’s duration.
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Speed: A pop-up menu that sets the type of interpolation used for the movement. The
value can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

HUD Controls
The HUD contains the same controls as the Inspector.

Framing
Animates the camera along a path to position it directly in front of a selected object. You
can control how the object fits into the frame at the ending position, and you can control
the shape of the path to affect the amount of bend or curvature, as well as the apex of
such a curved path. Other parameters allow you to customize the camera’s orientation
along the path, the speed at which it travels, and at what point it begins orienting towards
the target object.

The Framing behavior has onscreen controls to allow you to manipulate the path and
ending position directly in the Canvas. For more information on using the Framing
behavior’s onscreen controls, see Framing Behavior Onscreen Controls.

Tip: Multiple framing behaviors can be arranged consecutively to move a camera from
one object to another over the course of a scene.

Warning: Applying a Framing behavior before or after a Basic Motion behavior, such
as Motion Path or Throw, can create unexpected results. These behaviors can continue
to affect the object even after the behavior ends. For example, If a Framing behavior
was applied after a Motion Path, the residual effect of the Motion Path would be
combined with the path generated by the Framing behavior, resulting in the target
object being framed improperly. For more about Basic Motion behaviors, see Basic
Motion Behaviors.

Parameters in the Inspector
Target: An image well to specify the object upon which the camera will be framed.

Target Face: A pop-up menu listing the primary axes: Right (+x), Left (–x), Top (+y),
Bottom (–y), Front (+z), and Back (–z) to specify which face of the target to frame.

Up Vector: A pop-up menu providing a constraint for the camera to keep it the right
way up. The pop-up menu offers the following choices: Auto, Target +X, Target –X, Target
+Y, Target –Y, Target +Z, Target –Z, World +X, World –X, World +Y, World –Y, World +Z,
World –Z.

Auto tries to guess which axis should be pointing up, and the other choices allow the
user to specify an axis directly.

Framing: A pop-up menu to choose how the target should be framed. The menu choices
include:

• Fit Horizontal: Positions the camera so the full width of the target fits within the width
of the frame.
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• Fit Vertical: Positions the camera so the full height of the target fits within the height
of the frame.

• Fit Both: Positions the camera so both width and height of the target fit within the
frame.

• Simple Fit: Positions the camera so both width and height of the project fit within the
frame. If the target object is larger or smaller than the project dimensions it may not
properly fill the frame.

• Custom Fit: This option appears when the Framing Offset parameter is manipulated
manually.

Framing Offset: Three sliders (X, Y, and when expanded, Z) to offset (in pixels) which
point on the target should be centered, relative to the camera. This allows you to target
a point other than the center of the object. The Z slider moves the camera nearer or
farther away from the target.

Offset Path Apex: A slider to set the position along the path (from the original position
to the framing position) where the bend (if any) will occur if the user chooses to offset
the path. It is expressed as a value between 0 and 1, 0 being at the start of the path, 1 at
the end, and 0.5 being halfway along the path.

Path Offset: Three sliders (X, Y, and when expanded, Z) to offset the camera’s position
from the path, measured in pixels.

Orientation: A pop-up menu to set whether the camera is oriented towards the target
at every frame (Orient to Current) or oriented towards the target at its final position (Orient
to Final).

Position Transition Time: A slider to set how long it will take the camera to reach the
framing position, measured as a percentage of the behavior’s duration.

Rotation Transition Time: A slider to set how long it will take the camera to reach the
framing orientation, measured as a percentage of the behavior’s duration.

Transition: A pop-up menu listing choices for the speed of the transition. Choices include:
Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

Ease Out Time: A slider to set the percentage of the behavior’s duration at which the
ease out starts. The ease out will ramp down the behavior’s effect until the end of the
behavior.

Ease Out Curve: A slider that sets the rate of the ease out.

HUD Controls
The HUD contains a subset of the controls in the Inspector.

1218 Chapter 18 3D Compositing



Framing Behavior Onscreen Controls
The Framing behavior has onscreen controls that allow you to directly manipulate the
behavior settings in the Canvas.

Framing controls

Offset Path Apex

Camera motion path 
(created by Framing 
behavior)

Framing Offset control

When a Framing behavior is applied and selected, The controls in the Canvas allow you
to create a custom framing size and shape, as well as visually adjust the Framing Offset
and the Offset Path Apex.

To create a custom framing size and shape
µ With the Framing behavior selected in the Layers tab or the Timeline, click any corner of

the white frame control in the Canvas.

To adjust the Offset Path Apex
µ With the Framing behavior selected in the Layers tab or the Timeline, drag the small white

box along the diagonal white line to reposition the apex.

To adjust the Framing Offset
µ With the Framing behavior selected in the Layers tab or the Timeline, drag the 3D control

or any of the three colored arrows.

Sweep
Pivots the camera across a specified arc.

Parameters in the Inspector
Start: A dial and value slider that set the camera’s starting angle relative to its current
orientation. A nonzero value causes the camera to jump to this value at the start of the
behavior.
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End: A dial and value slider that set the camera’s final angle relative to its Start parameter
value.

Speed: A pop-up menu that sets the type of interpolation used for the rotation. The value
can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

Axis: A pop-up menu that sets the axis around which the sweep occurs. Value can be
set to Tilt X, Swivel Y, or Roll Z.

HUD Controls
The HUD contains the same controls as the Inspector.

Zoom In/Out
Animates the camera’s Angle of View parameter.

Parameters in the Inspector
Zoom: A slider and value slider that set a proportional value used to modify the camera’s
Angle of View parameter. For more information about the Angle of View parameter, see
Camera Controls.

Speed: A pop-up menu that sets the type of interpolation used for the movement. The
value can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

HUD Controls
The HUD contains the same controls as the Inspector.

Zoom Layer
Moves a camera to the position of a target object’s anchor point. Once the camera reaches
the object’s anchor point, the angle of view changes while offsetting the camera’s position
based on the Zoom parameter. (This parameter is set to 0 by default so no animation of
the Angle of View will occur.)

This behavior also allows you to animate the camera’s Angle of View during the camera’s
movement, based on the behavior’s Transition value. For more information about the
Angle of View parameter, see Camera Controls.

Parameters in the Inspector
Object: An image well to set the target of the camera’s movement. Drag an object from
the Layers tab into the well.

Transition: A slider and value slider that determine how far into the behavior the camera
stops moving and the camera’s Angle of View parameter begins to animate instead.
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If Transition is set to 50% in a Zoom Layer behavior that has a length of 300 frames, the
camera move takes 150 frames to arrive at the position of the target object and then
stops moving for the duration of the behavior, and the camera’s Angle of View parameter
animates over the rest of the duration. If Transition is set to 100%, the camera move takes
the full 300 frames to arrive at the position of the target object, and the camera’s angle
of view does not animate. If the Zoom Layer behavior’s duration is 100 frames, and
Transition is set to 50%, the camera move takes 50 frames to arrive at the position of the
target object.

Speed: A pop-up menu that sets the type of interpolation used for the rotation. The value
can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

Zoom: A slider and value slider that set a proportional value used to modify the camera’s
Angle of View parameter. A nonzero value determines how much the angle of view (and
thus perspective) changes relative to the camera’s initial angle of view. A zero value for
Zoom leaves the Angle of View parameter unchanged.

HUD Controls
The HUD contains the same controls as the Inspector.

2D and 3D Group Intersection
The 3D group type adds a new level of flexibility to your projects, but also creates complex
interactions between group types.

Groups can either be 2D or 3D, and it is possible to change a group’s type at any time.

To change a group’s 2D/3D type
µ In the Layers tab or Timeline, select the group you wish to change, then do one of the

following:

• Choose Object > 3D Group (or press Control-D).

• Click the 2D/3D icon in the Status column in the Layers tab.

2D icon

3D icon

• Click the Type pop-up menu in the Group tab of the Inspector.
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Root-Level Behavior
At the root level of the project, 2D groups behave differently than when they are nested
inside 3D groups. (For more information about root-level groups, see Relative Coordinates.)
2D groups at the root level are locked to the camera, even if the camera is animated. 2D
groups at the top of the Layers tab are always rendered in the foreground, and 2D groups
at the bottom of the Layers tab are always rendered in the background. Adjacent root-level
3D groups can intersect based on depth order.

Layers tab Result in Canvas

In the example above, the two gray balls in the 2D Foreground layer are always composited
on top of the rest of the scene. The 2D Background layer is always composited beneath
the rest of the scene. Group A and Group B intersect because they are 3D groups, but
neither of them can intersect with either of the 2D root-level groups.

2D and 3D Group Interaction
While 2D and 3D groups share a lot of common properties, there are distinct differences
in how they and their children behave and interact with other objects in a project. 2D
and 3D groups can be parents or children of each other; there are no restrictions on
mixing group types.

Important: Some operations, as well as the application of certain filters or a mask, cause
a group to be rasterized. When a group is rasterized, it is converted into a bitmap image.
Rasterization affects 2D and 3D groups in different ways. For more information, see Groups
and Rasterization.

Group Tab in the Inspector
In the Inspector, the Group tab appears when a group is the selected object. The Group
tab contains the Type parameter, a pop-up menu that allows you to switch a group
between 2D and 3D mode. A 2D group has different available parameters than a 3D
group.
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When the Type parameter is set to 3D, the Flatten and Layer Order parameters become
available. When the Flatten checkbox is selected, all of the elements in the 3D group are
flattened like a “card” or “billboard.” When the Layer Order checkbox is selected, the
group’s children are sorted by their order in the Layers tab rather than depth order
(position along the Z axis). For more information, see Layer Order and Depth Order.

When the Type parameter is set to 2D, the Fixed Resolution parameters become available,
allowing you to manually define the size of a group. By default, Fixed Resolution is disabled
and the size of the group is determined by the layers within that group. For more
information, see Fixing the Size of a Group.

Note: When selected, Fixed Resolution crops the group to the size specified in the Fixed
Width and Fixed Height parameters, around the anchor point of the group.

2D Group Properties
A 2D group has the following properties:

• Its children are composited in layer order.

• Filters are applied to the group in local space; that is, “flat” to the image.

Checkerboard in 2D group with Twirl filter applied

• The group is lit as a single object; its children are not lit individually.

Note: 2D groups at the root level are not lit.

• Because it is always flat, a 2D group has Crop, Drop Shadow, and Four Corner parameters.

• It can have a fixed resolution.

3D Group Properties
A 3D group has the following properties:

• Its children are composited in depth order (according to their position along the Z axis).
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• Filters are applied to the group in view space. In other words, the filter affects the group
as if it was applied to the lens of the camera viewing the group.

Checkerboard in 3D group with Twirl filter applied from three different angles

• Its children are lit individually.

• Only a 3D group with the Flatten parameter enabled has the Crop, Drop Shadow, and
Four Corner parameters.

Working with Objects Inside 2D Groups and Flattened 3D Groups
You can use the Isolate command to align the active view with the axis of a 2D group
or flattened 3D group. Doing so facilitates making adjustments to objects inside the
group. For more information on the Isolate command, see Isolate.

Should you be unable to find an object in your project, you can locate it by resetting
its Position parameter to 0, 0, 0. This centers the object in the flat group.

When moving an object along its Z axis inside a flat group—which includes 2D groups
and flattened 3D groups—the object appears to grow larger or smaller rather than
move closer to or further away from the camera.

Lighting
Lighting can be applied to a motion graphics project to enhance the depth and scope
of compositions, or it can help in creating realistic environments for composites.

Motion’s lighting system only works on 3D groups and their children.

To add a light to a project
µ Choose Object > New Light (or press Command-Shift-L).

A light object is added to the Layers tab, the Timeline, and the Canvas (represented there
by a wireframe icon), and the 3D transform tool in the Toolbar becomes active.
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If you add a light to a project with no existing 3D groups, the following dialog appears:

If you select Keep as 2D, a light at the root level has no effect until you have at least one
root-level 3D group. By default, 3D groups and objects display the shading from lights
as soon as lights are added.

A light is activated when it is a child of the following objects:

• The project (for example, a light is at the root level of the project)

• An unflattened 3D group

Properties Affecting the Appearance of Lights
When you add lights to a scene, two groups of properties contribute to the appearance
of lights: light properties and object lighting properties. You can adjust light properties
by selecting a light object in your project, then modifying the parameter values in the
Light tab in the Inspector. You can manipulate object lighting properties by selecting a
nonlight object in your project (an image, movie clip, shape, and so on), then adjusting
the Lighting parameters in that object’s Properties tab.

Light properties—the quality of the light source itself—fall into the following categories:
the type of light, its intensity, and its color. A light bulb, the sun, and lighting in a dance
club each have a different appearance, and lighting properties can be used to simulate
these differences.

Combining Multiple Light Types
Like real-world lights, you can use multiple lights to mix color. If one red and one blue
spot light are pointed at a white object, they mix to make magenta.

Each type of light has its own unique attributes. It may take a combination of light types
to achieve your desired effect. Most scenes with lights should include an ambient light
to add depth or prevent total darkness.

Light Parameters
When you create a light, or select a light object in the Layers tab, the Light tab becomes
available in the Inspector.
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Parameters in the Inspector
Light Type: A pop-up menu that lets you choose from four categories of light.

• Ambient: An ambient light emits light in all directions, illuminating all objects in the
scene from all directions equally. This type of light has no position and no representation
in the Canvas. Additionally, ambient lights are the only lights that do not affect
highlights. The most common use for ambient lights is to add an overall fill effect or
color cast.

Note: There is no global ambience property in Motion, so you may have to add an
ambient light to prevent total blackness.

• Directional: A directional light emits parallel rays of light in a specified direction from
a source located at an infinite distance. Only the rotation of this light has bearing on
its effect. A directional light icon, in conjunction with the transform controls, can be
used to assist in visualizing the direction the light is traveling in a scene. The directional
light appears as a cylinder with one end removed. The circle represents the back of the
light, and the lines indicate the direction in which the light is traveling.

Directional light Example of a directional light
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• Point: A point light emits light outward from a single point in 3D space in all directions.
Optionally, you can add falloff based on an object’s proximity to the light. This is Motion’s
default light, and it produces results similar to that of an incandescent light bulb.

Point light Point light example

• Spot: A spot light emits light from a conical light source and casts an elliptical pattern
on objects hit by the light. Using a spot light allows for a high degree of accuracy when
you wish to limit the area affected by the light.

Spot light Spot light example

Color: A standard set of controls that enable you to select the color of the light.

Intensity: This is the “dimmer switch” for lighting. If you use a Directional light at 100%
intensity pointed straight at a red object, the object looks red. If you lower the intensity,
the object and scene get darker. However, if you increase the intensity above 100% you
can begin to overexpose your scene, eventually causing the object to appear white. The
Intensity value slider can be used to set a value between 0 and 400, but there is no upper
limit for Intensity (use the value slider to set a value above 400).

Note: Multiple lights interacting with an object will combine to increase the object’s
apparent brightness. If you have two spot lights overlapping in space and pointing in
the same direction with Intensity set to 100%, you will see the same result as having a
single spot light with its Intensity set to 200%.
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Falloff Start: A slider and value slider that enable you to adjust where the falloff point of
a light begins. In the real world, light falls off—or has less of an effect—as the distance
from the light increases. Usually falloff starts at the center of the light. Setting Falloff Start
adds some additional control to your lighting. This parameter applies only to light types
that utilize a Position parameter (Point and Spot).

In the example below, a light is positioned slightly above the origin of the scene. There
are three rings of cards at a distance of 200, 500, and 1000 units from the light. (In this
example, a visible light source—the “bulb” at the center of the rings of cards—is simulated
for illustrative purposes.) The light’s Intensity is set to 100% and Falloff is set to 10%. When
Falloff Start is set to 0 (left, below), the light has already begun to fall off by the time it
hits the innermost ring. When Falloff Start is set to 200 (right, below), the inner ring is lit
at 100% intensity and the outer rings are slightly brighter than before.

Falloff Start set to 0 Falloff Start set to 200

When Falloff Start is increased to 500 (left, below), both the inner and middle rings are
lit at 100% intensity, and the outer ring is brighter than before. Finally, when Falloff Start
is set to 1000 (right, below), all of the rings are lit at 100% intensity.

Falloff Start set to 500 Falloff Start set to 1000
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In the next example, the image on the left contains a light with Intensity set to 100%,
while the image on the right has a light Intensity of 500%. In the image on the right, the
outer rings are slightly brighter, but the innermost ring is overexposed. If the Falloff Start
of the light in the image on the right were increased to 1000, the rings would be
overexposed.

Intensity set to 100; Falloff Start set to 0 Intensity set to 500; Falloff Start set to 0

Falloff: A slider and value slider that control the rate of falloff for a point or spot light
based on the Falloff Start setting. At low values, light falls off over a long distance from
the light source; therefore, the light travels further in the image. At high values, the falloff
occurs more rapidly.

Spot Cone Angle: A dial and value slider that become available only when Light Type is
set to Spot. The Spot Cone Angle is measured from the center of the light outward. The
angle may be set to a value between 0 and 90 degrees. The distance of the light from its
target affects the result of this parameter. If the light is close, a wider spot cone angle
may be needed to light more of the object. If the light is further away, a lower Spot Cone
Angle may be needed to isolate objects.

Cone Softness: A dial and value slider that become available only when Light Type is set
to Spot. Like Spot Cone Angle, this parameter can be set to a value between 0 and
90 degrees. Its starting point begins at the outer edge of the Spot Cone Angle. If set to
0, spot lights have a hard edge. Low values produce a slight softening effect to the
boundary of the lit area. Higher values produce a wide, more natural fade. Adding softness
expands the area of your light, so you may need to adjust the angle to achieve the desired
effect.

Note: Point lights and Spot lights also contain a set of parameters to control how they
cast shadows. For more information on these parameters, see Shadows.

HUD Controls
The Light HUD contains the Light Type, Color, Intensity, Falloff Start, and Falloff parameters,
which are also available in the Inspector. The Light HUD also contains 3D transform
controls. For more information, see 3D Transform HUD Controls.
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Object Lighting Parameters
All “lightable” objects have properties that control how they react to lights in a scene.
You can adjust these properties for a given object via the Lighting section of the Properties
tab.

Shading: A pop-up menu that enables you to set how an object responds to lights in
the scene. If set to On, the object can be lit. If set to Off, the object ignores scene lights.
If set to Inherited (the default), the object uses the Shading value of its parent.

Note: It is possible to set the Shading parameter of a child of a group (however deep it
may be nested) to On; that setting overrides any group settings previously applied to the
child object.

Highlights: A checkbox that controls whether or not lit objects show highlights. This
parameter has no effect if Shading is set to Off.

Shininess: A slider and value slider that set how strong an object’s highlights appear.
Higher values create a glossier appearance.

You may have to finesse both object surface properties and lighting parameters to achieve
the desired result.

Simulating Visible Lights
Light sources are not visible. You can simulate a visible light source by combining a point
light and an image or shape.

Simulated visible light source created by 
combining a light with a shape

Note: Use the Match Move behavior to move a simulated light source with a light in a
movie clip. For more information on the Match Move behavior, see Match Move Workflows.

Disabling Lighting
Lighting effects can significantly impact playback performance, so you may want to
temporarily disable all lighting to improve playback speed while working on other aspects
of your project.
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To Disable Rendering of Lighting
µ Click the Render pop-up menu in the Canvas Toolbar and choose Lighting or press

Option-L.

For information on overriding this setting during export, see Overriding Project Settings
Selected in the Render Pop-Up Menu

Shadows
Motion scenes that include Point or Spot lights can recreate more natural, realistic effects
by casting shadows. Shadows are created when opaque or semi-opaque object blocks
light from hitting another object. In order to see a shadow in Motion, you need at least
three things: A shadow-casting light source, an object to cast a shadow, and another
object upon which the shadow is cast. Multiple lights will cast multiple shadows that may
or may not be visible depending on the relative positions and settings of the objects in
the scene.

Note: Ambient and Directional lights do not cast shadows.

Warning: Some changes you make to 3D objects with shadows applied may cause the
shadows to disappear. This occurs when the change causes rasterization of the 3D
object—adjusting the opacity of a group or turning on the glow attributes for a text
object, for example. Flattening the 3D group will allow it to cast shadows again. For
more information about disappearing shadows, see Shadows and Rasterization.

In Motion, you can control whether a light source will create shadows, and whether each
object in the scene receives shadows and/or casts shadows. You can even have an object
cast a shadow when it is itself invisible. The strength, sharpness, shape, and position of
the shadow depends on the type and positions of the lights and relative position of all
three objects.
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Cast Shadows Versus Drop Shadows
There are two common types of shadow effects used in motion graphics work: drop
shadows and cast shadows. Motion can create both effects, but because they have
different purposes and applications, it may be helpful to consider the differences between
them. Both cast and drop shadows simulate the effect of light being blocked by an
opaque object. But a cast shadow is a 3D effect requiring a light source and an object
for the shadow to fall upon, and a drop shadow is a 2D effect simulating a cast shadow
without a light source and so is limited to a very small range of settings.

Cast shadowDrop shadow

Drop shadows are commonly used to simulate depth and separate foreground objects
from the background in 2D projects. The classic drop shadow effect is used on
light-colored titles so the text is legible against both dark and light backgrounds. In a
drop shadow effect, the imaginary light source does not create any shading effect on
the surface of the object and the shadow’s position is set at a fixed direction.

The shadow is actually rendered as a part of the foreground object, so it doesn’t interact
with any background objects. However, because it is an effect, a drop shadow’s
appearance can be directly customized; the softness, opacity, position, and even its
color can be customized and animated without the need to indirectly manipulate a
light source.

Cast shadows are true 3D effects, and their appearance is determined only by the light
source and the other objects in the scene. Multiple cast shadows interact with each
other and take their shapes based on the surfaces and positions of the objects upon
which they are cast.

Shadow Controls
Shadows are controlled by adjusting settings in two places. Point and spot lights have a
Shadows section in the Light tab of the Inspector, and all visible objects have a Shadows
section in the Properties tab in the Inspector.
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Note: 2D groups at the root level of the project do not have lighting or shadow controls.
To enable shadows on such a group, convert it to 3D or embed it within another 3D
group.

Shadow Parameters in the Light Tab
Shadows Checkbox: The shadows group in the Light tab of the Inspector can be turned
on and off using the Shadows checkbox. By default, it is deselected. This allows you to
set certain lights to cast shadows, and others not to cast shadows.

Selecting this checkbox causes the light to cast shadows on objects in front of it if they
also have their shadow controls enabled. Deselecting it will exempt the light from
generating any shadows, regardless of the settings on the individual objects.

Opacity: This slider controls the apparent opacity of the shadow. Dragging the slider to
the left creates a lighter shadow.

Opacity set to 25%Opacity set to 75%

Softness: This slider determines how blurry a shadow will appear.

Note: The appearance of a shadow is dependent on the rendering quality of the object
casting it. Because a shadow may be larger than the original object, you may see some
jagged edges or aliasing on a shadow that was not visible on the source object. If you
see such artifacts, be sure to check how your image looks when the project is set to best
quality, rather than draft or normal. For more about Canvas display quality, see Canvas
View Options.

Uniform Softness: Select this checkbox to constrain the results of the softness slider to
a uniform amount of blur on the shadow regardless of distance between the light, the
object casting the shadow, and the object receiving the shadow.

By deselecting the checkbox, you enable nonuniform softness, where the farther away
the objects are from each other, the more blur is applied.
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Note: Selecting non-uniform softness can impact playback performance.

Nonuniform softnessUniform softness

Note: Intersecting objects reveal an unnatural effect of using uniform softness. Because
an equal amount of blur is applied to the entire shadow, the blur appears to spill out in
front of the intersecting object, creating a strange appearance. This effect can be
eliminated in two ways; either by deselecting the Uniform Softness checkbox or setting
the object to not receive shadows.

Non-uniform softness

Uniform softness

Uniform softness with text object rejecting shadows

Shadow appears in front 
of intersecting objects.

No shadow appears.

The shadow is not visible 
on the text object.
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Color: This control allows you to set the color of the shadow. While semi-transparent
objects will cast lighter shadows than opaque objects, you cannot create light transmission
effects wherein a semi-transparent object allows some light to pass through it, picking
up it’s color or pattern and projecting that as part of the shadow as light passing through
stained glass would. For more on using the color controls, see Color Controls.

Note: When light shading is turned on, shadows are multiplied with the objects upon
which they are cast. This means that the result will be a darkening effect, regardless of
the color of the shadow. If you select a shadow color lighter than the background upon
which is is cast, the shadow may not be visible. So, for example, when shading (lighting)
is turned on, it is not possible to cast a white shadow on a dark surface. To override this
effect, you must disable shading. For more about using shadows without lights, see
Shadows Without Lights.

Shadow Parameters in the Properties Tab
Every visible object in a 3D space will have shadow controls in the Properties tab of its
Inspector. This includes shapes, clips, particles, and so on. Lights, Cameras, and 2D groups
at the root level of the project do not have shadow controls.

Cast Shadows: This checkbox sets whether or not an object will cast a shadow if it is
between a light source and another object.
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Receive Shadows: This checkbox controls whether or not neighboring objects’ shadows
will affect the current object. When deselected, light will affect the object as if the
shadow-casting object did not exist. The following image depicts an object (the white
ring) with the Receive Shadow checkbox selected and the Casts Shadow checkbox
deselected.

Shadows Only: This checkbox allows an object to block light and cast a shadow, while
the object itself does not appear in the scene.
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You can select both Receives Shadows and Shadows Only, which makes the object invisible
except for the regions where a shadow is cast upon it.

Shadows and Complex 3D Objects
When using shadows with objects such as particle systems, text objects, or replicators
that are set to 3D, shadows will be cast from one part of the object onto another part.
This is called self-shadowing.
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Modifying the object in a way that causes rasterization prevents shadows from being
displayed.

In some cases you may be able to find another way to perform the effect that will not
require rasterization. For example, in the following images, rather than modifying the
opacity of the particle emitter, which causes rasterization, you can modify the opacity of
the particle cells, creating the desired effect and maintaining the desired shadows.

Emitter set to 100% Opacity Emitter set to 60% Opacity Particle cells set to 60% Opacity

Note that in the second figure, the layer order of the particle system has been affected,
and all particles now appear in front of the letter A. For more about how rasterization
affects shadows, see Shadows and Rasterization.

Shadows Without Lights
Lighting and shadows can each be disabled independently. You can keep shadows visible,
even when lighting is disabled, allowing you to keep the original unshaded look of the
scene. Turning off lighting also changes the way shadows are rendered.
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When Shading (the visible effect of lighting) is disabled, shadows behave differently.
Rather than being multiplied with the object upon which they are cast, the shadow’s
color and opacity are controlled only by the Shadows settings in the Light tab of the
shadow-casting light’s Inspector.

Shading enabled Shading disabled

This enables you to create shadows of any color or opacity, from traditional dark shadows
to brightly colored or even white shadows.
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Shading can be disabled globally by choosing View > Render Options > Lighting (Option-L)
or by choosing Lighting in the Render pop-up menu above the Canvas (make sure there
is no checkmark beside the menu item). It can also be disabled for a specific object in
the Lighting section of an object’s Properties tab. For more about disabling
lighting/shading see Disabling Lighting.

Shading disabled globally Shading disabled on floor object

With Spot lights, enabling shadows but disabling shading can create an seemingly strange
result where the shadow is suddenly cut off because it has exceeded the scope of the
light cone. Because the shading effect of the light cone is turned off, the shadow edge
looks unnatural.

To correct such an occurrence, simply increase the Cone Angle in the Light Inspector.

Disabling Shadows
Rendering shadows can significantly impact playback performance, so you may want to
temporarily disable all shadows to improve playback speed while working on other aspects
of your project.

To disable rendering of shadows
µ Choose Shadows from the Render pop-up menu in the Status Bar (or press

Control-Option-S).
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For information on overriding this setting during export, see Overriding Project Settings
Selected in the Render Pop-Up Menu

Reflections
In the real world all objects exhibit some degree of reflectivity based on surface shine,
brightness, angle of view, and proximity to the reflected objects. Motion simulates this
natural effect, equipping every object with a set of parameters to create and control
realistic-looking reflections. When Reflections are enabled for an object, all other objects
in the scene will be reflected but may only be visible from certain angles and distances.

Reflection Parameters
The Properties tab in the Inspector window includes a Reflection section.

Reflections Parameters in the Properties Tab:
Reflection: This checkbox enables reflections based on the settings of the parameters
within the group.

Reflectivity: This slider controls how shiny the object’s surface appears. 0% indicates no
reflectivity at all, while 100% is perfectly reflective, like a mirror.

Blur Amount: Real reflections can appear in sharp focus or quite blurry depending on
the surface quality of the reflecting object.
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Falloff: This checkbox determines whether the reflection fades with distance from the
object, producing a more realistic result. There are additional options within the Falloff
section once this checkbox has been enabled:

No Falloff With Falloff

Begin Distance: This slider determines the distance (inside the reflection) at which the
falloff begins. When the slider is set to 0, falloff starts at the reflection plane.

End Distance: This slider determines the distance at which the falloff ends, beyond which
the reflection isn’t visible. Adjusting this slider moves the falloff point closer to the
reflection plane, which causes less of the reflected image to appear.

Exponent: This slider controls how quickly a reflection gets fainter as the reflected object
gets further from the reflective surface.

Blend Mode: This pop-up menu determines the blend mode used for the reflection.
Blend modes other than “add” are useful for achieving different looks, even if they aren’t
physically intuitive. For more about the different blend modes, see Blend Modes.
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Other Reflection Parameters
Casts Reflection: The Properties tab of every object also contains a Casts Reflections
parameter (in the Blending section) that controls whether or not an object is reflective.
This pop-up menu has three choices demonstrated by the text object in the figures below:

• Yes: The object is reflected in nearby reflective objects.

• No: The object is ignored by reflective surfaces.
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• Reflections Only: The object becomes invisible, but appears in reflective surfaces around
it.

Reflections and Groups
In addition to choosing the reflections settings for individual objects, you can adjust the
settings for an entire group. Reflections settings for a group override the settings of
individual layers within the group. For example, if an individual object in a group was not
set to receive reflections, turning that setting on for the whole group will force the
individual object to receive them. Turning off the setting for the group allows the individual
objects’ settings to act as expected.

The Cast Reflections settings work differently. If the group is set to cast reflections,
individual objects’ reflections can still be turned off (or set to Reflections Only). However,
if the group is set to not cast reflections at all, individual objects will never cast a reflection,
regardless of their setting.

Disabling Reflections
Rendering reflections can significantly impact playback performance, so you may want
to temporarily disable all reflections to improve playback speed while working on other
aspects of your project.

To disable rendering of reflections
µ Choose Reflections from the Render pop-up menu in the Status Bar (or press

Control-Option-R).

For information on overriding this setting during export, see Overriding Project Settings
Selected in the Render Pop-Up Menu
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Limiting Recursive Reflections
When a reflective object is itself reflected in another object, the first object can be seen
in the reflection, potentially causing an endless repetition of reflections. Motion limits
the number of “reflective bounces” that can occur in a scene, preserving performance
and preventing the viewer from getting lost in infinity. The number of allowed reflections
is set per project.

To set the number of recursive reflections in the current project
1 Choose Edit > Project Properties

2 Click the Render Settings tab.

3 In the Reflections section, adjust the Maximum Bounces slider.

1245Chapter 18 3D Compositing





Motion tracking is a method of recording the movement of an element (a shape or
reference point in a movie clip) in the Canvas, then applying that recorded movement
data to another element in the Canvas. For example, you can use motion tracking
techniques to “pin” a post-production graphic to the side of a moving bus, “track” a blurry
circle to a person’s face to preserve an innocent bystander’s anonymity, or “replace” a
daring stuntman’s head with the lazy mug of a leading actor.

This chapter covers the following:

• About Motion Tracking (p. 1248)

• How a Tracker Works (p. 1249)

• Motion Tracking Behaviors (p. 1250)

• Shape Track Points Behavior (p. 1252)

• Track Parameter Behavior (p. 1252)

• General Motion Tracking Workflow (p. 1252)

• Match Move Workflows (p. 1257)

• Using a Non-Match Move Four-Point Track for Corner-Pinning (p. 1271)

• Stabilize Workflow (p. 1274)

• Unstabilize Workflow (p. 1277)

• Track Points Workflow (p. 1278)

• Track Parameter Workflow (p. 1282)

• Adjusting the Onscreen Trackers (p. 1283)

• Strategies for Better Tracking (p. 1285)

• Tracking Behavior Parameters (p. 1304)
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About Motion Tracking
Motion provides a set of automated tracking behaviors that allow you to do the following:

• Match move elements in movie clips: You can apply tracking data from a background
element (such as a billboard) to a composited foreground element (such as a graphic
of a logo) so that both elements appear to be locked together. This technique is known
asmatch moving.

• Match move animated objects in the Canvas: You can apply the motion data of an
animated object to another object in the project. For example, you can attach a smoke
particle emitter to an animated spaceship so that a rocket exhaust trail “follows”
wherever the spaceship moves.

• Stabilize camera movement in movie clips: You can apply tracking data to remove
unwanted camera movement or jitter in a movie or image sequence. For example, you
can smooth handheld camera shots.

• Unstabilize movie clips: You can restore movement to a previously stabilized movie.
This technique is useful when you have stabilized a clip in order to add a foreground
effect but wish to restore the original camera movement to the final composite.

• Track the position parameter of a filter: You can apply tracking data to the position
parameter of a filter. For example, you can make the center point of a Light Rays filter
follow a moving flashlight beam in a movie clip. The tracking data from the flashlight
beam is applied to a single parameter of the filter (the Center parameter), rather than
to the filter as a whole.

• Track the control points of a shape or mask: You can apply tracking data from reference
points in a movie clip to the control points of a shape or mask. For example, you can
use this technique to attach a mask to a moving element in a movie clip, thereby
isolating that element to apply additional effects to it.

Motion lets you track one or multiple reference features in a clip:

• One-point tracking: Track a single reference pattern (a small area of pixels) in a movie
clip to record position data.

• Two-point tracking: Track two reference patterns in a movie clip and use the relationship
between the two tracked points to record position, scale, and rotation data.

• Four-point tracking: Often referred to as four-corner pinning. Track four reference patterns
in a movie clip to record position, scale, and rotation data. The four trackers analyze
the relationship between four reference patterns, such as the corners of a picture frame
or television monitor. This data is applied to each corner of an image or clip to “pin”
the clip so that it appears locked in the picture frame or television monitor.

• Multiple-point tracking: Track as many reference patterns in a clip as you like. You can
manually add trackers within the Analyze Motion and Stabilize behaviors. When you
apply a Track Points behavior from the Shape behaviors subcategory to a shape or
mask, a tracker is automatically assigned to each shape control point.
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Note: Although Motion provides a 3D workspace, tracking in Motion is planar. In other
words, tracking does not occur in Z space. For example, if you are analyzing two features
in a clip—and that clip is moving in 3D space—you are recording the changes in position,
scale, or rotation over time in the clip but not its actual 3D transformation.

The object that is tracked is called the background or source element. The object to which
the tracking data is applied is called the foreground or destination element.

How a Tracker Works
A tracker analyzes an area of pixels over a range of frames in a movie clip in order to “lock
onto” a pattern as it moves across the Canvas. You specify the snapshot of pixels in one
or more reference frames, and Motion proceeds to track that snapshot for a specified
duration of time. This duration of time is based on the length of the tracking behavior,
the length of the defined play range, or the length of the clip. In Motion, that snapshot
is known as a reference pattern, and its area is automatically defined around the onscreen
tracker.

Tracker

Ideally, the reference pattern should be a consistent, easily identifiable detail with high
contrast—this makes the pattern easier to track.

The tracker advances to each subsequent frame, sampling many positions within the
search region around the center point of the tracker. Some of those positions “fit” the
previously designated reference pattern more closely than others, and the tracker finds
the position where the search region most closely matches the reference pattern (with
subpixel accuracy). For every frame analyzed, the tracker assigns a correlation value by
measuring how close the best match is.

In addition to searching for the reference pattern’s position, the tracker identifies how
the pattern transforms (scales, rotates, or shears) from one frame to the next. Imagine
you are tracking a logo on the shirt sleeve of a person walking past the camera. If the
person turns slightly as he passes the camera, the reference pattern becomes rotated.
The tracker looks not only for the reference pattern, but also for any shifts in that pattern’s
scale or rotation.
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When the tracker’s position and correlation values for a given frame have been determined,
Motion records this information in keyframes. This process is then repeated for every
frame, until the end of the track range has been reached.

The recorded data is stored as keyframes in the tracking behavior. The data allows you
to quickly apply the tracks to many project elements.

Note: The Stabilize behavior uses an advanced technology that analyzes the motion of
the entire frame of a clip, without the use of trackers.

There are six tracking behaviors in Motion: four in the Motion Tracking behaviors
subcategory, one in the Shapes behavior subcategory, and one in the Parameter behaviors
subcategory.

Motion Tracking Behaviors
Motion uses behaviors to collect, store, and apply the motion data. Because the data is
stored within the behavior (as keyframes), it can easily be applied to other objects within
a project. A Motion Tracking behavior can also be used to share animation data that is
created by behaviors or keyframes between objects. The Motion Tracking behaviors are
applied in the same manner as all other behaviors.

When a tracking behavior performs its analysis, track points appear in the Canvas, and
tracking keyframes are created within the behavior. These keyframes live within the
behavior that is applied to an object—the keyframes are not applied to the object itself.

Note: Onscreen track points (and their corresponding tracking keyframes that appear in
the Keyframe Editor) are not created when using the default motion analysis in the Stabilize
behavior.

When applicable, you can convert tracking data that is recorded or referenced by the
Match Move, Stabilize, or Unstabilize behavior to object keyframes. When converted, the
tracking behavior is removed and the transform keyframes are “baked” into the object.
For more information on converting behaviors, see Converting Tracks to Keyframes.

There are four Motion Tracking behaviors:

• Analyze Motion: This behavior is used only to generate and contain tracking information
from a clip. Unlike the Match Move and Stabilize behaviors, Analyze Motion has no
capability to alter the object being tracked. The tracks gathered by the Analyze Motion
behavior can be applied to other project elements via the Match Move, Track (in the
Parameter behaviors), and Track Points (in the Shape behaviors) behaviors.

Note: The Analyze Motion behavior can only be applied to footage (a QuickTime movie
or image sequence).

The Analyze Motion behavior can generate as many trackers as you like.
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• Match Move: This behavior is used to “match” a foreground element to a background
element so that they appear locked together. This effect can be achieved in three
different ways:

• You can match a foreground element to a background element using one-point
(position), two-point (position, scale, or rotation), or four-point (corner-pinning)
tracking. Unlike other tracking behaviors, Match Move can perform the compositing
operation, or you can perform further modifications (blur, color corrections, and so
on) before you create the final composite.

• You can reference a track recorded in another tracking behavior. A referenced track
is chosen from the tracking behaviors pop-up menu, located in the behavior’s HUD
or Inspector.

• You can quickly apply the animation data of an object, such as animation created
by behaviors or keyframes, to another element in the project without analyzing the
source object. Drag the animated source object to the Source well in the behavior’s
HUD or Inspector to apply its movement to the destination object.

Note: The Match Move behavior can be applied to nearly any object type.

• Stabilize: This behavior removes unwanted motion in a clip, such as camera jitter. The
stabilization can be applied to the horizontal or vertical movement in the clip, or to a
combination of horizontal and vertical movement. This effect can be achieved in one
of three ways:

• Motion can analyze and automatically stabilize a clip without the use of any trackers.
In this case, the Stabilize behavior evaluates the entire frame of a clip using motion
analysis to record the movement of the camera. This behavior offers two ways to
use this recorded data: clip smoothing, which eliminates unwanted jitter while
maintaining the general motion of the camera; and clip locking, which stabilizes a
subject. This behavior can analyze and affect position, scale, and rotation.

• In addition to full-frame motion analysis, you have the option to manually add trackers
for one-point (position) tracking or two-point (position, scaling, or rotation) tracking.
When you add manual trackers to the Stabilize behavior, Motion stabilizes the clip
using data from the trackers rather than from an automatic motion analysis. When
using this method, the tracker moves the entire frame so that the track point falls in
the same spot in each subsequent frame.

• You can load tracks recorded in another Stabilize behavior. To load another track,
choose a track from the tracking behaviors pop-up menu, located in the tracking
behavior HUD or Inspector.

Note: The Stabilize behavior can only be applied to footage (a QuickTime movie or an
image sequence).
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• Unstabilize: This behavior does not perform any tracking. Instead, the Unstabilize
behavior applies the movement recorded by another tracking behavior, such as Stabilize,
to a clip or object. This allows you to match the camera shake in a clip to foreground
elements added in post-production. To load the tracking data, choose a track from the
tracking behaviors pop-up menu, located in the tracking behavior HUD or Inspector.

Note: The Unstabilize behavior can be applied to nearly any object type.

Shape Track Points Behavior
The Track Points behavior, a member of the Shape behavior subcategory, allows you to
do either of the following:

• Track the control points of a shape or mask (including paint strokes) to reference features
on a source clip. For example, you can draw a mask around a car in a clip and then
track the control points of the mask to the moving car, cutting the car out of the
background. You can then apply effects to only the isolated car, and the surrounding
image is not affected.

• Apply existing tracking data that was recorded by the Analyze Motion, Match Move,
or Stabilize tracking behavior to the control points of a shape or mask.

Note: The Track Points behavior can be applied only to shapes (including paint strokes)
and masks.

Track Parameter Behavior
The Track Parameter behavior, a member of the Parameter behavior subcategory, allows
you to track a parameter of a filter, such as the Center parameter of a Circle Blur filter, to
a reference feature of a clip.

The tracking data is obtained in one of two ways:

• Once the Track Parameter behavior is added to a filter’s position parameter, a clip can
be analyzed from within the behavior and the recorded data applied to the position
parameter.

• Tracking data from another tracking behavior can be referenced by the Track Parameter
behavior. The recorded data from the referenced behavior is applied to the position
parameter.

Note: The Track Parameter behavior is designed for use with position parameters.

General Motion Tracking Workflow
This section is a general overview of the tracking workflow that is common to most of
the Motion Tracking behaviors. The Analyze Motion behavior is used in this example.
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The Analyze Motion behavior analyzes and stores tracking information from a clip. The
behavior does not transform the tracked object. This data can be referenced by other
tracking behaviors.

For a full description of the Analyze Motion parameters, see Analyze Motion Controls.

Tracking in one pass rarely yields perfect results without some fine-tuning. For information
on various tracking methods and tips, see Strategies for Better Tracking.

Important: With the exception of the Stabilize behavior’s automatic analysis mode, the
tracking analysis begins at the current playhead position for all workflows. To define a
tracking region, set an Out point for the tracked clip. If you are performing a reverse track,
set In and Out points for your track. To set an Out point, position the playhead at the
correct frame, select the clip, then choose Mark > Mark Play Range Out (or press
Command-Option-O). To set an In point, position the playhead at the correct frame, select
the clip, then choose Mark > Mark Play Range In (or press Command-Option-I).

To generate a track for a clip using the Analyze Motion behavior
1 In the Layers tab, Timeline, or Canvas, select the footage that you want to track, click the

Add Behavior icon in the Toolbar, then choose Motion Tracking > Analyze Motion from
the pop-up menu.

Note: You can also select the footage, select the behavior in the Library, then click the
Apply button in the Library Preview area, or drag a behavior from the Library to the
footage.
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The tracker is added to the footage. By default, a single tracker appears at the center of
the footage.

Tracker

2 Play your background clip several times to determine a good track point, then go to the
frame where you want to start the track.

3 In the Canvas, drag the tracker to the reference point you want to use.

Note: For more information on using the onscreen tracker, see Adjusting the Onscreen
Trackers. For more information on selecting a good tracking reference point, see Strategies
for Better Tracking.

4 To add trackers, click the Add button in the Behaviors tab of the Inspector.

Each new tracker is added to the center of the footage.

5 Drag the additional trackers to the reference points you want to use.

6 To track a specific range of frames, adjust the start and end points of the tracking behavior
(the purple bar) in the Timeline or mini-Timeline.

Note: If you adjust the length of the tracking behavior, make sure to set your tracking
reference points within the range of the behavior. In other words, if you set the tracker
to a point on the first frame of a clip, then change the start point of the tracking behavior,
the tracker will not analyze the point.

7 Click the Analyze button in the HUD or Behaviors tab of the Inspector.

Analyze button
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Once the tracking analysis begins, a progress window opens and track points on motion
path appear in the Canvas. The track point at the current playhead position is emphasized.

Track point at current 
playhead position

The tracking keyframes contained in the behavior appear in the Keyframe Editor.

Because the Analyze Motion behavior does not transform the source object, only the
tracking keyframes appear in the Keyframe Editor. When using a Match Move or Stabilize
behavior, the tracking keyframes appear as well as the transform curves of the source
object (for Stabilize) or destination object (for Match Move).

X position curve

Y position curve

Confidence curve
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A “confidence” curve is also displayed in the Keyframe Editor. This curve provides a visual
indication of the tracker’s accuracy relative to its parameter settings in the Inspector. The
confidence curve is not for editing purposes.

8 To stop a track, click the Stop button in the progress window or press Esc.

Tip: If it appears that the tracker loses its reference pattern, do not immediately click the
Stop button. Allow the analysis to continue for a few seconds. When the tracker fails, the
playhead jumps to the exact frame at which the track was lost.

The analyzed track, contained in the Analyze Motion behavior, can now be loaded into
other tracking behaviors (via a pop-up menu in the HUD or Inspector of the other tracking
behaviors).

Tracking behaviors 
pop-up menu in the 
Match Move HUD

Note: The Stabilize behavior can only load tracks from other Stabilize behaviors.

Loading Data into a Behavior
If the project contains any footage or animated objects when a Match Move, Stabilize,
Unstabilize, or Track Points behavior is applied, the nearest footage or animated object
below the behavior in the Layers tab is automatically applied to the behavior and appears
in the behavior’s Source well. This data is overwritten once a tracking analysis is done,
or when you choose another track from the tracking behaviors pop-up menu.

You can assign an animated object or tracking data to a tracking behavior in four ways:

• Choose another tracking behavior from the tracking behaviors pop-up menu.

• Drag a tracking behavior or footage object to the Source well in the HUD or Behaviors
tab of the Inspector.

• Drag an animated object to the Source well in the HUD or Behaviors tab of the
Inspector. The referenced animated object is applied as the source for the current
behavior. This option only applies to the Match Move and Track Points behaviors.

• Drag a tracking behavior or footage object directly to the current tracking behavior
in the Layers tab. The referenced tracking behavior or footage object is assigned as
the source for the current behavior.

Note: To clear a Source well, drag the item away from the well and release the mouse
button.
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Match Move Workflows
This section provides a general overview of several Match Move behavior workflows,
including four-corner pinning. For a full description of the Match Move parameters, see
Match Move Controls.

To use a Match Move behavior, you need a minimum of two objects in your project: a
background or source element and a foreground or destination object. The source object
provides the movement as either an animated object (shape, particle emitter, and so on)
or a recorded track (from movement in a clip). The movement from the source object is
applied to the destination object. The destination object can be a shape, text, particle
emitter, and so on).

Using Match Move to Track a Background Element
The Match Move behavior is applied to the foreground element and tracks a feature in
the background element. This data is applied to the foreground element so that it
“matches” the movement of the tracked feature in the background clip.

To “match move” a foreground object using the Match Move behavior
1 Play your background clip several times to determine a good track point.

2 Select the foreground element, then click the Add Behavior icon in the Toolbar, then
choose Motion Tracking > Match Move from the pop-up menu.

A single tracker (the Anchor checkbox in the Behaviors tab of the Inspector) is activated.
The Anchor tracker records position data.

3 Determine if you need to activate additional trackers for two- or four-point tracking.

• For two-point tracking, select the Rotation-Scale checkbox in the Behaviors tab of the
Inspector (under the Anchor checkbox).

• For four-point tracking, choose Four Corners from the Type pop-up menu in the
Behaviors tab of the Inspector and proceed to Four-Corner Pinning with Match Move.

4 Go to the frame where you want the track to begin.

5 In the Canvas, drag the tracker (or trackers) to the point (or points) you want to track.
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As you drag the tracker in the Canvas, the region around the tracker becomes magnified
to help you find a suitable reference pattern.

The foreground element is the particle emitter 
(emitting red flowers).

As you drag the track point in the Canvas, the 
area around the tracker becomes magnified.

6 Click the Analyze button in the HUD or Behaviors tab of the Inspector.

The foreground element is tracked to the background element.

7 If you are using two-point tracking, turn on (or off ) the Position, Scale, or Rotation buttons
(in the Adjust row) to add (or remove) tracking parameters.

In the following example, only Position is enabled in the Adjust row of the Behaviors tab.
As a result, although the camera pushes in toward the picture frames, the white elliptical
shape does not change its scale or rotation based on the position of the two trackers.
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In the next example, Position, Scale, and Rotation are enabled in the Adjust row of the
Behaviors tab. Consequently, the white elliptical shape changes its position, scale, and
rotation based on the position of the two trackers matching the camera’s push toward
the picture frames, thereby preserving the illusion that the shape is physically attached
to the picture frame.

Note: When using four-point tracking, scale and rotation are automatically applied to
the corner-pinned object.

Using Match Move to Apply Animation Data to a Project Element
You can instantly apply the animation of a source object to a destination object via the
Match Move behavior, without any tracking analysis. The source object can be animated
by behaviors or keyframes.

The following simple example uses a “magic wand” (made up of rectangle shapes) that
is animated on a motion path. The animation of the wand is then tracked to a particle
emitter to create the illusion of sparkles flying off the tip of the wand.

To apply the transformation of a source object to a destination object
1 Select the element to which you want to apply the behavior, click the Add Behavior icon

in the Toolbar, then choose Motion Tracking > Match Move from the pop-up menu.
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In this example, a Match Move behavior is applied to a nonanimated particle emitter.

Match Move behavior

The closest animation data (such as position or rotation changes caused by keyframes or
behaviors) beneath the Match Move behavior in the Layers tab is automatically applied
as the source and is displayed in the Source well. In this example, the animated wand is
the source animation.

Source well

Important: Animated objects, tracking behaviors, and footage can be dropped in the
Source wells.

2 Ensure that the Type parameter is set to Transformation in the Behaviors tab of the
Inspector.

3 Position the object with the applied Match Move behavior in the Canvas at the location
you want.
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In this example, the particle emitter is positioned at the tip of the wand.

The particle emitter and the wand now share the same animation path.

4 Play the project.

The particles match the movement of the wand.
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About Destination Object Animation
You can instantly apply the animation of an object (called the source object) to another
object (called the destination object) using the Match Move behavior. The source object
can be animated by behaviors or keyframes. The destination object can also be animated.

You can specify whether the animation of the destination object is ignored by the match
move or added to the match move. You do this by choosing an option from the
Transform pop-up menu and by selecting options from the Adjust parameters in the
Behaviors tab of the destination object.

When you choose Attach to Source from the Transform pop-up menu, the destination
object is anchored to the source object. If the destination object is animated when the
Match Move behavior is applied, you can choose whether the existing position, scale,
or rotation animation (of the destination object) is preserved or whether the position,
scale, or rotation animation of the source object is applied to the destination object.
This is controlled in the Adjust parameters of the Match Move behavior.

When you choose Mimic Source from the Transform pop-up menu, the destination
object “mimics” the recorded track or animation of the source. If the destination object
is animated when the Match Move behavior is applied, you can choose whether the
existing position, scale, or rotation animation (of the destination object) is preserved or
whether the position, scale, or rotation animation of the source object is added to
animation of the destination object. This is controlled in the Adjust parameters of the
Match Move behavior. For more information on Attach to Source and Mimic Source,
see Match Move Controls.

Reordering Match Move Behaviors
When a Match Move behavior is added to a project, the closest active footage or layer
with animation (transforms such as position or rotation changes caused by keyframes or
behaviors) is selected and automatically applied as the source animation. This source
animation is displayed in the Source well. When you move Match Move behaviors in the
Layers tab, that data is reset. To retain the source animation data, copy the Match Move
behavior and paste it to the new item.

To copy and paste a behavior
1 Select the behavior you want to copy in the Layers tab.

2 Choose Edit > Copy (Command-C).

3 Select the layer to which you want to apply the copied behavior.

4 Choose Edit > Paste (Command-V).

Note: You can also Option-drag the behavior to the new item.

The copied behavior is applied to the new item.
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Four-Corner Pinning with Match Move
The Match Move behavior allows you to track four points on a background clip and apply
the motion to the four corners of a foreground element. There are three possible
four-corner pinning workflows. In the first example, a foreground element is pinned to
a background element using the four-corner trackers. This workflow is useful when the
“pinned” image is the same size as the background reference patterns to which it is being
tracked. In the second example, the foreground element is corner-pinned prior to using
the four-corner trackers. This allows you to position the element in the correct location
on the background element prior to applying the Match Move behavior. In the third
example, the foreground object is transformed to fit a background picture frame using
the scale, rotation, and position parameters in the Properties tab prior to applying the
Match Move behavior. This workflow is helpful when you prefer to adjust the “pinned”
image prior to being tracked.

Motion offers many different tracking workflows because shots vary so greatly, and
tracking success is unpredictable. Several tracking attempts are often required before a
satisfactory track is achieved.

Tip: If one of the pinning options below doesn’t result in a successful track, try another
option. There is an additional four-corner pinning workflow that can be performed using
the Analyze Motion behavior.

Note: You can also perform four-point tracking using the Analyze Motion or the Stabilize
behavior. For more information, see Using a Non-Match Move Four-Point Track for
Corner-Pinning.

There are special considerations when corner-pinning groups. For more information, see
Tracking and Groups.

Option 1: Pinned Image Is Locked to the Reference Points
This workflow is ideal for a four-corner pin in which the transformed or “pinned” image
is the same size as the background “frame” (or reference patterns) to which it is being
tracked. In the following example, a foreground image is pinned to a background clip of
a picture frame.

To track an image using four trackers
1 Drag the playhead to the frame where you want to start the track and apply a Match

Move behavior to the foreground element.
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2 In the Behaviors tab of the Inspector, choose Four Corners from the Type pop-up menu.

Note: The Four Corners option is not available when Match Move is applied to a 3D group.
To corner-pin a 3D group, select the Flatten checkbox in the Group tab of the Inspector.

In the Canvas, a tracker appears at each corner of the foreground object’s bounding box.
In the Inspector, the default track list (Anchor and Rotation-Scale), is replaced with the
Top Left, Top Right, Bottom Right, and Bottom Left trackers.

3 In the Canvas, drag each tracker to a “corner” of the background element (in this example,
the corners of the picture frame provide the four-corner track points).

As with the Analyze Motion trackers, a magnified inset appears in the Canvas as you drag
the trackers.

4 Click the Analyze button in the HUD or Behaviors tab of the Inspector.
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The foreground element is “pinned” on the background element.

Note: In this example, a reflection is created on the table using a duplicated and
transformed copy of the tracked image.

To fine-tune the track (when Four Corners is chosen from the Type pop-up menu), you
may need to make minor adjustments to the foreground element, such as modifying its
scale or rotation. When you choose the Attach to Source option from the Transform
pop-up menu in the Behaviors tab of the Inspector, you cannot transform the tracked
object. To transform the tracked object, choose Mimic Source from the Transform pop-up
menu.

5 To transform the foreground element after the tracking data has been applied:

a Choose Mimic Source from the Transform pop-up menu in the Behaviors tab of the
Inspector.

b Click the Properties tab in the Inspector and make the necessary adjustments using
the Scale, Rotation, and other parameters.

For more information on the Mimic Source and Attach to Source transform options, see
Match Move Controls.

Option 2: Corner-Pin the Object Before Tracking
In this workflow, a foreground object is pinned to a background picture frame using the
Four Corner parameter in the Properties tab prior to applying the Match Move behavior.

To adjust the four corners of an element and then corner-pin the element
1 Select the foreground element you want to corner-pin.
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2 In the Toolbar, choose the Adjust Four Corner tool from the 2D transform tool set.

Adjust Four Corner tool

3 Drag each corner of the foreground element into the correct position.

Once a corner is dragged in the Canvas, the Four Corner checkbox is selected in the
Properties tab.

Tip: You may want to lower the opacity of the foreground object to better see the
reference points on the background clip. You may also want to disable snapping so the
image you are adjusting does not snap to the Canvas guidelines. To turn snapping on or
off, choose View > Snap or press N.

4 Go to the frame where you want to start the track and apply the Match Move behavior
to the foreground element.

1266 Chapter 19 Motion Tracking



In the Canvas, a tracker appears at each corner of the foreground object. In the Inspector,
the default track list (Anchor and Rotation-Scale) is replaced with the Top Left, Top Right,
Bottom Right, and Bottom Left trackers.

5 If necessary, drag each tracker in the Canvas and fine-tune its position in the Tracker
Preview of the Inspector.

Important: To adjust the trackers without adjusting the foreground image, choose Mimic
Source from the Transform pop-up menu in the Behaviors tab of the Inspector. When
Attach to Source is chosen from the Transform pop-up menu, the foreground image is
distorted when the trackers are repositioned.

6 Click the Analyze button in the HUD or Behaviors tab of the Inspector.

The foreground element is “pinned” on the background element.

Note: If you adjust the Four Corner parameter for a layer, then apply a Match Move
behavior, the Four Corner parameter is automatically applied in the behavior. If you delete
the behavior, the four corner settings for the layer remain. If you reset the Match Move
behavior, the four corner settings are reset.

1267Chapter 19 Motion Tracking



Option 3: Transform the Object Prior to Corner-Pinning
In this workflow, a foreground object is transformed to fit a background picture frame
using the scale, rotation, and position parameters in the Properties tab prior to applying
the Match Move behavior. This workflow is helpful when the “pinned” image needs fine
tuning, such as scaling, rotating, or cropping prior to being tracked.

To transform and corner-pin an image
1 Select the foreground element you want to corner-pin.

2 Using the onscreen transform controls or the Properties tab of the Inspector, adjust the
foreground element’s scale, position, or rotation to its “frame.”

3 Go to the frame where you want to start the track and apply the Match Move behavior
to the transformed element.

4 Choose Four Corners from the Type pop-up menu in the Behaviors tab of the Inspector.

5 Do one of the following:

• To position the trackers without changing the shape of the foreground image, choose
Mimic Source from the Transform pop-up menu, then position the trackers on the
reference patterns of the background image (in this example, the four inside corners
of the picture frame). In the image below, the tracker is being positioned in the Canvas,
but the foreground image is not affected because Mimic Source is chosen from the
Transform pop-up menu.
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• To adjust the trackers and affect the shape of the foreground image, choose Attach to
Source from the Transform pop-up menu, then position the trackers on the reference
patterns of the background image. In the image below, the tracker is being positioned
in the Canvas and the foreground image is affected because Attach to Source is chosen
from the Transform pop-up menu.

6 Click the Analyze button in the HUD or Behaviors tab of the Inspector.

The foreground element is “pinned” on the background element. Because this workflow
may not yield ideal results (the foreground element may not scale or move correctly with
the background image, for example), you may need to apply a mask to or crop the
foreground image.

Masking and Tracking
When a mask is added to an object with applied tracking data, the data is automatically
applied to the mask. In the following images, the foreground image is tracked to four
points on the background clip, but still needs to be masked to fit into the picture frame
(without unevenly scaling the image).

Transformed and tracked
foreground element

Transformed and tracked element with
applied mask

Although the mask is attached to the foreground image, you may need to animate
changes in the mask’s position and scale to accommodate changes in the background
clip over time.
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Note: As an alternative to using masks, you can also crop an object with applied tracking
data using the Crop controls in the Properties tab of the Inspector.

You can track the control points of a mask to a clip or apply existing tracking data to the
control points of a mask. For more information, see Track Points Workflow.

Using Mimic Source for Four-Corner Pinning
Depending on your source footage, you may need to corner-pin an element using
reference points that are in a different position from the final “pinned” size of the
foreground element. You do this by offsetting the trackers using the Mimic Source option.
In the basic example below, the reference patterns (the “markers”) to be tracked are
located inside a frame, rather than at the corners.

The orange visual aid (the orange 
outline) represents the resulting 
size of the corner-pinned image.

The orange visual aids circle the 
tracking reference points.

Because the tracking reference points (markers) are not flush with the inside edge of the
frame, you must offset the image from the four trackers. Otherwise, the final corner-pinned
image will appear too small, as in the example below.

Note: In this specific example, you could track to the corners of the frame. However, the
steps in the following section demonstrate a simple example of how to use the Mimic
Source parameter in order to four-corner pin an object when your predefined tracking
markers (markers placed on the objects in the physical set) are offset from the reference
points to which you want to track.
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To track reference points that are offset from the foreground image
1 Use one of the workflows above (Four-Corner Pinning with Match Move) to set up a

four-corner pin using the Match Move behavior.

2 Choose Mimic Source from the Transform pop-up menu in the Behaviors tab of the
Inspector.

3 In the Canvas, drag the trackers to the tracking markers.

The image is not affected and remains locked to its original placement.

4 Click the Analyze button in the HUD or Behaviors tab of the Inspector.

The foreground element is “pinned” on the background element.

Using a Non-Match Move Four-Point Track for Corner-Pinning
This section provides an additional four-corner pin workflow that references a four-point
track from an Analyze Motion behavior. The four-point tracking data collected from the
Analyze Motion behavior is loaded into a Match Move behavior in order to corner-pin a
foreground element.

Note: You can also perform this workflow using the Stabilize behavior.

To record four-point tracking using Analyze Motion and apply the tracking data to a
Match Move behavior

1 Go to the frame where you want to start the track and apply an Analyze Motion behavior
to the background element.

By default, a single tracker appears in the Canvas.
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Note: For four-point Analyze Motion and Stabilize operations, the trackers should be
positioned in a clockwise order, starting in the upper-left corner. This ensures the proper
alignment of your element when the transformation is applied.

Track 1

Track 2

Track 4

Track 3

2 Drag the tracker (Track 1) to the desired reference pattern in the top-left corner of the
background element.

3 In the Behavior tab of the Inspector, click Add to add a second tracker, then drag the
second tracker (Track 2) to the desired reference pattern in the top-right corner of the
background element.

4 Add another tracker (Track 3) and drag it to the desired reference pattern in the
bottom-right corner of the background element.

5 Add another tracker (Track 4) and drag it to the reference pattern in the bottom-left corner
of the background element.

6 Click the Analyze button in the HUD or Behaviors tab of the Inspector.

The track is generated and its data saved in the behavior.

Note: You can save tracking behaviors to the Library for later use.

7 Apply a Match Move behavior to the foreground element you want to corner-pin.

8 If not already selected, choose the Analyze Motion behavior from the tracking behaviors
pop-up menu.
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This applies the Analyze Motion tracking data recorded in step 6 to the Match Move
behavior.

Tracking behaviors 
pop-up menu

9 Choose Four Corners from the Type pop-up menu in the HUD or Behaviors tab of the
Inspector.

The four-point tracking data from the Analyze Motion behavior is applied to the foreground
element.

Note: When using the Match Move behavior for four-point tracking, the trackers are
automatically placed in the correct order (clockwise from the top left) in the Canvas after
Four Corner is chosen from the Type pop-up menu in the Behaviors tab of the Inspector.
If you’ve used more than four trackers or you need to change the order of the trackers,
choose a different order from the Top Left, Top Right, Bottom Right, or Bottom Left pop-up
menus.

Select a different tracker 
order from the pop-up 
menus
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Stabilize Workflow
This section provides a general overview of using the Stabilize tracking behavior to smooth
shaky motion in a movie or image sequence. For a full description of the Stabilize
parameters, see Stabilize Controls.

With the Stabilize behavior, there are three ways to analyze a clip:

• Use the default advanced motion analysis technique that evaluates the entire frame
of a clip at once to extract animation data without the use of onscreen trackers.

• Use onscreen trackers that analyze a reference pattern (a small group of pixels) in the
Canvas. These are the same trackers used by the Match Move and Analyze Motion
behaviors.

• Use a combination of the advanced motion analysis and the onscreen trackers.

Important: For information on using the onscreen trackers with the Stabilize behavior,
see Adding Trackers to the Stabilization.

Once the motion analysis is derived, you can apply it in either of two ways. The clip can
be smoothed, eliminating unwanted jitter while maintaining the general motion of the
camera, or the clip can be locked, stabilizing the subject. The smoothing can affect
translation, rotation, or scale, making it more flexible for certain operations than the other
tracking behaviors.

The Stabilize behavior is primarily useful for removing unwanted trembling from
less-than-stable crane or jib arm moves, eliminating teetering from handheld walking
shots, or reducing vibrations in automotive shots.

Note: As useful as the Stabilize behavior is, be aware that motion blur that is present in
the image will remain, even though the subject in the shot is successfully smoothed or
locked.

To stabilize a clip using the Stabilize behavior
1 Apply a Stabilize behavior to the clip you want to stabilize.

Note: Unlike the other behavior workflows, the Stabilize behavior’s automatic mode
analyzes the entire clip, rather than from the current playhead position.

2 Set the options for the analysis:

a Choose an option from the Method pop-up menu in the HUD or Behaviors tab of the
Inspector:

• Choose Stabilize to lock down an image, removing problems such as camera shake.

• Choose Smooth to smooth camera movement in the clip.
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b Choose an option from the Borders pop-up menu:

• Choose Normal to maintain the size of the stabilized footage. The resulting
transformations that are made to the stabilized image may cause moving black
borders to appear around the edges of the clip.

Normal borders maintain 
the size of the stabilized 
clip but create black 
borders around the 
clip’s edges.

• Choose Zoom to expand the clip to the full size of the Canvas. This prevents black
borders from appearing around the edges of the stabilized clip.

Zoomed borders scale 
the stabilized clip so
the clip does not move 
away from the edge
of the Canvas.

Note: For suggestions on correcting the black borders, see Removing Black Borders
Introduced by Stabilizing.

c Choose an option from the Direction pop-up menu:

• Choose Horizontal and Vertical to apply the stabilize transformation to the X and Y
dimensions.

• Choose Horizontal to apply the stabilize transformation to the X dimension.

• Choose Vertical to apply the stabilize transformation to the Y dimension.
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d Enable or disable the Adjust options:

• Turn on Position to apply the analyzed position data to the clip. (The X and Y position
changes in the footage are smoothed or stabilized.) To stabilize the X and Y position
of the shot, but leave any scale or rotation changes intact, turn on Position and turn
off Scale and Rotation.

• Turn on Scale to apply any analyzed scale data to the clip. (Any scale changes in the
footage are smoothed or stabilized.) To stabilize or smooth changes in scale, but
leave any position or rotation changes intact, turn on Scale and turn off Position and
Rotation.

• Turn on Rotation to apply analyzed rotation data to the clip. (Changes in the rotation
of the footage are smoothed or stabilized.) To stabilize or smooth changes in rotation
in the shot, but leave any position or scale changes intact, turn on Rotation and turn
off Position and Scale.

For the smoothest possible result, turn on all three Adjust options (Position, Scale, and
Rotation).

Note: The Scale option is not related to the Zoom option in the Borders pop-up menu.

Note: You can change the Method, Borders, Direction, and Adjust parameters before
or after the clip is analyzed.

3 Click the Analyze button in the HUD or Behaviors tab of the Inspector.

Note: The clip is stabilized according to the defined parameters. Unlike the Motion trackers,
the default Stabilize analysis does not create keyframes in the Keyframe Editor. However,
the stabilized object’s transformation can be converted to keyframes. For more information,
see Converting Tracks to Keyframes. When correlation trackers are added to and analyzed
with the Stabilize behavior, keyframes are created.

For more information on correcting problems associated with stabilization, see
Troubleshooting Stabilizing Effects.

Adjusting the Stabilize Behavior’s Track Region
When stabilizing a clip, you can use the Track Region parameter to define an area that
you want to be analyzed (isolating the stabilization to a limited area of the analyzed
source). During analysis, the area outside of the region is ignored. Use this option for
faster processing of a clip.

To use the Stabilize behavior’s Track Region parameter
1 In the Stabilize parameters (in the Behaviors tab of the Inspector), select the Track Region

checkbox.

A transparent red control appears in the Canvas.

2 Do one of the following:

• Drag in the region to change its position.
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• Drag a handle to resize the region. The corner handles simultaneously resize width and
height; the top and bottom center handles resize height; the left and right center
handles resize width.

• Press Option while dragging a handle to resize the region from its center.

• Drag the rotation handle in the center of the region to change the angle of the region.

Track Region rotation 
handle

3 After defining the track region, click the Analyze button in the Behaviors tab.

Because analysis is only taking place within the defined track region area, the clip is
analyzed more quickly.

Unstabilize Workflow
This section provides a basic overview of using the Unstabilize tracking behavior to reapply
camera shake or movement into a finished clip.

The Unstabilize behavior’s sole function is to apply movement recorded by another
tracking behavior, such as Stabilize, to a clip or object. This allows you to match the
camera movement from a background clip to foreground elements, or unstabilize a
stabilized clip.

Note: A project must include a tracking behavior with recorded motion data in order to
use the Unstabilize behavior.

To use the Unstabilize behavior
1 Select the object you want to unstabilize, click the Add Behavior icon in the Toolbar, then

choose Motion Tracking > Unstabilize from the pop-up menu.

The behavior is added. If a Stabilize behavior (that has completed an analysis) is present
in the project, the Stabilize data is automatically applied to the Unstabilize.

2 If you don’t want to use the Stabilize behavior that is auto-selected, do one of the
following:

• In the HUD or Behaviors tab of the Inspector, choose a tracking behavior from the
pop-up menu to the right of the Source well.
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• Drag an analyzed tracking behavior to the Source well in the HUD or Behaviors tab of
the Inspector.

The motion is applied to the destination object.

Track Points Workflow
The Track Points behavior (located in the Shape Behaviors category) is designed for use
with shapes, masks, and paint strokes. The Track points behavior can be used in the
following ways:

• Track the control points of a shape or mask (for example, when rotoscoping) to a clip.

• Apply tracking data from another tracking analysis to the control points of a shape or
mask.

• Apply the animation of an object to the control points of a shape or mask.

Note: To apply the analyzed movement of an object to a shape or mask as a whole (not
to the shape’s control points), use the Match Move behavior.

For a full description of the Track Points parameters, see Track Points Controls.

Tracking Control Points to a Clip
This section provides a brief overview of using the Track Points behavior to track the
vertices of a shape or mask to a clip.

To track a shape or mask using the Track Points behavior
1 Select the shape or mask you want to track, click the Add Behavior icon in the Toolbar,

then choose Shape > Track Points from the pop-up menu.

The behavior is added to the shape, and trackers appear for each control point on the
shape. The trackers are ordered in the same order that the shape was drawn: Control
Point 1 is Track 1, Control Point 2 is Track 2, and so on.

Note: Trackers are not added to disabled shape control points. You can still enable and
disable control points once a Track Points behavior is applied to a shape. For more
information on working with shape control points, see How to Edit Shapes. For more
information on working with masks, see Masking a Layer or Group.
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In this example, the Track Points behavior is applied to a loose mask of seven control
points isolating a car in a clip.

Note: Keep in mind that paint strokes usually have a very large number of control points.
You should simplify a paint stroke by deleting or disabling control points prior to applying
a Track Points behavior to the stroke. To track the stroke as a whole, rather than by its
control points, use the Match Move behavior.

2 Drag the trackers to fine tune their position on the reference patterns.

As you drag, a magnified view of the area around the tracker appears.

3 To disable a tracker, deselect its checkbox in the Behaviors tab of the Inspector.

Note: Any control points without an associated tracker are not modified.

4 Click the Analyze button in the HUD or Behaviors tab of the Inspector.

The mask control points are tracked to the reference patterns.
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In this example, a mask is tracked to a moving car so that the car can be isolated from
the rest of the clip. The illustration on the left shows the original unmodified clip. In the
illustration on the right, the tracked mask isolates the car, allowing separate effects to be
applied to the car and its background even though they are part of the same image. The
mask is “protecting” the car from the effects of the heavy blur and desaturation.

Note: As with all behaviors, you can drag or copy (Option-drag) a Track Points behavior
to a new shape in the Layers tab. When you apply the behavior to a new shape, the
trackers are automatically applied to the control points of the new shape. If the new
shape has more control points than the originally tracked shape, only the original track
points are applied. For example, if the originally tracked shape has three control points,
and the new shape has five controls points, trackers are applied to the first three control
points of the new shape. If the new shape has fewer control points than the originally
tracked shape, trackers are applied to the existing points on the new shape. For example,
if the originally tracked shape has five controls points, and the new shape has three
control points, the first three trackers from the original shape are applied to the three
control points of the new shape.

Using a Shape Object as the Animation Source
This section provides a brief overview of using the Track Points behavior to apply the
animation of a layer (another shape, in this example) to the vertices of a shape or mask.
Applying the animation of one animated shape to another is an easy way to quickly create
fun, complimentary animations in which the objects appear to “play” with each other.

For this workflow, your project must contain an object that is animated with keyframes
or behaviors.

To apply the animation of a shape to the control points of another shape or mask
1 In a project that contains two shapes, animate one of the shapes using keyframes or a

Basic Motion behavior.

In this example, a simple line shape is animated with the Spin behavior.

For more information about animating with keyframes, see Animating in the Canvas. For
more information about the Basic Motion behaviors, see Basic Motion Behaviors.
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2 Apply the Track Points behavior to a non-animated shape.

The animated object closest to the object with the applied Track Points behavior in the
Layers tab is automatically applied to the Track Points behavior as the animation source,
and is displayed in the Source well in the HUD and Inspector.

In this example, the Track Points behavior is applied to the Bezier shape, and a line used
as the source animation is animated with the Spin behavior.

Bezier shape with 
applied Track Points 
behavior

Animated source object

HUD’s Source well 
displays the referenced 
source object.

Note: To reference another animated object, drag that object to the Track Points behavior’s
Source well or directly to the behavior in the Layers tab.

3 In the Behaviors tab of the Inspector, choose Attach to Source from the Transform pop-up
menu.

The spinning animation of the line is applied to the Bezier shape. The Bezier shape changes
form because the vertex tangents match the transformation of the source animation.

4 To align the tangents to the transformation of the source object, select the Align Tangents
checkbox in the Behaviors tab of the Inspector.
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The spinning animation of the line is applied to the Bezier shape. The tangents remain
aligned at their original angles along the shape.

Note: By default, Mimic Source is chosen from the Transform pop-up menu. For more
information on the Transform pop-up menu, see Track Points Controls.

Track Parameter Workflow
The Track Parameter behavior allows you to track a position parameter of a filter to a
reference feature of a clip, or to apply existing tracking data to a position parameter of
a filter. For example, you can track the center of a Light Rays filter to a moving light in a
clip.

Note: This behavior is only applicable to filters with position parameters, such as Scrape,
Ring Warp, Light Rays, Slit Tunnel, and so on.

For a full description of the Track Parameter behavior, see Track Parameter Behavior
Controls.

To use the Track Parameter behavior
1 In the Canvas, position the center point of the filter over the reference pattern.

In this simple example, the center point of a blur is positioned over the license plate of
a car.

Use the onscreen 
controls to position the 
center point of a filter on 
the tracking reference 
pattern.

Note: To use a filter’s onscreen controls, select the filter in the Layers tab, then choose
the Adjust Item tool from the 2D transform tools in the Toolbar. For more information
on using filters, see Using Filters.
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2 In the Filters tab of the Inspector, Control-click the Center parameter, then choose Track
from the shortcut menu.

In the Canvas, the filter’s onscreen control is replaced with a tracker. The Behaviors tab
becomes active and the Track behavior parameters are displayed.

Note: In the Filters tab, a behavior icon appears next to the Center parameter, indicating
that it is influenced by a behavior.

If necessary, adjust the tracker in the Canvas. If the reference pattern you want to track
is offset from the center of the filter, use the Offset Track checkbox. For more information
on using the Offset Track parameter, see Tracking Obscured or Off-Frame Points.

3 Click the Analyze button in the HUD or Behaviors tab of the Inspector.

The filter’s center is tracked to the clip.

Note: You can make changes to the filter parameters after the analysis is performed.

Adjusting the Onscreen Trackers
The Analyze Motion, Stabilize, and Match Move behaviors share common onscreen and
Inspector controls.

A tracker consists of a single onscreen control: the tracker.

Tracker

The default onscreen tracker color is red. Depending on the color of your subject, you
may need to change the color of the tracker to see the tracker in the Canvas.

Once the tracking analysis begins, a progress window opens and track points appear in
the Canvas. The track points are the post-analysis motion path (the path that looks like
a string of pearls) that appears in the Canvas. The track point at the current playhead
position is emphasized.

Note: Track points in the Canvas correspond to the tracking keyframes that appear in the
Keyframe Editor.

To position the tracker
1 Drag the tracker in the Canvas.
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As you drag, the area around the tracker in the Canvas is magnified and its position is
displayed in an info window. This area is a visual aid for positioning the tracker and does
not represent a search area or region.

Note: Unlike many correlation trackers, you do not manually specify a search area when
setting up a tracker in Motion. Motion automatically searches, with subpixel accuracy, a
default area around the track point.

The Behaviors tab of the Inspector includes a Tracker Preview area that updates as you
drag the tracker in the Canvas.

2 Fine-tune the tracker position by doing one of the following:

• Drag in the Tracker Preview area

As you drag in the preview area, the tracker in the Canvas also updates.

Drag anywhere in the 
Tracker Preview area to 
adjust the position of
the tracker. You do not 
have to drag the red
plus sign (+) .

If you are using rotated footage, the rotation is not reflected in the Tracker Preview in
the Inspector. The rotation is reflected in the magnified visual aid in the Canvas.

• Click the tracker’s disclosure triangle in the Behaviors tab of the Inspector, and use the
Position controls to numerically adjust the tracker’s position.
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Note: You can Option–drag in the Tracker Preview area to manually override the pattern
search size. Option–drag left to reduce the size of the search pattern in the Canvas,
and Option–drag right to increase the pattern search size. Alternatively, you can modify
the search size using the Track Size slider in the tracker parameters.

To move multiple trackers at the same time
µ Drag to select or Shift-select the trackers in the Canvas, then drag them to a new position.

A selected tracker appears yellow.

Note: Because you risk moving the onscreen trackers when Shift-selecting, dragging to
select may be a better option.

To turn off the onscreen trackers
Do one of the following:

µ Control-click a tracker in the Canvas, then choose Hide Selected Tracker from the shortcut
menu.

µ Deselect the appropriate Track checkbox in the Behaviors tab of the Inspector.

Once the tracker is turned off, it is not used in the analysis.

To turn on the onscreen trackers
µ Select the appropriate Track checkbox in the Behaviors tab of the Inspector.

To change the color of the onscreen tracker
1 Select the tracker and click the Behaviors tab in the Inspector.

2 Click the trackers disclosure triangle and use the Color controls to change the color of
the tracker.

Tracker Color controls

Strategies for Better Tracking
Selecting a good tracking reference feature in a movie or image sequence is pivotal in
achieving an accurate track. Tracking a single reference pattern with a single analysis pass
rarely yields a perfect result. More often, a successful track combines automatic and
manual tracking, experimenting with different parameter settings, and resetting reference
points at different locations in the clip.
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Finding a Good Reference Pattern
The first step in selecting a good reference pattern is to play the footage several times.
As you review the clip, try to locate a reference pattern that follows as many of the
following rules as possible:

• The pattern contains perpendicular edges, such as dots, intersections, and corners (lines
and straight boundaries should be avoided as tracking reference patterns).

• It is a high-contrast pattern.

• It contains even changes in brightness or color (an example of an uneven color or
brightness change is a sharp-edged shadow that passes over your reference pattern).

• It appears in every frame of the clip (does not move offscreen or become obscured by
other objects).

• It is distinct from other patterns in the same “neighborhood” in the clip.

Manually Modifying Tracks
You can manually modify track points.

To manually adjust an onscreen track point
1 Position the playhead at the frame you want to modify.

The track point at the current playhead position is highlighted.

2 Do one of the following:

• Drag the highlighted track point in the Canvas to adjust its position.

• Drag in the Tracker Preview area in the Behaviors tab of the Inspector.

For fine-tuning, you can zoom in and out of the clip using the Zoom tool.

Zoom tool

The zoom follows the pointer, so place the pointer on the track point in the Canvas and
drag right to zoom in. Drag left to zoom out of the clip. To return to normal view, choose
100% from the Zoom Level pop-up menu (in the lower-right section of the Toolbar). If
you have a Multi-Touch trackpad you can also zoom in using a pinch open and zoom out
using a pinch closed, and then scroll around the zoomed view using two-finger swipes.

You can also adjust a tracking curve in the Keyframe Editor. For more information on
using the Keyframe Editor, see Keyframes and Curves.
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When Good Tracks Go Bad
Once an analysis is complete, you may need to retrack a portion of the clip. Rather than
tracking over bad tracking keyframes, it is recommended that you delete any bad
keyframes prior to retracking. If “bad” keyframes are not deleted, the tracker may continue
to use the old reference point.

Deleting Bad Keyframes in the Keyframe Editor
You can delete bad tracking keyframes in the Keyframe Editor.

To delete bad tracking keyframes
1 Position the playhead at the frame in which you want to reset the reference pattern.

2 In the Keyframe Editor, drag to select the keyframes you want to delete.

3 Control-click in the Keyframe Editor, then choose Cut from the shortcut menu (or press
Delete).

4 In the Canvas, drag the tracker to the reference point, then click Analyze.

New track keyframes are created.
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Tip: When dealing with multiple problem trackers, you may want to turn off the trackers
you are not correcting to simplify the Keyframe Editor. Additionally, when fine-tuning
tracks in the Keyframe Editor, you may want to simplify what is displayed in the graph.
The following image displays the curves for a simple four-corner pin.

To quickly solo a curve, Option-click the parameter’s checkbox in the Keyframe Editor’s
parameter list.

Deleting Track Points in the Canvas
Bad track points can also be deleted in the Canvas. The track points in the Canvas represent
keyframes in the Keyframe Editor.

To delete bad track points in the Canvas during analysis
1 During analysis, press the Esc key to stop the tracking.
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2 In the toolbar, ensure that the Adjust Item tool is selected.

3 Ensure that a track point is active in the Canvas.

You may want to zoom into the Canvas in order to better see the active track points. The
track point at the current playhead position appears larger than other track points.

Active track point at 
current playhead position

Note: If you press the Delete key when a track point is not selected, the entire path is
deleted.

4 Do one of the following:

• Press the Delete key to delete the track point at the current position of the playhead.

• Move the playhead to the frame where you want to begin deleting track points, and
press the Delete key.

Only active keyframes are deleted.
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To delete bad track points in the Canvas after analysis is complete
1 With the tracking analysis complete and the tracking behavior selected, move the playhead

to the frame with the track point (or start of the track points) you want to delete.

2 In the toolbar, ensure that the Adjust Item tool is selected.

3 Ensure that a track point is active in the Canvas.

You may want to zoom into the Canvas in order to better see the active track points. The
track point at the current playhead position appears larger than other track points.

4 Press the Delete key. Each press of the key removes one track point.

Smoothing Tracking Keyframe Curves
You can smooth a track with the Keyframe Thinning function in the Animation menu in
the Keyframe Editor parameter list. Prior to smoothing the curve, you may want to copy
the behavior (as a backup) to the Library or duplicate the behavior in the project.

To smooth a track curve
1 In the Keyframe Editor, click the Animation menu for the track you want to smooth, then

choose Reduce Keyframes from the pop-up menu.

Before the curve is 
simplified, a keyframe 
appears at every frame.

The Reduce Keyframes dialog appears.

Reduce Keyframes applies a thinning algorithm to the keyframes for the chosen parameter.
This reduces the number of keyframes in a parameter while attempting to maintain a
similar shape to the curve. The thinning algorithm can be adjusted in two ways. Increasing
the Maximum Error Tolerance results in fewer keyframes. Increasing the Smoothing Factor
makes smoother curves between keyframe values.
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This example uses 5, which means that 5 track points centered on the currently evaluated
point are used to compute the current point’s new, smoothed value. This is a standard
Gaussian (bell-curve type) filter. In other words, if you leave it at 5, when the value of
frame 12 is computed, frames 10, 11, 12, 13, and 14 are considered. If set to 3, it uses
frames 11, 12, and 13. The larger the Smoothing Factor, the more points are considered
(and thus more calculations done) for every point in the curve.

2 Set the values in the Reduce Keyframes dialog.

As you adjust the sliders or value sliders in the dialog, the curve is modified in the Keyframe
Editor.

After the curve is 
simplified, the curve 
contains fewer keyframes 
and is smoothed.

3 Click OK.

Averaging a Track Curve
Another possible smoothing option is to apply the Average parameter behavior to a track
curve in the Keyframe Editor. This behavior smoothes the transition from one keyframe
value to another. Averaged motion moves more fluidly.

To apply an Average parameter behavior to a track curve
µ In the parameter list of the Keyframe Editor, control-click the parameter name, then

choose Average from the shortcut menu.

The track is averaged, indicated by the simplified curve that appears behind the keyframes
in the Keyframe Editor.

For more information on using the Average parameter behavior, see Average.

Converting Tracks to Keyframes
Tracking data that is recorded or referenced by the Match Move, Stabilize, or Unstabilize
behavior can be “baked” into keyframes on the transformed object. The tracking keyframes
are applied to the tracked object and the behavior is deleted from the project. You can
then modify the animation curves in the Keyframe Editor.

Because the Analyze Motion behavior does not transform the image, analyzed tracks
cannot be converted into keyframes. However, a Match Move or Stabilize behavior that
references data from an Analyze Motion behavior can be converted into keyframes.
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To convert a tracking behavior to keyframes
1 Select the Match Move, Stabilize, or Unstabilize behavior that you want to convert.

2 Choose Object > Convert to Keyframes (or press Command-K).

A dialog appears confirming the conversion.

3 Click OK.

The behavior is converted into editable keyframes and the tracking behavior is deleted.

For more information on converting behaviors to keyframes, see Converting Behaviors
to Keyframes. For more information on using the Keyframe Editor, see Keyframes and
Curves.

Preserving Image Quality
Ideally, you should track an image with the most amount of raw data. The better the
quality of your footage, the better the quality of the track.

Asking Motion for a Hint
Motion can “suggest” good reference patterns.

To display the suggested tracking reference points
µ Press the Option key, click a tracker in the Canvas, and hold down the mouse button.

Note: You need at least one tracker in the Canvas to display suggested tracking reference
points.

The suggested reference points appear in the Canvas on the footage and in the magnified
inset as small red plus signs.

When you move a tracker toward one of the suggested points, the tracker snaps to the
point.
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The suggested points are not necessarily ideal tracking reference points for the feature
you want to track in the clip. Motion is merely picking locations in the current frame that
meet the track point criteria, such as an area of high contrast.

Giving Motion a Hint
When using the Analyze Motion behavior, you can direct a tracker where to look in a later
frame for its reference pattern. This tool is ideal for the following types of clips:

• A clip that contains fast-moving features

• A clip with a subjects moving in a relatively straight vector (with or without obstructions)

• A clip with swish pans (you may have to reset the “look-ahead” tracker at each panning
change)

Important: If your track fails and you reposition your tracker, you must also reset the
look-ahead tracker in the Canvas to provide a new motion vector from the new reference
point.

To define look-ahead frames
1 Apply an Analyze Motion behavior to a clip.

2 In the Canvas, position the tracker on the desired reference pattern.

In the following image, the tracker is positioned on a reference pattern on the front
bumper of the car.

Tracker

3 In the Behaviors tab of the Inspector, use the Look Ahead Frames slider or value slider to
specify how many frames you want the tracker to look ahead.
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Note: The maximum default for the Look Ahead Frames slider is 10 frames. However, you
can enter a larger frame amount using the adjacent value slider.

4 While holding down the Command key, click the tracker in the Canvas, then drag in the
direction the reference pattern is moving in the clip.

As you Command-drag the track point, an inset displays a magnified view of the frame
specified in the Look Ahead Frames parameter.

5 When the look-ahead tracker is positioned on the reference pattern, release the mouse
button.

When you click the Analyze button, the new reference point is used as the tracking pattern.

Note: Look Ahead Frames can be used when tracking in reverse. When the Reverse
checkbox is selected in the tracking behavior’s parameters and you use the Look Ahead
Frames parameter, you are looking at previous frames rather than future frames. The
Reverse checkbox is only available for the Analyze Motion, Track (in the Parameter
behaviors category), and Track Points (in the Shapes behaviors category) behaviors.

Manually Coaxing Your Track
When dealing with more challenging tracks, you can manually insert track position
keyframes to help guide the tracker towards a reference pattern. For example, if you have
a footage with significant motion blur or objects that partially obscure the tracking pattern,
you can manually create tracker position keyframes to help guide the tracker.

To manually coax a track using the Record button
1 Apply a Motion Tracking behavior to the clip, then enable Record (press A).

2 In the Canvas, position the tracker at the reference point you want to track.

A track position keyframe is created in the behavior (visible in the Keyframe Editor).

3 Navigate to the next frame at which you want to create a keyframe.

Note: You can press Shift-Right Arrow key to jump forward 10 frames, or press Shift-Left
Arrow key to jump backward 10 frames.

4 In the Canvas, position the tracker at the reference point you want to track.

5 Repeat steps 3 and 4 until you’ve completed the track.

1294 Chapter 19 Motion Tracking



6 In the Behaviors tab of the Inspector, click the disclosure triangle for the track you have
manually adjusted, then choose Use Existing Keyframes from the Fail Behavior pop-up
menu.

7 Turn off the Record button (press A).

8 Go to the first frame of the clip, then click the Analyze button in the behavior HUD or
Inspector.

Important: Even though keyframes have been created, you must analyze the footage in
order to obtain the tracking data.

To manually coax a track without enabling Record
1 Apply a Motion Tracking behavior to the clip.

2 In the Canvas, position the tracker at the reference point you want to track.

3 Choose Object > Add Position Keyframe.

This command is available for the Analyze Motion, Match Move, Stabilize (with manual
trackers), Track Points (in the Shape behaviors category), and Track (in the Parameter
behaviors category) behaviors.

Note: Keyframes cannot be created for automatically stabilized footage. Use the Track
Region option for adjusting automatic stabilization, or convert the stabilized footage to
keyframes. For more information on the Track Region parameter, see Adjusting the
Stabilize Behavior’s Track Region. For more information on converting tracking data to
keyframes, see Converting Tracks to Keyframes.

4 Navigate to the next frame at which you want to create a keyframe.

5 Repeat steps 2 and 3 until you’ve completed the track.

6 In the Behaviors tab of the Inspector, click the disclosure triangle for the track you have
manually adjusted, then choose Use Existing Keyframes from the Fail Behavior pop-up
menu.

7 Go to the first frame of the clip, then click the Analyze button in the behavior HUD or
Inspector.

Note: You can also use the Tracker Preview in the Behaviors tab of the Inspector to
reposition trackers in the Canvas.

Important: Even though keyframes have been created, you must analyze the footage in
order to obtain the tracking data.

Tracking Images with Perspective, Scale, or Rotational Shifts
For images with significant change in size and angle, you can try a few different strategies.
First, try using a larger search area. You can increase Motion’s default tracking search size
using the Search Size parameter in the Behaviors tab of the Inspector. Click the track’s
disclosure triangle to display the Search Size parameter.
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A second strategy is to lower the Fail Tolerance value. With a lower Fail Tolerance value,
the tracker is more likely to find a false match. With a higher value, the tracker is more
strict in finding a match. Click the track’s disclosure triangle to display the Fail Tolerance
parameter.

Another strategy is to jump to the midpoint frame of the clip and track forward to the
end frame of the clip. Then return to the midpoint frame and track backward to the
beginning of the clip.

Tracking Obscured or Off-Frame Points
In addition to experimenting with different tracker parameter settings, there is a basic
technique to correct track points that are obscured by moving offscreen or by an object
passing in front of them.

The following sequence is a simple example of a candidate for offset tracking. As the car
moves forward, it passes a tree that temporarily obstructs the reference pattern.

When the reference pattern becomes obscured, the Offset Track checkbox lets you move
the tracker, picking a new reference pattern in a different area from the original reference
pattern. The offset between the original reference pattern and the new pattern is calculated
to maintain continuity in the resulting track path.

In the following example, the track is obscured by a tree, so the tracker is moved to a
nearby reference pattern, and tracking continues until the original pattern reappears.
Even though one region is examined, the points are saved in another region. The second
tracking pattern should travel in the same direction as your original pattern.

To offset (move) the onscreen tracker control to an unobstructed area of the image
1 Go to the frame where you want to begin the offset track.
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When a track is lost during an analysis, Motion automatically jumps back to the frame at
which the track failed. The “bad” track point is identified by an “x” in the Canvas.

You can use the bad track point, or use any point prior to the failed track frame, to move
the tracker and select a new reference feature. In the Canvas, the track point at the current
playhead position is emphasized.

The track point at the 
current playhead is 
highlighted.

2 Select the Offset Track checkbox in the HUD or Behaviors tab of the Inspector.

Offset Track checkbox
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Note: The Offset Track parameter is available in the Analyze Motion behavior and in the
Stabilize behavior. Before the parameter becomes available in the Stabilize behavior, you
must explicitly add a tracker using the Add button in the Inspector.

3 Drag the tracker to a new position in the Canvas.

4 Click Analyze to restart the motion analysis.

Motion continues to keyframe the trajectory of the original track point, based on the
movement of the new offset reference pattern.

Tip: When you use Offset Track, make sure that the new reference pattern is as close to
the original tracking feature as possible. Ideally, the offset feature should share the same
motion as the originally tracked feature and appear on the same subject.

Note: When the cursor is held over a tracker in the Canvas, a tool tip displays the start
frame for the tracking analysis. When you perform an offset track, the tool tip displays
the frame from which the offset track began (if the playhead is in the range of the offset
track).

Tracking Retimed Footage
When working in a project that includes tracking and retiming tasks, use the following
guidelines for more successful results:

• Because the Motion tracker analyzes in a project’s frame rate, ensure that the frame
rate of the footage you plan to track matches the frame rate of the project. For example,
when you want to track 24 frames-per-second (fps) footage, your project’s frame rate
should be 24 fps. Once the tracking analysis is completed, retime the clip using the
Retiming parameters in the Media tab of the Inspector or the Retiming behaviors.

• Do not retime the footage prior to the tracking analysis.

• Do not retime the footage, perform a tracking analysis, then retime the footage again.
This may adversely affect your track.

Note: If you really want to track a clip after it has been retimed, it is recommended that
you retime and export the clip, then import the clip and perform the tracking analysis.

Troubleshooting Stabilizing Effects
If the output of a stabilize operation is unsatisfactory, there are several things you can try
to improve the result.

Keeping It Real
The automatic motion analysis (analysis without trackers) used by the Stabilize behavior
works best with real images. Artificial images, such as those with no texture, are not
recommended for use with the Stabilize behavior’s automatic mode. Shots with very
strong pans are also not recommended.
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Adding Trackers to the Stabilization
If a stabilized clip has a particularly bumpy section that is not getting smoothed, you can
add trackers to noncontiguous sections of a clip.

Any stabilize data from the automatic motion analysis is overwritten by the portions of
the clip that are analyzed using the onscreen trackers.

To use a tracker for a portion of a stabilize operation
1 Once the Stabilize motion analysis is complete, play the clip to determine what section

you want to track.

Important: Always analyze the entire clip before adding any trackers. The Stabilize behavior
needs “’meaningful” data—a large range of frames—to yield the best results.

2 Set an Out point for the tracker analysis: Position the playhead at the frame you want to
stop the analysis, then choose Mark > Mark Play Range Out (or press Command-Option-O).

3 Position the playhead at the frame where you want to start the track, then click the Add
button in the Inspector.

4 Position the newly added tracker on the reference pattern you want to track in the Canvas,
then click the Analyze button in the HUD or Inspector.

The specified play range is tracked, creating track points in the Canvas and tracking
keyframes in the Keyframe Editor.

Note: When using this strategy to track multiple noncontiguous sections of the clip, use
the same tracker whenever possible to simplify the track and to avoid clutter in the
Keyframe Editor.

This strategy is not recommended for small portions of the clip, such as using the default
stabilization for 25 frames, a tracker analysis for 10 frames, the default stabilization for
10 frames, and so on.

Changing the Smoothing Parameters
If you’re trying to smooth the motion in a clip, you should first try adjusting the smoothing
parameters. These parameters include Translation Smooth, Rotation Smooth, and Scale
Smooth. This can be accomplished without having to reanalyze the clip.

To display the Smoothing parameters for the Stabilize behavior
µ In the Behaviors tab in the Inspector, choose Smooth from the Method pop-up menu.

The Translation Smooth, Rotation Smooth, and Scale Smooth parameters become available.

Reanalyzing at a Higher Quality
When analyzing, choose Better from the Quality pop-up menu in the Behaviors tab of
the Inspector. This may take longer, but the quality of the analysis is higher.
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Editing the Analysis Data
If neither of the prior solutions helps, look at the “Analyze.Confidence” parameter in the
Keyframe Editor, then look for frames where the Confidence parameter falls to very low
values. You can convert the Stabilize behavior to keyframes in order to create transform
keyframes on the stabilized object. These keyframes can then be edited in the Keyframe
Editor. Try deleting any keyframes that create unusual spikes at the frames where the
Confidence curve value was low.

For more information on converting behaviors to keyframes, see Converting Tracks to
Keyframes.

Removing Black Borders Introduced by Stabilizing
When you use the Stabilize behavior, the resulting transformations that are made to
smooth or stabilize the shot cause moving black borders to appear around the edges of
the image. While this is necessary to achieve the desired effect, you probably don’t want
these black borders to appear in the final shot.

There are a few ways you can choose to handle these borders.

Zooming the Clip
You can zoom the clip using the Borders pop-up menu in the Behaviors tab of the
Inspector. The disadvantage of this method is the resulting softening of the image,
depending on how much it must be enlarged.

To zoom the clip
µ In the Behaviors tab of the Inspector, choose Zoom from the Borders pop-up menu.

The clip is expanded to the full size of the Canvas, preventing black borders from appearing
around the edges of the stabilized clip.

Scaling the Output Image to Fit the Original Frame Size
If you need to output the resulting image at the same size as the original, the quickest
fix is to scale the image after the Stabilize analysis. You’ll need to enlarge the image to
the point where all instances of black borders fall outside the edges of the frame. Like
the Zoom option (in the Borders pop-up menu), this method softens the image.

Note: This workflow is a manual version of zooming the clip using the Zoom option from
the Borders pop-up menu.

To scale the stabilized image
1 Select the clip and click the Properties tab of the Inspector.

2 Adjust the Scale parameter so that the borders no longer appear at the edges of the clip.
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Distorting the Edges
One last suggestion is to experiment with different filters to stretch the edges of the
image to fill any gaps. For example, you can experiment with the Scrape filter to stretch
out the edges of the image. This solution is highly dependent on the type of image and
may introduce other image artifacts that may or may not be acceptable.

In the following image, a large border is created when the clip is stabilized.

Next, a Scrape filter is applied to the group in which the stabilized clip resides. The left
image shows the clip when the filter is first applied to the group. At first, it does not
appear especially helpful. In the right image, the center and rotation of the filter are
adjusted, removing the black edge by stretching the right edge of the image.

Important: The filter must be applied to the clip’s group, not to the clip, for this technique
to have any effect.

Note: You may need to select the Fixed Resolution checkbox in the Group tab of the
Inspector so the effect of the Scrape filter is not cropped.
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Some General Guidelines
The Motion tracker uses the source image for its tracking analysis. This means that the
tracker automatically uses the best search area, the best color, the best contrast, subpixel
accuracy, and so on in the clip to generate the best possible tracking data. Common
tracking strategies, such as using filter tricks, manually resizing a tracking “box” or search
area, or specifying a subpixel sampling amount are not required.

This does not mean that you do not have to work to achieve a perfect track, of course.
Use the following guidelines to help you decide what may and what may not assist you
in your tracking analysis.

What will help you:

• Removing interlacing (fields) from the footage prior to tracking. To remove the fields
from footage, select the footage in the Media tab of the Project pane, click the Media
tab in the Inspector, then choose an option from the Field Order pop-up menu.

Note: Interlacing can be present in clips stabilized using the automatic analysis mode
in the Stabilize behavior.

• Stabilizing a clip, exporting the clip, importing the clip, then stabilizing the clip again.

• Sharpening or blurring a clip or an object with a filter, exporting the clip, importing
the clip into the same group as the original footage, tracking the filtered clip, then
using that tracking data as the source for other tracking behaviors.

Note: Other filter tricks may also be helpful, such as using a filter to isolate a less-noisy
color channel of a clip or an object.

• Setting the View resolution to a lower setting, which may speed the tracking analysis

What will not help you:

• Applying any filter to a clip or object prior to tracking

• Soloing or isolating a tracked clip. This does not speed tracking analysis.

• Adding multiple Stabilize behaviors. This does not help to further stabilize an analyzed
clip, because the tracker analyzes the original source footage and not the result of an
analyzed clip (or a filtered clip).

• Converting a track to keyframes and stabilizing again

• Selecting a tracking reference feature that does not change perspective, scale, or
rotation. The Motion tracker is designed to handle changes in perspective, scale, and
rotation very well.

Tracking and Groups
There are a few special considerations when tracking groups.
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Corner-Pinning Groups
You can corner-pin groups using the Match Move behavior. Use the following guidelines
for the best results:

• To corner-pin a 2D group, it is recommended that you select the Fixed Resolution
checkbox in the Group tab of the Inspector.

• To corner-pin a 3D group, you must select the Flatten checkbox in the Group tab of
the Inspector. If Flatten is not enabled for the group, the Four Corners option will not
be available from the Type pop-up menu in the Match Move parameters.

Once Four Corners is chosen from the Type pop-up menu, Four Corner is enabled in
the Properties tab of the Inspector, causing the group to be rasterized. For more
information on rasterization, see Groups and Rasterization.

Using either of the above techniques may still result in dynamic resizing. If you receive
unwanted results, export the group, import the group, then corner-pin the object.

Parallax in 3D Groups
When match moving 3D groups that contain objects that are offset in Z space, parallax
is simulated. Parallax is the apparent shift of an object against a distant background
caused by a shift in perspective, such as a change in camera position.

To remove a parallax effect, select the Flatten checkbox for the tracked group in the
Group tab of the Inspector.

Saving Tracks
As with all behaviors in Motion, you can save tracking behaviors to the Library. Keep in
mind, however, that a tracking behavior needs to reference the tracked source object.
Therefore, it may make more sense to save the entire group that contains the tracking
behavior, as well as the source footage, to the Library.

To save a group to the Library
1 Open the Library and select the category into which you want to save the group, such

as the Favorites category.

2 Drag the group that contains the tracking behavior and its source (tracked) footage from
the Layers tab or Timeline into the stack at the bottom of the Library.

The group is added to the Library category.

To save a behavior to the Library
1 Open the Library and select the Favorites, Favorites Menu, or Behaviors category.

2 Drag the customized behavior you want to save from the Layers tab, Timeline, or Inspector
into the stack at the bottom of the Library.

When you save a customized item to the Library, it is saved in the
/Users/username/Library/Application Support/Final Cut Studio/Motion/Library/ folder.

1303Chapter 19 Motion Tracking



For more information on saving behaviors to the Library, see Saving and Sharing Custom
Behaviors.

To add a group to a project from the Library
1 Open the Library and select the category that contains the group.

2 Do one of the following:

• To nest the group in an existing group, drag it to the existing group in the Layers tab.

• To create a new group, drag it to an empty area in the lower portion of the Layers tab.

The group is added to the project.

To apply a behavior to a clip from the Library
1 Open the Library and select the Favorites, Favorites Menu, or Behaviors category.

2 Drag the behavior to the clip in the Layers tab, Timeline, or Canvas.

To reference another tracking behavior in a project
1 Add an Analyze Motion, Match Move, Stabilize, or Unstabilize behavior.

2 In the tracking behavior’s HUD or Inspector, choose a track from the tracking behaviors
pop-up menu.

The track is applied to the tracking behavior.

Note: In a Stabilize behavior, only tracks from other Stabilize behaviors can be chosen
from the tracking behaviors pop-up menu.

Tracking Behavior Parameters
The following section provides a detailed description of the parameters available in the
different tracking behaviors.

Note: Cloned objects cannot be tracked.

Analyze Motion Controls
The Analyze Motion behavior is designed for use with footage (a movie or image
sequence). This behavior can be thought of as a “traditional” correlation tracker—you
position an onscreen tracker on a reference pattern on a clip. The movement of the clip
at the specified reference point is analyzed, and the analyzed data is saved in the behavior.
The recorded data can then be applied to other objects in the project.

The Analyze Motion behavior does not transform the input image. It is used only to
generate tracks that can be referenced by the Match Move and Stabilize behaviors.

For information on using the Analyze Motion behavior, see General Motion Tracking
Workflow.

Note: Analyze Motion cannot reference other tracking behaviors.

1304 Chapter 19 Motion Tracking



Important: The Analyze Motion behavior can only be applied to footage objects (a
QuickTime movie or image sequence).

Parameters in the Inspector
Movement: The Movement parameters contain the Analyze and Reverse controls.

• Analyze: Click the Analyze button to begin the motion tracking analysis. Once Analyze
is clicked, a status window appears that displays the tracking progress. To stop the
analysis, click the Stop button in the status window or press Esc.

The start of the track is based on the current playhead position, rather than the start
of the behavior in the Timeline.

• Reverse: When the Reverse checkbox is selected, the clip is analyzed from the current
playhead position to the first frame of the clip (or the first frame of the tracking
behavior).

Note: You must move the playhead to the frame from which you want to begin the
reverse analysis.

Tracker: Click the Add button to add trackers to the Analyze Motion behavior. By default,
one tracker is available. New trackers are added at the center of the Canvas.

Tracker Preview: This preview area provides a magnified view of the tracking reference
area for the selected tracker. The preview updates as you adjust the position of the tracker
in the Canvas. You can drag in the preview area to adjust the position of the tracker.
When dragging in the preview area, the image moves around the red crosshairs that
represent the tracker, while the tracker moves in the Canvas. Additionally, you can
Option–drag left or right to decrease or increase pattern size. (You can also adjust the
Track Size slider to achieve the same result.)

Offset Track: If a tracker’s reference point becomes temporarily hidden or goes off the
screen, this parameter allows you to select a different reference point that continues the
same tracking path as the original reference point. For more information on offset tracking,
see Tracking Obscured or Off-Frame Points.

Auto-Zoom: Choose an option from this pop-up menu to set the magnification level
when positioning the tracker in the Canvas. This allows you to zoom in on the Canvas
when searching for an ideal tracking reference pattern. There are four choices:

• None: When moving the tracker in the Canvas, there is no magnification (only the
tracker appears).

• 2x: When moving the tracker in the Canvas, the magnification around the tracker is
two times the normal zoom level.

• 4x: When moving the tracker in the Canvas, the magnification around the tracker is
four times the normal zoom level.

• 8x: When moving the tracker in the Canvas, the magnification around the tracker is
eight times the normal zoom level.
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Auto-Zoom Mode: Choose an option from this pop-up menu to set the display of the
auto-zoomed tracker in the Canvas. There are three choices:

• Normal: Displays a normal pattern.

• Contrast: Displays the tracker pattern with contrast detection.

• Edge: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies only to the trackers in the Canvas and does not appear
in the Tracker Preview in the Behaviors tab of the Inspector.

Note: When None is chosen from the Auto-Zoom pop-up menu, the Auto-Zoom Mode
setting has no effect.

Look Ahead Frames: This slider and value slider allow you to specify the number of
“future” frames to be analyzed by the tracker. In other words, you can direct the tracker
to look in a specific location for its reference point. This is especially useful for footage
that contains fast-moving objects, as the reference point can quickly “get away” from the
tracker. For more information on using Look Ahead Frames, see Giving Motion a Hint.

Track list: Displays the trackers in the behavior. In the Analyze Motion behavior, the
trackers in this list are called “Track 1, Track 2,” and so on.

To disable a tracker, deselect its checkbox. To remove a tracker, click the Remove button.
A tracker that is turned off is not analyzed with the track.

Click the disclosure triangle next to the track name to reveal additional parameters:

• Position: Displays the X and Y positions of the tracker. The X position is the value slider
on the left; the Y position is the value slider on the right. Click the disclosure triangle
to display labeled position value sliders.

• Track Size: Use this slider to adjust (in pixels) the pattern search size for the tracker. As
you adjust the track size, the Tracker Preview is updated to show the new track size
(there is no visual change in the Canvas tracker).

To adjust the Track Size without exposing its parameters, Option–drag left in the Tracker
Preview area to reduce the track size; Option–drag right to increase the track size.

• Search Size: Use this slider or value slider to increase or reduce the tracker’s search area
size. In Motion, you do not specify the size of a search area when setting up your trackers
in the Canvas. To change the default search size, use the slider or value slider. If Search
Size is set to 200 percent, the tracker’s search area is twice the default search area size.

• Fail Tolerance: This parameter defines the amount of tolerance for error, orconfidence
value, of the track. In other words, it defines at what “score” the tracker determines it
is able to match a reference feature. When above the score, the tracker accepts the
match. When below the score, the tracker rejects the match. Once the match is rejected,
the Fail Behavior kicks in.
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• Fail Behavior: This pop-up menu specifies what happens if the track confidence value
falls below the Fail Tolerance amount. The following options are available:

• Smart Retry: The tracker attempts to find the reference pattern in a larger search area.
If the pattern cannot be found, the tracker switches to the Predict option. Smart Retry
is the default fail behavior.

• Stop: Stops the analysis when the tracker loses the reference pattern. You can also
click the Stop button in the tracking progress dialog or press Esc to stop an analysis.

• Predict: The tracker predicts a new search area without creating keyframes until it
finds a match for the reference pattern. This is excellent for tracked objects that pass
behind foreground objects.

• Predict and Key: If a failure is detected, the tracker predicts the location of the keyframe
based on a vector of the last two keyframes, and continues tracking in the new area.

• Don’t Predict: The tracker remains in its position and searches for subsequent matches
as the clip’s frames progress. While searching for a match, the tracker does not create
keyframes.

• Use Existing Keyframes: Use this option if you have manually created track position
keyframes to guide the tracker. After manually adding keyframes, return to the start
frame and start the tracking analysis. If the tracker has difficulty locating the track
pattern, the manually created tracking keyframes are referenced to guide the tracker.

• Color: Click or Control-click the color well to set a new color for the onscreen tracker.
You can also click the eyedropper and select a color in the Canvas. The default tracker
color is red. When a tracker is selected, its center point is yellow and the border of its
magnified inset is the color set in the color well. To adjust the individual color channels,
including the tracker’s opacity, click the disclosure triangle.

HUD Controls
The Analyze Motion HUD contains controls to start the motion track (the Analyze button),
reverse the direction of the track (the Reverse checkbox), and to specify an offset track
(the Offset Track checkbox). Offset tracking allows you to reposition the tracker at a new
reference pattern.

Match Move Controls
The Match Move behavior can be applied to many different object types, including groups,
cameras, shapes, particle emitters, and so on.

Important: When applying the Match Move behavior to a group, make sure that the
footage being analyzed resides outside of the group being tracked.

In order to use Match Move (and access all of its parameters), your project must contain
a foreground and a background object. For information on using the Match Move behavior,
see Match Move Workflows.
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Parameters in the Inspector
Source: Drag the source object for the match move to this well. The source object can
be another tracking behavior, an animated object, or a footage object. When a Match
Move behavior is added to an object, the nearest animated object, recorded track, or
footage object beneath the behavior in the Layers tab appears in this well. To clear a
Source well, drag the item away from the well and release the mouse button.

When any non-footage object (such as a shape or mask) is dropped in the Source well,
the trackers are no longer available in Match Move.

Note: When the Match Move behavior is applied to a mask, the masked object is
automatically selected as the source.

Tracking behaviors pop-up menu: Choose from a list of tracking data (from other tracking
behaviors) within the project.

Tracking behaviors 
pop-up menu

Movement: The Movement parameters contain the Analyze and Reverse parameters.

• Analyze: Click the Analyze button to begin the motion tracking analysis. Once Analyze
is clicked, a status window appears that displays the tracking progress. To stop the
analysis, click the Stop button in the status window or press Esc.

The start of the track is based on the current playhead position, rather than the start
of the behavior in the Timeline.

• Reverse: When the Reverse checkbox is selected, the clip is analyzed from the current
playhead position to the first frame of the clip (or the first frame of the tracking
behavior).

Note: You must move the playhead to the frame from which you want to begin the
reverse analysis.

Type: This pop-up menu allows you to choose between one-point, two-point, or four-point
tracking.

• Transformation: This option allows one-point or two-point tracking, transforming the
destination object.

• Four Corners: This option enables four-point tracking, corner-pinning the destination
object. When this option is chosen, the Direction and Adjust parameters are no longer
available.

Important: The Four Corners option is not available when Match Move is applied to a
3D group or a mask. To corner-pin a 3D group, select the Flatten checkbox in the Group
tab of the Inspector.
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Direction: This pop-up menu allows you to specify the dimension in which the recorded
movement is applied to the destination object: Horizontal and Vertical (X and Y), Horizontal
(only X), or Vertical (only Y).

Transform: This pop-up menu allows you to choose how the destination object (the
object to which the Match Move behavior is applied) moves. This menu contains two
items: Attach to Source and Mimic Source.

• Attach to Source: This option anchors the foreground object to the recorded track or
animation source. Use Attach to Source when the source object is scaling or rotating,
and you want the destination object to “stick” to a particular spot on the source object.
Any animation that existed on the destination object prior to applying the track can
be preserved by using the Adjust parameters (Position, Scale, and Rotation), available
when Transformation is chosen from the Type pop-up menu.

Note: Although the destination object is attached to the movement of the source
object, the position of the destination object can be changed (offset from the source
object).

In the following example, Match Move is applied to the red “pill” shape and uses the
animated white arrow as the source object. The white arrow has an applied Spin
behavior and is spinning in a clockwise direction. Additionally, the arrow’s anchor point
is positioned at the bottom of the arrow (at the opposite end from the tip).

Arrow’s anchor point

When Attach to Source is chosen from the Transform pop-up menu and Position and
Rotation are selected in the Adjust parameter row, the red shape is anchored to one
spot (the tip, in this example) on the arrow as it matches the movement of the arrow.
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• Mimic Source: This option allows the destination object to “mimic” the recorded track
or animation source. Any animation that existed on the foreground object prior to
applying the track can be added to the track by selecting Position, Rotation, or Scale
in the Adjust parameters.

Note: As with Attach to Source, the position of the destination object can be changed
(offset from the source object). Additionally, the destination object can be scaled and
rotated.

In the following images, Mimic Source is chosen from the Transform pop-up menu and
Position and Rotation are selected in the Adjust parameter row. The red shape is not
locked to one spot on the white arrow, but rather mirrors the arrow’s animation.

Mimic Source allows you to transform a tracked object in the Properties tab of the
Inspector. For example, you can change the scale, position, or rotation of a corner-pinned
object. Also when using Four Corners, Mimic Source allows you to adjust the trackers
without adjusting the foreground image.

Adjust: This parameter allows you to choose the type of transformation applied to the
destination object.

• Position: When enabled, the position of the source (or background) object is applied
to the destination (or foreground) object. When Position is enabled, the Anchor (position)
tracker is turned on.

• Scale: When enabled, the scale of the source (or background) object is applied to the
destination (or foreground) object. The source track must include scale data for this
parameter to have any effect. When Scale is enabled, the Rotation-Scale tracker is turned
on.

• Rotation: When enabled, the rotation of the source (or background) object is applied
to the destination (or foreground) object. The source track must include rotation data
for this parameter to have any effect. When Rotation is enabled, the Rotation-Scale
tracker is turned on.

Tracker Preview: This parameter appears only when there is a tracking source (footage)
in the source well. This preview area provides a magnified view of the tracking reference
area for the selected tracker. The preview updates as you adjust the position of the tracker
in the Canvas. You can also drag in the preview area to adjust the position of the tracker.
When dragging in the preview area, the image moves around the red crosshairs in the
preview and the tracker moves in the Canvas.
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Offset Track: This parameter appears only when there is a tracking source (footage) in
the source well. If a tracker’s reference point becomes temporarily hidden or goes off the
screen, this parameter allows you to select a different reference point that continues the
same tracking path as the original reference point. For more information on offset tracking,
see Tracking Obscured or Off-Frame Points.

Auto-Zoom: This parameter appears only when there is a tracking source (footage) in
the source well. Choose an option from this pop-up menu to set the magnification level
when positioning the tracker in the Canvas. This allows you to zoom in on the Canvas
when searching for an ideal tracking reference pattern. There are four choices:

• None: When moving the tracker in the Canvas, there is no magnification (only the
tracker appears).

• 2x: When moving the tracker in the Canvas, the magnification around the tracker is
two times the normal zoom level.

• 4x: When moving the tracker in the Canvas, the magnification around the tracker is
four times the normal zoom level.

• 8x: When moving the tracker in the Canvas, the magnification around the tracker is
eight times the normal zoom level.

Auto-Zoom Mode: This parameter appears only when there is a tracking source (footage)
in the source well. Choose an option from this pop-up menu to set the display of the
auto-zoomed tracker in the Canvas. There are three choices:

• Normal: Displays a normal pattern.

• Contrast: Displays the tracker pattern with contrast detection.

• Edge: Displays the tracker pattern with edge detection. The Auto-Zoom Mode applies
only to the trackers in the Canvas and does not appear in the Tracker Preview in the
Behaviors tab of the Inspector. When None is chosen from the Auto-Zoom pop-up
menu, the Auto-Zoom Mode setting has no effect.

Look Ahead Frames: This parameter appears only when there is a tracking source (footage)
in the source well. This slider and value slider allow you to specify the number of “future”
frames to be analyzed by the tracker. In other words, you can direct the tracker to look
in a specific location for its reference point. This is especially useful for footage that
contains fast-moving objects, as the reference point can quickly “get away” from the
tracker. For more information on using Look Ahead Frames, see Giving Motion a Hint.

Anchor/Rotation-Scale(checkboxes): Available when one-point or two-point tracking is
enabled (when Transformation is chosen from the Type pop-up menu), these checkboxes
turn the Anchor and Rotation-Scale trackers on or off. The anchor tracker records position
data. When Position is enabled in the Adjust parameters, the Anchor tracker is turned on.
Rotation and scale data are recorded by using the relationship between the Anchor and
Rotation-Scale trackers. When Scale or Rotation is enabled in the Adjust parameters, the
Rotation-Scale tracker is turned on.
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When the Match Move behavior references another behavior, such as Analyze Motion,
the Anchor tracker becomes the Anchor pop-up menu. Likewise, the Rotation-Scale tracker
(if there is one) becomes the Rotation-Scale pop-up menu.

Click the Anchor or Rotation-Scale disclosure triangles to reveal additional parameters:

• Position: Displays the X and Y positions of the tracker. The X position is the value slider
on the left; the Y position is the value slider on the right. Click the disclosure triangle
to display labeled position value sliders.

• Track Size: Use this slider to adjust (in pixels) the pattern search size for the tracker. As
you adjust the track size, the Tracker Preview is updated to show the new track size
(there is no visual change in the Canvas tracker).

To adjust the Track Size without exposing its parameters, Option–drag left in the Tracker
Preview area to reduce the track size; Option–drag right to increase the track size.

• Search Size: Use this slider or value slider to increase or reduce the tracker’s search area
size. In Motion, you do not specify the size of a search area when setting up your trackers
in the Canvas. To change the default search size, use the slider or value slider. If Search
Size is set to 200 percent, the tracker’s search area is twice the default search area size.

• Fail Tolerance: This parameter defines the amount of tolerance for error, orconfidence
value, of the track. In other words, it defines at what “score” the tracker determines it
is able to match a reference feature. When above the score, the tracker accepts the
match. When below the score, the tracker rejects the match. Once the match is rejected,
the Fail Behavior kicks in.

• Fail Behavior: This pop-up menu specifies what happens if the track confidence value
falls below the Fail Tolerance amount. The following options are available:

• Smart Retry: The tracker attempts to find the reference pattern in a larger search area.
If the pattern cannot be found, the tracker switches to the Predict option. Smart Retry
is the default fail behavior.

• Stop: Stops the analysis when the tracker loses the reference pattern. You can also
click the Stop button in the tracking progress dialog or press Esc to stop an analysis.

• Predict: The tracker predicts a new search area without creating keyframes until it
finds a match for the reference pattern. This is excellent for tracked objects that pass
behind foreground objects.

• Predict and Key: If a failure is detected, the tracker predicts the location of the keyframe
based on a vector of the last two keyframes, and continues tracking in the new area.

• Don’t Predict: The tracker remains in its position and searches for subsequent matches
as the clip’s frames progress. While searching for a match, the tracker does not create
keyframes.
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• Use Existing Keyframes: Use this option if you have manually created track position
keyframes to guide the tracker. After manually adding keyframes, return to the start
frame and start the tracking analysis. If the tracker has difficulty locating the track
pattern, the manually created tracking keyframes are referenced to guide the tracker.

• Color: Click or Control-click the color well to set a new color for the onscreen tracker.
You can also click the eyedropper and select a color in the Canvas. The default tracker
color is red. When a tracker is selected, its center point is yellow and the border of its
magnified inset is the color set in the color well. To adjust the individual color channels,
including the tracker’s opacity, click the disclosure triangle.

Rotation-Scale (pop-up menu): When the Match Move behavior references another
behavior, such as Analyze Motion, the Rotation-Scale tracker becomes the Rotation-Scale
pop-up menu. The tracker’s subparameters are replaced with a pop-up menu that allows
you to select the tracker from the referenced behavior that you want to apply as the
Rotation-Scale tracker. By default, Track 2 is applied as the Scale-Rotation tracker. If there
is only one tracker in the referenced behavior, Track 1 is applied to both Anchor and
Rotation-Scale.

Anchor (pop-up menu): When the Match Move behavior references another behavior,
such as Analyze Motion, the Anchor tracker checkbox becomes the Anchor tracker. The
tracker’s subparameters are replaced with a pop-up menu that allows you to select the
tracker from the referenced behavior that you want to apply as the Anchor tracker. By
default, Track 1 from the referenced behavior is applied as the Anchor tracker. If there is
only one tracker in the referenced behavior, Track 1 is applied to both Anchor and
Rotation-Scale.

When Match Move 
references another 
behavior, the trackers 
from the referenced 
behavior are applied to 
the Match Move trackers.

Top Left: Available when four-point tracking is enabled (Four Corners is chosen from the
Type pop-up menu) and the Match Move behavior references another behavior (such as
Analyze Motion), this pop-up menu allows you to select the tracker from the referenced
behavior that you want to apply as the top left tracker.

Top Right: Available when four-point tracking is enabled (Four Corners is chosen from
the Type pop-up menu) and the Match Move behavior references another behavior (such
as Analyze Motion), this pop-up menu allows you to select the tracker from the referenced
behavior that you want to apply as the top right tracker.
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Bottom Right: Available when four-point tracking is enabled (Four Corners is chosen
from the Type pop-up menu) and the Match Move behavior references another behavior
(such as Analyze Motion), this pop-up menu allows you to select the tracker from the
referenced behavior that you want to apply as the bottom right tracker.

Bottom Left: Available when four-point tracking is enabled (Four Corners is chosen from
the Type pop-up menu) and the Match Move behavior references another behavior (such
as Analyze Motion), this pop-up menu allows you to select the tracker from the referenced
behavior that you want to apply as the bottom left tracker.

HUD Controls
The Match Move HUD contains controls to load an animated object or tracking data from
another tracking behavior (via the Source well or the tracking behaviors pop-up menu),
to start the motion analysis (the Analyze button), to reverse the direction of the track (the
Reverse checkbox), to offset the track (the Offset Track checkbox), to specify whether the
destination object is four-corner pinned (the Type pop-up menu), and to choose what
transform is applied to the destination object (the Adjust parameter).

Stabilize Controls
The Stabilize behavior uses a different method to analyze movement in a clip than the
Match Move and Analyze Motion behaviors. Generally, you do not use trackers to stabilize
a clip. The behavior’s sophisticated method of motion estimation automatically tracks
every pixel in one frame to the subsequent frame. A motion vector is calculated based
on this analysis. The analysis can be performed on the entire clip, or on a region of interest
(ROI). An ROI is a user-defined area of a clip that is analyzed.

If the result of the automatic analysis requires additional correction, you can perform
manual tracking on noncontiguous time regions of the clip. For example, if there is an
additional camera bump affecting frames 350 to 380, you can add a tracker to analyze
just that portion of the clip. The data recorded from the additional analysis is added to
the data recorded by the automatic tracking to further smooth the clip.

In addition to considering horizontal, vertical, or horizontal and vertical movement in the
clip, the Stabilize behavior also looks at position, scale, and rotation.

Note: The Stabilize behavior can only be applied to footage objects (a QuickTime movie
or an image sequence).

Important: When a Final Cut Pro clip or sequence that contains a SmoothCam filter is
exported to Motion, the filter is converted to a Stabilize behavior in Motion. Smooth is
chosen from the Method pop-up menu, rather than the default Stabilize option.

For information on using the Stabilize behavior, see Stabilize Workflow.

Note: When Smooth is chosen from the Method pop-up menu, additional parameters
become available in the HUD and Inspector.
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Parameters in the Inspector
Source: To clear a Source well, drag the item away from the well and release the mouse
button. Drag a source object for the behavior to this well. The source object can be
another Stabilize behavior or a footage object.

Tracking behaviors pop-up menu: Choose from a list of tracking data (from other tracking
behaviors) within the project.

Tracking behaviors 
pop-up menu

Note: When you select an option from the tracking behaviors pop-up menu, the Add
button, which allows you to add trackers, is no longer available.

Movement: Click the Analyze button to begin the motion tracking analysis. Once Analyze
is clicked, a status window appears that displays the tracking progress. To stop the analysis,
click the Stop button in the status window or press Esc.

When using the Stabilize behavior (without trackers), the track begins at the start of the
clip, rather than the current playhead position.

Quality: This pop-up menu defines the level of detail for the motion analysis. There are
two levels of quality, Faster and Better.

• Faster: This option allows for a faster operation, but the motion analysis is less detailed.

• Better: This option provides a more detailed analysis, but is slower. This is the
recommended option when the clip contains rotation.

Note: This option is equivalent to the default setting of the SmoothCam filter in
Final Cut Pro.

Track Region: When this checkbox is selected, a red box appears in the Canvas that
allows you to define a subject or area that you want to be analyzed. The area outside of
the region is ignored. The track region’s onscreen controls are similar to a shape’s onscreen
controls.

For more information on using the Track Region, see Adjusting the Stabilize Behavior’s
Track Region.

Method: This pop-up menu defines how the stabilization is applied to the clip. There are
two options:

• Stabilize: This method attempts to lock the motion of the principal subject in the shot
to eliminate motion. As a result, the background will appear to move around the subject
being tracked.
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• Smooth: This method smoothes the apparent motion of the camera, while allowing
the general movement in the frame to proceed. It’s useful for removing jitter from a
camera move. When enabled, this mode has three sliders for each of the dimensions
that can be smoothed.

Translation Smooth: This parameter appears when Method is set to Smooth. Smoothes
motion in both the X and Y dimensions.

Rotation Smooth: This parameter appears when Method is set to Smooth. Smoothes
image rotation.

Scale Smooth: This parameter appears when Method is set to Smooth. Smoothes an
uneven zoom.

Note: Don’t set the Scale Smooth above 0 unless you’re positive that the image is being
zoomed.

Borders: When a clip is stabilized, the resulting transformations that are made to the
stabilized image may cause moving black borders to appear around the edges of the clip.
This pop-up menu defines how the edges are handled.

• Normal: Maintains the size of the stabilized footage. The moving black borders remain
around the edges of the clip.

• Zoom: Expands the clip to the full size of the Canvas. This prevents black borders from
appearing around the edges, but scales up the stabilized clip.

Zoomed borders scale 
the stabilized clip so
the clip does not move 
away from the edge
of the Canvas.

Direction: This pop-up menu allows you to specify the dimension to which the recorded
movement is applied to the analyzed image: Horizontal and Vertical (X and Y), Horizontal
(only X), or Vertical (only Y).

Adjust: This parameter allows you to choose the transformation to which the stabilization
is applied.

• Position: When enabled, stabilize is applied to the position of the analyzed image.

• Scale: When enabled, stabilize is applied to the scale of the analyzed image.

• Rotation: When enabled, stabilize is applied to the rotation of the analyzed image.
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Tracker: Click the Add button to add trackers to the Stabilize behavior. By default, trackers
are added at the center of the Canvas. A maximum of two trackers can be added to the
Stabilize behavior. When added, Track 1 is used as the anchor (for position) and Track 2
is used for rotation-scale.

Once a tracker is added to a Stabilize behavior, the following occurs:

• The Track Region parameter is no longer available.

• The Reverse checkbox becomes available, allowing you to track a clip backwards.

• The Tracker Preview, Offset Track, Auto-Zoom, Auto-Zoom Mode, Look Ahead Frames,
and track list controls become available. For more information, see Analyze Motion
Controls.

Note: When another behavior is used as the source for the stabilization, you cannot
add trackers to the Stabilize behavior.

HUD Controls
The Stabilize HUD contains controls to load another stabilize track into the behavior (via
the Source well or the tracking behaviors pop-up menu), to start the motion analysis (the
Analyze button), to specify whether the clip is stabilized or smoothed (the Method pop-up
menu), to define how the stabilize clip is “sized” (the Borders pop-up menu), and to choose
what transform is applied to the analyzed clip (the Adjust parameter).

Unstabilize Controls
The Unstabilize behavior is used to apply movement tracked in another tracking behavior
to an object. This behavior does not perform any tracking analysis. The Unstabilize behavior
can be applied to many different object types, including groups, cameras, shapes, particle
emitters, and so on.

For information on using the Unstabilize behavior, see Unstabilize Workflow.

Parameters in the Inspector
Source: Drag a Stabilize behavior to this well to load the data into the Unstabilize behavior.
To clear a Source well, drag the item away from the well and release the mouse button.

Note: Dragging other objects (such as footage) to the source well has no effect on the
tracker.

• Tracking behaviors pop-up menu: Choose from a list of tracking data (from other tracking
behaviors) within the project.

Tracking behaviors 
pop-up menu

Note: The Unstabilize behavior can be converted to keyframes. For more information,
see Converting Tracks to Keyframes.
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HUD Controls
The Unstabilize HUD contains two controls to load another stabilize track into the behavior:
the Source well or the tracking behaviors pop-up menu. These controls are identical to
the controls in the Inspector.

Track Points Controls
The Track Points behavior allows you to link the control points of a shape or mask
(including paint strokes) to reference features on a source clip. This behavior also allows
you to apply existing tracking data that was recorded by the Analyze Motion, Match
Move, or Stabilize tracking behaviors to the control points of a shape or mask.

The Track Points behavior can be found in the Behaviors’ Shape subcategory in the Library,
or by choosing Shape > Track Points from the Add Behavior pop-up menu in the Toolbar.

For information on using the Track Points behavior, see Track Points Workflow.

Parameters in the Inspector
Source: Drag a source object for the track points to this well. The source object can be
another tracking behavior, an animated object, or a footage object. To clear a Source
well, drag the item away from the well and release the mouse button.

• Tracking behaviors pop-up menu: Choose from a list of tracking data (from other tracking
behaviors) within the project.

Tracking behaviors 
pop-up menu

Transform: This pop-up menu allows you to choose how the destination object moves.
There are two options:

• Attach to Source: This option anchors the foreground object to the recorded track or
animation source. Use Attach to Source when the source object is scaling or rotating,
and you want the destination object to “stick” to a particular spot on the source object.
Any animation that existed on the destination object prior to applying the track can
be preserved by using the Adjust parameters (Position, Scale, and Rotation), available
when Transformation is chosen from the Type pop-up menu.

Note: Although the destination object is attached to the movement of the source
object, the destination object can be offset from the source object.

• Mimic Source: This option allows the destination object to “mimic” the recorded track
or animation source. Any animation that existed on the foreground object prior to
applying the track can be added to the track by selecting Position, Rotation, or Scale
in the Adjust parameters.

Note: As with Attach to Source, the destination object can be offset from the source
object.
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Align Tangents: When this checkbox is deselected, tangents remain aligned at their
original angles. When the checkbox is selected, the tangents match the transformation
of the source animation, and the shape changes its form.

Movement: The Movement parameters contain the Analyze and Reverse parameters.
This parameter appears only when there is a tracking source (footage) in the source well.

• Analyze: Click the Analyze button to begin the motion tracking analysis. Once Analyze
is clicked, a status window appears that displays the tracking progress. To stop the
analysis, click the Stop button in the status window or press Esc.

The start of the track is based on the current playhead position, rather than the start
of the behavior in the Timeline.

• Reverse: When the Reverse checkbox is selected, the clip is analyzed from the current
playhead position to the first frame of the clip (or the first frame of the tracking
behavior).

Note: You must move the playhead to the frame where you want to begin the reverse
analysis.

Tracker Preview: This parameter appears only when there is a tracking source (footage)
in the source well. This preview area provides a magnified view of the tracking reference
area for the selected tracker. The preview updates as you adjust the position of the tracker
in the Canvas. You can also drag in the preview area to adjust the position of the tracker.
When dragging in the preview area, the image moves around the red crosshairs in the
preview and the tracker moves in the Canvas.

Offset Track: This parameter appears only when there is a tracking source (footage) in
the source well. If a tracker’s reference point becomes temporarily hidden or goes off the
screen, this parameter allows you to select a different reference point that continues the
same tracking path as the original reference point. For more information on offset tracking,
see Tracking Obscured or Off-Frame Points.

Auto-Zoom: This parameter appears only when there is a tracking source (footage) in
the source well. Choose an option from this pop-up menu to set the magnification level
when positioning the tracker in the Canvas. This allows you to zoom in on the Canvas
when searching for an ideal tracking reference pattern. There are four choices:

• None: When moving the tracker in the Canvas, there is no magnification (only the
tracker appears).

• 2x: When moving the tracker in the Canvas, the magnification around the tracker is
two times the normal zoom level.

• 4x: When moving the tracker in the Canvas, the magnification around the tracker is
four times the normal zoom level.

• 8x: When moving the tracker in the Canvas, the magnification around the tracker is
eight times the normal zoom level.
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Auto-Zoom Mode: This parameter appears only when there is a tracking source (footage)
in the source well. Choose an option from this pop-up menu to set the display of the
auto-zoomed tracker in the Canvas. There are three choices:

• Normal: Displays a normal pattern.

• Contrast: Displays the tracker pattern with contrast detection.

• Edge: Displays the tracker pattern with edge detection. The Auto-Zoom Mode applies
only to the trackers in the Canvas and does not appear in the Tracker Preview in the
Behaviors tab of the Inspector. When None is chosen from the Auto-Zoom pop-up
menu, the Auto-Zoom Mode setting has no effect.

Look Ahead Frames: This parameter appears only when there is a tracking source (footage)
in the source well. This slider and value slider allow you to specify the number of “future”
frames to be analyzed by the tracker. In other words, you can direct the tracker to look
in a specific location for its reference point. This is especially useful for footage that
contains fast-moving objects, as the reference point can quickly “get away” from the
tracker. For more information on using Look Ahead Frames, see Giving Motion a Hint.

Track list: Tracks appear only when there is a tracking source (footage) in the source well.
Displays the trackers in the behavior as “Track 1, Track 2,” and so on. The number of
trackers is determined by the number of control points on the shape with the applied
Track Points behavior. For example, when a Track Points behavior is added to a shape
with 12 control points, 12 trackers will appear in the track list.

When another track is referenced, the track list is replaced with Control Point pop-up
menus.

To disable a tracker, deselect its checkbox. To remove a tracker, click the Remove button.
A tracker that is turned off is not analyzed with the track.

Click the disclosure triangle next to the track name to reveal additional parameters:

• Position: Displays the X and Y positions of the tracker. The X position is the value slider
on the left; the Y position is the value slider on the right. Click the disclosure triangle
to display labeled position value sliders.

• Track Size: Use this slider to adjust (in pixels) the pattern search size for the tracker. As
you adjust the track size, the Tracker Preview is updated to show the new track size
(there is no visual change in the Canvas tracker).

To adjust the Track Size without exposing its parameters, Option–drag left in the Tracker
Preview area to reduce the track size; Option–drag right to increase the track size.

• Search Size: Use this slider or value slider to increase or reduce the tracker’s search area
size. In Motion, you do not specify the size of a search area when setting up your trackers
in the Canvas. To change the default search size, use the slider or value slider. If Search
Size is set to 200 percent, the tracker’s search area is twice the default search area size.
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• Fail Tolerance: This parameter defines the amount of tolerance for error, orconfidence
value, of the track. In other words, it defines at what “score” the tracker determines it
is able to match a reference feature. When above the score, the tracker accepts the
match. When below the score, the tracker rejects the match. Once the match is rejected,
the Fail Behavior kicks in.

• Fail Behavior: This pop-up menu specifies what happens if the track confidence value
falls below the Fail Tolerance amount. The following options are available:

• Smart Retry: The tracker attempts to find the reference pattern in a larger search area.
If the pattern cannot be found, the tracker switches to the Predict option. Smart Retry
is the default fail behavior.

• Stop: Stops the analysis when the tracker loses the reference pattern. You can also
click the Stop button in the tracking progress dialog or press Esc to stop an analysis.

• Predict: The tracker predicts a new search area without creating keyframes until it
finds a match for the reference pattern. This is excellent for tracked objects that pass
behind foreground objects.

• Predict and Key: If a failure is detected, the tracker predicts the location of the keyframe
based on a vector of the last two keyframes, and continues tracking in the new area.

• Don’t Predict: The tracker remains in its position and searches for subsequent matches
as the clip’s frames progress. While searching for a match, the tracker does not create
keyframes.

• Use Existing Keyframes: Use this option if you have manually created track position
keyframes to guide the tracker. After manually adding keyframes, return to the start
frame and start the tracking analysis. If the tracker has difficulty locating the track
pattern, the manually created tracking keyframes are referenced to guide the tracker.

• Color: Click or Control-click the color well to set a new color for the onscreen tracker.
You can also click the eyedropper and select a color in the Canvas. The default tracker
color is red. When a tracker is selected, its center point is yellow and the border of its
magnified inset is the color set in the color well. To adjust the individual color channels,
including the tracker’s opacity, click the disclosure triangle.

Control Points: When the Track Points behavior references another behavior, such as
Analyze Motion, the Track list parameters are replaced with the Control Point pop-up
menus. There is a pop-up menu for each control point on the shape. From the pop-up
menus, choose the track you want to assign to that control point.

Note: If you add or delete control points to a shape after you have applied the reference
track, select the Track Points behavior in Inspector or Layers tab to refresh the Control
Point pop-up menu list.

Tip: To check the number of any control point on a shape, you can select the shape in
the Layers tab, choose the Adjust Control Points tool from the Toolbar, and click on a
control point in the Canvas.
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HUD Controls
The Track Points HUD contains controls to load an animated object or tracking behavior
into the behavior (via the Source well or the tracking behaviors pop-up menu), to specify
how the destination object moves, to start the motion analysis (the Analyze button), to
reverse the direction of the track (the Reverse checkbox), and to offset the track (the
Offset Track checkbox).

Track Parameter Behavior Controls
The Track Parameter behavior allows you to track the position parameter of an object
(such as a filter, shape, or particle emitter) to a reference feature of a clip, or to apply
existing tracking data to the position parameter of an object.

The Track Parameter behavior can be found in the Behaviors’ Parameter subcategory in
the Library, or by choosing Parameter > Track from the Add Behavior pop-up menu in
the Toolbar.

For a description of the Tracker Preview, Offset Track, Auto-Zoom, Auto-Zoom Mode,
Look Ahead Frames, and track list parameters, as well as the tracker subparameters, see
Analyze Motion Controls.

For information on using the Track Parameter behavior, see Track Parameter Workflow.

Parameters in the Inspector
Source: Drag the source object for the track to this well. The source object can be another
tracking behavior or a footage object. Drag a behavior to the Source well to load that
track into the Track Parameter behavior. To clear a Source well, drag the item away from
the well and release the mouse button.

Note: An animated object cannot be used as a source for the Track Parameter behavior.

• Tracking behaviors pop-up menu: Choose from a list of tracking data (from other tracking
behaviors) within the project.

Tracking behaviors 
pop-up menu

Transform: This pop-up menu allows you to choose how the selected position parameter
moves. There are two options:

• Attach to Source: This option anchors the position of the object to the recorded track
or animation source. Use Attach to Source when the source object is scaling or rotating,
and you want the filter’s center to “stick” to a particular spot on the source object. Any
animation that existed on the filter’s center prior to applying the track can be preserved
by using the Adjust parameters (Position, Scale, and Rotation), available when
Transformation is chosen from the Type pop-up menu.
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Note: Although the object’s position is attached to the movement of the source object,
its position can be offset from the source object.

• Mimic Source: This option allows the object to “mimic” the recorded track or animation
source. Any animation that existed on the foreground object prior to applying the track
can be added to the track by selecting Position, Rotation, or Scale in the Adjust
parameters.

Note: As with Attach to Source, the object’s position can be offset from the source
object.

Movement: Click the Analyze button to begin the motion tracking analysis. Once Analyze
is clicked, a status window appears that displays the tracking progress. To stop the analysis,
click the Stop button in the status window or press Esc.

The start of the track is based on the current playhead position, rather than the start of
the behavior in the Timeline.

Reverse: When the Reverse checkbox is selected, the clip is analyzed from the current
playhead position to the first frame of the clip (or the first frame of the tracking behavior).

Note: You must move the playhead to the frame from which you want to begin the
reverse analysis.

Tracker Preview: This preview area provides a magnified view of the tracking reference
area for the selected tracker. The preview updates as you adjust the position of the tracker
in the Canvas. You can also drag in the preview area to adjust the position of the tracker.
When dragging in the preview area, the image moves around the red crosshairs in the
preview and the tracker moves in the Canvas.

Offset Track: If a tracker’s reference point becomes temporarily hidden or goes off the
screen, this parameter allows you to select a different reference point that continues the
same tracking path as the original reference point. For more information on offset tracking,
see Tracking Obscured or Off-Frame Points.

Auto-Zoom: Choose an option from this pop-up menu to set the magnification level
when positioning the tracker in the Canvas. This allows you to zoom in on the Canvas
when searching for an ideal tracking reference pattern. There are four choices:

• None: When moving the tracker in the Canvas, there is no magnification (only the
tracker appears).

• 2x: When moving the tracker in the Canvas, the magnification around the tracker is
two times the normal zoom level.

• 4x: When moving the tracker in the Canvas, the magnification around the tracker is
four times the normal zoom level.

• 8x: When moving the tracker in the Canvas, the magnification around the tracker is
eight times the normal zoom level.
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Auto-Zoom Mode: Choose an option from this pop-up menu to set the display of the
auto-zoomed tracker in the Canvas. There are three choices:

• Normal: Displays a normal pattern.

• Contrast: Displays the tracker pattern with contrast detection.

• Edge: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies only to the trackers in the Canvas and does not appear
in the Tracker Preview in the Behaviors tab of the Inspector.

Note: When None is chosen from the Auto-Zoom pop-up menu, the Auto-Zoom Mode
setting has no effect.

Look Ahead Frames: This slider and value slider allow you to specify the number of
“future” frames to be analyzed by the tracker. In other words, you can direct the tracker
to look in a specific location for its reference point. This is especially useful for footage
that contains fast-moving objects, as the reference point can quickly “get away” from the
tracker. For more information on using Look Ahead Frames, see Giving Motion a Hint.

Track list: Displays the trackers in the behavior.

To disable a tracker, deselect its checkbox. A tracker that is turned off is not analyzed with
the track.

When another track is referenced, the track list is replaced with a Tracker pop-up menu.

Click the disclosure triangle next to the track name to reveal additional parameters:

Position: Displays the X and Y positions of the tracker. The X position is the value slider
on the left; the Y position is the value slider on the right. Click the disclosure triangle to
display labeled position value sliders.

Track Size: Use this slider to adjust (in pixels) the pattern search size for the tracker. As
you adjust the track size, the Tracker Preview is updated to show the new track size (there
is no visual change in the Canvas tracker).

To adjust the Track Size without exposing its parameters, Option–drag left in the Tracker
Preview area to reduce the track size; Option–drag right to increase the track size.

Search Size: Use this slider or value slider to increase or reduce the tracker’s search area
size. In Motion, you do not specify the size of a search area when setting up your trackers
in the Canvas. To change the default search size, use the slider or value slider. If Search
Size is set to 200 percent, the tracker’s search area is twice the default search area size.

Fail Tolerance: This parameter defines the amount of tolerance for error, orconfidence
value, of the track. In other words, it defines at what “score” the tracker determines it is
able to match a reference feature. When above the score, the tracker accepts the match.
When below the score, the tracker rejects the match. Once the match is rejected, the Fail
Behavior kicks in.
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Fail Behavior: This pop-up menu specifies what happens if the track confidence value
falls below the Fail Tolerance amount. The following options are available:

• Smart Retry: The tracker attempts to find the reference pattern in a larger search area.
If the pattern cannot be found, the tracker switches to the Predict option. Smart Retry
is the default fail behavior.

• Stop: Stops the analysis when the tracker loses the reference pattern. You can also click
the Stop button in the tracking progress dialog or press Esc to stop an analysis.

• Predict: The tracker predicts a new search area without creating keyframes until it finds
a match for the reference pattern. This is excellent for tracked objects that pass behind
foreground objects.

• Predict and Key: If a failure is detected, the tracker predicts the location of the keyframe
based on a vector of the last two keyframes, and continues tracking in the new area.

• Don’t Predict: The tracker remains in its position and searches for subsequent matches
as the clip’s frames progress. While searching for a match, the tracker does not create
keyframes.

• Use Existing Keyframes: Use this option if you have manually created track position
keyframes to guide the tracker. After manually adding keyframes, return to the start
frame and start the tracking analysis. If the tracker has difficulty locating the track
pattern, the manually created tracking keyframes are referenced to guide the tracker.

Color: Click or Control-click the color well to set a new color for the onscreen tracker.
You can also click the eyedropper and select a color in the Canvas. The default tracker
color is red. When a tracker is selected, its center point is yellow and the border of its
magnified inset is the color set in the color well. To adjust the individual color channels,
including the tracker’s opacity, click the disclosure triangle.

Tracker pop-up menu: When the Track Parameter behavior references another behavior,
such as Analyze Motion, the Track list parameters are replaced with the Tracker pop-up
menu. Select the tracker you want to apply from the referenced tracking behavior to the
position parameter of the affected object from this menu.

Apply To: Click the Go pop-up menu to select a different parameter to apply the track.
For example, if the Track parameter is applied to the X Position parameter of the tracked
object and you want to apply the data to the X and Y Position parameters, click Go and
choose > Properties > Transform > Position > X and Y.

HUD Controls
The Track parameter HUD contains controls to load a tracking behavior into the behavior
(via the Source Behavior well or the tracking behaviors pop-up menu), to specify how
the position parameter moves, to start the motion analysis (the Analyze button), to reverse
the direction of the track (the Reverse checkbox), and to offset the track (the Offset Track
checkbox).
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Sound is an integral part of many motion graphics projects. Use audio in your project for
background music, dialogue, or scratch tracks.

This chapter covers the following:

• About Audio in Motion (p. 1327)

• Audio Files in Motion Projects (p. 1328)

• Working with Audio Tracks (p. 1337)

• Keyframing Level and Pan Changes (p. 1345)

• Crossfading Audio Tracks (p. 1347)

• Syncing Audio and Video Tracks (p. 1347)

• Retiming Audio (p. 1347)

• Using Markers with Audio (p. 1350)

• Audio Behaviors (p. 1350)

• Audio Parameter Behavior (p. 1353)

• Using Soundtrack Pro with Motion (p. 1357)

• Exporting Audio (p. 1358)

About Audio in Motion
You can add audio files to your project and use markers and keyframes to sync the audio
with other events in your project. You can import several different types of audio files,
including the audio tracks from QuickTime movie clips. For each mono audio file you add
to a project, Motion creates a single audio track. For each multichannel audio file you
add to a project, Motion creates a single audio track for each channel.
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You can turn audio tracks on and off, select and play individual tracks, mute and solo
tracks, and control volume and pan settings for each track in the Audio tab of the Project
pane.

The Audio tab lets you 
edit the settings for each 
audio track, as well as the 
Master audio track.

You can add keyframes for volume and pan to an audio track and trim an audio track in
the Audio Editor or in the Keyframe Editor. You can also trim an audio track in the Timeline.

Audio Editor

You can export audio with video, or export audio alone, in a variety of formats. See
Exporting Audio for a list of the audio export formats Motion supports.

If you have Soundtrack Pro installed, an audio file that exists in a Motion project can be
opened and modified in Soundtrack Pro. The modified file is automatically updated in
Motion. For more information, see Using Soundtrack Pro with Motion.

Audio Files in Motion Projects
You can add different kinds of audio files to a Motion project. In addition, Motion lets
you preview files before adding them to your project and lets you view the audio files in
a project in several ways.
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Import File Formats
Motion supports audio in a variety of common file formats, sample rates, and bit depths.
Supported import file formats include:

• AIFF

• WAV

• MP3

• AAC (except rights-protected AAC files)

• QuickTime Audio (.mov)

Note: Multitrack QuickTime movie files and multichannel audio files are also supported.

You can import audio files with sample rates up to 192 kHz and with bit depths up to
32 bits. Mono and stereo files are supported.

Note: Because MP3 and AAC are compressed file formats, playback quality may not be
as high as with uncompressed formats such as AIFF.

When you add an audio file to your project, Motion converts it to its own internal format.
This allows you to use audio files with different formats, sample rates, and bit depths in
the same project. When you export your project, the audio is exported according to the
current audio settings in the Export dialog.

Previewing an Audio File
You can listen to, or preview, an audio file in the File Browser before adding it to a project.

To preview an audio file
µ In the File Browser, select the audio file.

If “Play items automatically on a single click” in the General pane of Motion Preferences
is selected, the file begins to play.

If the file does not play automatically, click the Play button in the Preview area. You can
select “Play items automatically on a single click” in the General pane of Motion
Preferences.

While the file is playing, you can click the Play button again to pause playback or click
the Mute button to mute/unmute the sound.
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Adding an Audio File
To work with audio in your project, you start by adding an audio file to the project.

Note: Although you can see a connected iPod in the File Browser as a hard disk, you can
only browse for and import files stored in the hard disk storage area of the iPod into
Motion.

To add an audio file from the File Browser
Do one of the following:

µ Drag the file from the File Browser or the Finder into the Canvas.

µ Drag the file from the File Browser or the Finder into the Project pane or Timeline layers
list.

• Dragging the file to the Layers tab adds the audio file to the Media tab and the Audio
tab.

• Dragging the file to the Media tab adds the audio file to the Media tab but does not
add it to the project. To add the file to the project, drag the file from the Media tab to
the Canvas.

• Dragging the file to the Audio tab adds the audio file to the Media tab and the Audio
tab.

µ Drag the file from the File Browser or the Finder into the audio area of the Timeline (not
the Audio Editor).

Note: To display audio in the Timeline, click the Show Audio button in the bottom of the
Timeline layers list.

Click to display audio 
tracks in the Timeline.

When a black border appears around the audio section of the Timeline, release the mouse
button.

µ In the Audio tab, click the Add button (+), locate the file you want to add, then click
Import.

Note: If you use the Add button (+) in the Media tab, the audio file is only added to that
tab. To use the file in the project, drag the file from the Media tab to the Canvas.
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To add an audio file from iTunes
1 In the Library, select the Music category.

2 Select a playlist, then select a song in the file stack.

3 Do one of the following:

• In the Preview area, click Apply.

• Drag the file to the Canvas, Project pane, or Timeline layers list.

Note: Rights-protected AAC files cannot be imported into Motion and do not appear in
the file stack. This includes non-iTunes Plus music purchased from the iTunes Store.

The audio file is added to the project and appears in the Audio tab of the Project pane,
the Audio Editor, and the Timeline (if the Show Audio button is turned on). The start point
of the audio file is determined by the Create Layers At preference in the Project pane of
Motion Preferences. If set to “Start of project,” the file starts at the beginning of the project.
If set to “Current frame,” it starts at the current location of the Timeline playhead. A HUD
for the audio appears in the Canvas.

Note: If the HUD does not appear, press D or F7.

When you drag a QuickTime movie into the Canvas or the Layers tab of the Project pane,
the movie’s video and audio tracks are imported into your project. You can choose to
add only the audio track of a QuickTime movie.

You can also drag the file directly to the Media tab. As with image files, this stores the
file in the project but does not “use” the file until you actively add the file to the Timeline
layers list or Canvas. To use the file, drag the media file from the Media tab to the Canvas
or Timeline layers list.

To add only the audio track from a QuickTime movie
µ In the File Browser or in the Finder, locate the QuickTime movie file, then drag it into the

Audio tab of the Project pane.

The audio track from the movie is added to your project, without the video footage. The
video footage is added to the Media tab.

If the QuickTime movie contains multiple audio tracks, drag the file over the Audio tab,
the Canvas, or the Timeline layers list, holding down the mouse button until the drop
menu appears. To import the file with a single audio track, choose Mix To Stereo. To
import the file with individual tracks, choose Import All Tracks. For more information, see
Importing Multichannel Audio to Motion below.
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Importing Multichannel Audio to Motion
Multichannel audio files can be imported as a single track or as individual tracks. The
same applies to QuickTime movie files that contain multiple audio tracks, including files
with stereo audio tracks. For the purposes of this document, multichannel audio files and
multitrack QuickTime files can be manipulated in the same way, and should be considered
interchangeable. When this document refers to multitrack QuickTime files, multichannel
audio files are treated in the same way.

When importing a multitrack QuickTime movie file, you can import the audio portion of
the file as a single audio track or as individual tracks.

When you add any media file to Motion, an audio track appears that can be used
independently of the video file. When the file is unlinked from its source, a track can be
individually enabled, disabled, or deleted. Deleting a source QuickTime movie file from
the Media tab, however, deletes all audio and video that originated from that file.

Important: Because Soundtrack Pro also supports multichannel and multitrack audio files,
you can open a multichannel file in Soundtrack Pro from Motion. For more information
on modifying audio tracks in Soundtrack Pro, see Using Soundtrack Pro with Motion.

Note: When you export a multichannel audio file from Motion, you may choose whether
to export all channels or mix them down into a single track.

To import a multitrack QuickTime movie file using the drop menu
1 Drag the file from the File Browser or the Finder to the Canvas, holding down the mouse

button until a drop menu appears.

2 Do one of the following:

• To import the movie with a single audio track, choose Mix To Stereo, then release the
mouse button.

• To import the movie file with a single audio track for each track, choose Import All
Tracks, then release the mouse button.
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When you choose Mix To Stereo, the file appears in the Audio tab as a single audio
track and the video appears in the Canvas (and Layers tab). The link icon in the Lock
column of the Audio tab indicates that the audio object has a corresponding video
element.

Note: When a multitrack QuickTime file is imported without using the drop menu, Mix
To Stereo is the default import method.

Name field

Output Channel 
pop-up menu

Link icon

Mute button

Solo button

Level slider

Lock icon

Pan slider

Activation checkbox

In the Layers tab, the link icon also appears in the Lock column for the object, indicating
the object has a corresponding audio element.

When you choose Import All Tracks from the drop menu, the file appears in the Audio
tab with an individual audio track for each track in the file. The following image shows
the Audio tab after importing a multitrack QuickTime movie file that contains six channels
with a single channel in each track.
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To import a multitrack QuickTime movie file using the Import command
1 Choose File > Import (or press Command-I).

2 In the Import File dialog, select the QuickTime file.

3 Choose an import option from the Audio pop-up menu (located at the bottom of the
Import Files dialog), then click Import.

The file is imported with your chosen option.

Viewing Audio Files
You can view a listing of all the audio tracks in your project and view the audio waveform
for an individual track. You can also view information about each track, including its
duration, sample rate, and file size. In the Audio tab, each channel in a multichannel audio
file—or each track in a multitrack file—can be selected separately.

To view a listing of your project’s audio tracks
µ In the Project pane, click the Audio tab to see the audio files in your project.

To view the waveform of an audio track
µ Select an audio file or channel of a multichannel file in the Audio tab, then do one of the

following:

• Click the Timeline tab in the Timing pane, then click the Show/Hide Audio button at
the lower left of the pane.

A bar appears, containing the waveform of the file, if the Timeline row size is tall enough.
If the bar does not contain a waveform, adjust the height of the bars in the Timeline.
For more information about how to adjust Timeline tracks, see Timeline Tab Display
Options.

Important: In a multichannel audio file, all of the audio channels in the file appear in
the Timeline.

• Click the Keyframe Editor tab in the Timing pane, then click the Show Audio Waveform
button at the lower-left corner of the pane.

The waveform of the track appears in the Keyframe Editor, along with any keyframes,
if the Timeline row size is tall enough.
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Note: If there are multiple audio tracks in the project, the waveform of the master track
appears in the Keyframe Editor, and a pop-up menu at the bottom of the Keyframe
Editor allows you to view the waveform of any individual audio track in the project or
the master track.

Audio track selection 
pop-up menu

• Click the Audio Editor tab in the Timing pane.

The waveform of the selected track appears in the Audio Editor.

Viewing the audio waveform can be useful in the Keyframe Editor to synchronize motion
and other parameter changes with audio events such as peaks or points of silence, and
in the Audio Editor to synchronize level and pan changes with audio events.

To view information about your project’s audio files
Do one of the following:

µ In the Project pane, click the Media tab.

µ In the Media tab of the Project pane, select the audio file.

The Media tab in the Project pane and the Media tab in the Inspector both display
information about each audio file, including kind, duration, sample rate, format, file size,
and other details.

Cutting, Copying, and Pasting Audio Tracks
You can cut, copy, and paste audio tracks in the Audio tab. You can also duplicate tracks.

To cut an audio track
µ In the Audio tab, select the audio track, then do one of the following:

• Choose Edit > Cut (or press Command-X).

• Control-click the track, then choose Cut from the shortcut menu.
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To copy an audio track
µ In the Audio tab, select the audio track, then do one of the following:

• Choose Edit > Copy (or press Command-C).

• Control-click the track, then choose Copy from the shortcut menu.

To paste an audio track
µ In the Audio tab, do one of the following:

• Choose Edit > Paste (or press Command-V).

• Control-click an empty area, then choose Paste from the shortcut menu.

To duplicate an audio track
µ In the Audio tab, select the audio track, then do one of the following:

• Choose Edit > Duplicate (or press Command-D).

• Control-click the track, then choose Duplicate from the shortcut menu.

The duplicate appears below the original file in the Audio tab.

Deleting an Audio Track
There are two ways to remove an audio track from your project.

To delete an audio track
µ In the Audio tab, select the audio track, then do one of the following:

• Press the Delete key.

• Click the Delete button (–) at the top of the Audio tab.

• Control-click the file you want to remove, then choose Delete from the shortcut menu.

If you try to delete an audio file with linked video, the following alert dialog appears:

Note: Deleting tracks from the Audio tab removes the associated file from the Media tab
if “Automatically removed unused media” is selected in the General pane of Motion
Preferences.
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Working with Audio Tracks
When you add an audio file to your project, Motion creates one or more audio tracks for
the file. In the Audio tab of the Project pane, you can turn audio tracks on and off, select
tracks, mute and solo tracks, and control their volume and pan settings.

Audio tracks

Any changes you make to an audio track, such as renaming or trimming it, do not affect
the source audio file.

Turning Audio Tracks On or Off
When you add an audio file to your project, it becomes a track in the Audio tab and is
turned on by default. You can turn individual audio tracks on or off in the Audio tab.
Turning off an audio track silences it during playback and means the track is not part of
your final mix when you export the project.

To turn an audio track on or off
Do one of the following:

µ In the Audio tab of the Project pane, click the activation checkbox on the left side of the
track. Click the checkbox again to return the track to its previous state (on or off ).

µ In the Timeline, with the Show/Hide Audio button turned on, click the activation checkbox
(in the left column). Click the checkbox again to return the track to its previous state.

Turning an audio track off removes it from the overall audio mix.

Selecting Audio Tracks
To display an audio track in the mini-Timeline and in the Audio Editor, you first select it.

To select an audio track
µ Click anywhere in the row containing the track’s name and controls in the Audio tab.

Selected tracks are highlighted.

You can select multiple tracks by Shift-clicking. However, the Audio Editor can display
only one track at a time. When multiple tracks are selected, the Audio Editor appears
empty.
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Playing Audio Tracks
When you click the Play button in the transport controls, you hear the audio tracks in
your project play in time with your visuals. You can also play an individual audio track
separately from the project Timeline.

To play audio with your project
µ Click the Play button in the transport controls.

When you click the Play button, you hear all audio tracks in the project that are turned
on and are not muted.

To play an individual audio track
1 In the Audio tab, select the audio track.

2 In the Audio Editor, click the Play button.

The audio track plays, and the playhead in the Audio Editor shows the region of the track
currently playing. Playback in the Audio Editor is independent of the project.

By default, when you play audio tracks, the playback sample rate and bit depth are
determined by the playback device. If you are playing audio using an external device,
Motion plays the audio using the sample rate of the device.

Muting and Soloing Tracks
When you mute an audio track, it is silent during playback, but is still part of the mix when
you export your project. When you solo an audio track, all other audio tracks are muted,
which lets you hear the soloed track more clearly.

Mute button

Solo button

You can mute, unmute, solo, or unsolo an audio track at any time, even during playback.
When you export your project, all tracks that are turned on are included in the final mix,
regardless of whether they are muted or soloed.

To mute an audio track
Do one of the following:

µ Click the Mute button.

Click the Mute button again to unmute the track.

µ Control-click the track, then choose Mute from the shortcut menu.
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To solo an audio track
Do one of the following:

µ Click the Solo button.

Click the Solo button again to unsolo the track.

µ Control-click the track, then choose Solo from the shortcut menu.

You can also solo multiple audio tracks. When you solo more than one track, all tracks
not soloed are muted (silent) during playback.

Setting Levels
Level refers to the loudness or volume of an audio track (sometimes referred to as gain).
You can adjust an audio track’s level using the Level slider. The available range is from
–96 (minimum level) to 6 (maximum level). The default is 0 (sometimes called unity gain).
The values correspond to the decibel scale (dB).

Level value field

Level slider in Audio tab 
of the Project pane

To set an audio track’s level
µ In the Audio tab, the track’s HUD, or the Audio Track tab of the Inspector, drag the Level

slider to set the level you want. In the Audio tab, the Level slider is located in the Name
column under the track’s name.

In the Audio tab and Audio Editor, you can also type a number in the value field. You can
set the level in integer increments (–1, 0, 1, and so on).

Selecting Output Channels
If you’re working with multichannel audio, you can adjust which tracks are assigned to
which output channels, or you can create your own multichannel file from mono tracks.
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To set or change output channels for an audio track
1 Choose 5.1 Surround from the Master Output Channel pop-up menu at the bottom of

the Audio tab.

Master Output Channel 
pop-up menu

2 Choose an output channel for the specific audio track from the Output Channel pop-up
menu (in the track list of the Audio tab).

Output Channel pop-up 
menu

Note: If you do not have surround-sound hardware, the Center, LFE, Left Surround, and
Right Surround output channels will be italicized. You can still select those channels and
your choices will be reflected in an exported project or playback on a system that does
have the right hardware.

Setting Track Panning
Pan refers to the left-right balance of a track in the stereo field. You can adjust a track’s
pan position using the Pan slider. The available range is from –100 (hard left) to 100 (hard
right). The default is 0 (center).

Pan slider in Audio tab of 
the Project pane

To set a track’s pan position
µ In the Audio tab, the track’s HUD, or the Audio Track tab of the Inspector, drag the Pan

slider to the left or right to set the pan position for the track.
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In the Audio tab and Audio Editor, you can also type a value in the value field. You can
set the pan position in integer increments (–1, 0, 1, and so on). The pan field shows
numbers in a three-digit format (000, for example).

Locking Tracks
Locking a track prevents it from being edited. When a track is locked, you cannot mute
or solo the track, change its level or pan, move or trim it, or add keyframes. You can still
play the track, and turn it on or off.

To lock a track
µ In the Audio tab, click the lock icon on the right side of the track. Click the lock icon again

to unlock the track.

Renaming Tracks
You can also rename a track, to give it a more useful name in the project.

To rename a track
µ In the Audio tab, double-click the track’s name in the Name column, then type a new

name.

Working with the Master Track
Each project has a Master audio track. The controls for the Master track are located at the
bottom of the Audio tab, below the individual audio tracks. Using the Master track’s
controls, you can make changes that affect the final mixed output of all audio tracks. For
example, you can lower the volume of all tracks at once, or pan all tracks to the left or
right. In addition, you can turn the Master track on or off, or mute it.

Mute button

Level meters

Level slider

Pan slider

Clipping indicators

Lock icon

Output Channel
pop-up menu

Activation checkbox

You select the Master track by clicking its area at the bottom of the Audio tab. When
selected, the Master track area appears highlighted.

Turning the Master Track On or Off
The Master track is turned on by default. When it is deselected, no sound is audible when
you play the project, and no audio is included when you export your project. When it is
turned on, all audio tracks that are turned on are included in your export.
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To turn the Master track on or off
µ Click the checkbox at the left side of the Master track. Click the checkbox again to return

the Master track to its previous state.

When the master track is selected, a master waveform appears in the Audio Editor.

Setting Master Level
You can use the Master Level slider to set the overall volume level for the audio in your
project.

To set the master level
µ Drag the Master Level slider to set the level you want.

The Master level works in conjunction with the level setting for each individual track. For
example, if you set a track’s level to 0.5 and you set the master level to 0.5, the combined
level is 0.25 (one-fourth) of the original.

Note: If you raise both an individual track’s level and the Master level so that the combined
increase is greater than 2, you may cause audio distortion or “clipping.”

Viewing the Master Level
To the right of the Master track controls is a pair of stereo level meters that display the
combined level of all the audible tracks.

If either of the two red dots above the level meters (called clipping indicators) light up
during playback, this indicates that your master levels are too high, causing audio distortion
or clipping.

Preventing Clipping
Typically, when working with digital audio, audio engineers set the overall volume level
as high as possible without causing clipping. If the clipping indicators light up above the
master level meters, you need to find where clipping is occurring and lower the level to
eliminate the cause of the clipping.

If clipping occurs, play the project and observe where the clipping indicators light up.
You may want to solo each audio track to determine if a particular track is causing the
clipping. You can also play a track in the Audio Editor and watch the Audio Editor’s level
meters, which show only the levels of the track playing.
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Once you determine which track is causing the clipping, you can lower the track’s overall
level, or use keyframes to lower the track’s level at the specific point in time where clipping
occurs.

Clipping indicators

The clipping indicators are “sticky,” meaning that once they light up, they stay lit until
you reset them or close the project. This is intended to help remind you to find and
eliminate the cause of the clipping before you export your project. As you work to
eliminate clipping, reset the clipping indicators and play the project again to make sure
clipping no longer occurs.

To reset the clipping indicators
µ Click the clipping indicator that is lit.

Setting Master Pan
You can use the Pan slider in the Master track to set the left-right pan position for the
audio.

To set the Master pan position
µ Drag the Pan slider to place the sound where you want it in the stereo field.

The Master pan slider works in conjunction with the pan setting for each individual track.
For example, if you pan a track to –100 (hard left) and you pan the master to 100 (hard
right), the track is inaudible.

Slipping Audio Tracks
When you import an audio file, its start point is set to the location based on the setting
of the Create Layers At parameter in Motion preferences. You can slip an audio track so
it starts playing at a different point in time.

To slip an audio track
1 In the Audio tab, select the track.

The bar for the audio file appears in the mini-Timeline.

2 In the mini-Timeline, drag the track’s bar left or right.

As you drag the bar, a help tag appears, showing the In and Out points for the track.
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Note: You can also show and slip the timebar for an audio track in the Timeline. To display
audio in the Timeline, click the Show/Hide Audio button in the display options (located
in the lower section of the Timeline layers list).

Trimming Audio Tracks
You can edit the start and end points of an audio track to cut down the length of the
audio in the track, or to have it start or end at a specific point in time. This is called
“trimming” the track. Motion lets you trim audio tracks, either visually or by entering
numeric values for the In and Out points.

When you trim an audio track, the audible part of the track is highlighted in green in the
Audio Editor. Trimming an audio track is nondestructive and does not affect the original
audio file.

To trim an audio track visually
1 In the Audio tab, select the audio file you want to trim.

The track’s timebar appears in the Audio Editor and in the mini-Timeline.

2 In the Audio Editor or the mini-Timeline, position the pointer over the beginning or end
of the timebar, and the trim pointer appears.

Trim pointer

3 Drag the beginning or end of the timebar to the point where you want to set the In or
Out point for the file.

The progress of your trim is displayed in the Audio Editor and lets you see the time
markers, so you can trim more precisely.

To trim an audio track numerically
Do one of the following:

µ In the Audio Editor, type a value in the In field where you want the track to begin, or type
a value in the Out field where you want the track to end.

µ Click the arrow at the left edge of the field to decrease the value, or click the arrow at the
right edge of the field to increase the value. Shift-click to move in increments of 10.
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µ Position the pointer over the number in either the In or Out field, and the drag pointer
appears. Drag left to increase the value, or drag right to decrease the value.

The trimmed area 
appears highlighted in 
green.

Scrubbing an Audio Track
You can scrub an audio track in the Audio Editor to hear a portion of the track. Use the
Audio Scrubbing button to turn scrubbing on or off. Scrubbing is turned on by default
in the Audio Editor (it is off by default in the Timeline).

To scrub an audio track
1 In the Audio tab, select the track.

2 If scrubbing is turned off, click the Audio Scrubbing button, located at the lower-left
corner of the Audio Editor, to turn on scrubbing.

3 Drag the playhead in the Audio Editor left or right. Keep the pointer still to loop
continuously on the frames adjacent to the current frame.

Note: By default, audio scrubbing loops continuously on the five frames adjacent to the
current frame when you keep the pointer still. You can turn off looping by choosing
Motion > Preferences, clicking the Project icon, then deselecting the “Loop audio while
scrubbing” checkbox under Playback Control.

You can also scrub audio in the Timeline or Keyframe by Option-dragging in the ruler at
the top of the Timeline. You can scrub audio in the mini-Timeline by Option-dragging
the playhead in the mini-Timeline.

Keyframing Level and Pan Changes
Each audio track has curves for both level and pan, and you can add and edit keyframes
to automate level and pan changes over time. This lets you create fade-ins and fade-outs,
drop audio levels for voiceovers and other sound effects, and eliminate clipping. You edit
the curves directly on the audio waveform in the Audio Editor, allowing you to make
accurate edits.
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For more information about using keyframes and editing curves, see Keyframes and
Curves

Recording Keyframes
You can record keyframes for audio level and pan by clicking the Record button, then
moving the sliders in the Audio tab, the HUD, or the Inspector. Recording keyframes for
audio level and pan can be useful for trying out changes, and when you want to hear the
results in real time.

Adding and Editing Keyframes
In the Audio Editor, level curves are displayed as a purple dashed line, and pan curves
are displayed as a blue dashed line. Both curves appear overlaid on top of the audio
waveform.

• Level curves range from –96 to 6 with 0 equivalent to 0 dB (unity gain).

• Pan curves range from –100 to 100.

The range of values is displayed along the left side of the Audio Editor. Because level and
pan curves each use a different scale, you can only see numerical values for a curve if the
checkbox for that curve is selected, and the checkbox for the other curve is deselected.

To add keyframes to a level curve
1 Select the Level checkbox.

You may want to deselect the Pan checkbox, so that you can see the level curve more
clearly, and see its numeric values on the left.

2 Option-click the purple level curve to add a keyframe.

3 Drag the keyframe up or down to set the level you want at a specific time.

Drag down to lower the level, or drag up to raise the level.

4 Add any other keyframes you need, and drag each one to set its value.

Note: You can also perform these operations in the Keyframe Editor.

To add keyframes to a pan curve
1 Select the Pan checkbox.

You may want to deselect the Level checkbox, so that you can see the pan curve more
clearly, and see its numeric values on the left.
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2 Option-click the blue pan curve to add a keyframe.

3 Drag the keyframe up or down to set the pan position you want at a specific time.

Drag down to pan to the left, or drag up to pan to the right.

4 Add any other keyframe you need, and drag each one to set its value.

Note: When modifying Pan values, you can Control-click a keyframe to display a shortcut
menu that lets you set different interpolation methods between points on your curve.
See Modifying Curves for more information. Only the Linear interpolation method is
available for Level.

Crossfading Audio Tracks
In the Keyframe Editor, you can view the audio tracks in your project, along with the level,
pan, and speed curves for each track.

To create a crossfade, add keyframes to the level curve of each track at the same (or nearly
the same) points in time, where you want the crossfade to start and end. You can use
the frame numbers in the ruler of the Audio Editor for reference.

Be sure to listen to the crossfade as you work. You may find that the best-sounding results
are achieved by having the level curves for the two tracks be slightly asymmetrical. This
is because the perceived loudness of different sounds with the same numerical value in
the Audio Editor can be different.

Syncing Audio and Video Tracks
Motion lets you determine how to handle the playback of audio if the audio tracks are
not in sync with the video. You can choose to skip video frames in order to re-sync with
the audio, or to pause audio playback to avoid skipping frames if the video is out of sync.

To set audio sync preferences
1 Choose Motion > Preferences, then click the button for the Project pane.

2 In the Playback Control section of the Project pane, click the “Skip video frames” button
to skip frames, or click the “Pause audio playback” button to pause audio playback.

When you select “Pause audio playback,” audio playback pauses when video and audio
are out of sync, then begins playing when it catches up on the next loop.

Retiming Audio
Motion allows you to retime audio clips or individual channels to speed them up, slow
them down, or play them back at a different speed. All of the controls below can apply
either to a stereo audio clip, or individual channels.
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Note: When retiming video, audio attached to the footage is automatically retimed along
with it. You can unlink video and audio to retime them separately. For more information
on retiming footage, see Retiming.

Timing Controls in the Inspector
Each audio object has individual timing parameters in the Properties tab.

Speed: Sets the speed of the audio clip as a percentage. The default is 100%. Values
lower than 100 play back the audio clip more slowly than its original speed, and also
extend the Duration of the audio clip. Values higher than 100 play back the audio clip
faster than its original speed, and shorten the Duration of the audio clip.

In: Sets the In point of the audio clip. Adjusting this parameter always moves the audio
clip In point to the specified frame without affecting its duration.

Out: Sets the Out point of the audio clip. Adjusting this parameter always moves the
audio clip Out point to the specified frame without affecting its duration.

Duration: Sets the total duration of the audio clip. Adjusting Duration will also affect the
Speed and the Out point.

End Condition: Sets how playback continues when the end of the audio clip is reached.
This pop-up menu has four options:

• None: The default setting. The audio clip’s duration in your project is equal to the
duration of its source media file.

• Loop: When the last frame of the audio clip is reached, it loops back to the first frame
and plays again. This can cause a jump in the audio clip’s apparent playback unless it
was designed to be looped seamlessly. The End Duration value must be greater than
0 for this parameter to have any effect.

• Ping-Pong: When the last frame of the audio clip is reached, the next iteration of clip
playback is reversed. The End Duration value must be greater than 0 for this parameter
to have any effect.

Note: The Ping-Pong option is mainly for reverence—the “reversed” section of the
audio track will sound noisy, as Motion does not support true reverse playback.

• Hold: With this selected, the audio stops at the loop point.

End Duration: Sets the number of frames by which the clip is extended at the end of its
duration. This value may be adjusted only if End Condition is set to a value other than
None.

Adjusting a Track’s Speed in the Timeline
Motion allows you to change the timing of audio tracks in the Timeline as well.

Important: To affect all channels of a multichannel audio file, select all the tracks in the
Audio tab (press Command-A) before making adjustments in the Timeline.
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To shorten the audio clip’s duration and speed up its playback
1 Move the pointer over the end of the green audio track.

2 Press and hold down the Option key.

The pointer turns into the retiming pointer.

3 While continuing to hold down the Option key, drag the end of the track bar (the right
end of the bar) to the left.

As you drag, the tooltip displays the clip’s duration and speed.

To lengthen the audio clip’s duration and slow its playback
1 Move the pointer over the end of the audio track in the Timeline.

2 Press and hold down the Option key.

The pointer turns into the slip pointer.

3 Drag the end of the track bar to the right.

As you drag, the tooltip displays the clip’s duration and speed.

Looping an Audio Clip
Another way of extending a clip’s duration is by looping it. You can easily loop a clip by
adjusting it in the Timeline. When a looped audio clip reaches its last frame, the audio
starts playing again from its first frame.

To loop an audio clip
1 Move the pointer close to the end of the audio track in the Timeline.

2 Press and hold down the Option and Shift keys.

The pointer turns into the loop pointer.
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3 Drag the end of the track bar to the left.

As you drag, the tooltip displays the clip’s In and Out points, duration, and loop duration.
A looped clip has barriers to indicate where loops begin and end in the Timeline.

First loop barrier

The first loop barrier in a clip’s bar is interactive. Moving the barrier changes the point at
which the clip loops.

To change the loop point of an audio clip
µ Drag the first loop barrier left or right.

The end point of the clip’s loop moves as you drag.

Using Markers with Audio
When you add project markers to the Timeline, they appear in all three tabs of the Timing
pane: the Timeline, the Keyframe Editor, and the Audio Editor. You can use project markers
to designate “hit points” as you play back the project, to quickly jump to a specific point
in time, or to highlight points where you want to synchronize visual and audio events.

For information on adding and deleting markers, moving markers, editing marker
information, and using markers, see Adding Markers.

Audio Behaviors
Audio behaviors can be applied either to audio tracks from movie clips with sound or
standalone audio tracks. There are several ways to apply an audio behavior:

• Dragging an Audio behavior from the Library directly to an audio track in the Audio
tab or Timeline

• Selecting a track in the Audio tab or Timeline and then clicking the Add Behavior icon
in the Toolbar and choosing an Audio behavior from the pop-up menu

For more information about applying behaviors, see Applying and Removing Behaviors.
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There are two useful behaviors to control audio tracks in Motion:

Audio Auto Pan
Automates commonly used panning effects in an audio track.

Parameters in the Inspector
Pan Position: Sets the position of the pan. If the Pan Position slider is set to 0, the sound
is equally balanced between the left and right channels. With larger negative values of
Pan Position, the sound increases in volume in the left channel and decreases in the right
channel. With larger positive values of Pan Position, the sound increases in volume in the
right channel and decreases in the left channel.

Depth: Sets how far the automatic pan occurs in the left and right channels. Values range
from 0 to 100.

Direction: A pop-up menu that sets the direction in which the pan moves over the
behavior’s duration. Choose either Left or Right. If the direction is set to Right, over the
behavior’s duration the volume of the audio decreases in the left channel as it increases
in the right channel, giving the impression of a sound moving from left to right. If the
direction is set to Left, over the behavior’s duration the volume of the audio decreases
in the right channel as it increases in the left channel, giving the impression of a sound
moving from right to left.

Volume: A pop-up menu that sets how the audio levels are affected during the pan.
Choose from four options:

• Ramp Up: An animation curve that creates a constant increase in volume

• Ramp Down: An animation curve that creates a constant decrease in volume

• Crescendo: A logarithmic animation curve that creates a slowly accelerating increase
in volume

• Decrescendo: A logarithmic animation curve that creates a slowly decelerating decrease
in volume

Gain: Sets the target gain used for volume. Values range from –96 dB to +6 dB.

Loops: Sets the number of times the auto pan effect repeats. Values range from 1 to 30.

Apply Volume: A pop-up menu that sets how the audio levels change when the Auto
Pan effect repeats. Choose either Once Per Loop or Over Entire Duration. If set to Once
Per Loop, the Auto Pan affects audio level changes each time a loop marker is met. If set
to Over Entire Duration, the Auto Pan affects audio level changes.

End Condition: A pop-up menu that sets how the pan loops when the Auto Pan effect
repeats. Choose either Repeat or Ping Pong. This setting has an effect only if Loops is set
to a value greater than 1.

Start Offset: Sets the number of frames from the beginning of the audio after which the
audio effect starts.
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End Offset: Sets the number of frames from the end of the audio before which the audio
effect stops.

HUD Controls
The HUD contains the same controls as the Inspector, with the exception of the Start
Offset and End Offset controls.

Audio Fade In/Fade Out
Automates fading in and out an audio track.

Parameters in the Inspector
Fade In Time: Sets the number of frames over which the audio fades in from –96 dB to
0 dB from the first frame of the audio track. A duration of 0 frames leaves the beginning
of the audio track unmodified.

Fade Out Time: Sets the number of frames over which the audio fades out from 0 dB to
–96 dB. A duration of 0 frames leaves the end of the audio track unmodified.

Start Offset: Sets the number of frames from the beginning of the audio track after which
the volume animation starts. Adjust this parameter to make the behavior start after the
beginning of the audio track.

End Offset: Sets the number of frames from the end of the audio before which the
animation stops. Adjust this parameter to make the behavior end before the end of the
audio track.

HUD Controls
The Audio Fade In/Fade Out behavior has a custom control, shown below.

Note: The Audio Fade In/Fade Out HUD control is identical to the Fade In/Fade Out Basic
Motion behavior.
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Audio Parameter Behavior
Motion provides an easy and automated way for you to generate audio-driven animations
in your projects, using the Audio Parameter behavior. Whereas other behaviors are applied
to an object as a whole (usually modifying multiple parameters at once), a Parameter
behavior is applied to an individual parameter of an object. The Audio Parameter
behavior—available in the Parameter category in the Behaviors Library (and via the Add
Behavior icon in the Toolbar)—lets you make a particle system pulse to the beat of music,
or have an audio track’s bass amplitude affect an object’s opacity.

To apply an audio parameter behavior via the Add Behavior icon
1 In the Audio tab or Media tab of the Project pane, select the track.

2 In the Toolbar, click the Add Behavior icon, then choose Parameter > Audio from the
pop-up menu.

The Audio parameter behavior is added to the project. No Source Audio is yet applied,
however.

3 Do one of the following:

• In the Behaviors tab in the Inspector, click the To pop-up menu (in the Source Audio
row) and choose a source audio track.

• Drag the audio clip (or video clip with audio) from the Media tab (in the Project pane)
to the Source Audio well in the Behaviors tab of the Inspector.

To apply an audio parameter behavior via the shortcut menu
1 In the Audio tab, select the track.

2 In the Audio Track tab in the Inspector, control–click one of the audio parameters (such
as Level), and choose Audio from the shortcut menu.

The Audio parameter behavior is added to the project. No Source Audio is yet applied,
however.

3 Do one of the following:

• In the Behaviors tab in the Inspector, click the To pop-up menu (in the Source Audio
row) and choose a source audio track.

• Drag the audio clip (or video clip with audio) from the Media tab (in the Project pane)
to the Source Audio well in the Behaviors tab of the Inspector.

For more information on applying parameter behaviors, see Applying Parameter Behaviors.

Audio
The Audio Parameter behavior performs an analysis of a specific property of an audio
track, then applies an animation curve to a parameter based on that analysis.
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Parameters in the Inspector
Source Audio: Sets the audio track from which to read audio data. Can be set to any
single audio track in the project, or the Master track. Either drag an audio clip or a video
clip with audio into the Source Audio well, or use the pop-up menu to choose a source
for audio analysis.

Note: In order for the Audio Parameter behavior to have an effect on an object, audio
must be present in the Timeline at the position of the behavior.

Respond To: A pop-up menu that sets the type of audio data analysis to perform. Choose
either Amplitude or Transients. If set to Amplitude, the behavior responds to peak values
of a particular frequency. If set to Transients, the behavior responds to rapid changes in
frequency.

Graph Range: A pop-up menu that sets the initial range of frequency values to be analyzed
by the behavior. There are four menu options: All Frequencies, Bass, Mid, or Treble. The
choice of display affects the frequency range of the Low Frequency and High Frequency
parameters below.

Audio Graph: Displays a visual representation of the Source Audio data analyzed by the
behavior per frame.

During playback initiated by the Play button beneath the Audio Graph, the selected
Source Audio data is displayed. If audio analysis is being performed, progress is displayed
in the Audio Graph area as shown below.

The values of Low Frequency, High Frequency, Floor, and Ceiling can be set by dragging
the small triangles along the bottom or right side of the graph, or set numerically using
the four sliders underneath the graph to isolate certain frequencies and values for analysis.

Low Frequency: Sets the low frequency threshold of audio analysis. Only audio frequencies
above this value will be analyzed. Values range from 1 Hz to 22,050 Hz.
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High Frequency: Sets the high frequency threshold of audio analysis. Only audio
frequencies below this value will be analyzed. Values range from 1 Hz to 22,050 Hz.

Floor: Sets the minimum value of audio input, below which results are ignored. Values
range from 0 to 1.

Ceiling: Sets the maximum value of audio input, above which results are ignored. Values
range from 0 to 1.

Smoothness: Sets the window size to smooth the result curve. Any value other than 0
triggers a keyframe reduction with an error tolerance of 1%. Values range from 0 to 10.
This parameter is only available if Respond To is set to Amplitude.

Note: Depending on your audio file, Smoothness values greater than 7 may result in
audio playing out of sync.

Sensitivity: Sets the sensitivity of the transient detection. Values range from 0% to 100%.
This parameter is only available if Respond To is set to Transients.

Channel: Sets the audio channel to analyze. Value can be set to Mix/Mono, Left, or Right.

Note: With a multichannel audio file used as a source, Mix/Mono must be selected in
order for audio analysis to be performed properly.

Peaks: Sets the way the key points are linked when drawing the peak curves generated
by the audio analysis. Value can be set to Sharp, Smooth, Square, or Continuous.

The different peak types are described in the list below.

Note: The examples below are for reference only. Because the audio behavior does not
generate keyframes, you won’t see actual keyframes in the Keyframe Editor.

• Sharp: Each peak of the animation curve is described by three keyframes with a straight
line drawn between them. A selected keyframe has no tangent handles.

• Smooth: Each peak of the animation curve is drawn by a single keyframe with a Bezier
curve. A selected keyframe has a tangent handle to change the shape of the curve.
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• Square: Each peak of the animation curve is drawn by four keyframes. A selected
keyframe has no tangent handles.

• Continuous: This method behaves like Smooth interpolation, but without access to
Bezier handles, as they are calculated automatically from peak to peak.

Attack: The amount of the offset in frames between the first keyframe of the curve and
the peak of the curve generated by the Audio behavior. The number of frames that the
curve takes to reach its peak from its initial value is called the Attack. This parameter is
only available if Respond To is set to Transients.

Attack side of the curve

Release: The amount of the offset in frames between the peak of the curve generated
by the Audio behavior and the last keyframe of the curve. The number of frames that the
curve takes to reach its final value from its peak is called the Release. This parameter is
only available if Respond To is set to Transient.

Apply Mode: Sets the method by which the audio analysis affects the curve. Value can
be set to Add, Subtract, Multiply, or Add and Subtract.

Delay: Sets a delay in frames to offset the resulting keyframes.

Scale: Sets the scale factor to affect the result of the audio analysis.

Apply To: Sets the object parameter to which the audio behavior is applied.

HUD Controls
The HUD contains the Source Audio, Respond To, Graph Range, Audio Graph, Scale, and
Apply To controls.
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Using Soundtrack Pro with Motion
Once an audio file is imported into Motion, Soundtrack Pro can be opened from within
Motion and used to modify the audio track. After the audio track has been edited and
saved in Soundtrack Pro, the track is automatically updated in Motion.

For more information on Soundtrack Pro, see the Soundtrack Pro User Manual, available
in Soundtrack Pro Help.

To edit an audio track in Soundtrack Pro from within Motion
1 In the Audio tab or Timeline layers list, select the audio track you want to modify.

2 Do one of the following: Choose Edit > Send Audio to Soundtrack Pro.

• Choose Edit > Send Audio to Soundtrack Pro (Command-U).

• Control-click the audio track and choose Send to Soundtrack Pro from the shortcut
menu.

A Save As dialog appears.

Note: If Soundtrack Pro is not installed on your system, Send Audio to Soundtrack Pro is
not available in the menu.

3 If needed, type a name for the modified audio track and select a location in which to save
the file.

Note: Because this process creates a modified copy of the original audio file, the source
audio is not changed.

4 Click Save as Soundtrack Pro Audio.

A project that contains the audio track is opened in Soundtrack Pro.

5 In Soundtrack Pro, make your changes to the audio file and save the project (press
Command-S).

When Motion is displayed, the track and its saved name are automatically updated in the
Motion Audio tab. The original file, as well as the new Soundtrack Pro file, appear in the
Motion Media tab. A Soundtrack Pro file appears in the Media tab with a .stap extension.

Note: Do not choose File > Save As (from within Soundtrack Pro) and save a file with a
new name. If you save a new file, the live link between the audio track and Motion is lost.

Important: If you send a single track that is part of a multitrack or multichannel file
imported as separate tracks, all the tracks are replaced when coming back from
Soundtrack Pro.
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Exporting Audio
A Motion project can be exported as an audio-only QuickTime movie (.mov), or as a
QuickTime movie with both video and audio.

To export audio
1 Choose File > Export.

2 In the Export dialog, type a name for the exported file, then browse to the location where
you want to save the file.

3 Choose QuickTime Movie from the Kind pop-up menu.

4 Choose an export preset from the Export Preset pop-up menu, or click the Options button
to view and select export options.

5 Choose Audio Only from the Include pop-up menu to export audio only, or choose Video
and Audio to export a movie with both video and audio.

6 If you want to export only the marked play range instead of the entire project, click the
“Use play range” checkbox.

7 Click Export.

Your exported file is saved to the specified location.

After you export audio as a QuickTime movie, you can convert the QuickTime movie file
to another format using QuickTime Pro or another audio application.

For more information about exporting and export options, see Outputting Motion Projects.
This chapter includes information on exporting using Compressor, which allows you to
export audio to other file formats, such as AIFF.

For a complete listing of all video, still image, and audio export formats, see Supported
File Formats.
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When you are ready to output your project (either the finished version or a draft), you
have two basic choices: Share or Export. These options generate a new file (or files) that
contain all the components used in your project.

To make outputting easy, Motion provides a variety of presets. There are presets for both
broadcast-quality and highly compressed QuickTime movies, image sequences, audio
only, and still images. You can customize the existing export presets or create new ones
to suit your specific needs.

Share provides a number of presets for use with popular distribution methods such as
iTunes, AppleTV, MobileMe, iPod/iPhone, DVD, Blu- ray, and even YouTube. The file format
of the files created varies depending on the preset you choose.

Exporting also provides presets so you can quickly generate a variety of output types. You
can also fully customize the settings to create exactly the type of files you need.

This chapter covers the following:

• Exporting from Motion (p. 1359)

• Exporting an Audio File (p. 1367)

• Using Export Presets (p. 1367)

• Sharing Your Project (p. 1373)

• Exporting Portions of a Project (p. 1386)

Exporting from Motion
When exporting, you can choose which media to include in the exported file. You can
choose an export preset, or set video, audio, and output options individually. You can
export the entire project or, if you have marked a play range, export only the play range.

To export your project
1 Choose File > Export (or press Command-E).
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The Export dialog appears and the project name appears in the Save As field.

2 Type a new name in the Save As field or use the existing project name.

3 Browse to the location where you want to save the file using the pop-up menu and arrow
button at the top of the dialog.

To show a file browser pane, click the arrow button to the right of the Save As field.

4 Choose an export type from the Export pop-up menu.

You can export a QuickTime movie, an image sequence, or the current frame as a still
image. For information about the different kinds of export files, see Choosing the Export
Type.

5 Choose a preset from the Use pop-up menu.

For information about Use settings, see Using Export Presets.

6 If necessary, click the Options button to set export options individually.

For information about setting export options, see Setting Export Options.

7 Choose the media to include in the export file from the Include pop-up menu.

You can export video and audio, video only, or audio only.

8 Select the “Use play range” checkbox if you want to export only the marked play range,
rather than the entire project.

For information about marking a play range, see Defining the Play Range.

9 Click Export.

An Export progress window appears, and shows the time elapsed and time remaining.
Depending on the size and complexity of your project, exporting may take some time.

When the export is finished, the dialog closes.

Choosing the Export Type
You can export your project as a QuickTime movie or as a numbered sequence of images,
and you can also export the current frame as a still image.
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QuickTime Movie
When you export your project as a QuickTime movie, the project is rendered as a movie
file (.mov). Exported QuickTime movies can include both video and audio, video only, or
audio only.

Image Sequence
When you export your project as an image sequence, each frame is rendered as an image
file. The filename of each image file includes a sequence number that is incremented for
each successive file. Exported image sequences can include video only.

You can define the number of digits in the sequence number by adding a pound character
(#) for each digit to the end of the filename, and enclosing the pound characters in
brackets [ ]. For example, to make the sequence number four digits long, you add [####]
to the end of the filename.

Note: When you export an image sequence, Motion creates a still image for each frame
of the project, which can result in a large number of files. You may want to create an
empty folder to contain the image sequence files.

Current Frame
When you choose Current Frame, your project is exported as a still image (based on the
current playhead position). Exported still images include video only.

For a complete listing of video, image, and audio export formats, see Video and File
Formats.

Setting Export Options
If no export preset meets your specific needs, you can customize the export settings for
your project. You can set export options for video, audio, and output individually. You
can also set advanced export options, including QuickTime compression and audio
settings.

To change the video export options
1 Choose File > Export, then click the Options button.

The Export Options dialog appears, with the Video/Audio pane visible.
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2 In the Video section of the Video/Audio pane, choose the video settings you want:

• Choose the kind of export from the Kind pop-up menu.

• Choose the codec used to compress the exported project from the Compressor pop-up
menu. The available choices change depending on the kind of export you selected.

• Drag the Quality slider to adjust the level of compression. You can also type a value
between 1 and 100 in the field next to the slider. The lowest level of quality is 1, and
the highest level of quality is 100. Some codecs may not allow you to adjust the quality
level.

• If you are exporting an image sequence, type a number for the starting frame of the
sequence in the “Start number” field. Select the “Add spaces” checkbox to add an extra
space to the filename between the name and number. Some applications require the
space to read the image sequence files in the correct order.

• Click the Advanced button to view and select advanced audio and video options. The
available options change depending on the kind of export you selected.

To change the audio export options
1 Choose File > Export, then click the Options button.

2 In the Audio section of the Video/Audio pane, choose the audio settings you want:

• Choose the export sample rate from the “Sample rate” pop-up menu.

• Choose a mix type from the Mix pop-up menu.

• Click the Advanced button to set the compressor format, rate, quality, bit depth, and
channel mix settings in the Sound Settings dialog.

Additional export settings are available in the Output tab of the Export Options dialog.
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To change the output export options
1 Choose File > Export, then click the Options button.

2 Click the Output tab.

3 In the Output pane, choose the output settings you want:

Export presets are exported with “Use current project and canvas settings” selected by
default. When this checkbox is selected, the Color option is set to Color + Alpha. All other
fields are set according to the current project and canvas settings.

• Select the “Use current project and canvas settings” checkbox to use the current project
settings as displayed in the Project Properties dialog or turn it off to specify different
settings. When the “Use current project and canvas settings” checkbox is deselected,
the export uses the settings defined here, overriding your project settings.

• Choose one of the project preset sizes from the Resolution pop-up menu, or choose
Custom and type a custom frame size in the two Resolution value fields.

• Choose whether the export file includes only color data, only alpha channel
(transparency) data, or both from the Color pop-up menu.

Note: Some codecs do not support alpha channels.

• Select the Premultiply alpha checkbox to mix semi-transparent pixels in the exported
file with the project’s background color, as set in Project Properties.

• Select the Field Rendering checkbox to render individual fields, instead of rendering
whole frames.

• Select the Motion Blur checkbox to have motion blur applied to moving objects,
regardless of the setting in the View pop-up menu (above the Canvas).
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For more information on the Export Options, see Export Options Window.

Setting Advanced Export Options
You can select advanced export options for video and audio. The Advanced buttons in
the video and audio sections of the Export Options dialog display the standard QuickTime
export options.

Advanced video export options are available only when you are exporting your project
as a QuickTime movie. The options available depend on the export format of your project.

To change the advanced video export options
1 Choose File > Export, then click the Options button.

2 In the Video section of the Video/Audio pane, click the Advanced button.

3 In the Compression Settings dialog, choose the settings you want:

• Choose a codec from the “Compression type” pop-up menu.

• Choose the frame rate for your exported video in the “Frames per second” pop-up
menu, or choose Custom, then type a number in the field that appears next to the
pop-up menu.

• If the codec you choose uses temporal compression, you can set the frequency of
keyframes by selecting the “Key frame every” checkbox and typing the number of
frames you want in the field.

• If the codec lets you set the data rate for your exported video, you can do so by selecting
the “Limit data rate to” checkbox and typing a number in the field.

• Drag the Quality slider to adjust the level of compression. Some codecs may not allow
you to adjust the quality level.
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• Choose the scan mode (Interlaced or Progressive) of the export from the Scan Mode
pop-up menu.

• Choose the aspect ratio of the exported video from the Aspect Ratio pop-up menu.

To change the advanced audio export options
1 Choose File > Export.

2 Click the Options button.

The Export Options window appears.

3 In the Audio section of the Video/Audio pane, click the Advanced button.

Note: There are two different mix types for exporting audio: Stereo and 5.1 Surround.
Each of them have different advanced options.

4 In the Sound Settings dialog, choose the settings you want:

• Choose a codec to compress the audio from the Format pop-up menu.

• Choose an audio export format from the Channels pop-up menu.

• Choose a sample rate for audio export from the Rate field.

• Choose a quality from the Render Settings pop-up menu.

• Specify any additional export options relevant to the codec format.

• If there is an Options button, select it to view and set additional export options.

5 Click OK.

About Sound Format Compression Settings
Each of the compression algorithms in the Format pop-up menu of the Sound Settings
dialog has additional settings to control render quality and speed. In the Render Settings
Quality pop-up menu, choose Faster, Fast, Normal, Better, or Best. Some of the compression
formats have additional settings:
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OptionsAdditional settingsFormat

8-, 16-, 24-, or 32-bitSample SizeLinear PCM

Little Endian

Floating Point

Unsigned

Non-Interleaved

A-Law 2:1

8, 16, 20, 24, 28, 32, 40, 48, 56, 56, 64, 80, 96, 112,
128, 160, 192, 224, or 256 kbps

Target Bit RateAAC

4750, 5150, 5900, 6700, 7400, 7950, 10200, or
12200 bps

Bit RateAMR Narrowband

1–15Frames Per Packet

Apple Lossless

IMA 4:1

MACE 3:1

MACE 6:1

8, 10, 12, 16, 20, 24,32, 40, or 48 kbpsBitrateQdesign Music 2

PureVoice Full Rate, Qualcomm Half RateCompression OptionsQualcomm PureVoice

Optimize compression
for streaming

If you choose Stereo mix, you can export your project from Motion in either mono or
stereo. If you choose 5.1 Surround mix, Motion gives you the same mono or stereo options,
plus the following additional channel layouts for Channels in the Sound Settings dialog:

Channels exported and mix layoutFormat

Left, Right, Center, Left Surround, Right Surround5.0 (L R C Ls Rs)

Left, Right, Left Surround, Right Surround, Center5.0 (L R Ls Rs C)

Left, Center, Right, Left Surround, Right Surround5.0 (L C R Ls Rs)

Center, Left, Right, Left Surround, Right Surround5.0 (C L R Ls Rs)

Left, Right, Center, Low-Frequency Effects, Left Surround, Right
Surround

5.1 (L R C LFE Ls Rs)

Left, Right, Left Surround, Right Surround, Center, Low-Frequency
Effects

5.1 (L R Ls Rs C LFE)

Left, Center, Right, Left Surround, Right Surround, Low-Frequency
Effects

5.1 (L C R Ls Rs LFE)

Center, Left, Right, Left Surround, Right Surround, Low-Frequency
Effects

5.1 (C L R Ls Rs LFE)
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These settings use the output channel settings from the Audio tab to assign tracks to
each output bus. For more information on assigning tracks to output busses, Working
with Audio.

Exporting an Audio File
You can export an audio-only QuickTime movie. When you export audio only, the exported
movie includes all audio tracks in your project that are turned on and not muted.

To export an audio file
1 Choose File > Export.

2 In the Export dialog, type a name for the exported file, then browse to the location where
you want to save the file.

3 Choose QuickTime Movie from the Export pop-up menu.

4 Choose an export preset from the Use pop-up menu, or click the Options button to view
and select export options.

5 Choose Audio Only from the Include pop-up menu to export audio only, or choose Video
and Audio to export a movie with both video and audio.

6 If you want to export only the marked play range instead of the entire project, select the
“Use play range” checkbox.

7 Click Export.

Your exported file is saved to the specified location.

After you export audio as a QuickTime movie, you can convert the QuickTime movie file
to another format using QuickTime Pro, Compressor, or another audio application.

There are no audio-only export presets. However, you can use any QuickTime movie
export preset and edit the audio export options. For more information on working with
audio files, see Working with Audio.

Using Export Presets
Export presets let you quickly render your project using predefined groups of export
settings. In many cases, using an export preset can simplify your workflow. Motion provides
dozens of built-in presets that accommodate most common workflows.

You can edit the existing export presets, duplicate an export preset to use as a template
for creating a custom preset, or create a new export preset with the settings you choose.

Choosing an Export Preset
Motion includes export presets for many typical work situations. There are presets for
QuickTime movie, image sequence, and current frame export.
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To choose an export preset
µ In the Export dialog, choose a preset from the Use pop-up menu.

These presets, available in the Use pop-up menu of the Export dialog, include:

QuickTime Movie presets
• Apple ProRes 422 (HQ) Movie

• Apple ProRes 422 Movie

• Apple ProRes 4444 Movie

• DV NTSC Movie

• DV PAL Movie

• DVCPRO HD 1080i50 Movie

• DVCPRO HD 1080i60 Movie

• DVCPRO HD 1080p24 Movie

• DVCPRO HD 1080p30 Movie

• DVCPRO HD 720p24 Movie

• DVCPRO HD 720p25 Movie

• DVCPRO HD 720p30 Movie

• DVCPRO HD 720p50 Movie

• DVCPRO HD 720p60 Movie

• HDV 1080i50 Movie

• HDV 1080i60 Movie

• HDV 1080p24 Movie

• HDV 1080p25 Movie

• HDV 720p24 Movie

• HDV 720p25 Movie

• HDV 720p30 Movie

• Lossless+Alpha Movie

• Pixlet Movie

• Uncompressed 10-bit 48 kHz

• Uncompressed 8-bit 48 kHz

• XDCAM EX 1080i50 VBR Movie

• XDCAM EX 1080i60 VBR Movie

• XDCAM EX 1080p24 VBR Movie

• XDCAM EX 1080p25 VBR Movie
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• XDCAM EX 1080p30 VBR Movie

• XDCAM EX 720p24 VBR Movie

• XDCAM EX 720p25 VBR Movie

• XDCAM EX 720p30 VBR Movie

• XDCAM EX 720p50 VBR Movie

• XDCAM EX 720p60 VBR Movie

• XDCAM HD 1080i50 Movie

• XDCAM HD 1080i60 Movie

• XDCAM HD 1080p24 Movie

• XDCAM HD 1080p25 Movie

• XDCAM HD 1080p30 Movie

• XDCAM HD422 1080i50 Movie

• XDCAM HD422 1080i60 Movie

• XDCAM HD422 1080p24 Movie

• XDCAM HD422 1080p25 Movie

• XDCAM HD422 1080p30 Movie

• XDCAM HD422 720p50 Movie

• XDCAM HD422 720p60 Movie

Image Sequence presets
• JPEG Sequence

• OpenEXR Sequence

• Photoshop Sequence

• PICT Sequence

• PNG Sequence

• TGA Sequence

• TIFF Sequence

Current Frame presets
• JPEG

• OpenEXR

• Photoshop

• PICT

• PNG

• TGA
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• TIFF

Note: Photoshop export presets supports only a single-layer image, not multiple layers.

Exporting with Alpha Channels
To preserve areas of transparency in your project, you must export your project with an
alpha channel. The default QuickTime Movie preset—“Movie - current project and canvas
settings”—uses the Apple ProRes 4444 codec, which supports alpha channels. You can
also choose Lossless + Alpha Movie, which uses the Animation codec. This codec is usable
on any computer. In the Output pane of the Export dialog, you can choose whether the
alpha channel should premultiplied or straight. For more information about using alpha
channels, see More About Alpha Channels.

Additionally, to export your project with a transparent background, make sure that
Background is set to Transparent in the Project Properties dialog (press Command-J to
open the Project Properties dialog).

Viewing Export Preset Settings
You can view extended descriptions of the export presets in Motion Preferences.

To view export preset settings in Motion Preferences
1 Choose Motion > Preferences, then click Presets.

2 In the Presets pane, choose Export Presets from the Show pop-up menu.

3 Click a preset in the list, and its settings appear in the Summary field at the right, along
with a brief description.

The preset selected in Motion Preferences is also displayed in the Export Options dialog.

Editing an Export Preset
You can edit an existing preset. When you edit an existing preset, you replace the original
preset settings with your changes (unless you rename the preset).

1370 Chapter 21 Outputting Motion Projects



To edit an export preset
1 Choose File > Export, then click the Options button in the Export dialog.

The Export Options dialog appears, with the Video/Audio pane visible.

2 In the Video/Audio pane, edit the video and audio settings you want to change. Click the
Advanced buttons for video and audio to edit advanced export options.

3 Click the Output tab of the Export Options dialog, deselect the “Use current project and
canvas settings” checkbox, then edit the output settings you want to change.

4 When you are finished, click OK.

To save a copy of the preset with a different name, type a name for the preset in the
Name field, then click Save As.

Note: You can also edit an export preset from the Presets pane of Motion Preferences by
choosing Export Presets from the Show pop-up menu, selecting an export preset, then
clicking the Edit button.

Duplicating an Export Preset
You can duplicate an existing preset, and use it as the starting point for creating a new
preset.

To duplicate an export preset
1 Choose File > Export, then click the Options button in the Export dialog.

The Export Options dialog appears, with the Video/Audio pane visible.

2 In the Video/Audio pane, edit the video and audio settings you want to change. Click the
Advanced buttons for video and audio to edit advanced export options.

3 Click the Output tab of the Export Options dialog, deselect the “Use current project and
canvas settings” checkbox, then edit the output settings you want to change.

4 When you are finished, click Save As, then type a name for the preset.

Note: You can also duplicate an export preset from the Presets pane of Motion Preferences
by choosing Export Presets from the Show pop-up menu, selecting an export preset, then
clicking the Duplicate button.

Creating an Export Preset
If none of the included presets suits your needs, you can create a new export preset.

To create an export preset
1 Choose Motion > Preferences, then click Presets.

2 Choose Export Presets from the Show pop-up menu.

3 Click the Add button (+) to add a new preset.

4 Type a name for the preset in the Name field.
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You can optionally type a description for the preset in the Description field. (This is helpful
if there are settings or other information you want to remember about the preset.)

5 Select the video and audio settings for the preset in the Video/Audio pane of the Export
Options dialog. Click the Advanced buttons to change QuickTime compression or audio
settings.

6 Click the Output tab of the Export Options dialog.

If you want to change output settings, deselect the “Use current project and canvas
settings” checkbox, then select the output settings for the preset.

7 When you are finished, click OK.

For more on creating presets, see Export Options Window.

Deleting an Export Preset
If you decide you no longer need an export preset, you can delete it. You can delete
user-created export presets, but not the default export presets that come with Motion.

To delete an export preset
1 Choose Motion > Preferences, then click Presets.

2 Choose Export Presets from the Show pop-up menu.

3 Select the export preset you want to delete.

4 Click the Delete (–) button.
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Sharing Your Project
The Share feature is an easy “one-click” way to send your work to clients, friends, and
other audiences without any advanced knowledge of transcoding, delivery file formats,
or FTP protocols. From the Share window in Motion, you can quickly create and deliver
a version of your project that will play on popular devices such as iPods, iPhones, Apple TV,
MobileMe, DVD, or YouTube without having to open any additional applications.

With Share, you can also do any of the following:

• Create an output media file based on any (preset) setting from the list of (Apple or
custom) settings provided by Compressor.

• View or adjust the status of any Share export session in the Batch Monitor application.

• Open Share sessions in Compressor to use the advanced transcoding features of that
application.

To Share the current project
1 Choose File > Share or press Command-Shift-E.

2 Add outputs and adjust settings in the Share window.

3 Click Export.

About the Share Window
The central tool for the Share feature is the Share window.

Destination Folder: Use this pop-up menu to choose from a preset list of common places
to save the output media files.

Choose: Click the Choose button to open a standard Save dialog where you can select
any folder in which to save the output files.
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Outputs: Each of these outputs represents a separate media file which will be generated
from the current Motion project. For example, you might want to create an iPod version,
burn a DVD, and upload a copy to YouTube, all from the same project, and all at the same
time. For more information about creating multiple outputs, see Creating Multiple Outputs.

Each output contains a set of controls to configure the file it will create.

Output type pop-up 
menu Filename field

Add/Remove Output 
buttons

Post-transcoding action 
checkbox

Show Info button

Output type: Use this pop-up menu to select the type of output media file. The choices
are: Apple TV, Blu-ray, DVD, iPhone, iPod, MobileMe, YouTube, Apple ProRes 422, Apple
ProRes with Alpha (which uses the Apple ProRes 4444 codec), QuickTime H.264, and
Other.

Use the Other output to create a file based on any (preset) setting from the list provided
by Compressor. You can customize any setting in Compressor and save it for future Share
export sessions. For more about creating presets in Compressor, see the Compressor
User Manual, available in Compressor Help.

Filename Template: Motion automatically enters a filename in this field for the output
media file. The first part of the filename is based on the Motion project name. Motion
also automatically appends an output type identifier (such as “iPod” or “YouTube”) at the
end of the filename. You can manually edit any portion of the filename by double-clicking
it.
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Show Info button: Click this button to display more information about the current setting
and the output media file.

Note: You can also double-click the Output bar to display the Share Info balloon.

Add/Remove Output: Click the Add Output button (+) to create additional outputs. To
remove a particular output, click its Remove Output (–) button.

Post-transcoding action: Select this checkbox to activate any post-transcoding actions
such as adding the clip to your iTunes library or creating a DVD.

Selecting this checkbox automatically opens a drawer where you can set additional
options specific to the current output type.

Show Details: Click Show Details to open the Action/Output drawer, where you can set
post-transcoding actions and adjust output settings. The contents of the Action drawer
depend on the type of output selected. For more about the different actions available,
see Post-Transcoding Actions.

The Output drawer contains the same options regardless of the selected output. For more
about the Output drawer, see Additional Output Options.

Use play range: Select this checkbox to limit the output to the range specified in the
Timeline play range. For more information about setting a play range, see Defining the
Play Range.

Send to Compressor: Click Send to Compressor to open a batch in the Compressor
application based on all of the current Share window outputs (and their applied settings).
This allows you to use the advanced transcoding features in Compressor to complete the
exporting session. For information about using Compressor, see the Compressor
User Manual, available in Compressor Help.
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Show Progress: Checking this box will cause the Batch Monitor to launch once the Export
button is clicked. The Batch Monitor allows you to view or adjust the status of any Share
export session after it has been submitted for processing.

For more about using Batch Monitor, see the Batch Monitor User Manual, available in
Batch Monitor Help or Compressor Help.

Export: Once you have created all the outputs you want in the Share window and are
satisfied with the settings and details of your intended output media files, you are ready
to export. Click the Export button to begin the batch processing.

Note: Depending on the number of outputs, output types, and selected options (as well
as the length and complexity of your project), exporting may take a long time. To monitor
the progress of the batch, open the Batch Monitor application.

Post-Transcoding Actions
For many of the output types, additional settings are available to control actions taken
once the new media file is created. The actions include uploading the clip to your YouTube
account, posting it on your MobileMe page, burning a DVD, and other similar actions,
each specific to the selected output type.

These settings are accessed in the Action drawer, which appears to the right of the Share
window when the Show Details button is clicked or when the Post-transcoding action
checkbox is selected for a particular output.

To Open the Action drawer
Do one of the following:

µ In the Share window, select the output you want to modify, then select the
post-transcoding action checkbox under the output type pop-up menu.

µ In the Share window, select the output you want to modify, then click the Show Details
button.
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DVD Action Drawer
Use the DVD Action drawer to enter information and settings for the DVD you want to
burn.

Output Device: Use this pop-up menu to choose a DVD burner to burn a DVD or select
Hard Drive to create a disk image (.img) on your drive. You can then burn that file to a
DVD at a later point using the Disk Utility application (found in the Utilities folder). Any
DVD burners connected to your Mac will appear in the menu.

Disc Template: Use this pop-up menu to choose a template for the DVD.

Title: Use this field to enter a name for the DVD. By default the Title field contains the
output filename.

When Disc Loads: This pop-up menu lets you set the DVD’s first-play action. Choices are
Show Menu and Play Movie.

Use Chapter Marker Text as Subtitles: Select this checkbox to create subtitles on the
DVD based on the text contained in any chapter markers.

Note: Subtitles are not supported on AVCHD discs. Also, it is recommended that you limit
the number of AVCHD disc chapter markers to 50.

Background: Click the Add button to select a file on disk to serve as a background graphic
for the DVD title. If nothing is selected, the background will be black or white, depending
on the setting in the Disc Template pop-up menu. Once a file is selected, you can remove
the selection by clicking the Clear button, at which point you can click Add again to
choose a different file.

Clear button
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DVD preview area: A preview area shows what the disc menu will look like based on any
loaded graphic and the settings selected in the Disc Template pop-up menu.

Main Menu/Chapter Menu: Click the Main Menu button to preview the disc’s root menu
in the preview area. Click the Chapter Menu button to preview the disc’s chapter menu.

Blu-ray Action Drawer
Use the Blu-ray Action drawer to enter information and settings for the Blu-ray disc you
want to burn.

Note: Because Blu-ray and AVCHD menus are best suited for display at 1080i or 1080p
resolutions, ensure that your player and display are set accordingly.

Output Device: Use this pop-up menu to choose a Blu-ray disc burner to burn a Blu-ray
disc, or select Hard Drive to create a disk image (.img) on your drive that can be burned
to a Blu-ray disc later using the Disk Utility application (available in the Utilities folder).
Any disc burners connected to your Mac will appear in the list.

If you don’t have a Blu-ray disc burner, you can also use a standard DVD burner to burn
discs that will play in some Blu-ray players.

When outputting to a standard DVD burner (using standard DVD media), the Blu-ray
output burns the disc in the AVCHD format. AVCHD discs can be thought of as simpler
HD discs that you can burn to red laser media. Blu-ray disc players that support the AVCHD
format can play these discs. This allows you to burn a disc that contains HD video content
and some basic menu features on a standard DVD burner and be able to play that disc
on many Blu-ray Disc players.

Note: Some Blu-ray Disc players may not support playing the AVCHD format.

Important: You cannot play any disc containing Blu-ray content on a Macintosh computer.

Disc Template: Use this pop-up menu to choose a template for the Blu-ray disc.
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Title field: Use this field to enter a name for the Blu-ray disc. By default, the Title field
contains the output filename.

When Disc Loads: This pop-up menu lets you set the disc’s first-play action. Choices are
Show Menu and Play Movie.

Use Chapter Marker Text as Subtitles: This checkbox will create subtitles on the disc
based on the text contained in any chapter markers.

Include Loop Movie Button: Select this checkbox to add a button on the disc menu to
loop the movie.

Background: Click the Add button to select a file on disk to serve as a background graphic
for the Blu-ray menu. If nothing is selected, the background will be based on the template
chosen in the Disc Template pop-up menu. Once a file is selected, you can remove the
selection by clicking the Clear button, at which point you can click Add again to choose
a different file.

Clear button

Logo Graphic: Click the Add button to select a file on disk to serve as a logo graphic for
the Blu-ray disc. Once a file is selected, you can remove the selection by clicking the Clear
button, at which point you can click Add again to choose a different file.

Title Graphic: Click the Add button to select a file on disk to serve as a graphic for the
Blu-ray title. If nothing is selected, the background will be based on the template chosen
in the Disc Template pop-up menu. Once a file is selected, you can remove the selection
by clicking the Clear button, at which point you can click Add again to choose a different
file.

Disc preview area: A preview area shows what the disc menu will look like based on any
loaded graphics and the settings selected in the Disc Template pop-up menu.

Note: In order to successfully share to a Blu-ray disc, you must have a Blu-ray compatible
DVD burner.

Main Menu/Chapter Menu: Click the Main Menu button to preview the disc’s root menu
in the preview area. Click the Chapter Menu button to preview the disc’s chapter menu.
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Using Share to Burn Dual-Layer Discs
When you burn a disc using Share, the data rate in the output media file is calculated
automatically based on the capacity of the disc media, the type of disc format (DVD or
Blu-ray disc), and the duration of the source media file.

• If you initiate a Share export session before inserting blank Blu-ray Disc media into
your disc-burning device, the Share feature assumes single-layer media and adjusts
the data rate accordingly.

• If you initiate a Share export session after inserting blank dual-layer Blu-ray Disc media
into your disc-burning device, the Share feature detects the dual-layer media and
adjusts the data rate accordingly.

To ensure the best quality for a dual-layer projects, first insert blank dual-layer Blu-ray
Disc media into your disc-burning device, then click Export to initiate the Share export
session.

Note: If you choose Hard Drive (Blu-ray) in the Output Device pop-up menu to create
a disk image (.img) file, the Share feature invariably assumes single-layer media and
adjusts the data rate accordingly.

MobileMe Action Drawer
Use the MobileMe Action drawer to enter information about movies you want to publish
to a MobileMe Gallery on the web.
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Note: When you choose the MobileMe output type, the Share feature creates three output
media files for each source media file: Mobile, Medium, and Large. If you publish to
MobileMe, the MobileMe gallery automatically plays the most appropriate version for
any viewer's device and connection speed. For information about manually adjusting the
number and the details of the media files created with the MobileMe output type, see
Sending Outputs to Compressor and the Compressor User Manual.

User Name: Use this field to enter a MobileMe member name. Do not include “@me.com”
or “@mac.com.”

The MobileMe member name is required for successful uploading via Share.

Password: Use this field to enter a MobileMe password.

The MobileMe password is required for successful uploading via Share.

Title: Use this field to enter the name of the movie you are publishing.

Description: Use this field to enter a description of the movie you are publishing.

Hide movie on my Web Gallery page: Select this checkbox to limit viewing to the movie
you are publishing. In other words, viewers will not be able to access other items in your
MobileMe gallery.

Allow movie to be downloaded: Select this checkbox to allow viewers to download the
movie you are publishing.

Viewable by: Use this pop-up menu to control viewing access to the movie you are
publishing. There are three options:

• Everyone: Choose this option to make the movie freely available on the web.

• Only me: Choose this option to limit access to anyone with your MobileMe member
name and password.

• Edit Names and Passwords: Choose this option to open the Names and Passwords dialog
in which you create names and passwords to restrict viewing of your published movies.
You can assign only one name and password to each movie, but you can use the same
name and password for multiple movies. Names may contain letters, numbers,
underscores, and one dot (.). Names and passwords are case sensitive. Passwords must
contain four or more characters.
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YouTube Action Drawer
Use this form to enter information about movies you want to publish to a YouTube
account on the web.

Important: You must complete all fields for successful uploading via Share.

Username: Use this field to enter a YouTube username.

Password: Use this field to enter a YouTube password.

Title: Use this field to enter the name of the movie you are publishing.

Description: Use this field to enter a description of the movie you are publishing.

Tags: Use this field to enter keywords that describe your movie. These are search terms
that your intended audience might use to find your movie on YouTube.

Category: Use this pop-up menu to choose a YouTube category for your movie. On
YouTube, a movie can belong to one of several categories (topic areas).

Make this movie private: Select this checkbox to control viewing access to the movie
you are publishing. When you make a video private on YouTube, you have the option of
sharing it with a select number of people from any of the contact lists you create for your
account.
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Apple TV, iPhone, and iPod Action Drawers
The Action drawers for Apple TV, iPhone, and iPod are identical.

Add to Playlist: Use the Add to Playlist pop-up menu to add the output media file to a
particular playlist in your iTunes library.

Note: The first time you use Share, this pop-up menu will be empty. To populate this
menu with playlists from your iTunes library, choose Refresh from the Add to Playlist
pop-up menu.

QuickTime Action Drawer
The Action drawers for any of the other presets, including custom presets selected when
the Output is set to Other, are all identical, with a single control.

Open With: Use the Open With pop-up menu to have the new file automatically opened
into any QuickTime-aware application.
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Additional Output Options
Motion allows you to override the current project and Canvas settings when creating an
output in the Share window. This allows you to modify the included channels, camera
angles, render quality, and render options such as Lighting, shadows, reflections and
depth of field. These settings appear in the Output drawer.

To access the Output drawer
1 In the Share window, click the Show Details button.

2 In the drawer that appears, click the Output button.

Option in the Output drawer
The controls found in the Output drawer are the same as the ones available when
exporting, although they are arranged in a slightly different way.

Use current project and canvas settings: When this checkbox is selected, Motion uses
the current project settings (in the Project Properties dialog) for the output. When this
checkbox is deselected, Motion overrides the current project settings in favor of the
options you select in the Output drawer.

Color: Use this pop-up menu to choose whether the exported items include the color
data only, color data plus alpha channel (transparency), or just the alpha channel data.

Important: Some compressor types do not support alpha channels.

Premultiply alpha: When this checkbox is selected, semi-transparent pixels in your output
are mixed with the project background color.

Camera: A pop-up menu that sets which camera view is used when you output a 3D
project. Use the default Active Camera setting or choose another scene camera.
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Note: A scene camera is a camera that you add to a project, as opposed to a default
camera view that you choose in the upper-left corner of the Canvas (Top, Right,
Perspective, and so on). You can only export a project using a scene camera.

Lighting: When this checkbox is selected, the lighting effects are rendered with the
project. When this checkbox is deselected, no lighting effects appear in your final output.

Shadows: When this checkbox is selected, shadows are rendered with the project. When
this checkbox is deselected, no shadows appear in your final output.

Reflections: When this checkbox is selected, reflections are rendered with the project.
When this checkbox is deselected, no reflections appear in your final output.

Depth of Field: When this checkbox is selected, camera depth of field effects are rendered
with the project. When this checkbox is deselected, no depth of field effects appear in
your final output.

Render Quality: Allows you to choose Draft, Normal, Best or Custom quality for your final
output. The better the quality, the longer the render time.

For descriptions of the render quality options, see the Render pop-up menu section in
Canvas View Options.

Field Rendering: When this checkbox is selected, the output always renders individual
fields regardless of the setting in the View pop-up menu above the Canvas. When the
checkbox is deselected, frames are rendered whole, regardless of the setting in the View
pop-up menu.

Motion Blur: When this checkbox is selected, motion blur is applied to moving layers
regardless of the setting in the View pop-up menu. When deselected, no motion blur is
applied.

Frame Blending: When this checkbox is selected, frame blending is applied to moving
footage in the rendered output. The result can be smoother looking playback, but this
option can increase rendering time.

Use Float Bit Depth: When working in float space, turning this setting off drops the
rendered output to 8-bit. Because working in float space drastically increases processing
time, turn this setting off to speed your rendering time. This setting does not affect the
use of float bit depth in the Canvas.

Creating Multiple Outputs
When you export via Share, you can create multiple outputs from a single source. For
example, you might want create an iPod version, burn a DVD, and upload a copy to
YouTube, all at the same time. When you click the Export button, all of the files will be
created

To add an output in the Share window
1 In the Share window, click the Add Output button (+) on the right side of any existing

output.
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2 Use the output type pop-up menu in the output you just created to assign a specific
output type.

To remove an output from the Share window
µ In the Share window, click the Remove Output button (–) on the right end of the output

you want to remove.

Sending Outputs to Compressor
From the Share window, you can send one or more outputs to the Compressor application.
Clicking the Send to Compressor button opens a batch window in Compressor based on
all of the current Share window outputs (and their applied settings). This allows you to
use the advanced transcoding features in Compressor to complete the exporting session.
You can use default Apple settings or create custom settings for future Share exports.
For information about using Compressor, see the Compressor User Manual, available in
Compressor Help.

Exporting Portions of a Project
You aren’t required to export your entire project. You can limit what is exported in several
ways. You can select specific items in your project to be exported, and you can also restrict
the export to a specific range of time.

Exporting a Selection
The Export Selection option allows you to export only certain elements such as a group
or an individual layer.

Note: When reflections are enabled, exporting an object actively reflecting another object
will export without the reflection unless the reflected object is also included in the export.

To export a selection
1 Select at least one object in your project in the Project pane or Timeline.

2 Choose File > Export Selection.

3 Follow the same steps as for regular exporting.

For information about exporting, see Exporting from Motion.

Options in the Export Selection Dialog
The Export Selection dialog contains options for file naming, choosing a file type, choosing
which elements to include in the export, and designating options for events that take
place when the export operation is completed. The Export Selection dialog contains the
following items:

Save As: Type the name of the file you wish to export.

Where: Choose a location to save the exported file.
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Export: Choose a file type from the pop-up menu. An Options button allows you to set
Output options. For more information on export options, see Setting Export Options.

The Export pop-up menu contains the following items:

• QuickTime Movie: When this option is chosen, a QuickTime movie is created.

• Image Sequence: When this option is chosen, a series of numbered image files is
exported. Each image file represents a single frame in the sequence.

• Current Frame: When this option is chosen, only the frame at the current playhead is
exported.

Use: Allows you to choose from a menu of export presets. For more information on export
options, see Setting Export Options. Depending on the option you choose in the Export
pop-up menu, one of three default presets appears in the Use pop-up menu:

• Movie - current project and canvas settings: This option, the default when Export is set
to QuickTime Movie, uses the current project and Canvas movie settings when rendering
the selection for export.

• Sequence - current project and canvas settings: This option, the default when Export is
set to Image Sequence, uses the current project and Canvas image settings when
rendering the selection for export.

• Image - current project and canvas settings: This option, the default when Export is set
to Current Frame, uses the current project and Canvas image settings when rendering
the selection for export.

Include: A pop-up menu that sets which audio and video elements to include in the
export. There are three options:

• Video and Audio: This option exports video and audio.

• Video only: This option exports video only.

• Audio only: This option exports audio only.

After Export: A pop-up menu that sets which additional actions to take with the result
file after the export is complete. There are four options:

• Do nothing: When this option is selected, no additional action is taken after export is
complete.

• Open in viewer window: The default behavior, this option opens the exported element
in a viewer.

• Add to Media: This option adds the exported element to the Media tab of the current
project. This element does not appear in the Canvas.

• Import into project: This option imports the element into the project after exporting.
By default, the movie is imported into the Canvas and appears in the Layers tab hierarchy
just above the elements used to create it.
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Baking Elements
After you adjust project elements to your taste, you might want to reuse them in another
project. You can export elements as rendered files to minimize their effect on playback
performance in another complex project. This is a process known as baking.

To bake selected elements for export
1 Select the layers in your project that you wish to bake.

2 Choose File > Export Selection.

3 Choose the options you prefer in the Export Selection dialog, then click Export.

Note: If multiple layers are selected for export, the upper section of the dialog does not
include a Save As field.

Exporting a Play Range
If you have defined a play range for your project, you can chose to limit the export to
that play range.

To export a play range
1 Mark an In and Out point in the project around the area you want to export.

2 Choose File > Export or File > Share, then enable the “Use play range” checkbox.

For more information about setting a play range, see Defining the Play Range.
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Some operations, as well as the application of certain filters or a mask, cause a group to
be rasterized. When a group is rasterized, it is converted into a bitmap image. This affects
how the rasterized group interacts with other objects in the project.

This appendix covers the following:

• Groups and Rasterization (p. 1389)

• Text and Rasterization (p. 1392)

• Shapes and Rasterization (p. 1393)

• Particles and Rasterization (p. 1393)

• Replicators and Rasterization (p. 1395)

• Filters and Rasterization (p. 1397)

• Shadows and Rasterization (p. 1399)

Groups and Rasterization
Rasterization affects 2D and 3D groups in different ways. When a 2D group is rasterized,
the blend modes on objects within the group no longer interact with objects outside of
the group. When a 3D group is rasterized, the group as a whole can no longer intersect
with objects outside of the group. The rasterized 3D group is treated as a single object
and uses layer order (in the Layers tab), rather than depth order when composited in the
project.

For more information on layer order versus depth order, see Layer Order and Depth Order.

Note: When a group is rasterized, cameras and lights in the project still interact with
objects within the rasterized group.

Important: Lighting in a 2D group does not pass beyond the boundaries of that 2D group,
whether it is rasterized or not.

The following operations on a 2D group trigger the rasterization of that group:

• Making Blending changes (to the Opacity, Blend Mode, or Preserve Opacity parameters)
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• Turning on the Drop Shadow parameter

• Turning on the Four Corner parameter

• Turning on the Crop parameter

• Applying any filter

• Adding a mask

• Adding a light

The following operations on a 3D group trigger the rasterization of that group:

• Making blending changes

• Applying certain filters

• Adding a light to a 3D group with the Flatten parameter enabled (in the Group tab of
the Inspector)

Once an operation triggers a rasterization on a group, the following occurs:

• A rasterization indicator (resembling an LED) appears next to the parameter in the
Properties tab.

Rasterization indicator

• A small outline appears around the rasterized 2D group, 3D group, emitter, replicator,
or text icon (to the left of the group name) in the Layers tab and Timeline layers list.

Rasterization frame

Note: Unlike vector graphics, rasterized groups may lose quality when scaled.

Important: 3D particle emitters, 3D replicators, and nonflattened text objects are treated
as 3D groups for the purposes of rasterization.
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Examples of 2D Group and 3D Group Rasterization
The following examples show the effect of rasterization on the blend modes of 2D groups.
In both examples, the lone elephant image, which is the topmost group in the Layers
tab, overlaps a portion of the family of elephants image, which resides in a separate 2D
group in the Layers tab. And in both examples, the lone elephant group has its Blend
Mode parameter set to Vivid Light. In the nonrasterized left-hand example, the lone
elephant’s blend mode interacts with the pixels of the group underneath it (the family
of elephants). In the right-hand example, however, the topmost group is rasterized;
consequently, its Vivid Light blend mode no longer interacts with the pixels of the second
group.

No groups rasterized Topmost group rasterized

The next examples show the effect of rasterization on the intersection of 3D groups. In
the left-hand, nonrasterized example, two groups (Group A and Group B) containing
rectangle shapes intersect in 3D space. In the right-hand example, Group A has been
rasterized; consequently, Group A and Group B no longer intersect.

No groups rasterized Group A rasterized

Important: If a group’s Blend Mode is set to Pass Through and any of the group’s layers
have different Blend Modes applied, the layers are not rasterized.
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Text and Rasterization
Because all text layers are contained in groups, rasterization affects how text interacts
with other objects within your project.

Note: Text can be rasterized independently of the group in which it lives. Doing this
affects how the text interacts with objects within its own group. For example, applying
a Circle Blur filter to text that exists in 3D space (such as text on a path) causes the text
to no longer intersect with other objects in the same group. The same operations that
cause a 3D group to rasterize cause 3D text to rasterize. In some situations, selecting the
Flatten checkbox in the Layout pane of the Text Inspector can minimize this effect.

The following example on the left shows the nonrasterized 2D group (“titles”) containing
text. In the illustration on the right, the text interacts with the image beneath it in the
layer stack because the text is set to the Add blend mode (notice the texture in the word
“leopard” created by the image beneath it).

In the next example, the group that contains the text and upper leopard image is
rasterized—triggered in this case by selecting the Crop checkbox in the Properties tab
of the group. The text’s Add blend mode and the leopard image’s Multiply blend mode
no longer interact with the object beneath them (the lower leopard image) in the layer
stack. Notice that the group icon for the rasterized group now appears with a frame
around the icon (the icon immediately to the left of the “Group - titles” group).
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For more information on rasterization with 2D and 3D groups, see Groups and
Rasterization.

Shapes and Rasterization
When a group becomes rasterized, all layers within that group—including masks, shapes,
and paint strokes—are affected and may no longer interact with other layers and groups
as expected.

Because paint strokes are rendered in a plane, they are always rasterized (independent
of other objects within the same group). This affects how the dabs that comprise a paint
stroke interact with objects in the same group.

Note: Because a paint stroke is always rasterized, no rasterization indicator appears around
the paint stroke icon.

For more information on rasterization with 2D and 3D groups, see Groups and
Rasterization.

Particles and Rasterization
When a group becomes rasterized, all layers within that group—including particles—are
affected and may no longer interact with other layers and groups as expected.

The following examples demonstrate how rasterization affects particles in 2D groups.
The first set of illustrations depicts a nonrasterized 2D group that contains a particle
emitter set to the Add blend mode. The right illustration displays the particles interacting
with the group beneath the emitter in the Layers tab (the group containing the “orange
texture” layer). Note that the star particles interact with the pixels of the underlying group,
blending with the “orange texture” light streak effect.
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In the next set of illustrations, the group that contains the particle emitter is rasterized.
(The rasterization is triggered by selecting the Four Corner checkbox in the group’s
Properties tab.) As shown in the right illustration, the particle emitter’s Add blend mode
no longer interacts with the group beneath it in the Layers tab. In the left illustration,
notice that the icon for the rasterized group is now enclosed in a frame. This is called a
rasterization frame.

A 3D particle emitter can be rasterized independently of the group in which it lives.
Consequently, the resulting particles may not interact as expected with objects inside
the same group. For example, applying a Circle Blur filter to a particle emitter causes the
particles to no longer intersect with other objects in the same group. The same operations
that cause a 3D group to rasterize cause a 3D particle emitter to rasterize. To minimize
this effect, apply the filter directly to the emitter’s source object, or deselect the 3D
checkbox in the Particles tab.

Once a group or a 3D particle emitter is rasterized, the group as a whole can no longer
intersect with objects outside of the group. In the following illustration on the left, the
nonrasterized group that contains the particle emitter intersects with images from another
group (when Render Particles is set to In Global 3D). In the illustration on the right, a
Bloom filter applied to the particles group has triggered a rasterization, so the emitter
no longer intersects with images from another group.

Note: Unlike vector graphics, rasterized groups lose quality when scaled.
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For more information on rasterization with 2D and 3D groups, see Groups and
Rasterization.

Replicators and Rasterization
When a group becomes rasterized, all layers within that group—including replicators—are
affected and may no longer interact with other layers and groups as expected.

Note: A replicator can be rasterized independently of the group in which it lives. This
affects how the replicator interacts with objects within its own group. For example,
applying a Circle Blur filter to a replicator causes the replicator to no longer intersect with
other objects in the same group. The same operations that cause a 3D group to rasterize
cause a 3D replicator to rasterize. To minimize this effect, apply the filter directly to the
replicator’s source object, or deselect the 3D checkbox in the Replicator tab.

In the following illustrations, the nonrasterized 2D group that contains the replicator is
set to the Add blend mode. The replicator interacts with the group beneath it in the layer
stack.

The Elements group is not rasterized. The replicator blend mode interacts with the 
group beneath it in the project.
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In the next illustrations, the group that contains the replicator is rasterized. (The
rasterization is triggered by setting the Opacity parameter of the group to 90%.) As a
result of the rasterization, the replicator’s Add blend mode no longer interacts with the
group beneath it in the layer stack. Notice that the group icon for the rasterized group
now appears with a rasterization frame around the icon (the icon immediately to the left
of the Elements group.

The Elements group is rasterized, indicated by the 
frame around the group icon.

The replicator blend mode no longer interacts 
with the group beneath it in the project.

A rasterized 3D group as a whole can no longer intersect with objects outside of its group.
In the following illustration on the left, the nonrasterized group that contains the replicator
intersects with an image from another group. In the illustration on the right, a Gradient
Blur filter applied to the replicator group has caused the replicator group to rasterize. As
a result, the replicator no longer intersects with the image from another group.

Note: Unlike vector graphics, rasterized groups may lose quality when scaled.

Note: When a group is rasterized, cameras and lights in the project still interact with
objects within the rasterized group.

For more information on rasterization and 3D groups, see Groups and Rasterization.
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Filters and Rasterization
The application of some filters can cause a group to be rasterized. When a group is
rasterized, it is converted into a bitmap image. In 2D groups, the application of any filter
causes rasterization. In 3D groups, the application of certain filters causes rasterization.

For more information on rasterization and 3D groups, see Groups and Rasterization.

The following filters force rasterization of 3D groups:

Blur
• Circle Blur

• Compound Blur

• Gradient Blur

• Movement Blur

• Radial Blur

• Variable Blur

• Zoom Blur

Border
All Border filters force rasterization of 3D groups.

Color Correction
• Colorize

• Equalize

• Negative

• Saturate

• Tint

Distortion
All Distortion filters force rasterization of 3D groups.

Glow
• Light Rays

Matte
• Matte Magic

Sharpen
• Unsharp Mask

Stylize
• Bad TV

• Bad Film
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• Circle Screen

• Circles

• Crystallize

• Edge Work

• Edges

• Extrude

• Halftone

• Hatched Screen

• Highpass

• Indent

• Lens Flare

• Line Art

• Line Screen

• MinMax

• Pixellate

• Relief

• Slit Scan

• Slit Tunnel

• Texture Screen

• Vignette

• Wavy Screen

Tiling
All Tiling filters force rasterization of 3D groups.

Time
All Border filters force rasterization of 3D groups.

Video
• Deinterlace
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Shadows and Rasterization
Rasterized 3D objects do not cast shadows. If you perform an action that causes a group
to be rasterized (such as modifying the group opacity or enabling the glow setting for a
text object) and you still want that group to cast a shadow, you must flatten the group.
Flattened groups act as 2D layers and can cast and receive shadows as long as they are
themselves embedded in a 3D group. Text objects are flattened in the Layout pane of
the Text Inspector, and 3D groups are flattened in the Group tab of the Inspector. Particle
systems and Replicators are flattened by deselecting the 3D checkbox in the Emitter or
Replicator tab.

Remember that rasterizing causes layers to be rendered in the stacking order shown in
the Layers tab. So even if the shadow-casting object is in front of the shadow-receiving
object in the Canvas, rasterizing it may cause it to change position to reflect the relative
order of the layers in the Layers tab. You may need to rearrange the layer order in the
Layers tab to enable the rasterized, flattened object to cast a shadow.

For more on working with Shadows, see Shadows.
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Motion allows you to create projects that integrate many media types using a wide variety
of formats. Whether you’re using one of the Motion project presets or creating your own,
it’s important to be aware of what distinguishes one video format from another. This
appendix details the different characteristics of video formats and explains the different
frame sizes, how interlacing works, the difference between square and nonsquare pixels,
and which frame rates correspond to which video formats.

This appendix covers the following:

• Supported File Formats (p. 1401)

• Standard Definition Versus High Definition Video Formats (p. 1404)

• Popular Video Codecs for File Exchange (p. 1408)

• What Is Field Order? (p. 1410)

• Using Square or Nonsquare Pixels When Creating Graphics (p. 1411)

• Differences in Color Between Computer and Video Graphics (p. 1413)

• Using Fonts and Creating Line Art for Video (p. 1413)

• Scaling Imported High-Resolution Graphics (p. 1414)

• Creating Graphics for HD Projects (p. 1414)

Supported File Formats
Motion supports the use of a wide variety of video, still image, and audio files within a
single project. Because it’s a QuickTime standard application, Motion supports many of
the same file formats that QuickTime does.

QuickTime Video Codecs
Motion supports QuickTime video files using nearly any codec installed on your computer,
including, but not limited to:

• Animation

• BMP

• Cinepak
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• Component Video

• DV - PAL

• DV/DVCPRO - NTSC

• DVCPRO - PAL

• DVCPRO HD 1080i50, 1080i60, 1080p25, 1080p30, and 720p50, 720p60

• DVCPRO50 - NTSC

• DVCPRO50 - PAL

• Uncompressed 8- and 10-bit 4:2:2

• Graphics

• H.261

• HDV 1080i50, 1080i60, 1080p24, 1080p25, and 720p24, 720p25, 720p30

• Apple Intermediate Codec

• Motion JPEG A and JPEG B

• MPEG IMX 525/60 (30Mb/s, 40 Mb/s, 50 Mb/s)

• MPEG IMX 625/50 (30Mb/s, 40 Mb/s, 50 Mb/s)

• MPEG-4 Video

• Photo - JPEG

• Apple Pixlet Video

• Planar RGB

• PNG

• Apple ProRes 4444

• Apple ProRes 422 (HQ)

• Apple ProRes 422

• Apple ProRes 422 (LT)

• Apple ProRes 422 (Proxy)

• TGA

• TIFF

• VC H.263

• Video

• XDCAM HD 1080i50, 1080i60, 1080p24, 1080p25, 1080p30 (35 Mb/s VBR)

• H.263

• H.264

• JPEG 2000
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• Sorenson Video 3

• Sorenson Video

Still Image Formats
Motion supports most commonly used still image file types, including:

• SGI

• Photoshop

• BMP

• JPEG

• PICT

• PNG

• MacPaint

• TIFF

• TGA

• JPEG-2

• QuickTime Image Files

• OpenEXR

Other Image Formats
In addition, Motion includes special support for the following image types:

• Layered Photoshop files

• PDF files

Audio Formats
You can import audio files with sample rates up to 192 kHz and with bit depths up to
32 bits. Mono and stereo files are supported. Multichannel audio files are also supported.
Motion supports the following audio file types:

• WAV

• AIFF

• .cdda

• MP3

• AAC (AAC files are listed in the Finder with the .m4p file extension.)

• QuickTime Audio, with support for the following audio codecs:

• 8-bit

• 8-bit Unsigned (Little Endian/WAV)

• 16-bit Integer

1403Appendix B Video and File Formats



• 24-bit Integer

• 32-bit Integer

• 32-bit Float

• 64-bit Float

• ALaw 2:1

• AMR Narrowband

• Apple Lossless

• IMA 4:1

• MACE 3:1

• MACE 6:1

• MPEG-4 Audio

Important: You cannot import rights-managed AAC files, such as those purchased from
the iTunes Store.

For more information about the file formats supported by Motion, go to the Motion
website at http://www.apple.com/finalcutstudio/motion.

Standard Definition Versus High Definition Video Formats
Motion is extremely flexible and can work with both highly compressed and uncompressed
video.

Standard Definition Video
Despite having differing frame sizes, NTSC and PAL standard definition video share certain
characteristics.

• Both signals are interlaced, although the field order depends on the video capture
device used.

• Both signals have a 4:3 aspect ratio, but a 16:9 aspect ratio can be accommodated
either anamorphically or by using letterboxing.

• Both use nonsquare pixels to display the picture.

Analog standard definition formats include S-VHS, Hi-8, and Beta SP.

Scanning methodFrame ratesFrame sizeStandard

Interlaced29.97720 x 486NTSC

Interlaced25720 x 576PAL
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Digital standard definition formats include Digital Betacam and the D-1 through D-5
formats. Due to the wide variety of compression ratios and types in the different digital
standards, the table below presents more information on these formats.

Recorded bit
rate

Compression
type

Compression
ratio

Color
samplingMakerDigital format

11.9 MB/sec.DCT2.3:14:2:2SonyDigital
Betacam

21.5 MB/sec.NoneUncompressed4:2:2SonyD-1

11.75 MB/sec.NoneUncompressed4fscAmpexD-2

27.5 MB/sec.NoneUncompressed4:2:2MatsushitaD-5

Standard Definition DV
The frame sizes of NTSC DV and NTSC analog video differ. NTSC and PAL standard
definition DV video signals are both interlaced, and share a 4:3 aspect ratio using
nonsquare pixels.

Scanning methodFrame ratesFrame sizeStandard

Interlaced29.97720 x 480NTSC

Interlaced25720 x 576PAL

Standard definition DV formats include DV, DVCAM, DVCPRO25, and DVCPRO50.

Recorded bit
rate

Compression
type

Compression
ratio

Color
samplingMakerDigital format

3.6 MB/sec.DV5:14:1:1SonyDV

3.6 MB/sec.DV5:14:1:1SonyDVCAM

3.6 MB/sec.DV5:14:1:1 (NTSC)
4:2:0 (PAL)

PanasonicDVCPRO 25

7 MB/sec.DV3.3:14:2:2PanasonicDVCPRO 50

High Definition Video
All high definition formats use a nonanamorphic, 16:9 aspect ratio using square pixels,
just like a computer display. Despite these similarities, there are many high definition
video formats.

Scanning methodFrame ratesFrame sizeStandard

Progressive23.98, 24, 25, 29.97,
59.94, 60

1280 x 720720p

Progressive23.98, 24, 25, 29.97,
59.94, 60

1920 x 10801080p

Interlaced25, 29.97, 59.94, 601920 x 10801080i
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The different frame sizes, frame rates, and scanning methods serve different markets,
both domestically and internationally. For example, the availability of the 720p format is
a result of needing a lower-resolution format, so that current standard definition
programming can be blown up more easily. It is also seen as a format suitable for
programming that would not benefit from additional resolution, such as local news. For
broadcast, bandwidth is a critical issue, and the larger resolution of 1080 video takes up
valuable room on the broadcasting spectrum as well as on the available bandwidth of
cable and satellite services.

As you can see in the previous table, each high definition standard supports numerous
frame rates. These can be divided into two categories:

• Frame rates for film production and post-production

• Frame rates for broadcast video applications

Frame rates intended for broadcast video use can be interlaced, similar to standard
definition video on a television, or progressive like a computer display.

Video formatFrame rate

A progressive frame rate intended for HD video transfer to film.
23.98 is rounded up from the actual frame rate of 23.976. This frame
rate is useful in post-production since it can be converted easily by
hardware to the interlaced 59.94 frame rate for video viewing
purposes.

23.98

A progressive frame rate intended for HD video transfer to film24

Matches the frame rate of PAL video, used for broadcast.25

Matches the frame rate of NTSC video, used for broadcast. Some
manufacturers that refer to a frame rate of 30 fps are actually
referring to 29.97 fps.

29.97

Doubles the frame rate of PAL, a high-quality frame rate used for
broadcast.

50

Doubles the frame rate of 29.97 video. It’s easier for broadcast
equipment to down-convert from 59.94 to 29.97 for purposes of
standard definition broadcasting.

59.94

Doubles the 30 fps (actually 29.97) frame rate corresponding to
NTSC video; a higher quality frame rate used for high definition
broadcast.

60

There are two options available for shooting high definition video:

• Sony’s HDCAM format supports 29.97i and 60i. Sony also has a 24p format.

• Panasonic’s high definition format, DVCPRO HD. Don’t confuse this format with DVCPRO
25 and DVCPRO 50, which are both standard definition formats. Panasonic also has a
24p format that offers variable speed using a variable frame rate technology.
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Both of these acquisition formats have color sampling of 8 bits per channel. High definition
tape decks also exist with color sampling of 16 bits per channel, for film scanning,
mastering, and archival purposes.

Recorded bit
rate

Compression
type

Compression
ratio

Color
samplingMakerDigital format

17.5 MB/sec.DCT7.1:13:1:1SonyHDCAM

12.5 MB/sec.DCT1.7:14:2:2PanasonicDVCPRO HD

Supported DVCPRO HD Formats
Motion natively supports the following DVCPRO HD formats.

Scanning methodDimensionsMotionEasy SetupFormat

Interlaced1920 x 1080DVCPRO HD - 1080i601080i60

Progressive1280 x 720DVCPRO HD - 720p60720p60

Progressive1280 x 720DVCPRO HD - 720p30720p30

Progressive1280 x 720DVCPRO HD - 720p24720p24

Source timecode (in
Motion)Timebase (in Motion)Timebase (on tape)Format

30 fps29.97 fps29.97 fps(59.94 fields
per second)

1080i60

30 fps59.94 fps59.94 fps720p60

30 fps29.97 fps59.94 fps(flagged as
29.97)

720p30

30 fps23.98 fps59.94 fps(flagged as
23.976)

720p24

Note: Motion also supports additional uncompressed high definition formats using
third-party PCI cards. The table above shows only DVCPRO HD formats currently supported
by Motion.

Data Rates of Common High Definition and Standard Definition Formats
The table below shows the relative data rates of some commonly used high definition
formats. These data rates can be used as a reference for deciding how much hard drive
space you may need for the media you want to use in your project.

Bytes per secondBits per second (video only)Format

11.75 MB/sec.100 MbpsDVCPRO HD, 1080i60

11.75 MB/sec.100 MbpsDVCPRO HD, 1080i50

11.75 MB/sec.100 MbpsDVCPRO HD, 720p60

11.75 MB/sec.50 MbpsDVCPRO HD, 720p30
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Bytes per secondBits per second (video only)Format

11.75 MB/sec.40 MbpsDVCPRO HD, 720p24

26.25 MB/sec.210 MbpsD-5 HD

3.6 MB/sec.25 MbpsDV

3.6 MB/sec.25 MbpsDVCAM

3.6 MB/sec.25 MbpsDVCPRO(25)

6.25 MB/sec.50 MbpsDVCPRO 50

11.9 MB/sec.95.2 MbpsDigital Betacam

21.5 MB/sec.172 MbpsD-1

Choosing a Frame Rate
Most DVCPRO HD cameras and decks allow two types of video frame rates:

• Integer frame rates such as 60, 30, and 24 fps

• NTSC-related frame rate variants such as 59.94, 29.97, and 23.98 fps

Note: If you are outputting via Final Cut Pro, Motion only supports NTSC-related timebases
such as 59.94, 29.97, and 23.98 fps when transferring video between a computer and a
DVCPRO HD device via FireWire. Using tapes recorded with whole-number frame rates
such as 60 fps or 30 fps is not supported in Motion.

Popular Video Codecs for File Exchange
You can use video compressed with nearly any video codec in Motion. Bear in mind that
when you are working on a project in Motion, it is best to use high-quality codecs with
a minimum of compression. Highly compressed video files, such as those compressed
using the MPEG-4 or Sorenson codec, are probably going to be unsuitable for creating
high-quality work.

Note: Motion works in the RGB color space. Any clips you use in Motion that were captured
or recompressed using a Y′CBCR codec, such as DV, the Apple ProRes family, or
Uncompressed 8-bit 4:2:2, are converted to the RGB color space when used in a Motion
project. Clips that are exported from Motion using a Y′CBCR codec are converted back
into the Y′CBCR color space.

Apple ProRes
The Apple ProRes family of codecs provides a variety of versatile, adjustable compression
formats to serve nearly any post-production workflow. There are five different Apple
ProRes codecs, from Apple ProRes 4444, which includes an alpha channel, to
Apple ProRes 422 (Proxy), an offline format used by Final Cut Server for proxy movies.
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Apple ProRes 4444 is the default export codec for Motion because it is virtually lossless
and includes an alpha channel to preserve transparency in your projects. For more
information on the Apple ProRes family of codecs, see Final Cut Pro
Professional Formats and Workflows, available in Final Cut Pro Help.

Uncompressed 8-Bit and 10-Bit 4:2:2 Video
Video stored using these codecs undergoes no data compression, but some color
resampling may occur depending on the source video format. Because compression
usually results in video artifacts, using no compression guarantees the highest level of
quality. Unfortunately, it also guarantees enormous file sizes.

Note: Uncompressed 8-bit and 10-bit 4:2:2 movies cannot have alpha channels. (Alpha
channels define levels of transparency in your movie and are useful if you’re delivering
an effects shot for use in someone else’s composition.)

Animation
The Animation codec was developed for computer-generated imagery, which often has
large areas of uniform color and little, if any, noise. It is a lossless codec, which means it
doesn’t degrade quality or add artifacts to your video when it applies compression.

Video footage, which generally has more grain, noise, and variations of texture and color
than animated material, may not be compressed as much with the Animation codec as
with other methods. Because some lossless compression is better than none, this codec
is used more frequently than Uncompressed.

Note: Animation movies can have alpha channels. This codec is the most common
QuickTime format supporting alpha channels.

DVCPRO HD
A high definition video format that can be used to capture video digitally from
FireWire-enabled DVCPRO HD compatible decks. Don’t confuse this format with DVCPRO
25 or DVCPRO 50, which are both standard definition formats. This format supports a
number of frame sizes and frame rates, including a 24p format that offers variable speed
via a variable frame rate technology. DVCPRO HD uses 4:2:2 color sampling for high color
fidelity, and has a fixed data rate of 12.5 MB/sec.

Note: DVCPRO HD movies cannot have alpha channels.

DVCPRO 50
The DVCPRO 50 codec is used to capture video digitally from FireWire-enabled DVCPRO
50-compatible camcorders and decks. Although it’s similar to the DV codec in that DVCPRO
50 is imported as YUV encoded video, it produces considerably higher quality video since
it uses less compression. (DVCPRO 50 uses a 3:3:1 compression ratio, versus DV’s 5:1
compression ratio.) DVCPRO 50 also uses 4:2:2 color sampling for high color fidelity, as
opposed to DV’s 4:1:1 color sample rate. DVCPRO 50 has a fixed data rate of 7 MB/sec.
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Note: DVCPRO 50 movies cannot have alpha channels.

Apple M-JPEG
There are two Apple M-JPEG codecs, M-JPEG A and M-JPEG B. These are variable data
rate codecs similar to the ones used by video capture cards. If you need to deliver more
heavily compressed material to keep files small, consider these codecs. M-JPEG is a lossy
codec and results in artifacts in your final video. The severity of these artifacts depends
on the data rate you choose.

Several capture and playback cards on the market can play back either M-JPEG A or
M-JPEG B in real time without re-rendering the material, or at most, doing minimal
re-rendering. This makes file interchange very fast. Before you use either M-JPEG A or B,
consult the manufacturer of the capture card you’re using to find out which one you
should use.

Note: Apple M-JPEG movies cannot have alpha channels.

JPEG
JPEG is similar to M-JPEG, except that the compression artifacts can be less severe at
similar data rates. JPEG movies may play back in real time on your system, depending on
your system’s speed and the data rate of the movie.

Note: JPEG movies cannot have alpha channels.

Third-Party Codecs
There are several manufacturers of video-editing solutions, most of whom use different
variations of the M-JPEG codec. Many make software-only QuickTime codecs that you
can install in your System folder, enabling you to play back movies with little or no
re-rendering. For more information, contact the manufacturer of the editing system.

Note: Most third-party codecs cannot have alpha channels.

What Is Field Order?
All video displays, whether analog or digital, work by breaking a single frame of video
into individual lines of horizontal resolution running across the screen. Standard definition
NTSC and PAL are both interlaced video formats, as opposed to high definition video, or
video displayed on a computer screen, which are progressive-scanned video formats. With
progressive scanning, these lines are drawn one at a time, from the top of the screen to
the bottom.
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Interlaced video, including NTSC and PAL, works differently. When you record footage
with your camcorder, each video frame is broken down into two fields, each containing
half of the total lines of resolution in the frame. The first field is recorded, then the second,
and both are laid down to tape, one after the other, so that both fields constitute one
frame. When you play the tape back, a television monitor displays each recorded frame
in two passes, first drawing field 1, then drawing field 2.

Field order refers to the order in which video fields are recorded from your video
equipment to your hard disk. If you remember that video fields come one after another
in time, as if playing 60 “frames” per second, it becomes a little easier to understand.

There are two options for field order:

• Upper (Field 2 is dominant, so the second field is drawn first.)

• Lower (Field 1 is dominant, so the first field is drawn first.)

Generally, Upper is used by 640 x 480 systems, while Lower is most common in professional
720 x 486 and DV 720 x 480 systems.

It’s important to render digital video with the field order used by your hardware. Because
motion continues from one field to the next, it’s crucial that each field plays in the correct
order. Because different capture cards handle interlacing differently, choosing the correct
field order ensures proper playback.

Using Square or Nonsquare Pixels When Creating Graphics
When you’re preparing to import graphics into Motion, it’s important to be aware of the
pixel aspect ratio you’re using and whether your project requires you to work with square
or nonsquare pixels.

• Use nonsquare pixels for standard definition projects in NTSC or PAL.

• Use square pixels for high definition projects, as well as multimedia video that will be
played back only on computers and doesn’t use any captured video footage.

Graphics created on a computer, whether scanned, painted, or rendered, look distorted
on a video monitor unless you account for the different pixel aspect ratio. Fortunately,
this is easy to do, since every nonsquare video frame size has an equivalent square frame
size that you can use to create your graphics.

To create graphics that look correct when output to video
1 In your graphics application, create a frame size that’s the square pixel equivalent of the

video frame size you’re using.

See the chart below for equivalent sizes. For example, if you’re working in DV-PAL with
a nonsquare video frame size of 720 x 576, your graphic should have a square pixel frame
size of 768 x 576.
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2 Create the graphic.

3 Do one of the following:

• In your graphics program, rescale the graphic from the square frame size used to create
it to the nonsquare equivalent used in Motion.

• Save your image as is.

Within your Motion project, select the object in the Media tab of the project window,
open the Media tab in the Inspector, then choose the correct aspect ratio from the Pixel
Aspect Ratio pop-up menu.

Square pixel size
(graphics program)Aspect ratio

Nonsquare 4:3 pixel
size (Motion)Video format

720 x 5470.9720 x 486601-NTSC 4:3

853 x 4861.2720 x 486601-NTSC 16:9
Anamorphic

720 x 5400.9720 x 480DV-NTSC 4:3

853 x 4801.2720 x 480DV-NTSC 16:9
Anamorphic

768 x 5761.07720 x 576601/DV-PAL 4:3

1024 x 5761.42720 x 576601/DV-PAL 16:9
Anamorphic

1280 x 7201.0NA720i/p high definition

1920 x 10801.0NA1080i/p high definition

Working with Standard Definition (SD) Video Monitors and Computer
Displays
Standard definition (SD) video monitors differ from computer displays in a significant
way (aside from interlacing): computer displays represent images using a grid of square
pixels, while video monitors use pixels that are rectangular in shape.

720 x 486 Broadcast
(720 x 480 DV)

640 x 480
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SD NTSC pixels are narrower than computer pixels and SD PAL pixels are wider than
computer pixels. As a result, a 720 x 486 pixel image looks different on a computer display
than it does on a video monitor. For example, if you capture a clip of video with a globe
in the picture, export a frame, and look at this frame in a graphics application, you’ll see
something like this:

Looks right
on a video monitor

NTSC square vs. nonsquare pixels example

Looks wrong
on a computer monitor

The Canvas let you display nonsquare pixel video correctly on the computer’s screen
using the Correct For Aspect Ratio command in the View pop-up menu above the Canvas.

Note: High definition video uses only square pixels, so it doesn’t show this discrepancy.

Differences in Color Between Computer and Video Graphics
You should also be aware that the range of colors that can be displayed on a broadcast
video monitor is much smaller than that which can be displayed on your computer. For
this reason, colors that appear bright and clean on NTSC or PAL video can seem duller
when viewed on your computer.

If you output graphics images with colors that go outside the “legal” range for video,
they will appear oversaturated, and may “bleed” into other parts of the image. This
distortion can be easily avoided by controlling the palette of colors you use in your
graphics program. As you create the graphics you’ll be outputting to video, resist the
temptation to use the brightest and most saturated shades of color available in your paint
program.

Using Fonts and Creating Line Art for Video
When creating line art or selecting a font to use for a broadcast video image, you should
avoid creating horizontal single-pixel lines, or using fonts that are too thin. Because video
is interlaced, single-pixel lines will flicker as the field in which they appear alternates on
and off. This results in “buzzing” in your graphics, with the buzzing becoming more
pronounced the closer the thin areas in your image are to horizontal.
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This can be lessened by adding a bit of blur or anti-aliasing to your image, but the best
thing to do is to avoid single-pixel lines altogether when creating graphics for broadcast.

Scaling Imported High-Resolution Graphics
A high-resolution image is useful if you want to pan and zoom in or out of the image,
such as a scanned map or photograph. There won’t be any image degradation because
you typically won’t have to zoom more than 100 percent.

Scaling video and still images more than 100 percent creates artifacts: individual pixels
become noticeable, causing a “stair-stepping” artifact on high-contrast diagonal lines.

Sometimes the frame size of your imported graphic doesn’t match the frame size of your
edited sequence. If the frame size of the graphic is too large, only a small part of your
image appears within the Canvas. If it’s too small, the background color of the Canvas
(usually black) appears behind the graphic.

To scale an imported graphic to match the frame size of a sequence, use the following:

Type of videoFrame size (pixels)

High definition, 16:9, square pixel1920 x 1080

High definition, 16:9, square pixel1280 x 720

Standard definition, 4:3, nonsquare pixel for NTSC720 x 486

Standard definition DV, 4:3, nonsquare pixel for NTSC720 x 480

Standard definition, 4:3, nonsquare pixel for PAL720 x 576

Multimedia, 4:3, square pixel640 x 480

Multimedia, 4:3, square pixel480 x 360

Multimedia, 4:3, square pixel320 x 240

Multimedia, 4:3, square pixel240 x 180

Multimedia, 4:3, square pixel160 x 120

Creating Graphics for HD Projects
Creating graphics and still images for high definition video projects is the same process
as for standard definition video. To determine the image dimensions for your sequence,
follow the guidelines below.

Still image dimensionsSequence preset

1920 horizontal x 1080 vertical1080i

1280 horizontal x 720 vertical720p
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Unlike standard definition video formats, which use rectangular pixels, most high definition
video formats use square pixels. You don’t have to worry about adjusting high definition
image dimensions before importing your graphics into Motion.
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Use keyboard shortcuts to streamline your work in Motion. The tables in this appendix
organize the keyboard shortcuts by menu, component, and task. Some keyboard shortcuts
are always active, whether or not you are working in the group that they are listed in,
while other keyboard shortcuts are only active under special circumstances.

Note: Some keyboard shortcuts described in this appendix may conflict with system
commands assigned to the Mac OS X Finder.

The keyboard shortcuts listed in the following pages are the Standard Set of shortcuts
available in Motion. You can use the Command Editor to customize and save your own
keyboard shortcuts to create a set that works best for you. The Command Editor lets you
import and export saved sets, as well as duplicate a set of shortcuts to modify.

This appendix covers the following:

• Enabling Traditional Function Keys on Mobile Macintosh Systems (p. 1418)

• General Interface Commands (p. 1419)

• Motion Menu (p. 1420)

• File Menu (p. 1421)

• Edit Menu (p. 1421)

• Mark Menu (p. 1422)

• Object Menu (p. 1423)

• View Menu (p. 1424)

• Window Menu (p. 1426)

• Help Menu (p. 1427)

• Audio Editor (p. 1427)

• Audio Tab (p. 1427)

• View Tools (p. 1428)

• Create Tools (p. 1429)

• Mask Tools (p. 1432)
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• Transport Controls (p. 1434)

• View Options (p. 1434)

• Miscellaneous (p. 1436)

• HUD (p. 1436)

• File Browser (p. 1437)

• Inspector (p. 1437)

• Keyframe Editor (p. 1438)

• Layers (p. 1438)

• Library (p. 1439)

• Media Tab (p. 1440)

• Timeline Editing and Navigating (p. 1440)

• Keyframing Commands (p. 1442)

• Shape and Mask Commands (p. 1442)

• Toolbar (p. 1443)

• 3D Commands (p. 1444)

• Using the Command Editor (p. 1445)

Enabling Traditional Function Keys on Mobile Macintosh
Systems
By default, on MacBook and MacBook Pro computers, the F1-F12 keys are assigned to
hardware controls, such as brightness, audio volume, numlock, and so on. This means
that you have to press the Function (Fn) key along with the F-key when you want to
invoke F-key commands in your software applications.

You can change your keyboard preferences so that the F-keys work in the traditional
manner, without pressing the Fn key. When this setting is activated, you can press the
Fn key along with the F-key to activate the hardware commands.

To enable traditional function keys
µ In the Keyboard tab of the Keyboard & Mouse preferences in System Preferences, select

the “Use all F1, F2, etc. keys as standard function keys” checkbox. Uncheck the box to
return to the default setting.
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General Interface Commands

FunctionKeyboard shortcut

Open a project.
O

Create a new project.
N

Create a new project from a list of project presets.
option N

Open a template.
shift O

Open the Project Properties dialog.
J

Save a project.
S

Save a project as a new project.
shift S

Save all open projects.
option S

Close a project.
W

Close all open projects.
option W

Import a file.
I

Export a project.
E

Export a project using Compressor.
shift E

Print the current view of the Canvas.
P

Import files as a project.
shift I

Undo the last change.
Z

Redo the last change.
shift Z

Cut
X

Copy
C

Paste
V

Duplicate
D

Select all items.
A
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FunctionKeyboard shortcut

Deselect all items.
shift A

Delete
delete

Close the active window.
W

Minimize the active window.
M

Cycle through project windows. Press repeatedly until the window
you want is displayed.

Open Motion Preferences.,

Open Motion Help.
/

Display Page Setup dialog.
shift P

Hide Motion.
H

Hide other open application files.
option H

Quit Motion.
Q

Play/Pause a project.
space

Record animation.
A

Go to the start of a project.
home

Go to the end of a project.
end

Motion Menu

FunctionKeyboard shortcut

Open Motion Preferences.,

Hide Motion.
H

Hide other open application files.
option H

Quit Motion.
Q
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File Menu

FunctionKeyboard shortcut

Create a new project.
N

Open a project.
O

Open a template.
shift O

Close a project.
W

Save a project.
S

Save a project as a new project.
shift S

Import a file.
/

Import files as a project.
shift ?

Export a project.
E

Export selection.
option E

Export a project using Compressor.
shift E

Display Page Setup dialog.
shift P

Print the current view of the Canvas.
P

Create a new project from a list of project presets.
option N

Close all open projects.
option W

Save all open projects.
option S

Edit Menu

FunctionKeyboard shortcut

Undo the last change.
Z

Redo the last change.
shift Z

Cut
X
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FunctionKeyboard shortcut

Copy
C

Paste
V

Paste special.
option V

Duplicate
D

Delete
delete

Perform a ripple delete which removes the selected object and
closes the gap left behind.

shift delete

Select all items.
A

Transform control points.
shift T

Deselect all items.
shift A

Send Audio to Soundtrack Pro.
U

Open the Project Properties dialog.
J

Mark Menu

FunctionKeyboard shortcut

Mark In point.
I

Mark Out point.
O

Move the selected object to the In point.
shift {

Move the selected object to the Out point.
shift }

Add a project marker at the current frame.
M

Add a project marker at the current frame.

Add a global marker at the current frame.
shift M

Open the Edit Marker dialog.
option M

Mark In point of play range.
option I
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FunctionKeyboard shortcut

Mark Out point of play range.
option O

Object Menu

FunctionKeyboard shortcut

Add a new empty group to the project.
shift N

Add a new camera to the project.
option C

Add a new light to the project.
shift L

Add a new drop zone to the project.
option D

Move the selected object to the top of the Layers tab.
shift }

Move the selected object up the Layers tab by one level.
shift }

Move the selected object down the Layers tab by one level.[

Group the selected objects into a new layer.
shift G

Ungroup a group of objects so you can manipulate the objects
individually.

option G

Make an object active or deactivate an object.
control T

For an audio track, enable/disable the Solo button of the selected
track. For an object, solo the object.

control S

Isolate the selected group or layer.
control I

Lock/Unlock an object.
control L

Unsolo only the video portion of a file that contains video.
shift control S

Create a 3D Group of the selected objects.
control D

Add an image mask to the selected object.
shift M

Add keyframe (to the last modified parameter for the selected
object).

control K

Convert the applied behaviors to keyframes.
K

Make the selected object the cell source for a particle emitter.
E
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FunctionKeyboard shortcut

Replicate the selected object.
L

Clone the selected layer.
K

Open the Media tab and Inspector to display the source and
properties of media objects.

shift F

View Menu

FunctionKeyboard shortcut

Zoom in.
=

Zoom out.

Zoom to 100 percent.
option Z

Zoom to fit in window.
shift Z

Show/Hide the Canvas in the Full Screen mode.
F8

Send output to external monitor.
F12

Show Full View Area.
shift V

Set 3D View to Active Camera.
control A

Set 3D View to Perspective.
control P

Set 3D View to Next Camera.
control C

Reset 3D Camera View.
control R

Show all color channels.
shift C

Show the transparent channel.
shift T

Show the alpha channel overlay.
shift option T

Show the RGB channels only.
shift option C

Show the red channel.
shift R

Show the green channel.
shift G
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FunctionKeyboard shortcut

Show the blue channel.
shift B

Show the alpha channel.
shift A

Show the inverted alpha channel.
shift option A

Switch between the current channel and alpha channels.
V

Show the Canvas at full resolution.
shift Q

Enable/Disable lighting in the Canvas.
option L

Enable/Disable field rendering in the Canvas.
option F

Enable/Disable motion blur in the Canvas.
option M

Enable/Disable frame blending in the Canvas.
option control B

Enable/Disable preview float bit depth.
\

Show Overlays.
/

Show the rulers.
shift R

Show tool info.
option T

Show/Hide the grid.

Show/Hide the guides.;

Show/Hide the Dynamic Guides
shift :

Show/Hide the Safe Zones.

Show/Hide the Film Zones.
shift

Lock the guides.
shift :

Enable/Disable snapping to guides.
N

Show 3D grid.
shift

Show the Font dialog.
T

Show the Colors window.
shift C
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FunctionKeyboard shortcut

Show/Hide the Toolbar.
option T

Window Menu

FunctionKeyboard shortcut

Minimize the active window.
M

Show the project in Standard layout.
control U

Show the project in Alternate layout.
shift control U

Show the project in Cinema layout.
option control U

Show/Hide the Properties tab in Inspector.
F1

Show/Hide the Behaviors tab in Inspector.
F2

Show/Hide the Filters tab in Inspector.
F3

Show/Hide the Object tab in Inspector.
F4

Show/Hide the Project pane.
F5

Show/Hide the Timing pane.
F6

Show/Hide the HUD.
F7

Show/Hide the File Browser.
1

Show/Hide the Library.
2

Show/Hide the Inspector.
3

Show/Hide the Layers tab.
4

Show/Hide the Media tab.
5

Show/Hide the Audio tab.
6

Show/Hide the Timeline.
F6

Show/Hide the Keyframe Editor.
8
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FunctionKeyboard shortcut

Show/Hide the Audio Editor.
9

Help Menu

FunctionKeyboard shortcut

Open Motion Help.
/

Show the Welcome Screen.
0

Audio Editor

FunctionKeyboard shortcut

Show/Hide the Audio Editor.
9

Play/Pause a project.
space

Record animation.
A

Add a marker at the current frame.
M

Add a marker at the current frame.

Audio Tab

FunctionKeyboard shortcut

Show/Hide the Audio tab.
6

Make object active or inactive.
control T

Lock/Unlock an audio file.
control L

Enable/disable the Solo button of a selected track.
control S

Move up one level in the Audio list.

Move down one level in the Audio list.

Import.
I
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View Tools
The View tools in the upper-left corner of the Canvas activate a number of contextual
keyboard commands. Depending on the View tool chosen, different keyboard commands
are available.

Global Transform Commands

FunctionKeyboard shortcut

Choose the selected transform mode.
S

Choose the Select/Transform tool.
shift S

Cycle through the transform modes. Press repeatedly until the
transform mode you want is selected.

tab

Constrain the movement of an object to the guidelines.Press Shift and drag the pointer.

Override snapping while moving an object.Press Command and drag the
object.

Duplicate a selected object.Press Option and drag the
object.

Select/Transform Tool

FunctionKeyboard shortcut

Scale an object proportionally.Press Shift and drag the object
handle.

Scale an object from its center.Press Option and drag the object
handle.

Scale an object proportionally from its center.Press Shift-Option and drag the
object handle.

Snap the rotation of an object to 45 degree increments.Press Shift and drag the object
rotation handle.

Activate 3D transform tool.
Q

Crop Tool

FunctionKeyboard shortcut

Crop an object proportionally.Press Shift and drag the object
handle.

Crop an object from its center.Press Option and drag the object
handle.

Crop an object proportionally from its center.Press Shift-Option and drag the
object handle.
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FunctionKeyboard shortcut

Pan a cropped object within the bounding box.Press Command and drag over
the object.

Move the bounding box around a cropped object.Press Option-Command and
drag over the object.

Adjust Control Points Tool

FunctionKeyboard shortcut

Add a point to a path.Double-click the path.

Add a point to a path.Press Option and click the path.

Convert a point to linear.Press Command and click the
point.

Create a tangent on a control point.Press Command and drag the
point.

Scale a tangent proportionally.Press Command and drag the
tangent handle.

Adjust a B-Spline point bias.Press Command and drag a
B-Spline point.

Switch a B-Spline point bias.Press Command and click a
B-Spline point.

Break or relink a tangent handle.Press Option and drag a tangent
handle.

Constrain a tangent to 45 degrees and original value.Press Shift and drag a tangent
handle.

Pan & Zoom Tools

FunctionKeyboard shortcut

Select the Pan tool.
H

Select the Zoom tool.
Z

Zoom Out with the Zoom tool selected.Press Option and click in the
Canvas.

Create Tools
The Create tools in the upper-left corner of the Canvas activate a number of contextual
keyboard commands. Depending on the Create tool chosen, different keyboard commands
are available.
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Rectangle & Circle Tools

FunctionKeyboard shortcut

Select the Rectangle Shape tool.
R

Select the Circle Shape tool.
C

Draw a shape proportionally.Press Shift and drag in the
Canvas.

Draw a shape from its center.Press Option and drag in the
Canvas.

Draw a shape proportionally from its center.Press Shift-Option and drag in
the Canvas.

Snap the rotation of an object to 45 degree increments.Press Shift and drag a rotation
handle

Bezier Tool

FunctionKeyboard shortcut

Select the Bezier tool.
B

Switch between the Bezier and B-spline tools.
B

Close shape.
C

Add a point to path.Press Option and click a path.

Add a point to path.Double-click a path.

Convert a point to linear.Press Command and click a
point.

Create tangents on a point.Press Command and drag a
point.

Scale a tangent handle proportionally.Press Command and drag a
tangent handle.

Break or relink a tangent handle.Press Option and drag a tangent
handle.

Constrain a tangent to 45 degree increments and original value.Press Shift and drag a tangent
handle.

Cancel shape drawing and delete the open shape.
esc

Exit shape-drawing mode.
return
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B-Spline Tool

FunctionKeyboard shortcut

Select the B-Spline tool.
B

Switch between the Bezier and B-Spline tools.
B

Close shape.
C

Add a point to path.Double-click a path.

Add a point to path.Press Option and click a path.

Adjust a B-Spline point bias.Press Command and drag a
B-Spline point.

Switch a B-Spline point bias.Press Command and click a
B-Spline point.

Cancel shape drawing and delete the open shape.
esc

Exit shape drawing mode.
return

Paint Stroke Tool

FunctionKeyboard shortcut

Activate Paint Stroke tool.
P

Adjust stroke width.Press Command and drag in the
Canvas.

Text Tool

FunctionKeyboard shortcut

Select the Text tool.
T

Move the insertion point by character.Press the Up, Down, Left, or
Right Arrow key.

Move the insertion point by word.Press Option and the Up, Down,
Left, or Right Arrow key.

Move to the beginning of a line of text.

Move to the end of a line of text.

Select one or more characters from the insertion point.Press Shift and the Up, Down,
Left, or Right Arrow key.
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FunctionKeyboard shortcut

Select one or more words from the insertion point.Press Shift-Option and the Up,
Down, Left, or Right Arrow key.

Select a line of text from the insertion point.Press Shift-Command and the
Up, Down, Left, or Right Arrow
key.

Increase kerning from the insertion point.
control

Decrease kerning from the insertion point.
control

Select All.
A

Deselect All.
shift A

Exit Text tool.
esc

Mask Tools
The Mask tools in the upper-left corner of the Canvas activate a number of contextual
keyboard commands. Depending on the Mask tool chosen, different keyboard commands
are available.

Rectangle Mask & Circle Mask Tools

FunctionKeyboard shortcut

Select the Rectangle Mask tool.
option R

Select the Circle Mask tool.
option C

Select the Freehand Mask tool.
option P

Draw a mask proportionally.Press Shift and drag in the
Canvas.

Draw a mask from its center.Press Option and drag in the
Canvas.

Draw a mask proportionally from its center.Press Shift-Option and drag in
the Canvas.

Snap the rotation of a mask to 45 degree increments.Press shift and drag a rotation
handle.
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Bezier Mask Tool

FunctionKeyboard shortcut

Select the Bezier Mask tool.
option B

Switch between the Bezier Mask and B-Spline Mask tools.
option B

Close mask.
C

Add a point to path.Double-click a path.

Add a point to path.Press Option and click a path.

Convert a point to linear.Press Command and click a
point.

Create tangents on point.Press Command and drag a
point.

Scale tangents proportionally.Press Command and drag a
tangent handle.

Break or relink a tangent handle.Press Option and drag a tangent
handle.

Constrain a tangent to 45 degrees and original value.Press Shift-Option and drag a
tangent handle.

Cancel shape drawing and delete the open shape.
esc

Exit shape-drawing mode.
return

B-Spline Mask Tool

FunctionKeyboard shortcut

Select the B-Spline Mask tool.
option B

Switch between the Bezier Mask and B-Spline Mask tools.
option B

Close mask.
C

Add a point to path.Double-click a path.

Add a point to path.Press Option and click a path.

Adjust a B-Spline point bias.Press Command and drag a
B-Spline point.

Switch a B-Spline point bias.Press Command and click a
B-Spline point.

Cancel shape drawing and delete the open shape.
esc
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FunctionKeyboard shortcut

Exit shape drawing mode.
return

Select the Bezier Mask tool.
option B

Show/Hide mask control points.

Transport Controls

FunctionKeyboard shortcut

Play/Pause a project.
space

Record an animation.
A

Enable/disable loop playback.
shift L

Go to the start of a project.
home

Go to the end of a project.
end

Go to the start of the play range.
shift home

Go to the end of the play range.
shift end

Go to the previous frame.

Go to the next frame.

Go backward ten frames.
shift

Go forward ten frames.
shift

View Options

FunctionKeyboard shortcut

Zoom In.
=

Zoom Out.

Zoom Out with the Zoom tool selected.Press Option and click the
Canvas.
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FunctionKeyboard shortcut

Zoom to region.Press Command and drag in the
Canvas.

Zoom to 100 percent.
option Z

Zoom to fit in the Canvas.
shift Z

Show all color channels.
shift C

Show the transparent channel.
shift T

Show the alpha channel overlay.
shift option T

Show the RGB channels only.
shift option C

Show the red channel.
shift R

Show the green channel.
shift G

Show the blue channel.
shift B

Show the alpha channel.
shift A

Show the inverted alpha channel.
shift option A

Show the Canvas at full resolution.
shift Q

Enable/Disable field rendering in the Canvas.
option F

Enable/Disable motion blur in the Canvas.
option M

Show the rulers.
shift R

Lock the guides.
option ;

Show/Hide the grid.

Show/Hide the guides.;

Show/Hide dynamic guides.
shift :

Show/Hide film zones.
shift

Show overlays.
/

Switch between the current channel and alpha channel.
V
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FunctionKeyboard shortcut

Show/Hide safe zones.

Enable/Disable snapping to guides.
N

Expose active layers.
X

Expose all layers.
shift X

Miscellaneous

FunctionKeyboard shortcut

Create a particle emitter.
E

Import an image mask to the selected object.
shift M

Select the next object above.

Select the next object below.

Nudge the selected object(s) one pixel.Press Command and the Up
Arrow, Down Arrow, Left Arrow,
or Right Arrow key.

Nudge the selected object(s) 10 pixels.Press Shift-Command and the
Up Arrow, Down Arrow, Left
Arrow, or Right Arrow key.

Add/Remove selected objects using the region box.Press Shift and drag in the
Canvas.

Select multiple objects in a group or layer.Press Command and click an
object or objects.

Add to selection.Press Shift and click an object.

HUD

FunctionKeyboard shortcut

Show/Hide the HUD.
F7

Cycle through the HUDs from top to bottom (when more than one
effect is applied to an object).

D

Cycle through the HUDs from bottom to top (when more than one
effect is applied to an object).

shift D
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File Browser

FunctionKeyboard shortcut

Show/Hide File Browser.
1

Open project.
O

Open template.
shift O

New project.
N

Show/Hide Project pane.
F5

Move up one item in the sidebar or file stack.

Move down one item in the sidebar or file stack.

Move left one item in the file stack.

Move right one item in the file stack.

Select first item in the file stack.
space

Move up one level in the folder hierarchy of the file stack.

Inspector

FunctionKeyboard shortcut

Show/Hide the Inspector.
3

Increase a slider value by an increment of one.Press the Up Arrow or Right
Arrow key.

Decrease a slider value by an increment of one.Press the Down Arrow or Left
Arrow key.

Increase a slider value by an increment of ten.Press Command and the Up
Arrow or Right Arrow key.

Decrease a slider value by an increment of ten.Press Command and the Down
Arrow or Left Arrow key.
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Keyframe Editor

FunctionKeyboard shortcut

Show/Hide Keyframe Editor.
8

Convert the applied behaviors to keyframes.
K

Fit visible curves.
F

Show animated curves.
U

Show modified curves.
Y

Show position curves.
P

Show rotation curves.
R

Show scale curves.
S

Show shear curves.
H

Show anchor point curves.
A

Show opacity curves.
O

Layers

FunctionKeyboard shortcut

Create a new group.
shift N

Bring the object to the top of the group.]

Send the object to the bottom of the group.[

Bring the object up one level in the Layers tab.]

Send the object down one level in the Layers tab.[

Place the selected objects in a new group.
shift G

Ungroup a group of objects so you can manipulate the objects
individually.

option G

Make the object active or deactivate the object.
control T
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FunctionKeyboard shortcut

Enable/disable the Solo button of a selected track.
control S

Isolate the selected group or layer.
control I

Lock/Unlock an object.
control L

Move up one level in the Layers tab.

Move down one level in the Layers tab.

Expand a group in the Layers tab.

Collapse a group in the Layers tab.

Import
I

Add an image mask to the selected object.
shift M

Convert the applied behaviors to keyframes.
K

Open the Media tab and Inspector to reveal the source and
properties of media objects.

shift F

Clone the selected layer.
K

Library

FunctionKeyboard shortcut

Show/Hide the Library.
2

Select the first item in the sidebar or file stack.
space

Move up one item in the sidebar or file stack.

Move down one item in the sidebar or file stack.

Move left one item in the file stack.

Move right one item in the file stack.

Move up one level in the folder hierarchy of the file stack.
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Media Tab

FunctionKeyboard shortcut

Show/Hide Media tab.
5

Move up one level in the Media list.

Move down one level in the Media list.

Import
/

Timeline Editing and Navigating

FunctionKeyboard shortcut

Nudge one frame forward.

Nudge one frame backward.

Nudge ten frames forward.
shift

Nudge ten frames backward.
shift

Move the selected object to the In point.
shift {

Move the selected object to the Out point.
shift }

Mark the In point of the play range.
I

Mark the Out point of the play range.
O

Reset the play range by moving the In and Out points to the first
and last frames of the project.

option X

Enable/Disable loop playback.
shift L

Open the Recording Options dialog.
option A

Go to the start of play range.
shift home

Go to the end of play range.
shift end

Go to the In point of the selected object.
shift I

Go to the Out point of the selected object.
shift O
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FunctionKeyboard shortcut

Go to the previous frame.

Go to the next frame.

Go backward ten frames.
shift

Go forward ten frames.
shift

Go to the next marker.
option

Go to the previous marker.
option

Render a RAM Preview for the play range.
R

Render a RAM Preview for the selected object.
option R

Render a RAM Preview for the entire project.
shift option R

Mark an In point.
I

Mark an Out point.
O

Add a marker at the current frame.
M

Add a marker at the current frame.

Open the Edit Marker dialog.
option M

Play/Pause the project.
space

Record animation.
A

Go to the start of project.
home

Go to the end of project.
end

Convert the applied behaviors to keyframes.
K

Perform a ripple delete.
shift delete

Paste special.
option V
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Keyframing Commands

FunctionKeyboard shortcut

Add a point to path.Double-click a path.

Add a point to path.Press Option and click a path.

Create tangents on point.Press Command and drag a
Bezier point.

Convert a point to linear.Press Command and click a
Bezier point.

Adjust a B-Spline point bias.Press Command and drag a
B-Spline point.

Switch a B-Spline point bias.Press Command and click a
B-Spline point.

Scale tangents proportionally.Press Command and drag a
tangent handle.

Break or relink a tangent handle.Press Option and drag a tangent
handle.

Constrain a tangent to 45 degrees and original value.Press Shift and drag a tangent
handle.

Shape and Mask Commands

FunctionKeyboard shortcut

Draw a shape proportionally with the Rectangle, Circle Shape, and
Mask tools.

Press Shift and drag in the
Canvas.

Draw a shape from its center with the Rectangle, Circle Shape, and
Mask tools.

Press Option and drag in the
Canvas.

Draw a shape proportionally from its center with the Rectangle,
Circle Shape, and Mask tools.

Press Shift-Option and drag in
the Canvas.

Cancel spline drawing and delete the open spline.
esc

Exit spline drawing mode and complete the existing spline drawing.
return

Add a point to path.Double-click a path.

Add a point to path.Press Option and click a path.

Convert a point to linear.Press Command and click a
Bezier point.

Create tangents on point.Press Command and drag a
Bezier point.
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FunctionKeyboard shortcut

Scale tangents proportionally.Press Command and drag a
tangent handle.

Adjust a B-Spline point bias.Press Command and drag a
B-Spline point.

Switch a B-Spline point bias.Press Command and click a
B-Spline point.

Break or relink a tangent handle.Press Option and drag a tangent
handle.

Constrain a tangent to 45 degrees and original value.Press Shift and drag a tangent
handle.

Toolbar

FunctionKeyboard shortcut

Show/Hide the Toolbar.
option T

Choose the selected transform mode.
S

Choose the Select/Transform tool.
shift S

Cycle through the transform modes. Press repeatedly until the
transform mode you want is selected.

tab

Select the Pan tool.
H

Select the Zoom tool.
Z

Select the Rectangle Shape tool.
R

Select the Circle Shape tool.
C

Switch between the Bezier and B-Spline tools.
B

Select the Text tool.
T

Select the Rectangle Mask tool.
option R

Select the Circle Mask tool.
option C

Switch between the Bezier Mask and B-Spline Mask tools.
option B

Show/Hide the HUD.
F7
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FunctionKeyboard shortcut

Show/Hide the File Browser.
1

Show/Hide the Library.
2

Show/Hide the Inspector.
3

Show/Hide the Project pane.
F5

Show/Hide the Timing pane.
F6

Show the Fonts dialog.
T

Show the Colors window.
shift C

3D Commands

FunctionKeyboard shortcut

Select the 3D transform tool.
Q

Switch 3D transform tool between position-only and universal.,

Switch the 3D transform tool between rotate-only and universal..

Switch the 3D transform tool between scale-only and universal.
/

Set 3D View to Active Camera.
control A

Set 3D View to Perspective.
control P

Set 3D View to next camera.
control C

Reset 3D camera view.
control R

Create 3D Group of the selected objects.
control D

Switch the 3D grid on and off.
shift
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Using the Command Editor
Motion provides a wide variety of menu commands and keyboard shortcuts that let you
control almost every aspect of your project, from playback to displaying windows and
inspectors to working with tools. The Command Editor lets you search or browse the
various commands and keyboard shortcuts in Motion. In addition, the Command Editor
lets you customize keyboard shortcuts so you can streamline the way you work.

This section covers how to modify keyboard shortcuts using the Command Editor.

Use the Command Editor’s search tools to find keyboard commands, view their
descriptions, and preview highlighted key combinations in a visual representation of your
keyboard. You can modify existing shortcuts, create new shortcuts, and save multiple
sets that can be imported and exported for use by others. If you’re more familiar with
keyboard commands from other applications, you can use the Command Editor to
substitute those commands for Motion’s default set.

Motion provides four built-in sets of keyboard shortcuts for the following languages:
English, Japanese, French, and German.

To display the Command Editor in Motion
µ Choose Motion > Commands > Customize.

The Command Editor appears.

Command Set options

Command list Detail areaCommand groups

Search field

Keyboard Highlight 
buttonModifier key buttons
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Command Editor Interface
The upper half of the Command Editor displays a virtual keyboard. The lower half contains
a Command List that sorts menu commands by group and offers a brief description of
each command, along with its associated key combination, if any.

The virtual keyboard is color-coded to help you identify the type of command each key
performs. For example, transport commands, such as Play (Space bar) and Record (A), are
light blue, while alignment commands are pink. The Command Groups window on the
left side of the Command List contains a clickable color key for reference.

Keys that are assigned to shortcuts are marked with a dark gray dot, while unassigned
keys have no additional markings. Several keys are shaded with a hatch pattern, indicating
that they are reserved for system use.

Keys reserved for system 
commands

Keys with assigned 
shortcuts

Unassigned keys

Choosing a Set
By default, Motion uses the Standard Set of commands, with the language choice that
you specified when you set up your computer.

To choose a key command set
Do one of the following:

µ Choose Motion > Commands, then choose a set from the submenu.

µ If the Command Editor is already open, choose a set from the pop-up menu in the
upper-left corner.

Once you choose the command set you want, the keyboard shortcuts in the set become
active in Motion.

Saved sets appear at the 
bottom of the menus.
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Viewing Keyboard Shortcuts by Group
The Command List displays several groupings of commands, organized by Motion menus
as well as types of commands (Alignment, Tools, Transport, Go To, View, and Mark). Click
a group to quickly filter the Command list to display only the commands and keyboard
shortcuts in that group.

Searching for Commands
Use the Search field in the upper-right corner of the Command Editor to quickly locate
a command or keyboard equivalent. You can search by command name, description, or
keyboard shortcut.

To search for a keyboard shortcut
µ In the Command Editor, click in the Search field type and a word that describes the

keyboard shortcut you need.

The Command List immediately displays the search results, listing all commands and key
combinations related to the search term.

You can further narrow your search by choosing a category from the Search field pop-up
menu. The menu options include All, Command, Description, and Key Equivalent.

Note: Do not use the Shift key to capitalize letters when typing in the Search field. The
Search field recognizes the Shift key as a modifier key in a keyboard shortcut.

You can use the Search field in conjunction with the virtual keyboard to highlight keyboard
shortcuts.

To search for and highlight a shortcut on the virtual keyboard
1 Click the Keyboard Highlight button to the left of the Search field.

The keyboard dims.

2 Click in the Search field and begin typing.

Motion filters the Command List as you type and highlights the keys related to your search
term.
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For example, in the image below, the search term “Ripple” returns two keyboard shortcuts
for the Ripple Delete command, and the command keys are highlighted in the virtual
keyboard.

Note: When you turn on the Keyboard Highlight button, only command keys are
highlighted. Modifier keys that may be part of the keyboard shortcut (Command, Shift,
Option, and Control) are not highlighted.

Command keys are 
highlighted on the 
keyboard for easy 
reference.

Filtering the View by Modifier Keys
You can use the Modifier buttons (Command, Shift, Option, and Control) at the top of
the Command Editor to quickly see which keys work in conjunction with the various
modifier keys.

To filter by modifier keys
1 Click one of the four modifier buttons at the top of the Command Editor (or click one of

the modifier keys on the virtual keyboard).

Keys assigned to work in conjunction with the selected modifier key appear marked with
a dark gray dot.

2 If necessary, click another modifier button (or modifier key in the virtual keyboard) to
create a combination.

The virtual keyboard updates to show which keys are assigned to shortcuts that use those
combined modifier keys.

1448 Appendix C Keyboard Shortcuts



Viewing Key and Command Details
The window to the right of the Command List shows additional information about a
selected key in the virtual keyboard or a selected command in the Command List. When
you select a key in the virtual keyboard, this window displays a list of all keyboard shortcuts
associated with that key.

Selected key

All available shortcuts 
that include the selected 
key are displayed here.

When you select a command in the Command List, this window displays a brief description
of the command.

Customizing Keyboard Shortcuts
Customizing shortcuts in the Command Editor is fast and easy. Because the default
Standard Set includes commands for which no shortcut is defined, you may want to apply
a new shortcut to them. Because you cannot modify the Standard Set, you must first
duplicate that set and then customize the new duplicate set.

To duplicate the currently active command set
1 Choose Duplicate from the pop-up menu at the top of the Command Editor.

A dialog appears and prompts you to name the new set.

2 Type a name in the dialog, then click OK.

The new duplicate set is saved and appears as an item at the bottom of both the pop-up
menu and the top-level Motion > Commands menu.

Now that you have a duplicate set of assigned keyboard shortcuts, you can modify the
individual key settings to create new or modified shortcuts.
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To add or modify a key command
1 Using the Search field (or browsing the Command List) of the Command Editor, select

the command to which you want to assign a new shortcut key combination.

2 Using your physical keyboard, press the combination of keys you want to use for the
command (for example, Shift-Option-T, or any other keys).

If the key combination is not already assigned to a command, the virtual keyboard updates
to show the new key assignment. A gray dot appears on a newly assigned key (or keys),
and a color is applied if the command belongs to a color-coded command group.

If the key combination is already assigned to a command, Motion displays the current
setting, and prompts you to confirm the change.

Once you make changes to the command set, you can use several methods to save the
changes.

To save a command set
µ Click the Save button in the lower-right corner of the Command Editor.

If you close the Command Editor with unsaved changes, Motion prompts you to save the
set.

To delete a command set
1 Make sure you are using the set you want to delete, then choose Delete from the pop-up

menu at the top of the Command Editor.

A dialog appears.

2 Click Delete.

The set is removed, and the Standard Set becomes the active set of commands.

Importing and Exporting Command Sets
Once you save a command set, you may want to export it to create a backup or to share
the new set with another user. Exported sets are saved in a file that can be imported back
into Motion at a later time.

To export a set of keyboard shortcuts
1 If necessary, use the pop-up menu to activate the command set you want to export, then

do one of the following:

2 In the Command Editor, choose Export from the pop-up menu.

3 Choose Motion > Commands > Export.

A Save As dialog appears.

4 Navigate to the location where you want to save the exported set, then type a name in
the Save As field.

5 Click OK.
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The file is saved in the location you chose, with the “.commandset” filename extension.

To import a set of shortcuts
1 Do one of the following:

2 In the Command Editor, choose Import from the pop-up menu.

3 Choose Motion > Commands > Import.

An Open dialog appears.

4 Navigate to the location where you have stored a command set file, select it, then click
Open.

The new command set is added to the Motion > Commands submenu and the pop-up
menu in the Command Editor.

If you are already using a set with the same name, a dialog appears and prompts you to
rename the set.
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You can add Motion projects directly to sequences in Final Cut Pro and send Final Cut Pro
sequence clips directly to a new Timeline in Motion.

This appendix covers the following:

• Using Motion with Final Cut Pro (p. 1453)

• Rendering Motion Projects for Use in Final Cut Pro (p. 1458)

• Using Motion Templates in Final Cut Pro (p. 1458)

• Master Templates in Final Cut Pro (p. 1462)

Using Motion with Final Cut Pro
Integration between Motion and Final Cut Pro allows you to:

• Import Motion projects into Final Cut Pro: You can add motion graphics created in Motion
directly to your Final Cut Pro sequence without rendering.

• Update embedded Motion projects in Final Cut Pro: You can immediately see changes
to a Motion project in your Final Cut Pro sequence.

• Send Final Cut Pro clips or sequences to Motion: You can create new Motion projects
based on a selection of clips or a sequence in Final Cut Pro. You can use this feature to
sketch a motion graphics sequence in Final Cut Pro and then refine it in Motion. The
new Motion project can then be embedded in your Final Cut Pro sequence.

Note: Motion can import audio included in a Final Cut Pro project, but audio in a Motion
project does not appear in Final Cut Pro.

Importing a Motion Project into Final Cut Pro
You can import Motion projects into Final Cut Pro to quickly add motion graphics, title
sequences, and animations to your sequence.

To import a Motion project into Final Cut Pro
Do one of the following:

µ Drag the Motion project from the Finder to the Final Cut Pro Browser or Timeline.
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µ Choose File > Import > Files, then select the Motion project in the dialog that appears
and click Choose.

Importing a Motion project into Final Cut Pro creates a Motion clip (also called an embedded
Motion project) that you can edit in the same way as any other clip in your Final Cut Pro
project. A Motion clip in Final Cut Pro is linked to the original Motion project stored on
your hard disk. Motion clips appear in the Final Cut Pro Browser and Timeline with a .motn
extension.

Motion clips can play back in real time, although you may have to choose Unlimited RT
mode to avoid rendering. For more information, see the Final Cut Pro User Manual, available
in Final Cut Pro Help.

Important: In order for a Motion clip to play correctly in Final Cut Pro, all media files (such
as movies and still images) used in the original Motion project must be on the same hard
disk as the Final Cut Pro project.

Making Changes to a Motion Clip in Final Cut Pro
While working in Final Cut Pro, you can quickly make changes to a Motion clip by opening
the clip’s project file in Motion. After you save the Motion project, any changes you made
appear immediately in Final Cut Pro.

Note: This feature requires both Final Cut Pro and Motion to be installed on the same
computer.

To open a Motion project from within Final Cut Pro
Do one of the following:

µ Select the Motion clip, then choose View > Clip in Editor.

µ Control-click a Motion clip, then choose Open in Editor from the shortcut menu.

The Motion project opens in Motion. Once you make changes in Motion and save the
project, Final Cut Pro automatically reconnects the Motion clip to the updated project so
you can see the changes.

If you do not use the View > Clip in Editor or Open in Editor command in Final Cut Pro
to open a Motion project, Final Cut Pro may not automatically reconnect the Motion
project if you resave it. In this case, you will have to manually reconnect the Motion clip
in Final Cut Pro to its original Motion project file.

To reconnect a Motion clip to an updated Motion project
Do one of the following:

µ Initiate the Motion project update from within Final Cut Pro by selecting the Motion clip
and choosing View > Clip in Editor.

This method informs Final Cut Pro that the Motion project may be updated; as a result,
the Motion clip is automatically reconnected when you return from Motion to Final Cut Pro.
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µ Select the Always Reconnect Externally Modified Files option in the Editing tab of the
Final Cut Pro User Preferences window.

This method tells Final Cut Pro to automatically reconnect any modified media and project
files when you switch to another application and then switch back to Final Cut Pro.

Note: The Always Reconnect Externally Modified Files checkbox is active by default in
Final Cut Pro User Preferences.

Restrictions When Working with Motion Clips in Final Cut Pro
When working with Motion projects in Final Cut Pro, keep the following restrictions and
limitations in mind:

• The audio in a Motion project is not imported into Final Cut Pro.

• All video tracks in a Motion project appear as a single layer when imported into
Final Cut Pro as a Motion clip.

• The frame size and duration of the Motion clip are determined by the settings in the
Motion project.

• The Final Cut Pro Media Manager does not manage source media files used by a Motion
clip’s project file. You need to manage your media for Motion projects separately from
your Final Cut Pro media.

Sending Final Cut Pro Clips and Sequences to Motion
Just as you can import Motion projects into Final Cut Pro (where they are embedded as
Motion clips), you can also send standard Final Cut Pro clips and sequences to Motion.
To do this, use the Send To Motion Project command. This command is useful when you
want to:

• Edit a rough motion graphics sequence in Final Cut Pro and then send those clips to
Motion for more complex animation

• Use Final Cut Pro to capture media files for use in Motion

Many of the clip parameters you adjust in Final Cut Pro are retained in the resulting Motion
project.

Selecting Clips or Sequences to Send to Motion
The Send To Motion Project command behaves slightly differently depending on what
you select in Final Cut Pro and where you select it.

• Browser clips: When one or more clips are selected in the Final Cut Pro Browser, the
Send to Motion Project command sends the clip or clips to a new project in Motion;
the Motion Timeline remains empty and the clips appear in the Motion Media tab.

• Sequence in the Browser: When a sequence is selected in the Final Cut Pro Browser, the
Send to Motion Project command creates a new Motion project with a track and clip
layout identical to that of your Final Cut Pro sequence.
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• Clips in a sequence: When one or more clips in a sequence are selected in the
Final Cut Pro Timeline, a new Motion project is created containing only the clips you
selected in your Final Cut Pro Timeline. In Motion, the clips retain the same track layout
as your original selection. If you select the Embed Motion Content checkbox in the
Export Selection to Motion Project dialog the clips in your Final Cut Pro sequence will
be replaced with a single Motion project file. For more about this option, see About
the Embed Motion Content Option.

Important: Sending a Motion clip (as opposed to a Final Cut Pro clip) by itself back to
Motion results in an empty project. If you want to open a Motion clip in Motion, use the
Open in Editor command instead. For more information about working with imported
Motion projects, see Making Changes to a Motion Clip in Final Cut Pro.

To send clips or sequences from Final Cut Pro to a new Motion project
1 In Final Cut Pro, do one of the following:

• Select one or more clips in the Browser.

• Select a sequence in the Browser.

• Select one or more clips in the Timeline.

2 Choose File > Send To > Motion Project.

3 In the dialog that appears, do the following:

• Choose an export location and enter a name for the new Motion project.

• If you want the new Motion project to open immediately in Motion, select the Launch
Motion checkbox.

• If you selected sequence clips in the Timeline, select the Embed Motion Content
checkbox to replace the selected sequence clips in Final Cut Pro with the Motion project
you just created (an embedded Motion clip with the .motn extension). For more
information, see Sending Selected Sequence Clips from Final Cut Pro to Motion.

4 Click Save.

A new Motion project is created. If you selected the Launch Motion option, the new
project opens in Motion. For more information about the results of sending different
kinds of selections to Motion, see the following sections.

Sending Browser Clips from Final Cut Pro to Motion
When you send Browser clips from Final Cut Pro to Motion, a new Motion project is created
with an empty Timeline, and the media from each selected Final Cut Pro clip is displayed
in the Media tab of Motion. Use this method to quickly import media from Final Cut Pro
into an empty Motion project.
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Sending a Browser Sequence from Final Cut Pro to Motion
When you send a sequence (selected in the Browser) from Final Cut Pro to Motion, each
clip in that sequence is placed in a separate layer in a new Motion project (in the Layers
tab and Timeline). Use this method to edit one or more layers in Final Cut Pro and then
add effects, animation, or text in Motion.

Important: Sending a sequence that contains Motion clips from Final Cut Pro to Motion
causes gaps to appear in the Motion Timeline where the Motion clips appeared in the
sequence.

Sending Selected Sequence Clips from Final Cut Pro to Motion
When you send multiple sequence clips (selected in the Timeline) from Final Cut Pro to
Motion, each selected clip in that sequence is placed in a separate layer in a new Motion
project. Noncontiguous selections are allowed. For example, if you selected sequence
clips A, B, and D in Final Cut Pro, but you skipped clip C, the Motion Timeline would also
contain media from clips A, B, and D with a gap where clip C was located.

When you send sequence clips to Motion, several things happen:

• Final Cut Pro automatically creates a new sequence containing only the clips you
selected. You can verify that there is a new sequence by looking in the Browser.

• The contents of the new sequence are used to create a new Motion project.

• If you choose the Embed Motion Content option in the Export Selection to Motion
Project dialog, the new Motion project is imported back into Final Cut Pro as an
embedded Motion clip (with a .motn extension) in the Browser. The selected sequence
clips are replaced by the new Motion clip.

About the Embed Motion Content Option
The Embed Motion Content option is available only when you send selected sequence
clips from the Final Cut Pro Timeline to a new Motion project. This option imports the
new Motion project back into Final Cut Pro and replaces your selected sequence clips. In
effect, it converts your selection of sequence clips into a Motion clip in a single step. For
more information about working with imported Motion projects, see Making Changes
to a Motion Clip in Final Cut Pro.

If you don’t select the Embed Motion Content checkbox, the selected sequence clips are
still copied into a new sequence in the Browser, but they are not replaced. Furthermore,
the new Motion project is not imported into Final Cut Pro, so your original sequence
remains unchanged.

What Properties Are Exported to Motion?
When you send sequence clips from the Final Cut Pro Timeline to Motion, the following
properties are retained in the exported Motion project.
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Exported properties

• Clips, with In and Out points, placed on the correct Timeline
tracks and positions

• Clip and sequence markers (called object and project markers in
Motion)

• Almost all attributes in a clip’s Motion tab, including Basic Motion,
Crop, Distort, Opacity, Drop Shadow, and Time Remap. Any linear
and smooth Bezier keyframes are also included.

• Composite (blend) modes
• The SmoothCam filter. If applied, the filter is converted to the

Stabilize behavior with the Smooth method enabled in Motion.

Video

• Media
• Markers
• Levels and keyframes

Audio1

1 The audio exported to Motion is not imported when you bring the Motion project back into Final Cut Pro. The audio
is only intended to be used in Motion for playback and markers. For this reason, make sure that you retain the
original audio clips in Final Cut Pro.

Note: With the exception of the SmoothCam filter, Final Cut Pro does not send filters
applied to clips. Also, transitions and generators are not sent.

Rendering Motion Projects for Use in Final Cut Pro
If necessary, you can export a Motion project to a QuickTime movie and import it into
Final Cut Pro. This method is less flexible than importing Motion projects directly into
Final Cut Pro, so you should usually avoid this option. When you export the Motion project,
choose the Animation codec for lossless compression and to include an 8-bit alpha
channel. The alpha channel makes it easy to composite the QuickTime movie with your
footage in Final Cut Pro.

Important: When importing a QuickTime movie that has been exported from Motion,
set the alpha type for the sequence clip in Final Cut Pro to black.

Using Motion Templates in Final Cut Pro
In Motion, templates are useful when you are creating a number of projects that share
elements like text or media. You can use a Motion template as a starting point for project
customization. A Motion template used in Final Cut Pro can be used in any number of
projects and sequences, and each instance can be customized. In addition, you can make
changes to the source Motion template file, and have the changes propagate to all the
projects and sequences in Final Cut Pro that use that project.

Template integration between Motion and Final Cut Pro allows you to:

• Create templates in Motion for use in Final Cut Pro.

You can create templates in Motion that can be used directly in Final Cut Pro.
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• Customize master templates in Final Cut Pro.

You can edit master templates into sequences and then customize parameters such
as text and video within drop zones. You can globally modify the look of all template
clips in your project by editing the original Motion template file.

Terminology for Master Templates
The following definitions provide some shorthand for discussing the behavior of
sequences containing clips derived from master templates:

• Motion template file: A template file created and saved in Motion. This term refers to
the template file stored on disk.

• Master template: A Motion template file as it appears in Final Cut Pro. You can view
master templates in the Viewer and edit them into a sequence, creating copies called
template clips.

• Template clip: An instance of a master template edited into a sequence or copied into
the Browser. Just as normal Final Cut Pro clips refer to QuickTime media files on disk,
a template clip refers to a Motion template file on disk. When a Motion template file
is changed and saved in Motion, any template clips that refer to the template file are
updated.

• Template parameters: Special template clip parameters that you can customize directly
in Final Cut Pro using the Controls tab of the Viewer. For example, you can modify
text or video content in a template clip.

Creating a Template in Motion for Use in Final Cut Pro
You can create templates in Motion that automatically appear in the Effects tab of
Final Cut Pro in the Master Templates section. For more detailed information on working
with templates in Motion, see Customizing and Creating New Templates. There are two
types of objects in a Motion template that can be edited in Final Cut Pro:

• Drop zone media: You can replace clips or stills in drop zones in Final Cut Pro.

• Text: You can edit the content, Text Size, and Text Tracking of text in template clips in
Final Cut Pro.

There are templates that are installed when Motion is installed. These templates already
appear in the Effects tab in Final Cut Pro, in the Master Templates bin.
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Considerations When Creating Motion Templates for Final Cut Pro
In preparation for creating a project for use as a template, you should keep the following
considerations in mind:

• To get the best quality from your template, choose the same aspect ratio, resolution,
and frame rate as your destination Final Cut Pro sequence when creating the template
in Motion. For more information on Motion project settings, see Editing Project
Properties.

• By default, drop zones are named by the media used to create the drop zone, and text
objects are named by the content of the text therein. If your project contains a large
number of drop zones and text, consider renaming these objects in a way that will help
you easily identify the ones you wish to edit in Final Cut Pro. For more information on
naming objects in Motion, see Renaming Groups.

• Position text visually as well as with the desired Alignment parameter in the Layout
pane of the Text Inspector (Left, Center, or Right), in order to retain the expected visual
alignment when the text objects are edited in Final Cut Pro. For more information on
text, see Adding Text.

• If adding dissolves or other transitions to a template clip in Final Cut Pro, be sure to
allow for this in the template design, by adding a sufficient number of extra frames at
the beginning or end of the template.

• Final Cut Pro always uses the Best scaling option (in the Video Processing tab) when
rendering Motion projects and templates.

• To retain proper text formatting in Final Cut Pro, do not mix different text sizes, fonts,
or styles within a single text object.

Important: In order for your template to be loaded into Final Cut Pro as a template, the
Motion project must be saved as a template.

Creating Drop Zones in Motion
Media contained within drop zones are the only media objects that can be replaced in
master templates in Final Cut Pro.

Drop zones provide a way for template users to intuitively and quickly replace footage
in a template. There are two ways to create drop zones. The first is to create a drop zone
from scratch, and the second is to convert an existing object into a drop zone.

To create a new drop zone in Motion
Do one of the following:

µ Choose Object > New Drop Zone (or press Command-Shift-D)

µ Select an existing object in the canvas, then select the Drop Zone checkbox in the Image
tab of the Inspector.
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To show the drop zone controls
µ Select the object with the applied drop zone, and click the Image tab in the Inspector.

For more information on using drop zones, see Using Drop Zones.

Creating Text in Motion
The following properties of any text you create in a Motion template can be edited in
Final Cut Pro:

• Text Size

• Text Tracking

• Content

If you wish to create text in Motion that cannot be edited in Final Cut Pro, deselect the
Publish To FCP checkbox in the Text tab of the Inspector. For more information about
text formatting and properties, see Editing Text Format.

Saving Templates in Motion for Use in Final Cut Pro
Templates are simply Motion files that are saved with certain parameters and options
enabled. You can create a new template or use an existing Motion template.

To save a Motion project as a template
1 Choose File > Save as Template.

A save dialog appears.

Note: It is recommended that you create a new custom theme in which to save your own
templates.

2 If you want to create a new theme category for your template, click New Theme, type a
name in the New Theme dialog, then click Create.

3 In the save dialog, type a name for the template.

4 In the Theme pop-up menu, choose a theme category in which to store your template.

5 Choose a template format from the Format pop-up menu.

6 If you want your template to play a preview when it appears in the Template Browser,
select Create QuickTime Preview.
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7 Click Save.

Your new template is saved into the theme category you selected. Customized templates
are saved to /Users/username/Library/Application
Support/Final Cut Studio/Motion/Templates/ in a folder that corresponds to the name of
the theme you’ve selected.

If you wish to manually copy projects from one system to another, copy them to the same
location.

Important: Templates do not appear in the Final Cut Pro Template Browser unless the
templates are copied to a theme subfolder in /Users/username/Library/Application
Support/Final Cut Studio/Motion/Templates/.

When you save a template in Motion, the template immediately appears in the Master
Templates bin of the Final Cut Pro Effects tab in a bin corresponding to the name of the
theme in which you saved the template in Motion.

Important: Only projects that are saved as templates appear as master templates in
Final Cut Pro.

Master Templates in Final Cut Pro
Master templates can be used in any number of sequences within any number of
Final Cut Pro projects. If the Motion template is edited in Motion, any template clip that
refers to that Motion template file is updated.

Adding Master Templates to a Sequence
You can add master templates to your sequence from four different locations within
Final Cut Pro. When you edit a master template into a Final Cut Pro sequence, a template
clip is created in the sequence. Each template clip can be adjusted independently, so you
can uniquely customize the text and media parameters of each template clip in a sequence.
Try out the following methods to see which one works best for you.

• Master Template Browser: Choose Sequence > Add Master Template to open the Master
Template Browser. From this window, you can perform an overwrite, insert, or
superimpose edit with a master template directly into your sequence. This method
provides the most options for editing a template in your sequence and allows you to
see a preview of all the installed templates.

• Master Templates bin in the Effects tab of the Browser: Double-click a master template
to open it in the Viewer or drag a master template to the current sequence in the
Canvas or Timeline. This is the quickest way to add multiple master templates to your
sequence in one drag-and-drop operation.
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• Generator pop-up menu in the Viewer: In the Viewer, choose Master Template from the
Generator pop-up menu, then choose a template from the submenu. This method
opens a master template in the Viewer, which you can then edit into your sequence.

• Master Templates submenu within the Effects menu: Choose Effects > Master Templates
and then choose a master template. The template opens in the Viewer, which you can
then edit into your sequence.

Working with Template Clips in Final Cut Pro
Because templates saved in Motion automatically appear in the Effects tab in Final Cut Pro,
there is no need to specifically import templates into Final Cut Pro. You can edit a template
clip just like any other clip in your project.

To open a master template or template clip in the Viewer
Do one of the following:

µ Select the master template, then choose View > Master Template.

µ Control-click a master template and then choose Open in Viewer from the shortcut menu.

µ Double-click a master template.

The master template opens in the Viewer.

You may edit certain properties of template clips in the Controls tab of the Viewer.

To replace the media in a drop zone
1 Open the clip containing media you wish to replace in the Viewer.

2 Select the Controls tab.

3 Find the media you wish to replace.

4 Drag the new clip into the image well in the Parameters column.

The new media replaces what was previously in the drop zone.

To change the position of a drop zone
1 Move the playhead to the clip containing drop zone you wish to move.

2 Double-click the clip in the Timeline.

3 In the Viewer, select the Controls tab.

4 Find the media you wish to move.

5 Click the point control for the drop zone you want to reposition.

In the Canvas, a red center crosshair appears.

6 Drag the crosshair to reposition the selected drop zone.

To edit the text in a text object
1 Open the clip containing text you wish to edit in the Viewer.

2 Select the Controls tab.
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3 Find the text object you wish to edit.

4 Edit the text in the Parameters tab.

To change the size or tracking of a text object
1 Open the clip containing media you wish to exchange in the Viewer.

2 Select the Controls tab.

3 Find the text object you wish to exchange.

4 Use the slider or value field to set a new Text Size or Text Tracking value.

Making Changes to a Master Template in Final Cut Pro
While working in Final Cut Pro, you can quickly make changes to template clips in Motion
by opening the master template in Motion. After you save the Motion template, any
changes you made appear immediately in Final Cut Pro.

Important: When you make changes to a master template, you are editing the master
template itself, and not template clips already in Final Cut Pro sequences. Any drop zone
media changes already made in template clips remain intact. Customized text content
remains the same, but updates made to the text font or style appear in template clips.

To open a master template from within Final Cut Pro
Do one of the following:

µ Select the master template and then choose View > Master Template in Editor.

µ Control-click a master template and then choose Open in Editor from the shortcut menu.

The master template opens in Motion. Once you make changes in Motion and save the
project, Final Cut Pro automatically reconnects the master template to the updated project
so you can see the changes.

If you do not use the Open in Editor command in Final Cut Pro to open a master template,
Final Cut Pro may not automatically reconnect the master template if you resave it. In
this case, you will have to manually reconnect the master template in Final Cut Pro to its
project file.

To reconnect a master template to an updated Motion project
µ Initiate the master template update from within Final Cut Pro by selecting the master

template and choosing View > Clip in Editor.

This method informs Final Cut Pro that the master template may be updated, so it is
automatically reconnected the next time you switch to Final Cut Pro.

µ Select the Always Reconnect Externally Modified Files option in the Editing tab of the
Final Cut Pro User Preferences window.

This method tells Final Cut Pro to automatically reconnect any modified media and project
files when you switch to another application and then switch back to Final Cut Pro.
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If you have used a master template in a number of sequences, and you wish to make a
change to the master template that is isolated to a single instance—and not universally
replace the master template—you can make a copy of the master template.

To open a copy of a master template from within Final Cut Pro
Do one of the following:

µ Select the master template and then choose View > Copy of Master Template in Editor.

µ Control-click a master template and then choose Open Copy in Editor from the shortcut
menu.

A copy of the master template opens in Motion. Once you make changes in Motion and
save the project, Final Cut Pro automatically reconnects that copy of the master template
to the updated project so you can see the changes.

Using Float Precision with Motion Content in Final Cut Pro
When embedding Motion content in Final Cut Pro, you can take advantage of the
rendering benefits of Motion’s 16- or 32-bit float rendering modes. To do this, go to the
Video Processing tab of Sequence Settings in Final Cut Pro and enable “Render all YUV
material in high-precision YUV.” Once this is set, Final Cut Pro forces Motion elements in
the sequence to render in 32-bit mode.
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In Motion 4, Apple made significant changes to the text behaviors. The Sequence Text
behavior was revised, and the Crawl Left, Crawl Right, Scroll Down, and Scroll Up text
animation behaviors were replaced with a new, single behavior called Scroll Text. When
projects created in earlier versions of Motion that contain the older Sequence Text behavior
or a Crawl Left, Crawl Right, Scroll Down, or Scroll Up behavior (from the Text Animation
category) are opened in Motion 4, the older versions of the behaviors appear.

Because the Text Sequence presets are based on the Sequence Text behavior, the presets
were also revised. When projects created in earlier versions of Motion that contain the
old versions of the Text Sequence preset behaviors are opened in Motion 4, the older
preset behaviors also appear.

This appendix details the settings and options for these behaviors, and the workflow
associated with the old Sequence Text behavior.

This appendix covers the following:

• Using the Sequence Text Behavior (Motion 3.0.2 and Earlier) (p. 1467)

• Sequence Text Controls (p. 1472)

• Using the Sequence Text Custom Behavior Option (Motion 3.0.2 and Earlier) (p. 1477)

• Preset Text Sequence Behaviors (Motion 3.0.2 and Earlier) (p. 1479)

• Using the Crawl and Scroll Behaviors (Motion 3.0.2 and Earlier) (p. 1486)

Using the Sequence Text Behavior (Motion 3.0.2 and Earlier)
The Sequence Text behavior allows you to select and apply text Format and Style
parameters, such as Position, Color, Scale, or Opacity, and animate those parameters in
sequence through the text characters. For example, you can create a sequence in which
the text characters fall vertically into place as they scale down, fade in, and rotate. The
sequence works by moving a selection area, represented by small white lines, through
the characters of the text. You can set the sequence to repeat, change direction, or to
randomize. The location of the selection can also be keyframed to customize the direction
of the sequence. For example, you can animate the selection to move through half of
the text, return to the beginning of the text, then move to the end of the text.
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Important: The following description is for the Sequence Text behavior that shipped in
Motion versions 3.0.2 and earlier. Motion 4 contains a revised Sequence Text behavior.

Once you have added and modified the Sequence Text behavior, you can save the behavior
to the Library. For information on saving a modified behavior to the Library, see Saving
and Sharing Custom Behaviors.

To assign parameters to the Sequence Text behavior
1 Apply the Sequence Text behavior (from the Text Animation subcategory) to the text.

In the Canvas, the text bounding box is replaced with the sequence bounding box.

Sequence bounding box

The Sequence Text HUD also appears and the behavior is added to the text in the Layers
tab and Timeline.

Important: Before any animation can occur, you must explicitly add at least one parameter
to the behavior from within the Inspector. Until a parameter is added, adjustments made
in the HUD have no effect.

2 With the Sequence Text behavior selected, display the Behaviors tab in the Inspector.

1468 Appendix E Obsolete Text Behaviors



The upper area of the Sequence Text controls contains the Add and Remove pop-up
menus, which are used to select parameters to add to the behavior, or to remove
parameters. The second group of parameters are the Sequence controls, which include
options for setting the direction of the animation, whether the animation is applied per
character, per word, or per text layer, and so on.

Sequence controls

Add or Remove
parameters

3 In the Parameter row, click the Add pop-up menu, choose Format, then choose Scale.

The Scale parameter is added to the behavior and is set to 100% by default (which
represents the original size of the text).

4 Set Scale to the largest (or smallest) value you want the text to become in your animation.

In this example, the Scale value is set to 350%. To enter separate values for the X and Y
scale, click the Scale disclosure triangle.
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Note: Often, you can enter values larger than a parameter’s slider allows by typing in the
value slider.

5 Click the Play button (or press the Space bar).

The first character begins at 100%, scales up to 350%, and then scales back down to 100%.
The animation sequence moves through the text.

Small white lines represent selection.

As the animation sequences through the text, small white lines travel with the animation.
These lines represent selection—whatever is in between the two solid white lines is the
current selection, and receives the full effect of the animation. The soft line represents
the selection falloff, and “leads” the next character into the animation.

6 Add the Rotation parameter to the Sequence Text behavior by choosing Format > Rotation
from the Add pop-up menu (in the Parameter row of the Behaviors tab).
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7 Set Rotation to the largest (or smallest) value you want the text to rotate in your animation.
In this example, Rotation is set to 90 degrees.

The first character begins at 0 degrees, rotates to 90 degrees, and then rotates back to
0 degrees.

The animation—which begins at the default value for any added parameter, animates
to the value you specify, then resolves back to the default value—cycles completely
through each character because the Select parameter is set to Character by default. When
Select is set to Word, each word in the text scales up and down as a single character.

Select parameter

8 Click the Select pop-up menu, then choose All.

All of the text characters begin at 350% scale and 90 degrees rotation simultaneously.
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Note: Make sure that the Map Animation parameter is set to To Entire Object.

9 In the Parameter row, click the Add pop-up menu, choose Face, then choose Opacity.

Set the Opacity to the lowest value you want to use in your animation. In this example,
Opacity is set to 0% so that the text characters begin completely transparent and fade
in to become opaque.

To create a softer transition between each character, you can adjust the Spread parameter.

To adjust the Spread parameter
µ In the Behaviors tab, drag the Spread slider (or type a number in the value slider).

This example uses a Spread value of 4.

Sequence Text Controls
Use the Sequence controls to repeat the animation over the duration of the text, to
randomize the order in which the effect is applied to the text characters, to change the
direction of the animation, to “soften” the effect between characters, and so on.

Parameter: Use the Add and Remove pop-up menus to add and remove text format and
style parameters to the sequence.

Traversal: Use this pop-up menu to set the action of the sequence behavior. There are
six options:

• Ramp: Moves the selection from one end of the text to the other at a constant speed.
The sequence moves in the direction specified in the Direction pop-up menu.
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• Ping Pong: Moves the selection back and forth from one end of the text to the other.
The sequence moves in the direction specified in the Direction pop-up menu. Loops
must be set to a value greater than 1 for the sequence to Ping Pong.

• Ease In: The sequence animation (the movement of the selection bars) begins slowly
and increases to normal speed as it moves through the text.

• Ease Out: The sequence animation begins at normal speed and slows toward the end
of the text.

• Ease In/Out: The sequence animation begins slowly, increases to normal speed as it
moves toward the middle of the duration of the text, and slows as it reaches the end
of the text.

• Custom: Allows you to keyframe how the selection (the animation) moves through the
text. When Custom is selected from the Traversal pop-up menu, the Location parameter
replaces the Loops parameter. For more information on using Custom, see the Custom
section in Sequence Text Controls.

Location: If Custom is selected in the Traversal menu, this parameter is available. Defines
the location of the text where the animation is in effect.

Loops: Use the slider or value slider to set the number of times the animation sequences
through the text layer over its duration.

Note: Loops is not available when the Traversal parameter is set to Custom.

Random: Select this checkbox to randomize the selection of the text sequence. For
example, a text sequence (using the Scale parameter) set to Ramp scales the text characters
from one end of the text to the other. When Random is selected, the characters are scaled
in a random order.

Sequence (Scale) moves smoothly through the 
text characters.

Sequence with Random turned on randomly 
scales the text characters.

If the Behavior parameter is set to Custom and there is a keyframed animation using the
Location parameter, Random respects the keyframe values and randomizes the effect
within the values set by the keyframes.

Note: When selected, Random overrides the Direction parameter.

1473Appendix E Obsolete Text Behaviors



Random Seed: When you first enable Random, an initial random “seed” is created. If you
are not happy with the randomness of the character selection when you first select the
Random checkbox, click Generate or enter a value in the field. This creates a new random
seed which changes the way the characters are selected. The random variation in the
text selection is based on the random seed number displayed in the Generate field.

Note: Generate has no effect unless the Random checkbox is selected.

Direction: Sets the direction of the sequence through the text to travel Left to Right
(default) or Right to Left.

Select: A pop-up menu that specifies how the values set in the parameters (for example,
Opacity set to 0%) are applied to the text. The choices include Character (default), Word,
Line, All, and Custom.

• Character: Selects single characters of text to be affected by the values set in the applied
parameters.

• Word: Selects the separate words of text to be affected by the values set in the applied
parameters.

• Line: Selects the separate line of text to be affected by the values set in the applied
parameters.

• All: Selects all characters of text to be affected by the values set in the applied
parameters.

• Custom: Allows you to offset the start and end points of the selection (based on the
location of the selection).

When Select is set to 
Custom, the Start and 
End parameters become 
available.
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Spread: Controls the amount of falloff of the selection. To create a softer transition
between each character, increase the Spread value.

Y Position parameter sequenced with
Spread set to 0

Y Position parameter sequenced with
Spread set to 4
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Map Animation: The Map Animation pop-up sets the timing of the animation to either
To Entire Object or To Selection. In a basic example, the Scale parameter is added to the
Sequence Text behavior. Next, the Scale parameter is keyframed to animate from 100%
to 250% over 10 seconds. With the given example, use the following guidelines to
understand the difference between the two Map Animation options.

Original text with Sequence behavior applied 
(before animation begins)

• To Entire Object (does not require a keyframed animation): Leaves the original animation
timing of the sequence across the entire text layer untouched, and the selection follows
the animation at its current point in time. Using the above example, in which Scale
animates from 100% to 250% over 10 seconds, the first character in the text grows
slightly and returns to its original value, the second character grows a little more, the
third a little more, and so on until finally the last character grows to the full 250% value.
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• To Selection (requires a keyframed animation): Changes the timing of the original
animation to “fit” within the selection. Each selection (by character, word, line, and so
on) goes through the entire source animation as the selection moves across the text.
Using the same 100 to 250% Scale animation example, the first character grows from
100% to 250% and holds at 250%, the second character grows from 100% to 250% and
holds at 250%, and so on, until all characters have completed the animation.

Using the Sequence Text Custom Behavior Option (Motion 3.0.2
and Earlier)
When Traversal is set to Custom, you can create location keyframes to specify where the
effect of the sequence is at any given time.

To use the Custom Traversal parameter
1 Once the Sequence Text behavior is applied to the text, add the format or style parameters

that you want to include in the sequence.

Sequence behavior applied to text prior
to animation

2 Set the values for the added parameters.
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In this example, the Scale parameter is added and the Y scale value set to 25%. For more
information on adding parameters to the Sequence Text behavior, see the steps in Using
the Sequence Text Behavior (Motion 3.0.2 and Earlier).

3 Choose Custom from the Traversal pop-up menu.

In the Canvas, the first few characters are selected by default, and are affected by the
Scale value.

In the Behaviors Inspector, the Location parameter becomes available.

Location parameter

4 Enable Record (press A).

5 At the frame where you want to begin the animation, drag the Location slider (or use the
value slider) to set where the sequence begins.

As you drag the slider, the selection bars move through the text characters. Values less
than 0% select toward the left of the text (regardless of where the anchor point is); values
greater than 100% select from the beginning of the text toward the right.
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In the Inspector, a keyframe is added to the Location parameter.

The keyframe icon 
indicates the parameter 
is animated.

6 Go to the next frame where you want to set a keyframe, and move the Location slider.

7 Repeat step 6 until you have created all of your keyframes.

8 Play the project (press the Space bar).

The selection moves through the text based on its keyframed locations.

Preset Text Sequence Behaviors (Motion 3.0.2 and Earlier)
The Text Sequence behavior subcategory includes the 3D Move, Basic, Fade, Glow,
Miscellaneous, Move and Zoom Text behavior groups. Although all of the behaviors in
these groups are predefined animations, the parameter values can be modified, and other
parameters can be added or removed. For example, the Blur Fade In behavior (from the
Fade group) automatically animates the text Blur and Opacity values by default. However,
you can add a parameter, such as Scale, to the behavior.

All of the sequence behaviors are variations on the Sequence Text behavior in the Text
Animation subcategory. Although the Text Sequence behaviors are all presets—the
parameters are already selected and animated—you can still add, remove, or modify any
parameter that is available to the Sequence Text behavior. For more information on the
Sequence Text behavior, see Using the Sequence Text Behavior (Motion 3.0.2 and Earlier).

As with all behaviors, you can save a modified behavior to the Library as your own custom
behavior. For more information, see Saving a Modified Text Behavior to the Library.

1479Appendix E Obsolete Text Behaviors



The Text Sequence behaviors are applied to text layers in the same manner as all other
behaviors. However, there is one big difference between the Text Sequence behaviors
and all other behaviors in Motion: Once added to text, the Text Sequence behaviors do
not last the duration of the text. This is because usually—to achieve the desired preset
effect—you want the animation to complete in a shorter period of time than over the
duration of the text. The default duration of the behavior can be modified to slow down
or speed up the effect of the animation.

Like the Text Animation and other behavior subcategories, clicking a behavior in the
Library stack plays the animation in the Preview area.

Working with a Preset Text Sequence Behavior: Drop In From Left
(Motion 3.0.2 and Earlier)
In this section, the Drop In From Left behavior (from the Move group) is used to illustrate
working with the Text Sequence behaviors. In general, the guidelines for modifying the
Drop In From Left behavior also apply to the other sequence behaviors.

Original text prior to application of Text 
Sequence behavior

Note: Because the sequence behaviors are preset variations of the Sequence Text behavior
(in the Text Animation subcategory), the guidelines for modifying the Sequence Text
behavior also apply to the Text Sequence behaviors.

Applying the Drop In From Left Behavior
The Drop In From Left behavior creates an animation in which the text characters fade
and drop in vertically from left to right to land in their original position. The parameters
included in the behavior are Opacity and Position. The following steps begin at the first
frame of the text.

To use the Drop In From Left behavior
1 Apply the Drop In From Left behavior (from the Text Sequence subcategory) to the text.
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Because the behavior creates an animation in which the text starts above its original
position and drops in, the behavior selection box moves up in the Canvas. Also, the
selection bar is located at the left edge of the box because the animation starts at the
leftmost text character. This appears and displays the projected motion of the text.

Behavior selection box

Once applied, the Drop In From Left behavior appears in the Layers tab and Timeline.

The HUD also appears. Remember that because the sequence behaviors are all preset
variations on the Sequence Text behavior, the Drop In From Left HUD parameters are
identical to the parameters in the Sequence Text behavior (in the Text Animation
subcategory).
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As with the Sequence Text behavior, the specific text parameters that the behavior uses
to create the animation are listed in the Inspector. Because the Drop In From Left behavior
uses the Opacity (from the Face controls) and Position (from the Format controls)
parameters, those parameters are listed in the Inspector.

Also, because you can apply sequence behaviors to text with applied styles (such as Glow
or a Library text style), all of the Style parameters also appear in the Text Sequence
behavior parameters. Using the Drop In From Left behavior as an example, if the Glow
and Outline are enabled for the text to which the behavior is applied, the Glow and
Outline are also affected by the Opacity preset.

Position parameter
(set to 200 on Y axis)

Opacity parameter
(set to 0%)

Other Style parameters

Sequence controls 
(common to all sequence 
behaviors)

2 Click Play (or press the Space bar).

From left to right, the text characters fade and drop in and land in their original position.
As the text animates, the selection box expands to encompass the text characters.
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In the Inspector, notice the Position parameter is automatically included in the behavior
parameters. This is because the Drop In From Left behavior animates the text characters
to drop in one at a time (by default). The value of the Y Position determines the furthest
vertical point from the original position of the text. The default Y Position value is 200,
which means the text animation begins 200 points above the original position of the
text. To change the initial starting position of the text, enter a different number in the
Position parameter value sliders.

In the following image, the Y Position value is set to 100, so the text falls a shorter distance
(than the default 200 pixels). A value of 100 is also set in the X Position value, so the text
falls at an angle rather than vertically.

Because the Drop In From Left behavior animates the opacity of the characters of text,
the Opacity parameter is included in the behavior parameters. The Opacity value
determines the most transparent point in the text animation. The default Opacity value
is 0%, which means the text animation begins completely transparent and ends at the
Opacity value of the original text. To change transparency of the text, enter a different
number in the Opacity parameter value field.

Note: You can set different Opacity values for the different text style parameters (Outline,
Glow, and Drop Shadow).

1483Appendix E Obsolete Text Behaviors



Changing the Speed of Text Sequence Behaviors
With the Drop In From Left behavior selected, notice that the duration of the behavior is
much shorter than the duration of the text layer to which it is applied. You can see this
in the mini-Timeline or the Timeline. By default, the duration of a Text Sequence behavior
is 60 frames.

Like the Type On behavior (in the Text Animation subcategory), you slow down or speed
up the animation by changing the duration of the behavior.

To slow the sequence animation
1 Select the sequence behavior.

2 Do one of the following:

• In the mini-Timeline or Timeline, click the right end of the behavior bar and drag toward
the right (extend the behavior) to the frame where you want the animation to end.

• Go to the frame where you want to set the new Out point, then choose Mark > Mark
Out (or press O).

Note: Conversely, you can speed up the animation by shortening the duration of the
behavior.

Adding or Removing Text Sequence Behavior Parameters
Although the Text Sequence behaviors include predetermined parameters, you can add
and remove parameters. Parameters are removed and added in the same manner as
adding parameters to the Sequence Text (Text Animation) behavior—using the Parameter
Add and Remove pop-up menus. The following example continues with the Drop In From
Left behavior to illustrate adding parameters to a Text Sequence behavior.

To add a parameter to a sequence behavior
1 Select the sequence behavior to which you want to add a new parameter.
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2 In the Parameter row, choose a parameter from the Add pop-up menu.

The chosen parameter is added to the sequence behavior.

Scale parameter added 
to the Drop In From Left 
behavior

3 Set a value in the new parameter (Scale). In this example, the Scale value is set to 150%.
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In addition to the text dropping and fading in, the text Scale value begins at 150% scale
and changes to 100% as the characters land in place.

4 To remove a parameter, choose a parameter from the Remove pop-up menu.

The chosen parameter is removed from the sequence behavior.

Using the Crawl and Scroll Behaviors (Motion 3.0.2 and Earlier)
In this section, the Crawl Left behavior is used to illustrate working with the Text Animation
behaviors. The guidelines for modifying the Crawl Left behavior also apply to the Crawl
Right, Scroll Down, and Scroll Up behaviors.

The Crawl Left behavior scrolls the text to the left across the Canvas.

To use the Crawl Left behavior
1 Apply the Crawl Left behavior (from the Text Animation subcategory) to the text.

The behavior animation path appears and displays the projected motion of the text. The
animation path extends from the anchor point of the text. For example, if the alignment
of the text in the following image was set to Center, the animation path would extend
from the anchor point at the center of the text.

Note: To show and hide animation paths, use the View pop-up menu in the upper-right
corner of the main window (above the Canvas).

2 Click Play (or press Space bar).

The text moves horizontally across the Canvas over the duration of the text to which it
is applied.

Crawl Left and Crawl Right Controls (Motion 3.0.2 and Earlier)
Use the parameters in the Crawl Right or Crawl Left behavior tabs in the Inspector to
modify the crawl animation.
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Rate: Increases or decreases the rate of the crawl. By default, Rate is set to 10 (pixels per
second). A higher rate increases the speed of the crawl, so the text travels a greater
distance over time; a lower rate slows the crawl.

Note: Although the Rate slider value is limited to 100, you can enter a higher value in the
value slider.

Position Offset: Offsets the start position of the text. By default, the crawl animation
begins at the original position of the text. To move the text further to the right at the
start of the animation, enter a higher number in the Position Offset field. For example,
to move the text 80 pixels to the right, drag the Position Offset slider to 80 or enter 80
in the value slider.

Note: Although the slider value is limited to 100, you can enter a higher value in the
Offset value slider.

End Offset: By default, the text crawls to the end of the duration of the text. To stop the
crawl 60 frames from the end of the text layer (or project), for example, drag the End
Offset slider to 60 or enter 60 in the value slider.

Note: Although the slider value is limited to 100, you can enter a higher value in the End
Offset value slider.

Scroll Up and Scroll Down Controls (Motion 3.0.2 and Earlier)
Use the parameters in the Scroll Up or Scroll Down behavior tabs in the Inspector to
modify the scrolling animation.

Rate: Increases or decreases the rate of the scroll. By default, Rate is set to 10 (pixels per
second). A higher rate increases the speed of the scroll, so the text travels a greater
distance over time; a lower rate slows the scroll.

Note: Although the Rate slider value is limited to 100, you can enter a higher value in the
value slider.

Position Offset: Offsets the start position of the text. By default, the scroll animation
begins at the original position of the text.

Note: Although the slider value is limited to 100, you can enter a higher value in the
Offset value slider.

End Offset: By default, the text scrolls to the end of the duration of the text. To stop the
scroll 60 frames from the end of the text layer (or project), for example, drag the End
Offset slider to 60 or enter 60 in the value slider.

Note: Although the slider value is limited to 100, you can enter a higher value in the End
Offset value slider.
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If you use a Wacom tablet and pen with your computer system, you can use gestures to
navigate within Motion and to perform tasks such as editing, copying, pasting, and so
on. Gestures are continuous, uninterrupted patterns that are drawn in the Motion user
interface (using your tablet).

Note: The supported tablet for using gestures in Motion is the Wacom Intuos tablet family.
Swipes, pinches and other gestures performed on a Multi-Touch trackpad are unrelated
to the gestures described in this appendix. Multi-Touch gestures require no setup or
special controls.

This appendix covers the following:

• Configuring Gesture Setup (p. 1489)

• Wacom Settings (p. 1491)

• Using Gestures (p. 1492)

Configuring Gesture Setup
Gestures are enabled by default—but you can change the default gesture input and
trigger methods in Motion Preferences. When gestures are enabled, you can choose to
use a modifier key (the Control key) or a button on the pen to trigger gesturing.

Before you can use gestures, Handwriting Recognition must be enabled in Mac OS X Ink
Preferences. The Ink Preferences can be accessed in Motion Gesture Preferences.

Important: To use gestures, make sure that your Wacom tablet and its current drivers
are correctly installed on your computer. For more information, see your tablet’s
documentation.

To set up Motion Gesture Preferences
1 In Motion, choose Motion > Preferences (or press Command-Comma).

2 Click Gestures.
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The Gestures Preferences pane appears.

Turn gestures on or off.

Important: Gestures in Motion use the Inkwell technology in the Mac OS X operating
system. In order to use gestures, you must first enable Handwriting Recognition in Motion
Preferences. If you cannot turn gestures on at this point, or perform the following steps,
click Open Ink Preferences and follow the instructions in the section, Gestures in the Air.
Once you have enabled Handwriting Recognition, complete the following steps.

3 For “Gestures are,” ensure that On is selected.

4 To select a gesture input method, select an option from the Trigger pop-up menu:

• Choose Pen Button 1 to invoke gestures by pressing the first button (the button closest
to the tip) on the pen.

• Choose Pen Button 2 to invoke gestures by pressing the second button on the pen.

• Choose Modifier (Ctrl) to invoke gestures by pressing Control.

Gestures in the Air
You can use gestures by swiping just above the tablet, without the tip of the pen actually
touching the tablet. Turn this feature on by selecting the “Allow gestures in the air”
checkbox.

Important: To use gestures in the air, you must set one of the pen buttons as the gesture
trigger input method, as well as set the pen button 1 to Ignored in the Tool Buttons tab
of the Wacom Tablet application. For more information, see Wacom Settings.

To set up Ink Preferences
1 In the Gestures pane of Motion Preferences, click Open Ink Preferences.

The Ink Preferences appear.
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2 For “Handwriting recognition is,” click the On option.

Turn handwriting 
recognition on or off.

By default, a “whoosh” sound is played when gestures are drawn.

To disable the default gesture sound
1 Click the Options button in Ink Preferences.

2 In the Ink dialog, deselect “Play sound while writing.”

Turn “Play sound while 
writing” on and off.

Wacom Settings
In the Wacom Tablet application, you can create customized tool settings for individual
applications. For example, you can disable the pen buttons for use in Motion, but have
button 1 set as “Double-Click” for another application.
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To customize the pen buttons for a specific application
1 In your Applications folder, open the Wacom Tablet application.

2 In the Wacom Tablet dialog, click Add Application To List and do one of the following:

• If Motion is currently open, select it from the “Currently running applications” list.

• If Motion is not currently open, click the Browse button, navigate to and select Motion,
then click Choose.

Motion appears in the Selected Application field.

3 Select all applicable tablets, then click OK.

4 In the Add Tool To Application dialog, click OK.

Motion appears in the “Applications with customized tool settings” window.

5 Click the Motion icon, then set your pen tool options in the Tool Buttons tab.

6 To set customized tool settings for another application, follow steps 2–5 for that
application.

Using Gestures
The following illustration shows the basic gesture anatomy. The green dot represents the
start of the gesture; the blue arrow is the direction of your gesture; and the red dot the
end of the gesture. Draw the gesture on the tablet, with your pointer in the Motion Canvas
or Timeline.

Direction of movement

Gesture end position

Gesture start position

Modifier Keys
Many gestures have additional functionality when used in combination with a key on the
keyboard. In the following tables, if a gesture has an entry in the Modifier keys column,
it has additional functionality that is accessed by using a shortcut key. For example, if you
have the Control key set as the gesture trigger, and you draw the play forward gesture,
the project plays forward from the current time. If you press Control-Shift and draw the
play forward gesture, the project plays from the start of the project.

The Motion Gestures
The following tables describe the available Motion gestures and their modifier keys, where
applicable.
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Note: There is no defined minimum or maximum scale for the gestural input. The tolerance
is defined by the Inkwell technology. However, the size at which certain gestures are
drawn may affect the result of the gesture. For example, when using the “fit to fill” zoom
gesture and you draw a large circle, the zoom amount is small. If you draw a small circle,
the zoom is large.

Playback Control Gestures
Use the gestures described in the following table for controlling playback.

Modifier keysDescriptionGesture

To advance in increments of
10 frames, press Shift.

Advance one frame.

To go back in increments of
10 frames, press Shift.

Go back one frame.

• To play from start, press Shift.
• To turn looping on or off,

press Option.

Play forward at normal speed.

Stop or pause playback.

General Navigation
Use the gestures in the following table for general navigation, such as zooming the Canvas
and displaying the different panes in the Motion user interface.

Modifier keysDescriptionGesture

• To zoom to the area within
the gesture, press Shift. For
example, if you draw a small
gesture around an area, you
get a large zoom. If you draw
a large gesture, you get a
small zoom.

• To position the zoom in at the
center of the gesture, press
Option.

Zoom in to the Canvas.

To position the zoom out at the
center of the gesture, press
Option.

Zoom out of the Canvas.
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Modifier keysDescriptionGesture

Select the Zoom tool. To zoom
in and out of the Canvas, move
the pen left or right. The zoom
is centered on the area in which
the pointer is placed in the
Canvas.

Select the Pan tool.

Set the Canvas to Home (100
percent).

To switch the Canvas display to
full-screen mode, press Shift.

Fit the Canvas in the window.

Show or hide the Timing pane.

Show or hide the Project pane.

Show or hide the Inspector.

Show or hide the File Browser.

Show or hide the Library.

General Commands
The following table describes the gestures for general commands, such as undo, select,
and copy and paste.
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Modifier keysDescriptionGesture

Undo

Redo

Delete the selected object.

Choose the Select tool. If a Select
tool mode is enabled, such as
Shear, when the gesture is
drawn, the Select mode is
enabled.

Show and hide the HUD.

Copy

Paste Note: The Paste command
may be a bit tricky to master.

Timeline Navigation and Editing Gestures
The following table describes the gestures used for Timeline navigation and editing.

Modifier keysDescriptionGesture

Go to start of play range.
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Modifier keysDescriptionGesture

Go to end of play range.

Go to the start of the project.

Go to the end of the project.

Go to start of the currently
selected object.

Go to end of the currently
selected object.

Group

Ungroup

To move the In point to the
current playhead position, press
Shift.

Set a local In point for the
currently selected object.

To move the Out point to the
current playhead position, press
Shift.

Set a local Out point for the
currently selected object.

To bring an object to the front
of the stack, press Shift.

Bring the selected object
forward in the stack.
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Modifier keysDescriptionGesture

To send an object to the back of
the stack, press Shift.

Send the selected object
backward in the stack.

• To edit a project marker, press
Shift.

• To clear a project marker,
press Option.

Add a project marker.

• To edit an object marker,
press Shift.

• To clear an object marker,
press Option.

Add an object marker.

To clear the play range, press
Option.

Set the start of the play range.

To clear the end of the play
range, press Option.

Set the end of the play range.
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